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New features

New Features in Version 5.1.30

Status bar width
● You can now hide/show tools in the status bar. See Hiding/Showing status bar tools.

Systemic barlines
● You can now hide systemic barlines and brackets/braces at individual system/frame breaks 

and codas. See Hiding/Showing systemic barlines and brackets/braces.

Coda gaps
● You can now change the gap preceding individual coda sections. See Changing the gap 

before codas.

New Features in Version 5.1.20

Comments panel improvements
● You can now sort comments by different attributes, and change which pieces of 

information are shown. See Reordering comments and Hiding/Showing comment 
information.

Mixer values
● You can now enter exact panning and volume values in Mixer channels. See Changing the 

volume of channels and Panning channels.

Staff label improvements
● When hiding/showing staff labels, you can now apply your changes to the first flow only, or 

to all flows in the layout. See Hiding/Showing staff labels.
● You can now indent the first systems of flows only when staff labels are hidden. See 

Changing the first system indent.

Aggregate time signatures
● It is now possible to combine aggregate time signatures with the same denominator into 

a single time signature, while retaining dashed barlines for meter divisions. See Combining 
aggregate time signatures.

New Features in Version 5.1.10

Harp pedals editor
● A new Harp Pedals section in the Playing Techniques panel allows you to create harp pedal 

diagrams using a visual editor. See Playing Techniques panel.

Colors for accidentals
● You can now show cautionary and forced accidentals in different colors, independently of 

each other. See Hiding/Showing colors for accidentals.
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New Features in Version 5.1.0

Highlights

Iconica Sketch
● Iconica Sketch sounds, and playback templates for using them, are now included with 

Dorico Elements. See Playback templates.

Text export
● It is now possible to export all text in the project to a CSV file. See Exporting text.

Project statistics
● Dorico Elements can now generate statistics for the whole project or only an individual 

flow. Being able to know how many bars there are in a piece of music, and to differentiate 
between filled and empty bars, can be necessary when calculating engraving fees. See 
Project Statistics dialog.

History dialog
● You can now view your edits and selections in a dialog, and undo/redo all actions up to the 

selected one. See History dialog.

Polyphonic voice balancing
● Dorico Elements can now identify melodies and bass notes in polyphonic music, and 

emphasize them relative to accompanying notes. See Enabling/Disabling polyphonic voice 
balancing.

● There are further voice balancing options for themes in contrapuntal music specifically. See 
Enabling/Disabling dynamic rules for contrapuntal music.

Hold and pause playback
● Holds and pauses now affect playback, using a combination of changing note durations 

and inserting gaps. See Holds and pauses in playback.

More New Features

Project Info dialog
● You can now use italic, bold, and bold italic Markdown formatting for specific characters 

within fields in the Project Info dialog. See Project Info dialog.

Instrument change improvements
● You can now delay instrument changes until before the first note in the new instrument, 

and change where instrument change labels appear relative to cues. See Changing the 
position of instrument changes.

● You can now hide instrument change warnings in each layout independently. See Hiding/
Showing instrument change warnings.

● Dorico Elements now provides two paragraph styles for instrument change labels, allowing 
you to customize the appearance of instrument change warnings independently of the 
labels shown at new instruments’ entries. See Instrument change label paragraph styles.

Hidden notations
● You can now input hidden tempo marks and playing techniques by enclosing your popover 

entry in parentheses. See Inputting tempo marks with the popover and Inputting playing 
techniques with the popover.

Mouse editing
● It is now possible to transpose notes by octave division when clicking and dragging with 

the mouse. See Changing the pitch of individual notes.

New features
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Exporting flows
● You can now export flows as separate PDF files. See Exporting layouts as graphics files.

Lock Played Durations
● This new function allows you to retain the played durations of notes, regardless of edits 

you make to their notated positions/durations in the piano roll editor. See Key Editor panel 
toolbar.

Used chord diagrams grids
● It is now possible to exclude individual chord diagram shapes from used chord diagrams 

grids. See Including/Excluding chord diagrams from used chord diagrams grids.

Dynamics improvements
● There are new options for the appearance and position of syllables in hyphenated gradual 

dynamics. See Changing the appearance of gradual dynamics and Abbreviating gradual 
dynamics.

Cautionary key/time signatures
● It is now possible to hide cautionary key signatures and time signatures at the ends of 

systems. See Hiding/Showing cautionary key signatures and Hiding/Showing cautionary 
time signatures.

Glissando playback
● Dorico Elements now supports continuous glissando playback using MIDI pitch bend. See 

Changing the glissando playback type.

New Features in Version 5.0.20

Mixer panel
● Channel strips are now shown in the Mixer panel when it is sufficiently tall. See Mixer panel.

Tie chains
● Edits to tie chains in Write mode, including changing the stem direction of notes, now affect 

all notes and ties in the chain.

New Features in Version 5.0.0

Highlights

Groove Agent SE
● Dorico Elements now comes with Groove Agent SE, allowing you to drag and drop patterns 

onto drum set tracks and trigger patterns using MIDI trigger regions. See Importing drum 
set patterns from Groove Agent SE.

● If you have installed Groove Agent SE, you can use new playback templates to load Groove 
Agent SE automatically when you add drum sets. See Playback templates.

Dorico Elements features
● You can now have unlimited players in a single project. See Players.
● Note spacing and staff spacing tools are now available in Engrave mode in Dorico 

Elements, allowing you to adjust horizontal and vertical spacing in more detailed ways. 
See Engrave mode.

● The Playback Options dialog is now available in Dorico Elements. See Playback Options 
dialog.

● The Edit Font Styles, Paragraph Styles, and Character Styles dialogs are now available in 
Dorico Elements, allowing you to change the formatting of text styles. See Text formatting.

New features
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Mouse editing
● It is now possible to transpose, move, and copy notes by clicking and dragging with the 

mouse. See Enabling/Disabling mouse editing.

Multiple item creation
● You can now input notations onto multiple staves simultaneously outside of note input. By 

default, Dorico Elements inputs notations at the first note on each staff. See Changing the 
item input position setting.

Scrubbing
● It is now possible to use scrub playback in Dorico Elements. See Scrubbing.

MIDI trigger regions
● This new feature allows you to play back notes without showing them in the music, such as 

when using patterns in Groove Agent for playback. See MIDI trigger regions.

Space and Stage templates
● These new features work together to make it much easier to produce realistic playback 

performances of your music. Stage templates allow you to position instruments as if 
they were on a real stage. Space templates emulate different rooms and concert halls 
by applying panning and reverb settings to instruments’ stage positions. The end result 
is playback that uses the stereo field more realistically, with deeper and more natural 
reverberation. See Space templates and Stage templates.

Pitch contour emphasis
● This new algorithm allows melodies to play back even more expressively. See Enabling/

Disabling pitch contour emphasis.

More New Features

User interface improvements
● The status bar has been given additional options, allowing you to switch the current layout 

between concert/transposed pitch and galley/page view more easily. See Status bar.
● You can now enable/disable playhead following during playback in each project window 

independently. See Enabling/Disabling playhead following.

Middle C numbering convention
● You can now change the numbering convention used for middle C (MIDI note 60) 

throughout Dorico Elements. See Changing the middle C numbering convention.

Instrument numbering
● It is now possible to renumber instruments so that their numbering matches their default 

player order. See Renumbering instruments.

Staff label improvements
● In simple cases, horizontal alignment and leading set for individual instrument names is 

now used in staff labels, overriding the settings from the corresponding paragraph style. 
See Edit Instrument Names dialog.

● You can now show player names in staff labels only on the first system in each flow, 
with instrument names shown in staff labels on all other systems. See Showing instrument/
player names in staff labels.

Rhythm dots
● To select dotted note durations, you can now double-press note duration key commands. 

See Inputting notes with rhythm dots.

Text improvements
● You can now enter Unicode characters into both text items and text frames more easily. 

See Inputting text items.

New features
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● You can now adjust leading in individual text items. See Text editor options in Write mode.
● You can now change the paragraph style applied to multiple selected text items 

simultaneously. See Changing the paragraph style of text items.

Playback improvements
● Notes and items can now be muted in specific playthroughs, allowing you to hear selected 

notes only the second time around, for example. See Muting notes/items individually.
● Dorico Elements now supports microtonal playback using MIDI pitch bend. See Expression 

Maps dialog.

Mixer improvements
● It is now possible to add multiple FX channels to the Mixer. See Adding FX channels.
● You can now rename channels in the Mixer. See Renaming channels.

Music fonts
● A variety of new music font families are now available by default. See Music fonts.

Hiding items
● You can now hide clefs in layouts of any transposition, independently of other layouts. See 

Hiding/Showing clefs.
● You can now hide octave lines in individual layouts. See Hiding/Showing octave lines.

New features
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Introduction

Thank you very much for purchasing Dorico Elements.

We are delighted that you have chosen Steinberg's scoring application and hope that you will 
enjoy using it for years to come.

Dorico is a next-generation application for producing beautiful sheet music, whether you are 
a composer, arranger, music engraver, publisher, instrumentalist, teacher, or student. Whether 
you want to print your music or share it in a digital format, Dorico is the most sophisticated 
program available.

Like all of Steinberg's products, Dorico has been designed from the ground up by a team of 
musicians who understand your needs and who are dedicated to producing a tool that is both 
easy to learn and use, but also capable of results of the highest quality. Dorico also integrates 
with your existing workflow and can import and export files in a variety of formats.

Dorico thinks about music the same way a human musician does and has a deeper 
understanding of the elements of music and musical performance than other scoring 
applications. Its unique design allows an unprecedented degree of flexibility, in music input and 
editing, in score layout, in rhythmic freedom, and many other areas besides.

Most sincerely yours,

The Steinberg Dorico Team

Platform-independent documentation
This documentation applies to the operating systems Windows and macOS.

Features and settings that are specific to one of these platforms are clearly indicated. In all other 
cases, the descriptions and procedures in the documentation are valid for Windows and macOS.

Some points to consider:

● The screenshots are taken from macOS and use the dark theme in Dorico Elements.

● Some functions that are available on the File menu on Windows can be found in the 
program name menu on macOS.

Usage of musical terms
This documentation uses American terminology for musical items.

The following table lists all the notes and notations that have different names in American and 
British English:

American name British name

Double whole note Breve

Whole note Semibreve
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American name British name

Half note Minim

Quarter note Crotchet

Eighth note Quaver

Sixteenth note Semiquaver

Thirty-second note Demisemiquaver

Sixty-fourth note Hemidemisemiquaver

Hundred twenty-eighth note Semihemidemisemiquaver

Two hundred fifty-sixth note Demisemihemidemisemiquaver

Half-step Semitone

Whole step Whole tone

Staff Stave

Bar/Measure

NOTE

This documentation only uses “bar”.

Bar

Documentation structure
In our documentation, we divide information into three different types of topics, according to 
their content.

Descriptions of the user interface
Topics that describe the functionality of user interface items and list the options and 
settings of dialogs, panels, or other items.

Descriptions of basic concepts
Topics that describe concepts and explain the functionality of a specific software 
feature.

Descriptions of procedures
Topics that provide step-by-step instructions for how to perform a specific task. These 
topics often provide an example for why you might want to follow the steps and a brief 
summary of the result, including consequences to be aware of.

Because of this division of information, our documentation structure functions as a reference 
you can consult for specific information or instructions as required, rather than a guide you must 
read from start to finish.

Introduction
Documentation structure 
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TIP

Descriptive topics do not describe how to perform a task, and procedural topics do not explain 
what something is. To find general information about items or concepts, we recommend 
searching for them by name, such as “dynamics”. To find instructions for performing particular 
actions, we recommend including a relevant verb in your search, such as “moving”.

Links at the bottom of topics guide you to further relevant content. You can also check the 
sidebar for nearby, related topics in the documentation structure.

Typographical conventions
In our documentation, we use structural and markup elements to present information according 
to its purpose.

Structural elements

Prerequisite
Describes any actions or conditions you must have fulfilled before starting a 
procedure.

Procedure
Lists the steps that you must take to achieve a specific result.

Important
Informs you about serious issues; for example, issues that affect the system, the 
connected hardware, or that risk data loss.

Note
Informs you about issues or other relevant information.

Tip
Adds further information or useful suggestions.

Example
Provides you with an example.

Result
Describes the result of the procedure.

After Completing This Task
Informs you about actions or tasks that you can perform after completing the 
procedure.

Related Links
Lists related topics that you can find in this documentation.

Markup

Bold text indicates the name of a menu, option, function, dialog, window, and so on.

EXAMPLE
To open the Project Info dialog, choose File > Project Info.

Introduction
Typographical conventions 
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If bold text is separated by a greater-than symbol, this indicates either a sequence of different 
menus to open, or directions to follow for navigation inside the dialog named at the start of the 
sequence.

EXAMPLE
Choose Edit > Notations > Voices > Change Voice > [Voice].

You can change this option in Preferences > Note Input and Editing > Editing.

File names and folder paths are shown in a different font.

EXAMPLE
example_file.txt

Key commands
Key commands are sets of keys that perform defined tasks when pressed together. They are 
also known as “keyboard shortcuts” or “hotkeys”. Many key commands are the same on different 
operating systems but some are not, and this guide distinguishes them.

When key commands use equivalent modifier keys depending on the operating system, the 
modifier keys are indicated separated by a slash, with the Windows modifier key first and the 
macOS modifier key second.

EXAMPLE
Ctrl/Cmd-Alt/Opt-Down Arrow  means: press Ctrl - Alt - Down Arrow  on Windows, Cmd - Opt -
Down Arrow  on macOS.

When key commands require entirely different keys depending on the operating system, they are 
indicated with the Windows key command first, followed by the macOS key command.

EXAMPLE
# (Windows) or \ (macOS)  means: press #  on Windows, \  on macOS.

In this documentation, we use key commands that match the language of the documentation. 
For example, key commands in the English documentation correspond to the English keyboard 
language.

RELATED LINKS
Key commands in Dorico on page 26
Key Commands page in the Preferences dialog on page 60
Changing the keyboard language on page 64
Changing the application language on page 57

How you can reach us
You can access additional information from the Help menu.

The menu contains links to various Steinberg web pages. Selecting one of these menu items 
automatically launches your web browser and opens the page. On these pages, you can find 
support and compatibility information, answers to frequently asked questions, information 
about updates and other Steinberg products, and so on.

Introduction
Key commands 
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Dorico concepts

Dorico is based on a number of key concepts that come from its design philosophy.

We recommend familiarizing yourself with these concepts, as this will greatly enhance your 
ability to work efficiently with Dorico and to navigate more easily through this documentation.

Design philosophy and higher-level concepts
Deep design considerations are required to create a notation software like Dorico, which might 
be of particular interest to users familiar with scoring applications. Dorico has a forward-thinking 
design that is led by musical concepts rather than computational convenience, and this provides 
many benefits.

In most other graphically-orientated scoring applications, the highest-level concept is the staff or 
the instrument definition that creates a staff or staves. When setting up your full score in such 
programs, you start by adding the correct number of staves, and you are immediately forced 
into making decisions about the layout. This means that you must know in advance whether two 
flutes share a staff or have their own individual staves, or whether there should be two trumpets 
or three. Many of these decisions have significant effects throughout the process of inputting, 
editing, and producing individual instrumental parts.

Typically, every system of a score must contain the same number of staves, even if some 
are hidden on particular systems. This requires the user to manage common conventions for 
themselves, such as multiple players of the same instrument sharing staves. This can be time-
consuming and is naturally error-prone.

By contrast, Dorico is designed to conform more closely to how music is performed in the real 
world and to make the score a flexible expression of the practical choices that go into a musical 
performance, rather than to make the musical performance subservient to the way the score was 
initially prepared.

To that end, the highest-level concept of Dorico is the group of human musicians that performs 
a score. A score can be written for one or more groups; for example, a double choir, or an 
orchestra plus off-stage chamber ensemble, and so on. Each group includes one or more players 
which correspond to the humans who play one or more instruments. Players may either be 
individuals who play more than one instrument, such as an oboist doubling cor anglais, or 
groups in which everyone plays only one instrument, such as eight desks of violinists.

One crucial difference between Dorico and other scoring applications is that the musical content 
exists independently of the score layout in which it is viewed.

The actual music played by the group in your score belongs to one or more flows. A flow is 
any span of music that stands alone; for example, a whole song, a movement of a sonata or 
symphony, a number in a musical show, or even a short scale or exercise. Players might or might 
not have any music to play in a given flow. For example, all the brass players might be omitted 
from the slow movement of a classical symphony, or certain players might have nothing to play 
in some cues in a movie score. This is no problem as you can combine players in flows in any 
combination.

Dorico’s design philosophy provides several benefits. Chief among them is its ability to produce 
multiple layouts that share the same musical content, but each having customized appearances 
to suit different requirements. For example, in the same project you can create a conductor’s 
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score with as many instruments as possible condensed onto a smaller number of staves, a full 
score with each player’s music on separate staves, a custom score layout containing just the 
piano and vocal staves for choral rehearsals, and an instrumental part for each player that only 
contains the music belonging to them.

This means it is not necessary to extract flows or parts as separate files: all this information can 
co-exist in the same Dorico project file.

RELATED LINKS
Condensing on page 643
Assigning players to layouts on page 176

Projects in Dorico
A project is an individual file that you create within Dorico. It can contain multiple separate pieces 
of music of any duration, written for any combination of instruments, and use as many layouts as 
required.

For example, you can create a single project that contains all the preludes and fugues in Bach’s 
“The Well-Tempered Clavier” as separate flows. You could then have one layout that contains only 
the flows for Book 1 and another layout that contains the flows for Book 2.

In addition to the notated music, projects save other relevant information, such as the playback 
template applied.

Dorico projects are saved as .dorico files.

RELATED LINKS
Flows in Dorico on page 20
Layouts in Dorico on page 24
Options dialogs in Dorico Elements on page 27
Page templates in Dorico on page 25
Playback templates on page 558
Project Info dialog on page 75

Modes in Dorico
Modes in Dorico represent a logical sequence of the workflow phases of preparing music, but 
you can switch between them at any time as required for your own workflow.

Dorico Elements contains the following modes:

Setup
In Setup mode, you can set up the fundamental elements of the project: instruments 
and the players that hold them, flows, layouts, and videos. You can also determine how 
they interact with each other; for example, by changing the players assigned to layouts.

You can view music in the music area and switch between viewing other tabs and 
layouts, but you cannot select or interact with anything in the music area in Setup 
mode.

Write
In Write mode, you can input and edit your music, including changing the rhythmic 
positions of items, changing the pitch of notes, and deleting notes and items. The 
available toolboxes and panels allow you to input all the notes and notation items that 
are most commonly used.

Dorico concepts
Projects in Dorico 
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By design, you cannot move notes and items graphically on the page in Write mode. 
Graphical adjustments are only possible in Engrave mode.

Engrave
In Engrave mode, you can make fine adjustments to the position, size, and appearance 
of notes and items, and determine how the pages of your project are laid out.

By design, you cannot delete any notes or items, change their rhythmic positions, or 
change the pitch of notes in Engrave mode; this prevents mistakes when engraving.

Play
In Play mode, you can change how your music sounds in playback. You can do this by 
changing the playback template and assigning VST instruments, inputting automation, 
adjusting the mix, and changing the sounding duration of notes in playback without 
affecting their notated duration.

Print
In Print mode, you can print your layouts or export them as graphics files. When 
printing layouts, you can specify the paper size and other options, such as duplex or 
booklet printing. When exporting layouts, you can specify different graphics file types, 
such as PDF or PNG, and the information you want to include in their exported file 
names.

RELATED LINKS
Setup mode on page 109
Write mode on page 195
Engrave mode on page 502
Print mode on page 576
Play mode on page 519

Flows in Dorico
Flows are separate spans of music that are completely independent in musical content; for 
example, a single song in an album, a movement in a sonata or symphony, a number in a stage 
musical, or a short scale or sight-reading exercise of only a few bars in length. A single project 
can contain any number of flows.

Each flow can contain music for any combination of players, independently of other flows. For 
example, brass players are often tacet in the second movements of Classical-period symphonies, 
so you can remove brass players from the flow for the second movement but leave them in the 
flows for other movements. In a set of cues for a movie, for example, specific players might not 
be required in some cues, so the corresponding flows can contain only those players who have 
anything to play.

The correct assignment of players to flows allows Dorico, for example, to generate tacet sheets 
automatically for individual instrumental parts.

RELATED LINKS
Players, layouts, and flows on page 121
Flows on page 171
Tacets on page 640
Flow headings on page 651

Dorico concepts
Flows in Dorico 
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Players in Dorico
In Dorico, a player can represent an individual musician or multiple musicians in the same 
section. Players hold instruments, so you must add at least one player to your project before you 
can add instruments.

● A single player represents one person who can play one or more instruments. For example, 
a clarinettist who doubles on alto saxophone or a percussionist who plays bass drum, clash 
cymbals, and triangle.

● A section player represents multiple people who all play the same instrument. For example, 
a violin section player might represent all eight desks of the Violin I section in an orchestra, 
or a soprano section player might represent the whole soprano section in a mixed voice 
choir.

NOTE

Section players can only hold one instrument.

You can also group players together; for example, to separate off-stage players from on-stage 
players in a large-scale work. Grouping players together means they are positioned together in 
the score, numbered independently of players outside the group, and are bracketed together 
according to the ensemble type set for each layout.

Players can be assigned to any combination of layouts and flows.

RELATED LINKS
Players, layouts, and flows on page 121
Players on page 123
Player groups on page 167
Divisi on page 1329
Condensing on page 643
Brackets according to ensemble type on page 866

Instruments in Dorico
In Dorico, an instrument is an individual musical instrument, such as a piano, a flute, or a violin. 
Human voices, such as soprano or tenor, are also considered instruments.

In Dorico, instruments are held by players, just as real instruments are held by human players. 
Section players can only hold one instrument but single players can hold multiple instruments. 
This allows you to handle instrument changes easily, such as when an oboist doubling the cor 
anglais switches from one instrument to the other.

Each instrument automatically gets its own staff, but when instrument changes are allowed, the 
music for multiple instruments held by the same single player can appear on the same staff as 
long as no notes overlap.

Dorico has a database of information about the properties of each instrument. These include 
the playable range, common and uncommon playing techniques, notational conventions, 
transposition properties, tunings, clef, number of staves, type of staff, and so on. Having these 
properties predetermined makes it easier and quicker to set up projects correctly. For example, 
there is a Horn in F instrument that automatically shows treble clefs in transposed pitch layouts. 
Similarly, there is a timpani instrument that automatically hides all key signatures.

RELATED LINKS
Instruments on page 130

Dorico concepts
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Instrument changes on page 136
Transposing instruments on page 132

Popovers
Popovers allow you to input different notations and perform tasks, such as transposing a 
selection of notes, using only your computer keyboard. They are temporary value fields that use 
text entries for different items and tasks, and there are specific popovers for different purposes.

The dynamics popover with an example entry

One of the key benefits of popovers is that you can use them as you input notes: for example, 
once you reach the position where you want to input a new time signature, you can open the 
time signatures popover, input the time signature you want, and then continue inputting notes.

Although specific entries are required for many notations, the correct entries for different 
notations are consistently and logically structured. For example, tuplets are always expressed as 
a ratio, such as 3:2 or 5:4. Key signatures are expressed using capital letters for major keys and 
lowercase letters for minor keys. Time signatures are expressed as a pair of separated numbers; 
common time signatures use a slash, such as 3/4 or 6/8.

During note input, and depending on the notation you are inputting with the respective popover, 
notations are input either on the currently selected note, which is usually the last note you input, 
or at the current rhythmic position, indicated by the caret.

You can always identify popovers by the icon on their left-hand side, which are the same icons 
used in the Notations toolbox on the right of the window. The Notations toolbox allows you to 
hide/show the corresponding notation’s panel, which is another way you can input notations.

You can only use popovers in Write mode, as that is the only mode where you can input notes 
and items together and change the pitch of notes. Popovers open above the top staff on which 
the caret is active or an item is selected, and at the caret position or the rhythmic position of the 
earliest selected item.

RELATED LINKS
Caret on page 218
Note input on page 223
Notations input on page 271
Notations toolbox on page 201
Right zone (Write mode) on page 204

Dorico concepts
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Notes and rests in Dorico
In Dorico, the notation and division of notes and rests is determined semantically by rules based 
on convention. This means that note and rest durations can change and appear differently later 
than when you first input them.

Dorico is able to update how notes and rests are notated depending on their context because of 
the following key concepts:

1. Notes are treated as a single unit, even if they appear as a tie chain that contains multiple 
notes tied together.

2. Implicit rests automatically fill the gaps between the notes you input.

In combination with time signatures and Dorico’s understanding of their corresponding meters, 
this allows you to input only the notes you want with the duration required. It is not necessary 
to input rests between notes or input ties for notes that cross the half-bar, for example. If you 
subsequently change the time signature or move notes rhythmically to start earlier or later, 
Dorico updates how notes and rests are notated, such as by notating a quarter note as two tied 
eighth notes if it now straddles a barline or consolidating two eighth note rests into a single 
quarter note rest if they are now in the same bar.

If you tie existing notes together, you might find that they turn into a single note, such as a 
half note instead of two tied quarter notes, or into a tie chain containing more notes. This is 
because tie chains are treated as single notes in Dorico, and Dorico automatically notates and 
beams notes appropriately depending on their duration, the prevailing time signature, and their 
position in the bar. Similarly, notes can change after you input notes immediately following them 
as this changes the context, such as a quarter note tied to an eighth note becoming a dotted 
quarter note when it is followed by an eighth note rather than a rest.

TIP

In Write mode, selecting any part of a tie chain selects the whole tie chain because it is a single 
note. However, you can still input notations, such as dynamics, in the middle of tie chains by 
activating the caret and moving it to the required rhythmic position within the tie chain.

You can change default settings for note and rest grouping, and also beam grouping, on a 
per-flow basis. You can force the duration of individual notes and rests; for example, if you want 
to specify subdivisions within a tie chain that are different than the prevailing meter.

RELATED LINKS
Notes on page 1052
Ties on page 1364
Implicit vs. explicit rests on page 1272
Note and rest grouping on page 860
Beam grouping according to meters on page 841
Per-flow notation options for beam grouping on page 840
Caret on page 218
Inputting notes on page 224
Forcing the duration of notes/rests on page 262
Inputting ties on page 247

Dorico concepts
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Rhythmic position
In Dorico, notes and items exist at rhythmic positions, which are calculated using their place in 
musical time in the flow rather than their position in a specific bar that has a particular time 
signature.

In Dorico, musical time is the number of beats starting from the beginning of each flow. For 
example, instead of a note existing on beat 3 in bar 4 in a 4/4 time signature, Dorico considers 
that note to exist at beat 15, regardless of the time signature and its position in a bar.

This approach allows for a lot of flexibility. For example, because notes and items exist 
independently of bars and time signatures in Dorico, you can change the time signature without 
changing when notes happen in relation to each other or adding rests at the end of each 
bar. Instead, the barlines simply move to different positions and note grouping is updated as 
required, such as notating a quarter note as two tied eighth notes if it now straddles a barline or 
crosses the half-bar. You can even start writing notes without inputting a time signature at all.

Similarly, you can easily push notes to later rhythmic positions or pull them in to earlier ones 
using Insert mode without the risk of them being incorrectly notated. It also means you can 
think of items existing in the music independently of notes, because items exist at a particular 
rhythmic position, rather than being attached to notes. To input items at rhythmic positions that 
do not coincide with the start of notes, such as dynamics in the middle of tie chains, you can 
either select any other item at that position, or activate the caret and input items at the caret 
position.

In Dorico, the rhythmic position of notes and items is separate from their graphical position on 
the page. The benefit of this is that you can input items at the position in the music where they 
must apply and then move them graphically without causing them to apply to different notes or 
inadvertently split multi-bar rests. For example, if you want strings to play pizzicato from the start 
of a bar, but because of tight vertical spacing you want to move the pizz. indication slightly to 
the side. Attachment lines link items to the rhythmic positions to which they apply, so it is always 
clear where they belong, but are not printed.

RELATED LINKS
Note and rest grouping on page 860
Hiding/Showing ties across beat boundaries on page 861
Beaming on page 840
Time signatures on page 1381
Inputting notes in Insert mode on page 237
Notes on page 1052
Caret on page 218
Insert mode on page 451
Rhythmic grid on page 217
Annotations on page 597
Hiding/Showing attachment lines on page 437

Layouts in Dorico
Layouts combine musical content, as represented by flows and players, with rules for page 
formatting and music engraving, and allow you to produce paginated music notation that can be 
printed or exported in various formats. For example, part layouts typically only show the music 
for one player, whereas full score layouts show the music of all players in the project.

A typical project for an ensemble contains several layouts. By default, Dorico projects contain a 
single full score layout that contains the music for all players, and a part layout for each player 
that only contains their music. However, you can also create as many layouts as required.

Dorico concepts
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When you add the first player to a project, Dorico automatically creates a full score layout and 
a part layout. For all subsequent players you add to the project, Dorico creates a part layout for 
each player and assigns them all to the existing full score layout.

Layouts can contain any combination of players and flows. They share the musical content of 
these players and flows, such as the notes each instrument plays. For example, when you change 
the pitch of a note in the full score, that note’s pitch is also updated in the corresponding part 
layout.

You can control practically every aspect of page formatting in each layout independently, 
including note spacing, staff size, page size, margins, and casting off; that is, the positions of 
system breaks and page turns. Changing these aspects in one layout does not affect other 
layouts. For example, inserting systems breaks in a part layout does not change the casting off in 
the full score.

Similarly, you can change the visual appearance of many items only in one layout, without 
affecting other layouts, using local properties. For example, you can hide text items in the full 
score layout but show them in part layouts.

The default formatting of pages in layouts is determined by page templates. By default, full score 
layouts use a different page template set to part layouts; however, you can apply a different page 
template set to each layout.

Deleting layouts does not delete any music from the project.

RELATED LINKS
Layouts on page 174
Players, layouts, and flows on page 121
Page formatting on page 598
Casting off on page 629
Condensing on page 643
Properties on page 663
Local vs. global properties on page 664
Page templates on page 647
Page template sets on page 647
Types of page templates on page 648
Applying page template sets to layouts on page 601
Printing layouts on page 581
Exporting layouts as graphics files on page 585

Page templates in Dorico
Page templates in Dorico Elements allow you to achieve consistent page formatting by applying 
the same arrangements of frames to multiple pages and in different layouts.

Frames are boxes in which you can display text, music, and graphics. The default page templates 
contain a large music frame that takes up most of the page and text frames at the top and 
bottom. These text frames display different information according to the page template type.

All pages in your scores and parts inherit their default formatting from page templates.

Dorico Elements provides different types of page templates so that there is appropriate page 
formatting for first pages independently of subsequent pages, as the first page typically includes 
additional information, such as the title, composer, and copyright. Dorico Elements uses tokens 
to display this additional information.

Dorico concepts
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Page templates are contained in page template sets. By default, Dorico Elements provides 
separate page template sets for full score and part layouts. Page template sets are automatically 
applied to every layout that you create.

NOTE

● In Dorico Elements, you cannot edit page templates or create new ones; this is only available 
in Dorico Pro.

● Changing individual pages in layouts is considered a page template override in Dorico 
Elements. This includes, for example, editing the title or running header in Write mode. 
Pages with page template overrides are not automatically deleted, even if they are empty 
because the layout became shorter.

If you want to change the information shown at the tops of pages, that is, the title and 
running header text that you cannot select, we recommend that you do so in the Project 
Info dialog to avoid page template overrides.

RELATED LINKS
Page template sets on page 647
Page templates on page 647
Types of page templates on page 648
Frames on page 654
Project Info dialog on page 75
Tokens on page 655

Key commands in Dorico
Dorico’s key commands have been designed to be logical, consistent, and accessible using a 
standard computer keyboard, without needing a number pad.

EXAMPLE

● The arrow keys on their own navigate the selection around the music area.

● Alt/Opt  modifies selected items.

For example, in Write mode, adding Alt/Opt  to the up/down arrow keys transposes notes by 
staff position; adding Alt/Opt  to the right/left arrow keys moves notes/items rhythmically. 
In Engrave mode, adding Alt/Opt  to any arrow key moves items a small amount graphically.

● Shift - Alt/Opt  changes the duration of notes/items in Write mode.

For example, Shift-Alt/Opt-Right Arrow  lengthens notes/items by the current rhythmic 
grid resolution.

● Ctrl/Cmd  increases the amount by which selected items are modified.

For example, in Write mode, adding Ctrl/Cmd - Alt/Opt  to the up/down arrow keys 
transposes notes by an octave; Ctrl/Cmd-Shift-Alt/Opt-Right Arrow  doubles the duration 
of notes. In Engrave mode, adding Ctrl/Cmd - Alt/Opt  to any arrow key moves items a large 
amount graphically.

● Shift  plus letter keys opens popovers in Write mode.

For example, Shift-D  opens the dynamics popover; Shift-O  opens the ornaments popover.

● Ctrl/Cmd - Shift  plus specific letter keys opens options dialogs.

For example, Ctrl/Cmd-Shift-L  opens Layout Options; Ctrl/Cmd-Shift-N  opens Notation 
Options.

Dorico concepts
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The default key commands in Dorico depend on your keyboard language setting, which follows 
your application language setting by default.

You can view available key commands in the following ways:

● Choose Help > Key Commands to open the Dorico Key Commands window, which provides 
an overview of all available key commands.

● Search for key commands of specific functions or menu items in Preferences > Key 
Commands. In this dialog, you can also assign new key commands or change default key 
commands.

● When you move the mouse over a tool or a function that has a key command, a tooltip with 
the corresponding key command in brackets is shown.

RELATED LINKS
Interactive Dorico key commands map on page 61
Key Commands page in the Preferences dialog on page 60
Changing the keyboard language on page 64
Changing the application language on page 57

Options dialogs in Dorico Elements
Options to control the default appearance of music and functionality of Dorico Elements are 
available in different dialogs according to their type and purpose.

We recommend becoming familiar with the available options in these dialogs, as finding the 
most appropriate settings for each project reduces the requirement for manual intervention and 
graphical tweaks.

Any changes you make in options dialogs apply to the current project only, unless you save your 
settings as default, which updates the default settings with which all future projects start.

Dorico Elements contains the following dialogs for global settings:

Layout Options
Contains options that are likely to vary from layout to layout, such as page size, staff 
size, and the appearance and position of bar numbers. Options in Layout Options 
affect only the selected layouts but apply to all flows in those layouts.

Notation Options
Contains options that are likely to vary from flow to flow, such as beam grouping and 
accidental duration rules. Options in Notation Options affect only the selected flows 
but apply to all layouts in which those flows appear.

Playback Options
Contains options that control what you hear in playback and how notation items affect 
playback, including setting a dynamic curve for how much different dynamics affect 
the volume, whether repeats are included in playback, and whether you want a gap 
between flows. Options in Playback Options affect the whole project but do not affect 
any other projects unless you save your settings as default.

TIP

Many options have equivalent properties, which you can change for individual notes and items.

RELATED LINKS
Layout Options dialog on page 745

Dorico concepts
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Notation Options dialog on page 747
Playback Options dialog on page 749
Preferences dialog on page 58
Properties on page 663

Dorico concepts
Options dialogs in Dorico Elements 
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User interface

The user interface of Dorico Elements is designed to keep all of the important tools at your 
fingertips. This chapter introduces you to key aspects of the user interface.

Project window
Dorico Elements’s main project window allows you to access all the options and tools you need 
to work on a project. You can open multiple project windows for the same project or for different 
projects.

The project window comprises the following areas:

1 Toolbar

Allows you to access the modes, workspace options, the Mixer window, the Video window, 
and the mini transport. Also allows you to undo and redo actions.

2 Tab bar

Displays all open tabs. If you split the music area and open several tabs, tab groups are 
shown. Available in Setup, Write, and Engrave modes.

3 Central area

The central part of the project window where you work on your project.

When you start a new empty project, this area shows the project start area that allows you to 
add your first players.

Once you have added a player or an ensemble, this area becomes the music area that shows 
the music notation of the currently selected layout.

In Play mode, this area contains a track overview that displays your music in a similar way to 
that used in a digital audio workstation, or “DAW”, such as Cubase.
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In Print mode, the print preview area shows a preview of how your project will appear when 
printed onto paper or exported into a graphics file format.

4 Zones

Zones on the left, right, and lower edges of the project window contain panels that provide 
the notes, notations, and functions that you need to create and edit your music. Different 
panels are available in each zone according to the mode.

5 Toolboxes

Toolboxes provide access to items and tools that you can use to input and edit your music. 
Different toolboxes contain different items and tools according to the mode.

6 Status bar

Allows you to choose a different view and page arrangement of the music area. It also 
contains zoom options and a summary of your current selection in the music area.

RELATED LINKS
Starting new projects on page 71
Workspace setup on page 43
Project window in Setup mode on page 109
Project window in Write mode on page 195
Project window in Engrave mode on page 502
Project window in Play mode on page 519
Project window in Print mode on page 576

Toolbar
The toolbar allows you to access modes and workspace options as well as the Mixer and main 
transport options. It is located at the top of the project window and is available in all modes.

You can hide/show the toolbar in any of the following ways:

● Press Ctrl/Cmd-6 .

● Choose Window > Show Toolbar.

The toolbar contains the following:

1 Modes

Selectable workspaces in the project window that represent different phases in the workflow 
of preparing a score. If the width of the main project window becomes sufficiently small, the 
mode buttons become a menu.

2 Workspace options

Allow you to select different layouts to open in the music area, hide/show zones, and hide/
show the tab bar.

3 Show Video

Hides/Shows the Video window.

4 Show Mixer

Hides/Shows the Mixer window.

5 Mini transport

Allows you quick access to the main transport functions, including Play, Record, and Click.

User interface
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6 Show Transport Bar

Hides/Shows the Transport window, which contains playback and MIDI recording functions.

7 Undo

Allows you to undo previous actions.

8 Redo

Allows you to restore previous actions that were undone using Undo.

RELATED LINKS
Hub on page 69
Modes in Dorico on page 19
Transport window on page 555
Videos on page 189
Mixer window on page 718
Undoing/Redoing actions on page 438

Workspace options
The workspace options in the middle of the toolbar provide options that allow you to select 
different layouts and to change the working environment.

Layout selector

Allows you to select other layouts to show in the current tab.

Show Tabs
Shows/Hides the tab bar above the music area.

Show Tabs when the tab bar is hidden Show Tabs when the tab bar is shown

Hide/Restore Zones
Shows/Hides all open zones.

Hide/Restore Zones when zones are shown Hide/Restore Zones when all zones were 
previously shown but are now all hidden

RELATED LINKS
Layouts on page 174
Switching between layouts on page 43
Zones and panels on page 37
Hiding/Showing zones on page 44
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Mini transport
The mini transport on the right of the toolbar provides quick access to the main transport 
functions of Dorico Elements.

Activate Project

Activates/Deactivates playback in the project. When playback is deactivated, transport 
and playback functions are disabled.

Time display
Shows the position of the playhead in one of the following formats:

● Bars, beats, and ticks

● Elapsed time in the following order of units: hours, minutes, seconds, milliseconds

● Timecode in the following order of units: hours, minutes, seconds, frames

Time display showing bars 
and beats

Time display showing 
elapsed time

Time display showing the 
timecode

You can change the content shown in the time display by clicking it.

Rewind to Beginning of Flow

Moves the playhead back to the beginning of the flow.

Play
Starts/Stops playback, either from the playhead position or the earliest selected item, 
depending on your setting on the Play page in Preferences.

Play when playback is stopped Play during playback

Record
Starts/Stops MIDI recording.

Record outside of MIDI recording Record during MIDI recording

Click

Plays/Mutes the metronome click during playback and recording.

Tempo Mode
Displays the tempo used for both playback and recording. The value changes 
according to the playhead position, and its appearance changes according to its mode.
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Fixed Tempo Mode Follow Tempo Mode

● You can change the tempo mode by clicking the beat unit.

● You can change the metronome mark value used in fixed tempo mode by clicking 
the number to show a slider, then dragging the slider to the right/left.

Scrub Playback
Activates/Deactivates scrub playback.

Scrub Playback outside of scrubbing Scrub Playback during scrubbing

TIP

The Transport window contains additional transport functions.

RELATED LINKS
Transport window on page 555
Playing back music on page 540
Moving the playhead on page 538
Scrubbing on page 542
MIDI recording on page 264
Changing the tempo mode on page 543
Changing the sound used for the click on page 533
Preferences dialog on page 58
Timecodes on page 1226

Tab bar
The tab bar in Dorico Elements allows you to display different layouts within the same project 
window. It is located between the toolbar and the music area.

● You can hide/show the tab bar by clicking Show Tabs  in the toolbar.

The tab bar contains the following:

1 Tabs

Displays all open tabs, with their position from left to right reflecting the order in which you 
opened them. Each tab is labeled with the name of the selected layout. The tab currently in 
view in the music area is highlighted.

When you hover over an individual tab, an x appears that allows you to close the tab.
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2 New Tab

Allows you to open a new tab. Tabs can contain a different layout, or an additional view of a 
layout that is already open in another tab or window.

TIP

You can change whether the tab bar is hidden or shown in new projects by default in 
Preferences > General > View.

RELATED LINKS
Preferences dialog on page 58

Project start area
The project start area is displayed in the middle of the project window in Setup, Write, and 
Engrave modes when you set up a new empty project. When you add at least one player, the 
view changes into the music area.

The project start area shows cards that allow you to add players to the project.

RELATED LINKS
Adding players on page 124

Music area
In Setup, Write, and Engrave modes, the music area shows the music notation of the currently 
selected layout. It is the central part of the project window where you work on your project.
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The music area displays layouts in either galley view or page view. In Engrave mode, layouts 
always appear in page view.

The tab bar above the music area allows you to open multiple layouts in the project 
simultaneously and switch between them. The scroll bars to the right and to the bottom of the 
music area allow you to scroll within the layout.

You can use the layout selector in the toolbar to show other layouts in the music area.

When zones are open on the right, left, and lower edges of the window, the size of the music 
area can be reduced. You can hide/show zones when necessary.

RELATED LINKS
Toolbar on page 30
Switching to galley/page view on page 50
Switching between layouts on page 43
Hiding/Showing zones on page 44
Navigation on page 439
Layouts on page 174
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Print preview area
The print preview area is the central part of the project window in Print mode that shows a 
preview of what will be printed or exported as a graphic.

Print preview area displaying a score set to print 2-up

The print preview area shows a preview of the first layout selected in the Layouts panel. You 
can scroll through the pages that are shown, but you cannot edit layouts. If you want to make 
changes, you must switch to Setup or Write mode.

TIP

You can go directly to the first page in the layout by pressing Home , and to the last page 
by pressing End . You can change these key commands on the Key Commands page in 
Preferences.

If you select multiple layouts to be printed as part of the same print job, the print preview area 
only displays the first layout. If you want to show the expected page arrangement for each layout 
in the print preview, you must check each layout individually before you start printing.

RELATED LINKS
Project window in Print mode on page 576
Layouts panel (Print mode) on page 577
Key Commands page in the Preferences dialog on page 60
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Zones and panels
Zones on the left, right, and lower edges of the project window contain panels that provide 
the notes, notations, and functions that you need to set up, write, edit, and format your music. 
Different panels are available in each zone according to the mode.

You can hide/show each zone individually or all of them at the same time.

1 Left zone. In Write mode, this contains the Notes panel.

2 Right zone. In Write mode, this can display different panels, according to the current 
selection in the Notations toolbox.

3 Lower zone. In Write mode, this can display different panels, including the Properties panel 
and Mixer.

The zones contain different panels in each mode in Dorico Elements.

Modes and their panels

Mode Left Zone Right Zone Lower Zone

Setup Players panel Layouts panel Flows panel

Write Notes panel Notations panels Properties, Keyboard, 
Fretboard, Drum Pads, 
Mixer, and Key Editor 
panels

Engrave Formatting panel n/a Properties and Mixer 
panels

Play Track Inspector and 
VST and MIDI panel

n/a Mixer and Key Editor 
panels

Print Layouts panel Print Options panel n/a
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RELATED LINKS
Modes in Dorico on page 19
Hiding/Showing zones on page 44
Players panel on page 110
Layouts panel (Setup mode) on page 117
Flows panel on page 120
Notes panel on page 200
Right zone (Write mode) on page 204
Lower zone (Write mode) on page 205
Properties panel on page 663
Track Inspector on page 522
Key Editor panel on page 667
Mixer panel on page 717
Layouts panel (Print mode) on page 577
Print Options panel on page 578

Toolboxes
Toolboxes are located on the right and left edges of the project window in some modes. They 
contain different tools and options according to the current mode, but in general they allow you 
to input and modify notes/items and to show different panels in the corresponding zone.

The following toolboxes are available in the different modes:

Write mode

● Notes toolbox on the left of the project window

● Notations toolbox on the right of the project window

Engrave mode

● Engrave toolbox on the left of the project window

RELATED LINKS
Project window on page 29
Notes toolbox on page 196
Notations toolbox on page 201
Engrave toolbox on page 503

Status bar
The status bar at the bottom of the project window allows you to choose different views and 
page arrangements for the music area.

NOTE

Not all options in the status bar are available in all modes.

1 Rhythmic Grid selector

Allows you to change the rhythmic grid resolution, which affects certain aspects of inputting 
and editing, such as the amount by which items move.

2 Layout transposition

Allows you to change the transposition of the layout currently open in the music area.
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3 Order

Allows you to change the instrument score order. Only available in Setup mode.

4 Selection summary

Displays the following information about the current selection, from left to right:

● The bar/range of bars of the current selection

● Summary of the selection; for example, the pitch and voice of a single selected note, or 
the implied chord of multiple selected notes

5 Disclosure arrow

Allows you to hide/show the lower zone.

6 Follow playhead

Allows you to enable/disable views in the corresponding window to follow the playhead 
during playback.

7 Selection tools

Allow you to switch between using the Marquee Tool and the Hand Tool.

8 View type

Allows you to change the view type of the layout currently open in the music area between 
page view and galley view.

9 Page arrangement options

Allow you to choose between different horizontal and vertical arrangements of either 
individual pages or pairs of pages, which are called spreads.

10 Zoom options

Allow you to change the zoom factor of the music area and its musical contents. There are 
preset zoom levels, but you can also use a custom zoom level.

11 MIDI activity indicator/Audio engine connection warning

Indicates that there might be MIDI or audio problems that require your attention.

● A brief green light  indicates that Dorico Elements is receiving MIDI input from a 
connected device. If the green light is persistent, a connected MIDI device is sending lots 
of data, which can cause problems.

● A warning icon  indicates that Dorico Elements is unable to send MIDI events to the 
audio engine; for example, if no device is chosen or the sample rate is wrong. You can 
click the warning icon to open the Device Setup dialog, where you can fix the problem in 
most cases.

RELATED LINKS
Rhythmic grid on page 217
MIDI recording on page 264
Playing back music on page 540
Enabling/Disabling MIDI input devices on page 270
Switching to galley/page view on page 50
Making layouts transposed/concert pitch on page 178
Changing the default player order on page 125
Changing the middle C numbering convention on page 51
Playback techniques on page 787
Percussion maps on page 780
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Hiding/Showing status bar tools
You can change which tools appear in the status bar; for example, to reduce the minimum 
project window width.

PROCEDURE

● Right-click in the status bar, then choose the tool that you want to hide/show.

For example, to hide the summary of the current selection, choose Selection Summary so 
that no tick appears beside it.

RESULT
The corresponding tool is hidden/shown in the status bar in the current project and all future 
projects on your computer.

RELATED LINKS
Switching between modes on page 43

Selection tools
The status bar in Dorico Elements contains selection tools that you can use to select items and 
change the music shown within the music area.

Marquee Tool

Allows you to drag a rectangle to select multiple notes and notations.

Hand Tool

Allows you to move the view within the music area.

TIP

● You can press Alt/Opt-H  to switch between selection tools.

● To use the other tool briefly without selecting it, Shift -drag with the mouse.

● You can change the default selection tool for all future projects on the Note Input and 
Editing page in Preferences.

RELATED LINKS
Selecting notes/items on page 421
Selecting multiple items using marquee selections on page 424
Moving the view in the music area on page 442
Preferences dialog on page 58

View types
In Dorico Elements there are different ways to view your layouts.

The following view types are available:

Galley View
Lays out all the staves in the current layout and flow on a single continuous system.

This view type is most useful during the process of inputting the music as it allows 
you to focus on the musical content of your project. Because it shows all staves, galley 
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view is particularly useful when inputting notes for single players holding multiple 
instruments.

By default, bar numbers are shown every bar above every staff. Staff labels are also 
shown above every staff, and follow the view as you scroll so they are always visible.

NOTE

Note spacing is unjustified in galley view and there is no automatic vertical collision 
avoidance, so notes and items might overlap. You can change the default gaps 
between staves in galley view for each layout independently.

Page View
Displays your layout paginated exactly as it appears when you print or export it.

This view type is useful for determining appropriate page turns, for example.

NOTE

● The view type is reset to your default setting when you switch layouts.

● You can change the default view type used for all future projects in Preferences > General > 
View.

RELATED LINKS
Preferences dialog on page 58
Switching to galley/page view on page 50
Changing the staff spacing in galley view on page 623
Page formatting on page 598
Players on page 123
Instruments on page 130

Page arrangements for page view
Page arrangement options in the status bar allow you to change the way pages are arranged in 
the music area, for layouts shown in page view.

Spreads Horizontally

Displays pages in pairs as two-page spreads, with each pair laid out from left to right in 
a row.

Spreads Vertically

Displays pages in pairs as two-page spreads, with each pair laid out from top to bottom 
in a column.

Single Pages Horizontally

Displays individual pages laid out from left to right.

Single Pages Vertically

Displays individual pages laid out from top to bottom.
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Zoom options
Zoom options in the status bar allow you to change the displayed size of pages in the music area.

Custom Zoom

Opens a dialog that allows you to set a custom zoom percentage.

Set Zoom

Allows you to select one of the preset zoom scaling factors.

Zoom Out

Decreases the size of notes and notations in the music area.

Zoom In

Increases the size of notes and notations in the music area.

TIP

You can change the default zoom level that is used when opening layouts in all future projects in 
Preferences > General > View.

RELATED LINKS
Status bar on page 38
Preferences dialog on page 58
Zooming in/out of the music area on page 443

Disclosure arrows
Disclosure arrows indicate that objects, areas, and menus can be expanded/collapsed, either 
vertically or horizontally.

In Dorico Elements, disclosure arrows are commonly used to expand/collapse sections in panels 
and cards, such as player cards in the Players panel in Setup mode.

Disclosure arrow for a player card
Disclosure arrows for sections in the Tempo panel

RELATED LINKS
Players panel on page 110
Instruments on page 130
Options dialogs in Dorico Elements on page 27
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Workspace setup
Dorico Elements enables you to set up your workspace according to your working style. For 
example, you can open multiple tabs to display multiple layouts in the same window. You can 
also open the same project in multiple project windows.

RELATED LINKS
Navigation on page 439
Hiding/Showing zones on page 44
Starting new projects on page 71

Switching between modes
You can switch between modes at any time and in different ways. For example, if you want to add 
more players to your project in Setup mode after starting to input music in Write mode.

PROCEDURE

● Switch between modes in any of the following ways:

● Press Ctrl/Cmd  plus one of the numbers 1  to 5  ( Ctrl/Cmd-1  for Setup, Ctrl/Cmd-2 
for Write, Ctrl/Cmd-3  for Engrave, Ctrl/Cmd-4  for Play, Ctrl/Cmd-5  for Print).

● Click the corresponding button in the toolbar.

● Choose Window > [mode].

● To switch to Write mode, double-click in the music area in Setup mode or Engrave mode.

TIP

You can disable this option in Preferences > Note Input and Editing > Editing.

RELATED LINKS
Modes in Dorico on page 19
Project window on page 29
Toolbar on page 30
Preferences dialog on page 58
Opening multiple project windows on page 49

Switching between layouts
You can change which layout is displayed in the current tab in the music area in Setup, Write, 
and Engrave modes, or in the track overview in Play mode. For example, if you want to check 
individual part layouts.

NOTE

You can only switch between layouts to which players are assigned.

PROCEDURE

● Switch to another layout in any of the following ways:

● To switch to the next layout, press Shift-Alt/Opt-]  or choose Window > Next Layout.

● To switch to the previous layout, press Shift-Alt/Opt-[  or choose Window > Previous 
Layout.
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● Select an item on a staff or in the piano roll of the player whose layout you want to open, 
then press W  or choose Window > Counterpart Layout.

● In the toolbar, click the layout selector and select a layout from the menu.

RESULT
The selected layout is opened in the music area. It replaces the layout previously open in the tab.

TIP

You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.

RELATED LINKS
Layouts on page 174
Assigning players to layouts on page 176
Navigation on page 439
Switching to galley/page view on page 50
Switching between flows in the track overview on page 521

Hiding/Showing zones
You can hide/show individual zones or all zones simultaneously; for example, to increase the 
space available for displaying music in the music area, or to access options in a specific panel.

NOTE

In some modes, not all methods are available.

PROCEDURE

1. Hide/Show the left zone in any of the following ways:

● Press Ctrl/Cmd-7 .

● In the toolbox on the left, click Show Left Zone .

● Click the disclosure arrow on the left edge of the main window.

● Choose Window > Show Left Zone.

2. Hide/Show the right zone in any of the following ways:

● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● In the Notations toolbox, click the button for any panel you want to show, or the active 
button for the panel you want to hide.
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● Choose Window > Show Right Zone.

3. Hide/Show the lower zone in any of the following ways:

● Press Ctrl/Cmd-8 .

● Click the disclosure arrow at the bottom of the main window.

● Choose Window > Show Lower Zone.

4. Hide/Show all zones in any of the following ways:

● Press Ctrl/Cmd-0 .

● In the toolbar, click Hide/Restore Zones .

● Choose Window > Hide/Restore Zones.

RESULT
The corresponding zones are hidden/shown.

If you hide all active zones, the Hide/Restore Zones button in the toolbar indicates which zones 
were previously active but are now hidden.

TIP

● You can assign key commands for showing specific panels in the lower zone on the Key 
Commands page in Preferences.

● You can choose to hide the right/left zones when the lower zone is shown, and vice versa, 
automatically in all future projects in Preferences > General > Window.

EXAMPLE

Hide/Restore Zones button when zones are shown Hide/Restore Zones button when all zones were 
previously shown but are now all hidden

RELATED LINKS
Zones and panels on page 37
Toolbar on page 30
Disclosure arrows on page 42
Properties panel on page 663
Preferences dialog on page 58

Opening new tabs
You can open multiple tabs in the same project window, which you can use to display multiple 
layouts or different views of the same layout. For example, you can show your full score layout in 
page view in one tab and in galley view in another tab.

Each tab can contain a separate layout or a different view of a layout already open in another tab 
or window. Whenever you open a new tab, you are prompted to select a layout that you want to 
display in the tab.

You can find tabs in the tab bar, located at the top of the music area, below the toolbar. If no tabs 
are shown, click Show Tabs  in the toolbar.
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PROCEDURE

1. Open a new tab in any of the following ways:

● Press Ctrl/Cmd-T .

● At the right end of the tab bar, click New Tab .

● Choose Window > New Tab.

A new tab opens that shows recent layouts at the top and a list of other layouts in the project 
at the bottom. If the tab bar was hidden, it is now shown.

2. Select a layout to open in the new tab in any of the following ways:

● Click one of the icons.

● In the list at the bottom, select a layout.

● In the toolbar, click the layout selector and select a layout.

RESULT
The layout that you choose opens in the active tab.

TIP

You can also switch between different layouts within the same tab.

RELATED LINKS
Tab bar on page 33
Toolbar on page 30
Switching between layouts on page 43
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Closing tabs
You can close individual tabs of layouts that you no longer need, and you can close multiple tabs 
at the same time.

PROCEDURE

● Close tabs in any of the following ways:

● Select the tab you want to close and press Ctrl/Cmd-W .

● Hover over the tab you want to close and click x.

● Right-click the single tab you want to close and choose Close Tab from the context 
menu.

● Right-click the tab you do not want to close and choose Close Other Tabs from the 
context menu.

NOTE

You cannot close the last tab in a window. If only one tab is open and you no longer want to 
see the tabs, deactivate Show Tabs in the main toolbar. The tab is no longer displayed, but 
the corresponding layout is still shown.

RESULT
If you selected a single tab and closed it, the selected tab and its corresponding layout are 
closed.

If you selected a single tab and closed other tabs, all open tabs except for the selected tab are 
closed.

Switching between tabs
You can switch between different open tabs to show different layouts in the music area.

PROCEDURE

● Switch tabs in any of the following ways:

● To cycle forwards through all open tabs, press Ctrl-Tab .

● To cycle backwards through all open tabs, press Ctrl-Shift-Tab .

● Click the tab to which you want to switch.

TIP

● You can choose to keep selected items in view automatically when switching between 
tabs and windows on the General page in Preferences.

● You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.

RELATED LINKS
Preferences dialog on page 58
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Changing the order of tabs
You can move tabs to a different position on the tab bar.

PROCEDURE

● Click and drag a tab to the new position.

The other tabs move to show where the dragged tab will be positioned.

Showing multiple tabs in the same project window
You can split your project window to display two tabs at the same time. The split can be either 
vertical or horizontal, allowing you to display different layouts either side by side or above one 
another.

PROCEDURE

1. Select the tab of the layout that you want to move to a new tab group.

2. Split the view in one of the following ways:

● To show layouts side by side, choose Window > Vertical Split.

● To show layouts above one another, choose Window > Horizontal Split.

RESULT
The project window is split to display two tabs at the same time. The selected tab is moved to the 
new tab group.

Moving tabs to another tab group
You can move tabs to other tab groups. For example, if you want to compare different layouts or 
two views of the same layout.

PREREQUISITE
You have opened at least two tabs, and they are both shown in the same project window.

PROCEDURE

● Click and drag the tab into the target tab group.

Moving tabs to other windows
You can move tabs to another open window of the same project to show the corresponding 
layouts in a new window. For example, if you want to compare two layouts on two displays.

NOTE

● The layouts must belong to the same project. If you attempt to move a tab to a window of a 
different project, a new window is created for the project to which the layout belongs.

● You can only move tabs to other windows if you have opened at least two tabs.

PROCEDURE

● Do one of the following:
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● To create a new project window with the tab inserted, either click and drag the tab away 
from the tab bar and release it, or choose Window > Move Tab To New Window. You 
can also right-click tabs and choose this option from the context menu.

● To move the tab to an existing project window, click and drag the tab onto the tab bar in 
the corresponding project window.

Opening multiple project windows
You can open multiple project windows for the same project; for example, if you want to work 
on multiple layouts at the same time. You can also show a different mode of the same project in 
each window, such as having one window show Write mode and another show Play mode.

By default, all windows that belong to the same project show the playhead and move the view to 
follow the music during playback.

PROCEDURE

● Open a new project window in any of the following ways:

● Press Ctrl/Cmd-Shift-T .

● Choose Window > New Window.

RESULT
A duplicate of the window opens. It contains the same tabs and the same view options as the 
original window.

TIP

You can choose to keep selected items in view automatically when switching between tabs and 
windows on the General page in Preferences.

RELATED LINKS
Switching between modes on page 43
Switching between tabs on page 47
Playhead on page 538
Hiding/Showing the playhead on page 539
Enabling/Disabling playhead following on page 539

Switching to full screen view
You can maximize the amount of screen space available for your music by making any project 
window cover the whole screen.

You can also hide the desktop elements provided by your operating system; for example, the 
task bar in Windows or the system menu bar and Dock in macOS.

Within Dorico Elements, you can also hide/show the zones on the edges of the window.

PROCEDURE

● Choose View > Full Screen.

AFTER COMPLETING THIS TASK
To return to the default view, choose View > Full Screen again.
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RELATED LINKS
Hiding/Showing zones on page 44
Zooming in/out of the music area on page 443
Moving the view in the music area on page 442
Hiding/Showing status bar tools on page 40

Switching to galley/page view
You can switch between different view types in the music area in Setup mode and Write mode. 
For example, if a flute player in your project is doubling piccolo, you can switch to galley view to 
see the piccolo staff in addition to the flute staff.

NOTE

In Engrave mode, layouts always appear in page view.

PROCEDURE

1. Switch to galley or page view in any of the following ways:

● To switch to galley view, press Ctrl/Cmd-Alt/Opt-2  or choose Galley View in the status 
bar.

● To switch to page view, press Ctrl/Cmd-Alt/Opt-1  or choose Page View in the status 
bar.

2. Optional: If you selected Page View, choose one of the available page arrangements in the 
status bar.

● To show display pages in pairs as two-page spreads, with each pair laid out from left to 
right in a row, choose Spreads Horizontally .

● To display pages in pairs as two-page spreads, with each pair laid out from top to 
bottom in a column, choose Spreads Vertically .

● To display individual pages laid out from left to right, choose Single Pages Horizontally 

● To display individual pages laid out from top to bottom, choose Single Pages Vertically 
.

RESULT
The view type in the music area is changed.

● In page view, only staves containing notes or items are shown by default. For players holding 
multiple empty instruments, only the top instrument is shown in full scores.

● In galley view, all staves in the project are shown. By default, guide bar numbers are shown 
above each staff and guide instrument labels are shown above each instrument. For players 
holding multiple instruments, the player name is also shown in guide instrument labels.

NOTE

● Note spacing is unjustified in galley view and there is no automatic vertical collision 
avoidance, so notes and items might overlap. You can change the default gaps between 
staves in galley view for each layout independently.

● The view type is reset to your default setting when you switch layouts.

● You can change the default view type used for all projects in Preferences > General > View.
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● You can assign a key command for Toggle View Type on the Key Commands page in 
Preferences. This command switches between galley view and page view.

● You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.

AFTER COMPLETING THIS TASK
In galley view, you can use instrument filters to show only specific staves.

RELATED LINKS
Switching between layouts on page 43
Status bar on page 38
Changing the staff spacing in galley view on page 623
Preferences dialog on page 58
Hiding/Showing guide bar numbers on page 829
Renaming players on page 182
Instrument filters on page 445

Changing your preferred unit of measurement
You can change your default preferred unit of measurement to be used throughout Dorico 
Elements for options that use absolute measurements, such as the size of page margins in 
Layout Options. It does not affect options that are relative to the size of staves, such as options 
in Notation Options.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the General section, select one of the following options from the Preferred unit of 
measurement menu:

● Points (pt)

● Millimeters (mm)

● Inches (in)

● Centimeters (cm)

4. Click Apply, then Close.

Changing the middle C numbering convention
You can change the numbering convention used for middle C (MIDI note 60) throughout Dorico 
Elements, including in the piano roll editor, Keyboard panel, and status bar display. By default, 
MIDI note 60 is numbered as C4 in Dorico Elements.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the General section, choose one of the following options for Middle C (note 60):

● C3

● C4
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● C5

4. Click Apply, then Close.

RELATED LINKS
Status bar on page 38
Piano roll editor on page 678
Keyboard panel on page 206

Color setup
Dorico Elements allows you to change the colors used in different contexts, including for project 
windows and pages in each type of layout.

RELATED LINKS
Annotations on page 597
View options for notes and rests on page 1064
Hiding/Showing voice colors on page 1439
Hiding/Showing colors for notes out of range on page 1064

Changing the window color theme
You can change the color theme used throughout Dorico Elements; for example, you might 
switch to the light theme if you prefer to read dark text on a light background. By default, Dorico 
Elements uses the dark theme, which shows light text on a dark background.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Window section, select one of the following options from the Theme menu:

● Dark

● Light

4. Click Apply, then Close.

RESULT
The color theme used in Dorico Elements is changed. This affects the current project immediately 
and all future projects you open, until you next change your setting.
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EXAMPLE

Dark theme Light theme

Changing the page color
You can change the color of pages in each of the different layout types; for example, to help you 
identify whether you are in a part layout or full score layout, or to make reading the music easier 
or more comfortable.

By default, full score and custom score layouts have white pages, while part layouts have cream 
pages.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Colors.

3. In the Page Colors section, change the page color for Full score layouts, Part layouts, 
and/or Custom score layouts in any of the following ways:

● Click the corresponding color preview and select a color in the dialog that opens.

● Enter a color code into the corresponding value field.

4. Click Apply, then Close.

RESULT
The page color in layouts of the corresponding type is changed in the current project and 
all future projects you open. This does not affect the resulting page color when exporting or 
printing layouts.

TIP

You can reset page colors back to the default factory settings by clicking Reset  for each layout 
type.

RELATED LINKS
Layouts on page 174
Printing layouts on page 581
Exporting layouts as graphics files on page 585
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Changing the background color
You can change the background color of the music area. The background can be a gradient of up 
to four colors or a single block color. You can also change the background color for Write mode 
and Engrave mode independently of each other; for example, to help you identify which mode 
you are in.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Colors.

3. In the Background Colors section, choose one of the following options for Use for Write 
mode and/or Engrave mode:

● Gradient

● Single Color

4. Change the background color in one of the following ways:

● If you chose Gradient and want to use a preset selection of colors, select it from the 
Preset menu.

● If you chose Gradient and want to use a custom selection of colors, either click each 
color preview and select a color in the dialog that opens, or enter color codes into the 
value fields.

● If you chose Single Color, either click the Stop 1 color preview and select a color in the 
dialog that opens, or enter a color code into the value field.

RESULT
The background color is changed in the current project and all future projects you open.

TIP

● The background color set for Write mode is also used in Setup mode.

● You can reset background colors back to the default factory settings by clicking Reset .

Changing music area colors
You can change the colors used for various purposes in the music area, including the first eight 
voice colors on each staff and the color of selected items. For example, if you find specific color 
combinations easier to read than others.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Colors.

3. In the Voice Colors section, change the color for each voice in any of the following ways:

● Click the corresponding color preview and select a color in the dialog that opens.

● Enter a color code into the corresponding value field.

4. In the Other Colors section, change the color for each item in any of the following ways:

● Click the corresponding color preview and select a color in the dialog that opens.

● Enter a color code into the corresponding value field.
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5. Click Apply, then Close.

RESULT
The color of the corresponding voices and items is changed in the current project and all future 
projects you open.

TIP

You can reset colors back to the default factory settings by clicking Reset  for each voice or 
item.

RELATED LINKS
Preferences dialog on page 58
Annotations on page 597
View options for notes and rests on page 1064
Hiding/Showing colors for accidentals on page 795
Selecting notes/items on page 421
Caret on page 218
MIDI recording on page 264
Playhead on page 538
Tablature on page 1330
Linked dynamics on page 951
Linked slurs on page 1297

Inverting colors
You can invert the colors used for music and pages in Dorico Elements, which by default shows 
white music on black pages. You can then customize the inverted page color; for example, to 
show white music on a blue background.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Colors.

3. In the Page Colors section, activate Invert colors for music (white on black).

4. Change the inverted page color in any of the following ways:

● Click the corresponding color preview and select a color in the dialog that opens.

● Enter a color code into the corresponding value field.

5. Click Apply, then Close.

RESULT
The colors for music and pages are inverted in the current project and all future projects you 
open. Music always appears white, while pages use the inverted page color you set. This does 
not affect the resulting colors when exporting or printing layouts.

Deactivating Invert colors for music (white on black) returns music/page colors to their non-
inverted configuration.

TIP

You can reset the inverted page color back to the default factory setting by clicking Reset .
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Changing the color of items
You can change the color of individual notes and items; for example, to distinguish specific items 
when creating educational worksheets. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the items whose color you want to change. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Color in the Common group.

3. Click the color preview to open the Select Color (Windows)/Colors (macOS) dialog.

4. Select or create the color you want.

5. Click OK to save your changes and close the dialog.

RESULT
The color of the selected items is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

TIP

You can change the default color of many items, such as by editing the paragraph style of 
text-based notations.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Paragraph Styles dialog on page 756
Lyrics paragraph styles on page 1041
Staff label paragraph styles on page 1318

Language setup
Dorico Elements allows you to change the language used in different contexts, including for the 
application itself and for instrument names in staff labels.

RELATED LINKS
Changing the keyboard language on page 64
Instrument transpositions in staff labels on page 1314
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Changing the application language
You can change the language used for the user interface in the current project and all future 
projects you open; for example, if your operating system language is different to the language 
you want to use in Dorico Elements.

NOTE

Changing the application language does not affect the language used for instrument names or 
date and time tokens.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the General section, select the language you want to use from the Language menu.

4. Click Apply, then Close.

RESULT
The language used for the user interface in the current project and all future projects is changed. 
If your keyboard language is set to Default, the keyboard language is also changed.

RELATED LINKS
Preferences dialog on page 58
Changing the keyboard language on page 64

Changing the language for instrument names
You can change the language used for instrument names; for example, if you want to recreate a 
French score. This affects staff labels and instrument change labels.

PROCEDURE

1. Choose Library > Project Language to open the Project Language dialog.

2. Select the language you want to use from the Instrument names language menu.

3. Activate/Deactivate Reset instrument names.

4. Click OK to save your changes and close the dialog.

RESULT
The language for all instrument names and prefixes for instrument change labels is changed 
project-wide. Future instruments you add to the project use your new language setting.

● If you activated Reset instrument names, the names of existing instruments in the project 
are reset to follow your new language setting.

● If you deactivated Reset instrument names, the names of existing instruments in the 
project are not reset and continue to use their existing language.

TIP

You can change the default language used for instrument names in all future projects on the 
General page in Preferences.
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RELATED LINKS
Adding players on page 124
Adding instruments to players on page 133
Instrument changes on page 136
Staff labels on page 1309
Showing instrument/player names in staff labels on page 1313
Instrument transpositions in staff labels on page 1314
Changing the default font family on page 760

Changing the language for date and time tokens
You can change the language used for all date and time tokens project-wide; for example, if 
you want to display the date and time using a different language convention to your operating 
system.

PROCEDURE

1. Choose Library > Project Language to open the Project Language dialog.

2. Select the language you want to use from the Date and time language menu.

3. Click OK to save your changes and close the dialog.

RELATED LINKS
Tokens on page 655

Preferences dialog
The Preferences dialog allows you to change how Dorico Elements functions by default across all 
projects.

You can open Preferences in any of the following ways:

● Press Ctrl/Cmd-, .

● Choose Edit > Preferences (Windows) or Dorico > Preferences (macOS).

The Preferences dialog contains the following:
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1 Search categories field

Allows you to filter categories and section titles according to your entry.

TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list, 
and its options appear as a page in the main body of the dialog.

3 Section titles

Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the active setting is highlighted.

NOTE

The arrangement of options on the Key Commands page is significantly different to other 
pages in the Preferences dialog. This page is described separately in further detail.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match : Allows you to navigate to the previous match on the page. You can 
also navigate to the previous match by pressing Ctrl/Cmd-Shift-G .

● Next match : Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close : Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

6 Reset to Factory

Resets all the options in the dialog back to the default factory settings.

RELATED LINKS
Changing your preferred unit of measurement on page 51
Changing values in numeric value fields on page 666
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Key Commands page in the Preferences dialog
The Key Commands page in the Preferences dialog allows you to view all the functions to which 
you can assign key commands, change existing key commands, and assign new key commands 
to functions that have no key command assigned by default.

Assigning your own key commands can be helpful for items or actions that you find yourself 
performing regularly, such as setting specific rhythmic grid resolutions or exporting all layouts to 
PDF.

● You can find the Key Commands page by opening the Preferences dialog, then clicking Key 
Commands in the category list.

The Key Commands page comprises the following:

1 Search field

Allows you to search for functions to view, change, or add key commands. Because there 
are multiple levels of disclosure arrows before you reach many functions, this is often the 
quickest way to find what you are looking for.

2 Functions list

Displays the functions that can be assigned key commands. The list can be filtered using 
the Search field. Disclosure arrows beside options indicate that further options are available 
when the option is expanded.

Hovering over functions shows a tool tip, which is helpful for some functions with 
particularly long names.

3 Key Commands section

Displays any existing key commands set in the current keyboard language for the function 
selected in the list of assigned key commands, and allows you to assign new key commands.

● Keyboard language: Allows you to change the keyboard language used for key 
commands.

● Add Key Command: Adds the key command you pressed to the selected function.

NOTE

● You can assign multiple key commands to the same function.
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● If you enter a key command that is already assigned to another function, a warning 
is shown.

● Remove Key Command: Removes the selected key command from the selected 
function.

● Print Summary: Directs you to an offline page in a web browser that displays your key 
commands on an interactive keyboard.

● Reset Key Commands: Resets all of your key commands to their defaults.

4 MIDI Learn section

Allows you to assign MIDI controllers, notes, and combinations of notes to control functions.

● MIDI Learn : Prepares Dorico Elements to receive the MIDI input data that you want 
to save as a command.

● Add MIDI Command: Adds the MIDI controllers or notes you changed or pressed to the 
selected function.

● Remove MIDI Command: Removes the MIDI command from the selected function.

5 Jump Bar Alias section

Allows you to assign aliases that you can enter into the jump bar to perform the 
corresponding function.

● Alias field: Allows you to enter a jump bar alias for the selected function.

● Add Alias: Adds the characters you entered as the jump bar alias for the selected 
function.

● Remove Alias: Removes the existing jump bar alias from the selected function.

RELATED LINKS
Key commands in Dorico on page 26
Assigning key commands on page 63
Assigning MIDI commands on page 63
Assigning key commands for custom zoom levels on page 444
Jump bar on page 65

Interactive Dorico key commands map
The interactive Dorico Key Commands map shows a virtual computer keyboard, with keys that 
have been assigned key commands highlighted in different colors according to the modifier 
keys they contain. All key commands for the selected keyboard language layout are listed below, 
divided into global and mode-specific groups.

You can open the Dorico Key Commands map in any of the following ways:

● Choose Help > Key Commands.

● In the Preferences dialog, click Key Commands in the category list, then click Print 
Summary in the Key Commands section.
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The interactive key commands map as it appears when US English is selected

The Dorico Key Commands map opens in a web browser. It allows you to do any of the 
following:

● To see the available key commands, select a context. The context of a key command is the 
mode in which it can be used. Key commands that have a global context work in all modes.

● To highlight the keys that you can press in combination with modifier keys to form a key 
command, press one or more modifier keys on your computer keyboard, such as Shift  or 
Ctrl/Cmd - Alt/Opt , or click a modifier key on the virtual keyboard. The virtual computer 
keyboard highlights the pressed/clicked keys and displays the assigned functions on each 
key.

● To search for a specific key command, enter one or multiple words in the search field.

● To get an overview of all available key commands, browse the key commands that are listed 
below the virtual keyboard. The key commands are listed according to the context in which 
they can be used.

RELATED LINKS
Changing the keyboard language on page 64

Searching for the key commands of functions
You can search for key commands that are assigned to functions or menu items in Dorico 
Elements.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Enter the name of a function in the Search field.

The entries that are listed below are filtered according to the words that you enter.

4. Expand an entry and select the function for which you want to see the key command.
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For particularly long names, you can hover over them to see a tool tip.

RESULT
If the function has a key command, it is shown in the list of assigned key commands.

TIP

You can also search for functions in the interactive key commands map.

Assigning key commands
You can assign key commands to many functions; for example, for functions you use frequently 
but that do not have a key command assigned by default. You can also change existing key 
commands.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Search for the name of a function and select it.

For particularly long names, you can hover over them to see a tool tip.

4. Optional: If the function already has an assigned key command, click Remove Key 
Command in the Key Commands section.

If you assign a new key command without removing an existing one, you can use either key 
command.

5. Click the Press shortcut input field.

6. On your computer keyboard, press the key command that you want to assign.

7. Click Add Key Command.

If the key command you pressed is already used by another function, a warning is displayed.

8. Click Apply, then Close.

RESULT
The key command you pressed is added to the list of assigned key commands for the selected 
menu item or function. You can use it immediately.

RELATED LINKS
Assigning key commands for custom zoom levels on page 444

Assigning MIDI commands
You can assign specific keys or buttons on your MIDI keyboard to perform functions and access 
menu items. For example, if you want to navigate using MIDI keys during chord symbol input.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Select the menu item or function to which you want to assign MIDI commands.

For particularly long names, you can hover over them to see a tool tip.
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4. In the MIDI Learn section, click MIDI Learn .

5. Press the key or button on your MIDI keyboard that you want to assign to the selected 
parameter.

6. Click Add MIDI Command.

7. Click Apply, then Close.

Changing the keyboard language
You can change the keyboard language used for key commands in Dorico Elements; for example, 
if the application language is set to German, but you are using an English keyboard and want to 
use English key commands.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Select the keyboard language you want to use for key commands from the Keyboard 
language menu.

NOTE

Default follows the application language.

4. Click Apply, then Close.

RESULT
The keyboard language used for key commands in the current project and all future projects is 
changed.

RELATED LINKS
Changing the application language on page 57

Removing key commands
You can remove individual key commands from a function.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Search for the name of a function and select it.

4. In the Key Commands section, click Remove Key Command.

5. Click Apply, then Close.

RESULT
The key command is removed from the selected function.

RELATED LINKS
Removing jump bar aliases on page 68
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Resetting key commands
You can reset all the key commands in your project to their defaults.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. In the Key Commands section, click Reset Key Commands.

4. Click Apply, then Close.

RESULT
All custom key commands are deleted and the default key commands are reinstated.

Jump bar
The jump bar is a temporary value field that allows you to perform commands and go to 
locations in the current layout using only your computer keyboard.

● You can show the jump bar in Setup, Write, Engrave, and Play modes by pressing J .

TIP

You can assign key commands for showing the jump bar in Commands mode and Go To mode 
on the Key Commands page in Preferences.

Jump bar in Commands mode with an example entry

Commands

In Commands mode, you can use the jump bar to perform commands, such as opening the 
Layout Options dialog with the specified page already selected.

● You can switch the jump bar to Commands mode by pressing Alt-C (Windows) or 
Ctrl-1 (macOS) .

When you start entering text into the jump bar in Commands mode, a menu appears that shows 
valid commands containing the letters/words you enter.

If you show the jump bar in Commands mode after performing a command, your previous entry 
is shown with its text selected.

User interface
Jump bar 

65
Dorico Elements 5.1.30



You can press Down Arrow  to show a list of up to five commands that you perform most 
frequently.

NOTE

● You can only perform commands using the jump bar in the same contexts as you can 
perform the corresponding action. For example, you can only perform Setup mode-specific 
actions in Setup mode.

● You can assign jump bar aliases to specific commands; for example, so you can use shorter 
entries for your favorite commands.

● If commands have a corresponding key command or jump bar alias, they are shown in the 
menu of valid commands.

Go To

In Go To mode, you can use the jump bar to go to bars, rehearsal marks, pages, and flows.

● You can switch the jump bar to Go To mode by pressing Alt-G (Windows) or Ctrl-2 (macOS) .

Example move Jump bar entry

Go to bar number [n]; for example, bar 
number 32

b[n]; for example, b32 or b+32

Go to rehearsal mark [n]; for example, 
rehearsal mark K

r[n]; for example, rK or rk

Go to page number [n]; for example, page 6 p[n]; for example, p6 or p+6

Go to flow number [n]; for example, flow 3 f[n]; for example, f3 or f+3

Go to the next flow fn

Go to the previous flow fp

EXAMPLE
To go to bar 20 in flow 3, enter f3b20.

RELATED LINKS
Navigation on page 439
Key Commands page in the Preferences dialog on page 60
Properties panel on page 663
Popovers on page 22
Notations input on page 271
Options dialogs in Dorico Elements on page 27

Going to locations with the jump bar
You can use the jump bar to go to bars, rehearsal marks, pages, and flows in Setup, Write, 
Engrave, and Play modes.
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PROCEDURE

1. Press J  to show the jump bar.

2. Optional: Press Alt-G (Windows) or Ctrl-2 (macOS)  to switch to Go To mode.

3. Enter the appropriate entry for the location to which you want to go.

For example, enter f3b20 to go to bar 20 in flow 3.

4. Press Return .

Performing commands with the jump bar
You can use the jump bar to perform commands, such as opening the Layout Options dialog 
with the specified page already selected, in Setup, Write, Engrave, and Play modes.

PREREQUISITE
If you want to perform mode-specific commands, you are in the corresponding mode.

PROCEDURE

1. Press J  to show the jump bar.

2. Optional: Press Alt-C (Windows) or Ctrl-1 (macOS)  to switch to Commands mode.

3. Select the command you want to perform in any of the following ways:

● Enter relevant text into the jump bar.

When you start entering text into the jump bar in Commands mode, a menu appears 
that shows valid commands containing the letters/words you enter, which you can select 
by pressing Up Arrow / Down Arrow .

● Enter the appropriate jump bar alias into the jump bar.

● To show a list of up to five commands that you perform most frequently, press 
Down Arrow , then press Up Arrow / Down Arrow  to select a command.

4. Press Return .

Assigning jump bar aliases
You can assign jump bar aliases to specific commands; for example, so you can use shorter 
entries for your favorite commands.

PROCEDURE

1. Press J  to show the jump bar.

2. Optional: Press Alt-C (Windows) or Ctrl-1 (macOS)  to switch to Commands mode.

3. Enter the command to which you want to assign an alias into the jump bar.

TIP

To ensure the command is entered correctly, select it from the menu of valid commands by 
pressing Up Arrow / Down Arrow .

4. Immediately after the command, enter = followed by the characters you want to use as the 
jump bar alias.

For example, to assign the jump bar alias rr to the Remove Rests command, enter Remove 
Rests=rr.
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5. Do one of the following:

● To perform the command and assign the jump bar alias, press Return .

● To assign the jump bar alias only, without performing the command, press Alt/Opt-
Return .

RESULT
The characters you entered after the = are assigned as the jump bar alias for the specified 
command.

TIP

You can also assign jump bar aliases on the Key Commands page in Preferences.

RELATED LINKS
Key Commands page in the Preferences dialog on page 60

Removing jump bar aliases
You can remove jump bar aliases you have assigned to specific commands.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. Search for the name of a function and select it.

4. In the Jump Bar Alias section, click Remove Alias.

5. Click Apply, then Close.

RESULT
The jump bar alias is removed from the selected function.
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Project and file handling

In addition to opening and importing/exporting projects and other file formats, project and file 
handling also includes auto-save and project backups.

RELATED LINKS
Project Info dialog on page 75
File import and export on page 78
Auto-save on page 103
Project backups on page 105
Project templates on page 77
Project Statistics dialog on page 106

Hub
The Hub allows you to access recent projects, start new projects, and keep up-to-date with 
learning materials including tutorials, videos, and blog updates. The Hub opens automatically 
when you start Dorico Elements.

● You can also open the Hub by choosing Window > Hub.

The Hub contains the following pages:

Open Recent
Allows you quick access to the projects that you worked on last. You can scroll through 
the list to access recent projects out of view. You can navigate through recent projects 
by pressing Up Arrow / Down Arrow .

Double-clicking a recent project, or selecting it and pressing Return , opens the 
project.

You can choose one of the following view types for recent projects:
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● Grid view 

● List view 

When recent projects are shown in the grid view, you can click the menu button  for 
each project to access the following options:

● Remove from Recent Projects: Removes the project from the Recent Projects 
page.

● Open Enclosing Folder: Opens the File Explorer/macOS Finder and shows the 
folder where the project is saved.

Create New
Allows you to start new projects from project templates or choose an empty project.

The Choose a template list on the left allows you to select a project template category, 
with available project templates in the selected category listed in the middle. The 
Empty project template creates a project with no players or flows.

You can choose one of the following view types for project templates:

● Grid view 

● List view 

On the right, the Project Options section provides the following options:

● Project title: Allows you to enter the project title.

● Composer: Allows you to enter the project composer.

● Page size: Allows you to select the page size for the full score layout.

● Page orientation: Allows you to choose whether the page orientation in the full 
score layout is Portrait  or Landscape .

● Rastral size: Allows you to select the staff size for the full score layout.

● Project will use multiple flows: When activated, flow headings are shown in 
all layouts, and flow titles are shown in running headers in score layouts. When 
deactivated, flow headings are hidden in all layouts, and the project title is shown 
in running headers in score layouts.

● Music font: Allows you to select the music font used in the project.

● Text font: Allows you to select the font family used throughout the project by 
default.

● Time signature: Allows you to specify a time signature for the project. When 
deactivated, the project starts with no time signature, which is treated as open.

● Bars: Allows you to set the number of bars you want the project to contain.

● Key signature: Allows you to specify a key signature for the project. When 
deactivated, the project starts with no key signature, which is treated as atonal.

At the bottom of the Hub, Create project creates a new project using the selected 
project template and project options. You can also double-click project templates to 
start a new project.

Learn
Provides access to learning materials. Dorico Elements displays a notification when 
new materials are available.

● Hands-on tutorials: Displays available practical tutorials that introduce you to 
common operations directly in Dorico demo projects.

● Videos: Displays recent Dorico video tutorials. Double-clicking a video tutorial, or 
selecting it and clicking Watch Now, opens it in a web browser.
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You can find more tutorial videos and information about new features on the 
Dorico YouTube channel.

● Forum: Links you to the Steinberg user forum.

● Manual: Links you to the documentation.

● Dorico Blog: Displays recent entries in the Dorico blog. Clicking a blog entry opens 
it in a web browser.

At the bottom of the Hub, Open or Import File allows you to search for and open MusicXML, 
MIDI, and Dorico project files.

RELATED LINKS
Toolbar on page 30
Project templates on page 77
Project Info dialog on page 75
Staff size on page 617

Starting new projects
You can start new projects from project templates, such as for orchestra or a vocal ensemble. 
You can also start empty projects.

PROCEDURE

1. Optional: If the Hub is not open, choose Window > Hub to open the Hub.

2. In the Hub, click Create New to show the Create New page.

3. Choose one of the following project template categories:

● Band

● Chamber

● Choral

● Empty

● Jazz

● Orchestral

● Solo

4. Choose a project template.

5. In the Project Options section, add or change information and settings as required.

NOTE

The Project Options section does not affect Empty project templates.

6. Create a new project in any of the following ways:

● Click Create project.

● Double-click the project template.

RESULT
A new project is created using the selected project template.
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TIP

● You can start a new, empty project at any time by pressing Ctrl/Cmd-N  or choosing File > 
New.

● You can also start a new project from a project template by choosing File > New From 
Project Template > [Project template category] > [Project template].

AFTER COMPLETING THIS TASK
You can customize your project, such as by adding or deleting players/instruments.

RELATED LINKS
Project templates on page 77
Brackets according to ensemble type on page 866
Adding players on page 124
Deleting players on page 127
Adding titles on page 997

Opening projects/files
You can open Dorico projects at any time and in addition to other open projects; for example, if 
the project you want to open is not listed as a recent project in the list in the Hub. You can also 
open MusicXML and MIDI files.

PROCEDURE

1. Open the File Explorer/macOS Finder in any of the following ways:

● In the Hub, click Open or Import File.

● Choose File > Open.

● Choose File > Open Recent > [Project file name].

2. Locate and select the files you want to open.

3. Click Open.

4. Optional: If you opened a MIDI file, change the settings as required in the MIDI Import 
Options dialog that opens.

RESULT
The selected files are opened.

If you opened MusicXML or MIDI files, Dorico Elements creates new project files from the 
MusicXML or MIDI content, which you can save as default Dorico projects.

If MusicXML files include page size, margin, and staff size settings, Dorico Elements imports 
those values. If they are not included, Dorico Elements creates suitable settings according to the 
number of instruments in the file.

TIP

● You can also import MusicXML and MIDI files as new flows in existing projects, rather than 
opening them as separate projects.

● You can hide/show complete paths for recent files in the menu in Preferences > General > 
Files.
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RELATED LINKS
Hub on page 69
Preferences dialog on page 58
Importing MusicXML files on page 82
Importing MIDI on page 85
MIDI Import Options dialog on page 85

Opening recent projects from the Hub
You can open projects you have recently worked on from the Hub.

PROCEDURE

1. Optional: If the Hub is not open, choose Window > Hub to open the Hub.

2. In the Hub, click Open Recent to show the Open Recent page.

3. Double-click the recent project you want to open.

RESULT
The selected Dorico project is opened.

Projects from different versions of Dorico
You can open projects that were last saved in other versions of Dorico than the one you have. In 
such cases, Dorico Elements shows a warning message to make you aware of any implications.

The contents of the warning message vary according to the version of Dorico in which the project 
was last saved:

● When opening a project last saved in an older version, it shows the version number the 
project was last saved in and informs you that the project will be updated to your current 
version.

● When opening a project last saved in a newer version, it shows only that the project is from 
a newer version. It also informs you that items and notations from that version might not 
appear and will be deleted if you save the project in your current version.

In both cases, opening the project is non-destructive. This means that its contents and 
formatting are unaffected if you do not save it.

You can prevent Dorico Elements from showing you warnings about projects from different 
versions in Preferences > General > Files. In the same section, you can also tell Dorico Elements 
to prompt you to choose a new location for projects from different versions when you save them. 
This reduces the risk of you overwriting them by mistake.

RELATED LINKS
Preferences dialog on page 58

Missing Fonts dialog
The Missing Fonts dialog appears when you open a project that contains a font that you do not 
have installed on your computer. It allows you to select replacement fonts that are installed on 
your computer as substitutes.

The Missing Fonts dialog displays a table with multiple columns that identify the specific font 
families and styles that are missing for font, character, and paragraph styles and text items. 
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Every place in the project where a font is missing has its own row. For example, if the bold style 
of a font family is used in three different paragraph styles, three rows are shown in the dialog, 
one for each paragraph style.

The Missing Fonts dialog comprises the following:

1 Missing Family

Contains a list of font families included in the project but missing on your computer.

2 Missing Style

Contains a list of the specific styles within the corresponding font families that are included 
in the project but missing on your computer.

3 Used By

Contains a list of the places in the project where the corresponding font is used.

4 Replacement Family

Allows you to select replacement font families. You can select replacement font families by 
double-clicking entries, then either entering the font family you want or clicking the arrow 
and selecting a font family from the menu. Once selected, their names are displayed in the 
corresponding entry.

5 Replacement Style

Allows you to select any of the available styles within the corresponding replacement font 
families. You can select replacement font styles by double-clicking entries, then either 
entering the font style you want or clicking the arrow  and selecting a font style from 
the menu. Once selected, the styles are displayed in the corresponding entry.

6 Fonts

Contains a list of all the available fonts installed on your computer. You can access the menu 
in the Replacement Family and Replacement Style columns by double-clicking any entry.

TIP

● You can choose whether or not the Missing Fonts dialog appears when you open a project 
containing fonts not installed on your computer on the General page in Preferences.

● You can change the width of columns in the Missing Fonts dialog by dragging between 
column headings. Their widths are remembered in future projects.

RELATED LINKS
Preferences dialog on page 58
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Edit Font Styles dialog on page 754
Character Styles dialog on page 759
Paragraph Styles dialog on page 756
Text editor options in Write mode on page 389

Project Info dialog
The Project Info dialog allows you to specify information about the whole project and each 
flow within it separately, such as the title, composer, and lyricist, as these might be different for 
different flows. You can then refer to these entries using tokens in text frames.

You can open the Project Info dialog in any mode in any of the following ways:

● Press Ctrl/Cmd-I .

● Choose File > Project Info.

The Project Info dialog comprises the following:

1 Flows list

Contains all the flows in the project, with a separate entry for the project as a whole at the 
top. You can select individual or multiple flows in the flows list.

NOTE

The flows list uses the names of flows as shown in the Flows panel in Setup mode, which can 
be different to their entry in the Title field if you have changed their flow title.

Project and file handling
Project Info dialog 

75
Dorico Elements 5.1.30



The action bar at the bottom of the list contains the following options:

● New Flow : Creates a new flow with no information. Its default name is New Flow.

● Duplicate Flow : Creates a new flow with all the information of the selected flow. Its 
default name is Copy of [selected flow].

● Rename Flow : Opens the Rename Flow dialog, which allows you to change the name 
of the flow.

NOTE

If you have already manually changed the flow title, changing the name of the flow does 
not automatically change the flow title.

● Move Down : Moves the selected flows down the flows list, which changes their order 
in the project.

● Move Up : Moves the selected flows up the flows list, which changes their order in the 
project.

● Delete Flow : Deletes the selected flows.

2 Information fields

Allow you to enter information about the currently selected flows or the whole project in the 
corresponding field, such as Composer and Lyricist.

If you have selected multiple flows with different entries in the same fields, such as flows 
with different composers, those fields display Mixed.

You can change the font style of specific characters within information fields using the 
following Markdown formatting:

● To make characters appear in italics, enclose them inside single asterisks, such as 
*Allegro*.

● To make characters appear bold, enclose them inside double asterisks, such as 
**Chaminade**.

● To make characters appear bold and italic, enclose them inside triple asterisks, such as 
***28***.

TIP

If you want entire information fields to appear with the same formatting, such as all in italics, 
we recommend that you edit the corresponding paragraph styles.

3 Generate preview thumbnails when saving

When activated, Dorico Elements generates the following preview images of the layout open 
in the music area when you save the project:

● PNG file of the first page. This is displayed on the Open Recent page in the Hub.

● PDF file of the whole layout.

When deactivated, Dorico Elements does not generate preview images. This reduces the file 
size and can make saving large projects quicker.

4 Resolve Markdown formatting for text tokens

Allows you to enable/disable the resolution of Markdown formatting in information fields.

5 Copy info from menu

Allows you to select another flow or the whole project whose information you want to copy; 
for example, for a project containing multiple flows that all have the same composer and 
lyricist.
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6 Copy

Copies all the information from the specified flow/project to the selected flows/project.

NOTE

● The information you add in Project Info only appears on pages where the corresponding 
tokens exist. For example, if you want to display a dedication above the project title, you 
must add the dedication token to the First page template.

● You cannot specify line breaks in single-line fields. However, you can enter line breaks in 
larger fields, namely Copyright and Other information, which you can then copy into 
single-line fields.

● By default, First page templates have tokens that refer to project information. If you only 
enter information for individual flows in the Project Info dialog, that information does not 
automatically appear on pages that use the First page template.

Similarly, if you started a new project from the Hub and deactivated Project will use 
multiple flows, running headers in score layouts display the project title instead of the flow 
title.

RELATED LINKS
Tokens on page 655
Types of page templates on page 648
Flow names and flow titles on page 187
Hiding/Showing flow headings on page 611
Front matter on page 997
Reordering flows on page 173
Paragraph Styles dialog on page 756
Hub on page 69

Project templates
Project templates allow you to start new projects that already contain a particular set of players 
and project library settings. For example, full score layouts in orchestral project templates have 
larger page sizes than in chamber ensemble project templates.

Dorico Elements provides the following project template categories:

Band
Ensembles containing mostly woodwind and brass instruments, such as brass band or 
pit band.

Chamber
Typically small ensembles containing only a few players, such as string quartet.

Choral
Ensembles containing voices, including popular choir arrangements, such as SATB 
unaccompanied.

Empty
An empty project template.

Jazz
Popular ensembles commonly used to perform jazz, such as big band or jazz trio.
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Orchestral
Large ensembles containing most Western instruments, including strings, woodwinds, 
brass, and percussion.

Solo
Ensembles containing only a single player/instrument, such as a solo organ, guitar with 
tablature, or lead sheet.

RELATED LINKS
Brackets according to ensemble type on page 866
Starting new projects on page 71
Page formatting on page 598
Page templates on page 647

File import and export
External files are files in different formats than Dorico projects, such as MIDI, MusicXML, or 
tempo tracks. It is possible in Dorico Elements both to import and export different types of files.

This can be useful if, for example, you want to share your project with others who use a different 
notation software, or to convert the notes, audio, or time signatures and tempo information in 
your project into other formats.

RELATED LINKS
Exporting lyrics on page 1034
Exporting comments on page 500
Exporting layouts as graphics files on page 585
Printing layouts on page 581
Exporting project statistics on page 107

Importing flows
You can import individual flows into existing projects; for example, if you want to bring together 
multiple existing pieces into one project for publishing, or if you have an empty project file with 
your preferred settings saved and want to reuse those settings.

PROCEDURE

1. Choose File > Import > Flows to open the File Explorer/macOS Finder.

2. Locate and select the project files of the flows you want to import.

3. Click Open to open the Flow Import Options dialog for the first selected project.

4. In the Flow Import Options dialog, choose one of the following options for Player 
handling:

● Create All New Players

● Merge with Existing Players Where Possible

5. In the Import flows list, activate the checkbox for each flow you want to import.

You can also click Select All or Select None at the bottom of the list.

6. Click OK to import the selected flows and close the dialog.

7. Optional: If you selected multiple projects from which to import flows, repeat steps 4 to 6 for 
each project. The Flow Import Options dialog reopens automatically for each project.
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RESULT
The selected flows are imported into the project.

● If you chose Create All New Players, new players are added as required for each flow.

● If you chose Merge with Existing Players Where Possible, any players that the imported 
flows and existing project have in common are merged; for example, if you imported a flow 
containing one piano into a project containing a piano and viola, the imported flow is added 
to the existing piano player.

NOTE

● Players are not automatically added to flows that you imported into the project.

● You can also open flows directly if you want them to be separate projects, rather than new 
flows in existing projects.

RELATED LINKS
Opening projects/files on page 72
Flows on page 171
Adding players on page 124
Assigning players to flows on page 172

Flow Import Options dialog
The Flow Import Options dialog allows you to determine whether players in imported flows are 
merged with existing players in the project and which flows from within other projects you want 
to import.

● You can open the Flow Import Options dialog by choosing File > Import > Flows and 
opening a Dorico project from the File Explorer/macOS Finder.

The Flow Import Options dialog comprises the following:

1 Player handling

Allows you to determine how imported flows are assigned to players.

● Create All New Players adds separate players for each imported flow.

● Merge with Existing Players Where Possible merges players from imported flows with 
any existing compatible players in the project.

2 Import flows
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Contains a list of all the flows in the selected project. Flows are included in the import when 
their checkbox is activated.

3 Selection options

Allow you to select/deselect all the flows in the project. For example, you can deselect all 
flows and then activate the checkbox of a single flow you want to import.

Exporting flows
You can export individual flows from projects; for example, to save small excerpts of large 
projects separately.

NOTE

These steps export flows as separate Dorico projects. If you want to export flows as other file 
formats, such as MusicXML or MP3, there are different methods.

PREREQUISITE
If you want the exported flows to include all players and layouts in the project, including players 
with no music, you have deactivated Omit excluded players and layouts when exporting flows 
in Preferences > General > Files.

PROCEDURE

1. Choose File > Export > Flows to open the Export Flows dialog.

2. Activate/Deactivate Export each selected flow as a separate file.

3. In the Select flows to export list, activate the checkbox for each flow you want to export.

You can also click Select All or Select None at the bottom of the list.

4. Activate/Deactivate Export layouts as separate files.

5. Optional: If you activated Export layouts as separate files, activate the checkbox for each 
layout you want to export in the Select layouts to export list.

You can also click Select All or Select None at the bottom of the list.

6. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

7. Locate and select the destination folder you want.

8. Click Choose to insert the new path in the Export to field.

9. Activate/Deactivate Create folder for exported files.

10. Click OK to export the selected flows and layouts and close the dialog.

RELATED LINKS
Flows on page 171
Exporting MusicXML files on page 83
Exporting MIDI on page 95
Exporting tempo tracks on page 98
Exporting audio on page 100

Export Flows dialog
The Export Flows dialog allows you to save individual flows and layouts as separate Dorico files.

● You can open the Export Flows dialog by choosing File > Export > Flows.
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The Export Flows dialog contains the following options and lists:

1 Export each selected flow as a separate file

Allows you to export each flow as a separate file instead of all the selected flows as a single 
file.

2 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

3 Export layouts as separate files

Allows you to export each layout in the project as a separate file instead of as a single file.

4 Select layouts to export

Contains a list of all the layouts in the project. Layouts are included in the export when their 
checkbox is activated. Only available if you have activated Export layouts as separate files.

5 Selection options

Allow you to select/deselect all the flows/layouts in the corresponding list. For example, you 
can deselect all flows and then activate the checkbox of a single flow you want to export.

6 Create folder for exported files

Controls whether or not Dorico Elements generates a new folder for the selected flows 
within the selected export path. The automatic folder name is “Flows from” followed by the 
project file name; for example, “Flows from Smyth - String Quintet”.

7 Export to field

Displays the export path where exported flows will be saved.

8 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.
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Importing MusicXML files
You can import MusicXML files into existing Dorico Elements projects as separate flows; for 
example, to continue work on a piece started in a different notation software.

PREREQUISITE
You have set your preferences for importing MusicXML files as appropriate for the file on the 
MusicXML Import page in Preferences.

PROCEDURE

1. Choose File > Import > MusicXML to open the File Explorer/macOS Finder.

2. Locate and select the MusicXML files you want to import.

3. Click Open to open the Flow Import Options dialog for the first selected MusicXML file.

4. In the Flow Import Options dialog, choose one of the following options for Player 
handling:

● Create All New Players

● Merge with Existing Players Where Possible

5. Click OK to import the selected flows and close the dialog.

6. Optional: If you selected multiple MusicXML files, repeat steps 4 and 5 for each file. The Flow 
Import Options dialog reopens automatically for each file.

RESULT
The selected MusicXML files are imported into the project as new flows.

● If MusicXML files include page size, margin, and staff size settings, Dorico Elements imports 
those values. If they are not included, Dorico Elements creates suitable settings according to 
the number of instruments in the file.

● If you chose Create All New Players, new players are added as required for each MusicXML 
file.

● If you chose Merge with Existing Players Where Possible, any players that the imported 
MusicXML files and existing project have in common are merged; for example, if you 
imported a MusicXML file containing one piano into a project containing a piano and viola, 
the imported MusicXML file is added to the existing piano player.

TIP

You can also open MusicXML files directly if you want them to be separate projects, rather than 
new flows in existing projects.

RELATED LINKS
Flow Import Options dialog on page 79
Opening projects/files on page 72
Preferences dialog on page 58
Assigning players to flows on page 172
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Unpitched percussion imported from MusicXML files
Unpitched percussion music can be expressed in a number of ways in MusicXML. Scoring 
applications take different approaches to what data is exported and how it is encoded. Therefore, 
the results of importing MusicXML into Dorico Elements vary considerably.

Dorico Elements identifies each instrument in kits explicitly and then combines them dynamically 
onto five-line staves. Other scoring applications and MusicXML have a different approach to how 
unpitched percussion music is represented. For example, a drum set may be effectively notated 
as pitched notes on a five-line staff and annotated with additional information to help identify 
which instrument corresponds to each staff position.

Because of these different approaches, mapping information between the MusicXML 
representation and the Dorico Elements representation can be challenging, so Dorico Elements 
employs heuristics to improve the quality of results.

Typically, drum set instruments in MusicXML files exported from both Sibelius and Finale are 
imported quite cleanly into Dorico Elements.

Results are particularly good, and more likely to be imported correctly, if the voicing of the drum 
set is consistent, such as consistently notating the snare drum in a down-stem voice. If the 
voicing changes from bar to bar, it is possible that some notes are either identified incorrectly or 
not imported at all.

Other kinds of percussion that are notated on five-line staves produce more variable results. In 
most cases, Finale includes information about which percussion instrument maps onto each staff 
position, but Sibelius does not. As a result, you might find that Dorico Elements chooses different 
instruments than you expected, but you can change instruments using the Edit Percussion Kit 
dialog.

RELATED LINKS
Edit Percussion Kit dialog on page 143
Changing instruments in percussion kits on page 148
Adding instruments to percussion kits on page 146
Percussion editor on page 679
Importing MIDI on page 85

Exporting MusicXML files
You can export flows and layouts as separate MusicXML files; for example, if you want to export 
just the soloist’s layout containing the first flow.

PROCEDURE

1. Choose File > Export > MusicXML to open the Export MusicXML dialog.

2. Choose one of the following file format options:

● Export compressed XML (.mxl)

● Export uncompressed XML (.xml)

3. In the Select flows to export list, activate the checkbox for each flow you want to export.

You can also click Select All or Select None at the bottom of the list.

4. Activate/Deactivate Export layouts as separate files.

5. Optional: If you activated Export layouts as separate files, activate the checkbox for each 
layout you want to export in the Select layouts to export list.

You can also click Select All or Select None at the bottom of the list.
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6. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

7. Locate and select the destination folder you want.

8. Click Choose to insert the new path in the Export to field.

9. Activate/Deactivate Create folder for exported files.

10. Click OK to export the selected flows/layouts as MusicXML files and close the dialog.

Export MusicXML dialog
The Export MusicXML dialog allows you to save individual flows and layouts as separate 
MusicXML files.

● You can open the Export MusicXML dialog by choosing File > Export > MusicXML.

The Export MusicXML dialog contains the following options and lists:

1 File format options

Allows you to choose the MusicXML file format you want to export. Compressed MusicXML 
files contain the same information as uncompressed MusicXML files but have a smaller file 
size.

2 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

3 Export layouts as separate files

Allows you to export each layout in the project as a separate file instead of as a single file.

4 Select layouts to export

Contains a list of all the layouts in the project. Layouts are included in the export when their 
checkbox is activated. Only available if you have activated Export layouts as separate files.

5 Selection options

Allow you to select/deselect all the flows/layouts in the corresponding list. For example, you 
can deselect all flows and then activate the checkbox of a single flow you want to export.
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6 Create folder for exported files

Controls whether or not Dorico Elements generates a new folder for the selected flows 
within the selected export path. The automatic folder name is “Flows from” followed by the 
project file name; for example, “Flows from Smyth - String Quintet”.

7 Export to field

Displays the export path where exported files will be saved.

8 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

Importing MIDI
You can import MIDI files into existing Dorico Elements projects, as either separate flows or into 
existing flows; for example, to work on a different version of a section of a piece.

PROCEDURE

1. Choose File > Import > MIDI to open the File Explorer/macOS Finder.

2. Locate and select the MIDI files you want to import.

3. Click Open to open the MIDI Import Options dialog for the first selected MIDI file.

4. Change the settings as required.

For example, you can change the playing techniques of tracks, assign tracks to specific 
players, and customize quantization options.

5. Click OK to close the MIDI Import Options dialog and import the first selected MIDI file.

6. Optional: If you selected multiple MIDI files, repeat steps 4 to 5 for each file. The MIDI 
Import Options dialog reopens automatically for each file.

RESULT
The selected MIDI files are imported into the project according to your settings. Dorico Elements 
uses an algorithm on imported MIDI notes to produce the correct enharmonic spelling.

If the MIDI files contained markers, they are also imported. If they have SMPTE offset values 
defined, Dorico Elements uses them to set the timecode position for the start of the flow.

TIP

You can also open MIDI files directly if you want them to be separate projects, rather than new 
flows in existing projects.

RELATED LINKS
Opening projects/files on page 72
Requantizing notes on page 266
Changing the sustain pedal controller settings for MIDI recording/import on page 270
Assigning players to flows on page 172

MIDI Import Options dialog
The MIDI Import Options dialog allows you to customize the settings Dorico Elements uses to 
translate MIDI data into a Dorico project when importing and opening MIDI files.

Your MIDI import settings are stored to the track memory, allowing you to reuse settings 
automatically the next time you open or import MIDI files with similar tracks.
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You can open the MIDI Import Options dialog in any of the following ways:

● Choose File > Import > MIDI and import a MIDI file from the File Explorer/macOS Finder.

● Choose File > Open and open a MIDI file from the File Explorer/macOS Finder.

At the top of the MIDI Import Options dialog, there are the following options:

Importing MIDI File
Displays the file name of the MIDI file you are importing or opening.

Use track memory
Allows you both to apply settings from the track memory to the current MIDI file, and 
to save the settings for the current MIDI file to the track memory for reuse in future 
when importing or opening MIDI files with identical track names.

Interpret as General MIDI
Allows Dorico Elements to use MIDI program changes at the start of tracks 
to determine instrument types, including identifying tracks using channel 10 as 
containing unpitched percussion using the General MIDI drum set.

We recommend deactivating this option for MIDI files that do not conform to General 
MIDI conventions.
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Destination
Allows you to select the flow into which you want to import the MIDI file. You can 
import MIDI as a new flow or into an existing flow in the project; for example, if you 
want to overwrite specific tracks in an existing flow. Only available when importing 
MIDI files.

Re-use existing players
Allows you to determine the players to which tracks in the MIDI file are assigned. Only 
available when importing MIDI files.

● When activated, tracks from the imported MIDI file are either merged with existing 
players in the project or overwrite them, depending on your setting for Overwrite 
all track contents when importing into existing flow/player in the Import 
Options section.

● When deactivated, tracks are imported as new players.

Tracks from the MIDI file

Displays all the tracks from the imported or opened MIDI file in a table. Allows you to enable/
disable tracks for import and change their player type, instrument, and playing techniques.

At the top of the table, there are the following filter controls:

● Filter field: Allows you to filter tracks by name, instrument, or family.

● Track visibility: Allows you to show either all tracks or only tracks enabled for import.

The table contains the following columns:

● #: Displays the number of the track.

● Enable: Allows you to enable/disable the track for import.

● MIDI track name: Displays the name of the track in the MIDI file.
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● Player type: Displays the player type for the track. You can change the player type by 
double-clicking the icon. Icons show the current player type from the following options:

● Single player 

● Section player 

● Instrument(s) in track: Displays the instruments identified for the track. You can change 
the instrument by double-clicking the field and selecting an instrument in the instrument 
picker that opens. If a single track requires multiple instruments, you must use the advanced 
editor options.

● Technique(s): Displays the playing techniques identified for the track. You can change the 
playing technique by double-clicking the field and selecting a playing technique from the 
menu. If a single track requires multiple playing techniques, you must use the advanced 
editor options.

TIP

● It is not necessary to specify natural or legato playing techniques, as Dorico Elements 
automatically creates slurs if Detect slurs is activated in the Import Options section.

● Dorico Elements inputs the corresponding playing techniques at the required positions 
in the music if Create playing techniques is activated in the Import Options section.

● Family: Displays the instrument family of the track. For tracks with multiple instruments, the 
family of the first instrument is displayed.

● Destination Instrument: Displays the instrument in the project to which the track will 
be assigned. You can change the destination instrument by double-clicking the field and 
selecting an instrument from the menu. For example, if you want to assign multiple tracks to 
the same destination instrument.

● Max. sim. notes: Displays the number of notes played simultaneously in the track. This can 
help you identify whether tracks represent single, multiple, or grand staff instruments.

● Total no. of notes: Displays the total number of notes in the track. Tracks containing no 
notes might be unnecessary to import.

TIP

You can click each column’s header to change its sort order.

The action bar at the bottom of the table contains the following options:

● Enable Selected: Enables the selected tracks for import.

● Disable Selected: Disables the selected tracks for import.

● Invert Selection: Switches your selection to include all tracks not previously selected.

● Select All: Selects all tracks.

Advanced editor options

Contains advanced options that allow you to control how the selected track is mapped to players 
in the project.
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The Advanced editor options are divided into the following sections:

Track settings
Contains a list of instruments in the track selected in the Tracks from the MIDI file 
table and allows you to view and change details of how Dorico Elements will interpret 
the track.

● Instruments in track list: Contains all the instruments in the selected track and 
allows you to change them. For example, you might add enough horn instruments 
to match the Max. sim. notes in a horn ensemble track, and therefore ensure each 
instrument only plays a single note at a time.

Chords are split between instruments in tracks in pitch order; for example, piccolos 
receive higher notes than flutes.

The action bar at the bottom of the list contains the following options:

● Add Instrument : Opens the instrument picker and allows you to add a new 
instrument to the track.

● Duplicate Instrument : Duplicates the selected instrument.

● Change Instrument : Opens the instrument picker and allows you to 
change the selected instrument.

● Delete Instrument : Deletes the selected instrument.

● Player type: Allows you to choose the player type for the track.

● Transpose: Allows you to transpose the track by the specified number of half-steps 
(semitones).

● Playing tech.: Allows you to select the playing techniques for the track; 
for example, when assigning multiple tracks that represent different playing 
techniques to the same player.
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● Start: The playing technique used at the start of the track.

● End: The playing technique used at the end of the track.

For example, for a violin part that switches between pizzicato and arco, using two 
tracks in the MIDI file, selecting Pizzicato/Arco instructs Dorico Elements to input 
pizz. and arco playing techniques at the appropriate positions.

● Percussion map: Allows you to select a percussion map for the track. Only 
available for percussion kits.

● Articulations: Allows you to select articulations you want to input on all notes in 
the track.

● Voice separation mode: Allows you to select a voice approach for chords. Only 
available when mapping a track to a single instrument. When mapping one 
track to multiple instruments or multiple tracks to one player, Dorico Elements 
automatically distributes notes to voices.

● 1 voice: All music in the track is assigned to the same voice.

● 2 voice (auto): Music in the track is assigned to two voices on the same staff.

● 2 voice (fixed split point): Music in the track is assigned to two voices, each 
on its own staff, using the split point set in the Import Options section.

● 2 voice (explode): Music in the track is assigned to two voices, each on its own 
staff. This option can be useful for fretted instruments.

● 4 voice keyboard (auto): Music in the track is assigned to four voices, 
spread across two staves. We recommend using this option for grand staff 
instruments, as it can automatically detect common keyboard textures, such 
as bass and melody with inner chords.

Players in Dorico project
Contains a list of the players in the project to which tracks will be assigned, including 
existing players in the project and any new players required by the imported MIDI file. 
Icons for each player indicate if it is new and its type from the following options:

● Single player 

● Section player 

When you select an instrument in the Instruments in track list in the Track settings 
section, its current assigned player appears highlighted in the Players in Dorico 
project list.

You can assign instruments to other players by clicking an available player in the 
list. Only players of the same type and with the same instrument are available. 
For example, if multiple tracks represent different techniques played by the same 
instrument, you can assign them all to the same player.

If no instruments are assigned to a new player, it is automatically deleted.

● Use MIDI track names allows you to use MIDI track names for player names.

● Add new player for track  allows you to assign the selected instrument to a new 
player. Only available when you have assigned more than one instrument to the 
same player.

Project and file handling
File import and export 

90
Dorico Elements 5.1.30



Import Options

The Import Options section contains the following subsections:

Instruments
Contains options that determine how Dorico Elements identifies and handles 
instruments from the imported MIDI file.

● Use GM program changes to identify instruments: Allows you to set whether 
Dorico Elements uses MIDI program changes or track names to identify 
instruments.

● Interpret channel 10 as General MIDI percussion: Allows you to set whether 
Dorico Elements interprets tracks using channel 10 as conforming to the General 
MIDI drum set standard.

● Overwrite all track contents when importing into existing flow/player: When 
activated, imported tracks overwrite all existing music belonging to destination 
players. When deactivated, imported tracks merge with existing music belonging 
to destination players. Only applies when importing MIDI into an existing flow.

Interpretation
Contains options that determine how Dorico Elements interprets key switches and 
keyboard music from the imported MIDI file.

● Split point for grand staff instruments: Allows you to change how notes are 
assigned to each staff for grand staff instruments.

● Auto: Dorico Elements automatically determines split points according to the 
musical context.

● Fixed: Dorico Elements uses the set split point.

● Split at MIDI note number: Allows you set a MIDI note number at which notes are 
split between staves. Only available when Fixed is chosen for Split point for grand 
staff instruments.

● Filter out key switches outside range: Allows you to set the range of pitches 
used for notes in the MIDI file. Notes higher/lower than the set range are omitted.

● Quantize Options: Opens the MIDI Quantize Options dialog, which allows you to 
customize the quantization options.
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NOTE

Quantization options are linked between Preferences > Play > Quantization and the 
MIDI Import Options dialog.

Notations
Contains options that determine the handling and detection of notations from the 
imported MIDI file, such as pedal lines and slurs.

NOTE

● Notation settings are linked between Preferences > Play > Recording and the 
MIDI Import Options dialog.

● When Detect key signature if missing is activated, Dorico Elements creates a 
single key signature at the start of the flow. This option works best for music with a 
strong tonal center that does not modulate.

Performance
Contains options that determine how much of the original performance in the MIDI file 
is preserved for playback purposes. They do not affect how the imported MIDI notes 
are notated, as this is controlled by quantization options.

NOTE

Performance settings are linked between Preferences > Play > Recording and the 
MIDI Import Options dialog.

Players
Contains options that determine the handling of players and layouts.

For example, if you are importing a MIDI file into an existing project in order to 
orchestrate, you might want to import players into their own player group without 
creating any extra part layouts for them.

RELATED LINKS
Changing the sustain pedal controller settings for MIDI recording/import on page 270
Unpitched percussion imported from MusicXML files on page 83
Types of actions on page 775
Preferences dialog on page 58
Player groups on page 167
Players on page 123
Instruments on page 130
Layouts on page 174
Instrument picker on page 112
Playing techniques on page 1180
Pedal lines on page 1161
Key signatures on page 1019
Slurs on page 1283
Tremolos on page 1399
Trills on page 1094
Tuplets on page 1408
Grace notes on page 1002
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Quantization options
Quantization options allow you to customize the quantization you want to apply to notes when 
importing MIDI files, inputting notes using MIDI recording, or requantizing notes.

You can access the available quantization options in any of the following ways:

● In Preferences > Play > Quantization.

● In the MIDI Import Options dialog, click Quantize Options in the Import Options section.

● When at least one note is selected in the music area, choose Edit > Requantize.

NOTE

Quantization options are linked between Preferences > Play > Quantization and the MIDI 
Import Options dialog.

The following quantization options are available:

Quantization unit
Allows you to set the smallest beat unit to which you want notes to be quantized. For 
example, if the smallest intentional note duration in your imported file is an eighth 
note, set Quantization unit to eighth notes.

Detect tuplets
Allows you to control whether off-beat notes can be considered tuplets. If you know 
there are no intentional tuplets in your imported MIDI file, deactivating Detect tuplets 
ensures no notes are imported as tuplets.

Quantization unit for tuplets
Allows you to set the smallest beat unit to which you want tuplet notes to be quantized. 
For example, if the smallest intentional tuplet note duration in your imported file is a 
quarter note, set Quantization unit for tuplets to quarter notes.

Fill gaps
Allows you to determine whether Dorico Elements fills in gaps between short notes. 
If you are importing already precisely quantized music, we recommend that you 
deactivate Fill gaps to ensure that note and rest durations are notated exactly as 
quantized.
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Detect grace notes
Allows you to determine whether Dorico Elements interprets grace notes. When 
deactivated, Dorico Elements turns grace notes into normal notes.

RELATED LINKS
MIDI recording on page 264
Requantizing notes on page 266
Tuplets on page 1408
Grace notes on page 1002

Importing drum set patterns from Groove Agent SE
You can import Groove Agent SE patterns into drum set tracks and show them as notes; for 
example, if you want to include patterns in notated part layouts.

PREREQUISITE

● You have added a drum set to your project.

● The drum set is assigned to a Groove Agent SE endpoint.

You can apply playback templates that load Groove Agent SE for drum sets automatically, or 
load Groove Agent SE manually and assign the drum set to the required endpoint.

PROCEDURE

1. In Play mode, select the drum set track in the track overview.

2. In the Track Inspector, in the Routing section, click Edit Instrument  to open the Groove 
Agent SE window.

3. At the top of the pad section, choose Pattern to show pattern pads.

4. Click and drag the pattern you want to use into one of the following places:

● Track overview in Play mode

● Percussion editor in the Key Editor

TIP

You can click and hold pattern pads to preview them.

An insertion line indicates where the pattern will begin.

RESULT
Notes in the selected pattern are imported into the corresponding drum set. They appear in the 
track overview, percussion editor, and notation staves in the same ways as normal notes.
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TIP

For more information about Groove Agent SE, see the Groove Agent SE user manual.

RELATED LINKS
Percussion kits and drum sets on page 142
Project window in Play mode on page 519
Percussion editor on page 679
Playback templates on page 558
Loading VST/MIDI instruments manually on page 528
MIDI trigger regions on page 574
Changing the middle C numbering convention on page 51

Exporting MIDI
You can export flows as separate MIDI files; for example, if you want to edit the audio in further 
detail in a DAW. MIDI files exported from Dorico Elements contain any markers in the project by 
default.

PREREQUISITE

● You have opened a layout in the music area that contains the players whose MIDI you want 
to export.

● Playback is activated in the current project.

PROCEDURE

1. Choose File > Export > MIDI to open the Export MIDI dialog.

2. In the Select flows to export list, activate the checkbox for each flow you want to export.

You can also click Select All or Select None at the bottom of the list.

3. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

4. Locate and select the destination folder you want.

5. Click Choose to insert the new path in the Export to field.

6. Activate/Deactivate Create folder for exported files.

7. Click OK to export the selected flows as MIDI files and close the dialog.

RESULT
The selected flows are exported as MIDI files. They contain the MIDI of all the players assigned to 
the layout open in the music area.

RELATED LINKS
Activating/Deactivating playback on page 542
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Switching between layouts on page 43
Opening new tabs on page 45
Assigning players to layouts on page 176

Export MIDI dialog
The Export MIDI dialog allows you to save individual flows as separate MIDI files.

● You can open the Export MIDI dialog by choosing File > Export > MIDI.

The Export MIDI dialog comprises the following:

1 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

2 Selection options

Allow you to select/deselect all the flows in the project. For example, you can deselect all 
flows and then activate the checkbox of a single flow you want to export.

3 Create folder for exported files

Controls whether or not Dorico Elements generates a new folder for the selected flows 
within the selected export path. The automatic folder name is “Flows from” followed by the 
project file name; for example, “Flows from Smyth - String Quintet”.

4 Export to field

Displays the export path where exported files will be saved.

5 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.
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Importing tempo tracks
You can import tempo tracks into individual flows and new flows in existing projects; for 
example, if you are writing music for a film and changes to the footage require tempo and 
time signature changes. This does not overwrite the notes and notations in the flow.

PROCEDURE

1. Choose File > Import > Tempo Track to open the File Explorer/macOS Finder.

2. Locate and select the MIDI file whose tempo track you want to import.

3. Click Open to open the Import Tempo Track dialog.

4. In the Import into flow list, select the flow into which you want to import the tempo track.

5. In the Import and replace section, activate the checkbox for each tempo track aspect you 
want to include.

6. Optional: If you activated the checkbox for Markers as, choose one of the following options:

● Markers

● System-attached Text

7. Optional: If you chose System Text for Markers as, activate/deactivate Show border 
around system-attached text markers.

8. Click OK to import the tempo track and close the dialog.

RESULT
The tempo track is imported into the selected flow. If you selected New Flow in the Import into 
flow list, a new flow is added to the project. All selected aspects are applied to the existing music 
or the new flow, and notes and tempo marks are adjusted as required.

RELATED LINKS
Flows on page 171

Import Tempo Track dialog
The Import Tempo Track dialog allows you to import tempo tracks to individual flows within 
projects and to control which aspects of the tempo track you want to apply to the flow.

● You can open the Import Tempo Track dialog by choosing File > Import > Tempo Track 
and opening a MIDI file from the File Explorer/macOS Finder.
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The Import Tempo Track dialog comprises the following:

1 Import into flow

Contains a list of all the flows in the project. The currently selected flow is highlighted.

NOTE

You can only import tempo tracks into a single flow at a time.

2 Import and replace

Allows you to control which tempo track aspects you want to include in your import and 
apply to the selected flow.

● Timecode display offset sets the initial timecode position at the start of the flow.

● Tempo changes replaces all immediate and gradual tempo changes in the flow with the 
tempo changes from the MIDI file.

● Time signatures replaces all time signatures in the flow with time signatures from the 
MIDI file.

● Markers as adds any markers from the MIDI file to the flow as either Markers or 
System-attached Text.

Importing markers as Markers replaces any existing markers in the flow with markers 
from the MIDI file, while importing markers as System-attached Text does not replace 
any existing markers or system-attached text items.

● Show border around system-attached text markers adds borders to markers 
imported as system-attached text items when activated. Only available if you have 
chosen System-attached Text for Markers as.

Exporting tempo tracks
You can export flows as separate tempo tracks; for example, if you want to apply the tempo 
marks and time signatures of one flow to a different flow, which can be in the same project.

PROCEDURE

1. Choose File > Export > Tempo Track to open the Export Tempo Track dialog.

2. Activate the checkbox for each flow you want to export as a tempo track.

You can also click Select All or Select None at the bottom of the list.
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3. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

4. Locate and select the destination folder you want.

5. Click Choose to insert the new path in the Export to field.

6. Activate/Deactivate Create folder for exported files.

7. Click OK to export the selected flows as tempo tracks and close the dialog.

RELATED LINKS
Importing tempo tracks on page 97

Export Tempo Track dialog
The Export Tempo Track dialog allows you to save individual flows as separate tempo tracks in 
the format of MIDI files.

● You can open the Export Tempo Track dialog by choosing File > Export > Tempo Track.

The Export Tempo Track dialog comprises the following:

1 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

2 Selection options

Allow you to select/deselect all the flows in the project. For example, you can deselect all 
flows and then activate the checkbox of a single flow you want to export.

3 Create folder for exported files

Controls whether or not Dorico Elements generates a new folder for the selected flows 
within the selected export path. The automatic folder name is “Flows from” followed by the 
project file name; for example, “Flows from Smyth - String Quintet”.

4 Export to field

Displays the export path where exported files will be saved.

5 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.
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Exporting audio
You can export projects as audio files in MP3, FLAC, or WAV formats, including exporting flows 
and players as separate files. For example, if you want to share an audio mock-up of only the 
soloist’s part in the second flow.

PREREQUISITE

● You have opened a layout in the music area that contains the players whose audio you want 
to export.

● Playback is activated in the current project.

PROCEDURE

1. Choose File > Export > Audio to open the Export Audio dialog.

2. Activate/Deactivate Export each selected flow as a separate file.

3. In the Select flows to export list, activate the checkbox for each flow you want to export as 
audio.

You can also click Select All or Select None at the bottom of the list.

4. Activate/Deactivate Export players as separate files.

5. Optional: If you activated Export players as separate files, activate the checkbox for each 
player you want to export in the Select players to export list.

You can also click Select All or Select None at the bottom of the list.

6. Click Choose Folder  beside the Export to field to open the File Explorer/macOS Finder.

7. Locate and select the destination folder you want.

8. Click Choose to insert the new path in the Export to field.

9. In the Audio Export Options section, choose one of the following audio file formats:

● MP3 (.mp3)

● FLAC (.flac)

● WAV (.wav)

10. Optional: If you chose FLAC (.flac) or WAV (.wav), choose one of the following bit depths:

● 16-bit

● 24-bit

● 32-bit (WAV files only)

11. Optional: If you chose WAV (.wav), activate/deactivate Broadcast WAVE.

12. Change the reverb tail duration by changing the value in the Reverb tail (s) value field.

13. Click OK to export the selected flows/players with the set audio export options and close the 
dialog.

RELATED LINKS
Activating/Deactivating playback on page 542
Switching between layouts on page 43
Opening new tabs on page 45
Assigning players to layouts on page 176
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Export Audio dialog
The Export Audio dialog allows you to export projects as audio files in MP3, FLAC, or WAV 
formats, including exporting flows and players as separate files.

● You can open the Export Audio dialog by choosing File > Export > Audio.

The Export Audio dialog contains the following options and lists:

1 Export each selected flow as a separate file

Allows you to export each flow in the project as a separate audio file instead of as a single 
audio file.

2 Select flows to export

Contains a list of all the flows in the project. Flows are included in the export when their 
checkbox is activated.

3 Export players as separate files

Allows you to export each player in the project as a separate audio file instead of all players 
in a single audio file.

4 Select players to export

Contains a list of all the players in the project. Players are included in the export when their 
checkbox is activated. Only available if you have activated Export players as separate files.

5 Selection options

Allow you to select/deselect all the flows/players in the corresponding list. For example, you 
can deselect all flows and then activate the checkbox of a single flow you want to export.
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6 Export to field

Displays the export path where exported audio files will be saved.

7 Choose Folder

Opens the File Explorer/macOS Finder and allows you to change the export path.

8 Audio Export Options

Contains the following options that allow you to control the audio file format and export:

● File format: Allows you to export audio as an MP3 (.mp3), FLAC (.flac) or WAV (.wav) 
file.

● Bit depth: Allows you to export FLAC files as 16-bit or 24-bit, and WAV files as 16-bit, 
24-bit, or 32-bit.

● Broadcast WAVE: Allows you to export audio in Broadcast WAVE format, which includes 
start timecodes and markers.

● Reverb tail (s): Allows you to change the duration of time added to the end of the 
exported audio to accommodate reverb effects.

Exporting text
You can export all visible text in the project to a CSV file; for example, to populate catalog 
databases, or to proof-read text across the project.

Text exports include all fields in the Project Info dialog, text in text frames, text items, lyrics, 
tempo marks, dynamics, and so on.

PREREQUISITE
You have opened a layout in the music area that contains the visible text that you want to export.

PROCEDURE

1. Choose File > Export > Text to open the File Explorer/macOS Finder.

2. Specify a name and location for the CSV file.

3. Click Save.

RESULT
All visible text in the layout currently open in the music area is exported and saved in the selected 
location as a CSV file. By default, the CSV file opens automatically in your default application for 
CSV files.

TIP

You can change whether exported text CSV files open automatically in Preferences > General > 
Files.

RELATED LINKS
Switching between layouts on page 43
Preferences dialog on page 58
Project Info dialog on page 75
Types of page templates on page 648
Text items on page 1351
Lyrics on page 1029
Exporting lyrics on page 1034
Playing techniques on page 1180
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Dynamics on page 921
Tempo marks on page 1335
Rehearsal marks on page 1216
Markers on page 1221
Comments on page 494
Exporting comments on page 500

Auto-save
The auto-save function stores a version of the currently active project at regular intervals, 
including new projects you have not explicitly saved yet. This reduces the chances of losing 
significant amounts of work if you accidentally close a project without saving or in the unlikely 
event that Dorico Elements or your computer crashes.

Dorico Elements saves auto-saved projects in an AutoSave folder inside the application data 
folder for your user account. You cannot change this location.

NOTE

● Dorico Elements might become less responsive briefly in order to perform auto-saves, 
particularly for larger projects.

● Dorico Elements does not generate preview images when auto-saving.

Auto-save with multiple projects open

Only the currently activated project is auto-saved at each auto-save interval if you have multiple 
projects open. This is because only a single project at a time can be activated for playback. If 
you are switching between multiple projects frequently, we recommend that you set a smaller 
auto-save interval.

Removal of auto-save files

All files in the AutoSave folder are automatically deleted when you close their corresponding 
projects and also when you quit Dorico Elements. You can find deleted auto-saved projects in the 
bin on your computer. Dorico Elements automatically adds “[AutoSave]” to the end of auto-saved 
project file names so you can identify them.

IMPORTANT

When Dorico Elements deletes files from the AutoSave folder, this includes any files in the folder, 
not just auto-saved Dorico projects. Therefore, it is important that you do not manually save 
anything in the AutoSave folder.

TIP

If you want to access earlier versions of projects, you can use project backups.

RELATED LINKS
Project backups on page 105
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Recover Auto-saved Projects dialog
The Recover Auto-saved Projects dialog allows you to recover individual auto-saved projects; 
for example, if you accidentally closed a project without saving, or if Dorico Elements or your 
computer crashed.

The Recover Auto-saved Projects dialog contains the following:

Auto-saved projects list
Contains all the auto-saved projects that are available for recovery. Displays the file 
name of each project and the date and time of the auto-save.

You can activate the checkbox for each project you want to recover.

Discard All
Deletes all auto-saved projects in the list and moves them to the bin on your computer.

Recover Selected Projects
Recovers the selected auto-saved projects and opens them in separate project 
windows.

Recovering auto-saved projects
If Dorico Elements crashes, you can recover the most recent auto-saved version of each project 
that was open.

PROCEDURE

1. Reopen Dorico Elements.

2. In the Recover Auto-saved Projects dialog that opens after the Dorico Elements splash 
screen, activate the checkbox for each auto-saved project you want to recover.

NOTE

Any auto-saved projects you do not recover are permanently deleted once you close the 
dialog.

3. Click Recover Selected Projects to recover the selected auto-saved projects and close the 
dialog.

RESULT
The selected auto-saved projects are recovered and opened in separate project windows.
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AFTER COMPLETING THIS TASK
You can save auto-saved projects permanently in any folder location and with new file names if 
required.

Changing the auto-save frequency
You can change how frequently Dorico Elements auto-saves projects. By default, the auto-save 
interval is five minutes for the currently active project.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Files section, change the value for Auto-save every [n] minutes.

4. Click Apply, then Close.

Disabling auto-save
You can disable auto-save completely; for example, if it is significantly affecting the performance 
of a large project.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Files section, deactivate Auto-save every [n] minutes.

4. Click Apply, then Close.

Project backups
Dorico Elements stores backup versions of your projects each time you save them explicitly. By 
default, the previous five saves are stored as backups.

Their default location is in a folder named after the corresponding project file name in 
the Backup Projects folder in the Dorico Projects folder, whose default location is in the 
Documents folder for your user account.

You can find deleted project backups in the bin on your computer.

Changing the number of backups per project
You can change the number of backups that Dorico Elements stores for each project; for 
example, if you want to store a greater range of changes.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Files section, change the value for Number of backups per project.

4. Click Apply, then Close.
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Changing the backup location
You can change the folder that Dorico Elements uses to store project backups. By default, Dorico 
Elements uses the Backup Projects folder inside your Dorico Projects folder, whose default 
location is in the Documents folder for your user account.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Files section, click Choose beside the Project backup folder field to open the File 
Explorer/macOS Finder.

4. Locate and select the folder where you want to save project backups.

5. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Project backup 
folder field.

6. Click Apply, then Close.

RESULT
The default folder for project backups is changed. If the folder specified does not exist, Dorico 
Elements creates it.

Project Statistics dialog
The Project Statistics dialog displays and allows you to export statistics for either the whole 
project or only an individual flow, including the number of staves, notes, filled bars, and empty 
bars.

By default, Dorico Elements calculates statistics using the full score layout. For projects that 
contain either no or multiple full score layouts, Dorico Elements calculates statistics using the 
layout currently open in the music area.

● You can open the Project Statistics dialog in any mode by choosing File > Project Statistics.
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In the Project section, you can use the Show statistics for menu to show statistics only for the 
selected flow.

Further sections contain various statistics for notes and notations, grouped according to their 
function. You can hide/show each section by clicking the corresponding section header.

At the bottom of the dialog, Export allows you to export project/flow statistics to a plain text file.

NOTE

In the context of project/flow statistics, a “frame” is a bar on a single staff. For example, a 24-bar 
flow with two staves contains 48 frames.

Exporting project statistics
You can export statistics for the whole project or only an individual flow; for example, to calculate 
engraving fees.

By default, Dorico Elements calculates statistics using the full score layout.

PREREQUISITE
If the project contains either no or multiple full score layouts, you have opened the layout that 
you want to use for generating and exporting statistics in the music area.

PROCEDURE

1. Choose File > Project Statistics to open the Project Statistics dialog.
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2. Optional: To export statistics from an individual flow only, select the flow from the Show 
statistics for menu in the Project section.

3. At the bottom of the dialog, click Export to open the File Explorer/macOS Finder.

4. Specify a name and location for the statistics file.

5. Click Save.

RESULT
Statistics for either the whole project or only the selected flow are exported to a plain text file, 
which opens automatically in your default text editor.

TIP

You can also open project statistics files in spreadsheet applications.

RELATED LINKS
File import and export on page 78
Switching between layouts on page 43
Creating layouts on page 176
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Setup mode

Setup mode allows you to set up the fundamental elements of the project: instruments and the 
players that hold them, flows, layouts, and videos. You can also determine how they interact with 
each other; for example, by changing the players assigned to layouts.

You can view music in the music area and switch between viewing other tabs and layouts, but 
you cannot select or interact with anything in the music area in Setup mode.

Project window in Setup mode
The project window in Setup mode contains panels with all the tools and functions that allow you 
to add players and instruments as well as to create layouts and flows for your project.

You can switch to Setup mode in any of the following ways:

● Press Ctrl/Cmd-1 .

● In the toolbar, click Setup.

● Choose Window > Setup.

The following panels are available in Setup mode:

1 Players

Lists the players, instruments, and groups in your project. By default, players are assigned to 
all flows, all full score layouts, and their own part layout.

2 Layouts

Lists the layouts in your project. A single full score layout and a part layout for each player 
are created automatically, but you can create and delete layouts as required. By default, 
layouts contain all flows and full score layouts contain all players.

3 Flows
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Shows the flows in your project, ordered left to right. By default, flows contain all players and 
are assigned to all layouts.

The three panels work together to allow you to control how and where the players, layouts, and 
flows in your project are used. When you select an item in one of the panels, that panel and the 
selected item are highlighted in a different color and checkboxes appear in cards in the other 
panels. You can activate/deactivate these checkboxes independently to change how material is 
distributed across players, layouts, and flows.

RELATED LINKS
Toolbar on page 30
Players, layouts, and flows on page 121
Starting new projects on page 71

Players panel
The Players panel contains all the players and player groups in the project, shown in a list. It is 
located on the left of the window in Setup mode.

You can hide/show the Players panel in Setup mode in any of the following ways:

● Press Ctrl/Cmd-7 .

● Click the disclosure arrow on the left edge of the main window.

● Choose Window > Show Left Zone.

The order in which players are listed in the Players panel sets the default player order used in all 
layouts. You can also set a custom player order in each layout independently.
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In the Players panel, each player is shown as a card that contains the instruments held by that 
player. Each player card shows the following:

1 Disclosure arrow

Expands/Collapses the player card.

2 Player type

Shows the type of player from the following options:

● Single player 

● Section player 

3 Player name

Shows the name of the player. By default, player names contain the names of all instruments 
held by the player. You can also rename players manually.

4 Add instruments icon

Opens the instrument picker, from which you can select an instrument for the player.

5 Instrument labels

Each instrument assigned to a player has its own instrument label. The instrument menu 
in each instrument label opens a menu with further options that allow you to, for example, 
change the instrument names or move the instrument to another player.

Instrument labels appear blue. Kit instrument labels appear green.

The action bar at the bottom of the panel contains the following options:

Add Single Player

Adds a single player to your project. Dorico Elements also automatically adds a part 
layout for the player in the Layouts panel.

Add Section Player

Adds a section player to your project. Dorico Elements also automatically adds a part 
layout for the player in the Layouts panel.

Add Ensemble

Adds multiple players to your project. Dorico Elements also automatically adds part 
layouts for each player in the Layouts panel.

Add Group

Adds a player group to your project. If no players were selected, an empty player group 
is added. If existing players were selected, they are grouped together.
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Sort Players

Sorts all players in the Players panel according to the first instrument they hold and 
the current instrument score order.

You can click and hold or right-click Sort Players to change the setting to one of the 
following options:

● None: New players are added at the bottom of the players list, regardless of their 
instrument.

● Band: Players are sorted according to the accepted wind/concert band convention; 
for example, strings positioned between brass and percussion.

● Jazz: Players are sorted according to the accepted jazz convention; for example, 
trumpets positioned above horns, and pitched percussion above guitars.

● Orchestral: Players are sorted according to the accepted orchestral order 
convention ;for example, woodwinds positioned above brass and strings.

Player Settings

Allows you to access settings and controls for the selected player; for example, to 
rename them or show chord symbols above their staves.

You can also access player settings by right-clicking players.

Delete Player

Deletes selected players and player groups from the project. A warning message 
appears with further options, including allowing you to cancel.

RELATED LINKS
Players on page 123
Player groups on page 167
Ensembles on page 128

Instrument picker
The instrument picker allows you to find and add instruments to your project. It contains 
multiple versions of some instruments that have specific formatting and tuning requirements, 
such as French Horn, which has a version whose transposed pitch layouts are always in treble 
clef.

The instrument picker uses the application language.

You can open the instrument picker in Setup mode in any of the following ways:

● Add a new player.

● In the Players panel, click Add Instrument to Player  in player cards.

● In the Players panel, select a player and press Shift-I .

● In the Players panel, select a player, then click Player Settings  in the action bar and 
choose Add Instrument to Player. You can also right-click players and choose this option 
from the context menu.
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The instrument picker contains the following sections and options:

1 Search field

Allows you to enter the instrument you are searching for directly. You can enter only part of 
the instrument name, such as cello for Violoncello.

2 Instrument family column

Contains instrument families to help you focus your search.

3 Instrument column

Contains the instruments available in the selected instrument family.

4 Variants column

Contains variants of the selected instrument, such as alternative transpositions, tunings, key 
signature options, or different behavior in concert/transposed pitch layouts. This column is 
not populated for instruments without variants.

5 Create Empty Kit

Adds an empty percussion kit to the player.

6 Import Kit

Imports an existing percussion kit previously exported as a library file.

7 Add

Adds the selected instrument to the project.

In addition to entering the instrument you want directly into the Search field, you can click 
options in the instrument picker to select them, and you can also select other items in the same 
column by pressing Up Arrow / Down Arrow .

You can cycle forwards through the instrument picker by pressing Tab , which navigates in the 
following order: Search field, Instrument, Variants, Instrument family. You can also cycle 
backwards by pressing Shift-Tab , which navigates in the opposite direction.

An enclosure line shows which instrument family or instrument is selected when using the 
keyboard to navigate.
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RELATED LINKS
Players on page 123
Instruments on page 130
Transposing instruments on page 132
Fretted instrument tuning on page 153
Percussion kits and drum sets on page 142
Capos on page 157
Adding players on page 124
Adding instruments to players on page 133
Changing instruments on page 134
Changing the application language on page 57

Ensemble picker
The ensemble picker allows you to find and add ensembles containing multiple players to your 
project. You can select existing ensembles and build new ones.

The ensemble picker uses the application language.

You can open the ensemble picker in Setup mode in any of the following ways:

● Press Shift-E .

● In the Players panel, click Add Ensemble .

● In empty projects, click Add Ensemble  in the project start area.

The ensemble picker contains Build and Choose tabs. You can switch between them using the 
options in the top left of the ensemble picker.

Build tab

The Build tab contains the following:

1 Search field

Allows you to specify the instruments you want to include in the ensemble in the following 
ways:

● Enter the name of an existing ensemble, such as String Section.
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● Enter the names or abbreviations of instruments, with each name/abbreviation 
separated by a comma. You can prefix instruments with a number followed by a space. 
For example, enter 2 vln, 3 cl,bsn,tuba,marim to build an ensemble containing two 
violins, three clarinets, a bassoon, a tuba, and a marimba.

● Enter the corresponding orchestral shorthand, with or without separators. For example, 
enter 2picc.2.2.2 / 4.3.3.1 to add two flutes, one piccolo, two oboes, two clarinets, and 
two bassoons followed by four horns, three trumpets, three trombones, and one tuba.

To specify only brass instruments, prefix orchestral shorthand entries with br, such as 
br4331.

NOTE

You can only use single digit numbers for each instrument type.

2 Player list

Contains the instruments currently in the ensemble based on your entries in the Search 
field.

By default, instruments are held by single players. You can change the player type by double-
clicking players in the list. Icons show the current player type from the following options:

● Single player 

● Section player 

3 Save

Opens the Save Custom Ensemble dialog, which allows you to name and save your 
ensemble for reuse in future projects.

4 Add

Adds the players in the custom ensemble to the project.
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Choose tab

The Choose tab contains the following:

1 Search field

Allows you to enter the ensemble you are searching for directly.

2 Ensemble category column

Contains ensemble categories to help you focus your ensemble search.

3 Ensemble column

Contains the ensembles available in the selected category.

4 Ensemble contents column

Displays the instruments included in the selected ensemble.

5 Add

Adds the players in the selected ensemble to the project.

RELATED LINKS
Ensembles on page 128
Players on page 123
Project templates on page 77
Changing the application language on page 57

Save Custom Ensemble dialog

The Save Custom Ensemble dialog allows you to name and save custom ensembles for reuse in 
future projects.

● You can open the Save Custom Ensemble dialog in Setup mode from inside the ensemble 
picker by building a custom ensemble, then clicking Save.
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The Save Custom Ensemble dialog contains the following options:

Category
Allows you to select an ensemble category for the custom ensemble.

Name
Allows you to enter a name for the custom ensemble.

RELATED LINKS
Building and saving custom ensembles on page 129

Layouts panel (Setup mode)
The Layouts panel contains all the layouts in the project, shown in a list. In Setup mode, it is 
located on the right of the window.

You can hide/show the Layouts panel in Setup mode in any of the following ways:

● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● Choose Window > Show Right Zone.
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In the Layouts panel, each layout is shown as a card. Each layout card shows the following:

1 Disclosure arrow

Expands/Collapses the layout card.

2 Layout type

Shows the type of layout from the following options:

● Full score layout 

● Instrumental part layout 

● Custom score layout 

3 Layout name

Shows the name of the layout. Dorico Elements automatically adds default names depending 
on the name of the instrument that is assigned to a player and on the type of layout 
that is added. For example, if you assign a flute to a player, the instrumental part layout 
automatically gets the same name. If you add an empty instrumental part layout, the layout 
name shows Empty part and an incremental number if you add multiple empty part layouts.

4 Page size and orientation
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Shows the size and orientation of the layout as set on the Page Setup page in Layout 
Options.

5 Space size

Shows the space size between two staff lines in points, as set on the Page Setup page in 
Layout Options. This indicates the size of staves in the layout.

6 Layout number

Allows you to set a unique number for the layout that can be used as part of its file name 
when exported as a graphic. This can be useful to ensure exported part layout files are 
organized in their orchestral order, as this is usually different to their alphabetical order.

There is a different layout number sequence for each layout type. For example, full score 
layouts are numbered independently of part layouts.

The action bar at the bottom of the panel contains the following options:

Add Full Score Layout

Adds a full score layout to your project. By default, every player and flow is included in 
the layout.

Add Instrumental Part Layout

Adds an empty instrumental part layout to your project. You can then assign one or 
multiple players to the layout. By default, part layouts contain all flows that originated 
in the project.

Add Custom Score Layout

Adds an empty custom score layout to your project. You can then assign players and 
flows to the layout.

Sort Layouts

Sorts all layouts in the Layouts panel according to their type in the following order: full 
score layouts, instrumental part layouts, custom score layouts.

You can click and hold or right-click Sort Layouts to change the setting to one of the 
following options:

● Layout Number: Sorts layouts within each category according to their current 
layout number.

● Instrument Score Order: Sorts layouts within each category according to the 
corresponding player order in the Players panel.

Layout Options

Opens the Layout Options dialog for the selected layouts.

Layout Settings

Allows you to access settings and controls for the selected layout; for example, to 
rename the layout.
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You can also access layout settings by right-clicking layouts.

Delete Layout

Deletes selected layouts from the project.

RELATED LINKS
Layouts on page 174
Layout Options dialog on page 745
Layouts panel (Print mode) on page 577
File import and export on page 78
Assigning players to layouts on page 176
Assigning flows to layouts on page 177

Flows panel
The Flows panel contains all the flows in the project, shown in a horizontal list. It is located at the 
bottom of the window in Setup mode.

You can hide/show the Flows panel in Setup mode in any of the following ways:

● Press Ctrl/Cmd-8 .

● Click the disclosure arrow at the bottom of the main window.

● Choose Window > Show Lower Zone.

In the Flows panel, each flow is shown as a card. Each flow card shows the following:

1 Flow name

Shows the name of the flow. If you create multiple flows without renaming them, each flow 
name shows a number that increments with each new flow that you create.

2 Film reel icon

Indicates the flow has an attached video.

3 Flow timecode

Shows the start timecode for the flow.

4 Flow number
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Shows the number of the flow. The number increments with each new flow that you create 
or import. The number also indicates the position of the flow in a layout.

The Flows panel contains the following options:

Add Flow

Adds a new flow to your project. By default, every new flow is included in all layouts, 
and every player is added to the new flow.

Notation Options

Opens the Notation Options dialog that provides multiple options that allow you to 
make changes that affect the way music is notated for each flow.

Delete Flow

Deletes the selected flows from the project.

RELATED LINKS
Flows on page 171
Videos on page 189
Notation Options dialog on page 747

Players, layouts, and flows
In Dorico Elements, players, layouts, and flows are all connected to each other. Because they 
exist in the project rather than in a single score, you can, for example, have players and flows 
saved in the project without showing them in the full score.

● Players can be assigned to any combination of layouts and flows. For example, you can 
assign a single player to both the full score layout and their own part layout, and remove 
them from flows in which they do not play. By default, players are assigned to all flows that 
originated in the project, all full score layouts, and their own part layout.

● Layouts can contain any combination of players and flows. For example, you can assign all 
the singers to a single part layout, then remove the flows in which they do not sing from the 
layout. By default, layouts contain all flows and full score layouts contain all players.

● Flows can contain any combination of players and be assigned to/removed from layouts. By 
default, flows contain all players and are assigned to all layouts.

NOTE

● If you remove a player from a flow, any notes you have already input for that player in that 
flow are deleted.

● Removing a flow from a layout automatically removes that layout from the flow, and vice 
versa. The same is true for players and layouts, and players and flows.

When you select a card in one of the panels in Setup mode, each card in the other panels 
shows a checkbox. Connected cards appear highlighted and have activated checkboxes, while 
unconnected cards are not highlighted and have deactivated checkboxes. For example, if you 
select a player card in the Players panel, all the flows to which the player is assigned are 
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highlighted and activated in the Flows panel, and all layouts to which the player is assigned are 
highlighted and activated in the Layouts panel.

A piano player selected in the Players panel with connected flows and layouts highlighted in the Flows and 
Layouts panels

EXAMPLE
A work for string quartet and choir is divided into three movements. The string quartet is tacet 
for the third movement, which the choir sings a cappella.

The Dorico project contains three flows (one for each movement), four single players for the 
string quartet, four section players for the choir, and another single player for a piano reduction. 
It uses the following layouts to produce the required performance materials:

● Four instrumental part layouts, one for each string quartet player. Each part layout contains 
all three flows but because the string players are not assigned to the third flow, automatic 
tacets are shown for it.

● One full score layout containing all three flows, the string quartet players, and the choir 
players but omitting the piano reduction player.

● One custom score layout for the vocal score. It contains all three flows, the choir players, and 
the piano reduction player.

RELATED LINKS
Project Info dialog on page 75
Flows on page 171
Layouts on page 174
Assigning flows to layouts on page 177
Assigning players to layouts on page 176
Assigning players to flows on page 172
Player, layout, and instrument names on page 181
File import and export on page 78
Tacets on page 640
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Players
In Dorico Elements, a player can represent an individual musician or multiple musicians in the 
same section. Players hold instruments, so you must add at least one player to your project 
before you can add instruments.

In Dorico Elements, there are the following types of players:

Single player
Represents an individual person who can play one or more instruments. For example, 
a clarinettist who doubles on alto saxophone or a percussionist who plays bass drum, 
clash cymbals, and triangle.

A single player in the Players panel in Setup mode

Section player
Represents multiple people who all play the same instrument. For example, a violin 
section player might represent all eight desks of the Violin I section in an orchestra, or 
a soprano section player might represent the whole soprano section in a mixed voice 
choir.

A section player in the Players panel in Setup mode

NOTE

Section players can only hold one instrument.

You can designate both single and section players as soloists, such as in a concerto for solo violin 
and orchestra.

When you add a player in Dorico Elements, the following happens automatically:

● A part layout is created and the new player is assigned to it.

● The player is added to any full score layouts that already exist. If no full score layouts exist, a 
new full score layout is created.

● The player is assigned to all existing flows that originated in the project. It is not added to 
any flows that you imported into the project.

RELATED LINKS
Instruments on page 130
Player groups on page 167
Adding ensembles on page 128
Player, layout, and instrument names on page 181
Instrument numbering on page 131
Instrument changes on page 136
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Adding players
You can add both single and section players to your project. Single players can hold multiple 
instruments, while section players can only hold one instrument.

PROCEDURE

1. In Setup mode, add an empty-handed player and open the instrument picker in any of the 
following ways:

● To add a single player, either press Shift-P , or click Add Single Player  in the Players 
panel or project start area.

● To add a section player, either press Shift-Alt/Opt-P , or click Add Section Player  in 
the Players panel or project start area.

2. Select the instrument you want in the instrument picker.

3. Press Return  to add the selected instrument.

RESULT
The single/section player is added and is automatically named after the selected instrument. The 
player’s position in the Players panel depends on the current instrument score order.

The player is assigned to its own new part layout, all full score layouts, and all flows that 
originated in the project.

Dorico Elements automatically loads sounds for the instrument according to the current playback 
template.

NOTE

● Players are not automatically added to flows that you imported into the project.

● If you want to add multiple instruments to your project at the same time, you can add 
ensembles or use a project template.

AFTER COMPLETING THIS TASK

● If you added a single player and you want them to hold multiple instruments, you can add 
other instruments to the single player.

● You can designate the player as a soloist.

● You can change the default order of players in all layouts and set custom player orders in 
each layout independently.

RELATED LINKS
Players panel on page 110
Instrument picker on page 112
Player, layout, and instrument names on page 181
Showing instrument/player names in staff labels on page 1313
Changing the language for instrument names on page 57
Instrument numbering on page 131
Adding instruments to players on page 133
Project templates on page 77
Playback templates on page 558
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Duplicating players
You can duplicate existing players. This adds another player of the same type holding the same 
instruments as the original.

PROCEDURE

1. In Setup mode, in the Players panel, select the player you want to duplicate.

2. In the action bar, click Player Settings  and choose Duplicate Player.

RESULT
A new player is added, with the same instruments as the original player and is named after those 
instruments. It is positioned in the Players panel according to the current instrument score 
order, and below the highest-numbered matching player.

The original and new players are automatically numbered to ensure their names are unique.

The new player is assigned to its own new part layout, all full score layouts, and all flows that 
originated in the project.

NOTE

● Any existing music belonging to the original player is not duplicated.

● You can also duplicate players by right-clicking them in the Players panel and choosing 
Duplicate Player from the context menu.

RELATED LINKS
Copying and pasting notes/items on page 457
Duplicating flows on page 172

Changing the default player order
You can change the default order in which players’ staves appear in all layouts; for example, if 
your project requires an unconventional instrument order.

PROCEDURE

1. In Setup mode, in the Players panel, click and hold or right-click Sort Players .

2. Choose one of the following instrument score orders:

● None

● Band

● Jazz

● Orchestral

3. Optional: Click and drag players upwards/downwards.

An insertion line indicates where the players will be positioned.

RESULT
The default player order is changed. All players are automatically sorted according to first 
instrument they hold and the instrument score order, including if you later add or delete players.

NOTE

● This does not change the player order in layouts with custom player orders.

Setup mode
Players 

125
Dorico Elements 5.1.30



● When you move players manually in the Players panel, Dorico Elements automatically 
changes the instrument score order to None. This preserves your player order if you later 
add more players, for example.

● You can also select instrument score orders from the Order menu in the status bar.

AFTER COMPLETING THIS TASK
You can renumber instruments so that their numbering matches their default player order.

RELATED LINKS
Players panel on page 110
Status bar on page 38
Renumbering instruments on page 132
Reordering layouts on page 179

Setting custom player orders
You can change the order in which players’ staves appear in each layout independently; for 
example, if you want to have a different player order in a custom score layout than the default 
player order for your other layouts, as set by the order of players in the Players panel.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layout in which you want to set a custom player order.

NOTE

You can only set custom player orders in one layout at a time. By default, the layout currently 
open in the music area is selected when you open the dialog.

3. In the category list, click Players.

4. In the Players section, activate Uses custom player order.

5. In the list, select a player whose position you want to change.

6. Change its position relative to other players in one of the following ways:

● Click Move up.

● Click Move down.

7. Optional: Repeat steps 5 to 6 for other players in the selected layout whose position you 
want to change.

8. Click Apply, then Close.

RESULT
The player order in the selected layout is changed. This overrides the default player order.

Any subsequent changes you make to the order of players in the Players panel are not reflected 
in layouts with custom player orders.

RELATED LINKS
Layout Options dialog on page 745
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Designating players as soloists
You can designate both single and section players as soloists, such as in a concerto for solo violin 
and orchestra. You can have multiple soloists in a single project.

PREREQUISITE
You have added the players you want to designate as soloists.

PROCEDURE

1. In Setup mode, in the Players panel, select the player you want to designate as a soloist.

2. In the action bar, click Player Settings  and choose Soloist.

RESULT
The selected player is designated as a soloist.

Instruments held by players designated as soloists are not automatically numbered. Provided 
they have default instrument names, they are automatically given the prefix “Solo” as 
appropriate for the current instrument language setting, which appears in staff labels.

Soloists are automatically positioned in the conventional score position; that is, above the strings, 
and are bracketed separately from other players.

Choosing Soloist again, so that no tick appears beside it in the menu, returns soloists to being a 
normal player of their type.

TIP

You can also designate players as soloists by right-clicking them in the Players panel and 
choosing Soloist from the context menu.

RELATED LINKS
Players panel on page 110
Instrument numbering on page 131
Brackets according to ensemble type on page 866
Changing the positions of system objects on page 1327
Changing the language for instrument names on page 57
Staff labels on page 1309

Deleting players
You can delete players from your project, which also deletes all instruments held by those 
players. You can also optionally delete their part layouts.

IMPORTANT

Deleting instruments permanently deletes any music that you have input on their staves.

PROCEDURE

1. In Setup mode, in the Players panel, select the players that you want to delete.

2. Delete the selected players in any of the following ways:

● Press Backspace or Delete .

● In the Players panel, click Delete Player .

3. Choose one of the following options in the warning message that appears:
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● To delete the selected players and all the instruments they hold, but leave their part 
layouts in the project, choose Delete Player Only.

● To delete the selected players, their instruments, and all corresponding part layouts, 
choose Delete Player and Part Layouts.

NOTE

Part layouts that also contain other players are not deleted.

RESULT
The selected players, and optionally their part layouts, are deleted.

TIP

You can delete only players without music in any flow by choosing Setup > Delete Empty 
Players.

RELATED LINKS
Players panel on page 110
Deleting instruments on page 136
Deleting layouts on page 180
Deleting player groups on page 169
Restoring default layouts on page 180
Assigning players to layouts on page 176

Ensembles
Ensembles are sets of multiple players that are commonly used together, such as a double 
woodwind section that contains two flutes, two oboes, two clarinets, and two bassoons. Dorico 
Elements provides predefined ensembles, but you can also build custom ensembles.

Ensembles can contain single and/or section players, depending on the ensemble. For example, 
woodwind ensembles contain single players whereas string ensembles contain section players.

You can use ensembles to add multiple players to your project simultaneously and build up the 
instrumentation quickly.

RELATED LINKS
Players, layouts, and flows on page 121
Project templates on page 77

Adding ensembles
You can add multiple players simultaneously by adding ensembles, such as a complete string 
section or four-part choir. You can select existing ensembles and build new ones.

PROCEDURE

1. In Setup mode, open the ensemble picker in any of the following ways:

● Press Shift-E .

● In the Players panel, click Add Ensemble .

● In an empty project, click Add Ensemble  in the project start area.
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2. Select or build the ensemble you want in the ensemble picker.

3. Optional: If you built a new ensemble that you want to reuse in future projects, click Save to 
open the Save Custom Ensemble dialog and save your ensemble.

4. Click Add.

RESULT
The players in the selected ensemble are added to the Players panel, as either single or section 
players depending on the ensemble type. They are assigned to all flows that originated in the 
project.

TIP

You can use project templates to start projects with multiple players.

RELATED LINKS
Players panel on page 110
Ensemble picker on page 114
Changing the language for instrument names on page 57
Starting new projects on page 71
Project templates on page 77
File import and export on page 78

Building and saving custom ensembles
You can build custom ensembles in the ensemble picker and save them for reuse in 
future projects; for example, if you frequently write music for an ensemble with unusual 
instrumentation.

PROCEDURE

1. In Setup mode, open the ensemble picker in any of the following ways:

● Press Shift-E .

● In the Players panel, click Add Ensemble .

● In an empty project, click Add Ensemble  in the project start area.

2. Click Build to switch to the Build tab.

3. Enter the instruments you want into the Search field.

For example, enter 2 vln, 3 cl,bsn,tuba,marim to build an ensemble containing two violins, 
three clarinets, a bassoon, a tuba, and a marimba.

TIP

You can also use orchestral shorthand to specify instruments.

4. Optional: To confirm the instruments identified by your current entry and clear the Search 
field, press Tab .

5. Optional: To change the player type, double-click players in the list.

The icons for each player show whether they are single players  or section players .

6. Click Save to open the Save Custom Ensemble dialog.

7. Select an ensemble category from the Category menu.

8. Enter a name for your ensemble in the Name field.
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9. Click Save to save your ensemble and close the Save Custom Ensemble dialog.

10. Optional: Click Add to add the ensemble to the project and close the ensemble picker.

RESULT
Your ensemble is saved, allowing you to add it to future projects. If you clicked Add in the 
ensemble picker, the players in the ensemble are added to the project.

RELATED LINKS
Ensemble picker on page 114
Save Custom Ensemble dialog on page 116

Instruments
In Dorico Elements, an instrument is an individual musical instrument, such as a piano, a flute, or 
a violin. Human voices, such as soprano or tenor, are also considered instruments.

In Dorico Elements, instruments are held by players, just as real instruments are held by human 
players. Section players can only hold one instrument, but single players can hold multiple 
instruments, which allows you to handle instrument changes easily, such as when an oboist 
doubling the cor anglais switches from one instrument to the other.

This means that before you can add instruments to a project, you must first add players or 
ensembles, which may in turn also be assigned to groups if needed. If you add ensembles, the 
appropriate instruments for the ensemble are automatically added to the players.

A single player holding two instruments, an Oboe and Cor Anglais, in the Players panel in Setup mode

Each instrument automatically gets its own staff, but when instrument changes are allowed, the 
music for multiple instruments held by the same single player can appear on the same staff, as 
long as no notes overlap. By default, Dorico Elements allows instrument changes in all layouts 
and automatically shows instrument change labels. This means that only the top instrument held 
by players is shown automatically in the music area. You can see staves for all instruments in 
galley view, and you can allow/disallow instrument changes in each layout independently. You 
can also hide/show empty staves in each layout independently.

Instruments in Dorico Elements do not have limited ranges; it is possible to notate any pitch in 
any register on every instrument. However, in the piano roll editor, only pitches that fall in the 
MIDI note range 0-127 can be represented. Similarly, if you input a pitch beyond the range of 
samples in the assigned VST instrument, the pitch does not sound in playback.

There are multiple variants of some instruments that have specific formatting and tuning 
requirements, such as French Horn, which has a version whose part layouts are always in treble 
clef.

You can change instruments at any time, add/delete them from players, and move them 
between players. You can also change the language for instrument names; for example, to 
recreate a French score.

RELATED LINKS
Players on page 123
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Player, layout, and instrument names on page 181
Brackets according to ensemble type on page 866
Designating players as soloists on page 127
Changing the default player order on page 125
Hiding/Showing empty staves on page 605
Piano roll editor on page 678

Instrument numbering
It is customary to number instruments when there is more than one in a piece so that they 
can be easily identified, such as Horn 1 and Horn 2. Dorico Elements automatically numbers 
instruments where there are multiple instruments of the same type in the same project.

For example, if there is only one flute in a project, it is called Flute, but if there are three flutes, 
they are automatically called Flute 1, Flute 2, and Flute 3.

One violin with no number Adding a second violin automatically generates 
numbers for both violins

Instrument numbering applies to individual instruments, rather than players. For example, if an 
ensemble contains two flute players and a piccolo player, but the second flute is also holding a 
piccolo, then the instruments are numbered in the following way:

● Flute 1

● Flute 2 & Piccolo 1

● Piccolo 2

TIP

You can move individual instruments to different players if you want to change which numbered 
instruments are held by each player. For example, if you want the second flute to double second 
piccolo rather than first piccolo, you can swap the piccolo instruments between the players.

Dorico Elements automatically generates instrument numbers for players if the following criteria 
are met:

● The project contains multiple instruments with identical instrument names.

● The instruments have the same transposition.

● The players holding them are the same type, either single or section.

● The players are in the same group.

For example, if you have two flutes in your project, but one flute is a section player and the other 
flute is a single player, they are not numbered automatically. Similarly, if the two flutes are in 
different player groups, they are not numbered automatically.
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NOTE

Instruments held by players designated as soloists are not automatically numbered.

RELATED LINKS
Player, layout, and instrument names on page 181
Changing instrument names on page 183
Player groups on page 167
Instrument transpositions in staff labels on page 1314
Moving instruments on page 135
Designating players as soloists on page 127
Staff label contents on page 1313
Transposing instruments on page 132

Renumbering instruments
You can renumber instruments so that their numbering matches their default player order; for 
example, if you want to swap the numbering of Horns 2 and 3.

PREREQUISITE
Your default player order matches the instrument numbering you want.

PROCEDURE

● In Setup mode, choose Setup > Renumber Instruments.

RESULT
Instruments are renumbered according to the order of players in the Players panel.

For players you have not already renamed, player names are updated to reflect the new 
instrument numbers.

RELATED LINKS
Changing the default player order on page 125
Reordering layouts on page 179
Renumbering layouts on page 180
Player, layout, and instrument names on page 181

Transposing instruments
While most instruments produce notes at concert pitch, transposing instruments produce a note 
that is different to the one that is written. Common transposing instruments include clarinets, 
horns, trumpets, saxophones, and the cor anglais.

When a clarinet in B♭ plays a C, the sound produced is a B♭, one whole step (tone) below. When a 
horn in F plays a C, the sound produced is an F, a fifth below.

Octave-transposing instruments include the piccolo (sounding an octave above written), 
glockenspiel (sounding two octaves above written), and guitar and double bass (both sounding 
an octave below written).

Dorico Elements stores all note information in concert pitch and automatically transposes notes 
as appropriate for the transposition of the instrument. This means notes, key signatures, and 
chord symbols are automatically changed in transposing layouts compared to non-transposing 
layouts. You can also change instruments at any time, and the music is adjusted automatically to 
ensure the correct pitches are shown.
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You can also change the octave of individual clefs and whether Dorico Elements respects or 
ignores clef octave indicators in each flow independently.

NOTE

According to convention, octave-transposing instruments always show transposed pitches, 
including in concert pitch layouts and without requiring clefs with octave indicators.

RELATED LINKS
Instrument picker on page 112
Instrument numbering on page 131
Instrument transpositions in staff labels on page 1314
Concert vs. transposed pitch on page 178
Making layouts transposed/concert pitch on page 178
Editing layout transposition text on page 1000
Changing fretted instrument transpositions on page 161
Enharmonic equivalent key signatures on page 1025
Changing instruments on page 134
Hiding/Showing clefs according to layout transpositions on page 910
Clefs with octave indicators on page 913
Fretted instrument tuning on page 153
Capos on page 157

Adding instruments to players
You can add instruments and percussion kits to both single and section players. Single players 
can hold multiple instruments, while section players can only hold one instrument.

PREREQUISITE
You have added at least one player.

PROCEDURE

1. In Setup mode, in the Players panel, select the player to which you want to add instruments.

NOTE

● You can only add instruments to one player at a time.

● You cannot add instruments to section players who are already holding one instrument.

2. Open the instrument picker in any of the following ways:

● Press Shift-I .

● Click the plus symbol  in the player card.

3. Select the instrument you want in the instrument picker.

4. Press Return  to add the selected instrument.

RESULT
The selected instrument is added to the selected player. Dorico Elements automatically loads 
sounds for the instrument according to the current playback template.

If you have not already renamed the player, the player name updates to include all instruments 
held by the player.
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NOTE

● Before you have input any notes, only the first instrument held by single players is shown in 
full scores in page view. All instrument staves are shown in galley view, so we recommend 
switching to galley view to input notes for any other instruments held by single players; for 
example, to create instrument changes.

● If you want to add multiple players to your project at the same time, you can add ensembles 
or use a project template.

RELATED LINKS
Players on page 123
Players panel on page 110
Instrument picker on page 112
Adding players on page 124
Adding ensembles on page 128
Designating players as soloists on page 127
Changing the default player order on page 125
Instrument changes on page 136
Percussion kits and drum sets on page 142
Fretted instrument tuning on page 153
Capos on page 157
Player, layout, and instrument names on page 181
Changing the language for instrument names on page 57
Changing instrument names on page 183
Starting new projects on page 71
Switching to galley/page view on page 50
Playback templates on page 558
Note input on page 223
Importing drum set patterns from Groove Agent SE on page 94

Changing instruments
You can change the type of instruments without affecting any music already entered onto their 
staves; for example, if your Clarinet part is very low and you want to change it to a Bass Clarinet, 
or you want to change the tuning of a guitar.

NOTE

● You cannot change percussion kits into other instruments, you can only change individual 
unpitched percussion instruments.

● You cannot change a pitched instrument into an unpitched instrument, and vice versa.

● These steps describe changing the instrument type, not an instrument change where a 
performer switches from one instrument to another partway through a flow.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player whose instrument you 
want to change.

The card lists the instruments held by the player.
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2. In the instrument label, click the instrument menu  and choose Change Instrument to 
open the instrument picker.

3. Select the instrument you want in the instrument picker.

4. Press Return  to change to the selected instrument.

RESULT
The selected instrument is changed without affecting any music on its staff.

Where appropriate, different clefs are used by default. This means that notes can appear 
differently so that they are notated correctly according to the new clef.

AFTER COMPLETING THIS TASK
You can change the player order; for example, if the new instrument requires a different position 
according to orchestral convention.

RELATED LINKS
Players panel on page 110
Instrument picker on page 112
Transposing instruments on page 132
Fretted instrument tuning on page 153
Instrument changes on page 136
Changing the language for instrument names on page 57
Hiding/Showing instrument transpositions in staff labels on page 1315
Changing the default player order on page 125

Moving instruments
You can move individual instruments without affecting any music already input for those 
instruments. You can move instruments between players, or to a different position in the 
instrument list for a single player; for example, if you want to change the order of staves in 
the score.

Changing the order of instruments held by a single player also affects its player name, if you 
have not already renamed the player.

PREREQUISITE
You have added the players to which you want to move instruments.

PROCEDURE

1. In Setup mode, in the Players panel, expand the cards of the players holding the 
instruments you want to move.

2. Move instruments in any of the following ways:

● To change the order of instruments for a single player, click and drag a single 
instrument to the required position, then release the mouse.

● To move instruments to another player, click and drag a single instrument to the 
required player card, then release the mouse.
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● To move instruments to another player, click the instrument menu  in the instrument 
label and choose Move Instrument to Player > [Player].

RELATED LINKS
Players panel on page 110
Adding players on page 124
Changing the default player order on page 125
Setting custom player orders on page 126
Renaming players on page 182
Resetting player names on page 182

Deleting instruments
You can delete individual instruments without deleting the player holding them or other 
instruments held by the same player.

IMPORTANT

Deleting instruments permanently deletes any music that you have input on their staves.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the instrument 
you want to delete.

2. In the instrument label, click the instrument menu  and choose Delete Instrument.

3. Click OK.

RESULT
The instrument is deleted from the player.

TIP

If you want to delete all instruments held by a single player, you can also delete the player.

RELATED LINKS
Players panel on page 110
Deleting players on page 127

Instrument changes
Instruments changes are when a player holding multiple instruments switches from playing one 
instrument to a different instrument. They are usually indicated with text labels, both after the 
last note before the change and at the first note after the change.

An instrument change from Oboe to Cor Anglais

Setup mode
Instrument changes 

136
Dorico Elements 5.1.30



Dorico Elements handles instrument changes automatically, including showing the appropriate 
instrument change labels, when the following criteria are met:

● You have added a single player holding at least two instruments.

● You have input notes on at least two instrument staves held by the single player, such as 
inputting oboe notes on the Oboe staff and cor anglais notes on the Cor Anglais staff.

● Notes for different instruments held by the same single player do not overlap.

● Instrument changes are allowed in the layout.

You can see staves for all instruments in galley view, and you can allow/disallow instrument 
changes in each layout independently.

By default, instrument changes occur after the last note in old instruments, instrument change 
labels for new instruments appear after cues on their staves, and instrument change warnings 
are hidden in full score layouts.

You can change the positions of instrument changes and instrument change labels in each layout 
independently.

Instrument change labels use the appropriate prefix for the current instrument name language 
setting.

RELATED LINKS
Adding players on page 124
Adding instruments to players on page 133
Switching to galley/page view on page 50
Inputting notes on page 224
Changing the language for instrument names on page 57
Changing instruments on page 134

Allowing/Disallowing instrument changes
You can allow/disallow instrument changes in each layout independently; for example, if you 
want to show multiple percussion instruments on as few staves as possible in the score, but on 
separate staves for each percussion instrument in the percussion part.

Disallowing instrument changes shows all instrument staves in the selected layouts, including 
multiple instruments held by one single player.

TIP

If you want to input notes for other instruments held by single players but keep instrument 
changes in the layout, you can switch to galley view to see all staves in the project.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to allow/disallow instrument 
changes.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Instrument Changes section, activate/deactivate Allow instrument changes.
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5. Click Apply, then Close.

RESULT
Instrument changes are allowed in the selected layouts when Allow instrument changes is 
activated, and disallowed when it is deactivated.

NOTE

Multiple instruments can only appear on the same staff with an instrument change if none of 
their notes overlap. If any of their notes do overlap, multiple staves are shown.

RELATED LINKS
Instruments on page 130
Inputting notes on page 224
Hiding/Showing empty staves on page 605
Hiding/Showing instrument change labels at the start of flows on page 141
Changing instruments on page 134
Layout Options dialog on page 745

Changing the position of instrument changes
You can show instrument changes either after the last note in the old instrument or before the 
first note in the new instrument in each layout independently. You can also change the positions 
of instrument change labels relative to cues.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the position of instrument 
changes.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Instrument Changes section, choose one of the following options for Instrument 
transition position:

● After last note in old instrument

● Before first note in new instrument

5. Activate/Deactivate Show instrument change label after cue, if cue precedes first note in 
new instrument.

6. Click Apply, then Close.

RESULT
Instrument changes are shown at the corresponding position in the selected layouts.
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TIP

When instrument changes occur mid-system, you might prefer to show the new instrument in 
the staff label, if it is the first sounding instrument in the system. You can change this setting in 
Layout Options > Staves and Systems > Staff Labels.

EXAMPLE

Instrument change after last note in old instrument, 
and instrument change label at start of cue

Instrument change before first note in new 
instrument, and instrument change label after cue

RELATED LINKS
Cues on page 920
Transposing instruments on page 132

Editing the default instrument change label text
You can change the default instrument change label prefix and whether instrument change 
labels show full or short instrument names by default in each layout independently; for example, 
if you want to show full instrument names in part layouts but short instrument names in full 
score layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the default content in 
instrument change labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Instrument Changes section, choose one of the following options for Instrument 
names to use in change labels:

● Full Names

● Short Names

5. Choose one of the following options for Prefix for instrument change warnings:

● To

● Take

● Custom

NOTE

To and Take prefixes appear as appropriate for the current instrument name language 
setting.
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6. Optional: If you chose Custom, enter the text you want in the following fields, individually or 
together:

● Custom prefix

● Custom suffix

7. Click Apply, then Close.

RESULT
The length of instrument names and prefixes/suffixes in all instrument change labels in the 
selected layouts is changed.

RELATED LINKS
Hiding/Showing instrument change labels at the start of flows on page 141
Changing the language for instrument names on page 57
Staff labels on page 1309

Editing instrument change label text individually
You can override the text shown in instrument change labels individually; for example, if you 
want to show the full instrument name in the first instrument change label in the flow.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the instrument change labels whose text you want to edit.

2. In the Properties panel, activate Custom text in the Instrument Changes group.

3. Enter the text you want to appear in the instrument change labels into the value field.

4. Press Return .

5. Optional: Activate/Deactivate Hide prefix.

RESULT
The selected instrument change labels are changed to show the text you entered. If you 
activated Hide prefix, the prefix is hidden.

Deactivating Custom text returns the corresponding instrument change labels to their default 
text.

NOTE

● Deactivating properties permanently deletes any custom text entered.

● You can change the default instrument change label prefix and whether instrument change 
labels show full or short instrument names by default in each layout independently.

RELATED LINKS
Engrave toolbox on page 503
Changing the language for instrument names on page 57
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Hiding/Showing instrument change labels at the start of flows
You can hide/show instrument change labels at the start of each flow in each layout 
independently. These labels can be useful for players holding multiple instruments as a way of 
clarifying the instrument required in their part layouts, which do not normally show staff labels.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show instrument change 
labels at the start of flows.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Instrument Changes section, activate/deactivate Show instrument change label at 
start of flow.

5. Click Apply, then Close.

Hiding/Showing instrument change warnings
You can hide/show all instrument change warnings after the last notes before instrument 
changes in each layout independently. For example, if you want to show “To Marimba” in the 
percussion part layout but hide it in the full score.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show instrument change 
warnings.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Instrument Changes section, activate/deactivate Show instrument change 
warnings.

5. Click Apply, then Close.

RELATED LINKS
Layout Options dialog on page 745
Allowing/Disallowing instrument changes on page 137
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Instrument change label paragraph styles
There are different paragraph styles for instrument change labels and instrument change 
warnings. You can change different aspects of these paragraph styles in the Paragraph Styles 
dialog, such as hiding/showing borders for each type of label.

By default, borders are shown on instrument change labels but not shown on instrument change 
warnings.

The following paragraph styles are used for instrument change labels:

1 Instrument Change Warnings: Used for warning labels before instrument changes

2 Instrument Change Labels: Used for labels after instrument changes

RELATED LINKS
Paragraph Styles dialog on page 756
Editing instrument change label text individually on page 140
Hiding/Showing borders on layout names on page 1001
Adding borders to text items on page 1358

Percussion kits and drum sets
A percussion kit is a collection of unpitched percussion instruments that are played by a single 
player. Drum sets are a particular type of percussion kit that are often used in pop and rock 
music.

NOTE

In this documentation, we use “percussion kit” to refer to both percussion kits and drum sets.

In Dorico Elements, you can present percussion kits in different ways, including as a five-line staff 
and as a grid. If you want percussion kits to behave as drum sets, you can define them as drum 
sets. For example, there are options on the Percussion page in Notation Options for handling 
voices that only apply to drum sets.

You can add percussion kits to projects in the following ways:

● Add percussion kits to players in the same way as adding instruments.

● Combine existing unpitched percussion instruments held by a single player into kits.

● Add empty kits to players, to which you can then add unpitched percussion instruments.

● Import existing kits you have previously exported and saved.

You can move percussion instruments between players without affecting any music already 
added to that instrument. If the instrument you want to move is combined into a percussion kit, 
you must first remove the instrument from the kit before you can move it to another player.

You can change individual percussion instruments like any other instrument. However, you can 
only change unpitched percussion instruments to other unpitched percussion instruments, and 
you can only change the percussion instruments in kits within the Edit Percussion Kit dialog.
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Percussion kit instrument labels appear green in the Players panel in Setup mode.

A single player holding a percussion kit in the Players panel in Setup mode

RELATED LINKS
Percussion kit presentation types on page 1428
Playing techniques for unpitched percussion instruments on page 1420
Staff labels for percussion kits on page 1319
Adding instruments to players on page 133
Inputting notes for unpitched percussion on page 238
Importing drum set patterns from Groove Agent SE on page 94

Edit Percussion Kit dialog
The Edit Percussion Kit dialog allows you to make changes to percussion kits, including 
which instruments they contain and how instruments are arranged in the different available 
kit presentations.

You can open the Edit Percussion Kit dialog in any of the following ways:

● Add an empty percussion kit or combine existing instruments into a percussion kit.

● In Setup mode, in the Players panel, expand the card of a player holding a percussion kit, 
then click the instrument menu  in the kit instrument label and choose Edit Percussion 
Kit.

TIP

Percussion kit instrument labels are green in the Players panel in Setup mode.
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1 Name

Allows you to enter or change the full name for the percussion kit. This is used in Full staff 
labels for percussion kits that use the five-line staff presentation type.

2 Short name

Allows you to enter or change the abbreviated name for the percussion kit. This is used in 
Abbreviated staff labels for percussion kits that use the five-line staff presentation type.

3 Drum set

Percussion kits are defined as drum sets when the checkbox is activated. Percussion kits 
that are defined as drum sets follow your settings for drum sets on the Percussion page in 
Notation Options, including for voicing and default stem directions.

4 Presentation types

Allows you to select a percussion kit presentation type in order to edit how the selected 
percussion kit appears in that presentation type.

● 5-line Staff: Kit instruments are shown on a five-line staff. You can determine which 
instruments are shown on each line and in each space of the staff. A single staff label 
containing the name of the kit is shown.

● Grid: Kit instruments are shown on a grid, with each instrument on its own line. You can 
customize how large the gaps between each line are. Staff labels are shown for each 
instrument in a smaller font than normal staff labels.

● Single-line Instruments: Kit instruments are shown as individual instruments with their 
own lines. Normal-sized staff labels are shown for each instrument.

5 Editor

Displays the current arrangement of instruments in the selected percussion kit presentation 
type. You can change the order of instruments and the layout of lines and spaces in the grid 
presentation type by using the controls.
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6 Controls

Allows you to change the order and stem direction of instruments in the selected percussion 
kit presentation type. It also allows you to add slash voices to the kit.

● Edit Names: Opens the Edit Instrument Names dialog, which allows you to change the 
names of the currently selected instrument.

NOTE

This changes the appearance of percussion instrument names in all presentations. 
Depending on the percussion kit presentation type, staff labels might use different 
information than these instrument names.

● Edit Percussion Playing Techniques: Opens the Percussion Instrument Playing 
Techniques dialog, which allows you to change how combinations of noteheads, 
articulations, and tremolos affect playback for the currently selected instrument.

● Edit Noteheads: Opens the Override Percussion Noteheads dialog, which allows you 
to override the noteheads used by the currently selected instrument in five-line staff kit 
presentations.

7 Action bar

Contains options that apply to all presentation types.

● Add New Instrument : Opens the instrument picker, which allows you to choose a 
new unpitched percussion instrument to be added to the kit.

● Add Existing Instrument From Player : Shows a menu listing the other players in 
your project that are holding individual percussion instruments not in kits. You can 
select a percussion instrument from another player to move to this kit, bringing its 
music with it.

● Remove Instrument From Kit : Removes the selected instrument from the kit, so 
it appears as an individual instrument. You can move individual instruments to other 
players or into other kit instruments.

● Change Instrument : Opens the instrument picker, which allows you to choose a new 
unpitched instrument to replace the selected instrument while retaining its music.

● Delete Instrument : Deletes the instrument from the kit, including its music.

8 Export Kit

Allows you to export the percussion kit as a library file so you can use it in other projects.

RELATED LINKS
Players panel on page 110
Adding empty percussion kits to players on page 146
Combining individual percussion instruments into kits on page 147
Percussion kits and drum sets on page 142
Voices in percussion kits on page 1435
Staff labels for percussion kits on page 1319
Percussion kit presentation types on page 1428
Edit Instrument Names dialog on page 184
Percussion Instrument Playing Techniques dialog on page 1421
Override Percussion Noteheads dialog on page 1423
Playing techniques for unpitched percussion instruments on page 1420
Playing technique-specific noteheads on page 1421
Specifying the stem direction/voice of instruments in percussion kits on page 1435
Inputting notes for unpitched percussion on page 238
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Adding empty percussion kits to players
You can add empty percussion kits to players, to which you can then add unpitched percussion 
instruments.

NOTE

You cannot add percussion kits to section players that are already holding one instrument.

PREREQUISITE
You have added at least one player.

PROCEDURE

1. In Setup mode, in the Players panel, open the Edit Percussion Kit dialog in any of the 
following ways:

● Select a player, press Shift-I , and click Create Empty Kit in the instrument picker.

● Click the plus symbol  in a player card and click Create Empty Kit in the instrument 
picker.

● Select a player, then click Player Settings  in the action bar and choose Create Empty 
Kit. You can also right-click players and choose this option from the context menu.

2. Add the percussion instruments you want to the kit in the Edit Percussion Kit dialog.

RELATED LINKS
Players panel on page 110
Percussion kits vs. individual percussion instruments on page 1419
Edit Percussion Kit dialog on page 143
Instrument picker on page 112
Percussion kit presentation types on page 1428
Changing the language for instrument names on page 57

Adding instruments to percussion kits
You can add new instruments to percussion kits within the Edit Percussion Kit dialog.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit to which 
you want to add instruments.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Add New Instrument  to open the instrument picker.

4. Select the percussion instrument you want in the instrument picker.

5. Press Return  to add the selected instrument.

6. Click Close.

RESULT
The selected instrument is added to the percussion kit.
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RELATED LINKS
Players panel on page 110
Changing the language for instrument names on page 57
Percussion kit presentation types on page 1428
Inputting notes for unpitched percussion on page 238

Combining individual percussion instruments into kits
If a player is holding one or more individual percussion instruments, you can combine them into 
a percussion kit.

PROCEDURE

1. In Setup mode, in the Players panel, select the player whose percussion instruments you 
want to combine into a kit.

2. In the action bar, click Player Settings  and choose Combine Instruments into Kit to 
open the Edit Percussion Kit dialog.

TIP

You can also right-click players and choose this option from the context menu.

3. Edit the new percussion kit.

For example, you can change the order in which the instruments appear in a grid or on a 
five-line staff.

RESULT
A new kit is created containing all the instruments held by the player.

NOTE

If the player was already holding one or more kit instruments, all individual instruments and any 
other kits are combined into the first kit.

Removing individual instruments from percussion kits
You can remove individual instruments from percussion kits without affecting other instruments 
in the kit. For example, if you want to move an instrument from one percussion kit to another 
player.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit from 
which you want to remove instruments.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click the instruments you want to remove from the kit.

4. Click Remove Instrument From Kit  in the action bar.

5. Click Close.
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RESULT
The selected instruments are removed from the percussion kit. They appear as individual 
instruments belonging to the same player.

AFTER COMPLETING THIS TASK
You can move the instruments to other players if required.

RELATED LINKS
Players panel on page 110
Moving instruments on page 135

Defining percussion kits as drum sets
You can define individual percussion kits as drum sets. Drum sets follow your per-flow notation 
options for voicing in drum sets with five-line staff presentations.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit you want 
to define as a drum set.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Activate Drum set in the top right of the dialog.

4. Click Apply, then Close.

RESULT
The selected percussion kit is defined as a drum set. The arrangement of voices for instruments 
in the kit when using the five-line staff presentation type follows your per-flow setting on the 
Percussion page in Notation Options.

NOTE

If you no longer want a percussion kit to be defined as a drum set, you can deactivate Drum set 
in the Edit Percussion Kit dialog for that kit.

RELATED LINKS
Players panel on page 110
Notation Options dialog on page 747
Percussion Instrument Playing Techniques dialog on page 1421

Changing instruments in percussion kits
You can change existing instruments in percussion kits while retaining any existing music for that 
instrument.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit in which 
you want to change instruments.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click the instrument you want to change.
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4. Click Change Instrument  in the action bar to open the instrument picker.

5. Select the percussion instrument you want in the instrument picker.

6. Press Return  to change to the selected instrument.

7. Click Close.

RESULT
The instrument is changed to the one selected in the instrument picker. Any music input for the 
previous instrument is retained.

NOTE

Playing techniques expressed using playing technique-specific noteheads are not retained.

RELATED LINKS
Playing technique-specific noteheads on page 1421
Changing the language for instrument names on page 57

Moving instruments in percussion kits
You can change the positions of instruments within percussion kits of all presentation types 
to change the order in which the instruments appear in the score and parts. In five-line staff 
presentation types, you can also change the staff position of slash voices.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit in which 
you want to change the positions of instruments.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click the kit presentation type in which you want to change the order of instruments.

For example, click Grid to change the order of instruments when the kit uses the grid 
presentation type.

4. Click the percussion instruments and/or slash voices whose position you want to change.

NOTE

When using the mouse, you can only move one instrument or slash voice at a time.

5. Change the position of the selected instruments/slash voices in any of the following ways:

● To move them upwards, click Move Up .

● To move them downwards, click Move Down .

● Click and drag a single instrument upwards/downwards (five-line staff presentation 
only).

6. Optional: Repeat these steps for other instruments in the percussion kit, and for other kit 
presentation types for the same percussion kit.

7. Click Apply, then Close.
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RESULT
The positions of the selected instruments and/or slash voices within the kit is changed. Multiple 
instruments can share the same staff position, but we recommend that they use different 
noteheads so that the player can tell them apart.

RELATED LINKS
Players panel on page 110
Moving notes to other instruments in percussion kits on page 465
Inputting notes for unpitched percussion on page 238

Creating groups of instruments within grid presentation percussion 
kits

You can create groups of instruments within percussion kits that use the grid presentation type 
in order to have a better overview of the instruments in the kit.

In grid presentation percussion kits, the name of each individual instrument is shown in the staff 
label. You can simplify the staff label of grid presentation percussion kits by creating groups; for 
example, to show “Wood Blocks” instead of “Wood Block (High)”, “Wood Block (Medium)”, and 
“Wood Block (Low)”.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit in which 
you want to create groups in the grid presentation.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Click the first instrument you want to include in the group.

5. Shift -click the last instrument you want to include in the group.

NOTE

You can only include adjacent instruments in groups.

6. Click Add .

RESULT
A group is created containing the selected instruments. The group is given a default name that 
you can change.

RELATED LINKS
Players panel on page 110
Percussion kit presentation types on page 1428
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Renaming groups in grid presentation percussion kits
Group names are shown as instrument labels. You can change the names of groups in 
percussion kits using the grid presentation type.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit whose 
grid presentation groups you want to rename.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Double-click the group you want to rename to open the Edit Percussion Grid Group Names 
dialog.

Groups are shown as colored blocks in the column to the left of the list of percussion kit 
instruments.

5. Enter the names you want to give the group in the corresponding fields in the Edit 
Percussion Grid Group Names dialog:

● Full Name

● Short Name

6. Click OK to save your changes and close the dialog.

RESULT
The name of the group is changed. This also changes the staff label for the group.

NOTE

Staff labels for groups in grid presentation percussion kits use a different paragraph style to the 
staff labels for non-grouped instruments in grid presentation percussion kits.

EXAMPLE

Ungrouped grid presentation percussion kit Grid presentation percussion kit with wood blocks 
grouped

RELATED LINKS
Staff labels for percussion kits on page 1319
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Deleting groups within grid presentation percussion kits
You can delete groups in percussion kits using the grid presentation type without deleting the 
instruments within the group.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit from 
whose grid presentation you want to delete groups.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Click the group you want to delete.

Groups are shown as colored blocks in the column to the left of the list of percussion kit 
instruments.

5. Click Delete .

RESULT
The group is deleted. The individual staff labels for each instrument in the group are restored.

Changing the size of gaps between lines in percussion grids
You can change the size of gaps between lines in percussion kits using the grid presentation 
type.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player in whose percussion kit 
you want to change the size of gaps in the grid presentation.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Click Grid at the top of the dialog.

4. Click the instruments below which you want to change the gap size.

5. Change the value for Gap.

6. Click Apply, then Close.

RESULT
The size of the gaps below the selected instruments is changed.

Exporting percussion kits
You can export percussion kits as .doricolib files. This allows you to use kits again without 
having to create them from scratch.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player whose percussion kit you 
want to export.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.
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3. Click Export Kit at the bottom of the dialog to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.

RESULT
The kit is exported and saved as a .doricolib file.

TIP

You can later import the .doricolib file into other projects to reuse the percussion kit.

Importing percussion kits
You can import .doricolib files containing percussion kits, which allows you to use kits again 
without having to create them from scratch.

PREREQUISITE
Your project contains at least one single player or empty-handed section player.

PROCEDURE

1. In Setup mode, in the Players panel, open the instrument picker for the player to which you 
want to assign the imported percussion kit in any of the following ways:

● Select the player and press Shift-I .

● Click the plus symbol  in the player card.

● Select the player, then click Player Settings  in the action bar and choose Add 
Instrument to Player. You can also right-click players and choose this option from the 
context menu.

2. Click Import Kit in the instrument picker to open the File Explorer/macOS Finder.

3. Locate and select the percussion kit .doricolib file you want to import.

4. Click Open.

RESULT
The selected .doricolib file is imported as a percussion kit. It is assigned to the player from 
whose card you opened the instrument picker.

RELATED LINKS
Players panel on page 110
Adding players on page 124

Fretted instrument tuning
Fretted instruments can have different numbers of strings and frets. In order to display tablature 
for fretted instruments in Dorico Elements, you must specify information about the tuning of 
fretted instruments.

Dorico Elements requires the following information to display tablature:

● The number of strings the instrument has

● The open pitch of each string
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● The number of frets

● The fret number at which each string starts, such as for the fifth string on a banjo

● The pitch intervals between frets

● The fret number of the capo, if applicable

When you add a fretted instrument or change an existing instrument, any available tunings for 
that instrument are shown in the instrument picker.

You can also customize all aspects of fretted instruments in the Edit Strings and Tuning dialog, 
including adding capos.

RELATED LINKS
Instrument picker on page 112
Changing instruments on page 134
Capos on page 157
Changing the middle C numbering convention on page 51
Chord symbols on page 871
Chord diagrams on page 894
Tablature on page 1330
Guitar bends on page 1122
Guitar techniques on page 1137

Edit Strings and Tuning dialog
The Edit Strings and Tuning dialog allows you to customize the tuning of individual fretted 
instruments by changing the number of strings and frets they have, the pitches of their open 
strings, and the spacing of their frets. It also allows you to add/remove capos and change the 
fretted instrument transposition.

● You can open the Edit Strings and Tuning dialog in Setup mode by expanding the card of 
the player holding the fretted instrument in the Players panel, then clicking the instrument 
menu  in its instrument label and choosing Edit Strings and Tuning.

The Edit Strings and Tuning dialog comprises the following:

1 Instrument
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Displays the name of the selected fretted instrument.

2 Compatible preset tunings

Allows you to select preset fretted instrument tunings with the same number of strings as 
the selected fretted instrument. If your changes in the dialog match a preset tuning, it is 
automatically selected.

3 String editor

Allows you to select and edit individual or all strings of the fretted instrument. The 
arrangement of strings in the editor matches that of the real instrument. The pitch and 
total number of frets of each string is shown to the left of the vertical line that represents the 
nut.

You can navigate through strings by pressing Up Arrow / Down Arrow , and to top/bottom 
strings by pressing Page Up/Page Down.

4 Capo representation

Indicates the fret position and extent of the capo added to the fretted instrument.

5 Controls

Allow you to edit individual or multiple strings. The following controls are available when at 
least one string is selected in the string editor:

● Open pitch: Allows you to set the open pitch of the string using the appropriate note 
name and octave for your middle C numbering convention setting, such as C4 for middle 
C. If necessary, you can add # for sharp and b for flat.

● No. of frets: Allows you to set the number of frets for the selected strings.

● Starting fret: Allows you to set the number of the first fret on the selected strings. For 
example, the fifth string on the banjo starts at fret 5.

● Tune Up Half-Step: Allows you to raise the open pitch of the selected strings by a 
half-step (semitone).

● Tune Down Half-Step: Allows you to lower the open pitch of the selected strings by a 
half-step (semitone).

● Irregular fret spacing: Allows you to set non-chromatic fret arrangements for 
instruments with fretboards that correspond to other scales, such as the dulcimer. Enter 
1 for a half-step and 2 for a whole step, with each step separated by a comma. For 
example, enter 2,2,1,2,2,2,1 to set the pattern for a major scale.

6 Action bar

Contains options that allow you to change the number and arrangement of strings.

● Add String : Adds a new string below the lowest currently selected string. The new 
string is a duplicate of the lowest currently selected string.

● Add String at Top : Adds a new string at the top of the fretboard. The new string is a 
duplicate of the previous top string.

● Select all: Selects all strings at once.

● Move string buttons: Allow you to move the currently selected strings up/down the 
fretboard.

● Reset to Default: Returns all strings and corresponding tunings to the factory default 
settings for the fretted instrument.

● Delete String : Deletes the selected strings.

7 Capo and Transposition section

Contains options that allow you to change the capo and fretted instrument transposition.
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● Capo: Opens the Capo Definition dialog, which allows you to add full and partial capos 
to fretted instruments.

● In staff notation, written middle C (MIDI note 60) sounds as: Allows you to change 
the transposition of the selected fretted instrument. The pitch determines the spelling of 
notes and chord symbols for the corresponding number of half-steps.

8 Import Tuning

Opens the File Explorer/macOS Finder, where you can select the .doricotuning file that 
you want to import and apply to the fretted instrument.

9 Export Tuning

Opens the File Explorer/macOS Finder, where you can select the location to which you want 
to export the strings and tuning settings of the fretted instrument as a .doricotuning file. 
You can then import the .doricotuning file into other instruments/projects and share it 
with other users.

RELATED LINKS
Players panel on page 110
Chord diagrams on page 894
Tablature on page 1330
Fretted instrument tuning on page 153
Capos on page 157
Changing the middle C numbering convention on page 51

Changing the open pitches of fretted instrument strings
You can change the open pitch of each fretted instrument string independently; for example, if 
your project requires an unconventional tuning that is not available as an instrument variant in 
the instrument picker.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument whose open pitches you want to change.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. Select the string whose open pitch you want to change.

4. Change the Open pitch value; for example, to G2.

5. Optional: Repeat steps 3 and 4 to change the open pitch of other strings.

6. Click OK to save your changes and close the dialog.

RESULT
The open pitches of the selected strings are changed. This affects the tuning of the instrument 
and the pitch of all fret positions on those strings.

The new tuning becomes available for chord diagrams.

RELATED LINKS
Players panel on page 110
Chord diagrams on page 894
Hiding/Showing chord diagrams on page 895
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Exporting fretted instrument tunings
You can export fretted instrument tunings so you can reuse them for other instruments and in 
other projects. Fretted instrument tunings are exported as .doricotuning library files.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument whose tuning you want to export.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. Click Export Tuning at the bottom of the dialog to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.

RESULT
The tuning of the selected fretted instrument is exported and saved as a .doricotuning library 
file.

AFTER COMPLETING THIS TASK
You can import the library file into other projects to reuse the fretted instrument tuning.

Importing fretted instrument tunings
You can import custom fretted instrument tunings that you have already created and apply them 
to instruments. This allows you to reuse tunings without having to create them from scratch.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument to which you want to apply an imported tuning.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. Click Import Tuning at the bottom of the dialog to open the File Explorer/macOS Finder.

4. Locate and select the .doricotuning library file you want to import.

5. Click Open.

RESULT
The selected .doricotuning file is applied to the fretted instrument. The imported tuning 
becomes available for chord diagrams.

Capos
Capos are devices that performers clamp onto the necks of fretted instruments to depress 
strings at a single fret position. This raises the sounding pitch of open strings affected by the 
capo, allowing performers to use the same fingerings and chord shapes but produce higher 
pitches.

In Dorico Elements, you can allow capos to affect your notated music in the following ways, 
independently of each other:
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● You can change the pitches shown on tablature by adding capos to fretted instruments. 
Dorico Elements treats capos as fret 0 for fret numbers on tablature. Capos added to 
individual fretted instruments appear at the corresponding fret position and crossing the 
specified strings in the Edit Strings and Tuning dialog and in the Fretboard panel.

● You can change fretted instrument transpositions to reflect capos or detuned fretted 
instruments, and optionally allow fretted instrument transpositions to affect pitches on 
notation staves and in main chord symbols.

● You can define capos for chord symbols/diagrams in the music and/or used chord diagrams 
grids, and show only main chords, only capo chords, or both.

For example, you can show capo pitches on tablature but show sounding pitches on notation 
staves. You can also show both main and capo chords in chord symbols in layouts that do not 
contain a fretted instrument, such as when creating lead sheets in vocal part layouts.

RELATED LINKS
Edit Strings and Tuning dialog on page 154
Fretboard panel on page 208
Chord symbols on page 871
Chord diagrams on page 894
Tablature on page 1330
Guitar bends on page 1122
Guitar techniques on page 1137
Fretted instrument tuning on page 153
Defining capos for chord symbols/diagrams on page 163
Defining capos for used chord diagrams grids on page 165
Layouts on page 174
Making layouts transposed/concert pitch on page 178
Assigning players to layouts on page 176

Capo vs. main chords
For the same chord symbol, Dorico Elements can show its original pitch only, its sounding pitch 
based on the defined capo only, or both with capo chords above or below main chords.

Main chord
The original chord symbol you input. Its displayed pitches depend on whether the 
layout is transposing or concert pitch, and whether the layout uses fretted instrument 
transpositions for main chord symbols. For example, in the transposed pitch part 
layout for a trumpet in B♭, a C7 chord symbol appears as D7.

Capo chord
The chord that the fretted instrument must play in order to produce the desired main 
chord, according to the fret position of the capo. For example, if a guitarist with a capo 
on the second fret plays Gm7, the chord that sounds is Am7.

By default, capo chords appear in italics when shown alongside main chords.

TIP

You can choose to show capo chords in parentheses instead and change the vertical gap 
between capo and main chord symbols in the Capo section of the Chord Symbols Options 
dialog.

RELATED LINKS
Concert vs. transposed pitch on page 178
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Changing fretted instrument transpositions on page 161
Hiding/Showing capo chord symbols on page 163
Hiding/Showing capo chord symbols in used chord diagrams grids on page 166
Respelling chord symbols on page 884
Chord symbol appearance presets on page 872
Chord symbol font styles on page 877

Adding capos to fretted instruments
You can add capos to individual fretted instruments. This affects the pitches shown on tablature 
for the corresponding instruments, as Dorico Elements treats capos as fret 0. For example, if 
each flow in a project for guitar requires a capo at a different fret, you might add multiple 
players, each holding a guitar instrument with the required capo.

NOTE

These steps do not affect pitches on notation staves, chord symbols/diagrams in the music, or 
used chord diagram grids.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument to which you want to add a capo.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. In the Capo and Transposition section, click Capo to open the Capo Definition dialog.

4. Choose one of the following options for Capo:

● Full Capo

● Partial Capo

5. Change the fret position of the capo by changing the value for Fret.

6. Optional: If you chose Partial Capo, change the strings across which the capo extends.

7. Click OK to save your changes and close the Capo Definition dialog.

8. Click OK to save your changes and close the Edit Strings and Tuning dialog.

RESULT
A capo is added to the selected instrument according to your settings. The capo appears at the 
corresponding fret position and crossing the specified strings in the Edit Strings and Tuning 
dialog and in the Fretboard panel for the selected instrument.
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EXAMPLE

No capo Capo added to the third fret

RELATED LINKS
Players panel on page 110
Edit Strings and Tuning dialog on page 154
Fretboard panel on page 208
Changing fretted instrument transpositions on page 161
Defining capos for chord symbols/diagrams on page 163
Defining capos for used chord diagrams grids on page 165

Capo Definition dialog
The Capo Definition dialog allows you to add full and partial capos to fretted instruments.

● You can open the Capo Definition dialog from inside the Edit Strings and Tuning dialog by 
clicking Capo in the Capo and Transposition section.

The Capo Definition dialog contains the following options:

Capo
Allows you to choose one of the following capo types:

● None

● Full Capo

● Partial Capo

Fret
Allows you to change the fret position of the capo.

From string [n] to [n]
Allows you to set the first and last strings across which the capo extends. Only available 
when Partial Capo is chosen for Capo.

Setup mode
Capos 

160
Dorico Elements 5.1.30



Removing capos from fretted instruments
You can remove capos from individual fretted instruments. This affects the pitches shown on 
tablature for the corresponding instruments.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument whose capo you want to remove.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. In the Capo and Transposition section, click Capo to open the Capo Definition dialog.

4. Choose None for Capo.

5. Click OK to save your changes and close the Capo Definition dialog.

6. Click OK to save your changes and close the Edit Strings and Tuning dialog.

Changing fretted instrument transpositions
You can change the transposition of individual fretted instruments; for example, to reflect capos 
added to them, or for a fretted instrument whose strings have all been detuned. This can affect 
the pitches shown on notation staves and in main chord symbols in the music, depending on 
your per-layout setting for using fretted instrument transpositions.

NOTE

● You can find different tunings for each fretted instrument in the instrument picker.

● You can also change the open pitch of individual fretted instrument strings.

● Fretted instrument transpositions do not affect pitches shown on tablature, which use the 
instrument’s capo, or used chord diagram grids.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the fretted 
instrument whose transposition you want to change.

2. In the instrument label, click the instrument menu  and choose Edit Strings and Tuning to 
open the Edit Strings and Tuning dialog.

3. In the Capo and Transposition section, change the pitch for In staff notation, written 
middle C (MIDI note 60) sounds as.

The pitch determines the spelling of notes and chord symbols for the corresponding number 
of half-steps.

4. Click OK to save your changes and close the dialog.

RELATED LINKS
Players panel on page 110
Edit Strings and Tuning dialog on page 154
Instrument picker on page 112
Changing the open pitches of fretted instrument strings on page 156
Making layouts transposed/concert pitch on page 178
Changing the middle C numbering convention on page 51
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Using fretted instrument transpositions
You can show transposed pitches on notation staves and in main chord symbols, according to 
the corresponding fretted instrument’s transposition, in each layout independently and for each 
player holding at least one fretted instrument independently.

For example, if you have added a capo to a fretted instrument and want notation staves and 
main chord symbols to show the pitches the performer must play in order to produce the desired 
sounding pitch.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to use fretted instrument 
transpositions for notation staves and main chord symbols.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Fretted Instruments section, activate Use fretted instrument transposition for 
each player holding at least one fretted instrument in your project.

5. Choose one of the following options:

● For notation

● For notation and main chord symbols

6. Click Apply, then Close.

RESULT
Transpositions set for the corresponding fretted instruments are used for either notation staves 
only or both notation staves and main chord symbols in the selected layouts.

For example, you might choose For notation for fretted instruments with capos that are set 
to show capo chord symbols, and For notation and main chord symbols for detuned fretted 
instruments.

EXAMPLE

Fretted instrument transposition 
(reflecting capo at fret 3) not used 
for notation staff or main chord 
symbols

Fretted instrument transposition 
used for notation staff only

Fretted instrument transposition 
used for notation staff and main 
chord symbols

RELATED LINKS
Layout Options dialog on page 745
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Players on page 123
Capo vs. main chords on page 158
Chord symbols on page 871
Hiding/Showing notation staves and tablature on page 1331
Hiding/Showing capo chord symbols on page 163

Defining capos for chord symbols/diagrams
You can define capos for chord symbols and chord diagrams on a per-player basis. This affects 
chord diagram shapes and the transposition of capo chord symbols. For example, you might 
show both main and capo chord symbols for the voice player when creating a lead sheet.

NOTE

These steps do not affect used chord diagram grids or pitches on notation staves/tablature.

PROCEDURE

1. In Setup mode, select a player in the Players panel for whom you want to define a capo for 
chord symbols/diagrams.

2. In the action bar, click Player Settings  and choose Chord Symbols > Capo Chord Symbol 
Definition to open the Capo Chord Symbol Definition dialog.

TIP

You can also right-click players and choose this option from the context menu.

3. Change the pitch for In capo chord symbols, written middle C (note 60) sounds as.

The pitch determines the spelling of capo chord symbols for the corresponding number of 
half-steps.

4. Click OK to save your changes and close the dialog.

RESULT
A capo with the set transposition and spelling is set for the selected player.

Hiding/Showing capo chord symbols
You can show only main chords, only capo chords, or both in chord symbols on a per-player 
basis. For example, if you want to show both for the guitar player but only main chords for the 
singer.

NOTE

Chord diagrams always reflect the capo set for the player.

PROCEDURE

1. In Setup mode, select a player in the Players panel for whom you want to hide/show capo 
chords in chord symbols.

2. In the action bar, click Player Settings  and choose one of the following options:

● To show only main chords, choose Chord Symbols > Show Main Chord Symbol for 
Capo.
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● To show only capo chords, choose Chord Symbols > Show Transposed Chord Symbol 
for Capo.

● To show capo chords above main chords, choose Chord Symbols > Show Capo Chord 
Symbol Above Main.

● To show capo chords below main chords, choose Chord Symbols > Show Capo Chord 
Symbol Below Main.

TIP

You can also right-click players and choose these options from the context menu.

RESULT
Main and/or capo chords are shown in chord symbols, according to the instrument staves and 
layouts set to show chord symbols for the selected player. By default, capo chords appear in 
italics when shown alongside main chords.

In layouts where chord symbols are only shown above the top staff in each system, the visibility 
of main/capo chords in chord symbols is determined by the setting for the player at the top of 
each system.

EXAMPLE

Main chords shown only Capo chords shown only Capo chords shown 
above main chords

Capo chords shown 
below main chords

RELATED LINKS
Capo vs. main chords on page 158
Positions of chord symbols on page 878
Hiding/Showing chord symbols on page 878
Hiding/Showing chord symbols in layouts on page 879
Showing chord symbols above one/multiple staves on page 880
Changing the vertical alignment of chord symbols on page 881
Changing the arrangement of compound chord symbols on page 887
Hiding/Showing empty staves on page 605
Showing only chord symbols or chord diagrams on page 897
Hiding/Showing chord diagrams on page 895
Chord symbol appearance presets on page 872
Chord symbol font styles on page 877
Inputting chord symbols on page 318

Showing only main or capo chord symbols
You can show only the main or capo chord in individual chord symbols on staves set to show 
both. For example, if you want to show both the first time each chord symbol appears but only 
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show main chords for subsequent instances. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The players on whose staves you want to show only main or capo chords are set to show 
both.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols whose shown chords you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Show only in the Chord Symbols group.

3. Choose one of the following options:

● Main Chord

● Capo Chord

RESULT
The selected chord symbols show only main or capo chords. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Both main and capo chords shown in all chord 
symbols

Only main chords shown in some chord symbols

Defining capos for used chord diagrams grids
You can define capos for used chord diagrams grids in each layout independently. This affects 
chord diagram shapes and the transposition of capo chord symbols. For example, you might 
show both main and capo chord symbols in used chord diagrams grids in the voice part layout 
when creating a lead sheet.

NOTE

These steps do not affect chord symbols/diagrams in the music or pitches on notation staves/
tablature.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.
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2. In the Layouts list, select the layouts for which you want to define capos for used chord 
diagrams grids.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Diagrams section, change the pitch for Use capo with transposition.

The pitch determines the spelling of capo chord symbols for the corresponding number of 
half-steps.

5. Click Apply, then Close.

RELATED LINKS
Used chord diagrams grids on page 898
Capo vs. main chords on page 158
Adding capos to fretted instruments on page 159
Inputting chord symbols on page 318

Hiding/Showing capo chord symbols in used chord diagrams grids
You can show only main chords, only capo chords, or both in used chord symbol grids in each 
layout independently. For example, if you want to show both in the guitar part layout but only 
main chords in the vocal part layout.

NOTE

Chord diagrams in used chord diagrams grids always reflect the capo set for the layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show capo chord symbols in 
used chord diagrams grids.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Diagrams section, select one of the following options from the Capo chord 
symbols menu:

● To show only main chords, select Show Only Main Chord Symbol.

● To show only capo chords, select Show Only Transposed Chord Symbol.

● To show capo chords above main chords, select Show Above Main Chord Symbol.

● To show capo chords below main chords, select Show Below Main Chord Symbol.

5. Click Apply, then Close.

RESULT
Main and/or capo chords are shown in used chord diagrams grids in the selected layouts. By 
default, capo chords appear in italics when shown alongside main chords.
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Player groups
A player group represents a collection of musicians that are considered together, such as one 
choir in a work for double choir or an off-stage ensemble. Player groups can have their own 
brackets, depending on the bracket grouping set for each layout.

Grouping players together means they are positioned together in the default player order, 
numbered independently of players outside the group, and are bracketed together according 
to the ensemble type set for each layout.

For example, if your project is for double choir (SATB/SATB), all voices are joined by a single 
bracket by default because they are in the same family. However, if you add each choir to its own 
group, they are bracketed separately. This is useful in works containing multiple groups, such as 
in Britten's “War Requiem”, which has three distinct groups, or in Walton's “Belshazzar's Feast” 
which requires two separate off-stage brass groups.

Two choir player groups in the Players panel in Setup mode

You can add as many player groups as required; for example, to allow easy separation of 
forces, or to prevent automatic instrument numbering for percussion instruments when multiple 
percussion players hold the same instrument to accommodate instrument changes.

You can also show player group labels for player groups in each layout independently.

RELATED LINKS
Instrument numbering on page 131
Brackets according to ensemble type on page 866
Changing the default player order on page 125
Setting custom player orders on page 126
Player group labels on page 1317
Player, layout, and instrument names on page 181
Players panel on page 110
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Adding player groups
You can organize players into groups; for example, if you want to bracket them together. Players 
in different groups are also numbered separately.

PROCEDURE

1. Optional: If you want to add a group that includes existing players, select those players in 
the Players panel in Setup mode.

2. In the Players panel, click Add Group .

RESULT
A new player group is added to the Players panel. If you selected players, those players are 
added to the group. If you did not select players, the new group is empty.

AFTER COMPLETING THIS TASK

● You can add players to groups and move them between groups.

● You can rename player groups and show player group labels.

RELATED LINKS
Players panel on page 110
Adding players to groups on page 168
Moving players between groups on page 170
Renaming player groups on page 169
Player group labels on page 1317

Adding players to groups
You can add new players to existing player groups.

PROCEDURE

1. In Setup mode, in the Players panel, select the group to which you want to add new players.

2. Add new players in one of the following ways:

● To add a single player, click Add Single Player  in the action bar.

● To add a section player, click Add Section Player  in the action bar.

The instrument picker opens.

TIP

You can also open the instrument picker by selecting an existing player in the Players panel 
and pressing Shift-I .

3. Select the instrument you want in the instrument picker.

4. Press Return  to add the selected instrument.

RESULT
The corresponding type of player is added to the selected group.

TIP

You can also move existing players to, from, or between groups.

Setup mode
Player groups 

168
Dorico Elements 5.1.30



RELATED LINKS
Players panel on page 110
Instrument picker on page 112
Adding players on page 124
Moving players between groups on page 170
Player group labels on page 1317
Changing the language for instrument names on page 57

Renaming player groups
You can change the name of player groups after you have added them. This changes the name 
shown in player group labels.

PROCEDURE

1. In Setup mode, in the Players panel, select the player group you want to rename.

2. In the action bar, click Player Settings  and choose Rename Player Group to open the 
Rename Player Group dialog.

TIP

You can also right-click player groups and choose this option from the context menu.

3. Enter new names or edit the existing names in the following fields:

● Full name

● Short name

4. Click OK to save your changes and close the dialog.

RESULT
The corresponding names for the selected player group are changed.

Player group labels show full player group names by default. Short player group names are used 
when the full player group name is longer than the bracket.

RELATED LINKS
Players panel on page 110
Player group labels on page 1317
Player, layout, and instrument names on page 181

Deleting player groups
You can delete groups of players; for example, if you no longer need a group of players that you 
created when importing a MIDI file. When deleting player groups, you can choose to keep the 
players within the group or delete them as well.

PROCEDURE

1. In Setup mode, in the Players panel, select the player groups that you want to delete.

2. Delete the selected player groups in any of the following ways:

● Press Backspace or Delete .

● In the Players panel, click Delete Player .

3. Choose one of the following options in the warning message that appears:
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● To delete the selected player groups but keep the players within them, choose Keep 
Players.

● To delete both the selected player groups and the players within them, choose Delete 
Players.

Moving players between groups
You can move players to, from, or between player groups. For example, you can move 
ungrouped players into existing groups and move players from one group to another.

PROCEDURE

1. In Setup mode, in the Players panel, select the players that you want to move.

2. Click and drag the selected players to the position you want.

An insertion line indicates where the players will be positioned.

RESULT
The players are moved to the new position.

TIP

● You can also add existing players to existing groups by right-clicking them in the Players 
panel and choosing Add Player to Group > [Group] from the context menu.

● You can also add new players to player groups.

RELATED LINKS
Adding players to groups on page 168

Removing players from groups
You can remove players from groups.

PROCEDURE

● In Setup mode, in the Players panel, remove players from groups in any of the following 
ways:

● Select multiple players, then click and drag them out of the group.

● Select one player, then click Player Settings  in the action bar and choose Remove 
Player from Group. You can also right-click players and choose this option from the 
context menu.

RESULT
The players are removed from their groups but remain in the project as individual players.
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Flows
Flows are separate spans of music that are completely independent in musical content, meaning 
they can contain completely different players from each other and have different time signatures 
and key signatures. A single project can contain any number of flows.

Depending on the purpose of each project, a flow could be, for example, a single song in an 
album, a movement in a sonata or symphony, a number in a stage musical, or a short scale or 
sight-reading exercise of only a few bars in length.

Dorico Elements automatically adds a flow to projects once you have added at least one player. 
You cannot add flows until you have added at least one player to the project.

When you add a flow in Dorico Elements, the following happens automatically:

● The flow is assigned to all full score and part layouts in the project.

● All players are assigned to the new flow.

By default, all layouts include all flows in the project. If necessary, you can change the layouts to 
which flows are assigned and which players are assigned to flows.

IMPORTANT

If you exclude a player from a flow, any notes that you have already input for that player in that 
flow are deleted.

You can change notation options, such as beam grouping and accidental duration rules, for each 
flow independently in the Notation Options dialog.

RELATED LINKS
Flows panel on page 120
Notation Options dialog on page 747
Players on page 123
Layouts on page 174
Tacets on page 640
Players, layouts, and flows on page 121
Importing flows on page 78
Exporting flows on page 80
Starting new projects on page 71
Opening projects/files on page 72
Changing the gap between flows in playback on page 545
Flow headings on page 651

Adding flows
You can add any number of new flows to your project; for example, when engraving a large work 
that comprises multiple movements.

PROCEDURE

● In Setup mode, add a flow in any of the following ways:

● Press Shift-F .

● In the Flows panel, click Add Flow .
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RESULT
A new flow is added to your project. All existing players are assigned to new flows, and new flows 
are automatically assigned to all existing full score and part layouts.

AFTER COMPLETING THIS TASK

● You can rename the flow.

● You can change the players assigned to the flow and the layouts to which the flow is 
assigned.

RELATED LINKS
Flows panel on page 120
Importing flows on page 78
Exporting flows on page 80
Starting new projects on page 71
Opening projects/files on page 72
Renaming flows on page 188
Adding players on page 124
Assigning players to flows on page 172
Assigning flows to layouts on page 177
Adding titles on page 997

Duplicating flows
You can duplicate flows; for example, if you want to experiment with some ideas without 
affecting the original flow, or if you want to copy material with any barlines you have added.

PROCEDURE

1. In Setup mode, in the Flows panel, right-click the flow that you want to duplicate.

2. Choose Duplicate Flow from the context menu.

RESULT
A new flow is added, containing all the music and players of the original flow. It is automatically 
added to all full score and part layouts.

Assigning players to flows
By default, all players in your project are added to all flows that originated in the project. You can 
assign players to and remove players from flows manually; for example, if the soloists in a choral 
work do not sing for an entire flow.

NOTE

If you remove a player from a flow, any notes you have already input for that player in that flow 
are deleted.

PROCEDURE

1. In Setup mode, in the Flows panel, select the flow whose assigned players you want to 
change.

2. In the Players panel, activate the checkbox in the card of each player you want to assign to 
the flow.
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TIP

You can Shift -click to activate/deactivate the checkboxes in multiple player cards at once.

RESULT
Players are assigned to the selected flow when the checkbox in their player card is activated, and 
removed from the flow when the checkbox is deactivated.

RELATED LINKS
Flows panel on page 120
Tacets on page 640
Assigning flows to layouts on page 177
Assigning players to layouts on page 176

Reordering flows
You can change the order of flows; for example, if you want an imported flow to be the first flow 
rather than the last.

PROCEDURE

1. In Setup mode, in the Flows panel, select the flows whose order you want to change.

2. Click and drag the selected flows to the right/left.

RESULT
The selected flows are moved to the specified position. Their flow numbers are automatically 
updated, as is their order in the Project Info dialog and in layouts by default.

TIP

You can also reorder flows in the Project Info dialog by selecting them in the flows list and 
clicking Move Down  or Move Up  in the action bar. This can be an easier method of 
reordering flows in projects that contain many flows.

RELATED LINKS
Project Info dialog on page 75
Flow names and flow titles on page 187
Importing flows on page 78
Flow headings on page 651
Tokens on page 655
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Deleting flows
You can delete flows that you no longer need. This deletes all music for all instruments and 
players in the flows.

PROCEDURE

1. In Setup mode, in the Flows panel, select the flows you want to delete.

2. Delete the selected flows in any of the following ways:

● Press Backspace or Delete .

● In the Flows panel, click Delete Flow .

RELATED LINKS
Importing flows on page 78
Exporting flows on page 80

Layouts
Layouts combine musical content, as represented by flows and players, with rules for page 
formatting and music engraving, and allow you to produce paginated music notation that can be 
printed or exported in various formats. For example, part layouts typically only show the music 
for one player, whereas full score layouts show the music of all players in the project.

Layouts can contain any combination of players and flows. They share the musical content of 
these players and flows, such as the notes each instrument plays. For example, when you change 
the pitch of a note in the full score, that note’s pitch is also updated in the corresponding part 
layout.

You can control practically every aspect of page formatting in each layout independently, 
including note spacing, staff size, page size, margins, and casting off; that is, the positions of 
system breaks and page turns. Changing these aspects in one layout does not affect other 
layouts. For example, inserting systems breaks in a part layout does not change the casting off in 
the full score.

Similarly, you can change the visual appearance of many items only in one layout, without 
affecting other layouts, using local properties. For example, you can hide text items in the full 
score layout but show them in part layouts.

The default formatting of pages in layouts is determined by page templates. By default, full score 
layouts use a different page template set to part layouts; however, you can apply a different page 
template set to each layout.

Dorico Elements provides the following layout types:

Full score
A full score layout includes all players and all flows in your project by default. Full score 
layouts are concert pitch by default.

Dorico Elements automatically creates a single full score layout in every project.

Part
A part layout is automatically created when you add a player to your project. You can 
also create empty part layouts and assign players to them manually.

By default, instrumental part layouts contain all flows. They are also transposed pitch 
by default.

You can propagate the formatting of part layouts.
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Custom score
A custom score layout initially does not contain any players or flows. This allows you 
to create your score manually and, for example, assign only one flow instead of all 
flows or only vocal and piano players to create a vocal score. Custom score layouts are 
concert pitch by default.

TIP

● You can create as many layouts of each type in each project as required.

● You can combine players, layouts, and flows together in any combination. For example, 
you might add all percussion players to a single part layout so that the performers can 
manage instrument changes themselves. In a large-scale work, you might also create a 
piano reduction for choir rehearsals, but only assign that piano player to the vocal score, 
meaning it does not appear in the orchestral full score at all.

● By default, respelling notes in score layouts also affects their spelling in all other layouts, but 
respelling notes in part layouts only affects their spelling in the current part layout.

● You can save options set in Layout Options as the default for score and part layouts 
independently. For example, full scores and part layouts often require different page and 
staff sizes.

● Deleting layouts does not delete any music from the project.

RELATED LINKS
Page formatting on page 598
Part formatting propagation on page 643
Flows on page 171
Players on page 123
Players, layouts, and flows on page 121
Page templates on page 647
Page template sets on page 647
Types of page templates on page 648
Applying page template sets to layouts on page 601
Properties on page 663
Local vs. global properties on page 664
Layout Options dialog on page 745
Player, layout, and instrument names on page 181
Renumbering layouts on page 180
Renaming layouts on page 183
Hiding/Showing borders on layout names on page 1001
Switching between layouts on page 43
Switching to galley/page view on page 50
Hiding/Showing staff labels on page 1310
Brackets according to ensemble type on page 866
Casting off on page 629
Condensing on page 643
Divisi on page 1329
Editing layout transposition text on page 1000
Respelling notes on page 473
Hiding/Showing text items on page 1362
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Creating layouts
You can create any number of full score, custom score, and part layouts in each project. By 
default, Dorico Elements creates a single full score layout and a part layout for each player.

PROCEDURE

● In Setup mode, in the Layouts panel, click one of the following layout types:

● Add Full Score Layout 

● Add Instrumental Part Layout 

● Add Custom Score Layout 

RESULT
The layout is added to the list of layouts in the Layouts panel.

NOTE

● Layouts are not available in the layout selector until you have assigned at least one player to 
them.

● You can also add new custom score layouts by pressing Shift-L .

AFTER COMPLETING THIS TASK

● You can assign players and flows to the layout.

● If you want to change the position of the new layout in the layouts list, you can reorder and 
renumber layouts.

RELATED LINKS
Layouts panel (Setup mode) on page 117
Workspace options on page 31
Reordering layouts on page 179
Renumbering layouts on page 180
Switching between layouts on page 43
Switching to galley/page view on page 50
Opening new tabs on page 45

Assigning players to layouts
By default, all players are included in full score layouts and each player is automatically assigned 
its own part layout. You can assign players to and exclude players from layouts manually; for 
example, if you want to remove unnecessary players from the full score, or you want to add the 
soloists’ music to the part for the accompanist.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layout whose assigned players you want to 
change.

2. In the Players panel, activate the checkbox in the card of each player you want to assign to 
the layout.
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TIP

You can Shift -click to activate/deactivate the checkboxes in multiple player cards at once.

RESULT
Players are assigned to the selected layout when the checkbox in their player card is activated, 
and removed from the layout when the checkbox is deactivated. If you have not changed the 
name of the layout, it is automatically updated to reflect the players included in the layout.

RELATED LINKS
Project window in Setup mode on page 109
Player, layout, and instrument names on page 181
Renaming layouts on page 183
Assigning players to flows on page 172

Assigning flows to layouts
By default, all flows in your project are added to all full score and part layouts. You can assign 
flows to and remove flows from layouts manually; for example, if a flow in your project contains 
specific performance instructions for strings that you want to show in string part layouts but not 
in other part layouts.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layout whose assigned flows you want to 
change.

2. In the Flows panel, activate the checkbox in the flow card of each flow you want to assign to 
the layout.

TIP

You can Shift -click to activate/deactivate the checkboxes in multiple flow cards at once.

RESULT
Flows are assigned to the selected layout when the checkbox in their flow card is activated, and 
removed from the layout when the checkbox is deactivated.

Dorico Elements automatically creates enough pages to display the flows assigned to the layout.

RELATED LINKS
Project window in Setup mode on page 109
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Making layouts transposed/concert pitch
You can change whether each layout in your project is transposed or concert pitch. In Dorico 
Elements, full score layouts are concert pitch and part layouts are transposed pitch by default.

For example, full scores are often concert pitch, to show notes at their sounding pitch, but part 
layouts are transposed pitch so the player can read the notes they must play in order to achieve 
the desired sounding pitch.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts you want to make transposing/non-transposing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Players section, activate/deactivate Transposing layout.

5. Click Apply, then Close.

RESULT
The selected layouts are transposed pitch when Transposing layout is activated, and concert 
pitch when it is deactivated.

TIP

You can also change the transposition of the layout currently open in the music area in the 
following ways:

● To make layouts transposed pitch, choose either Transposed Pitch in the status bar or 
Edit > Transposed Pitch.

● To make layouts concert pitch, choose either Concert Pitch in the status bar or Edit > 
Concert Pitch.

RELATED LINKS
Status bar on page 38
Transposing instruments on page 132
Fretted instrument tuning on page 153
Transposing selections on page 469
Changing the input pitch setting on page 215
Hiding/Showing clefs according to layout transpositions on page 910
Editing layout transposition text on page 1000

Concert vs. transposed pitch
Layouts in Dorico Elements can use concert or transposed pitch. This affects the pitches and key 
signatures on staves belonging to transposing instruments.

Concert pitch
When music is in concert pitch, all notes are written as they sound. This means that 
players with transposing instruments reading music in concert pitch must transpose 
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the music themselves. For example, if a clarinet in B♭ reads a C in concert pitch, they 
must play the note D on their instrument to produce the sounding note C.

Transposed pitch
When music is in transposed pitch, the notes written are the ones each instrument 
must play in order to produce the desired sounding pitch. For example, if a clarinet in 
B♭ reads a D in transposed pitch, the pitch that sounds from the instrument is C.

Transposed pitch layouts automatically transpose key signatures and chord symbols according to 
the transposition of the instrument. Transposing and concert pitch layouts can also use different 
clefs.

RELATED LINKS
Transposing selections on page 469
Enharmonic equivalent key signatures on page 1025
Clefs with octave indicators on page 913
Capo vs. main chords on page 158
Editing layout transposition text on page 1000

Reordering layouts
You can change the order in which layouts appear in the Layouts panel and the layout selector; 
for example, if you added a custom score layout and want it to be positioned at the top next to 
the full score layout.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layouts whose order you want to change.

2. Click and drag the selected layouts upwards/downwards.

RESULT
The selected layouts are moved to the specified position. This does not affect their layout 
numbers.

TIP

You can also automatically sort layouts according to their type by clicking Sort Layouts  in the 
Layouts panel, which positions all full score layouts at the top, all part layouts in the middle, and 
all custom score layouts at the bottom.

You can click and hold or right-click Sort Layouts  to change the setting to one of the following 
options:

● Layout Number

● Instrument Score Order

RELATED LINKS
Layouts panel (Setup mode) on page 117
Changing the default player order on page 125
Renumbering instruments on page 132
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Renumbering layouts
You can renumber all layouts according to their current position in the Layouts panel in Setup 
mode; for example, after you have dragged layouts to different positions.

PROCEDURE

1. In Setup mode, in the Layouts panel, select any layout.

2. In the action bar, click Layout Settings  and choose Renumber Layouts.

TIP

You can also right-click layouts and choose this option from the context menu.

RESULT
All layouts are renumbered according to their current position in the panel. Full score layouts, 
custom score layouts, and part layouts are all numbered separately.

Deleting layouts
You can delete layouts without removing the corresponding music from the project. For example, 
if you only want to use a combined Violin I and II part layout, you can delete their separate part 
layouts.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layouts that you want to delete.

2. Delete the selected layouts in any of the following ways:

● Press Backspace or Delete .

● In the Layouts panel, click Delete Layout .

RESULT
The selected layouts are deleted without removing any music from the project.

AFTER COMPLETING THIS TASK
You can later restore all the part layouts that Dorico Elements provides by default.

RELATED LINKS
Layouts panel (Setup mode) on page 117
Players, layouts, and flows on page 121

Restoring default layouts
You can recreate all the part layouts that Dorico Elements provides by default; for example, if you 
accidentally deleted some part layouts.

PROCEDURE

● In Setup mode, choose Setup > Create Default Part Layouts.

RESULT
The default set of part layouts is restored, recreating a single part layout for each player that 
contains all flows in the project. Any part layouts that were recreated are added at the bottom 
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of the Layouts list. Their order matches the order of the corresponding players in the Players 
panel.

Player, layout, and instrument names
In Dorico Elements, you can use three different names to refer to the same player in different 
contexts. This allows you to show relevant information in different places, such as in staff labels 
and at the top of part layouts.

The following names relate to players and instruments:

Player name
The name of each player in the Players panel. They can be used in staff labels instead 
of instrument names.

Player names are automatically generated when you add instruments, and are linked 
to the corresponding instrument names until you rename the player.

Layout name
The name for each layout in the Layouts panel. By default, layout names appear with 
borders at the top of pages in part layouts that use the First page template.

Layout names for part layouts are automatically linked to the corresponding players’ 
names until you rename the layout.

Instrument names
Used in staff labels by default. This means that the instrument label on each staff 
is relevant to the instrument or percussion kit currently being played by that player, 
rather than listing all instruments that player is playing in the flow.

For example, if a clarinettist is doubling bass clarinet, the staff label where the player 
plays clarinet automatically shows Clarinet, and the staff label automatically shows 
Bass Clarinet where the player plays bass clarinet.

All instruments in Dorico Elements come with a set of instrument names that you 
can change for individual instruments, independently of other players in the project 
holding the same instrument. You can change the language used for instrument 
names. You can also save changes to instrument names as default, which are then 
used whenever you add that instrument again in the current project and all future 
projects.

NOTE

● Changing the default instrument names does not change the instrument names of 
existing instruments of that type in your project.

● You can change various aspects of how instrument names appear in staff labels 
without changing instrument names, such as whether instrument transpositions 
are shown before or after instrument names.

RELATED LINKS
Instrument numbering on page 131
Types of page templates on page 648
Tokens on page 655
Staff labels on page 1309
Percussion legends on page 1430
Assigning players to layouts on page 176
Renaming player groups on page 169
Changing the language for instrument names on page 57
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Renaming players
You can change the player names of players, and reset renamed players to their default names. 
Player names appear in guide instrument labels in galley view for players holding multiple 
instruments and can appear in staff labels.

PROCEDURE

1. In Setup mode, in the Players panel, select the player you want to rename.

2. In the action bar, click Player Settings  and choose Rename Player to open the Rename 
Player dialog.

TIP

You can also right-click players and choose this option from the context menu.

3. Enter new names or edit the existing names in the following fields:

● Full name

● Short name

4. Click OK to save your changes and close the dialog.

RESULT
The corresponding names for the selected player are changed. If you have not already renamed 
the corresponding part layout, its layout name is updated.

NOTE

● This does not affect staff labels that show instrument names, or the name at the top of 
part layouts if you have already renamed the layout. You can change instrument and layout 
names separately.

● Player names you have changed no longer get updated when you change the instruments or 
names of instruments held by the player.

RELATED LINKS
Players panel on page 110
Renaming player groups on page 169
Adding instruments to players on page 133
Designating players as soloists on page 127
Showing instrument/player names in staff labels on page 1313
Switching to galley/page view on page 50

Resetting player names
You can reset both full and short player names to their defaults simultaneously. Default player 
names automatically update when you change the instruments or names of instruments held by 
the player.

PROCEDURE

1. In Setup mode, in the Players panel, select the player whose names you want to reset.

2. Press Return  to open the player name text field.

3. Click Reset to Default .
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RESULT
Both the full and short names for the corresponding player are reset to their defaults.

Renaming layouts
You can rename layouts and reset renamed layouts to their default name. By default, layout 
names appear with borders at the top of pages in part layouts that use the First page template.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the layout you want to rename.

2. Press Return  to open the layout name text field.

3. Rename the layout in any of the following ways:

● Enter a new layout name, or edit the existing name.

● To revert the layout name to the player name, click Reset to Default .

TIP

If you want to include an accidental in the instrument transposition, you can enter the 
appropriate token, such as {@flat@} for ♭.

4. Press Return .

RESULT
The selected layout is renamed, or reverted to its default name.

NOTE

● Renaming layouts does not affect staff labels, which show either instrument or player 
names.

● Part layout names you have changed no longer get updated when you rename the 
corresponding players.

RELATED LINKS
Layouts panel (Setup mode) on page 117
Tokens on page 655
Types of page templates on page 648
Hiding/Showing borders on layout names on page 1001
Staff label contents on page 1313

Changing instrument names
By default, instrument names are used in staff labels and instrument change labels shown above 
the staff. You can change the different instrument names used for each instrument.

NOTE

● If you want to change instrument names because you want them to appear in a different 
language, you can instead change the default language for all instrument names.

● You can change various aspects of how instrument names appear in staff labels without 
changing instrument names, such as whether instrument transpositions are shown before 
or after instrument names.
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● Changing instrument names does not automatically update player and layout names if you 
have already renamed them.

PROCEDURE

1. In Setup mode, in the Players panel, click the disclosure arrow in the card of the player 
holding the instrument whose names you want to change.

This expands the card to show the instruments held by the player.

2. In the instrument label, click the instrument menu  and choose Edit Names to open the 
Edit Instrument Names dialog.

3. Enter new names in any of the name fields.

4. Choose one of the following options for Show transposition:

● Always

● Follow Layout Options

● Never

5. Optional: Activate Save as default for instrument.

6. Click OK to save your changes and close the dialog.

RESULT
The instrument names for the selected instrument are changed. If you have not already renamed 
the corresponding player, its player name is updated.

● If you did not save your changes as default, only the names of the selected instrument are 
changed. Any instruments of the same type added later or in future projects use the original 
default names.

● If you saved your changes as default, any instruments of the same type added later 
or in future projects use your new instrument names. This does not affect any existing 
instruments of that type unless you reset their names.

RELATED LINKS
Players panel on page 110
Showing instrument/player names in staff labels on page 1313
Changing the appearance/position of instrument transpositions in staff labels on page 1315
Changing the language for instrument names on page 57
Editing the default instrument change label text on page 139

Edit Instrument Names dialog
The Edit Instrument Names dialog allows you to change the content and formatting of each 
instrument’s names, which are used in staff labels and instrument change labels shown above 
the staff. You can edit both singular/plural full instrument names and singular/plural short 
instrument names.

● You can open the Edit Instrument Names dialog in Setup mode by clicking the instrument 
menu  in an instrument label in the Players panel and choosing Edit Names.
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The Edit Instrument Names dialog contains the following options and sections:

1 Editing instrument

Displays the permanent underlying name of the instrument.

2 Editing

Allows you to switch between editing the Singular names and Plural names of the selected 
instrument.

Singular names are used when the staff contains one player, Plural names are used when 
the staff contains multiple players.

3 Full name section

Contains options that allow you to edit the appearance of the full instrument name.

4 Full name text editor options

Allows you to customize the font, size, and formatting of the selected part of the full 
instrument name.

5 Full name text editing area

Shows the current long name for the selected instrument, as it appears in Full staff labels. 
You can select any part of the instrument name and edit it independently of other parts; for 
example, if you want to add additional information on a new line and in italics. However, 
instrument names in instrument change labels are always shown on a single line.

Staff labels are right-aligned by default, so they appear at the right edge of the text editing 
area.

6 Short name section

Contains options that allow you to edit the appearance of the short instrument name.

7 Short name text editor options
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Allows you to customize the font, size, and formatting of the selected part of the short 
instrument name.

8 Short name text editing area

Shows the current short staff label for the selected instrument, as it appears in Abbreviated 
staff labels. You can select any part of the instrument name and edit it independently of 
other parts; for example, if you want to add additional information on a new line and in 
italics. However, instrument names in instrument change labels are always shown on a 
single line.

Staff labels are right-aligned by default, so they appear at the right edge of the text editing 
area.

9 Show transposition

Allows you to choose when the transposition is shown in the instrument name for the 
selected instrument. It is common to see the transposition included in the name of 
transposing instruments, such as Clarinet in B♭.
You can choose when the transposition is shown from the following options:

● Always: Instrument transpositions are shown even if you have chosen to hide them on 
the Staves and Systems page in Layout Options.

● Follow Layout Options: Instrument transpositions can be hidden and shown, 
depending on your per-layout settings in Layout Options.

● Never: Instrument transpositions are never shown, even if you have chosen to show 
them in Layout Options.

10 Save as default for instrument

Activating the checkbox saves your changes in the dialog as the default. This affects all new 
instruments of that type that you add to the project and all future projects. It does not affect 
any existing instruments of that type unless you reset their names.

11 Reset to Default

Removes all your changes to the names of the selected instrument type and reverts them to 
the current default settings. If you changed the default name for an instrument type or the 
instrument name language setting after adding an instrument, resetting its names changes 
them to your new default names and language setting.

NOTE

Overrides to the horizontal alignment or leading of instrument names are only used in staff 
labels in simple cases. They are not used for inner, grouped, or condensed staff labels.

RELATED LINKS
Players panel on page 110
Layout Options dialog on page 745
Staff label paragraph styles on page 1318
Hiding/Showing instrument transpositions in staff labels on page 1315
Text editor options in Write mode on page 389
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Resetting instrument names
You can reset all your changes to the names of individual instruments and revert them to the 
current default settings for their instrument type.

NOTE

Resetting instrument names does not change the name shown at the top of part layouts. If you 
want to change the name used at the top of part layouts, rename the layout.

PROCEDURE

1. In Setup mode, in the Players panel, click the disclosure arrow in the card of the player 
holding the instrument whose names you want to reset.

This expands the card to show the instruments held by the player.

2. In the instrument label, click the instrument menu  and choose Edit Names to open the 
Edit Instrument Names dialog.

3. Click Reset to Default.

4. Click OK to save your changes and close the dialog.

RESULT
The instrument names for the selected instrument are reset to the current default settings for 
its instrument type. If you changed the default name for the instrument type or the instrument 
name language setting after adding the instrument, resetting its names changes them to your 
new default names and language setting.

TIP

You can assign a key command for Reset Instrument Names on the Key Commands page in 
Preferences, which resets all instrument names in the project to their default settings.

RELATED LINKS
Players panel on page 110
Key Commands page in the Preferences dialog on page 60
Changing the language for instrument names on page 57

Flow names and flow titles
Whenever you add a flow to a project, the default name of a flow is Flow plus an incremental 
number. In Dorico Elements, flows have both a flow name and a flow title, which are the same by 
default but can be different if, for example, you want to organize sketch versions of flows without 
affecting their displayed titles in the music.

Flow names
Set either in the Flows panel in Setup mode or in the flows list in the Project Info 
dialog.

Flow titles
Set in the Title field for each flow in the Project Info dialog.

Flow titles automatically match the flow name until you change the flow title independently. 
Changing flow titles removes the link between their flow title and flow name.
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Titles shown in layouts are linked to the Title fields in the Project Info dialog, using the 
{@projectTitle@} and {@flowTitle@} tokens. This allows you to organize flows with different 
names to their displayed title in the music.

TIP

You can change both flow names and flow titles in the Project Info dialog, and you can also 
change flow names in the Flows panel in Setup mode.

RELATED LINKS
Tokens on page 655
Project Info dialog on page 75
Flows panel on page 120
Export File Names dialog on page 588
Adding titles on page 997

Renaming flows
You can change the names of flows in Setup mode. This automatically updates the title of the 
corresponding flow until you change the title in the Project Info dialog.

PROCEDURE

1. In Setup mode, in the Flows panel, double-click the card of the flow you want to rename to 
open the flow name text field.

2. Enter a new name for the flow, or edit the existing name.

3. Press Return .

RESULT
The name of the flow is changed. If you have not entered a different title for the flow in the 
Project Info dialog, the title shown in the music area is updated to match the new flow name.

TIP

You can also rename flows in the Project Info dialog.

Changing flow titles
You can change flow titles in the Project Info dialog. Once you have done so, flow titles are no 
longer automatically changed if you change their flow name.

PROCEDURE

1. Press Ctrl/Cmd-I  to open the Project Info dialog.

2. Select the flow whose title you want to change in the flows list.

3. Enter a new title in the Title field.

4. Optional: Repeat steps 2 and 3 for other flows in your project.

5. Click OK to save your changes and close the dialog.

RESULT
The titles of the selected flows are changed.
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NOTE

This breaks the link between flow names and the title shown in the music area.

RELATED LINKS
Project Info dialog on page 75

Videos
Dorico Elements supports the use of videos within the program as well as the associated 
notations, such as markers and timecodes, and allows you to find appropriate tempos based 
on where important markers occur.

Videos in Dorico Elements are shown in a separate Video window and play back in sync with the 
music. Any existing audio in the video is also played back, and you can control the volume of this 
audio independently of the volume of the music.

TIP

You can use these features, including setting a project frame rate, without having a video 
attached.

RELATED LINKS
Timecodes on page 1226
Markers on page 1221
Find Tempo dialog on page 403
Changing the volume of video audio on page 193

Supported video formats
Dorico Elements uses the same video engine that was introduced in Cubase and Nuendo in 2017. 
It supports the most commonly-used video formats.

The following video formats are supported:

● MOV: Including H263, H264, Apple ProRes, DV/DVCPro and Avid DNxHR codecs

● MP4: Including H263 and H264

● AVI: Including DV/DVCPro and MJPEG/PhotoJPEG

All the common frame rates, such as 23.976, 24, 24.975, 25, 29.97, and 30 frames per second, are 
fully supported in Dorico Elements.

NOTE

● Videos with variable frame rates are not supported.

● Support for more formats is planned for future versions.

You can consult the Steinberg support site for more information about the supported formats as 
well as how to identify and change video formats.

RELATED LINKS
Frame rates on page 193
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Video Properties dialog
The Video Properties dialog allows you to change video-related settings, including their frame 
rate and start position.

● You can open the Video Properties dialog in Setup mode by right-clicking a flow in the 
Flows panel and choosing Video > Properties from the context menu.

It also opens automatically when you add a new video.

The Video Properties dialog contains the following fields and options:

Video file
Shows the location of the video file on your computer. This field is read-only.

Video frame rate
Shows the frame rate of the video file. This field is read-only.

Project frame rate
Allows you to select a frame rate for your project from the menu. You can only have a 
single frame rate across the project.

Use video frame rate
Sets the project frame rate to be the same as the video file.

Flow attachment position
Allows you to set the rhythmic position at which the video attaches. This is set using 
the Beat count and Beat unit settings in combination, such as eight dotted quarter 
notes.

Video start offset
Allows you to set a position within the video that syncs with the flow attachment 
position; for example, you can set the fifth second of the video to attach to the start of 
the third bar.

Timecode start
Allows you to set the timecode at the start of the video. This also affects the timecode 
of the flow, but the initial timecode of the flow adjusts to accommodate the video. For 
example, if the initial timecode of the video is 02:00:00:00 but the video does not start 
until the start of the third bar in 4/4, the initial timecode of the flow is eight beats of 
time less than 02:00:00:00; if the tempo is 60 bpm, this makes the initial flow timecode 
01:59:52:00.
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NOTE

Flow timecodes are shown in their flow cards in the Flows panel.

RELATED LINKS
Timecodes on page 1226
Flows panel on page 120

Adding videos
You can add a video to each flow in your project. You can also follow these steps to reload videos 
previously added to the project that Dorico Elements can no longer locate.

Flows with missing videos show a warning icon  instead of the video icon in the flow card in the 
Flows panel. This can happen if you send a project to someone else without the video file.

PREREQUISITE
You have added at least one player to the project.

PROCEDURE

1. In Setup mode, in the Flows panel, right-click the flow to which you want to add/reload a 
video.

2. Choose Video > Attach from the context menu to open the File Explorer/macOS Finder.

3. Locate and select the video file you want to add.

4. Click Open to open the Video Properties dialog.

5. Change the settings as required.

6. Click OK to save your changes and close the dialog.

RESULT
The selected video file is added to the flow and is shown in the Video window. A video reel icon 
appears in the flow card in the Flows panel, beside a timecode indicating the combination of the 
Video start offset and Timecode start.

If you reloaded a video, all your previous settings are retained.

RELATED LINKS
Flows panel on page 120
Adding players on page 124
Changing the initial timecode value on page 1227

Changing the start position of videos
You can change both the rhythmic position in the music at which videos start, and the position in 
the video that coincides with that rhythmic position; for example, if you want the fifth second of a 
video to sync with the start of the third bar of music.

PROCEDURE

1. In Setup mode, open the Video Properties dialog in one of the following ways:

● Add a video to a flow.

● In the Flows panel, right-click a flow and choose Video > Properties from the context 
menu.
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2. Change the values for the following options, individually or together:

● Flow attachment position

● Video start offset

3. Click OK to save your changes and close the dialog.

RESULT
Changing the value for Flow attachment position changes the rhythmic position in the music at 
which the video starts.

Changing the value for Video start offset changes the position in the video that occurs at the 
Flow attachment position.

For example, if you change the Video start offset to 00:00:05:00 and the Flow attachment 
position to 8, then the fifth second in the video happens on the eighth beat in the music.

NOTE

● The initial rhythmic position is 0. Therefore, if the Flow attachment position is set to 8 and 
the time signature is 4/4, the flow attachment occurs on the first beat in the third bar.

● Changing the Video start offset changes what part of the video coincides with the Flow 
attachment position, but this does not cut the video before this point. Any preceding video 
material is shown as long as it happens within the flow.

Hiding/Showing the Video window
You can hide and show the Video window at any time and in any mode; for example, if you do 
not want it in view when working on the music in the music area.

PROCEDURE

● Hide/Show the Video window in any of the following ways:

● Press F4 .

● In the toolbar, click Show Video .

● Choose Window > Video.

RELATED LINKS
Toolbar on page 30
Markers track on page 534

Changing the size of the Video window
You can change the size of the Video window at any time.

PREREQUISITE
The Video window is shown.

PROCEDURE

● Change the size of the Video window in any of the following ways:

● Click and drag the corners/edges in any direction.

● Shift -click and drag a corner/edge to change the size without changing the shape.
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RESULT
The size of the Video window is changed. Dorico Elements saves the new size and shape and 
uses this for all projects until you change the size again.

Changing the volume of video audio
Any audio that is part of a video you have added is played back in sync with the music in the 
project. You can change the video volume manually.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

1. Optional: If the Video channel is not shown in the Mixer, click Video in the Mixer toolbar.

2. Do one of the following:

● To change the volume of video audio, click and drag the Video channel fader upwards/
downwards.

● To mute video audio, click Mute  in the Video channel.

RESULT
The volume of audio from videos in your project is changed.

RELATED LINKS
Mixer on page 717
Muting/Soloing tracks on page 547
Deactivating mute/solo instrument states on page 548

Removing videos
You can remove videos from each flow independently.

PROCEDURE

1. In Setup mode, in the Flows panel, right-click the flow from which you want to remove a 
video.

2. Choose Video > Detach from the context menu.

RESULT
The video is removed from the selected flow.

RELATED LINKS
Flows panel on page 120

Frame rates
The frame rate of a video is the number of still images that are used per unit of time in order to 
create the impression of a moving image, commonly measured in frames per second, or “fps”.

The number of frames per second required to create the impression of a moving image is 
determined by how fast the human eye processes movement, and so the most common frame 
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rate is around 24 fps. However, recent major films have been released at 48 fps, which results in 
sharper images.

Dorico Elements supports frame rates from 23.976 fps to 60 fps. For example, the US and 
Canadian broadcast standard NTSC uses 29.97 fps.

Frame rates are closely linked to timecodes, as timecodes include both the time and the current 
frame position.

All the common frame rates, such as 23.976, 24, 24.975, 25, 29.97, and 30 frames per second, are 
fully supported in Dorico Elements.

By default, Dorico Elements uses the same frame rate for the project as the video file, but you 
can manually choose a different frame rate.

RELATED LINKS
Timecodes on page 1226

Changing the project frame rate
By default, Dorico Elements uses the video frame rate as the project frame rate. You can change 
the project frame rate if you want it to be different; for example, if your project contains multiple 
videos with different frame rates.

TIP

You can change the frame rate even if there are no videos in the project.

PROCEDURE

1. In Setup mode, open the Video Properties dialog in one of the following ways:

● Add a video to a flow.

● In the Flows panel, right-click a flow and choose Video > Properties from the context 
menu.

2. Select the frame rate you want to use for the project from the Project frame rate menu.

3. Click OK to save your changes and close the dialog.

RESULT
The project frame rate is changed.
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Write mode

Write mode allows you to input and edit your music, including changing the rhythmic positions 
of items, changing the pitch of notes, and deleting notes and items. The available toolboxes and 
panels allow you to input all the notes and notation items that are most commonly used.

By design, you cannot move notes and items graphically in Write mode. Graphical adjustments 
are only possible in Engrave mode.

Project window in Write mode
The project window in Write mode contains toolboxes and panels with the tools and functions 
required to write your music.

You can switch to Write mode in any of the following ways:

● Press Ctrl/Cmd-2 .

● In the toolbar, click Write.

● Choose Window > Write.

● In Setup mode or Engrave mode, double-click in the music area.

TIP

You can disable this option in Preferences > Note Input and Editing > Editing.

The following zones and toolboxes are available in Write mode:

1 Notes toolbox

Contains tools that affect note input and editing.

2 Left zone
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Contains the Notes panel. The Notes panel provides the note durations, accidentals, and 
articulations that are most commonly used during note input.

3 Right zone

Can display different panels, according to the current selection in the Notations toolbox. 
Panels in the right zone contain notation items that you can add to your music, such as 
dynamics and playing techniques, divided into separate categories.

4 Notations toolbox

Contains either panel or popover buttons, depending on whether Panels  or Popovers 
is active.

Allows you to show panels for different notations in the right zone, open popovers, and input 
certain items directly, such as rehearsal marks and text.

5 Lower zone

Can display different panels, according to the current selection in the lower zone toolbar. 
Panels in the lower zone include the Properties panel, which allows you to make individual 
modifications to the currently selected notes and notations, and the Keyboard panel, which 
allows you to input notes.

RELATED LINKS
Toolbar on page 30
Properties panel on page 663
Mixer panel on page 717

Notes toolbox
The tools in the Notes toolbox allow you to start note input, modify notes, and change the type 
and scope of notes you input. The Notes toolbox is located on the left of the window in Write 
mode.

Show Left Zone

Hides/Shows the left zone.

Select

Enables/Disables mouse input. When Select is activated, mouse input is disabled and 
you cannot input notes by clicking on the staff.

TIP

You can assign a key command for Disable Mouse Input on the Key Commands page 
in Preferences.

Start Note Input

Starts/Stops note input by showing/hiding the caret. If a note, rest, or item is selected 
in the music area, note input starts at the selected rhythmic position. If nothing is 
selected in the music area, note input starts at the earliest rhythmic position on the top 
staff in view.
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Pitch Before Duration

When this option is activated, you can select the pitch before specifying the duration 
during note input. This allows you to experiment with pitches without having to stop 
note input because you only input the note when you specify the duration.

You can also activate/deactivate Pitch Before Duration by pressing K .

Chords

Allows you to add multiple notes at the same rhythmic position in order to build a 
chord during note input. This function prevents the caret from advancing automatically 
after inputting a note. Chord mode also affects some edits outside of note input, such 
as copying/pasting notes and items without overwriting existing material.

You can also start/stop chord input by pressing Q .

Insert

Allows you to insert notes before existing notes in the current voice ahead of the caret, 
instead of overwriting them, during note input. Insert mode also affects some edits 
outside of note input, such as deleting notes or changing their duration. For example, 
reducing the duration of notes with Insert mode activated pulls them closer together 
without leaving rests between the notes.

When inputting or changing time signatures, Insert mode instructs Dorico Elements to 
add any extra beats required to fill bars.

You can click and hold or right-click Insert to access the following options:

● Voice : Insert mode only affects the selected voices.

● Player : Insert mode affects all voices and instruments belonging to the selected 
players.

● Global : Insert mode affects all players in the flow.

● Global Adjustment of Current Bar : Insert mode affects all players in the flow, 
changes the duration of the current bar, and updates its time signature to reflect 
its new duration.

You can also activate/deactivate Insert mode by pressing I . You can cycle through the 
different Insert mode scopes by pressing Alt/Opt-I .

Lock Duration

Allows you to maintain the duration of notes while you change their pitches. Only 
available during note input.

You can also activate/deactivate Lock Duration by pressing L .

Force Duration

Allows you to input notes/rests with the explicit duration you have selected during note 
input, and fixes the current notated duration of existing notes outside of note input. 
For example, you can activate Force Duration to force the input of a dotted quarter 
note on the second quarter beat of 4/4, where Dorico Elements splits the note with a 
tie by default.
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IMPORTANT

You can get unexpected results if you force the duration of notes and later change the 
time signature or move barlines, for example.

You can remove Force Duration from selected notes by resetting their appearance.

You can also activate/deactivate Force Duration by pressing O .

Create Voice

Allows you to create a new voice on the current staff into which you can input notes 
during note input. Outside of note input, Create Voice allows you to change the voice 
of existing notes.

You can click and hold or right-click Create Voice to access the following options:

● Create Voice : Creates a new voice on the current staff. You can also use the key 
command Shift-V .

● Create Slash Voice : Creates a new slash voice with each click. For example, 
the third new slash voice is stemless. You can also use the key command Shift-Alt/
Opt-V .

● Next Voice : Cycles through active voices on the staff. You can also use the key 
command V .

Dotted Notes

Allows you to input dotted notes/rests based on the currently selected duration during 
note input. Outside of note input, Dotted Notes allows you to add rhythm dots to, and 
remove rhythm dots from, existing notes/rests.

You can click and hold or right-click Dotted Notes to access the following options:

● One Rhythm Dot : Inputs notes/rests with one rhythm dot during note input. 
Adds one rhythm dot to selected existing notes/rests outside of note input.

● Two Rhythm Dots : Inputs notes/rests with two rhythm dots during note input. 
Adds two rhythm dots to selected existing notes/rests outside of note input.

● Three Rhythm Dots : Inputs notes/rests with three rhythm dots during note 
input. Adds three rhythm dots to selected existing notes/rests outside of note 
input.

● Four Rhythm Dots : Inputs notes/rests with four rhythm dots during note input. 
Adds four rhythm dots to selected existing notes/rests outside of note input.

You can also activate/deactivate Dotted Notes by pressing .  or double-pressing note 
duration key commands. You can cycle through the different numbers of rhythm dots 
by pressing Alt/Opt-. .

Rests

Allows you to input rests of the currently selected duration instead of notes.

You can also start/stop rest input by pressing , .
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NOTE

If Force Duration is not activated, Dorico Elements automatically combines adjacent 
rests as appropriate for their position in relation to notes and according to the current 
meter.

Tuplets

Inputs a triplet based on the currently selected note duration at the caret position or at 
the selected rhythmic position.

You can click and hold or right-click Tuplets to access the following options:

● 2:3 : Inputs a duplet; that is, two notes in the space of three.

● 3:2 : Inputs a triplet; that is, three notes in the space of two.

● 4:3 : Inputs a quadruplet; that is, four notes in the space of three.

● 5:4 : Inputs a quintuplet; that is, five notes in the space of four.

● 6:4 : Inputs a sextuplet; that is, six notes in the space of four.

● 7:8 : Inputs a septuplet; that is, seven notes in the space of eight.

● x:y : Opens the tuplets popover, into which you can enter any tuplet ratio.

Grace Notes

Allows you to input grace notes instead of normal notes at the caret position. Only 
available during note input.

You can click and hold or right-click Grace Notes to access the following options:

● Unslashed Grace Notes : Selects unslashed grace notes.

● Slashed Grace Notes : Selects slashed grace notes.

You can also start/stop grace note input by pressing / . You can switch between 
slashed/unslashed grace notes by pressing Alt/Opt-/ .

Tie

During note input, this ties the next note you input to the previous note of the same 
pitch, in the same voice, and on the same staff. Outside of note input, you can use this 
tool to tie together notes of the same pitch in different voices or to tie grace notes to 
rhythmic notes.

You can also activate Tie by pressing T .

NOTE

You cannot deactivate Tie. If you want to delete ties, you must use Scissors.

Scissors

Splits notes and explicit rests in two at the caret position during note input. Outside of 
note input, it deletes all ties in tie chains.

You can also activate Scissors by pressing U .

Write mode
Project window in Write mode 

199
Dorico Elements 5.1.30



RELATED LINKS
Enabling/Disabling mouse input on page 212
Inputting notes with rhythm dots on page 230
Inputting chords on page 251
Inputting grace notes on page 249
Inputting tuplets on page 254
Tuplets popover on page 256
Input methods for time signatures and pick-up bars on page 283
Resetting the appearance of items on page 436
Key Commands page in the Preferences dialog on page 60

Notes panel
The Notes panel contains buttons that allow you to select note and rest durations, and to input 
accidentals, slurs, and articulations. It is located on the left of the window in Write mode.

You can hide/show the Notes panel in any of the following ways:

● Press Ctrl/Cmd-7 .

● In the toolbox on the left, click Show Left Zone .

● Choose Window > Show Left Zone.

The upper part of the Notes panel contains note durations that you can select for input or to 
change the duration of existing notes. By default, only the most common note durations are 
shown. You can see all note durations by clicking the Show/Hide All Notes disclosure arrows at 
the top and bottom of the section.

In the middle part of the Notes panel, you can activate/deactivate accidentals and activate slurs.

In the bottom part of the Notes panel, you can activate/deactivate articulations.

RELATED LINKS
Inputting notes on page 224
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Inputting accidentals on page 244
Inputting articulations on page 271
Inputting slurs on page 273
Inputting nested slurs on page 1295
Deleting notes/items on page 455
Deleting accidentals on page 792
Deleting articulations on page 805

Notations toolbox
The Notations toolbox allows you to access panels and popovers, which you can use to input the 
different notations available. It is located on the right of the window in Write mode.

Panels

Allows you to access panels from the Notations toolbox. Panels allow you to input 
notations by clicking them in the panel.

Popovers

Allows you to access popovers from the Notations toolbox. Popovers allow you to input 
notations by typing entries on your computer keyboard. Popovers open above the top 
staff on which the caret is active or an item is selected, and at the caret position or the 
rhythmic position of the earliest selected item.

NOTE

Popovers are only available during note input or when at least one note/item is 
selected in the music area.

Panel buttons

Clefs

Hides/Shows the Clefs panel, which contains sections for clefs and octave lines.

Key Signatures, Tonality Systems, and Accidentals

Hides/Shows the Key Signatures, Tonality Systems, and Accidentals panel, which 
contains sections for key signatures, tonality systems, and accidentals. You can also 
create and edit custom tonality systems from this panel.

Time Signatures (Meter)

Hides/Shows the Time Signatures (Meter) panel, which contains sections for the 
different types of time signatures, including a section where you can create custom 
time signatures, such as interchangeable time signatures and time signatures with 
pick-up bars.

Tempo
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Hides/Shows the Tempo panel, which contains sections for the different types of tempo 
changes, including gradual tempo changes, metronome marks, and tempo equations.

Dynamics

Hides/Shows the Dynamics panel, which contains sections for the different types of 
dynamics, including immediate, gradual, and custom combined dynamics.

Ornaments

Hides/Shows the Ornaments panel, which contains sections for ornaments, arpeggio 
signs, glissando lines, and guitar techniques.

Repeat Structures

Hides/Shows the Repeat Structures panel, which contains sections for the different 
types of repeat structures, including repeat endings and segments, repeat markers, 
single-note and multi-note tremolos, bar repeats, and slash regions.

Bars and Barlines

Hides/Shows the Bars and Barlines panel, which contains sections for bars, bar rests, 
and barlines.

Holds and Pauses

Hides/Shows the Holds and Pauses panel, which contains sections for fermatas, breath 
marks, and caesuras.

Playing Techniques

Hides/Shows the Playing Techniques panel, which contains sections for the various 
instrument family groups. Each section contains playing techniques for the 
corresponding instrument family.

Lines

Hides/Shows the Lines panel, which contains sections for horizontal and vertical lines.

Video

Hides/Shows the Video panel, which allows you to open the Video Properties dialog, 
view and edit markers in the current flow, and to calculate suitable tempos for 
important markers.

Comments

Hides/Shows the Comments panel, which allows you to view, edit, and export 
comments in the current flow.
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Popover and direct input buttons

Clefs

Opens the clefs and octave lines popover.

Key Signatures, Tonality Systems, and Accidentals

Opens the key signatures popover.

Time Signatures (Meter)

Opens the time signatures popover.

Tempo

Opens the tempo popover.

Dynamics

Opens the dynamics popover.

Ornaments

Opens the ornaments popover.

Repeat Structures

Opens the repeats popover.

Bars and Barlines

Opens the bars and barlines popover.

Holds and Pauses

Opens the holds and pauses popover.

Playing Techniques

Opens the playing techniques popover.

Rehearsal Marks

Inputs a rehearsal mark.
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Text

Opens the text editor for inputting text items.

Lyrics

Opens the lyrics popover.

Chord Symbols

Opens the chord symbols popover.

Note Tools

Opens the note tools popover.

Fingering

Opens the fingerings popover.

Figured Bass

Opens the figured bass popover.

RELATED LINKS
Notations input on page 271
Note tools popover on page 487
Video Properties dialog on page 190
Comment dialog on page 495

Right zone (Write mode)
The right zone in Write mode can display different panels for the available notation items, 
according to your selection in the Notations toolbox. You can use panels in the right zone to 
input notations. The right zone is located on the right of the window in Write mode.

You can hide/show the right zone in any of the following ways; for example, if you want to find a 
notation to input but then want to increase the size of the music area after inputting it:

● Press Ctrl/Cmd-9 .

● In the Notations toolbox, click the button for any panel you want to show, or the active 
button for the panel you want to hide.

● Choose Window > Show Right Zone.

RELATED LINKS
Hiding/Showing zones on page 44
Clefs panel on page 331
Key Signatures, Tonality Systems, and Accidentals panel on page 279
Time Signatures (Meter) panel on page 285
Tempo panel on page 296
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Dynamics panel on page 312
Ornaments panel on page 345
Repeat Structures panel on page 409
Bars and Barlines panel on page 303
Holds and Pauses panel on page 337
Playing Techniques panel on page 371
Lines panel on page 385
Video panel on page 402
Comments panel on page 496

Lower zone (Write mode)
The lower zone in Write mode can display different panels for inputting notes and editing notes/
items.

You can hide/show the lower zone in any of the following ways:

● Press Ctrl/Cmd-8 .

● Click the disclosure arrow at the bottom of the main window.

● Choose Window > Show Lower Zone.

You can use the panel selectors in the top left of the lower zone to display the corresponding 
panel:

Properties

Shows the Properties panel, which allows you to edit individual notes and notations, 
such as by changing their appearance or position.

Keyboard

Shows the Keyboard panel, which allows you to input notes using a piano keyboard 
layout and displays the pitches of selected notes as depressed keys.

Fretboard

Shows the Fretboard panel, which allows you to input notes for fretted instruments 
using the corresponding fretboard layout for the selected instrument type.

Drum Pads

Shows the Drum Pads panel, which allows you to input notes for unpitched percussion 
instruments using a drum pads layout.

Mixer

Shows the Mixer panel, which allows you to control the sounds produced in playback 
by instruments in the project, both for the master output and each individual 
instrument’s channel.
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Key Editor

Shows the Key Editor panel, which allows you to view and edit notes belonging to the 
selected instrument in a continuous piano roll.

RELATED LINKS
Hiding/Showing zones on page 44
Properties panel on page 663
Mixer panel on page 717
Key Editor panel on page 667
Note input on page 223
Notations input on page 271

Keyboard panel
The Keyboard panel allows you to input notes using a piano keyboard layout, and displays 
selected notes and sounding notes in playback as depressed keys with blue dots. It is located in 
the lower zone at the bottom of the window in Write mode.

During note input, the notes you press in the Keyboard panel are input. Outside of note input, 
Dorico Elements plays the notes you press using the instrument sounds of your most recent 
selection but does not input them.

● You can show the Keyboard panel by showing the lower zone, then clicking Keyboard  in 
the lower zone toolbar.

Between the toolbar and the keyboard, there is a keyboard range selector. The brighter keys 
indicate the keys shown in the panel. The shaded keys at each end of the range allow you to 
change the keys shown in the panel; for example, if you want to show fewer, wider keys.

The Keyboard panel toolbar contains the following options:

Advance Caret

Advances the caret by the currently selected note duration without inputting notes. 
Extends notations with duration, such as gradual dynamics and pedal lines. Only 
available during note input.

You can also advance the caret by pressing Space .

Delete Left

Deletes notes at the previous rhythmic position and moves the caret back to that 
position. Only available during note input.

You can also delete notes/items during note input by pressing Backspace .
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TIP

You can delete notes/items outside of note input by pressing Backspace or Delete .

Set Note Duration

Allows you to select a note duration, both for the next notes you input during note 
input and to change the duration of existing notes outside of note input.

You can also select note durations by pressing the corresponding key command or by 
clicking note durations in the Notes panel in the left zone.

Slur

Inputs a slur, starting from the currently selected note or spanning the selected notes. 
During note input, slurs extend automatically as you input notes.

You can also input slurs by pressing S .

Set Articulation

Allows you to activate/deactivate articulations, both for the next notes you input during 
note input and to add articulations to existing notes.

You can also activate/deactivate articulations by pressing the corresponding key 
command.

NOTE

Notes cannot have both accent and marcato articulations, or both staccato and tenuto 
articulations.

Respell Using Note Name Above

Respells the selected notes upwards to show the enharmonic equivalent using the note 
name above; for example, respelling F♯ as G♭.

Respell Using Note Name Below

Respells the selected notes downwards to show the enharmonic equivalent using the 
note name below, such as respelling G♭ as F♯.

Resize Lower Zone

Allows you to change the height of the lower zone.

RELATED LINKS
Caret on page 218
Notes panel on page 200
Hiding/Showing zones on page 44
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Inputting notes on page 224
Inputting chords on page 251
Deleting notes/items on page 455
Selecting note/rest durations on page 259
Inputting slurs on page 273
Inputting articulations on page 271
Respelling notes on page 473
Changing the middle C numbering convention on page 51

Fretboard panel
The Fretboard panel allows you to input notes for fretted instruments using the corresponding 
fretboard layout for the selected instrument type, and displays the pitches of the earliest 
selected notes as stopped strings with blue dots. It is located in the lower zone at the bottom of 
the window in Write mode.

During note input, the notes you press in the Fretboard panel are input. Outside of note input, 
Dorico Elements plays the notes you press using the instrument sounds of your most recent 
selection but does not input them.

● You can show the Fretboard panel by showing the lower zone, then clicking Fretboard  in 
the lower zone toolbar.

The Fretboard panel toolbar contains the following options:

Advance Caret

Advances the caret by the currently selected note duration without inputting notes. 
Extends notations with duration, such as gradual dynamics and pedal lines. Only 
available during note input.

You can also advance the caret by pressing Space .

Delete Left

Deletes notes at the previous rhythmic position and moves the caret back to that 
position. Only available during note input.

You can also delete notes/items during note input by pressing Backspace .

TIP

You can delete notes/items outside of note input by pressing Backspace or Delete .

Set Note Duration
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Allows you to select a note duration, both for the next notes you input during note 
input and to change the duration of existing notes outside of note input.

You can also select note durations by pressing the corresponding key command or by 
clicking note durations in the Notes panel in the left zone.

RELATED LINKS
Caret on page 218
Notes panel on page 200
Hiding/Showing zones on page 44
Inputting notes on page 224
Inputting notes on tablature on page 242
Inputting chords on page 251
Deleting notes/items on page 455
Selecting note/rest durations on page 259
Fretted instrument tuning on page 153
Tablature on page 1330

Drum Pads panel
The Drum Pads panel allows you to input notes for unpitched percussion instruments using a 
drum pads layout. It is located in the lower zone at the bottom of the window in Write mode.

During note input, the notes you press in the Drum Pads panel are input. Outside of note input, 
Dorico Elements plays sounds for the instruments and techniques you press but does not input 
them.

● You can show the Drum Pads panel by showing the lower zone, then clicking Drum Pads 
in the lower zone toolbar.

The Drum Pads panel toolbar contains the following options:

Advance Caret

Advances the caret by the currently selected note duration without inputting notes. 
Extends notations with duration, such as gradual dynamics and pedal lines. Only 
available during note input.

You can also advance the caret by pressing Space .

Delete Left

Deletes notes at the previous rhythmic position and moves the caret back to that 
position. Only available during note input.

You can also delete notes/items during note input by pressing Backspace .
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TIP

You can delete notes/items outside of note input by pressing Backspace or Delete .

Set Note Duration

Allows you to select a note duration, both for the next notes you input during note 
input and to change the duration of existing notes outside of note input.

You can also select note durations by pressing the corresponding key command or by 
clicking note durations in the Notes panel in the left zone.

Reorder Drum Pads

Allows you to move drum pads in relation to each other; for example, to create a 
different arrangement for easier input in different circumstances.

Resize Lower Zone

Allows you to change the height of the lower zone.

RELATED LINKS
Caret on page 218
Notes panel on page 200
Hiding/Showing zones on page 44
Inputting notes for unpitched percussion on page 238
Deleting notes/items on page 455
Selecting note/rest durations on page 259
Percussion kits and drum sets on page 142
Percussion kit presentation types on page 1428
Voices in percussion kits on page 1435

Inputting vs. editing
Dorico Elements distinguishes the processes for inputting and editing music.

Inputting

If you can see the caret, you are inputting new music. The caret must be activated in order to 
input notes and notations. If the caret is activated, selecting tools or items in the Notes toolbox 
and the Notes panel affects the note or chord that you are about to input, as you can specify 
the duration, rhythm dot, accidentals, and articulations. Then you specify the pitch by clicking the 
note into the score, by pressing the letter name of the note on your computer keyboard, or by 
playing the note or chord on your MIDI keyboard.

When the caret is activated, notes and notations are input at the caret position.

If no notes or chords are selected in the music area and you select a duration, either by pressing 
its key command or by clicking it in the Notes panel, mouse input is activated. If you move the 
mouse pointer over the staff, a shadow note is displayed to indicate where the note will be input 
if you click.
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NOTE

Deactivating mouse input prevents Dorico Elements from starting mouse input in this 
circumstance.

Editing

If you cannot see the caret, you can edit existing music. Editing music includes moving, copying/
paste, and deleting notes and notations. You can switch back and forth between inputting and 
editing at any time.

When the caret is not activated, new items are input at the position of the first selected note or 
item in the music area, according to your item input position setting. If there is no selection, the 
mouse pointer is loaded with the new item. The item is then created at the location where you 
click.

To edit existing notes and notations, you must select them in the music area. This allows 
you to update the selected notes or items when you select, for example, new note durations, 
accidentals, or articulations in the Notes panel.

We recommend that you spend a moment to understand the difference between how Dorico 
Elements behaves if the caret is shown and if it is not. In the latter case, all editing functions 
operate on the items that you have selected in the music area.

NOTE

The results of some edits outside of note input, including copying/pasting notes, can be affected 
by Insert mode and Chord mode.

RELATED LINKS
Editing items on page 430
Selecting notes/items on page 421
Note input on page 223
Notations input on page 271
Insert mode on page 451
Chord mode on page 254
Key Editor on page 667
Changing the gradual dynamic input position setting on page 317

Changing your mouse input settings
You can change your mouse input settings; for example, if you want to load a playing technique 
on the pointer once and input it in multiple places without having to reselect the playing 
technique each time.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Editing section, choose one of the following options for Creating items with the 
mouse:

● To input items at the position of the earliest selected note/item in the music area, 
choose Create item at selection.
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● To load items onto the mouse pointer so you can click in the music area where you want 
to input the item, choose Load pointer with item.

4. Optional: If you chose Load pointer with item, activate/deactivate Allow multiple items to 
be created with the mouse.

NOTE

When this option is activated, you can load an item onto your mouse pointer once, then 
input that item multiple times without having to reselect it each time.

When this option is deactivated, you can only input an item loaded onto your mouse pointer 
once.

5. Click Apply, then Close.

RESULT
Your mouse input settings are changed in the current project and for all future projects.

RELATED LINKS
Preferences dialog on page 58
Notations input on page 271

Enabling/Disabling mouse input
You can enable/disable mouse input; for example, if you only want to input notes using your 
computer keyboard or MIDI device. Disabling mouse input also allows you to click other items to 
stop note input.

PROCEDURE

● In Write mode, in the Notes toolbox, activate/deactivate Select .

RESULT
Mouse input is enabled in the current project when Select  is deactivated, and disabled when 
Select  is activated.

TIP

You can change whether mouse input is enabled/disabled by default in all future projects in 
Preferences > Note Input and Editing > Note Input.

RELATED LINKS
Notes toolbox on page 196
Preferences dialog on page 58

Enabling/Disabling mouse editing
You can enable/disable mouse editing for notes; for example, if you want to transpose and move 
notes by dragging with the mouse.

This does not affect your ability to edit notations using the mouse, which is always enabled.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.
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2. In the category list, click Note Input and Editing.

3. In the Note Input section, activate/deactivate Enable note pitch and rhythmic position 
editing using the mouse.

4. Click Apply, then Close.

RESULT
The setting is changed in the current project and for all future projects.

TIP

You can assign a key command for Toggle Mouse Note Editing on the Key Commands page in 
Preferences.

RELATED LINKS
Key Commands page in the Preferences dialog on page 60
Changing the pitch of individual notes on page 468
Adding notes above/below existing notes on page 258
Copying and pasting notes/items on page 457
Moving notes/items rhythmically on page 461
Moving notes/items to other staves on page 464

Changing the item input position setting
By default, Dorico Elements inputs items at the position of the earliest note on each selected 
staff. You can change this setting if you prefer to input items at the same rhythmic position on 
each selected staff, regardless of whether that represents a note or rest.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Editing section, activate/deactivate Create items at position of first selected note.

4. Optional: If you activated Create items at position of first selected note, activate/
deactivate Create clefs at position of first selected note.

5. Click Apply, then Close.

RESULT
When Create items at position of first selected note is activated, items are input at the 
rhythmic position of the earliest selected note. Items with duration end at the rhythmic position 
of the last selected note. This can cause items to be input at different rhythmic positions on each 
selected staff.

When Create items at position of first selected note is deactivated, items are input at the 
rhythmic position of the earliest selected item. Items with duration end at the rhythmic position 
of the last selected item. This can cause items to be input at the rhythmic positions of rests rather 
than notes.
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EXAMPLE

Whole bar selected Octave line input with setting 
activated

Octave line input with setting 
deactivated

RELATED LINKS
Preferences dialog on page 58
Notations input on page 271
Selecting notes/items on page 421
Inputting notes and notations onto multiple staves on page 235
Changing the gradual dynamic input position setting on page 317

Changing the note-based notation input setting
You can change your default setting for whether rhythm dots, accidentals, and articulations 
apply to the last input note or the next note you input during note input. This setting also affects 
whether or not the last input note remains selected after entry when using pitch before duration 
for inputting notes.

For example, changing the setting to After inputting note when using pitch before duration 
for notes ensures the last input note remains selected after you input it, making it easier to 
change its enharmonic spelling when inputting notes using a MIDI keyboard. The last input note 
is always selected when using duration before pitch for notes, regardless of your note-based 
notation input setting.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, choose one of the following options for Specify accidental, 
rhythm dot and articulations in the Pitch and Duration subsection:

● After inputting note

● Before inputting note

4. Click Apply, then Close.

RESULT
The setting is changed in the current project and for all future projects. If you chose Before 
inputting note, notes do not remain selected after you input them during pitch before duration 
note input.

RELATED LINKS
Inputting notes on page 224
Inputting notes using pitch before duration on page 227
Inputting accidentals on page 244
Inputting notes with rhythm dots on page 230
Inputting articulations on page 271
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Changing the input pitch setting
You can input and record notes at either sounding pitch or written pitch; for example, if you want 
to record notes at their sounding pitch in transposing part layouts.

In concert pitch layouts, written pitch and sounding pitch are the same.

PROCEDURE

● In Write mode, choose one of the following input pitch settings:

● To input/record notes at their written pitch, choose Write > Input Pitch > Written Pitch.

● To input/record notes at their sounding pitch, choose Write > Input Pitch > Sounding 
Pitch.

RESULT
The resulting pitch notated or recorded is changed. For example, if you input a C in a Horn in F 
transposing part layout with the input pitch set to Sounding Pitch, the note is written as a G.

RELATED LINKS
Inputting notes on page 224
Inputting notes using MIDI recording on page 264
Concert vs. transposed pitch on page 178

Playing/Muting notes during note input/selection
You can change your default setting for whether notes are played back as you input them or not. 
By default, notes are played back with the prevailing dynamic but you can set a fixed volume 
instead.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, activate/deactivate Play notes during note input and selection 
in the Auditioning subsection.

4. Optional: If you want notes to play back with a fixed volume instead of the prevailing 
dynamic, activate Use fixed volume to play selected notes and change the value in the 
value field.

5. Click Apply, then Close.

RESULT
When the option is activated, notes play back as you input them during note input and when you 
select them. When it is deactivated, notes do not play back.

When Use fixed volume to play selected notes is activated, notes play back with the set 
volume. When it is deactivated, notes play back with the prevailing dynamic.

RELATED LINKS
Inputting notes on page 224
Selecting/Deselecting notes and items individually on page 421
Playing back music on page 540
Changing the click settings on page 267
Mixer panel on page 717
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Input methods for dynamics on page 309

Playing all/individual notes in chords during note input/selection
You can change your default setting for whether all notes in chords are played when you select 
any note in the chord or whether only the selected notes are played.

PREREQUISITE
Notes are played during note input/selection.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, activate/deactivate Play all notes in chord when any is selected 
in the Auditioning subsection.

4. Click Apply, then Close.

RESULT
When the option is activated, all notes in chords are played when any note in the chord is 
selected. When it is deactivated, only the selected notes are played.

Enabling/Disabling MIDI thru
You can enable/disable MIDI thru at any time. For example, you can enable MIDI thru during 
note input to hear sounds from your MIDI keyboard, but disable MIDI thru during playback to 
hear the sounds produced by Dorico Elements.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the Recording subsection, activate/deactivate Enable MIDI thru.

4. Click Apply, then Close.

RESULT
The setting is changed in the current project and for all future projects.

TIP

You can assign a key command for Toggle MIDI Thru on the Key Commands page in 
Preferences.

RELATED LINKS
Key Commands page in the Preferences dialog on page 60
Inputting notes on page 224
Playing back music on page 540
MIDI recording on page 264
Enabling/Disabling MIDI input devices on page 270
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Rhythmic grid
The rhythmic grid is a unit of rhythmic duration whose value affects certain aspects of inputting 
and editing, such as the amount by which items move. However, it does not control the duration 
of notes and items that you input.

Rhythmic grid set to eighth notes (quavers) shown above the staff

The current rhythmic grid resolution is shown by the note value in the status bar, and by ruler 
markings above the staff on which the caret is active or on which you are dragging notes. Longer 
lines in the rhythmic grid indicate beat divisions, while shorter lines indicate beat subdivisions.

The rhythmic grid controls the following:

● The possible input positions when using the caret or the mouse, and when copying and 
pasting. For example, setting the rhythmic grid resolution to 32nd notes allows you to input 
notes and items at a greater number of possible rhythmic positions than when the rhythmic 
grid is set to quarter notes.

● The amount by which the caret moves when using Right Arrow / Left Arrow .

● The amount by which notes and items are lengthened/shortened.

● The amount by which notes and items move.

● The duration by which notes are split.

RELATED LINKS
Rhythmic position on page 24
Changing the Key Editor rhythmic grid resolution on page 675
Caret on page 218
Splitting notes by duration on page 261
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430
Copying and pasting notes/items on page 457
Changing music area colors on page 54

Changing the rhythmic grid resolution
You can change the resolution of the rhythmic grid; for example, you might decrease the 
rhythmic grid resolution so you can shorten notes by smaller increments. The resolution is 
indicated by the note value symbol in the status bar and by the beat divisions/subdivisions in the 
ruler markings above the caret.

The rhythmic grid resolution is set to eighth notes (quavers) by default.

PROCEDURE

● Change the resolution of the rhythmic grid in any of the following ways:

● To decrease the rhythmic grid resolution, press Alt/Opt-] .

● To increase the rhythmic grid resolution, press Alt/Opt-[ .

● Choose Write > Rhythmic Grid > Decrease Grid Resolution.

● Choose Write > Rhythmic Grid > Increase Grid Resolution.
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● Choose Write > Rhythmic Grid > [Beat division].

● Select a value from the Rhythmic Grid selector in the status bar.

RESULT
Decreasing the rhythmic grid resolution makes it finer by making the note value shorter. 
Increasing the rhythmic grid resolution makes it coarser by making the note value longer.

RELATED LINKS
Status bar on page 38
Changing the Key Editor rhythmic grid resolution on page 675

Caret
In Dorico Elements, the caret is a vertical line that extends above and below five-line staves but 
appears shorter on percussion staves and tablature. It shows the rhythmic position at which 
notes, chords, or notation items are input, which can be partway through tie chains.

A caret is a mark that is commonly used when proofreading published text to denote the position 
at which something should be inserted or added; for example, a missing letter or a word. In 
software, the caret shows where something is inserted. The caret is also known as an “insertion 
point” or “cursor”. In this documentation, we use “caret” to refer to the line that appears during 
note input, and “cursor” to refer to the line that appears during text input.

If you are inputting notes, the caret advances to the next rhythmic position automatically. If you 
are inputting chords or notes on tablature, the caret does not move automatically, and you must 
move it to the next rhythmic position manually.

The caret has a note symbol beside it, which indicates the stem direction and type of the 
currently selected voice. It is accompanied by a + symbol if the voice is new.

The caret

The appearance of the caret changes depending on the input mode and the currently selected 
voice number.

Multiple staves
The caret extends vertically across all the staves onto which notes and notations will be 
input. This allows you to input, for example, the same dynamics or playing techniques 
on multiple staves simultaneously or play in chords on a MIDI keyboard and distribute 
the notes in those chords onto multiple staves. The note symbol and rhythmic grid also 
appear for each included staff.
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Caret when inputting notes onto multiple staves

Insert
The caret shows V and inverted V shapes at the top and bottom. Dotted lines are 
shown on staves affected by the Insert mode scope across which the caret does not 
already extend. In Insert mode, inserted notes shift existing notes after the caret along 
by the input duration instead of overwriting them.

Caret when Insert (Voice) is 
active

Caret when Insert (Player) 
is active

Caret when either Insert 
(Global) or Insert (Global 
Adjustment of Current Bar) 
is active

NOTE

Insert mode also affects some edits outside of note input, such as copying/pasting, 
deleting, and lengthening/shortening notes.

Chords
The caret shows a plus symbol at the top left. During chord input, you can input 
multiple notes at the same rhythmic position.

Caret when inputting chords
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NOTE

Chord mode also affects some edits outside of note input, such as copying/pasting and 
lengthening/shortening notes and items.

Lock Duration
The caret is dashed. Lock Duration allows you to repitch notes without changing their 
duration or rhythm.

Caret when Lock Duration is activated

Grace Notes
The caret is shorter than the default caret. It allows you to input grace notes at the 
caret position.

Caret when inputting grace notes

Voices
To identify voices, the caret shows the following:

● An up-stem or down-stem note symbol to indicate the stem direction of the voice

● The voice number into which you are about to input notes, for second voices and 
above

● A plus symbol at the bottom left, if the voice is new

Caret when inputting notes 
into the first up-stem voice

Caret when inputting notes 
into a new down-stem voice

Caret when inputting notes 
into a new, second up-stem 
voice

Slash voices
To identify slash voices, the caret shows the following:

● An up-stem or down-stem slash note symbol, indicating the stem direction of the 
slash voice, and whether it has stems or is stemless

● The number of the slash voice into which you are about to input notes, for second 
voices and above
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● A plus symbol on the left at the bottom, if the slash voice is new

Caret when inputting notes 
into an up-stem slash voice

Caret when inputting notes 
into a new, second up-stem 
slash voice

Caret when inputting notes 
into a new, stemless slash 
voice

Percussion kits
The caret appears significantly smaller than usual when inputting notes into 
percussion kits. The name of the kit instrument into which you are currently inputting 
notes is shown above the rhythmic grid.

Caret when inputting notes into percussion kits

Tablature
The caret appears significantly smaller than usual when inputting notes into tablature. 
On tablature, the caret behaves as if chord input is always active, meaning you must 
advance the caret and move it to other string lines manually.

Caret when inputting notes on tablature

RELATED LINKS
Note input on page 223
Chord mode on page 254
Insert mode on page 451
Repitching notes without changing their rhythm on page 472
Splitting tie chains on page 1373
Splitting notes by duration on page 261
Changing music area colors on page 54
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Activating/Deactivating the caret
When the caret is activated, you can input notes and notations at the caret position; for example, 
if you want to input a dynamic in the middle of a tie chain. When the caret is deactivated, you 
cannot input notes, instead you can select and edit items in the music area.

PROCEDURE

1. In Write mode, activate the caret and start note input in any of the following ways:

● Select an item and press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click a rhythmic position on a staff.

2. Deactivate the caret and stop note input in any of the following ways:

● Press Shift-N , Return , or Esc .

● If you have deactivated mouse input, click any selectable item in the music area.

● In the Notes toolbox, click Start Note Input .

● Switch to another mode.

RELATED LINKS
Enabling/Disabling mouse input on page 212
Note input on page 223
Notations input on page 271

Extending the caret to multiple staves
You can extend the caret so it spans multiple staves. This allows you to input notes and notations 
onto multiple staves simultaneously, including automatically exploding the notes in chords that 
you play on a MIDI keyboard onto the appropriate staves.

PROCEDURE

1. In Write mode, activate the caret in any of the following ways:

● Select an item and press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click a rhythmic position on a staff.

2. Extend the caret to other staves in any of the following ways:

● To extend to the staff above, press Shift-Up Arrow .

● To extend to the staff below, press Shift-Down Arrow .

3. Optional: Repeat step 2 as many times as you require.

RELATED LINKS
Notes toolbox on page 196
Inputting notes and notations onto multiple staves on page 235
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Moving the caret manually
During normal note input, the caret moves automatically as you input notes, but you can also 
move it manually. For example, the caret does not move automatically when Chords  is 
activated.

PROCEDURE

● In Write mode, move the caret in any of the following ways:

● To move the caret according to the current rhythmic grid resolution or to the next/
previous note/rest, whichever is closest, press Right Arrow / Left Arrow .

● To advance the caret according to the note value currently selected, press Space  or click 
Advance Caret  in the Keyboard, Fretboard, or Drum Pads panel toolbar.

● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

● To move the caret to the staff above/below, press Up Arrow / Down Arrow .

● To move the caret to the top/bottom staff in the system, press Ctrl/Cmd-Up Arrow /
Ctrl/Cmd-Down Arrow .

RELATED LINKS
Inputting chords on page 251
Keyboard panel on page 206
Fretboard panel on page 208
Drum Pads panel on page 209
Rhythmic grid on page 217

Note input
In Dorico Elements, you can only input notes during note input, which is when the caret is 
activated. This reduces the risk of you adding notes to staves accidentally.

You can also input notations at the same time as inputting notes. Notations are input at the caret 
position or on the selected note.

You can input notes in different ways and using any of the following devices, including switching 
between them at any time:

● MIDI keyboard

● Computer keyboard

● Mouse or touchpad

● Keyboard, Fretboard, and Drum Pads panels

RELATED LINKS
Accidental selection during MIDI input on page 245
Keyboard panel on page 206
Fretboard panel on page 208
Drum Pads panel on page 209
Notations input on page 271
Arranging tools on page 455
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Inputting notes
You can input notes into your project during note input, which is when the caret is activated. You 
can input notes with a computer keyboard, with the mouse, using panels in the lower zone, or by 
playing notes with a MIDI keyboard.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● These steps describe selecting rhythm dots, articulations, and accidentals not in the 
prevailing key signature before inputting notes. However, you can also select them after 
inputting notes. If you change this setting, you must perform step 7 before steps 4 to 6.

● You do not have to input rests between notes, as Dorico Elements automatically shows 
implicit rests of the appropriate duration between the notes you input. Similarly, you do not 
have to input ties, as Dorico Elements shows notes as tie chains if necessary.

● You can also input notations alongside notes without deactivating note input.

PREREQUISITE

● You have chosen the appropriate input pitch setting.

● You have chosen the appropriate note-based notation input setting.

● You have connected any MIDI devices you want to use for note input.

● If you want to hear sounds from connected MIDI devices, you have enabled MIDI thru.

● If you want to select note durations using the Notes panel, the left zone is shown.

● If you want to input notes into multiple instruments held by a single player or instruments 
not visible in the score in page view, you are in galley view.

● If your music requires a key signature, you have input that key signature.

PROCEDURE

1. In Write mode, start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .

NOTE

You can also press Return ; however, if you select a notation, such as a dynamic, 
pressing Return  opens the corresponding popover instead of starting note input.

● Select a note or rest on the staff where you want to input notes and click Start Note 
Input  in the Notes toolbox.

● Double-click the staff where you want to input notes.

2. Optional: If you want to input notes onto multiple staves at once, extend the caret to those 
staves.

3. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.
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● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

4. Optional: Select any required rhythm dots.

5. Optional: If you want to input a pitch whose accidental is not in the prevailing key signature, 
select the appropriate accidental.

6. Optional: Select any required articulations.

7. Input the pitches you want in any of the following ways:

● Press the corresponding letters on your computer keyboard.

TIP

Dorico Elements automatically selects the note whose register is the smallest interval 
away from the previously input note. However, you can force a different register.

● To input a note above the previously input note, press Shift-Alt/Opt  as well as the 
letter for the note; for example, Shift-Alt/Opt-A .

● To input a note below the previously input note, press Ctrl-Alt (Windows) or 
Ctrl (macOS)  as well as the letter for the note; for example, Ctrl-Alt-A (Windows) 
or Ctrl-A (macOS) .

● Click the staff at the rhythmic position of each note you want to input.

A shadow notehead appears when inputting with the mouse to indicate where the note 
will be input.

● In the Keyboard, Fretboard, or Drum Pads panel, play the notes you want.

● Play the notes on a MIDI keyboard.

8. Optional: Advance the caret by the currently selected note duration without inputting notes 
in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

TIP

You can also move the caret in different ways and by different increments.

9. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input with the selected duration at the caret position or where you click and are played 
back as you input them by default. Their pitch follows the prevailing key signature. For example, 
if you press F  in G major, an F♯ is input automatically.

If you selected rhythm dots or articulations, notes continue to be input with them until you 
deactivate them. However, accidentals not in the prevailing key signature are only added to the 
first note you input after selecting them.

Dorico Elements notates and beams notes appropriately according to their duration, the 
prevailing time signature, and their position in the bar. This includes showing notes as tie chains 
if required.

If you advance the caret without inputting notes, Dorico Elements fills the gaps between notes 
with implicit rests of the appropriate duration.
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If you input notes on notation staves belonging to fretted instruments, Dorico Elements 
automatically allocates these notes to the strings on which they can be played closest to the 
nut. Because this calculation is done for each note separately, multiple notes can be allocated 
to the same string. In such cases, the notes are shown next to each other on tablature and are 
colored green. You can then select them individually and make your own string allocation.

NOTE

● The notes you input overwrite existing notes at the caret position in the voice indicated by 
the quarter note symbol beside the caret. If you want to add notes to an existing voice, you 
can input chords. You can also input notes into new voices.

● You can change the default beam, note, and rest grouping settings for each flow 
independently in Notation Options. You can also specify custom beat groupings within 
individual time signatures.

AFTER COMPLETING THIS TASK

● You can move notes to different rhythmic positions and other staves after they have been 
input.

● You can also show brackets on noteheads individually.

RELATED LINKS
Changing the input pitch setting on page 215
Changing the note-based notation input setting on page 214
Switching to galley/page view on page 50
Notes toolbox on page 196
Notes panel on page 200
Moving notes/items rhythmically on page 461
Moving notes/items to other staves on page 464
Changing the allocated string for notes on tablature on page 1332
Note and rest grouping on page 860
Bracketed noteheads on page 1066

Register selection during note input
Dorico Elements automatically selects the register of pitches during note input, but you can 
override this and select the register manually.

During note input, Dorico Elements automatically selects the note whose register is the smallest 
interval away from the previously input note. For example, if you input an F and then press A , an 
A is input a third above the F, rather than a sixth below.

You can override this automatic register selection in the following ways:

● To input a note above the previously input note, press Shift-Alt/Opt  as well as the letter for 
the note; for example, Shift-Alt/Opt-A .

● To input a note below the previously input note, press Ctrl-Alt (Windows) or Ctrl (macOS) 
as well as the letter for the note; for example, Ctrl-Alt-A (Windows) or Ctrl-A (macOS) .

Register selection when inputting chords

During chord input, Dorico Elements automatically inputs notes above the highest note at the 
caret position. For example, if you press A  then E  then A , a chord of A-E-A is input at the caret 
position.
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You can input notes below the lowest note at the caret position instead by pressing Ctrl-
Alt (Windows) or Ctrl (macOS)  as well as the letter for the note name; for example, Ctrl-Alt-
A (Windows) or Ctrl-A (macOS) .

RELATED LINKS
Changing the pitch of individual notes on page 468
Accidental selection during MIDI input on page 245
Respelling notes on page 473

Inputting notes using pitch before duration
You can input notes into your project by specifying their pitch before their duration, meaning you 
can test pitches before inputting them without leaving note input. You can input notes with a 
computer keyboard, with the mouse, using panels in the lower zone, or by playing notes with a 
MIDI keyboard.

By default in Dorico Elements, you must specify the duration before the pitch of notes.

NOTE

● These steps describe selecting the pitch before the duration when inputting notes. However, 
you can also specify the duration before the pitch instead, which is the default note input 
behavior in Dorico Elements.

● These steps describe selecting rhythm dots, articulations, and accidentals not in the 
prevailing key signature before inputting notes. However, you can also select them after 
inputting notes. If you change this setting, you must perform steps 7 and 8 before steps 4 to 
6.

● When inputting notes on tablature using pitch before duration, you must select note 
durations by clicking them in the Notes panel.

● You do not have to input rests between notes, as Dorico Elements automatically shows 
implicit rests of the appropriate duration between the notes you input. Similarly, you do not 
have to input ties, as Dorico Elements shows notes as tie chains if necessary.

● You can also input notations alongside notes without deactivating note input.

PREREQUISITE

● You have chosen the appropriate input pitch setting.

● You have chosen the appropriate note-based notation input setting.

● You have connected any MIDI devices you want to use for note input.

● If you want to hear sounds from connected MIDI devices, you have enabled MIDI thru.

● If you want to select note durations using the Notes panel, the left zone is shown.

● If you want to input notes into multiple instruments held by a single player or instruments 
not visible in the score in page view, you are in galley view.

● If your music requires a key signature, you have input that key signature.

PROCEDURE

1. In Write mode, start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .
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NOTE

You can also press Return ; however, if you select a notation, such as a dynamic, 
pressing Return  opens the corresponding popover instead of starting note input.

● Select a note or rest on the staff where you want to input notes and click Start Note 
Input  in the Notes toolbox.

● Double-click the staff where you want to input notes.

2. Activate Pitch Before Duration in any of the following ways:

● Press K .

● In the Notes toolbox, click Pitch Before Duration .

3. Optional: If you want to input notes onto multiple staves at once, extend the caret to those 
staves.

4. Optional: If you want to input a pitch whose accidental is not in the prevailing key signature, 
select the appropriate accidental.

5. Optional: Select any required articulations.

6. Optional: Select any required rhythm dots.

7. Select a pitch in any of the following ways:

● Press the corresponding letters on your computer keyboard.

TIP

Dorico Elements automatically selects the note whose register is the smallest interval 
away from the previously input note. However, you can force a different register.

● To input a note above the previously input note, press Shift-Alt/Opt  as well as the 
letter for the note; for example, Shift-Alt/Opt-A .

● To input a note below the previously input note, press Ctrl-Alt (Windows) or 
Ctrl (macOS)  as well as the letter for the note; for example, Ctrl-Alt-A (Windows) 
or Ctrl-A (macOS) .

When inputting notes using pitch before duration, you can press these key commands 
multiple times to select higher/lower octaves.

● Click the staff at the rhythmic position of each note you want to input.

A shadow notehead appears when inputting with the mouse to indicate where the note 
will be input.

● In the Keyboard, Fretboard, or Drum Pads panel, play the notes you want.

● Play the notes on a MIDI keyboard.

Once you have selected a pitch, a shadow note of the corresponding pitch appears at the 
caret position. You can release the pitch after selecting it.

8. Select a note duration and input the note in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.
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NOTE

When inputting notes on tablature, you must click durations in the Notes panel.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

9. Optional: Advance the caret by the currently selected note duration without inputting notes 
in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

TIP

You can also move the caret in different ways and by different increments.

10. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input with the selected duration at the caret position or where you click and are played 
back as you input them by default. Their pitch follows the prevailing key signature. For example, 
if you press F  in G major, an F♯ is input automatically.

If you selected rhythm dots or articulations, notes continue to be input with them until you 
deactivate them. However, accidentals not in the prevailing key signature are only added to the 
first note you input after selecting them.

Dorico Elements notates and beams notes appropriately according to their duration, the 
prevailing time signature, and their position in the bar. This includes showing notes as tie chains 
if required.

If you advance the caret without inputting notes, Dorico Elements fills the gaps between notes 
with implicit rests of the appropriate duration.

If you input notes on notation staves belonging to fretted instruments, Dorico Elements 
automatically allocates these notes to the strings on which they can be played closest to the 
nut. Because this calculation is done for each note separately, multiple notes can be allocated 
to the same string. Similarly, when you input chords on tablature using pitch before duration 
with a MIDI keyboard, all notes in the chord are allocated to the same string. In such cases, the 
notes are shown next to each other on tablature and are colored green. You can then select them 
individually and make your own string allocation.

NOTE

● The notes you input overwrite existing notes at the caret position in the voice indicated by 
the quarter note symbol beside the caret. If you want to add notes to an existing voice, you 
can input chords. You can also input notes into new voices.

● You can switch between using pitch before duration and duration before pitch note input at 
any time by pressing K  or clicking Pitch Before Duration . For example, duration before 
pitch can be easier when inputting a sequence of notes with the same duration.

● You can change the default beam, note, and rest grouping settings for each flow 
independently in Notation Options. You can also specify custom beat groupings within 
individual time signatures.

Write mode
Note input 

229
Dorico Elements 5.1.30



● You can change whether note input uses pitch before duration or duration before pitch by 
default on the Note Input and Editing page in Preferences.

AFTER COMPLETING THIS TASK
You can move notes to different rhythmic positions and other staves after they have been input.

You can also show brackets on noteheads individually.

RELATED LINKS
Changing the input pitch setting on page 215
Changing the note-based notation input setting on page 214
Switching to galley/page view on page 50
Notes toolbox on page 196
Notes panel on page 200
Moving notes/items rhythmically on page 461
Moving notes/items to other staves on page 464
Changing the allocated string for notes on tablature on page 1332
Note and rest grouping on page 860
Bracketed noteheads on page 1066

Inputting notes with rhythm dots
The Dotted Notes tool allows you to input notes with rhythm dots and add rhythm dots to 
existing notes. You can input notes with up to four rhythm dots.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● These steps describe selecting rhythm dots before inputting notes. However, you can 
change this setting if you prefer to specify rhythm dots after inputting notes.

● You cannot add rhythm dots to grace notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select existing notes to which you want to add rhythm dots.

2. Optional: If you want to input notes with rhythm dots onto multiple staves at once, extend 
the caret to those staves.

3. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

4. Activate Dotted Notes in any of the following ways:

● Press . .
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● Double-press the required note duration key command.

For example, press 6  twice quickly for a dotted quarter note.

● In the Notes toolbox, click Dotted Notes .

5. Optional: Change the number of rhythm dots in any of the following ways:

● Press Alt/Opt-.  to cycle through different numbers of rhythm dots.

● In the Notes toolbox, click and hold Dotted Notes , then click the number of rhythm 
dots you want.

Dotted Notes  in the Notes toolbox updates to indicate the current number of rhythm 
dots. You can input notes with up to four rhythm dots.

6. Optional: Activate Force Duration in any of the following ways:

● Press O .

● In the Notes toolbox, click Force Duration .

If Force Duration  is not activated, the notes you input might be shown as tied notes 
rather than dotted notes, depending on their position in the bar and the prevailing meter.

7. Input the dotted notes you want.

Dotted Notes  remains activated until you either select a different note duration or 
deactivate it.

8. Press .  or click Dotted Notes  again to deactivate Dotted Notes.

9. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
During note input, notes are input as dotted notes until you deactivate Dotted Notes or change 
the note duration.

When you add rhythm dots to multiple existing notes that would then overlap, Dorico Elements 
adjusts the duration of notes in the selection to avoid deleting notes at the end of the selection.

EXAMPLE

A phrase containing eighth notes After adding rhythm dots to the whole selection

RELATED LINKS
Note and rest grouping on page 860
Inputting notes using pitch before duration on page 227
Changing the note-based notation input setting on page 214
Extending the caret to multiple staves on page 222
Notes toolbox on page 196
Notes panel on page 200
Insert mode on page 451
Chord mode on page 254
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Inputting notes into multiple voices
By default, notes are input into the first up-stem voice, as indicated by the symbol of an up-stem 
quarter note beside the caret. You can input notes directly into other voices during note input, 
and switch between voices as required.

You can also create new voices on staves with existing notes and input notes into those voices 
anywhere else on those staves.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input multiple voices.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Select the voice into which you want to input notes in one of the following ways:

● To create a new voice, press Shift-V  or click Create Voice  in the Notes toolbox.

When a new voice is added, a + sign appears beside the symbol of a quarter note beside 
the caret. The quarter note symbol indicates the stem direction, and the number beside 
the quarter note indicates the voice number if applicable.

Caret when adding the first down-stem voice

TIP

You can press Shift-V  as many times as you require. For example, on a staff containing 
no notes, creating one new voice allows you to input notes into the first down-stem 
voice, but you can also create another new voice immediately if you want to input notes 
into the second up-stem voice.

Only voices that contain notes are preserved.

● To select an existing voice, press V  or click Next Voice  in the Notes toolbox to cycle 
through active voices on the staff.

NOTE

● You can switch between voices as often as you like.

● If you have three or more voices on a single staff, you can only cycle through all 
the voices in a set order. For example, if you have two up-stem voices and two 
down-stem voices, the order is: first up-stem voice, first down-stem voice, second 
down-stem voice, second up-stem voice.

4. Input the notes you want.

5. Stop note input in any of the following ways:
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● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input into the voice indicated by the quarter note symbol beside the caret.

If you are inputting notes into a new voice on a staff that already contains notes in another 
voice, the stem directions of existing notes at the same rhythmic position change automatically 
as necessary. Rests appear as required around notes in different voices.

NOTE

● Any voices that you created, but did not input notes into, are deleted.

● You can show voice colors to check which notes are in which voice. Additionally, when you 
select single notes or multiple notes in the same voice at the same rhythmic position, their 
pitches are shown in the status bar and as depressed keys in the Keyboard panel.

EXAMPLE

Caret when inputting notes into 
the first up-stem voice

Caret when inputting notes into 
the first down-stem voice

Caret when inputting notes into a 
new, second up-stem voice

RELATED LINKS
Inputting notes on page 224
Voices on page 1438
Stem direction on page 1074
Implicit rests in multiple-voice contexts on page 1273
Hiding/Showing voice colors on page 1439
Changing the voice of existing notes on page 466
Allowing/Disallowing noteheads in opposing voices to overlap on page 1440
Hiding/Showing bar rests in additional voices on page 1278

Inputting notes into slash voices
You can input notes into multiple slash voices; for example, if you want to indicate a precise 
rhythm without specifying pitches. By default, the first slash voice is up-stem, but you can add 
extra slash voices both with and without stems, and switch between them as often as you want.

You can also input notes into new slash voices on a staff with existing notes. Once you have 
created a slash voice somewhere on a staff, you can input notes into that slash voice anywhere 
else on the same staff.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input slash voices.
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2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Select the slash voice into which you want to input notes in one of the following ways:

● To create a new slash voice, press Shift-Alt/Opt-V . You can also click and hold Create 
Voice  in the Notes toolbox, then click Create Slash Voice .

When a new slash voice is added, a + sign appears beside the symbol of a note beside 
the caret, which now appears as a slash note. The slash note symbol indicates the stem 
direction, and the number beside the slash note symbol indicates the voice number if 
applicable.

Caret when adding the first down-stem slash voice

TIP

You can press Shift-Alt/Opt-V  as many times as you require. For example, on a staff 
containing no notes in slash voices, creating one new slash voice allows you to input 
notes into the first up-stem slash voice.

You can also create a second new slash voice immediately if you want to input notes 
into a down-stem slash voice, or a third new slash voice if you want to input notes into a 
stemless slash voice.

Only voices that contain notes are preserved.

● To select an existing slash voice, press V  or click Next Voice  in the Notes toolbox to 
cycle through active voices on the staff.

4. Input the notes you want.

Notes in slash voices appear at the same staff position, regardless of their pitch. By default, 
this is the middle line of the staff, but this changes in multiple-slash-voice contexts.

NOTE

By default, notes in slash voices are not played back. However, if you include slash voices in 
playback, notes in slash voices play back with their input pitch.

5. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are input into new slash voices, as indicated by the caret indicator. The slash note symbol 
beside the caret changes to indicate which voice is currently selected and into which notes are 
input.

You can switch between voices as often as you like.
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NOTE

● If you are inputting notes into a new slash voice on a staff that already contains notes in 
other voices/slash voices, the stem directions of existing notes and the staff positions of 
slash voices at the same rhythmic position change automatically as necessary. Rests appear 
as required around notes in different voices.

● If you have three or more voices of any type on a single staff, you must cycle through all the 
voices in a set order. For example, if you have two up-stem voices, two down-stem voices, 
and a slash voice, the order is: first up-stem voice, first down-stem voice, second down-stem 
voice, second up-stem voice, slash voice.

● Any voices that you created, but did not input notes into, are deleted.

EXAMPLE

Caret when inputting 
notes into the first up-
stem slash voice

Caret when inputting 
notes into the first down-
stem slash voice

Caret when inputting 
notes into a new 
stemless slash voice

Caret when inputting 
notes into a new, second 
up-stem slash voice

RELATED LINKS
Notes toolbox on page 196
Slash voices on page 1258
Slash regions on page 1261
Adding slash voices to percussion kits on page 1260
Changing the voice of existing notes on page 466
Including/Excluding slash voices in playback on page 1260
Stem direction on page 1074
Implicit rests in multiple-voice contexts on page 1273

Inputting notes and notations onto multiple staves
You can input notes and notations onto multiple staves simultaneously, including automatically 
exploding the notes in chords that you play on a MIDI keyboard onto the appropriate staves. 
For example, if you want to input notes onto both piano staves or input the same dynamics for 
multiple instruments.

Inputting notes and notations onto multiple staves is most useful for multiple adjacent pitched 
instruments whose music is only a single voice.

PREREQUISITE
If you want to explode individual notes in chords onto multiple staves during note input, you 
have connected a MIDI keyboard. You can only input the different notes in chords onto separate 
staves when using a MIDI keyboard.
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PROCEDURE

1. In Write mode, select an item at the rhythmic position where you want to input notes/
notations onto multiple staves.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Extend the caret to another staff in any of the following ways:

● To extend to the staff above, press Shift-Up Arrow .

● To extend to the staff below, press Shift-Down Arrow .

4. Optional: Repeat step 3 for as many staves as you require.

5. Input the notes and notations you want.

NOTE

You must input notes using a computer keyboard or MIDI keyboard. If you use the mouse, 
notes are only input on the staff you click. Similarly, you must use the corresponding 
popover to input notations on multiple staves. When inputting notations using the 
corresponding panel, they are only input on the top staff.

6. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
The notes and notations you input are input at the caret position on all staves across which the 
caret extends. If the caret extends across both staves of a grand staff instrument, notes are input 
on either the top or bottom staff according to their pitch. However, this does not apply to grand 
staff instruments with extra staves.

When inputting notes using a MIDI keyboard, the individual notes in any chords you input are 
automatically exploded across the staves.

RELATED LINKS
Caret on page 218
Notes toolbox on page 196
Inputting notes using pitch before duration on page 227
Changing the item input position setting on page 213
Notations input on page 271
Preferences dialog on page 58
MIDI Import Options dialog on page 85
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Inputting notes in Insert mode
In Insert mode, you can input notes before existing notes in a single voice without overriding 
them. This allows you to push existing notes ahead at the same time as inputting new notes at 
their previous positions.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● You can only input chords in Insert mode when using a MIDI keyboard.

PROCEDURE

1. In Write mode, start note input.

2. Activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

In Insert mode, the caret shows V and inverted V shapes at the top and bottom. Dotted 
lines are shown on staves affected by the Insert mode scope across which the caret does not 
already extend.

3. Choose the appropriate Insert mode scope.

4. Optional: If the Insert mode scope is set to Voice , press V  until the voice you want is 
selected.

5. Optional: If the Insert mode scope is set to Player  or Voice  and you want to input notes 
in Insert mode onto multiple staves at once, extend the caret to those staves.

6. Input the notes you want.

7. Optional: Press I  or click Insert  again to deactivate Insert mode and return to normal 
note input.

8. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Notes are inserted at the caret position or where you click without overwriting any existing notes 
at rhythmic positions after the caret. Instead, existing notes after the caret are pushed ahead to 
subsequent rhythmic positions.

The voices and staves affected by Insert mode depend on the Insert mode scope.

RELATED LINKS
Notes toolbox on page 196
Caret on page 218
Insert mode on page 451
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Insert mode scopes on page 452

Inputting notes for unpitched percussion
You can input notes for individual unpitched percussion instruments and on all percussion 
instruments in percussion kits using any presentation type, including selecting playing 
technique-specific noteheads for individual instruments.

When inputting notes in percussion kits, the caret is smaller than when inputting notes on 
pitched instrument or individual percussion instrument staves. Instead of occupying the whole 
height of the staff, the caret in percussion kits is positioned at a particular staff position.

The name of the percussion instrument or slash voice currently selected by the caret, and any 
applicable playing technique, is shown directly above the rhythmic grid display.

NOTE

● You can only input notes into slash voices in percussion kits when using the five-line staff 
presentation type.

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

Inputting notes on instruments with five-line staff kit presentation

PREREQUISITE
If you want to use additional playing technique-specific noteheads for percussion instruments, 
you have defined these in the Percussion Instrument Playing Techniques dialog for each 
instrument.

PROCEDURE

1. In Write mode, select an item on the unpitched percussion instrument/kit staff and at the 
rhythmic position where you want to input notes.

2. In Write mode, start note input in any of the following ways:

● Select a note or rest on the staff where you want to input notes and press Shift-N .

NOTE

You can also press Return ; however, if you select a notation, such as a dynamic, 
pressing Return  opens the corresponding popover instead of starting note input.

● Select a note or rest on the staff where you want to input notes and click Start Note 
Input  in the Notes toolbox.

● Double-click the staff where you want to input notes.

3. Optional: When inputting into percussion kits, move the caret up/down to other instruments 
in the kit in any of the following ways:

● To move it up, press Up Arrow .

● To move it down, press Down Arrow .

4. Select a note duration in any of the following ways:
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● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

5. Select an appropriate playing technique for the instrument currently selected by the caret 
before inputting notes.

● To cycle upwards through playing techniques, press Alt/Opt-Up Arrow .

● To cycle downwards through playing techniques, press Alt/Opt-Down Arrow .

● Play the pitch for the playing technique you want on a MIDI keyboard.

NOTE

You can define MIDI pitches for playing techniques on the Note Input and Editing page 
in Preferences.

6. Input notes in one of the following ways:

● Any kit presentation type/Individual instruments: Press Y  to input notes for the 
instrument and playing technique shown above the rhythmic grid.

● Any kit presentation type/Individual instruments: Click on the staff where you want to 
input notes, and at the rhythmic positions where you want them.

● Five-line staff presentation type: Press letters on a computer keyboard or play notes on 
a MIDI keyboard, corresponding to staff positions for the clef set in Preferences. For 
example, press B  to input notes for the instrument assigned to the middle line of a 
five-line staff when Treble G clef is set.

● Grid and single-line instruments presentation types/Individual instruments: Press the 
letter of any note name A  to G  on a computer keyboard or play any note on a 
MIDI keyboard to input notes for the instrument on whose line the caret is currently 
positioned.

NOTE

Notes played on MIDI keyboards are interpreted differently, depending on whether Use 
percussion map or Use staff position is set for the different kit presentation types in 
Preferences > Note Input and Editing > Note Input.

7. Optional: Advance the caret by the currently selected note duration without inputting notes 
in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

TIP

You can also move the caret in different ways and by different increments.

8. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .
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RESULT
Notes are input at the caret position or where you click with the selected duration and are 
played back as you input them by default. If you selected playing techniques, their noteheads 
appear as set in the Percussion Instrument Playing Techniques dialog for the corresponding 
instrument and playing technique, or in the Override Percussion Noteheads dialog for five-line 
staff presentations only.

If you selected rhythm dots or articulations, notes continue to be input with them until you 
deactivate them.

Dorico Elements notates and beams notes appropriately according to their duration, the 
prevailing time signature, and their position in the bar. This includes showing notes as tie chains 
if required.

If you advance the caret without inputting notes, Dorico Elements fills the gaps between notes 
with implicit rests of the appropriate duration.

TIP

You can change the default beam, note, and rest grouping settings for each flow independently 
in Notation Options. You can also specify custom beat groupings within individual time 
signatures.

RELATED LINKS
Notes toolbox on page 196
Caret on page 218
Percussion kits and drum sets on page 142
Playing techniques for unpitched percussion instruments on page 1420
Specifying the stem direction/voice of instruments in percussion kits on page 1435
Adding slash voices to percussion kits on page 1260
Edit Percussion Kit dialog on page 143
Importing drum set patterns from Groove Agent SE on page 94
Preferences dialog on page 58
Note and rest grouping on page 860
Notation Options dialog on page 747

Note input setup for percussion kits
Inputting music for unpitched percussion instruments works differently than for pitched 
instruments. You can use any of the usual methods for unpitched percussion input, but using 
a MIDI keyboard or a computer keyboard is most efficient.

● You can find options relating to note input for percussion in Preferences > Note Input and 
Editing > Note Input.

There is one set of options for input onto five-line staves, and another set of options for input 
onto grids and individual instruments.

The main choice affects input via MIDI keyboards and computer keyboards.

Use percussion map
A percussion map defines which MIDI notes produce which sound for a particular 
patch in a sound library. For example, in General MIDI percussion, C2 (note 36) 
produces bass drum, and D2 (note 38) produces snare drum, and so on.

If you know a particular mapping well, you may find it helpful to use the mapping 
directly for input.
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Use staff position
This option uses the staff position defined in the Edit Percussion Kit dialog. For 
example, on a drum set, the bass drum is normally positioned in the bottom space 
of the staff, while the snare drum is positioned in the third space from the bottom.

You can think of staff positions relative to what they would be when using a treble G 
clef (F4 and C5 respectively) or using a bass F clef (A2 and E3 respectively).

You can choose which clef is used to interpret staff positions for five-line staves:

● Treble G clef

● Bass F clef

When you select Use staff position, you can designate one octave of your MIDI keyboard to 
input playing techniques.

By default, the Input techniques from MIDI key option is set to MIDI note 48, which is C3 
when using the middle C numbering convention that middle C (MIDI note 60) is numbered as C4. 
You can click the MIDI learn button and then play a note on your MIDI keyboard to change the 
starting pitch. Assuming a starting pitch of C3, ascending notes operate as follows:

● C3 (48): Previous playing technique

● C♯3 (49): Next playing technique

● D3 (50): First mapped playing technique

● E♭3 (51): Second mapped playing technique

● E3 (52): Third mapped playing technique

And so on, up to:

● B3 (59): Tenth mapped playing technique

In general, we recommend that you set Use staff position for percussion input. Use percussion 
map is normally only useful when you are inputting notes onto a drum set and you have already 
memorized the General MIDI percussion map.

RELATED LINKS
Preferences dialog on page 58
Edit Percussion Kit dialog on page 143
Changing playing technique-specific noteheads on page 1424
Changing the middle C numbering convention on page 51

Default note selection during note input for percussion kits
During note input in percussion kits, you can press the letters on a computer keyboard that 
correspond to staff positions for kits using the five-line staff presentation type. For example, you 
can press F  to input a note on the F space or line.

In Preferences > Note Input and Editing > Note Input, you can set options for inputting notes 
into percussion kits. For example, if you want to use staff positions to determine notes, choose 
Use staff position for Input onto kit or grid.

If you have the staff positions set relative to Treble G clef, then F could mean either the bottom 
space on the staff or the top line on the staff. In a standard drum set, this means either the kick 
drum in the bottom space, or the ride cymbal on the top line.

When inputting notes in pitched instruments, Dorico Elements chooses the lower or upper 
possible staff position based on which is closer to the current position of the caret.
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However, when inputting notes in percussion kits, Dorico Elements chooses the staff position of 
the note with the same stem direction as the last input note, rather than the staff position that is 
closest to the current position of the caret. This makes it easier to input common note patterns 
used in percussion kits.

For example, inputting kick drum and snare drum notes on a standard drum set is a common 
pattern. The kick drum is in the bottom space, and the snare drum is two spaces above: five staff 
positions away from the bottom space, and four staff positions away from the top line.

You can press F  for the kick drum and C  for the snare drum.

The default stem direction behavior for inputting notes in kits in Dorico Elements means that you 
can alternate pressing F  and C , and the notes are input at the positions of the kick drum and 
snare drum, even though the top line is the closer position after inputting a snare drum note.

This is because the kick drum uses the same stem direction, and therefore voice, as the snare 
drum.

NOTE

Dorico Elements automatically changes the directions of stems according to the positions of 
notes on the staff when only one voice on the staff contains notes, regardless of their voice.

RELATED LINKS
Stem direction on page 1074

Inputting notes on tablature
You can input notes directly into tablature in the same ways as inputting normal notes. When 
inputting notes on tablature, the caret is smaller than when inputting notes on standard five-line 
staves and behaves as if chord input is always active, meaning you must advance the caret 
manually to input notes at other rhythmic positions.

NOTE

These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

When inputting notes on tablature using pitch before duration, you must select note durations 
by clicking them in the Notes panel.

PROCEDURE

1. In Write mode, select an item on the tablature and at the rhythmic position where you want 
to input notes.

NOTE

If both notation staves and tablature are shown in the current layout, you must select an 
item on the notation staff and then move the caret to the tablature after starting note input.

2. Start note input in any of the following ways:

Write mode
Note input 

242
Dorico Elements 5.1.30



● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Select a note duration in any of the following ways:

● To select the next longer duration, press = .

● To select the next shorter duration, press - .

● In the Notes panel, click the duration you want.

● In the Fretboard panel toolbar, click the duration you want.

4. Input the pitch you want for the current string in any of the following ways:

● Press the number on your computer keyboard or numeric keypad that corresponds to 
the fret number you want. For example, press 6  for fret 6.

For fret numbers 10 and above, press the two digits quickly.

● Press the corresponding letters on your computer keyboard.

NOTE

When using letters, Dorico Elements automatically chooses the octave closest to the nut 
on the corresponding string.

● In the Fretboard panel, click the corresponding string and fret position.

● Play the note on a MIDI keyboard.

5. Move the caret up/down to input notes on different strings at the same rhythmic position in 
any of the following ways:

● To move it up, press Up Arrow .

● To move it down, press Down Arrow .

6. Move the caret to other rhythmic positions in any of the following ways:

● To move the caret according to the current rhythmic grid resolution, press 
Right Arrow / Left Arrow .

● To advance the caret according to the note duration currently selected, press Space  or 
click Advance Caret  in the Fretboard panel toolbar.

● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

RESULT
Notes are input at the caret position with the selected duration on the string indicated by the 
caret and are played back as you input them by default. Notes continue to be input at the caret 
position until you move the caret manually and overwrite any previous note on the same string. 
If you attempt to input a note that is impossible on the current string, it is input on the closest 
available string in addition to any existing notes.

If you have input two or more notes on the same string at the same rhythmic position, they 
are shown next to each other on tablature and are colored green. Similarly, when you input 
chords on tablature using pitch before duration with a MIDI keyboard, all notes in the chord 
are allocated to the same string. You can then select them individually and change their string 
allocation.

RELATED LINKS
Caret on page 218
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Fretboard panel on page 208
Tablature on page 1330
Hiding/Showing notation staves and tablature on page 1331
Changing the allocated string for notes on tablature on page 1332

Inputting accidentals
You can input accidentals during note input and by adding them to existing notes. You can also 
change the accidentals of existing notes.

NOTE

● Accidentals that are part of the prevailing key signature are input automatically. For example, 
if you press F  in G major, an F♯ is input automatically. You would only need to specify an 
accidental if you want to input an F♮, for example.

This also applies if you are using a MIDI keyboard, though you can respell notes if the 
accidentals chosen automatically are not the ones that you expected.

● These steps describe selecting accidentals before inputting each note. However, you can 
change this setting if you prefer to specify accidentals after inputting notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the existing notes to which you want to add accidentals or whose accidentals you 
want to change.

2. Select the accidental you want to input in one of the following ways:

● For a flat accidental, press - .

● For a sharp accidental, press = .

● For a natural accidental, press 0 .

● In the Notes panel, click the accidental you want.

TIP

You can find more accidentals, such as double sharps/flats or microtonal accidentals, in the 
Accidentals section of the Key Signatures, Tonality Systems, and Accidentals panel on the 
right of the window.

3. Optional: During note input, input the note you want with your selected accidental.

RESULT
The accidental is added to the selected existing notes. If you selected existing notes with 
different accidentals, they are changed to have the accidental you selected.

During note input, the selected accidental is only input on the next note you input. You must 
reselect the accidental for each subsequent note.

NOTE

● Due to the default accidental duration rule in Dorico Elements, subsequent accidentals for 
the same note in the same register do not appear in the same bar.
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● If you input notes using a MIDI device, Dorico Elements automatically shows an accidental 
if necessary. It selects a sharp, flat, or natural based on key signature and context. You 
can later respell notes so they are shown as their enharmonic equivalents with different 
accidentals.

RELATED LINKS
Notes panel on page 200
Accidentals on page 792
Changing the note-based notation input setting on page 214
Respelling notes on page 473
Changing the pitch of individual notes on page 468
Accidental duration rules on page 800

Accidental selection during MIDI input
Dorico Elements interprets MIDI data to create accidentals, and automatically determines the 
spelling of notes according to preset rules.

Dorico Elements automatically displays an accidental if one is required. It selects a sharp or flat 
based on key signature and context.

The algorithm for this takes into account the key signature and the intervals between successive 
notes and chords. Therefore Dorico Elements prefers sharp accidentals in a key with sharps, and 
flats in a key with flats. If you change the spelling of an accidental, Dorico Elements follows your 
spelling preference whenever that note is used again in the score.

If you input notes with accidentals outside the key signature, Dorico Elements uses sharps if the 
figure is rising, and flats if it is falling. The spelling is also calculated vertically, meaning a simpler 
interval is produced where possible, such as a major third rather than a diminished fourth.

By default, Dorico Elements makes retrospective changes to how it has spelled accidentals, 
depending on how your music develops. For example, in C major, if you input a sequence of 
pitches C-E-G♯, but then input a G♭, the G♯ is respelled as an A♭.

Inputting rests
Dorico Elements automatically shows rests as appropriate in the gaps between the notes you 
input. However, you can also input rests manually; for example, to show fermatas on specific 
beats for players without notes in that bar.

NOTE

These steps describe selecting the duration before inputting rests. However, you can also input 
rests when Pitch Before Duration is active, in which case step 7 is unnecessary.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input rests.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.
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3. Optional: If you want to input rests onto multiple staves at once, extend the caret to those 
staves.

4. Start rest input in any of the following ways:

● Press , .

● In the Notes toolbox, click Rests .

5. Activate Force Duration in any of the following ways:

● Press O .

● In the Notes toolbox, click Force Duration .

6. Select the rest duration you want.

7. Input rests in any of the following ways:

● Press Y  or any of the letters from A  to G .

● Click the staff at the rhythmic position of each rest you want to input.

A shadow rest appears when inputting with the mouse to indicate where the rest will be 
input.

● Play notes on a MIDI keyboard.

8. Optional: Press ,  or click Rests  again to stop rest input.

9. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Rests of the selected duration are input. If Force Duration is not activated, Dorico Elements 
automatically combines adjacent rests as appropriate for their position in relation to notes and 
according to the current meter.

RELATED LINKS
Rests on page 1271
Implicit vs. explicit rests on page 1272
Note and rest grouping on page 860
Notes toolbox on page 196
Extending the caret to multiple staves on page 222
Selecting note/rest durations on page 259
Forcing the duration of notes/rests on page 262

Inputting bar rests into specific voices
When inputting music in multiple voices, rests are normally created automatically when there is a 
gap in the secondary voice. However, if you want secondary voices to begin with explicit bar rests 
in strict contrapuntal music, you can input a bar rest into those voices.

For music in a single voice, you do not have to input bar rests as they appear in each new bar 
automatically when you advance the caret. You can also hide/show bar rests in all empty bars in 
each layout independently.

PROCEDURE

1. In Write mode, start note input.
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2. Select the appropriate secondary voice by pressing V  until the voice direction indicator 
shows the correct voice.

Alternatively, if you want to input bar rests into a new voice, press Shift-V  until the voice 
direction indicator shows the correct voice.

3. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

4. Enter rest into the popover to add a bar rest.

5. Press Return  to close the popover.

6. Press Ctrl/Cmd-Right Arrow  to advance the caret to the start of the next bar after the bar 
rest.

7. Optional: If you want to show bar rests in multiple bars for the selected voice, repeat steps 3 
to 6 as many times as required.

TIP

If your notation options are set to show bar rests in additional voices, bar rests appear in all 
subsequent empty bars for the selected voice after you have input one bar rest.

RESULT
Bar rests are input into the selected voice at the caret position. If the caret position is within a bar 
that contains notes for the selected voice, these notes are replaced by the bar rest.

NOTE

Alternatively, you can click Insert Bar Rest in the Insert Bar Rest section of the Bars and 
Barlines panel to input bar rests during note input.

RELATED LINKS
Bars and barlines popover on page 301
Caret on page 218
Hiding/Showing bar rests in empty bars on page 1277
Hiding/Showing bar rests in additional voices on page 1278

Inputting ties
You can input ties manually to join two notes of the same pitch, both during note input and by 
joining two existing notes with a tie. You can tie existing notes in different voices or on different 
staves belonging to the same instrument, or that are not rhythmically adjacent.

For example, you might have input a melody across multiple voices in order to accommodate 
passing notes, but want to tie two notes together even though they are in different voices. 
Similarly, you might have written multiple notes before a chord that are all held down and want 
to reduce the number of tied notes.

TIP

Dorico Elements automatically creates ties as required for note durations in each meter. For 
example, if you want to input a tie between two quarter notes across a barline, you can input 
a half note at the rhythmic position where you want to input the first quarter note. Dorico 
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Elements automatically splits the half note into two quarter notes, one on each side of the 
barline, and joins them with a tie.

PREREQUISITE
If you want to preserve the durations of existing notes, you have forced their duration. For 
example, if you want to specify subdivisions within a tie chain that are different than the 
prevailing meter.

We also recommend starting ties from the first note in the tie chain, as tied notes become a 
single note whose settings, including forced durations, come from the first note.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the note from which you want the tie to start. If you want to input a tie between 
two specific notes or between a grace note and a normal note, select those two notes.

NOTE

The two notes must be the same pitch, but can be in different voices or on different 
staves belonging to the same instrument.

2. Optional: During note input, input the note that you want at the start of the tie.

3. Input a tie in any of the following ways:

● Press T .

● In the Notes toolbox, click Tie .

4. Optional: During note input, input the note that you want at the end of the tie.

NOTE

The second note must be the same pitch as the first note.

RESULT
During note input, the two notes input are joined by a tie.

If you selected a single existing note, it is joined by a tie to the next note of the same pitch in the 
same voice and staff. If you selected two existing notes, they are tied together, provided they are 
the same pitch and belong to the same instrument.

NOTE

● During note input, Dorico Elements ties the first note you input after inputting the tie to the 
previous note of the same pitch in the same voice and staff, even if there are other notes of 
other pitches between them.

● Depending on the prevailing time signature, the position of the start of the note in the bar, 
and your settings on the Note Grouping page in Notation Options, inputting a tie between 
two notes can instead create a single note of a different duration, such as a half note instead 
of two tied quarter notes. You can override your note grouping settings and fix your notated 
rhythm by forcing their duration. Dorico Elements then notates your input notes with the 
rhythmic durations specified, as long as they can fit inside the bar.
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EXAMPLE

Ties between adjacent notes Ties between non-adjacent notes Ties between grace notes 
and normal notes

RELATED LINKS
Note and rest grouping on page 860
Hiding/Showing ties across beat boundaries on page 861
Forcing the duration of notes/rests on page 262
Notes toolbox on page 196
Inputting notes on page 224
Ties vs. slurs on page 1365

Inputting grace notes
You input grace notes in the same ways as normal notes, and they can have any rhythmic note 
value, accidental, and articulation.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

● You cannot add rhythm dots to grace notes.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input grace notes.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Optional: If you want to input grace notes onto multiple staves at once, extend the caret to 
those staves.

4. Start grace note input in any of the following ways:

● Press / .

● In the Notes toolbox, click Grace Notes .

5. Press the number for the note duration you want. For example, press 5  for eighth grace 
notes.

6. Optional: Switch between inputting slashed/unslashed grace notes in any of the following 
ways:

● Press Alt/Opt-/ .
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● In the Notes toolbox, click and hold Grace Notes , then click Unslashed Grace Notes 
 or Slashed Grace Notes .

Grace Notes  in the Notes toolbox updates to indicate the current grace note type.

7. Input the grace notes you want.

TIP

There is no limit to the number of grace notes that can exist at the same rhythmic position.

8. Press /  or click Grace Notes  again to stop grace note input and return to normal note 
input.

RESULT
The pitches you enter are input as grace notes at the caret position.

TIP

● You can also change the type of grace notes after they have been input.

● Slashed and unslashed grace notes are handled differently in playback.

RELATED LINKS
Grace notes on page 1002
Selecting note/rest durations on page 259
Notes toolbox on page 196
Extending the caret to multiple staves on page 222
Inputting notes on page 224
Changing the type of grace notes on page 1006
Grace notes in playback on page 1009

Creating grace note runs for percussion kits
You can create runs of consecutive grace notes for different instruments in percussion kits; for 
example, to indicate a short drum fill.

PROCEDURE

1. In Write mode, input the grace notes that you require for each instrument in the percussion 
kit.

NOTE

● When percussion kits use the grid or five-line staff presentation types, grace notes at the 
same rhythmic position appear as a chord by default.

● We recommend creating grace note runs by starting from the end of the run and 
working backwards.

2. Select the grace note that you want to be the penultimate note in the run.

3. Press Alt/Opt-Left Arrow  once.
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4. Select the grace note that you want to appear to the left of the previous note.

5. Press Alt/Opt-Left Arrow  twice.

6. Optional: Repeat steps 4 to 5 as many time as required for the number of grace notes in your 
run.

NOTE

You must increase the number of Alt/Opt-Left Arrow  presses by 1 each time.

RESULT
The grace notes at the selected rhythmic position are spread out and appear as a run. This 
affects both the grid and five-line staff presentation types.

EXAMPLE

Run of four grace notes on a five-line staff percussion kit

RELATED LINKS
Inputting notes for unpitched percussion on page 238
Percussion kit presentation types on page 1428

Inputting chords
You can input chords during note input when both note input and Chords are activated. You can 
input notes with a computer keyboard, with the mouse, using panels in the lower zone, or by 
playing notes with a MIDI keyboard.

NOTE

● These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

When inputting chords using pitch before duration, you must use your computer keyboard 
or a MIDI keyboard and complete step 6 before step 5.

● You can only input chords in Insert mode when using a MIDI keyboard.
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● You can input chords without activating Chords when using the Keyboard panel, Fretboard 
panel, or a MIDI keyboard.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input chords.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Start chord input in any of the following ways:

● Press Q .

● In the Notes toolbox, click Chords .

In chord input, a + sign appears at the top of the caret. This allows you to input multiple 
notes at the caret position.

4. Optional: If you want to input chords onto multiple staves at once, extend the caret to those 
staves.

5. Select a note duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

6. Input the pitches you want in any of the following ways:

● Press the corresponding letters on your keyboard.

TIP

Dorico Elements automatically inputs notes above the highest note at the caret position 
when Chords  is activated.

You can input notes below the lowest note at the caret position instead by pressing Ctrl-
Alt (Windows) or Ctrl (macOS)  as well as the letter for the note name; for example, 
Ctrl-Alt-A (Windows) or Ctrl-A (macOS) .

● Click the staff at the rhythmic positions where you want to input notes.

A shadow notehead appears when inputting with the mouse to indicate where the note 
will be input.

● In the Keyboard, Fretboard, or Drum Pads panel, play the notes you want.
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● Play the notes on a MIDI keyboard.

7. Optional: Advance the caret to input chords at other rhythmic positions in any of the 
following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

During chord input, notes are input at the same rhythmic position and above the previous 
note until you advance the caret manually.

TIP

You can also move the caret in different ways and by different increments.

8. Press Q  or click Chords  again to stop chord input.

9. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
Multiple notes are input at the caret position.

● If entering pitches by clicking with the mouse, you can put the same pitch into the chord 
twice by clicking again on the same line.

● If entering pitches with the keyboard, repeated notes are automatically input an octave 
above. You can change the register of notes by forcing the register selection during note 
input, or by transposing them after they have been input.

NOTE

● You can stop chord input and immediately continue inputting notes as before, with a single 
note at each rhythmic position and the caret advancing automatically to the next rhythmic 
position.

● When chords contain two pitches in the same register but with different accidentals, that is 
known as an altered unison. Altered unisons are shown with either single stems or with split 
stems, depending on your settings on the Accidentals page in Notation Options.

● When you input chords on tablature using pitch before duration with a MIDI keyboard, all 
notes in the chord are allocated to the same string. In such cases, the notes are shown next 
to each other on tablature and are colored green. You can then select them individually and 
make your own string allocation.

RELATED LINKS
Register selection during note input on page 226
Changing the note-based notation input setting on page 214
Notes toolbox on page 196
Notes panel on page 200
Keyboard panel on page 206
Fretboard panel on page 208
Drum Pads panel on page 209
Extending the caret to multiple staves on page 222
Moving the caret manually on page 223
Altered unisons on page 798
Adding notes above/below existing notes on page 258
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Changing the allocated string for notes on tablature on page 1332

Chord mode
Chord mode changes how notes are input and how edits you make outside of note input affect 
the music. When Chord mode is activated, notes can overlap or stack on top of each other to 
create chords rather than overwriting existing notes. During chord input, the caret does not 
advance automatically.

Edits outside of chord input that are affected by Chord mode include copying/pasting notes or 
changing their duration. For example, if you copy four notes and paste them to a staff that 
already has notes with Chord mode activated, the existing notes are not overwritten but instead 
combine with the new notes to make chords.

● You can activate/deactivate Chord mode in Write mode by pressing Q  or clicking Chords 
in the Notes toolbox.

NOTE

You cannot have both Insert mode and Chord mode activated simultaneously.

RELATED LINKS
Insert mode on page 451
Caret on page 218
Copying and pasting notes/items on page 457
Changing the duration of notes on page 259
Inputting notes with rhythm dots on page 230

Inputting tuplets
You can input all types of tuplets using the tuplets popover. Tuplets can contain notes of any 
duration, such as a quarter note at the start of an eighth note triplet.

NOTE

These steps describe inputting notes with the default preference of duration before pitch. 
However, you can also specify the pitch before duration instead.

When inputting tuplets using pitch before duration, Dorico Elements determines the base value 
of the tuplet on either the first note you input after specifying the tuplet or the note value 
included in your tuplet ratio.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input tuplets.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Optional: If you want to input tuplets onto multiple staves at once, extend the caret to those 
staves.

4. Open the tuplets popover in any of the following ways:
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● Press ; .

● In the Notes toolbox, click and hold Tuplets , then click x:y .

When inputting tuplets with the keyboard, Dorico Elements automatically continues 
inputting notes as the specified tuplet.

5. Enter the tuplet you want into the popover as a ratio followed by the beat unit.

For example, enter 3:2e to input eighth note triplets or 5:4x to input sixteenth note 
quintuplets.

NOTE

If you do not specify the beat unit, the tuplet is based on the note value currently selected in 
the Notes panel.

6. Press Return  to close the popover.

The tuplet is entered.

7. Optional: Change the selected note duration.

For example, you can input a tuplet based on eighth notes but input a quarter note within 
that tuplet.

8. Enter or play in the pitches you want.

When inputting tuplets with the keyboard, Dorico Elements automatically continues 
inputting notes as the specified tuplet.

9. Optional: Advance the caret to continue inputting tuplets of the same ratio at later rhythmic 
positions in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

10. Stop tuplet input in one of the following ways:

● To return to inputting normal notes, press :  or move the caret with the arrow keys.

● To stop note input completely, press Esc .

RESULT
The pitches you enter or play in are input as tuplets, starting from the caret position.

If you want to input a different type of tuplet immediately after inputting tuplets, you must stop 
the first type of tuplet before inputting the second type. If you do not stop the first type, the 
second type is input as a nested tuplet.

TIP

You can also input tuplets by clicking and holding Tuplets  in the Notes toolbox, then clicking 
the tuplet you want.

RELATED LINKS
Tuplets on page 1408
Nested tuplets on page 1408
Selecting note/rest durations on page 259
Notes toolbox on page 196
Notations toolbox on page 201
Keyboard panel on page 206
Fretboard panel on page 208
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Drum Pads panel on page 209
Inputting notes on page 224
Extending the caret to multiple staves on page 222

Tuplets popover
The tuplets popover allows you to input tuplets of any ratio and based on any note duration. The 
table contains examples of what you can enter into the tuplets popover to input different types 
of tuplets.

You can open the tuplets popover in Write mode during note input or when notes are selected in 
any of the following ways:

● Press ; .

As tuplets are often described in ratios, such as 3:2, the tuplets popover uses the semicolon 
key to be memorable.

● In the Notes toolbox, click and hold Tuplets , then click x:y .

● Choose Write > Create Tuplet.

The icon on the left-hand side of the popover matches the corresponding button in the Notes 
toolbox on the right of the window.

Tuplets popover with an example entry
Tuplets button in the Notes toolbox

When inputting tuplets with the keyboard, Dorico Elements continues to input notes as the 
specified tuplet until any of the following happens:

● You press :  to return to inputting normal notes.

● You move the caret with the arrow keys.

● You stop note input.

Type of tuplet Popover entry

Triplet, three notes in the space of two 3, 3:2, 3/2, or 3 2

Triplet, three notes in the space of four 3:4, 3/4, or 3 4

Quadruplet, four notes in the space of three 4:3, 4/3, or 4 3

Quintuplet, five notes in the space of two 5:2, 5/2, or 5 2

Quintuplet, five notes in the space of four 5:4, 5/4, or 5 4

Sextuplet, six notes in the space of four 6:4, 6/4, or 6 4

Septuplet, seven notes in the space of four 7:4, 7/4, or 7 4

Nonuplet, nine notes in the space of eight 9:8, 9/8, or 9 8
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Type of tuplet Popover entry

Duplet, two notes in the space of three. Often 
used in compound meters.

2:3, 2/3, or 2 3

Quintuplet, five notes in the space of six. Often 
used in compound meters.

5:6, 5/6, or 5 6

Quintuplet, five dotted quarter notes in the 
space of four

NOTE

When using a number to specify the beat unit, 
you must separate the tuplet ratio from the 
beat unit using a space or hyphen.

5:4q., 5/4q., 5 4q., or 5:4-6.

This list is not comprehensive. It is intended to illustrate how you can structure your entry to 
input different tuplets.

NOTE

Unless you specify a beat unit in your entry, the total duration of the tuplet depends on the note 
value selected when you open the popover. For example, if a quarter note is selected when you 
input a triplet, the triplet input is three quarter notes in the space of two.

Tuplet beat units

Tuplet beat unit Popover entry

64th note z or 2

32nd note y or 3

16th note x or 4

Eighth note e or 5

Quarter note q or 6

Half note h or 7

Whole note w or 8

Double whole note 2w or 9

Rhythm dot . (period)

RELATED LINKS
Turning existing notes into tuplets on page 1410
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Selecting note/rest durations on page 259

Adding notes above/below existing notes
You can add notes above/below existing notes. You can add multiple notes at the same time, 
according to their intervals relative to the existing notes.

PREREQUISITE
If you want to use the mouse, you have enabled mouse editing.

PROCEDURE

1. In Write mode, select the notes to which you want to add notes.

2. Open the note tools popover in any of the following ways:

● Press Shift-I .

● In the Notations toolbox, click Popovers , then Note Tools .

3. Enter the intervals of the notes you want, relative to your selected notes.

For example, enter -m3,4 to add notes a minor third below and a fourth above the selected 
notes.

4. Press Return  to close the popover.

RESULT
Notes are added to the selected notes according to the intervals specified.

TIP

You can also add notes above/below existing notes by Alt/Opt -dragging selected notes 
upwards/downwards.

When you drag notes, shadow noteheads indicate their destination pitches, and the affected 
region appears highlighted with the rhythmic grid shown above it.

RELATED LINKS
Note tools popover on page 487
Notations toolbox on page 201
Rhythmic grid on page 217
Arranging tools on page 455
Enabling/Disabling mouse editing on page 212

Note durations
In Dorico Elements, you can change note durations both during note input and for existing 
notes.

RELATED LINKS
Notes and rests in Dorico on page 23
Note and rest grouping on page 860
Played vs. notated note durations on page 687
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Selecting note/rest durations
You can select different durations for notes/rests, both during note input and for existing notes/
rests.

PROCEDURE

1. Optional: If you want to select a note duration not shown in the Notes panel, click the Show/
Hide All Notes disclosure arrows at the top and bottom of the notes list to show more note 
durations.

2. Select a note/rest duration in any of the following ways:

● Press the number on your computer keyboard that corresponds to the duration you 
want.

For example, press 6  for quarter notes (crotchets). Press smaller numbers for smaller 
durations, such as 5  for eighth notes (quavers) and 4  for 16th notes (semiquavers). 
Press larger numbers for larger durations, such as 7  for half notes (minims).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

3. Optional: Add rhythm dots to the duration in one of the following ways:

● For a single rhythm dot, press . .

● For multiple rhythm dots, press Alt/Opt-.  to cycle through different numbers of rhythm 
dots. You can specify up to four rhythm dots.

● In the Notes toolbox, click Dotted Notes  to add the displayed number of rhythm 
dots.

● In the Notes toolbox, click and hold Dotted Notes  to access different numbers of 
rhythm dots.

NOTE

You cannot add rhythm dots to grace notes.

RELATED LINKS
Notes toolbox on page 196
Keyboard panel on page 206
Fretboard panel on page 208
Drum Pads panel on page 209
Notes panel on page 200
Caret on page 218
Key commands in Dorico on page 26
Inputting notes on page 224

Changing the duration of notes
You can lengthen/shorten the duration of notes after they have been input.

PROCEDURE

1. In Write mode, select the notes whose duration you want to change.
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NOTE

If you want to extend a note to the end of the current selection, select both that note and an 
item at the rhythmic position to which you want to extend the note.

2. Change the duration in any of the following ways:

● Press the key command of the duration you want. For example, press 4  for a 16th note 
(semiquaver).

● In the Notes panel, click the duration you want.

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click the duration you want.

● To lengthen notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To double the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Right Arrow .

● To halve the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● To lengthen notes by the current rhythmic grid resolution, choose Write > Edit 
Duration > Lengthen Duration by Grid Value.

● To shorten notes by the current rhythmic grid resolution, choose Write > Edit 
Duration > Shorten Duration by Grid Value.

● To double the length of notes, choose Write > Edit Duration > Double Note Duration.

● To halve the length of notes, choose Write > Edit Duration > Halve Note Duration.

● To lengthen notes up to the next existing note in their voice, choose Write > Edit 
Duration > Extend to Next Note.

NOTE

This does not apply to grace notes.

● To lengthen a single note up to the rhythmic position of the end of the current selection, 
choose Write > Edit Duration > Extend to End of Selection.

● To shorten overlapping notes in the same voice so that they no longer overlap, choose 
Write > Edit Duration > Shorten to Next Note.

RESULT
The duration of the selected notes is changed. Dorico Elements automatically notates and beams 
the notes appropriately according to their new duration, the prevailing time signature, and their 
position in the bar.

When extending notes, their duration fills in any intervening rests. Extending notes to the end 
of the current selection does not delete any intervening notes, instead they combine with the 
extended note to create chords where necessary.

TIP

You can assign your own key commands to lengthen/shorten notes by specific durations and to 
extend them. You can find these by searching for Shorten duration by, Lengthen duration by, 
and Extend to on the Key Commands page in Preferences.

RELATED LINKS
Notes panel on page 200
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Notes toolbox on page 196
Keyboard panel on page 206
Fretboard panel on page 208
Drum Pads panel on page 209
Rhythmic grid on page 217
Key Commands page in the Preferences dialog on page 60
Insert mode on page 451
Chord mode on page 254
Lengthening/Shortening items on page 430
Played vs. notated note durations on page 687
Changing the voice of existing notes on page 466
Note and rest grouping on page 860
Hiding/Showing ties across beat boundaries on page 861

Splitting notes by duration
You can split notes by either a specific duration, the current rhythmic grid resolution, or the 
duration between the start of the note and the caret position; for example, to turn a long tie 
chain into a sequence of eighth notes.

PROCEDURE

1. In Write mode, select the notes you want to split.

2. Split the selected notes in any of the following ways:

● To split them by the current rhythmic grid resolution, press Alt/Opt-U  or choose 
Write > Edit Duration > Split by Rhythmic Grid Resolution.

● To split them by the duration between the start of the note and the caret position, 
activate the caret, extend it across the required staves, move the caret to the required 
position, then press Alt/Opt-U .

● To split them by a specific duration, choose Write > Edit Duration > Split by Note 
Duration > [Note duration].

RESULT
The selected notes, or notes across which the caret extends, are split into multiple, shorter notes 
of the corresponding duration. If multiples of the selected duration do not fit exactly into the 
original notes, the final note is shortened.

EXAMPLE

A phrase containing long notes Up-stem notes split into eighth notes

RELATED LINKS
Rhythmic grid on page 217
Caret on page 218
Activating/Deactivating the caret on page 222
Moving the caret manually on page 223
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Extending the caret to multiple staves on page 222
Deleting ties on page 1373
Splitting tie chains on page 1373

Forcing the duration of notes/rests
Dorico Elements automatically notates and beams notes/rests appropriately according to the 
prevailing time signature and their position in the bar. You can force the duration of notes/rests 
to specify their notation.

For example, if you input a half note at the start of a 6/8 bar, it is notated as a dotted quarter 
note (crotchet) tied to an eighth note (quaver). This is because, according to convention, 6/8 bars 
are subdivided into two groups of three eighth notes. To reflect this for a half note (four eighth 
notes), Dorico Elements automatically divides the note to show the correct grouping, but you can 
force the note duration to show a half note instead.

TIP

If you want to force the duration of all notes on a staff to imply a different meter, for example, 
to show three quarter note groups in 6/8 to indicate a hemiola, you can also input a time 
signature only on those staves to group notes according to that meter. You can then hide the 
time signatures if required.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select existing notes whose duration you want to force.

TIP

If you later want to tie notes together, we recommend forcing the duration of all notes 
you want in the tie chain.

2. Optional: If you want input rests with forced durations, start rest input in any of the following 
ways:

● Press , .

● In the Notes toolbox, click Rests .

3. Activate Force Duration in any of the following ways:

● Press O .

● In the Notes toolbox, click Force Duration .

4. Select the note/rest duration you want.

TIP

If you want tie chains to appear as single noteheads with the same total duration, you must 
first reduce their duration, then change it to the duration you want.

5. Optional: During note or rest input, input the notes or rests you want.

Write mode
Note durations 

262
Dorico Elements 5.1.30



RESULT
During note or rest input, any notes you input are notated with their whole rhythmic value, 
whatever their position in the bar. If you move them later, they keep the same notation. Rests are 
input as explicit rests. Notes that cross barlines are notated as tied notes.

Forcing the duration of existing notes or rests preserves their current duration or any duration to 
which you subsequently change them.

TIP

● Force position and duration in the Notes and Rests group of the Properties panel is 
activated automatically for rests input with forced durations. You can also use this property 
to force the duration and position of rests.

● You can choose whether or not Force Duration retains its previous state when you stop and 
restart note input in Preferences > Note Input and Editing > Note Input.

● You can change how notes are grouped in different contexts project-wide on the Note 
Grouping page in Notation Options.

EXAMPLE

Default notation of notes in 6/8 Notes in the down-stem voice input with forced 
durations

RELATED LINKS
Implicit vs. explicit rests on page 1272
Notes toolbox on page 196
Notes panel on page 200
Caret on page 218
Inputting notes on page 224
Inputting rests on page 245
Inputting ties on page 247
Selecting note/rest durations on page 259
Changing the duration of notes on page 259
Notation Options dialog on page 747
Beam grouping according to meters on page 841
Note and rest grouping on page 860
Hiding/Showing ties across beat boundaries on page 861
Creating custom beat groupings for meters on page 861
Turning explicit rests into implicit rests on page 1274
Changing the voice of existing notes on page 466
Changing the style of ties on page 1366
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MIDI recording
MIDI recording is a way of inputting notes into Dorico Elements by playing them in real time on 
a MIDI device. This can be particularly useful if, for example, you prefer to improvise your music 
rather than plan pitches and note durations in advance.

In Dorico Elements, you can record MIDI notes using any MIDI device.

Dorico Elements automatically transcribes multiple simultaneous parts into separate voices, such 
as in contrapuntal piano music. Depending on your settings for MIDI recording and quantization, 
Dorico Elements can also detect slurs, tremolos, trills, pedal lines, tuplets, and grace notes.

Outside of note input, Dorico Elements uses the instrument sounds of your most recent selection 
for the notes you play on your MIDI device. In Play mode, this is the most recent track header 
you clicked, while in Write mode, this is the last instrument staff on which you selected an item, 
started note input, or into which you recorded MIDI. During note input, Dorico Elements always 
uses the instrument sounds of the instrument into which you are recording notes.

TIP

You can enable/disable MIDI thru on the Play page in Preferences. For example, if you do not 
want to hear sounds in Dorico Elements when playing on your MIDI keyboard.

As you play notes on your MIDI device, Dorico Elements uses an algorithm to produce the correct 
enharmonic spelling for those notes.

RELATED LINKS
Optimization for MIDI recording on page 268
Quantization options on page 93
MIDI Import Options dialog on page 85
Enabling/Disabling MIDI thru on page 216

Inputting notes using MIDI recording
You can input notes by recording what you play on a MIDI device in real time. You can record 
notes in both concert and transposed pitch.

PREREQUISITE

● You have connected the MIDI device you want to use.

● You have set the quantization and recording options on the Play page in Preferences as 
required for the music you intend to record.

● You have input enough bars or empty rhythmic space for the amount of music you want to 
record. Dorico Elements does not automatically add extra bars or rhythmic space.

● If you want to hear a click during your recording, you have input a time signature. There is 
no click in open meter or when there is no time signature.

● You have chosen the appropriate input pitch setting.

PROCEDURE

1. Select a note or rest on the staff/instrument track into which you want to record notes, at the 
position from which you want to record. You can do this in Write mode and Play mode.

NOTE

● In Play mode you cannot select rests, meaning you can only record into instrument 
tracks that already contain at least one note.

Write mode
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● You can also record MIDI during note input, but this prevents Dorico Elements from 
using both staves in grand staff instruments.

2. Optional: If you want to record notes without overwriting any existing notes on the staff, 
activate Chord mode in any of the following ways:

● Press Q .

● In the Notes toolbox, click Chords .

3. Optional: If you want to record into a specific voice on the staff, in Write mode, press Shift-N 
to start note input, then do one of the following:

● If the voice you want already exists on the staff, press V  until the note symbol beside 
the caret indicates the correct voice.

● If the voice you want does not exist on the staff yet, press Shift-V  until the note symbol 
beside the caret indicates the correct voice.

4. Press Ctrl/Cmd-R  to start recording.

During recording, the playhead appears red and moves along in time. By default, there is 
one bar of count-in before the playhead reaches the rhythmic position of either your original 
selection or the caret.

5. Play the notes you want on your MIDI device.

NOTE

Notes do not appear until you stop recording.

6. Press Space or Enter  or Ctrl/Cmd-R  to stop recording.

RESULT
The notes you played on the MIDI device are input onto the selected staff.

If you did not specify the voice, notes are recorded into voices according to what you played. 
For example, if you played notes in rhythmic unison, they are recorded into a single voice. If you 
played notes with different rhythms, they are recorded into separate voices, up to two voices per 
staff.

If you activated Chords, the notes you played are merged into the first available voice on the 
staff without overwriting any existing notes.

The notated duration of the notes follows your quantization options, but their played durations 
are retained for playback.

AFTER COMPLETING THIS TASK

● If the notes you played in are not notated as you intended, you can requantize them.

● If you do not want to retain played durations for playback, you can reset playback overrides.

RELATED LINKS
Optimization for MIDI recording on page 268
Enabling/Disabling MIDI thru on page 216
Changing the input pitch setting on page 215
Input methods for bars, beats, and barlines on page 300
Input methods for time signatures and pick-up bars on page 283
Changing the voice of existing notes on page 466
Turning existing notes into grace notes on page 1004
Resetting playback overrides on page 689
Preferences dialog on page 58
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Retrieving played notes that you did not record
During playback, you can play notes on your MIDI keyboard and hear them without recording 
them into the score. You can use retrospective recording to retrieve these notes and input them 
into the project without previously explicitly recording them. For example, if you only intended to 
experiment with ideas, but afterwards decided you wanted to keep them.

PREREQUISITE
You have started playback, played notes on a MIDI device alongside playback, then stopped 
playback.

PROCEDURE

1. In Write mode, select a note or rest on the staff where you want to input the retrieved notes.

2. Optional: If you want to input retrieved notes without overwriting any existing notes on the 
staff, press Q  to activate Chords.

3. Retrieve the notes you played in any of the following ways:

● Press Ctrl/Cmd-Alt/Opt-R .

● In the Transport window, click Retrospective Record .

RESULT
All the notes you played on your MIDI device during the previous playback are input on the 
selected staff, starting from the selected rhythmic position. They are input into the first available 
voice on the staff and overwrite any existing notes in that voice by default. If you activated 
Chords, the retrieved notes are merged into the first available voice on the staff without 
overwriting any existing notes.

NOTE

The retrospective recording buffer is cleared each time you start playback, meaning you cannot 
retrieve music you played before the most recent playback.

RELATED LINKS
Playing back music on page 540
Transport window on page 555

Repeats in MIDI recording
When recording MIDI into flows that contain repeat structures, such as repeat barlines, Dorico 
Elements records the notes you play during each playthrough and merges them together into 
the same voice.

Any differences in rhythms between the recordings are notated according to the current meter.

Requantizing notes
You can requantize notes using different quantization options. For example, if you want to 
change notated rhythms after importing MIDI or recording notes using a MIDI device. This does 
not affect the played duration of notes in playback.

PROCEDURE

1. Select all the notes you want to requantize. You can do this in Write mode and Play mode.

2. Choose Edit > Requantize to open the Requantize dialog.
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3. Change the quantization options as required.

4. Click OK to save your changes and close the dialog.

RESULT
The notated durations of all selected notes are changed according to the quantization options. 
This does not affect their played duration in playback.

RELATED LINKS
Quantization options on page 93
Resetting playback overrides on page 689
Selecting notes/items on page 421

Changing the click settings
You can change the sound, volume, and subdivision of the metronome click, which is always used 
during MIDI recording. During playback, the click only sounds if the metronome is activated.

By default, Dorico Elements only subdivides the beat in the metronome click in compound time 
signatures, and uses a click for the metronome click sound. The click uses different tones for the 
first beat in each bar, subsequent beats, and further beat subdivisions.

NOTE

● There is no click in open meter or when there is no time signature.

● The click is produced by a tone generator called DoricoBeep. You can use the Tempo track in 
Play mode to change the device used for the click.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Click.

3. In the Metronome Click section, activate/deactivate the following options for Beat 
subdivisions:

● Subdivide beats in simple time signatures

● Subdivide beats in compound time signatures

4. Choose one of the following options for Click sound:

● Click (unpitched)

● Beep (pitched)

● Wood Block

5. For Pitch and velocity, change the MIDI pitch and/or Velocity values for any of the 
following types of beat:

● First beat

● Subsequent beats

● Beat subdivisions

6. Click Apply, then Close.
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RESULT
The sound, volume, and subdivision settings for the metronome click in the current project are 
changed.

RELATED LINKS
Types of time signatures on page 1382
Input methods for time signatures and pick-up bars on page 283
Playback templates on page 558
Playing back music on page 540
Tempo track on page 532
Changing the sound used for the click on page 533
Playback Options dialog on page 749

Changing the count-in duration
For each project, you can change the default number of bars used in the count-in before you 
start recording. By default, Dorico Elements provides a one bar count-in.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Click.

3. In the Count-in section, change the value for Number of bars count-in.

4. Click Apply, then Close.

RESULT
The default duration of the count-in is changed in the current project.

Optimization for MIDI recording
Depending on your operating system and the MIDI devices you use for recording, you might find 
that the notes you record are not notated with the durations or at the rhythmic positions you 
expected. Optimizing the settings related to MIDI recording can help you achieve better results.

● You can find options that affect MIDI recording on the Play page in Preferences.

Because there can be a time latency between you pressing keys on a MIDI device and the notes 
being picked up by Dorico Elements, we recommend that you check the latency by inputting a 
simple rhythm against the click; for example, recording quarter notes in a 4/4 time signature.

Depending on the results, there are different settings you can change:

● If your notes are notated with incorrect durations, such as sixteenth notes notated as eighth 
notes, we recommend that you change the quantization options.

● If notes are input with missing or incorrect notations, we recommend that you change the 
detected notations in Preferences > Play > Recording.

NOTE

Notation settings are linked between Preferences and the MIDI Import Options dialog.

● If your notes are notated ahead of the beat, we recommend that you increase the latency 
compensation value.
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● If your notes are notated behind the beat, we recommend that you reduce the buffer size 
for your audio device to the lowest possible value that still produces stable playback with no 
drop-outs.

NOTE

The built-in audio device on Windows computers cannot always achieve a low enough 
latency for reliable input in real time. In such cases, we recommend that you use an external 
USB audio interface with ASIO support.

RELATED LINKS
Preferences dialog on page 58
Quantization options on page 93
MIDI Import Options dialog on page 85
Turning existing notes into grace notes on page 1004
Changing the sound used for the click on page 533
Enabling/Disabling MIDI thru on page 216

Changing the MIDI latency compensation value
You can change the MIDI latency compensation value to correct any discrepancy between when 
you press keys during MIDI recording and where the corresponding notes are notated relative to 
the beat.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the Recording subsection, change the value for MIDI input latency compensation.

4. Click Apply, then Close.

RESULT
Increasing the latency compensation value increases the time between pressing the key and the 
note being notated. This is useful if the notes you record were previously notated ahead of the 
beat.

Decreasing the latency compensation value decreases the time between pressing the key and 
the note being notated. This is useful if the notes you record were previously notated behind the 
beat.

Changing the audio device buffer size
You can change the audio buffer size; for example, if the current buffer size is causing notes 
input using MIDI recording appear significantly after the beat.

NOTE

● If the notes you play when recording MIDI are notated behind the beat, we recommend 
that you reduce the buffer size for your audio device to the lowest possible value that still 
produces stable playback with no drop-outs.

● The built-in audio device on Windows computers cannot always achieve a low enough 
latency for reliable input in real time. In such cases, we recommend that you use an external 
USB audio interface with ASIO support.
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PROCEDURE

1. Choose Edit > Device Setup to open the Device Setup dialog.

2. Select the audio device whose buffer size you want to change from the ASIO Driver menu.

3. Click Device Control Panel to open the device settings dialog for the selected audio device.

4. In the audio device settings dialog, change the buffer size in one of the following ways, as 
appropriate for your operating system:

● For Windows systems, in the Audio buffer size section, either drag the slider to a 
different position or activate User definable and change the value in the Selected 
buffer size field.

● For macOS systems, select a sample rate from the Buffer Size menu.

5. Click OK (Windows)/Close (macOS) to close the audio device settings dialog.

6. Click Close to close the Device Setup dialog.

Changing the sustain pedal controller settings for MIDI recording/
import

You can change your default setting for whether Dorico Elements interprets sustain pedal 
controllers as pedal lines when recording MIDI and importing or opening MIDI files.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the Recording subsection, activate/deactivate Import CC64 as pedal lines.

4. Optional: If you activated Import CC64 as pedal lines, activate/deactivate Snap pedal lines 
to previous beat.

5. Click Apply, then Close.

RESULT
When Import CC64 as pedal lines is activated, the MIDI controller CC64 is interpreted as pedal 
lines.

When Snap pedal lines to previous beat is activated, the start of pedal lines is automatically 
moved back to the start of the beat.

NOTE

These options are also available in the MIDI Import Options dialog, and your settings are linked 
between this dialog and Preferences.

RELATED LINKS
MIDI Import Options dialog on page 85
Preferences dialog on page 58

Enabling/Disabling MIDI input devices
By default, Dorico Elements accepts MIDI input from all connected MIDI devices, including virtual 
MIDI cables and inter-application buses. You can enable/disable MIDI devices individually; for 
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example, if you are using devices that continuously output MIDI data or if you want particular 
devices to remain routed exclusively to another application.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the MIDI Input Devices subsection, activate/deactivate the checkbox for each MIDI input 
device.

4. Click Apply, then Close.

Notations input
You can input many types of notations, both during note input and by adding them to existing 
notes and music. In Dorico Elements, “notation” is a broad term that includes many different 
items, including articulations, slurs, dynamics, and more.

In Dorico Elements, you can input most notations with the keyboard by using popovers and with 
the mouse by using panels.

RELATED LINKS
Popovers on page 22

Inputting articulations
You can input notes with articulations during note input, and you can add articulations to notes 
after they have been input.

NOTE

These steps describe selecting articulations before inputting notes. However, you can change 
this setting if you prefer to specify articulations after inputting notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the existing notes to which you want to add articulations.

2. Optional: If you want to input notes with articulations onto multiple staves at once, extend 
the caret to those staves.

3. Select the articulations you want to input in any of the following ways:

● Press the key commands for the articulations you want.

● In the Notes panel, click the articulations you want.

● In the Keyboard panel toolbar, click the articulations you want.

4. Optional: During note input, input the notes or chords you want with your selected 
articulations.
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RESULT
The selected articulations are added to the selected notes. They are positioned between 
noteheads or stems and tuplet brackets, so they are closer to the notes than tuplet brackets 
or tuplet numbers/ratios.

During note input, the selected articulations are added to all notes that are input until the 
articulations are deactivated.

NOTE

Some combinations of articulations on the same notes are not possible. For example, you cannot 
have both staccato and staccatissimo marks on the same notes, as both articulations indicate 
that notes are played shorter.

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have slurs in one voice and staccatos in 
another voice.

RELATED LINKS
Articulations on page 804
Note input on page 223
Notes panel on page 200
Keyboard panel on page 206
Copying and pasting articulations on page 805
Extending the caret to multiple staves on page 222
Enabling independent voice playback on page 545

Key commands for articulations
In addition to clicking them in the Notes panel, you can input common articulations by pressing 
key commands on your computer keyboard.

You can use the following key commands to input articulations with the keyboard:

Type of articulation Key command

Accent:  [

Marcato:  '

Stressed:  {

Unstressed:  @ (Windows) or " (macOS)

Staccato:  ]

Tenuto:  # (Windows) or \ (macOS)

Staccatissimo: , , or  }

Combined tenuto and staccato:  ~ (Windows) or | (macOS)
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Inputting slurs
You can input slurs, both during note input and by adding them to existing notes. You can also 
add slurs to existing notes on multiple staves at the same time, and to notes in different voices 
or on different staves belonging to the same instrument; for example, when phrases span both 
staves of grand staff instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes to which you want to add slurs.

TIP

● If you only select a single note, the slur connects that note to the next note in the 
same voice on the staff. To input slurs between notes in different voices, you must 
select both notes; for example, by selecting the first note then Ctrl/Cmd -clicking 
the second note.

● For instruments with multiple staves, such as piano and harp, you can select two 
existing notes, each on a different staff, to create cross-staff slurs. However, you 
cannot create cross-staff slurs between different instruments.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Input a slur in any of the following ways:

● Press S .

● In the Notes panel, click Slur .

● In the Keyboard panel toolbar, click Slur .

NOTE

If you added slurs to existing notes, stop here.

4. During note input, input the notes you want.

The slur extends automatically, even if there are rests between the notes you input.

5. During note input, end the slur on the currently selected note in any of the following ways:

● Press Shift-S .

● In the Keyboard panel toolbar, click Slur .

RESULT
During note input, slurs begin from the currently selected note on all staves across which the 
caret extends, not from the caret position. Slurs extend automatically as you input notes, and 
end on the currently selected note.

When adding slurs to existing notes, the selected notes are connected by slurs. For example, if 
you select two notes belonging to one instrument and two notes belonging to another, two slurs 
are input connecting the notes on each selected staff. If you selected notes on different staves 
belonging to the same instrument, a cross-staff slur is input.

Slurs are placed either above or below the notes, depending on the stem direction of the notes 
within the selection.
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TIP

When nothing is selected, you can also click Slur  in the Notes panel or Keyboard panel 
toolbar, and then click and drag to input a slur and extend it to your preferred length.

AFTER COMPLETING THIS TASK

● You can enable independent voice playback for individual instruments to hear different 
sounds in different voices simultaneously; for example, if you have slurs in one voice and 
staccatos in another voice.

● You can change the curvature direction and style of individual slurs; for example, to make 
them appear dashed and S-shaped.

RELATED LINKS
Notes panel on page 200
Keyboard panel on page 206
Hiding/Showing zones on page 44
Slurs on page 1283
Inputting nested slurs on page 1295
Inputting notes on page 224
Extending the caret to multiple staves on page 222
Slurs in playback on page 1308
Enabling independent voice playback on page 545
Cross-staff and cross-voice slurs on page 1294
Changing the curvature direction of slurs on page 1293
Changing the style of slurs on page 1290
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430

Inputting fingerings
You can input fingerings on existing notes using the fingerings popover, both during note input 
and by adding them to existing notes.

NOTE

● You can only add fingerings to notes at one rhythmic position at a time, and you can only 
input as many fingerings as there are notes at each rhythmic position. For example, you can 
input three fingerings at the rhythmic position of a chord containing three notes, but only 
one fingering at the rhythmic position of a single note.

● If you select notes in multiple voices, fingerings are only input into the top voice.

● Although they contain two numbers, substitution fingerings are considered one fingering, 
meaning you can add substitution fingerings to single notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an existing note on a single staff to which you want to add fingering.

If you want to add fingerings to all notes in a chord, select all the notes in the chord.

2. Optional: During note input, input at least one note.

3. Open the fingerings popover in any of the following ways:
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● Press Shift-F .

● In the Notations toolbox, click Popovers , then Fingerings .

4. Optional: If you are inputting fingerings for fretted instruments, change the hand in one of 
the following ways:

● To switch to the right hand, press Down Arrow .

● To switch to the left hand, press Up Arrow .

The popover icon updates to show the current hand.

Fingerings popover when inputting right-hand 
fingerings

Fingerings popover when inputting left-hand 
fingerings

5. Enter the fingerings you want into the popover.

For example, enter:

● 3-2 for a substitution fingering from the third finger to the second finger.

● 1,3,5 for a chord.

● 12 to show the first two valves should be depressed on a valved brass instrument.

● p for a right-hand thumb fingering or t for a left-hand thumb fingering.

● 2/ for a fingering with a shift indicator.

6. Optional: When adding fingerings to existing notes, move the popover in one of the 
following ways:

● To advance the popover to the next note/chord in the current voice, press Space .

● To move the popover back to the previous note/chord in the current voice, press Shift-
Space .

● To advance the popover to the first note/chord in the current voice in the next bar, press 
Tab .

● To move the popover back to the first note/chord in the current voice in the previous 
bar, press Shift-Tab .

● To move the cursor and popover to the right/left and to the next/previous note/fingering 
in the current voice, press Right Arrow / Left Arrow .

7. Press Return  to close the popover.

RESULT
The fingerings are input on the selected notes, including during note input. The popover 
advances through notes in the voice as indicated by the caret or in the same voice as your 
initial selection.

RELATED LINKS
Fingering on page 971
Changing the rhythmic position of substitution fingerings on page 973
Fingerings for valved brass instruments on page 989
Deleting fingerings on page 978
Hiding/Showing fingerings in chord diagrams on page 900
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Fingerings popover
The following tables contain examples of what you can enter into the fingerings popover to input 
the different types of fingerings available. The fingerings popover behaves differently for fretted 
instruments compared to other instruments, so there is a separate table for fretted instrument 
fingerings.

You can open the fingerings popover in Write mode in any of the following ways when either a 
note is selected or the caret is active:

● Press Shift-F .

● In the Notations toolbox, click Popovers , then Fingerings .

● Choose Write > Create Fingerings.

When inputting fingerings for non-fretted instruments, the icon on the left-hand side of the 
popover matches the corresponding button in the Notations toolbox. When inputting fingerings 
for fretted instruments, the icon on the left-hand side of the popover indicates whether you are 
inputting left-hand or right-hand fingerings.

Fingerings popover with an 
example entry for inputting a non-
fretted instrument fingering

Fingerings popover with an 
example entry for a left-hand 
fretted instrument fingering

Fingering button in the Notations 
toolbox

Fingerings popover with an 
example entry for a right-hand 
fretted instrument fingering

Non-fretted instruments

Type of fingering Example popover entry

Single fingerings for individual notes, including 
for brass valve numbers and trombone slide 
positions

1, 2, 3, and so on

Valved brass instruments 12

Single fingerings for each note in chords

For keyboard instruments, Dorico Elements 
automatically orders numbers appropriately 
according to the hand playing the notes. The 
default is:

● Right hand for the upper staff

● Left hand for the lower staff

1,3,5

Left-hand fingerings (non-fretted instruments) L2, G2, S5, I2, or H2
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Type of fingering Example popover entry

Right-hand fingerings (non-fretted 
instruments)

R5, D5, or M5

Thumb indicator (non-fretted instruments) T

Multiple fingerings for individual notes; for 
example, for ornaments such as mordents or 
turns

2343

Single fingerings for multiple notes: enter 
the same fingering number for two adjacent 
notes.

For example, in keyboard music the thumb 
may depress two keys simultaneously.

1,1

Alternative fingerings 2(3)

Editorial fingerings [4]

Finger substitutions 1-3

Fingering shift indicator (string instruments) 2/

Fretted instruments

Type of fingering Example popover entries

Left-hand fingerings 0, 1, 2, 3, 4, 5

Left-hand thumb t

Right-hand fingerings 1, 2, 3, 4, 5

p, i, m, a, e

Right-hand thumb p, t, or 1

Right-hand pinky finger e, x, c, o, or 5

These lists are not comprehensive as there are many possible fingerings. It is intended to 
illustrate how you can structure your entries to input different types of fingerings.

NOTE

Finger substitutions are shown as immediate by default, but you can change the rhythmic 
position of the substitution by changing the deferral duration.
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RELATED LINKS
Notations toolbox on page 201
Fingering on page 971
Changing the rhythmic position of substitution fingerings on page 973
Fingerings for valved brass instruments on page 989
Hiding/Showing fingerings in chord diagrams on page 900

Input methods for key signatures
You can input key signatures with the keyboard by using the key signatures popover, and with 
the mouse by using the Key Signatures, Tonality Systems, and Accidentals panel.

RELATED LINKS
Key signatures on page 1019

Key signatures popover
The table contains the entries for the key signatures popover that you can use to input the 
different key signatures available.

You can open the key signatures popover in Write mode in any of the following ways when either 
an item is selected or the caret is active:

● Press Shift-K .

● In the Notations toolbox, click Popovers , then Key Signatures .

● Select an existing key signature and press Return .

● Choose Write > Create Key Signature.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Key signatures popover with an example entry
Key Signatures, Tonality Systems, and Accidentals 
button in the Notations toolbox

Type of key signature Popover entry

Open or atonal key signature open or atonal

Major keys (capital letters) C, D, G#, Ab, and so on

Minor keys (lowercase letters) g, d, f#, bb, and so on

Number of sharps

NOTE

Assumes the major key for that many sharps.

3s, 2#, and so on
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Type of key signature Popover entry

Number of flats

NOTE

Assumes the major key for that many flats.

4f, 5b, and so on

This list is not comprehensive as you can input every possible key signature. It is intended to 
illustrate how you can structure your entry to input different types of key signatures.

RELATED LINKS
Notations toolbox on page 201
Key signatures on page 1019
Types of key signatures on page 1021

Key Signatures, Tonality Systems, and Accidentals panel
The Key Signatures, Tonality Systems, and Accidentals panel allows you to create and input 
common key signatures. It is located in the right zone in Write mode.

● You can hide/show the Key Signatures, Tonality Systems, and Accidentals panel by clicking 
Panels , then Key Signatures, Tonality Systems, and Accidentals  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Key Signatures, Tonality Systems, and Accidentals panel contains the following sections:

Used in This Flow
Contains all the key signatures currently used in the flow.

Key Signatures
Allows you to create key signatures.

The Key Signatures section contains the following parts:

1 Major/Minor

Allow you to choose whether your key signature is Major or Minor.

2 More Sharps/Fewer Flats

Each time you click, you add one sharp accidental to the key signature, or remove 
one flat accidental from the key signature.

3 Fewer Sharps/More Flats
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Each time you click, you remove one sharp accidental from the key signature, or 
add one flat accidental to the key signature.

4 Input key signature

Shows how the key signature looks on a staff. Clicking this button inputs the 
displayed key signature. If nothing in the project is selected, the key signature is 
loaded onto the mouse pointer.

Accidentals
Contains all accidentals available in the currently selected tonality system.

RELATED LINKS
Notations toolbox on page 201
Key signatures on page 1019
Tonality systems on page 1028

Inputting key signatures with the popover
You can input key signatures using the key signatures popover, both during note input and by 
adding them to existing music. You can also input key signatures only on specific staves.

NOTE

It is not necessary to input different key signatures for transposing instruments, as Dorico 
Elements automatically shows the appropriate key signatures for transposing instruments in 
transposing layouts.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a key signature. If you 
want to input a key signature on specific staves, select items that only belong to those 
staves.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Open the key signatures popover in any of the following ways:

● Press Shift-K .

● In the Notations toolbox, click Popovers , then Key Signatures .

4. Enter the key signature you want into the popover.

● For major keys, enter capital letters or the corresponding number of sharps/flats, such 
as G or 1s for G major.

● For minor keys, enter lowercase letters, such as g for G minor.

● For an atonal key signature, enter open.

5. Input the key signature and close the popover in one of the following ways:

● To input a key signature on all staves, press Return .

● To input a key signature only on the selected staves or staves across which the caret 
extends, press Alt/Opt-Return .

Write mode
Notations input 

280
Dorico Elements 5.1.30



RESULT
During note input, key signatures are input at the caret position, even if this is in the middle of a 
bar.

When adding key signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. If you selected an existing key signature, the new key signature directly 
replaces the existing one.

All subsequently input notes follow the input key signature, until the next existing key signature 
or the end of the flow, whichever comes first. When you input notes using a MIDI keyboard, 
accidentals are spelled according to the key signature.

Key signatures that do not show accidentals, such as A minor or open key signatures, are 
indicated by signposts.

NOTE

An individual key signature on a single staff is not intended for transposing instruments. 
Transpositions of notes and key signatures are done automatically for transposing instruments.

RELATED LINKS
Key signatures popover on page 278
Accidental selection during MIDI input on page 245
Key signatures on page 1019
Extending the caret to multiple staves on page 222
Moving notes/items rhythmically on page 461
Transposing instruments on page 132
Making layouts transposed/concert pitch on page 178
Respelling notes on page 473
Changing the pitch of individual notes on page 468
Transposing selections on page 469
Mapping notes to scales on page 484
Signposts on page 450

Inputting key signatures with the panel
You can input key signatures using the Key Signatures, Tonality Systems, and Accidentals panel, 
both during note input and by adding them to existing music. You can also input key signatures 
only on specific staves.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● It is not necessary to input different key signatures for transposing instruments, as Dorico 
Elements automatically shows the appropriate key signatures for transposing instruments in 
transposing layouts.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a key signature. If you 
want to input a key signature on specific staves, select items that only belong to those 
staves.
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2. In the Notations toolbox, click Panels , then Key Signatures, Tonality Systems, and 
Accidentals  to show the Key Signatures, Tonality Systems, and Accidentals panel.

3. Optional: If you have not already used the key signature you want in the current flow, create 
the key signature you want using the Key Signatures editor in the Key Signatures, Tonality 
Systems, and Accidentals panel.

4. Input the key signature you want in one of the following ways:

● To input a key signature on all staves, click it in the Key Signatures, Tonality Systems, and 
Accidentals panel.

● To input a key signature only on the selected staves or staff on which the caret is active, 
Alt/Opt -click it in the Key Signatures, Tonality Systems, and Accidentals panel.

RESULT
During note input, key signatures are input at the caret position, even if this is in the middle of a 
bar.

When adding key signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. If you selected an existing key signature, the new key signature directly 
replaces the existing one.

All subsequently input notes follow the input key signature, until the next existing key signature 
or the end of the flow, whichever comes first. When you input notes using a MIDI keyboard, 
accidentals are spelled according to the key signature.

Key signatures that do not show accidentals, such as A minor or open key signatures, are 
indicated by signposts.

NOTE

An individual key signature on a single staff is not intended for transposing instruments. 
Transpositions of notes and key signatures are done automatically for transposing instruments.

RELATED LINKS
Notations toolbox on page 201
Key Signatures, Tonality Systems, and Accidentals panel on page 279
Key signatures on page 1019
Accidental selection during MIDI input on page 245
Moving notes/items rhythmically on page 461
Changing your mouse input settings on page 211
Transposing instruments on page 132
Making layouts transposed/concert pitch on page 178
Respelling notes on page 473
Changing the pitch of individual notes on page 468
Transposing selections on page 469
Mapping notes to scales on page 484
Signposts on page 450
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Input methods for time signatures and pick-up bars
You can input time signatures, including time signatures with pick-up bars, with the keyboard 
by using the time signatures popover, and with the mouse by using the Time Signatures (Meter) 
panel.

NOTE

You can create most types of custom time signatures using the Create Time Signature section 
of the Time Signatures (Meter) panel, but certain time signatures are only possible using the time 
signatures popover. For example, you can only specify beat subdivisions with the time signatures 
popover.

RELATED LINKS
Preferences dialog on page 58
Time signatures on page 1381
Types of time signatures on page 1382

Time signatures popover
The table contains the entries for the time signatures popover that you can use to input the 
different types of time signatures available.

You can open the time signatures popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-M .

● In the Notations toolbox, click Popovers , then Time Signatures (Meter) .

● Select an existing time signature and press Return .

● Choose Write > Create Time Signature.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Time signatures popover with an example entry
Time Signatures (Meter) button in the Notations 
toolbox

Time signatures

Type of time signature Popover entry

Simple time signatures

For example, 2/2 (two half notes per bar), 2/4 
(two quarter notes per bar), 6/8 (six eighth 
notes per bar), 3/4, 5/4, and so on

2/2, 2/4, 6/8, 3/4, 5/4, and so on
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Type of time signature Popover entry

Alternating time signatures, such as 6/8+3/4 6/8 + 3/4

NOTE

You must include spaces either side of the plus 
sign.

Common time, the equivalent of 4/4 c

Cut common time, the equivalent of 2/2 cutc, cut, or ¢

Open meter indicated by X X or x

Open meter with no indication

NOTE

A time signature signpost is shown at the 
position of the open meter.

open

Additive time signature with explicit beat 
grouping

3+2+2/8, 3+2/4, and so on

Beat grouping specified but not shown in the 
time signature

For example, a time signature of 7/8 is shown 
but beams are subdivided into 2+3+2 eighth 
notes.

[2+3+2]/8

Aggregate time signature with dashed barlines 
shown in each bar, indicating the divisions 
between the different meters

2/4|6/8

Aggregate time signature without dashed 
barlines shown in each bar

2/4:6/8

Interchangeable time signature with different 
styles: parenthesized, slash, equals sign, and 
dashed

2/4 (6/8), 2/4 / 6/8, 2/4 = 6/8, or 2/4 – 6/8

NOTE

You must include spaces either side of the 
slashes, equals signs, or dashes, and before 
opening parentheses.
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Pick-up bars

Example time signature with pick-up bar Popover entry

4/4 time signature with a quarter note 
(crotchet) pick-up

4/4,1

4/4 time signature with a dotted quarter note 
pick-up

4/4,1.5

4/4 time signature with a sixteenth note 
(semiquaver) pick-up

4/4,0.25

3/4 time signature with a dotted eighth note 
(dotted quaver) pick-up

3/4,0.75

6/8 time signature with a pick-up of two eighth 
notes (quavers)

6/8,2

2/2 time signature with a quarter note pick-up 2/2,0.5

TIP

The number after the comma indicates a fraction/multiple of the rhythmic unit specified by the 
time signature denominator. For example, 1 indicates a quarter note in 4/4, or an eighth note in 
6/8.

These lists are not comprehensive, as there are many possible time signatures and pick-up 
bars. They are intended to illustrate how you can structure your entry to input different time 
signatures and pick-up bars.

RELATED LINKS
Notations toolbox on page 201
Time signatures on page 1381
Types of time signatures on page 1382
Time signature styles on page 1389
Inputting time signatures with the popover on page 287
Inputting pick-up bars with the popover on page 289
Creating custom beat groupings for meters on page 861
Ending interchangeable time signatures on page 1397

Time Signatures (Meter) panel
The Time Signatures (Meter) panel allows you to input different time signatures. In the Create 
Time Signature section of the panel, you can create uncommon time signatures. It is located in 
the right zone in Write mode.

● You can hide/show the Time Signatures (Meter) panel by clicking Panels , then Time 
Signatures (Meter)  in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Time Signatures (Meter) panel contains the following sections:
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Used in This Flow
Contains any time signatures already used in the current flow.

Common
Contains common time signatures, such as 4/4, 3/4, 6/8, and 7/8.

Create Time Signature
Allows you to design your own time signatures, including alternating time signatures 
and aggregate time signatures.

The Create Time Signature section contains the following parts:

1 Time signature type menu

Allows you to select one of the following types of time signatures:

● Regular

● Additive

● Interchangeable

● Aggregate

● Alternating

2 Time signature spaces

Allows you to combine up to four time signatures. For example, you can specify 
only one time signature for a regular time signature, but for an alternating time 
signature, you might want to include three time signatures.

3 Pick-up bar of

Allows you to include a pick-up bar before the time signature. A pick-up bar is 
not a complete bar, and so allows you to include only a few beats before the first 
complete bar.

You can select one of the following options for the number of beats in a pick-up 
bar:

● 1/2 beat

● 1 beat

● 2 beats
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● 3 beats

4 Input time signature button

Click the button that displays the time signature to input it. If nothing in the project 
is selected, the time signature is loaded onto the mouse pointer.

RELATED LINKS
Notations toolbox on page 201
Time signatures on page 1381
Types of time signatures on page 1382
Time signature styles on page 1389
Inputting time signatures with the panel on page 288
Inputting pick-up bars with the panel on page 291

Inputting time signatures with the popover
You can input time signatures using the time signatures popover, both during note input and by 
adding them to existing music. You can also input time signatures only on specific staves.

NOTE

Dorico Elements does not automatically add beats to fill bars according to the new time 
signature at the end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a time signature. If you 
want to input a time signature on specific staves, select items that only belong to those 
staves.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Optional: If you want Dorico Elements to add beats at the end of the region affected by the 
new time signature if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

4. Open the time signatures popover in any of the following ways:

● Press Shift-M .

● In the Notations toolbox, click Popovers , then Time Signatures (Meter) .

5. Enter the time signature you want into the popover.

For example, enter 4/4 for a 4/4 time signature or [2+2+3]/8 for a 7/8 time signature with a 
custom beat grouping.

6. Input the time signature and close the popover in one of the following ways:

● To input a time signature on all staves, press Return .

● To input a time signature only on the selected staves or staves across which the caret 
extends, press Alt/Opt-Return .
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RESULT
During note input, time signatures are input at the caret position, even if this is in the middle of 
an existing bar.

When adding time signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. If you selected an existing time signature, the new time signature directly 
replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico Elements automatically inputs and moves barlines 
as required so that subsequent music is barred correctly. However, in open meters, you must 
input barlines and add beats manually.

Any time signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

RELATED LINKS
Time signatures popover on page 283
Extending the caret to multiple staves on page 222
Time signatures on page 1381
Pick-up bars on page 1386
Time signature styles on page 1389
Changing the separator style of interchangeable time signatures on page 1392
Inputting pick-up bars with the popover on page 289
Inputting barlines with the popover on page 306
Inputting bars/beats with the popover on page 304
Insert mode on page 451
Ending interchangeable time signatures on page 1397
Rhythmic position on page 24
Note and rest grouping on page 860

Inputting time signatures with the panel
You can input time signatures using the Time Signatures (Meter) panel, both during note input 
and by adding them to existing music. You can also input time signatures only on specific staves.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● Dorico Elements does not automatically add beats to fill bars according to the new time 
signature at the end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a time signature. If you 
want to input a time signature on specific staves, select items that only belong to those 
staves.

2. Optional: If you want Dorico Elements to add beats at the end of the region affected by the 
new time signature if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

Write mode
Notations input 

288
Dorico Elements 5.1.30



3. In the Notations toolbox, click Panels , then Time Signatures (Meter)  to show the Time 
Signatures (Meter) panel.

4. Optional: If you want to input a time signature that is not available in the Used in This Flow 
or Common sections, select the type of time signature you want to input from the menu in 
the Create Time Signature section.

5. Optional: Enter the time signatures you want into the available spaces.

6. Input the time signature you want in one of the following ways:

● To input a time signature on all staves, click it in the Time Signatures (Meter) panel.

● To input a time signature only on the selected staves or staff on which the caret is active, 
Alt/Opt -click it in the Time Signatures (Meter) panel.

RESULT
During note input, time signatures are input at the caret position, even if this is in the middle of 
an existing bar.

When adding time signatures to existing music, they are added at the rhythmic position of the 
earliest selected item. If you selected an existing time signature, the new time signature directly 
replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico Elements automatically inputs and moves barlines 
as required so that subsequent music is barred correctly. However, in open meters, you must 
input barlines and add beats manually.

Any time signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

RELATED LINKS
Notations toolbox on page 201
Time Signatures (Meter) panel on page 285
Changing your mouse input settings on page 211
Time signatures on page 1381
Pick-up bars on page 1386
Time signature styles on page 1389
Changing the separator style of interchangeable time signatures on page 1392
Inputting pick-up bars with the panel on page 291
Inputting barlines with the panel on page 307
Inputting bars/beats with the popover on page 304
Insert mode on page 451
Ending interchangeable time signatures on page 1397
Rhythmic position on page 24
Note and rest grouping on page 860

Inputting pick-up bars with the popover
You can input pick-up bars as part of time signatures using the time signatures popover, both 
during note input and by adding them to existing music. You can also input time signatures with 
pick-up bars only on specific staves.

NOTE

Dorico Elements does not automatically add beats to fill bars according to the new time 
signature at the end of the affected region unless Insert mode is activated.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a pick-up bar. If you 
want to input a pick-up bar on specific staves, select items that only belong to those 
staves.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Optional: If you want Dorico Elements to add beats at the end of the region affected by the 
pick-up bar if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

4. Open the time signatures popover in any of the following ways:

● Press Shift-M .

● In the Notations toolbox, click Popovers , then Time Signatures (Meter) .

5. Enter the time signature and the number of pick-up beats you want into the popover.

For example, enter:

● 3/4,0.75 for a 3/4 time signature with a dotted eighth note (dotted quaver) upbeat.

● 4/4,1 for a 4/4 time signature with one quarter note (crotchet) upbeat.

● 6/8,2 for a 6/8 time signature with a pick-up of two eighth notes (quavers).

The number after the comma indicates multiples of the rhythmic unit specified by the 
denominator of the time signature.

6. Input the pick-up bar and close the popover in one of the following ways:

● To input a pick-up bar on all staves, press Return .

● To input a pick-up bar only on the selected staves or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
During note input, pick-up bars are added at the caret position as part of the specified time 
signature, even if this is in the middle of an existing bar.

When adding pick-up bars to existing music, they are added at the rhythmic position of the 
earliest selected item as part of the specified time signature. If you selected an existing time 
signature, the new time signature with pick-up bar directly replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico Elements automatically inputs and moves barlines 
as required so that subsequent music is barred correctly. However, in open meters, you must 
input barlines and add beats manually.

Any time signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

NOTE

● Dorico Elements does not automatically insert beats at the start of existing music to which 
you add time signatures with pick-up bars. If you add a pick-up bar at the start of a flow, that 
flow now begins in the pick-up bar, not in the first full bar. You can insert beats at the start to 
push existing music to later rhythmic positions.
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● You can use the Global Adjustment of Current Bar Insert mode scope to create and delete 
pick-up bars by deleting notes/rests in the first bar in the flow. You can also use it to shorten 
the last bar in flows that start with a pick-up bar.

RELATED LINKS
Time signatures popover on page 283
Pick-up bars on page 1386
Defining partial bars as pick-up bars or irregular bars on page 1386
Extending the caret to multiple staves on page 222
Inputting time signatures with the popover on page 287
Inputting bars/beats with the popover on page 304
Inputting barlines with the popover on page 306
Rhythmic position on page 24
Inputting notes in Insert mode on page 237
Insert mode on page 451
Insert mode scopes on page 452
Ending interchangeable time signatures on page 1397

Inputting pick-up bars with the panel
You can input pick-up bars as part of time signatures using the Time Signatures (Meter) panel, 
both during note input and by adding them to existing music. You can also input time signatures 
only on specific staves.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● Dorico Elements does not automatically add beats to fill bars according to the new time 
signature at the end of the affected region unless Insert mode is activated.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a pick-up bar. If you 
want to input a pick-up bar on specific staves, select items that only belong to those 
staves.

2. Optional: If you want Dorico Elements to add beats at the end of the region affected by the 
pick-up bar if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

3. In the Notations toolbox, click Panels , then Time Signatures (Meter)  to show the Time 
Signatures (Meter) panel.

4. In the Create Time Signature section, select the type of time signature you want from the 
menu.

5. Enter the time signatures you want into the available spaces.

6. Activate Pick-up bar of and select one of the following options:

● 1/2 beat

● 1 beat
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● 2 beats

● 3 beats

NOTE

Not all pick-up bar lengths are possible when using the panel. For example, you cannot 
produce a single eighth note upbeat in 6/8 with the available options. In such cases, you 
must use the time signatures popover.

7. Input the pick-up bar in one of the following ways:

● To input a pick-up bar on all staves, click the input time signature button in the Create 
Time Signature section.

● To input a pick-up bar only on the selected staves or staff on which the caret is active, 
Alt/Opt -click the input time signature button in the Create Time Signature section.

RESULT
During note input, pick-up bars are added at the caret position as part of the specified time 
signature, even if this is in the middle of an existing bar.

When adding pick-up bars to existing music, they are added at the rhythmic position of the 
earliest selected item as part of the specified time signature. If you selected an existing time 
signature, the new time signature with pick-up bar directly replaces the existing one.

All subsequent bars follow the input time signature, until the next existing time signature or the 
end of the flow, whichever comes first. Dorico Elements automatically inputs and moves barlines 
as required so that subsequent music is barred correctly. However, in open meters, you must 
input barlines and add beats manually.

Any time signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

NOTE

● Dorico Elements does not automatically insert beats at the start of existing music to which 
you add time signatures with pick-up bars. If you add a pick-up bar at the start of a flow, that 
flow now begins in the pick-up bar, not in the first full bar. You can insert beats at the start to 
push existing music to later rhythmic positions.

● You can use the Global Adjustment of Current Bar Insert mode scope to create and delete 
pick-up bars by deleting notes/rests in the first bar in the flow. You can also use it to shorten 
the last bar in flows that start with a pick-up bar.

RELATED LINKS
Notations toolbox on page 201
Time Signatures (Meter) panel on page 285
Pick-up bars on page 1386
Inputting pick-up bars with the popover on page 289
Defining partial bars as pick-up bars or irregular bars on page 1386
Inputting bars/beats with the popover on page 304
Inputting barlines with the panel on page 307
Rhythmic position on page 24
Inputting notes in Insert mode on page 237
Insert mode on page 451
Insert mode scopes on page 452
Ending interchangeable time signatures on page 1397
Changing your mouse input settings on page 211
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Input methods for tempo marks
You can input tempo marks with the keyboard by using the tempo popover, with the mouse by 
using the Tempo panel, and in the Tempo editor. You can input a tempo mark containing just a 
text instruction, just a metronome mark, or a combination of the two.

You can also input tempo equations using the tempo popover and Tempo panel.

RELATED LINKS
Tempo marks on page 1335
Tempo editor on page 706

Tempo popover
The following tables contain examples of what you can enter into the tempo popover to input 
tempo marks, tempo equations, and rhythmic feels for swing playback.

When you start entering a tempo into the tempo popover, a menu appears with suggestions 
containing the letters/words you enter. You can select one of these suggestions to input, or enter 
your own tempo into the popover.

You can open the tempo popover in Write mode in any of the following ways when either an item 
is selected or the caret is active:

● Press Shift-T .

● In the Notations toolbox, click Popovers , then Tempo .

● Select an existing tempo mark and press Return .

● Choose Write > Create Tempo.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Tempo popover with an example entry

Tempo button in the Notations toolbox

Tempo marks

Example tempo mark Popover entry

Adagio Adagio

Presto  = 176 Presto q = 176 or Presto q=176

Largo ( = 52) Largo (q = 52) or Largo (q=52)

 = 96-112 q = 96-112, q=96-112, 6 = 96-112, or 6=96-112

  = 84 q. = 84, q.=84, 6. = 84, or 6.=84
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Example tempo mark Popover entry

 = 60 h = 60, h=60, 7 = 60, or 7=60

 = 120 e = 120, e=120, 5 = 120, or 5=120

rit. rit.

ritardando ritardando

rit. with continuation line (property override) rit....

accel. accel.

accelerando accelerando

accel. with continuation line (property override) accel....

più più

meno meno

Rubato Rubato

Faster, with energy Faster, with energy

This list is not comprehensive as you can enter tempos freely and there are many possible 
metronome marks and tempo marks. It is intended to illustrate how you can structure your entry 
to input different types of tempo marks and metronome marks.

NOTE

● The tempo popover is case-sensitive. If you want your tempo mark to start with a capital 
letter, you must enter a capital letter into the popover.

● To input hidden tempo marks, enclose your popover entry in parentheses, such as (q=96).

Metronome mark beat units

Metronome mark beat unit Popover entry

64th note z or 2

32nd note y or 3

16th note x or 4

Eighth note e or 5

Quarter note q or 6
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Metronome mark beat unit Popover entry

Half note h or 7

Whole note w or 8

Double whole note 2w or 9

Rhythm dot . (period)

Tempo equations

Example tempo equation Popover entry

 =   e = e. or e=e.

 =  q = e or q=e

 =  q. = h or q.=h

This list is not comprehensive as there are many possible tempo equations, using all available 
beat units. It is intended to illustrate how you can structure your entry to input different tempo 
equations.

NOTE

Tempo equations do not yet include tuplet durations. This is planned for future versions.

Rhythmic feels for swing playback

Rhythmic feel Popover entry

Light 16th note swing rhythmic feel light swing 16ths

Light eighth note swing rhythmic feel light swing 8ths

Medium 16th note swing rhythmic feel medium swing 16ths

Medium eighth note swing rhythmic feel medium swing 8ths

Heavy 16th note swing rhythmic feel heavy swing 16ths

Heavy eighth note swing rhythmic feel heavy swing 8ths

Straight rhythmic feel straight (no swing)

Triplet 16th fixed rhythmic feel 2:1 swing 16ths (fixed)
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Rhythmic feel Popover entry

Triplet 8th fixed rhythmic feel 2:1 swing 8ths (fixed)

Dotted 16th-32nd fixed rhythmic feel 3:1 swing 16ths (fixed)

Dotted 8th-16th fixed rhythmic feel 3:1 swing 8ths (fixed)

RELATED LINKS
Notations toolbox on page 201
Tempo marks on page 1335
Types of tempo marks on page 1336
Hiding/Showing tempo marks on page 1340
Changing the style of gradual tempo changes on page 1347
Changing the order of metronome marks on page 1345
Swing playback on page 552
Enabling swing playback for specific sections/instruments on page 554

Tempo panel
The Tempo panel contains the different types of tempo marks available in Dorico Elements, 
organized into sections. It is located in the right zone in Write mode.

● You can hide/show the Tempo panel by clicking Panels , then Tempo  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

Used in This Flow
Contains any tempo marks already used in the flow, including custom tempo marks 
added using the tempo popover.

Tap Tempo
Allows you to create an absolute tempo change based on the speed with which you 
click the Tap button. It appears as a metronome mark with no text by default. The 
metronome mark value is always rounded to the nearest integer.

You can use the available options to set the beat unit on which you want to base the 
tempo.
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Absolute Tempo Change
Contains a range of tempos with both an Italian tempo indication and a metronome 
mark. You can later choose to show or hide the metronome mark for individual tempo 
marks.

You can change the range shown in the list by adjusting the slider at the top.

Gradual Tempo Change
Contains tempo marks that indicate a change in tempo over a defined period of time, 
such as rallentando or accelerando.

You can add modifiers to gradual tempo changes. Available modifiers are shown at the 
top of the section.

Relative Tempo Change
Contains tempo marks that indicate a change in tempo that is relative to the previous 
tempo, such as mosso (movement, or with movement). They often include modifiers 
that qualify the change, such as poco meno mosso (a little less movement), and are not 
defined by a metronome mark.

You can add modifiers to relative tempo changes. Available modifiers are shown at the 
top of the section.

You can later set a relative metronome mark change as a percentage of the previous 
metronome mark for individual tempo marks.

Reset Tempo
Contains tempo marks that indicate a return to the previous tempo, such as A tempo, 
or a previously defined tempo, such as Tempo primo.

Tempo Equation
Allows you to input a tempo equation, using beat units from 16th notes to whole notes 
and up to two rhythm dots.
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RELATED LINKS
Notations toolbox on page 201
Tempo marks on page 1335
Types of tempo marks on page 1336
Changing the metronome mark value on page 1342

Inputting tempo marks with the popover
You can input tempo marks using the tempo popover, both during note input and by adding 
them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a tempo mark. If you 
want to input a gradual tempo change across a duration, select items that span the 
required duration.

2. Open the tempo popover in any of the following ways:

● Press Shift-T .

● In the Notations toolbox, click Popovers , then Tempo .

3. Enter the tempo you want into the popover.

For example, enter q=72 or Allegretto.

When you start entering a tempo into the tempo popover, a menu appears that shows 
suggested tempos containing the letters/words you enter. You can select one of these 
suggestions, or you can enter your own tempo into the popover.

To input a hidden tempo mark, enclose its entry in parentheses, such as (q=96).
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NOTE

If you want to show gradual tempo changes separated into syllables spread across their 
duration, such as rit-ar-dan-do, we recommend selecting a suggested entry from the 
menu. Only gradual tempo changes with valid full text appear separated into syllables 
automatically.

You can change the text of existing gradual tempo changes, including adding hyphens 
manually to control how they are separated into syllables.

4. Press Return  to close the popover.

RESULT
During note input, tempo marks are input at the caret position. Gradual tempo changes, such as 
rallentando, are also input at the caret position with a default duration of a quarter note. Gradual 
tempo changes do not extend as you input notes.

When adding tempo marks to existing music, they are added at the rhythmic position of the 
earliest selected item. Gradual tempo changes span the duration of the selected items.

NOTE

Metronome mark values appear as integers without decimal places, even if you input decimal 
places. However, the exact metronome mark value you input is always reflected in playback.

AFTER COMPLETING THIS TASK
You can lengthen/shorten gradual tempo changes.

RELATED LINKS
Tempo marks on page 1335
Tempo track on page 532
Tempo editor on page 706
Gradual tempo changes on page 1345
Metronome marks on page 1341
Tempo equations on page 1349
Lengthening/Shortening items on page 430
Hiding/Showing tempo marks on page 1340
Changing tempo text on page 1338
Changing the style of gradual tempo changes on page 1347
Changing the order of metronome marks on page 1345
Playing back music on page 540
Changing the tempo mode on page 543

Inputting tempo marks with the panel
You can input tempo marks using the Tempo panel, both during note input and by adding them 
to existing music.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● You cannot specify decimal places for metronome marks using the panel. You can specify 
decimal places using the popover or by changing the metronome mark value of existing 
tempo marks.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a tempo mark. If you 
want to input a gradual tempo change across a duration, select items that span the 
required duration.

2. In the Notations toolbox, click Panels , then Tempo  to show the Tempo panel.

3. In the Tempo panel, click the tempo mark you want.

TIP

If you want Dorico Elements to calculate the metronome mark for you, you can click Tap in 
the Tap Tempo section multiple times at the required speed.

4. Optional: Select a modifier from the available options.

NOTE

You can only add modifiers to a Gradual Tempo Change or a Relative Tempo Change.

RESULT
During note input, tempo marks are input at the caret position. Gradual tempo changes, such as 
rallentando, are also input at the caret position with a default duration of a quarter note. Gradual 
tempo changes do not extend as you input notes.

When adding tempo marks to existing music, they are added at the rhythmic position of the 
earliest selected item. Gradual tempo changes span the duration of the selected items.

AFTER COMPLETING THIS TASK
You can lengthen/shorten gradual tempo changes.

RELATED LINKS
Notations toolbox on page 201
Changing your mouse input settings on page 211
Tempo marks on page 1335
Gradual tempo changes on page 1345
Metronome marks on page 1341
Tempo equations on page 1349
Changing the metronome mark value on page 1342
Changing the style of gradual tempo changes on page 1347
Changing the order of metronome marks on page 1345
Playing back music on page 540
Changing the tempo mode on page 543

Input methods for bars, beats, and barlines
You can input both bars and barlines with the keyboard by using the bars and barlines popover, 
and also with the mouse by using the available options in the Bars and Barlines panel. The bars 
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and barlines popover also allows you to input beats. Additionally, you can input bars and beats 
using the system track.

Normally you do not need to create bars in Dorico Elements, as they are created automatically 
as needed when you input music. However, you can add bars in advance if, for example, you are 
copying or arranging an existing piece of music.

RELATED LINKS
Bars on page 810
Barlines on page 815
System track on page 425
Inputting bar rests into specific voices on page 246
Repeats in playback on page 549

Bars and barlines popover
The following tables contain examples of what you can enter into the bars and barlines popover 
to add and delete bars and beats, and the entries you can use to input the different barlines 
available.

You can open the bars and barlines popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

● Choose Write > Create Bar or Barline.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Bars and barlines popover with an 
example entry for inputting bars

Bars and barlines popover with an 
example entry for a barline

Bars and Barlines button in the 
Notations toolbox

Bars

Example action Popover entry

Add two bars 2 or +2

Add fourteen bars 14 or +14

Delete one bar –1

Delete six bars –6

Add a bar rest rest

Delete empty bars at the end of the flow trim
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This list is not comprehensive, as you can add and delete any number of bars using the popover. 
This table is intended to illustrate how you can structure your entry to input and delete bars, and 
input bar rests.

Beats

You can specify a number of beats that you want to add/delete by entering the number of beats 
you want followed by either the number that corresponds to the beat unit, such as 5 for eighth 
notes, or the letter that corresponds to the beat unit, such as h for half notes. When using 
numbers for both the number of beats and the beat unit, you must separate them with a space 
or hyphen. You can also specify beats in the form of a time signature, such as 3/4 for three 
quarter note beats.

Example action Popover entry

Add one whole note beat 1w, 1-8, 1 8, or 4/4

Add two quarter note beats 2q, 2-6, 2 6, or 2/4

Add four eighth note beats 4e, 4-5, 4 5, 4/8, or 2/4

Delete two quarter note beats –2q, -2-6, -2 6, or -2/4

Delete empty beats at the end of the flow trim

This list is not comprehensive, as you can add and delete any number of beats using the 
popover. This table is intended to illustrate how you can structure your entry to input and delete 
beats.

Beat unit Popover entry

64th note z or 2

32nd note y or 3

16th note x or 4

Eighth note e or 5

Quarter note q or 6

Half note h or 7

Whole note w or 8

Double whole note 2w or 9

Rhythm dot . (period)
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Barlines

Type of barline Popover entry

Normal (Single) |, single, or normal

Double || or double

Final |] or final

Start repeat |: or start

End repeat :| or end

End/Start repeat :|:, :||:, end-start, or endstart

RELATED LINKS
Notations toolbox on page 201
Inputting bar rests into specific voices on page 246
Bars on page 810
Barlines on page 815
Deleting bars/beats on page 810
Repeats in playback on page 549

Bars and Barlines panel
The Bars and Barlines panel allows you to input bars, bar rests, and different types of barlines. It 
is located in the right zone in Write mode.

● You can hide/show the Bars and Barlines panel by clicking Panels , then Bars and Barlines 
 in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Bars and Barlines panel contains the following sections:

Insert Bars
Allows you to determine how many bars you want to insert and where to insert them, 
such as at the end of the flow.

Insert Bar Rest
Allows you to insert a bar rest.

Create Barline
Contains the different barlines you can input.

RELATED LINKS
Notations toolbox on page 201
Repeats in playback on page 549
Hiding/Showing zones on page 44
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Inputting bars/beats with the popover
You can input bars/beats using the bars and barlines popover, both during note input and by 
adding them to or inserting them into existing music. For example, if you want to extend a 
cadenza in an open meter.

PREREQUISITE
If you want to input bars, you have input a time signature.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to add bars/beats. If you want to 
add bars/beats to specific staves, select items that only belong to those staves.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

4. Enter the number of bars/beats you want to input.

For example, enter 2 to input two bars or 2q to input two quarter note beats.

5. Input the bars/beats and close the popover in one of the following ways:

● To input bars/beats for all staves, press Return .

● To input bars/beats only on the selected staves or staves across which the caret extends, 
press Alt/Opt-Return .

RESULT
The number of bars or beats specified is input.

During note input, bars/beats are input from the caret position on all staves across which the 
caret extends. If the caret is in the middle of the bar when inputting bars, sufficient beats are 
added to ensure that the final bar created has the correct number of beats.

When you add bars/beats to existing music, they are added after selected barlines and before 
other selected items, including time signatures.

TIP

● Another way to add bars is by choosing a note duration, such as a whole note when in a 4/4 
time signature, and pressing Space  repeatedly during note input.

● You can assign a key command for Add Bar at End of Flow on the Key Commands page in 
Preferences.

RELATED LINKS
Bars and barlines popover on page 301
Bars on page 810
Extending the caret to multiple staves on page 222
Inputting time signatures with the popover on page 287
Types of time signatures on page 1382
Key Commands page in the Preferences dialog on page 60
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Inputting bars with the panel
You can input bars using the Bars and Barlines panel, both during note input and by inserting 
them into existing music.

PREREQUISITE
You have input a time signature.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an existing barline after which you want to input bars.

● Select an existing item before which you want to input bars.

2. In the Notations toolbox, click Panels , then Bars and Barlines  to show the Bars and 
Barlines panel.

3. In the Insert Bars section of the Bars and Barlines panel, change the number of bars you 
want to input by changing the value in the value field.

4. Select one of the following options for where you want to input bars:

● Start of Flow: Bars are input at the beginning of the flow.

● Start of Selection: Bars are input from the selected note or rest.

● End of Flow: Bars are input at the end of the flow.

NOTE

If you want to input bars from the caret position, make sure that you have selected Start 
of Selection from the menu.

5. Click Insert Bars.

RESULT
The number of bars specified is input. During note input, bars are input from the caret position.

If you selected Start of Selection, bars are input directly after a selected barline, and directly 
before a selected note, bar, or time signature.

RELATED LINKS
Notations toolbox on page 201
Bars on page 810
Inputting time signatures with the panel on page 288

Inputting bars/beats with the system track
You can insert bars/beats into existing music using the system track; for example, if you decide 
you want to repeat several bars before the next section. You can insert whole bars and just a few 
beats.

NOTE

You cannot use the system track during note input.

PREREQUISITE
The system track is shown.
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PROCEDURE

1. In the system track, select the region whose duration you want to insert.

For example, if you want to insert two bars, select two bars in the system track immediately 
before where you want the two new bars to be input.

2. Click Add  above the system track.

Add  appears highlighted when you hover your mouse pointer over it.

RESULT
The rhythmic duration selected in the system track is added immediately after the end of the 
selection. Existing music after the selection is pushed back after the inserted bars/beats.

RELATED LINKS
System track on page 425
Hiding/Showing the system track on page 427
Selecting bars with the system track on page 427
Selecting beats with the system track on page 428

Inputting barlines with the popover
You can input barlines using the bars and barlines popover, both during note input and by 
adding them to existing music. You can also change the type of existing barlines.

PREREQUISITE
If you want to input barlines onto specific staves only, you have input an independent time 
signature on those staves.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a barline. If you want to 
input a barline on specific staves, select items that only belong to those staves.

TIP

If you want to add repeat barlines at the start/end of a region simultaneously, select 
items that span the required duration.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

4. Enter the barline you want into the popover.

For example, enter || for a double barline, or |: for a start repeat barline.

5. Input the barline and close the popover in one of the following ways:

● To input a barline on all staves, press Return .

● To input a barline only on the selected staves or staves across which the caret extends, 
press Alt/Opt-Return .
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NOTE

You can only input barlines onto single staves that already have an independent time 
signature.

RESULT
During note input, barlines are input at the caret position.

When you add barlines to existing music, they are added at the rhythmic position of the earliest 
selected item. If you selected an existing barline, the new barline directly replaces the existing 
one. However, inputting repeat barlines at the positions of existing repeat barlines produces 
combined end/start repeat barline as applicable.

When you add start repeat barlines with a range of items selected, end repeat barlines are also 
added at the end of the selection.

Surrounding music automatically adjusts to accommodate the barline. For example, note 
grouping, rests, and tied notes all adjust if necessary. Inputting final barlines at the end of the 
last bar of flows can automatically trim the flow if there is no further music and depending on the 
time signature.

NOTE

Normal barlines that you have input directly, such as to replace an existing double barline, 
are still considered explicit barlines and break multi-bar rests. Deleting barlines resets them 
completely.

Explicit single barlines appear with time signature signposts.

RELATED LINKS
Bars and barlines popover on page 301
Barlines on page 815
Signposts on page 450
Extending the caret to multiple staves on page 222
Inputting notes on page 224
Inputting time signatures with the popover on page 287
Deleting notes/items on page 455
Deleting bars/beats on page 810
Repeats in playback on page 549
Changing the number of playthroughs at repeat barlines on page 551

Inputting barlines with the panel
You can input barlines using the Bars and Barlines panel, both during note input and by adding 
them to existing music. You can also change the type of existing barlines.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PREREQUISITE
If you want to input barlines onto specific staves only, you have input an independent time 
signature on those staves.
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PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a barline. If you want to 
input a barline on specific staves, select items that only belong to those staves.

TIP

If you want to add repeat barlines at the start/end of a region simultaneously, select 
items that span the required duration.

2. In the Notations toolbox, click Panels , then Bars and Barlines  to show the Bars and 
Barlines panel.

3. Input the barline you want in one of the following ways:

● To input a barline on all staves, click it in the Create Barline section.

● To input a barline only on the selected staves or staff on which the caret is active, Alt/
Opt -click it in the Create Barline section.

NOTE

You can only input barlines onto single staves that already have an independent time 
signature.

RESULT
During note input, barlines are input at the caret position.

When you add barlines to existing music, they are added at the rhythmic position of the earliest 
selected item. If you selected an existing barline, the new barline directly replaces the existing 
one. However, inputting repeat barlines at the positions of existing repeat barlines produces 
combined end/start repeat barline as applicable.

When you add start repeat barlines with a range of items selected, end repeat barlines are also 
added at the end of the selection.

Surrounding music automatically adjusts to accommodate the barline. For example, note 
grouping, rests, and tied notes all adjust if necessary. Inputting final barlines at the end of the 
last bar of flows can automatically trim the flow if there is no further music and depending on the 
time signature.

NOTE

Normal barlines that you have input directly, such as to replace an existing double barline, 
are still considered explicit barlines and break multi-bar rests. Deleting barlines resets them 
completely.

Explicit single barlines appear with time signature signposts.

RELATED LINKS
Notations toolbox on page 201
Barlines on page 815
Bars and barlines popover on page 301
Signposts on page 450
Inputting notes on page 224
Inputting time signatures with the panel on page 288
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Changing your mouse input settings on page 211
Repeats in playback on page 549
Changing the number of playthroughs at repeat barlines on page 551

Input methods for dynamics
You can input dynamics with the keyboard by using the dynamics popover, and with the mouse 
by using the Dynamics panel. When using the dynamics popover, you can input whole dynamic 
phrases containing immediate and gradual dynamics simultaneously, such as p<f>p.

You can also input dynamic points that affect playback, but do not appear in the music, in the 
Dynamics editor.

RELATED LINKS
Dynamics on page 921
Inputting dynamics with the popover on page 313
Inputting dynamics with the panel on page 315
Niente markings on page 947
Adding modifiers to existing dynamics on page 933
Dynamics editor on page 694

Dynamics popover
The dynamics popover allows you to input all types of dynamics, including whole dynamic 
phrases containing immediate and gradual dynamics simultaneously, such as p<f>p.

You can open the dynamics popover in Write mode in any of the following ways when either an 
item is selected or the caret is active:

● Press Shift-D .

● In the Notations toolbox, click Popovers , then Dynamics .

● Select an existing dynamic and press Return .

● Choose Write > Create Dynamic.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Dynamics popover with an example entry
Dynamics button in the Notations toolbox

Dynamics popover entries

Dynamic or modifier Popover entry

pianissimo:  pp

piano:  p

mezzo piano:  mp
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Dynamic or modifier Popover entry

mezzo forte:  mf

forte:  f

fortissimo:  ff

fortepiano without separator:  fp

fortepiano with separator, such as - f-p, f:p, or f/p

subito subito, sub, or sub.

possibile possibile, poss, or poss.

poco poco

molto molto

più piu or più

meno meno

mosso mosso

crescendo (appears as  by default) <

cresc. text only (property override) cresc

cresc. text with continuation line (property 
override)

cresc...

diminuendo (appears as  by default) >

dim. text only (property override) dim

dim. text with continuation line (property 
override)

dim...

messa di voce hairpin:  (crescendo then 
diminuendo)

<>

messa di voce hairpin:  (diminuendo then 
crescendo)

><
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Dynamic or modifier Popover entry

A pair of grouped hairpins that looks like a 
messa di voce hairpin

NOTE

You must separate hairpins with a space.

< > or > <

niente hairpins that start/end with a small circle o< or >o

niente hairpins that start/end with the letter “n” n< or >n

sforzando:  sfz

rinforzando:  rfz

This list is not comprehensive as you can enter anything as a dynamic modifier. It is intended to 
illustrate how you can structure your entry to input different types of dynamics.

NOTE

● Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce 
hairpins share a single center handle.

● You can input hairpins and messa di voce hairpins directly, without using the popover.

● For a crescendo hairpin, press < .

● For a diminuendo hairpin, press > .

● For a crescendo/diminuendo messa di voce hairpin, press Shift-Alt/Opt-, .

● For a diminuendo/crescendo messa di voce hairpin, press Shift-Alt/Opt-. .

● You can also change the appearance of individual gradual dynamics after they have been 
input.

Inputting modifiers into the dynamics popover

You can enter modifiers into the dynamics popover, such as poco, molto, subito, espressivo, or 
dolce. Modifiers appear in the correct italic font beside the dynamic. However, you must also 
enter an accompanying immediate dynamic, such as p or f, and separate the two with a space; 
for example, f molto or p espressivo.

You can hide immediate dynamics if you only want to show the modifier.

RELATED LINKS
Notations toolbox on page 201
Dynamics on page 921
Dynamic modifiers on page 932
Gradual dynamics on page 937
Messa di voce hairpins on page 945
Niente markings on page 947
Groups of dynamics on page 949
Hiding/Showing immediate dynamics on page 927
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Changing the appearance of gradual dynamics on page 939
Hiding/Showing combined dynamic separators on page 928
Changing the appearance of sforzando/rinforzando dynamics on page 929
Changing the appearance/position of subito modifiers on page 934

Dynamics panel
The Dynamics panel contains the different dynamics available in Dorico Elements, including 
gradual dynamics and dynamic modifiers, such as poco and possibile. It is located in the right 
zone in Write mode.

● You can hide/show the Dynamics panel by clicking Panels , then Dynamics  in the 
Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Dynamics panel contains the following sections:

Immediate Dynamics
Contains dynamics such as  and , and modifiers, such as subito and possibile. 
Available modifiers are shown at the top of the section in boxes.

You can only input modifiers alongside a dynamic.

Gradual Dynamics
Contains dynamics such as  and , and modifiers, such as poco and niente. Available 
modifiers are shown at the top of the section in boxes.

You can only input modifiers alongside a dynamic.

NOTE

Pairs of separate hairpins are treated differently than messa di voce hairpins. For 
example, separate hairpins each have start and end handles in Write mode, whereas 
messa di voce hairpins share a single center handle.

Force/Intensity of Attack
Contains dynamics such as  and .

Combined Dynamics
Allows you to create custom combinations of dynamics, such as . The controls 
allow you to increase and decrease the dynamic on each side, and to swap their order.

RELATED LINKS
Notations toolbox on page 201
Dynamics on page 921
Dynamic modifiers on page 932
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Gradual dynamics on page 937
Messa di voce hairpins on page 945
Niente markings on page 947
Hiding/Showing combined dynamic separators on page 928

Inputting dynamics with the popover
You can input dynamics and modifiers using the dynamics popover, both during note input and 
by adding them to existing music, including inputting whole dynamic phrases. You can also input 
different dynamics into each voice independently in multiple-voice contexts; for example, to give 
the separate staves of grand staff instruments different dynamics.

TIP

● You can input dynamics in the middle of tie chains by starting note input, then moving the 
caret to the required rhythmic position.

● You can also change dynamics during note input by following these steps when the caret is 
at the rhythmic position of the dynamic you want to change.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

NOTE

If you want to input voice-specific dynamics, the caret must be active.

● Select an item on each staff at the rhythmic position where you want to input dynamics. 
If you want to input dynamics across a duration, select items that span the required 
duration.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Open the dynamics popover in any of the following ways:

● Press Shift-D .

● In the Notations toolbox, click Popovers , then Dynamics .

4. Enter the dynamics you want into the popover.

For example, p, p<f>p, or f>.

5. Input the dynamics and close the popover in one of the following ways:

● To input the dynamics for all voices/staves belonging to the selected instruments, press 
Return .

● During note input, input the dynamics only into the voice indicated by the caret indicator 
by pressing Alt/Opt-Return .

6. Optional: During note input, advance the caret and extend open-ended gradual dynamics, 
such as p<, in any of the following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

Open-ended gradual dynamics also extend automatically as you continue inputting notes.

7. Optional: During note input, stop open-ended dynamics in any of the following ways:
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● Press ? .

● Open the dynamics popover and input an immediate dynamic, such as f.

RESULT
The specified dynamics are input. Unless you input voice-specific dynamics, dynamics apply to 
all voices on all staves belonging to a single instrument, including grand staff instruments. Voice-
specific dynamics are placed on the default side of the staff for the instrument type, regardless of 
the voice’s stem direction.

Adjoining dynamics, or dynamics that were input together or in sequence, are automatically 
grouped together, both during note input and when adding dynamics to existing music.

During note input, dynamics are input at the caret position on all staves across which the caret 
extends. If you included an open-ended gradual dynamic, it extends automatically when you 
advance the caret or input notes. Voice-specific dynamics are input in the voice indicated by the 
quarter note symbol beside the caret.

Dynamics added to existing music are input at the rhythmic position of, or span the duration 
of, either only notes or any items on each selected staff, according to your item input position 
setting.

Gradual dynamics added to existing music end at either the start or end of the last selected note, 
according to your gradual dynamic input position setting.

NOTE

● If you entered a dynamic phrase into the popover during note input, such as p<f>p, each 
gradual dynamic lasts a quarter note (crotchet). You can lengthen/shorten gradual dynamics 
and groups of dynamics later.

● Some modifiers, such as molto, appear before immediate dynamics rather than after them, 
even if you do not enter them in that order. This follows the generally accepted practice for 
the placement of that text.

You can add modifiers before and after existing dynamics. You can also hide immediate 
dynamics later if you only want to show the modifier.

● Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce 
hairpins share a single center handle.

● You can input hairpins and messa di voce hairpins directly, without using the popover.

● For a crescendo hairpin, press < .

● For a diminuendo hairpin, press > .

● For a crescendo/diminuendo messa di voce hairpin, press Shift-Alt/Opt-, .

● For a diminuendo/crescendo messa di voce hairpin, press Shift-Alt/Opt-. .

AFTER COMPLETING THIS TASK
You can move dynamics within dynamic phrases and change the placement of dynamics relative 
to the staff.

RELATED LINKS
Dynamics on page 921
Notations toolbox on page 201
Caret on page 218
Moving the caret manually on page 223
Extending the caret to multiple staves on page 222
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Changing the item input position setting on page 213
Changing the gradual dynamic input position setting on page 317
Keyboard panel on page 206
Fretboard panel on page 208
Drum Pads panel on page 209
Dynamics editor on page 694
Dynamics in playback on page 953
Gradual dynamics on page 937
Messa di voce hairpins on page 945
Niente markings on page 947
Gradual dynamics in Engrave mode on page 938
Changing the appearance of gradual dynamics on page 939
Adding niente markings to existing gradual dynamics on page 948
Groups of dynamics on page 949
Voice-specific dynamics on page 931
Dynamic modifiers on page 932
Changing the appearance/position of subito modifiers on page 934
Hiding/Showing combined dynamic separators on page 928
Changing dynamic levels on page 926
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430
Showing consecutive hairpins as continuous on page 940
Hiding/Showing immediate dynamics on page 927
Changing the staff-relative placement of items on page 434

Inputting dynamics with the panel
You can input dynamics and modifiers using the Dynamics panel, both during note input 
and by adding them to existing music. You can also input different dynamics into each voice 
independently in multiple-voice contexts; for example, to give the separate staves of grand staff 
instruments different dynamics.

NOTE

● You can input dynamics in the middle of tie chains by starting note input, then moving the 
caret to the required rhythmic position.

● You can also change dynamics during note input by following these steps when the caret is 
at the rhythmic position of the dynamic you want to change.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

NOTE

If you want to input voice-specific dynamics, the caret must be active.

● Select an item on each staff at the rhythmic position where you want to input dynamics. 
If you want to input dynamics across a duration, select items that span the required 
duration.

2. In the Notations toolbox, click Panels , then Dynamics  to show the Dynamics panel.
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3. Input the dynamics you want in one of the following ways:

● To input dynamics for all voices/staves belonging to the selected instruments, click them 
in the Dynamics panel.

● During note input, input the dynamics only into the voice indicated by the caret indicator 
by Alt/Opt -clicking them in the Dynamics panel.

NOTE

● If you want to add expressive or qualifying text to the dynamics, do not deselect them.

● When inputting voice-specific dynamics, you can release Alt/Opt  once you have input 
the dynamic level, such as .

● Gradual dynamics have a default duration of a quarter note. You can lengthen/shorten 
gradual dynamics later.

4. Optional: In the Dynamics panel, click the expressive/qualifying texts you want in the 
Immediate Dynamics and Gradual Dynamics sections.

RESULT
The specified dynamics are input. Unless you input voice-specific dynamics, dynamics apply to 
all voices on all staves belonging to a single instrument, including grand staff instruments. Voice-
specific dynamics are placed on the default side of the staff for the instrument type, regardless of 
the voice’s stem direction.

Adjoining dynamics, or dynamics that were input together or in sequence, are automatically 
grouped together, both during note input and when adding dynamics to existing music.

During note input, dynamics are input at the caret position. Gradual dynamics are input with a 
default duration of a quarter note. Voice-specific dynamics are input in the voice indicated by the 
quarter note symbol beside the caret.

Dynamics added to existing music are input at the rhythmic position of, or span the duration 
of, either only notes or any items on each selected staff, according to your item input position 
setting.

Gradual dynamics added to existing music end at either the start or end of the last selected note, 
according to your gradual dynamic input position setting.

NOTE

● Some modifiers, such as molto, appear before immediate dynamics rather than after them, 
even if you do not enter them in that order. This follows the generally accepted practice for 
the placement of that text.

You can add modifiers before and after existing dynamics. You can also hide immediate 
dynamics later if you only want to show the modifier.

● Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce 
hairpins share a single center handle.

● You can also input gradual dynamics by clicking the gradual dynamic you want in the 
Dynamics panel when nothing is selected in the music area. Then click and drag to input 
the gradual dynamic and extend it to the length you want.

AFTER COMPLETING THIS TASK
You can move dynamics within dynamic phrases and change the placement of dynamics relative 
to the staff.
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RELATED LINKS
Notations toolbox on page 201
Caret on page 218
Dynamics on page 921
Voices on page 1438
Dynamics in playback on page 953
Gradual dynamics in Engrave mode on page 938
Changing the appearance of sforzando/rinforzando dynamics on page 929
Hiding/Showing combined dynamic separators on page 928
Changing dynamic levels on page 926
Hiding/Showing immediate dynamics on page 927
Changing your mouse input settings on page 211

Changing the gradual dynamic input position setting
By default, Dorico Elements inputs gradual dynamics spanning the full duration of selected 
notes/items. You can change this setting if you prefer gradual dynamics to end at the start of the 
last selected note.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Editing section, activate/deactivate End gradual dynamics at start of last note in 
multiple selections.

4. Click Apply, then Close.

RESULT
When End gradual dynamics at start of last note in multiple selections is activated, gradual 
dynamics end at the start of the last selected note. Immediate dynamics at the end of gradual 
dynamics are attached to the last selected note.

When End gradual dynamics at start of last note in multiple selections is deactivated, 
gradual dynamics end at the end of the last selected note. Immediate dynamics at the end of 
gradual dynamics are attached to the next note/rest.

EXAMPLE

Notes selected Dynamic phrase input with setting 
activated

Dynamic phrase input with setting 
deactivated

RELATED LINKS
Preferences dialog on page 58
Changing the item input position setting on page 213
Selecting notes/items on page 421
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Inputting chord symbols
You can input chord symbols using the chord symbols popover with the computer keyboard and 
any connected MIDI keyboard, both for all instruments or only for individual instruments. You 
can also open the chord symbols popover during note input; however, inputting a chord symbol 
stops note input.

PREREQUISITE
If you want to input chord symbols using a MIDI device, you have connected the MIDI device you 
want to use.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
input a chord symbol.

2. Open the chord symbols popover in any of the following ways:

● Press Shift-Q .

● In the Notations toolbox, click Popovers , then Chord Symbols .

NOTE

If you selected an item on a staff that has local chord symbols at earlier rhythmic positions, 
the chord symbols popover is automatically set to input local chord symbols when it opens.

3. Optional: Change the type of chord symbol you want to enter in one of the following ways:

● To input local chord symbols, press Alt/Opt-L .

● To input global chord symbols, press Alt/Opt-G .

The popover icon updates to show the current type.

Chord symbols popover when inputting a global 
chord symbol

Chord symbols popover when inputting a local 
chord symbol

4. Enter the chord symbol you want into the chord symbols popover in any of the following 
ways:

● Enter the appropriate letters and numbers using the computer keyboard. For example, 
enter D#sus4 for a D#sus4 chord symbol or CM7|D for a Cmaj7/D polychord chord 
symbol.

● Play the chord in the Keyboard panel.

● Play the chord using a MIDI keyboard.

TIP

● To input a polychord chord symbol, play the first chord and keep the keys 
depressed, then play the second chord.

● To input a chord symbol that consists only of the root note, just play a single note.

● You can indicate root notes in any of the following ways:

● First play the root with one finger, and then play the remaining notes of the 
chord while still holding down the root.
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● Play all the notes of the chord together, then release them all, then replay the 
root note.

● You can indicate altered bass notes in any of the following ways:

● Play all notes of the chord together with the altered bass note at the bottom.

● Play the chord and its altered bass note separately: Hold down the keys for the 
chord, then play the altered bass note while keeping the rest of the keys of the 
chord depressed.

5. Optional: Press Space  to advance the popover to the next beat according to the prevailing 
time signature.

TIP

You can also navigate the popover forwards and backwards by different amounts.

6. Optional: To input an individual local chord symbol when the popover is set to global, and 
vice versa, press Alt/Opt-Return  to input the chord symbol.

7. Press Return  to close the popover.

RESULT
The chord symbol specified is input. If you selected an item belonging to an instrument that 
was not already set to show chord symbols in the current layout, the corresponding player is 
automatically updated to show chord symbols for all instruments.

Global chord symbols apply to all instruments in the project and appear on all staves set to show 
chord symbols. Local chord symbols only apply to the selected instrument. Local chord symbols 
always appear, even if global chord symbols exist at the same rhythmic positions.

NOTE

● The chord symbol may look different to what you entered into the popover. For example, 
entering D|C7 may result in two chords placed directly above each other or two chords 
placed beside each other, depending on your settings in the Chord Symbols Options dialog.

● When you input chord symbols using a MIDI keyboard, the voicing you used is retained 
for chord symbol playback. You can reset the voicing of chord symbols input using MIDI 
keyboards.

AFTER COMPLETING THIS TASK
You can hide/show chord symbols above specific staves and hide/show chord diagrams 
alongside them.

RELATED LINKS
Notations toolbox on page 201
Keyboard panel on page 206
Chord symbols on page 871
Generating chord symbols from notes on page 326
Hiding/Showing chord symbols on page 878
Hiding/Showing chord symbols in layouts on page 879
Hiding/Showing chord diagrams on page 895
Inputting chord symbol regions on page 326
Inputting slash regions on page 417
Enabling/Disabling MIDI input devices on page 270
Chords track on page 535
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Enabling chord symbol playback on page 535
Resetting the voicing of chord symbols on page 536
Chord symbol appearance presets on page 872

Chord symbols popover
The following tables contain examples of what you can enter into the chord symbols popover to 
input the different possible chord symbol components. You can enter them in any combination.

You can open the chord symbols popover in Write mode in any of the following ways when either 
an item is selected or the caret is active:

● Press Shift-Q .

● In the Notations toolbox, click Popovers , then Chord Symbols .

● Select an existing chord symbol and press Return .

● Choose Write > Create Chord Symbol.

When inputting global chord symbols, the icon on the left-hand side of the popover matches the 
corresponding button in the Notations toolbox. When inputting local chord symbols, the icon on 
the left-hand side of the popover appears smaller and includes the icon for a single player.

Chord symbols popover with an 
example entry for a global chord 
symbol

Chord symbols popover with an 
example entry for a local chord 
symbol

Chord Symbols button in the 
Notations toolbox

NOTE

You can combine multiple types of entries to create more complex chord symbols if you enter 
them one after another into the chord symbols popover without spaces between them. For 
example, enter Eblocrian for the following chord symbol:

Chord symbol roots

Type of chord symbol root Popover entry

English note names

C, D♭, F♯, B, and so on

C, Db, F#, B, and so on

German note names

C, D♭, F♯, H, and so on

C, Des, Fis, H, and so on

Fixed-do solfège

C, D♭, F, F♯, B, and so on

do, reb, fa, fa#, ti, and so on
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Type of chord symbol root Popover entry

Nashville numbers representing scale degrees

Assuming C major:

C, D♭, F♯, B, and so on

1, 2b, 4#, 7, and so on

TIP

When using a MIDI keyboard, you can also indicate root notes in any of the following ways:

● First play the root with one finger, and then play the remaining notes of the chord while still 
holding down the root.

● Play all the notes of the chord together, then release them all, then replay the root note.

Chord symbol accidentals

Type of accidental Popover entry

Sharp #

Flat b

Double sharp x or ##

Triple sharp x#, #x, or ###

Double flat bb

Triple flat bbb

Chord symbol qualities

Chord symbol quality Popover entry

Major maj, M, ma, or nothing after entering the root.

Minor m, min, or mi

Diminished dim, di, or o

Augmented aug, au, ag, or +

Half-diminished half-dim, halfdim, or hd

6/9 6/9, 69, or %
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NOTE

M and m entries for major and minor are case-sensitive.

Chord symbol intervals

Interval Popover entry

Scale degrees 1, 2, 3, and so on

Major 7th ^7 or ^

Major 9th ^9, maj9, or 9maj7

Chord symbol alterations

Type of chord symbol alteration Popover entry

Alterations b5, -5, #9, +9, b10, and so on

Added notes add#11, add+11, addb9, add-9, addF#, 
addBb, and so on

Suspensions sus4, sus9, and so on

Omissions omit3, no7, and so on

Chord symbols with altered bass notes

Example altered bass note chord symbols Popover entry

G7/D G7/D, G7,D, Gmaj7/D or Gmaj7,D

C(♭5)/E♭ CMb5/Eb, CMb5,Eb, Cmajb5/Eb, or Cmajb5,Eb

Fm/D♯ Fm/D#, Fm,D#, Fmi/D#, or Fmi,D#

TIP

When using a MIDI keyboard, you can also indicate altered bass notes in any of the following 
ways:

● Play all notes of the chord together with the altered bass note at the bottom.

● Play the chord and its altered bass note separately: Hold down the keys for the chord, then 
play the altered bass note while keeping the rest of the keys of the chord depressed.
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Polychord chord symbols

Example polychord chord symbols Popover entry

G/E G|E, G;E, Gmaj|E, or Gmaj;E

Cmaj7/D CM7|D, CM7;D, Cmaj7|D, or Cmaj7;D

Fm/D♯ Fm|D#, Fm;D#, Fmi|D#, or Fmi;D#

TIP

When using a MIDI keyboard, you can also input polychord symbols by playing the first chord 
and keeping the keys depressed, then playing the second chord.

No chord symbols

No chord symbol Popover entry

No chord N.C., NC, no chord, or none

Modal chord symbols

Modal chord symbol Popover entry

Ionian ionian

Dorian dorian

Phrygian phrygian

Lydian lydian

Mixolydian mixolydian

Aeolian aeolian

Locrian locrian

Melodic minor melodicminor

Harmonic minor harmonicminor

Whole tone wholetone
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Modal chord symbol Popover entry

Half-whole diminished or octatonic diminishedhalfwhole, 
diminishedsemitonetone, 
octatonichalfwhole, or 
octatonicsemitonetone

Whole-half diminished or octatonic diminishedwholehalf, 
diminishedtonesemitone, 
octatonicwholehalf, or 
octatonictonesemitone

This list is not comprehensive, as there are many possible chord symbols. It is intended to 
illustrate the different components you can use to input different chord symbols.

NOTE

The appearance of the resulting chord symbols is determined by Dorico Elements’s default 
settings. The structure of your entry in the chord symbols popover is not considered. For 
example, entering a C major chord as C, Cmaj, or CM results in the same chord symbol.

Parenthesized chord symbols

Example parenthesized chord symbol Popover entry

(Cmaj7) (Cmaj7)

Chord symbol regions

Chord symbol region Popover entry

New chord symbol region reg

RELATED LINKS
Notations toolbox on page 201
Chord symbols on page 871
Parenthesized chord symbols on page 889

Write mode
Notations input 

324
Dorico Elements 5.1.30



Navigation during chord symbol input

You can move the chord symbols popover manually by different amounts to input chord symbols 
at other positions without closing and reopening the popover each time.

Navigating with a computer keyboard

Popover navigation Key command

Advance the popover to the next beat, 
according to the prevailing time signature.

Space

Move the popover back to the previous beat, 
according to the prevailing time signature.

Shift-Space

Advance the popover to the start of the next 
bar.

Tab

Move the popover back to the start of the 
previous bar.

Shift-Tab

Move the cursor and popover to one of the 
following positions, whichever is closest:

● Next/Previous note or rest

● Next/Previous rhythmic grid position

● Next/Previous character in existing chord 
symbol’s entry

Right Arrow / Left Arrow

Move the popover to the next/previous chord 
symbol.

Ctrl/Cmd-Right Arrow / Ctrl/Cmd-Left Arrow

Navigating with a MIDI keyboard

When inputting chord symbols using a MIDI keyboard, by default the popover advances 
automatically to the next beat after you play a chord.

You can define specific keys or buttons on your MIDI keyboard to trigger different navigation 
behaviors. Use the MIDI Learn button on the Key Commands page in Preferences to assign 
specific keys to the Note Input > Advance Chord Symbol Input commands.

RELATED LINKS
Key Commands page in the Preferences dialog on page 60
Assigning MIDI commands on page 63
Assigning key commands on page 63
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Inputting chord symbol regions
You can input specific regions in which you want to show chord symbols; for example, if an 
instrument that does not need chord symbols for most of the project has an improvisation 
section that requires chord symbols to be shown.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● On each staff where you want to input a chord symbol region, select items that span the 
required duration.

2. Open the chord symbols popover in any of the following ways:

● Press Shift-Q .

● In the Notations toolbox, click Popovers , then Chord Symbols .

3. Enter reg into the popover.

4. Press Return  to close the popover.

RESULT
During note input, chord symbol regions are input spanning the duration of the selected note or 
item, which is usually the last input note.

When adding chord symbol regions to existing music, they span the selected duration on each 
selected staff.

The players holding the corresponding instruments are automatically set to show chord symbols 
in chord symbol regions and slash regions, even if they were previously set to hide all chord 
symbols.

TIP

You can also input chord symbol regions by choosing Write > Create Chord Symbol Region. You 
can assign a key command for this option on the Key Commands page in Preferences.

RELATED LINKS
Chord symbols popover on page 320
Chord symbol regions on page 882
Hiding/Showing chord symbols on page 878
Inputting slash regions on page 417
Key Commands page in the Preferences dialog on page 60

Generating chord symbols from notes
You can automatically generate chord symbols based on the harmony of notes you have already 
input. You can specify the musical context you want to consider in the calculation, such as which 
note durations and inversions to include.

PROCEDURE

1. In Write mode, select the notes from which you want to generate chord symbols.

TIP

You can select notes on multiple staves.
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2. Choose Edit > Notations > Chord Symbols and Diagrams > Generate Chord Symbols from 
Selection to open the Generate Chord Symbols From Notes dialog. You can also choose 
this option from the context menu.

3. Change the settings as required.

For example, you can change the minimum note duration you want to include in chord 
symbols, and disallow the creation of open fifth chord symbols.

4. Click OK to save your changes and close the dialog.

RESULT
Chord symbols are generated based on the selected notes and your settings. Chord symbols are 
input at the rhythmic positions of chords comprising at least two or three notes, depending on 
your settings.

All instruments included in your selection are set to show chord symbols.

RELATED LINKS
Hiding/Showing chord symbols on page 878
Calculating harp pedal diagrams based on existing music on page 381

Generate Chord Symbols From Selection dialog

The Generate Chord Symbols From Selection dialog allows you to generate chord symbols 
based on the harmony of notes you have already input, and specify the musical context you want 
to consider in the calculation.

● You can open the Generate Chord Symbols From Selection dialog in Write mode when at 
least one chord is selected in the music area by choosing Edit > Notations > Chord Symbols 
and Diagrams > Generate Chord Symbols from Selection. You can also choose this option 
from the context menu.

The Generate Chord Symbols From Selection dialog contains the following options:
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Harmonic rhythm
Allows you to set the minimum rhythmic interval between generated chord symbols.

● Every bar: Chord symbols are created at least every bar.

● Every beat: Chord symbols are created at least every beat, according to the 
prevailing time signature.

● Fixed: Chord symbols are created at the specified interval.

Minimum duration of single notes following chords to include in analysis
Allows you to set the shortest note value for single notes that you want to include in 
the chord symbol calculation. This allows you to exclude passing notes shorter than the 
set duration.

Minimum duration of chords eligible for chord symbols
Allows you to set the shortest note value for chords that you want to include in the 
chord symbol calculation. This allows you to exclude transitory chords shorter than the 
set duration.

Only use downbeats when creating chord symbols from notes at multiple positions
When activated, only notes that start on strong beats in each bar are included in the 
chord symbol calculation.

Detect inversions
Allows you to change how inversions are handled in the chord symbol calculation.

● Always: Inversions are always considered.

● Never: Inversions are never considered. This is particularly useful when calculating 
chord symbols from notes belonging to multiple instruments.

● Below specific pitch: Inversions are only considered for notes below the specified 
pitch.

Only create chord symbols from horizontal passages when unambiguous
When activated, chord symbols are only created from notes at multiple rhythmic 
positions if the resulting chord is simple.

Try to detect and handle passing notes
When activated, Dorico Elements detects passing notes where possible and excludes 
them from the chord symbol calculation.

Use vamp detection
When activated, Dorico Elements detects rhythmic patterns and textures often used 
when vamping and considers them in the chord symbol calculation.

Minimum length for chords in vamp
Allows you to change the minimum note value for chords in vamp sections.

Maximum rhythmic separation between chords in vamp
Allows you to change the maximum gap between chords in vamp sections.

Allow creation of open fifths
When activated, Dorico Elements creates chord symbols from chords comprising only 
two notes, a fifth apart.

Allow creation of major and minor thirds
When activated, Dorico Elements creates chord symbols from chords comprising only 
two notes, a third apart.

Write mode
Notations input 

328
Dorico Elements 5.1.30



Ignore omitted fifths
Allows you to change how chords with omitted fifths are handled.

● Never: Omitted fifths are never ignored, meaning chords are considered 
according to the notes available.

● In major/minor triads: Omitted fifths are only ignored in chords comprising only 
two notes, a third apart.

● In major/minor triads and chords with 7th: Omitted fifths are ignored in chords 
comprising only two notes, a third apart, and chords with a seventh.

● Always: Omitted fifths are always ignored, meaning chord symbols are created as 
if the fifth were present.

RELATED LINKS
Chord symbols on page 871
Inputting chord symbols on page 318
Hiding/Showing chord symbols on page 878
Calculating harp pedal diagrams based on existing music on page 381
Types of time signatures on page 1382

Input methods for clefs and octave lines
You can input clefs and octave lines with the keyboard by using the clefs and octave lines 
popover, and also with the mouse by using the Clefs panel.

Clefs and octave lines share the same popover and panel as both affect the pitch and register of 
notes.

RELATED LINKS
Clefs on page 907
Octave lines on page 915

Clefs and octave lines popover
The following tables contain the entries for the clefs and octave lines popover that you can use to 
input the different clefs and octave lines available.

You can open the clefs and octave lines popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-C .

● In the Notations toolbox, click Popovers , then Clefs .

● Select an existing clef or octave line and press Return .

● Choose Write > Create Clef.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Clefs and octave lines popover 
with an example entry for a clef

Clefs and octave lines popover 
with an example entry for an 
octave line

Clefs button in the Notations 
toolbox
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Clefs

Type of clef Popover entry

Treble G clef g, G, g2, sol, or treble

Bass F clef f, F, f4, fa, or bass

Tenor C clef ct, CT, c4, ut4, or tenor

Alto C clef ca, CA, c3, ut3, or alto

Treble G clef, octave below g8ba, G8ba, g8d, G8d, treble8ba, or treble8d

Unpitched percussion perc

4-string tablature tab4

6-string tablature tab6

TIP

The rectangular percussion clef is available in the Clefs panel.

Octave shifts for clefs

Function of octave shifts Popover entry

Shift notes up by one octave +1

Shift notes up by two octaves +2

Shift notes down by one octave -1

Shift notes down by two octaves -2

Set octave shift for concert pitch c

Set octave shift for transposed pitch t

For example, enter treble+1t for a treble clef shifted up one octave in transposed pitch layouts, 
causing notes after the clef in transposed pitch layouts to appear an octave lower than they 
appear with a normal treble clef.
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Octave lines

Function of octave line Popover entry

Shift notes up by one octave 8va, 8, 8u, or 1u

Shift notes up by two octaves 15ma, 15, 15u, or 2u

Shift notes up by three octaves 22ma, 22, 22u, or 3u

Shift notes down by one octave 8ba, 8vb, 8d, or 1d

Shift notes down by two octaves 15ba, 15vb, 15d, or 2d

Shift notes down by three octaves 22ba, 22vb, 22d, or 3d

Loco indication loco

End of octave line

For example, enter stop to specify where an 
octave line ends during note input.

| or stop

RELATED LINKS
Notations toolbox on page 201
Clefs on page 907
Octave lines on page 915
Changing the octave of clefs on page 912
Respecting/Ignoring clef octave indicators on page 913

Clefs panel
The Clefs panel contains the different types of clefs and octave lines available in Dorico Elements. 
It is located in the right zone in Write mode.

● You can hide/show the Clefs panel by clicking Panels , then Clefs  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Clefs panel contains the following sections:

Common Clefs
Contains the clefs you are most likely to need, including treble clef and bass clef.

Octave Lines
Contains octave lines, indicating up to three octaves above and below, and a loco line.

RELATED LINKS
Notations toolbox on page 201
Clefs on page 907
Octave lines on page 915
Inputting clefs with the panel on page 333
Inputting octave lines with the panel on page 335
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Inputting clefs with the popover
You can input clefs using the clefs and octave lines popover, both during note input and by 
adding them to existing music. You can also use the popover to change the type of existing clefs.

NOTE

Many instruments in Dorico Elements have variants that show alternative clefs according to 
the layout transposition by default. You can select the appropriate instrument variant from the 
instrument picker when adding or changing instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff at the rhythmic position where you want to input a clef. If 
you want to add restorative clefs at later positions, select items that span the required 
duration.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Open the clefs and octave lines popover in any of the following ways:

● Press Shift-C .

● In the Notations toolbox, click Popovers , then Clefs .

4. Enter the appropriate entry for the clef you want into the popover.

For example, enter:

● bass for a bass clef.

● alto for an alto clef.

● treble+1t for a treble clef shifted up one octave in transposed pitch layouts.

5. Press Return  to close the popover.

RESULT
During note input, clefs are input at the caret position on all staves across which the caret 
extends.

Clefs added to existing music are input on each selected staff, at the rhythmic position of the 
earliest selected either note or item, according to your item input position setting. When you add 
clefs to a range of selected items, restorative clefs are also added at the end of the selection.

Clefs apply to all notes on the staff until the next clef or the end of the flow, whichever comes 
first.

RELATED LINKS
Clefs on page 907
Changing the item input position setting on page 213
Extending the caret to multiple staves on page 222
Hiding/Showing clefs on page 910
Hiding/Showing clefs according to layout transpositions on page 910
Changing the octave of clefs on page 912
Respecting/Ignoring clef octave indicators on page 913
Changing instruments on page 134
Adding instruments to players on page 133
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Inputting clefs with the panel
You can input clefs using the Clefs panel, both during note input and by adding them to existing 
music.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection.

● Many instruments in Dorico Elements have variants that show alternative clefs according to 
the layout transposition by default. You can select the appropriate instrument variant from 
the instrument picker when adding or changing instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff at the rhythmic position where you want to input a clef. If 
you want to add restorative clefs at later positions, select items that span the required 
duration.

2. In the Notations toolbox, click Panels , then Clefs  to show the Clefs panel.

3. In the Clefs panel, click the clef you want.

RESULT
During note input, clefs are input at the caret position.

Clefs added to existing music are input on each selected staff, at the rhythmic position of the 
earliest selected either note or item, according to your item input position setting. When you add 
clefs to a range of selected items, restorative clefs are also added at the end of the selection.

Clefs apply to all notes on the staff until the next clef or the end of the flow, whichever comes 
first.

RELATED LINKS
Notations toolbox on page 201
Clefs on page 907
Changing your mouse input settings on page 211
Hiding/Showing clefs on page 910
Universal Indian Drum Notation on page 1436

Inputting octave lines with the popover
You can input octave lines using the clefs and octave lines popover, both during note input and 
by adding them to existing music. You can also input octave lines only into specific voices in 
multiple-voice contexts.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes to which you want to add an octave line. If you want to add an octave 
line for a single voice, only select notes in that voice.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.
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3. Open the clefs and octave lines popover in any of the following ways:

● Press Shift-C .

● In the Notations toolbox, click Popovers , then Clefs .

4. Enter the appropriate entry for the octave line you want into the popover.

For example, enter 8va for an octave line that shifts notes up one octave.

5. Input the octave line and close the popover in one of the following ways:

● To input an octave line for all voices on each selected staff, press Return .

● To input an octave line only for the currently selected voice, press Alt/Opt-Return .

6. Optional: During note input, advance the caret and extend the octave line in any of the 
following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

The octave line also extends automatically as you continue inputting notes.

7. Optional: During note input, stop any octave line by opening the clefs and octave lines 
popover again and entering | or stop.

RESULT
During note input, octave lines are input from the caret position, on all staves across which the 
caret extends. When you stop octave lines, they end at the caret position.

Octave lines added to existing music span the duration of either only notes or any items on each 
selected staff, according to your item input position setting.

Octave lines appear either above or below your selection, depending on whether they indicate 
that notes are played higher or lower than notated.

The pitches of notes within octave lines are adjusted automatically. For example, notes within 
octave above lines appear an octave lower than they do without the octave above line.

TIP

You can also lengthen/shorten octave lines after they have been input.

RELATED LINKS
Clefs and octave lines popover on page 329
Octave lines on page 915
Hiding/Showing octave lines on page 917
Extending the caret to multiple staves on page 222
Changing the item input position setting on page 213
Lengthening/Shortening items on page 430
Changing the pitch of individual notes on page 468
Notations toolbox on page 201
Keyboard panel on page 206
Fretboard panel on page 208
Drum Pads panel on page 209
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Inputting octave lines with the panel
You can input octave lines using the Clefs panel, both during note input and by adding them to 
existing music. You can also input octave lines only into specific voices in multiple-voice contexts.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes to which you want to add an octave line. If you want to add an octave 
line for a single voice, only select notes in that voice.

2. In the Notations toolbox, click Panels , then Clefs  to show the Clefs panel.

3. Input the octave line you want in one of the following ways:

● To input an octave line for all voices on the selected staves, click it in the Octave Lines 
section.

● To input an octave line only for the currently selected voice, Alt/Opt -click it in the 
Octave Lines section.

Alternatively, when adding octave lines to existing music, you can click the octave line you 
want in the Clefs panel first, and then click and drag it to the length you want.

RESULT
During note input, octave lines are input at the caret position. They are input with a default 
duration of a quarter note.

Octave lines added to existing music span the duration of either only notes or any items on each 
selected staff, according to your item input position setting.

Octave lines appear either above or below your selection, depending on whether they indicate 
that notes are played higher or lower than notated.

The pitches of notes within octave lines are adjusted automatically. For example, notes within 
octave above lines appear an octave lower than they do without the octave above line.

TIP

You can also lengthen/shorten octave lines after they have been input.

RELATED LINKS
Notations toolbox on page 201
Octave lines on page 915
Lengthening/Shortening items on page 430
Changing the pitch of individual notes on page 468
Changing your mouse input settings on page 211
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Input methods for holds and pauses
You can input holds and pauses with the keyboard by using the holds and pauses popover in 
Write mode, and with the mouse by using the Holds and Pauses panel.

RELATED LINKS
Holds and pauses on page 1010
Correct positioning for caesura input on page 340

Holds and pauses popover
The table contains the entries for the holds and pauses popover that you can use to input the 
different holds and pauses available.

You can open the holds and pauses popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-H .

● In the Notations toolbox, click Popovers , then Holds and Pauses .

● Select an existing hold or pause and press Return .

● Choose Write > Create Hold or Pause.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Holds and pauses popover with an example entry
Holds and Pauses button in the Notations toolbox

Fermatas

Type of fermata Popover entry

Fermata fer, fermata, or pause

Very long fermata verylongfermata or verylongfer

Long fermata longfermata or longfer

Short fermata shortfermata or shortfer

Very short fermata veryshortfermata or veryshortfer

Short fermata (Henze) shorthenzefermata or shorthenzefer

Long fermata (Henze) longhenzefermata or longhenzefer

Curlew (Britten) curlew
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NOTE

The Curlew mark was originally devised by Benjamin Britten for “Curlew River”, a parable for 
church performance inspired by Japanese Noh theater. It indicates that a player should hold a 
note or a rest until a synchronization point in asynchronous music.

Caesuras

Type of caesura Popover entry

Caesura caes, caesura, or //

Thick caesura caesurathick, thickcaesura, or thick//

Curved caesura caesuracurved, curvedcaesura, or curved//

Short caesura caesurashort, shortcaesura, or short//

Single-stroke caesura caesurasingle, singlecaesura, or single//

Breath marks

Type of breath mark Popover entry

Breath mark (Comma-like) breathmarkcomma, comma, or , (comma)

Breath mark (Tick-like) breathmarktick

Breath mark (Upbow-like) breathmarkupbow

Breath mark (Salzedo) breathmarksalzedo

RELATED LINKS
Notations toolbox on page 201
Holds and pauses on page 1010
Types of fermatas on page 1011
Types of caesuras on page 1012
Types of breath marks on page 1012

Holds and Pauses panel
The Holds and Pauses panel allows you to input all the different types of holds and pauses 
available in Dorico Elements, including alternative versions of fermatas. It is located in the right 
zone in Write mode.

● You can hide/show the Holds and Pauses panel by clicking Panels , then Holds and 
Pauses  in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Holds and Pauses panel contains the following sections:
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● Fermatas

● Breath Marks

● Caesuras

NOTE

Holds and pauses do not currently have an effect in playback, but this is planned for future 
versions.

RELATED LINKS
Notations toolbox on page 201
Inputting holds and pauses with the panel on page 339
Holds and pauses on page 1010
Types of fermatas on page 1011
Types of caesuras on page 1012
Types of breath marks on page 1012

Inputting holds and pauses with the popover
You can input holds and pauses using the holds and pauses popover, both during note input and 
by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a fermata or caesura.

● Select an item on each staff at the rhythmic position where you want to input a breath 
mark.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Open the holds and pauses popover in any of the following ways:

● Press Shift-H .

● In the Notations toolbox, click Popovers , then Holds and Pauses .

4. Enter the hold or pause you want into the popover.

For example, enter fermata for a pause or caesura for a caesura.

5. Press Return  to close the popover.

RESULT
During note input, the specified hold or pause is input at the caret position. Breath marks are 
input at the caret position on all staves across which the caret extends.

Breath marks added to existing music are input on each selected staff, at the rhythmic position 
of the earliest selected either note or item, according to your item input position setting.

Fermatas and caesuras added to existing music are input at the rhythmic position of the earliest 
selected item.

● Fermatas appear on all staves at the rhythmic position of the note, chord, or rest that 
corresponds with the end of the fermata.

● Breath marks appear to the right of the caret or selected note.

● Caesuras appear on all staves to the left of the caret or selected note.
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RELATED LINKS
Changing the item input position setting on page 213
Extending the caret to multiple staves on page 222
Holds and pauses on page 1010
Holds and pauses in playback on page 1016
Types of fermatas on page 1011
Types of breath marks on page 1012
Types of caesuras on page 1012
Positions of holds and pauses on page 1012

Inputting holds and pauses with the panel
You can input holds and pauses using the Holds and Pauses panel, both during note input and 
by adding them to existing music.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a fermata or caesura.

● Select an item on each staff at the rhythmic position where you want to input a breath 
mark.

2. In the Notations toolbox, click Panels , then Holds and Pauses  to show the Holds and 
Pauses panel.

3. In the Holds and Pauses panel, click the hold or pause you want.

RESULT
During note input, the specified hold or pause is input at the caret position.

Breath marks added to existing music are input on each selected staff, at the rhythmic position 
of the earliest selected either note or item, according to your item input position setting.

Fermatas and caesuras added to existing music are input at the rhythmic position of the earliest 
selected item.

● Fermatas appear on all staves at the rhythmic position of the note, chord, or rest that 
corresponds with the end of the fermata.

● Breath marks appear to the right of the caret or selected note.

● Caesuras appear on all staves to the left of the caret or selected note.

RELATED LINKS
Notations toolbox on page 201
Holds and pauses on page 1010
Holds and pauses in playback on page 1016
Positions of holds and pauses on page 1012
Changing your mouse input settings on page 211
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Correct positioning for caesura input
Caesuras are commonly placed at the end of a bar, before a barline. In Dorico Elements, caesuras 
must be attached to the note immediately after the position where you want it to appear, as then 
Dorico Elements can automatically position them correctly.

If you input caesuras with your mouse input preference set to Load pointer with item, you must 
click the first note in the next bar for a caesura to appear to the left of the barline. You can also 
click directly on the barline.

A correctly input caesura. The dotted attachment 
lines are attached to the notehead after the barline, 
meaning the caesura is correctly positioned before 
the barline.

An incorrectly input caesura. By clicking to the left of 
the barline, the caesura is attached to the last eighth 
note in the bar.

When input correctly, the dotted attachment lines link the caesura to the notehead immediately 
after the barline.

If your dotted attachment lines do not link the caesura to the notehead immediately after 
the barline, delete the caesura and re-input it. Caesuras can cause spacing issues when input 
incorrectly.

RELATED LINKS
Holds and pauses on page 1010
Types of caesuras on page 1012
Hiding/Showing attachment lines on page 437

Input methods for ornaments, arpeggio signs, glissando lines, and 
jazz articulations

You can input ornaments, including arpeggio signs, glissando lines, and jazz articulations with 
the keyboard by using the ornaments popover, and with the mouse by using the Ornaments 
panel.

You can input ornaments and arpeggio signs during note input and by adding them to existing 
notes, but you cannot input glissando lines during note input. You can only input glissando lines 
by adding them to existing notes.

You can specify the type/length of jazz articulations when using the Ornaments panel but not 
when using the ornaments popover.

RELATED LINKS
Ornaments on page 1090
Arpeggio signs on page 1108
Glissando lines on page 1115
Jazz articulations on page 1145
Jazz ornaments on page 1146
Lines on page 1194
Input methods for lines on page 385
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Ornaments popover
The following tables contain the entries for the ornaments popover that you can use to input the 
different ornaments, arpeggio signs, glissando lines, and jazz articulations available.

You can open the ornaments popover in Write mode in any of the following ways when either an 
item is selected or the caret is active:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

● Select an existing ornament and press Return .

● Choose Write > Create Ornament.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Ornaments popover with an example entry
Ornaments button in the Notations toolbox

Ornaments

Type of ornament Popover entry

Trill:  tr or trill

Short trill:  shorttr

Mordent:  mor or mordent

Turn:  turn

Inverted turn:  invturn or invertedturn

Trill intervals

Trill interval or quality Popover entry

Interval degree

Unison, second, third, fourth, fifth, sixth, 
seventh, octave

1, 2, 3, 4, 5, 6, 7, 8

Major M, maj, or major

Minor m, min, or minor

Perfect p, per, or perf
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Trill interval or quality Popover entry

Diminished d, dim, or diminished

Augmented a, aug, or augmented

EXAMPLE
To input a trill with a perfect fifth interval, enter tr p5.

Jazz ornaments

Type of jazz ornament Popover entry

Bend brassbend

Flip flip

Jazz turn jazz or shake

Smear smear

Jazz articulations

Type of jazz articulation Popover entry

Plop (bend) plop

Plop (smooth) plopsmooth

Scoop scoop

Doit (bend) doit

Doit (smooth) doitsmooth

Fall (bend) fall

Fall (smooth) fallsmooth

TIP

Other ornaments are available in the Ornaments panel. You can specify the type/length of jazz 
articulations when using the Ornaments panel but not when using the ornaments popover.
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Arpeggio signs

Type of arpeggio sign Popover entry

Up arpeggio sign arp, arpup, or arpeggioup

Down arpeggio sign arpdown or arpeggiodown

Non arpeggio sign nonarp or nonarpeggio

Curved arpeggio sign slurarp

Glissando lines

Type of glissando line Popover entry

Default style glissando line gliss

Straight glissando line glissstraight

Wavy glissando line glisswavy

Guitar techniques

Type of guitar technique Popover entry

Guitar bend bend

Vibrato bar dive and return vibbend

Vibrato bar scoop vibscoop

Vibrato bar dip vibdip

Vibrato bar line

NOTE

Must have duration to show its line.

wbar or w/bar

Hammer-on

NOTE

You must select at least two notes assigned 
to the same string with ascending pitch 
directions, such as C-D.

ho or hammer
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Type of guitar technique Popover entry

Pull-off

NOTE

You must select at least two notes assigned 
to the same string with descending pitch 
directions, such as D-C.

po or pull

Hammer-on then pull-off or pull-off then 
hammer-on (ligado)

NOTE

You must select at least three notes assigned 
to the same string with alternating pitch 
directions, such as C-D-C or D-C-D.

hp, hopo, hammerpull, lig, or ligado

Right-hand tapping tap

Right-hand tapping with pull-off

NOTE

You must select at least two notes assigned 
to the same string with descending pitch 
directions, such as D-C.

tappull

Left-hand tapping lhtap

Left-hand tapping with pull-off

NOTE

You must select at least two notes assigned 
to the same string with descending pitch 
directions, such as D-C.

lhtappull

RELATED LINKS
Notations toolbox on page 201
Inputting arpeggio signs with the popover on page 347
Inputting glissando lines with the popover on page 349
Inputting jazz articulations with the popover on page 351
Inputting guitar bends with the popover on page 354
Inputting vibrato bar dives on page 356
Inputting vibrato bar dives and returns with the popover on page 358
Inputting vibrato bar scoops with the popover on page 360
Inputting vibrato bar dips with the popover on page 362
Inputting hammer-ons/pull-offs on page 364
Inputting tapping on page 366
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Assigning notes to strings on page 1059
Changing the allocated string for notes on tablature on page 1332
Ornaments on page 1090
Trill intervals on page 1097
Arpeggio signs on page 1108
Glissando lines on page 1115
Guitar bends on page 1122
Guitar techniques on page 1137
Jazz articulations on page 1145
Jazz ornaments on page 1146
Playing technique duration on page 1187

Ornaments panel
The Ornaments panel allows you to input all the different types of ornaments available, including 
jazz articulations, as well as arpeggio signs, glissando lines, guitar bends, and vibrato bar 
techniques. It is located in the right zone in Write mode.

● You can hide/show the Ornaments panel by clicking Panels , then Ornaments  in the 
Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Ornaments panel contains the following sections:

Jazz
Contains ornaments and pitch alterations commonly used in jazz music, such as bends, 
scoops, and falls.

Baroque and Classical
Contains ornaments commonly used in Baroque and Classical music, such as 
mordents, turns, and trills.

Arpeggiation
Contains the different types of arpeggio signs.

NOTE

You cannot input arpeggio signs with the panel during note input.

Glissandi
Contains the different types of glissando lines.

Guitar
Contains techniques and pitch alterations commonly associated with guitars, such as 
guitar bends and vibrato bar scoops.

RELATED LINKS
Notations toolbox on page 201
Inputting ornaments/trills with the panel on page 347
Inputting arpeggio signs with the panel on page 348
Inputting glissando lines with the panel on page 350
Inputting jazz articulations with the panel on page 352
Input methods for guitar bends and guitar techniques on page 353
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Inputting ornaments/trills with the popover
You can input ornaments, trills, and jazz ornaments using the ornaments popover, both during 
note input and by adding them to existing notes. When inputting trills, you can specify the trill 
interval, such as a minor third.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff at the rhythmic position where you want to input an 
ornament. If you want to input a trill with a specific duration, select items that span 
the required duration.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

4. Enter the appropriate entry for the ornament you want into the popover.

For example, enter tr m3 for a trill with a minor third interval or mor for a mordent.

5. Press Return  to close the popover.

6. Optional: When inputting trills during note input, input a note or press Space  to advance 
the caret and input the trill.

RESULT
During note input, ornaments are input at the caret position on all staves across which the caret 
extends. Trills span the duration of the rhythmic value of the note input at the caret position or 
the duration by which the caret advanced.

Ornaments added to existing music are input on each selected staff, at the rhythmic position of 
the earliest selected either note or item, according to your item input position setting. Trills span 
the duration of either only notes or any items on each selected staff, according to your item input 
position setting.

Trills have a default interval of a second, either major or minor depending on the context. If you 
specified an interval for your trill, the interval applies only to the first note in the selection, but 
you can also change the interval partway through trills.

TIP

You can choose to input a separate trill for each selected note in Preferences > Note Input and 
Editing > Editing.

RELATED LINKS
Ornaments on page 1090
Trills on page 1094
Trill intervals on page 1097
Changing trill intervals on page 1099
Changing trill intervals partway through trills on page 1100
Trill interval appearance on page 1102
Jazz ornaments on page 1146
Inputting notes on page 224
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Inputting jazz articulations with the popover on page 351
Extending the caret to multiple staves on page 222
Changing the item input position setting on page 213

Inputting ornaments/trills with the panel
You can input ornaments, trills, and jazz ornaments using the Ornaments panel, both during 
note input and by adding them to existing notes.

NOTE

These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff at the rhythmic position where you want to input an 
ornament. If you want to input a trill with a specific duration, select items that span 
the required duration.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Ornaments panel, click the ornament you want.

RESULT
During note input, ornaments are input at the caret position. Trills are input with a default 
duration of a quarter note.

Ornaments added to existing music are input on each selected staff, at the rhythmic position of 
the earliest selected either note or item, according to your item input position setting. Trills span 
the duration of either only notes or any items on each selected staff, according to your item input 
position setting.

TIP

● You can specify trill intervals when inputting trills using the popover.

● You can choose to input a separate trill for each selected note in Preferences > Note Input 
and Editing > Editing.

RELATED LINKS
Notations toolbox on page 201
Ornaments panel on page 345
Inputting jazz articulations with the panel on page 352
Changing your mouse input settings on page 211

Inputting arpeggio signs with the popover
You can input arpeggio signs using the ornaments popover, both during note input and by 
adding them to existing notes. You can also input arpeggio signs across notes in multiple voices 
and on different staves that belong to the same instrument, such as piano or harp.

PROCEDURE

1. In Write mode, do one of the following:
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● Start note input.

● Select at least one note in each voice to which you want to add an arpeggio sign.

NOTE

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff arpeggio signs. However, you cannot 
create cross-staff arpeggio signs between different instruments.

● Arpeggio signs are added to all notes in the selected voices at the selected rhythmic 
positions.

2. Optional: If you started note input, press Q  to start chord input.

NOTE

You can only input arpeggio signs during chord input.

3. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the appropriate entry for the arpeggio sign you want into the popover.

For example, enter arpup for an up arpeggio sign or arpdown for a down arpeggio sign.

6. Press Return  to close the popover.

7. Optional: During chord input, input the notes you want.

RESULT
During chord input, arpeggio signs are input at the caret position on all staves across which the 
caret extends.

When adding arpeggio signs to existing notes, they are input to the left of the selected notes.

Arpeggio signs automatically span the pitch range of all notes at that rhythmic position in 
the current voice during chord input, and all notes in the selected voices/staves when adding 
arpeggio signs to existing notes.

RELATED LINKS
Ornaments popover on page 341
Arpeggio signs on page 1108
Arpeggios in playback on page 1112
Inputting notes on page 224
Inputting chords on page 251
Extending the caret to multiple staves on page 222

Inputting arpeggio signs with the panel
You can input arpeggio signs on existing notes using the Ornaments panel. You can also input 
arpeggio signs across notes in multiple voices and on different staves that belong to the same 
instrument, such as piano or harp.

NOTE

● You cannot input arpeggio signs with the panel during note input.
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● These steps describe inputting with the default mouse input preference Create item at 
selection. You cannot create cross-staff and cross-voice arpeggio signs if your preference is 
set to Load pointer with item.

PROCEDURE

1. In Write mode, select at least one note in each voice to which you want to add an arpeggio 
sign.

NOTE

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff arpeggio signs. However, you cannot 
create cross-staff arpeggio signs between different instruments.

● Arpeggio signs are added to all notes in the selected voices at the selected rhythmic 
positions.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Arpeggiation section, click the arpeggio sign you want.

RESULT
The arpeggio sign specified is input to the left of the selected note or chord. Arpeggio signs 
automatically span the pitch range of all notes in the selected voices/staves at that rhythmic 
position.

RELATED LINKS
Notations toolbox on page 201
Ornaments panel on page 345
Arpeggio signs on page 1108
Arpeggios in playback on page 1112
Changing your mouse input settings on page 211

Inputting glissando lines with the popover
You can input glissando lines between existing notes using the ornaments popover. You can 
input glissando lines between both adjacent and non-adjacent notes.

NOTE

You cannot input glissando lines during note input or on the last note on a staff. Instead, you can 
input a jazz articulation.

PREREQUISITE
You have input at least two notes that you want to join with a glissando.

PROCEDURE

1. In Write mode, select the notes you want to join with glissando lines.

For example, select a grace note and a normal note, two notes in different voices, or two 
notes on different staves belonging to the same instrument.

2. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .
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3. Enter the appropriate entry for the glissando line you want into the popover.

● For a default style glissando line, enter gliss.

● For a straight glissando line, enter glissstraight.

● For a wavy glissando line, enter glisswavy.

4. Press Return  to close the popover.

RESULT
The glissando line specified is input between all selected notes.

NOTE

● If you select a single note and input a glissando line, the glissando line specified starts from 
the selected note and ends at the next note in the same voice on the staff, even if this 
crosses rests.

● Glissando lines do not automatically adjust around any notes or rests between the selected 
notes. If glissando text is shown, the text can collide with notes or rests, in which case we 
recommend that you make further adjustments, such as not showing glissando text for that 
glissando line.

● By default, glissando line text is hidden on staves belonging to fretted instruments. However, 
you can show glissando line text manually.

RELATED LINKS
Ornaments popover on page 341
Glissando lines on page 1115
Changing glissando line text on page 1117
Changing when glissando line text is shown on page 1118
Changing the style of glissando lines on page 1116
Inputting jazz articulations with the panel on page 352

Inputting glissando lines with the panel
You can input glissando lines between existing notes using the Ornaments panel. You can input 
glissando lines between both adjacent and non-adjacent notes.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection. If your preference is set to Load pointer with item, you can only input glissando 
lines between the note you click on and the note immediately following it.

● You cannot input glissando lines during note input or on the last note on a staff. Instead, you 
can input a jazz articulation.

PREREQUISITE
You have input at least two notes that you want to join with a glissando.

PROCEDURE

1. In Write mode, select the notes you want to join with glissando lines.

For example, select a grace note and a normal note, two notes in different voices, or two 
notes on different staves belonging to the same instrument.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.
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3. In the Glissandi section, click the style of glissando line you want.

● Glissando (Straight) 

● Glissando (Wavy) 

RESULT
The glissando line specified is input between all selected notes.

NOTE

● If you select a single note and input a glissando line, the glissando line specified starts from 
the selected note and ends at the next note in the same voice on the staff, even if this 
crosses rests.

● Glissando lines do not automatically adjust around any notes or rests between the selected 
notes. If glissando text is shown, the text can collide with notes or rests, in which case we 
recommend that you make further adjustments, such as not showing glissando text for that 
glissando line.

● By default, glissando line text is hidden on staves belonging to fretted instruments. However, 
you can show glissando line text manually.

RELATED LINKS
Notations toolbox on page 201
Ornaments panel on page 345
Glissando lines on page 1115
Changing glissando line text on page 1117
Changing when glissando line text is shown on page 1118
Inputting jazz articulations with the panel on page 352
Changing your mouse input settings on page 211

Inputting jazz articulations with the popover
You can input jazz articulations using the ornaments popover, both during note input and by 
adding them to existing notes.

NOTE

You can input jazz ornaments, such as flips or jazz turns, in the same ways as inputting 
ornaments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add jazz articulations.

2. Optional: If you want to input notes with jazz articulations onto multiple staves at once, 
extend the caret to those staves.

3. Optional: During note input, input at least one note.
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4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the appropriate entry for the jazz articulation you want into the popover.

For example, enter scoop for a scoop or fall for a fall.

6. Press Return  to close the popover.

RESULT
The jazz articulation you specify is input on all selected notes. During note input, this is usually 
the last note you input.

NOTE

When using the popover, all jazz articulations are input with a default line style for their type. You 
can change their type/length after they have been input.

When using the panel, you can specify the line style of jazz articulations when you input them.

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different jazz 
articulations in different voices simultaneously.

RELATED LINKS
Ornaments popover on page 341
Inputting ornaments/trills with the popover on page 346
Extending the caret to multiple staves on page 222
Jazz articulations on page 1145
Changing the type/length of existing jazz articulations on page 1147
Changing the line style of smooth jazz articulations on page 1148
Enabling independent voice playback on page 545
Playback techniques on page 787

Inputting jazz articulations with the panel
You can input jazz articulations using the Ornaments panel, both during note input and by 
adding them to existing notes.

NOTE

● You can input jazz ornaments, such as flips or jazz turns, in the same ways as inputting 
ornaments.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add jazz articulations.

2. Optional: If you want to input notes with jazz articulations onto multiple staves at once, 
extend the caret to those staves.

3. Optional: During note input, input at least one note.

4. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

5. In the Jazz section, click the jazz articulation you want.

RESULT
The jazz articulation you specify is input on all selected notes. During note input, this is usually 
the last note you input.

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different jazz 
articulations in different voices simultaneously.

RELATED LINKS
Notations toolbox on page 201
Ornaments panel on page 345
Inputting ornaments/trills with the panel on page 347
Extending the caret to multiple staves on page 222
Changing your mouse input settings on page 211
Enabling independent voice playback on page 545
Playback techniques on page 787

Input methods for guitar bends and guitar techniques
You can input guitar bends (including pre-bends and post-bends), vibrato bar techniques 
(including dips, dives, scoops, and dives and returns) and tapping, hammer-on, and pull-off 
indications with the keyboard by using the ornaments popover, and with the mouse by using the 
Ornaments panel.

You can also input guitar pre-bends, post-bends, and vibrato bar pre-dives using properties in 
the Properties panel.

You can input guitar techniques during note input and by adding them to existing notes, but you 
cannot input guitar bends during note input. You can only input guitar bends by adding them to 
existing notes.

RELATED LINKS
Ornaments popover on page 341
Ornaments panel on page 345
Guitar bends on page 1122
Guitar pre-bends and pre-dives on page 1124
Guitar post-bends on page 1125
Vibrato bar dives and returns on page 1127
Vibrato bar techniques on page 1137
Tapping on page 1138
Hammer-ons and pull-offs on page 1139
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Inputting guitar bends with the popover
You can input guitar bends between existing notes, including between grace notes and normal 
notes, using the ornaments popover. You can input guitar bends between both adjacent and 
non-adjacent notes.

NOTE

You cannot input guitar bends during note input or on the last note on a staff.

PREREQUISITE
You have input at least two notes that you want to join with a guitar bend.

PROCEDURE

1. In Write mode, select the two notes you want to join with a guitar bend.

For example, select a grace note and a normal note or two notes in different voices.

2. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

3. Enter bend into the popover.

4. Press Return  to close the popover.

RESULT
The guitar bend is input between the selected notes.

Guitar bends automatically appear as guitar bends or returns on tablature according to the pitch 
direction of the notes they join.

TIP

● If you select a single note and input a guitar bend, the guitar bend starts from the selected 
note and ends at the next note in the same voice on the staff, even if this crosses rests.

● You can assign a key command for Create Guitar Bend on the Key Commands page in 
Preferences.

RELATED LINKS
Ornaments popover on page 341
Guitar bends on page 1122
Inputting guitar pre-bends/pre-dives on page 355
Inputting guitar post-bends on page 356
Key Commands page in the Preferences dialog on page 60

Inputting guitar bends with the panel
You can input guitar bends between existing notes, including between grace notes and normal 
notes, using the Ornaments panel. You can input guitar bends between both adjacent and 
non-adjacent notes.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection. If your preference is set to Load pointer with item, you can only input guitar 
bends between the note you click on and the note immediately following it.
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● You cannot input guitar bends during note input or on the last note on a staff.

PREREQUISITE
You have input at least two notes that you want to join with a guitar bend.

PROCEDURE

1. In Write mode, select the two notes you want to join with a guitar bend.

For example, select a grace note and a normal note or two notes in different voices.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Guitar Bend .

RESULT
The guitar bend is input between the selected notes.

Guitar bends automatically appear as guitar bends or returns on tablature according to the pitch 
direction of the notes they join.

TIP

● If you select a single note and input a guitar bend, the guitar bend starts from the selected 
note and ends at the next note in the same voice on the staff, even if this crosses rests.

● You can assign a key command for Create Guitar Bend on the Key Commands page in 
Preferences.

RELATED LINKS
Notations toolbox on page 201
Ornaments panel on page 345
Guitar bends on page 1122
Changing your mouse input settings on page 211

Inputting guitar pre-bends/pre-dives
You can input guitar pre-bends on any existing notes belonging to fretted instruments. You can 
also specify that pre-bends should be played using the vibrato bar, a technique that is known as 
a “pre-dive”.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes before which you want to input guitar pre-bends/pre-dives. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate Pre-bend interval in the Guitar Pre-bends group.

3. Change the interval as required.

4. Optional: To turn the guitar pre-bends into guitar pre-dives, activate Vibrato bar pre-bend 
and the corresponding checkbox in the Guitar Pre-bends group.
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RESULT
Guitar pre-bends of the specified interval are input before the selected notes. They are shown as 
guitar pre-dives when Vibrato bar pre-bend and the corresponding checkbox are both activated.

RELATED LINKS
Guitar pre-bends and pre-dives on page 1124
Vibrato bar techniques on page 1137
Properties panel on page 663
Engrave toolbox on page 503

Inputting guitar post-bends
You can input guitar post-bends on any existing notes belonging to fretted instruments. You can 
also specify that post-bends are microtonal.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes after which you want to input guitar post-bends. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Post-bend interval in the Guitar Post-bends group.

3. Do one of the following:

● Change the interval as required.

● To turn the guitar post-bends into microtonal post-bends, activate Microtone bend in 
the Guitar Post-bends group.

RESULT
Guitar post-bends of the specified interval are input after the selected notes. They are shown as 
microtonal when Microtone bend is activated.

RELATED LINKS
Guitar post-bends on page 1125
Properties panel on page 663
Inputting guitar bends with the popover on page 354
Engrave toolbox on page 503

Inputting vibrato bar dives
You can input vibrato bar dives, both during note input and by adding them to existing notes.

Vibrato bar dives are notated using a smooth fall jazz articulation combined with a vibrato bar 
indication.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add vibrato bar dives.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter fallsmooth into the popover to input a smooth fall jazz articulation.

6. Press Return  to close the popover.

7. Optional: During note input, move the caret back to the position of the note with the smooth 
fall.

8. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

9. Enter wbar into the popover to input a vibrato bar indication.

10. Press Return  to close the popover.

11. Optional: During note input, input a note or press Space  to advance the caret and input the 
vibrato bar indication.

RESULT
The smooth fall jazz articulation is input on all selected notes. During note input, this is usually 
the last note you input.

During note input, vibrato bar indications are input at the caret position on all staves across 
which the caret extends.

Vibrato bar indications added to existing music are input at the rhythmic position of, or span the 
duration of, either only notes or any items on each selected staff, according to your item input 
position setting.

By default, vibrato bar indications/lines are placed below the staff and only appear on notation 
staves, not tablature.

NOTE

When using the popover, all jazz articulations are input with a default line style for their type. You 
can change their type/length after they have been input.

You can also input both smooth fall jazz articulations and vibrato bar indications using the 
Ornaments panel. When using the panel, you can specify the line style of jazz articulations when 
you input them.

AFTER COMPLETING THIS TASK
If you want vibrato bar indications to show a line, you can lengthen them to give them duration.
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RELATED LINKS
Vibrato bar techniques on page 1137
Notations toolbox on page 201
Ornaments popover on page 341
Ornaments panel on page 345
Extending the caret to multiple staves on page 222
Changing the item input position setting on page 213
Moving the caret manually on page 223
Jazz articulations on page 1145
Inputting jazz articulations with the popover on page 351
Inputting jazz articulations with the panel on page 352
Changing the type/length of existing jazz articulations on page 1147
Changing the line style of smooth jazz articulations on page 1148
Deleting jazz articulations on page 1149
Lengthening/Shortening items on page 430
Playing technique duration on page 1187

Inputting vibrato bar dives and returns with the popover
You can input vibrato bar dives and returns between both adjacent and non-adjacent existing 
notes using the ornaments popover.

NOTE

You cannot input vibrato bar dives and returns during note input or on the last note on a staff.

PREREQUISITE
You have input at least three notes with alternating pitch directions, such as D-C-D, that you want 
to join with a vibrato bar dive and return.

PROCEDURE

1. In Write mode, select the two notes you want to join with a vibrato bar dive.

NOTE

The notes must be on the same staff and have a descending pitch direction, such as D-C.

2. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

3. Enter vibbend into the popover to input the dive.

4. Press Return  to close the popover.

5. Select the two notes you want to join with a vibrato bar return.

NOTE

The notes must be on the same staff and have an ascending pitch direction, such as C-D.

6. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

7. Enter vibbend into the popover to input the return.
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8. Press Return  to close the popover.

RESULT
Vibrato bar dives are input between notes with descending pitch directions, and vibrato bar 
returns are input between notes with ascending pitch directions.

If a vibrato bar dive ends on the same note that a vibrato bar return starts on, they appear as a V 
on tablature with the bend interval shown at the point.

If you input vibrato bar dives on consecutive notes with the same pitch direction, such as E-D-C, 
they are notated on tablature with an additional line protrusion beyond the staff and bend 
interval for each vibrato bar dive.

Vibrato bar dives and returns automatically point upwards or downwards on tablature according 
to the pitch direction of the notes they join.

RELATED LINKS
Ornaments popover on page 341
Vibrato bar dives and returns on page 1127
Vibrato bar techniques on page 1137
Guitar bends on page 1122
Inputting guitar bends with the popover on page 354

Inputting vibrato bar dives and returns with the panel
You can input vibrato bar dives and returns between both adjacent and non-adjacent existing 
notes using the Ornaments panel.

NOTE

● These steps describe inputting with the default mouse input preference Create item at 
selection. If your preference is set to Load pointer with item, you can only input vibrato 
bar dives and returns between the note you click on and the note immediately following it.

● You cannot input vibrato bar dives and returns during note input or on the last note on a 
staff.

PREREQUISITE
You have input at least three notes with alternating pitch directions, such as D-C-D, that you want 
to join with a vibrato bar dive and return.

PROCEDURE

1. In Write mode, select the two notes you want to join with a vibrato bar dive.

NOTE

The notes must be on the same staff and have a descending pitch direction, such as D-C.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Guitar Bend with Vibrato Bar  to input the vibrato bar dive.

4. Select the two notes you want to join with a vibrato bar return.

NOTE

The notes must be on the same staff and have an ascending pitch direction, such as C-D.
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5. Click Guitar Bend with Vibrato Bar  to input the vibrato bar return.

RESULT
Vibrato bar dives are input between notes with descending pitch directions, and vibrato bar 
returns are input between notes with ascending pitch directions.

If a vibrato bar dive ends on the same note that a vibrato bar return starts on, they appear as a V 
on tablature with the bend interval shown at the point.

If you input vibrato bar dives on consecutive notes with the same pitch direction, such as E-D-C, 
they are notated on tablature with an additional line protrusion beyond the staff and bend 
interval for each vibrato bar dive.

Vibrato bar dives and returns automatically point upwards or downwards on tablature according 
to the pitch direction of the notes they join.

RELATED LINKS
Notations toolbox on page 201
Ornaments panel on page 345
Vibrato bar dives and returns on page 1127
Vibrato bar techniques on page 1137
Guitar bends on page 1122
Inputting vibrato bar dives on page 356
Changing your mouse input settings on page 211

Inputting vibrato bar scoops with the popover
You can input vibrato bar scoops using the ornaments popover, both during note input and by 
adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add vibrato bar scoops.

2. Optional: If you want to input notes with vibrato bar scoops onto multiple staves at once, 
extend the caret to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter vibscoop into the popover.

6. Press Return  to close the popover.

RESULT
Vibrato bar scoops are input on the selected notes. During note input, this is usually the last note 
you input.
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By default, vibrato bar scoops only appear on notation staves, not tablature. They are positioned 
to the left of notes.

AFTER COMPLETING THIS TASK
You can input vibrato bar indications to clarify the vibrato bar scoops should be played using the 
vibrato bar.

RELATED LINKS
Ornaments popover on page 341
Extending the caret to multiple staves on page 222
Vibrato bar techniques on page 1137
Inputting vibrato bar indications/lines with the popover on page 363
Deleting guitar techniques on page 1143

Inputting vibrato bar scoops with the panel
You can input vibrato bar scoops using the Ornaments panel, both during note input and by 
adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add vibrato bar scoops.

2. Optional: If you want to input notes with vibrato bar scoops onto multiple staves at once, 
extend the caret to those staves.

3. Optional: During note input, input at least one note.

4. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

5. In the Guitar section, click Vibrato Bar Scoop .

RESULT
Vibrato bar scoops are input on the selected notes. During note input, this is usually the last note 
you input.

By default, vibrato bar scoops only appear on notation staves, not tablature. They are positioned 
to the left of notes.

AFTER COMPLETING THIS TASK
You can input vibrato bar indications to clarify the vibrato bar scoops should be played using the 
vibrato bar.

RELATED LINKS
Notations toolbox on page 201
Ornaments panel on page 345
Extending the caret to multiple staves on page 222
Vibrato bar techniques on page 1137
Inputting vibrato bar indications/lines with the panel on page 364
Deleting guitar techniques on page 1143
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Inputting vibrato bar dips with the popover
You can input vibrato bar dips using the ornaments popover, both during note input and by 
adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff at the rhythmic position where you want to input a vibrato 
bar dip.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

4. Enter vibdip into the popover.

5. Press Return  to close the popover.

6. Optional: During note input, input a note or press Space  to advance the caret and input the 
vibrato bar dip.

RESULT
During note input, vibrato bar dips are input at the caret position on all staves across which the 
caret extends.

Vibrato bar dips added to existing music are input on each selected staff, at the rhythmic position 
of the earliest selected either note or item, according to your item input position setting.

By default, vibrato bar dips have half step intervals, are placed above the staff, and only appear 
on notation staves, not tablature.

RELATED LINKS
Ornaments popover on page 341
Changing the item input position setting on page 213
Extending the caret to multiple staves on page 222
Vibrato bar techniques on page 1137
Changing vibrato bar dip intervals on page 1142
Inputting vibrato bar indications/lines with the popover on page 363
Changing the staff-relative placement of items on page 434

Inputting vibrato bar dips with the panel
You can input vibrato bar dips using the Ornaments panel, both during note input and by adding 
them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff at the rhythmic position where you want to input a vibrato 
bar dip.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.
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3. In the Guitar section, click Vibrato Bar Dip .

RESULT
During note input, vibrato bar dips are input at the caret position.

Vibrato bar dips added to existing music are input on each selected staff, at the rhythmic position 
of the earliest selected either note or item, according to your item input position setting.

By default, vibrato bar dips have half step intervals, are placed above the staff, and only appear 
on notation staves, not tablature.

RELATED LINKS
Notations toolbox on page 201
Ornaments panel on page 345
Changing the item input position setting on page 213
Vibrato bar techniques on page 1137
Changing vibrato bar dip intervals on page 1142
Inputting vibrato bar indications/lines with the panel on page 364
Changing the staff-relative placement of items on page 434

Inputting vibrato bar indications/lines with the popover
You can input vibrato bar indications/lines using the ornaments popover, both during note input 
and by adding them to existing music. When vibrato bar indications are input across a range of 
items, they are input with duration and show a duration line, which is dashed by default.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff at the rhythmic position where you want to input a vibrato 
bar indication. If you want to input a vibrato bar line, select items that span the required 
duration.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

4. Enter wbar into the popover to input the vibrato bar indication.

5. Press Return  to close the popover.

6. Optional: During note input, input a note or press Space  to advance the caret and input the 
vibrato bar indication.

RESULT
During note input, vibrato bar indications are input at the caret position on all staves across 
which the caret extends.

Vibrato bar indications added to existing music are input at the rhythmic position of, or span the 
duration of, either only notes or any items on each selected staff, according to your item input 
position setting. Vibrato bar indications with duration show a duration line, which is dashed by 
default.
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By default, vibrato bar indications/lines are placed below the staff and only appear on notation 
staves, not tablature.

RELATED LINKS
Ornaments popover on page 341
Vibrato bar techniques on page 1137
Changing the item input position setting on page 213
Extending the caret to multiple staves on page 222
Lengthening/Shortening items on page 430
Playing technique duration on page 1187

Inputting vibrato bar indications/lines with the panel
You can input vibrato bar indications/lines using the Ornaments panel, both during note input 
and by adding them to existing music. When vibrato bar indications are input across a range of 
items, they are input with duration and show a duration line, which is dashed by default.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff at the rhythmic position where you want to input a vibrato 
bar indication. If you want to input a vibrato bar line, select items that span the required 
duration.

2. In the Notations toolbox, click Panels , then Ornaments  to show the Ornaments panel.

3. In the Guitar section, click Vibrato Bar Line .

RESULT
During note input, vibrato bar indications are input at the caret position.

Vibrato bar indications added to existing music are input at the rhythmic position of, or span the 
duration of, either only notes or any items on each selected staff, according to your item input 
position setting. Vibrato bar indications with duration show a duration line, which is dashed by 
default.

By default, vibrato bar indications/lines are placed below the staff and only appear on notation 
staves, not tablature.

RELATED LINKS
Ornaments panel on page 345
Vibrato bar techniques on page 1137
Changing the item input position setting on page 213
Lengthening/Shortening items on page 430
Playing technique duration on page 1187

Inputting hammer-ons/pull-offs
You can input hammer-ons/pull-offs on any notes belonging to fretted instruments using the 
ornaments popover, both during note input and by adding them to existing notes. If you select 
multiple notes, Dorico Elements automatically inputs the appropriate slurs. You can also add 
tapping with hammer-ons/pull-offs to existing notes.

PROCEDURE

1. In Write mode, do one of the following:
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● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add hammer-ons/pull-offs.

NOTE

● If you want to input hammer-ons, you must select at least two notes assigned to the 
same string with ascending pitch directions, such as C-D.

● If you want to input pull-offs or tapping with pull-offs, you must select at least two 
notes assigned to the same string with descending pitch directions, such as D-C.

● If you want to input ligados, you must select at least three notes assigned to the 
same string with alternating pitch directions, such as C-D-C for a hammer-on then 
pull-off or D-C-D for a pull-off then hammer-on.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the appropriate entry for the hammer-on/pull-off you want into the popover.

For example, enter ho for a hammer-on or hopo for a hammer-on then pull-off.

6. Press Return  to close the popover.

RESULT
The hammer-on/pull-off you specify is input on the selected notes. During note input, this is 
usually the last note you input.

If you selected multiple adjacent notes assigned to the same string, Dorico Elements 
automatically inputs slurs spanning the selected notes and centers hammer-on/pull-off 
indications on the slurs. For slurs with multiple hammer-on/pull-off indications, each indication is 
centered over the range of notes in the corresponding direction.

By default, hammer-ons/pull-offs appear on both notation staves and tablature and are placed 
above the staff.

TIP

You can also add hammer-ons/pull-offs to existing notes by selecting them, activating Technique 
in the Guitar Techniques group of the Properties panel, and selecting the appropriate indication 
from the menu. To show hammer-on/pull-off indications centered on slurs, select all notes except 
the first note under each slur.

RELATED LINKS
Ornaments popover on page 341
Hammer-ons and pull-offs on page 1139
Extending the caret to multiple staves on page 222
Changing the staff-relative placement of guitar techniques on page 1142
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Assigning notes to strings on page 1059
Changing the allocated string for notes on tablature on page 1332
Deleting guitar techniques on page 1143

Inputting tapping
You can input right-hand and left-hand tapping indications on any notes belonging to fretted 
instruments using the ornaments popover, both during note input and by adding them to 
existing notes. You can also add tapping with hammer-ons/pull-offs to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add tapping indications.

NOTE

If you want to input tapping with pull-offs, you must select at least two notes assigned to 
the same string with descending pitch directions, such as D-C.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Optional: During note input, input at least one note.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the appropriate entry for the tapping indication you want into the popover.

For example, enter tap for right-hand tapping or lhtappull for left-hand tapping with pull-
off.

6. Press Return  to close the popover.

RESULT
The tapping indication you specify is input on the selected notes. During note input, this is 
usually the last note you input.

By default, tapping indications appear on both notation staves and tablature and are placed 
above the staff.

TIP

You can also add tapping indications to existing notes by selecting them, activating Technique 
in the Guitar Techniques group of the Properties panel, and selecting the appropriate indication 
from the menu.

RELATED LINKS
Ornaments popover on page 341
Tapping on page 1138
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Extending the caret to multiple staves on page 222
Changing the staff-relative placement of guitar techniques on page 1142
Assigning notes to strings on page 1059
Changing the allocated string for notes on tablature on page 1332
Deleting guitar techniques on page 1143

Input methods for playing techniques, pedal lines, string indicators, 
and harp pedal diagrams

You can input playing techniques with the keyboard by using the playing techniques popover, 
and with the mouse by using the Playing Techniques panel.

You can input string indicators outside the staff in the same ways, using either the playing 
techniques popover or Playing Techniques panel.

You can input string indicators inside the staff using a property in the String Indicators group of 
the Properties panel.

RELATED LINKS
Playing techniques on page 1180
Pedal lines on page 1161
Harp pedaling on page 1153
String indicators on page 993
Inputting playing techniques with the popover on page 372
Inputting playing techniques with the panel on page 374
Inputting pedal lines with the popover on page 375
Inputting pedal lines with the panel on page 377
Inputting harp pedal diagrams with the popover on page 379
Inputting harp pedal diagrams with the panel on page 380
Inputting string indicators outside the staff with the popover on page 381
Inputting string indicators outside the staff with the panel on page 383
Inputting string indicators inside the staff on page 383

Playing techniques popover
The following tables contain the entries for the playing techniques popover that you can use to 
input playing techniques, harp pedal diagrams, pedal lines, and retakes.

When you start entering a playing technique into the playing techniques popover, a menu 
appears that shows valid playing techniques containing the letters/words you enter. You can 
then select one of these playing techniques to input.

You can open the playing techniques popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

● Select an existing playing technique and press Return .

● Choose Write > Create Playing Technique.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.
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Playing techniques popover with 
an example entry for inputting a 
playing technique

Playing techniques popover with 
an example entry for inputting a 
pedal line

Playing Techniques button in the 
Notations toolbox

Playing techniques

Playing technique Popover entry

Naturale (nat.) nat

Vibrato vibrato

Senza vibrato senza vibrato

Harmonic (o) o

Con sord. con sord

Strong air pressure strong air pressure

Double-tongue double-tongue

Down bow downbow

Up bow upbow

Sul ponticello sul pont

Sul tasto sul tasto

Poco sul tasto pst

Pizzicato pizz

Spiccato spicc

Arco arco

Tongue click (Stockhausen) tongue click

Finger click (Stockhausen) finger click

Vibraphone motor on motor on

Vibraphone motor off motor off
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Playing technique Popover entry

Open open

Damp damp

Damp (large) damp large

Full barré full barre

Half barré half barre

Strum up strum up

Strum down strum down

Left hand lh

Right hand rh

This list is not comprehensive as there are many valid playing techniques. It is intended 
to illustrate how you can structure your entry to input different types of common playing 
techniques.

If you do not know the correct entry for a playing technique, start entering part of the playing 
technique and see if it becomes available in the popover menu.

NOTE

● To give playing techniques duration, add -> at the end of your entry, such as vibrato->. 
During note input, the duration of the playing technique extends as you continue inputting 
notes or advance the caret. When adding playing techniques to existing music, they are 
added as a group.

● To input hidden playing techniques, enclose your popover entry in parentheses, such as 
(pizz).

● As playing techniques correspond to specific samples, they must be input as described or 
selected from the popover menu.

Pedal lines

Type of pedal line or retake Popover entry

Sustain pedal line ped

Retake in sustain pedal line ^, notch, or retake

Remove retake in sustain pedal line nonotch

Stop sustain pedal line *
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Type of pedal line or retake Popover entry

Sostenuto pedal line sost

Stop sostenuto pedal line s*

Una corda pedal line unacorda

Stop una corda pedal line u*

Harp pedaling

Example harp pedaling Popover entry

D, C, B♭, E♭, F, G, A DCBbEbFGA, BbEb, or --^|^---

D, C♯, B, E, F♯, G♯, A DC#BEF#G#A, C#F#G#, or -v-|-vv-

TIP

The pipe character is optional.

String indicators outside the staff

Example string indicator Popover entry

1 string1

3 string3

RELATED LINKS
Notations toolbox on page 201
Playing techniques on page 1180
Groups of playing techniques on page 1191
Pedal lines on page 1161
Sustain pedal retakes and pedal level changes on page 1162
Harp pedaling on page 1153
String indicators on page 993
Adding retakes with the popover on page 377
Inputting harp pedal diagrams with the popover on page 379
Inputting string indicators outside the staff with the popover on page 381
Hiding/Showing playing techniques on page 1183
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Playing Techniques panel
The Playing Techniques panel contains the different playing techniques available in Dorico 
Elements, divided into instrument families. It is located in the right zone in Write mode. Pedal 
lines are included in the Keyboard section.

● You can hide/show the Playing Techniques panel by clicking Panels , then Playing 
Techniques  in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Playing Techniques panel contains the following sections:

Common
Contains commonly used playing techniques that also apply to multiple different 
instrument families, such as “mute” and “legato”.

Wind
Contains playing techniques typically only used for wind instruments, such as “key 
clicks” and “whistle tones”.

Brass
Contains playing techniques typically only used for brass instruments, such as “cup 
mute” and “stopped”.

Unpitched Percussion
Contains playing techniques typically only used for unpitched percussion instruments, 
such as “rim” and “scrape”.

Pitched Percussion
Contains playing techniques typically only used for pitched percussion instruments, 
such as “motor on” and “½ Ped.” for vibraphones.

Keyboard
Contains playing techniques typically only used for keyboard instruments, such as 
“Ped.” and different pedal depression levels.

Choral
Contains playing techniques typically only used for the voice, such as “mouth open” 
and “tongue click”.

Strings
Contains playing techniques typically only used for string instruments, such as “col 
legno battuto” and “down bow”.

Guitar
Contains playing techniques typically only used for guitars and fretted instruments, 
such as string indicators, “half barré”, and “strum up”.

Harp Pedals
Allows you to create harp pedal diagrams.

You can change the pitch settings for pedals by clicking the column section that 
corresponds to the required pitch alteration, as displayed by accidentals on the left.

You can then input the harp pedal diagram by clicking Create.
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TIP

You can hover your mouse pointer over the options in each section to show the name of each 
playing technique.

RELATED LINKS
Notations toolbox on page 201
Inputting string indicators outside the staff with the panel on page 383
Inputting harp pedal diagrams with the panel on page 380
Playing techniques on page 1180
Pedal lines on page 1161
String indicators on page 993
Harp pedaling on page 1153

Inputting playing techniques with the popover
You can input playing techniques using the playing techniques popover, both during note input 
and by adding them to existing music.

NOTE

● You can only enter one playing technique into the popover during note input. You can 
enter two playing techniques when adding playing techniques to existing music if they are 
separated by ->.

● You can input playing techniques in the middle of tie chains by starting note input, then 
moving the caret to the required rhythmic position.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff at the rhythmic position where you want to input a playing 
technique. If you want to input playing techniques with duration or a separate playing 
technique for each note, select items that span the required duration.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

4. Enter the appropriate entry for the playing technique you want into the popover.
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For example, enter pizz or non vibrato->.

When you start entering a playing technique into the playing techniques popover, a menu 
appears that shows valid playing techniques containing the letters/words you enter, which 
you can select.

● To give the playing technique duration, add -> at the end.

● To input a hidden playing technique, enclose its entry in parentheses, such as (pizz).

5. Press Return  to close the popover.

Open-ended playing techniques, such as non vibrato->, automatically extend during note 
input as you continue inputting notes, or if you advance the caret by pressing Space  or 
clicking Advance Caret  in the Keyboard, Fretboard, or Drum Pads panel toolbar.

6. Optional: During note input, stop open-ended playing techniques by opening the playing 
techniques popover again and entering one of the following entries:

● To end the current playing technique with another playing technique, enter that playing 
technique. For example, enter vibrato. This joins the current playing technique to the 
following one with a continuation line.

● To end the current playing technique with another open-ended playing technique, enter 
that playing technique followed by ->. For example, enter vibrato->. This joins the 
current playing technique to the following one with a continuation line.

● To end the current playing technique without inputting another playing technique, 
enter ? into the popover. This leaves the current playing technique with a duration line 
rather than a continuation line.

RESULT
The specified playing techniques are input. They are considered voice-specific by default, 
meaning they only apply to the voice indicated by the caret indicator during step input or the 
selected voice when adding playing techniques to existing notes. They are automatically placed 
above the staff for up-stem voices and below the staff for down-stem voices.

Adjoining playing techniques, or playing techniques that were input together or in sequence, are 
automatically grouped together, both during note input and when adding playing techniques to 
existing notes.

During note input, playing techniques are input at the caret position on all staves across which 
the caret extends. If you included an open-ended playing technique with duration, it extends 
automatically when you advance the caret or input notes.

Playing techniques added to existing music are input according to their playback technique and 
your selection:

● If you selected a single item on each staff, a playing technique without duration is input on 
each staff at the corresponding rhythmic position.

● If you selected a range of items on each staff and input a playing technique with an 
Attribute playback technique, a playing technique is input at the rhythmic position of either 
only notes or any items in the selection, according to your item input position setting.

● If you selected a range of items on each staff and input a playing technique with a Direction 
playback technique, a playing technique with duration is input that spans either only notes 
or any items in the selection, according to your item input position setting. For playing 
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techniques whose continuation type is set to show lines, the appropriate continuation line is 
shown.

AFTER COMPLETING THIS TASK

● You can move playing techniques within playing technique groups, lengthen/shorten playing 
techniques, and hide/show playing technique duration lines.

● You can enable independent voice playback for individual instruments to hear different 
playing techniques in different voices simultaneously.

RELATED LINKS
Groups of playing techniques on page 1191
Playing technique continuation lines on page 1186
Hiding/Showing playing techniques on page 1183
Playback techniques on page 787
Edit Playback Techniques dialog on page 788
Lengthening/Shortening items on page 430
Moving notes/items rhythmically on page 461
Caret on page 218
Moving the caret manually on page 223
Extending the caret to multiple staves on page 222
Changing the item input position setting on page 213
Enabling independent voice playback on page 545

Inputting playing techniques with the panel
You can input playing techniques using the Playing Techniques panel, both during note input and 
by adding them to existing music.

NOTE

● You cannot input playing techniques with duration in sequence, which automatically groups 
them, when using the panel. If you want to input playing techniques with duration in 
sequence, you can use the popover.

● You can input playing techniques in the middle of tie chains by starting note input, then 
moving the caret to the required rhythmic position.

● These steps describe inputting with the default mouse input preference Create item at 
selection. If you want to input the same playing technique in multiple places, change your 
mouse input preference to Load pointer with item so that you do not have to reselect the 
playing technique for each note.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff at the rhythmic position where you want to input a playing 
technique. If you want to input playing techniques with duration or a separate playing 
technique for each note, select items that span the required duration.

2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, click the playing technique you want.
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RESULT
The specified playing technique is input. It is considered voice-specific by default, meaning it only 
applies to the voice indicated by the caret indicator during step input or the selected voice when 
adding playing techniques to existing notes. It is automatically placed above the staff for up-stem 
voices and below the staff for down-stem voices.

During note input, playing techniques are input at the caret position, even if your preference is 
set to Load pointer with item.

Playing techniques added to existing music are input according to their playback technique and 
your selection:

● If you selected a single item on each staff, a playing technique without duration is input on 
each staff at the corresponding rhythmic position.

● If you selected a range of items on each staff and input a playing technique with an 
Attribute playback technique, a playing technique is input at the rhythmic position of either 
only notes or any items in the selection, according to your item input position setting.

● If you selected a range of items on each staff and input a playing technique with a Direction 
playback technique, a playing technique with duration is input that spans either only notes 
or any items in the selection, according to your item input position setting. For playing 
techniques whose continuation type is set to show lines, the appropriate continuation line is 
shown.

AFTER COMPLETING THIS TASK

● If you want to show transition lines between playing techniques, you can group them 
together.

● You can enable independent voice playback for individual instruments to hear different 
playing techniques in different voices simultaneously.

RELATED LINKS
Notations toolbox on page 201
Changing your mouse input settings on page 211
Playback techniques on page 787
Edit Playback Techniques dialog on page 788
Changing the item input position setting on page 213
Caret on page 218
Moving the caret manually on page 223
Lengthening/Shortening items on page 430
Grouping playing techniques together on page 1192
Enabling independent voice playback on page 545

Inputting pedal lines with the popover
You can input pedal lines using the playing techniques popover, both during note input and 
by adding them to existing music. Because pedal lines extend automatically as you input notes 
during note input, you can also input retakes when you reach the appropriate rhythmic position.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● On each staff where you want to input a pedal line, select items that span the required 
duration.

2. Open the playing techniques popover in any of the following ways:
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● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

3. Enter the appropriate entry for the pedal line you want into the popover.

For example, enter ped for a sustain pedal line.

When you start entering a pedal line into the playing techniques popover, a menu appears 
that shows valid pedal lines containing the letters/words you enter, which you can select.

4. Press Return  to close the popover.

The pedal line is input.

5. Optional: During note input, advance the caret and extend the pedal line in any of the 
following ways:

● Press Space .

● In the Keyboard, Fretboard, or Drum Pads panel toolbar, click Advance Caret .

The pedal line also extends automatically as you continue inputting notes.

6. Optional: During note input, input retakes by opening the playing techniques popover again 
at the appropriate rhythmic position and entering ^ or retake into the popover.

7. Optional: During note input, stop the pedal line by opening the playing techniques popover 
again and enter the appropriate entry into the popover.

For example, enter * to stop a sustain pedal line.

8. Press Return  to close the popover.

RESULT
During note input, pedal lines start at the caret position, and end at the caret position.

Pedal lines added to existing music span the duration of either only notes or any items on each 
selected staff, according to your item input position setting.

NOTE

Retakes only appear for sustain pedal lines with the Line continuation type.

AFTER COMPLETING THIS TASK
You can change the continuation type used for individual pedal lines; for example, to show a sign 
at the end.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 1162
Positions of pedal lines on page 1167
Changing the pedal line continuation type on page 1173
Changing the item input position setting on page 213
Inputting notes on page 224
Notations toolbox on page 201
Keyboard panel on page 206
Fretboard panel on page 208
Drum Pads panel on page 209
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Adding retakes with the popover

You can add retakes to sustain pedal lines using the playing techniques popover, both during 
note input and by adding them to existing music.

NOTE

You cannot add retakes to sostenuto or una corda pedal lines. Retakes only appear for sustain 
pedal lines with the Line continuation type.

PREREQUISITE
You have input a sustain pedal line.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff and at each rhythmic position where you want to input 
retakes.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

4. Enter ^ or retake into the popover.

5. Press Return  to close the popover.

RESULT
During note input, retakes are input at the caret position on all staves across which the caret 
extends.

Outside of note input, retakes are input at each selected rhythmic position on each selected staff.

TIP

You can also input retakes by selecting notes within the ranges of sustain pedal lines and 
choosing Edit > Notations > Pedal Lines > Add Retake. You can also choose this option from 
the context menu.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 1162
Playing techniques popover on page 367
Changing the pedal line continuation type on page 1173
Moving the caret manually on page 223
Removing retakes and pedal level changes on page 1167

Inputting pedal lines with the panel
You can input pedal lines using the Playing Techniques panel.

NOTE

● When using the panel, you cannot input pedal lines during note input.
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● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, on each staff where you want to input a pedal line, select items that span the 
required duration.

2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, expand the Keyboard section.

4. Click the pedal line you want.

RESULT
Pedal lines added to existing music span the duration of either only notes or any items on each 
selected staff, according to your item input position setting.

TIP

Alternatively, when nothing is selected, you can click the pedal line you want in the Keyboard 
section of the Playing Techniques panel, then click and drag in the music area to input a pedal 
line and extend it to the duration you want.

AFTER COMPLETING THIS TASK

● You can change the continuation type used for individual pedal lines; for example, to show a 
sign at the end.

● You can add retakes within the ranges of sustain pedal lines.

NOTE

Retakes only appear for sustain pedal lines with the Line continuation type.

RELATED LINKS
Playing Techniques panel on page 371
Sustain pedal retakes and pedal level changes on page 1162
Changing the item input position setting on page 213
Changing the pedal line continuation type on page 1173
Changing your mouse input settings on page 211

Adding retakes with the panel

You can add retakes to existing sustain pedal lines using the Playing Techniques panel.

NOTE

You cannot add retakes to sostenuto or una corda pedal lines. Retakes only appear for sustain 
pedal lines with the Line continuation type.

PREREQUISITE
You have input a sustain pedal line.
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PROCEDURE

1. In Write mode, select an item on each staff and at each rhythmic position where you want to 
input retakes.

2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, expand the Keyboard section.

4. Click Retake Pedal .

RESULT
The retake is input at each selected rhythmic position on each selected staff.

TIP

● Alternatively, when nothing is selected in the music area, you can click Retake Pedal in the 
Keyboard section of the Playing Techniques panel, and then click at each rhythmic position 
where you want to input the retake.

● You can also input retakes by selecting notes within the ranges of sustain pedal lines and 
choosing Edit > Notations > Pedal Lines > Add Retake. You can also choose this option 
from the context menu.

RELATED LINKS
Sustain pedal retakes and pedal level changes on page 1162
Playing Techniques panel on page 371
Changing the pedal line continuation type on page 1173
Removing retakes and pedal level changes on page 1167

Inputting harp pedal diagrams with the popover
You can input harp pedal diagrams using the playing techniques popover, both during note input 
and by adding them to existing music.

If you do not input any harp pedaling, Dorico Elements assumes all harp pedals are in their 
natural setting, as they would be for C major. Any pitches that do not fit with the current harp 
pedaling, excluding the two lowest harp strings, appear red when colors for notes out of range 
are shown.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input on a harp staff.

● Select an item on a harp staff at the rhythmic position where you want to input a harp 
pedal diagram.

2. Open the playing techniques popover in any of the following ways:

● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

3. Enter the appropriate entry for the harp pedals you want.

For example, enter:

● C#F#G# or -v-|-vv- for C♯, F♯, and G♯ pedals, such as in A major.

● BbEb or --^|^--- for B♭ and E♭ pedals, such as in B♭ major.
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4. Press Return  to close the popover.

RESULT
The corresponding harp pedal diagram is input at the selected rhythmic position. Depending on 
your per-layout settings, it is either displayed as a diagram, using note names, or not shown and 
instead indicated by a signpost.

During note input, harp pedal diagrams are input at the caret position.

RELATED LINKS
Playing techniques popover on page 367
Harp pedaling on page 1153
Hiding/Showing harp pedaling in layouts on page 1155
Changing the appearance of harp pedal diagrams on page 1154
Hiding/Showing colors for notes out of range on page 1064
Signposts on page 450

Inputting harp pedal diagrams with the panel
You can input harp pedal diagrams using the Playing Techniques panel.

NOTE

● You cannot input harp pedal diagrams with the panel during note input.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, select an item on a harp staff at the rhythmic position where you want to 
input a harp pedal diagram.

2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, expand the Keyboard section.

4. For each pedal, click the column section that corresponds to the required pitch alteration, as 
displayed by accidentals on the left.

5. Click Create.

RESULT
The corresponding harp pedal diagram is input at the selected rhythmic position. Depending on 
your per-layout settings, it is either displayed as a diagram, using note names, or not shown and 
instead indicated by a signpost.
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RELATED LINKS
Playing Techniques panel on page 371
Harp pedaling on page 1153
Hiding/Showing harp pedaling in layouts on page 1155
Changing the appearance of harp pedal diagrams on page 1154
Hiding/Showing colors for notes out of range on page 1064
Signposts on page 450

Calculating harp pedal diagrams based on existing music
You can automatically calculate suitable harp pedal diagrams based on the notes you have 
already input, either from a single point onwards or within a selected region.

If you do not input any harp pedaling, Dorico Elements assumes all harp pedals are in their 
natural setting, as they would be for C major. Any pitches that do not fit with the current harp 
pedaling, excluding the two lowest harp strings, appear red when colors for notes out of range 
are shown.

PROCEDURE

1. In Write mode, select the region you want to use to calculate harp pedaling in one of the 
following ways:

● Select an existing single note from which you want to calculate harp pedaling.

● Select a range of notes for which you want to calculate harp pedaling.

NOTE

Dorico Elements ignores the lowest two harp strings, C and D, when calculating harp pedals.

2. Choose Write > Calculate Harp Pedals.

RESULT
A harp pedal diagram is input at the start of your selection. Depending on your per-layout 
settings, it is either displayed as a diagram, using note names, or not shown and instead 
indicated by a signpost.

RELATED LINKS
Generating chord symbols from notes on page 326

Inputting string indicators outside the staff with the popover
You can input string indicators outside the staff using the playing techniques popover, both 
during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff at the rhythmic position where you want to input a string 
indicator outside the staff. If you want to input a string indicator with a duration line, 
select items that span the required duration.

2. Optional: During note input, if you want to input notes and notations onto multiple staves, 
extend the caret to those staves.

3. Open the playing techniques popover in any of the following ways:
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● Press Shift-P .

● In the Notations toolbox, click Popovers , then Playing Techniques .

4. Enter the appropriate entry for the string indicator you want into the popover.

For example, enter string1 for just a string 1 indicator or string3-> for a string 3 indicator 
with duration.

5. Press Return  to close the popover.

Open-ended string indicators, such as string3->, automatically extend during note input as 
you continue inputting notes, or if you advance the caret by pressing Space  or clicking 
Advance Caret  in the Keyboard, Fretboard, or Drum Pads panel toolbar.

6. Optional: During note input, stop open-ended string indicators by opening the playing 
techniques popover again and entering ?  into the popover.

This leaves the current string indicator with a duration line. You can also enter another string 
indicator into the popover, but this joins the current string indicator to the following one 
with a continuation line rather than a duration line, which is a less common notation.

RESULT
The specified string indicators are input. They are considered voice-specific by default, meaning 
they only apply to the voice indicated by the caret indicator during step input or the selected 
voice when adding string indicators to existing notes. They are automatically placed above the 
staff for up-stem voices and below the staff for down-stem voices.

During note input, string indicators are input at the caret position on all staves across which 
the caret extends. If you included an open-ended string indicator with duration, it extends 
automatically when you advance the caret or input notes.

String indicators added to existing music are input at the rhythmic position of, or span the 
duration of, either only notes or any items on each selected staff, according to your item input 
position setting. String indicators with duration show a duration line, which is dashed with a 
hook cap end by default.

AFTER COMPLETING THIS TASK

● If you input string indicators without duration but want to show dashed duration lines, you 
can add them.

● You can change the staff-relative placement of string indicators.

RELATED LINKS
Playing techniques popover on page 367
String indicators on page 993
Lengthening/Shortening items on page 430
Changing the item input position setting on page 213
Extending the caret to multiple staves on page 222
Changing the staff-relative placement of items on page 434
Notations toolbox on page 201
Keyboard panel on page 206
Fretboard panel on page 208
Drum Pads panel on page 209
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Inputting string indicators outside the staff with the panel
You can input string indicators outside the staff using the Playing Techniques panel, both during 
note input and by adding them to existing music.

NOTE

● You cannot input string indicators with duration during note input when using the panel. 
You can only do so when using the popover.

● These steps describe inputting with the default mouse input preference Create item at 
selection. If you want to input the same string indicator in multiple places, change your 
mouse input preference to Load pointer with item so that you do not have to reselect the 
string indicator for each note.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on each staff at the rhythmic position where you want to input a string 
indicator outside the staff. If you want to input a string indicator with a duration line, 
select items that span the required duration.

2. In the Notations toolbox, click Panels , then Playing Techniques  to show the Playing 
Techniques panel.

3. In the Playing Techniques panel, expand the Guitar section.

4. Click the string indicator you want.

RESULT
The specified string indicator is input. It is considered voice-specific by default, meaning it only 
applies to the voice indicated by the caret indicator during step input or the selected voice when 
adding string indicators to existing notes. It is automatically placed above the staff for up-stem 
voices and below the staff for down-stem voices.

During note input, string indicators are input at the caret position, even if your preference is set 
to Load pointer with item.

String indicators added to existing music are input at the rhythmic position of, or span the 
duration of, either only notes or any items on each selected staff, according to your item input 
position setting. String indicators with duration show a duration line, which is dashed with a 
hook cap end by default.

AFTER COMPLETING THIS TASK

● If you input string indicators without duration but want to show dashed duration lines, you 
can add them.

● You can change the staff-relative placement of string indicators.

RELATED LINKS
Playing Techniques panel on page 371
Changing your mouse input settings on page 211

Inputting string indicators inside the staff
You can show a string indicator inside the staff for each fretted instrument note. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains. Dorico Elements 
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automatically detects a string that each pitch could be played on, but you can also specify the 
string manually.

NOTE

These steps only apply to notes belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes belonging to fretted instruments beside which you want to show string 
indicators. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Show in the String Indicators group.

RESULT
String indicators are shown in the staff beside each selected note. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

Unless you have specified a string for each note, the string number shown in the string 
indicators is calculated automatically. String indicators inside the staff for open strings appear 
as a bold number zero without a circle enclosure.

By default, string indicators appear on the left of noteheads without left-hand fingerings and on 
the right of noteheads with left-hand fingerings.

AFTER COMPLETING THIS TASK

● You can specify the string on which notes are played, which affects the number shown in 
their corresponding string indicators.

● You can change the notehead-relative position of string indicators.

RELATED LINKS
String indicators on page 993
Fingerings for fretted instruments on page 981
Fretted instrument tuning on page 153
Assigning notes to strings on page 1059
Changing the notehead-relative position of string indicators on page 995
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
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Input methods for lines
You can input both horizontal and vertical lines by using the Lines panel. There is no popover for 
lines.

TIP

If you want lines to represent specific notations that affect playback if applicable, you can instead 
input these notations directly. For example, dynamics, arpeggios, glissandi, and trills all have 
dedicated features in Dorico Elements.

RELATED LINKS
Lines on page 1194
Input methods for dynamics on page 309
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367
Input methods for clefs and octave lines on page 329
Input methods for tempo marks on page 293
Input methods for repeats and tremolos on page 405

Lines panel
The Lines panel contains the different types of lines available in Dorico Elements. It is located in 
the right zone in Write mode.

● You can hide/show the Lines panel by clicking Panels , then Lines  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Lines panel contains the following sections:

Horizontal
Contains the different horizontal lines available. The options at the top of the section 
allow you to determine the attachment type for the start and end of horizontal lines 
you subsequently input.

Horizontal lines can be attached to noteheads, barlines, or rhythmic positions, and the 
start and end can have different attachment types.

Vertical
Contains the different vertical lines available.

RELATED LINKS
Notations toolbox on page 201
Lines on page 1194
Line components on page 1196
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Inputting horizontal lines
You can input horizontal lines between existing notes or spanning a specified duration using the 
Lines panel. Horizontal lines can be attached to noteheads, barlines, or rhythmic positions, and 
can have different attachment types at their start and end.

You can also input barline-/rhythmic position-attached lines that apply to all staves.

NOTE

● You cannot change the attachment type of horizontal lines after they have been input.

● If you want to input notehead-attached horizontal lines to represent glissandi, you can 
instead input glissando lines directly.

● These steps describe inputting with the default mouse input preference Create item at 
selection.

PROCEDURE

1. In Write mode, select one of the following:

● If you want to input a notehead-attached line, select the notes you want to join with a 
line.

● If you want to input a barline-/rhythmic position-attached line, select items that span the 
required duration of the line.

● If you want to input a horizontal line that is attached to noteheads at one end but 
barlines/rhythmic positions at the other end, select the required note and any item at 
the required rhythmic position of the other end.

TIP

You can input horizontal lines on multiple selected staves simultaneously. However, 
notehead-attached lines can only join notes belonging to the same player, although they 
can be in different voices and on different staves.

2. In the Notations toolbox, click Panels , then Lines  to show the Lines panel.

3. In the Horizontal section, choose one of the following options for both Start and End:

● Attach to notehead 

● Attach to barline (where available) 

● Attach to rhythmic position 

4. Input a line with the specified attachments in one of the following ways:

● To input a notehead-attached line or barline-/rhythmic position-attached line on the 
selected staves only, click it in the Horizontal section.

● To input a barline-/rhythmic position-attached line that applies to all staves, Alt/Opt -
click it in the Horizontal section.

RESULT
A horizontal line with the specified attachments is input. They are positioned according to their 
attachment types and their rhythmic positions.

Barline-/Rhythmic position-attached lines span the duration of either only notes or any items on 
each selected staff, according to your item input position setting.

Horizontal lines that apply to all staves are categorized as system objects. Therefore, they follow 
your per-layout settings for the visibility and positioning of system objects.
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AFTER COMPLETING THIS TASK

● You can change the placement and staff position of barline-/rhythmic position-attached 
lines.

● You can add text to lines.

RELATED LINKS
Notations toolbox on page 201
Lines on page 1194
Positions of lines on page 1197
Length of lines on page 1203
System objects on page 1326
Changing the positions of system objects on page 1327
Adding text to lines on page 1208
Changing the placement of horizontal lines on page 1201
Inputting glissando lines with the popover on page 349
Changing the item input position setting on page 213

Inputting vertical lines
You can input vertical lines on existing notes using the Lines panel, including across notes in 
multiple voices and on different staves that belong to the same instrument, such as piano or 
harp.

NOTE

● If you want to input vertical lines to represent arpeggios, you can instead input arpeggio 
signs directly.

● These steps describe inputting with the default mouse input preference Create item at 
selection. You cannot create cross-staff and cross-voice vertical lines if your preference is set 
to Load pointer with item.

PROCEDURE

1. In Write mode, select at least one note in each voice to which you want to add a vertical line.

NOTE

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff vertical lines. However, you cannot create 
cross-staff vertical lines between different instruments, even if they are held by the same 
player.

● Vertical lines are added to all notes in the selected voices at the selected rhythmic 
positions.

2. In the Notations toolbox, click Panels , then Lines  to show the Lines panel.

3. In the Vertical section, click the line you want.

RESULT
The vertical line specified is input to the left of the selected notes. Its length is adjusted 
automatically so that it spans the range of all notes in the selected voices/staves at that rhythmic 
position.
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AFTER COMPLETING THIS TASK

● You can change the order of lines when multiple exist at the same rhythmic position and 
show vertical lines on the right of notes.

● You can lengthen/shorten vertical lines.

● You can add text to lines.

RELATED LINKS
Notations toolbox on page 201
Lines on page 1194
Length of lines on page 1203
Lengthening/Shortening vertical lines on page 1204
Adding text to lines on page 1208
Showing vertical lines on the right/left of notes on page 1198
Changing the horizontal order of vertical lines on page 1199
Inputting arpeggio signs with the popover on page 347
Changing your mouse input settings on page 211

Inputting text items
You can input text at specific rhythmic positions in the score using text items. You can input 
staff-attached text for single staves or input system-attached text that applies to all staves and 
appears in all applicable layouts.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item on the staff and at the rhythmic position where you want to input text.

2. Open the text editor in any of the following ways:

● To input staff-attached text, press Shift-X  or click Popovers , then Text  in the 
Notations toolbox.

● To input staff-attached text with a specific paragraph style, choose Write > Create 
Text > [Paragraph style].

● To input system-attached text, press Shift-Alt/Opt-X .

● To input system-attached text with a specific paragraph style, choose Write > Create 
System Text > [Paragraph style].

3. Enter the text you want.

● To insert a line break, press Return .

● To insert a music symbol, right-click in the text item and choose Insert Music Text from 
the context menu to open the Insert Music Text dialog. Select the music symbol you 
want to insert, then click OK.

● To insert a Unicode character, enter its four-character hexadecimal code, then press 
Alt/Opt-X .

4. Optional: Format the text using the text editor options.

5. Press Esc  or Ctrl/Cmd-Return  to close the text editor.
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RESULT
During note input, the text you entered into the text editor is input at the caret position. When 
adding text to existing music, it is input at the position of the earliest selected item.

If you did not change or specify the paragraph style, the text item uses the Default Text 
paragraph style.

Text items are automatically placed above the staves to which they apply and follow the default 
settings for the vertical position of text.

NOTE

● In Dorico Elements, system-attached text is categorized as a system object. Therefore, 
system-attached text follows your per-layout settings for the visibility and positioning of 
system objects.

● If you override the paragraph style of text in an individual text item or text frame, such 
as by making text bold, any changes you later make to corresponding parameters of the 
paragraph style are not applied to the overridden text. However, font size overrides are 
combined with the font size in the paragraph style.

● You can assign key commands for inputting text with specific paragraph styles, for both 
Create Text and Create System Text, on the Key Commands page in Preferences.

RELATED LINKS
Text items on page 1351
Types of text on page 1352
Notations toolbox on page 201
System objects on page 1326
Changing the staff-relative placement of items on page 434
Enabling/Disabling text collision avoidance on page 1357
Paragraph Styles dialog on page 756
Key Commands page in the Preferences dialog on page 60

Text editor options in Write mode
The text editor allows you to add and format text. In Write mode, it opens when you add or edit 
text items.

The text editor provides the following options:

1 Character Style

Allows you to change the appearance of selected text within paragraphs. This overrides the 
paragraph style applied to the corresponding paragraph.

2 Paragraph Style

Allows you to change the paragraph style applied to the whole text item. Depending on the 
paragraph style, this can change the appearance, formatting, and alignment of the text.

3 Font

Allows you to change the font family of selected text.

4 Font Style
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Allows you to change the font style of selected text.

NOTE

● Depending on the font selected, some font styles might not be available.

● You can also change the font style using the following standard key commands:

● Ctrl/Cmd-B  for bold

● Ctrl/Cmd-I  for italic

5 Font Size

Allows you to change the size of selected text.

TIP

You can also change the font size using the following key commands:

● Ctrl/Cmd-Shift-.  to increase the font size

● Ctrl/Cmd-Shift-,  to decrease the font size

6 Font Stretch

Allows you to make selected text wider or narrower.

7 Baseline Shift

Allows you to shift the baseline of selected text gradually up or down.

8 Letter Spacing

Allows you to increase/decrease the space between the characters of selected text.

9 Word Spacing

Allows you to increase/decrease the space between the words of selected text.

10 Leading

Allows you to increase/decrease the line spacing of the whole text item.

11 Line Types

Allows you to show any of the following types of lines, in any combination, on selected text:

● Underline

● Overline

● Strikethrough

TIP

You can also make selected text underlined by pressing Ctrl/Cmd-U .

12 Script Types

Allows you to position selected text in one of the following positions relative to the text on 
the baseline:

● Superscript

● Subscript

13 Alignment

Allows you to choose one of the following alignments for the text item relative to its rhythmic 
position:

● Align Left

● Align Center
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● Align Right

14 Foreground Color

Allows you to change the color of selected text.

15 Background Color

Allows you to change the background color of selected text.

NOTE

If you override the paragraph style of text in an individual text item or text frame, such as by 
making text bold, any changes you later make to corresponding parameters of the paragraph 
style are not applied to the overridden text. However, font size overrides are combined with the 
font size in the paragraph style.

RELATED LINKS
Types of text on page 1352
Text items on page 1351
Changing the default font family on page 760
Text formatting on page 753
Paragraph Styles dialog on page 756
Character Styles dialog on page 759
Missing Fonts dialog on page 73

Insert Music Text dialog
The Insert Music Text dialog allows you to add music symbols, such as accidentals and note 
symbols, to text items.

● You can open the Insert Music Text dialog when inputting or editing text in a text item by 
right-clicking and choosing Insert Music Text from the context menu.

The Insert Music Text dialog comprises the following:

1 Search field

Allows you to search for music symbols by their SMuFL name. When you start entering text, a 
menu appears that shows valid music symbols containing the letters/words you enter, which 
you can select.

2 Range menu
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Allows you to select which SMuFL glyph range is available in the music symbol selector. By 
default, Recently used is selected, which contains common accidentals and note symbols in 
addition to music symbols you have used in recent projects.

3 Music symbol selector

Contains the available music symbols in the selected range or that match your entry.

4 Name

Displays the SMuFL name and description, where available, of the selected music symbol.

5 OK

Inserts the selected music symbol at the cursor position with the Music Text character style 
applied to them automatically.

You can also insert music symbols by selecting them and pressing Return , or double-
clicking them.

Editing text in text items
You can edit the text shown in text items; for example, to replace individual words or to change 
their formatting.

PROCEDURE

1. Open the text editor for an existing text item in any of the following ways:

● Select the text item and press Return .

● Double-click the text item.

2. Edit the text in the text item.

For example, you can format the text using the text editor options.

3. Press Esc  or Ctrl/Cmd-Return  to close the text editor.

Inputting lyrics
You can input lyrics by entering text into the lyrics popover, and you can advance the lyrics 
popover to the next note on the staff without closing and reopening it for every note.

PROCEDURE

1. In Write mode, select the note on the staff from which you want to start inputting lyrics.

2. Open the lyrics popover in any of the following ways:

● Press Shift-L .

● In the Notations toolbox, click Popovers , then Lyrics .

3. Optional: Change the type of lyric in one of the following ways:

● To change the lyric line number, press Down Arrow .

● To input lyrics above the staff, press Shift - Up Arrow .

● To input chorus lines, press Up Arrow .

● To input lyric line translations, press Alt/Opt - Down Arrow .

4. Enter the word or syllable you want to add to the selected note into the popover.

● To include multiple words in a single lyric, press Shift-Alt/Opt-Space  for a non-breaking 
space.

● To include a hyphen within a single word or syllable, press Alt/Opt--  (hyphen).
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● To include an elision in a lyric, press _  (underscore).

5. Advance the popover to the next note in one of the following ways:

● If you entered a complete word, or the final syllable in a multi-syllabic word, press 
Space .

● If you entered one syllable of a multi-syllabic word that is not the final syllable, press - 
(hyphen).

● If you do not want the syllable to be followed by an extension line or hyphen, press 
Right Arrow .

TIP

For lyrics sung over multiple notes, you can press these key commands multiple times until 
the lyrics popover reaches the note where you want to input the next lyric.

6. Continue entering words and syllables into the popover for the rest of the notes to which 
you want to add lyrics.

7. Press Return  or Esc  to close the popover.

The popover closes automatically when you reach the last note on the staff.

RESULT
The text you entered into the popover is input as lyrics of the type indicated by the icon on the 
left-hand side of the popover.

When you advance the popover to the next note by pressing - , a hyphen appears after the last 
entered lyric. This is used for multi-syllabic words across multiple notes.

When you advance the popover by pressing Space , either a gap or a lyric extender line appears 
after the last entered lyric, depending on the available horizontal space and whether the note 
appears as a tie chain. This is used for single-syllable words or for the final syllable in multi-
syllabic words.

TIP

● You can later change whether a gap or a hyphen appears between lyrics by changing their 
syllable type.

● You can also input lyrics by copying and pasting them; for example, from an external text 
editor.

RELATED LINKS
Notations toolbox on page 201
Copying and pasting lyrics on page 1032
Lyrics on page 1029
Navigation during lyric input on page 395
Types of lyrics on page 1029
Types of syllables in lyrics on page 1031
Positions of lyrics on page 1035
Lyric line numbers on page 1047
Lyric hyphens and lyric extender lines on page 1045
Elision slurs on page 1050
Lyric text editing on page 1043
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Lyrics popover
You can input lyrics, including chorus lines and lyric line translations, using the lyrics popover. 
You can use key commands to change the type of lyric being input at any time.

You can open the lyrics popover in Write mode in any of the following ways when either an item 
is selected or the caret is active:

● Press Shift-L .

● In the Notations toolbox, click Popovers , then Lyrics .

● Select an existing lyric and press Return .

● Choose Write > Create Lyrics.

Lyric lines
The popover automatically opens ready to input lyrics into Line 1, except if you are 
changing an existing lyric.

The number shown on the left-hand side of the lyrics popover indicates the lyric line 
into which the lyric is input.

The lyrics popover with an example entry for Line 1

You can change the lyric line number by pressing Up Arrow  and Down Arrow  when 
the lyrics popover is open.

The lyrics popover with an example entry for Line 2

Lyric lines above the staff
You can input lyrics into lines above the staff by pressing Shift - Up Arrow  when the 
lyrics popover is open.

You can then press Up Arrow  and Down Arrow  to change the lyric line number 
above the staff.

Chorus lines
You can input chorus lines by pressing Up Arrow  when the lyrics popover is open. You 
can do this when inputting lyrics below the staff and above the staff.

A c, for “chorus lines”, is shown on the left-hand side of the popover.

The lyrics popover with an example entry for a chorus line

Lyric line translations
You can input lyric line translations by pressing Alt/Opt - Down Arrow  when the lyrics 
popover is open.

An asterisk (*) is shown beside the lyric line number for which you are inputting a lyric 
line translation on the left-hand side of the popover.

The lyrics popover with an example entry for a lyric line translation

Write mode
Notations input 

394
Dorico Elements 5.1.30



Navigation during lyric input
You can move the lyrics popover to input new lyrics and edit existing lyrics without having to 
close and reopen the lyrics popover.

Popover navigation Key command

Finish the current word and advance the 
popover to the next note or chord.

Space

Finish the current syllable and advance the 
popover to the next note or chord.

-  (hyphen)

Advance the popover to the next note without 
showing an extension line or hyphen.

Right Arrow

Move the cursor to the next/previous letter. If 
the next/previous letter is in another lyric, the 
popover advances to that lyric.

Right Arrow / Left Arrow

Move the popover forwards/backwards from 
syllable to syllable within lines of lyrics.

Alt/Opt-Right Arrow / Alt/Opt-Left Arrow

Add non-breaking spaces without advancing 
the popover.

Shift-Alt/Opt-Space

Add a hyphen within a single word or syllable 
without advancing the popover.

Alt/Opt--  (hyphen)

Add an elision slur within a word or syllable. _  (underscore)

Inputting figured bass
You can input figured bass using the figured bass popover, both for all instruments or only for 
individual instruments. You can also open the figured bass popover during note input; however, 
inputting a figure stops note input.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
start inputting figured bass.

2. Open the figured bass popover in any of the following ways:

● Press Shift-G .

● In the Notations toolbox, click Popovers , then Figured Bass .

NOTE

If you selected an item on a staff that has local figures at earlier rhythmic positions, the 
figured bass popover is automatically set to input local figures when it opens.

3. Optional: Change the type of figure you want to enter in one of the following ways:

● To input local figures, press Alt/Opt-L .
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● To input global figures, press Alt/Opt-G .

The popover icon updates to show the current type.

Figured bass popover when inputting a global 
figure

Figured bass popover when inputting a local 
figure

4. Enter the figure you want into the figured bass popover.

For example, enter 4->3d=4r=2 for a 4-3 suspension that lasts a whole note, with the 
resolution to the third after a half note. For bracketed figures, include parentheses around 
the required figures or accidentals, such as (#)64(3).

If you want Dorico Elements to follow your entry exactly, include O, o, or ! at the start of your 
entry. For example, to force Dorico Elements to show 5,3 figures.

5. Optional: Press Space  to advance the popover to the next beat according to the prevailing 
time signature.

TIP

You can also navigate the popover forwards and backwards by different amounts.

6. Optional: To input an individual local figure when the popover is set to global, and vice versa, 
press Alt/Opt-Return  to input the figure.

7. Press Return  to close the popover.

RESULT
The figured bass specified is input. If you selected an item belonging to an instrument that was 
not already set to show figured bass in the current layout, its player is automatically updated to 
show them. If Dorico Elements cannot identify the bass note at the position of a figure, such as if 
you input a figure on a rest, it appears as a signpost.

Dorico Elements calculates and saves the pitches implied by the figures you enter in relation to 
the lowest note at that rhythmic position. This semantic understanding of the harmony implied 
by figures allows Dorico Elements to update the displayed figures on different staves and if you 
transpose or change the pitch of notes.

Global figures apply to all instruments in the project and appear on all staves whose players are 
set to show figured bass. Local figures only apply to the selected instrument, and by default refer 
to its lowest staff. Local figures always appear, even if global figures exist at the same rhythmic 
positions.

NOTE

● Unless you included an entry for Follow input literally at the start of your popover entry, 
the appearance of the resulting figure is determined by the default settings in Dorico 
Elements

● The appearance of tasto solo indications depends on the formatting of the Figured Bass 
Tasto Solo paragraph style.

● You can move figures graphically in Engrave mode, including changing the graphical length 
of hold lines.
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EXAMPLE
Entering 4->3d=4r=2 into the figured bass popover produces a 4-3 suspension that lasts a whole 
note, with the resolution to the third after a half note.

AFTER COMPLETING THIS TASK

● You can hide/show figured bass above specific players in each layout independently.

● You can simplify compound figures; that is, figures 9 and above.

● You can show figures on individual rests.

RELATED LINKS
Figured bass on page 957
Figured bass hold lines on page 961
Navigation during figured bass input on page 400
Hiding/Showing figured bass in layouts on page 958
Hiding/Showing figured bass hold/suspension lines on page 961
Lengthening/Shortening figured bass hold lines on page 962
Moving figured bass resolutions on page 966
Paragraph Styles dialog on page 756
Showing single brackets on figured bass on page 960
Showing brackets on figured bass hold lines on page 963
Simplifying figured bass compound intervals on page 969
Showing figured bass on rests on page 959
Fixing the current appearance of figured bass on page 969

Figured bass popover
The following tables contain examples of what you can enter into the figured bass popover to 
input the different possible figured bass figures, including alterations and suspensions.

You can open the figured bass popover in Write mode in any of the following ways when either a 
note is selected or the caret is active:

● Press Shift-G .

● In the Notations toolbox, click Popovers , then Figured Bass .

● Choose Write > Create Figured Bass.

When inputting global figured bass, the icon on the left-hand side of the popover matches the 
corresponding button in the Notations toolbox. When inputting local figured bass, the icon on 
the left-hand side of the popover appears smaller and includes the icon for a single player.

Figured bass popover with an 
example entry for a global figure

Figured bass popover with an 
example entry for a local figure

Figured Bass button in the 
Notations toolbox
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Figures and suspensions

Type of figure Example popover entry

Figures (1-19) 1, 2, 3, and so on, up to 19

Bracketed figures or accidentals (#643), #64(3), (#)643, and so on

Figures determined by chord symbols

Dorico Elements automatically converts chord 
symbols, as you would enter into the chord 
symbols popover, into correct figured bass.

Em7, Amaj7, or G/B, and so on

tasto solo ts or tasto

Hold duration d=2 (number of quarter notes) or d=1/2n 
(fraction of bass note duration)

Multiple figures

TIP

You can separate figures with commas to 
remove ambiguity.

6#42 or 6,#4,2

Hide figures <3> or {3}

Suspensions 4->3, 4_3, or 4~3

Suspension duration; that is, the duration 
between suspension and resolution figures

r=2 (number of quarter notes) or r=1/2n 
(fraction of bass note duration)

Hold and suspension durations both specified

For example, a 4-3 suspension that lasts a 
whole note, with the resolution to the third 
after a half note.

4->3d=4r=2 or 4->3d=1nr=1/2n

Follow Engraving Options for this figure only

NOTE

Must be at the start of the popover entry.

R, r, V, v, or ?

Follow input literally for this figure only

NOTE

Must be at the start of the popover entry.

O, o, or !
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This list is not comprehensive. It is intended to illustrate how you can structure your entry to 
input different figures.

NOTE

● Unless you include an entry for Follow input literally at the start of your popover entry, the 
appearance of resulting figures is determined by Dorico Elements’s default settings.

● The appearance of tasto solo indications depends on the formatting of the Figured Bass 
Tasto Solo paragraph style.

EXAMPLE
Entering 4->3d=4r=2 into the figured bass popover produces a 4-3 suspension that lasts a whole 
note, with the resolution to the third after a half note.

Accidentals and alterations

Type of accidental/alteration Popover entry

Sharp

TIP

For raised thirds, you can enter just without 
the number.

# or s

Flat b or f

Natural N or n

Double sharp x, ##, or ds

Triple sharp x#, #x, ###, or ts

Double flat bb or db

Triple flat bbb or tb

Raise figure by a half-step (semitone) +

Lower figure by a half-step (semitone) -

Diminished figure d

Unaltered figure u
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RELATED LINKS
Notations toolbox on page 201
Figured bass on page 957
Figured bass hold lines on page 961
Hiding/Showing figured bass hold/suspension lines on page 961
Lengthening/Shortening figured bass hold lines on page 962
Showing brackets on figured bass hold lines on page 963
Showing single brackets on figured bass on page 960
Chord symbols popover on page 320
Paragraph Styles dialog on page 756

Navigation during figured bass input
You can move the figured bass popover manually by different amounts to input figured bass 
figures at other positions without closing and reopening the popover each time.

Popover navigation Key command

Advance the popover to the next beat, 
according to the prevailing time signature.

Space

Move the popover back to the previous beat, 
according to the prevailing time signature.

Shift-Space

Advance the popover to the start of the next 
bar.

Tab

Move the popover back to the start of the 
previous bar.

Shift-Tab

Move the cursor and popover to one of the 
following positions, whichever is closest:

● Next/Previous note or rest

● Next/Previous rhythmic grid position

● Next/Previous character in existing figure’s 
entry

Right Arrow / Left Arrow

Move the popover to the next/previous figure. Ctrl/Cmd-Right Arrow / Ctrl/Cmd-Left Arrow

RELATED LINKS
Key Commands page in the Preferences dialog on page 60

Inputting rehearsal marks
You can input rehearsal marks with the mouse and the keyboard. You can input rehearsal marks 
during note input and later by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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● Select an item at the rhythmic position where you want to input a rehearsal mark. For 
example, a barline or a note.

NOTE

You can only input one rehearsal mark at a time, even if multiple items are selected.

2. Input a rehearsal mark in any of the following ways:

● Press Shift-A .

● In the Notations toolbox, click Popovers , then Rehearsal Marks .

RESULT
A rehearsal mark is input at the selected barline, or at the rhythmic position of other selected 
items.

The order of rehearsal marks is updated automatically, meaning you can input them in any 
order, including before and between existing rehearsal marks.

AFTER COMPLETING THIS TASK
If you want to change the letter/number displayed in the rehearsal mark, you can change its 
index and/or sequence type.

RELATED LINKS
Notations toolbox on page 201
Rehearsal marks on page 1216
Changing the index of rehearsal marks on page 1217
Changing the rehearsal mark sequence type on page 1218
Adding prefixes/suffixes to rehearsal marks on page 1219
Going to rehearsal marks on page 442
Changing your mouse input settings on page 211

Inputting markers/timecodes
You can input markers at specific positions in time. In Dorico Elements, timecodes are 
automatically shown alongside markers.

PROCEDURE

1. In Write mode, move the playhead to the time position where you want to input a marker.

2. Press Shift-Alt/Opt-M  to open the Add Marker dialog.

3. Enter the marker text you want into the Text field.

4. Optional: Change the timecode in the Timecode field.

5. Click OK to input the marker and close the dialog.

RESULT
A marker is input at the timecode position set in the Add Marker dialog, which by default is the 
position of the playhead. It shows the text you entered, or the default text “Marker” if you did not 
change the marker text, and a timecode reflecting its position.
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TIP

You can also input markers by clicking Add Marker  in the Markers section of the Video panel, 
or by using the Markers track in Play mode.

RELATED LINKS
Markers on page 1221
Timecodes on page 1226
Moving the playhead on page 538
Editing marker text on page 1223
Changing the timecodes of markers on page 1224
Video panel on page 402
Markers track on page 534

Add Marker dialog
The Add Marker dialog allows you to input markers with custom text at specific timecodes.

● The Add Marker dialog opens automatically when you input markers in Write mode, either 
by pressing Shift-Alt/Opt-M  or by clicking Add Marker  in the Markers section of the 
Video panel.

The Add Marker dialog contains the following options:

Text
Allows you to enter custom text that is shown in the marker.

Timecode
Allows you to specify the timecode at which you want to input the marker. For example, 
if you already know the timecodes for each marker, you can enter them directly rather 
than positioning the playhead at the position of each marker.

Valid range
Displays the timecode range of the flow.

Video panel
The Video panel in Write mode allows you to access the Video Properties dialog, and to input 
and edit markers and timecodes. You can also define markers as important and calculate suitable 
tempos for them. It is located in the right zone in Write mode.

● You can hide/show the Video panel by clicking Panels , then Video  in the Notations 
toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .
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In the Video section of the Video panel, you can click Properties to open the Video Properties 
dialog.

The Markers section of the Video panel contains a table of markers, divided into the following 
columns:

Timecode
Shows the timecode of the marker. You can edit the timecode by double-clicking in the 
field.

Text
Shows the text of the marker. You can edit the text by double-clicking in the field.

Imp.
Stands for “important”. Allows you to define markers as important by activating their 
checkbox in this column.

When markers are defined as important, their entry uses a bold font in the table and 
they are considered when finding a suitable tempo in the Find Tempo dialog.

The action bar at the bottom of the table contains the following options:

● Add Marker : Adds a marker at the playhead position.

● Delete Marker : Deletes the selected marker.

NOTE

You can only delete one marker at a time.

RELATED LINKS
Notations toolbox on page 201
Video Properties dialog on page 190

Find Tempo dialog
The Find Tempo dialog allows you to calculate tempos that best accommodate your important 
markers; for example, by identifying which tempos cause markers to coincide as closely as 
possible with strong beats.

● You can open the Find Tempo dialog in Write mode by clicking Find Tempo in the Markers 
section of the Video panel.

NOTE

● The Find Tempo dialog only considers markers in a single flow. You can change which flow 
by selecting an item in the corresponding flow and then opening the dialog.

● The Find Tempo dialog is only available if you have input at least one marker in the flow and 
defined at least one marker as important.
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The Find Tempo dialog contains the following options and sections:

Flow
Shows the name of the flow whose tempo you are determining. This field is read-only.

Beat unit
Allows you to change the beat unit considered for the tempo. For example, if the time 
signature for the flow is 6/8, you might want to change the beat unit to a dotted 
quarter note.

Tempo increments
Allows you to filter the suggested tempos according to their precision.

● Integral only: Only whole number tempos, that is, tempos without decimal places, 
are suggested.

● Allow increment by 0.25: Allows tempos with decimal places of .25, .5, and .75 to 
be suggested.

Tempo range
Allows you to set the minimum/maximum tempos you want to consider.

Tempos found
Contains a list of possible tempos that you can select to see how they affect the 
position of your markers relative to beats. The list is updated automatically when you 
change options such as Tempo range and Beat unit.

The list contains columns for the following information:

● BPM: Stands for “beats per minute”. Lists different possible tempos according to 
their metronome mark value.

● IFO: Stands for “important frames off”. Indicates the average number of frames by 
which important markers miss significant beats, either before or after.

● NFO: Stands for “non-important frames off”. Indicates the average number of 
frames by which non-important markers miss significant beats, either before or 
after.

● AFO: Stands for “all frames off”. Indicates the average number of frames by which 
all markers in the flow miss significant beats, either before or after.
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Found tempos are listed in descending order of average frames off for important 
markers.

Markers
Shows the impact that the tempo currently selected in the Tempos found list would 
have on each marker in the flow in more detail.

● Timecode: Shows the exact timecode of each marker.

● Text: Shows the marker text of each marker to help you identify them.

● Imp.: Indicates whether a marker has been defined as important.

● Fr. Off: Stands for “frames off”. Shows the average number of frames by which 
each marker misses being aligned to beats.

● Time Diff.: Stands for “time difference”. Shows the time difference between the 
position of the marker and the position of the nearest beat, expressed in fractions 
of a second.

● Not. Diff.: Stands for “notated difference”. Shows the notated difference between 
the position of the marker and the position of the nearest beat, expressed in 
fractions of a whole note.

Selected tempo
Displays the currently selected tempo for the flow.

Apply
Applies the selected tempo to the flow by inputting it as a tempo mark at the 
beginning of the flow. Any other tempo marks in the flow are automatically deleted.

RELATED LINKS
Defining markers as important on page 1225
Metronome marks on page 1341

Input methods for repeats and tremolos
You can input repeats and tremolos, including repeat endings, repeat markers, and rhythm 
slashes, with the keyboard by using the repeats popover, and with the mouse by using the 
Repeat Structures panel.

Tremolos are included in the Repeat Structures panel because they indicate that notes are 
repeated, either individually as single-note tremolos or in sequences as multi-note tremolos.

TIP

To indicate repeats using repeat barlines, you can input repeat barlines using the available input 
methods for barlines.

RELATED LINKS
Input methods for bars, beats, and barlines on page 300
Barlines on page 815
Types of barlines on page 816
Repeat endings on page 1230
Repeat markers on page 1236
Tremolos on page 1399
Rhythm slashes on page 1258
Bar repeats on page 1245
Numbered bar regions on page 1253
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Repeats in playback on page 549

Repeats popover
The following tables contain the entries for the repeats popover that you can use to input the 
different tremolos, repeat markers, repeat endings, and bar repeat, slash, and numbered bar 
regions available.

You can open the repeats popover in Write mode in any of the following ways when either an 
item is selected or the caret is active:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

● Select an existing repeat marker, slash region, or bar repeat and press Return .

● Choose Write > Create Repeat.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Repeats popover with an example entry
Repeat Structures button in the Notations toolbox

Repeat endings

Part of repeat ending Popover entry

Whole repeat ending end or ending

Additional repeat ending segment add

Repeat markers

Type of repeat marker Popover entry

D.C. dc, D.C., da capo, and so on

D.C. al Fine dcalf, DC al Fine, D.C. al Fine, and so on

D.C. al Coda dcalc, DC al Coda, D.C. al Coda, and so on

D.S. ds, D.S., dal segno, and so on

D.S. al Fine dsalf, DS al Fine, D.S. al Fine, and so on

D.S. al Coda dsalc, DS al Coda, D.S. al Coda, and so on

to Coda toc, tc, to coda, To Coda, and so on
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Type of repeat marker Popover entry

Segno s, seg, segno, and so on

Fine f, fin, fine, and so on

Coda c, co, coda, and so on

The list of entries for repeat markers is not comprehensive, as the flexibility of the popover 
means you can enter any reasonable version or abbreviation of the type of repeat marker you 
want, and the popover recognizes it in most cases.

Single-note tremolos

Type of tremolo Popover entry

One stroke /, \, or 1

Two strokes //, \\, or 2

Three strokes ///, \\\, or 3

Four strokes ////, \\\\, or 4

Z on stem (buzz roll) z or zonstem

Tremolo with release; for example, two-strokes 
with release

rel; for example, //rel or 2rel

Tremolo with attack; for example, two-strokes 
with attack

att; for example, //att or 2att

Remove all tremolos 0 or clear

Multi-note tremolos

Type of tremolo Popover entry

One stroke /2, \2, or 12

Two strokes //2, \\2, or 22

Three strokes ///2, \\\2, or 32

Four strokes ////2, \\\\2, or 42

Remove all tremolos 0 or clear
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Slash regions

Slash region Popover entry

New slash region slash

Numbered bar regions

Numbered bar region Popover entry

New numbered bar region nb, num, numbars, or number bars

Bar repeats

Type of bar repeat Popover entry

Repeat last bar % or %1

Repeat last 2 bars %2

Repeat last 4 bars %4

Repeat last bar, group in 2 %1,2

Repeat last bar, group in 4 %1,4

Repeat last 2 bars, group in 4 %2,4

RELATED LINKS
Notations toolbox on page 201
Inputting repeat endings with the popover on page 409
Inputting repeat markers with the popover on page 413
Inputting tremolos with the popover on page 414
Inputting slash regions on page 417
Inputting bar repeats on page 418
Inputting numbered bar regions on page 419
Bars and barlines popover on page 301
Repeat endings on page 1230
Repeat markers on page 1236
Tremolos on page 1399
Rhythm slashes on page 1258
Bar repeats on page 1245
Numbered bar regions on page 1253
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Repeat Structures panel
The Repeat Structures panel contains the different types of repeat notations available in Dorico 
Elements, including repeat endings, tremolos, and bar repeats. It is located in the right zone in 
Write mode.

Tremolos are included in the Repeat Structures panel because they indicate that notes are 
repeated, either individually as single-note tremolos or in sequences as multi-note tremolos.

● You can hide/show the Repeat Structures panel by clicking Panels , then Repeat 
Structures  in the Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

The Repeat Structures panel contains the following sections:

Repeat Endings
Contains options that allow you to input new repeat endings and add additional 
endings to existing repeat endings.

Repeat Jumps
Contains different types of repeat markers that instruct players to jump to a specific 
point in the piece, such as “D.S. al Coda”.

Repeat Sections
Contains different sections used in conjunction with repeat jumps, such as “Coda”.

Tremolos
Contains different types of single-note and multi-note tremolos.

Rhythm Slashes
Allows you to input a region that displays rhythm slashes that are automatically 
formatted to be compatible with the prevailing time signature.

Bar Repeats
Allows you to input a region that indicates that the preceding bar is repeated without 
re-notating the bar.

TIP

You can input bar repeat regions with different bar groupings when using the repeats 
popover.

Numbered Bars
Allows you to input a region that displays bar counts without additional notations.

RELATED LINKS
Notations toolbox on page 201
Repeats popover on page 406

Inputting repeat endings with the popover
You can input repeat endings using the repeats popover, both during note input and by adding 
them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.
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TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select at least one item in each bar that you want to include in the first ending.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter end or ending into the popover.

4. Press Return  to close the popover.

RESULT
The repeat ending is input, with the first ending segment covering the bars in which you selected 
items, and a second ending segment created automatically in the following bar.

An end repeat barline is created at the end of the first ending if none exists already.

RELATED LINKS
Repeats popover on page 406
Repeat endings on page 1230

Adding additional repeat endings with the popover

You can have more than two possible endings in each repeat ending structure by adding 
additional segments using the repeats popover. You can add repeat ending segments both 
during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the bars that you want to include in the additional ending.

NOTE

Your selection must start from the first bar in the final repeat ending segment.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter add into the popover.

4. Press Return  to close the popover.

5. Optional: Repeat these steps as many times as required for the number of additional 
endings you want.
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RESULT
A new repeat ending segment is added. The existing previous repeat ending segment now ends 
with a closed line, with an end repeat barline created if necessary.

TIP

You can also add additional repeat ending segments by selecting the repeat ending and 
changing the value for No. endings in the Repeat Endings group of the Properties panel.

However, No. endings only adds additional repeat ending segments that contain one bar, and 
does not automatically input or reposition repeat barlines. You must input repeat barlines as 
appropriate manually.

EXAMPLE

Default repeat ending structure with two 
endings

Repeat ending structure with additional third ending

Inputting repeat endings with the panel
You can input repeat endings using the Repeat Structures panel, both during note input and by 
adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select at least one item in each bar that you want to include in the first ending.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. In the Repeat Endings section, click Create Repeat Ending .

RESULT
The repeat ending is input, with the first ending segment covering the bars in which you selected 
items, and a second ending segment created automatically in the following bar.

An end repeat barline is created at the end of the first ending if none exists already.

RELATED LINKS
Repeat Structures panel on page 409
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Adding additional repeat endings with the panel

You can have more than two possible endings in each repeat ending structure by adding 
additional segments using the Repeat Structures panel. You can add repeat ending segments 
both during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the bars that you want to include in the additional ending.

NOTE

Your selection must start from the first bar in the final repeat ending segment.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. In the Repeat Endings section, click Add Section To Repeat Ending .

NOTE

If increasing the number of endings makes the repeat ending collide with any part of 
another repeat ending, the other repeat ending is deleted. However, its repeat barlines are 
not deleted.

4. Optional: Repeat these steps as many times as required for the number of additional 
endings you want.

RESULT
A new repeat ending segment is added. The existing previous repeat ending segment now ends 
with a closed line, with an end repeat barline created if necessary.

TIP

You can also add additional repeat ending segments by selecting the repeat ending and 
changing the value for No. endings in the Repeat Endings group of the Properties panel.

However, No. endings only adds additional repeat ending segments that contain one bar, and 
does not automatically input or reposition repeat barlines. You must input repeat barlines as 
appropriate manually.
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EXAMPLE

Default repeat ending structure with two 
endings

Repeat ending structure with additional third ending

Inputting repeat markers with the popover
You can input repeat markers, including repeat jumps and repeat sections, using the repeats 
popover, both during note input and by adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select an item at the rhythmic position where you want to input a repeat marker.

For repeat jumps, we recommend that you select the barline with which you want the 
end of the jump instruction to align. For repeat sections, we recommend that you select 
the barline with which you want the start of the section marker to align.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter the appropriate entry for the type of repeat marker you want into the popover.

For example, enter coda to input a coda section or enter $ to input a segno.

4. Press Return  to close the popover.

RESULT
During note input, repeat markers are input at the caret position. Coda sections are 
automatically formatted so that there is a gap between the coda and the preceding material.

When adding repeat markers to existing music, they are input at the rhythmic position of the 
earliest selected item.

Repeat markers that indicate the end of a section, such as Fine and D.C. al Coda, are right-aligned 
with the selected rhythmic position.

RELATED LINKS
Repeats popover on page 406
Repeat markers on page 1236
Repeats in playback on page 549
Changing the gap before codas on page 1242
Hiding/Showing repeat markers on page 1240
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Inputting repeat markers with the panel
You can input repeat markers using the Repeat Structures panel, both during note input and by 
adding them to existing music.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select an item at the rhythmic position where you want to input a repeat marker.

For repeat jumps, we recommend that you select the barline with which you want the 
end of the jump instruction to align. For repeat sections, we recommend that you select 
the barline with which you want the start of the section marker to align.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. Click the repeat marker you want to input in any of the following sections:

● Repeat Jumps

● Repeat Sections

RESULT
During note input, repeat markers are input at the caret position. Coda sections are 
automatically formatted so that there is a gap between the coda and the preceding material.

When adding repeat markers to existing music, they are input at the rhythmic position of the 
earliest selected item.

Repeat markers that indicate the end of a section, such as Fine and D.C. al Coda, are right-aligned 
with the selected rhythmic position.

Inputting tremolos with the popover
You can input both single-note and multi-note tremolos using the repeats popover, both during 
note input and by adding them to existing notes.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add tremolos.
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NOTE

If you want to input multi-note tremolos, you must select at least two notes that are in 
the same voice, have the same duration, and are notated using a single notehead. The 
notes can also be tuplets and cross-staff notes.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter the appropriate entry for the type of tremolo you want into the popover.

For example, enter:

● // for single-note tremolos with two strokes.

● ///2 for multi-note tremolos with three strokes.

● //rel for two-stroke single-note tremolos with release.

4. Press Return  to close the popover.

RESULT
Single-note tremolos are input on the selected notes with the number of tremolo strokes 
specified. They appear on all notes in tie chains.

Tremolos with release show single-note tremolo strokes on all notes in tie chains apart from the 
last note. Tremolos with attack show single-note tremolo strokes on all notes in tie chains apart 
from the first note.

Multi-note tremolos with the number of tremolo strokes specified are input between selected 
individual notes and the notes immediately after them, or between selected pairs of notes. The 
notated duration of notes in multi-note tremolos is automatically updated. For example, two 
quarter notes joined by a multi-note tremolo both appear as half notes.

When tuplets are selected, multi-note tremolos are input across the selected tuplets, with the 
tremolo strokes positioned in the center of all notes in the tuplet. The tuplet bracket is hidden, 
and a signpost is shown at the start of each tuplet indicating its ratio.

EXAMPLE

Multi-note tremolos with three tremolo strokes 
across tuplets

Tremolo with release added to tie chain

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have tremolos in one voice and slurs in 
another voice.

RELATED LINKS
Repeats popover on page 406
Tremolos on page 1399
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Tremolos in playback on page 1405
Tremolos in tie chains on page 1401
Deleting tremolos on page 1403
Enabling independent voice playback on page 545
Forcing the duration of notes/rests on page 262
Creating cross-staff beams/tremolos on page 851
Tuplets on page 1408

Inputting tremolos with the panel
You can input both single-note and multi-note tremolos using the Repeat Structures panel, both 
during note input and by adding them to existing notes.

Tremolos are included in the Repeat Structures panel because they indicate that notes are 
repeated, either individually as single-note tremolos or in sequences as multi-note tremolos.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

TIP

During note input, you can select additional notes before/after the last input note 
without deactivating the caret by pressing Shift-Right Arrow / Shift-Left Arrow .

● Select the notes to which you want to add tremolos.

NOTE

If you want to input multi-note tremolos, you must select at least two notes that are in 
the same voice, have the same duration, and are notated using a single notehead. The 
notes can also be tuplets and cross-staff notes.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. In the Tremolos section, click the tremolo you want to input.

For example, click:

● Two Strokes Single-note Tremolo  for single-note tremolos with two strokes.

● Three Strokes Multi-note Tremolo  for multi-note tremolos with three strokes.

● Tremolo With Release  for three-stroke single-note tremolos with release.

RESULT
Single-note tremolos are input on the selected notes with the number of tremolo strokes 
specified. They appear on all notes in tie chains.

Tremolos with release show single-note tremolo strokes on all notes in tie chains apart from the 
last note. Tremolos with attack show single-note tremolo strokes on all notes in tie chains apart 
from the first note.

Multi-note tremolos with the number of tremolo strokes specified are input between selected 
individual notes and the notes immediately after them, or between selected pairs of notes. The 
notated duration of notes in multi-note tremolos is automatically updated. For example, two 
quarter notes joined by a multi-note tremolo both appear as half notes.
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When tuplets are selected, multi-note tremolos are input across the selected tuplets, with the 
tremolo strokes positioned in the center of all notes in the tuplet. The tuplet bracket is hidden, 
and a signpost is shown at the start of each tuplet indicating its ratio.

EXAMPLE

Multi-note tremolos with three tremolo strokes 
across tuplets

Tremolo with release added to tie chain

AFTER COMPLETING THIS TASK
You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have tremolos in one voice and slurs in 
another voice.

RELATED LINKS
Repeat Structures panel on page 409
Enabling independent voice playback on page 545
Forcing the duration of notes/rests on page 262
Creating cross-staff beams/tremolos on page 851
Tuplets on page 1408

Inputting slash regions
You can input slash regions using the repeats popover.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● On each staff where you want to input a slash region, select items that span the required 
duration.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter slash into the popover.

4. Press Return  to close the popover.

RESULT
During note input, slash regions are input spanning the duration of the selected note or item, 
which is usually the last input note.

When adding slash regions to existing music, they span the selected duration on each selected 
staff.
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Slash regions are automatically formatted as appropriate for the meter. If you later change the 
time signature, slash regions retain their duration but the appearance of slashes within them 
automatically updates.

TIP

You can also input slash regions by clicking Create Slash Region in the Rhythm Slashes section 
of the Repeat Structures panel, or by choosing Write > Create Slash Region. You can assign a 
key command for this option on the Key Commands page in Preferences.

RELATED LINKS
Repeats popover on page 406
Repeat Structures panel on page 409
Rhythm slashes on page 1258
Slash regions on page 1261
Slash voices on page 1258
Inputting chord symbol regions on page 326
Hiding/Showing chord symbols on page 878
Lengthening/Shortening items on page 430
Key Commands page in the Preferences dialog on page 60

Inputting bar repeats
You can input bar repeat regions when at least one bar before the region contains notes.

PROCEDURE

1. In Write mode, on each staff where you want to input a bar repeat region, select items that 
span the required duration.

NOTE

You cannot input bar repeat regions in the first bar of a flow.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter the appropriate entry for the type of bar repeat region you want into the popover.

For example, enter %2,4 to repeat the previous two bars, grouped in four.

4. Press Return  to close the popover.

RESULT
A bar repeat region spanning the selected duration is input on each selected staff, in which the 
corresponding type of bar repeat symbol is shown at the intervals specified.

NOTE

● You can also input bar repeat regions during note input; however, this inputs bar repeat 
regions from the bar containing the currently selected note. As bar repeats are mostly 
shown in empty bars, this is likely to produce unintended results.

● You can also input one-bar repeat regions by clicking Create Bar Repeat Region in the Bar 
Repeats section of the Repeat Structures panel, or by choosing Write > Create Bar Repeat 
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Region. You can assign a key command for this option on the Key Commands page in 
Preferences.

AFTER COMPLETING THIS TASK
You can change how bar repeats are grouped.

RELATED LINKS
Bar repeats on page 1245
Bar repeat grouping on page 1251
Changing bar repeat grouping on page 1251

Inputting numbered bar regions
You can input numbered bar regions using the repeats popover.

PROCEDURE

1. In Write mode, on each staff where you want to number bars, select items that span the 
required duration.

2. Open the repeats popover in any of the following ways:

● Press Shift-R .

● In the Notations toolbox, click Popovers , then Repeats .

3. Enter num into the popover.

4. Press Return  to close the popover.

RESULT
A numbered bar region spanning the selected duration is input on each selected staff.

By default, bar counts are shown on every bar in the region. If the numbered bar region lasts 
four or more bars, Dorico Elements adds the total range in parentheses to the count on the first 
bar, such as showing “1 (-8)” on the first bar in a numbered bar region lasting eight bars.

NOTE

● You can also input numbered bar regions during note input; however, this only inputs a 
numbered bar region in the bar containing the currently selected note.

● You can also input numbered bar regions by clicking Create Numbered Bar Region in 
the Numbered Bars section of the Repeat Structures panel, or by choosing Write > 
Create Numbered Bar Region. You can assign a key command for this option on the Key 
Commands page in Preferences.

● Numbered bar regions are hidden in full score layouts and shown in part layouts by default, 
but you can choose to hide/show numbered bar regions in any layout.

RELATED LINKS
Repeats popover on page 406
Repeat Structures panel on page 409
Numbered bar regions on page 1253
Numbered bar region counts on page 1254
Hiding/Showing numbered bar regions on page 1254
Lengthening/Shortening items on page 430
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Inputting MIDI trigger regions
You can input MIDI trigger regions using the MIDI trigger regions popover.

PREREQUISITE
You have the chosen the appropriate middle C numbering convention setting.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● On each staff where you want to input a MIDI trigger region, select items that span the 
required duration.

2. Press Shift-0  to open the MIDI trigger regions popover.

3. Enter the notes you want to trigger into the popover.

For example, enter C4,E4,G4, 60,64,67, or play a C major chord on a MIDI keyboard. To 
specify the velocity, include the required number in parentheses, such as (112), at the end of 
your entry.

TIP

You can audition notes/chords while the popover is open.

4. Press Return  to close the popover.

RESULT
During note input, MIDI trigger regions are input spanning the duration of the selected note or 
item, which is usually the last input note.

When adding MIDI trigger regions to existing music, they span the selected duration on each 
selected staff. If you selected a duration within an existing MIDI trigger region, the new MIDI 
trigger region replaces the existing region only for the selected duration.

RELATED LINKS
MIDI trigger regions on page 574
Changing the middle C numbering convention on page 51
Inputting slash regions on page 417
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430
Inputting notes on page 224

MIDI trigger regions popover
The following table contains examples of what you can enter into the MIDI trigger regions 
popover to input notes for playback that are not shown in the music.

You can open the MIDI trigger regions popover in Write mode in any of the following ways when 
either an item is selected or the caret is active:

● Press Shift-0 .

● Select an existing MIDI trigger region and press Return .

● Choose Write > Create MIDI Trigger Region.
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MIDI trigger regions popover with an example entry

Notes and velocity Popover entry

Notes by pitch and octave

NOTE

Follows your middle C numbering convention 
setting.

C0, Db1, E2, F#3, and so on

Notes by MIDI note number 12, 25, 40, 54, and so on

Played notes Play notes on a MIDI keyboard

TIP

This also sets the velocity.

Specify velocity (0) to (127) after the final note

Selecting notes/items
In Dorico Elements, there are multiple different ways you can select notes and items in your 
project, from selecting items individually to making large selections covering multiple staves. You 
can also change whether notes play back during note input/selection.

RELATED LINKS
Large selections on page 424
System track on page 425
Filters on page 429
Selection tools on page 40
Playing/Muting notes during note input/selection on page 215
Playing all/individual notes in chords during note input/selection on page 216
Selecting items in the Key Editor on page 676

Selecting/Deselecting notes and items individually
You can select/deselect existing notes and other notation items individually in the music area; 
for example, if you want to add articulations to a selection of notes or delete a short passage of 
music. You can do this in Write mode and Engrave mode.

TIP

If you want to select a large number of notes/items, we recommend that you use one of the 
larger selection methods.
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PROCEDURE

1. Select individual notes/items in the music area in any of the following ways:

● Click a single note/item.

TIP

If the item you want to select is behind another item, Shift - Alt/Opt -click it.

● Ctrl/Cmd -click individual notes/items.

● Shift -click adjacent notes/items.

● To select all notes in a beam group, click the beam.

● To select all notes in a chord, click the stem.

● To select everything in a bar, click on the staff in that bar, but not on any notes, stems, or 
items.

● Make a marquee selection around multiple notes/items.

● Navigate to other items from an existing selection.

● If nothing is selected in the music area, press any arrow key on your computer keyboard 
to select the first note, rest, or other item on the top staff in the current layout.

2. Deselect all currently selected items in any of the following ways:

● Press Ctrl/Cmd-D .

● Choose Edit > Select None.

● Click outside of the staves within the music area.

RELATED LINKS
Selecting multiple items using marquee selections on page 424
Selecting items in the Key Editor on page 676
Playing/Muting notes during note input/selection on page 215
Navigating to other items in the music area on page 439
Undoing/Redoing actions on page 438
Filters on page 429

Extending selections
You can extend your current selection to adjacent notes and items, including to the start/end of 
systems and flows.

PROCEDURE

1. In Write mode, make a selection in the music area.

2. Extend the selection in any of the following ways:

● To select adjacent notes/items to the right, press Shift-Right Arrow .

● To select adjacent notes/items to the right, press Shift-Left Arrow .

● To select to the end of the bar, press Ctrl/Cmd-Shift-Right Arrow .

● To select to the start of the bar, press Ctrl/Cmd-Shift-Left Arrow .

● To select to the end of the system, choose Edit > Select To End Of System.

● To select to the start of the system, choose Edit > Select To Start Of System.

● To select to the end of the flow, choose Edit > Select To End Of Flow.
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● To select to the start of the flow, choose Edit > Select To Start Of Flow.

Selecting more items of the same type
You can incrementally extend your current selection to more items of the same type and notes 
in the same voices, which is particularly helpful if you want to select multiple different items at 
once, such as dynamics and lyrics.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes and items you want to select more of. You can do this in Write mode and 
Engrave mode.

TIP

You can select notes and items on multiple staves and in specific voices; for example, if you 
only want to select notes in up-stem voices on four staves.

2. Press Ctrl/Cmd-Shift-A  to expand your selection.

3. Optional: Continue pressing Ctrl/Cmd-Shift-A  to extend your selection further.

RESULT
More of the same types of items and notes in the same voices as your original selection are 
selected, with the range of selected items expanding each time you press the key command: 
firstly to the boundaries of the bar, secondly to the boundaries of the system, and finally to the 
rest of the flow. If there are no other items available in the bar, Dorico Elements automatically 
advances to the second expansion. In galley view, the second expansion is to the entire flow 
directly as there is only a single system in galley view.

For items that span multiple bars and systems, they are selected in the earliest bar/system in 
which they exist.

NOTE

Dorico Elements selects the following items differently if you select only a single one of them:

● Lyrics: The selection expands only to other lyrics with the same line number, placement, and 
line type as the originally selected lyric.

● Dynamics: The first expansion is to all other dynamics in the same group and on the same 
staves as the original selection, with further expansions selecting other dynamics in other 
groups.

● Text items: The selection expands only to other text items using the same paragraph style as 
the originally selected text item.

● Playing techniques: The selection expands only to playing techniques of the same category, 
such as Strings or Choral. Additionally, if you select either an up bow or down bow playing 
technique, the selection expands only to other up bow and down bow playing techniques. It 
does not select any other playing techniques.

RELATED LINKS
Engrave toolbox on page 503
Types of lyrics on page 1029
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Lyric line numbers on page 1047
Groups of dynamics on page 949
Changing the paragraph style of text items on page 1356
Paragraph Styles dialog on page 756

Selecting multiple items using marquee selections
You can use a marquee selection to select multiple notes and notations at the same time within a 
specific area. You can do this in Write mode and Engrave mode.

PROCEDURE

1. In the status bar, click Marquee Tool .

2. In the music area, click and drag across the area where you want to select everything.

A gray rectangle indicates which notes and notations will be selected. We recommend that 
you click in one corner of the area you want to select and drag diagonally across to the other 
corner.

RESULT
When you release the mouse, all notes and notations in the area within the gray rectangle are 
selected.

NOTE

Only items completely within the area are selected. However, if any part of a note/tie chain is 
within the area, the whole note/tie chain is selected.

RELATED LINKS
Status bar on page 38
Selection tools on page 40
Extending selections on page 422
Selecting items in the Key Editor on page 676
Changing values using the Transform tool on page 715

Large selections
You can make large selections, including selecting the contents of whole staves or the whole 
flow.

Select everything in a specific area
You can use the Marquee Tool  to specify an area in which you want to select 
everything.

Select everything in the whole flow

● Press Ctrl/Cmd-A .

● Choose Edit > Select All.

Select everything on a single staff

● Select the first note on the staff, hold down Shift , then select the last note on the 
staff.

● Select the first note on the staff and choose Edit > Select To End Of System or 
Edit > Select To End Of Flow.
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● Select the last note on the staff and choose Edit > Select To Start Of System or 
Edit > Select To Start Of Flow.

Select everything on multiple adjacent staves

● Select one whole staff at the top/bottom of the range of staves you want to select 
and press Shift-Up Arrow  or Shift-Down Arrow  until all the staves you want are 
selected.

● Select one whole staff at the top/bottom of the range of staves you want to select 
and Shift -click the staff at the other end of the range of staves you want to select.

Select more of the currently selected types of items
You can use Edit > Select More ( Ctrl/Cmd-Shift-A ) to expand your current selection 
horizontally and incrementally to other items of the same types and in the selected 
voices and staves in Write mode. For items that span multiple bars and systems, they 
are selected in the earliest bar/system in which they exist.

1. The first expansion is to the boundaries of the current bar, both to the left 
and right. If there is nothing to select within the bar, such as if you selected a 
whole note in a 4/4 bar, Dorico Elements automatically advances to the second 
expansion.

2. The second expansion in page view is to the boundaries of the current system, 
both to the left and right. In galley view, the second expansion is to the rest of the 
flow, as there is only a single system in galley view.

3. In page view, the third expansion is to the entire flow.

Select everything in the system within a range of beats/bars
You can use the system track to select a region of beats/bars and then select 
everything on all staves in the system within that region.

System track selections include system objects, such as chord symbols, key signatures, 
and time signatures.

TIP

If you want to select only a certain type of item, such as lyrics or dynamics, you can then use the 
corresponding filters.

RELATED LINKS
Filters on page 429
Selecting/Deselecting notes and items individually on page 421
Extending selections on page 422
Selecting items in the Key Editor on page 676
Selecting more items of the same type on page 423
Undoing/Redoing actions on page 438
Histogram tool on page 710

System track
The system track is a translucent line above the top of each system in Write mode. It allows 
you to add and delete bars and beats, and to select everything on all staves in the system. 
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System track selections include system objects, such as chord symbols, key signatures, and time 
signatures.

The system track above a staff, showing bars The system track above a staff, showing beat 
units reflecting the current rhythmic grid resolution 
(available when you hold Alt/Opt )

The color of the system track changes depending on how you are interacting with it.

● When you hover the mouse over it, it becomes more opaque.

● When you select a region in the system track, it appears highlighted.

The system track when the mouse pointer hovers 
over it

The system track with a region selected

When you have selected a region in the system track, the following options are available:

1 Set Edit Stop Position

Allows you to set and delete Insert mode stop positions.

2 Delete

Allows you to delete the selected region.

NOTE

When you hover over Delete, the highlight color of the selected region changes.

3 System Track Select

Allows you to select all items, including system objects, on all staves in the system across the 
selected region.

4 Add

Allows you to add bars or beats of the same duration as the selection in the system track. 
The extra time is inserted immediately after the end of the selection.
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NOTE

Selections on the system track are cleared whenever you make any other kind of selection, or 
when you switch layouts. However, selections on the system track are retained when switching 
between page and galley view.

RELATED LINKS
Inputting bars/beats with the system track on page 305
Deleting bars/beats with the system track on page 811
System objects on page 1326
Rhythmic grid on page 217
Insert mode on page 451

Hiding/Showing the system track
The system track is shown by default in new projects, but you can hide/show it in Write mode at 
any time.

PROCEDURE

● Hide/Show the system track in any of the following ways:

● Press Alt/Opt-T .

● Choose View > System Track.

RESULT
The system track is hidden/shown.

TIP

You can hide the system track in all future projects by default in Preferences > General > View.

RELATED LINKS
Preferences dialog on page 58

Selecting bars with the system track
The system track allows you to select all items, including system objects, on all staves in the 
system across the selected bars.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In Write mode, click a bar in the system track.

2. Optional: Select additional bars in any of the following ways:

● Shift -click bars to the right/left along the system track.

● Click and drag to the right/left along the system track.

3. Click System Track Select  in the system track. It can also appear above the system track if 
your selection is narrow.

System Track Select  appears filled in when you hover your mouse pointer over it.
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RESULT
Everything on all staves in the selected bars is selected and highlighted, including system objects, 
notations, and signposts.

NOTE

If you then delete your selection, any signposts included are also deleted. This can affect the 
page layout; for example, by removing ossia staves whose signposts were included in the 
selection.

Selecting beats with the system track
The system track allows you to select all items, including system objects, on all staves in the 
system across the selected beats.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In Write mode, press and hold Alt/Opt .

Grid lines that match the current rhythmic grid resolution appear in the system track.

2. Without releasing Alt/Opt , click and drag to the right/left along the system track.

NOTE

You cannot Shift -click when selecting beats.

3. Click System Track Select  in the system track. It can also appear above the system track if 
your selection is narrow.

System Track Select  appears filled in when you hover your mouse pointer over it.

RESULT
Everything on all staves in the selected beats is selected and highlighted, including system 
objects, notations, and signposts.

NOTE

If you then delete your selection, any signposts included are also deleted. This can affect the 
page layout; for example, by removing ossia staves whose signposts were included in the 
selection.

RELATED LINKS
Copying and pasting notes/items on page 457
Deleting the contents of bars on page 812
Deleting bars/beats with the system track on page 811
System objects on page 1326
Rhythmic grid on page 217
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Filters
Filters in Dorico Elements allow you to select only a specific type of item from a larger selection. 
Dorico Elements includes a filter for every notation item.

● You can find the available filters by choosing Edit > Filter > [Item] > [Item type]. You can 
also choose filters from the context menu.

All significant notation items have their own filter; for example, arpeggio signs, chord symbols, 
key signatures, and playing techniques. You can also filter for note spacing changes.

The following items have multiple filters because they have multiple types:

Notes
Allows you to filter notes, grace notes, and chords. You can also filter notes according 
to their position in chords.

Voices
Allows you to filter voices according to their stem direction. You can also filter slash 
voices.

Dynamics
Allows you to filter all dynamics, or just gradual or immediate dynamics.

Tempos
Allows you to filter all tempo marks, or just absolute, relative, or gradual tempo 
changes.

Lyrics
Allows you to filter all lyrics, or just lyrics with a specific line number, type, or staff-
relative placement.

NOTE

There is no filter for barlines. You also cannot filter notations that are considered part of the 
notes to which they apply, including fingerings, beams, articulations, and tremolos.

RELATED LINKS
Filters for lyrics on page 1034
Selecting more items of the same type on page 423
Changing the voice of existing notes on page 466
Changing the line number and type of lyric lines on page 1048

Changing filters to select/deselect
You can change whether the available filter options select or deselect the specified items. By 
default, filters select items, meaning that the resulting selection only includes the item being 
filtered.

When filters are set to deselect, the resulting selection includes everything except the item being 
filtered.

PROCEDURE

● Change the filter behavior in one of the following ways:

● To change filters to select, choose Edit > Filter > Select Only.

● To change filters to deselect, choose Edit > Filter > Deselect Only.
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TIP

You can also choose these options from the context menu.

Editing items
In Dorico Elements, there are editing methods that are common to most notations, including 
lengthening/shortening items and changing their staff-relative placement.

RELATED LINKS
Selecting notes/items on page 421
Arranging tools on page 455
Moving notes/items rhythmically on page 461
Undoing/Redoing actions on page 438

Lengthening/Shortening items
You can lengthen/shorten items with duration rhythmically after they have been input; for 
example, if you want an octave line to cover more/fewer notes.

Lengthening figured bass or playing techniques, including string indicators outside the staff and 
vibrato bar indications, that were input without a specified duration gives them duration and 
shows duration or hold lines if required.

PREREQUISITE
You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. In Write mode, select the items you want to lengthen/shorten.

NOTE

● When multiple items are selected, you can only lengthen/shorten them by the current 
rhythmic grid resolution.

● You can only lengthen/shorten one of the following items at a time: slurs, gradual 
dynamics, groups of gradual dynamics, and bar repeat regions.

● When using the mouse, you can only lengthen/shorten a single item at a time. Figured 
bass and playing techniques, including string indicators and vibrato bar lines, must have 
duration already.

● When lengthening/shortening multiple figured bass or playing techniques using the 
keyboard, they must all have duration already.

● You can only lengthen/shorten non-grouped playing techniques or the last playing 
technique in a group.

● You can only lengthen/shorten cross-staff slurs to notes on the same staff as the 
corresponding endpoint, and you can only lengthen/shorten cross-voice slurs to notes in 
the same voice as the corresponding endpoint.

2. Lengthen/Shorten the selected items in any of the following ways:

● To lengthen them by the current rhythmic grid resolution or to the next notehead, 
whichever is closer, press Shift-Alt/Opt-Right Arrow .
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● To shorten them by the current rhythmic grid resolution or to the previous notehead, 
whichever is closer, press Shift-Alt/Opt-Left Arrow .

NOTE

Bar repeat regions are lengthened/shortened by the duration of their grouping.

● To lengthen a single item to the next notehead, press Ctrl/Cmd-Shift-Alt/Opt-
Right Arrow .

● To shorten a single item to the previous notehead, press Ctrl/Cmd-Shift-Alt/Opt-
Left Arrow .

● Click and drag the circular handle at the start/end to the right/left.

NOTE

Playing technique groups only have a single handle at their start and end, not individual 
handles for each playing technique within the group.

RESULT
The selected items are lengthened/shortened by moving their end rhythmically to the right/left. 
Most items are lengthened/shortened either by the current rhythmic grid resolution or to the 
next/previous notehead, whichever is closer, or directly to the next/previous notehead.

Bar repeat regions are lengthened/shortened by the duration of their grouping. Numbered bar 
regions are lengthened/shortened by bars. Slurs are lengthened/shortened to notes.

If figured bass or playing techniques previously had no duration, they now have duration and 
show duration or hold lines if required.

If any part of slash regions now overlap rhythmic positions with other slash regions, the staff 
positions of slashes are automatically adjusted to accommodate multiple slash regions at the 
same positions.

Dynamic groups are lengthened/shortened proportionally by lengthening/shortening the 
gradual dynamics and moving any other type of dynamic in the group. This retains the relative 
durations of the gradual dynamics in the group.

NOTE

● The minimum length of a bar repeat region is one bar. If you shorten regions with longer 
groupings, such as every four bars, the length of the region is halved until a one-bar repeat 
region remains.

● Only a single bar repeat region or chord symbol region can exist at each rhythmic position 
on each staff. If a bar repeat region or chord symbol region collides with another item of 
the same type when it is lengthened/shortened, the existing item is deleted or shortened 
accordingly. For bar repeat regions, this can mean the grouping of other bar repeat regions 
is changed.

You can undo this action and restore the previous lengths of the other regions. However, if 
you lengthened/shortened a bar repeat region or chord symbol region using the mouse and 
it overwrote another region of the same type completely, the other region is permanently 
deleted.

● You can move items graphically in Engrave mode, including changing their graphical length.
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EXAMPLE
In the example, lengthening the phrase moves the  at the end two quarter notes to the right, 
but moves the  in the middle only one quarter note to the right. This keeps the lengths of the 
gradual dynamics equal.

Original dynamic phrase Lengthened dynamic phrase

RELATED LINKS
Rhythmic grid on page 217
Changing the duration of notes on page 259
Lengthening/Shortening segments in repeat endings on page 1232
Moving notes/items rhythmically on page 461
Moving items graphically on page 514
Hiding/Showing playing technique duration lines on page 1189
Notations input on page 271
Bar repeat grouping on page 1251
Playing technique continuation lines on page 1186
Playing technique duration on page 1187
Pedal line start signs, hooks, and continuation lines on page 1171
Sustain pedal retakes and pedal level changes on page 1162
Slashes in multiple-voice contexts on page 1268
Octave lines in Engrave mode on page 918
Slurs in Engrave mode on page 1300
Cross-staff and cross-voice slurs on page 1294
Groups of dynamics on page 949
Showing consecutive hairpins as continuous on page 940
Hiding/Showing figured bass hold/suspension lines on page 961

Changing existing items
You can change all items that have an associated popover, rather than deleting them and 
inputting new ones. For example, if you want to change an 8va octave line into a 15va octave line 
or change a short fermata into a long fermata.

PROCEDURE

1. Select the item or the signpost of the item you want to change.

2. Open the popover for that item in any of the following ways:

● Press Return .

● Double-click the item.

3. Change the existing entry in the popover.

For chord symbols, you can also play the new chord on your MIDI keyboard.

4. Press Return  to close the popover.
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RESULT
The selected item is changed according to the new entry in the popover. This changes different 
parameters for different items, such as the duration of a hold or pause or the volume of a 
dynamic.

NOTE

● Any properties previously set on the item are reset.

● If you change a fermata to a breath mark, only the fermata on the top staff is changed to 
a breath mark. If you change a caesura to a breath mark, a breath mark is input on the top 
staff at the end of the bar to which the caesura is attached. However, the existing caesura 
also remains on all staves.

● If you open the playing techniques popover in this way, Dorico Elements inputs your new 
entry as a separate playing technique and does not delete the previous one.

● If you change an immediate dynamic to a combined dynamic, such as  to , or vice versa, 
Dorico Elements inputs your new entry as a separate dynamic and does not delete the 
previous one.

RELATED LINKS
Popovers on page 22
Properties panel on page 663
Changing the text of existing lyrics on page 1043
Assigning key commands on page 63
Changing dynamic levels on page 926

Changing the size of notes/items
You can change the size of individual notes and items using the default scale sizes for cues, grace 
notes, a custom scale size, or a custom scale size in addition to a default scale size. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

TIP

● To make all notes, items, and staves proportionally larger/smaller, you can change the staff 
size.

● If you want to make notes smaller to represent grace notes, you can input them as grace 
notes instead.

● You can change the default size of many text-based notations, such as rehearsal marks and 
chord symbols, project-wide by editing the corresponding font style or paragraph style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes/items whose size you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate any of the following properties in the Common group:
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● To use a default scale size, activate Scale.

● To use a custom scale size, activate Custom scale.

● To use a custom scale size based on a default scale size, activate both Scale and Custom 
scale.

3. Optional: If you activated Scale, select one of the following options from the menu:

● Normal

● Grace

● Cue

● Cue grace

4. Optional: If you activated Custom scale, change the value in the value field.

RESULT
The size of the selected notes/items is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

● If you activated Scale, the selected notes/items are changed to the selected default scale 
size.

● If you activated Custom Scale, the selected notes/items are changed to the custom 
percentage scale size you set.

● If you activated both Scale and Custom Scale, the selected notes/items are changed to the 
custom percentage scale size of the selected default scale size. For example, if you selected 
Grace for Scale then set Custom Scale to 50, the size of the selected notes/items is half the 
size of grace notes.

RELATED LINKS
Staff size on page 617
Changing the default staff size on page 602
Grace notes on page 1002
Inputting grace notes on page 249
Cues on page 920
Notehead set designs on page 1053
Text formatting on page 753
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Changing the size of accidentals on page 794
Changing the size of fingerings on page 976
Large time signatures on page 1387

Changing the staff-relative placement of items
You can flip any item that can be placed both above/below the staff to change their staff-relative 
placement; for example, if you want to change the stem direction of notes quickly. For many 
items, you can do this for the current layout and frame chain only or for all layouts and frame 
chains.

NOTE

These steps do not apply to text in text frames or pedal lines.
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PREREQUISITE

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the items you want to flip. You can do this in Write mode and Engrave mode.

NOTE

● You cannot flip items during note input. You cannot flip text items when the text editor is 
open.

● If you want to select parts of items, such as articulations, a single notehead within a tie 
chain, or a single fermata, you must be in Engrave mode.

● To select multiple items of the same type, you can use large selections and/or filters.

2. Press F .

RESULT
The staff-relative placement of the selected items is changed by setting Placement, Position, or 
Direction properties appropriately in the corresponding groups of the Properties panel. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain for items whose staff-relative placement properties are local.

Deactivating these properties resets items to their default placement.

NOTE

If you flipped multiple multi-segment slurs or tuplet brackets with different hook directions at the 
same time, all selected items are set to either above or below the staff, unless they all originally 
had compatible directions set.

AFTER COMPLETING THIS TASK
If you need to move items to different graphical positions, you can move them graphically in 
Engrave mode.

RELATED LINKS
Filters on page 429
Large selections on page 424
Local vs. global properties on page 664
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Tucking index properties on page 518
Changing the stem direction of notes on page 1076
Changing the staff-relative placement of beams on page 846
Changing the placement of articulations relative to notes on page 808
Changing the staff-relative placement of fingerings on page 974
Changing the staff-relative placement of tuplet brackets on page 1414
Changing the staff-relative placement of chord symbols on page 882
Changing the curvature direction of slurs on page 1293
Changing the curvature direction of ties on page 1369
Changing the direction of guitar pre-bends/pre-dives on page 1129
Changing the staff-relative placement of guitar techniques on page 1142
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Moving items graphically on page 514
Positions of lyrics on page 1035

Resetting the appearance of items
You can reset all changes that you have made to the appearance of individual items, which 
returns them to the default settings.

Properties relating to the appearance of items include those that change their style, type, and 
some additions, such as poco a poco text for dynamics.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the items whose appearance you want to reset. You can do this in Write mode and 
Engrave mode.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Choose Edit > Reset Appearance.

RESULT
All properties that affect the appearance of the selected items are reset to their default settings.

NOTE

Local properties that were originally set with the property scope set to Globally are reset in all 
layouts and frame chains that do not have subsequent local overrides.

RELATED LINKS
Notation Options dialog on page 747
Engrave toolbox on page 503
Local vs. global properties on page 664
Filters on page 429
Large selections on page 424

Resetting the position of items
You can reset the position of individual items that you have moved graphically, which returns 
them to their default position.

Properties relating to the position of items include horizontal and vertical offsets, beat-relative 
position, and staff-relative placement.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the items whose position you want to reset. You can do this in Write mode and 
Engrave mode.
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TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Choose Edit > Reset Position.

RESULT
All properties that affect the position of the selected items are reset to their default settings.

NOTE

Local properties that were originally set with the property scope set to Globally are reset in all 
layouts and frame chains that do not have subsequent local overrides.

Hiding non-printing elements
You can temporarily hide all visible elements that do not print, such as signposts and selection 
highlights. This allows you to view the current layout as it will appear when printed/exported 
without switching to Print mode.

PROCEDURE

● Press and hold \ (Windows) or ` (macOS) .

RESULT
All non-printing elements in the current layout are hidden until you release the key command. 
Printing elements appear as they will when printed/exported.

TIP

You can also hide/show individual non-printing elements permanently.

RELATED LINKS
Annotations on page 597
Printing layouts on page 581
Exporting layouts as graphics files on page 585
Hiding/Showing signposts on page 450
Hiding/Showing the system track on page 427
Hiding/Showing guide bar numbers on page 829
Hiding/Showing colors for notes out of range on page 1064
Hiding/Showing voice colors on page 1439
Hiding/Showing region highlights on page 1247
Hiding/Showing slash region highlights on page 1265

Hiding/Showing attachment lines
You can hide/show attachment lines in Write mode and Engrave mode. Attachment lines link a 
single selected item to its rhythmic position, including items that you have moved graphically.

PROCEDURE

● Choose View > Attachment Lines.
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RESULT
Attachment lines are hidden/shown.

EXAMPLE

Attachment lines shown Attachment lines hidden

RELATED LINKS
Hiding/Showing crosshairs on page 517
Rhythmic position on page 24
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430
Moving items graphically on page 514

Undoing/Redoing actions
You can undo/redo sequences of edits and selections in reverse order.

PROCEDURE

1. Undo actions in any of the following ways:

● Press Ctrl/Cmd-Z  as many as times as required.

● In the toolbar, click Undo .

● Choose Edit > History to open the History dialog, select the action that you want to 
undo up to, then click OK.

2. Redo actions in any of the following ways:

● Press Ctrl/Cmd-Shift-Z or Ctrl/Cmd-Y  as many as times as required.

● In the toolbar, click Redo .

● Choose Edit > History to open the History dialog, select the action that you want to 
redo up to, then click OK.

RESULT
All edits and selections you made up to the selected action are undone/redone.

RELATED LINKS
Toolbar on page 30

History dialog
The History dialog displays all your edits and selections in the current session, and allows you to 
undo/redo all actions up to the selected one.

● You can open the History dialog in any mode by choosing Edit > History.
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RELATED LINKS
Undoing/Redoing actions on page 438
Selecting notes/items on page 421
Editing items on page 430

Navigation
There are different ways you can navigate around the layout currently open in the music area, 
such as moving the selection to different items or bringing specific bar numbers or pages into 
view. Many navigation methods function in multiple modes.

If you have an item selected, you can navigate to other notes/items, which moves the selection to 
those notes/items.

RELATED LINKS
Workspace setup on page 43
Going to locations with the jump bar on page 66
Jump bar on page 65
Moving the caret manually on page 223

Navigating to other items in the music area
You can navigate to other notes and items in the music area after you have selected a note/item; 
for example, if you want to move the selection to other notes along the staff without using the 
mouse.

NOTE

In Engrave mode, navigating to other items always moves the selection to the closest item 
graphically, rather than the next/previous item of the same type.

PROCEDURE

1. Select an item in the music area.

● If you want to navigate through notes, select a note.
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● If you want to navigate through a particular type of item, such as rehearsal marks, select 
an item of that type.

NOTE

You can only navigate forwards/backwards through items on the same staff. You cannot 
navigate to other items of the same type on other staves.

2. Navigate to other notes or items in any of the following ways:

● To navigate to the next item or note in the same voice, press Right Arrow .

● To navigate to the previous item or note in the same voice, press Left Arrow .

● To navigate to the closest note above the current selection, press Up Arrow .

This navigates to any existing notes on the same staff first, then to the lowest note/rest 
on the staff above. If a whole chord was selected, this leaves the bottom note in the 
chord selected.

● To navigate to the closest note below the current selection, press Down Arrow .

This navigates to any existing notes on the same staff first, then to the highest note/rest 
on the staff below. If a whole chord was selected, this leaves the top note in the chord 
selected.

● To navigate forwards to the note/rest at the start of the next bar, press Ctrl/Cmd-
Right Arrow .

● To navigate backwards to the note/rest at the start of the previous bar, press Ctrl/Cmd-
Left Arrow .

● To navigate to the top staff in the system, press Ctrl/Cmd-Up Arrow .

● To navigate to the bottom staff in the system, press Ctrl/Cmd-Down Arrow .

3. Optional: Switch the selection to another type of item at the same rhythmic position in one 
of the following ways:

● To cycle forwards through items, press Tab .

● To cycle backwards through items, press Shift-Tab .

NOTE

You cannot switch the selection to system objects, such as system-attached text or rehearsal 
marks. However, you can select system objects directly and navigate through them.

4. Optional: After switching the selection to another type of item, navigate to other items of 
that type.

RELATED LINKS
System objects on page 1326

Going to flows
You can go to the next/previous flow in the current layout, which automatically brings the start of 
that flow into view in the music area. This is particularly useful when navigating around layouts 
that contain many flows.

These steps function in Setup, Write, and Engrave modes.
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PROCEDURE

● Go to a different flow in one of the following ways:

● To go to the previous flow in the layout, choose Edit > Go To > Go To Previous Flow.

● To go to the next flow in the layout, choose Edit > Go To > Go To Next Flow.

RESULT
The music area updates to show the start of the corresponding flow. Dorico Elements 
automatically positions the top staff towards the top left of the music area.

TIP

You can assign key commands to both Go To Previous Flow and Go To Next Flow on the Key 
Commands page in Preferences.

Going to pages
You can go to any specified page in the current layout using its page number; for example, to 
jump quickly to the exact page that requires changes when editing music.

These steps function in Setup, Write, and Engrave modes.

PROCEDURE

1. Choose Edit > Go To > Go To Page to open the Go To Page dialog.

2. Enter the page number to which you want to go into the Page field.

3. Click OK.

RESULT
The music area updates to show the start of the corresponding page. Dorico Elements 
automatically centers the top of the page in the music area.

TIP

● You can assign a key command for Go To Page on the Key Commands page in Preferences.

● You can also move the view and navigate to other pages in the layout in other ways.

RELATED LINKS
Key Commands page in the Preferences dialog on page 60
Page arrangements for page view on page 41
Moving the view in the music area on page 442
Zooming in/out of the music area on page 443

Going to bars
You can go to any specific bar in any flow in the current layout; for example, to jump quickly to 
the exact bar that requires changes when editing music.

These steps function in Setup, Write, Engrave, and Play modes.

PROCEDURE

1. Press Ctrl/Cmd-G  to open the Go To Bar dialog.
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2. Select the flow containing the bar to which you want to go from the Flow menu.

3. Enter the bar number to which you want to go into the Bar field.

4. Click OK.

RESULT
The music area updates to show the corresponding bar. Dorico Elements automatically positions 
the top staff towards the top left of the music area.

In Play mode, the playhead moves to the start of the corresponding bar. Dorico Elements 
automatically positions the playhead at the start of the ruler.

Going to rehearsal marks
You can go to any specific rehearsal mark in any flow in the current layout; for example, to jump 
quickly to passages that require changes when editing music.

These steps function in Setup, Write, and Engrave modes.

PROCEDURE

1. Choose Edit > Go To > Go To Rehearsal Mark to open the Go To Rehearsal Mark dialog.

2. Select the flow containing the rehearsal mark to which you want to go from the Flow menu.

3. Enter the rehearsal mark to which you want to go into the Rehearsal mark field.

4. Click OK.

RESULT
The music area updates to show the corresponding rehearsal mark.

TIP

You can assign a key command for Go To Rehearsal Mark on the Key Commands page in 
Preferences.

Moving the view in the music area
You can move the view in the music area to show different parts of layouts. For example, you can 
scroll through a layout to view each page in sequence.

PROCEDURE

● Move the view in any of the following ways:

● To move the view upwards/downwards, scroll upwards/downwards on a mouse wheel or 
swipe upwards/downwards on a touchpad.

● To move the view to the right/left, Shift -scroll upwards/downwards on a mouse wheel 
or swipe to the right/left on a touchpad.

● To navigate to the next page, press End (horizontal page arrangements) or Page 
Down (vertical page arrangements) .

● To navigate to the previous page, press Home (horizontal page arrangements) or 
Page Up (vertical page arrangements) .

● To navigate to the first page, press Ctrl/Cmd-Home .

● To navigate to the last page, press Ctrl/Cmd-End .
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● In the status bar, click Hand Tool , then click and drag in any empty space within the 
page boundaries in the music area.

The mouse pointer changes into a hand symbol during the move.

RESULT
The view in the music area is moved.

TIP

● You change the maximum overscroll amount, that is, how far beyond the edges of pages you 
can move the view, on the General page in Preferences.

● You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.

RELATED LINKS
Status bar on page 38
Selection tools on page 40
Enabling/Disabling playhead following on page 539

Zooming in/out of the music area
You can change the zoom level in the music area; for example, if you want a larger overview 
when inputting notes, but want to see notes and notations more closely when making detailed 
graphical amendments.

PREREQUISITE
If you want to keep a specific item in the center of the music area when you zoom in/out, you 
have selected that item.

PROCEDURE

1. Zoom in in any of the following ways:

● Press Ctrl/Cmd-= or Z .

● Spread two fingers outwards on a touchpad.

● Ctrl/Cmd -scroll upwards on a mouse wheel.

● Use the zoom options  in the status bar.

2. Zoom out in any of the following ways:

● Press Ctrl/Cmd-- or X .

● Pinch two fingers together on a touchpad.

● Ctrl/Cmd -scroll downwards on a mouse wheel.

● Use the zoom options  in the status bar.

RESULT
The zoom level in the music area is changed. If you had anything selected, Dorico Elements 
uses your selection as the focal point of the zoom. If you had nothing selected, Dorico Elements 
focuses on the area previously in the center of the view.
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TIP

● You can change the default zoom level that is used when opening layouts in all future 
projects in Preferences > General > View.

● You can assign a key command for Center Selection on the Key Commands page in 
Preferences. This command automatically brings the selection into view.

RELATED LINKS
Status bar on page 38
Zoom options on page 42
Zooming in/out of tracks on page 537
Workspace setup on page 43

Assigning key commands for custom zoom levels
You can assign key commands for multiple custom zoom levels; for example, if you regularly use 
zoom levels not available from the preset menu in the status bar.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Key Commands.

3. In the functions list, expand View, then select Zoom.

4. In the Key Commands section, enter the zoom level for which you want to assign a key 
command into the Parameter ‘ZoomPercent’ value field.

5. Click the Press shortcut input field.

6. On your computer keyboard, press the key command that you want to assign.

7. Click Add Key Command.

If the key command you pressed is already used by another function, a warning is displayed.

8. Click Apply.

The functions list is refreshed, and Zoom is no longer selected. To assign key commands for 
other custom zoom levels, you must navigate to Zoom again in the functions list.

9. Click Close.

RESULT
The key command you pressed is added to the list of assigned key commands for the selected 
zoom level.

In the functions list, Zoom now has a disclosure arrow and your new zoom level is listed beneath. 
Each zoom level for which you have assigned a key command appears separately.

RELATED LINKS
Key Commands page in the Preferences dialog on page 60
Zooming in/out of the music area on page 443
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Instrument filters
Instrument filters allow you to show only the staves of selected instruments in galley view in 
Write mode. This can be useful in large projects when you want to focus on a specific set of 
instruments, such as only the woodwinds or strings.

When instrument filters are active, dashed lines are shown at the vertical positions of hidden 
staves, and you can only select and edit music on visible staves.

Instrument filters are layout-specific.

Instrument filter containing flute and violin instruments active in galley view

TIP

You can assign key commands for up to ten instrument filter presets on the Key Commands 
page in Preferences. The instruments filtered by these commands vary in each layout and 
project.

RELATED LINKS
Switching to galley/page view on page 50
Selecting notes/items on page 421
Editing items on page 430
Arranging tools on page 455
Hiding/Showing empty staves on page 605
Scrubbing on page 542

Instrument filter overlay
The instrument filter overlay allows you to apply instrument filters to layouts and add new 
instrument filters. It only appears in galley view in Write mode.

● You can hide/show the instrument filter overlay in Write mode by choosing View > 
Instrument Filter Overlay.
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The instrument filter overlay contains the following options:

Filter
Activates/Deactivates the selected instrument filter. Only available when the layout 
contains at least one instrument filter.

Filter when deactivated Filter when activated

Instrument filter menu

Allows you to select the instrument filter you want to apply to the current layout. Only 
available when Filter is activated.

Add Instrument Filter

Adds an instrument filter containing the instruments on which you have selected 
items. Only available when at least one item is selected in the music area.

Manage Instrument Filters

Opens the Manage Instrument Filters dialog, which allows you to add, edit, and 
delete instrument filters for the current layout.

Manage Instrument Filters dialog
The Manage Instrument Filters dialog allows you to add, edit, and delete instrument filters for 
the current layout.

You can open the Manage Instrument Filters dialog in Write mode in any of the following ways:

● In the instrument filter overlay, click Manage Instrument Filters .

● Choose Write > Instrument Visibility > Edit Instrument Filter Presets.
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The Manage Instrument Filters dialog comprises the following:

1 Managing instrument presets for

Displays the name of the layout whose instrument filters are listed in the dialog.

2 Instrument filters list

Contains the instrument filters set for the layout. Each instrument filter displays its name 
and the instruments it contains. If multiple instrument filters contain the same instruments, 
Dorico Elements displays a warning.

The first ten instrument filters show a number corresponding to their order in the list. 
This denotes the instrument filters for which you can assign key commands on the Key 
Commands page in Preferences.

Rename Instrument Filter  allows you to rename each instrument filter.

The action bar at the bottom of the list contains the following options:

● Add Filter Preset : Adds a new empty instrument filter.

● Duplicate Filter Preset : Creates a copy of an existing instrument filter that you can 
edit separately from the original.

● Add Presets From Instrument Families : Generates an instrument filter for each 
instrument family in the layout automatically, such as woodwind and brass.

● Move Up : Moves the selected instrument filter up the list, which can change its key 
command.

● Move Down : Moves the selected instrument filter down the list, which can change its 
key command.

3 Instruments in filter list

Contains the instruments in the layout. Allows you to change the instruments included in the 
selected instrument filter by activating/deactivating instrument checkboxes.
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Activating/Deactivating instrument filters
You can activate/deactivate instrument filters at any time in each layout independently. For 
example, if you want to show only woodwind staves whilst working on the woodwind section.

PREREQUISITE

● You are in galley view.

● The instrument filter overlay is shown.

● You have added the instrument filters you want to use.

PROCEDURE

1. In Write mode, open the layout in which you want to activate/deactivate instrument filters.

2. In the instrument filter overlay, click Filter .

Filter when activated Filter when deactivated

3. Optional: If you activated instrument filters, select the instrument filter you want to use from 
the menu.

RESULT
Instrument filters are activated/deactivated. When instrument filters are active, dashed lines are 
shown at the vertical positions of hidden staves and you can only select and edit music on visible 
staves.

TIP

● You can also activate/deactivate and select instrument filters from the Write > Instrument 
Visibility menu.

● You can assign a key command for Use Instrument Filter on the Key Commands page in 
Preferences.

● You can assign key commands for up to ten instrument filter presets on the Key Commands 
page in Preferences. The instruments filtered by these commands vary in each layout and 
project.

RELATED LINKS
Switching to galley/page view on page 50
Switching between layouts on page 43
Selecting notes/items on page 421
Editing items on page 430
Arranging tools on page 455
Hiding/Showing empty staves on page 605
Scrubbing on page 542
Key Commands page in the Preferences dialog on page 60
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Adding instrument filters
You can add any number of instrument filters to each layout independently.

PREREQUISITE

● You are in galley view.

● The instrument filter overlay is shown.

PROCEDURE

1. In Write mode, open the layout to which you want to add instrument filters.

2. Select at least one item belonging to each instrument you want to include in the instrument 
filter.

3. In the instrument filter overlay, click Add Instrument Filter .

RESULT
A new instrument filter containing the selected instruments is added to the layout open in the 
music area. Dorico Elements automatically activates instrument filters in the layout and selects 
the new instrument filter.

TIP

● You can also add, edit, and delete instrument filters in the Manage Instrument Filters 
dialog.

● You can assign key commands for up to ten instrument filter presets on the Key Commands 
page in Preferences. The instruments filtered by these commands vary in each layout and 
project.

Renaming instrument filters
You can change the names of instrument filters, and reset renamed instrument filters to their 
default names; for example, to summarize instrument filter contents into a shorter name.

PROCEDURE

1. In Write mode, open the layout whose instrument filters you want to rename.

2. Choose Write > Instrument Visibility > Edit Instrument Filter Presets to open the 
Manage Instrument Filters dialog.

3. Click Rename Instrument Filter  for the instrument filter you want to rename.

4. Rename the instrument filter in any of the following ways:

● Enter a new instrument filter name, or edit the existing name.

● To reset the instrument filter name, delete the existing name.

5. Press Return .

Deleting instrument filters
You can delete instrument filters you no longer need from each layout independently.

PROCEDURE

1. In Write mode, open the layout from which you want to delete instrument filters.
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2. Choose Write > Instrument Visibility > Edit Instrument Filter Presets to open the 
Manage Instrument Filters dialog.

3. Select the instrument filter you want to delete.

4. In the action bar, click Delete Filter Preset .

RESULT
The selected instrument filter is deleted from the layout open in the music area.

Signposts
In Dorico Elements, signposts indicate the positions of important items or changes that cannot 
be seen in the score, such as key signatures with no accidentals, hidden items, and rhythmic feel 
changes.

Signposts have different colors depending on the item they mark because many items can 
show signposts, such as hidden bar numbers and time signatures. They are selectable, meaning 
you can use signposts to change properties of hidden/invisible items; for example, by selecting 
system break signposts in order to change the staff size from that position. Selected signposts 
appear solid, while unselected signposts appear translucent.

Signposts include a text summary of the hidden/invisible item to help you identify it. For 
example, time signature signposts include the time signature, expressed as a fraction, and its 
beat subdivision.

When multiple signposts exist at the same rhythmic position or in close proximity to each other, 
they stack vertically so that they do not overlap and remain legible.

Multiple signposts for different items above the staff, with time signature signposts selected

NOTE

By default, signposts are not printed or included when you export graphics files.

RELATED LINKS
Annotations on page 597

Hiding/Showing signposts
You can hide/show all signposts or only hide/show signposts for specific items at any time in 
Setup, Write, and Engrave modes.
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PROCEDURE

● Hide/Show signposts in any of the following ways:

● To hide/show all signposts, choose View > Signposts > Hide Signposts.

● To hide/show signposts for specific items, choose View > Signposts > [Type of item].

Insert mode
Insert mode changes how notes are input and how edits you make outside of note input affect 
the music. When Insert mode is activated, notes are pushed to subsequent rhythmic positions 
instead of being overwritten if you input new notes or lengthen existing notes. Similarly, deleting 
notes or reducing their duration with Insert mode activated pulls surrounding notes closer 
together without leaving rests between them.

For example, if you input four quarter notes with Insert mode activated, all subsequent notes are 
pushed four quarter note beats back to accommodate the new notes.

Edits outside of note input that are affected by Insert mode include copying/pasting notes, 
deleting notes, changing the duration of notes including by adding/removing rhythm dots, or 
inputting time signatures.

The voices and staves affected by Insert mode depend on the Insert mode scope. The current 
Insert mode scope is indicated in the Notes toolbox and by the caret during note input.

You can set a single rhythmic position in each flow as an Insert mode stop position, which 
prevents any material beyond the stop point being affected by inserted notes. For example, if 
you want to insert notes at the start of a flow but want to preserve material from a specific 
position later in the flow. Stop positions appear as a vertical translucent line that spans all staves.

● You can activate/deactivate Insert mode in Write mode by pressing I  or clicking Insert  in 
the Notes toolbox.

NOTE

You cannot have both Insert mode and Chord mode activated simultaneously.

When Insert mode is not activated, Dorico Elements does not add extra beats before an existing 
time signature if you change a previous time signature. When Insert mode is activated, Dorico 
Elements inserts beats before existing time signatures to fill the final bar.

3/4 time signature input without Insert mode 
activated

3/4 time signature input with Insert mode activated

RELATED LINKS
Inputting notes in Insert mode on page 237
Rhythmic position on page 24
Chord mode on page 254
Caret on page 218
System track on page 425
Inputting notes on page 224
Arranging tools on page 455
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Changing the duration of notes on page 259
Deleting notes/items on page 455
Turning tuplets into normal notes on page 1410

Insert mode scopes
Insert mode has different scopes, from affecting only selected voices to affecting all players and 
changing the duration of the current bar. All scopes apply until the Insert mode stop position or 
the end of the flow, whichever comes first.

You can change the Insert mode scope in Write mode in any of the following ways:

● Press Alt/Opt-I  to cycle through the different Insert mode scopes.

● In the Notes toolbox, click and hold Insert , then click the scope you want.

● Choose Write > Insert Scope > [Scope].

In Dorico Elements, there are the following Insert mode scopes:

Voice

Insert mode only affects the selected voices. During note input, this is the voice 
indicated by the caret indicator. Outside of note input, this includes all selected voices, 
such as when you copy and paste material across multiple staves.

Player

Insert mode affects all voices and instruments belonging to the selected players. 
During note input, dotted lines are shown on staves affected by the Insert mode scope 
across which the caret does not already extend.

Global

Insert mode affects all players in the flow. During note input, dotted lines are shown 
on staves affected by the Insert mode scope across which the caret does not already 
extend.

Global Adjustment of Current Bar

Insert mode affects all players in the flow, changes the duration of the current bar, 
and updates its time signature to reflect its new duration. For example, inputting notes 
extends the duration of bars while deleting notes shortens the duration of bars.

During note input, dotted lines are shown on staves affected by the Insert mode scope 
across which the caret does not already extend.

TIP

You can use the Global Adjustment of Current Bar Insert mode scope to create and 
delete pick-up bars by deleting notes/rests in the first bar in the flow. You can also use 
it to shorten the last bar in flows that start with a pick-up bar.

RELATED LINKS
Caret on page 218
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Arranging tools on page 455
Players on page 123
Voices on page 1438
Time signatures on page 1381
Pick-up bars on page 1386

Changing the Insert mode scope
You can change the Insert mode scope; for example, if you want to switch from inserting notes 
into the selected voice only to inserting rhythmic time for all players.

The current Insert mode scope is indicated in the Notes toolbox and by the caret during note 
input.

PROCEDURE

● In Write mode, change the Insert mode scope in any of the following ways:

● Press Alt/Opt-I  to cycle through the different Insert mode scopes.

● In the Notes toolbox, click and hold Insert , then click the scope you want.

● Choose Write > Insert Scope > [Scope].

RELATED LINKS
Notes toolbox on page 196
Inputting notes in Insert mode on page 237

Setting Insert mode stop positions
You can set a single rhythmic position in each flow as an Insert mode stop position, which 
prevents any material beyond the stop point being affected by inserted notes. For example, if 
you want to insert notes at the start of a flow but want to preserve material from a specific 
position later in the flow.

PROCEDURE

1. In Write mode, select the rhythmic position that you want to be the Insert mode stop 
position in any of the following ways:

● Select an item in the music area.

● In the system track, select the bar whose start barline you want to set as the stop 
position.

2. Set the Insert mode stop position in any of the following ways:

● Press Shift-Alt/Opt-I .

● In the system track, click Set Edit Stop Position .

● Choose Write > Insert Scope > Set Edit Stop Position.

RESULT
The Insert mode stop position for the flow is set at the selected rhythmic position. It appears as a 
vertical translucent line that spans all staves.

Because each flow can only have a single stop position, any existing stop position elsewhere in 
the flow is deleted.
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When Insert mode is activated, existing notes that would otherwise be pushed beyond the stop 
position are deleted.

TIP

You can also move stop positions to barlines by clicking the top handle and dragging to the 
right/left.

EXAMPLE

Insert mode stop position across two piano staves

RELATED LINKS
System track on page 425
Arranging tools on page 455
Inputting notes on page 224

Deleting Insert mode stop positions
You can delete Insert mode stop positions after they have been set.

PROCEDURE

● In Write mode, delete Insert mode stop positions in any of the following ways:

● Select an item at the rhythmic position of the Insert mode stop position and press 
Shift-Alt/Opt-I .

● In the system track, click Set Edit Stop Position  above existing stop positions.

● Click the stop position top handle and drag it in any direction until the mouse pointer is 
outside the music, then release the mouse.
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TIP

When the mouse pointer is in the correct position, the stop position appears as a dotted 
line.

Arranging tools
Arranging tools in Dorico Elements allow you to allocate notes to different staves and voices 
quickly and efficiently.

These tools include copying notes and items to multiple staves at the same time, and multiple 
times within a selected range, moving notes between staves, and changing the voices of notes.

RELATED LINKS
Filters on page 429
Note durations on page 258
Transposing tools on page 468
Selecting notes/items on page 421
Copying and pasting articulations on page 805
Adding notes above/below existing notes on page 258
Repitching notes without changing their rhythm on page 472
Rhythmic grid on page 217
Insert mode on page 451
Chord mode on page 254
Musical transformations on page 477

Deleting notes/items
You can delete any notes/items you have input into your project independently of each other, 
such as deleting repeat endings without deleting the notes in them. However, you must be in 
Write mode. You cannot delete notes and items in Setup, Engrave, or Print modes.

You can also delete notes in the Key Editor, but not other notation items.

PROCEDURE

1. In Write mode, select the notes, items, and/or the signposts of items you want to delete.

NOTE

● You must select barlines directly, not their signposts.

● If you delete some but not all dynamics from a dynamics group that is linked to other 
staves, the selected dynamics are also deleted from all linked staves.

● Deleting only tuplets does not delete the notes within them, and vice versa.

● To select multiple items of the same type, you can use large selections and/or filters.

2. Press Backspace or Delete .

RESULT
All selected notes/items are deleted from your project. Dorico Elements moves your selection to 
the most logical and nearby item to the deleted items. For example, if you deleted a note, Dorico 
Elements’s first choice is the nearest note in the same voice.
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If Insert mode was activated, notes following deleted notes move up to fill the gap. If Insert 
mode was deactivated, deleted notes are replaced by implicit rests as appropriate.

TIP

You can also delete markers by selecting them in the Markers section of the Video panel and 
clicking Delete in the action bar.

If a slur began or ended on a deleted note, the slur is automatically repositioned to the next/
previous notehead. If only one note is left under a slur, the slur is automatically deleted.

Holds and pauses are not automatically deleted if they are not selected when you delete notes. 
They are positioned above the note/rest closest to their rhythmic position, or over whole bar 
rests if you delete all notes in a bar.

Any repeat barlines input as part of repeat endings are not deleted automatically when you 
delete repeat endings.

When you delete barlines, the two bars on either side combine into one bar, containing the same 
number of beats but without changing the time signature. This might cause note, rest, and beam 
groupings to change. Signposts are shown at the start of passages with deleted single barlines.

When you delete time signatures, subsequent bars are re-barred according to the previous time 
signature in the score, up until the next time signature or the end of the flow, whichever comes 
first. Flows without time signatures are notated in an open meter, but notes and items retain 
their duration and positions.

When you delete clefs and key signatures, the pitches of notes are not changed but they are 
automatically notated according to the previous clef and key signature on the staff, such as 
with additional accidentals, up to the next existing one or the end of the flow, whichever comes 
first. Flows without any key signatures are treated as if there were an open/atonal key signature 
rather than A minor or C major.

When you delete octave lines, any notes to which the deleted octave lines previously applied are 
shown at either concert pitch or transposed pitch, depending on your current setting for the 
layout.

If you delete some but not all dynamics in a dynamics group that is linked to other staves, the 
selected dynamics are also deleted from all linked staves. However, if you select and delete the 
whole group of dynamics from a single staff, those dynamics are not deleted from other linked 
staves. Deleting immediate dynamics immediately before/after hairpins can automatically adjust 
the length of hairpins, depending on the context.

When you delete rehearsal marks, any subsequent rehearsal marks are adjusted until the next 
change in the sequence or the end of the flow, whichever comes first. For example, if you delete 
the first rehearsal mark, the second rehearsal mark shows either the letter A, the number 1, or 
the bar number, depending on your choice of sequence type.

Deleting tempo marks also removes them from the Tempo editor and the Tempo track in Play 
mode. The tempo in playback follows the previous tempo mark, or the default tempo of 120 bpm 
if there is no previous tempo mark.

AFTER COMPLETING THIS TASK
If you deleted notes/items because you want to change where they occur, you can input new 
notes/items at the new positions.

RELATED LINKS
Signposts on page 450
Editing items on page 430
Selecting notes/items on page 421
Filters on page 429
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Selecting lyrics using filters on page 1035
Deleting rests on page 1276
Deleting notes in the Key Editor on page 687
Note and rest grouping on page 860
Turning existing notes into tuplets on page 1410
Turning tuplets into normal notes on page 1410
Insert mode on page 451
Insert mode scopes on page 452
Groups of dynamics on page 949
Linked dynamics on page 951
Accidental duration rules on page 800
Changing the rehearsal mark sequence type on page 1218
Hiding/Showing clefs on page 910
Inputting notes on page 224
Notations input on page 271

Copying and pasting notes/items
You can copy and paste items, including notes and notations, to other rhythmic positions and 
staves in different ways.

PREREQUISITE
If you want to use the mouse, you have enabled mouse editing.

PROCEDURE

1. In Write mode, select the notes/items you want to copy.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Copy the selected notes/items to other rhythmic positions in any of the following ways:

● Press Ctrl/Cmd-C , select the position to which you want to paste them, then press Ctrl/
Cmd-V .

● Alt/Opt -click each position to which you want to paste them.

● Alt/Opt -drag notes to the position and staff to which you want to paste them.

When you drag notes, shadow noteheads indicate their destination positions, and the 
affected region appears highlighted with the rhythmic grid shown above it.

● To repeat the material directly after itself, press R .

● To copy notes/items to the staff above, select them and choose Edit > Paste Special > 
Duplicate to Staff Above.

● To copy notes/items to the staff below, select them and choose Edit > Paste Special > 
Duplicate to Staff Below.
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RESULT
The selected notes/items are copied without deleting them from their original positions. By 
default, any MIDI CC points in the copied range are also pasted.

If you copied dynamics or slurs to other staves at the same rhythmic position, they are 
automatically linked by default.

When you copy or move chord symbol regions to other staves, the corresponding players are set 
to show chord symbols.

TIP

You can assign key commands for Duplicate to Staff Above and Duplicate to Staff Below on 
the Key Commands page in Preferences.

RELATED LINKS
Disabling automatic copying of MIDI data when pasting on page 460
Enabling/Disabling mouse editing on page 212
Copying and pasting articulations on page 805
Copying and pasting lyrics on page 1032
Copying and pasting notes in the Key Editor on page 686
Copying and pasting points in the Key Editor on page 676
Copying dynamic points to other instruments on page 699
Copying MIDI points to other instruments on page 705
Rhythmic grid on page 217
Filters on page 429
Large selections on page 424
Selecting/Deselecting notes and items individually on page 421
Moving notes/items to other staves on page 464
Resetting notes crossed to other staves on page 854
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430
Changing the duration of notes on page 259
Splitting notes by duration on page 261
Disabling automatic linking of dynamics and slurs when pasting on page 460
Repitching notes without changing their rhythm on page 472
Hiding/Showing chord symbols on page 878
Key Commands page in the Preferences dialog on page 60
Linked dynamics on page 951
Linked slurs on page 1297
Musical transformations on page 477
Numbered bar regions on page 1253
Insert mode on page 451
Chord mode on page 254

Copying and pasting notes/items to multiple staves
You can copy and paste notes and other items to multiple staves at once; for example, to copy a 
single phrase to all the woodwind staves when they are playing in unison.

PROCEDURE

1. In Write mode, select the notes/items you want to copy to multiple staves.
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TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Press Ctrl/Cmd-C  to copy the selected notes/items.

3. Select an item on each staff to which you want to paste the selected items.

NOTE

The earliest selected item on the top selected staff determines the rhythmic position for 
pasted items on all staves.

4. Press Ctrl/Cmd-V  to paste the selected notes/items.

RESULT
The selected notes/items are copied to all of the selected staves. By default, any MIDI CC points 
in the copied range are also pasted.

If you copied dynamics or slurs to other staves at the same rhythmic position, they are 
automatically linked by default.

When you copy or move chord symbol regions to other staves, the corresponding players are set 
to show chord symbols.

TIP

If you selected a range of notes/items on each staff, the selected notes/items are also pasted 
multiple times to fill the selected range.

RELATED LINKS
Filters on page 429
Large selections on page 424
Disabling automatic copying of MIDI data when pasting on page 460
Linked dynamics on page 951
Linked slurs on page 1297
Resetting notes crossed to other staves on page 854

Copying and pasting notes/items to fill a selected range
You can copy and paste items, including notes and notations, multiple times within a selected 
range at once; for example, if you want to fill multiple bars with the same phrase.

NOTE

You can only copy and paste items that have a duration to fill a selection. For example, you can 
copy and paste gradual dynamics to fill a selection but not immediate dynamics.

PROCEDURE

1. In Write mode, select the notes/items you want to copy throughout a range.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Press Ctrl/Cmd-C  to copy the selected notes/items.
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3. Select the range throughout which you want to paste the selected notes/items.

4. Press Ctrl/Cmd-V  to paste the selected notes/items.

RESULT
The selected notes/items are copied as many times as will fit within the selected range without 
extending beyond it. By default, any MIDI CC points in the copied range are also pasted.

If you copied dynamics or slurs to other staves at the same rhythmic position, they are 
automatically linked by default.

When you copy or move chord symbol regions to other staves, the corresponding players are set 
to show chord symbols.

TIP

If you selected a range on multiple staves, the selected items are also pasted to multiple staves.

RELATED LINKS
Filters on page 429
Large selections on page 424
Splitting notes by duration on page 261

Disabling automatic linking of dynamics and slurs when pasting
By default, dynamics and slurs are automatically linked when you copy them to other staves at 
the same rhythmic position. You can disable this behavior so dynamics and slurs are not linked 
by default.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Editing section, deactivate Link dynamics and slurs to existing items when 
pasting.

4. Click Apply, then Close.

RELATED LINKS
Preferences dialog on page 58
Linked dynamics on page 951
Linked slurs on page 1297

Disabling automatic copying of MIDI data when pasting
By default, all MIDI CC, MIDI pitch bend, and dynamic points are copied when you copy the notes 
to which they apply. You can disable this behavior for all future projects on your computer.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, deactivate Include MIDI CC, pitch bend and dynamics from Key 
Editor when copying music.
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4. Click Apply, then Close.

RELATED LINKS
Preferences dialog on page 58
Copying and pasting notes/items on page 457
Copying and pasting notes in the Key Editor on page 686

Moving notes/items rhythmically
You can move notes and items to new rhythmic positions to the right/left along staves after they 
have been input. For example, if you want a cresc. dynamic to start a beat later. You can also 
move individual dynamics and playing techniques within a group.

NOTE

● These steps do not apply to the following items: barlines, notehead brackets, glissando lines, 
notehead-attached horizontal lines, fingerings and fingering slides, jazz articulations, guitar 
bends, vibrato bar dives/returns, pedal retakes, and tremolo strokes. If you want to change 
the rhythmic positions of these items, you must delete them from their original positions 
and input new ones at the new positions.

We recommend deleting and inputting new arpeggio signs and vertical lines rather than 
moving them. If you move arpeggio signs and vertical lines to the rhythmic position of a rest, 
they are deleted.

● Because markers have a fixed position in time, moving markers relative to the notated music 
automatically changes the tempo on either side of the marker. If you want to move a marker 
to a new time position, you must change the timecode of the marker; for example, if you 
want to move it from 25 seconds to 28 seconds.

PREREQUISITE

● You have chosen the appropriate rhythmic grid resolution.

● If you want to use the mouse, you have enabled mouse editing.

PROCEDURE

1. In Write mode, select the notes, items, or signposts that you want to move.

NOTE

● If you want tuplet notes to remain tuplets, you must also select their tuplet numbers/
ratios, brackets, or tuplet signposts, otherwise notes become normal notes of their 
rhythmic value when you move them beyond the boundaries of tuplets.

● You can only move a single slur, marker, repeat ending, or bar repeat region at a time.

● When using the mouse, you can only move a single item at a time.

● You cannot move the following items using the mouse: tuplets, lyrics, slash regions, time 
signatures, arpeggio signs, and vertical lines.

● You can only select clefs that you have input. You cannot select initial clefs at the start of 
flows or clefs shown automatically at the start of each system.

● To move a single dynamic within a group, you must click and drag it with the mouse. If 
you use the key commands, the whole group is moved.

● Moving multiple playing techniques or dynamics in the same group at the same time 
ungroups them.
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2. Optional: If you selected notes and do not want them to overwrite existing notes they pass 
over as part of their move, activate one of the following:

● If you want the selected notes to overlap with existing notes, activate Chord mode by 
pressing Q  or clicking Chords  in the Notes toolbox.

● If you want the selected notes to move through existing notes, activate Insert mode in 
Write mode by pressing I  or clicking Insert  in the Notes toolbox.

NOTE

Moving notes rhythmically with Insert mode activated can affect the durations of 
existing notes the selected notes move through.

3. Move the notes, items, and/or signposts in any of the following ways:

● To move them to the right, press Alt/Opt-Right Arrow .

● To move them to the left, press Alt/Opt-Left Arrow .

NOTE

Most items move according to the current rhythmic grid resolution. A single selection 
of the following items moves to adjacent noteheads, bars, or barlines: ornaments, slurs, 
horizontal lines, octave lines, pedal lines, rehearsal marks, repeat endings, and bar 
repeat regions.

● To move items to the right according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Right Arrow .

● To move items to the left according to the current rhythmic grid resolution, press Ctrl/
Cmd-Alt/Opt-Left Arrow .

● Click and drag them to the right/left.

When you drag notes, shadow noteheads indicate their destination positions, and the 
affected region appears highlighted with the rhythmic grid shown above it.

NOTE

The following items move to adjacent noteheads, bars, or barlines: ornaments, slurs, 
horizontal lines, octave lines, pedal lines, rehearsal marks, repeat endings, and bar 
repeat regions.

RESULT
The selected notes, items, and/or signposts are moved to new rhythmic positions. Attachment 
lines link items to the rhythmic positions to which they apply.

Most items move according to the current rhythmic grid resolution. However, a single selection 
of some items automatically moves to adjacent noteheads, bars, or barlines. When multiple 
items are selected, they move as a block according to the current rhythmic grid resolution.
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NOTE

Only a single instance of many items, such as tempo marks and clefs, can exist at each rhythmic 
position on each staff. If an item passes over another item of the same type as part of its move, 
the existing item is deleted or shortened accordingly.

You can undo this action, but any items deleted in the process are only restored if you moved 
items using the keyboard.

Items that can have multiple instances at the same rhythmic position on the same staff include 
dynamics, octave lines, playing techniques, horizontal lines, slash regions, and text items. 
However, if you move multiple items together, any existing items of the same type between the 
selected items or that they pass over as part of the move are deleted or shortened accordingly 
unless Insert mode is activated.

Notes are automatically positioned according to their rhythmic duration and position relative to 
other notes.

If a tuplet number/ratio or tuplet bracket is included in the selection, the whole tuplet is moved 
along the staff. If it crosses a barline, the tuplet is automatically adjusted to compensate. 
However, tuplets are not automatically adjusted at the mid-point of bars, where it is convention 
to split tuplets to show the beat division. You must enter two tuplets manually to show the beat 
division at the mid-point of bars.

Items such as clefs, key signatures, and time signatures take effect from their new positions until 
the next item of the same type or the end of the flow, whichever comes first. Barlines on either 
side of a moved time signature are automatically updated up to the previous/next existing time 
signature, or the start/end of the flow.

If you moved divisi change signposts, any music on divisi staves outside of divisi passages 
is automatically hidden, and any unison ranges before/after divisi passages are automatically 
updated.

If you moved harp pedal diagrams and colors are shown for notes out of range, any notes that 
no longer fit with the prevailing harp pedal diagram appear red.

The position of holds and pauses you have moved might not appear to change. For example, if 
one staff has a bar rest and you move a fermata rhythmically within the bar, the fermata still 
appears above the bar rest.

The rhythmic duration of slurs is usually maintained. However, depending on the rhythms they 
cross as they move, slurs may cover longer/shorter durations than before the move.

Moving repeat endings does not automatically input, delete, or move repeat barlines.

When you move markers, their fixed position in time is not changed. Therefore, the tempo 
immediately preceding the marker automatically updates so that the marker occurs at the 
correct time. For example, moving a marker to the right increases the preceding tempo. Any 
gradual tempo changes between the preceding tempo change or the start of the flow and the 
marker are removed. The tempo change affects the positions of all other markers in the flow 
relative to the notated music.

RELATED LINKS
Rhythmic grid on page 217
Enabling/Disabling mouse editing on page 212
Hiding/Showing attachment lines on page 437
Notes toolbox on page 196
Note spacing on page 507
Chord mode on page 254
Insert mode on page 451
Note and rest grouping on page 860
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Tuplet brackets on page 1413
Tuplet numbers/ratios on page 1416
Changing the duration of notes on page 259
Lengthening/Shortening items on page 430
Changing the staff-relative placement of items on page 434
Moving notes/items to other staves on page 464
Creating cross-staff beams/tremolos on page 851
Moving figured bass resolutions on page 966
Moving the center of messa di voce hairpins on page 945
Splitting pedal lines on page 1169
Moving items graphically on page 514
Hiding/Showing colors for notes out of range on page 1064
Groups of dynamics on page 949
Groups of playing techniques on page 1191
Deleting notes/items on page 455
Input methods for lines on page 385
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340
Input methods for guitar bends and guitar techniques on page 353
Input methods for clefs and octave lines on page 329
Input methods for repeats and tremolos on page 405
Adding retakes with the popover on page 377
Adding retakes with the panel on page 378
Inputting fingerings on page 274
Hiding/Showing fingering slides on page 988
Showing brackets on noteheads on page 1067
Changing the timecodes of markers on page 1224

Moving notes/items to other staves
You can move notes and items to other staves of any type; for example, if you want to move 
individual notes from one keyboard staff to another after importing a keyboard part from a MIDI 
file.

NOTE

● These steps do not apply to pedal lines or system objects.

● If you want notes to appear on a different staff but remain attached to their original staff, 
such as to create a cross-staff beam, you can cross notes to other staves instead.

PREREQUISITE
If you want to use the mouse, you have enabled mouse editing.

PROCEDURE

1. In Write mode, select the notes and/or items you want to move to another staff.

TIP

To select multiple items of the same type, you can use large selections and/or filters.

2. Move the selected notes/items another staff in one of the following ways:

● To move them to the staff above, press Alt/Opt-N .

● To move them to the staff below, press Alt/Opt-M .

● Click and drag notes to other staves.
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When you drag notes, shadow noteheads indicate their destination positions, and the 
affected region appears highlighted with the rhythmic grid shown above it.

● Choose Edit > Paste Special > Move to Staff Above.

● Choose Edit > Paste Special > Move to Staff Below.

TIP

You can also choose these options from the context menu.

RESULT
The selected notes and/or items are moved to another staff by cutting them from their original 
staff and pasting them to the new staff. By default, notes are pasted into the first voice active on 
that staff.

Notes within tuplets remain tuplets even if you did not select the tuplet bracket, tuplet number/
ratio, or tuplet signpost.

When you copy or move chord symbol regions to other staves, the corresponding players are set 
to show chord symbols.

RELATED LINKS
Filters on page 429
Large selections on page 424
Rhythmic grid on page 217
Enabling/Disabling mouse editing on page 212
Creating cross-staff beams/tremolos on page 851
Moving notes/items rhythmically on page 461
Copying and pasting notes/items to multiple staves on page 458
Changing the duration of notes on page 259
Changing the pitch of individual notes on page 468
Changing the positions of system objects on page 1327
Hiding/Showing chord symbols on page 878
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367

Moving notes to other instruments in percussion kits
You can move notes to different instruments in the same percussion kit after they have been 
input.

NOTE

These steps do not apply in layouts using the single-line instruments kit presentation type. In 
such layouts, you can cross or move notes to other staves.
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PROCEDURE

1. In Write mode, select the notes you want to move to a different instrument in the percussion 
kit.

2. Move the notes to another instrument in any of the following ways:

● To move them to the instrument above, press Alt/Opt-Up Arrow .

● To move them to the instrument below, press Alt/Opt-Down Arrow .

AFTER COMPLETING THIS TASK
You can change the position of each instrument in the kit.

RELATED LINKS
Moving instruments in percussion kits on page 149
Changing playing technique-specific noteheads on page 1424
Percussion kit presentation types on page 1428
Creating cross-staff beams/tremolos on page 851

Changing the voice of existing notes
You can change the voice of notes after they have been input, including notes in slash voices. For 
example, you can change notes in an up-stem voice to a down-stem voice or a slash voice.

PROCEDURE

1. In Write mode, select the notes whose voice you want to change.

TIP

You can use large selections and filters to select many notes in the same voice quickly.

2. Change the voice in any of the following ways:

● To change the selected notes to a new normal voice, press Shift-V  or click Create Voice 
 in the Notes toolbox.

● To change the selected notes to a new slash voice, press Shift-Alt/Opt-V . You can also 
click and hold Create Voice  in the Notes toolbox, then click Create Slash Voice .

● To change the selected notes to an existing voice, press V  or click Next Voice  in the 
Notes toolbox to cycle through active voices on the staff.

RESULT
The voice of the selected notes is changed, which might cause Dorico Elements to change the 
stem directions of the selected notes and other notes on the staff. Rests appear as required 
around notes in different voices.

By default, notes in slash voices are not played back. However, if you include slash voices in 
playback, notes in slash voices play back with their input pitch.

TIP

You can also change the voice of selected notes by choosing Edit > Notations > Voices > Change 
Voice > [Voice]. You can also choose these options from the context menu. If there is only one 
voice on the staff, you can create a new voice for your selected notes.
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AFTER COMPLETING THIS TASK

● You can later delete or hide rests and change the stem direction of notes manually.

● You can also change whole voices into slash voices.

RELATED LINKS
Notes toolbox on page 196
Hiding/Showing voice colors on page 1439
Inputting notes into multiple voices on page 232
Inputting notes into slash voices on page 233
Large selections on page 424
Filters on page 429
Implicit rests in multiple-voice contexts on page 1273
Deleting rests on page 1276
Changing the stem direction of notes on page 1076
Changing the slash voice type on page 1259
Changing the duration of notes on page 259
Tuplets on page 1408
Signposts on page 450

Swapping the contents of voices
You can swap the contents of two voices that contain musical material.

PROCEDURE

1. In Write mode, select the notes in two voices that you want to swap.

2. Choose Edit > Notations > Voices > Swap Voice Contents. You can also choose this option 
from the context menu.

RESULT
The contents of the voices are swapped. For example, the notes previously in an up-stem voice 
are now in a down-stem voice, and the notes previously in a down-stem voice are now in an 
up-stem voice.

NOTE

Depending on the pitches involved in the swap and their stem directions, the notes might 
overlap. Dorico Elements automatically positions notes with the noteheads partially overlapping, 
in order to minimize the horizontal space they occupy and maintain the clarity of the rhythm. 
However, if you want to change this arrangement, you can change the order of voices or change 
the voice column index.

EXAMPLE

An E is in the up-stem voice, an F in the down-stem 
voice.

After swapping their voice contents, the E is in the 
down-stem voice, and the F is in the up-stem voice.

Write mode
Arranging tools 

467
Dorico Elements 5.1.30



RELATED LINKS
Swapping the order of voices on page 1442
Voice column index on page 1442

Transposing tools
In Dorico Elements, you can change the pitches of existing notes in a variety of ways.

RELATED LINKS
Arranging tools on page 455
Transposing instruments on page 132
Concert vs. transposed pitch on page 178
Transposing notes in the piano roll editor on page 685

Changing the pitch of individual notes
You can raise/lower the pitch and register of individual notes, including grace notes, after they 
have been input by octave divisions, staff position, and octaves.

PREREQUISITE
If you want to use the mouse, you have enabled mouse editing.

PROCEDURE

1. In Write mode, select the notes whose pitches you want to change.

2. Raise/Lower the pitches of the selected notes in any of the following ways:

● To move notes up one staff position, such as from C to D, press Alt/Opt-Up Arrow .

● To move notes down one staff position, such as from D to C, press Alt/Opt-
Down Arrow .

● To transpose notes up a single octave division, such as a half-step (semitone) in 12-EDO 
or a quarter tone in 24-EDO, press Shift-Alt/Opt-Up Arrow .

● To transpose notes down a single octave division, such as a half-step (semitone) in 
12-EDO or a quarter tone in 24-EDO, press Shift-Alt/Opt-Down Arrow .

● To transpose notes up an octave, press Ctrl/Cmd-Alt/Opt-Up Arrow .

● To transpose notes down an octave, press Ctrl/Cmd-Alt/Opt-Down Arrow .

● To transpose notes up/down by staff position, click and drag notes upwards/downwards.

● To transpose notes up/down by octave division, start dragging notes upwards/
downwards, then press and hold Shift .

● To transpose notes up/down by octaves, start dragging notes upwards/downwards, then 
press and hold Ctrl/Cmd .

When you drag notes, shadow noteheads indicate their destination pitches, and the 
affected region appears highlighted with the rhythmic grid shown above it.
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RESULT
The pitch or register of the selected notes is changed. Any figured bass shown on the affected 
staves is updated automatically.

If the pitch is now impossible to play on a fretted instrument, such as if a note would have to be 
played below the nut on the lowest string, it appears on tablature as a question mark.

NOTE

You can press Alt/Opt-Up Arrow  and Alt/Opt-Down Arrow  to change the staff positions of 
notes in percussion kits using grid and five-line staff presentation types. However, this also 
changes the instrument playing the note.

RELATED LINKS
Equal Division of the Octave (EDO) on page 1028
Adding notes above/below existing notes on page 258
Respelling notes on page 473
Inputting accidentals on page 244
Transposing notes in the piano roll editor on page 685
Enabling/Disabling mouse editing on page 212
Rhythmic grid on page 217
Figured bass on page 957
Arranging tools on page 455
Musical transformations on page 477
Inverting pitches on page 478
Reversing pitches/rhythms on page 478
Rotating pitches/rhythms on page 480
Mapping notes to pitches on page 482
Mapping notes to scales on page 484

Transposing selections
You can transpose whole flows or specific selections, including selected key signatures, using the 
Transpose dialog.

TIP

Dorico Elements automatically shows the appropriate key signatures for transposing instruments 
in transposing layouts.

PROCEDURE

1. Optional: In Write mode, select the region you want to transpose.

NOTE

● To transpose key signatures, chord symbols, or figured bass, you must include them in 
your selection.

● If nothing is selected, the whole flow in which you last selected a note/item is 
transposed.

2. Choose Write > Transpose to open the Transpose dialog.

3. Adjust the parameters required for your transposition, such as interval and quality.
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TIP

● We recommend using the Calculate interval section to determine your required 
settings; for example, if you want to transpose from G♭ major to G major.

● Different intervals have different possible qualities. For example, you can specify a major 
third but not a major octave. Therefore, if you want to set your transposition parameters 
manually, we recommend selecting the interval before the quality.

4. Optional: If you want to transpose any key signatures in the flow or included in your 
selection, activate Transpose key signatures.

5. Click OK to save your changes and close the dialog.

RESULT
All notes in your selection, or all notes in the flow if nothing was selected, are transposed 
according to the interval or number of divisions of the octave specified in the Transpose dialog.

If your selection included key signatures and you activated Transpose key signatures, all key 
signatures in the selection are also transposed.

Any figured bass shown on the affected staves is also transposed accordingly.

Key signatures that apply to all staves are transposed on all staves in the layout, even if your 
selection did not include all staves. Key signatures that apply only to single staves are transposed 
if they are included in a selection, but this does not affect any other staff in the layout.

RELATED LINKS
Large selections on page 424
System track on page 425
Figured bass on page 957
Enharmonic equivalent key signatures on page 1025
Concert vs. transposed pitch on page 178

Transpose dialog
The Transpose dialog allows you to transpose whole flows or selections of notes, including key 
signatures. You can transpose according to an interval and quality or by a set number of octave 
divisions.

● You can open the Transpose dialog in Write mode by choosing Write > Transpose.
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The Transpose dialog contains the following sections:

1 Transposition options

Contains options that allow you to specify the transposition you want. For example, you can 
choose to transpose by an interval quality, such as a major third, or by a set number of 
divisions of the octave. You can choose the direction of the transposition, whether it includes 
octaves, and the interval and quality or number of divisions by which you want to transpose 
your selection.

According to convention, different intervals have different possible qualities. For example, 
you can specify a major third but not a major octave. Therefore, we recommend selecting 
the interval before the quality.

Additional options also allow you to transpose any key signatures included in your selection, 
keep relative respelled notes and chord symbols where possible, and avoid double and triple 
accidentals.

NOTE

You can only use Respell to avoid double and triple sharps and flats when transposing 
music in tonality systems that are compatible with 12-EDO.

2 Calculate interval

Allows you to set transposition options according to a starting note and the resulting note 
you want. For example, if you want to transpose a selection relative to a C♮ becoming a G♯ but 
you are not certain of the interval and quality required, you can enter those two notes in the 
Calculate interval section, click Apply, and Dorico Elements automatically sets the required 
transposition options for you.

NOTE

The Transpose dialog does not allow transpositions that would result in impossible notations, 
such as sharper than a triple sharp, or that require a microtonal accidental that does not exist in 
the tonality system in place at the position of your selection.
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RELATED LINKS
Note tools popover on page 487
Equal Division of the Octave (EDO) on page 1028
Tonality systems on page 1028
Arranging tools on page 455
Musical transformations on page 477
Mapping notes to pitches on page 482
Mapping notes to scales on page 484

Transposing existing notes with the note tools popover
You can change the pitch of notes after they have been input using the note tools popover.

PROCEDURE

1. In Write mode, select the notes you want to transpose.

2. Open the note tools popover in any of the following ways:

● Press Shift-I .

● In the Notations toolbox, click Popovers , then Note Tools .

3. Enter the transposition interval you want into the popover.

For example, enter t3 to transpose the notes up a third, or t-min6 to transpose the notes 
down a minor sixth.

4. Press Return  to close the popover.

RESULT
The selected notes are transposed by the degree specified. Any figured bass shown on the 
affected staves is also transposed accordingly.

RELATED LINKS
Notations toolbox on page 201
Note tools popover on page 487
Figured bass on page 957

Repitching notes without changing their rhythm
You can repitch notes after you have input them while keeping their durations the same. For 
example, if you want to duplicate the rhythm but have different pitches.

PROCEDURE

1. In Write mode, select the first note you want to repitch.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Optional: If you want to repitch notes on multiple staves at once, extend the caret to those 
staves.

4. Activate Lock Duration in any of the following ways:

● Press L .
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● In the Notes toolbox, click Lock Duration .

5. Enter the pitches you want.

6. Optional: Press L  or click Lock Duration  again to deactivate Lock Duration.

NOTE

Lock Duration automatically deactivates when you reach the last existing note on the staff. 
By default, normal note input continues using the previous note value selected before you 
activated Lock Duration.

RESULT
Existing notes on the selected staff are repitched without their rhythms being changed. The caret 
automatically advances from note to note, even if there are large rests between notes on the 
staff.

TIP

You can set a maximum number of rests over which you want to advance when repitching notes 
in Preferences > Note Input and Editing > Note Input > Lock Duration.

RELATED LINKS
Caret on page 218
Extending the caret to multiple staves on page 222
Arranging tools on page 455
Musical transformations on page 477
Mapping notes to pitches on page 482
Mapping notes to scales on page 484
Copying and pasting articulations on page 805
Preferences dialog on page 58

Respelling notes
You can change the enharmonic spelling of notes so they are shown as their enharmonic 
equivalents; for example, to show the stepwise movement in a phrase clearly, or to avoid altered 
unisons in a chord. You can do this for all layouts or only in the current part layout.

By default, Dorico Elements uses an algorithm that automatically decides the spelling of pitches, 
based on key signature and context.

There are always at least three options for every pitch, as Dorico Elements allows enharmonic 
spellings to show up to two accidental glyphs. This means the same note can be spelled four 
ways if the original pitch can be spelled with the note name either two notes below or two notes 
above, using a maximum of two accidental glyphs. For example, B is a possible enharmonic 
spelling of G♯ because a triple-flat uses a single accidental glyph, whereas an F♯ uses two 
accidental glyphs.

PROCEDURE

1. In the music area, open the layout in which you want to respell accidentals. You can do this 
in Write mode and Engrave mode.
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NOTE

By default, respelling notes in score layouts also affects their spelling in all other layouts, but 
respelling notes in part layouts only affects their spelling in the current part layout.

2. Select the notes you want to respell.

NOTE

If you want to respell individual noteheads in tie chains, you must be in Engrave mode.

3. Respell the selected notes in any of the following ways:

● To respell them upwards, press Alt/Opt-=  or click Respell Using Note Name Above 
in the Keyboard panel toolbar.

● To respell them downwards, press Alt/Opt--  or click Respell Using Note Name Below 
 in the Keyboard panel toolbar.

● To respell them automatically, choose Write > Respell > Respell Notes Automatically 
to open the Respell Notes Automatically dialog.

4. Optional: If you opened the Respell Notes Automatically dialog, change the settings for 
respelling as required, then click OK to close the dialog and respell the selected notes.

RESULT
The enharmonic spelling of the selected notes is changed.

EXAMPLE

A G sharp When respelled 
downwards, the G sharp 
becomes an F triple-
sharp

When respelled upwards, 
the G sharp becomes an 
A flat

When respelled upwards 
again, the G sharp 
becomes a B triple-flat

AFTER COMPLETING THIS TASK
You can copy note spellings to other layouts, such as if you respelled notes in a part layout but 
want the same spelling to appear in the full score layout.

RELATED LINKS
Keyboard panel on page 206
Switching between layouts on page 43
Selecting notes/items on page 421
Accidentals on page 792
Inputting accidentals on page 244
Accidental selection during MIDI input on page 245
Key signatures on page 1019
Tonality systems on page 1028
Input methods for key signatures on page 278
Mapping notes to pitches on page 482
Mapping notes to scales on page 484
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Respell Notes Automatically dialog
The Respell Notes Automatically dialog allows you to simplify the note spelling of all notes in 
specific selections based on the musical context, including respelling some notes upwards and 
other notes downwards.

● You can open the Respell Notes Automatically dialog in Write mode when at least one note 
is selected in the music area by choosing Write > Respell > Respell Notes Automatically.

The Respell Notes Automatically dialog contains the following options:

Additional context at start
Allows you to specify additional musical context before the selected notes that you 
want Dorico Elements to consider when calculating automatic note spellings.

● None: Only notes in the selection.

● To start of bar: Includes notes back to the start of the earliest selected bar.

● Previous bar: Includes notes back to the start of the previous bar.

● Previous notes: Includes a specified number of notes before the selection.

● Number of additional notes: Allows you to specify the number of additional notes 
you want to consider. Only available if you have activated Previous notes.

Additional context at end
Allows you to specify additional musical context after the selected notes that you want 
Dorico Elements to consider when calculating automatic note spellings.

● None: Only notes in the selection.

● To end of bar: Includes notes up to the end of the last selected bar.

● Next bar: Includes notes up to the end of the next bar.

● Following notes: Includes a specified number of notes after the selection.

● Number of additional notes: Allows you to specify the number of additional notes 
you want to consider. Only available if you have activated Following notes.

Write mode
Transposing tools 

475
Dorico Elements 5.1.30



Prefer accidentals used most in this flow
Allows you to specify whether to choose accidentals based on how frequently they are 
used in the flow or the default accidental for the corresponding pitch delta. Useful in 
tonality systems that contain multiple accidentals with the same pitch delta.

Preserve accidentals on unchanged pitches
Allows you to specify whether existing accidentals on notes that are not respelled are 
retained or chosen according to your setting for Prefer accidentals used most in this 
flow. Useful in tonality systems that contain multiple accidentals with the same pitch 
delta.

RELATED LINKS
Selecting notes/items on page 421
Respelling notes on page 473
Changing the pitch of individual notes on page 468
Inputting accidentals on page 244
Accidental selection during MIDI input on page 245
Tonality systems on page 1028

Copying note spellings to other layouts
You can copy note spellings to other layouts; for example, if you originally respelled notes in a 
part layout but want those spellings to appear in the full score layout as well.

PROCEDURE

1. In Write mode, open the layout containing the note spellings you want to copy.

2. Select the notes you want to respell.

3. Choose Write > Respell > Propagate Note Spellings.

RESULT
The spellings of the selected notes in the current layout are copied to all other layouts in which 
those notes appear.

RELATED LINKS
Switching between layouts on page 43
Part formatting propagation on page 643

Resetting note spellings
You can reset changes to note spellings so they follow the spelling in score layouts; for example, 
if you want future revisions to note spellings you make in the full score layout to affect notes 
whose spelling you previously overrode in a part layout. You can do this in either one part layout 
only or in all layouts.

PROCEDURE

1. Optional: If you want to reset note spellings in one part layout only, open that layout in the 
music area.

2. In Write mode, select the notes whose spellings you want to reset.

3. Reset their note spellings in one of the following ways:

● Choose Write > Respell > Reset Note Spellings in Current Layout.

● Choose Write > Respell > Reset Note Spellings in All Layouts.
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RESULT
The spellings of the selected notes are reset either in the current part layout only or in all layouts. 
Their link to the score note spelling is restored, meaning all future changes you make to the 
spelling of the selected notes in score layouts also affect their spelling in either the current part 
layout or all layouts.

RELATED LINKS
Switching between layouts on page 43
Respelling notes on page 473
Transposing selections on page 469

Musical transformations
Dorico Elements provides multiple tools for transforming pitches and rhythms, including 
reversing and inverting pitches and rotating rhythms.

In Dorico Elements, the term “musical transformations” covers the following methods of 
changing the pitch and/or rhythm of notes:

Inversion
The melodic contours of phrases are switched upside-down by forcing pitch intervals 
between notes in the opposite direction, such as a note originally a fifth above the 
previous note becoming a fifth below the previous note.

Reversal
The order of notes, including pitches and/or rhythms, and items is reversed so they are 
played backwards; for example, the first note of a phrase becoming the last note. Also 
known as “retrograde”.

Rotation
Notes, including pitches and/or rhythms, and items are shifted along by a specified 
number of steps either forwards or backwards, so that, for example, the first note in a 
phrase’s original pitch is given to the second note, the second note’s pitch to the third 
note, and so on.

Repetition
The pitches of the specified number of notes at the start of a phrase is repeated across 
all subsequent notes in the selection.

Pitch mapping
Specified pitches are transposed to become other specified pitches, such as mapping 
all C♯s to D♭s.

Scale mapping
All notes in the specified source scale are transposed to become the equivalent notes 
in the destination scale according to their scale degree.

RELATED LINKS
Arranging tools on page 455
Note tools popover on page 487
Adding notes above/below existing notes on page 258
Transposing existing notes with the note tools popover on page 472
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Inverting pitches
You can invert the pitches of selected notes, which switches the melodic contour of phrases 
upside-down by forcing pitch intervals between notes in the opposite direction, such as a 
note originally a fifth above the previous note becoming a fifth below the previous note. This 
transformation is also known as “inversion”.

PROCEDURE

1. In Write mode, select the notes you want to invert.

2. Do one of the following:

● To invert pitches only, choose Write > Transform > Pitches > Invert Pitches to open the 
Invert Pitches dialog.

● To invert and reverse pitches, choose Write > Transform > Pitches > Reverse and 
Invert Pitches to open the Reverse and Invert Pitches dialog.

● To invert and reverse pitches and reverse rhythms, choose Write > Transform > All > 
Reverse and Invert Pitches and Reverse Rhythms to open the Reverse and Invert 
Pitches and Reverse Rhythms dialog.

3. Change the settings as required for your inversion.

4. Click OK to save your changes and close the dialog.

RESULT
The selected notes are transformed according to your initial menu selection and your settings in 
the dialog.

TIP

You can also invert pitches using the note tools popover.

RELATED LINKS
Reverse and Invert Pitches and Reverse Rhythms dialogs on page 479
Note tools popover on page 487
Large selections on page 424
Arranging tools on page 455
Inputting notes on page 224

Reversing pitches/rhythms
You can reverse notes, including pitches and/or rhythms, and staff-attached items so that 
selections are played backwards; for example, the first note of a phrase becomes the last note. 
This transformation is also known as “retrograde”.

PROCEDURE

1. In Write mode, select the notes and staff-attached items whose pitches and/or rhythms you 
want to reverse.

For example, to reverse dynamics alongside notes, include dynamics in your selection.

2. Do one of the following:

● To reverse pitches only, choose Write > Transform > Pitches > Reverse Pitches.

● To reverse rhythms only, choose Write > Transform > Rhythm > Reverse Rhythms.
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● To reverse pitches and rhythms, choose Write > Transform > All > Reverse Pitches and 
Rhythms.

● To reverse and invert pitches, choose Write > Transform > Pitches > Reverse and 
Invert Pitches to open the Reverse and Invert Pitches dialog.

● To reverse and invert pitches and reverse rhythms, choose Write > Transform > All > 
Reverse and Invert Pitches and Reverse Rhythms to open the Reverse and Invert 
Pitches and Reverse Rhythms dialog.

3. Optional: If you chose to reverse and invert pitches, change the settings as required for your 
inversion.

4. Click OK to save your changes and close the dialog.

RESULT
The selected notes and staff-attached items are transformed according to your initial menu 
selection and optionally your settings in the dialog.

TIP

You can also reverse pitches/rhythms using the note tools popover.

Reverse and Invert Pitches and Reverse Rhythms dialogs
The Invert Pitches, Reverse and Invert Pitches, and Reverse and Invert Pitches and Reverse 
Rhythms dialogs allow you to invert and reverse the pitches and reverse the rhythms of selected 
notes. These transformations are also known as “inversion” and “retrograde inversion”.

You can open these dialogs in Write mode when at least one note is selected in the music area in 
the following ways:

● To open the Invert Pitches dialog, choose Write > Transform > Pitches > Invert Pitches.

● To open the Reverse and Invert Pitches dialog, choose Write > Transform > Pitches > 
Reverse and Invert Pitches.

● To open the Reverse and Invert Pitches and Reverse Rhythms dialog, choose Write > 
Transform > All > Reverse and Invert Pitches and Reverse Rhythms.

The dialogs contain the following options:

Invert using
Allows you to change the inversion behavior.

● Outermost pitches: Inverts pitches within the range of the highest and lowest 
notes in the selection.

Write mode
Musical transformations 

479
Dorico Elements 5.1.30



● Specific pitch: Inverts pitches around the specified pitch.

● Root: Inverts pitches around the root of the prevailing key. In open keys or music 
without key signatures, C is used.

● First note: Inverts pitches around the first note in the selection.

Inversion type
Allows you to change how intervals are handled in the inversion.

● Diatonic: Inversions use the interval degree, according to the scale degrees in 
the prevailing key signature. Diatonic inversions preserve the interval relationship 
between pitches, which can result in, for example, a minor second interval below 
becoming a major second interval above.

● Chromatic: Inversions use the specified number of half-steps (semitones), 
regardless of the prevailing key signature.

Not available when Outermost pitches is chosen for Invert using.

Specific pitch
Allows you to specify the central pitch for inversion. You can select the note name, 
accidental, and octave, according to your middle C numbering convention setting. The 
available accidentals depend on the prevailing tonality system.

Only available when Specific pitch is chosen for Invert using.

When first note is a chord, use
Allows you to specify which pitch to use as the central pitch for inversion when the first 
note is part of a chord.

● Top note of chord: The highest note in the chord is used.

● Bottom note of chord: The lowest note in the chord is used.

Only available when First note is chosen for Invert using.

RELATED LINKS
Tonality systems on page 1028
Changing the middle C numbering convention on page 51

Rotating pitches/rhythms
You can rotate notes, including pitches and/or rhythms, and staff-attached items by a specified 
number of steps either forwards or backwards, so that, for example, the first note in a phrase’s 
original pitch is given to the second note, the second note’s pitch to the third note, and so on.

PROCEDURE

1. In Write mode, select the notes and staff-attached items whose pitches and/or rhythms you 
want to rotate.

For example, to rotate dynamics alongside notes, include dynamics in your selection.

2. Do one of the following:

● To rotate pitches only, choose Write > Transform > Pitches > Rotate Pitches to open 
the Rotate Pitches dialog.

● To rotate rhythms only, choose Write > Transform > Rhythm > Rotate Rhythms to 
open the Rotate Rhythms dialog.

● To rotate pitches and rhythms, choose Write > Transform > All > Rotate Pitches and 
Rhythms to open the Rotate Pitches and Rhythms dialog.
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3. Change the settings as required for your rotation.

4. Click OK to save your changes and close the dialog.

RESULT
The selected notes and staff-attached items are rotated according to your settings in the dialog.

TIP

You can also rotate pitches/rhythms using the note tools popover.

RELATED LINKS
Note tools popover on page 487
Large selections on page 424
Arranging tools on page 455
Inputting notes on page 224

Rotate Pitches/Rhythms dialogs
The Rotate Pitches, Rotate Rhythms, and Rotate Pitches and Rhythms dialogs allow you to 
rotate the pitches and/or rhythms of selected notes.

You can open these dialogs in Write mode when at least one note is selected in the music area in 
the following ways:

● To open the Rotate Pitches dialog, choose Write > Transform > Pitches > Rotate Pitches.

● To open the Rotate Rhythms dialog, choose Write > Transform > Rhythm > Rotate 
Rhythms.

● To open the Rotate Pitches and Rhythms dialog, choose Write > Transform > All > Rotate 
Pitches and Rhythms.

The dialogs contain the following options:

Number of steps
Allows you to set the number of steps in the rotation.

Direction
Allows you to set the rotation direction.

● Forwards: Rotates forwards; that is, pitches/rhythms shift to the right.

● Backwards: Rotates backwards; that is, pitches/rhythms shift to the left.
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Repeating pitches across notes
You can repeat a specified number of pitches across all subsequent notes in the selection; for 
example, if you want to change the harmonic pattern for a passage.

PROCEDURE

1. In Write mode, make a selection that includes both of the following:

● The notes whose pitches you want to repeat

● The notes across which you want to repeat pitches

2. Choose Write > Transform > Pitches > Repeat Pitches to open the Repeat Pitches dialog.

3. Change the value in the value field.

4. Click OK to save your changes and close the dialog.

RESULT
The specified number of pitches at the start of the selection is repeated across the following 
notes in the selection.

TIP

You can also repeat pitches using the note tools popover.

Repeat Pitches dialog
The Repeat Pitches dialog allows you to set the number of pitches you want to repeat across all 
subsequent notes in the selection.

● You can open the Repeat Pitches dialog in Write mode when at least one note is selected in 
the music area by choosing Write > Transform > Pitches > Repeat Pitches.

The Repeat Pitches dialog contains the following option:

Number of pitches to repeat
Allows you to set the number of pitches you want to repeat across the selection, 
starting from the first selected note.

Mapping notes to pitches
You can map multiple source pitches to destination pitches in a single transformation; for 
example, if you want to transform all C♯s, F♯s, and A♯s into D♭s, G♭s, and B♭s.

PROCEDURE

1. In Write mode, select the notes whose pitches you want to map.

2. Choose Write > Transform > Pitches > Map Pitches to open the Map Pitches dialog.

3. Change the settings for Map pitch to specify the source pitch.
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4. Activate/Deactivate Include enharmonic equivalents.

5. Change the settings for To to specify the destination pitch.

6. Click Add mapping.

7. Optional: Repeat steps 3 to 6 for each pitch you want to map.

8. Click OK to save your changes and close the dialog.

RESULT
The specified source pitches are mapped to the specified destination pitches according to your 
settings.

TIP

You can also map pitches using the note tools popover.

RELATED LINKS
Note tools popover on page 487
Large selections on page 424
Respelling notes on page 473
Arranging tools on page 455
Inputting notes on page 224

Map Pitches dialog
The Map Pitches dialog allows you to set multiple pitch mappings in a single transformation; for 
example, if you want to transform all C♯s, F♯s, and A♯s into D♭s, G♭s, and B♭s.

● You can open the Map Pitches dialog in Write mode when at least one note is selected in the 
music area by choosing Write > Transform > Pitches > Map Pitches.

The Map Pitches dialog contains the following options:
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Map pitch
Allows you to specify the source pitch you want to map to the destination pitch. You 
can select a note name and accidental, and you can also optionally specify the octave, 
according to your middle C numbering convention setting. The available accidentals 
depend on the prevailing tonality system.

Include enharmonic equivalents
When activated, enharmonic equivalents to the specified source pitch are included in 
the mapping. For example, if you want to map A♯s and B♭s to Gs.

When deactivated, enharmonic equivalents to the specified source pitch are excluded 
from the mapping.

To
Allows you to specify the destination pitch to which you want to map the source pitch. 
You can select a note name and accidental. The available accidentals depend on the 
prevailing tonality system.

Transform
Allows you to specify the octave selection for the mapping.

● Up: Destination pitches are higher than the source pitch.

● Down: Destination pitches are lower than the source pitch.

● Closest: Destination pitches use the octave the smallest interval from the source 
pitch.

● Specific octave: Destination pitches use the octave specified in the value field. 
Follows your middle C numbering convention setting.

Add mapping
Adds the set mapping to the mapping list.

Delete mapping
Removes the selected mapping from the mapping list.

Mapping list
Contains the set mappings for the transformation.

RELATED LINKS
Changing the middle C numbering convention on page 51

Mapping notes to scales
You can map all notes in a specified source scale to equivalent degrees of a destination scale; for 
example, if you want to transform a passage from major to minor with the same root.

PROCEDURE

1. In Write mode, select the notes whose pitches you want to map.

2. Choose Write > Transform > Pitches > Map Scale to open the Map Scale dialog.

3. Adjust the parameters required for your scale mapping, such as scale roots and scale 
patterns.

4. Click OK to save your changes and close the dialog.
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RESULT
The specified pitches in the source scale are mapped to the specified pitches in the destination 
scale according to your settings.

TIP

You can also map scales using the note tools popover.

RELATED LINKS
Note tools popover on page 487
Large selections on page 424
Respelling notes on page 473
Arranging tools on page 455
Inputting notes on page 224

Map Scale dialog
The Map Scale dialog allows you to map all notes in the specified source scale to equivalent 
degrees of the destination scale; for example, if you want to transform a passage from major to 
minor with the same root.

● You can open the Map Scale dialog in Write mode when at least one note is selected in the 
music area by choosing Write > Transform > Pitches > Map Scale.

The Map Scale dialog contains the following options:
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Use source root
When activated, allows you to specify the source scale root you want to map to 
the destination scale root. You can select a note name and accidental. The available 
accidentals depend on the prevailing tonality system.

When deactivated, Dorico Elements uses the scale root implied by the prevailing key 
signature.

Use destination root
When activated, allows you to specify the destination scale root to which you want to 
map the source scale root. You can select a note name and accidental. The available 
accidentals depend on the prevailing tonality system.

When deactivated, Dorico Elements uses the scale root implied by the prevailing key 
signature.

Source scale pattern
Allows you to select the scale type of the source scale.

Destination scale pattern
Allows you to select the scale type of the destination scale.

Source scale overrides
Allows you to customize the source scale by specifying pitches that deviate from 
its preset pattern. Notes are mapped relative to the customized scale pattern. For 
example, if you add a sharp sixth source scale override when mapping C major to C 
harmonic minor, A♮s are treated as flattened sixths and become As.

● To specify flat scale degrees, enter b[n], such as b2.

● To specify sharp scale degrees, enter #[n], such as #6.

Destination scale overrides
Allows you to customize the destination scale by specifying pitches that deviate from 
its preset pattern. Notes are mapped relative to the customized scale pattern. For 
example, if you add a flattened second destination scale override when mapping C 
major to C harmonic minor, D♮s become D♭s.

● To specify flat scale degrees, enter b[n], such as b2.

● To specify sharp scale degrees, enter #[n], such as #6.

Direction
Allows you to specify the octave selection for the mapping.

● Closest: Destination pitches use the octave the smallest interval from the source 
pitch.

● Up: Destination pitches are higher than the source pitch.

● Down: Destination pitches are lower than the source pitch.

Snap all pitches to destination scale
When activated, all notes are snapped to the nearest pitch in the destination scale, 
including notes outside the source scale. When deactivated, only notes in the source 
scale are mapped to the destination scale.

Treat enharmonic equivalents as matching source scale
When activated, notes that are enharmonic equivalents to notes in the source scale are 
included in the mapping. When deactivated, only notes whose enharmonic spelling is 
in the source scale are mapped to the destination scale.
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Respell enharmonic equivalents to fit destination scale
When activated, enharmonic equivalent notes included in the mapping are respelled 
to fit the destination scale. When deactivated, enharmonic equivalent notes are 
transposed according to the scale mapping without being respelled.

Only available when Treat enharmonic equivalents as matching source scale is 
activated.

Keep relative offsets from source scale
When activated, Dorico Elements preserves the relative offsets between notes in the 
source scale. For example, if you map C major to D Aeolian, a B♭ would be mapped to 
C♭.
When deactivated, Dorico Elements changes the relative offsets between notes in the 
source scale if different intervals are more appropriate in the destination scale. For 
example, if you map C major to D Aeolian, a B♭ would be mapped to C♮.

Note tools popover
The note tools popover allows you to add notes above and below existing notes, transpose 
existing notes, and transform the pitches and rhythms of selected notes.

It makes much of the functionality provided by the Add Notes Above or Below, Transpose, 
Reverse and Invert Pitches/Rhythms, Rotate Pitches/Rhythms, Map Pitches, Map Scale, and 
Repeat Pitches dialogs accessible directly via the keyboard.

You can open the note tools popover in Write mode in any of the following ways when notes are 
selected, including during note input:

● Press Shift-I .

● In the Notations toolbox, click Popovers , then Note Tools .

● Choose Write > Add Intervals.

The icon on the left-hand side of the popover matches the corresponding button in the Notations 
toolbox on the right of the window.

Note tools popover with an example entry
Note Tools button in the Notations toolbox

The following tables contain examples of what you can enter into the note tools popover to 
transform selections, transpose notes, or add notes above/below existing notes.

Intervals

Interval or quality Popover entry

Interval degree

Unison, second, third, fourth, fifth, and so on, 
up to two octaves

1, 2, 3, 4, 5, and so on, up to 15

Major M, maj, or major
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Interval or quality Popover entry

Minor m, min, or minor

Perfect p, per, or perf

Diminished d, dim, or diminished

Augmented a, aug, or augmented

Diatonic diat or diatonic

[n] octave divisions in any tonality system [n] d, [n] div, or [n] divisions

[n] half-steps (semitones) in 12-EDO [n] s, [n] st, [n] semi, or [n] semitones

[n] quarter tones in 24-EDO [n] q, [n] qt, or [n] quartertones

NOTE

● You must include an interval degree before a specified total number of octave divisions, such 
as 5 8 div. Together, they specify the desired note name and accidental.

● M and m entries for major and minor are case-sensitive.

Note additions

Type of addition Popover entry

Add notes a third above 3 or 3rd

Add notes a fourth below -4 or -4th

Add notes [n] octave divisions above, using the 
note name a fifth above

5 8 div in any tonality system

5 8 st in 12-EDO

5 16 qt in 24-EDO

Add notes [n] octave divisions below, using the 
note name a sixth below

-6 9 div in any tonality system

-6 9 st in 12-EDO

-6 18 qt in 24-EDO

Add chords containing multiple notes 3,6 or -3,3,4

Add notes only to the top notes in chords top

Add notes only to the bottom notes in chords bottom
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NOTE

● When adding multiple notes, you must separate notes with commas, not spaces.

● If you do not specify the interval quality, the interval degree follows the prevailing key 
signature. For example, in C major, if you enter 3 to add a third above a D♮, the added note 
is an F♮. You can specify the interval quality by including it before the interval degree, such as 
maj3.

EXAMPLE

● To add notes a major second below and minor third above the bottom notes in the selected 
chords, enter -M2,m3 bottom.

● To add G♯s above C♮s in 24-EDO, enter 5 16 qt.

Transposition

Example transposition Popover entry

Transpose notes upwards by a third t3

Transpose notes downwards by a sixth t-6

Transpose notes upwards by [n] octave 
divisions, using the note name a fifth above

t 5 8 div in any tonality system

t 5 8 st in 12-EDO

t 5 16 qt in 24-EDO

Transpose notes downwards by [n] octave 
divisions, using the note name a sixth below

t -6 9 div in any tonality system

t -6 9 st in 12-EDO

t -6 18 qt in 24-EDO

EXAMPLE
To transpose C♮ upwards by nine quarter tones in 24-EDO, you can enter t 3 9 qt for E or t 4 9 qt 
for F.

Inversion

Type of inversion Popover entry

Invert pitches within the range of the highest 
and lowest notes in the selection

inv, invert, inversion, or mirror

Specify the central pitch for inversion

For example, C4, E♭4, F5, G♯6, and so on

C4, eb4, F5, g#6, and so on
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Type of inversion Popover entry

Specify the central octave division for inversion

For example, D4 or A5 in 24-EDO

d1/24 4 or A-3/24 5

Specify root of prevailing key as central pitch 
for inversion

NOTE

In open keys or music without key signatures, 
C is used.

root

Specify first note as central pitch for inversion first

Specify top note in first chord as central pitch 
for inversion

top

Specify bottom note in first chord as central 
pitch for inversion

bottom

Diatonic inversion diatonic or diat

Chromatic inversion chromatic or chrom

EXAMPLE
To invert pitches around E♭4, enter inveb4.

Reversal

Type of reversal Popover entry

Reverse the selection, including pitches and 
rhythms

retrograde, ret, reverse, or rev

Specify pitches only pitch or pt

Specify rhythms only rhythm or rm

Reverse and invert pitches

TIP

You can also include additional specifications 
for the inversion.

ret invert, rev inv, and so on

Include additional items belonging to the 
same player as the selection

player
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Type of reversal Popover entry

Include only items belonging to the same voice 
as the selection

voice

EXAMPLE
To reverse the pitches and items in the selected voice only, enter rev pt voice.

Rotation

Type of rotation Popover entry

Rotate the selection, including pitches and 
rhythms

rotate or rot

Specify pitches only pitch or pit

Specify rhythms only rhythm, rhy, or rm

Specify number of steps forwards 1, 2, 3, 4, and so on

Specify number of steps backwards -1, backwards 2, bw 3, prev 4, and so on

EXAMPLE
To rotate only the rhythms of the selected notes backwards three steps, enter rot rm bw 3.

Repetition

Type of repetition Popover entry

Repeat the first two pitches in the selection 
across the selection

repeat 2 pitches

Repeat the first eight pitches in the selection 
across the selection

repeat 8 pitches

This list is not comprehensive as you can repeat any number of pitches. It is intended to illustrate 
how you can structure your entry.
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Pitch mapping

Type of pitch mapping Popover entry

Specify source and destination pitches

For example, to map C4 to E♭4, F4 to G4, and 
A4 to B♭4.

NOTE

● Separate source and destination pitches 
with equals signs, and pairs of pitches with 
commas.

● The octave number is optional.

c4=eb4,f4=g4,a4=bb5

Include enharmonic equivalents of specified 
notes

* after note name and octave, if specified

Specify that destination pitch is higher than 
source pitch

up

Specify that destination pitch is lower than 
source pitch

down

EXAMPLE
To map A♯s and enharmonic equivalents, including B♭s, to the G below, enter a#*=Gdown.

Scale mapping

Type of scale mapping or scale Popover entry

Scale mapping structure [source scale] to [destination scale], such as 
c M to c m or Fmin to Dmaj

Snap pitches outside the source scale to the 
nearest pitch by interval in the destination 
scale

snap

Specify snapped pitches should be raised up or higher

Specify snapped pitches should be lowered down or lower

Respell notes to the specified scale spell [scale], such as spell Cmaj

Snap notes to the specified scale snap [scale], such as snap cmin

Scale roots c, Db, e, f#, g, and so on
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Type of scale mapping or scale Popover entry

Alterations #4, b6, and so on

Major maj or M

Minor min or m

Ionian major ion maj or ion M

Harmonic minor harm m or hmc min

Melodic minor (ascending) me m or mdc min

Dorian dor or drn

Phrygian phryg, phry, or phr

Lydian lyd

Mixolydian mixlyd, mlyd, mixo, mix, or ml

Aeolian or natural minor aeol m, aeo m, aln min, or nat min

Locrian loc

Super Locrian (altered scale) super loc, sup loc, or spr loc

Major pentatonic pent maj, 5tonic M, or 5ton M

Minor pentatonic pent min, 5tonic m, 5ton m

Major blues blue maj or bls M

Minor blues blue min or bls m

Whole tone wholetone, whole-tone, wtone, wton, whole, 
or wt

Half-whole diminished half whole dimin, halfwhole dimin, hw dim, 
half-tone dimin, half tone dimin, halftone 
dimin, htone dim, hton dim, half dim, or ht 
dim

Half-whole octatonic half whole octa, halfwhole octa, hw oct, 
half-tone octa, half tone octa, halftone octa, 
htone oct, hton oct, half oct, or ht oct
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Type of scale mapping or scale Popover entry

Whole-half diminished whole half dimin, wholehalf dimin, wh 
dim, whole tone dimin, whole-tone dimin, 
wholetone dimin, wtone dim, wton dim, 
whole dim, or wt dim

Whole-half octatonic whole half octa, wholehalf octa, wh 
oct, whole tone octa, whole-tone octa, 
wholetone octa, wtone oct, wton oct, whole 
oct, or wt oct

Locrian 7 or harmonic major mode 7 loc maj mode7 or harm M mod7

Super locrian 7 or harmonic minor mode 7 sup loc min mode7 or spr loc m mod7

NOTE

● You can use scale type entries in any combination, such as me min, me m, mdc min, and 
mdc m.

● M and m entries for major and minor are case-sensitive.

● You must separate roots from M and m with a space, such as c M.

EXAMPLE
To respell all F♭s in a selection as E♮s, and snap A♭s to A♮s, enter spell snap Cmaj.

RELATED LINKS
Notations toolbox on page 201
Large selections on page 424
Equal Division of the Octave (EDO) on page 1028
Changing the middle C numbering convention on page 51
Adding notes above/below existing notes on page 258
Transposing existing notes with the note tools popover on page 472
Arranging tools on page 455

Comments
Comments allow you to add notes or instructions at precise positions in your project without 
affecting the music. They are considered annotations in Dorico Elements, meaning they are not 
printed by default.

Comments exist outside of the music, so they do not affect note spacing, vertical spacing, or 
casting off. However, you can attach them to specific items and staves in order to show the 
precise subject of each comment.
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A passage with comments and replies

By default, comments are shown in the music area. They appear as speech bubble symbols as 
close as possible to their attached position. Comments that are replies are stacked vertically 
below the original comment.

All comments in the current layout are listed in the Comments panel in Write mode. Clicking a 
comment, either in the Comments panel or in the music area, automatically moves the view to 
bring that rhythmic position into focus.

In addition to its content, each comment identifies the following by default:

● Author of the comment, using either the current user account name or a custom name

On macOS, the user account name uses the long account name; on Windows, it uses the 
full name associated with the account. If Dorico Elements cannot determine your account 
name, a dialog appears into which you can add the name and initials you want to use for 
comments. You can also change these in Preferences.

● Date the comment was added

● Instrument to which the comment applies

● Bars to which the comment applies

NOTE

In the music area, only the initials of the author are shown.

You can hide/show comments in the music, and hide/show comment information in the 
Comments panel. You can also choose to include comments, alongside other view options, when 
printing/exporting layouts.

RELATED LINKS
Annotations on page 597

Comment dialog
The Comment dialog allows you to enter and edit text as comments.

● You can open the Comment dialog by adding a comment, replying to a comment, or double-
clicking an existing comment, either in the music area or in the Comments panel.
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Comments panel
The Comments panel shows all the comments in the current layout as a list. Replies to comments 
are indented to indicate their relationship to the original comment. The Comments panel is 
located in the right zone in Write mode.

● You can hide/show the Comments panel by clicking Panels , then Comments  in the 
Notations toolbox.

You can also hide/show the right zone by pressing Ctrl/Cmd-9 .

Each comment in the panel shows the following information by default:

Write mode
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1 Author name: This uses either the current user account or a custom name, depending on 
the preference that was set when the comment was added.

2 Date the comment was added to the project

3 Comment content

4 Instrument to which the comment applies

5 Flow to which the comment applies

6 Bars to which the comment applies

The action bar at the bottom of the panel contains the following options:

Create Comment

Adds a comment to the selected rhythmic position and staff.

Edit Comment

Opens the selected comment in the Comment dialog and allows you to change its 
content.

Reply to Comment

Adds a comment that is a reply to the selected comment. Replies are shown indented 
in the Comments panel and stacked in the music area.

Export Comments

Exports all the comments in the project as an HTML file, which opens automatically in 
your default web browser. The HTML file is automatically saved in the same location as 
the project.

Delete Comment

Deletes the selected comments.

RELATED LINKS
Notations toolbox on page 201
Hiding/Showing comment information on page 499
Changing the author name used for comments on page 499
Reordering comments on page 500
Exporting comments on page 500

Adding comments
You can add comments at any rhythmic position in your project, including adding different 
comments to multiple staves at the same rhythmic position.

PROCEDURE

1. In Write mode, select an item on the staff and at the rhythmic position where you want to 
add a comment. If you want your comment to apply to a range, select multiple items.

2. Press Alt/Opt-C  to open the Comment dialog.

3. Enter your comment into the dialog.
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4. Click OK to close the dialog and add the comment.

RESULT
The text you entered into the dialog is saved as a comment.

● In the music area, it is indicated by a speech bubble symbol that contains your initials.

● In the Comments panel, the text you entered is shown alongside additional comment 
information.

TIP

You can also add comments by clicking Create Comment  in the Comments panel, or by 
choosing Write > Create Comment.

EXAMPLE

A comment in the music area

Replying to comments
You can add replies to existing comments, which is useful when co-ordinating with others, as this 
organizes the list of comments in the Comments panel into clear sections.

PROCEDURE

1. In Write mode, select the comment to which you want to reply. You can do this in the music 
area and in the Comments panel.

2. Press Alt/Opt-R  to open the Comment dialog.

3. Enter your reply into the dialog.

4. Click OK to close the dialog and add the reply.

RESULT
The text you entered into the dialog is saved as a reply to the selected comment.

● In the music area, it is indicated by a speech bubble symbol that contains your initials and is 
positioned immediately below the selected comment.

● In the Comments panel, the reply is indented below the selected comment.

TIP

You can also reply to comments by clicking Reply to Comment  in the Comments panel, or by 
choosing Write > Reply to Comment.
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EXAMPLE

A reply to a comment

Editing existing comments
You can change the contents of existing comments after you have added them; for example, to 
correct misspellings or add further information.

PROCEDURE

1. Double-click the comment you want to edit to open the Comment dialog. You can do this in 
the music area and in the Comments panel.

2. Change the text in the dialog.

3. Click OK to save your changes and close the dialog.

Hiding/Showing comment information
You can change which pieces of information appear in comments, independently of each other. 
For example, if you mostly create comments for yourself, showing the author name might be 
superfluous.

PROCEDURE

1. In Write mode, in the Notations toolbox, click Panels , then Comments  to show the 
Comments panel.

2. Right-click in the Comments panel, then choose Show > [information].

For example, to hide the author name, choose Show > Author, so that no tick appears 
beside it in the menu.

RESULT
The corresponding information is hidden/shown in all comments in the current project and all 
future projects on your computer.

Changing the author name used for comments
You can change the author name used for comments to either your user account name or a 
custom name. This affects subsequent comments you add to the project without changing the 
author name used for existing comments.

For the custom name, you can specify both the full name that is shown in the Comments panel 
and the initials shown in the music area.
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PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click General.

3. In the Comments subsection, choose one of the following options for Author name for 
comments:

● User Name

● Custom Name

4. Optional: If you chose Custom Name, enter the full name you want to use into the Full 
name field.

5. Optional: If you chose Custom Name, enter the initials you want to use into the Initials 
field.

6. Click Apply, then Close.

Reordering comments
You can change the order in which layouts appear in the Comments panel. By default, comments 
are sorted according to their flow and bar number.

PROCEDURE

1. In Write mode, in the Notations toolbox, click Panels , then Comments  to show the 
Comments panel.

2. Right-click in the Comments panel, then choose Sort By > [information].

For example, to sort comments according to their instrument, choose Sort By > Instrument.

RESULT
The order of all comments is changed in the current project and all future projects on your 
computer.

Exporting comments
You can export all comments from all flows in the layout currently open in the music area to an 
HTML file. For example, if you want to view them all in a single place.

PROCEDURE

1. In Write mode, open the layout whose comments you want to export.

2. In the Notations toolbox, click Panels , then Comments  to show the Comments panel.

3. In the Comments section action bar, click Export Comments .

RESULT
All comments in the layout currently open in the music area are saved as an HTML file, which 
opens automatically in your default web browser. Comments are displayed in a table, with 
columns corresponding to the comment information currently shown in the Comments panel.

The HTML file is automatically saved in the same location as the project. Its file name includes the 
layout name.
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RELATED LINKS
Hiding/Showing comment information on page 499
Switching between layouts on page 43
Exporting lyrics on page 1034
Exporting text on page 102

Hiding/Showing comments
You can hide/show comments at their positions in the music; for example, if you want to hide 
them when inputting music but show them when engraving.

Comments are considered annotations in Dorico Elements, meaning they are not printed by 
default.

PROCEDURE

● Choose View > Comments.

RESULT
Comments are hidden/shown. When shown, comments appear in the music as speech bubbles.

RELATED LINKS
Hiding/Showing comment information on page 499

Splitting flows
You can split flows at specific rhythmic positions. For example, if you want the music from a 
specific bar onwards to be a new flow, separate from the preceding music.

PROCEDURE

1. In Write mode, select a note or item at the position where you want to split the flow.

2. Choose Write > Split Flow.

RESULT
The flow is split into two flows: the existing flow, and a new flow that begins from the position 
of the item you selected. By default, new flows in full score layouts start on a new page in page 
view, and are shown on a separate background in galley view.

AFTER COMPLETING THIS TASK
You can set options for each flow independently in the Notation Options dialog.

RELATED LINKS
Flows on page 171
Adding flows on page 171
Duplicating flows on page 172
Deleting flows on page 174
Notation Options dialog on page 747
Deleting empty bars/beats at the end of flows on page 812
Allowing/Disallowing multiple flows on the same page on page 609
Switching between layouts on page 43
Switching to galley/page view on page 50
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Engrave mode

Engrave mode allows you to manipulate and modify every item in your project, but without 
deleting them, moving them rhythmically, or changing the pitch of notes. You can also determine 
the casting off in each layout of your project using system and frame breaks.

Project window in Engrave mode
The project window in Engrave mode contains a toolbox and panels with all the tools and 
functions that allow you to format the pages, systems, and properties of individual notations in 
your score.

You can switch to Engrave mode in any of the following ways:

● Press Ctrl/Cmd-3 .

● In the toolbar, click Engrave.

● Choose Window > Engrave.

The project window in Engrave mode contains the following:

1 Engrave toolbox

Allows you to switch between Engrave mode tools, and to hide/show the left zone.

2 Left zone

Contains the Formatting panel, which allows you to change how systems and frames are 
formatted on pages, including inserting system/frame breaks.

The left zone is hidden automatically when either Note Spacing  or Staff Spacing  is 
selected in the Engrave toolbox.

3 Music area
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Displays layouts in page view. Additional engraving aids are shown on pages, according to 
the current selection in the Engrave toolbox.

● Frame outlines are always shown.

● System and frame fullness indicators are shown when either Graphic Editing , Staff 
Spacing , or Note Spacing  is selected.

● When Staff Spacing  is selected, staff/system spacing handles, gap measurements, 
and music frame margin highlights are shown.

● When Note Spacing  is selected, note spacing handles, system handles, and dashed 
lines that represent spacing columns are shown.

4 Lower zone

Can display either the Properties panel or Mixer panel, according to the current selection in 
the lower zone toolbar.

RELATED LINKS
Toolbar on page 30
Project window on page 29
Music area on page 34
Properties panel on page 663
Mixer panel on page 717
System fullness indicators on page 506
Frame fullness indicators on page 506
Moving individual staves/systems vertically on page 624
Adjusting note spacing at individual rhythmic positions on page 509
Hiding/Showing crosshairs on page 517

Engrave toolbox
The Engrave toolbox allows you to change the panel shown in the left zone and to activate note 
and staff spacing. The Engrave toolbox is located on the left of the window in Engrave mode.

Show Left Zone

Hides/Shows the left zone.

Graphic Editing

Allows you to select and edit items in the music area or page template editor. Shows 
the Formatting panel in the left zone, which contains options for formatting systems, 
frames, brackets, braces, and barline joins.

Staff Spacing

Allows you to move individual staves and systems vertically.

Note Spacing

Allows you to edit the graphical horizontal positions of individual notes and other 
items, such as clefs and key signatures.

Engrave mode
Project window in Engrave mode 
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TIP

● By default when you switch to Engrave mode, Dorico Elements automatically selects Graphic 
Editing . You can choose to remember your last selected tool instead on the General page 
in Preferences.

● You can assign key commands for Engrave mode tools on the Key Commands page in 
Preferences.

RELATED LINKS
Formatting panel on page 504
Staff spacing on page 620
Note spacing on page 507
Moving items graphically on page 514
Hiding/Showing zones on page 44
Preferences dialog on page 58

Formatting panel
The Formatting panel allows you to change how systems and frames are formatted on pages, 
including inserting system/frame breaks. It is located in the left zone in Engrave mode.

● You can show the Formatting panel by showing the left zone, then clicking Graphic Editing 
 in the Engrave toolbox.

The Formatting panel contains the following sections:

Moving Bars Between Systems

The Moving Bars Between Systems allows you to move selected bars to other systems.

Move to Previous System

Moves the selected bars to the previous system. Inserts system breaks at the start and 
end of the system to which the bars were moved.

You can also move bars to the previous system by pressing , .

Move to Next System

Moves the selected bars to the next system. Inserts system breaks at the start and end 
of the system to which the bars were moved.

You can also move bars to the next system by pressing . .

Format Systems

The Format Systems section allows you to change how the music in the layout currently open in 
the music area is arranged into systems.

Insert System Break

Forces music from the selected item onwards onto the next system. Depending on 
your staff size and other settings, this may mean the music is forced onto the next 
page.

Engrave mode
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You can insert system breaks by pressing Shift-F .

Lock System

Fixes the formatting of the selected systems, even if you change the formatting of 
surrounding musical material and other systems.

Make into System

Forces all music between the selected items into the same system.

Format Music Frames

The Format Music Frames section allows you to change how the music in the layout currently 
open in the music area is arranged into frames.

Insert Frame Break

Forces music from the selected item onwards onto the next frame, which is often on 
the next page. This allows you to control what music appears on each page.

You can insert frame breaks by pressing Shift-F .

Lock Frame

Fixes the formatting of the selected frames, even if you change the formatting of 
surrounding frames.

Make into Frame

Forces all music between the selected items into the same frame. You can use this 
option to force music onto a single page.

Lock Layout

The Lock Layout section allows you to fix and reset all systems and pages in the current layout.

Lock Layout

Inserts system and frame breaks on all systems in the current layout as required to fix 
its current casting off.

Reset Layout

Removes all system and frame breaks from the current layout.

RELATED LINKS
Hiding/Showing zones on page 44
Project window in Engrave mode on page 502
Frame breaks on page 636
System breaks on page 633
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Page templates on page 647
Page formatting on page 598
Casting off on page 629

System fullness indicators
System fullness indicators are highlighted regions that are shown to the right of systems in 
Engrave mode. They use colors and percentages to indicate the horizontal fullness of the 
corresponding system.

The following colors are used in system fullness indicators:

● Green: the system is comfortably full. Notes have enough horizontal space to be legible but 
are not too far apart. Systems that are 60-100% full are considered comfortably full.

● Purple: the system is under-full, meaning notes might appear overly stretched. Systems that 
are less than 60% full are considered under-full.

● Red: the system is over-full, meaning notes might appear squashed with not enough 
horizontal space between them. Systems that are more than 100% full are considered over-
full.

The fullness of systems is also expressed using a percentage. The percentage indicated is 
calculated by dividing the number of spaces occupied in the system by the total number of 
available spaces in the system, which is measured from the start of the rhythmic space to the 
right of the initial clef/time signature/key signature up to the final barline in the system.

Both the color of the system fullness indicator and the fullness percentage are updated in real 
time as you adjust note spacing in the system.

System comfortably full System under-full System over-full

RELATED LINKS
Engrave toolbox on page 503
Note spacing on page 507
Adjusting note spacing at individual rhythmic positions on page 509
Positions of lyrics on page 1035
Project window in Engrave mode on page 502
Margins on page 614

Frame fullness indicators
Frame fullness indicators are highlighted regions that are shown outside the bottom left corners 
of music frames in Engrave mode. They use colors and percentages to indicate the vertical 
fullness of the corresponding music frame, which in most cases represents a full page.

The following colors are used in frame fullness indicators:

● Green: the frame is comfortably full. Staves and systems have enough vertical space to be 
legible but are not too far apart. Frames that are 60-100% full are considered comfortably 
full.

Engrave mode
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● Red: the frame is over-full, meaning staves and systems might appear squashed with not 
enough vertical space between them. Frames that are more than 100% full are considered 
over-full.

The fullness of frames is also expressed using a percentage. The percentage indicated is 
calculated by dividing the number of spaces occupied in the frame by the total number of 
available spaces in the frame, which is measured using the vertical distance between the top and 
bottom music frame padding margins.

Frame comfortably full Frame over-full

RELATED LINKS
Engrave toolbox on page 503
Per-layout vertical spacing options on page 621
Changing the default staff/system spacing on page 603
Changing the vertical justification of staves/systems on page 604
Project window in Engrave mode on page 502
System fullness indicators on page 506
Margins on page 614

Note spacing
The positions of notes and rests relative to each other, and the automatic gaps between them, 
are known as note spacing.

You can change note spacing in your project at different levels:

● Change the default note spacing in each layout in Layout Options > Note Spacing.

● Change the note spacing at individual rhythmic positions and for individual voice columns.

RELATED LINKS
System fullness indicators on page 506
Staff spacing on page 620
Changing the default staff size on page 602
Changing the horizontal justification of final systems on page 612
Enabling/Disabling vertical line collision avoidance on page 1199

Changing the default note spacing
You can change the default note spacing in each layout independently. For example, you can 
have tighter note spacing in full score layouts compared to part layouts. The options available 
include changing the default space for quarter notes and the scale space for grace notes and 
cues.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

Engrave mode
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2. In the Layouts list, select the layouts in which you want to change note spacing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Note Spacing.

4. Change the values of the options you want to change.

5. Click Apply, then Close.

RESULT
The default note spacing is changed in the selected layouts.

RELATED LINKS
Changing the horizontal justification of final systems on page 612
Positions of lyrics on page 1035
Casting off on page 629
Locking layouts on page 631

Per-layout note spacing options
Dorico Elements provides multiple options that you can use to control the default note spacing 
in each layout. You can also change how full the final system in flows must be before it is 
automatically justified.

● You can access per-layout note spacing options by opening the Layout Options dialog and 
clicking Note Spacing in the category list.

The Note Spacing page in Layout Options contains the following options:

Default space for crotchet/quarter note
Sets the default note spacing for quarter notes (crotchets). The spacing of other 
durations is scaled proportionally. Increasing the value increases note spacing, 
decreasing the value decreases note spacing. This is reflected in the preview as you 
change the value.

Minimum space for short notes
Sets the minimum note spacing for notes with short durations. This can be 
independent of the default note spacing value.

Custom spacing ratio
Sets the spacing of notes in relation to other notes according to their rhythmic values. 
For example, setting Custom spacing ratio to 2 means half notes (minims) take up 
twice as much space as quarter notes, and eighth notes (quavers) take up half as much 
space as quarter notes.

Scale space for grace notes by
Sets the note spacing for grace notes as a percentage of the note spacing normally 
used for notes of their duration. The value cannot be greater than 100%. Increasing the 
value increases the note spacing for grace notes, decreasing the value decreases the 
note spacing for grace notes.

Scale space for cue notes by
Sets the note spacing for cues as a percentage of the note spacing normally used for 
notes of their duration. The value cannot be greater than 100%. Increasing the value 
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increases the note spacing for cues, decreasing the value decreases the note spacing 
for cues.

Make space for lyrics
Controls whether or not lyrics are included in note spacing calculations. When 
deactivated, lyrics are excluded from note spacing calculations, producing a result 
where notes are spaced as if lyrics were not there.

We recommend using this option with caution and only if you intend to space lyrics 
manually, such as in tightly-spaced hymnals.

Only justify final system in flow when more than [n]% full
Allows you to change how full the final system in each flow must be before it is justified 
to the full width of the frame. By default, final systems that are 50% full or less are not 
justified.

Use optical spacing for beams between staves
When activated, stems in cross-staff beams are evenly spaced, which can mean the 
noteheads are unevenly spaced. When deactivated, noteheads in cross-staff beams are 
evenly spaced, which can mean stems appear unevenly spaced.

RELATED LINKS
Layout Options dialog on page 745
Changing to optical cross-staff beam spacing on page 852
Creating cross-staff beams/tremolos on page 851
Changing the paragraph style used for lyrics on page 1042

Adjusting note spacing at individual rhythmic positions
You can make adjustments to the note spacing at individual rhythmic positions independently of 
your project-wide settings.

When Note Spacing  is activated in the Engrave toolbox, the following are shown:

● Dashed lines that represent spacing columns.

● Note spacing handles: square handles on every staff for each spacing-significant item, such 
as notes, grace notes, rests, clefs, key signatures, and time signatures.

● System handles: larger square handles at the start/end of each system, which control the 
start/end horizontal position of individual systems. System handles are positioned on the top 
left and bottom right corners of each system.

Handles and dashed lines are shown when Note Spacing is activated.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

Engrave mode
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PROCEDURE

1. In Engrave mode, select a square note spacing handle on the dashed line at each rhythmic 
position whose spacing you want to adjust.

2. Move the handles in any of the following ways:

● To increase the space to the left of selected handles, press Alt/Opt-Right Arrow .

● To decrease the space to the left selected handles, press Alt/Opt-Left Arrow .

NOTE

● To move handles by large increments, press Ctrl/Cmd  plus the standard key 
command; for example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move handles by moderate increments, press Shift  plus the standard key 
command; for example, Shift-Alt/Opt-Left Arrow .

● To move handles by small increments, press Ctrl/Cmd - Shift  plus the standard key 
command; for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● You cannot move note spacing handles with the mouse, you can only move them 
using the keyboard.

RESULT
The selected note spacing handles are moved, which increases/decreases the spacing to the 
left of their original rhythmic position. This also affects the spacing of each selected rhythmic 
position on all staves in the system. The color of the handles changes to indicate that you have 
moved them.

System breaks are automatically inserted at the start/end of each system in which you adjusted 
note spacing.

NOTE

● Moving notes too far away from their intended rhythmic positions can be misleading for 
players reading the music.

● You can also adjust the spacing of individual notes/items independently of their rhythmic 
positions.

● When Note Spacing  is activated, you cannot select or edit anything other than note 
spacing handles. To resume normal selection and editing, click Graphic Editing  in the 
Engrave toolbox or return to Write mode.

Engrave mode
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EXAMPLE

Moving note spacing handles to the left reduces 
spacing to the left of the rhythmic position

Moving note spacing handles to the right increases 
spacing to the left of the rhythmic position

RELATED LINKS
Engrave toolbox on page 503
Changing the default note spacing on page 507
System fullness indicators on page 506
Moving the start/end of systems on page 513
Changing the horizontal justification of final systems on page 612
Enabling/Disabling vertical line collision avoidance on page 1199
System breaks on page 633
Signposts on page 450

Adjusting the spacing of individual notes/items independently of their rhythmic 
positions

You can change the graphical position of notes according to their voice column, independently of 
their rhythmic positions. These steps also apply to certain notation items, such as key signatures, 
time signatures, and clefs.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the square note spacing handle at the rhythmic position of the 
note/item you want to move graphically.

A circular handle appears beside each voice/item.

2. Press Tab  to select the circular handle.

3. Move the handle in any of the following ways:
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● To move it a standard amount to the right or left, press Alt/Opt  plus the corresponding 
arrow key. For example, press Alt/Opt-Left Arrow  to move handles to the left.

● To move it a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move it a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow .

● To move it a small amount, press Ctrl/Cmd - Shift  plus the standard key command; for 
example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

NOTE

You cannot move note spacing handles with the mouse, you can only move them using the 
keyboard.

RESULT
The graphical position of the selected note/item is changed without changing the note spacing 
of its rhythmic position. Other notes in the same voice column at the same rhythmic position are 
also moved.

System breaks are automatically inserted at the start/end of each system in which you adjusted 
the position of individual notes/items.

EXAMPLE

Removing individual changes to note spacing
You can remove changes you have made to the note spacing at individual rhythmic positions and 
reset note spacing handles to their original default positions.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the note spacing handles you want to restore to their original 
positions.

2. Press Backspace or Delete .

RESULT
The selected rhythmic positions are reset to their default positions.

Engrave mode
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TIP

You can also reset all note spacing changes within selected systems, frames, or all note spacing 
changes in the layout by choosing one of the options in the Engrave > Note Spacing menu.

Moving the start/end of systems
You can change the horizontal start/end position of each system individually; for example, if you 
want to indent a single system or increase the gap before an individual coda section.

NOTE

● If you want to increase the space before staff labels, you can change the minimum indent for 
systems with staff labels.

● If you want to change the end position of systems because they do not fill the entire width of 
the page, you can change the minimum fullness for horizontal justification.

● If you want to change the width of all systems on a page by the same amount, you can 
change the width of the music frame.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the system handle at the start/end of each system whose start/end 
position you want to change.

System handle at the start of a system System handle at the end of a system

2. Move the handles in any of the following ways:

● To move them a standard amount to the right or left, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move handles to 
the left.

● To move them a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move them a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow .

● To move them a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

NOTE

You cannot move note spacing handles with the mouse, you can only move them using the 
keyboard.
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RESULT
The start/end position of the selected systems is changed. Notes on the selected systems appear 
more/less tightly spaced, depending on whether moving the system handles made their system 
narrower or wider.

Dorico Elements automatically inserts system breaks at the start of the moved and subsequent 
systems.

RELATED LINKS
Engrave toolbox on page 503
System indents on page 1327
Changing the horizontal justification of final systems on page 612
Changing the first system indent on page 1328
Changing the minimum indent for systems with staff labels on page 1311
Positions of repeat markers on page 1241
System breaks on page 633

Moving items graphically
You can move items graphically without changing the rhythmic positions or notes to which they 
are attached; for example, to offset individual items on specific pages without moving other 
items of the same type elsewhere in the layout. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

You can move individual instances of system objects, such as tempo marks or system-attached 
text, independently of other instances shown at different staff positions. You can also move each 
end of items with duration, such as gradual dynamics or octave lines, independently, allowing 
you to adjust their graphical length and angle.

NOTE

● These steps do not apply to the following: text in text frames, accidentals, notes, clefs, 
barlines, key signatures, or time signatures shown on staves.

● You can only move some items and handles in specific directions. For example, you can 
move:

● Articulations upwards/downwards only, not to the right/left.

● Octave line end handles to the right/left only, not upwards/downwards.

● When using the mouse, you can only move whole guitar bends and vibrato bar dives/returns 
upwards/downwards.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select any of the following that you want to move.

● Whole items or segments of items that cross system/frame breaks

● Lines extending from items, such as figured bass hold lines or lyric extender lines

● Individual handles on items
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TIP

● You can cycle through handles on a selected item by pressing Tab .

2. Move the selected items in any of the following ways:

● To move items a standard amount to the right, left, up, or down, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move items to the 
left. This moves beams by 1/4 space and all other items by 1/8 space per press.

● To move items a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow . This moves items by 1 space per press.

● To move items a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow . This moves items by 1/2 space per press.

● To move items a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow . This moves items by 1/32 space per 
press.

● Click and drag them in any direction.

NOTE

● To constrain movement either horizontally or vertically, start dragging, then press 
and hold Shift .

● You cannot move vibrato bar scoops using the mouse.

RESULT
The selected items are moved graphically without changing the rhythmic positions or notes to 
which they are attached. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

Attachment lines link items to the rhythmic positions to which they apply, so it is always clear 
where they belong.

Moving some items, such as notehead brackets and jazz articulations, causes other nearby items, 
such as ties and slurs, to move automatically to avoid collisions. This might affect note spacing 
and casting off.

If you move dynamics linked to other dynamics, all dynamics linked to the selected dynamics in 
the current layout are also moved.

Moving items with continuation or hold lines, such as playing techniques or figured bass, moves 
them both together. Moving continuation/hold lines or continuation/hold line handles moves the 
continuation/hold lines independently of the item. Dorico Elements automatically lengthens hold 
lines between figured bass suspensions and resolutions when you move resolution figures.

Lengthening/Shortening lyric hyphens does not change the size or shape of the hyphens 
themselves. Instead, you increase/decrease the distance between the handles in which hyphens 
can appear.

By default, player labels erase their backgrounds if positioned in the staff so they do not collide 
with staff lines.

NOTE

● Moving the start handle of hairpins with the keyboard changes the vertical position of whole 
hairpins, not their angles. You must change the end offset position as well to change the 
angle of hairpins. Dragging hairpin handles with the mouse always changes the angle.
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● Properties that control the graphic offsets of items are activated automatically when you 
move items. You can find these properties in the corresponding group of the Properties 
panel for the item, or in the Common group for some items, such as text items and lyrics.

Some offset properties have separate value fields for horizontal offsets on the X axis and 
vertical offsets on the Y axis. Similarly, items with length or duration have separate offset 
properties for each end.

You can also use these properties to move items graphically by changing the values in 
the value fields. Deactivating offset properties resets the selected items to their default 
positions.

RELATED LINKS
Resetting the position of items on page 436
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Hiding/Showing attachment lines on page 437
Selecting notes/items on page 421
Moving notes/items rhythmically on page 461
Moving figured bass resolutions on page 966
Lengthening/Shortening items on page 430
Tucking index properties on page 518
Changing the vertical order of playing techniques on page 1185
Properties panel on page 663
Casting off on page 629
Note spacing on page 507
Adjusting note spacing at individual rhythmic positions on page 509
Moving clefs graphically on page 909
Moving barlines graphically on page 821
Moving key signatures graphically on page 1023
Moving time signatures graphically on page 1395
Moving accidentals graphically on page 797
Changing the alignment of chord symbols relative to notes on page 880
Guitar bends in Engrave mode on page 1131
Notehead brackets in Engrave mode on page 1072
Positions of lyrics on page 1035
Moving lyric lines vertically on page 1039
Lyric hyphens and lyric extender lines on page 1045
Octave lines in Engrave mode on page 918
Sustain pedal lines in Engrave mode on page 1163
Slurs in Engrave mode on page 1300
Lines in Engrave mode on page 1215
Frames on page 654

Selecting handles on items
In Engrave mode, you can select individual handles on items; for example, if you want to move 
the graphical end of a gradual dynamic without moving its start.

PROCEDURE

1. Select a handle in any of the following ways:

● Select the whole item and press Tab  until the handle you want is selected.
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● Click the handle you want.

2. Optional: Select handles on other items as well by Ctrl/Cmd -clicking them.

NOTE

You cannot select subsequent handles on other items by selecting the items and pressing 
Tab .

RELATED LINKS
Gradual dynamics on page 937
Changing the shape/angle of ties on page 1375

Hiding/Showing crosshairs
You can hide/show crosshairs in Engrave mode for selected items and/or when dragging items 
using the mouse. Crosshairs can make it easier to align items graphically.

PROCEDURE

● In Engrave mode, do one or both of the following:

● To hide/show crosshairs when dragging items, choose Engrave > Crosshairs > Show 
When Dragging.

● To hide/show crosshairs for selected items, choose Engrave > Crosshairs > Show When 
Selected.

RESULT
Crosshairs are hidden/shown in the corresponding context.

EXAMPLE

Crosshairs shown Crosshairs hidden

RELATED LINKS
Moving items graphically on page 514
Selecting/Deselecting notes and items individually on page 421
Large selections on page 424
Hiding/Showing signposts on page 450
Hiding non-printing elements on page 437
Hiding/Showing attachment lines on page 437
Annotations on page 597
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Tucking index properties
The tucking index of notations determines their position relative to other notations in the vertical 
stacking order when multiple notations exist at the same rhythmic positions.

In most published music, the order in which items appear relative to each other is consistent. 
Dorico Elements uses established conventions to determine the position and placement of 
notations automatically. For example, where slurs and tuplet brackets exist at the same 
positions, Dorico Elements calculates their placement based on their relative lengths. If the slur is 
longer than the tuplet bracket, the slur is placed outside the tuplet bracket; if the tuplet bracket is 
longer than the slur, the slur is placed inside the tuplet bracket.

However, rules for the order and placement of articulations, slurs, tuplets, and octave lines 
frequently vary, based on their lengths and musical context. Therefore, you can override the 
automatic order and manually change the order in which they appear in specific contexts.

To allow you this flexibility, slurs, octave lines, and tuplets all have Tucking index properties in 
their respective Properties panel groups.

NOTE

● Articulations are considered alongside these notations when calculating the stacking order, 
but do not have a tucking index property.

● Playing techniques have a separate tucking index that allows you to change the vertical 
order of playing techniques relative to each other.

A Tucking index value of 0 positions items closest to notes. The higher the number, the further 
away the item is positioned from notes in the stacking order.

RELATED LINKS
Changing the vertical order of playing techniques on page 1185
Changing the vertical stacking order of octave lines on page 919
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Play mode

Play mode allows you to change how your music sounds in playback, including by adjusting the 
mix, changing the playback template, and assigning VST instruments.

Project window in Play mode
The project window in Play mode contains all the tools and functions for setting up your project 
for playback. In Play mode, your project appears in a similar way to that used in a digital audio 
workstation, or “DAW”, such as Cubase.

You can switch to Play mode in any of the following ways:

● Press Ctrl/Cmd-4 .

● In the toolbar, click Play.

● Choose Window > Play.

The project window in Play mode comprises the following:

1 Left zone

Can display either the Track Inspector or VST and MIDI panel, according to the current 
selection at the top of the left zone.

2 Track overview

Allows you to view the tracks in the selected flow, mute/solo instrument tracks, and select 
the track whose music you want to show in the Key Editor or whose sounds you want to edit 
in the Track Inspector.

3 Lower zone
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Can display either the Key Editor panel or Mixer panel, according to the current selection in 
the lower zone toolbar.

RELATED LINKS
Toolbar on page 30
Project window on page 29
Track Inspector on page 522
VST and MIDI panel on page 525
Key Editor panel on page 667
Mixer panel on page 717
Hiding/Showing zones on page 44

Track overview
The track overview allows you to view the tracks in the selected layout and flow, and to mute and 
solo instrument tracks. It also allows you to select a single track whose music you want to show 
in the Key Editor, if it is unlocked, or whose sounds you want to edit in the Track Inspector. It is 
the central part of the window in Play mode.

The track overview contains the following:

1 Flow selector

Allows you to select the flow you want to show in the track overview. Only a single flow can 
be shown at a time. Only available when nothing is selected in any flow.

2 Track height button

Allows you to cycle through different heights for all tracks in the track overview.

3 Track visibility buttons

Allow you to hide/show the corresponding track.

● Tempo : Hides/Shows the Tempo track.

● Markers : Hides/Shows the Markers track.

● Chords : Hides/Shows the Chords track.

4 Mute /Solo  buttons

Allow you to mute/solo tracks. Shown in track headers when tracks are sufficiently tall, and 
at the top of the track overview when tracks appear short. They apply to the corresponding 
track when shown in track headers, and the selected track when shown at the top of the 
track overview.

5 Ruler

Displays bar numbers and shows beat divisions.

6 Track headers
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Display the name of each track and contain appropriate options for the track type.

Percussion kit track headers contain disclosure arrows, which allow you to show a separate 
track for each instrument in the kit.

7 Tracks

Rows that display an overview of the corresponding musical element, such as notes in 
instrument tracks and chord symbols in the chord symbols track.

8 Playhead

Shows the current rhythmic position in playback.

RELATED LINKS
Tracks on page 530
Instrument tracks on page 531
Tempo track on page 532
Markers track on page 534
Chords track on page 535
Key Editor on page 667
Showing instruments in the Key Editor on page 671
Hiding/Showing tracks on page 536
Muting/Soloing tracks on page 547
Playhead on page 538
Changing the height of tracks on page 537
Zooming in/out of tracks on page 537
Hiding/Showing zones on page 44
Switching between layouts on page 43

Switching between flows in the track overview
You can change which flow is displayed in the track overview in Play mode manually. Only a 
single flow can be shown at a time.

PREREQUISITE
You have deselected all notes/items. You cannot switch flows when notes/items are selected.

PROCEDURE

● In Play mode, click the flow selector at the top of the track overview and select a flow from 
the menu.

RELATED LINKS
Selecting/Deselecting notes and items individually on page 421
Switching between layouts on page 43
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Track Inspector
The Track Inspector allows you to edit sounds for the track currently selected in the track 
overview. It is located in the left zone in Play mode.

The Track Inspector contains the following sections:

Routing

Allows you to change the sound routing of the selected track.

The following routing controls are available:

Audio plug-in menu

Allows you to select the VST or MIDI instrument plug-in you want to use for the 
selected track. Only plug-ins already loaded in the project are available.

Port field
Allows you to change the endpoint to which the selected track is assigned by entering 
the port you want to use. Only necessary when using a plug-in that has multiple ports 
of 16 channels.

Channel field
Allows you to change the endpoint to which the selected track is assigned by entering 
the channel you want to use in the loaded VST or MIDI instrument.

NOTE

● You must assign a VST or MIDI instrument and a channel for the Chords track in 
order to hear chords in playback.

● If you manually load sounds into the channel you selected for your Chords 
track and later add more instruments to your project, the sounds for the new 
instruments overwrite the sounds you manually loaded in that channel.

Endpoint Setup

Opens the Endpoint Setup dialog for the corresponding plug-in instance.
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Edit Instrument

Opens the corresponding VST or MIDI instrument in a window, which allows you to edit 
its settings.

Expression map/Percussion map
Allows you to change the expression/percussion map for the endpoint to which the 
selected track is assigned.

Percussion map is only available for unpitched percussion tracks.

Edit Expression Map/Edit Percussion Map

Opens the Expression Map/Percussion Map dialog, with the corresponding 
expression/percussion map selected automatically.

Enable Independent Voice Playback

Allows you to enable independent voice playback for the selected instrument track. 
This shows each voice belonging to the instrument as a separate voice track below the 
instrument track.

Dorico Elements automatically loads enough additional channels, and additional plug-
in instances if necessary, to accommodate all voices belonging to the corresponding 
instrument project-wide, according to the current playback template. Voices are 
automatically assigned to endpoints according to their voice order.

Disable Independent Voice Playback

Allows you to disable independent voice playback for the selected instrument track and 
return it to using a single endpoint for all voices.

Edits apply to
Allows you to determine whether changing the routing of the selected voice affects the 
current flow only or all flows in the project.

Only applies to future changes you make immediately after choosing either This flow 
or All flows.

Only available for voice tracks belonging to instruments with independent voice 
playback enabled.

Insert Effects

Allows you to add and manage inserts on the Mixer channel for the selected instrument track. 
Each instrument track’s Mixer channel has four insert slots.
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Each slot contains the following:

Activate Insert

Activates/Deactivates the insert slot.

Insert menu

Allows you to select an insert to load into the slot.

Edit Insert

Opens the corresponding effect in a window, which allows you to edit its settings.

TIP

● You can also access inserts for all channels in the Mixer.

● For more information about the plug-ins included with Dorico Elements, see the separate 
document Plug-in Reference.

Channel

Shows the Mixer channel strip for the selected track and allows you to adjust the channel.
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TIP

You can also access all channels in the Mixer.

RELATED LINKS
Track overview on page 520
Instrument tracks on page 531
Endpoint Setup dialog on page 567
Expression Maps dialog on page 762
Percussion Maps dialog on page 781
Mixer on page 717
Mixer channel strips on page 722
Enabling independent voice playback on page 545
Changing the sound used for chord symbol playback on page 535
Loading VST/MIDI instruments manually on page 528

VST and MIDI panel
The VST and MIDI panel contains the VST and MIDI instruments available and used in your 
project, and allows you to edit their settings. It is located in the left zone in Play mode.

VST Instruments

The VST Instruments section of the panel contains plug-in instances that each contain a VST 
instrument plug-in. Dorico Elements automatically loads plug-ins and enough plug-in instances 
for the instruments you add to your project according to the current playback template, but you 
can also load VST instruments manually.

NOTE

Dorico Elements only shows VST 3 instruments in the VST Instruments section by default. 
If you also want VST 2 instruments to be available, you must allow them. Only Kontakt and 
NotePerformer are allowed by default.
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Each VST plug-in instance contains the following:

1 Activate Instance

Activates/Deactivates the plug-in instance.

2 Name

Displays the number and name of the plug-in instance. Plug-in instances are automatically 
numbered to help you differentiate between instances when you have multiple instances of 
the same plug-in.

3 VST Instruments menu

Displays the VST instrument currently loaded in the plug-in instance and allows you to select 
another available VST instrument from the menu.

4 Endpoint Setup

Opens the Endpoint Setup dialog for the corresponding plug-in instance.

5 Edit Instrument

Opens/Closes the VST instrument window.

The action bar at the bottom of the section contains the following options:

● Add : Adds a new empty plug-in instance.

● Duplicate : Creates a copy of the selected plug-in instance that you can edit separately 
from the original.

● Save Endpoint Configuration : Opens the Save Endpoint Configuration dialog, which 
allows you to save the current state of all plug-in instances in the section as a custom 
endpoint configuration.

● Delete : Deletes the selected plug-in instance.

MIDI Instruments

The MIDI Instruments section of the panel contains plug-in instances that each contain a MIDI 
device to use for output during playback. Which MIDI devices are available depends on your 
operating system.

● On Windows, you can select any MIDI device that is plugged into your computer.

● On macOS, you can select any MIDI device that is plugged into your computer, and any other 
device set up in the Audio MIDI Setup application. For example, this allows you to use MIDI 
from one application in another application.

TIP

We recommend plugging MIDI devices into your computer before starting Dorico Elements. 
Similarly, if your device is not recognized, we recommend restarting Dorico Elements.
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Each MIDI plug-in instance contains the following:

1 Name

Displays the number and name of the plug-in instance. Plug-in instances are automatically 
numbered to help you differentiate between instances when you have multiple instances of 
the same plug-in.

2 MIDI Instruments menu

Displays the MIDI device currently loaded in the plug-in instance and allows you to select 
another available MIDI device from the menu.

3 Endpoint Setup

Opens the Endpoint Setup dialog for the corresponding plug-in instance.

The action bar at the bottom of the section contains the following options:

● Add : Adds a new empty plug-in instance.

● Save Endpoint Configuration : Opens the Save Endpoint Configuration dialog, which 
allows you to save the current state of all plug-in instances in the section as a custom 
endpoint configuration.

● Delete : Deletes the selected plug-in instance.

RELATED LINKS
Project window in Play mode on page 519
Playback templates on page 558
Endpoints on page 567
Endpoint Setup dialog on page 567
Custom endpoint configurations on page 571
Save Endpoint Configuration dialog on page 573
Loading VST/MIDI instruments manually on page 528
Editing VST instruments on page 529

Allowing/Blocking VST plug-ins
You can allow individual VST 2 instrument plug-ins that you want to use in Dorico Elements 
and block plug-ins you want to prevent Dorico Elements from using. Allowed plug-ins are 
subsequently available in any project.

Dorico Elements automatically blocks plug-ins that crash and plug-ins that Steinberg has not 
already qualified for use with Dorico Elements. Only Kontakt and NotePerformer are allowed by 
default.

NOTE

This application runs natively on Apple Silicon and supports native VST 3 plug-ins only. Support 
for VST 2 plug-ins is available in Rosetta mode.
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PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click VST Plug-ins.

3. In the Allowed VST 2 Plug-ins subsection, allow plug-ins in any of the following ways:

● To allow individual blocked plug-ins, select them in the Blocked Plug-ins list and click 
Allow selected plug-ins  in the action bar.

● To allow all blocked plug-ins, click Allow All in the Blocked Plug-ins list action bar.

● To allow a plug-in not included in the Blocked Plug-ins list, click Add plug-in name  in 
the Allowed Plug-ins list action bar, then enter the name of the plug-in in the new entry.

4. Block plug-ins in any of the following ways:

● To block individual allowed plug-ins, select them in the Allowed Plug-ins list and click 
Block selected plug-ins  in the action bar.

● To block all allowed plug-ins, click Block All in the Allowed Plug-ins list action bar.

5. Click Apply, then Close.

6. Quit Dorico Elements.

RESULT
When Dorico Elements next opens, your allowed VST plug-in entries are available for use in the 
program.

RELATED LINKS
Preferences dialog on page 58
Track Inspector on page 522
Playing back music on page 540
Playback templates on page 558

Loading VST/MIDI instruments manually
Dorico Elements automatically loads plug-in instances as required, according to the instruments 
in the project and the current playback template. However, you can also load VST/MIDI 
instruments manually, either into new plug-in instances or into existing ones to replace existing 
VST/MIDI instruments.

PREREQUISITE

● Any VST instruments you want to use are saved on your computer.

● You have connected any MIDI devices you want to use.

TIP

We recommend plugging MIDI devices into your computer before starting Dorico Elements. 
Similarly, if your device is not recognized, we recommend restarting Dorico Elements.

PROCEDURE

1. In Play mode, choose VST and MIDI in the left zone to show the VST and MIDI panel.

2. Optional: If you want to load a VST/MIDI instrument into a new plug-in instance, click Add 
in the corresponding section of the VST and MIDI panel.

3. In the plug-in instance into which you want to load a new VST/MIDI instrument, select the 
one you want to load from the menu.
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AFTER COMPLETING THIS TASK

● You can edit VST instruments, such as by loading sounds into channels.

● You can assign instruments/voices and expression/percussion maps to endpoints in the VST/
MIDI instruments you loaded.

● You can save your changes to VST instruments and endpoints as custom endpoint 
configurations for reuse in other projects.

NOTE

If you loaded a MIDI instrument, we strongly recommend disabling it for MIDI input to avoid 
feedback loops.

RELATED LINKS
Playback templates on page 558
Applying/Resetting playback templates on page 564
VST and MIDI panel on page 525
Endpoint Setup dialog on page 567
Enabling/Disabling MIDI input devices on page 270
Assigning instruments/voices to endpoints on page 569
Assigning expression/percussion maps to endpoints on page 570
Saving custom endpoint configurations on page 572
Creating custom playback templates on page 564
Importing drum set patterns from Groove Agent SE on page 94

Editing VST instruments
You can edit the sounds and effects loaded into VST instruments; for example, if you are using a 
third-party sound library.

PREREQUISITE
You have loaded the VST instruments that you want to edit, either manually or by applying a 
playback template.

PROCEDURE

1. In Play mode, choose VST and MIDI in the left zone to show the VST and MIDI panel.

2. In a plug-in instance containing the VST instrument that you want to edit, click Edit 
Instrument  to open the VST instrument window.

3. Edit the VST instrument using the available options.
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For example, you can:

● Load sounds into channels, such as a different type of guitar or “Oo” vocals.

● Adjust controls, such as the amount of air for flute sounds.

● Change effects, such as loading distortion and delay effects for guitars.

TIP

● For more information about the sounds and effects you can edit and load, see the 
documentation for your sound libraries.

● You can assign a key command for Show VST Plug-in Window For Selected Staff on the 
Key Commands page in Preferences. This command opens the VST instrument window 
for the first selected staff/voice in the music area, or the track selected in the track 
overview.

AFTER COMPLETING THIS TASK

● You can assign instruments/voices and expression/percussion maps to endpoints in VST 
instruments.

● You can save your changes to VST instruments and endpoints as custom endpoint 
configurations for reuse in other projects.

Tracks
Tracks are rows that represent a musical element across time, extending from left to right. They 
allow you to control multiple musical elements in a project simultaneously but independently of 
each other.

The term was established when audio mixing was done on tapes, and multitracking allowed 
separate elements of the music to be recorded and edited independently of each other before 
being combined into the final piece of music.

In modern programs, such as Cubase, tracks can contain many types of sounds, including 
audio recordings and software instruments. Tracks containing audio recordings often display the 
waveform of the audio, while tracks containing software instruments often display the pitches as 
rectangular note events positioned horizontally in time and vertically in pitch on a piano roll.

Dorico Elements provides the following types of tracks in Play mode:

Instrument tracks
Display previews of the notes belonging to the corresponding instrument. Each 
instrument in the project has its own instrument track, including when a single player 
holds multiple instruments.

Selecting an instrument track shows its music in the Key Editor, if it is unlocked, and its 
track settings in the Track Inspector.

Tempo track
Displays a preview of any tempo changes in the flow. Each project contains a single 
Tempo track.

Selecting the Tempo track shows the Tempo editor in the Key Editor panel, if it is 
unlocked, and its track settings in the Track Inspector.

Markers track
Displays any markers in the flow, including their text. Each project contains a single 
Markers track.
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Chords track
Displays any chord symbols in the flow. Each project contains a single Chords track.

Selecting the Chords track shows its track settings in the Track Inspector.

RELATED LINKS
Track overview on page 520
Track Inspector on page 522
Key Editor on page 667
Showing instruments in the Key Editor on page 671
Tempo track on page 532
Chords track on page 535
Markers track on page 534
Changing the height of tracks on page 537
Hiding/Showing tracks on page 536
Hiding/Showing zones on page 44
Mixer channels on page 720

Instrument tracks
Instrument tracks allow you to preview notes belonging to the corresponding instrument and 
select the instrument you want to show in the Key Editor.

Each instrument in the project has its own instrument track in Play mode, including when a 
single player holds multiple instruments. Instrument tracks are labeled using the full instrument 
name set for each instrument.

When independent voice playback is enabled, each voice belonging to the corresponding 
instrument appears as a separate voice track below the instrument track.

Similarly, you can expand percussion kit tracks to show a separate track for each instrument in 
the kit.

Instruments are automatically assigned a color according to their player order in the current 
layout, so that you can tell them apart more easily. This color is used consistently for the 
corresponding instrument, including in the Mixer and Key Editor.

When an instrument track is selected in the track overview, you can do the following:

● View and edit its notes and data in the Key Editor panel, if it is unlocked.

● Use the Track Inspector to change the routing of the track.

Piano instrument track with two voice tracks below

Each instrument track comprises the following:

1 Track name

Shows the name of the track.

● Instrument tracks display the full instrument name set for the instrument.

● Voice tracks display the stem direction and number of the corresponding voice. For 
instruments with multiple staves, the staff of the corresponding voice is also included.
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2 Mute /Solo  buttons

Allow you to mute/solo the track. Shown in track headers when tracks are sufficiently 
tall, and at the top of the track overview when tracks appear short. They apply to the 
corresponding track when shown in track headers, and the selected track when shown at the 
top of the track overview.

3 Track preview

Displays a preview of notes belonging to the instrument.

RELATED LINKS
Key Editor on page 667
Piano roll editor on page 678
Percussion editor on page 679
Showing instruments in the Key Editor on page 671
Velocity editor on page 691
Dynamics editor on page 694
Playing Techniques editor on page 690
MIDI CC editor on page 701
Player, layout, and instrument names on page 181
Changing instrument names on page 183
Inputting notes into multiple voices on page 232
Voices on page 1438
Endpoint Setup dialog on page 567
Muting/Soloing tracks on page 547
Enabling independent voice playback on page 545
Assigning instruments/voices to endpoints on page 569
Changing the default player order on page 125
Setting custom player orders on page 126
Changing the height of tracks on page 537

Tempo track
The Tempo track displays tempo changes in the selected flow. It appears at the top of the track 
overview in Play mode, and is one of the tracks you can hide/show. Each project contains a single 
Tempo track.

Tempo track

When the Tempo track is selected in the track overview, you can do the following:

● Edit and input tempo changes in the Tempo editor in the Key Editor panel, if it is unlocked.

● Use the Track Inspector to change the sound used for the click.

RELATED LINKS
Hiding/Showing tracks on page 536
Track Inspector on page 522
Key Editor on page 667
Tempo editor on page 706
Showing instruments in the Key Editor on page 671
Tempo marks on page 1335
Input methods for tempo marks on page 293
Signposts on page 450
Changing the click settings on page 267
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Hiding/Showing tempo marks on page 1340
Exporting MIDI on page 95

Changing the sound used for the click
You can change the sound used for the click in playback by assigning the Tempo track to the 
required endpoint, including loading a new sound manually if required; for example, if you want 
to use a sound that is not provided by default.

TIP

You can choose an available factory default click sound in Playback Options > Click > 
Metronome Click. Click, beep, and wood block sounds are provided by default.

PREREQUISITE

● The Tempo track is shown.

● You have loaded the VST/MIDI instrument you want to use for the click.

PROCEDURE

1. In Play mode, select the Tempo track in the track overview.

2. In the Track Inspector, in the Routing section, select the VST/MIDI instrument plug-in you 
want to use for the click from the audio plug-in menu.

3. Optional: If the sound you want to use is not already loaded in the plug-in instance, click Edit 
Instrument  to open the corresponding VST or MIDI instrument in a window, then load 
the required sound into an available channel.

4. Select the required endpoint in the plug-in instance using the following value fields, 
individually or together:

● To assign the Tempo track to a different port in the selected plug-in instance, enter the 
required port in the Port field.

NOTE

Only necessary when using a plug-in that has multiple ports of 16 channels.

● To assign the Tempo track to a different channel in the selected port, enter the required 
channel in the Ch. field.

RELATED LINKS
Playback Options dialog on page 749
Loading VST/MIDI instruments manually on page 528
Track Inspector on page 522
Endpoints on page 567
Endpoint Setup dialog on page 567
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Markers track
The Markers track displays markers in the selected flow and allows you to input new markers. 
It appears at the top of the track overview in Play mode, and is one of the tracks you can hide/
show. Each project contains a single Markers track.

The Markers track comprises the following:

1 Add Marker

Opens the Add Marker dialog, which allows you to input a marker.

2 Markers

Show the position of each marker in the flow, including their text.

RELATED LINKS
Hiding/Showing tracks on page 536
Markers on page 1221
Videos on page 189
Editing marker text on page 1223

Inputting markers in the Markers track
You can input markers directly into the Markers track in Play mode.

PREREQUISITE
The Markers track is shown.

PROCEDURE

1. In Play mode, move the playhead to the time position where you want to input a marker.

NOTE

You cannot input markers in negative time, such as when a video starts three bars into the 
flow, causing the initial timecode of the flow to be in negative time.

2. In the Markers track header, click Add Marker  to open the Add Marker dialog.

3. Enter the marker text you want into the Text field.

4. Optional: Change the timecode in the Timecode field.

5. Click OK to input the marker and close the dialog.

RESULT
A marker is input at the position of the playhead. It shows the text you entered, or the default 
text “Marker” if you did not change the marker text.

EXAMPLE

Marker in the Markers track
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RELATED LINKS
Moving the playhead on page 538
Add Marker dialog on page 402
Editing marker text on page 1223
Changing the start position of videos on page 191

Chords track
The Chords track displays chord symbols in the selected flow and allows you to hear the 
corresponding chords in playback. It appears at the top of the track overview in Play mode, 
and is one of the tracks you can hide/show. Each project contains a single Chords track.

When the Chords track is selected in the track overview, you can use the Track Inspector to 
change its routing.

The Chords track comprises the following:

1 Enable Chords Playback

Allows you to include chords in, or exclude chords from, playback.

2 Chords

Indicates where chord symbols exist in the flow and shows the chord symbol name.

RELATED LINKS
Chord symbols on page 871
Track overview on page 520
Track Inspector on page 522
Loading VST/MIDI instruments manually on page 528
Hiding/Showing tracks on page 536

Enabling chord symbol playback
You can include chord symbols in playback. They are played as sustained chords, with their 
duration taken from the gap between one chord symbol and the next. Chord symbols input via 
a MIDI keyboard use the voicing you played when inputting them, whereas chord symbols input 
via a computer keyboard use a default voicing.

PREREQUISITE
The Chords track is shown.

PROCEDURE

● In Play mode, activate Enable Chords Playback  in the Chords track header.

Changing the sound used for chord symbol playback
You can change the sound used for chord symbol playback by assigning the Chords track to the 
required endpoint, including loading a new sound manually if required; for example, if you want 
to use a sound that is not used by any of the instrument tracks in your project.

PREREQUISITE

● The Chords track is shown.

Play mode
Tracks 

535
Dorico Elements 5.1.30



● You have loaded the VST/MIDI instrument you want to use for chord symbol playback.

PROCEDURE

1. In Play mode, select the Chords track in the track overview.

2. In the Track Inspector, in the Routing section, select the VST/MIDI instrument plug-in you 
want to use for chord symbol playback from the audio plug-in menu.

3. Optional: If the sound you want to use is not already loaded in the plug-in instance, click Edit 
Instrument  to open the corresponding VST or MIDI instrument in a window, then load 
the required sound into an available channel.

4. Select the required endpoint in the plug-in instance using the following value fields, 
individually or together:

● To assign the Chords track to a different port in the selected plug-in instance, enter the 
required port in the Port field.

NOTE

Only necessary when using a plug-in that has multiple ports of 16 channels.

● To assign the Chords track to a different channel in the selected port, enter the required 
channel in the Ch. field.

RELATED LINKS
Loading VST/MIDI instruments manually on page 528
Track Inspector on page 522
Endpoints on page 567
Endpoint Setup dialog on page 567

Resetting the voicing of chord symbols
When you input chord symbols via a MIDI keyboard, the voicing you used is retained for chord 
symbol playback. You can reset the voicing of chord symbols input using MIDI keyboards; for 
example, if you prefer to hear the default voicing for that chord symbol in playback.

PROCEDURE

1. In Write mode, select the chord symbols whose voicing you want to reset.

2. Choose Edit > Notations > Chord Symbols and Diagrams > Clear Chord Symbol Played 
Pitches. You can also choose this option from the context menu.

RELATED LINKS
Inputting chord symbols on page 318

Hiding/Showing tracks
You can hide/show the Tempo, Markers, and Chords tracks at the top of the track overview 
independently of each other.

NOTE

You cannot hide/show player and instrument tracks.
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PROCEDURE

● At the top of the track overview, hide/show tracks in the following ways:

● To show/hide the Tempo track, activate/deactivate Tempo .

● To show/hide the Markers track, activate/deactivate Markers .

● To show/hide the Chords track, activate/deactivate Chords .

RELATED LINKS
Track overview on page 520
Tracks on page 530
Key Editor panel on page 667
Piano roll editor on page 678

Changing the height of tracks
You can change the height of all types of tracks; for example, to preview more tracks 
simultaneously. This does not affect the width of tracks.

PROCEDURE

● In Play mode, click Track height  at the top left of the track overview to cycle through 
different track heights.

NOTE

When tracks appear short, Mute  and Solo  buttons appear at the top of the track 
overview. They only appear in each track header when there is sufficient vertical space.

RELATED LINKS
Changing the height of the Key Editor on page 673
Zooming in/out of the Key Editor on page 674

Zooming in/out of tracks
You can change the width of tracks in the track overview; for example, to preview more bars 
simultaneously. This does not affect the height of tracks.

PROCEDURE

1. Zoom in horizontally in any of the following ways:

● Click in the ruler and drag upwards.

● Ctrl/Cmd -scroll upwards in the ruler.

● Click Zoom In  at the bottom of the track overview.

2. Zoom out horizontally in any of the following ways:

● Click in the ruler and drag downwards.

● Ctrl/Cmd -scroll downwards in the ruler.

● Click Zoom Out  at the bottom of the track overview.
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Playhead
The playhead is a vertical line that moves during playback, showing the current rhythmic 
position. It is also known as a “playback line”.

The playhead appears at all times in Play mode and during playback in other modes, and its 
current position is displayed in both the Transport window and the mini transport in the toolbar. 
You can also choose to show the playhead when playback is stopped in other modes.

The playhead in the Key Editor

Dorico Elements automatically keeps the playhead in view during playback by moving it along 
with the music, but you can disable playhead following to keep the view stationary. When 
playhead following is enabled, Dorico Elements tries to keep systems in a consistent place on 
the screen.

You can also move the playhead manually.

NOTE

The playhead never appears in Print mode.

RELATED LINKS
Changing music area colors on page 54

Moving the playhead
The playhead automatically moves along with the music during playback, but you can also move 
the playhead manually in any mode.

You can move the playhead both when it is stopped and during playback, but not all methods of 
moving the playhead work during playback.

By default, the playhead is only shown during playback but you can choose to show the playhead 
at all times.

PROCEDURE

● Move the playhead in any of the following ways:

● To move the playhead forwards, press Num +  (plus on a numeric keypad) or click Fast 
Forward  in the Transport window.

● To move the playhead backwards, press Num -  (minus on a numeric keypad) or click 
Rewind  in the Transport window.

● To move the playhead back to the start of the flow, press Num .  (period on a numeric 
keypad) or click Rewind to Beginning of Flow  in the Transport window or mini 
transport.

● To move the playhead to the start of the earliest selected item, press Alt/Opt-P .
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● To move the playhead forwards by frames, press Ctrl/Cmd-Num + or Ctrl/Cmd-F9 .

● To move the playhead backwards by frames, press Ctrl/Cmd-Num - or Ctrl/Cmd-F7 .

● In Play mode or the Key Editor, click the ruler at any position.

NOTE

You cannot click the ruler to move the playhead during playback.

RELATED LINKS
Transport window on page 555
Mini transport on page 32
Preferences dialog on page 58
Frame rates on page 193

Hiding/Showing the playhead
You can hide/show the playhead when playback is stopped; for example, to help line up your 
music when working with timecodes and video. By default, the playhead is hidden when playback 
is stopped, except in Play mode, where it always appears.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the Playhead subsection, activate/deactivate Show playhead when stopped.

4. Click Apply, then Close.

RESULT
The playhead is shown outside of playback when Show playhead when stopped is activated, 
and hidden when it is deactivated.

NOTE

This does not apply to Play mode or Print mode. The playhead always appears in Play mode and 
never appears in Print mode.

Enabling/Disabling playhead following
You can enable/disable views to follow the playhead during playback in each project window 
independently; for example, if you want keep a specific system in view while listening to your 
music.

PROCEDURE

● In the status bar, activate/deactivate Follow playhead.

RESULT
Playhead following during playback is enabled when Follow playhead is activated, and disabled 
when it is deactivated.
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TIP

● You can change whether playhead following is enabled/disabled by default in all projects in 
Preferences > Play > Playhead.

● You can assign a key command for Toggle Follow Playhead on the Key Commands page in 
Preferences.

RELATED LINKS
Status bar on page 38
Opening multiple project windows on page 49
Moving the view in the music area on page 442
Preferences dialog on page 58
Key Commands page in the Preferences dialog on page 60

Playing back music
You can listen to the music you have written from the beginning of your project or from a specific 
point. You can use playback key commands in any mode.

PREREQUISITE

● Playback is activated in the current project.

● You have applied a playback template to the project that includes sounds for the instruments 
in your project.

● If you want to use different sounds for different voices, you have enabled independent voice 
playback for those instruments.

● If you do not want to hear sounds from connected MIDI devices, you have disabled MIDI 
thru.

PROCEDURE

1. Start playback in one of the following ways:

● To play back from the earliest selected item, make a selection, then either press P , 
click Play From Selection  in the Transport window, or choose Play > Play From 
Selection.

TIP

● To play back all instruments, select a single note.

● To play back only a single staff, select multiple items on the staff.

● To play back multiple staves, select items on multiple staves.

This does not affect which channels are soloed or muted in the Mixer.

● To continue playback from the playhead position, either press Space or Enter , click Play 
 in the mini transport, click Play From Playhead Position  in the Transport window, 

or choose Play > Play From Playhead Position.

● To move the playhead and start playback from its new position simultaneously, double-
click the ruler at the top of the track overview or Key Editor at the required position.

● To play back from the last playback start position, press Shift-Space  or choose Play > 
Play From Last Start Position. This works even if you have since deselected the item at 
that position.
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● To play back from the start of the flow, press Shift-Alt/Opt-Space  or choose Play > Play 
From Start of Flow.

● To play back from the start of the project, choose Play > Play From Start of Project.

2. Optional: Move the playhead during playback to later/earlier positions.

3. Optional: To enable/disable the metronome click, click Click  in the Transport window or 
mini transport.

TIP

You can assign a key command for Enable Click on the Key Commands page in 
Preferences.

4. Stop playback in any of the following ways:

● Press Space or Enter  or P .

● Press Num 0  (0 on a numeric keypad).

● In the mini transport, click Stop .

● In the Transport window, click Stop .

● Double-click the ruler at the top of the track overview or Key Editor.

TIP

If you notice a change in sound when stopping playback, you can deactivate Reset 
controllers and send ‘all notes off’ when stopping playback on the Play page in 
Preferences.

RELATED LINKS
Playback templates on page 558
Applying/Resetting playback templates on page 564
Enabling independent voice playback on page 545
Enabling/Disabling MIDI thru on page 216
Loading VST/MIDI instruments manually on page 528
Allowing/Blocking VST plug-ins on page 527
Playhead on page 538
Mixer on page 717
Muting/Soloing tracks on page 547
Repeats in playback on page 549
Including/Excluding pauses in playback on page 1016
Changing the pre-roll duration on page 544
Changing the gap between flows in playback on page 545
Changing the click settings on page 267
MIDI trigger regions on page 574
Track overview on page 520
Key Editor panel on page 667
Endpoint Setup dialog on page 567
Transport window on page 555
Mini transport on page 32
Preferences dialog on page 58
Key Commands page in the Preferences dialog on page 60
Status bar on page 38
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Activating/Deactivating playback
You can activate/deactivate playback and transport functions in each project independently. For 
example, to prevent re-loading of sounds when copying material between projects with different 
playback templates.

PROCEDURE

● In the toolbar or Transport window, activate/deactivate Activate Project .

RESULT
Playback and transport functions are activated/deactivated.

TIP

You can change the default playback activation behavior in Preferences > Play > Project 
Activation.

RELATED LINKS
Toolbar on page 30
Transport window on page 555
Preferences dialog on page 58

Scrubbing
You can use scrub playback to listen to your music at variable speeds and both forwards and 
backwards, according to how you move the mouse pointer. This can help you locate specific 
rhythmic positions to edit.

PREREQUISITE

● Playback is activated in the current project.

● You have applied a playback template to the project that includes sounds for the instruments 
in your project.

● If you want to scrub specific instruments only, you have activated the appropriate 
instrument filter or selected at least one note/item on the corresponding staves.

PROCEDURE

1. In Write mode, activate scrub playback in any of the following ways:

● In the toolbar, activate Scrub Playback .

● Choose Play > Scrub Playback.

● To scrub all staves, press and hold Ctrl-Space (Windows) or Opt-Space (macOS) .

● To solo the instrument underneath the mouse pointer, press and hold Ctrl-Shift-
Space (Windows) or Shift-Opt-Space (macOS) .

2. Scrub in any of the following ways:

● Move the mouse pointer to the rhythmic positions and instruments you want to hear 
played back.

● When scrubbing all staves, press Right Arrow / Left Arrow  to move the playhead to the 
next/previous note.

During scrub playback, the playhead is shown at the mouse pointer position and the mouse 
pointer appears as a speaker icon.
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3. Deactivate scrub playback in any of the following ways:

● Press Esc .

● In the toolbar, deactivate Scrub Playback .

● Choose Play > Scrub Playback.

● Release the key command.

RESULT
Music at the mouse pointer position is played back and sustained. The speed of playback 
depends on how fast you move the mouse pointer. During solo scrubbing, the instrument played 
back depends on the staff the mouse pointer is over.

NOTE

● Non-rhythmic notes, including grace notes, are not played back during scrubbing.

● When scrubbing music with repeats, Dorico Elements plays back music from the first 
playthrough.

● You can assign a key command for Toggle Scrub Playback on the Key Commands page in 
Preferences.

RELATED LINKS
Applying/Resetting playback templates on page 564
Muting/Soloing tracks on page 547
Activating/Deactivating instrument filters on page 448
Selecting/Deselecting notes and items individually on page 421
Key Commands page in the Preferences dialog on page 60

Changing the tempo mode
You can switch the tempo mode at any time between using a single fixed tempo and following 
tempo changes; for example, if you have a project with multiple tempo changes but want to use 
a single fixed tempo when recording MIDI.

PREREQUISITE
Playback is activated in the current project.

PROCEDURE

1. Change the tempo mode in any of the following ways:

● Click Tempo Mode  in the toolbar.

● Choose Play > Fixed Tempo Mode.
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Fixed Tempo Mode Follow Tempo Mode

2. Optional: When Fixed Tempo Mode  is active, change the metronome mark value by 
clicking the Fixed Tempo Mode number in the toolbar to show a slider, then dragging the 
slider to the right/left.

RESULT
In follow tempo mode, the tempo for playback and recording is set by tempo marks in the 
project.

In fixed tempo mode, the tempo for playback and recording is a single tempo, as determined by 
the Fixed Tempo Mode metronome mark value.

RELATED LINKS
Toolbar on page 30
Tempo marks on page 1335
Tempo track on page 532
Tempo editor on page 706
MIDI recording on page 264
Playing back music on page 540
Including/Excluding pauses in playback on page 1016
Transport window on page 555

Changing the pre-roll duration
In Dorico Elements, pre-roll is the time added to playback before the first beat of the first bar 
in each flow. You can change the pre-roll duration before all flows project-wide; for example, if 
some flows in your project start with grace notes and you want to hear them in playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Timing.

3. In the Flows section, change the value for Pre-roll before flow.

For example, for flows starting with a single grace note, 0.25 seconds is usually sufficient.

4. Click Apply, then Close.

RESULT
The duration of the pre-roll before each flow in playback, measured in seconds, is changed.

RELATED LINKS
Playing back music on page 540
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Changing the gap between flows in playback
You can change the gap between all flows in playback, measured in seconds; for example, if the 
flows in your project should be played attacca and you want no gap between them.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Timing.

3. In the Flows section, change the value for Gap between flows during playback.

4. Click Apply, then Close.

Changing the playback tuning
You can change the tuning used for playback, based on the pitch of the A above middle C; for 
example, if you want to hear your music played at the Baroque pitch of A=415 Hz.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Tuning.

3. Change the value for Pitch of first A above middle C.

4. Click Apply, then Close.

RESULT
The tuning of all notes in the project is changed, which affects their sounding pitch in playback.

TIP

The sample rate of the current playback device also affects the playback tuning.

RELATED LINKS
Preferences dialog on page 58
Changing the audio device buffer size on page 269
Changing the middle C numbering convention on page 51

Enabling independent voice playback
By default, all voices belonging to a single instrument, including divisi staves, use the same 
endpoint for playback. You can enable independent voice playback for individual instruments; for 
example, to hear the different playing techniques in playback for a string divisi where some parts 
are pizzicato and some parts are arco.

NOTE

You cannot enable independent voice playback for unpitched percussion instruments and 
percussion kits.

PROCEDURE

1. In Play mode, in the track overview, select the instrument track for which you want to enable 
independent voice playback.
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2. In the Track Inspector, click Enable Independent Voice Playback  in the Routing section.

RESULT
Independent voice playback is enabled for the selected instrument. Each voice belonging to the 
instrument appears as a separate voice track below the instrument track.

Dorico Elements automatically loads enough additional channels, and additional plug-in 
instances if necessary, to accommodate all voices belonging to the corresponding instrument 
project-wide, according to the current playback template. Voices are automatically assigned to 
endpoints according to their voice order.

NOTE

When independent voice playback is enabled, you can only change the routing and effects of 
each voice track.

AFTER COMPLETING THIS TASK
You can change the routing and effects of each voice track, including in each flow independently; 
for example, if some voices in some flows require a solo sound instead of an ensemble one.

RELATED LINKS
Track overview on page 520
Track Inspector on page 522
Playback templates on page 558
Endpoints on page 567
Instrument tracks on page 531
Piano roll editor on page 678
Velocity editor on page 691
Dynamics editor on page 694
MIDI CC editor on page 701
Playing Techniques editor on page 690
Assigning instruments/voices to endpoints on page 569
Playback techniques on page 787
Tremolos in playback on page 1405
Articulations in playback on page 809
Slurs in playback on page 1308
Dynamics in playback on page 953

Disabling independent voice playback
You can disable independent voice playback for individual instrument tracks and return them to 
using a single endpoint for all voices.

PROCEDURE

1. In Play mode, in the track overview, select the instrument track for which you want to disable 
independent voice playback.

NOTE

You must select the instrument track, not any of its voice tracks.

2. In the Track Inspector, click Disable Independent Voice Playback  in the Routing section.
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RESULT
Independent voice playback is disabled for the selected instrument. Its voice tracks disappear 
from the track overview, and all voices belonging to the instrument return to using a single 
endpoint for playback.

Muting/Soloing tracks
You can mute/solo individual tracks, instruments, and voices belonging to instruments with 
independent voice playback enabled. This can be useful if you want to ensure only certain 
instruments are played back while you are working on a specific section of a project.

PROCEDURE

1. Mute tracks in any of the following ways:

● In the Mixer, click Mute  in the corresponding channels.

● In Play mode, click Mute  for the corresponding tracks in the track overview.

2. Solo tracks in any of the following ways:

● In the Mixer, click Solo  in the corresponding channels.

● In Play mode, click Solo  for the corresponding tracks in the track overview.

● To solo selected instruments and mute other instruments, select at least one note 
belonging to each instrument you want to solo, then press Alt/Opt-S  or choose Play > 
Solo Selected Instruments.

RESULT
The corresponding tracks are muted/soloed. This affects playback until you change which tracks 
are muted/soloed, meaning you do not have to reselect the tracks you want to hear each time.

NOTE

● Soloing tracks automatically mutes all other tracks. If you solo a track that was muted, it is 
automatically unmuted.

● You can also play back only specific tracks/staves temporarily by selecting notes/items on 
each track/staff you want to hear, then starting playback.

EXAMPLE

Mute when enabled Solo when enabled

RELATED LINKS
Track overview on page 520
Mixer on page 717
Playing back music on page 540
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Deactivating mute/solo instrument states
You can deactivate the mute and solo states of all instruments in your project; for example, if you 
want to hear all instruments in playback after soloing a small selection.

PROCEDURE

● Deactivate mute/solo instrument states in the following ways:

● To deactivate all mute instrument states, press Alt/Opt-U  or click Deactivate All Mute 
States  in the Mixer toolbar.

● To deactivate all solo instrument states, press Shift-Alt/Opt-S  or click Deactivate All 
Solo States  in the Mixer toolbar.

RESULT
All instruments in the project have the corresponding state removed. For example, removing 
both mute and solo instrument states reverts all instruments to their default state, causing all 
instruments to be included in playback.

RELATED LINKS
Mixer window on page 718
Mixer toolbar on page 719

Muting notes/items individually
You can mute individual notes and items to exclude them from playback without deleting 
them, and in specific playthroughs only. For example, if you want to hear chords without their 
arpeggios, a passage with multiple dynamics at a single volume level, or without tempo changes 
from specific tempo marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes/items you want to mute. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Suppress playback in the Common group.

3. Choose one of the following options:

● To mute the selected notes/items in all playthroughs, choose Always.

● To mute the selected notes/items only in specific playthroughs, choose On Passes.

4. Optional: If you chose On Passes, activate Suppress on passes.

5. Optional: Enter the playthroughs in which you want to mute the selected notes/items.

● To specify a range of playthroughs, enter the first playthrough and last playthrough 
separated with a dash, such as 1-4.

● To specify individual playthroughs or separate ranges, enter each playthrough/range 
separated with commas, such as 1,3,5-8.

RESULT
The selected items are muted in either all or only the specified playthroughs.
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TIP

You can assign a key command for Toggle Suppress Playback on the Key Commands page in 
Preferences.

RELATED LINKS
Properties panel on page 663
Hiding/Showing zones on page 44
Changing the tempo mode on page 543
Key Commands page in the Preferences dialog on page 60

Hiding/Showing colors for muted notes/items
You can hide/show colors for individual notes/items whose playback you have suppressed, which 
causes them to appear gray.

PROCEDURE

● Choose View > Note And Rest Colors > Suppressed Playback.

RELATED LINKS
View options for notes and rests on page 1064
Hiding/Showing rest colors on page 1275
Hiding/Showing voice colors on page 1439

Repeats in playback
Dorico Elements supports the playback of repeat structures, including repeat endings, repeat 
barlines, and repeat markers, provided all the correct jumps and sections are in place.

There is no limit to the number of repeat structures you can have in a single flow and still obtain 
correct playback.

By default, Dorico Elements plays sections between repeat barlines twice and includes repeats in 
playback, except after repeat jumps, such as D.S. al Coda.

During playback, the bars/beats and time displays in the mini transport and Transport window 
reflect the playhead position in repeat structures.

Dynamics and tempo marks are reflected in repeats by default. Repeats are also included in both 
audio and MIDI exports.

NOTE

● When repeat structures are unbalanced and would play back infinitely, Dorico Elements 
automatically excludes repeats from playback.

● You can mute individual notes/items to exclude them from playback in specific playthroughs 
only.

RELATED LINKS
Transport window on page 555
Mini transport on page 32
Repeat endings on page 1230
Repeat markers on page 1236

Play mode
Repeats in playback 

549
Dorico Elements 5.1.30



Types of barlines on page 816
Tremolos on page 1399
Rhythm slashes on page 1258
Bar repeats on page 1245
MIDI trigger regions on page 574
Muting notes/items individually on page 548

Including/Excluding repeats in playback
By default, Dorico Elements plays back all playthroughs in all types of repeat structures. You can 
include/exclude all repeats in playback project-wide. For example, you might exclude all repeats 
to listen to your music as a single playthrough.

NOTE

When repeat structures are unbalanced and would play back infinitely, Dorico Elements 
automatically excludes repeats from playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Repeats.

3. In the Repeats section, activate/deactivate Play repeats.

4. Click Apply, then Close.

RELATED LINKS
Playback Options dialog on page 749
Including/Excluding pauses in playback on page 1016
Including/Excluding slash voices in playback on page 1260

Including/Excluding repeats in playback after repeat jumps
By default, Dorico Elements plays back all playthroughs in all types of repeat structures. You 
can manually include/exclude repeats indicated by repeat markers, repeat endings, and repeat 
barlines in playback after individual repeat jumps, independently of your project-wide setting.

NOTE

You can only include/exclude repeats after repeat jumps, such as D.C. al Fine and D.S. al Coda.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the repeat jumps after which you want to include/exclude repeats in playback. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Replay repeats in the Repeat Markers group.

3. Activate/Deactivate the corresponding checkbox.
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RESULT
Repeats are included in playback after the selected repeat jumps when the checkbox is activated, 
and excluded from playback when the checkbox is deactivated.

When the property is deactivated, repeat markers follow your project-wide setting for including 
repeats in playback after repeat jumps.

TIP

You can include/exclude all repeats after all repeat jumps project-wide on the Repeats page in 
Playback Options.

Changing the number of playthroughs at repeat barlines
End repeat barlines typically indicate that the preceding music is played through twice. You can 
change the number of playthroughs for each end repeat barline individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the end repeat barlines whose number of playthroughs you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Play n times in the Time Signatures group.

3. Change the value in the value field.

NOTE

The minimum value is 2.

RESULT
The number of times the music preceding the selected end repeat barlines is played through is 
changed.

When repeats are included in playback, repeat counts are shown at system object positions for 
end repeat barlines set to have three or more playthroughs.

EXAMPLE

Final repeat barline with the default 2 playthroughs 
set

Final repeat barline with 4 playthroughs set and 
repeat count shown
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RELATED LINKS
Repeat counts on page 1242
Types of barlines on page 816
Input methods for bars, beats, and barlines on page 300
Muting notes/items individually on page 548
Including/Excluding repeats in playback after repeat jumps on page 550
Changing the total number of playthroughs in repeat endings on page 1230
Engrave toolbox on page 503
Properties panel on page 663

Swing playback
Swing is a style of performance where equally-notated notes are played in a regular pattern of 
alternating longer and shorter notes, which commonly entails eighth notes being played as a 
quarter note triplet followed by an eighth note triplet.

A swing phrase with simplified straight notation How the same phrase sounds with a 2:1 swing ratio

Swing playback allows you to hear the uneven rhythms you want whilst retaining their simplified 
notation, including if the second eighth note beat is divided into two 16th notes. In Dorico 
Elements, you can enable swing playback for your whole project, only for certain sections, and 
only for individual instruments. You can swing either eighth notes or 16th notes.

Based on academic research into the rendering of swing by musicians, swing patterns in Dorico 
Elements are tempo-dependent by default. This means that the swing feels more pronounced at 
lower tempos, and straighter at higher tempos.

Swing ratios and rhythmic feels
Swing ratios express the strength of the swing using beat units. For example, a swing ratio of 2:1 
means the first note in each pair is twice as long as the second, creating a triplet swing.

A swing ratio of 1:1 means the music is played straight, while a swing ratio of 5:1 means each 
pair of notes is played as if they were sextuplets, with the first note in the pair lasting five 
divisions and the second note lasting one.

Swing ratio 1:1 Swing ratio 5:1

The following rhythmic feels and swing ratios are provided by default in Dorico Elements:
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2:1 swing 16ths (fixed)
Extends the first note in a pair of 16th notes to be twice as long as the second, creating 
a strict triplet 2:1 ratio. This is also known as a “triplet swing”. This ratio is maintained 
regardless of the tempo by default.

2:1 swing 8ths (fixed)
Extends the first note in a pair of eighth notes to be twice as long as the second, 
creating a strict triplet 2:1 ratio. This is also known as a “triplet swing”. This ratio is 
maintained regardless of the tempo by default.

3:1 swing 16ths (fixed)
Extends the first note in a pair of 16th notes to be three times as long as the second, 
creating a dotted 16th-32nd ratio (dotted semiquaver-demisemiquaver). This ratio is 
maintained regardless of the tempo by default.

3:1 swing 8ths (fixed)
Extends the first note in a pair of eighth notes to be three times as long as the 
second, creating a dotted eighth-16th ratio (dotted quaver-semiquaver). This ratio is 
maintained regardless of the tempo by default.

Heavy swing 16ths
Produces a tempo-dependent 16th note swing ratio of between 3:1 at low tempos and 
1.5:1 at high tempos.

Heavy swing 8ths
Produces a tempo-dependent eighth note swing ratio of between 3:1 at low tempos 
and 1.5:1 at high tempos.

Light swing 16ths
Produces a tempo-dependent 16th note swing ratio of between 1.5:1 at low tempos 
and 1:1 at high tempos.

Light swing 8ths
Produces a tempo-dependent eighth note swing ratio of between 1.5:1 at low tempos 
and 1:1 at high tempos.

Medium swing 16ths
Produces a tempo-dependent 16th note swing ratio of between 2:1 at low tempos and 
1.5:1 at high tempos.

Medium swing 8ths
Produces a tempo-dependent eighth note swing ratio of between 2:1 at low tempos 
and 1.5:1 at high tempos.

Straight (no swing)
Produces no swing; that is, even eighth notes in the ratio 1:1 at all tempos.

You can change the swing ratio used project-wide, and you can also change the swing ratio used 
for specific sections and for individual players.

Enabling swing playback project-wide
You can enable swing playback project-wide using any of the default swing ratios or custom 
swing ratios you have created in the project.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.
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2. In the category list, click Timing.

3. In the Rhythmic Feel section, select the rhythmic feel you want from the Default rhythmic 
feel menu.

4. Click Apply, then Close.

RESULT
All pairs of either eighth notes or 16th notes in your project are played back with the selected 
swing ratio, depending on the swing unit for the selected ratio. This includes if the second beat is 
divided into two, such as two 16th notes in an eighth note swing.

RELATED LINKS
Playback Options dialog on page 749

Enabling swing playback for specific sections/instruments
You can enable swing playback for specific sections in your project and for individual instruments 
independently; for example, if you want only the trumpet player to swing for a twelve-bar 
section, or if you only want swing playback in one flow.

PROCEDURE

1. In Write mode, select one of the following:

● If you want to enable swing playback from a specific rhythmic position onwards, select 
a single item at the start of the bar where you want swing playback/a different rhythmic 
feel to start.

● If you want to enable swing playback within a section then return to straight playback, 
select multiple items that span the duration where you want swing playback/a different 
rhythmic feel.

NOTE

● If you want to enable swing playback for a single instrument, select items that belong to 
that instrument only.

● If you select an item in the middle of a bar, the rhythmic feel change only takes effect 
from the start of the next bar.

2. Open the tempo popover in any of the following ways:

● Press Shift-T .

● In the Notations toolbox, click Popovers , then Tempo .

3. Enter the appropriate entry for the rhythmic feel you want into the popover.

When you start entering a rhythmic feel into the tempo popover, a menu appears that shows 
valid rhythmic feels containing the letters/words you enter, which you can select.
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NOTE

If you do not enter the name of a rhythmic feel that exists in your project, the text you 
entered into the popover is input as a tempo mark and does not enable swing playback.

4. Input the rhythmic feel change and close the popover in one of the following ways:

● To input a rhythmic feel change for all staves, press Return .

● To input a rhythmic feel change only for the selected instrument, press Alt/Opt-Return .

RESULT
The rhythmic feel used for swing playback is changed from the start of the bar containing the 
earliest selected item, or the start of the next bar if you selected an item in the middle of a bar.

If you selected multiple items, the rhythmic feel is automatically reset at the position of the last 
selected item.

If you pressed Alt/Opt-Return , the rhythmic feel change only applies to the instrument on 
whose staff you selected an item or items. Rhythmic feels added to single instruments apply to 
all staves belonging to those instruments.

A signpost appears showing the name of the rhythmic feel you input. It is shown above the top 
staff in the system for rhythmic feel changes that apply to all staves, and directly above the top 
staff of the instrument for rhythmic feel changes that apply only to single instruments.

RELATED LINKS
Tempo popover on page 293
Signposts on page 450
Hiding/Showing signposts on page 450

Deleting rhythmic feel changes
You can delete rhythmic feel changes you have enabled for specific sections or for individual 
players only.

PREREQUISITE
Rhythmic change signposts are shown.

PROCEDURE

1. In Write mode, select the signposts of the rhythmic changes you want to delete.

2. Press Backspace or Delete .

RESULT
The rhythmic changes are deleted. The affected staves return to the default non-swing playback 
until the next existing rhythmic change signpost, if applicable.

Transport window
The Transport window contains playback and MIDI recording functions, such as rewinding 
and fast-forwarding. It contains additional and more precise versions of the playback functions 
available in the toolbar.

You can hide/show the Transport window in any of the following ways:

● Press F2 .
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● In the toolbar, click Show Transport Bar .

The Transport window contains the following information and functions:

Bars/Beats display

Shows the position of the playhead relative to bars and beats in the current flow in the 
following order of units: bars, beats, 16th notes, 120ths of a 16th note.

Time display
Shows the position of the playhead in one of the following formats:

● Elapsed time in the following order of units: hours, minutes, seconds, milliseconds

● Timecode in the following order of units: hours, minutes, seconds, frames

Time display showing elapsed time Time display showing the timecode

You can change the content shown in the time display by clicking it.

Activate Project

Activates/Deactivates playback in the project. When playback is deactivated, transport 
and playback functions are disabled.

Rewind to Beginning of Flow

Moves the playhead back to the beginning of the flow.

Rewind

Moves the playhead back by a second each time you click.

Fast Forward

Moves the playhead forwards by a second each time you click.

Stop

Stops playback.
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Play From Playhead Position

Plays back from the position of the playhead.

Play From Selection

Plays back from the position of the first selected item in the music area.

If you select items on multiple staves, or multiple items on a single staff, only the 
selected staves are played back.

Record
Starts/Stops MIDI recording.

Record outside of MIDI recording Record during MIDI recording

Retrospective Record

Retrieves any MIDI notes you played during the previous playback and allows you to 
input them on any staff, even if you were not recording them explicitly.

Click

Plays/Mutes the metronome click during playback and recording.

Tempo Mode
Displays the tempo used for both playback and recording. The value changes 
according to the playhead position, and its appearance changes according to its mode.

Fixed Tempo Mode Follow Tempo Mode

● You can change the tempo mode by clicking the beat unit.

● You can change the metronome mark value used in fixed tempo mode by clicking 
the number to show a slider, then dragging the slider to the right/left.

Scrub Playback
Activates/Deactivates scrub playback.
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Scrub Playback outside of scrubbing Scrub Playback during scrubbing

RELATED LINKS
Toolbar on page 30
Mini transport on page 32
Playing back music on page 540
Changing the tempo mode on page 543
MIDI recording on page 264
Changing the sound used for the click on page 533
Timecodes on page 1226

Changing the content shown in the transport display
You can switch between showing the timecode, the total elapsed time, and the current rhythmic 
position of the playhead expressed in bars, beats, and ticks in both the mini transport in the 
toolbar and the Transport window.

PROCEDURE

● In either the mini transport in the toolbar or the Transport window, click the transport 
display until the content you want appears.

In the Transport window, this is the display on the right.

RESULT
Each time you click in the mini transport display, it cycles through showing the rhythmic position 
of the playhead, elapsed time, and the timecode.

In the Transport window, it only switches between the timecode and elapsed time, as the 
rhythmic position of the playhead is shown permanently on the left of the window.

TIP

You can change what is shown in the mini transport by default for all future projects on the Play 
page in Preferences.

RELATED LINKS
Preferences dialog on page 58

Playback templates
Dorico Elements uses playback templates to allocate sounds from VST instruments and MIDI 
devices to the instruments in your project.

Playback templates combine the following information in order to obtain correct playback:

● The instrument sounds, articulations, and playback techniques provided by plug-ins, such as 
VST instruments

● The expression/percussion maps required to obtain those sounds

● The endpoint configurations required for the sounds for each instrument

When you add instruments to players in a project, Dorico Elements automatically loads 
plug-ins for them according to the current playback template and sets up expression maps 
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and percussion maps as required. Dorico Elements also automatically loads enough plug-in 
instances, as many plug-ins can only load a limited number of sounds in each instance.

You can override playback templates and make your own manual changes to the sounds used 
by instruments in your project, such as by changing the expression maps assigned to endpoints. 
You can then save such changes as custom endpoint configurations, which you can include in 
your own custom playback templates.

You can also export custom playback templates; for example, to share them with other users. 
Playback templates are saved as .dorico_pt files.

NOTE

● Playback templates are available in all projects you open or create on your computer, 
meaning any changes you make to playback templates affect all projects that use those 
playback templates.

● Dorico Elements automatically loads sounds for any new instruments you add to the project, 
using the sounds included in the current playback template. Therefore, we recommend that 
you always include a factory default playback template at the bottom of custom playback 
templates as a fallback to ensure that all instruments are assigned sounds.

● Any changes you make within plug-ins are saved when you save the project but are not 
communicated to Dorico Elements, which can lead to unexpected low notes sounding in 
playback because Dorico Elements is still using the expression and percussion maps for the 
original sounds. If you make changes in plug-ins, you must manually assign the correct 
expression and percussion maps to the appropriate endpoints.

● The Silence playback template prevents Dorico Elements from loading sounds. This can 
make project files significantly smaller.

RELATED LINKS
Edit Playback Template dialog on page 561
Applying/Resetting playback templates on page 564
Creating custom playback templates on page 564
Exporting playback templates on page 566
Loading VST/MIDI instruments manually on page 528
Editing VST instruments on page 529
Endpoint Setup dialog on page 567
Endpoints on page 567
Assigning instruments/voices to endpoints on page 569
Assigning expression/percussion maps to endpoints on page 570
Saving custom endpoint configurations on page 572
Activating/Deactivating playback on page 542
MIDI trigger regions on page 574
Importing drum set patterns from Groove Agent SE on page 94

Apply Playback Template dialog
The Apply Playback Template dialog allows you to change the playback template applied to the 
current project and to import/export playback templates. It also allows you to access the Edit 
Playback Template dialog.

● You can open the Apply Playback Template dialog by choosing Play > Playback Template.
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The Apply Playback Template dialog comprises the following:

1 Search field

Allows you to filter playback templates in the list according to your entry.

2 Name column

Contains a list of the playback templates available on your computer. You can click the 
column header to change the sorting order.

NOTE

Dorico Elements only shows playback templates for sounds that you have installed and for 
which you own licenses.

3 Factory column

Contains the factory symbol if the playback template in the corresponding row is a factory 
default playback template. You can click the column header to change the sorting order.

4 Action bar

Contains the following options for playback templates:

● Add Playback Template : Opens the Edit Playback Template dialog and allows you 
to create a new playback template.

● Duplicate Playback Template : Opens the Edit Playback Template dialog and allows 
you to create a new playback template that starts as a duplicate of the selected one.
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● Edit Playback Template : Opens the Edit Playback Template dialog and allows you 
to edit the existing selected playback template.

NOTE

You cannot edit factory default playback templates.

● Show Factory : Allows you to hide/show factory default playback templates in the 
table.

● Export: Opens the File Explorer/macOS Finder, where you can select the location to 
which you want to export the currently selected playback templates as .dorico_pt 
files. You can then import the .dorico_pt files into Dorico Elements on other 
computers and share them with other users.

● Import: Opens the File Explorer/macOS Finder, where you can select the .dorico_pt 
files that you want to import as playback templates.

● Delete : Deletes the selected playback templates.

NOTE

You cannot delete factory default playback templates.

5 Apply and Close

Applies the selected playback template to the project and closes the dialog.

Edit Playback Template dialog
The Edit Playback Template dialog allows you to create new custom playback templates and 
edit existing ones. You can use any combination of custom endpoint configurations and existing 
playback templates and specify the order in which they should be used.

Playback templates are available in all projects you open or create on your computer.

● You can open the Edit Playback Template dialog from inside the Apply Playback Template 
dialog by clicking Add Playback Template , Duplicate Playback Template , or Edit 
Playback Template .
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The Edit Playback Template dialog contains the following sections and options:

1 Playback template data

Allows you to specify the following identifying information for the selected custom playback 
template:

● Name: Allows you to set the name of the playback template that appears in the 
program; for example, in the Apply Playback Template dialog.

● ID: Allows you to set the unique ID of the playback template. Dorico Elements 
automatically populates the ID field with the information you enter into the Name field.

● Creator: Allows you to name the creator if you are sharing your playback template with 
other users.

● Version: Allows you to indicate the playback template version so you can identify the 
most recent one; for example, you can increase the Version number each time you 
make changes to the playback template.

● Space template: Allows you to select the space template that you want the playback 
template to use.

● Description: Allows you to add any other information about the playback template.

NOTE

All fields in the playback template data section, except for Name, are locked by the Lock Info 
button. You must click this button in order to change the information in the fields.

2 Entries

Contains a table of all the custom endpoint configurations and existing playback templates 
used by the selected custom playback template. Entries are listed in order of priority, 
meaning that Dorico Elements assigns sounds from the top entry first. We recommend that 
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you always include a factory default playback template at the bottom of the list as a fallback 
to ensure that all instruments are assigned sounds.

In most cases, listing entries in your order of preference in the Entries section is sufficient 
to achieve your desired playback. However, if multiple entries in your custom playback 
template provide sounds for the same instrument, you must set family and/or instrument 
overrides; for example, if you only want to use woodwind sounds from the first entry and use 
all other sounds from the second entry.

The column on the right identifies the type of the entry in the corresponding row.

● Manual: Entries that cannot load sounds automatically, including custom endpoint 
configurations

● Auto: Entries that can load sounds automatically; that is, factory default playback 
templates

The action bar at the bottom of the section contains the following options:

● Add Manual: Allows you to add a manual entry to the playback template.

● Add Automatic: Allows you to add an automatic entry to the playback template.

● Move Up : Moves the selected entry up the list.

● Move Down : Moves the selected entry down the list.

● Delete : Removes the selected entry from the playback template.

3 Family Overrides

Contains a list of family overrides applied to the selected entry and allows you to add/
remove overrides. Family overrides allow you to specify the instrument family sounds you 
want to use; for example, if you only want to use the woodwind sounds from an entry that 
also includes brass and string sounds.

The action bar at the bottom of the section contains the following options:

● Add Instrument Family : Allows you to select an instrument family to apply as an 
override to the selected entry.

● Delete Instrument Family : Removes the selected family override from the selected 
entry.

4 Instrument Overrides

Contains a list of instrument overrides applied to the selected entry and allows you to add/
remove overrides. Instrument overrides allow you to specify individual instrument sounds 
you want to use; for example, if you only want to use a solo violin sound from an entry that 
also includes ensemble string sounds.

The action bar at the bottom of the section contains the following options:

● Add Instrument : Allows you to select an instrument to apply as an override to the 
selected entry.

● Delete Instrument : Removes the selected instrument override from the selected 
entry.

5 Endpoint Configurations

Opens the Edit Endpoint Configurations dialog, which allows you to rename and delete 
custom endpoint configurations, and view the plug-ins and players they contain.

RELATED LINKS
Endpoints on page 567
Edit Endpoint Configurations dialog on page 573
Space templates on page 738
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Applying/Resetting playback templates
You can change the playback template applied to the current project; for example, if you want to 
use a different sound library for playback. Re-selecting playback templates resets them to their 
default settings.

PREREQUISITE
You have installed all the sounds that you want to use for playback.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Select the playback template you want to use.

NOTE

Dorico Elements only shows playback templates for sounds that you have installed and for 
which you own licenses.

3. Click Apply and Close.

RESULT
The playback template applied to the current project is changed. If you re-selected the playback 
template already in use, the playback template is reset.

Sounds are loaded into plug-in instances in their score order.

TIP

● You can change the default playback template used for all future projects on the Play page 
in Preferences. If Dorico Elements detects that you have installed new sounds, a dialog 
appears that allows you to update your default playback template.

● You can also load sounds only for instruments without assigned sounds by choosing Play > 
Load Sounds for Unassigned Instruments.

RELATED LINKS
Preferences dialog on page 58
Activating/Deactivating playback on page 542
Changing the default player order on page 125
Importing drum set patterns from Groove Agent SE on page 94

Creating custom playback templates
You can create custom playback templates that can include combinations of factory default 
playback templates, custom endpoint configurations, and other non-factory default playback 
templates that cannot load sounds automatically.

PREREQUISITE
You have saved custom endpoint configurations for any third-party sound libraries you want to 
include in your custom playback template.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.
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2. Open the Edit Playback Template dialog to create a new playback template in one of the 
following ways:

● To create an empty playback template, click Add Playback Template  in the action 
bar.

● To create a copy of an existing playback template, select it and click Duplicate Playback 
Template  in the action bar.

3. In the Edit Playback Template dialog, click Lock Info  to unlock the data fields.

4. Enter information for your playback template in the relevant fields.

5. In the Entries section, add the custom endpoint configurations and/or factory default 
playback templates you want.

● To add a custom endpoint configuration or non-factory default playback template, click 
Add Manual and select the one you want from the menu.

● To add a factory default playback template, click Add Automatic and select the one you 
want from the menu.

TIP

We recommend that you always include a factory default playback template at the bottom of 
the list as a fallback to ensure that all instruments are assigned sounds.

6. Optional: To change the order of entries and their order of preference in the playback 
template, select an entry and click one of the following options in the action bar:

● To move the selected entry upwards, click Move Up .

● To move the selected entry downwards, click Move Down .

7. Optional: Repeat step 6 until all the entries are in the correct order of preference.

8. Optional: Select an entry for which you want to specify instrument family overrides.

9. In the Family Overrides section action bar, click Add Instrument Family  and select the 
one you want from the menu.

For example, if you only want to use the woodwind sounds from a sound library that also has 
string sounds, select Woodwinds.

10. Optional: Select an entry for which you want to specify individual instrument overrides.

11. In the Instrument Overrides section action bar, click Add Instrument  and select the one 
you want in the instrument picker.

For example, if you only want to use the piano sound from a sound library that has other 
keyboard instrument sounds, select Piano.

12. Optional: Repeat steps 8 to 11 for other entries for which you want to specify instrument 
family and instrument overrides.

13. Click OK to save your changes and close the dialog.

RESULT
Your new custom playback template is created. It is available to use in the current project and all 
projects you create/open on your computer.

RELATED LINKS
Apply Playback Template dialog on page 559
Edit Playback Template dialog on page 561
Endpoints on page 567
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Saving custom endpoint configurations on page 572

Importing playback templates
You can import playback templates into projects; for example, if someone you are working 
with exported their custom playback template for you to use. Playback templates are saved 
as .dorico_pt files.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Click Import to open the File Explorer/macOS Finder.

3. Locate and select the playback template file you want to import.

4. Click Open.

RESULT
The selected playback template is imported. It becomes available in the current project and all 
projects you create/open on your computer.

If the imported playback template included a space template, that space template is applied to 
the project automatically.

TIP

You can also import playback templates by dragging .dorico_pt files into a Dorico Elements 
project window.

RELATED LINKS
Space templates on page 738

Exporting playback templates
You can export playback templates so you can send them to other users or use them on other 
computers. By default, any playback templates you create are available in all projects on your 
computer.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Select the playback templates you want to export.

3. Click Export to open the File Explorer/macOS Finder.

4. Specify a name and location for the playback template files.

5. Click Choose.

RESULT
The selected playback templates are exported and saved in the selected location as 
separate .dorico_pt files.

Any space templates used by the selected playback templates are included in the export.
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Endpoints
“Endpoint” is the term used for the unique combination of inputs and outputs that together allow 
the correct sounds to be played for each instrument.

In Dorico Elements, each endpoint brings together the following:

● A VST instrument or MIDI output device instance

● A specific channel on that VST instrument or MIDI output device

● The patch or program assigned to that channel

● The expression map and/or percussion map that describes the instrument or instruments 
that can be played by that patch or program, and the playback techniques and articulations 
provided

Each instrument in your project is connected to a specific endpoint. Assigning an expression/
percussion map to the same endpoint allows Dorico Elements to translate any playing technique 
changes and articulations you input into the key switches and controller switches necessary to 
produce the required sounds for the instrument in playback.

When you use a factory default playback template, Dorico Elements sets up endpoints and 
expression/percussion maps automatically. If you want to load other plug-ins or change the 
patches within HALion Sonic SE, you can do so in the Endpoint Setup dialog.

NOTE

Any changes you make within plug-ins are not communicated to Dorico Elements; for example, 
changing a sound that the expression map expects to use a modulation wheel for dynamics to 
one that uses note velocity instead. This can lead to unexpected low notes sounding in playback 
because Dorico Elements is still using the expression and percussion maps for the original 
sounds. If you make changes in plug-ins, you must manually assign the correct expression and 
percussion maps to the appropriate endpoints.

You can then save your changes as a custom endpoint configuration if you want to reuse them in 
other projects.

RELATED LINKS
Playback templates on page 558

Endpoint Setup dialog
The Endpoint Setup dialog displays which expression and percussion maps are currently linked 
to each endpoint in the corresponding plug-in instance, and allows you to change these settings. 
It also allows you to save your current settings as custom endpoint configurations, which you can 
then include in custom playback templates.

● You can open the Endpoint Setup dialog by clicking Endpoint Setup  in each plug-in 
instance in the VST and MIDI panel, or in the Routing section of the Track Inspector.
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The Endpoint Setup dialog contains the following options and sections:

1 Name

Allows you to change the name of the selected plug-in instance. This affects the name shown 
in the VST and MIDI panel and in the Mixer.

2 Number of MIDI ports

Displays the number of MIDI ports the corresponding plug-in instance currently uses.

You can change the number of MIDI ports; for example, if you are using a plug-in that uses 
more than one port. Dorico Elements does not load multiple MIDI ports by default.

3 Number of MIDI channels

Displays the number of MIDI channels the corresponding plug-in instance currently uses.

You can change the number of channels; for example, if you have a monotimbral plug-in 
such as a piano sampler which only has one MIDI channel, or a multitimbral plug-in with 16 
MIDI channels and 16 audio outputs.

4 Set

Sets the plug-in instance to have the number of MIDI ports and channels specified in the 
Number of MIDI ports and Number of MIDI channels value fields. This changes the 
number of rows in the table.

5 Endpoint setup table

Contains the settings for the corresponding plug-in instance, arranged into the following 
columns:

● Port: Displays the port used by the instrument in the corresponding row of the table.

NOTE

You cannot change the port from within the Endpoint Setup dialog. You must change 
the port in the Track Inspector.
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● Channel: Displays the channel used by the instrument in the corresponding row of the 
table.

NOTE

You cannot change the channel from within the Endpoint Setup dialog. You must 
change the channel in the Track Inspector.

● Assigned Instruments: Displays the full name of the instrument in the corresponding 
row, as set for that instrument in the Edit Instrument Names dialog, and its instrument 
number, if applicable.

● Expression map: Displays the expression map currently assigned to the instrument in 
the corresponding row. You can change the expression map by double-clicking it and 
selecting another expression map from the menu.

● Percussion map: Displays the percussion map currently assigned to the instrument in 
the corresponding row. You can change the percussion map by double-clicking it and 
selecting another percussion map from the menu.

6 Number of audio outputs to show in Mixer

Allows you to change the number of audio outputs shown in the Mixer; for example, if you 
want to hide unused outputs when using plug-ins that provide more audio outputs than 
Dorico Elements uses.

7 Save Endpoint Configuration

Opens the Save Endpoint Configuration dialog, which allows you to enter a name for the 
current endpoint configuration and save it as a custom endpoint configuration.

RELATED LINKS
Track Inspector on page 522
VST and MIDI panel on page 525
Expression Maps dialog on page 762
Edit Instrument Names dialog on page 184
Mixer on page 717

Assigning instruments/voices to endpoints
You can assign instruments to any endpoint; for example, if you have loaded a plug-in with 
multiple ports and want to change the endpoint of an existing instrument to an endpoint on 
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one of your new ports. For instruments with independent voice playback enabled, you can assign 
each voice to a different endpoint.

PREREQUISITE

● If you want to assign different voices belonging to the same instrument to different 
endpoints, you have enabled independent voice playback.

● If you want to assign instruments to endpoints in specific plug-in instances, you have loaded 
those plug-in instances. You can do this by applying a suitable playback template or by 
loading VST/MIDI instruments manually.

PROCEDURE

1. In Play mode, in the track overview, select the instrument/voice track whose assigned 
endpoint you want to change.

2. Optional: If you selected a voice track, choose one of the following options for Edits apply to 
in the Routing section of the Track Inspector:

● To change the assigned endpoint for the selected voice in the current flow only, choose 
This flow.

● To change the assigned endpoint for the selected voice in all flows, choose All flows.

3. Optional: To assign the instrument/voice to an endpoint in a different plug-in instance, 
select that plug-in instance from the audio plug-in menu in the Routing section of the Track 
Inspector.

4. Change the endpoint using the following value fields, individually or together:

● To assign the instrument/voice to a different port in the selected plug-in instance, enter 
the required port in the Port field.

NOTE

Only necessary when using a plug-in that has multiple ports of 16 channels.

● To assign the instrument/voice to a different channel in the selected port, enter the 
required channel in the Ch. field.

RELATED LINKS
Track overview on page 520
Track Inspector on page 522
Instrument tracks on page 531
Enabling independent voice playback on page 545

Assigning expression/percussion maps to endpoints
You can assign expression/percussion maps to the endpoints in your project; for example, if you 
have created a custom percussion map and must link it to the endpoint for the corresponding 
VST patch.

TIP

You can also assign expression/percussion maps to endpoints in the Routing section of the Track 
Inspector.
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PREREQUISITE
You have made or imported any expression/percussion maps that you require but do not exist 
on your computer.

PROCEDURE

1. In Play mode, in the VST and MIDI panel, click Endpoint Setup  in the plug-in instance in 
which you want to change the expression/percussion maps assigned to endpoints to open 
the Endpoint Setup dialog.

2. Double-click the expression/percussion map you want to change.

3. Click the disclosure arrow to the right of the field.

A menu appears containing all maps of the same type currently loaded in your project.

4. Select the expression/percussion map you want from the menu.

5. Press Return .

6. Optional: Repeat steps 2 to 5 for any other endpoints whose assigned expression/percussion 
maps you want to change.

7. Click OK to save your changes and close the dialog.

RELATED LINKS
VST and MIDI panel on page 525
Track Inspector on page 522
Expression maps on page 761
Percussion maps on page 780

Custom endpoint configurations
Custom endpoint configurations save the current state and settings of plug-ins in your project, 
such as the number and type of VST/MIDI instruments loaded and the instruments and 
expression/percussion maps assigned to endpoints.

You can save custom endpoint configurations that include the settings for all plug-ins currently 
loaded or only a single one.

Custom endpoint configurations are available in all projects you open or create on your 
computer. You can view, rename, and delete the custom endpoint configurations on your 
computer in the Edit Endpoint Configurations dialog.
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Saving custom endpoint configurations
You can save any overrides you have made to endpoint configurations, such as changing the 
instruments and expression maps assigned to particular endpoints. This allows you to use these 
overrides in custom playback templates and re-use the same endpoint configurations in other 
projects.

PREREQUISITE

● You have opened a project containing all instruments and plug-ins that are necessary for the 
custom endpoint configuration.

● You have created any necessary expression maps and playback technique combinations.

● You have created any necessary custom playing techniques.

PROCEDURE

1. Load the plug-ins you want.

You can do this by applying a playback template or by adding plug-in instances manually in 
the VST and MIDI panel in Play mode.

2. Change the settings for the endpoints as required.

For example, change the instruments or expression maps assigned to each endpoint.

3. Open the Save Endpoint Configuration dialog in one of the following ways:

● To save a custom endpoint configuration for only a single plug-in instance, open the 
Endpoint Setup dialog for that plug-in instance and click Save Endpoint Configuration.

● To save a custom endpoint configuration that includes all VST instrument or MIDI 
instrument plug-in instances, click Save Endpoint Configuration  in the action bar 
of the corresponding section of the VST and MIDI panel.

4. Enter a name for your custom endpoint configuration in the Name field.

NOTE

If you enter a name that already exists, or select an existing custom endpoint configuration 
from the menu, the existing custom endpoint configuration is overwritten.

5. Click OK to save your changes and close the dialog.

RESULT
The current state of either the selected plug-in instance or all plug-in instances in the 
corresponding section is saved as a custom endpoint configuration. This includes any custom 
playing techniques included in any of the expression/percussion maps.

AFTER COMPLETING THIS TASK
You can include custom endpoint configurations in custom playback templates, which allows you 
to use endpoint configurations in other projects.

RELATED LINKS
Playback templates on page 558
Loading VST/MIDI instruments manually on page 528
Adding/Editing switches in expression maps on page 777
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Save Endpoint Configuration dialog
The Save Endpoint Configuration dialog allows you to save the current state and settings of 
plug-ins in your project. Saving custom endpoint configurations allows you to re-use them in 
other projects and include them in custom playback templates.

You can open the Save Endpoint Configuration dialog in Play mode in any of the following 
ways:

● In the VST and MIDI panel, click Save Endpoint Configuration in the VST Instruments 
or MIDI Instruments action bar. This saves the current state of all plug-ins in the 
corresponding section of the panel.

● In the Endpoint Setup dialog, click Save Endpoint Configuration. This saves the current 
state of the selected plug-in only.

The Save Endpoint Configuration dialog contains a Name field that allows you to enter a name 
for the endpoint configuration you are saving. The arrow at the end of the field allows you to 
select an existing custom endpoint configuration to use to populate the field.

If you enter a name that already exists, you can overwrite the existing custom endpoint 
configuration. When you overwrite existing custom endpoint configurations, Dorico Elements 
moves the previous version to your recycle bin.

Edit Endpoint Configurations dialog
The Edit Endpoint Configurations dialog allows you to rename and delete custom endpoint 
configurations, and view the plug-ins and players they contain.

● You can open the Edit Endpoint Configurations dialog by clicking Endpoint Configurations 
in the Edit Playback Template dialog.

The Edit Endpoint Configurations dialog comprises the following:

1 Endpoint configurations list

Contains all the endpoint configurations on your computer.
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Delete Endpoint Configuration  in the action bar at the bottom of the list allows you to 
delete the selected endpoint configuration from your computer.

2 Name

Allows you to set the name of the selected endpoint configuration that appears in the 
program; for example, in the Edit Playback Template dialog.

3 Plug-ins and players list

Contains all the plug-ins and players contained within the selected endpoint configuration. 
If the endpoint configuration contains multiple instances of the same plug-in, each plug-in 
instance is listed separately.

MIDI trigger regions
MIDI trigger regions allow you to play back notes in specific bars without showing them in the 
music. This can be particularly useful when using pattern-based software instruments, such as 
Groove Agent SE, for playback.

Multiple adjacent midi trigger regions

By default, MIDI trigger regions are highlighted with a solid colored line below the bottom 
staff line and a colored background. As you zoom out, the colored backgrounds become more 
opaque, which is especially useful when viewing full score layouts in galley view. These highlights 
are considered annotations, are not printed by default, and you can hide/show them.

The names of notes played by the MIDI trigger region are displayed at the start of the 
solid colored line, according to your middle C numbering convention setting. If the velocity is 
specified, it is displayed in parentheses after the note names.

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

Handles on a selected MIDI trigger region

TIP

You can input slash regions at the same positions as MIDI trigger regions.

RELATED LINKS
Inputting MIDI trigger regions on page 420
Changing the middle C numbering convention on page 51
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430
Slash regions on page 1261
Annotations on page 597
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Hiding/Showing MIDI trigger region highlights
You can hide/show colored highlights for MIDI trigger regions at any time; for example, if you 
want to show the highlights when inputting music but hide them when engraving.

PROCEDURE

● Choose View > Highlight MIDI Trigger Regions.
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Print mode

Print mode allows you to print your layouts or to export them as graphics files, such as PDF and 
SVG.

● When printing layouts, you can specify the paper size and other options, such as duplex or 
booklet printing.

● When exporting layouts, you can specify different graphics file types and the information 
you want to include in their exported file names.

Project window in Print mode
The project window in Print mode contains the print preview area and panels that provide all the 
necessary tools and functions for printing and exporting layouts.

You can switch to Print mode in any of the following ways:

● Press Ctrl/Cmd-5 .

● In the toolbar, click Print.

● Choose Window > Print.

The following panels and options are available in Print mode:

1 Layouts panel

Shows a list of all layouts in your project and allows you to select the layouts you want to 
print or export.
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NOTE

The layout selector in the toolbar is disabled in Print mode. To show a different layout in the 
print preview area, select it in the Layouts panel.

2 Print Options panel

Contains options for printing or exporting your layouts.

3 System Dialogs (macOS only)

Contains macOS-specific printing options.

4 View options

Allows you to change the print preview area to show pages in one of the following views:

● Page Width: The page fills the width of the print preview area, which might not show 
the whole page depending on the orientation and format of the page.

● Whole Page: Shows the whole page in the print preview area.

TIP

You can go directly to the first page in the layout by pressing Home , and to the last page 
by pressing End . You can change these key commands on the Key Commands page in 
Preferences.

RELATED LINKS
Toolbar on page 30
Project window on page 29
Print preview area on page 36
Key Commands page in the Preferences dialog on page 60

Layouts panel (Print mode)
In Print mode, the Layouts panel shows a list of all layouts in your project and allows you to 
select layouts to preview, print, and export. It is located on the left of the window.

You can hide/show the Layouts panel in Print mode in any of the following ways:

● Press Ctrl/Cmd-7 .

● Click the disclosure arrow on the left edge of the main window.

● Choose Window > Show Left Zone.

The Layouts panel contains all the layouts in your project, displayed as cards. Each layout card 
shows the following:
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1 Disclosure arrow

Expands/Collapses the layout card.

2 Layout type

Shows the type of layout from the following options:

● Full score layout 

● Instrumental part layout 

● Custom score layout 

3 Layout name

Shows the name of the layout. Dorico Elements automatically adds default names depending 
on the name of the instrument that is assigned to a player and on the type of layout 
that is added. For example, if you assign a flute to a player, the instrumental part layout 
automatically gets the same name. If you add an empty instrumental part layout, the layout 
name shows Empty part and an incremental number if you add multiple empty part layouts.

4 Page size and orientation

Shows the size and orientation of the layout as set on the Page Setup page in Layout 
Options.

5 Layout length

Shows the number of pages in the layout. You can use this in combination with its page size 
and orientation to determine the best job type for printing/exporting.

TIP

A layout with two pages might best be printed as 2-up, while a layout with five pages might 
best be printed as spreads with the final page printed on a different paper size. A layout with 
12 pages might best be printed as a booklet.

The selected layouts are printed/exported when you click Print or Export in the Print Options 
panel. If you have selected some layouts set to print and some set to export graphics, the button 
reads Print and Export.

RELATED LINKS
Page arrangements for printing/exporting on page 590
Booklet printing on page 591

Print Options panel
The Print Options panel contains options for printing or exporting your layouts. It is located on 
the right of the window in Print mode.

You can hide/show the Print Options panel in any of the following ways:

● Press Ctrl/Cmd-9 .

● Click the disclosure arrow on the right edge of the main window.

● Choose Window > Show Right Zone.
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All the options that you set in the Print Options panel are saved with your project. The options 
are divided into the following sections:

Destination
Allows you to select a physical printer for printing or a file location for exporting a 
graphics file.

● For layouts set to print, you can change the number of copies.

● For layouts set to export as graphics files, you can specify the format, color mode, 
image resolution, file name, and directory of the saved file.

Job Type
Allows you to choose the pages to be printed or exported, and how they are arranged. 
You can choose all pages, a range of pages, or a range of flows.

When exporting ranges of flows to PDF, you can also choose to export each flow as a 
separate PDF file.

Page Setup
Allows you to set the paper size and orientation. You can specify the scale factor of the 
image to be printed or exported.
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Duplex Printing
Allows you to specify whether to print on one or on both sides of each sheet of paper. 
Only available when Printer is selected in the Destination section.

Annotations
Allows you to activate options that are often required by publishing houses or printing 
agencies, such as crop marks or a border around the printed image.
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Print button
Allows you to print/export selected layouts according to the settings you have set in 
the Print Options panel.

Depending on your selection, the print button can appear in one of the following ways:

● Print

● Export

● Print and Export

For example, if you selected layouts that are all set to print, Print is shown. If you 
selected some layouts set to export graphics and some layouts set to print, Print and 
Export is shown.

RELATED LINKS
Project window in Print mode on page 576
Exporting layouts as graphics files on page 585
Printers on page 589
Duplex printing on page 592
Page arrangements for printing/exporting on page 590
Page vs. paper size on page 593
Graphics file formats on page 595
Annotations on page 597

Printing layouts
You can print hard copies of individual layouts or multiple layouts together. You can specify print 
settings for each layout independently; for example, you can set different numbers of copies or 
select different printers for layouts in the same project.

Dorico Elements uses settings for layouts to create automatic print settings, so you might find 
that many print options are already appropriate for the layouts you want to print. For example, if 
you are connected to a printer that can print A3 paper and the page size of your full score layout 
is set to A3 in Layout Options, Dorico Elements automatically selects A3 in the Page Setup 
section of the Print Options panel.

TIP

● If you want to save layouts in graphics files formats, such as PDF or PNG, we recommend 
that you export them.

● You can select individual layouts and set up their printing options without printing straight 
away. Once you have set up the printing options you want for different layouts, you can 
then select all the layouts you want to print and click Print. Your existing print settings are 
applied, even if your selection contains layouts with different print settings.

For example, you can set your full score layout to print 3 booklet copies and the part layouts 
to print 1 2-up copy each. You can then select all layouts to print them together and the 
previously set values are followed.

PROCEDURE

1. In the Layouts panel, select the layouts that you want to print.
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NOTE

The layout selector in the toolbar is disabled in Print mode. To show a different layout in the 
print preview area, select it in the Layouts panel.

2. In the Print Options panel, enter the number of copies you want into the Copies field in the 
Destination section.

NOTE

The Copies field appears blank when you have selected layouts with different values.

3. Activate/Deactivate Collate copies.

4. In the Destination section, choose Printer and select a printer from the menu.

5. In the Job Type section, select the page arrangement you want from the menu.

6. Optional: Specify a range of pages/flows.

7. In the Page Setup section, select a paper size from the menu.

8. Choose the paper orientation you want.

9. Optional: If you selected Spreads or 2-up for the job type, activate/deactivate Print odd final 
page on to specify the paper size on which you want to print final pages for layouts with odd 
numbers of pages.

10. Select a paper size and paper orientation for the odd final page.

11. Choose one of the following size options:

● Fit to Paper

● Custom Scale

12. Optional: If you selected Custom Scale, enter the scale factor you want into the Scale factor 
field.

13. In the Duplex Printing section, select one of the printing options from the Print on menu.

14. Optional: If you selected a duplex printing option, use the bottom two menus to select how 
the printed image is flipped when printing on the reverse side of the paper.

15. In the Annotations section, activate each annotation you want to add to the selected 
layouts.

16. Click Print.

RESULT
The selected layouts are printed according to the print settings you have applied.

If your selection included part layouts set to concert pitch that contain transposing instruments, 
Dorico Elements shows a warning and offers to switch them all to transposed pitch before 
printing/exporting. You can also select which layouts you want to switch to transposed pitch or 
proceed anyway with no changes.

TIP

● You can choose to show a warning when printing/exporting concert or transposed pitch full 
score and custom score layouts in Preferences > General > Files.

● You can assign key commands to different printing and exporting commands on the Key 
Commands page in Preferences.
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RELATED LINKS
Preferences dialog on page 58
Key Commands page in the Preferences dialog on page 60
Printers on page 589
Paper size and orientation setup on page 594
Export File Names dialog on page 588
Page arrangements for printing/exporting on page 590
Print Options panel on page 578
Duplex printing on page 592
Annotations on page 597
Changing the page size and/or orientation on page 600
Exporting layouts as graphics files on page 585

Specifying ranges of pages/flows
By default, Dorico Elements prints/exports all pages in the selected layouts. You can specify 
ranges of either pages or flows for each layout independently.

NOTE

You can only print booklets using the complete range of pages. You cannot specify page or flow 
ranges.

PROCEDURE

1. In the Layouts panel, select the layouts for which you want to specify ranges of pages/flows.

2. In the Print Options panel, in the Job Type section, choose one of the following options for 
Print range:

● To specify ranges of pages, choose Pages.

● To specify ranges of flows, choose Flows.

3. If you chose Pages, enter the pages you want into the value field.

● To specify a range of pages, enter the first page and last page separated with a dash, 
such as 1-4.

● To specify individual pages or separate ranges, enter each page/range separated with 
commas, such as 1,3,5-8.

NOTE

Separate ranges are exported as separate files.

4. If you chose Flows, click Choose to open the Print Flows dialog. Select the flows you want to 
print/export, then click OK.

RESULT
The pages set to be printed/exported from the selected layouts are changed. Ranges of flows 
include all pages on which those flows appear, in full or in part.

RELATED LINKS
Print Options panel on page 578
Export File Names dialog on page 588
Page arrangements for printing/exporting on page 590
Exporting flows on page 80
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Print Flows dialog
The Print Flows dialog allows you to select the flows you want to print/export from the selected 
layouts. Ranges of flows include all pages on which those flows appear, in full or in part.

● You can open the Print Flows dialog in Print mode by clicking Choose in the Job Type 
section of the Print Options panel. Choose is available when the selected layouts are set to 
print/export a range of flows.

1 Flows to print or export

Contains a list of all the flows in the selected layouts. Flows are included in the page range to 
be printed/exported when their checkbox is activated.

2 Selection options

Allow you to select/deselect flows. The following selection options are available:

● Select All: Selects all flows.

● Select None: Deselects all flows.

● Invert Selection: Switches your selection to include all flows not previously selected.

Specifying printing options (macOS only)
Dorico Elements allows you to access the standard printing options of your operating system.

NOTE

If you use the standard printing options of your operating system, the settings in the Print 
Options panel are ignored. macOS-specific print settings are not saved with your project. These 
must be set each time you want to print, whereas the Dorico Elements print options are always 
saved with your project.

PROCEDURE

1. In the Layouts panel, click Page Setup in the OS X Dialogs section to open the macOS Page 
Setup dialog.

2. In the Page Setup dialog, set the paper size.

3. Click OK.

4. In the OS X Dialogs section, click Print to open the macOS Print.

5. In the Print dialog, set up the printing options you want.
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Exporting layouts as graphics files
You can export layouts as a variety of graphics files, such as PDF or PNG.

TIP

You can export layouts with different image settings and export paths simultaneously.

PROCEDURE

1. In the Layouts panel, select the layouts you want to export.

NOTE

The layout selector in the toolbar is disabled in Print mode. To show a different layout in the 
print preview area, select it in the Layouts panel.

2. In the Print Options panel, choose Graphics in the Destination section.

3. Optional: Change the image settings for the selected layouts.

4. Optional: Change the export path for the selected layouts.

5. Optional: If you want to change the file name recipe, click File Name Options to open the 
Export File Names dialog.

6. Optional: In the Export File Names dialog, change the file name recipe for your selected 
graphics file formats.

TIP

● We recommend including the Page number token for PNG, SVG, and TIFF files as each 
page in layouts using these formats is exported as a separate file.

● When exporting ranges of flows to PDF as separate files, we recommend including either 
the flow name or flow number to prevent the files from overwriting each other.

7. Optional: Specify a range of pages/flows.

8. Optional: If you are exporting a range of flows to PDF, activate/deactivate Separate file for 
each flow in the Job Type section.

9. In the Page Setup section, choose the page orientation you want.

10. In the Annotations section, activate each annotation you want to add to the selected 
layouts.

NOTE

Watermarks are only included in layouts exported as Color graphics.

11. Click Export.

RESULT
The selected layouts are exported as the selected graphics format, using the file name recipe set 
for their graphics file format in the Export File Names dialog. They are saved in the folder set in 
the Destination folder field, or in the same folder as the project file if the set export path is no 
longer accessible.

Exported layouts use the page size set for the layout on the Page Setup page in Layout Options.

If your selection included part layouts set to concert pitch that contain transposing instruments, 
Dorico Elements shows a warning and offers to switch them all to transposed pitch before 
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printing/exporting. You can also select which layouts you want to switch to transposed pitch or 
proceed anyway with no changes.

TIP

● You can choose to show a warning when printing/exporting concert or transposed pitch full 
score and custom score layouts in Preferences > General > Files.

● You can assign key commands to different printing and exporting commands on the Key 
Commands page in Preferences.

RELATED LINKS
Specifying ranges of pages/flows on page 583
Changing the page size and/or orientation on page 600
Export File Names dialog on page 588
Annotations on page 597
Preferences dialog on page 58
Key Commands page in the Preferences dialog on page 60
Layout Options dialog on page 745
Page vs. paper size on page 593
Exporting flows on page 80
Exporting project statistics on page 107

Changing the image settings for layouts
You can change the graphics file format, color mode, and image resolution of layouts 
individually; for example, if you want to export some layouts as PDF files but others as PNG 
files.

PROCEDURE

1. In the Layouts list, select the layouts whose export path you want to change.

2. In the Print Options panel, choose Graphics in the Destination section.

3. Select a graphics file format from the menu.

4. Choose a color mode.

● Mono exports the graphic in black and white.

● Color exports the graphic in full color.

NOTE

● For layouts that you want to export with watermarks, or that contain colored or not 
completely transparent elements, you must choose Color. If you select Mono, such 
elements appear black in the exported file.

● When exporting graphics files with a resolution of 72 dpi, we recommend that you select 
Color. If you select Mono, staff lines can disappear.

5. Optional: For PNG or TIFF files, do the following:

● If you chose Color, activate/deactivate Transparent background.

● Select a resolution from the Resolution menu.

TIP

The Resolution setting does not affect PDF and SVG files as they are vector formats.
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RESULT
The image settings for the selected layouts are changed. This also changes the file name recipe 
used for the corresponding layouts when you export them.

RELATED LINKS
Graphics file formats on page 595
Image resolution on page 595
Monochrome and color graphics processing on page 596
Embedding of fonts in PDF and SVG files on page 596
Hiding/Showing noteheads on page 1060

Changing the export path for layouts
You can specify an export path to any folder to which you want to export layouts as 
graphics files. You can specify a different export path for each layout and still export them all 
simultaneously.

By default, Dorico Elements exports graphics files into the same folder as your project file. If you 
have not saved your project yet, graphics files are saved in your Dorico Projects folder.

PROCEDURE

1. In the Layouts list, select the layouts whose export path you want to change.

2. In the Destination section of the Print Options panel, click Choose Folder  beside the 
Destination folder field to open the File Explorer/macOS Finder.

3. Locate and select the destination folder you want.

4. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Destination 
folder field.

5. Optional: Repeat steps 1 to 4 for other layouts whose export path you want to change.

6. Optional: If you want to change the file name recipe, click File Name Options to open the 
Export File Names dialog.

7. Optional: In the Export File Names dialog, change the file name recipe for your selected 
graphics file formats.

TIP

We recommend including the Page number token for PNG, SVG, and TIFF files as each page 
in layouts using these formats is exported as a separate file.

RESULT
The export path for the selected layouts is changed. When exported, the layouts use the file 
name recipe set for their graphics file format in the Export File Names dialog.

NOTE

If the export path specified is no longer accessible, such as if you receive a project from someone 
who uses a different operating system, Dorico Elements automatically updates the export path to 
the same location as the project file.
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Export File Names dialog
The Export File Names dialog allows you to determine the contents of file names for each 
graphics file format independently. You can use universal ingredients that update to show the 
correct information for each layout automatically, and you can enter text that is the same for all 
layouts.

You can open the Export File Names dialog in any of the following ways:

● In Print mode, click File Name Options in the Destination section of the Print Options panel 
when the currently selected layout is set to Graphics.

● In Preferences > General > Exporting Files, click Edit.

NOTE

Your settings are linked between both ways of accessing the dialog and are saved as the default 
for all future projects.

The Export File Names dialog contains the following options:

1 File names for

Allows you to select different graphics file formats. You can set different file name recipes for 
each graphics file format.

2 Preview

Displays an example file name based on the current recipe. The layout used for the preview 
is the one shown in the layout selector in the toolbar.

For example, the preview for a full score PDF file name using the default recipe might be 
01 - Full score - Lieder.pdf.
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3 File name recipe

Displays the recipe for the selected graphics file format. You can enter text directly into this 
field, and click ingredients to add them automatically.

For example, the default PDF file name recipe is $n - $l - $t.

4 Reset to Default

Resets the file name recipe to the default for the selected graphics file format.

5 Copy to All

Copies the file name recipe to all layouts in the project.

6 File name ingredients

Allow you to add ingredients to the file name recipe quickly that are automatically populated 
as appropriate for each layout. For example, the ingredient $l becomes Piano when used to 
export a piano part layout.

The buttons for each ingredient display both the information to which the ingredient refers 
and the characters for it.

When you click file name ingredients, they are added to the end of the file name recipe. They 
are automatically separated from the previous ingredient using the default separator.

NOTE

The page number ingredient is not available for the PDF file name recipe as it is a multi-page 
format.

7 Default separator

Allows you to set the characters used to separate ingredients in the file name recipe by 
default.

RELATED LINKS
Exporting layouts as graphics files on page 585
Flow names and flow titles on page 187

Printers
You can print layouts from Dorico Elements projects to any printer to which your computer is 
connected.

You can select different printers for each layout in your project. This allows you to send layouts 
to the most appropriate printer for their requirements. You can select a printer when Printer is 
chosen in the Destination section of the Print Options panel.

Dorico Elements uses the same printer as designated by the operating system by default, unless 
you specify another printer. In this case, the settings in the following sections in the Print 
Options panel can change:

● In the Page Setup section, the list of available paper sizes lists only paper sizes that the 
chosen printer provides.

● In the Duplex Printing section, the option for automatic duplex printing is only available if 
the chosen printer has this function.
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NOTE

The printer menu in the Destination section only shows the name of a printer if all currently 
selected layouts are set to print to the same printer. If you select a new printer from the menu, 
all selected layouts are set to print to that printer.

RELATED LINKS
Print Options panel on page 578
Printing layouts on page 581

Page arrangements for printing/exporting
Dorico Elements provides several page arrangements that you can use for printing/exporting 
your layouts.

In the Job Type section of the Print Options panel, you can specify how you want the layouts to 
be printed/exported. You can select the following job types from the Job Type menu:

Normal
Prints one page on each sheet of paper. This produces single-sided pages; for example, 
for instrumental parts that do not have regular page turns and must be bound in a 
continuous line.

Spreads
Prints two pages on each sheet of paper, with odd-numbered pages on the right-hand 
side and even-numbered pages on the left-hand side.

You can also specify a paper size on which to print odd final pages; for example, if you 
are printing a layout containing five pages.

2-up
Prints two pages on each sheet of paper. The first page in the range is printed on the 
left-hand side of the first sheet of paper. This can be useful for printing instrument 
parts as it reduces the number of edges that must be bound, because pages can also 
be folded in half.

You can also specify a paper size on which to print odd final pages; for example, if you 
are printing a layout containing five pages.

Booklet
Prints two pages on each sheet of paper according to imposition requirements. This 
means that if the paper is folded, the pages are laid out like a book. This can be 
useful for scores and choir parts in particular as they often contain more pages than 
instrumental parts.

NOTE

You can only print booklets using the complete range of pages. You cannot specify 
page or flow ranges.

NOTE

● Depending on the job type that you choose, Dorico Elements switches the page orientation 
automatically. The changed orientation is immediately displayed in the music area. If this is 
not what you want, you can override the orientation in the Page Setup section.

● All of the job types allow printing either onto a single side of each sheet of paper or on both 
sides of the paper.
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● It is usual to print booklets, spreads, and 2-up onto paper in landscape orientation. Printing 
one page to each sheet typically uses portrait orientation, unless the layout itself uses 
landscape orientation.

Also in the Job Type section, you can choose which pages you want to print/export.

All
Allows you to print/export all pages in the selected layouts.

Pages
Allows you to set a range of pages to be printed/exported. Choosing Pages makes the 
value field available.

● To specify a range, enter the first page and last page separated with a dash, such 
as 1-4.

● To specify individual pages or separate ranges, enter each page/range separated 
with commas, such as 1,3,5-8.

Flows
Allows you to set a range of flows to be printed/exported. When Flows is chosen, you 
can click Choose to open the Print Flows dialog, which allows you to select the flows 
you want to print/export.

RELATED LINKS
Printing layouts on page 581
Exporting layouts as graphics files on page 585
Paper size and orientation setup on page 594
Specifying ranges of pages/flows on page 583
Margins on page 614

Booklet printing
Booklets are documents printed on both sides of the paper and folded to resemble the pages in 
a book. When printed as a booklet, pages are reordered so that you can fold the printed pages 
and read the content in the same order as they were in the project.

Printing layouts as a booklet can be much quicker than printing pages single-sided or double-
sided. For example, if your full score is twenty pages long and you print it on both sides 
automatically, you must then bind one edge of the printed pages in order to keep them together. 
However, if you print the full score as a booklet, you can simply fold the printed pages in the 
middle.

Booklet printing settings reorder pages so that they appear in the correct order on the printed 
page. For example, a layout containing four pages printed as a booklet is laid out as follows:

● First side: page four on the left, page one on the right

● Reverse side: page two on the left, page three on the right

If the layout you are printing as a booklet contains an odd number of pages, Dorico Elements 
automatically places any empty last pages at the end of the booklet. This follows the convention 
of showing odd-numbered pages on the right. For example, if you print a layout containing six 
pages as a booklet, a total of eight pages are printed with the last two pages in the booklet left 
blank. If you want the empty pages to be positioned differently, you can add extra pages to the 
layout; for example, a title page.
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NOTE

● You can only print booklets using the complete range of pages. You cannot specify page or 
flow ranges.

● If the order of inward pages is incorrect when you are printing booklets using manual 
duplexing, you can activate Reverse order of outward pages in the Duplex Printing section 
of the Print Options panel, which instructs Dorico Elements to output the first set of pages in 
the opposite order.

Duplex printing
Dorico Elements allows duplex printing, which means that you can print on both sides of each 
sheet of paper.

If your printer supports automatic duplex printing, you can use this function in Dorico Elements. 
If your printer can only print on one side of each sheet of paper, there is a manual duplex 
printing option.

The Print on menu in the Duplex Printing section of the Print Options panel contains the 
following options:

One side only
Prints on one side of each sheet of paper.

Both sides manually
Prints on both sides of each sheet of paper. Use this option if you printer lacks an 
automatic duplex printing function. After all outward pages have been sent to the 
printer, a message box informs you to turn over the stack of printed pages and put 
them back into the printer. Click OK to continue printing the inward pages.

Both sides automatically
Prints on both sides of each sheet of paper automatically. This option is only available if 
your printer supports this type of printing.

The other menus in the Duplex Printing section allow you to set how the printed image is 
flipped when printing on the reverse side of the paper.

Flip image (portrait)

Determines how the image is flipped for reverse side printing in portrait orientation.

● Flip automatically uses the printer’s default settings for printing on the reverse 
side. If you find that the printer flips on a different edge than expected, use one of 
the other options.

● Flip long side sets the printer to flip the pages on the long edge.

● Flip short side sets the printer to flip the pages on the short edge.

Flip image (landscape)

Determines how the image is flipped for reverse side printing in landscape orientation.

● Flip automatically uses the printer’s default settings for printing on the reverse 
side. If you find that the printer flips on a different edge than expected, use one of 
the other options.

● Flip long side sets the printer to flip the pages on the long edge.
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● Flip short side sets the printer to flip the pages on the short edge.

Reverse order of outward pages at the bottom of the section instructs Dorico Elements, when 
activated, to output the first set of pages in the opposite order when printing booklets using 
manual duplexing. This is necessary for some printers so that you do not have to reverse sort the 
pages manually before returning them to the printer to print the other sides.

RELATED LINKS
Printing layouts on page 581

Page vs. paper size
In Dorico Elements, page sizes and paper sizes use different settings. This means that you can 
print layouts with any page size onto paper with a different paper size.

For each layout in your project, you can define a page size on the Page Setup page in Layout 
Options, which sets the dimensions of the layout.

When exporting layouts as graphics files, the layout’s page size is always used. When printing 
layouts, you must usually choose a paper size that is provided by the printer that you are using.

Normally, the layout's page size and the printed paper size match. However, if you define a 
layout with an unusual page size that is not supported by your printer, such as 10" x 13", one of 
the standard page sizes for instrumental parts, you may have to print the layout onto a different 
paper size. You can change the paper size in the Page Setup section of the Print Options panel 
according to your needs. As long as your printer supports sufficiently large paper for your page 
size settings, and they match a standard paper size, your dimensions are included in the menu. 
Changing the paper size has no effect on your layout's page size, and does not, therefore, affect 
the way the music is laid out.

If you do not select a specific paper size, Dorico Elements automatically chooses a paper size that 
is based on your computer's locale settings. For example, if these are set to a European country, 
an international ISO standard might be used, such as A4. If they are set to a North American 
country, one of their typical standards might be used, such as US Letter.

If you have defined a page size for your layout that is larger than a typical standard, Dorico 
Elements automatically chooses the next larger paper size, provided that your printer supports 
this. For example, if the layout's page size is larger than A4/US Letter, A3/Tabloid is used.

If you print to a different paper size than the layout's page size, Dorico Elements automatically 
scales the image to fit the paper. You can change this setting by specifying a custom scale factor 
in the Page Setup section.

RELATED LINKS
Layout Options dialog on page 745
Printing layouts on page 581
Exporting layouts as graphics files on page 585
Margins on page 614

Paper orientation
Paper orientation is the direction of rectangular paper for viewing and printing. Paper can have 
either landscape or portrait orientation.

Instrumental parts are most often printed using portrait orientation, as this allows two or three 
pages to be spread out at a time on most music stands.
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Full scores for conductors are also commonly printed using portrait orientation, as this allows 
more staves to fit on the page than with landscape orientation. However, full scores for small 
ensembles might use landscape orientation as fewer staves have to fit on the page. Having more 
horizontal room on the page allows more bars to fit on each page, reducing the number of page 
turns required.

In Dorico Elements, you can set the orientation of pages independently of the paper orientation; 
for example, you can print portrait pages on landscape paper. You can also separately set 
the paper orientation of the odd final page in layouts using the Spreads and 2-up page 
arrangements.

RELATED LINKS
Changing the page size and/or orientation on page 600

Paper size and orientation setup
Layouts can have different paper sizes and orientation settings.

NOTE

If you have selected Graphics in the Destination section of the Print Options panel, you can only 
change the paper orientation. No other options are available.

The Page Setup section of the Print Options panel contains the following options when you have 
chosen Printer in the Destination section:

Paper size
Allows you to select one of the available paper sizes from the menu. The paper sizes 
available depend on the capabilities of the selected printer.

Paper orientation
Allows you to choose one of the following paper orientation options:

● Portrait 

● Landscape 

Print odd final page on
For Spreads and 2-up job types only: If this is activated, you can select a different 
paper size or orientation for the odd final page.

This setting is useful when printing layouts with an odd number of pages on A3 paper 
in landscape orientation. For example, if your layout contains five pages, the first four 
pages fit onto two sheets of A3, while the fifth page would occupy only the left-hand 
side of a third sheet of A3. This setting allows you to print the odd final page on A4 
paper in portrait orientation instead.

Fit to Paper
The whole page is scaled to fit the paper size selected. For example, if you select a 
layout with a page size of A4 and select a paper size of A3, pages in the layout are 
enlarged to fit the larger paper size.

Custom Scale
The page is scaled to the set percentage of its original size. For example, if you are 
printing a layout with a page size of A3, select a paper size of A4, and set Custom Scale 
to 100, the original page remains at its original size, exceeding the boundaries of the 
A4 paper.
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RELATED LINKS
Page arrangements for printing/exporting on page 590
Changing the page size and/or orientation on page 600
Margins on page 614

Graphics file formats
Dorico Elements supports multiple graphics file formats as which you can export your layouts.

PDF
Stands for Portable Document Format. Exporting layouts to PDF allows you to create 
a platform-independent document that contains a fixed version of each layout; for 
example, to send to someone who does not have access to Dorico Elements.

PNG
Stands for Portable Network Graphics. PNG files are losslessly compressed, meaning 
they produce high-quality images.

SVG
Stands for Scalable Vector Graphics. Because SVG is an XML-based text format, it can 
be scaled to any size without any loss of quality. Dorico Elements renders SVG graphics 
using drawing instructions rather than rasterizing them, resulting in better resolutions 
and smaller file sizes.

TIFF
Stands for Tagged Image File Format. TIFF files are not compressed, which means their 
file sizes can be larger than other formats and the quality of the image is not reduced.

RELATED LINKS
Exporting layouts as graphics files on page 585
Changing the image settings for layouts on page 586

Image resolution
Image resolution refers to the number of pixels contained in an image. The larger the number of 
pixels, the sharper and clearer the image appears.

In Dorico Elements, you can export PNG and TIFF files with different image resolutions. The 
image resolution is measured in dots per inch, or “dpi”.

● 72

● 150

● 300

● 600

● 1200

NOTE

A resolution of 72 dpi is suitable for display on screen so that you can embed the graphic in an 
e-mail or on a web page. If you choose 300, 600, or 1200 dpi, a high-resolution image is saved 
that you can include as an illustration in a word processing or desktop publishing document.
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Monochrome and color graphics processing
Dorico Elements applies different settings when you export monochrome and color graphics. The 
most appropriate setting depends on your intended purpose for the graphics.

Most musical scores are monochrome, meaning they use only black ink and are normally 
printed on white/near-white paper. Some educational books occasionally use colors to highlight 
particular notations; for example, to identify clefs, or to color notes according to their pitch. If 
you export graphics files and print them with your own printer, you can leave Color selected in 
the Destination section.

However, if you export graphics files in PDF format for direct printing on a platesetter or for 
further production work in a page layout program, select Mono, unless your layout actually 
contains elements with color or opacity set. If you select Mono, Dorico Elements uses a different 
color space for the resulting PDF, ensuring that the printed image only uses black ink. If you 
choose Color, then the black items in your layout are exported as rich black; that is, black 
produced by combining multiple colored inks. This can cause problems in production when 
making color separations at the pre-press stage.

Dorico Elements specifies colors using the RGB color model, rather than the CMYK color model 
that is used by platesetters and other professional printing machines. If you have colored objects 
in your layouts and your layouts are printed professionally, you must post-process the graphics 
files that are exported from Dorico Elements in another graphics application to convert the colors 
from RGB to CMYK.

Embedding of fonts in PDF and SVG files
How fonts are handled in PDF and SVG files mainly depends on the fonts that you use in the 
project.

PDF Files
The music and text fonts, and their sub-sets, that are supplied with Dorico Elements 
are embedded in PDF files during the export. If you open the PDF files on a different 
computer, they look the same, even if that computer does not have the fonts installed 
that are used in the document. If you use different fonts, make sure that these permit 
embedding.

SVG Files
SVG (Scalable Vector Graphics) files do not embed fonts directly. Some font characters, 
such as note heads, articulations, and accidentals, are converted into outlines, so that 
they do not depend on the font from which they are taken. Other font characters, such 
as time signature and tuplet digits, are only encoded using references to the font from 
which they are taken. The latter also applies to regular text, such as staff labels, tempo 
instructions, and dynamics. This means that the SVG file looks incorrect if rendered by 
a web browser on a computer that does not have the fonts installed. The appearance 
of SVG files depends on the browser or the rendering software, and on the fonts that 
are installed on the computer.

To ensure that the SVG file appears correctly if embedded in a web page, you can open 
the SVG file in an illustration program and convert all font characters to outline paths, 
then re-export the SVG file and embed that file. Alternatively, you can use web fonts to 
ensure that the necessary fonts are available on the web server.

SVG graphics that are exported from Dorico Elements conform to the SVG Tiny 1.1 
specification, which defines a subset of features in the full SVG specification.

For information about using web fonts with SVG, refer to the Help Center on the 
Steinberg website.
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RELATED LINKS
Exporting layouts as graphics files on page 585
Changing the image settings for layouts on page 586

Annotations
Annotations provide additional information for printed or exported documents, such as the 
date and time it was printed. Publishers and printing agencies can use these to identify and 
register printed images correctly or to embed exported graphics files into a desktop publishing 
application.

When printing/exporting your layouts for publication, you can include typical annotations. You 
can also allow Dorico Elements to print or export any view options that you have activated in 
your project.

NOTE

Crop marks and the border can only be printed if the page size is smaller than the paper size.

The Annotations section of the Print Options panel contains the following options:

Crop marks
Adds short vertical and horizontal lines at each of the four corners of the page.

Border
Adds an outline around the edge of the page dimensions.

Date and time
Adds the date and time of printing at the bottom of each page.

Watermark
Adds large translucent text across the middle of each page. This is useful for indicating 
that this version is a draft, proof, or perusal score.

In the Watermark field at the bottom of the section, you can enter the text that you 
want to show on each page.

TIP

● Watermarks use the Print Watermark Font font style. You can edit the formatting 
of this font in the Edit Font Styles dialog; for example, to change its font size.

● Watermarks are only included in layouts exported as Color graphics.

View options
Adds all active view options, such as signposts, comments, and note and rest colors, to 
the printout or exported graphic.

RELATED LINKS
Signposts on page 450
Comments on page 494
Edit Font Styles dialog on page 754
Printing layouts on page 581
Exporting layouts as graphics files on page 585
Hiding non-printing elements on page 437
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Page formatting

The formatting of pages in Dorico Elements is determined by a number of factors, including 
the layout’s staff size, page margins, the page template applied to them, any casting off values 
applied to them, system and frame breaks, and frame padding.

Important factors that determine how pages are formatted in Dorico Elements include:

Staff size
Staff size refers to the distance between the top and bottom lines of staves. The most 
appropriate staff size depends on the intended purpose and contents of the layout. In 
many cases, changing the staff size is the quickest way to produce legible layouts.

Staff spacing
Staff spacing is the vertical spacing of your music. It involves the height of staves and 
the necessary gaps between staves and systems.

Note spacing
Note spacing is the horizontal spacing of your music. It involves the positions of notes 
and rests relative to each other, and the automatic gaps between them.

Casting off
“Casting off” is the term used to encompass fixing the layout of pages of music, such as 
setting the number of systems per page.

System and frame breaks
System and frame breaks allow you to adjust layouts at a more granular level, by 
determining which bars are shown on each system and where music is pushed into the 
next frame.

Page size
The page size determines the available space for music and frames for each layout.

Page margins
Page margins determine the dimensions of pages in layouts. Frames cannot exceed 
the boundaries set by the margins of the layout, which you can change on the Page 
Setup page in Layout Options. You can change the size of margins on each edge of 
each page.

Page templates
All pages in your layouts inherit their layout formats from page templates. Although 
you cannot create or edit page templates in Dorico Elements, we recommend being 
familiar with them as a concept, so you are aware of how pages are formatted. 
For example, if you override a page template, such as by editing the title directly 
in the music area, empty pages that are no longer required might not be deleted 
automatically.

TIP

We recommend entering information such as the composer, librettist, and flow/
project titles in the Project Info dialog. The default page templates display different 
information from the Project Info dialog according to their type.
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Flow headings
Flow headings show the number and title of each flow immediately above their first 
system automatically. They have no fixed vertical position and follow the music if it 
moves. The default flow heading contains tokens to display the flow number and flow 
title; in a new project, this appears as “1. Flow 1”.

You can hide/show flow headings on a per-layout basis. You can change the tokens 
included in flow headings; for example, if you want to remove flow numbers and only 
show flow titles. Deleting or editing individual flow headings is considered a page 
template override, which is a type of page format change.

Music frame margins
Music frames have margins at the top and bottom. Music frame margins provide 
padding to ensure that musical material displayed within the frame remains on the 
page. For example, if music frames have no padding, the top line on the top staff in the 
frame is positioned at the top of the frame. Any notes that require ledger lines above 
the staff might then be positioned off the top of the page. You can change the music 
frame margins for each layout.

We recommend familiarizing yourself with these concepts, and how to use them together and in 
different contexts, in order to produce well-formatted layouts.

NOTE

In Dorico Elements, you cannot edit all the objects and settings used to determine page 
formatting, such as frames and page templates. However, we have included basic information 
about these topics in this documentation for your information.

RELATED LINKS
Layout Options dialog on page 745
Staff size on page 617
Staff spacing on page 620
Casting off on page 629
System breaks on page 633
Frame breaks on page 636
Page templates on page 647
Types of page templates on page 648
Flow headings on page 651
Hiding/Showing flow headings on page 611
Removing page template overrides on page 651
Tacets on page 640
Margins on page 614
Page vs. paper size on page 593
Hiding/Showing empty staves on page 605
Hiding/Showing used chord diagrams grids on page 898
Layouts on page 174
Flows on page 171
Players on page 123
Project Info dialog on page 75
Project templates on page 77
Changing the default font family on page 760
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Changing the page size and/or orientation
You can change the page size and/or orientation of each layout independently. For example, you 
can use a large, landscape page in full score layouts and a small, portrait page for part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the page size and/or 
orientation.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Size section, select a page size from the Size menu.

For example, you can select fixed page sizes, such as A3 or Letter, or select Custom to 
define your own page size.

5. Optional: If you selected Custom, set the page dimensions by changing the values in the 
following value fields:

● Width

● Height

6. Choose one of the following options for Orientation:

● Portrait

● Landscape

7. Click Apply, then Close.

RESULT
The page size and/or orientation is changed for all the selected layouts.

NOTE

Changing the page size of layouts might not change the paper size automatically selected for 
those layouts in the Print Options panel in Print mode. For example, if your default printer 
cannot print the page size selected for layouts, the largest paper size the printer can handle is 
selected. Similarly, if you had already set options for printing layouts before changing the page 
size in Layout Options, Dorico Elements attempts to preserve your original print options.

Similarly, the page orientation is independent of the paper orientation. We recommend that you 
check that layouts have the correct paper orientation set for their page orientation in the Print 
Options panel in Print mode before printing/exporting, as it is possible to print landscape layouts 
on portrait paper and vice versa.

RELATED LINKS
Paper size and orientation setup on page 594
Printing layouts on page 581
Exporting layouts as graphics files on page 585
Hiding/Showing status bar tools on page 40
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Changing page margins
You can change the page margins of each layout independently; for example, if you want wider 
margins for layouts in your project that will be spiral bound.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the page margins.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Margins section, choose one of the following options for Page margins:

● Same: All pages in the selected layouts have the same margins.

● Different: Left and right pages in the selected layouts can have completely different 
margins.

● Mirrored: Left and right pages in the selected layouts use the same margin values but 
they correspond to the inside/outside edges of pages.

5. Optional: Change the margins by changing the values in the value fields.

6. Click Apply, then Close.

RESULT
The page margins in the selected layouts are changed.

RELATED LINKS
Margins on page 614
Changing the first system indent on page 1328
Changing the gap before codas on page 1242
Hiding/Showing staff labels on page 1310
Hiding/Showing used chord diagrams grids on page 898

Applying page template sets to layouts
You can change the page template set used by each layout in your project; for example, if you 
want a custom score layout to use the Default Part page template set because that set shows 
the layout name on the first page.

By default, full score and custom score layouts use the Default Full Score page template set and 
part layouts use the Default Part page template set.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose page template set you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.
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3. In the category list, click Page Setup.

4. In the Page Template section, select the page template set you want from the Page 
template set menu.

5. Click Apply, then Close.

RESULT
The selected page template set is applied to the selected layouts.

RELATED LINKS
Page template sets on page 647
Changing when the First page template is used on page 610
Allowing/Disallowing multiple flows on the same page on page 609
Hiding/Showing flow headings on page 611

Changing the default staff size
You can change the default size of staves in each layout independently. For example, you can 
have a small staff size in full score layouts but a larger staff size in part layouts.

NOTE

If the size of system object font styles is set to Staff-relative, the staff size of the top staff in each 
instrument family group affects the size of system objects if they are shown above that bracketed 
group. Font styles that are set to Absolute are unaffected by staff size.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose staff size you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Space Size section, select the staff size you want from the Rastral size menu.

NOTE

If you select Custom, you can set a custom value in the Space size field, expressed in your 
preferred unit of measurement.

You can also set a Custom value by changing the value when any Rastral size is selected.

5. Optional: Repeat steps 2 to 4 for other layouts.

6. Click Apply, then Close.

RESULT
The staff size is changed throughout the selected layouts.
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TIP

You can also change the size of individual staves.

RELATED LINKS
Staff size on page 617
Paragraph Styles dialog on page 756
Edit Font Styles dialog on page 754
Brackets and braces on page 864
System objects on page 1326

Changing the default staff/system spacing
You can change the default gaps between staves and systems in each layout independently. For 
example, you can have smaller gaps between staves in full score layouts to accommodate more 
staves, and larger gaps between systems in part layouts to give players space to add pencil 
markings.

TIP

● If the staves in a layout are very close together, just decreasing the staff size might be 
sufficient to produce good results.

● We recommend that you set the ideal gaps to the minimum value acceptable to you, as 
Dorico Elements automatically allocates additional space for other items, such as system 
objects and dynamics, and avoids collisions between notes and staves above/below.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the default staff/system 
spacing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Vertical Spacing.

4. In the Ideal Gaps section, change the values for the different contexts as required.

5. Click Apply, then Close.

RESULT
The minimum gaps between staves and systems in the corresponding contexts are changed. This 
affects how much space Dorico Elements allows for staves/systems in its casting off estimations 
and whether frames are considered full enough to justify vertically automatically.

RELATED LINKS
Staff spacing on page 620
Enabling/Disabling text collision avoidance on page 1357
Locking layouts on page 631
Note spacing on page 507
Changing the first system indent on page 1328
Changing the gap before codas on page 1242
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Hiding/Showing staff labels on page 1310
Hiding/Showing empty staves on page 605
Changing the default player order on page 125

Changing the vertical justification of staves/systems
You can change the minimum fullness threshold above which Dorico Elements automatically 
vertically justifies staves and systems, which means they are evenly distributed to fill the height 
of frames. You can also control whether staves and systems are both vertically justified or only 
systems are vertically justified.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the automatic vertical 
justification of staves/systems.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Vertical Spacing.

4. In the Ideal Gaps section, choose one of the following options for Gap to use for divisi 
staves:

● Staff to staff

● Braced staff to braced staff

5. In the Vertical Justification section, change the values for the following options, individually 
or together:

● Justify distance between staves and systems when frame is at least [n]% full

● Justify distance only between systems when frame is at least [n]% full

6. Activate/Deactivate Justify staves when frame with single system is above this threshold.

7. Click Apply, then Close.

RESULT
The automatic vertical justification of staves and systems in the selected layouts is changed. 
Braced staves are never vertically justified.
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EXAMPLE

A page with staves and systems both justified The same page with only systems justified

RELATED LINKS
Per-layout vertical spacing options on page 621
Moving multiple systems simultaneously on page 627
Frame fullness indicators on page 506

Hiding/Showing empty staves
You can hide/show empty staves differently in each layout independently. For example, you can 
show all staves, including empty staves, in a full score layout for the conductor but hide empty 
staves in a full score layout intended for reference only.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show empty staves.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Vertical Spacing.

4. In the Staff Visibility section, choose one of the following options for Hide empty staves:

● After first system

● All systems

● Never

5. Activate/Deactivate Allow individual staves of multi-staff instruments to be hidden.
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6. Optional: For Players excluded from Hide Empty Staves, activate the checkbox for each 
instrument you want to be shown regardless of your choice for Hide empty staves.

7. Click Apply, then Close.

RESULT
Empty staves in the selected layouts are hidden/shown according to your choice. If you activated 
Allow individual staves of multi-staff instruments to be hidden, any single empty staves in 
multi-staff instruments, such as piano or harp, can be hidden in the selected layouts.

RELATED LINKS
Extra staves on page 1323
Divisi on page 1329
Per-layout vertical spacing options on page 621
Hiding/Showing blank staves after final flows on page 608
Changing the default player order on page 125
Hiding/Showing system dividers on page 1324
Hiding/Showing secondary brackets on page 868
Hiding/Showing braces on single staves on page 867
MIDI trigger regions on page 574
Instrument filters on page 445

Hiding/Showing staves from system/frame breaks
You can manually change staff visibility from the rhythmic positions of system/frame breaks 
onwards by hiding, showing, and resetting individual staves. For example, if you have hidden 
empty staves in the layout but want specific empty staves to appear in some sections, or you 
want to hide staves with music on them in some layouts.

PROCEDURE

1. Optional: If you want to change staff visibility manually from a rhythmic position that does 
not yet have a system/frame break, select an item at the position from which you want to 
change staff visibility.

2. Open the Manual Staff Visibility dialog in one of the following ways:

● If a system/frame break signpost exists at the position where you want to change staff 
visibility, select it and press Return  or double-click it.

● If no system/frame break exists, choose Edit > Notations > Staff > Manual Staff 
Visibility. You can also choose this option from the context menu.

3. Change staff visibility as required.

For example, you can activate and change the setting for individual staves, or use the 
options in the action bar to change the setting for all staves simultaneously.

4. Click OK to save your changes and close the dialog.

RESULT
Staff visibility is changed from the selected rhythmic position or system/frame break signpost 
onwards until the next staff visibility change or the end of the flow, whichever comes first and 
whether the staves are empty or not.

If a system/frame break signpost did not yet exist at the selected rhythmic position, a system 
break with your staff visibility settings is inserted at the selected rhythmic position.
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RELATED LINKS
Frame breaks on page 636
System breaks on page 633
Staff spacing on page 620
MIDI trigger regions on page 574

Manual Staff Visibility dialog
The Manual Staff Visibility dialog allows you to hide, show, and reset individual staves manually 
from system/frame breaks.

You can open the Manual Staff Visibility dialog in Write mode in any of the following ways:

● Choose Edit > Notations > Staff > Manual Staff Visibility when an item is selected in the 
music area. You can also choose this option from the context menu.

● Select a system/frame break signpost and press Return , or double-click a system/frame 
break signpost.

The Manual Staff Visibility dialog comprises the following:

1 Staff list

Contains all the staves that exist at the selected rhythmic position, including hidden empty 
staves. Activating staves includes them in the manual staff visibility change.

For each staff, the following staff visibility options are available:

● Reset: Resets the visibility of the staff to the default setting in the layout, as set on the 
Vertical Spacing page in Layout Options.

● Show: Shows the staff from the selected rhythmic position onwards, whether it is empty 
or not.

● Hide: Hides the staff from the selected rhythmic position onwards, whether it is empty 
or not.

2 Action bar

Contains options that allow you to change the staff visibility setting of all staves 
simultaneously.

● Clear All: Deactivates all staves.

● Reset All: Activates all staves and sets them to Reset.

● Show All: Activates all staves and sets them to Show.
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● Hide All: Activates all staves and sets them to Hide.

Hiding/Showing blank staves after final flows
You can hide/show additional blank staves to fill the page after the final flow in each layout 
independently; for example, if you want to emulate the convention of showing additional blank 
staves between the final system and the bottom of the page when formatting part layouts for 
recording sessions.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show blank staves after the 
ends of flows.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, activate/deactivate Fill frame with blank staves.

5. If you activated Fill frame with blank staves, activate/deactivate Show blank staves in 
systems identical to final flow.

6. Customize the appearance of blank staves in one of the following ways:

● If you activated Show blank staves in systems identical to final flow and want to 
show clefs that follow the previous flow on blank staves, choose Include clefs.

● If you activated Show blank staves in systems identical to final flow and want to hide 
clefs on blank staves, choose Exclude clefs.

● If you deactivated Show blank staves in systems identical to final flow, change the 
number of staff lines in blank staves by changing the value for Number of staff lines 
for blank staves.

RESULT
Blank staves are shown after the final flow in the selected layouts when Fill frame with blank 
staves is activated, and hidden when it is deactivated. When shown, blank staves appear below 
the final system in the final flow and fill the width of the final system if it is not fully horizontally 
justified.

When Show blank staves in systems identical to final flow is activated, blank staves follow the 
staff grouping of the final flow, such as two bracketed staves in a part layout with two players 
assigned to it. When it is deactivated, single blank staves without clefs are shown.

NOTE

You cannot input music or change brackets/braces on blank staves.

RELATED LINKS
Per-layout vertical spacing options on page 621
Changing the horizontal justification of final systems on page 612
Staff labels on page 1309
Brackets and braces on page 864
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Starting layouts on left-hand pages
By default, all layouts start on a right-hand page, as convention dictates that odd numbered 
pages are always on the right-hand page. However, you can set individual layouts to start on a 
left-hand page; for example, to facilitate page turns better in that layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts you want to start on a left-hand page.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Numbers section, change the value for Initial page number to an even 
number.

5. Click Apply, then Close.

RESULT
The first page in the selected layouts is shown on a left-hand page when the initial page number 
is even.

Allowing/Disallowing multiple flows on the same page
You can allow/disallow new flows to be shown on the same page as previous flows if there is 
space; for example, to reduce the number of pages required for parts in works with multiple 
movements. By default, new flows are allowed on the same page in part layouts and are not 
allowed in full score layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to allow multiple flows to be shown 
on each page.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, choose one of the following options for New flows:

● Always start new page

● Allow on existing page

5. Click Apply, then Close.

RESULT
Always start new page ensures flows in the selected layouts always begin at the start of the 
next page after the end of the previous flow.

Allow on existing page allows flows in the selected layouts to continue immediately after each 
other, including within the same music frame if there is sufficient space. Flow headings are 
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automatically shown above the start of flows if you have chosen to show flow headings in the 
selected layouts.

NOTE

Flows are not automatically split into separate music frames. You must insert frame breaks 
manually to divide flows into separate music frames if required.

RELATED LINKS
Tokens on page 655
Casting off on page 629
Assigning flows to layouts on page 177
Assigning players to flows on page 172
Hiding/Showing information above flow headings on page 611
Hiding/Showing blank staves after final flows on page 608

Changing when the First page template is used
You can change the circumstances when the First page template is used in each layout 
independently; for example, if you want to use it for the start of every flow in the full score 
but only want to use it for the first flow in part layouts, even when subsequent flows start at the 
top of the page.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change when the First page 
template is used.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, choose one of the following options for Use ‘First’ page template:

● Never

● First flow only

● Any flow starting at top of page

5. Click Apply, then Close.

RESULT

● Choosing Never means the First page template is not used for any page in the selected 
layouts.

● Choosing First flow only means the First page template is used for the first page in the 
layout but no other pages, even if some subsequent flows start at the top of a page.

● Choosing Any flow starting at top of page means the First page template is used for all 
pages in the layout that begin with the start of a flow.

RELATED LINKS
Layout Options dialog on page 745
Types of page templates on page 648
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Hiding/Showing flow headings
You can hide/show flow headings in each layout independently; for example, if your project only 
contains a single flow and you only want to show the project title. You can also hide the heading 
for the first flow but show flow headings for subsequent flows.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show flow headings.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, choose one of the following options for Show flow headings:

● Never

● Not for first flow

● For all flows

5. Click Apply, then Close.

RESULT
Flow headings are shown above the first system in each flow in the selected layouts when you 
choose For all flows, hidden when you choose Never, and hidden above the first system in the 
first flow but shown above all other flows when you choose Not for first flow.

They are automatically positioned above each flow and below the preceding flow according to 
the margins set for each layout.

NOTE

Hiding flow headings does not hide the flow title shown at the top of the second page onwards 
by default.

RELATED LINKS
Flow headings on page 651
Allowing/Disallowing multiple flows on the same page on page 609
Hiding/Showing information above flow headings on page 611
Project Info dialog on page 75
Types of page templates on page 648
Changing when the First page template is used on page 610

Hiding/Showing information above flow headings
You can hide/show flow titles, page numbers, and flow page numbers separately when they 
appear above flow headings at the top of a new page in each layout independently. Hiding such 
information in running headers is a custom in publishing.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.
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2. In the Layouts list, select the layouts in which you want to hide/show information in running 
headers above flow headings.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, choose one of the following options for Flow title in header:

● Show above flow heading

● Hide above flow heading

5. Choose one of the following options for Page number in header:

● Show above flow heading

● Hide above flow heading

6. Choose one of the following options for Flow page number in header:

● Show above flow heading

● Hide above flow heading

7. Click Apply, then Close.

RESULT
The corresponding information is hidden/shown when they appear above flow headings at the 
top of the page.

NOTE

In order to hide running header information, the top of the music frame containing the 
flow heading frame must be lower than the top of text frames containing the corresponding 
information. If the top of the music frame is the same height as a running header text frame, any 
corresponding information in the text frame is shown, regardless of your setting.

RELATED LINKS
Frames on page 654
Page templates on page 647
Hiding/Showing page numbers on page 1151

Changing the horizontal justification of final systems
You can change whether the final systems of flows always fill the width of frames or only do so 
above a certain fullness threshold in each layout independently. By default in Dorico Elements, 
the final systems of flows only justify to the full width of the frame when they are more than half 
full.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the justification of the 
final systems in flows.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
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and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Note Spacing.

4. Change the justification of final systems in flows in one of the following ways:

● If you always want the final systems in flows to justify fully, deactivate Only justify final 
system in flow when more than [n]% full.

● If you want to change the minimum fullness of final systems before they justify, change 
the value for Only justify final system in flow when more than [n]% full.

5. Click Apply, then Close.

RESULT
The automatic justification of the final systems in flows in the selected layouts is changed.

TIP

You can also change the width of individual systems independently of your default settings by 
changing their start/end positions.

EXAMPLE

Final system below fullness threshold, unjustified Final system justified

RELATED LINKS
Note spacing on page 507
Moving the start/end of systems on page 513
Changing the first system indent on page 1328
Changing the gap before codas on page 1242
Fixing the number of bars per system on page 629
Hiding/Showing blank staves after final flows on page 608
Hiding/Showing bar rests in empty bars on page 1277
Deleting rests on page 1276
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Margins
Margins determine the spacing around music on pages, such as on all four edges of each page 
and above/below flow headings.

In Dorico Elements, there are the following types of margins:

1 Page margins

The gaps between the four edges of pages and the boundary of the content on them. For 
example, systems that are horizontally justified span the full width of pages between the left 
and right page margins. You cannot position frames beyond the page margins.

2 Music frame margins

The gaps at the top and bottom of music frames. Also known as “music frame padding”.

● Top music frame margins set the gap between the top edges of music frames and the 
top staff line of the highest staff in the frame.

● Bottom music frame margins set the gap between the bottom edges of music frames 
and the bottom staff line of the lowest staff in the frame.

3 Flow heading margins

The gaps above and below flow headings. When flow headings are positioned at the top of 
music frames, the flow heading bottom margin sets the gap at the top of the music frame, 
rather than the music frame margin.

● Flow heading top margins set the gap between the top of flow headings and the bottom 
staff line of the preceding flow, if applicable.

● Flow heading bottom margins set the gap between the bottom of flow headings and the 
top staff line of the next flow.
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NOTE

Notes and notations above the highest staff and below the lowest staff extend into margins.

RELATED LINKS
Flow headings on page 651
Changing page margins on page 601
Changing the margins above/below tacets on page 642
Changing the page size and/or orientation on page 600
Changing the default staff/system spacing on page 603
Changing the vertical justification of staves/systems on page 604
Changing the horizontal justification of final systems on page 612
System fullness indicators on page 506
Frame fullness indicators on page 506

Changing the margins above/below flow headings
You can change the margins both above and below flow headings, which control the gap 
between the preceding flow and the flow heading, and the gap between the flow heading and 
the start of the next flow.

PREREQUISITE
Flow headings are shown in the layouts in which you want to change the margins above/below 
flow headings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the margins above/below 
flow headings.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Flows section, change the values for the following options, individually or together:

● Flow heading top margin

● Flow heading bottom margin

5. Click Apply, then Close.

RESULT
The margins above/below flow headings in the selected layouts are changed.

● Flow heading top margin sets the gap between the top of flow headings and the end of the 
preceding flow.

● Flow heading bottom margin sets the gap between the bottom of flow headings and the 
start of the next flow.

For example, when the bottom margin is set to 0, the bottom of the lowest frame in the flow 
heading aligns with the top staff line of the first system in the flow below the flow heading.
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EXAMPLE

Flow heading with default margins above/below Flow heading with decreased margins above/below

RELATED LINKS
Flow headings on page 651
Per-layout vertical spacing options on page 621
Moving individual staves/systems vertically on page 624
Hiding/Showing used chord diagrams grids on page 898
Changing the margins above/below tacets on page 642

Changing the default music frame margins
You can change the default margins in all music frames in each layout independently. For 
example, you might want more padding at the top of music frames in part layouts containing lots 
of notes above the staff.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose music frame margins you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Music Frame Margins section, change the values for the following options, 
individually or together:

● Top

● Bottom

5. Click Apply, then Close.

RESULT
The margins within all music frames in the selected layouts are changed.

● Top sets the gap between the top edges of music frames and the top staff line of the highest 
staff in the frame.

● Bottom sets the gap between the bottom edges of music frames and the bottom staff line of 
the lowest staff in the frame.

For example, when the bottom music frame margin is set to 0, the bottom staff line of the lowest 
staff in the frame aligns with the bottom edge of the music frame.
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NOTE

Notes and notations above the highest staff and below the lowest staff extend into music frame 
margins.

RELATED LINKS
Changing page margins on page 601
Changing the default staff/system spacing on page 603
Hiding/Showing used chord diagrams grids on page 898

Staff size
Staff size refers to the distance between the top and bottom lines of staves, and can be 
expressed as a point size or in another supported unit of measurement, such as millimeters. 
For individual staves, you can use a scale size of the default staff size in the layout. The most 
appropriate staff size depends on the intended purpose of the layout.

For example, full orchestral scores that are quite dense need a much smaller staff size than 
individual parts, which require large enough notes so that performers can read them easily. 
Staves can overlap and the music can become illegible if the staff size is too large in dense 
scores.

In Dorico Elements, you can set the staff size using the rastral size and the space size, depending 
on which measurement is more appropriate for the selected layouts.

1 Rastral size is the size of the full staff, measured from the bottom line to the top line.

2 Space size is the distance between two staff lines.

When changing the staff size of each layout in Layout Options, we recommend that you use one 
of the preset rastral sizes, as these are based on traditional and generally accepted staff sizes 
that are all widely used in music engraving.

NOTE

The size of staves can affect the size of system objects.

RELATED LINKS
System objects on page 1326
Changing your preferred unit of measurement on page 51
Changing the default staff size on page 602
Staff spacing on page 620
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Changing the staff size from system/frame breaks
You can change the staff size of all staves from the rhythmic position of system/frame breaks 
onwards in layouts. For example, you can have smaller staves only on pages with more staves, 
and larger staves on other pages with fewer staves.

NOTE

If the size of system object font styles is set to Staff-relative, the staff size of the top staff in each 
instrument family group affects the size of system objects if they are shown above that bracketed 
group. Font styles that are set to Absolute are unaffected by staff size.

PREREQUISITE

● You have inserted system/frame breaks at the positions from which you want to change the 
staff size.

● Signposts are shown for system/frame breaks.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the system/frame break signposts from which you want to change 
the staff size.

2. In the Properties panel, activate Space size in the Format group.

3. Change the value in the value field.

RESULT
The staff size of all staves in the layout is changed until the next change in staff size or the end of 
the flow, whichever comes first.

By default, the next flow uses the default staff size in the layout.

RELATED LINKS
Engrave toolbox on page 503
Changing the default staff size on page 602
Inserting system breaks on page 634
Inserting frame breaks on page 637
Hiding/Showing system break signposts on page 636
Hiding/Showing frame break signposts on page 639

Changing the staff size for individual players
You can change the size of all staves belonging to individual players throughout each flow in 
the current layout only, independently other players’ staves. For example, piano accompaniment 
parts often include the solo instrument on a smaller staff.

You can change the size of staves to a set scale size, expressed as a percentage of the normal 
staff size in the layout, or set a custom scale.
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TIP

If you want to change the staff size to represent an alternative version of a passage, you can 
instead add an ossia staff, which you can show for specific regions.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select an item on the staff whose size you want to change. You can do this in Write mode 
and Engrave mode.

NOTE

You can only change the size of a single staff at a time.

2. Choose Edit > Notations > Staff Size > [Staff size]. You can also choose this option from the 
context menu.

3. Optional: If you chose Custom Staff Size, set the staff size in the Custom Staff Size dialog 
that opens.

RESULT
The size of all staves held by the selected player are changed throughout the whole flow in the 
current layout only.

This also works in combination with the other ways of changing the staff size, such as changing 
the size of all staves in the layout or changing the size of staves from specific system/frame 
breaks.

NOTE

If the size of system object font styles is set to Staff-relative, the staff size of the top staff in each 
instrument family group affects the size of system objects if they are shown above that bracketed 
group. Font styles that are set to Absolute are unaffected by staff size.

EXAMPLE

A piano part with smaller staff above

RELATED LINKS
Edit Font Styles dialog on page 754
Brackets and braces on page 864
System objects on page 1326
Engrave toolbox on page 503
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Custom Staff Size dialog
The Custom Staff Size dialog allows you to change the size of individual staves by a custom scale 
factor.

● You can open the Custom Staff Size dialog by selecting an item on a staff and choosing 
Edit > Notations > Staff Size > Custom Staff Size.

The Custom Staff Size dialog contains the following options:

Default staff size
Displays the default size of staves in the current layout. This size is set on the Page 
Setup page in Layout Options.

The default staff size is expressed as both a point size and in your preferred unit of 
measurement.

Rastral size
Allows you to select the rastral size on which you want to base your custom staff size.

Scale factor
Sets the custom staff size, expressed as a percentage of the selected rastral size.

New staff size
Displays the new custom staff size for the selected staff as a result of the changes you 
have made in the dialog.

The new staff size is expressed as both a point size and in your preferred unit of 
measurement.

Staff spacing
The vertical positioning of staves and systems within frames is known as staff spacing. Staff 
spacing calculations consider the height of staves and the necessary gaps between staves and 
systems.

You can change staff spacing in your project at different levels:

● Change the default staff spacing in each layout in Layout Options.

● Change the staff spacing between individual staves.

NOTE

● We recommend adjusting the default staff spacing values and/or changing the staff size in 
layouts before moving individual staves, as in most cases Dorico Elements produces suitable 
results without the need to move individual staves.
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● We recommend that you add extra pages and finish laying out your pages before moving 
individual staves. Individual staff spacing changes are automatically deleted if the frame in 
which they occur changes.

● Moving individual staves/systems vertically does not affect the casting off. If you want to 
show more/fewer systems in a frame, you can change the casting off by, for example, using 
frame breaks or setting a fixed number of systems per frame.

RELATED LINKS
Layout Options dialog on page 745
Staff size on page 617
Staves on page 1322
Engrave toolbox on page 503
Frame fullness indicators on page 506
Changing the default staff/system spacing on page 603
Enabling/Disabling text collision avoidance on page 1357
Changing the staff spacing in galley view on page 623
Changing the default staff size on page 602
Margins on page 614
Casting off on page 629
Frame breaks on page 636
Making selections into frames on page 638
Moving bars to other systems on page 631
Fixing the number of systems per frame on page 630
Note spacing on page 507

Per-layout vertical spacing options
Dorico Elements provides multiple options that you can use to control the default vertical spacing 
and justification of staves and systems in each layout.

● You can access per-layout vertical spacing options by opening the Layout Options dialog 
and clicking Vertical Spacing in the category list.

The Vertical Spacing page contains the following sections and options:

Ideal Gaps

Contains multiple scenarios that allow you to set the gap you want Dorico Elements to allow 
between staves and systems in the corresponding context, including the default scaling of these 
gaps in galley view, as Dorico Elements does not automatically avoid collisions between staves 
and items in galley view. The options are accompanied by diagrams to help you visualize the 
contexts to which each option applies.

We recommend setting the ideal gaps to the minimum value acceptable to you because Dorico 
Elements never reduces the gap between staves to less than your set values. Setting smaller 
values gives Dorico Elements greater flexibility when determining staff spacing, particularly in 
very full frames, such as reducing the space between staves with no dynamics to allow more 
space between staves with dynamics. Similarly, we recommend setting vertical spacing options 
after you have finished inputting notes and items, as this allows you to consider the entire 
project when setting these options.

Depending on the context, the options are affected by automatic vertical justification in different 
ways:
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● Staff to staff, Staff group to staff, Staff to staff group, Staff group to staff group, 
Inter-system gap, and Timecode staff to staff

These gaps do not apply in frames that are automatically justified.

● Braced staff to braced staff, Braced staff to unbraced staff, and Ossia staff to staff

These gaps always apply, including in frames that are automatically justified, because braced 
and ossia staves are never justified. This includes extra staves.

NOTE

● Divisi staves are vertically justified when they use the Staff to staff gap. When they use the 
Braced staff to braced staff gap, the staves in each divisi section use only the gap set for 
braced staves and are not vertically justified.

● If the staves in a layout are very close together, just decreasing the staff size might be 
sufficient to produce good results.

● When calculating the number of systems that can fit in each frame in a layout, Dorico 
Elements considers the height of staves, the minimum gaps between staves, the maximum 
distances between very high/low notes and staves, and other items that require vertical 
space, such as pedal lines and tempo marks. However, this calculation happens before 
horizontal spacing is finalized, which can result in either more or fewer systems being 
allocated to frames than ideally fit. In such circumstances, you can use fixed casting off 
settings and system/frame breaks to change which systems appear in frames.

Minimum Gaps

Contains options for the minimum gaps you want Dorico Elements to allow for items in addition 
to the staff spacing gaps.

● Automatically resolve collisions between adjacent staves and systems: When activated, 
Dorico Elements automatically allows extra space between staves and systems to avoid 
collisions. When deactivated, Dorico Elements only uses your set gaps for vertical spacing, 
which produces evenly-spaced staves and systems but with the possibility of collisions 
between items.

● Minimum inter-staff gap with content: Allows you to set the extra space you want to allow 
between staves when items are present.

● Minimum inter-system gap with content: Allows you to set the extra space you want to 
allow between systems when items are present.

NOTE

Minimum gaps do not affect casting off. For example, increasing the Minimum inter-system 
gap with content value changes the space above/below systems on a page but does not push 
systems to later pages. Instead, you can change the ideal gaps.

Vertical Justification

Contains options that allow you to control the frame fullness thresholds above which you want 
staves and/or systems to justify vertically automatically.

● Justify distance between staves and systems when frame is at least [n]% full: When 
frames are filled above this threshold, the staves and systems they contain are all 
automatically vertically justified, meaning they are evenly distributed to fill the height of 
the frame. Frames filled below this threshold are not automatically justified; instead, staves 
follow your ideal gap settings. This can leave gaps between the bottom staff/system and the 
bottom of the frame.
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● Justify distance only between systems when frame is at least [n]% full: When frames are 
filled above this threshold, only the distance between systems in the frame is justified. Staves 
follow your per-layout ideal gap settings. This helps keep a clear distance between systems 
on very full pages.

● Justify staves when frame with single system is above this threshold: When activated, 
all the staves in a single system taller than the set threshold are vertically justified, which 
distributes them evenly to fill the height of the frame.

Staff Visibility

Contains options allowing you to control when and which empty staves are hidden in the layout.

● Hide empty staves: Allows you to control when empty staves are hidden. For example, it is 
a common practice to show all staves in the first system, even if some are empty, but this is 
not always required.

● Allow individual staves of multi-staff instruments to be hidden: Allows you to control 
whether individual empty staves belonging to multi-staff instruments can be hidden 
independently or all multi-staff instrument staves must always be shown.

● Players excluded from Hide Empty Staves: Allows you to identify specific players whose 
staves you always want to show, even if their staff is empty on systems where you have 
hidden empty staves.

RELATED LINKS
Layout Options dialog on page 745
Changing the default staff/system spacing on page 603
Frame fullness indicators on page 506
Page formatting on page 598
Casting off on page 629
Margins on page 614
Staff size on page 617
Brackets and braces on page 864
Staves on page 1322
Ossia staves on page 1323
Tablature on page 1330
Hiding/Showing staves from system/frame breaks on page 606
Making selections into systems on page 635
Making selections into frames on page 638
Changing the vertical position of markers on page 1222
Changing the vertical position of timecodes on page 1227

Changing the staff spacing in galley view
You can change the vertical space between staves in galley view in each layout independently, 
expressed as a percentage of the set ideal gaps. Increasing the gaps between staves in layouts 
with very high/low notes can be useful because Dorico Elements does not perform automatic 
collision avoidance in galley view.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the staff spacing in galley 
view.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
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and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Vertical Spacing.

4. In the Ideal Gaps section, change the value for In galley view, expand ideal staff gaps to.

5. Click Apply, then Close.

RELATED LINKS
Instrument filters on page 445
Switching to galley/page view on page 50
Switching between layouts on page 43

Moving individual staves/systems vertically
You can change the spacing of individual staves, including ossia staves, by changing the vertical 
position of individual staves and systems independently of your project-wide settings.

IMPORTANT

We recommend that you finish casting off before moving individual staves, as individual staff 
spacing changes are automatically deleted if the frame in which they occur changes.

NOTE

Moving individual staves/systems vertically does not affect the casting off. If you want to show 
more/fewer systems in a frame, you can change the casting off by, for example, using frame 
breaks or setting a fixed number of systems per frame.

When Staff Spacing  is activated in the Engrave toolbox, the following are shown:

● System spacing handles: Large square handles on the top left corner of the top staff in each 
system. System spacing handles control the vertical position of whole systems.

● Staff spacing handles: Small square staff handles on the bottom left corner of each staff. 
Staff spacing handles control the vertical position of individual staves.

● Gap measurements: Lines and highlighted numbers indicating the distances between staves 
and systems, shown using your preferred unit of measurement.

● Music frame margin highlights: Translucent highlights at the top/bottom of music frames 
indicating the extent of music frame margins.

System spacing handle, staff spacing handle, and gap measurement in Engrave mode when Staff Spacing is 
activated

PREREQUISITE
Staff Spacing  is selected in the Engrave toolbox.
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PROCEDURE

1. In Engrave mode, select one of the following on each staff/system you want to move 
vertically:

● Staff spacing handle

● System spacing handle

NOTE

● You can switch between having a staff or system spacing handle selected by pressing 
Tab .

● When using the mouse, you can only move one staff/system at a time.

2. Move the selected staves/systems in any of the following ways:

● To move them a standard amount upwards or downwards, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Up Arrow  to move handles 
upwards.

● To move them a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Up Arrow .

● To move them a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Up Arrow .

● To move them a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Up Arrow .

● Click and drag a single staff/system spacing handle upwards/downwards.

RESULT
The vertical position of the selected staves/systems is changed. The color of the handles changes 
to indicate that you have moved them. When you move system handles, both the square handle 
and the highlighted strip at the top of the system change color.

NOTE

● When Staff Spacing  is activated, you cannot select or edit anything other than staff/
system spacing handles. To resume normal selection and editing, click Graphic Editing  in 
the Engrave toolbox or return to Write mode.

● You can also click the gap measurement numbers and change the value using any of the 
supported units of measurement, which are points, millimeters, centimeters, and inches.

You can change your preferred unit of measurement to be used throughout Dorico Elements 
on the General page in Preferences.
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EXAMPLE

Staff spacing handles at their default positions The second staff has been moved upwards

AFTER COMPLETING THIS TASK
You can copy manual changes you have made to the staff spacing on individual pages to other 
pages in the layout.

RELATED LINKS
Engrave toolbox on page 503
Frame fullness indicators on page 506
Moving multiple systems simultaneously on page 627
Enabling/Disabling text collision avoidance on page 1357
Changing the default music frame margins on page 616
Copying staff spacing changes to other pages on page 628
Changing your preferred unit of measurement on page 51
Margins on page 614
Casting off on page 629
Frame breaks on page 636
Making selections into frames on page 638
Moving bars to other systems on page 631
Fixing the number of systems per frame on page 630

Removing individual changes to staff spacing
You can remove changes you have made to the staff/system spacing and reset staff/system 
spacing handles to their original default positions.

PREREQUISITE
Staff Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the staff/system handles you want to reset to their original 
positions.

2. Press Backspace or Delete .

RESULT
The selected staff/system handles are reset to their original positions.

TIP

You can also reset all staff spacing changes within selected systems, frames, or all staff spacing 
changes in the layout by choosing one of the options in the Engrave > Staff Spacing menu.
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Moving multiple systems simultaneously
You can move multiple systems at the same time so that the gaps between each system remain 
equal. This is also known as “concertina dragging”.

IMPORTANT

We recommend that you add extra pages and finish laying out your pages before moving 
individual staves. Individual staff spacing changes are automatically deleted if the frame in which 
they occur changes.

NOTE

● You can only move multiple systems closer together, you cannot use this method to move 
them further apart.

● You cannot follow these steps for staff spacing handles on tacets.

● Moving individual staves/systems vertically does not affect the casting off. If you want to 
show more/fewer systems in a frame, you can change the casting off by, for example, using 
frame breaks or setting a fixed number of systems per frame.

PREREQUISITE
Staff Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the system handle on the highest systems you want to move.

NOTE

When using the mouse, you can only move systems below a single system at a time.

2. Move the selected systems in any of the following ways:

● To move them downwards a standard amount, press Alt/Opt-J .

● To move them downwards a large amount, press Ctrl/Cmd-Alt/Opt-J .

● Alt/Opt -click and drag the system handle downwards.

RESULT
All systems below the selected system, until the bottom of the music frame, are moved closer 
together. The gaps between each system remain equal.

RELATED LINKS
Engrave toolbox on page 503
Staff spacing on page 620
Tacets on page 640
Casting off on page 629
Frame breaks on page 636
Making selections into frames on page 638
Moving bars to other systems on page 631
Fixing the number of systems per frame on page 630
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Copying staff spacing changes to other pages
You can copy manual staff spacing changes you have made on individual pages to other pages in 
the layout.

NOTE

In order to copy staff spacing changes, destination pages must have the same number of staves 
per system and the same number of systems per frame as the source page.

PROCEDURE

1. In the music area, select an item on the page whose staff spacing you want to copy.

2. Choose Engrave > Staff Spacing > Copy Staff Spacing to open the Copy Staff Spacing 
dialog.

3. Optional: Change the page whose staff spacing you want to copy by changing the value for 
From page.

By default, the page on which you selected an item is set in the value field.

4. Change the first page to which you want to copy staff spacing by changing the value for To 
page start.

5. Change the last page in the range to which you want to copy staff spacing by changing the 
value for To page end.

6. Click OK to save your changes and close the dialog.

RELATED LINKS
Moving individual staves/systems vertically on page 624

Copy Staff Spacing dialog
The Copy Staff Spacing dialog allows you to choose pages whose individual staff spacing 
changes you want to copy and the pages to which you want to copy them.

● You can open the Copy Staff Spacing dialog in Engrave mode by choosing Engrave > Staff 
Spacing > Copy Staff Spacing.

TIP

You can assign a key command for opening the Copy Staff Spacing dialog on the Key 
Commands page in Preferences.

The Copy Staff Spacing dialog contains the following options:

From page
Allows you to change the page whose staff spacing you want to copy by specifying the 
page number. If you have an item selected when you open the dialog, that page is set 
in the value field automatically.

To page start
Allows you to set the first page in the layout to which staff spacing changes are copied.

To page end
Allows you to set the last page in the layout to which staff spacing changes are copied.
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For example, if you wanted to copy staff spacing changes you made on the first page to the next 
three pages, meaning pages two, three, and four, but not to page five and onwards, you would 
set From page to 1, To page start to 2, and To page end to 4.

Previews show the displayed page number beside each value field, so that if you have changed 
the displayed page number of pages within the layout you can still identify the page to which you 
are copying staff spacing changes.

RELATED LINKS
Key Commands page in the Preferences dialog on page 60

Casting off
“Casting off” is the term used to encompass fixing the layout of pages of music, such as setting 
the number of systems per page.

When calculating how much music can fit in each system and on each page, Dorico Elements 
considers multiple aspects of the layout, including note spacing and vertical spacing settings. You 
can change these settings to change the default casting off in each layout.

In Dorico Elements, you can set fixed numbers of bars per system and systems per music frame 
throughout each layout independently.

You can control the casting off at a more granular level by moving bars to other systems, 
inserting system/frame breaks, making selections into systems/frames, and locking/resetting the 
casting off in the current layout.

RELATED LINKS
Per-layout note spacing options on page 508
Per-layout vertical spacing options on page 621
Inserting system breaks on page 634
Inserting frame breaks on page 637
Allowing/Disallowing breaks within bars on page 633
Moving bars to other systems on page 631
Locking layouts on page 631
Resetting casting off on page 632
Splitting multi-bar rests on page 1281
Hiding/Showing blank staves after final flows on page 608
Margins on page 614

Fixing the number of bars per system
You can define a fixed number of bars you want included in each system in each layout 
independently; for example, if you want four bars per system in a lead sheet.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to fix the number of bars per 
system.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.
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4. In the Casting Off section, activate Fixed number of bars per system.

5. Change the value in the value field.

6. Click Apply, then Close.

RESULT
The number of bars automatically contained in each system in the selected layouts is changed. 
If any of the layouts contain two-bar or four-bar repeat regions, Dorico Elements automatically 
adjusts casting off to ensure phrases are not split across systems.

RELATED LINKS
Bar repeats on page 1245
Inserting system breaks on page 634
Inserting frame breaks on page 637
Making selections into systems on page 635
Changing the horizontal justification of final systems on page 612

Fixing the number of systems per frame
You can define a fixed number of systems you want included in each music frame in each layout 
independently. Because the default page templates have a single music frame per page, fixing 
the number of systems per frame usually fixes the number of systems per page.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to fix the number of systems per 
frame.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Casting Off section, activate Fixed number of systems per frame.

5. Change the value in the value field.

6. Activate/Deactivate Scale number of systems by frame height.

7. Click Apply, then Close.

RESULT
The number of systems automatically contained in each music frame in the selected layouts is 
changed.

If you activated Scale number of systems by frame height, the number of systems contained in 
each frame is adjusted according to the size of the music frame. For example, pages with smaller 
frames, such as the first page, contain fewer systems than your casting off setting.
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Moving bars to other systems
You can move bars to the next or previous system; for example, if you want specific bars to 
appear in the same system.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select an item in the bar you want to move to another system.

For example, select an item in the earliest bar you want to move to the next system, or select 
an item in the last bar you want to move to the previous system.

2. Move bars to another system in one of the following ways:

● To move all bars between the start of the current system and the selection to the 
previous system, press ,  or click Move to Previous System  in the Move Bars 
Between Systems section of the Formatting panel.

● To move all bars between the selection and the end of their current system to the next 
system, press .  or click Move to Next System  in the Move Bars Between Systems 
section of the Formatting panel.

RESULT
The selected bars are moved to the previous or next system. System breaks are inserted at the 
start and end of each new system.

NOTE

● System breaks inserted at the start of systems have Wait for next system break activated 
in the Format group of the Properties panel by default. Because this property tells Dorico 
Elements to include all music in the system until the next system break or the end of the 
flow, if you later delete subsequent system breaks, this can create very full, tightly spaced 
systems.

● You can change how many systems are locked as a consequence of moving bars to other 
systems in Preferences > Note Input and Editing > Note Input > Breaks.

RELATED LINKS
Making selections into frames on page 638
Making selections into systems on page 635
Properties panel on page 663
Preferences dialog on page 58

Locking layouts
You can lock the current casting off throughout individual layouts.

PREREQUISITE

● The left zone is shown.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, open the layout whose casting off you want to lock.
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2. In the Formatting panel, click Lock Layout  in the Lock Layout section.

RESULT
System and frame breaks are inserted at the start of every system as required to lock the current 
casting off in the layout open in the music area.

NOTE

● The system and frame breaks have Wait for next system break and Wait for next frame 
break activated in the Format group of the Properties panel by default. Because this 
property tells Dorico Elements to include all music in the system until the next system break, 
frame break, or the end of the flow, if you later delete subsequent system or frame breaks, 
this can create very full, tightly spaced systems.

● You can assign a key command for Lock Layout on the Key Commands page in 
Preferences.

RELATED LINKS
Engrave toolbox on page 503
Formatting panel on page 504
Hiding/Showing zones on page 44
Switching between layouts on page 43
System breaks on page 633
Frame breaks on page 636
Casting off on page 629
Properties panel on page 663
Key Commands page in the Preferences dialog on page 60

Resetting casting off
You can delete all system and frame breaks in individual layouts and return the layouts to their 
default casting off and spacing settings.

PREREQUISITE

● The left zone is shown.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, open the layout whose casting off you want to reset.

2. In the Formatting panel, click Reset Layout  in the Lock Layout section.

RESULT
All system and frame breaks in the layout open in the music area are deleted. The layout returns 
to following its default casting off and spacing settings.

NOTE

● The system and frame breaks have Wait for next system break and Wait for next frame 
break activated in the Format group of the Properties panel by default. Because this 
property tells Dorico Elements to include all music in the system until the next system break, 
frame break, or the end of the flow, if you later delete subsequent system or frame breaks, 
this can create very full, tightly spaced systems.
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● You can assign a key command for Reset Layout on the Key Commands page in 
Preferences.

Allowing/Disallowing breaks within bars
You can choose whether or not to allow Dorico Elements to insert system/frame breaks within 
bars. For example, you might disallow breaks within bars when formatting lead sheets that only 
require breaks at barlines.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Note Input and Editing.

3. In the Note Input section, activate/deactivate Snap system and frame breaks to barlines 
when creating in the Breaks subsection.

4. Click Apply, then Close.

RESULT
System/Frame breaks are disallowed within bars when the option is activated, and allowed when 
it is deactivated.

When breaks are disallowed within bars, inserted breaks snap to the barline before the earliest 
selected item. When making systems/frames from selections, the first break snaps to the barline 
before the earliest selected item, while the second break snaps to the barline after the last 
selected item.

RELATED LINKS
Preferences dialog on page 58
Frame breaks on page 636
Casting off on page 629

System breaks
System breaks occur when musical material reaches the right page margin and must continue 
on a new system, usually below the previous system on the same page or on a new page. Dorico 
Elements automatically arranges music across systems so that notes are correctly spaced and 
legible, but you can also control system breaks manually.

System breaks that you have inserted manually are indicated by signposts, which you can hide/
show at any time. They are also layout-specific, meaning each layout can have system breaks at 
different rhythmic positions.

System break signpost, selected

NOTE

● By default, system/frame breaks snap to the barline before the earliest selected item. You 
can change whether breaks are allowed at rhythmic positions within bars.
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● System breaks at the start of systems that were created using Make into System have Wait 
for next system break activated in the Format group of the Properties panel by default. 
When this property is activated, Dorico Elements creates a system containing all material 
between that system break and the next system break or the end of the flow, whichever 
comes first.

If you later delete subsequent system breaks, this creates very full, tightly spaced systems. 
For example, if you delete all subsequent system breaks, all music until the end of the flow is 
forced into a single system.

● You can also control the content of systems by fixing the number of bars per system in each 
layout.

RELATED LINKS
Note spacing on page 507
Properties panel on page 663
Fixing the number of bars per system on page 629
Splitting multi-bar rests on page 1281
Signposts on page 450

Inserting system breaks
You can insert system breaks at any rhythmic position; for example, so that musical phrases fit in 
systems for readability.

PREREQUISITE

● You have allowed/disallowed breaks within bars.

● Graphic Editing  is selected in the Engrave toolbox.

● If you want to insert system breaks in the middle of multi-bar rests, you have either hidden 
multi-bar rests in the layout or split multi-bar rests at the required positions.

PROCEDURE

1. In Engrave mode, select a note or item at the rhythmic position you want to appear at the 
start of the next system.

2. Insert a system break in any of the following ways:

● Press Shift-S .

● In the Formatting panel, click Create System Break  in the Format Systems section.

RESULT
A system break is inserted at the rhythmic position of the earliest selected item. If breaks are 
disallowed within bars, it snaps to the preceding barline. All notations after the system break are 
moved to the next system.

NOTE

If you insert a system break in the middle of a phrase in a two-bar or four-bar repeat region, 
Dorico Elements does not automatically move the system break to before/after the phrase, 
causing it to be split across the system break.

RELATED LINKS
Engrave toolbox on page 503
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Formatting panel on page 504
Allowing/Disallowing breaks within bars on page 633
Hiding/Showing multi-bar rests on page 1279
Splitting multi-bar rests on page 1281
Locking layouts on page 631
Hiding/Showing staves from system/frame breaks on page 606
Hiding/Showing staff labels at system/frame breaks on page 1312
Changing the staff size from system/frame breaks on page 618

Making selections into systems
You can force all musical material between two selected rhythmic positions into a single system; 
for example, if you want specific bars to appear in the same system.

PREREQUISITE

● You have allowed/disallowed breaks within bars.

● The left zone is shown.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select an item at the rhythmic position that you want to be the start of the 
system.

NOTE

We recommend that you select noteheads or barlines. Selecting other items, such as slurs, 
can cause system breaks to be inserted earlier/later than you might have intended.

2. Ctrl/Cmd -click one of the following:

● A notehead that you want to be at the end of the system

● An item that you want to be at the start of the next system

3. In the Format Systems section of the Formatting panel, click Make into System .

RESULT
A fixed system is created by inserting system breaks at the start/end of your selection. The 
system contains all musical material between the two selected items.

If breaks are disallowed within bars, the first break snaps to the barline before the earliest 
selected item, while the second break snaps to the barline after the last selected item.

If breaks are allowed within bars, the content of the system depends on your selections.

● If you selected items, such as barlines or slurs, the start of your first selected item is 
positioned at the start of the system, and the end of your last selected item is positioned 
at the start of the next system.

● If you selected noteheads, the last selected notehead is also included in the system, rather 
than being positioned at the start of the next system.

● If you selected ties, all musical material between the first and last notes tie chains is included 
in the system, regardless of where in the tie chains you made selections.

NOTE

The system break inserted at the start of the selection has Wait for next system break activated 
in the Format group of the Properties panel by default. Because this property tells Dorico 
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Elements to include all music in the system until the next system break or the end of the flow, if 
you later delete subsequent system breaks, this can create very full, tightly spaced systems.

Deactivating Wait for next system break allows Dorico Elements to cast off subsequent music 
as normal.

Hiding/Showing system break signposts
You can hide/show system break signposts at any time.

PROCEDURE

● Choose View > Signposts > System Breaks.

RELATED LINKS
Signposts on page 450
Hiding non-printing elements on page 437
Selecting/Deselecting notes and items individually on page 421

Deleting system breaks
You can delete system breaks after you have inserted them.

PREREQUISITE
System break signposts are shown.

PROCEDURE

1. Select the system break signposts of the system breaks you want to delete.

2. Press Backspace or Delete .

RELATED LINKS
Resetting casting off on page 632

Frame breaks
Frame breaks occur when musical material reaches the right page margin at the bottom of a 
frame and must continue on a new system in the next frame in the music frame chain, which 
is usually on the next page. Dorico Elements automatically arranges music in frames so that 
systems are correctly spaced and legible, but you can also control frame breaks manually; for 
example, to insert page turns at specific positions in part layouts.

Frame breaks that you have inserted manually are indicated by signposts, which you can hide/
show at any time. They are also layout-specific, meaning each layout can have frame breaks at 
different rhythmic positions.
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Frame break signpost, selected

NOTE

● By default, system/frame breaks snap to the barline before the earliest selected item. You 
can change whether breaks are allowed at rhythmic positions within bars.

● Frame breaks at the start of frames that were created using Make into Frame have Wait for 
next frame break activated in the Format group of the Properties panel by default. When 
this property is activated, Dorico Elements creates a frame containing all material between 
that frame break and the next frame break.

If you later delete subsequent frame breaks, this creates very full frames with tightly spaced, 
or overlapping, systems. For example, if you delete all subsequent frame breaks, all music 
until the end of the flow is forced into a single frame.

● You can also control the content of music frames by fixing the number of systems per music 
frame in each layout.

RELATED LINKS
Staff spacing on page 620
Frames on page 654
Music frame chains on page 662
Properties panel on page 663
Fixing the number of systems per frame on page 630
Signposts on page 450

Inserting frame breaks
You can insert frame breaks at any rhythmic position; for example, to create page turns at 
appropriate places in the current layout.

PREREQUISITE

● You have allowed/disallowed breaks within bars.

● Graphic Editing  is selected in the Engrave toolbox.

● If you want to insert frame breaks in the middle of multi-bar rests, you have either hidden 
multi-bar rests in the layout or split multi-bar rests at the required positions.

PROCEDURE

1. In Engrave mode, select a note or item at the rhythmic position you want to appear at the 
start of the next frame.

2. Insert a frame break in any of the following ways:

● Press Shift-F .

● In the Formatting panel, click Create Frame Break  in the Format Music Frames 
section.
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RESULT
A frame break is inserted at the rhythmic position of the earliest selected item. If breaks are 
disallowed within bars, it snaps to the preceding barline. All notations after the frame break are 
moved to the next music frame.

NOTE

If you insert a frame break in the middle of a phrase in a two-bar or four-bar repeat region, 
Dorico Elements does not automatically move the frame break to before/after the phrase, 
causing it to be split across the frame break.

RELATED LINKS
Engrave toolbox on page 503
Formatting panel on page 504
Allowing/Disallowing breaks within bars on page 633
Hiding/Showing multi-bar rests on page 1279
Splitting multi-bar rests on page 1281
Locking layouts on page 631
Hiding/Showing staves from system/frame breaks on page 606
Hiding/Showing staff labels at system/frame breaks on page 1312
Changing the staff size from system/frame breaks on page 618

Making selections into frames
You can force all musical material between two selected rhythmic positions into a single frame; 
for example, if you want specific bars to appear on the same page.

PREREQUISITE

● You have allowed/disallowed breaks within bars.

● The left zone is shown.

●

PROCEDURE

1. In Engrave mode, select an item at the rhythmic position that you want to be the start of the 
frame.

NOTE

We recommend that you select noteheads or barlines. Selecting other items, such as slurs, 
can cause frame breaks to be inserted earlier/later than you might have intended.

2. Ctrl/Cmd -click one of the following:

● A notehead that you want to be at the end of the frame

● An item that you want to be at the start of the next frame

3. In the Format Music Frames section of the Formatting panel, click Make into Frame .

RESULT
A fixed frame is created by inserting frame breaks at the start/end of your selection. The frame 
contains all musical material between the two selected items.

If breaks are disallowed within bars, the first break snaps to the barline before the earliest 
selected item, while the second break snaps to the barline after the last selected item.
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If breaks are allowed within bars, the content of the frame depends on your selections.

● If you selected items, such as barlines or slurs, the beginning your first selected item is 
positioned at the start of the frame, and the end of your last selected item is positioned at 
the start of the next frame.

● If you selected noteheads, the last selected notehead is also included in the frame, rather 
than being positioned at the start of the next frame.

● If you selected ties, all musical material between the first and last notes tie chains is included 
in the frame, regardless of where in the tie chains you made selections.

NOTE

The frame break inserted at the start of the selection has Wait for next frame break activated in 
the Format group of the Properties panel by default. Because this property tells Dorico Elements 
to include all music in the frame until the next frame break, if you later delete subsequent frame 
breaks, this can create very full frames with tightly spaced, or overlapping, systems.

Deactivating Wait for next frame break allows Dorico Elements to cast off subsequent music as 
normal.

Hiding/Showing frame break signposts
You can hide/show frame break signposts at any time.

PROCEDURE

● Choose View > Signposts > Frame Breaks.

RELATED LINKS
Signposts on page 450
Hiding non-printing elements on page 437
Selecting/Deselecting notes and items individually on page 421

Deleting frame breaks
You can delete frame breaks after you have inserted them.

PREREQUISITE
Frame break signposts are shown.

PROCEDURE

1. Select the frame break signposts of the frame breaks you want to delete.

2. Press Backspace or Delete .

RELATED LINKS
Resetting casting off on page 632
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Tacets
Tacet is the indication used to show that a player does not play anything in an entire flow, which 
might be a movement in a symphony or cue in a film score. In Dorico Elements, you can generate 
tacets automatically.

Dorico Elements shows tacets for flows in part layouts when the following conditions are met:

● You have removed the player from the flows in which they do not play.

● The flows are assigned to the part layout.

● The flows are assigned to the page template frame chain in the part layout.

● You have chosen to show tacets in the part layout.

An extract of a part layout where the player is tacet in the second flow

In Engrave mode, tacets behave like systems, meaning they have their own staff spacing handle 
when Staff Spacing  is activated. This allows you to move individual tacets and their flow 
headings upwards/downwards. You can also insert system and frame breaks at the start of 
tacets.

NOTE

We do not recommend that you use Copy Staff Spacing and Lock Frame  on pages where 
tacets are the first or last system in frames. Because tacets do not contain any bars, Dorico 
Elements cannot insert system or frame breaks at the ends of tacets in order to lock the frame 
contents.

You can change the text shown in tacets and the margin above/below them in each layout 
independently.

You can further customize the project-wide appearance and design of tacets by editing the Tacet 
paragraph style in the Paragraph Styles dialog.

RELATED LINKS
Assigning players to flows on page 172
Allowing/Disallowing multiple flows on the same page on page 609
Staff spacing on page 620
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System breaks on page 633
Frame breaks on page 636
Flow headings on page 651
Paragraph Styles dialog on page 756

Hiding/Showing tacets
You can hide/show tacets in each layout independently; for example, if you want to show empty 
bars or multi-bar rests in some layouts to allow those players to add in notes on those staves 
later.

PREREQUISITE

● You have removed the player from the flows in which they do not play.

● The flows are assigned to the part layout.

● The flows are assigned to the page template frame chain in the part layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show tacets.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Tacets section, activate/deactivate Show tacet for flows where no players are 
assigned.

5. Click Apply, then Close.

RESULT
Tacets are shown in the selected layouts when Show tacet for flows where no players are 
assigned is activated and the prerequisite criteria are also met.

When it is deactivated, any flows to which the player is not assigned do not appear in the layout. 
When the player is assigned to those flows, all bars in the flow are shown in the part, split into 
empty bars and multi-bar rests as appropriate for the flow.

RELATED LINKS
Multi-bar rests on page 1279
Assigning players to flows on page 172
Hiding/Showing multi-bar rests on page 1279

Editing tacet text
You can change the text shown in tacets in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose tacet text you want to edit.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
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and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Tacets section, enter the text you want in the Tacet text field.

5. Click Apply, then Close.

RESULT
The text shown in all tacets in the selected layouts is changed.

Changing the margins above/below tacets
You can change the margins both above/below tacets in each layout independently; for example, 
if you want smaller gaps between flow headings and tacets in some layouts to facilitate page 
turns better.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the margins above/below 
tacets.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Tacets section, change the values for the following options, individually or together:

● Margin above tacet

● Margin below tacet

5. Click Apply, then Close.

RESULT
Changing the value for Margin above tacet increases/decreases the minimum gap between 
tacets and whatever precedes them.

Changing the value for Margin below tacet increases/decreases the minimum gap between 
tacets and whatever follows them.

RELATED LINKS
Flow headings on page 651
Paragraph Styles dialog on page 756
Margins on page 614
Per-layout vertical spacing options on page 621
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Condensing
Condensing is the process of showing the music for multiple players on fewer staves than 
normal, usually by allowing multiple instruments of the same type to share a staff, such as Flutes 
1-2 or Horns 1-4.

In Dorico Elements, you cannot enable automatic condensing as it is only available in Dorico Pro. 
However, if you import or open a project that contains layouts with condensing enabled, those 
staves remain condensed.

NOTE

● You cannot select anything on condensed staves.

● Condensing is never enabled in galley view, so you can switch to galley view to see all staves 
separately. This does not disable condensing in the current layout.

● Having condensing enabled in any layout in a project can cause Dorico Elements to operate 
more slowly, due to the large number of calculations involved.

RELATED LINKS
Staff labels on condensed staves on page 1320
Switching to galley/page view on page 50
Divisi on page 1329

Part formatting propagation
The propagation of part formatting involves copying the layout options and system formatting 
that determine the layouts of pages in specific part layouts and applying them to other part 
layouts. This can save time when formatting similar parts.

System formatting includes the positions of system and frame breaks, but also note spacing 
changes that affect the horizontal space that notes require.

In Dorico Elements, you can copy layout options and system formatting both together and 
independently of each other from a selected source layout to other destination layouts. For 
example, for source layouts whose formatting relies primarily on their Casting Off settings in 
Layout Options, it is likely that copying only their layout options is sufficient to produce the 
required formatting in the destination layouts without adding system/frame breaks on every 
system.

You can also copy the layout-specific property settings from the layout currently open in the 
music area to all other layouts in which those items appear.

NOTE

● Part formatting propagation is only available for part layouts. You cannot propagate part 
formatting from/to full score or custom score layouts.

● We do not recommend using layouts with multiple music frame chains as either source or 
destination layouts as you can get unexpected results.

Copying part formatting to other layouts
You can copy all the formatting from one part layout to other part layouts; for example, to save 
time if multiple part layouts in your project require similar formatting. You can include layout 
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options, such as page size and margins, and other page formatting, such as system and frame 
breaks.

NOTE

● Part formatting propagation is only available for part layouts. You cannot propagate part 
formatting from/to full score or custom score layouts.

● We do not recommend using layouts with multiple music frame chains as either source or 
destination layouts as you can get unexpected results.

PROCEDURE

1. In Setup mode, in the Layouts panel, select the part layout whose part formatting you want 
to copy.

2. In the action bar, click Layout Settings  and choose Propagate Part Formatting to open 
the Propagate Part Formatting dialog.

TIP

You can also right-click layouts and choose this option from the context menu.

3. In the Copy formatting from list, select the part layout whose part formatting you want to 
copy.

By default, the layout whose card you used to open the dialog is selected.

4. In the Propagate formatting to list, select the part layouts to which you want to copy part 
formatting.

You can use the selection options in the action bar, click and drag across multiple layouts, 
Shift -click adjacent layouts, and Ctrl/Cmd -click individual layouts.

5. Activate/Deactivate Include layout options.

6. Activate/Deactivate Include system formatting.

7. Click OK to copy part formatting to the selected layouts and close the dialog.

RESULT
Part formatting from the selected source layout is copied to the selected destination layouts.

● If you activated Include layout options, layout options are copied from the source layout to 
the destination layouts.

● If you activated Include system formatting, Dorico Elements copies the distribution of bars 
in systems, systems on pages, and note spacing changes from the source layout to the 
destination layouts.

TIP

● If the formatting of the source layout relies primarily on its Casting Off settings in Layout 
Options, it is likely that only activating Include layout options is sufficient to produce very 
similar formatting in the destination layouts without adding system/frame breaks on every 
system.

● You can assign a key command for Propagate Part Formatting on the Key Commands 
page in Preferences. You can use this key command in any mode.
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Propagate Part Formatting dialog
The Propagate Part Formatting dialog allows you to copy the page formatting and layout 
options from a source layout to destination layouts.

You can open the Propagate Part Formatting dialog in Setup mode in any of the following 
ways:

● In the Layouts panel, select a part layout, then click Layout Settings  in the action bar 
and choose Propagate Part Formatting. This automatically selects that layout as the source 
layout in the Copy formatting from list.

TIP

You can also right-click layouts and choose this option from the context menu.

● Choose Setup > Propagate Part Formatting.

The Propagate Part Formatting dialog contains the following sections and options:

1 Copy formatting from

Contains a list of all the part layouts in the project. You can only select a single part layout as 
the source layout.

2 Propagate formatting to

Contains a list of all the part layouts in the project. You can select multiple part layouts as 
destination layouts.

3 Selection options

Allow you to select/deselect all the part layouts in the Propagate formatting to list.

4 Include layout options

Allows you to copy layout options relating to part formatting from the source layout to 
the destination layouts. These options include page size, page margins, the default page 

Page formatting
Part formatting propagation 

645
Dorico Elements 5.1.30



template set, space size, vertical spacing, note spacing, casting off, multi-bar rest settings, 
and staff labels.

5 Include system formatting

Allows you to copy the distribution of bars in systems, systems on pages, and note spacing 
changes from the source layout to the destination layouts. Dorico Elements achieves this by 
copying system breaks, frame breaks, and note spacing changes, inputting additional system 
and frame breaks as required, and deleting any existing system breaks, frame breaks, and 
note spacing changes in the destination layouts.

RELATED LINKS
Layout Options dialog on page 745
Layouts panel (Setup mode) on page 117

Copying property settings to other layouts/frame chains
Local properties are layout- and frame chain-specific, meaning that by default, changing local 
properties for an item in one layout does not affect the same item in other layouts or other 
frame chains. You can copy the properties set on notes and items to all other layouts and frame 
chains in which they appear; for example, to show gradual dynamics with the same style in part 
layouts after changing their style in the full score layout.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes or items whose properties you want to copy to other layouts. You can do 
this in Write mode and Engrave mode.

NOTE

Only the properties that are available in the current mode are copied.

2. Choose Edit > Propagate Properties.

RESULT
All properties set on the selected notes/items that are available in the current mode are copied 
to all layouts and frame chains in which those notes/items appear. For example, if you selected 
slurs in Write mode, their staff-relative placement and design settings are copied. If you selected 
them in Engrave mode, their slur end and control point positions are also copied.

TIP

If you know in advance that you want your changes to affect all layouts and frame chains, you 
can change the property scope before changing property settings.

RELATED LINKS
Engrave toolbox on page 503
Large selections on page 424
Local vs. global properties on page 664
Resetting the appearance of items on page 436
Resetting the position of items on page 436
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Page templates
Page templates in Dorico Elements allow you to achieve consistent page formatting by applying 
the same arrangements of frames to multiple pages and in different layouts.

NOTE

You can set the page size, margins, page orientation, and staff size for each layout in Layout 
Options.

All pages in your scores and parts inherit their default formatting from page templates.

Dorico Elements provides different types of page templates so that there is appropriate page 
formatting for first pages independently of subsequent pages, as the first page typically includes 
additional information, such as the title, composer, and copyright. Dorico Elements uses tokens 
to display this additional information.

Page templates are contained in page template sets. By default, Dorico Elements provides 
separate page template sets for full score and part layouts. Page template sets are automatically 
applied to every layout that you create.

NOTE

● In Dorico Elements, you cannot edit page templates or create new ones; this is only available 
in Dorico Pro.

● Changing individual pages in layouts is considered a page template override in Dorico 
Elements. This includes, for example, editing the title or running header in Write mode. 
Pages with page template overrides are not automatically deleted, even if they are empty 
because the layout became shorter.

If you want to change the information shown at the tops of pages, that is, the title and 
running header text that you cannot select, we recommend that you do so in the Project 
Info dialog to avoid page template overrides.

RELATED LINKS
Types of page templates on page 648
Removing page template overrides on page 651
Layout Options dialog on page 745
Flow headings on page 651
Project Info dialog on page 75
Tokens on page 655
Applying page template sets to layouts on page 601
Page formatting on page 598
Project templates on page 77

Page template sets
In Dorico Elements, page templates are provided as parts of page template sets. Page template 
sets group page templates and flow headings together, so there is suitable page formatting 
available for all possible situations in your project.

New projects contain the following page template sets by default:

● Default Full Score: Used for full score and custom score layouts by default.

● Default Part: Used for part layouts by default.
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The default page template sets contain page templates for first (First) and subsequent (Default) 
pages.

Page template sets also contain flow headings that allow you to show flow titles above the start 
of each flow automatically, including when they start on the same page as a previous flow. The 
default page template sets each contain a single flow heading.

The default page template sets are applied automatically to the appropriate layouts in each new 
project. You can apply different page template sets to each layout independently.

NOTE

In Dorico Elements, you cannot edit page template sets or create new ones; this is only available 
in Dorico Pro.

RELATED LINKS
Flow headings on page 651
Applying page template sets to layouts on page 601

Types of page templates
Page template sets contain different types of page templates, which are used in different 
circumstances. For example, First page templates are usually used for the first page of music 
in a layout.

In Dorico Elements, there are the following types of page templates:

First

A page template that is usually used for the first page of music in a layout. It contains a single 
large music frame and multiple text frames to display information, such as the project title and 
composer.
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First page template open in the page template editor

The First page template contains the following tokens in text frames:

1 Layout name (Default Part page template set only)

2 Project title

3 Project lyricist

4 Project composer

5 Project copyright

TIP

You can edit the formatting of the paragraph styles used for tokens on page templates in the 
Paragraph Styles dialog. For example, layout names on First page templates use the Layout 
name paragraph style by default.

Default

A page template that is usually used for the second page of music onwards. It contains a single 
large music frame and text frames to show the running header and page number.
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Default page template open in the page template editor

The Default page template contains the following tokens in text frames:

1 Page number

2 Default Full Score page template set: Flow title (optionally Project title for projects created 
from the Hub with Project will use multiple flows deactivated)

Default Part page template set: Layout name

TIP

You can edit the formatting of the paragraph styles used for tokens on page templates in the 
Paragraph Styles dialog. For example, flow titles and layout names on Default page templates 
use the Header paragraph style by default.

RELATED LINKS
Project Info dialog on page 75
Tokens on page 655
Page template sets on page 647
Changing when the First page template is used on page 610
Paragraph Styles dialog on page 756
Hiding/Showing borders on layout names on page 1001
Changing flow titles on page 188
Flow headings on page 651
Hub on page 69
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Removing page template overrides
You can remove overrides that you have made to individual pages and return them to following 
the page template format.

Page template overrides include editing the title or running header on individual pages, rather 
than by changing the contents of fields in the Project Info dialog.

Removing overrides from empty pages deletes them from the layout.

PROCEDURE

1. In Engrave mode, open the layout whose page template overrides you want to remove.

2. Optional: If you want to remove overrides from individual pages, select items on those 
pages.

3. Remove page template overrides in one of the following ways:

● To remove overrides from selected pages only, choose Engrave > Remove Page 
Override(s).

● To remove overrides from all pages, choose Engrave > Remove All Page Overrides.

RESULT
Any overrides you made to the page template format are removed from either the selected 
pages only or from all pages in the layout currently open in the music area. Empty pages that are 
considered overrides are deleted.

If you removed overrides from selected pages only, any other pages with overrides in the layout 
are unaffected.

RELATED LINKS
Hiding/Showing zones on page 44
Switching between layouts on page 43
Frames on page 654
Project Info dialog on page 75
Customizing flow headings on page 652

Flow headings
Flow headings allow you to show the titles of flows immediately above their first system 
automatically. They function like templates, in much the same way as page templates, allowing 
the same flow heading formatting to be applied to multiple flows in different layouts.

Flow headings exist as part of page template sets. By default, Dorico Elements provides one flow 
heading in each page template set, which contains tokens to display the flow number and flow 
title; in a new project, this appears as “1. Flow 1”. This is used automatically for all flow headings.

By default, flow headings use the Flow Title paragraph style, which you can edit in the 
Paragraph Styles dialog.

You can change the tokens included in flow headings; for example, if you want to remove flow 
numbers and only show flow titles.
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A flow heading above the third flow in a part layout

Any changes you make in the Edit Flow Heading dialog are automatically reflected on the pages 
that use those flow headings. For example, if you delete a token, that token is removed from all 
flow headings in all layouts that use the same page template set, so long as the pages on which 
the flow headings appear do not have page template overrides.

Flow headings are automatically inserted inside music frames above the first system of the flow 
to which they apply, meaning they do not have a fixed vertical position on the page like other 
frames and follow the music if it moves. They also occupy vertical space within music frames. You 
can change the margins for the space above and below flow headings.

NOTE

Changing individual flow headings in layouts is considered a page template override in Dorico 
Elements. This includes, for example, deleting a token from a flow heading on one page, rather 
than in the Edit Flow Heading dialog. Pages with page template overrides no longer get 
updated if you edit the flow heading and are not automatically deleted, even if they are empty 
because the layout became shorter.

RELATED LINKS
Tacets on page 640
Hiding/Showing flow headings on page 611
Changing the margins above/below flow headings on page 615
Hiding/Showing information above flow headings on page 611
Removing page template overrides on page 651
Margins on page 614
Frames on page 654
Tokens on page 655
Paragraph Styles dialog on page 756
Adding titles on page 997

Customizing flow headings
You can change the tokens included in flow headings; for example, if you want to remove flow 
numbers and only show flow titles. This affects all flow headings in all layouts that use the same 
page template set; for example, customizing the flow heading in a part layout updates flow 
headings in all other part layouts.

PROCEDURE

1. In Engrave mode, open a layout that uses the page template set containing the flow heading 
you want to customize.

2. Choose Engrave > Edit Flow Heading to open the Edit Flow Heading dialog.

3. Change the tokens included in the flow heading.

4. Click OK to save your changes and close the dialog.
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RELATED LINKS
Switching between layouts on page 43
Page template sets on page 647
Applying page template sets to layouts on page 601
Removing page template overrides on page 651
Paragraph Styles dialog on page 756
Project Info dialog on page 75
Tokens on page 655

Edit Flow Heading dialog
The Edit Flow Heading dialog allows you to change the tokens included in flow headings; for 
example, if you want to remove flow numbers and only show flow titles. This affects all flow 
headings in all layouts that use the same page template set.

● You can open the Edit Flow Heading dialog in Engrave mode by choosing Engrave > Edit 
Flow Heading.

The Edit Flow Heading dialog contains the following options:

Flow heading tokens
Displays the tokens included in the flow heading. You can enter text directly into this 
field, and click tokens to add them automatically.

Reset to Default
Resets the tokens in the flow heading.

Insert token
Allows you to add tokens to the flow heading.

RELATED LINKS
Engrave mode on page 502
Removing page template overrides on page 651
Project Info dialog on page 75
Tokens on page 655
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Export File Names dialog on page 588

Frames
Dorico uses boxes called frames to position music, additional text, and graphics inside the 
margins of pages. In Dorico Elements, you cannot input or edit frames, but frames on page 
templates control the formatting of pages in your project.

In Dorico Elements, there are the following types of frames:

Music frames
Music frames display the music of selected players and flows or blank staves.

A music frame displaying the start of a piano piece

Text frames
Text frames display text, which you can enter directly or by using tokens.

A text frame displaying a project title, "Sechs Lieder"

Graphics frames
Graphics frames display the images that you load into them, which can be in a variety 
of formats.

A graphics frame with image loaded
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EXAMPLE

The first page of a piano piece. It contains a music frame, text frames for the title, dedication, and composer, 
a flow heading frame inside the top of the music frame, and graphics frames in the top corners.

RELATED LINKS
Project window in Engrave mode on page 502
Flows in Dorico on page 20
Layouts in Dorico on page 24
Frame breaks on page 636
Tokens on page 655
Page templates on page 647
Flow headings on page 651
Changing page margins on page 601

Tokens
Tokens are codes that you can use as substitutes for information stored in your project, such 
as titles, composers, and the time and date. This can reduce the risk of mistakes or outdated 
information appearing in your project. Tokens are also known as “wildcards” or “text codes”.

For example, if you use a token for the title of your project, you can change the project title in the 
Project Info dialog as often as you want, and the project title in every layout in your project is 
updated automatically.

Tokens can refer to information in the Project Info dialog, including for the whole project or 
each flow individually. Tokens can also refer to the current time and date or the time and date 
the project was last saved.

NOTE

● You can only use tokens in text frames. You cannot use tokens in text items. Full text frame 
functionality is only available in Dorico Pro, but we have included the available tokens for 
your reference.

● Flow tokens refer to the nearest flow below the top edge of their text frame and on the same 
page. When the top edge of a text frame containing a flow token is in line with or above the 
top staff line of the first staff in a system, it then refers to that flow.
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You can specify the flow number to which you want flow tokens to refer, such as 
{@flow2title@}. This always shows the specified flow, regardless of the token’s position.

You can see the flow number of each flow in the Flows panel in Setup mode.

● You can access all the available tokens from the context menu when the cursor is inside a 
text frame. In the context menu, tokens are organized into submenus.

The following tokens are available in Dorico Elements:

General tokens

Description Token

Project file name {@projectfilename@}

Path to the project’s save location, including 
the project file name

{@projectfilepath@}

Total duration of the project in minutes and 
seconds, using smart quotes

{@projectDuration@}

Total duration of the project in minutes and 
seconds, using straight quotes

{@projectDurationStraightQuotes@}

Total duration of the project in minutes and 
seconds, using primes

{@projectDurationPrimes@}

Player tokens

Description Token

Player list {@playerlist@}

Player names {@playernames@}

Layout tokens

Description Token

Layout name {@layoutname@}

Layout number, as set in the Layouts panel in 
Setup mode

{@layoutnumber@}
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Description Token

Layout transposition

NOTE

Uses your instrument language setting.

{@layouttransposition@}

Staff label tokens

Staff label Token

Full staff labels of the players in the current 
layout

{@staffLabelsFull@}

Abbreviated staff labels of the players in the 
current layout

{@staffLabelsShort@}

NOTE

● You can use staff label tokens as an alternative way to name part layouts, instead of using 
the default {@layoutName@} token shown at the top left of the first page in part layouts.

● Staff label tokens might not exactly match the appearance of staff labels shown before initial 
barlines; however, staff label tokens respect your per-layout options for how transpositions 
appear in staff labels.

Music symbol tokens

Music symbol Token

Flat accidental: ♭ {@flat@}

Sharp accidental: ♯ {@sharp@}

Natural accidental: ♮ {@natural@}

Treble clef (G clef) {@gClef@}

Bass clef (F clef) {@fClef@}

Alto clef (C clef) {@cClef@}

Fermata above {@U+E4C0@}

TIP

● This list is not comprehensive, as you can enter the code point for any SMuFL symbol within 
a token. You can find the necessary code points in the SMuFL specification online.

Page formatting
Frames 

657
Dorico Elements 5.1.30



● Music symbol tokens in text frames automatically use the Music text character style, which 
is set to Bravura Text by default.

● You can include music symbol tokens in fields in the Project Info dialog. For example, if you 
enter Symphony in B{@flat@} major into the Title field, the title displayed in text frames 
using the corresponding title token is Symphony in B♭ major.

● You can also enter music symbols in text items and text frames using the Insert Music Text 
dialog.

Project/Flow information tokens

Field in the Project Info 
dialog

Token for Project page Token for Flow pages

Title {@projecttitle@} {@flowtitle@}

Subtitle {@projectsubtitle@} {@flowsubtitle@}

Dedication {@projectdedication@} {@flowdedication@}

Composer {@projectcomposer@} {@flowcomposer@}

Arranger {@projectarranger@} {@flowarranger@}

Lyricist {@projectlyricist@} {@flowlyricist@}

Artist {@projectartist@} {@flowartist@}

Copyist {@projectcopyist@} {@flowcopyist@}

Publisher {@projectpublisher@} {@flowpublisher@}

Editor {@projecteditor@} {@floweditor@}

Copyright {@projectcopyright@} {@flowcopyright@}

Work number {@projectworknumber@} {@flowworknumber@}

Composer dates {@projectcomposerdates@} {@flowcomposerdates@}

Composition year {@projectcompositionyear@} {@flowcompositionyear@}

Other information {@projectotherinfo@} {@flowotherinfo@}
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Flow tokens

Per-flow token function Token

Flow number of the current flow, according to its 
position in the project

{@flownumber@}

Flow number of the current flow, according to its 
position in the current layout

{@flowInLayoutNumber@}

Flow number of the current flow shown in lower case 
Roman numerals, such as iii or xvi

{@flowNumberRomanLower@}

Flow number of the current flow shown in upper case 
Roman numerals, such as III or XVI

{@flowNumberRomanUpper@}

Duration of the current flow in minutes and seconds, 
using smart quotes

{@flowDuration@}

Duration of the current flow in minutes and seconds, 
using straight quotes

{@flowDurationStraightQuotes@}

Duration of the current flow in minutes and seconds, 
using primes

{@flowDurationPrimes@}

Duration of the specified flow “n” in minutes and 
seconds, such as {@flow3Duration@}

{@flownDuration@}, 
{@flownDurationStraightQuotes@}
, or {@flownDurationPrimes@}

Page number tokens

Page number token function Token

Page number {@page@}

Total number of pages in the layout {@pageCount@}

Number of this page within the current flow, counting 
from 1 for the first page of the flow and including pages 
with no displayed page number

{@flowPage@}

Total number of pages in the current flow {@flowPageCount@}

The displayed page number on which the specified flow 
“n” begins, such as {@flow3FirstPage@}

{@flownFirstPage@}
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NOTE

{@flowPage@} and {@flowPageCount@} tokens only consider the flow that is active at the 
beginning of the first system of the music frame closest to the top left corner of the page on 
which the tokens are used.

Time/Date tokens: project last saved

Time/Date description Time/Date example Token

Standard date and time string 
(locale dependent)

Sun Dec 31 11:10:12 2017 {@projectdate@}

Four-digit year 2017 {@projectdateyear@}

Two-digit year 17 {@projectdateyearshort@}

Full month name (locale 
dependent)

October {@projectdatemonth@}

Short month name (locale 
dependent)

Oct {@projectdatemonthshort@}

Month as a decimal number, 
range 1-12

10 {@projectdatemonthnum@}

Full weekday name (locale 
dependent)

Friday {@projectdateday@}

Abbreviated weekday name 
(locale dependent)

Fri {@projectdatedayshort@}

Day of month as decimal 
number, range 1-31

24 {@projectdatedaynum@}

ISO 8601 date 2017-12-31 {@projectdateymd@}

Month day, year December 31, 2017 {@projectdatemdy@}

Day month year 31 December 2017 {@projectdatedmy@}

Time representation (locale 
dependent)

11:10:12 {@projectdatetime@}

Hours:minutes, hour in 24-
hour clock range

23:10 {@projectdatetimeHHMM@}

Hours:minutes:seconds, hour 
in 24-hour clock range

13:02:24 {@projectdatetimeHHMMSS@}
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Time/Date description Time/Date example Token

Hour in 24-hour clock range 23 {@projectdatetimehour24@}

Hour in 12-hour clock range 11 {@projectdatetimehour12@}

Minute as decimal number, 
range 00-59

10 {@projectdatetimeminute@}

Second as decimal number, 
range 00-59

44 {@projectdatetimesecond@}

Time/Date tokens: current time and date

Time/Date description Time/Date example Token

Standard date and time string 
(locale dependent)

Sun Dec 31 11:10:12 2017 {@date@}

Four-digit year 2017 {@dateyear@}

Two-digit year 17 {@dateyearshort@}

Full month name (locale 
dependent)

October {@datemonth@}

Short month name (locale 
dependent)

Oct {@datemonthshort@}

Month as a decimal number, 
range 1-12

10 {@datemonthnum@}

Full weekday name (locale 
dependent)

Friday {@dateday@}

Abbreviated weekday name 
(locale dependent)

Fri {@datedayshort@}

Day of month as decimal 
number, range 1-31

24 {@datedaynum@}

ISO 8601 date 2017-12-31 {@dateymd@}

Month day, year December 31, 2017 {@datemdy@}

Day month year 31 December 2017 {@datedmy@}

Time representation (locale 
dependent)

11:10:12 {@datetime@}
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Time/Date description Time/Date example Token

Hours:minutes, hour in 24-
hour clock range

23:10 {@datetimeHHMM@}

Hours:minutes:seconds, hour 
in 24-hour clock range

13:02:24 {@datetimeHHMMSS@}

Hour in 24-hour clock range 23 {@datetimehour24@}

Hour in 12-hour clock range 11 {@datetimehour12@}

Minute as decimal number, 
range 00-59

10 {@datetimeminute@}

Second as decimal number, 
range 00-59

44 {@datetimesecond@}

RELATED LINKS
Project Info dialog on page 75
Player, layout, and instrument names on page 181
Flow names and flow titles on page 187
Insert Music Text dialog on page 391
Renumbering layouts on page 180
Reordering flows on page 173
Instrument transpositions in staff labels on page 1314
Changing the language for instrument names on page 57
Concert vs. transposed pitch on page 178
Editing layout transposition text on page 1000
Exporting text on page 102
Paragraph Styles dialog on page 756

Music frame chains
A music frame chain is a collection of music frames that show the same selection of music in a 
set order, often in sequence. Music frame chains can include any number of frames, including 
only a single music frame.

The default page templates contain a single frame chain that is set to display all flows and 
all players in the layout. Therefore, Dorico Elements automatically creates enough pages and 
frames to display all flows in all the layouts that use those page templates.

NOTE

In Dorico Elements, you cannot create new frame chains or change the flows and players 
assigned to frame chains; this is only available in Dorico Pro.

RELATED LINKS
Page templates on page 647
Layouts in Dorico on page 24
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Properties

Properties are settings that apply to individual notes and items and allow you to edit them, such 
as by changing their appearance or position. You can access properties in the Properties panel.

Properties can affect items only in the current layout and frame chain, known as “local 
properties”, or in all layouts and frame chains, known as “global properties”.

Many properties also have equivalent default settings available that control the appearance 
or position of all instances of the corresponding type of note or notation. You can access the 
available default settings in Notation Options.

RELATED LINKS
Notation Options dialog on page 747

Properties panel
The Properties panel provides options that allow you to edit individual notes and notations, such 
as by changing their appearance or position. It is located in the lower zone at the bottom of the 
window in Write mode and Engrave mode.

● You can show the Properties panel by showing the lower zone, then clicking Properties  in 
the lower zone toolbar.

The Properties panel contains a group of properties for each notation item. When you select a 
note or item in the music area, the Properties panel displays the groups and options that you 
might require to edit the selected note or item. If there are more available groups than can fit in 
the panel simultaneously, you can scroll to the right/left along the displayed groups.

All the properties that are available in the Properties panel in Write mode are also available in 
Engrave mode, but additional properties in Engrave mode allow you to edit items in more detail.

NOTE

● If you select multiple different types of notation items, only the groups that they have in 
common are displayed. For example, if you select a slur, the Common and Slurs groups are 
displayed in the Properties panel. However, if you select a slur and a note, only the Common 
group is displayed.

● If the property scope is set to Locally, changing local properties only affects the current 
layout and frame chain. You can set the property scope to Globally if you want subsequent 
changes to local properties to affect all layouts and frame chains. You can also copy property 
changes to other layouts and frame chains later.

● In Write mode, you can only change the properties of complete notes and items. For 
example, you can only change the line style of whole pedal lines, even if they extend across 
multiple systems. In Engrave mode, you can change individual parts of notes and items 
separately; for example, the curvature direction of a single tie within a tie chain.

● You can activate properties by clicking their activation switch or property name.
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Properties panel in Write mode, filtered by a search term

The Properties panel toolbar contains the following options:

Search
Allows you to filter properties according to your entry.

Show (active status)
Allows you to filter properties according to their activated status.

● Active: Shows only activated properties.

● All: Shows all properties.

Show (property scope)
Allows you to filter properties according to their property scope.

● Local Only: Shows only local properties.

● Global Only: Shows only global properties.

● All: Shows all properties.

Set local properties
Allows you to change the scope of subsequent local properties you change.

● Locally: Local properties only take effect locally.

● Globally: Local properties take effect globally.

RELATED LINKS
Hiding/Showing zones on page 44
Copying property settings to other layouts/frame chains on page 646
Changing your preferred unit of measurement on page 51
Selecting handles on items on page 516
Resetting the appearance of items on page 436
Resetting the position of items on page 436

Local vs. global properties
Properties can affect items either in the current layout and frame chain only or in all layouts and 
frame chains. This allows you to have the same items appear differently in different layouts, such 
as if you want to show gradual dynamics as hairpins in part layouts but as “cresc.” text in full 
score layouts.

Local properties
Local properties are layout- and frame chain-specific. By default, changing local 
properties for an item in one layout does not affect the same item in other layouts 
or other frame chains. This is particularly useful for local properties that control the 
graphical position of items, as usually this needs to be different in the part layout 
compared to the full score.
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You can force local properties to apply globally by changing the property scope in 
the Properties panel to Globally before changing their setting. Local properties that 
have been set globally appear with a bolder font in the Properties panel than local 
properties that have been set locally. You can also show only local properties in the 
Properties panel by using the property scope filter.

NOTE

Changing local properties with the property scope set to Globally overrides any local 
settings for those properties for the selected notes or items in other layouts.

Global properties
Global properties affect items in all layouts and frame chains, including new layouts 
you subsequently create. They appear with a bolder font in the Properties panel than 
local properties. You can also show only global properties in the Properties panel by 
using the property scope filter.

RELATED LINKS
Layouts on page 174
Music frame chains on page 662
Copying property settings to other layouts/frame chains on page 646

Changing the property scope
You can change the property scope of local properties; for example, if you want the subsequent 
properties you change to affect all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

PROCEDURE

● In the Properties panel, choose one of the following options for Set local properties:

● Locally

● Globally

RESULT
The property scope is changed. All subsequent local properties you change take effect only in 
the current layout and frame chain if you chose Locally, or in all layouts and frame chains if you 
chose Globally.

NOTE

● The property scope includes local properties that control the graphical position of items. 
Because it is common for items to require different graphical positions in different layouts, 
we recommend that you change the property scope to Globally only when required.

● This only applies to subsequent properties you change. If you want to change the property 
scope of existing properties, you can copy property settings to other layouts and frame 
chains.

● You can change the default property scope for all future projects on the Note Input and 
Editing page in Preferences.

Properties
Changing the property scope 

665
Dorico Elements 5.1.30



RELATED LINKS
Copying property settings to other layouts/frame chains on page 646
Preferences dialog on page 58

Changing values in numeric value fields
You can change the values in numeric value fields in multiple different ways, such as doubling 
or halving the existing values. In Dorico Elements, value fields are most commonly used in the 
Properties panel and in options dialogs.

Numeric value fields have up/down buttons. They are also known as “spin boxes”.

A numeric value field in the Properties panel

PREREQUISITE
For value fields that are only accessible when their corresponding property/option is activated, 
you have activated their property/option.

PROCEDURE

● Change the value in numeric value fields in any of the following ways:

● Enter a number directly.

● To increase/decrease the value by 1/8 space, click the up/down buttons.

● To increase/decrease the value by 1/32 space, Ctrl/Cmd - Shift -click the up/down 
buttons.

● To increase/decrease the value by 1/2 space, Shift -click the up/down buttons.

● To increase/decrease the value by 1 space, Ctrl/Cmd -click the up/down buttons.

● To increase the current value by a specific amount, enter += followed by the amount into 
the spin box. For example, enter +=2 to increase the current value by two.

● To decrease the current value by a specific amount, enter -= followed by the amount into 
the spin box. For example, enter -=3.5 to decrease the current value by three and a half.

● To multiply the current value by a specific amount, enter * followed by the amount into 
the spin box. For example, enter *3 to triple the current value.

● To divide the current value by a specific amount, enter / followed by the amount into the 
spin box. For example, enter /2 to halve the current value.

NOTE

You must replace the existing value with your calculation entry.

RELATED LINKS
Options dialogs in Dorico Elements on page 27
Changing your preferred unit of measurement on page 51
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Key Editor

The Key Editor is a MIDI editor that comprises multiple components. It allows you to edit notes 
and other playback items, including note velocity, MIDI CC, and tempo. You can access the Key 
Editor in the Key Editor panel in the lower zone, which you can show alongside layouts in Write 
mode and the track overview in Play mode.

The Key Editor contains the following editors, which you can show in different combinations:

● Piano roll editor

● Percussion editor

● Playing Techniques editor

● Velocity editor

● Dynamics editor

● MIDI Pitch Bend editor

● MIDI CC editor

● Tempo editor

The Key Editor also provides different tools and controls, according to the requirements of each 
editor.

RELATED LINKS
Piano roll editor on page 678
Percussion editor on page 679
Playing Techniques editor on page 690
Velocity editor on page 691
Dynamics editor on page 694
MIDI Pitch Bend editor on page 700
MIDI CC editor on page 701
Tempo editor on page 706
Histogram tool on page 710
MIDI trigger regions on page 574

Key Editor panel
The Key Editor panel allows you to view and edit notes, either in a continuous piano roll for 
pitched instruments or in the percussion editor for unpitched instruments. It is located in the 
lower zone at the bottom of the window in Write mode and Play mode.

● You can show the Key Editor panel by showing the lower zone, then clicking Key Editor  in 
the lower zone toolbar.

In Write mode, you can show the Key Editor panel alongside layouts in the music area. In Play 
mode, you can show the Key Editor panel alongside the track overview.

By default, the Key Editor displays the instrument on whose staff you have selected an item. 
However, you can also select the instruments you want to show in the Key Editor manually.
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1 Key Editor panel toolbar

Contains tools that allow you to select and edit notes and items in the Key Editor.

2 Key Editor ruler

Displays bar numbers and shows beat divisions that match the current rhythmic grid 
resolution.

3 Playhead

Shows the current rhythmic position in playback.

4 Header

Displays the name of each editor and can contain further options, according to the editor.

5 Primary editor

Contains either the piano roll editor, percussion editor, or Tempo editor, depending on your 
most recent selection and whether the Key Editor is locked.

6 Playing Techniques editor

Displays where playing techniques are in use for the corresponding instrument or voice. 
Only available when a single instrument/voice is shown in the Key Editor.

7 Additional editors

You can add/close multiple additional editors below the piano roll/percussion editor, such 
as the Velocity and MIDI CC editors. You can save configurations of editors for use in other 
projects.

8 Add Editor

Allows you to add additional editors to the Key Editor.

9 Presets

Allows you to save, apply, and delete Key Editor configurations.

10 Zoom controls

Allow you to change the zoom manually, such as making notes wider and/or taller.

11 Scroll bars

Allow you to scroll vertically and horizontally in the Key Editor.

RELATED LINKS
Hiding/Showing zones on page 44
Track overview on page 520
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Voices on page 1438
Rhythmic grid on page 217
Changing the Key Editor rhythmic grid resolution on page 675
Adding/Closing editors in the Key Editor on page 675
Showing instruments in the Key Editor on page 671
Key Editor configurations on page 715
Played vs. notated note durations on page 687
Histogram tool on page 710
Transform tool on page 713

Key Editor panel toolbar
The Key Editor panel toolbar contains tools that allow you to select and edit notes and items in 
the Key Editor. It is located at the top of the Key Editor panel in the lower zone.

Select

Allows you to select items in the Key Editor, such as notes in the piano roll editor 
or velocity bars in the Velocity editor, including by clicking and dragging marquee 
selections.

You can also select Select by pressing Shift-Alt/Opt-1 .

Draw

Allows you to input notes in the piano roll and percussion editors. The end positions 
and minimum durations of notes follow the current Key Editor rhythmic grid 
resolution.

You can also select Draw by pressing Shift-Alt/Opt-2 .

Drumstick

Allows you to set a different rhythmic duration for each unpitched percussion 
instrument independently, and input sequences of notes with the corresponding 
duration by clicking and dragging in the percussion editor.

Also allows you to delete notes by clicking them.

Only available in the percussion editor.

You can also select Drumstick by pressing Shift-Alt/Opt-3  when the percussion editor 
is shown.

Line

Allows you to draw straight lines between two points. Not available in the piano roll 
editor or percussion editor.

Transform

Allows you to make Transform selections and use Transform controls on the selected 
range. Only available in the Velocity and MIDI CC editors.
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Sync Region

Copies data from the primary track to secondary tracks. Only available in the Dynamics 
and MIDI CC editors, and when multiple instruments are shown in the Key Editor.

Delete

Deletes the selected items.

You can also delete selected items by pressing Backspace or Delete .

Played Durations

Allows you to change when notes start/end in playback without affecting their notated 
durations. Displays the played durations of notes as a rectangle, above a thinner line 
that shows their notated duration.

Notated Durations

Allows you to change the rhythmic duration of notes, which affects the position and 
notation of those notes. Displays the full, notated durations of notes as rectangles.

Lock Played Durations

Allows you to control how changing notated durations impacts on played durations. 
Only available when Notated Durations  is selected.

● When Lock Played Durations  is activated, played durations retain their original 
positions/durations, regardless of the new notated positions/durations of the 
corresponding notes.

● When Lock Played Durations  is deactivated, played durations move with their 
corresponding notes and retain their start/end offsets relative to them.

Rhythmic Grid

Allows you to change the rhythmic grid resolution for the Key Editor. The Key Editor 
rhythmic grid resolution affects the minimum duration of the notes you input, the 
number of grid lines, and certain aspects of inputting and editing, such as the amount 
by which you can drag notes to the right/left. The button updates to show the current 
rhythmic grid resolution.

Playing Techniques

Hides/Shows the Playing Techniques editor.

Voice selector

Allows you to select the voice whose notes you want to appear highlighted in the piano 
roll and into which you want to input notes. Automatically updates according to your 
current selection.

Key Editor
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When multiple instruments are shown in the Key Editor, only voices belonging to the 
primary instrument are available.

Resize Lower Zone

Allows you to change the height of the lower zone.

TIP

● You can right-click and hold in the Key Editor to access tools in the quick tool selector.

● You can also select tools by pressing Shift-Alt/Opt-1  to Shift-Alt/Opt-6 . The tool selected 
by each key command depends on the tools currently available in the Key Editor panel 
toolbar, counted from left to right.

RELATED LINKS
Notes in the Key Editor on page 678
Playing Techniques editor on page 690
Velocity editor on page 691
Dynamics editor on page 694
MIDI CC editor on page 701

Showing instruments in the Key Editor
You can show specific instruments in the Key Editor, change the primary instrument, and lock the 
Key Editor to keep those instruments in view. For example, if you want to draw MIDI points for all 
string instruments in your project simultaneously.

By default, the Key Editor is unlocked and follows the current selection in either the music area or 
track overview.

For example, if your most recent selection was a Flute note or the Flute track, that Flute is shown 
in the piano roll editor. If your most recent selection was a tempo mark or the Tempo track, the 
Tempo editor is shown in the Key Editor, provided you had not already added the Tempo editor 
manually.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Your most recently selected item belonged to an instrument, so that either the piano roll or 
percussion editor is shown in the Key Editor.

NOTE

You cannot add editors to the Key Editor when the Tempo editor is the primary editor.

PROCEDURE

1. In the piano roll/percussion editor header, click the instrument menu, then select the 
instrument you want to show as the primary instrument.
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2. To lock the Key Editor and keep the selected instrument in view, click Lock Key Editor .

3. To show multiple instruments in the Key Editor simultaneously, activate View multiple 
instruments.

NOTE

You can only show multiple pitched instruments in the Key Editor. You cannot show multiple 
unpitched percussion instruments, or unpitched percussion instruments in addition to 
pitched instruments.

4. Activate each instrument you want to show in the Key Editor.

5. Optional: Click Make Primary beside the instrument you want to designate as the new 
primary instrument.

RESULT
The Key Editor shows the selected instruments. If you locked the Key Editor, including if you 
optionally selected multiple instruments, it no longer follows your most recent selection.

TIP

You can assign key commands for the following commands on the Key Commands page in 
Preferences:

● Lock Key Editor to Selection automatically shows in the Key Editor the instruments on 
whose staves you have selected notes/items in the music area, and locks the Key Editor to 
that selection.
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● Toggle Key Editor Locked View locks/unlocks the Key Editor.

AFTER COMPLETING THIS TASK

● You can view, input, and edit notes, dynamic points, and MIDI points for all the instruments 
shown in the Key Editor.

● You can copy dynamic and MIDI points from the primary instrument to secondary 
instruments.

RELATED LINKS
Hiding/Showing zones on page 44
Adding/Closing editors in the Key Editor on page 675
Piano roll editor on page 678
Percussion editor on page 679
Dynamics editor on page 694
MIDI CC editor on page 701
MIDI Pitch Bend editor on page 700
Tempo editor on page 706
Track overview on page 520
Enabling independent voice playback on page 545
Copying dynamic points to other instruments on page 699
Copying MIDI points to other instruments on page 705

Changing the height of the Key Editor
You can change the height of the whole Key Editor and each editor within it. For example, you 
can make the piano roll editor taller when inputting notes, and make the Velocity editor taller 
when changing note velocity.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

PROCEDURE

● Do one of the following:

● To change the height of the whole Key Editor, click and drag Resize Lower Zone  or 
the top edge of the lower zone upwards/downwards.

● To change the height of individual editors, click and drag their splitters 
upwards/downwards. When the mouse pointer is in the correct position, it appears as a 
split arrow.

TIP

You can assign a key command for Cycle Lower Zone Size on the Key Commands page in 
Preferences, which makes the lower zone fill 25%, 50%, then 75% of the project window.

RELATED LINKS
Key Commands page in the Preferences dialog on page 60
Opening multiple project windows on page 49
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Zooming in/out of the Key Editor
You can change the zoom level in the Key Editor; for example, you can zoom in vertically and 
horizontally to make notes appear taller and wider in the piano roll editor. This does not affect 
the height of the Key Editor.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

PROCEDURE

1. Zoom in horizontally in any of the following ways:

● Press H .

● Click Zoom In  at the bottom of the Key Editor.

● Click in the Key Editor ruler and drag upwards.

● Ctrl/Cmd -scroll upwards in the Key Editor ruler.

2. Zoom out horizontally in any of the following ways:

● Press G .

● Click Zoom Out  at the bottom of the Key Editor.

● Click in the Key Editor ruler and drag downwards.

● Ctrl/Cmd -scroll downwards in the Key Editor ruler.

3. Zoom in vertically in any of the following ways:

● Press Ctrl/Cmd-Shift-H .

● Click Zoom In  on the right of the Key Editor.

● Ctrl/Cmd -scroll upwards in the area to the left of the piano roll/percussion editor.

4. Zoom out vertically in any of the following ways:

● Press Ctrl/Cmd-Shift-G .

● Click Zoom Out  on the right of the Key Editor.

● Ctrl/Cmd -scroll downwards in the keyboard to the left of the piano roll.

RELATED LINKS
Key Editor panel on page 667
Zooming in/out of tracks on page 537
Hiding/Showing zones on page 44

Scrolling in the Key Editor
You can scroll in any direction in the Key Editor; for example, to view higher/lower notes in the 
piano roll editor, or MIDI points in later bars in the MIDI CC editor.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.
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PROCEDURE

● In the Key Editor, scroll in any of the following ways:

● Click and drag the sliders on the right and bottom edges of the Key Editor.

● Swipe in any direction on a touchpad.

● To scroll vertically when using a mouse wheel, scroll upwards/downwards.

● To scroll horizontally when using a mouse wheel, Shift -scroll upwards/downwards.

Changing the Key Editor rhythmic grid resolution
You can change the rhythmic grid resolution used for the Key Editor, independently of the 
rhythmic grid used outside of the Key Editor. The Key Editor rhythmic grid resolution affects 
the minimum duration of the notes you input, the number of grid lines, and certain aspects of 
inputting and editing, such as the amount by which you can drag notes to the right/left.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● If you want to use key commands, your most recent selection must have been in the Key 
Editor panel.

PROCEDURE

● Change the Key Editor rhythmic grid resolution in any of the following ways:

● In the Key Editor panel toolbar, click Rhythmic Grid  and choose the resolution you 
want.

● To decrease the rhythmic grid resolution, press Alt/Opt-] .

● To increase the rhythmic grid resolution, press Alt/Opt-[ .

RELATED LINKS
Rhythmic grid on page 217
Notes in the Key Editor on page 678

Adding/Closing editors in the Key Editor
You can add/close all types of editors in the Key Editor, excluding the piano roll and percussion 
editors. You can also change the editor type shown in an existing editor.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Your most recently selected item belonged to an instrument, so that either the piano roll or 
percussion editor is shown in the Key Editor.

NOTE

You cannot add editors to the Key Editor when the Tempo editor is the primary editor.
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PROCEDURE

● Change the editors shown in the Key Editor in one of the following ways:

● To add a new editor, click Add Editor  at the bottom left of the Key Editor.

● To change the editor type shown in an existing editor, click the menu in its header and 
select an editor from the menu.

● To close editors, click Close Editor  in their headers.

AFTER COMPLETING THIS TASK
You can save Key Editor configurations for use in other projects.

Selecting items in the Key Editor
You can select notes and items, such as MIDI or dynamic points, in the Key Editor in the same 
ways.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have added the editors whose points you want to select.

PROCEDURE

1. Select the Select tool in any of the following ways:

● Press Shift-Alt/Opt-1 .

● In the Key Editor panel toolbar, click Select .

● In the Key Editor, right-click and hold to show the quick tool selector, move the mouse 
pointer to Select , then release the mouse.

2. Select notes or items in any of the following ways:

● Click a single note or point.

● Ctrl/Cmd -click or Shift -click multiple notes or points.

● In one editor, click and drag across an area where you want to select everything.

A blue rectangle indicates which notes or points will be selected when you release the 
mouse. We recommend that you click in one corner of the area you want to select and 
drag diagonally across to the other corner.

Copying and pasting points in the Key Editor
You can copy and paste points in the Key Editor, including to other editors and repeating them 
directly after themselves in the same editor. For example, if you want to copy a pattern of MIDI 
points between different MIDI controllers.

NOTE

These steps describe copying/pasting points within/between editors belonging to the same 
instrument. However, you can also copy/paste dynamic and MIDI points between instruments.
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PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have added the editors whose points you want to copy/paste.

PROCEDURE

1. In one of the open editors, select the points you want to copy.

2. Copy the selected points in any of the following ways:

● Press Ctrl/Cmd-C .

● Choose Edit > Copy.

3. Move the playhead to the position to which you want to paste the selected points.

4. Select the header of the editor into which you want to paste the selected points.

5. Paste the selected points in any of the following ways:

● Press Ctrl/Cmd-V .

● Choose Edit > Paste.

RESULT
The selected points are copied to the selected position and editor, without deleting them from 
their original positions. They apply to all instruments shown in the Key Editor.

NOTE

● All the points of gradual dynamics and combined/force dynamics input in Write mode are 
copied, even if you only selected a single point.

● You can also repeat points immediately after themselves by selecting them, then pressing R . 
In each repetition, the earliest selected point replaces the last selected point.

● You can also copy points by selecting them, then Alt/Opt -dragging them to the position 
where you want to paste them.

RELATED LINKS
Showing instruments in the Key Editor on page 671
Moving the playhead on page 538
Copying dynamic points to other instruments on page 699
Copying MIDI points to other instruments on page 705
Inputting dynamic points on page 696
Inputting MIDI points on page 703

Deleting points in the Key Editor
You can delete selected points from multiple editors simultaneously.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.
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● You have selected the instruments that you want to show in the Key Editor.

● You have added the editors whose points you want to delete.

PROCEDURE

1. In any of the open editors, select the points you want to delete.

TIP

You can select points in multiple editors simultaneously.

2. Delete the selected points in any of the following ways:

● Press Backspace or Delete .

● In the Key Editor panel toolbar, click Delete .

RESULT
The selected points are deleted.

Deleting dynamic points that overrode dynamics input in Write mode reverts those dynamics 
to their default points. Deleting the points of dynamics input in Write mode also deletes the 
corresponding dynamics.

Deleting tempo points also deletes their corresponding tempo marks or tempo mark signposts 
from layouts.

Notes in the Key Editor
In the Key Editor, notes appear as colored rectangles in either the piano roll editor for pitched 
instruments, or the percussion editor for unpitched percussion instruments and percussion kits.

Piano roll editor
The piano roll editor displays MIDI notes for pitched instruments in a continuous sequence. It is 
located in the Key Editor in the lower zone.

● You can show the piano roll editor by showing a pitched instrument in the Key Editor.

The piano roll editor comprises the following:

1 Instrument menu

Allows you to select the instruments you want to show in the piano roll editor, and to change 
the primary instrument when multiple instruments are shown.
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2 Piano keyboard

Provides a reference for pitches.

3 Piano roll

Displays the notes belonging to the instruments shown in the Key Editor. The horizontal 
position of notes indicates their rhythm, and their width indicates their duration. The vertical 
position of notes indicates their pitch. When notes are sufficiently tall and wide, pitches are 
also displayed inside each note.

Instruments are automatically assigned a color according to their player order in the current 
layout, so that you can tell them apart more easily. This color is used consistently for the 
corresponding instrument, including in the Mixer and Key Editor.

When multiple instruments are shown, notes belonging to the primary instrument appear 
solid and bold in the piano roll editor, while notes belonging to secondary instruments 
appear with gray outlines and pastel colors.

4 Tuplets

Bars and ratios at the top of the piano roll editor indicate tuplets in the active voice.

You can input and edit notes in the piano roll editor, including moving and transposing them. 
This also updates their notation in all applicable layouts.

RELATED LINKS
Played vs. notated note durations on page 687
Showing instruments in the Key Editor on page 671
Track overview on page 520
Mixer on page 717
Tuplets on page 1408
Voices on page 1438
Inputting notes into multiple voices on page 232
Changing the voice of existing notes on page 466
Changing the middle C numbering convention on page 51
MIDI trigger regions on page 574

Percussion editor
The percussion editor displays MIDI notes for unpitched percussion instruments in a continuous 
sequence. It is located in the Key Editor in the lower zone.

● You can show the percussion editor by showing an unpitched percussion instrument or 
percussion kit in the Key Editor.
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The percussion editor comprises the following:

1 Instrument menu

Allows you to select the instrument you want to show in the percussion editor. You can only 
show one percussion kit or individual percussion instrument at a time.

2 Percussion instrument names and playing techniques

In the percussion editor, each unpitched percussion instrument has its own row, including 
when they are in a percussion kit. Alternative playing techniques are listed beneath the 
corresponding unpitched percussion instrument.

3 Percussion Rhythmic Grid

Allows you to set a different default note duration for each unpitched percussion instrument 
independently. Only available when the Drumstick  tool is selected.

4 Percussion editor

Displays the notes belonging to the instruments shown in the Key Editor. The vertical 
position of notes indicates their instrument and playing technique, where applicable. The 
horizontal position of notes indicates their rhythm, and their width indicates their duration.

Instruments are automatically assigned a color according to their player order in the current 
layout, so that you can tell them apart more easily. This color is used consistently for 
the corresponding instrument, including in the Mixer and Key Editor. Percussion kits are 
assigned a single color for the whole kit.

RELATED LINKS
Percussion maps on page 780
Showing instruments in the Key Editor on page 671
Inputting notes using the Drumstick tool on page 682
Track overview on page 520
Playing techniques for unpitched percussion instruments on page 1420
MIDI trigger regions on page 574
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Inputting notes in the Key Editor
You can input notes in the Key Editor, in either the piano roll editor for pitched instruments, or in 
the percussion editor for unpitched percussion instruments and percussion kits. Notes you input 
in the Key Editor also appear in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● If you want to input notes into a specific voice for an instrument, you have created that voice 
in Write mode and input at least one note into it.

● You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. Optional: If you want to input notes into a specific voice, select it from the voice selector in 
the Key Editor panel toolbar.

2. Select the Draw tool in any of the following ways:

● Press Shift-Alt/Opt-2 .

● In the Key Editor panel toolbar, click Draw .

● In the Key Editor, right-click and hold to show the quick tool selector, move the mouse 
pointer to Draw , then release the mouse.

3. Click Rhythmic Grid  and choose the default note duration you want.

4. Input notes in any of the following ways:

● To input single notes with the default note duration, click in the piano roll/percussion 
editor at each rhythmic position where you want to input a note.

● To input notes with any duration, click and drag horizontally in the piano roll/percussion 
editor at the required pitch position and for the required duration.

As you drag, highlights help you to reference durations against the ruler, pitches against 
the piano keyboard in the piano roll editor, and notes against instruments/playing 
techniques in the percussion editor.

RESULT
For pitched instruments, notes are input at the pitches indicated by the piano keyboard on the 
left of the piano roll, and into the active voice indicated by the voice selector in the Key Editor 
panel toolbar.

For unpitched percussion instruments and kits, notes are input into the instrument in the 
corresponding row of the percussion editor.
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When you click once, notes are input with the default note duration, set by the Key Editor 
rhythmic grid resolution. When you click and drag, their duration is determined by the width of 
your drag.

AFTER COMPLETING THIS TASK
You can change both the notated and played durations of notes.

RELATED LINKS
Hiding/Showing zones on page 44
Zooming in/out of the Key Editor on page 674
Changing the height of the Key Editor on page 673
Changing the Key Editor rhythmic grid resolution on page 675
Inputting notes into multiple voices on page 232
Changing the voice of existing notes on page 466
Enabling independent voice playback on page 545
Played vs. notated note durations on page 687

Inputting notes using the Drumstick tool
The Drumstick tool allows you to input notes with a different rhythmic duration for each 
unpitched percussion instrument independently.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the unpitched percussion instrument or percussion kit that you want to 
show in the Key Editor.

PROCEDURE

1. Select the Drumstick tool in any of the following ways:

● Press Shift-Alt/Opt-3 .

● In the Key Editor panel toolbar, click Drumstick .

● In the Key Editor, right-click and hold to show the quick tool selector, move the mouse 
pointer to Drumstick , then release the mouse.

2. In the percussion editor header, click Percussion Rhythmic Grid  for each instrument and 
choose its required note duration.

For example, you might set quarter notes for the kick drum, and eighth notes for the hi-hat.

3. Input notes in any of the following ways:

● To input single notes, click in the percussion editor at each rhythmic position where you 
want to input a note.

● To input multiple notes, click and drag horizontally in the percussion editor.
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RESULT
Notes are input with the note duration set for the corresponding instrument, either a single note 
per click, or to fill the region in which you clicked and dragged.

TIP

When Drumstick  is selected, you can also delete notes by clicking them.

Moving notes in the Key Editor
You can move notes rhythmically in the Key Editor. This also affects how the selected notes are 
notated in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. In the Key Editor panel toolbar, click Notated Durations  to show notated note durations.

2. Activate/Deactivate Lock Played Durations .

3. In the piano roll/percussion editor, select the notes you want to move rhythmically.

4. Move the selected notes in any of the following ways:

● To move them to the right, press Alt/Opt-Right Arrow .

● To move them to the left, press Alt/Opt-Left Arrow .

● Click and drag them to the right/left.

TIP

As you drag, highlights help you to reference durations against the ruler, pitches against 
the piano keyboard in the piano roll editor, and notes against instruments/playing 
techniques in the percussion editor.

RESULT
The selected notes are moved to new rhythmic positions. If you selected multiple notes, they are 
moved together as a block.

If you activated Lock Played Durations , played durations are not moved; they retain their 
original positions.

Key commands move notes according to the current rhythmic grid resolution. Clicking and 
dragging moves notes according to the current Key Editor rhythmic grid resolution.

RELATED LINKS
Hiding/Showing zones on page 44
Played vs. notated note durations on page 687
Rhythmic grid on page 217
Changing the Key Editor rhythmic grid resolution on page 675
Moving percussion notes between instruments/playing techniques on page 685
Requantizing notes on page 266
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Lengthening/Shortening notes in the Key Editor
You can change the notated duration of notes in the Key Editor. This also affects how the 
selected notes are notated in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have chosen the appropriate rhythmic grid resolution.

PROCEDURE

1. In the Key Editor panel toolbar, click Notated Durations  to show notated note durations.

2. Activate/Deactivate Lock Played Durations .

3. In the piano roll/percussion editor, select the notes you want to lengthen/shorten.

4. Lengthen/Shorten the selected notes in any of the following ways:

● To lengthen notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten notes by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

● To double the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Right Arrow .

● To halve the length of notes, press Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● Click and drag the right end of one of the selected notes to the length you want.

TIP

As you drag, highlights help you to reference durations against the ruler, pitches against 
the piano keyboard in the piano roll editor, and notes against instruments/playing 
techniques in the percussion editor.

RESULT
The selected notes are lengthened/shortened.

If you activated Lock Played Durations , played durations are not lengthened/shortened; they 
retain their original positions/durations.

Key commands lengthen/shorten notes according to the current rhythmic grid resolution. 
Clicking and dragging lengthens/shortens notes according to the current Key Editor rhythmic 
grid resolution.

RELATED LINKS
Selecting items in the Key Editor on page 676
Note durations on page 258
Played vs. notated note durations on page 687
Rhythmic grid on page 217
Changing the Key Editor rhythmic grid resolution on page 675
Enabling independent voice playback on page 545
Requantizing notes on page 266
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Transposing notes in the piano roll editor
You can transpose notes in the piano roll editor by moving them vertically to other pitch 
positions. This also affects how the selected notes are notated in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

PROCEDURE

1. In the piano roll editor, select the notes you want to transpose.

2. Transpose the notes in any of the following ways:

● To move notes up one staff position, such as from C to D, press Alt/Opt-Up Arrow .

● To move notes down one staff position, such as from D to C, press Alt/Opt-
Down Arrow .

● To transpose notes up a single octave division, such as a half-step (semitone) in 12-EDO 
or a quarter tone in 24-EDO, press Shift-Alt/Opt-Up Arrow .

● To transpose notes down a single octave division, such as a half-step (semitone) in 
12-EDO or a quarter tone in 24-EDO, press Shift-Alt/Opt-Down Arrow .

● To transpose notes up an octave, press Ctrl/Cmd-Alt/Opt-Up Arrow .

● To transpose notes down an octave, press Ctrl/Cmd-Alt/Opt-Down Arrow .

● Click and drag them upwards/downwards.

TIP

As you drag, highlights help you to reference durations against the ruler, and pitches 
against the piano keyboard.

RESULT
The selected notes are transposed according to their new pitch positions in the piano roll editor.

RELATED LINKS
Hiding/Showing zones on page 44
Equal Division of the Octave (EDO) on page 1028
Transposing tools on page 468

Moving percussion notes between instruments/playing techniques
You can move notes to other instruments and playing techniques in the percussion editor; for 
example, if you want hi-hat notes to be played on a cymbal instead. This also affects how the 
selected notes are notated in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the unpitched percussion instrument or percussion kit that you want to 
show in the Key Editor.
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PROCEDURE

1. In the percussion editor, select the notes you want to move to other instruments/playing 
techniques.

2. Move the notes in any of the following ways:

● To move notes to the instrument above, press Alt/Opt-Up Arrow .

● To move notes to the instrument below, press Alt/Opt-Down Arrow .

● To cycle notes upwards through the playing techniques of their current instrument, 
press Shift-Alt/Opt-Up Arrow .

● To cycle notes downwards through the playing techniques of their current instrument, 
press Shift-Alt/Opt-Down Arrow .

● Click and drag them upwards/downwards.

TIP

As you drag, highlights help you to reference durations against the ruler, and notes 
against instruments/playing techniques.

RESULT
The selected notes are moved to the instrument/playing technique in the corresponding row in 
the percussion editor.

RELATED LINKS
Percussion editor on page 679
Playing techniques for unpitched percussion instruments on page 1420

Copying and pasting notes in the Key Editor
You can copy and paste notes in the piano roll and percussion editors, including to other pitched 
instruments and voices, and repeating them directly after themselves.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments that you want to show in the Key Editor.

PROCEDURE

1. In the piano roll/percussion editor, select the notes you want to copy.

2. Copy the selected notes in any of the following ways:

● Press Ctrl/Cmd-C .

● Choose Edit > Copy.

3. Move the playhead to the position to which you want to paste the selected notes.

4. Optional: If you want to paste notes to another instrument, make that instrument the 
primary instrument.

5. Optional: If you want to paste notes into another voice, select that voice from the voice 
selector in the Key Editor toolbar.
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6. Paste the selected notes in any of the following ways:

● Press Ctrl/Cmd-V .

● Choose Edit > Paste.

RESULT
The selected notes are copied to the selected position, instrument, and voice, without deleting 
them from their original positions. By default, any MIDI CC points in the copied range are also 
pasted.

TIP

● You can also repeat notes immediately after themselves by selecting them, then pressing R .

● You can also copy notes by selecting them, then Alt/Opt -dragging them to the position 
where you want to paste them.

RELATED LINKS
Moving the playhead on page 538
Disabling automatic copying of MIDI data when pasting on page 460
Copying dynamic points to other instruments on page 699
Copying MIDI points to other instruments on page 705
Copying and pasting notes/items on page 457

Deleting notes in the Key Editor
You can delete notes in the Key Editor. This also removes notes from all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

PROCEDURE

1. Optional: If Select  is selected in the Key Editor panel toolbar, select the notes you want to 
delete in the piano roll/percussion editor.

2. Delete notes in any of the following ways:

● Press Backspace or Delete .

● In the Key Editor panel toolbar, click Delete .

● In the Key Editor panel toolbar, click Drumstick , then click each note you want to 
delete in the percussion editor.

Played vs. notated note durations
In the Key Editor, you can show notes with their played duration or notated duration.

Played duration

When Played Durations  is selected in the Key Editor panel toolbar, notes in the piano roll/
percussion editor are each shown with two components:
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● A filled, light-colored rectangle showing the played duration of the note.

● A thin, darker rod showing the notated duration of the note.

This allows you to change the played, sounding duration of notes. For example, notes with 
staccato articulations are played for less time than their notated duration, whereas notes under 
slurs are played for longer than their notated duration.

Notated duration

When Notated Durations  is selected in the Key Editor panel toolbar, notes in the piano roll/
percussion editor appear as single rectangles whose width corresponds to the notated duration 
of the note. This allows you to change the duration of notes.

You can control how changing notated durations impacts on played durations:

● When Lock Played Durations  is activated, played durations retain their original positions 
and durations, regardless of the new notated positions/durations of the corresponding 
notes.

● When Lock Played Durations  is deactivated, played durations move with their 
corresponding notes and retain their start/end offsets relative to them.

EXAMPLE
The following examples all contain the same musical phrase, shown in different ways.

Played duration Notated duration Score

TIP

You can choose to display played or notated note durations in the piano roll editor by default in 
all future projects on the General page in Preferences.

RELATED LINKS
Key Editor panel toolbar on page 669
Slurs in playback on page 1308
Articulations in playback on page 809
Changing the duration of notes on page 259
Lengthening/Shortening notes in the Key Editor on page 684
Requantizing notes on page 266
Quantization options on page 93
Preferences dialog on page 58
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Changing the played duration of notes
You can change the played duration of notes individually, both at the start and end of notes. For 
example, you can make notes sound for longer, or start sounding later.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have applied a playback template to the project that includes sounds for the instruments 
in your project.

PROCEDURE

1. In the Key Editor panel toolbar, click Played Durations  to show played note durations.

2. In the piano roll/percussion editor, select the notes whose played duration you want to 
change.

3. Click and drag the start or end of one of the notes to the right/left.

When the mouse pointer is in the correct position, it appears as a split arrow.

RESULT
The played duration of the selected notes is changed.

TIP

You can assign key commands for increasing/decreasing playback start/end offsets in 
Preferences > Key Commands > Note Editing. You can use these commands when Played 
Durations  is selected in the Key Editor panel toolbar.

RELATED LINKS
Selecting items in the Key Editor on page 676
Applying/Resetting playback templates on page 564
Key Commands page in the Preferences dialog on page 60

Resetting playback overrides
You can remove all changes made to how individual notes play back; for example, if you 
previously changed the played duration of notes and want to revert them to their default start 
position, length, and velocity.

Removing playback overrides also removes any offsets to the start and end position of notes 
imported from MIDI files with preserved note positions.
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NOTE

Any note velocities that are set on notes are reflected in playback, including from imported MIDI 
files or MIDI recording. If you want dynamics you input in Write mode to be reflected in playback 
instead, you must remove playback overrides.

PROCEDURE

1. Select the notes whose playback overrides you want to reset.

You can do this in the music area, piano roll editor, percussion editor, or Velocity editor.

2. Choose Play > Reset Playback Overrides.

RESULT
All playback overrides are removed from the selected notes.

RELATED LINKS
Large selections on page 424
Selecting/Deselecting notes and items individually on page 421
Music area on page 34
Piano roll editor on page 678
Percussion editor on page 679
Resetting note velocity on page 693
MIDI recording on page 264
Importing MIDI on page 85
Opening projects/files on page 72

Playing Techniques editor
The Playing Techniques editor displays where playing techniques are in use for the 
corresponding instrument or voice; for example, as a result of inputting playing techniques, 
slurs, or articulations. It is located in the Key Editor in the lower zone.

● You can hide/show the Playing Techniques editor by clicking Playing Techniques  in the 
Key Editor panel toolbar.

NOTE

You can only show the Playing Techniques editor when a single instrument/voice is shown in 
the Key Editor.

The Playing Techniques editor comprises the following:

1 Editor header

Displays the name of the editor.
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2 Playing technique regions

Display the playing technique and note length condition that apply to notes in the region. 
You can hover your mouse pointer over playing technique regions to see the following 
related information:

● Any playback techniques, switches, and other effects in place, such as adjustments for 
articulations

● Expression map used for the region

● Channel in the VST or MIDI instrument used for the region

● VST or MIDI instrument used for the region

NOTE

You cannot change playing techniques in the Playing Techniques editor. You can only change 
them in Write mode.

RELATED LINKS
Hiding/Showing zones on page 44
Playing techniques on page 1180
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367
Playback techniques on page 787
Expression maps on page 761
Showing instruments in the Key Editor on page 671
Moving percussion notes between instruments/playing techniques on page 685
Enabling independent voice playback on page 545

Velocity editor
The Velocity editor allows you to view and edit the velocity of notes belonging to the 
instruments/voices shown in the Key Editor. It is located in the Key Editor in the lower zone.

● You can show the Velocity editor by adding an editor to the Key Editor, then selecting 
Velocity from the editor menu.

The Velocity editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Velocity edit scope: Allows you to change the scope of changes you make to velocity 
values. Only available when Draw , Line , or Transform  is selected in the Key 
Editor panel toolbar.

● All notes: Allows you to edit the velocity of all notes shown in the Velocity editor.

● Selection: Allows you to edit the velocity of selected notes only.
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● Histogram : Shows the Histogram tool in the editor.

● Value field: Displays the velocity value of the earliest selected note/velocity bar in the 
primary instrument. You can change the velocity value of all selected notes in the value 
field or click and drag velocity bars upwards/downwards in the editor. Only available 
when Select  is selected in the Key Editor panel toolbar.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 Value read-out

Displays the value of the current mouse pointer position in the editor.

4 Velocity bars

Velocities appear as vertical bars in the Velocity editor. Every note has its own velocity bar 
and a velocity value. When multiple notes exist at the same rhythmic position, such as in 
chords, the velocities for all notes appear stacked on top of each other, ordered by their 
value.

Velocity bars with higher values appear with bolder colors.

You can select velocity bars directly in the Velocity editor or by selecting their corresponding 
notes, in either the piano roll editor, percussion editor, or music area.

TIP

● Clicking and dragging velocity bars causes a read-out to appear temporarily, showing 
their value.

● You can use the Histogram and Transform tools to change velocity values.

RELATED LINKS
Key Editor panel on page 667
Key Editor panel toolbar on page 669
Histogram tool on page 710
Transform tool on page 713
Hiding/Showing zones on page 44
Adding/Closing editors in the Key Editor on page 675
Showing instruments in the Key Editor on page 671
Inputting notes on page 224
Inputting notes into multiple voices on page 232
Inputting notes in the Key Editor on page 681
Voices on page 1438

Changing the velocity of notes
You can change the velocity of notes individually, including for a single note in a chord, or to 
create a consistent increase/decrease in velocity across a range of notes.

Velocity is often used to control the dynamics of non-sustaining instruments.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have added the Velocity editor to the Key Editor.
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PROCEDURE

1. Select one of the following tools, depending on how you want to change velocities:

● To change the velocity of selected notes, select Select by pressing Shift-Alt/Opt-1  or 
clicking Select  in the Key Editor panel toolbar.

● To change the velocity using free shapes, select Draw by pressing Shift-Alt/Opt-2  or 
clicking Draw  in the Key Editor panel toolbar.

● To change the velocity using consistent slopes, select Line by clicking Line  in the Key 
Editor panel toolbar.

2. Optional: If you selected Select , select the notes whose velocity you want to change, such 
as individual notes in chords. This also selects their velocity bars.

3. Optional: If you selected either the Draw  tool or Line  tool, choose one of the following 
velocity edit scopes in the Velocity editor header:

● All notes

● Selection

4. In the Velocity editor, change the velocity in one of the following ways:

● If you selected Select , click and drag the top of one of the selected velocity bars 
upwards/downwards.

● If you selected Draw , click and draw any shape across the required range.

● If you selected Line , click and drag a line across the required range.

RESULT
The velocity of the affected notes is changed. If you selected the Selection velocity edit scope, 
this only applies to selected velocity bars.

TIP

You can also use the Transform and Histogram tools to change velocities on a large scale in 
different ways.

Resetting note velocity
You can remove changes you have made to the velocity of notes and reset them to their default 
velocity. You can do this for all notes belonging to an instrument, all notes in a specific voice, or 
only selected notes.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have added the Velocity editor to the Key Editor.

PROCEDURE

1. In the Velocity editor header, activate Histogram  to show the Histogram tool.

2. At the top of the Histogram tool, choose one of the following filters:

● All notes

● Voice
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● Selection

3. Click Reset.

RESULT
Any changes you have made to the velocity of notes in the selected filter are reset.

NOTE

This also resets the played duration of the selected notes.

RELATED LINKS
Histogram tool on page 710
Selecting items in the Key Editor on page 676
Resetting playback overrides on page 689

Dynamics editor
The Dynamics editor allows you to view, input, and edit dynamics for the instruments/voices 
shown in the Key Editor. It displays both dynamics input in Write mode and dynamic points input 
in the Dynamics editor. It is located in the Key Editor in the lower zone.

● You can show the Dynamics editor by adding an editor to the Key Editor, then selecting 
Dynamics from the editor menu.

The Dynamics editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Sync : Copies all points in the editor from the primary instrument to secondary 
instruments. Only available when multiple instruments are shown in the Key Editor.

● Convert to Constant Point : Makes the selected points constant. Only applies to 
points input in the Dynamics editor.

● Convert to Linear Point : Makes the selected points linear. Only applies to points in 
input in the Dynamics editor.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 Value read-out

Displays the value of the current mouse pointer position in the editor.

4 Dynamic point
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An immediate change in dynamic, input either in Write mode or using the Draw tool in the 
Dynamics editor. Immediate dynamic points are constant by default.

The maximum range of dynamic levels is from 8 to -8, loudest to quietest.

● Dynamic level 3 is equivalent to the dynamic .

● Dynamic level 0 is equivalent to the dynamic .

● Dynamic level -3 is equivalent to the dynamic .

NOTE

● Clicking and dragging dynamic points causes a read-out to appear temporarily, showing 
their dynamic level.

● Only points that are identical for all instruments shown in the Key Editor are editable.

● Dynamic points that you input in the Dynamics editor do not appear in layouts.

5 Dynamic text

Shows the dynamic level or crescendo/diminuendo symbol of dynamics input in Write mode; 
that is, dynamic points that correspond to notation items.

6 Dynamic region

Blue highlighted regions contain multiple points, input by clicking and dragging in a single 
motion in the Dynamics editor with either the Draw tool or Line tool. By default, dynamic 
points in regions input in the Dynamics editor are linear.

Green highlighted regions represent gradual dynamics and combined/force dynamics, such 
as  and , input in Write mode.

Thin blue bars at the top of the Editor represent dynamic groups.

NOTE

● Only points that are identical for all instruments shown in the Key Editor are editable.

● Dynamic regions that you input in the Dynamics editor override default playback 
adjustments for dynamics, such as humanization and increased dynamics for notes with 
accents. However, the dynamic curve setting still applies to dynamic regions.

● Default playback adjustments for dynamics, such as humanization and increased 
dynamics for notes with accents, still apply to notes within gradual dynamics that you 
input in Write mode.

● Start and end points for messa di voce regions are linked and always have the same 
value.

● Because the points of combined/force dynamics correspond to parameters of their 
envelopes, they function differently than other dynamic points. Combined dynamics 
have three points, while force dynamics have four points.

For example, if you change the value of the second point of a force dynamic, the third 
point also moves because it controls the duration of the second point; they always have 
the same value. Similarly, you cannot move combined/force dynamic points outside their 
regions.

7 Dynamic value line

When multiple instruments are shown in the Key Editor, a value line is shown for each 
instrument, using its color.

RELATED LINKS
Key Editor panel on page 667
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Hiding/Showing zones on page 44
Adding/Closing editors in the Key Editor on page 675
Showing instruments in the Key Editor on page 671
Dynamics on page 921
Input methods for dynamics on page 309
Groups of dynamics on page 949
Changing dynamic levels on page 926
Rhythmic grid on page 217

Inputting dynamic points
You can input single dynamic points and dynamic regions in the Dynamics editor. Dynamic points 
that you input in the Dynamics editor do not appear in layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have added the Dynamics editor to the Key Editor.

PROCEDURE

1. Select one of the following tools, depending on the type of dynamic points you want to input:

● To input single dynamic points, or dynamic regions containing multiple dynamic points 
at regular intervals, select Draw by pressing Shift-Alt/Opt-2  or clicking Draw  in the 
Key Editor panel toolbar.

● To input smooth dynamic regions, select Line by clicking Line  in the Key Editor panel 
toolbar.

2. Input dynamic points in one of the following ways:

● To input single dynamic points, click in the Dynamics editor at each position where you 
want a dynamic point.

● To input a dynamic region containing multiple dynamic points at regular intervals, click 
and drag in a single motion in the Dynamics editor.

● To input smooth dynamic regions, click and drag in the Dynamics editor from where you 
want the region to start to where you want it to end.

RESULT
Dynamic points are input for all instruments shown in the Key Editor.

● If you used the Draw tool, separate dynamic points are input at each position you clicked.

● If you clicked and dragged in a single motion using the Draw tool, dynamic points are input 
at 32nd note intervals in a dynamic region.

● If you used the Line tool, two dynamic points are input in a dynamic region, one at each end 
of the dragged range.

By default, dynamic points input using the Draw tool are constant, while dynamic points in 
dynamic regions are linear.

Dynamic regions appear with highlighted regions in the Dynamics editor.

Dynamic points input in the Dynamics editor affect playback, but are not shown in layouts.
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NOTE

● Inputting dynamic points/events at the positions of dynamics input in Write mode overrides 
default playback adjustments for those dynamics. Single dynamic points only override the 
dynamic level. Dynamic regions also override, for example, humanization and increased 
dynamics for notes with accents. However, the dynamic curve setting still applies to dynamic 
regions.

● For sound libraries that use MIDI CC 1 to control dynamics, the MIDI CC editor for CC 1 
displays values from the dynamics you input, including dynamic points, combined with 
humanization.

Making dynamic points constant/linear
You can make individual dynamic points input in the Dynamics editor constant or linear. By 
default, dynamic points you input in the Dynamics editor are linear.

NOTE

These steps do not apply to the points of dynamics input in Write mode.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have added the Dynamics editor to the Key Editor.

PROCEDURE

1. In the Dynamics editor, select the dynamic points you want to make constant/linear.

2. Do one of the following:

● To make the selected points constant, click Convert to Constant Point  in the editor 
header.

● To make the selected points linear, click Convert to Linear Point  in the editor header.

RESULT
The selected dynamic points become constant or linear.

Value lines always appear horizontal after constant points. Value lines appear angled after linear 
points if the next point has a different value, indicating a smooth transition between the points.
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EXAMPLE

Constant points in the Dynamics editor Linear points in the Dynamics editor

Moving dynamic points
You can move individual dynamic points, including moving them upwards and downwards to 
change their dynamic level. For example, if you want individual dynamics to take effect slightly 
earlier, or to adjust the volume of specific existing dynamics.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have added the Dynamics editor to the Key Editor.

PROCEDURE

1. In the Dynamics editor, select the dynamic points you want to move.

TIP

To move dynamics input in Write mode rhythmically, you can select only their start point, 
including for gradual dynamics and combined/force dynamics that have multiple points.

2. Move the selected dynamic points in any of the following ways:

● Click and drag them in any direction.

NOTE

● To constrain movement either horizontally or vertically, start dragging, then press 
and hold Shift .

● You can only move dynamics input in Write mode either horizontally or vertically at 
a time.

● To move dynamic points to the right according to the current rhythmic grid resolution, 
press Ctrl/Cmd-Alt/Opt-Right Arrow .

● To move dynamic points to the left according to the current rhythmic grid resolution, 
press Ctrl/Cmd-Alt/Opt-Left Arrow .

RESULT
The selected dynamic points are moved to new positions. Moving them to the right/left affects 
their rhythmic positions. Moving them upwards/downwards affects their dynamic level.
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Moving the end points of gradual dynamics to the right/left lengthens/shortens the 
corresponding gradual dynamics rhythmically. Their notated length is automatically updated in 
all applicable layouts.

NOTE

● Moving dynamic points for linked dynamics affects all linked dynamics.

● You cannot drag dynamics input in Write mode beyond other existing dynamic points during 
the same move. Releasing the mouse causes the moved dynamic points to change the value 
of the existing dynamic point.

RELATED LINKS
Linked dynamics on page 951
Gradual dynamics on page 937
Changing dynamic levels on page 926
Lengthening/Shortening items on page 430

Copying dynamic points to other instruments
When multiple instruments are shown in the Key Editor, you can copy dynamic points from the 
primary instrument to secondary instruments. You can copy only individual points and regions, 
or all points belonging to the primary instrument in the selected flow.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have added the Dynamics editor to the Key Editor.

● Multiple instruments are shown in the Key Editor.

PROCEDURE

1. Optional: If you want to sync individual dynamic points or regions only, click Sync Region 
in the Key Editor panel toolbar to select Sync Region.

2. In the Dynamics editor, do one of the following:

● To copy individual dynamic points or regions, click each dynamic point and region, or 
click and drag across multiple dynamic points and regions.

● To copy all dynamic points in the current flow, click Sync  in the editor header.

RESULT
The corresponding dynamic points are copied from the primary instrument to secondary 
instruments, and become editable for all instruments shown in the Key Editor.

Existing dynamic points in the affected regions belonging to secondary instruments are 
overwritten.

TIP

When multiple instruments are shown in the Key Editor, you can input dynamic points for all 
instruments directly.
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EXAMPLE

Dynamic region in primary instrument only Dynamic region copied to secondary instruments

RELATED LINKS
Adding/Closing editors in the Key Editor on page 675
Showing instruments in the Key Editor on page 671
Selecting items in the Key Editor on page 676
Switching between flows in the track overview on page 521
Copying and pasting points in the Key Editor on page 676

MIDI Pitch Bend editor
The MIDI Pitch Bend editor allows you to view, input, and edit MIDI pitch bend controller data for 
the instruments shown in the Key Editor. It is located in the Key Editor in the lower zone.

● You can show the MIDI Pitch Bend editor by adding an editor to the Key Editor, then 
selecting MIDI Pitch Bend from the editor menu.

The MIDI Pitch Bend editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Sync : Copies all points in the editor from the primary instrument to secondary 
instruments. Only available when multiple instruments are shown in the Key Editor.

● Convert to Constant Point : Makes the selected points constant. Only applies to 
points in regions.

● Convert to Linear Point : Makes the selected points linear. Only applies to points in 
regions.

● Value field: Displays the value of the earliest selected MIDI point. You can change this 
value in the value field, or click and drag the point upwards/downwards in the editor. 
The available range for MIDI pitch bend is -100% to +100%.

2 Splitter
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Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 Value read-out

Displays the value of the current mouse pointer position in the editor.

4 MIDI point

A single change to the MIDI pitch, input using the Draw tool. Individual MIDI points are 
constant by default. Only points that are identical for all instruments shown in the Key Editor 
are editable.

5 MIDI region

A highlighted region that contains multiple points, input by clicking and dragging in a single 
motion with either the Draw tool or Line tool.

By default, MIDI points in regions are linear, and the last point is constant. Only points that 
are identical for all instruments shown in the Key Editor are editable.

6 MIDI value line

When multiple instruments are shown in the Key Editor, a value line is shown for each 
instrument, using its color.

MIDI CC editor
The MIDI CC editor allows you to view, input, and edit data in any MIDI controller for the 
instruments shown in the Key Editor. It is located in the Key Editor in the lower zone.

● You can show the MIDI CC editor by adding an editor to the Key Editor, then selecting a MIDI 
controller from the editor menu.

TIP

● You can add multiple MIDI CC editors to the Key Editor simultaneously; for example, to copy 
MIDI points between two MIDI controllers.

● Dorico Elements displays generated values as non-editable value lines. For sound libraries 
that use MIDI CC 1 to control dynamics, the MIDI CC editor for CC 1 displays values from the 
dynamics you input, including dynamic points, combined with humanization.

The MIDI CC editor comprises the following:

1 Editor header

Contains the following options:

● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Histogram : Shows the Histogram tool in the editor.

● Sync : Copies all points in the editor from the primary instrument to secondary 
instruments. Only available when multiple instruments are shown in the Key Editor.
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● Convert to Constant Point : Makes the selected points constant. Only applies to 
points in regions.

● Convert to Linear Point : Makes the selected points linear. Only applies to points in 
regions.

● Value field: Displays the value of the earliest selected MIDI point. You can change this 
value in the value field, or click and drag the point upwards/downwards in the editor. 
The available range for MIDI CC is 0 to 127.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 Value read-out

Displays the value of the current mouse pointer position in the editor.

4 MIDI point

A single change to the MIDI value, input using the Draw tool. Individual MIDI points are 
constant by default. Only points that are identical for all instruments shown in the Key Editor 
are editable.

5 MIDI region

A highlighted region that contains multiple points, input by clicking and dragging in a single 
motion with either the Draw tool or Line tool.

By default, MIDI points in regions are linear, and the last point is constant. Only points that 
are identical for all instruments shown in the Key Editor are editable.

6 MIDI value line

When multiple instruments are shown in the Key Editor, a value line is shown for each 
instrument, using its color.

TIP

● Clicking and dragging MIDI points causes a read-out to appear temporarily, showing their 
value.

● You can use the Histogram and Transform tools to change MIDI CC values.

● MIDI CC data is included when exporting MIDI files.

RELATED LINKS
Key Editor panel on page 667
Histogram tool on page 710
Transform tool on page 713
Adding/Closing editors in the Key Editor on page 675
Showing instruments in the Key Editor on page 671
MIDI Pitch Bend editor on page 700
Copying and pasting points in the Key Editor on page 676
Exporting MIDI on page 95
Dynamics on page 921
Dynamics editor on page 694
Playback Options for dynamics on page 954
Pedal lines in playback on page 1178
Dynamics in playback on page 953
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Inputting MIDI points
You can input MIDI CC points into any MIDI controller, including pitch bend, in the MIDI CC and 
MIDI Pitch Bend editors.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have added at least one MIDI CC or MIDI Pitch Bend editor to the Key Editor.

PROCEDURE

1. Select one of the following tools, depending on the MIDI points you want to input:

● To input single MIDI points, or MIDI regions containing multiple points at regular 
intervals, select Draw by pressing Shift-Alt/Opt-2  or clicking Draw  in the Key Editor 
panel toolbar.

● To input smooth MIDI regions, select Line by clicking Line  in the Key Editor panel 
toolbar.

2. Input MIDI points in one of the following ways:

● To input single MIDI points, click in the MIDI CC or MIDI Pitch Bend editor at each 
position where you want a MIDI point.

● To input a MIDI region containing multiple MIDI points at regular intervals, click and 
drag in a single motion in the MIDI CC or MIDI Pitch Bend editor.

● To input smooth MIDI regions, click and drag in the MIDI CC or MIDI Pitch Bend editor 
from where you want the region to start to where you want it to end.

TIP

The horizontal line in the middle of the MIDI Pitch Bend editor represents the unmodified 
pitch.

RESULT
MIDI points are input for all instruments shown in the Key Editor.

● If you used the Draw tool, separate MIDI points are input at each position you clicked.

● If you clicked and dragged in a single motion using the Draw tool, MIDI points are input at 
small intervals in a MIDI region.

● If you used the Line tool, two MIDI points are input in a MIDI region, one at each end of the 
dragged range.

By default, single MIDI points are constant, MIDI points in regions are linear, and the last MIDI 
point in regions is constant.

MIDI regions appear highlighted with colored backgrounds in the MIDI CC and MIDI Pitch Bend 
editors.

Key Editor
MIDI CC editor 

703
Dorico Elements 5.1.30



Making MIDI points constant/linear
You can make selected MIDI points in regions constant or linear after they have been input; for 
example, if you want some points in a region to be constant.

By default, MIDI points are constant when you input them separately, and linear when you click 
and drag them as a region. The last MIDI point in a region is constant.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have added at least one MIDI CC or MIDI Pitch Bend editor to the Key Editor.

PROCEDURE

1. In the MIDI CC or Pitch Bend editor, select the MIDI points in regions you want to make 
constant/linear.

2. Do one of the following:

● To make the selected points constant, click Convert to Constant Point  in the editor 
header.

● To make the selected points linear, click Convert to Linear Point  in the editor header.

RESULT
The selected MIDI points become constant or linear.

Value lines always appear horizontal after constant points. Value lines appear angled after linear 
points if the next point has a different value, indicating a smooth transition between the points.

EXAMPLE

Constant points in the MIDI CC editor Linear points in the MIDI CC editor

Moving MIDI points
You can move individual MIDI points in the MIDI CC and MIDI Pitch Bend editors, including 
moving them upwards and downwards to change their values.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.
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● You have selected the instruments that you want to show in the Key Editor.

● You have added at least one MIDI CC or MIDI Pitch Bend editor to the Key Editor.

PROCEDURE

1. In the MIDI CC or Pitch Bend editor, select the MIDI points you want to move.

NOTE

You can only move MIDI points in a single editor at a time.

2. Move the selected MIDI points in any of the following ways:

● Click and drag them in any direction.

● To move them upwards/downwards only, hold Shift  while dragging them upwards/
downwards.

● To move them to the right/left only, hold Shift  while dragging them to the right/left.

TIP

You can also move MIDI points according to the current rhythmic grid resolution, as 
indicated in the status bar, by pressing Alt/Opt-Right Arrow / Alt/Opt-Left Arrow .

Copying MIDI points to other instruments
When multiple instruments are shown in the Key Editor, you can copy MIDI points from the 
primary instrument to secondary instruments. You can copy only individual points and regions, 
or all points belonging to the primary instrument in the selected flow.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have added at least one MIDI CC or MIDI Pitch Bend editor to the Key Editor.

● Multiple instruments are shown in the Key Editor.

PROCEDURE

1. Optional: If you want to sync individual MIDI points or regions only, click Sync Region  in 
the Key Editor panel toolbar to select Sync Region.

2. In the MIDI CC or MIDI Pitch Bend editor, do one of the following:

● To copy individual MIDI points or regions, click each MIDI point and region, or click and 
drag across multiple MIDI points and regions.

● To copy all MIDI points in the current flow, click Sync  in the editor header.

RESULT
The corresponding MIDI points are copied from the primary instrument to secondary 
instruments, and become editable for all instruments shown in the Key Editor.

Existing MIDI points in the affected regions belonging to secondary instruments are overwritten.
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TIP

When multiple instruments are shown in the Key Editor, you can input MIDI points for all 
instruments directly.

EXAMPLE

MIDI region in primary instrument only MIDI region copied to secondary instruments

RELATED LINKS
Adding/Closing editors in the Key Editor on page 675
Showing instruments in the Key Editor on page 671
Selecting items in the Key Editor on page 676
Copying and pasting points in the Key Editor on page 676

Tempo editor
The Tempo editor allows you to view, input, and edit tempo changes. It displays both tempo 
marks input in Write mode and tempo changes input in the Tempo editor. It is located in the Key 
Editor in the lower zone.

You can show the Tempo editor in any of the following ways:

● Add an editor to the Key Editor, then select Tempo from the editor menu.

● When the Key Editor is unlocked, select either a tempo mark or the Tempo track in Play 
mode.

NOTE

This shows the Tempo editor as the primary editor. To return to showing the piano roll/
percussion editor and/or other editors in the Key Editor, you must select a note/item 
belonging to an instrument in the music area.

The Tempo editor comprises the following:

1 Editor header

Contains the following options:
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● Editor menu: Allows you to change the MIDI controller or editor type shown in the 
editor. MIDI controllers into which you have already input points appear in the first 
menu level.

● Range max. value field: Allows you to set the maximum metronome mark value in the 
editor.

● Tempo value field: Displays the metronome mark value of the earliest selected tempo 
point, without decimal places. You can change this value in the value field, or click and 
drag the point upwards/downwards in the editor.

2 Splitter

Allows you to change the height of the editor by clicking and dragging. If multiple editors are 
open, this affects the height of the editors either side of the splitter.

3 Value read-out

Displays the value of the current mouse pointer position in the editor.

4 Tempo point

An immediate change in tempo, input either in Write mode or using the Draw tool in the 
Tempo editor. Absolute tempo changes comprise a single constant point.

TIP

● Clicking and dragging in the Tempo editor causes a read-out to appear temporarily, 
showing the metronome mark value of the mouse pointer position.

● Tempo points input in the Tempo editor appear as signposts in the music. Signposts are 
not printed by default, so if you want tempo points to appear in layouts as tempo marks, 
we recommend that you show them.

● All tempo points input in the Tempo editor are included when exporting MIDI files.

5 Tempo mark text

Shows the text of tempo marks input in Write mode; that is, tempo points that correspond to 
notation items.

6 Tempo region

A highlighted region with a linear point at the start and a constant point at the end, input by 
clicking and dragging in a single motion in the Tempo editor with the Line tool.

Tempo regions can also represent gradual tempo changes input in Write mode, such as 
rallentando.

RELATED LINKS
Key Editor panel on page 667
Tempo track on page 532
Adding/Closing editors in the Key Editor on page 675
Showing instruments in the Key Editor on page 671
Tempo marks on page 1335
Hiding/Showing tempo marks on page 1340
Input methods for tempo marks on page 293
Signposts on page 450
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Inputting tempo changes in the Tempo editor
You can input single tempo changes and tempo regions in the Tempo editor. Tempo changes 
input in the Tempo editor do not appear in layouts, but instead are shown as signposts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have added the Tempo editor to the Key Editor.

PROCEDURE

1. Select one of the following tools, depending on the type of tempo change you want to input:

● To input single absolute tempo changes, or multiple absolute tempo changes at regular 
intervals, select Draw by pressing Shift-Alt/Opt-2  or clicking Draw  in the Key Editor 
panel toolbar.

● To input tempo regions, select Line by clicking Line  in the Key Editor panel toolbar.

2. Input tempo changes in one of the following ways:

● To input single absolute tempo changes, click in the Tempo editor at each position 
where you want a tempo change.

● To input multiple absolute tempo changes at regular intervals, click and drag in the 
Tempo editor.

● To input tempo regions, click and drag in the Tempo editor from where you want the 
region to start, to where you want it to end.

TIP

Clicking and dragging in the Tempo editor causes a read-out to appear temporarily, showing 
the metronome mark value of the mouse pointer position.

RESULT

● If you used the Draw tool and clicked multiple times, separate tempo changes are input at 
each position you clicked.

● If you clicked and dragged in a single motion using the Draw tool, tempo changes are input 
at 32nd note intervals.

● If you used the Line tool, two tempo changes are input in a tempo region, one at each end 
of the dragged range.

This affects the speed of playback, but the tempo changes are not shown in layouts. Instead, 
they appear as signposts.

Tempo changes input in the Tempo editor are included when exporting MIDI files.

RELATED LINKS
Key Editor panel toolbar on page 669
Signposts on page 450
Hiding/Showing tempo marks on page 1340
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Moving tempo changes in the Tempo editor
You can move tempo changes to new rhythmic positions in the Tempo editor. This affects their 
rhythmic position in all applicable layouts.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have added the Tempo editor to the Key Editor.

PROCEDURE

1. In the Tempo editor, select the tempo changes you want to move.

2. To move the selected tempo changes without changing their metronome mark value, hold 
Shift  while dragging them to the right/left.

NOTE

You cannot drag tempo regions and single tempo changes input in Write mode beyond 
other existing tempo changes during the same move. Releasing the mouse causes the 
moved tempo change to change the value of the existing tempo change.

RESULT
The selected tempo changes are moved rhythmically. When you move multiple selected absolute 
tempo changes, they maintain their positions relative to each other. This also affects their 
rhythmic positions in any layouts in which they appear.

AFTER COMPLETING THIS TASK
You can also move tempo changes vertically, which changes their metronome mark value.

Changing the tempo in the Tempo editor
You can change the metronome mark value of individual tempo changes in the Tempo editor, 
expressed in beats per minute.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● Select  is selected in the Key Editor panel toolbar.

● You have added the Tempo editor to the Key Editor.

PROCEDURE

1. In the Tempo editor, select the tempo changes whose metronome mark values you want to 
change.

2. To change the metronome mark values of the selected tempo changes without moving them 
rhythmically, hold Shift  while dragging them upwards/downwards.

Clicking and dragging in the Tempo editor causes a read-out to appear temporarily, showing 
the metronome mark value of the mouse pointer position.
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RESULT
The metronome mark values of the selected tempo changes are changed proportionally. This 
affects the speed of playback, and the displayed metronome mark of any tempo changes also 
shown in layouts.

TIP

You can also change the metronome mark value of selected tempo changes using the Tempo 
value field in the Tempo editor header.

RELATED LINKS
Selecting items in the Key Editor on page 676

Histogram tool
The Histogram tool displays velocity and MIDI CC values as a chart, with values grouped 
according to their frequency distribution. It allows you to change values on a large scale, 
including across entire tracks; for example, increasing all velocity values proportionally.

● You can show the Histogram tool in the Velocity and MIDI CC editors by clicking Histogram 
 in the corresponding editor header.

1 Chart shape

Allows you to change the shape of the Histogram chart.

● Bars : Values are displayed as bars.

● Area : Values are displayed as an area.

2 Histogram filter

Allows you to filter the values shown in the Histogram tool.

● All/All notes: Shows all values for all instruments currently shown in the Key Editor.

● Voice: Shows only notes in the selected voice. Only available in the Velocity editor.

● Selection: Shows only values for selected items.

3 Histogram chart

Shows values according to the selected filter. The X axis represents numerical values, while 
the Y axis represents the frequency distribution of the corresponding values.

4 Histogram controls

Allow you to change the values currently in view.

5 Reset

Resets all values currently in view.
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TIP

If you want to change values on a smaller scale, you can use the Transform tool.

RELATED LINKS
Key Editor panel on page 667
Hiding/Showing zones on page 44
Adding/Closing editors in the Key Editor on page 675
Showing instruments in the Key Editor on page 671
Changing the velocity of notes on page 692
Voices on page 1438
Inputting notes into multiple voices on page 232
Changing the voice of existing notes on page 466
Transform tool on page 713
Velocity editor on page 691
MIDI CC editor on page 701

Histogram controls
Histogram controls allow you to change velocity and MIDI CC values on a large scale, in different 
ways.

● You can access Histogram controls when the Histogram tool is shown in the Key Editor.

Delta

Represents the center point of values. Allows you to move all displayed values to the 
right/left. This maintains explicit gaps between values.

Scale

Proportionally scales values. This maintains proportional relationships between values; 
that is, gaps between values widen when you scale multiply to the right, and narrow 
when you scale multiply to the left.

Spread

Spreads out values to both the right and left of the center point.

Lower Limit

Represents the lowest value. Allows you to raise low values.

Upper Limit

Represents the highest value. Allows you to lower high values.

Randomize
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Allows you to randomize values by clicking on the button and dragging upwards/
downwards. The higher your mouse pointer, the wider and more extreme the 
randomization. Randomization uses standard distribution on an approximate bell-
shape.

Changing values using the Histogram tool
You can use the Histogram tool to change velocity and MIDI CC values on a large scale, including 
across entire tracks; for example, increasing all velocity values proportionally.

TIP

If you want to change values on a smaller scale, you can use the Transform tool.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have added at least one Velocity or MIDI CC editor to the Key Editor.

PROCEDURE

1. In the header of each editor in which you want to use the Histogram tool, activate 
Histogram  to show the Histogram tool.

2. Optional: Choose the appropriate Histogram tool filter for each editor.

3. Use the available Histogram controls as required.

For example, you can click and drag Scale  to the right to increase the values currently in 
view proportionally.

Changing the Histogram tool filter
You can change the values shown in, and therefore affected by, the Histogram tool using the 
available filters. For example, if you only want the Histogram tool to affect values you have 
already selected.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have added at least one Velocity or MIDI CC editor to the Key Editor.

PROCEDURE

1. In the header of each editor in which you want to use the Histogram tool, activate 
Histogram  to show the Histogram tool.

2. At the top of each Histogram tool, choose one of the following filters:

● All (MIDI CC editor) or All notes (Velocity editor)

● Voice (Velocity editor only)

● Selection
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Changing the Histogram chart shape
You can switch between showing values in the Histogram tool as bars or as an area.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have added at least one Velocity or MIDI CC editor to the Key Editor.

PROCEDURE

1. In the header of each editor in which you want to use the Histogram tool, activate 
Histogram  to show the Histogram tool.

2. At the top of each Histogram tool, choose one of the following chart shapes:

● Bars 

● Area 

RESULT
The shape of the Histogram chart in each editor is changed.

EXAMPLE

Bars Area

RELATED LINKS
Hiding/Showing zones on page 44
Adding/Closing editors in the Key Editor on page 675
Showing instruments in the Key Editor on page 671

Transform tool
The Transform tool allows you to change consecutive velocity and MIDI CC values within 
a selected range in a variety of ways. For example, you can increase all velocity values 
proportionally, but only in two specific bars.

● You can use the Transform tool in the Velocity and MIDI CC editors by clicking Transform 
in the Key Editor panel toolbar, then clicking and dragging in one of those editors to make a 
Transform selection.
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Transform selection in the Velocity editor

TIP

If you want to change values on a larger scale, you can use the Histogram tool.

RELATED LINKS
Key Editor panel on page 667
Key Editor panel toolbar on page 669
Histogram tool on page 710
Velocity editor on page 691
MIDI CC editor on page 701

Transform controls
Transform controls allow you to change consecutive velocity and MIDI CC values within a 
Transform selection in different ways.

● You can access Transform controls when you have made a Transform selection in the Key 
Editor.

Tilt Left

Allows you to lower values according to an angled line by clicking on the button and 
dragging downwards. This lowers values on the left more than on the right.

Tilt Right

Allows you to lower values according to an angled line by clicking on the button and 
dragging downwards. This lowers values on the right more than on the left.

Delta

Represents the center point of values. Allows you to move all displayed values to 
upwards/downwards. This maintains explicit value gaps between bars.

Scale

Proportionally moves values upwards/downwards. This maintains proportional 
relationships between bars; that is, gaps between bars widen when you scale multiply 
upwards and narrow when you scale multiply downwards.

Randomize

Allows you to randomize values by clicking on the button and dragging upwards. 
The higher your mouse pointer, the wider and more extreme the randomization. 
Randomization uses standard distribution on an approximate bell-shape.

Key Editor
Transform tool 

714
Dorico Elements 5.1.30



RELATED LINKS
Histogram controls on page 711
Changing the velocity of notes on page 692

Changing values using the Transform tool
You can make Transform selections around consecutive velocity and MIDI CC values, then use 
Transform controls to change the selected values in a variety of ways; for example, increasing all 
values proportionally.

TIP

If you want to change values on a larger scale, you can use the Histogram tool.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have selected the instruments that you want to show in the Key Editor.

● You have added at least one Velocity or MIDI CC editor to the Key Editor.

PROCEDURE

1. In the Key Editor panel toolbar, click Transform  to select the Transform tool.

2. In the editor in which you want to change values, click and drag across the required range.

3. Use the available Transform controls as required.

For example, you can click and drag Scale  upwards to increase values proportionally.

RELATED LINKS
Hiding/Showing zones on page 44
Key Editor panel toolbar on page 669
Adding/Closing editors in the Key Editor on page 675
Showing instruments in the Key Editor on page 671

Key Editor configurations
Key Editor configurations allow you to open specific combinations of editors simultaneously. This 
can be much quicker than adding/closing the required editors manually.

For example, if you regularly switch between showing the Velocity and Dynamics editors, and 
several MIDI CC editors, you can save Key Editor configurations for these combinations, then 
apply each configuration as required.

Saving Key Editor configurations
You can save configurations of editors in the Key Editor; for example, if you regularly use the 
Velocity and Dynamics editors together. You can access Key Editor configurations in all projects 
on your computer.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.
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● You have added the editors you want to save in your Key Editor configuration.

PROCEDURE

1. Save the editors currently open in the Key Editor as a Key Editor configuration in one of the 
following ways:

● To save a new Key Editor configuration, click Presets  at the bottom left of the Key 
Editor, then choose Save Configuration.

● To replace an existing Key Editor configuration, click Presets  at the bottom left of the 
Key Editor, choose Replace Configuration, then select the configuration you want to 
replace.

2. If you saved a new Key Editor configuration, enter a name for the configuration in the 
Configuration Name dialog that opens.

3. Click OK to save your changes and close the dialog.

RELATED LINKS
Hiding/Showing zones on page 44
Adding/Closing editors in the Key Editor on page 675

Applying Key Editor configurations
You can apply Key Editor configurations to projects, which adds the editors saved in that 
configuration to the Key Editor and replaces any editors that were already open.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

● You have saved at least one Key Editor configuration on your computer.

PROCEDURE

1. At the bottom left of the Key Editor, click Presets .

2. Select the configuration you want to apply.

Deleting Key Editor configurations
You can delete Key Editor configurations; for example, if you no longer require a specific 
configuration after finishing a project.

PREREQUISITE

● The lower zone is shown.

● Key Editor  is selected in the lower zone toolbar.

PROCEDURE

1. At the bottom left of the Key Editor, click Presets .

2. Choose Delete Configuration.

3. Select the configuration you want to delete.
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Mixer

The Mixer allows you to control the volume, panning, and sounds of channels in playback.

You can access the Mixer in the following places:

● In the Mixer panel in the lower zone

● In the Mixer window

RELATED LINKS
Mixer window on page 718
Zones and panels on page 37
Stage templates on page 730
Space templates on page 738

Mixer panel
The Mixer panel allows you to control the volume and panning of channels in playback. When the 
Mixer panel is sufficiently tall, it also provides access to channel strips. It is located in the lower 
zone at the bottom of the window in Write, Engrave, and Play modes.

● You can show the Mixer panel by showing the lower zone, then clicking Mixer  in the lower 
zone toolbar.

The Mixer panel comprises the following:

1 Mixer toolbar

Contains tools that allow you to edit the mix, and to hide/show and add/remove channels.

2 Channel strips

Allow you to change the sound of the channel; for example, by loading inserts or changing 
its equalization.

3 Channels

Allow you to change the volume and pan position of the corresponding track or aspect of 
playback. There are audio and MIDI channels for each instrument/voice track, and additional 
channels, such as for the click and master output.

717
Dorico Elements 5.1.30



When additional channels are available beyond those currently in view, channels at the right/
left edges of the Mixer appear faded.

Any changes you make in the Mixer are automatically saved and applied to the project.

TIP

In order to control the volume levels in your project, we recommend that you first input 
dynamics and adjust the dynamic curve to suit your project before using the track faders.

RELATED LINKS
Mixer toolbar on page 719
Mixer channels on page 720
Zones and panels on page 37
Hiding/Showing zones on page 44
Playback Options for dynamics on page 954
Input methods for dynamics on page 309

Mixer window
The Mixer window allows you to control the volume and panning of channels in playback. It also 
provides permanent access to channel strips.

You can hide/show the Mixer window in any of the following ways:

● Press F3 .

● In the toolbar, click Show Mixer .

The Mixer window comprises the following:

1 Mixer toolbar

Contains tools that allow you to edit the mix, and to hide/show and add/remove channels.

2 Channel strips

Allow you to change the sound of the channel; for example, by loading inserts or changing 
its equalization.

3 Channels
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Allow you to change the volume and pan position of the corresponding track or aspect of 
playback. There are audio and MIDI channels for each instrument/voice track, and additional 
channels, such as for the click and master output.

When additional channels are available beyond those currently in view, channels at the right/
left edges of the Mixer appear faded.

Any changes you make in the Mixer are automatically saved and applied to the project.

TIP

In order to control the volume levels in your project, we recommend that you first input 
dynamics and adjust the dynamic curve to suit your project before using the track faders.

RELATED LINKS
Toolbar on page 30
Mixer toolbar on page 719
Mixer channel strips on page 722
Muting/Soloing tracks on page 547
Changing the volume of channels on page 725
Playback Options for dynamics on page 954
Input methods for dynamics on page 309

Hiding/Showing the Mixer window
You can hide and show the Mixer window at any time; for example, if you do not want it in view 
when working on the music in the music area.

PROCEDURE

● Hide/Show the Mixer window in any of the following ways:

● Press F3 .

● In the toolbar, click Show Mixer .

● Choose Window > Mixer.

Mixer toolbar
The Mixer toolbar contains tools that allow you to edit the mix, and to hide/show and add/
remove channels. It is located at the top of the Mixer, both in the lower zone and in the Mixer 
window.

Channel type buttons
Allow you to hide/show channels according to their type, and in any combination.

Deactivate all
Allows you to deactivate all mute  and solo  states by clicking the corresponding 
button. Indicates whether any channels have an active mute or solo state.

Add Effects Channel

Adds an FX channel.
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Remove Effects Channel

Removes the FX channel furthest to the right in the Mixer.

Live Stage

Opens the Live Stage dialog.

Live Space

Opens the Live Space dialog.

Resize Lower Zone

Allows you to change the height of the lower zone. Only available in the Mixer panel.

RELATED LINKS
Live Stage dialog on page 732
Live Space dialog on page 739
Stage templates on page 730
Space templates on page 738

Mixer channels
Mixer channels allow the sources connected to them, such as instrument tracks, to produce 
sound. You can access all channels in the Mixer panel and Mixer window, and individual channels 
in the Track Inspector for the corresponding track.

Each channel in the Mixer panel provides the following controls and displays:

1 Pan control

Allows you to position the sound/MIDI output of the channel on the stereo spectrum for 
stereo playback.
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2 Fader value

Displays the current volume as a value, corresponding to the position of the fader. Allows 
you to enter the volume level directly.

● Audio channels use dB.

● MIDI channels use MIDI volume, from 0 to 127.

3 Fader

Allows you to control the volume level of the channel.

4 Channel meter

Indicates the output volume of the channel in real time.

5 Mute

Allows you to mute the channel. Indicates whether the channel has an active mute state.

6 Solo

Allows you to solo the channel. Indicates whether the channel has an active solo state.

7 Channel name

Displays the name of the channel.

Instrument channels display the full instrument name set for that instrument in the Edit 
Instrument Names dialog and its instrument number, if applicable.

RELATED LINKS
Track Inspector on page 522
Edit Instrument Names dialog on page 184
Instrument numbering on page 131
Renaming channels on page 728

Types of Mixer channels
There are different types of channels available in the Mixer. The channel type can affect the 
controls available for the corresponding channel.

Instruments
There is a channel for each instrument/voice track in your project. When instrument 
channels are shown, all applicable channels are included, even if they are spread 
across multiple plug-in instances.

There is an additional instrument channel named “DoricoBeep”, which allows you to 
control the volume of the metronome click.

MIDI
Every VST instrument in your project has its own MIDI channel in addition to its VST 
channel. These MIDI channels allow you to change the MIDI volume and MIDI pan of 
each instrument.

Video
Allows you to control the volume of video audio.

FX
Allows you to control the volume of send effects, such as reverb. By default, the Mixer 
contains a single FX channel named “Reverb”, which has REVerence  loaded as an 
insert.

FX channels have green backgrounds.
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TIP

For more information about REVerence , see the separate document Plug-in 
Reference.

Output
Allows you to control the master output volume. The Output channel is always shown 
and has a red background.

RELATED LINKS
Renaming channels on page 728
Adding FX channels on page 727
Loading inserts into channels on page 728

Mixer channel strips
Each channel in the Mixer has its own channel strip, which contains the channel controls. 
Channel strips are located at the top of the Mixer window permanently, and at the top of the 
Mixer panel when it is sufficiently tall.

Each channel strip contains the following types of controls:

Inserts

Each channel has four slots into which you can load an insert. You can select inserts 
from the menu.

The header allows you to expand/collapse the section for all channels.

The indicator can have one of the following states:

● Disabled : No inserts are loaded into the channel.

● Enabled : At least one insert is loaded into the channel, and inserts are enabled.

● Bypassed : At least one insert is loaded into the channel, and all inserts are 
bypassed.

The following controls are available for slots with loaded inserts:

● Enable Insert : Enables/Bypasses the insert slot.

● Edit Insert : Opens the plug-in window for the loaded plug-in, which allows you 
to edit its settings.

● Insert menu : Opens the plug-in menu, which allows you to select a different 
plug-in to load into the insert slot.

TIP

● For more information about the plug-ins included with Dorico Elements, see the 
separate document Plug-in Reference.
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● You can access inserts for individual channels in the Track Inspector for the 
corresponding track.

EQ

Each channel has four bands for default EQ.

The indicator allows you to enable  and disable  the section. The header allows you 
to expand/collapse the section for all channels.

The following controls are available for each EQ band:

● Enable EQ : Enables/Bypasses the corresponding band.

● Gain: Sets the amount of attenuation/boost for the corresponding band in dB.

● Frequency: Sets the frequency of the corresponding band in Hz.

● Q: Controls the width of the band; that is, how many frequencies above/below it 
also affects, and by how much.

Sends

Each channel has a send slot for each FX channel.

The header allows you to expand/collapse the section for all channels.

The following controls are available for each send slot:

● Enable Send : Enables/Bypasses the corresponding send slot.

● Gain slider: Sets the amount of sound sent post-fader to the corresponding FX 
channel.

TIP

You can use stage and space templates to set the send gain for all instruments in the 
project automatically.

RELATED LINKS
Loading inserts into channels on page 728
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Track Inspector on page 522
Stage templates on page 730
Space templates on page 738

Hiding/Showing channels
You can hide/show channels in the Mixer according to their type; for example, you can hide MIDI 
channels while working on instrument channels.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer toolbar, activate/deactivate each channel type.

RESULT
Channels are shown in the Mixer when their type button is activated, and hidden when it is 
deactivated.

Scrolling through channels
When many channels are shown in the Mixer, you can scroll through them in order to view 
channels that do not fit in the view.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer, scroll through channels in any of the following ways:

● Scroll upwards/downwards on a mouse wheel, or swipe upwards/downwards on a 
touchpad.

● Click and drag, anywhere outside of channel faders, to the right/left.

Changing the height of channels
You can change the vertical space occupied by channels and channel strips in the Mixer; for 
example, to make channel strips taller when loading inserts or changing EQ settings.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer, on the line between channel strips and channels, click and drag upwards/
downwards.

When the mouse pointer is in the correct position, it appears as a split arrow.
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RELATED LINKS
Mixer panel on page 717
Hiding/Showing zones on page 44
Mixer window on page 718
Hiding/Showing the Mixer window on page 719
Mixer channels on page 720
Mixer channel strips on page 722

Changing the volume of channels
You can change and reset the volume of individual channels in the Mixer; for example, to balance 
instruments in an orchestral project.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer, change the volume of channels in any of the following ways:

● To increase their volume, drag their faders upwards.

● To decrease their volume, drag their faders downwards.

● Alt/Opt -click the fader value, enter a new value, then press Return .

TIP

● To set output channels to their maximum value, enter inf.

● To set output channels to their minimum value, enter -inf or -oo.

● To reset their volume to the default value, Ctrl/Cmd -click or double-click their fader 
values.
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● To reset the volume of all channels, choose Play > Apply Default Output Level.

RESULT
The volume of the corresponding channels is changed.

TIP

You can change the default output level for all future projects on the Play page in Preferences. 
By default, this is set to -6 dB to avoid clipping in projects with large ensembles.

RELATED LINKS
Mixer panel on page 717
Mixer window on page 718
Preferences dialog on page 58

Panning channels
You can change the pan position of individual channels on the stereo spectrum; for example, if 
you want the pan positions of instruments in an orchestral project to match their positions on a 
real-life stage.

TIP

You can use stage templates to set pan positions for all instruments in the project automatically.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer, change the pan position of each channel in any of the following ways:

● In the pan control, click positions directly, or click and drag to the right/left.
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● Alt/Opt -click the pan value, enter a new value, then press Return .

The available pan range is -100 to 100.

RELATED LINKS
Mixer channels on page 720
Stage templates on page 730

Adding FX channels
You can add multiple FX channels to the Mixer; for example, if you want to use a different reverb 
sound for each instrument family.

The Mixer can contain a maximum of eight FX channels.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer toolbar, click Add Effects Channel .

RESULT
A new FX channel is added. It is positioned to the right of all existing FX channels in the Mixer.

AFTER COMPLETING THIS TASK
You can load inserts into the FX channel and change its EQ using its channel strip.

RELATED LINKS
Mixer panel on page 717
Mixer window on page 718
Mixer channels on page 720
Mixer channel strips on page 722
Hiding/Showing channels on page 724
Loading inserts into channels on page 728
Changing the reverb plug-in on page 729

Removing FX channels
You can delete FX channels from the Mixer; for example, if you no longer need multiple reverb 
sounds.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

● In the Mixer toolbar, click Remove Effects Channel .

RESULT
The FX channel furthest to the right in the Mixer is removed.
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Renaming channels
You can rename channels and reset renamed channels to their default name. For example, to 
help you identify different FX channels.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

1. In the Mixer, double-click the channel name you want to change to open the channel name 
text field.

2. Rename the channel in any of the following ways:

● Enter a new channel name, or edit the existing name.

● To reset the channel name, delete the existing name.

3. Press Return .

Loading inserts into channels
You can load up to four inserts into each channel, excluding MIDI channels. For example, you can 
load specific EQ plug-ins instead of using the default EQ channel strips, and apply amp modeling 
plug-ins to clean guitar channels.

TIP

For more information about the plug-ins included with Dorico Elements, see the separate 
document Plug-in Reference.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

1. In the Mixer, click Inserts in any channel strip to expand all inserts sections.

2. Click an insert slot and select the plug-in you want to load from the menu.

3. Optional: If you want to edit settings for the new plug-in, click Edit Insert  to open its 
plug-in window.

4. Optional: If you loaded EQ plug-ins, deactivate the EQ channel strip in the corresponding 
channels.

RELATED LINKS
Mixer panel on page 717
Mixer window on page 718
Mixer channel strips on page 722
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Changing the sound used for the click on page 533

Enabling/Bypassing inserts
You can enable/bypass individual inserts without affecting their settings; for example, if you want 
to compare how a channel sounds with and without a specific insert.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

1. In the Mixer, click Inserts in any channel strip to expand all inserts sections.

2. In each insert slot you want to enable/bypass, do one of the following:

● To enable/bypass individual inserts, click Enable Insert  in the corresponding slots.

● To enable/bypass all inserts for channels, click the Inserts indicator  in the 
corresponding channel strips.

RESULT
The corresponding inserts are enabled/bypassed.

● Enabled inserts appear blue.

● Bypassed inserts appear yellow.

Removing inserts
You can remove individual inserts you have loaded into channels.

PREREQUISITE
The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

1. In the Mixer, click Inserts in any channel strip to expand all inserts sections.

2. In the slot whose insert you want to remove, click the insert menu  and select --- from the 
menu.

Changing the reverb plug-in
You can change the plug-in used for reverb; for example, if you want to use a specific reverb 
sound. By default, the reverb plug-in REVerence  is loaded into the first FX channel.

TIP

For more information about the plug-ins included with Dorico Elements, see the separate 
document Plug-in Reference.

PREREQUISITE

● The Mixer is shown, either in the lower zone or in the Mixer window.

● The FX channel is shown.
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PROCEDURE

1. In the Mixer, click Inserts in any channel strip to expand all inserts sections.

2. In the FX channel strip, click the insert menu  in the REVerence  insert slot, and select the 
reverb plug-in you want to use from the menu.

3. Optional: If you want to edit settings for the new plug-in, click Edit Insert  to open its 
plug-in window.

RELATED LINKS
Mixer window on page 718
Mixer channel strips on page 722
Hiding/Showing channels on page 724
Space templates on page 738

Stage templates
Stage templates allow you to set appropriate stage positions for all instruments in the project 
simultaneously, using the visual representation of a stage as seen from above to make this 
process easier. Stage positions determine the panning and reverb settings for instruments in 
playback.

When you apply stage templates to projects, Dorico Elements changes the panning and reverb 
settings for all channels in the Mixer simultaneously.

To match instruments in the project to stage positions defined in the stage template, Dorico 
Elements performs the following sequence of considerations in order of preference, first for 
instruments in groups, then for ungrouped instruments:

1 Soloist instruments are matched with soloist stage positions for the corresponding 
instrument type, if defined.

2 Numbered instruments are matched with numbered stage positions for the corresponding 
instrument type, if defined.

3 Instruments are matched with unnumbered stage positions for the corresponding 
instrument type, if defined.

4 Instruments are matched with instrument family stage positions for the corresponding 
instrument type, if defined.

5 Instruments without a suitable stage position use the fallback position.

Where possible, Dorico Elements uses groups in stage templates for the corresponding player 
groups in Setup mode.

You can override the stage template applied to the current project in the Live Stage dialog, such 
as by changing the arrangement of some instruments. You can then save your overrides as a 
new stage template.

You can also export custom stage templates; for example, to share them with other users. Stage 
templates are saved as .dorico_stt files.

NOTE

● Stage templates are available in all projects you open or create on your computer. Any 
changes you make to stage templates affect new instruments you add to existing projects 
that use those stage templates.
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● In combination with stage templates, you can use space templates to hear your 
arrangement of instruments in different spaces and with different amounts of reverb.

RELATED LINKS
Space templates on page 738
Playback templates on page 558
Designating players as soloists on page 127
Player groups on page 167
Mixer on page 717

Apply Stage Template dialog
The Apply Stage Template dialog allows you to change the stage template applied to the 
current project and to import/export stage templates. It also allows you to access the Edit Stage 
Template dialog.

● You can open the Apply Stage Template dialog by choosing Play > Stage Template.

The Apply Stage Template dialog comprises the following:

1 Search field

Allows you to filter stage templates in the list according to your entry.

2 Name column

Contains a list of the stage templates available on your computer. You can click the column 
header to change the sorting order.

3 Factory column

Contains the factory symbol if the stage template in the corresponding row is a factory 
default stage template. You can click the column header to change the sorting order.

4 Action bar

Contains the following options:
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● Add Stage Template : Opens the Edit Stage Template dialog and allows you to create 
a new stage template.

● Duplicate Stage Template : Opens the Edit Stage Template dialog and allows you to 
create a new stage template that starts as a duplicate of the selected one.

● Edit Stage Template : Opens the Edit Stage Template dialog and allows you to edit 
the existing selected stage template.

NOTE

You cannot edit factory default stage templates.

● Show Factory : Allows you to hide/show factory default stage templates in the table.

● Export: Opens the File Explorer/macOS Finder, where you can select the location to 
which you want to export the currently selected stage templates as .dorico_stt files. 
You can then import the .dorico_stt files into Dorico Elements on other computers 
and share them with other users.

● Import: Opens the File Explorer/macOS Finder, where you can select the .dorico_stt 
files that you want to import as stage templates.

● Delete : Deletes the selected stage templates.

NOTE

You cannot delete factory default stage templates.

5 Apply and Close

Applies the selected stage template to the project and closes the dialog.

Live Stage dialog
The Live Stage dialog allows you to change the arrangement of instruments in the current 
project, which affects their panning and reverb settings in the Mixer in real time.

● You can open the Live Stage dialog by clicking Live Stage  in the Mixer toolbar.

The Live Stage dialog provides a visual representation of a stage, as seen from above. The back 
of the stage is at the top of the dialog, while the front of the stage is at the bottom of the dialog.
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The horizontal axis determines pan positions, from left to right. The vertical axis determines the 
amount of sound sent to FX channels for reverb; typically, from low reverb at the bottom to more 
reverb at the top.

Each instrument in the project appears as a colored dot, representing its stage position, followed 
by its full instrument name. Each instrument family uses a different color.

You can click and drag instruments to new stage positions.

The action bar at the bottom of the dialog contains the following options:

Save as New Stage Template
Saves the current arrangement of instruments in the Live Stage dialog as a new 
custom stage template, allowing you to use it in future projects.

Expand

Moves instruments proportionally outwards. Applies to either only selected 
instruments, or all instruments when no instruments are selected.

Contract

Moves instruments proportionally inwards. Applies to either only selected instruments, 
or all instruments when no instruments are selected.

NOTE

Instruments do not appear in the Live Stage dialog in any of the following circumstances:

● If their expression/map settings prevent them from using space templates.

● If they use MIDI instruments for playback, rather than VST instruments.

RELATED LINKS
Mixer toolbar on page 719
Expression maps on page 761
Percussion maps on page 780
Playback templates on page 558
VST and MIDI panel on page 525

Edit Stage Template dialog
The Edit Stage Template dialog allows you to create new stage templates and edit existing ones. 
You can define the stage positions of instrument families, individual instruments, and soloists, 
independently of the instruments in the project.

You can open the Edit Stage Template dialog in the following ways:

● In the Live Stage dialog, click Save as New Stage Template.

● In the Apply Stage Template dialog, click Add Stage Template , Duplicate Stage 
Template , or Edit Stage Template .
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The Edit Stage Template dialog comprises the following:

1 Name

Allows you to set the name of the stage template that appears in the program; for example, 
in the Apply Stage Template dialog.

2 Search field

Allows you to filter instruments in the list according to your entry.

3 Instrument list

Contains all the instruments available on your computer and within your search filter, if 
applicable.

4 Show

Allows you to hide/show the names of instrument families and individual instruments, 
independently of each other. Hiding names also disables editing of the corresponding 
category, and their colored dots appear more transparent.

5 Stage

Provides a visual representation of a stage, as seen from above. The back of the stage is at 
the top of the dialog, while the front of the stage is at the bottom of the dialog.

The horizontal axis determines pan positions, from left to right. The vertical axis determines 
the amount of sound sent to FX channels for reverb; typically, from low reverb at the bottom 
to more reverb at the top.

Each instrument and instrument family appears as a colored dot, representing its stage 
position, followed by its full instrument name. Instrument family dots are larger than 
individual instrument dots.

Instrument families are color-coded, meaning instrument families and the instruments 
within them use the same color.

When you add multiple instruments of the same type to a stage template, Dorico Elements 
automatically numbers them.

Parenthesized indications for soloists and groups are automatically added to the ends of 
instrument names.

You can click and drag instruments to new stage positions.

6 Action bar
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Contains the following options:

● Add : Adds the instrument or instrument family currently selected in the instrument 
list to the center of the stage. You can also click and drag instruments from the 
instrument list to specific positions on the stage.

● Un-numbered : Includes/Excludes the selected instrument from instrument 
numbering. Sets the stage position for the corresponding numbered instrument when 
multiple instruments of the same type exist in the same project.

● Soloist : Turns the selected instrument into a soloist. Sets the stage position for 
instruments of the corresponding type that are designated as soloists.

● Create Group : Creates a group containing the instruments selected on the stage.

● Remove From Group : Removes the selected instruments from their corresponding 
group.

● Expand : Moves instruments proportionally outwards. Applies to either only selected 
instruments, or all instruments when no instruments are selected.

● Contract : Moves instruments proportionally inwards. Applies to either only selected 
instruments, or all instruments when no instruments are selected.

● Delete : Deletes the selected instruments from the stage template.

Applying/Resetting stage templates
You can change the stage template applied to the current project; for example, to use a different 
arrangement of instruments for panning and reverb. Re-selecting stage templates resets them to 
their default settings.

PROCEDURE

1. Choose Play > Stage Template to open the Apply Stage Template dialog.

2. Select the stage template that you want to use.

3. Click Apply and Close.

RESULT
The stage template applied to the current project is changed. If you re-selected the stage 
template already in use, the stage template is reset.

TIP

You can change the default stage template used for all future projects on the Play page in 
Preferences.

AFTER COMPLETING THIS TASK
You can change the space template applied to the project; for example, to hear your music with 
the acoustic qualities of a different performance space.

RELATED LINKS
Applying/Resetting space templates on page 742
Preferences dialog on page 58
Changing the default space template on page 744
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Creating stage templates
You can create new stage templates that you can apply to other projects, including specifying 
stage positions for soloists and instrument families.

PREREQUISITE

● You have added the instruments that you want to include in your stage template to the 
current project.

● You have loaded sounds for the instruments in the current project; for example, by applying 
a playback template.

● The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

1. In the Mixer toolbar, click Live Stage  to open the Live Stage dialog.

2. Select the instruments that you want to move to new stage positions.

3. Move the selected instruments in any of the following ways:

● Click and drag them.

● To move them proportionally outwards, click Expand .

● To move them proportionally inwards, click Contract .

TIP

● You can click and hold Expand  and Contract  to move instruments smoothly until 
you release the mouse pointer.

● When no instruments are selected, Expand  and Contract  apply to all instruments 
on the stage.

4. Click Save as New Stage Template to open the Edit Stage Template dialog.

5. Enter a name for the stage template in the Name field.

6. Optional: Edit the stage template using the available options.

● To add an instrument to the stage template, click and drag it from the instrument list to 
the stage.

● To delete instruments from the stage template, select them, then click Delete  in the 
action bar.

● To turn an instrument into a soloist, select it, then click Soloist  in the action bar.

● To include/exclude instruments from instrument numbering, select them, then click 
Un-numbered  in the action bar.

● To add instruments to a new group, select them, then click Create Group  in the 
action bar.

● To remove instruments from groups, select them, then click Remove From Group  in 
the action bar.

7. Click OK to confirm your settings and close the dialog.

RESULT
Your new stage template is created. It is available to use in the current project and all projects 
that you create/open on your computer.
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RELATED LINKS
Mixer toolbar on page 719
Applying/Resetting playback templates on page 564
Adding players on page 124
Adding instruments to players on page 133

Importing stage templates
You can import stage templates into projects; for example, if someone you are working with 
exported their custom stage template for you to use. Stage templates are saved as .dorico_stt 
files.

PROCEDURE

1. Choose Play > Stage Template to open the Apply Stage Template dialog.

2. Click Import to open the File Explorer/macOS Finder.

3. Locate and select the stage template file that you want to import.

4. Click Open.

RESULT
The selected stage template is imported. It becomes available in the current project and all 
projects you create/open on your computer.

TIP

You can also import stage templates by dragging .dorico_stt files into a Dorico Elements 
project window.

Exporting stage templates
You can export stage templates so you can send them to other users or use them on other 
computers. By default, any stage templates that you create are available in all projects on your 
computer.

PROCEDURE

1. Choose Play > Stage Template to open the Apply Stage Template dialog.

2. Select the stage templates that you want to export.

3. Click Export to open the File Explorer/macOS Finder.

4. Specify a name and location for the stage template files.

5. Click Choose.

RESULT
The selected stage templates are exported and saved in the selected location as 
separate .dorico_stt files.
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Space templates
Space templates allow you to define the panning and reverb settings of a space, such as a room 
or concert hall, so that you can hear how your project might sound in the corresponding space.

For example, the factory default space templates add more reverb to instruments positioned at 
the back of the stage to emulate how music sounds when played from a distance.

When you apply space templates to projects, Dorico Elements changes the panning and reverb 
settings for all channels in the Mixer simultaneously.

Space templates are available in all projects that you open or create on your computer. You can 
export custom space templates; for example, to share them with other users.

Space templates are saved as .dorico_spt files.

TIP

In combination with space templates, you can use stage templates to position instruments in 
different arrangements for playback.

RELATED LINKS
Stage templates on page 730
Playback templates on page 558
Mixer on page 717

Apply Space Template dialog
The Apply Space Template dialog allows you to change the space template applied to the 
current project and to import/export space templates. It also allows you to access the Edit Space 
Template dialog.

● You can open the Apply Space Template dialog by choosing Play > Space Template.
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The Apply Playback Template dialog comprises the following:

1 Search field

Allows you to filter space templates in the list according to your entry.

2 Name column

Contains a list of the space templates available on your computer. You can click the column 
header to change the sorting order.

3 Factory column

Contains the factory symbol if the space template in the corresponding row is a factory 
default space template. You can click the column header to change the sorting order.

4 Action bar

Contains the following options:

● Duplicate Space Template : Opens the Edit Space Template dialog and allows you to 
create a new space template that starts as a duplicate of the selected one.

● Edit Space Template : Opens the Edit Space Template dialog and allows you to edit 
the existing selected space template.

NOTE

You cannot edit factory default space templates.

● Show Factory : Allows you to hide/show factory default space templates in the table.

● Export: Opens the File Explorer/macOS Finder, where you can select the location to 
which you want to export the currently selected space templates as .dorico_spt files. 
You can then import the .dorico_spt files into Dorico Elements on other computers 
and share them with other users.

● Import: Opens the File Explorer/macOS Finder, where you can select the .dorico_spt 
files that you want to import as space templates.

● Delete : Deletes the selected space templates.

NOTE

You cannot delete factory default space templates.

5 Apply and Close

Applies the selected space template to the project and closes the dialog.

Live Space dialog
The Live Space dialog allows you to change the maximum pan positions and FX send values for 
instruments in the current project.

● You can open the Live Space dialog by clicking Live Space  in the Mixer toolbar.
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The Live Space dialog contains the following options:

Far Send
Allows you to select the FX channel that you want to use for instruments at the back of 
the stage. The gain slider sets the amount of sound sent post-fader to the selected FX 
channel.

Near Send
Allows you to select the FX channel that you want to use for instruments at the front of 
the stage. The gain slider sets the amount of sound sent post-fader to the selected FX 
channel.

Left Pan
Sets the maximum left pan position.

Right Pan
Sets the maximum right pan position.

Save as New Space Template
Saves the current settings in the Live Space dialog as a new custom space template, 
allowing you to use it in future projects.

Fallback Y Position
Sets the default near/far position for instruments in the project that are not defined in 
the stage template applied to the project.

Click Reverb
Allows you to select the FX channel that you want to use for the metronome click.

NOTE

The send value for the metronome click is fixed at a low value.

RELATED LINKS
Mixer toolbar on page 719
Types of Mixer channels on page 721
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Changing the reverb plug-in on page 729
Adding FX channels on page 727
Live Stage dialog on page 732

Edit Space Template dialog
The Edit Space Template dialog allows you to edit the settings of space templates.

You can open the Edit Space Template dialog in the following ways:

● In the Live Space dialog, click Save as New Space Template.

● In the Apply Space Template dialog, click Duplicate Space Template  or Edit Space 
Template .

The Edit Space Template dialog contains the following options:

Name
Allows you to set the name of the space template that appears in the program; for 
example, in the Apply Space Template dialog.

Far Send
Allows you to select the FX channel that you want to use for instruments at the back of 
the stage. The gain slider sets the amount of sound sent post-fader to the selected FX 
channel.

Near Send
Allows you to select the FX channel that you want to use for instruments at the front of 
the stage. The gain slider sets the amount of sound sent post-fader to the selected FX 
channel.

Left Pan
Sets the maximum left pan position.

Right Pan
Sets the maximum right pan position.
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Fallback Y Position
Sets the default near/far position for instruments in the project that are not defined in 
the stage template applied to the project.

Click Reverb
Allows you to select the FX channel that you want to use for the metronome click.

NOTE

The send value for the metronome click is fixed at a low value.

Applying/Resetting space templates
You can change the space template applied to the current project; for example, to hear your 
music with the acoustic qualities of a different performance space. Re-selecting space templates 
resets them to their default settings.

PROCEDURE

1. Choose Play > Space Template to open the Apply Space Template dialog.

2. Select the space template that you want to use.

3. Click Apply and Close.

RESULT
The space template applied to the current project is changed. If you re-selected the space 
template already in use, the space template is reset.

The panning of the corresponding Mixer channels and the amount of channel output sent to the 
selected FX channel are changed.

Any required inserts on FX channels are loaded, provided the plug-ins are installed on your 
computer.

AFTER COMPLETING THIS TASK
You can change the stage template applied to the project; for example, to try a different 
arrangement of instruments.

RELATED LINKS
Mixer channels on page 720
Panning channels on page 726
Applying/Resetting stage templates on page 735

Creating space templates
You can create new space templates that you can apply to other projects.

PREREQUISITE

● You have added the FX channels that you want to use for reverb, and loaded the required 
plug-ins into them.

● The Mixer is shown, either in the lower zone or in the Mixer window.

PROCEDURE

1. In the Mixer toolbar, click Live Space  to open the Live Space dialog.
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2. From the Far Send menu, select the FX channel that you want to use for reverb for 
instruments positioned at the back of the stage.

3. From the Near Send menu, select the FX channel that you want to use for reverb for 
instruments positioned at the front of the stage.

4. To change the amount of sound sent to the Far Send and Near Send FX channels, click and 
drag the corresponding gain slider.

5. To change the maximum pan positions, click and drag the Left Pan and Right Pan gain 
sliders.

6. To change the default near/far position for instruments not defined in the stage template, 
change the value for Fallback Y Position.

7. From the Click Reverb menu, select the FX channel that you want to use for the metronome 
click.

8. Click Save as New Space Template to open the Edit Space Template dialog.

9. Enter a name for the space template in the Name field.

10. Click OK to confirm your settings and close the dialog.

RESULT
Your new space template is created. It is available to use in the current project and all projects 
that you create/open on your computer.

RELATED LINKS
Mixer toolbar on page 719
Adding FX channels on page 727
Loading inserts into channels on page 728
Changing the reverb plug-in on page 729

Importing space templates
You can import space templates into projects; for example, if someone you are working 
with exported their custom space template for you to use. Space templates are saved 
as .dorico_spt files.

PROCEDURE

1. Choose Play > Space Template to open the Apply Space Template dialog.

2. Click Import to open the File Explorer/macOS Finder.

3. Locate and select the space template file that you want to import.

4. Click Open.

RESULT
The selected space template is imported. It becomes available in the current project and all 
projects that you create/open on your computer.

TIP

● You can also import space templates by dragging .dorico_spt files into a Dorico Elements 
project window.

● Space templates are automatically imported alongside playback templates that use them.
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RELATED LINKS
Playback templates on page 558
Importing playback templates on page 566

Exporting space templates
You can export space templates so you can send them to other users or use them on other 
computers. By default, any space templates that you create are available in all projects on your 
computer.

PROCEDURE

1. Choose Play > Space Template to open the Apply Space Template dialog.

2. Select the space templates that you want to export.

3. Click Export to open the File Explorer/macOS Finder.

4. Specify a name and location for the space template files.

5. Click Choose.

RESULT
The selected space templates are exported and saved in the selected location as 
separate .dorico_spt files.

Changing the default space template
You can change the default space template used for all future projects; for example, if you want 
all your projects to use a different reverb sound than Dorico Elements provides by default.

PREREQUISITE
If you want to use a custom space template, you have created or imported that space template.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. In the category list, click Play.

3. In the Playback Template subsection, select a space template from the Space template 
override menu.

4. Click Apply, then Close.

RELATED LINKS
Preferences dialog on page 58
Creating space templates on page 742
Importing space templates on page 743
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Library

In Dorico Elements, the library is the total compilation of visual items and options that are 
available in all projects on your computer. It combines factory default settings, custom items/
options you have saved as default, and items/options only available in the current project.

Layout Options dialog
The Layout Options dialog allows you to change various aspects of each layout independently. 
For example, you can change the physical properties of the layout, such as page size, staff size, 
or margins, and how the music appears and is laid out, such as note spacing or staff labels.

Any changes you make in options dialogs apply to the current project only, unless you save your 
settings as default.

Options in Layout Options affect only the selected layouts, but apply to all flows in those 
layouts.

You can open Layout Options in any of the following ways:

● Press Ctrl/Cmd-Shift-L .

● Choose Library > Layout Options.

● In Setup mode, click Layout Options  in the Layouts panel.

The Layout Options dialog contains the following:

1 Search categories field

Allows you to filter categories and section titles according to your entry.
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TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list, 
and its options appear as a page in the main body of the dialog.

3 Section titles

Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the active setting is highlighted.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match : Allows you to navigate to the previous match on the page. You can 
also navigate to the previous match by pressing Ctrl/Cmd-Shift-G .

● Next match : Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close : Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

6 Layouts list

Contains all the layouts in your project. By default, the layout currently open in the music 
area is selected when you open the dialog.

You can select multiple layouts in any of the following ways:

● Click one of the selection options in the action bar.

● Ctrl/Cmd -click to select multiple layouts.

● Shift -click to select multiple adjacent layouts.

● Click and drag across multiple layouts.

7 Action bar

Contains selection options that allow you to select layouts in the Layouts list according to 
their type.

● Select All: Selects all layouts, regardless of their type.

● Select All Full Score Layouts : Selects all full score layouts only.

● Select All Part Layouts : Selects all part layouts only.

● Select All Custom Score Layouts : Selects all custom score layouts only.
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8 Save as Default

Saves all options currently set and applied in the dialog as the default for the selected layout 
type in new projects. For example, you can save new default settings for part layouts without 
affecting the default settings for full score layouts. Only available when a single layout is 
selected.

9 Reset to Saved Defaults

Resets all the options in the dialog for the selected layouts back to your saved defaults, 
according to their layout type.

10 Reset to Factory

Resets all the options in the dialog for the selected layouts back to the default factory 
settings, according to their layout type. This only affects the current project and does not 
delete your saved defaults, meaning future projects still start with your saved defaults.

11 Remove Saved Defaults

Deletes your previous saved defaults for the selected layout type without resetting the 
options in the current project. After removing your saved defaults, all layouts of the selected 
type in future projects start with the default factory settings.

RELATED LINKS
Options dialogs in Dorico Elements on page 27
Layouts on page 174
Staves on page 1322
Page formatting on page 598
Condensing on page 643
Changing your preferred unit of measurement on page 51
Changing values in numeric value fields on page 666

Notation Options dialog
The Notation Options dialog allows you to change how music is notated by default in each 
flow independently. For example, there are options for beam, note, and rest grouping, voices, 
accidentals, and barlines.

Any changes you make in options dialogs apply to the current project only, unless you save your 
settings as default.

Options in Notation Options affect only the selected flows, but apply to all layouts in which 
those flows appear.

TIP

If you want to change notes and notations individually, you can use properties in the Properties 
panel.

You can open Notation Options in any of the following ways:

● Press Ctrl/Cmd-Shift-N .

● Choose Library > Notation Options.

● In Setup mode, click Notation Options  in the Flows panel.
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The Notation Options dialog contains the following:

1 Search categories field

Allows you to filter categories and section titles according to your entry.

TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list, 
and its options appear as a page in the main body of the dialog.

3 Section titles

Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the active setting is highlighted.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match : Allows you to navigate to the previous match on the page. You can 
also navigate to the previous match by pressing Ctrl/Cmd-Shift-G .
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● Next match : Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close : Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

6 Flows list

Contains all the flows in your project. By default, the flow in which you have selected an item 
in the music area or that is selected in the Flows panel in Setup mode is selected when you 
open the dialog.

You can select multiple flows in any of the following ways:

● Click Select All in the action bar to select all flows in the project.

● Ctrl/Cmd -click to select multiple flows.

● Shift -click to select multiple adjacent flows.

● Click and drag across multiple flows.

7 Save as Default

Saves all options currently set and applied in the dialog as the default for new projects. Only 
available when a single flow is selected.

8 Reset to Saved Defaults

Resets all the options in the dialog for the selected flows back to your saved defaults.

9 Reset to Factory

Resets all the options in the dialog for the selected flows back to the default factory settings. 
This only affects the current project and does not delete your saved defaults, meaning future 
projects still start with your saved defaults.

10 Remove Saved Defaults

Deletes your previous saved defaults without resetting the options in the current project. 
After removing your saved defaults, all future projects start with the default factory settings.

RELATED LINKS
Flows on page 171
Options dialogs in Dorico Elements on page 27
Changing your preferred unit of measurement on page 51
Changing values in numeric value fields on page 666

Playback Options dialog
The Playback Options dialog allows you to change how the music you have written sounds 
when played back. These options affect playback regardless of expression maps and patches, 
such as how dynamics, pedal lines, and different notations are interpreted during playback.

For example, you can change how much louder notes on the first beat in each bar are compared 
to other notes in the bar, change how long each pedal retake lasts, and how much different 
articulations, such as staccatissimo and tenuto, affect the duration of notes.

Any changes you make in options dialogs apply to the current project only, unless you save your 
settings as default.

You can open Playback Options in any of the following ways:

● Press Ctrl/Cmd-Shift-P .

● Choose Library > Playback Options.
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The Playback Options dialog contains the following:

1 Search categories field

Allows you to filter categories and section titles according to your entry.

TIP

You can set the focus to the Search categories field by pressing Ctrl/Cmd-L . You can set 
the focus away by pressing Tab .

2 Category list

Contains the categories of options that you can view and change in the dialog. When you 
click a category in this list, any applicable section titles appear below the category in the list, 
and its options appear as a page in the main body of the dialog.

3 Section titles

Shows the titles of any sections on the selected category’s page. You can click these section 
titles to navigate directly to that section of the page.

4 Section

Pages are divided into sections, which can contain multiple options. Sections that contain 
many options are divided into subsections. For options that have multiple possible settings, 
the active setting is highlighted.

5 Search pages bar

Allows you to search section titles and options on the currently selected page according to 
your entry and navigate through matches. The number of matches is displayed in the bar. 
Matches appear highlighted on the page, and the current option appears with a brighter 
highlight.

You can show the Search pages bar by pressing Ctrl/Cmd-F .

The bar contains the following options:

● Search pages field: Allows you to enter the term you want to search for. You can set the 
focus to the Search pages field by pressing Ctrl/Cmd-F .

● Previous match : Allows you to navigate to the previous match on the page. You can 
also navigate to the previous match by pressing Ctrl/Cmd-Shift-G .
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● Next match : Allows you to navigate to the next match on the page. You can also 
navigate to the next match by pressing Ctrl/Cmd-G .

● Close : Closes the bar and removes all match highlights. You can also close the bar by 
pressing Esc .

6 Save as Default

Saves all options currently set and applied in the dialog as the default for new projects.

7 Reset to Saved Defaults

Resets all the options in the dialog back to your saved defaults.

8 Reset to Factory

Resets all the options in the dialog back to the default factory settings. This only affects the 
current project and does not delete your saved defaults, meaning future projects still start 
with your saved defaults.

9 Remove Saved Defaults

Deletes your previous saved defaults without resetting the options in the current project. 
After removing your saved defaults, all future projects start with the default factory settings.

RELATED LINKS
Options dialogs in Dorico Elements on page 27
Expression maps on page 761
Changing your preferred unit of measurement on page 51
Changing values in numeric value fields on page 666

Music fonts
Music fonts control the project-wide appearance of notations, glyphs, and other items that are 
not text, such as clefs, dynamics, and bold tuplet numbers/ratios.

By default, Dorico Elements comes with the following SMuFL-compliant fonts:

Music font design Music font name

Bravura

Finale Ash

Finale Broadway
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Music font design Music font name

Finale Jazz

Finale Maestro

Golden Age

Leipzig

Leland

Petaluma

Sebastian

You can change the music font used in your project in the Music Fonts dialog.

TIP

You can change the appearance of individual fonts in the Edit Font Styles and Paragraph Styles 
dialogs.
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Music Fonts dialog
The Music Fonts dialog allows you to change the font used for notations and glyphs project-
wide. Any font you use for notations and glyphs must be SMuFL-compliant.

● You can open the Music Fonts dialog by choosing Library > Music Fonts.

The Music Fonts dialog contains all available SMuFL fonts you have installed on your computer 
that have the appropriate metadata for Dorico Elements to recognize them.

The Music Fonts dialog also contains the following options:

Update text fonts when changing music fonts
Allows you to include/exclude text fonts when changing the music font. For example, 
deactivating this option allows you to change the appearance of notes and notations 
without affecting the appearance of flow titles and staff labels.

● For the Bravura music font, the equivalent text font is Academico.

● For the Petaluma music font, the equivalent text font is Petaluma Script.

Use font’s recommended engraving options
Allows you to import the default settings that come with the font.

NOTE

Items marked as optional in SMuFL fonts, such as clef changes and non-bold tuplet numbers/
ratios, are not affected when you change the music font.

Text formatting
Dorico Elements combines different settings for the appearance of text, meaning that you can 
format fonts and texts in different places depending on their function.

● Font styles are used in notations that use text but are not generic text, such as tempo marks 
and dynamics.

● Paragraph styles apply to individual paragraphs in text frames or all text within a single text 
item. They are also used for text that appears in the music but is not a notation, such as bar 

Library
Text formatting 

753
Dorico Elements 5.1.30



numbers and staff labels. You can use paragraph styles to keep the presentation of different 
types of text consistent across your project.

● Character styles apply to individual letters or words, meaning you can apply different 
character styles to each word within the same text frame.

For example, you can change the font family used for all text notations in your project in the Edit 
Font Styles dialog and all other text in the Paragraph Styles dialog, where you can also make 
specific changes for when that font is used for titles.

If you open a project that contains fonts not installed on your computer, the Missing Fonts 
dialog opens and allows you to select replacement fonts as substitutes.

RELATED LINKS
Changing the default font family on page 760
Types of text on page 1352
Text editor options in Write mode on page 389
Missing Fonts dialog on page 73

Edit Font Styles dialog
The Edit Font Styles dialog allows you to edit the formatting of fonts used for items that you 
cannot edit using the text editor, such as changing the font size of playing techniques, dynamics, 
or tempo marks.

● You can open the Edit Font Styles dialog by choosing Library > Font Styles.

The Edit Font Styles dialog contains the following sections and options:

1 Search field

Allows you to filter font styles according to your entry.

TIP

If you cannot find a particular font style, it might instead be a paragraph style.

2 Font styles list
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Contains all the font styles in the project. If you have previously opened the Edit Font Styles 
dialog in the same session, your previously selected font style is remembered.

The action bar at the bottom of the list contains the following options:

● New : Creates a new font style with default values.

● New from Selection : Creates a copy of an existing font style that you can edit 
separately from the original. The new font style uses the original as its parent by default.

● Save as Default : Saves the selected font style to your user library, allowing you to use 
it in multiple projects. Appears as  for font styles saved as default.

● Revert to Factory : Removes all your changes to the selected font style, returning it to 
its saved settings.

● Delete : Deletes the selected font style.

NOTE

You cannot delete predefined font styles or any font style that is currently used in your 
project.

3 Name

Allows you to enter a name for new font styles or edit the name of existing font styles.

4 Parent

Allows you to choose a parent font style from which the selected font style inherits settings. 
Activated options override the parent style settings.

5 Font preview

Displays a preview of the selected font style using its current settings.

6 Font appearance options

Allow you to change the following parameters of the selected font style:

● Font family: Sets the overall font style.

● Size: Sets the size of the font. Allows you to choose whether the size of the font changes 
according to the staff size or whether it is always the set size. For example, items with 
staff-relative font sizes appear smaller on smaller staves.

NOTE

If the size of system object font styles is set to Staff-relative, the staff size of the top 
staff in each instrument family group affects the size of system objects if they are shown 
above that bracketed group. Font styles that are set to Absolute are unaffected by staff 
size.

● Style: Sets the style of the font, such as bold or italic.

● Underlined: Allows you to make the font style underlined.

7 Substitutes

Allows you to manage substitute font styles for music font styles. This can be useful when 
using music font styles that do not contain all glyphs in the SMuFL range.

The action bar at the bottom of the list contains the following options:

● Add Substitute : Adds a new substitute to the selected font style. You can change the 
substitute font style by double-clicking substitutes, then either entering the font style 
you want or clicking the arrow  and selecting a font style from the menu.

● Move Up : Moves the selected substitute up the substitutes list, which changes its 
substitution order.
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● Move Down : Moves the selected substitute down the substitutes list, which changes 
its substitution order.

● Delete : Deletes the selected substitute.

NOTE

Changes made to font styles apply project-wide, including in part layouts.

RELATED LINKS
Types of text on page 1352
Staff size on page 617
System objects on page 1326
Brackets according to ensemble type on page 866

Paragraph Styles dialog
The Paragraph Styles dialog allows you to change existing paragraph styles for text and create 
new styles. You can later apply paragraph styles to individual paragraphs in text frames or all text 
within a single text item by choosing them in the text editor.

For example, you can customize the paragraph style for layout names and then apply your layout 
name paragraph style to the layout name token in every applicable text frame. This allows you to 
keep the presentation of different types of text consistent across your project.

● You can open the Paragraph Styles dialog by choosing Library > Paragraph Styles.

The Paragraph Styles dialog contains the following sections and options:
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1 Paragraph styles list

Contains all the paragraph styles in the project. If you had text items selected when you 
opened the dialog, the corresponding paragraph style of the first selected item is selected in 
the paragraph styles list by default.

TIP

If you cannot find a particular paragraph style, it might instead be a font style.

The action bar at the bottom of the list contains the following options:

● New : Creates a new paragraph style with default values.

● New from Selection : Creates a copy of an existing paragraph style that you can edit 
separately from the original. The new paragraph style uses the original as its parent by 
default.

● Save as Default : Saves the selected paragraph style to your user library, allowing you 
to use it in multiple projects. Appears as  for paragraph styles saved as default.

● Revert to Factory : Removes all your changes to the selected paragraph style, 
returning it to its saved settings.

● Delete : Deletes the selected paragraph style.

NOTE

You cannot delete predefined paragraph styles or any paragraph style that is currently 
used in your project.

2 Name

Allows you to enter a name for new paragraph styles or edit the name of existing paragraph 
styles.

3 Parent

Allows you to choose a parent paragraph style from which the selected paragraph style 
inherits settings. Activated options override the parent style settings.

4 Font preview

Displays a preview of the selected paragraph style using its current settings.

5 Font appearance options

Allow you to change parameters of the appearance of the paragraph style font, such as 
changing the font, making the font bold, changing the size of the font, and changing the 
letter or word spacing. You can also make the font in paragraph styles appear underlined or 
overlined.

6 Border options

Allow you to show borders by default on text that uses the paragraph style and to change 
the border settings, such as thickness, style, and padding between the border and text.

NOTE

● When Border is deactivated, text items use the default border and padding values set 
on the Text page in Engraving Options.

● We recommend only using paragraph style borders for text frames that contain a single 
paragraph. If you want to show some paragraphs with borders but other paragraphs 
without borders, we recommend using separate text frames.

7 Paragraph layout options
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Allow you to change the layout of the paragraph style, such as changing the first line indent, 
line spacing, and text alignment.

8 Color options

Allow you to change the foreground and background colors of the paragraph style.

RELATED LINKS
Types of text on page 1352
Hiding/Showing borders on layout names on page 1001
Staff size on page 617
System objects on page 1326

Creating paragraph styles
You can create new paragraph styles from scratch and you can duplicate existing paragraph 
styles and edit the settings; for example, to format text consistently in multiple text frames.

PROCEDURE

1. Choose Library > Paragraph Styles to open the Paragraph Styles dialog.

2. Create a new paragraph style in one of the following ways:

● To create an entirely new paragraph style, click New  in the action bar.

● To create a copy of an existing paragraph style, select it in the paragraph styles list and 
click New from Selection  in the action bar.

3. Enter a name for the style in the Name field.

4. Optional: Select one of the available styles from the Parent menu.

NOTE

If you select a parent style, your paragraph style inherits its settings automatically for all 
options with deactivated sliders. If your paragraph style has activated sliders, which override 
its parent style settings, you can deactivate them to reset those options to follow the parent 
style.

5. Activate and change the options as required.

6. Optional: To make the paragraph style available in all future projects, click Save as Default 
 in the paragraph styles list action bar.

7. Click OK to save your changes and close the dialog.

RESULT
The new paragraph style is created.

If you clicked Save as Default  so that it appears as , the paragraph style is available in all 
future projects on your computer.

RELATED LINKS
Inputting text items on page 388
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Character Styles dialog
The Character Styles dialog allows you to change character styles and create new styles. You 
can later apply character styles to individual letters or words in different places in your project by 
choosing them in the text editor.

For example, you can create a custom character style with wide letter spacing for specific words 
and then apply that character style to selected words. Unlike paragraph styles, character styles 
do not have to apply to whole text items or paragraphs in text frames.

● You can open the Character Styles dialog by choosing Library > Character Styles.

The Character Styles dialog contains the following sections and options:

1 Character styles list

Contains all the character styles in the project.

The action bar at the bottom of the list contains the following options:

● New : Creates a new character style with default settings.

● New from Selection : Creates a copy of an existing character style that you can edit 
separately from the original.

● Save as Default : Saves the selected character style to your user library, allowing you 
to use it in multiple projects. Appears as  for character styles saved as default.

● Revert to Factory : Removes all your changes to the selected character style, 
returning it to its saved settings.

● Delete : Deletes the selected character style.

NOTE

You cannot delete predefined character styles or any character style that is currently 
used in your project.

2 Name

Allows you to enter a name for new character styles or edit the name of existing paragraph 
styles.

3 Character style options

Allow you to change parameters of the character style, such as changing the font, making 
the font bold, changing the size of the font, and changing the letter or word spacing. You 
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can also make the font in paragraph styles appear underlined or overlined, and change the 
vertical alignment of characters.

4 Color options

Allow you to change the foreground and background colors of the character style.

RELATED LINKS
Types of text on page 1352
Insert Music Text dialog on page 391

Creating character styles
You can create new character styles from scratch and you can duplicate existing character styles 
and edit the settings.

PROCEDURE

1. Choose Library > Character Styles to open the Character Styles dialog.

2. Create a new character style in one of the following ways:

● To create an entirely new character style, click New  in the action bar.

● To create a copy of an existing character style, select it in the character styles list and 
click New From Selection  in the action bar.

3. Enter a name for the style in the Name field.

4. Activate and change the options as required.

IMPORTANT

Only activated options have an effect on the text. If you deactivate options, their settings are 
reset.

5. Optional: To make the character style available in all future projects, click Save as Default 
in the character styles list action bar.

6. Click OK to save your changes and close the dialog.

RESULT
The new character style is created.

If you clicked Save as Default  so that it appears as , the character style is available in all 
future projects on your computer.

RELATED LINKS
Inputting text items on page 388

Changing the default font family
You can change the font family of the default font and paragraph styles, which affect all other 
font and paragraph styles in the project whose font family has not been overridden. For example, 
if you want all text and text-based notations, such as text playing techniques and gradual 
dynamics, to use your preferred font family.

PROCEDURE

1. Choose Library > Font Styles to open the Edit Font Styles dialog.

2. In the font styles list, select Default Text Font.
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3. Select the font family you want from the Font family menu.

4. Click OK to save your changes and close the dialog.

5. Choose Library > Paragraph Styles to open the Paragraph Styles dialog.

6. In the paragraph styles list, select Default Text.

7. Select the font family you want from the Font menu.

8. Click OK to save your changes and close the dialog.

RESULT
The font family used in the selected default font and paragraph styles is changed. This also 
affects the font family used by all other font and paragraph styles in the project whose font 
family has not been overridden.

TIP

You can change the default font family used in all future projects on the General page in 
Preferences.

RELATED LINKS
Edit Font Styles dialog on page 754
Paragraph Styles dialog on page 756
Preferences dialog on page 58
Text items on page 1351

Expression maps
Expression maps tell Dorico Elements how to use appropriately the patches and sounds in the 
VST instruments that you have loaded into your project.

Expressing a range of dynamics on instruments means changing the volume and attack of 
notes. Because the strength of attack changes the character of the start of sounds as well as 
their volume, loud sounds often require stronger attacks and quiet sounds often require softer 
attacks.

Different patches and instruments have different approaches to changing dynamics and volume 
in playback. For example, some patches only change the velocity whereas others use a controller 
in combination with changing the velocity.

Dorico Elements also uses expression maps to specify the playback techniques that are 
supported by each patch in your project. For example, string instruments such as the violin have 
different techniques, because they can play arco, pizzicato, and col legno, and their bow position 
can be anywhere between sul ponticello and sul tasto.

In addition to expression maps for each sound library, there are the following expression maps 
in Dorico Elements:

● CC11 Dynamics: Uses MIDI controller 11 to play dynamics.

NOTE

This only applies to instruments that can change their dynamic while notes are sounding, 
such as violin or flute.

● Default: Uses note velocity to control dynamic volume.

● Modulation Wheel Dynamics: Uses a modulation wheel to control dynamic volume.
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● Transpose down 1 octave: Used by some instrument patches that sound an octave higher 
than written so that they can be played without needing a full range keyboard.

● Transpose up 1 octave: Allows the bottom octave of keyboards to be used for key switches 
instead of notes, but is also used by some bass instrument patches that sound an octave 
lower than written so that they can be played without needing a full range keyboard.

Dorico Elements automatically adds expression maps to projects when you apply playback 
templates that use those expression maps.

You can edit, create, and import/export expression maps in the Expression Maps dialog. 
Expression maps are saved as .doricolib files.

NOTE

Although Dorico Elements approaches expression maps in a different way to Cubase, Dorico 
Elements correctly imports many switches from expression maps you import from Cubase, such 
as pizzicato, harmonics, and flutter tongue.

RELATED LINKS
Percussion maps on page 780
Types of switches on page 774
Types of actions on page 775
Creating new expression maps on page 776
Playback templates on page 558

Expression Maps dialog
The Expression Maps dialog allows you to create new expression maps, edit existing expression 
maps, and import/export expression maps. You can also import expression maps made in 
Cubase.

You can open the Expression Maps dialog in any of the following ways:

● Choose Library > Expression Maps.

● In Play mode, select a track in the track overview, then click Edit Expression Map  in the 
Routing section of the Track Inspector.
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The Expression Maps dialog contains the following sections and options:

Expression maps list

Contains the expression maps currently available in your project.

At the top of the list, there are the following options:

● Search field: Allows you to filter expression maps according to your entry.

● Show only expression maps used in this project : Allows you to filter the expression 
maps list so that it only includes expression maps used in the current project.

The action bar at the bottom of the list contains the following options:

● Add Expression Map : Adds a new expression map that contains no existing settings.
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● Duplicate Expression Map : Creates a copy of an existing expression map that you can 
edit separately from the original.

● Delete Expression Map : Deletes the selected expression maps.

NOTE

You cannot delete factory default expression maps or any expression map that is currently 
used in your project.

Expression Map Data

This section allows you to specify identifying information for the selected expression map.

You can hide/show the Expression Map Data section by clicking the section header.

The Expression Map Data section contains the following options:

Name
Allows you to set the name of the expression map that appears in the program; for 
example, in the Endpoint Setup dialog.

ID
Allows you to set the unique ID of the expression map. You can enter any content in 
the ID field.

It can be useful to include the instrument and sound library for which you created the 
map, as well as your name; for example, xmap.user.paulsmith.hso.violinpizz.

Creator
Allows you to name the creator if you are sharing your expression map with other 
users.

Version
Allows you to indicate the expression map version, so you can identify the most recent 
one.

Plug-ins
Allows you to list the names of plug-ins to which the expression map applies, with each 
name separated by a comma. You can leave this field blank.

Allow multiple notes at same pitch
Allows you to set whether or not the plug-in can treat identical pitches in 
multiple voices belonging to the same instrument as multiple separate notes when 
independent voice playback is disabled.
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Apply Stage Template settings
Allows you to set whether or not stage templates and space templates apply to 
endpoints using the expression map. We recommend deactivating this option for 
sounds whose recordings already have spatial and reverberation characteristics.

Microtonality playback
Allows you to select the microtonal playback method that you want to use for the 
expression map.

Pitch bend range
Allows you to set the pitch bend range supported by the plug-in, expressed in half-
steps. The range is typically either a whole step or an octave.

Description
Allows you to add any other information about the expression map.

NOTE

Many fields in the Expression Map Data section are locked by the Lock Info  button. You must 
click this button to unlock Lock Info  in order to change the information in the fields.

Base and Add-on Switches

This section allows you to view, edit, and control the switches for playback techniques in the 
selected expression map.

You can hide/show the Base and Add-on Switches section by clicking the section header.

At the top of the section, there are the following options:

Name
Allows you to change the name that appears for the currently selected switch in the 
Switches table; for example, so that it appears the same as in your sound library.
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TIP

You can still see which playback techniques are triggered by switches with custom 
names by hovering the mouse pointer over the corresponding row in the Switches 
table.

Enabled
Allows you to enable/disable the currently selected switch without removing it from the 
expression map.

The Base and Add-on Switches section also contains the following:

Switches table

Contains the switches in the currently selected expression map. Allows you to add new switches 
and edit existing ones.

The Switches table comprises the following:

1 Type column: Displays the switch type. Switches can be any of the following types:

● Base

● Add-on

● Init

2 Name column: Displays the name of the switch. By default, this is the same as the playback 
technique or playback technique combination it triggers.

In simple cases, each switch triggers an individual playback technique, such as Staccato 
or Accent. However, some plug-ins have separate samples for different combinations of 
playback techniques. For example, Staccato + Accent might require a separate set of key 
switches to Staccato and Accent individually.

3 Switches table action bar: Contains the following options:

● Add Base Switch : Allows you to add a new base switch to the expression map 
by selecting the playback techniques you want the switch to trigger in the Playback 
Technique Combinations dialog that opens.
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● Add Technique Add-on Switch : Allows you to add a new add-on switch to the 
expression map by selecting the playback techniques you want the switch to trigger 
in the Playback Technique Combinations dialog that opens.

● Duplicate Technique : Creates a copy of an existing switch that you can edit 
separately from the original.

● Edit Technique : Opens the Playback Technique Combinations dialog, which allows 
you to edit the combination of playback techniques triggered by the selected switch.

You can also edit the playback techniques of existing switches by double-clicking them in 
the Switches table.

● Audition : Plays two notes using the currently selected switch and any corresponding 
actions to demonstrate their effect on playback. Only available for expression maps used 
in the project.

● Delete Technique : Deletes the selected switch.

Selecting a switch in the Switches table allows you to edit its controls and actions. Different 
options are available in the Base and Add-on Switches section depending on the switch type.

NOTE

● Most instruments have a “natural” playback technique, which is the most common way of 
playing the instrument. Dorico Elements requires every instrument to have a defined natural 
playback technique.

● You can only select one switch at a time in the Switches table.

Actions

Displays in a table any actions required to produce the selected playback technique. Allows you 
to determine how the switch that triggers each playback technique is controlled, either by adding 
new actions or editing existing ones.

NOTE

Depending on your plug-in, multiple types of actions can be required for each switch.

The Actions subsection comprises the following:

1 Middle C (note 60): Allows you to choose the pitch for middle C, independently of 
your middle C numbering convention setting. We recommend that you consult the 
documentation for your sound libraries to check whether each one considers middle C to 
be C3, C4, or C5, and change this setting accordingly.

2 On events/Off events: Allows you to specify whether actions affect the start or end of notes. 
For example, you might want an event that resets the playback technique back to normal to 
apply only to the end of notes.
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On events affects the start of notes. Off events affects the end of notes.

3 Actions table: Contains the following columns:

● First column: Displays the action type. Actions can be a control change, program change, 
or key switch.

● Second column: Controls the first parameter of the MIDI event. For key switches, this 
indicates the pitch. For control changes, this indicates the control change number. For 
program changes, this indicates the program number.

● Third column: Controls the second parameter of the MIDI event. For key switches, this 
indicates the velocity. For control changes, this indicates the amount of control change 
within the range 0 to 127. Program changes do not have a second parameter.

NOTE

● You can change the values of cells in the Actions table by double-clicking them, or 
selecting them and pressing Return .

● You can only select one action at a time in the Actions table.

4 Actions table action bar: Contains the following options:

● Add Control Change Action : Adds a control change action with default settings.

● Add Program Change Action : Adds a program change action with default settings.

● Add Key Switch Note Action : Adds a key switch action with default settings.

● Add Absolute Channel Change Action: Adds an absolute channel change action with 
default settings.

● Add Relative Channel Change Action: Adds a relative channel change action with 
default settings.

● Transpose Up 1 Octave : Raises the octave of all key switch actions for the selected 
switch.

● Transpose Down 1 Octave : Lowers the octave of all key switch actions for the 
selected switch.

● Duplicate Action : Creates a copy of an existing action that you can edit separately 
from the original.

● Move Action Up : Moves the selected action up the table, which changes its order in 
the message sequence.

● Move Action Down : Moves the selected action down the table, which changes its 
order in the message sequence.

● Delete Action : Deletes the selected action.

Conditions

Displays in a table any conditions that determine the circumstances in which the base switch 
currently selected in the Switches table is used. Allows you to add new conditions and edit 
existing ones. Only available for Base switches.

For example, you can set conditions instructing the expression map to use a different legato 
sound with a quicker attack for short notes than for longer notes automatically.
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The Conditions subsection comprises the following:

1 Any of/All of: Allows you to set whether the switch is used when one or more conditions are 
met or only when all conditions are met.

2 Conditions table: Contains the following columns:

First column: Displays the condition type.

Second column: Controls how the condition type in the first column relates to the note 
length set in the third column using operators. The following operators are available:

● ==: Equal to

● !=: Not equal to

● <: Less than

● <=: Less than or equal to

● >: More than

● >=: More than or equal to

Third column: Controls the note length used by the condition. The following note length 
values are available:

● Very short: A dotted 16th note at 120 bpm, or 0.1875 seconds

● Short: A dotted eighth note at 120 bpm, or 0.375 seconds

● Medium: A dotted quarter note at 120 bpm, or 0.75 seconds

● Long: A dotted half note at 120 bpm, or 1.5 seconds

● Very long: Any longer duration

NOTE

● You can change the values of cells in the Conditions table by double-clicking them, or 
selecting them and pressing Return .

● You can only select one condition at a time in the Conditions table.

3 Conditions action bar: Contains the following options:

● Add Technique : Adds a new technique condition with default settings.

● Duplicate Technique : Creates a copy of an existing technique condition that you can 
edit separately from the original.

● Delete Technique : Deletes the selected technique condition.

Technique controls

Contains controls that affect the base switch currently selected in the Switches table. Only 
available for Base switches.
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The following technique controls are available:

Monophonic legato
Allows you to limit monophonic legato to music without chords; that is, two or 
more notes simultaneously. Only available for Base switches that include the Legato 
playback technique.

When this option is activated, Dorico Elements automatically removes the legato 
playback technique when chords or multiple voices are played by the same endpoint, 
but continues to use the default legato note length.

TIP

You can change the default legato note length in Playback Options > Timing > Note 
Durations.

Transpose
Allows you to set the MIDI transposition in half-steps (semitones).

Delay [n] milliseconds
Allows you to set a delay in milliseconds; for example, to compensate for sounds with 
a slow attack or rise time. Negative values cause notes to sound earlier than written, 
positive values cause notes to sound later than written.

Length %
Allows you to modify played note durations, which overrides the default value; for 
example, if you want the selected switch to produce short gaps between notes.

● For notes a quarter note or shorter in duration, the value applies to the entire 
note.

● For notes longer than a quarter note, the value only applies to the last quarter 
note of their overall duration.
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Volume dynamic
Allows you to choose whether the volume dynamic for the selected switch is controlled 
by its Note velocity or a Control change.

NOTE

If you choose Control change, you must specify the controller by number. You can 
consult the documentation for the VST instrument and/or MIDI controller you are 
using to find the appropriate controller number.

Volume dynamic Min/Max
Allow you to set the minimum and maximum range for dynamics using either note 
velocity or MIDI CC, depending on the sound library.

Use Secondary dynamic
Allows you to define an additional volume control for sound libraries that use both 
note velocity and control changes for volume dynamic.

Secondary dynamic Min/Max
Allow you to set the minimum and maximum range for dynamics using either note 
velocity or MIDI CC, depending on the sound library.

Playback Options Overrides

Allows you to override specific playback options for the selected expression map only. Activating 
a playback option overrides it. The available playback options include the default duration of 
notes with different articulations, unmeasured tremolo notes, and the effect that beat position 
and articulations have on dynamics. By default, the values set match the current settings in 
Playback Options.

You can hide/show the Playback Options Overrides section by clicking the section header.

Mutual Exclusion Groups

Allows you to define playback techniques that are mutually exclusive; that is, cannot be in use 
concurrently. For example, players cannot play vibrato and non-vibrato at the same time. Putting 
playback techniques into the same exclusion group means only one can be used at a time.

You can allow Dorico Elements to define mutual exclusion groups automatically or define them 
yourself manually.

Mutual exclusion groups apply only to the selected expression map. This allows you to set 
different mutual exclusion groups in each expression map; for example, if one of your sound 
libraries supports a particular playback technique combination for an instrument but another 
sound library does not.

You can hide/show the Mutual Exclusion Groups section by clicking the section header.
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The Mutual Exclusion Groups section contains the following options and columns:

1 Create mutual exclusion groups automatically: Allows Dorico Elements to define mutual 
exclusion groups automatically.

NOTE

Activating Auto permanently deletes any manual exclusion groups you have created.

2 Mutual Exclusion Groups column: Allows you to add and delete mutual exclusion groups 
manually. The action bar at the bottom of the column contains the following options:

● Add : Opens a dialog that allows you to create a new mutual exclusion group and 
enter a name for it.

● Delete : Deletes the selected mutual exclusion group.

NOTE

You can only select one mutual exclusion group at a time.

3 Has techniques column: Allows you to change the playback techniques included in the 
selected mutual exclusion group. The action bar at the bottom of the column contains the 
following options:

● Add : Opens the Playback Technique Combinations dialog that allows you to select 
playback techniques to add to the selected mutual exclusion group.

● Delete : Deletes the selected playback technique from the mutual exclusion group.

NOTE

You can only select one playback technique at a time.

Expression map/Library management options

At the bottom of the Expression Maps dialog, there are the following expression map and library 
management options:

Reset to Library Defaults
Allows you to revert any changes you have made to the expression maps from the 
Default Library.
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Import Library
Opens the File Explorer/macOS Finder, where you can select the .doricolib files that 
you want to import as expression maps.

You can also import Dorico and Cubase expression maps by dragging and dropping 
them into the Expression Maps dialog.

Export Library
Opens the File Explorer/macOS Finder, where you can select the location to which you 
want to export the currently selected expression maps as a .doricolib file. You can 
then import the .doricolib file into other projects and share it with other users.

Import Cubase Expression Map
Opens the File Explorer/macOS Finder, where you can select the 
Cubase .expressionmap files you want to import as expression maps.

NOTE

Cubase expression maps that you have imported often require some editing to 
function correctly in Dorico Elements. However, switch data is preserved.

RELATED LINKS
Types of switches on page 774
Types of actions on page 775
Playback techniques on page 787
Endpoint Setup dialog on page 567
Edit Playback Techniques dialog on page 788
Track overview on page 520
Track Inspector on page 522
Enabling independent voice playback on page 545
Creating new expression maps on page 776
Adding/Editing switches in expression maps on page 777
Adding/Editing mutual exclusion groups in expression maps on page 779
Playback Options dialog on page 749
Playback Options for dynamics on page 954
Slurs in playback on page 1308
Changing the middle C numbering convention on page 51

Playback Technique Combinations dialog
The Playback Technique Combinations dialog allows you to create combinations of playback 
techniques that you want to apply simultaneously. Playback techniques are used by expression 
maps to assign the correct sounds to the required playing techniques in the music.

You can open the Playback Technique Combinations dialog in the following ways:

● In the Expression Maps dialog, click Add Technique  in the Switches table action bar.

● In the Expression Maps dialog, select an existing playback technique in the Switches table 
and click Edit Technique  in the Techniques action bar. You can also double-click the 
playback technique.
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1 Search field

Allows you to search for playback techniques, then navigate to them by selecting them from 
the menu.

2 Techniques list

Allows you to select playback techniques to include in a new switch or to change the 
playback techniques in an existing switch.

You can select multiple playback techniques to combine by Ctrl/Cmd -clicking each playback 
technique.

3 Name

Displays the name of the selected playback technique. If you select multiple playback 
techniques, each name is automatically separated by a + symbol.

NOTE

You cannot rename playback techniques or playback technique combinations in the 
Playback Technique Combinations dialog. You can rename the switches that include them 
in the Base and Add-on Switches section of the Expression Maps dialog. You can rename 
individual playback techniques in the Edit Playback Techniques dialog.

RELATED LINKS
Expression Maps dialog on page 762
Edit Playback Techniques dialog on page 788

Types of switches
Switches are used in expression maps to trigger the required playback technique or combination 
of playback techniques. Dorico Elements supports multiple types of switches.

Base
A fundamental change to the playing technique or articulation, such as changing from 
arco to pizzicato or unmuted to muted. Base switches are mutually exclusive, meaning 
a new base switch replaces the previous one.
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Add-on
A switch that applies in addition to the existing base switch. For example, some sound 
libraries allow you to use the same legato switch in addition to different base switches. 
Add-on switches do not remove or change base switches. Add-on switches can only 
trigger simple key switch notes and controller values.

Init
A switch that sends instructions when playback starts, such as ensuring a MIDI 
controller always starts at a set value. By default, every expression map contains an 
empty init switch. Init switches can only trigger simple key switch notes and controller 
values.

RELATED LINKS
Expression Maps dialog on page 762
Adding/Editing switches in expression maps on page 777
Adding/Editing mutual exclusion groups in expression maps on page 779

Types of actions
Actions are used in expression maps to determine how individual switches are controlled in 
order to trigger the required playback technique or combination of playback techniques. Dorico 
Elements supports multiple types of actions, as different sound libraries require different actions.

Control change actions
Control change actions use MIDI CC events to modulate sounds. They are particularly 
useful when using sound libraries whose sounds can be manipulated incrementally, 
such as increasing/decreasing the string vibrato intensity.

Program change actions
Program change actions use MIDI PC events to switch to different sounds. They are 
particularly useful when using sound libraries, such as General MIDI, that use separate 
programs for each playback technique or combinations of instrument sounds and 
effects presets.

Key switch actions
Key switch actions use MIDI note events to switch to different sounds. They are 
particularly useful when recording MIDI live, as you can press the specified notes on a 
MIDI keyboard to trigger key switch actions while simultaneously playing the notes you 
want to record. Usually, key switch actions are mapped to notes in the lowest octave of 
the MIDI keyboard as they are rarely used for note input.

Key switch actions are also known as “note events”.

Absolute channel change actions
Absolute channel change actions switch to a specific, explicitly numbered channel. 
They are particularly useful for sound libraries that have separate plug-in instances for 
each individual instrument. For example, you might use an absolute channel change 
action to switch from “natural” on channel 1 to “pizzicato” on channel 2 in your viola 
section plug-in instance.

Relative channel change actions
Relative channel change actions switch to a channel numbered relative to the starting 
channel. They are particularly useful for sound libraries that have multiple instruments 
with separate playback technique channels in the same plug-in instance, as they can 
switch between playback techniques according to their relative channel number rather 
than an absolute number. For example, if you have four trumpet instruments loaded in 
the same plug-in instance, each with three channels for different playback techniques, 
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and want to use the same switches for all four trumpets, you might use a relative 
channel change action to switch from the “natural” original channel to “muted” on the 
+1 relative channel.

Relative channel numbers relate to the original channel number of the endpoint for the 
corresponding instrument. A 0 relative channel change switches back to the original 
channel.

TIP

You can add actions to individual switches in the Expression Maps dialog.

Creating new expression maps
You can create new expression maps from scratch, and you can duplicate existing expression 
maps and edit the settings; for example, when using third-party sound libraries or MIDI devices 
that do not provide expression maps.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. Create a new expression map in one of the following ways:

● To create an empty expression map, click Add Expression Map  in the expression 
maps list action bar.

● To create a copy of an existing expression map, select it in the expression maps list and 
click Duplicate Expression Map  in the action bar.

3. In the Expression Map Data section, click Lock Info  to unlock the fields.

4. In the Expression Map Data section, enter information for your expression map in the 
relevant fields.

5. Change the other available options as required.

6. Optional: In the Base and Add-on Switches section, add any new switches you require to 
trigger playback techniques or combinations of playback techniques.

7. In the Switches table, select a switch whose actions, conditions, and/or controls you want to 
edit.

8. Change any settings for the selected switch as required.

For example, you can add actions for all switch types or, for base switches only, choose 
whether the volume of a selected base switch is controlled by its Note velocity or a Control 
change.

9. Optional: Repeat steps 7 and 8 for all switches whose settings you want to change.

10. In the Playback Options Overrides section, activate each playback option you want to 
override for the expression map and change their values.

11. In the Mutual Exclusion Groups section, do one of the following:

● To use automatic exclusion groups defined by Dorico Elements, activate Create mutual 
exclusion groups automatically.

● To create mutual exclusion groups manually, deactivate Create mutual exclusion 
groups automatically, then add or edit mutual exclusion groups.

12. Click OK to save your changes and close the dialog.
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RELATED LINKS
Expression Maps dialog on page 762
Endpoint Setup dialog on page 567
Playback Technique Combinations dialog on page 773
Adding/Editing mutual exclusion groups in expression maps on page 779

Adding/Editing switches in expression maps
You can create new and edit existing switches that trigger playback techniques or combinations 
of playback techniques in individual expression maps; for example, to add an add-on switch to an 
existing base switch, or to create a new base switch with note length conditions.

Playback technique combinations are useful for expression maps that require different sets of 
key switches for Staccato + Accent compared to Staccato and Accent individually, for example.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. In the expression maps list, select the expression map to which you want to add switches or 
whose existing switches you want to edit.

3. Optional: In the Switches table in the Base and Add-on Switches section, add a new switch 
to trigger a playback technique or playback technique combination or edit an existing one in 
one of the following ways:

● To add a new base switch, click Add Base Switch .

● To add a new add-on switch, click Add Technique Add-on Switch .

● To create a copy of an existing switch, select it and click Duplicate Technique .

● To change the playing techniques triggered by an existing switch, select it and click Edit 
Technique .

4. Optional: If you added a new base/add-on switch or edited an existing switch, select 
the playback techniques you want the switch to trigger in the Playback Technique 
Combinations dialog.

TIP

You can select a single playback technique or combine multiple playback techniques. To 
select multiple playback techniques, Ctrl/Cmd -click each playback technique.

5. Optional: Click OK to add the selected playback techniques and close the Playback 
Technique Combinations dialog.

6. In the Switches table, select the switch whose actions, conditions, and/or controls you want 
to edit.

7. In the Actions subsection, choose the event type from one of the following options:

● On events

● Off events

8. In the Actions table, add an action of the selected event type for the currently selected 
switch in one of the following ways:

● Click Add Control Change Action .

● Click Add Program Change Action .

● Click Add Key Switch Note Action .

● Click Add Absolute Channel Change Action.
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● Click Add Relative Channel Change Action.

● Select an existing action and click Duplicate Action .

9. Double-click each cell whose value you want to change and change the value.

TIP

You can change the octave of all key switch actions for the selected switch by clicking 
Transpose Up 1 Octave  and Transpose Down 1 Octave  in the action bar.

10. Choose one of the following pitches for Middle C (note 60):

● C3

● C4

● C5

NOTE

Steps 11 to 15 only apply to base switches. For init and add-on switches, you can skip to step 
16.

11. Optional: Repeat steps 6 to 10 for each action you require for the currently selected switch.

12. In the Conditions table, add a condition for the currently selected base switch in one of the 
following ways:

● To create a new condition, click Add Technique  in the action bar.

● To create a copy of an existing condition, select it and click Duplicate Technique  in 
the action bar.

13. Double-click each cell whose value you want to change and select the required option from 
the menu.

14. Optional: Repeat steps 12 and 13 for each condition you want to add to the selected base 
switch.

15. Choose one of the following condition options:

● To use the switch when at least one condition is met, choose Any of.

● To use the switch when all conditions are met, choose All of.

16. Change any of the other settings in the Base and Add-on Switches section as required.

For example, choose whether the volume of the selected base switch is controlled by its 
Note velocity or a Control change.

17. Click OK to save your changes and close the Expression Maps dialog.

RELATED LINKS
Playback techniques on page 787
Expression Maps dialog on page 762
Playback Technique Combinations dialog on page 773
Changing the middle C numbering convention on page 51
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Adding/Editing mutual exclusion groups in expression maps
By default, Dorico Elements automatically defines mutual exclusion groups. You can create new 
and edit existing mutual exclusion groups in individual expression maps manually.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. In the expression maps list, select the expression map to which you want to add mutual 
exclusion groups or whose existing mutual exclusion groups you want to edit.

3. In the Mutual Exclusion Groups section, deactivate Create mutual exclusion groups 
automatically.

4. Optional: To add a new mutual exclusion group, click Add  in the Mutual Exclusion 
Groups column action bar.

5. Enter a name for the new mutual exclusion group in the dialog that opens.

6. Click OK to add the group and close the dialog.

7. In the Mutual Exclusion Groups column, select the mutual exclusion groups whose 
playback techniques you want to change.

8. Change the playback techniques in the selected mutual exclusion group in any of the 
following ways:

● To add new playback techniques to the mutual exclusion group, click Add  in the Has 
techniques column action bar to open the Playback Technique Combinations dialog, 
select the playback techniques you want to add, then click OK.

● To remove playback techniques from the mutual exclusion group, select them in the Has 
techniques column, and click Delete  in the action bar.

9. Click OK to save your changes and close the Expression Maps dialog.

Importing expression maps
You can import expression maps into projects, including .expressionmap files exported from 
Cubase. Expression maps exported from Dorico are saved as .doricolib files.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. Click Import Library to open the File Explorer/macOS Finder.

3. Locate and select the expression map file you want to import.

4. Click Open.

RESULT
The selected expression map is imported into your project. It appears in the expression maps list.

NOTE

● You can also import Dorico and Cubase expression maps by dragging and dropping them 
into the Expression Maps dialog.

● Although Dorico Elements approaches expression maps in a different way to Cubase, Dorico 
Elements correctly imports many switches from expression maps you import from Cubase, 
such as pizzicato, harmonics, and flutter tongue.
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Exporting expression maps
You can export expression maps for use in other projects. Expression maps are saved 
as .doricolib files.

PROCEDURE

1. Choose Library > Expression Maps to open the Expression Maps dialog.

2. In the expression maps list, select the expression maps you want to export.

3. Click Export Library to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.

RESULT
The selected expression maps are exported as a .doricolib file and saved in the selected 
location.

Percussion maps
Unpitched percussion instruments are played back using patches that map unpitched sounds 
onto different MIDI notes. The pitches required to produce different unpitched sounds vary 
by device, sound library, manufacturer, and so on, and have no connection to the position of 
percussion instruments on five-line staves.

The following list contains some examples of unpitched percussion instruments from the General 
MIDI percussion map.

● Bass drum: C2 (MIDI note 36, two octaves below middle C)

● Kick drum: D2 (MIDI note 38)

● Closed hi-hat: F♯2 (MIDI note 42)

● Cowbell: G♯3 (MIDI note 56)

● Open triangle: A5 (MIDI note 81)

Dorico Elements uses percussion maps to connect the written representation of notes and 
playing techniques for percussion instruments to the samples required to play those sounds 
back.

NOTE

A percussion map describes which unpitched percussion instruments and their playback 
techniques are present in a particular patch, and how to play them back. For example, it 
describes which MIDI note to play, and if another MIDI note is needed as a key switch to trigger 
particular playing techniques.

A set of percussion maps for the unpitched percussion patches that are part of theHALion 
Symphonic Orchestra and HALion Sonic SE factory libraries is provided with Dorico Elements. 
They are automatically chosen when you add percussion instruments to your project.

You can define custom percussion maps for third-party sound libraries or MIDI devices in the 
Percussion Maps dialog, in order to obtain correct playback.

RELATED LINKS
Unpitched percussion on page 1419
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Universal Indian Drum Notation on page 1436
Changing the middle C numbering convention on page 51

Percussion Maps dialog
In the Percussion Maps dialog, you can define custom percussion maps for third-party sound 
libraries or MIDI devices in order to obtain correct playback.

You can open the Percussion Maps dialog in any of the following ways:

● Choose Library > Percussion Maps.

● In Play mode, select an unpitched percussion instrument track in the track overview, then 
click Edit Percussion Map  in the Routing section of the Track Inspector.

The Percussion Maps dialog is divided into the following sections:

1 Percussion maps list

Contains the percussion maps currently available in your project.

At the top of the list, there are the following options:

● Search field: Allows you to filter percussion maps according to your entry.

● Show only expression maps used in this project : Allows you to filter the percussion 
maps list so that it only includes percussion maps used in the current project.

The action bar at the bottom of the list contains the following options:

● Add Percussion Map : Adds a new percussion map that contains no existing settings.

● Duplicate Percussion Map : Creates a copy of an existing percussion map that you 
can edit separately from the original.

● Delete Percussion Map : Deletes the selected percussion maps.
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NOTE

You cannot delete factory default percussion maps or any percussion map that is 
currently used in your project.

2 Percussion Map Data section

Allows you to specify the following identifying information for the selected percussion map:

● Name: Allows you to specify the displayed name for the percussion map that appears in 
the Endpoint Setup dialog.

● ID: Allows you to set the unique ID of the percussion map. You can enter any content in 
the ID field.

It can be useful to include the instrument and sound library for which you created the 
map, as well as your name; for example, xmap.user.paulsmith.hso.cowbell.

● Version: Allows you to indicate the percussion map version so you can identify the most 
recent one.

● Map defines sounds for: Allows you to choose one of the following options, as 
appropriate for the current percussion map:

● Multiple Instruments: Choose this if the patch for which you are creating a map 
contains many different percussion instruments, such as the General MIDI drum 
map.

● Single Instruments: Choose this if the patch for which you are creating a map 
contains only a single percussion instrument, perhaps with multiple playback 
techniques for that instrument. For example, a snare drumline patch in Virtual 
Drumline or another specialist sound library.

This can also be useful when your VST instrument has several patches that have the 
same playback technique mappings. For example, there are both large and small 
cymbal patches in HALion Symphonic Orchestra which provide natural strike and roll 
sounds. Creating a single individual instrument percussion map allows you to use 
the same mapping for these sounds for multiple patches.

● Apply Stage Template settings: Allows you to set whether or not stage templates 
and space templates apply to endpoints using the percussion map. We recommend 
deactivating this option for sounds whose recordings already have spatial and 
reverberation characteristics.

NOTE

● Many fields in the Percussion Map Data section are locked by the Lock Info  button. 
You must click this button to unlock Lock Info  in order to change the information in 
the fields.

● The Endpoint Setup dialog is where you set which percussion map Dorico Elements 
uses for each channel on your VST instrument or MIDI output device.

3 Drum Kit Note Map table

By default, the table shows the drum kit notes in use by the selected percussion map 
in numerical order. The table also contains the following columns, which display the 
corresponding available data about the selected drum kit note:

● MIDI Note: Shows the MIDI note number, such as “48”.

● Note Name: Shows the pitch and octave of the note, such as “C3”, according to your 
middle C numbering convention setting.

● Name: Shows the name of the technique, such as Snare “(long roll)”.
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● Instrument: Shows the unpitched percussion instrument, such as “Snare Drum”.

● Key Switch: Shows the number of the key switch that triggers the note, such as “24”.

● Playback Techniques: Shows the playback techniques triggered by the note, such as 
“Roll”.

At the bottom of the table, there are the following options:

● Show all: Shows all MIDI notes from 0 to 127.

● Show MIDI Notes in Use: Only shows the MIDI notes in use by the selected percussion 
map.

● Add Key Switch Alternative: Duplicates the selected drum kit note.

● Clear: Deletes the selected drum kit note.

You can change the data for the currently selected drum kit note in the Edit Drum Kit Note 
subsection.

4 Edit Drum Kit Note subsection

Allows you to specify data in the following fields for the drum kit note currently selected in 
the Drum Kit Note Map table:

● Name: The displayed name for the specific combination of instrument and playback 
technique. You may choose to input the name used in the manufacturer’s 
documentation for your VST instrument or MIDI output device.

● Instrument: Allows you to select an instrument for the drum kit note selected in the 
Drum Kit Note Map section from a list of all the unpitched percussion instruments you 
can create in Dorico Elements.

● Key switches: Allows you to specify the MIDI note number of the key you want to use as 
a key switch if this sound requires another MIDI note to be played to trigger this specific 
combination of instrument and playback techniques.

NOTE

Key switches are not compulsory.

● Techniques: Allows you to select playback techniques to apply to the instrument 
selected in the Instrument field from a list of the available playback techniques.

5 Reset to Library Defaults

Allows you to revert any changes you have made to the percussion maps from the Default 
Library.

6 Import Library

Opens the File Explorer/macOS Finder, where you can select the .doricolib files that you 
want to import as percussion maps.

7 Export Library

Opens the File Explorer/macOS Finder, where you can select the location to which you want 
to export the currently selected percussion maps as a .doricolib file. You can then import 
the .doricolib file into other projects and share it with other users.

RELATED LINKS
Track overview on page 520
Track Inspector on page 522
Assigning expression/percussion maps to endpoints on page 570
Changing the middle C numbering convention on page 51
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Creating new percussion maps
You can create new percussion maps from scratch and you can duplicate existing percussion 
maps and edit the settings; for example, to obtain correct playback when using third-party sound 
libraries or MIDI devices.

PROCEDURE

1. Choose Library > Percussion Maps to open the Percussion Maps dialog.

2. Create a new percussion map in any of the following ways:

● To create an empty percussion map, click Add Percussion Map  in the action bar.

● To create a copy of an existing percussion map, select it in the percussion maps list and 
click Duplicate Percussion Map  in the action bar.

3. In the Percussion Map Data section, click Lock Info  to unlock the fields.

4. Enter the display name you want for the percussion map in the Name field.

This name appears in the Endpoint Setup dialog.

5. Enter any unique identification name in the ID field.

It can be useful to include the instrument and sound library for which you created the 
map, as well as your name, in the identification name for percussion maps; for example, 
xmap.user.paulsmith.hso.cowbell.

6. Choose one of the following options for Map defines sounds for, as appropriate for the 
current percussion map:

● Multiple Instruments

● Single Instruments

7. Activate/Deactivate Apply Stage Template settings.

8. In the Drum Kit Note Map section, click Show all to show unmapped notes.

9. Select the row corresponding to the MIDI note for which you want to create a new mapping.

10. In the Edit Drum Kit Note subsection, click  beside the Instrument field to open a dialog 
containing a list of percussion instruments.

11. Select the instrument that corresponds to the sound produced by the selected MIDI note.

12. Click OK.

13. In the Edit Drum Kit Note subsection, click  beside the Techniques field to open the 
Playback Technique Combinations dialog.

14. Select the appropriate playback techniques for the sound produced by the selected MIDI 
note.

For example, Ctrl/Cmd -click Buzz roll and Rim.

15. Click OK.

16. In the Edit Drum Kit Note subsection, enter the display name you want for this combination 
of instrument and playing technique in the Name field.

17. Optional: If the key switch for this sound requires a MIDI note number, specify it in the Key 
switches field.

18. Click Apply.

19. Optional: Repeat these steps for each MIDI note until you have created all the required 
mappings for your project.

Library
Percussion maps 

784
Dorico Elements 5.1.30



20. Click OK to save your changes and close the dialog.

RESULT
The new percussion map is created.

AFTER COMPLETING THIS TASK

● You must assign percussion maps to the same endpoints as the VST instruments or MIDI 
devices that provide the corresponding patches.

● You can export the percussion map if you want to use it in other projects.

RELATED LINKS
Percussion maps on page 780
Assigning expression/percussion maps to endpoints on page 570
Endpoint Setup dialog on page 567

Importing percussion maps
You can import percussion maps into projects. Percussion maps are saved as .doricolib files.

PROCEDURE

1. Choose Library > Percussion Maps to open the Percussion Maps dialog.

2. Click Import Library to open the File Explorer/macOS Finder.

3. Locate and select the percussion map file you want to import.

4. Click Open.

RESULT
The selected percussion map is imported into your project. It appears in the percussion maps list.

Exporting percussion maps
You can export percussion maps so you can use them in other projects. Percussion maps are 
saved as .doricolib files.

PROCEDURE

1. Choose Library > Percussion Maps to open the Percussion Maps dialog.

2. In the percussion maps list, select the percussion maps you want to export.

3. Click Export Library to open the File Explorer/macOS Finder.

4. In the File Explorer/macOS Finder, specify a name and location for the library file.

5. Click Save.

RESULT
The selected percussion maps are exported as a .doricolib file and saved in the selected 
location.
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Defining how combinations of articulations and single-note 
tremolos sound in playback

You can define specific playback behaviors for particular combinations of articulations 
and single-note tremolos in playing technique-specific noteheads for unpitched percussion 
instruments.

PROCEDURE

1. Open the Percussion Instrument Playing Techniques dialog in any of the following ways:

● For an individual percussion instrument: In Setup mode, in the Players panel, click 
the instrument menu  in the instrument label, and choose Edit Percussion Playing 
Techniques from the menu.

● For percussion instruments that are part of percussion kits: In Setup mode, in the 
Players panel, click the instrument menu  in the kit instrument label, and choose Edit 
Percussion Kit to open the Edit Percussion Kit dialog. In the main editing area, select 
the instrument whose playing techniques you want to edit, then click Edit Percussion 
Playing Techniques.

2. In the list at the top of the dialog, select the playing technique-specific notehead whose 
playback behaviors you want to define.

3. Click Add Technique  in the action bar at the bottom left of the dialog.

4. Click Choose Playing Techniques  beside the Playback playing technique field to open 
the Playback Technique Combinations dialog.

5. Select the playback techniques you want.

TIP

You can select a single playback technique or combine multiple playback techniques. To 
select multiple playback techniques, Ctrl/Cmd -click each playback technique.

6. Click OK to add the selected playback techniques and close the Playback Technique 
Combinations dialog.

7. Choose one of the following options:

● Replace: Allows you to use this playing technique instead of the default playing 
technique defined for this combination of notehead and staff position.

● Add: Allows you to add this playing technique on top of the default playing technique 
defined for this combination of notehead and staff position.

8. Choose any articulations and the tremolo stroke that you want from the available options.

9. Click OK to save your changes and close the dialog.

RESULT
The behavior of the selected playing technique in playback is changed.

RELATED LINKS
Percussion Instrument Playing Techniques dialog on page 1421
Creating new playing technique-specific noteheads on page 1425
Playback Technique Combinations dialog on page 773
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Playback techniques
Playback techniques link together the notations you input into your music and techniques/
articulations in sound libraries in order to produce the correct sounds in playback. They are used 
by expression and percussion maps to trigger the appropriate commands, such as key switches 
or control changes.

● You can map playback techniques as required for different sound libraries in the Expression 
Maps dialog, including creating new combinations of existing playback techniques, such as 
Legato and Tremolo, which allows them to be used simultaneously.

● You can see which playback techniques are in use at any particular rhythmic position in the 
Playing Techniques editor for the corresponding instrument/voice.

When you input notations, such as playing techniques, tremolos, jazz articulations, or 
articulations, the corresponding expression maps look for the appropriate playback techniques. 
For example, inputting pizz. playing techniques causes expression maps to use the Pizzicato 
playback technique to switch to the pizzicato sound for playback. If the expression map cannot 
locate the sound, the playback technique applied either remains the same as the previous 
playback technique or reverts to the natural playback technique.

In Dorico Elements, there are the following types of playback techniques:

Attribute
Only applies to a single note at the corresponding rhythmic position, such as an up 
bow playing technique or staccato articulation.

Direction
Applies from the corresponding rhythmic position onwards, until it is replaced by 
another playback technique, such as pizzicato followed by arco.

TIP

● Custom playing techniques that use playback techniques which do not already exist 
in expression maps do not play back automatically. In order for them to play back 
appropriately, you must add them to the expression maps for each instrument for which 
you want to use them. You must also assign an action for each custom playing technique 
that determines how the switch that triggers the technique is controlled.

● If you have input a playing technique but cannot hear a change in the sound, you might 
be using a combination of playback techniques that the expression map does not expect. 
For example, if you input a new playing technique without cancelling an existing playing 
technique, the expression map cannot process the two corresponding playback techniques 
together if the expression map does not have an entry for those two techniques combined.

To avoid playback technique clashes, you can add playback techniques that cannot be in use 
concurrently to the same mutual exclusion group in the corresponding expression maps. 
Alternatively, you can create a combination of those playback techniques in order to use 
them simultaneously.

● You can enable independent voice playback for individual instruments to hear different 
playing techniques, tremolos, jazz articulations, or articulations in different voices 
simultaneously.

RELATED LINKS
Expression maps on page 761
Expression Maps dialog on page 762
Playback Technique Combinations dialog on page 773
Enabling independent voice playback on page 545
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Creating new expression maps on page 776
Adding/Editing mutual exclusion groups in expression maps on page 779
Playing Techniques editor on page 690
Playing techniques on page 1180
Tremolos on page 1399
Jazz articulations on page 1145
Articulations on page 804

Edit Playback Techniques dialog
The Edit Playback Techniques dialog allows you to define new playback techniques and edit 
existing ones. Playback techniques are used by expression maps to assign the correct sounds to 
the required notations in the music, such as playing techniques, tremolos, jazz articulations, and 
articulations.

● You can open the Edit Playback Techniques dialog by choosing Library > Playback 
Techniques.

The Edit Playback Techniques dialog contains the following sections and options:

1 Category menu

Allows you to filter the list of playback techniques by selecting a category from the menu, 
such as Techniques or Dynamics.

2 Playback techniques list

Contains all the playback techniques in the project within the currently selected category.

The action bar at the bottom of the list contains the following options:

● New : Adds a new blank playback technique.

● New from Selection : Creates a copy of an existing playback technique that you can 
edit separately from the original.

● Save as Default : Saves the selected playback technique to your user library, allowing 
you to use it in multiple projects. Appears as  for playback techniques saved as default.

● Revert to Factory : Removes all your changes to the selected playback technique, 
returning it to its saved settings.

● Delete : Deletes the selected playback technique.
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NOTE

You cannot delete predefined playing techniques or any playing technique that is 
currently used in your project.

3 Name

Allows you to edit or enter the name of the playback technique. This is the name shown in 
lists in the Edit Playing Techniques, Expression Maps, Playback Technique Combinations, 
and Percussion Maps dialogs.

4 Playback options

● Alias for: Allows you to select another playback technique whose sound mapping you 
want to apply to the selected playback technique as well.

● Group: Sets the group in which this playback technique appears.

● Fallback: Allows you to specify another playback technique that can be used if the 
present one is not available.

● Articulation type: Sets the duration over which the playback technique takes effect. 
Attribute applies only to the note at the rhythmic position where the playing technique 
is found, such as a staccato articulation, while Direction applies to all following notes 
until it is replaced by another playing technique, such as pizzicato.

RELATED LINKS
Expression Maps dialog on page 762
Playback Technique Combinations dialog on page 773
Adding/Editing mutual exclusion groups in expression maps on page 779
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Notation reference



Introduction

This notation reference contains information about the accepted conventions for presenting 
different notations and how to change their appearance and placement in Dorico Elements, both 
for individual items and by changing default settings.

It also contains instructions for inputting more complex notations, such as cross-staff glissando 
lines, which are described in the corresponding chapter.

Tasks in the notation reference outline the default per-layout changes you can make in Layout 
Options, such as changing the frequency of bar numbers, and the individual changes you can 
make to items, which often involve using properties in the Properties panel.

More detailed default options, such as precise spacing gaps between different items, are 
available in Dorico Pro.

You can find basic input methods for notations in the Write mode chapter.

RELATED LINKS
Write mode on page 195
Layout Options dialog on page 745
Properties panel on page 663
Notations input on page 271
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Accidentals

Accidentals are shown beside notes to indicate their pitch, both when notated on a staff and 
written out in text. In music based in Western tonality, they usually show that the pitch of a note 
has been altered so that it does not conform to the prevailing key signature.

In Dorico Elements, each note has its own fixed pitch that is independent of the prevailing key 
signature, and accidentals are automatically hidden and shown as appropriate. For example, if 
you input F♮s and then add a D major key signature before them, they do not turn into F♯s; they 
remain F♮s and show natural accidentals. However, if you input the D major key signature first, 
any Fs you then input without stating an accidental are input as F♯s.

There are different conventions for accidental duration rules, such as not repeating the same 
accidental on subsequent notes of the same pitch in the same bar. In music that has no key 
signatures, some or all notes might require accidentals, depending on the notation convention in 
use.

You can use accidental duration rules to determine when accidentals are shown.

RELATED LINKS
Accidental duration rules on page 800
Inputting notes on page 224
Inputting accidentals on page 244

Deleting accidentals
You can delete accidentals according to their type, and you can delete all accidentals from a 
selection of notes with different accidentals at the same time. This changes the pitch of the 
selected notes.

NOTE

These steps do not apply to cautionary accidentals, such as those shown on natural notes that 
follow the same notes with an accidental but in a different octave. In Dorico Elements, you can 
hide, show, or parenthesize cautionary accidentals in each flow and on individual notes.

PROCEDURE

1. In Write mode, select the notes whose accidentals you want to delete.

2. Delete accidentals in any of the following ways:

● To delete naturals, press 0 .

● To delete flats, press - .
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● To delete sharps, press = .

● In the Notes panel, click the accidentals you want to delete.

RESULT
The corresponding accidentals are deleted from the selected notes. This changes their pitch. For 
example, deleting the sharp from a G♯ turns it into G♮.
NOTE

● Depending on the accidental duration rule applied to the flow, deleting accidentals might 
cause accidentals to appear on subsequent notes of the same pitch in the same bar. When 
you select single notes or multiple notes in the same voice at the same rhythmic position, 
their pitches are shown in the status bar and as depressed keys in the Keyboard panel.

● To delete accidentals from a selection of notes with different accidentals, we recommend 
that you revert them all to natural by pressing 0  or clicking Natural in the Notes panel. 
This is because re-inputting an accidental over a selection of notes with different accidentals 
adds that accidental to every note in the selection. For example, two G♯s followed by two G♭s 
become four G♯s if you re-input a sharp. If you click Sharp or press =  twice, all accidentals 
are deleted.

RELATED LINKS
Inputting accidentals on page 244
Changing the pitch of individual notes on page 468
Notes panel on page 200
Status bar on page 38
Keyboard panel on page 206

Hiding/Showing or parenthesizing accidentals
You can hide/show individual accidentals, or show them in round or square brackets, including 
cautionary accidentals shown by default. For example, you can show cautionary accidentals on 
subsequent notes in tie chains that cross system/frame breaks by showing accidentals in round 
brackets. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose accidentals you want to hide/show or parenthesize. You can do this in 
Write mode and Engrave mode.

NOTE

You can only select individual noteheads within tie chains in Engrave mode.

2. In the Properties panel, activate Accidental in the Notes and Rests group.

3. Select one of the following options from the menu:

Accidentals
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● Hide

● Show

● Round brackets

● Square brackets

RESULT
Accidentals on the selected notes are shown, hidden, or shown in round or square brackets. If 
the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

If colors for accidentals are shown, accidentals that you have shown manually appear teal.

NOTE

● Hiding accidentals does not affect the pitch of notes in playback.

● If you are hiding/showing many accidentals, we recommend that you consider changing the 
accidental duration rule.

● You can assign key commands for different accidental hiding, showing, and parenthesizing 
commands on the Key Commands page in Preferences.

AFTER COMPLETING THIS TASK
You can also hide/show or parenthesize accidentals on artificial harmonics shown using diamond 
noteheads, independently of the normal noteheads that indicate the stopped pitch.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Accidental duration rules on page 800
Hiding/Showing or parenthesizing cautionary accidentals on page 801
Hiding/Showing or parenthesizing harmonic accidentals on page 1084
Hiding/Showing cautionary key signatures on page 1025

Changing the size of accidentals
You can change the size of accidentals individually without changing the size of the noteheads 
to which they apply; for example, to show editorial accidentals at a smaller size than normal 
accidentals. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the accidentals whose size you want to change.

2. In the Properties panel, activate Accidental scale in the Notes and Rests group.

3. Change the value in the value field.

Accidentals
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4. Press Return .

RESULT
The scale size of the selected accidentals is changed. For example, changing the value to 50 
scales the selected accidentals to half their normal size. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

Hiding/Showing colors for accidentals
You can show cautionary accidentals and accidentals that you have shown manually in different 
colors, independently of each other.

Colors for accidentals are considered annotations and are not printed by default.

PROCEDURE

● Do one of the following:

● To hide/show colors for cautionary accidentals, choose View > Note And Rest Colors > 
Cautionary Accidentals.

● To hide/show colors for forced accidentals, choose View > Note And Rest Colors > 
Forced Accidentals.

RESULT
Colors for accidentals are hidden/shown. Cautionary accidentals appear pink, while forced 
accidentals appear teal.

EXAMPLE

Colors for both cautionary and forced accidentals shown

RELATED LINKS
Hiding/Showing or parenthesizing accidentals on page 793
Hiding/Showing or parenthesizing cautionary accidentals on page 801
Changing music area colors on page 54
Hiding/Showing voice colors on page 1439
Annotations on page 597

Stacking of accidentals
If multiple accidentals are required for a chord in a single voice, or for notes in multiple voices at 
the same rhythmic position, they are stacked to the left of the chord in columns.

For chords with multiple accidentals, accidentals are generally stacked as follows:

1. The highest accidental is inserted in the first column immediately to the left of the notes.

Accidentals
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2. The lowest accidental is added to the same column, provided that it does not collide with the 
first accidental.

3. The remaining highest and lowest accidentals are alternated in successive columns located 
further left from the chord.

In Dorico Elements, additional rules help to produce a stack of accidentals that uses as few 
columns as possible. The following list contains some of the rules that are applied:

● Columns closer to the notes contain more accidentals than columns further from the notes.

● Accidentals on notes that are an octave apart are stacked in the same column. This also 
applies to accidentals that are a sixth or more apart, depending on the combination of 
accidentals.

● Accidentals in the same column never collide. The minimum interval between accidentals 
that is required to prevent collisions depends on the types of accidentals.

● Accidentals that are a second apart are arranged in adjacent columns, with the higher 
accidental in the right-hand column.

These rules minimize the amount of extra space that is required between successive notes or 
chords and ensure that accidentals appear as close as possible to the noteheads to which they 
apply. At the same time, they produce a contour that resembles a C-curve on the left-hand side of 
the chord.

Accidental stacking rules for dense chords

Dorico Elements uses special stacking calculations in dense chords with multiple accidentals to 
ensure legibility. Chords are considered dense when they have six or more accidentals within the 
span of an octave.

For dense chords, accidentals are stacked as follows:

1. The highest accidental is inserted in the first column to the left of the notes.

2. The next accidental on a note that is located at least a seventh below the highest note 
is stacked into the same column. This continues with the remaining notes until no more 
accidentals fit into the first column.

3. Steps 1 and 2 are repeated for the following columns until all accidentals are stacked.

4. The columns are grouped, interspersed, and re-stacked. This results in a stack with 
alternating accidentals, reminiscent of the way accidentals are arranged in a key signature.

By default for dense chords, Dorico Elements uses a lattice arrangement of accidentals, rather 
than the usual zig-zag arrangement. In very dense chords, the lattice arrangement can be wider 
and require more columns.

RELATED LINKS
Changing the column of accidentals on page 797
Moving accidentals graphically on page 797

Kerning of accidental columns
Dorico Elements applies kerning to accidental columns to ensure that the columns to the left of a 
chord occupy as little horizontal space as possible.

In typography, kerning adjusts the space between individual characters to increase legibility. In 
Dorico Elements, as well as in music engraving in general, kerning allows accidentals to interlock.

Accidentals
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EXAMPLE
If a low note is followed by a high note with an accidental, the accidental can be tucked above the 
low note to prevent the note spacing from being distorted.

Similarly, in the case of multiple columns of accidentals on a chord, the overall width of the stack 
of accidentals is reduced if, for example, a flat in the second column is kerned underneath a 
sharp in the first column belonging to a note a third higher. This also reduces the need to distort 
note spacing to accommodate accidentals.

Changing the column of accidentals
You can change the column of individual accidentals; for example, so they appear closer to the 
stem than other accidentals in the chord. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the notes or accidentals whose accidental column you want to 
change.

2. In the Properties panel, activate Accidental column in the Notes and Rests group.

3. Change the value in the value field.

RESULT
The column of the selected accidentals is changed. Accidentals with lower Accidental column 
values are placed closer to noteheads, while accidentals with higher values are placed further 
from noteheads. If necessary, Dorico Elements automatically changes the column of other 
accidentals at the same rhythmic position.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Tucking index properties on page 518

Moving accidentals graphically
You can move individual accidentals graphically to the right or left; for example, to reduce the 
horizontal spacing required for accidentals in a single dense chord. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

Accidentals
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NOTE

You cannot move accidentals rhythmically. If you want to change the notes to which accidentals 
apply, you must delete them from their original notes and input new accidentals on the new 
notes or change the pitch of existing notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the accidentals you want to move. You can also select their 
noteheads.

2. In the Properties panel, activate Accidental X offset in the Notes and Rests group.

3. Move the accidentals in one of the following ways:

● To move them to the right, increase the value in the value field.

● To move them to the left, decrease the value in the value field.

RESULT
The selected accidentals are moved graphically. If necessary, Dorico Elements automatically 
increases note spacing to accommodate the accidentals and avoid collisions.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

RELATED LINKS
Properties panel on page 663
Adjusting note spacing at individual rhythmic positions on page 509

Altered unisons
Altered unisons occur when two or more notes of the same name in the same octave have 
different accidentals in the same chord, such as D♯ and D♭.
In Dorico Elements, this is notated with a split stem by default. Split stems show the main body 
of a chord with a stem branch coming off the main stem that connects noteheads in altered 
unisons to the chord. This allows all notes to appear with their corresponding accidental directly 
beside them. A split stem is also known as a “cherry stalk” or a “tree”.

You can show individual altered unisons with a single stem, meaning noteheads appear directly 
beside each other, and the two accidentals are shown beside each other to the left of the chord.

You can also change the default appearance of all altered unisons in each flow independently on 
the Accidentals page in Notation Options.

NOTE

If a chord contains notes a second interval apart and one of those notes has an altered unison, it 
is always shown with a split stem, regardless of your setting. This is to ensure clarity in clusters.

Accidentals
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EXAMPLE

A single stem altered unison A split stem altered unison

RELATED LINKS
Inputting chords on page 251
Notation Options dialog on page 747

Changing how altered unisons appear
You can change how individual altered unisons appear, including within chords containing other 
altered unisons, and independently of your per-flow settings. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the altered unison notes whose appearance you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Split stem in the Notes and Rests group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected altered unison notes are shown with split stems when the checkbox is activated, 
and with single stems when the checkbox is deactivated. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

● Split stem applies to individual notes. You can have altered unisons appear differently within 
the same chord by setting their properties independently.

● You can change the default appearance of all altered unisons in each flow independently in 
Notation Options > Accidentals > Altered Unisons.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Notation Options dialog on page 747
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Microtonal accidentals
Microtonal accidentals indicate pitches beyond the standard accepted chromatic scale in Western 
tonality, such as a quarter sharp or quarter flat. Microtonal accidentals are only shown in Dorico 
Elements if you open a project that already contains them. They are available for input only 
where the corresponding key signature and tonality system apply.

Accidental duration rules
Accidental duration rules determine how long accidentals apply, such as within a bar, at a 
different octave, or just for a single note. Dorico Elements allows you to use different accidental 
duration rules.

● You can find the available accidental duration rules on the Accidentals page in Notation 
Options.

Common practice

In common practice, an accidental affects all notes of the same pitch in the same octave within 
the same bar, unless it is cancelled by another accidental. If it is not cancelled, it is automatically 
cancelled in the following bar.

It is customary to show cautionary accidentals on subsequent notes in certain circumstances. For 
example, in the key of G major, an F♯ in a bar following an F♮ shows a cautionary sharp sign, 
even though the sharp is included in the key signature. Cautionary accidentals are also known as 
“courtesy accidentals”.

When using the common practice accidental duration rule, you can choose to hide, show, or 
parenthesize cautionary accidentals in different circumstances.

In Dorico Elements, common practice is the default accidental duration rule.

Second Viennese School

The Second Viennese School accidental duration rule states that each accidental only applies to a 
single note. All notes show an accidental regardless of key signature, including naturals.

This accidental duration rule was used by Schoenberg and other composers of the Second 
Viennese School.

You can customize the options within the Second Viennese School accidental duration rule when 
changing the accidental duration rule, including choosing whether immediate repetitions of the 
same note within the same bar require a restatement of the accidental.

Modernist

The Modernist accidental duration rule states that only notes that have been altered from the 
key signature show accidentals. Naturals are not shown. However, accidentals that are shown 
only apply to the notes on which they are written, as with the Second Viennese School.

Charles Ives and Robert Crumb used this variation.

You can customize the options within the Modernist accidental duration rule when changing the 
accidental duration rule, including choosing whether or not the same accidental on the same 
pitch is restated later in the bar if the subsequent pitches occur immediately and if subsequent 
pitches occur after other, different notes. Similarly, there are options for accidentals on notes 
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in different octaves in the same bar and following bar. There is also an option controlling the 
restatement of accidentals within beam groups.

RELATED LINKS
Notation Options dialog on page 747

Changing the accidental duration rule
You can change the accidental duration rule in each flow independently; for example, if the 
Modernist accidental duration rule is appropriate for certain flows in your project but common 
practice is appropriate for others. In Dorico Elements, common practice is the default accidental 
duration rule.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to change the accidental duration rule.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Accidentals.

4. In the Basic section, choose one of the following options for Accidental duration rule:

● Common Practice

● Second Viennese School

● Modernist

5. Optional: Customize the options for your chosen accidental duration rule.

TIP

Options in the Basic section can apply to all accidental duration rules.

6. Click Apply, then Close.

Hiding/Showing or parenthesizing cautionary accidentals
You can hide/show cautionary accidentals, or show them in parentheses, in different 
circumstances by default in flows that use the common practice accidental duration rule.

PREREQUISITE
The flows in which you want to hide, show, or parenthesize cautionary accidentals use the 
common practice accidental duration rule.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to hide, show, or parenthesize cautionary 
accidentals.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Accidentals.

Accidentals
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4. In the Cautionary Accidentals section, change each option as required.

For example, you can show cautionary accidentals for notes at different octaves in the same 
bar, but hide them in the following bar.

5. Click Apply, then Close.

RESULT
Cautionary accidentals are hidden, shown, or parenthesized in the corresponding circumstances 
in the selected flows.

If colors for accidentals are shown, cautionary accidentals appear pink.

TIP

For flows using the Modernist accidental duration rule, options for cautionary accidentals are 
available in the Modernist Options section of the Accidentals page.

RELATED LINKS
Hiding/Showing colors for accidentals on page 795

Changing the cancellation of double accidentals
You can change the convention of double accidental cancellation in each flow independently; 
for example, if some flows in your project require archaic cancellation. You can do this in 
combination with any accidental duration rule.

By default, Dorico Elements uses modern cancellation.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to change the double accidental 
cancellation convention.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Accidentals.

4. In the Basic section, choose one of the following options for Single accidentals cancelling 
double accidentals:

● To show naturals immediately before single accidentals that come after double 
accidentals, choose Use archaic cancellation.

● To replace double accidentals with single accidentals without showing naturals, choose 
Use modern cancellation.

5. Click Apply, then Close.

RESULT
The double accidental cancellation convention is changed in the selected flows.

Accidentals
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EXAMPLE

Archaic cancellation Modern cancellation
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Articulations

Articulations are markings that are drawn above or below notes and chords. Articulations tell a 
performer how to attack a note or how long to play a note relative to its notated duration.

In Dorico Elements, articulations are defined as something that alters the way a note is played, 
in a way that is consistent across all instruments. Because instructions like bowing directions, 
harmonics, or tonguing apply to different instrument groups, in Dorico Elements such directions 
are defined as playing techniques.

A musical phrase with accent, staccato, and staccatissimo articulations

Articulations are categorized into the following types:

Articulations of force
Indicate a stronger attack at the start of notes, and include articulations such as accent 
and marcato. Marcato is also sometimes known as a “strong accent”. Dorico Elements 
shows these articulations at the start of a note or tie chain by default.

Articulations of duration
Indicate a shorter duration than notated, and include articulations such as 
staccatissimo, staccato, tenuto, and staccato-tenuto. Staccato-tenuto is also sometimes 
known as a “louré”. If a note includes ties, Dorico Elements shows articulations of 
duration above the last note in the chain by default.

Articulations of stress
Indicate notes that should be emphasized or not emphasized where that contradicts 
the prevailing meter, using stressed and unstressed marks. Dorico Elements shows 
these articulations at the start of a note or tie chain by default.

Dorico Elements positions articulations automatically on the notehead or stem side of notes 
and chords, according to the musical context. A note or chord can display one of each type of 
articulation.

RELATED LINKS
Inputting articulations on page 271
Articulations in playback on page 809
Positions of articulations on page 805
Changing the positions of articulations on tie chains on page 807
Playback techniques on page 787
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Copying and pasting articulations
You can copy an existing phrase and paste only its slurs, articulations, and jazz articulations to 
another phrase, without affecting the pitches of notes.

PROCEDURE

1. In Write mode, make a selection containing the slurs, articulations, and jazz articulations you 
want to copy.

2. Press Ctrl/Cmd-C  to copy the selected phrase.

3. Select the first note to which you want to paste articulations.

4. Choose Edit > Paste Special > Paste Articulations. You can also choose this option from the 
context menu.

RESULT
Slurs, articulations, and jazz articulations included in the selection are pasted to notes from the 
selected note onwards.

RELATED LINKS
Large selections on page 424
Copying and pasting notes/items on page 457
Repitching notes without changing their rhythm on page 472
Arranging tools on page 455

Deleting articulations
Individual articulation markings cannot be selected and deleted separately from their notehead 
in Write mode, so articulations must be deleted by selecting the note or notes to which they are 
attached, and deselecting the articulation.

PROCEDURE

1. In Write mode, select the notes whose articulations you want to delete.

2. Deselect the articulations in any of the following ways:

● Press the key commands of the articulations you want to delete.

● In the Notes panel, click the articulations you want to delete.

RELATED LINKS
Notes panel on page 200
Hiding/Showing zones on page 44
Key commands for articulations on page 272

Positions of articulations
There are established conventions for the position and placement of articulations relative 
to notes, the staff, and staff lines, which ensure articulations are always clearly visible. For 
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the smallest articulations, such as staccato marks, correct placement relative to staff lines in 
particular is vital.

Placement of articulations

Articulations are placed on the notehead side by default, with the following exceptions:

● In single-voice contexts, marcato is always placed above the staff, regardless of the stem 
direction of the note or chord on which it is used. In multiple-voice contexts, marcato can 
also be placed below the staff.

● If multiple voices are active, articulations are placed at the end of the stem side of a note 
or chord. This clarifies which articulations belong to the up-stemmed notes and which to the 
down-stemmed notes.

● If a note is placed on the middle staff line or on the space immediately on either side, 
articulations that are less than a space in height are centered in the next unoccupied space. 
This normally only applies to staccato and tenuto. If a note in the middle of the staff has a 
staccato-tenuto articulation, the component parts of the articulation are split up and placed 
in separate spaces.

● If an articulation cannot fit within a staff space, or if the note is placed high or low on the 
staff, the articulation is placed outside the staff.

● If a note or chord is tied and the tie is placed above or below the notehead, articulations that 
are placed on the notehead side of a note or chord are offset by an additional 1/4 space in 
order to avoid the end of the tie.

Articulations on the notehead side are always centered horizontally on the notehead. This 
also applies to articulations on the stem side, except if the only articulation is a staccato or 
staccatissimo. In this case, the articulation is centered on the stem.

Articulations in tie chains

By default, articulations of force and stress are shown on the first note/chord in tie chains, while 
articulations of duration are shown on the last note/chord.

You can change where in tie chains articulations appear individually.

RELATED LINKS
Moving items graphically on page 514
Changing the placement of articulations relative to notes on page 808
Changing the placement of articulations relative to slurs on page 808

Order of articulations
If there are multiple articulations on the same notes, their vertical position and proximity to 
noteheads/stems depends on their type.

Articulations are positioned in the following order:

1. Articulations of duration are positioned closest to notehead/stems.

2. Articulations of force are positioned outside articulations of duration.

3. Articulations of stress are positioned furthest from noteheads/stems.

Order of articulations in relation to slurs

Articulations of duration are positioned as follows:

Articulations
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● Inside slurs that start/end on a note or chord with an articulation.

● Inside the curvature of a slur.

● Inside tuplet brackets.

Articulations of force are positioned as follows:

● Outside slurs that start/end on a note or chord with an articulation, except if they can be 
positioned within the staff.

● Inside the curvature of a slur if they fit between the slur and the note or stem, to which they 
belong, without colliding.

● Outside tuplet brackets.

Force and stress articulations outside the ends of the 
slur

Duration articulations inside the ends of the slur

Changing the positions of articulations on tie chains
You can change where in tie chains articulations appear individually. By default, articulations of 
force and stress are shown on the first note/chord in tie chains, while articulations of duration 
are shown on the last note/chord.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the tied notes/chords whose articulation position you want to change. You can do this 
in Write mode and Engrave mode.

2. In the Articulations group of the Properties panel, activate Pos. in tie chain under the 
corresponding heading for the articulation whose position you want to change.

For example, activate Pos. in tie chain under the Articulations of force heading to change 
the position of accents.

3. Choose one of the following options:

● First note

● Last note

RESULT
The position of articulations in the selected tie chains is changed.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503

Articulations
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Changing the placement of articulations relative to notes
You can change whether individual articulations are placed on the notehead side or stem side of 
notes. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes/chords whose articulation placement you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Articulations group of the Properties panel, activate Placement under the 
corresponding heading for the articulations whose placement you want to change.

For example, activate Placement under the Articulations of force heading to change the 
placement of accents.

3. Select one of the following options from the menu:

● Notehead side

● Stem side

RESULT
The articulation is placed on the selected side of the notes or chords. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain. If this creates a 
collision with other markings, such as playing techniques, Dorico Elements automatically makes 
adjustments to make sure all markings are clear and legible.

Changing the placement of articulations relative to slurs
You can change whether individual articulations of duration are placed inside or outside slur 
endpoints. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

NOTE

These steps only apply to articulations of duration. They do not apply to articulations of force or 
stress.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes/chords whose articulation placement you want to change. You can do this in 
Write mode and Engrave mode.

Articulations
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2. In the Properties panel, activate Inside slur endpoint in the Articulations group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Articulations of duration are placed inside slur endpoints when the checkbox is activated, and 
outside slur endpoints when the checkbox is deactivated. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Slur endpoints relative to articulations on page 1286

Articulations in playback
Articulations affect how notes sound in playback. Depending on whether your sound library has 
specific samples for different articulations, Dorico Elements changes playback in different ways 
to reflect articulations.

● If your sound library includes samples for articulations, Dorico Elements loads the required 
samples using playback techniques. Additionally, Dorico Elements makes notes with 
staccatos sound shorter and notes with accents sound louder.

● If your sound library does not include samples for articulations, Dorico Elements adjusts 
notes according to the articulation without loading different samples. For example, making 
notes with staccatos sound shorter and notes with accents sound louder.

Because articulations apply to whole notes, samples are triggered at the start of notes, including 
tie chains.

TIP

● You can find options on the Timing page in Playback Options for the default effect of 
articulations of duration. You can find options for articulations of force on the Dynamics 
page.

● You can enable independent voice playback for individual instruments to hear different 
sounds in different voices simultaneously; for example, if you have slurs in one voice and 
staccatos in another voice.

RELATED LINKS
Playback techniques on page 787
Playback Options dialog on page 749
Enabling independent voice playback on page 545
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Bars

Bars indicate a usually regular pattern of beats, determined by the prevailing time signature. 
Bars are separated from adjacent bars by vertical barlines, and each bar has a unique bar 
number.

Dorico Elements automatically numbers bars and shows barlines between bars as required for 
the prevailing time signature.

RELATED LINKS
Barlines on page 815
Bar numbers on page 826
Note and rest grouping on page 860
Time signatures on page 1381
Pick-up bars on page 1386
Input methods for bars, beats, and barlines on page 300
Input methods for time signatures and pick-up bars on page 283
Hiding/Showing time signatures on page 1396

Bar length
Bars usually last the same duration and start and end at the same positions for all players. 
However, some music involves bars of different lengths coinciding, and there are situations 
where some players may have no bars indicated at all.

You can change the duration of a bar by changing its time signature or, in music in open meter, 
by inputting barlines where required. You can hide time signatures you do not want to show in 
the music; for example, if you are writing music with an irregular meter and you require barlines 
only to group material together, but not to imply any sense of meter.

Deleting bars/beats
You can delete whole bars and specific beats of music from your project completely by using the 
bars and barlines popover.

PROCEDURE

1. In Write mode, select one of the following:

● The first bar you want to delete, or the first note or rest in that bar.

● An item at the rhythmic position from which you want to delete beats.

2. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

3. Enter – (minus), followed by the number of bars or beats you want to delete into the 
popover.

For example, enter –6 to delete six bars, meaning the bar you selected and the subsequent 
five bars, or -2q to delete two quarter note beats, starting from the selected rhythmic 
position.
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4. Press Return  to close the popover.

RESULT
The number of bars or beats specified is deleted. Just as when Insert mode is activated, music to 
the right of the selection moves up to fill in the gap.

NOTE

● Any signposts in the selection are also deleted.

● Deleting some, but not all, beats from bars according to the prevailing time signature 
deletes the contents of those beats only. If you want to shorten a bar’s duration, such as at 
the end of flows that start with a pick-up bar, you must instead either input a time signature 
with the required number of beats then hide the time signature, or input a barline and 
delete any excess bars if necessary. You can also use the Global Adjustment of Current Bar 
Insert mode scope and delete notes/rests.

● You can also delete bars by selecting the bars you want to delete, then choosing Edit > 
Delete Bars.

RELATED LINKS
Bars and barlines popover on page 301
Pick-up bars on page 1386
Deleting notes/items on page 455
Deleting rests on page 1276
Insert mode on page 451
Signposts on page 450

Deleting bars/beats with the system track
You can delete whole bars and selected beats from your project completely using the system 
track.

PREREQUISITE
The system track is shown.

PROCEDURE

1. In the system track in Write mode, select the region that you want to delete.

2. Click Delete  in the system track. It can also appear above the system track if your 
selection is narrow.

The system track changes color when you hover your mouse pointer over Delete .

RESULT
The selected region is deleted. Just as when Insert mode is activated, music to the right of the 
selection moves up to fill in the gap.

NOTE

● Any signposts in the selection are also deleted.

● Deleting some, but not all, beats from bars according to the prevailing time signature 
deletes the contents of those beats only. If you want to shorten a bar’s duration, such as at 
the end of flows that start with a pick-up bar, you must instead either input a time signature 
with the required number of beats then hide the time signature, or input a barline and 
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delete any excess bars if necessary. You can also use the Global Adjustment of Current Bar 
Insert mode scope and delete notes/rests.

● You can also delete bars by selecting the bars you want to delete, then choosing Edit > 
Delete Bars.

RELATED LINKS
System track on page 425

Deleting empty bars/beats at the end of flows
You can trim flows by deleting any empty bars or beats left at the end.

PROCEDURE

1. In Write mode, select an item in the flow you want to trim.

2. Open the bars and barlines popover in any of the following ways:

● Press Shift-B .

● In the Notations toolbox, click Popovers , then Bars and Barlines .

3. Enter trim into the popover.

4. Press Return  to close the popover.

RESULT
Empty bars/beats at the end of the selected flow are deleted.

TIP

You can also trim flows by choosing Write > Trim Flow.

RELATED LINKS
Bars and barlines popover on page 301
Splitting flows on page 501
Deleting rests on page 1276

Deleting the contents of bars
You can delete just the contents of bars without deleting barlines or the bars themselves.

PROCEDURE

1. In Write mode, select the bars whose contents you want to delete.

TIP

Notes, rests, and other objects are highlighted orange when selected.

2. Press Backspace or Delete .

RELATED LINKS
Large selections on page 424
Filters on page 429
Insert mode on page 451
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Changing the width of empty bars
You can change the width of empty bars individually in Engrave mode.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select a square note spacing handle at the rhythmic position of the barline 
at the end of each empty bar whose width you want to change.

2. Adjust the spacing in any of the following ways:

● To increase the space to the left of the selected handles, press Alt/Opt-Right Arrow .

● To decrease the space to the left of the selected handles, press Alt/Opt-Left Arrow .

NOTE

● To move handles by large increments, press Ctrl/Cmd  plus the standard key 
command; for example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move handles by moderate increments, press Shift  plus the standard key 
command; for example, Shift-Alt/Opt-Left Arrow .

● To move handles by small increments, press Ctrl/Cmd - Shift  plus the standard key 
command; for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● You cannot move note spacing handles with the mouse, you can only move them 
using the keyboard.

RESULT
The width of the selected empty bars is changed. For example, if you select the handle of the 
barline on the right of a bar and nudge the handle to the left, the bar appears narrower. If you 
select the barline on the right of a bar and nudge the handle to the right, the bar appears wider.

RELATED LINKS
Engrave toolbox on page 503
Note spacing on page 507
Hiding/Showing bar rests in empty bars on page 1277
Hiding/Showing multi-bar rests on page 1279

Splits in bars
You can split bars rhythmically by changing the number of beats in each bar. You can split bars 
visually across system or frame breaks, which might be required in music with an irregular meter 
or in passages of polymeter.

Splitting bars by inputting new time signatures

You can split bars into two or more bars by changing the time signature at any rhythmic 
position. New time signatures apply until the next existing time signature or the end of the 
flow, whichever comes first.

Bars
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NOTE

If you change the time signature in the middle of an existing bar, we recommend inputting 
another time signature at the start of the preceding bar reflecting its new rhythmic duration to 
avoid confusion.

Splitting bars by inputting new barlines

You can also split bars by inputting new barlines that are not normal (single) barlines anywhere 
within a bar without affecting the time signature. However, inputting a normal (single) barline 
anywhere within an existing bar resets the prevailing time signature from that point onwards.

For example, selecting the third quarter note (crotchet) in a 4/4 bar and inserting a new barline 
causes a new 4/4 bar to start from the added barline. This leaves the equivalent of a 2/4 bar 
without a time signature to the left of the barline, but the bars to the right of the added 
barline are in 4/4 and continue to be in 4/4 until the next time signature or the end of the flow, 
whichever comes first.

Signposts are shown at the position of each barline that you add manually within bars.

Two 4/4 bars with quarter notes Adding a normal barline halfway through the first 
4/4 bar restarts the time signature from that point.

RELATED LINKS
Input methods for bars, beats, and barlines on page 300
Input methods for time signatures and pick-up bars on page 283
Inserting system breaks on page 634
Inserting frame breaks on page 637
Insert mode on page 451
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Barlines

Barlines are vertical lines that cross staves in order to show how music is divided into bars, 
according to the time signature. The most commonly used barline is the single barline between 
adjacent bars, but there are different types, such as double or repeat barlines.

The final system in a piece in 12/8 containing a key change with double barline, three normal barlines, and a 
final barline at the end

Dorico Elements automatically shows barlines as required for the prevailing time signature. For 
example, Dorico Elements automatically shows dashed barlines between the different meters in 
aggregate time signatures. If you change the time signature, Dorico Elements moves the barlines 
as required so that subsequent music is barred correctly.

By default, Dorico Elements uses single barlines in flows and final barlines at the end of flows. 
You can change the default barline used in and at the end of each flow independently.

Barlines automatically extend across staff groups that are joined by a bracket or brace.

NOTE

Because of their intrinsic connection, barlines are considered part of time signatures in Dorico 
Elements. Therefore, explicit barlines that you have input directly are treated as hidden time 
signatures and break multi-bar rests.

Explicit single barlines appear with time signature signposts.

RELATED LINKS
Types of barlines on page 816
Input methods for bars, beats, and barlines on page 300
Barlines across staff groups on page 822
Changing the default barline type in flows on page 817
Changing the default barline at the end of flows on page 818
Repeats in playback on page 549
Repeat counts on page 1242
Bars on page 810
Bar numbers on page 826
Multi-bar rests on page 1279
Signposts on page 450
Time signatures on page 1381
Input methods for time signatures and pick-up bars on page 283
Note and rest grouping on page 860
Deleting notes/items on page 455
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Per-flow notation options for barlines
You can find options for the per-flow the appearance of barlines on the Barlines page in 
Notation Options.

For example, you can change the type of barline used in and shown at the end of each flow by 
default, whether single barlines between staves only appear between staves or extend across 
staves, and whether barlines join all staves at the end of each system and at the end of the final 
system in a flow.

Musical examples demonstrate how each option affects the appearance of your music.

RELATED LINKS
Notation Options dialog on page 747

Types of barlines
There are multiple types of barlines in Dorico Elements, which can all be input, moved, and 
deleted in the same ways.

Normal (Single)
A standard single barline that spans the entire height of the staff. For single-line staves, 
the barline extends one space above and below the staff line by default.

Explicit single barlines appear with time signature signposts.

Double
A double barline consists of two lines, both the width of a single barline, positioned half 
a space apart by default. It is often used to denote significant changes in the music, or 
to mark the placement of rehearsal marks, key signature changes, and tempo changes.

Final
A final barline consists of two lines: one of normal width, the other thick. It marks 
where the music ends.

Start repeat
A start repeat line consists of a thick barline, followed by a normal barline, followed by 
one of the following arrangements of dots:

● Two dots, one each in the middle two spaces of a five-line staff

● Four dots, one each in all four spaces of a five-line staff

It shows the start of a repeated section. It is used alongside end repeat lines, which 
show the end of a repeated section.

Barlines
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End repeat
An end repeat line is the mirror of a start repeat line, so it consists of either two or 
four dots, followed by a normal barline, followed by a thick barline. It shows the end 
of a repeated section. It is used alongside start repeat lines, which show the start of a 
repeated section.

End/Start repeat
This line combines the start repeat and end repeat barlines, with either two single 
barlines with a single shared thick barline in the middle, or two thick barlines and no 
single barlines. On either side, there are either two or four repeat dots. It is used when 
a repeated section is immediately followed by another, separate repeated section.

RELATED LINKS
Input methods for bars, beats, and barlines on page 300
Repeats in playback on page 549
Repeat counts on page 1242
Barlines across staff groups on page 822
Signposts on page 450

Changing the default barline type in flows
By default, Dorico Elements uses single barlines to separate bars in flows. You can change which 
type of barline automatically separates bars in each flow independently. For example, short or 
tick barlines are frequently used for most barlines in chant notation.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows whose default barline type you want to change.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Barlines.

4. Choose one of the following options for Default barline type:

● Normal

● Double

● Dashed

● Final

Barlines
Types of barlines 

817
Dorico Elements 5.1.30



● Tick (Top)

● Tick (Bottom)

● Short (Center)

● Short (Top)

● Thick

● Start Repeat

● End Repeat

● End and Start Repeat

5. Click Apply, then Close.

RESULT
The default barline type in the selected flows is changed. This does not override any explicit 
barlines you have input, such as repeat barlines in repeat endings, or the final barlines in the 
selected flows.

RELATED LINKS
Types of barlines on page 816
Repeat endings on page 1230
Input methods for bars, beats, and barlines on page 300

Changing the default barline at the end of flows
By default, Dorico Elements uses final barlines at the end of flows. You can choose which type 
of barline is placed automatically at the end of each flow independently; for example, you might 
show double barlines at the end of flows to indicate there should be no gap before the following 
flow.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows whose default end barline you want to change.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Barlines.

4. Choose one of the following options for Automatic barline at end of flow:

● Final barline

● Double barline

● Normal barline

● Dashed barline

● Thick barline

● No barline

5. Click Apply, then Close.

RESULT
The default final barline at the end of the selected flows is changed.

Barlines
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NOTE

You can override individual final barlines by inputting a barline of a different type, but you cannot 
delete individual final barlines.

Changing the barline shown before repeat barlines
You can change the barline shown at the end of individual systems that are followed by start 
repeat barlines at the beginning of the next system. For example, if you want to show normal 
barlines at the end of some systems following by start repeat barlines but double barlines at the 
end of others.

These steps can also apply to barlines shown before key signature changes that coincide with 
start repeat barlines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the barlines at the end of systems followed by start repeat barlines whose barline type 
you want to change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Barline at end of system in the Time Signatures group.

3. Select one of the following options from the menu:

● Normal

● Double

● Final

● Dashed

● Tick (top)

● Short (center)

● Thick

● Triple

● Short (top)

● Tick (bottom)

● None

RESULT
The barline type shown at the selected barlines is changed.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
System breaks on page 633
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Hiding/Showing systemic barlines and brackets/braces
You can hide/show systemic barlines and brackets/braces at individual system/frame breaks and 
codas; for example, when formatting music with incipits.

PREREQUISITE

● You have inserted system/frame breaks or codas at the positions where you want to hide/
show systemic barlines.

● Signposts are shown for system/frame breaks.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the system/frame break signposts or codas at the positions where you want to hide/
show systemic barlines. You can do this in Write mode and Engrave mode.

NOTE

You must select either only system/frame signposts or only codas.

2. In the Properties panel, activate/deactivate Hide systemic barline in either the Format or 
Repeat Markers group.

RESULT
Systemic barlines and brackets/braces are hidden/shown on the corresponding systems to the 
selected system/frame breaks or codas.

EXAMPLE

Systemic barline shown Systemic barline hidden

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Input methods for repeats and tremolos on page 405
Inserting system breaks on page 634
Inserting frame breaks on page 637
Hiding/Showing signposts on page 450
Changing the gap before codas on page 1242
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Hiding/Showing systemic barlines on single-staff systems
By default, systemic barlines are shown at the start of systems containing two or more staves 
and hidden on single-staff systems. You can hide/show systemic barlines on single-staff systems 
on the first system and after the first system in each flow independently.

Showing systemic barlines on single-staff systems is a convention used in hand-copied lead 
sheets, usually in combination with hiding clefs and key signatures from the second system 
onwards.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to hide/show systemic barlines after the 
first system.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Barlines.

4. In the Systemic Barline subsection, choose one of the following options for Barline at start 
of first system:

● Show for one or more staves

● Show for two or more staves

5. Choose one of the following options for Barline at start of systems following first system:

● Show for one or more staves

● Show for two or more staves

6. Click Apply, then Close.

RELATED LINKS
Notation Options dialog on page 747
Hiding/Showing used chord diagrams grids on page 898
Hiding/Showing clefs at the start of systems on page 911
Hiding/Showing key signatures at the start of systems on page 1022

Moving barlines graphically
You can adjust the spacing between barlines and neighboring notes, time signatures, key 
signatures, or rests.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select a square note spacing handle at the rhythmic position of each 
barline you want to move.
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2. Move the handles in any of the following ways:

● To increase the space to the left of selected handles, press Alt/Opt-Right Arrow .

● To decrease the space to the left selected handles, press Alt/Opt-Left Arrow .

NOTE

● To move handles by large increments, press Ctrl/Cmd  plus the standard key 
command; for example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move handles by moderate increments, press Shift  plus the standard key 
command; for example, Shift-Alt/Opt-Left Arrow .

● To move handles by small increments, press Ctrl/Cmd - Shift  plus the standard key 
command; for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● You cannot move note spacing handles with the mouse, you can only move them 
using the keyboard.

RESULT
The spacing to the right/left of the selected barlines is increased/decreased.

EXAMPLE

The new position of the barline after decreasing the space to its left

RELATED LINKS
Engrave toolbox on page 503

Barlines across staff groups
In order to make it easier to find a particular instrument within a score, barlines can extend 
across instrumental and staff groups.

Barlines across default staff groups

When a barline only appears on individual staves, it is much harder to locate individual lines at 
a glance. However, when barlines continue across instrumental groups in the score, instrument 
families are shown as blocks, which makes finding an instrument much easier.
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Barlines on individual staves Barlines across instrumental groups

By default, barlines automatically extend across staff groups that are joined by a bracket or 
brace, except for vocal staves, across which barlines never automatically extend. Which staves 
are included in a bracket depends on the instrumentation and context, but usually staves for 
instruments from the same family, such as woodwind or strings, are bracketed together.

Dorico Elements automatically brackets staves according to the ensemble type set for each 
layout.

Barlines across grand staff instruments

Dorico Elements automatically joins barlines across grand staff instrument staves as they are 
braced. Because staves cannot be bracketed and braced simultaneously, grand staff instruments 
are excluded from brackets and therefore are not joined with barlines to any other staves.

Barline joins between staves

You can change whether single barlines only appear between staves or extend across the staves 
as well in each flow independently on the Barlines page in Notation Options. Barline joins 
only between staves are known as “Mensurstriche”. They are commonly used when typesetting 
early music to aid readability for modern performers while minimizing the visual impact on the 
originally unmetered notation.

Barlines drawn between staves
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Custom barline groups

You can create custom barline joins and bracket groups by manually arranging your players 
into groups. Player groups are bracketed together according to the ensemble type set for each 
layout.

RELATED LINKS
Brackets according to ensemble type on page 866
Showing barlines across all staves at time signature changes on page 824
Designating players as soloists on page 127
Player groups on page 167
Player group labels on page 1317
Notation Options dialog on page 747

Changing the default barline joins
You can change whether barline joins automatically extend across staff groups that are joined by 
a bracket or brace, or break between each instrument, in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the default barline joins.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Brackets and Braces.

4. In the Bracketing section, choose one of the following options for Barline joins:

● Follow primary brackets

● Separate at each instrument

5. Click Apply, then Close.

RELATED LINKS
Brackets and braces on page 864
Brackets according to ensemble type on page 866

Showing barlines across all staves at time signature changes
You can join all staves with a barline at time signature changes in individual layouts, regardless of 
your bracketing style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the time signature changes where you want to join all staves with a barline. You can 
do this in Write mode and Engrave mode.

Barlines
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2. In the Properties panel, activate Barline joins all staves in the Time Signatures group.

RESULT
All staves in the layout currently open in the music area are joined by a barline at the selected 
time signature changes.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503

Barlines
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Bar numbers

Bar numbers provide crucial reference points in music and make the chronological sequence 
of music clear. By providing a unique number for each bar, they enable accurate references 
to specific parts of pieces and allow players to co-ordinate themselves easily in rehearsals and 
concerts.

In Dorico Elements, bar numbers appear automatically, following the most common practice of 
showing a bar number at the start of each system in all layouts by default. You can hide and 
show bar numbers in each layout independently, including showing them at a specified regular 
interval or in every bar, which is frequently used in film music scores.

TIP

The majority of options relating to bar numbers are on the Bar Numbers page in Layout 
Options. This is because it is very common to display bar numbers differently in different 
layouts, such as in every bar in full score layouts but only at the start of each system in part 
layouts.

Bar numbers shown every bar in a part layout

RELATED LINKS
Bar number paragraph styles on page 829
Positions of bar numbers on page 831
Bar number changes on page 835
Layout Options dialog on page 745
Bars on page 810
Pick-up bars on page 1386
Barlines on page 815
Track overview on page 520

Hiding/Showing bar numbers
You can hide/show bar numbers in each layout independently, including showing them at 
different frequencies. For example, you can show bar numbers every bar in full score layouts 
but only at the start of each system in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.
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4. In the Frequency subsection, choose one of the following options for Show bar numbers:

● Every system

● Every n bars

● Every bar

● None

5. Optional: If you chose Every n bars, set a custom frequency for bar numbers by changing 
the value for Interval.

6. In the Showing and Hiding subsection, activate/deactivate each option as required.

For example, you can hide the first bar number when bar numbers are shown every bar, and 
show standard bar numbers in addition to bar number ranges on multi-bar rests.

7. Click Apply, then Close.

RESULT
Bar numbers are hidden in the selected layouts when you choose None, and shown at the 
corresponding frequency when you choose any other option.

Changing the Interval value changes how frequently bar numbers are shown. For example, 
setting an interval value of 10 means that bar numbers are shown every tenth bar.

TIP

You can also hide individual bar numbers in layouts where bar numbers are shown by selecting 
them and activating Hide bar number in the Time Signatures group of the Properties panel.

RELATED LINKS
Changing the distance between bar numbers and the staff/other objects on page 832
Changing the horizontal position of bar numbers on page 832
Showing bar numbers above specific staves on page 831
Changing the system-relative placement of bar numbers on page 834
Hiding/Showing bar number ranges on multi-bar rests on page 828
Hiding/Showing guide bar numbers on page 829
Bar number paragraph styles on page 829
Positions of bar numbers on page 831
Numbered bar regions on page 1253

Hiding/Showing bar number enclosures
You can optionally show bar numbers in either a rectangular or circular enclosure in each layout 
independently; for example, if you want bar numbers to appear with rectangle enclosures in the 
full score layout, so the conductor can easily see them, but with no enclosures in part layouts, 
where pages tend to be less busy.

Bar numbers in enclosures automatically erase their backgrounds.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the bar number enclosure 
type.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
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and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Appearance subsection, choose one of the following options for Enclosure type:

● None

● Rectangle

● Circle

5. Click Apply, then Close.

RESULT
The enclosure type of all bar numbers in the selected layouts is changed.

EXAMPLE

Bar number with no enclosure Bar number with a rectangle 
enclosure

Bar number with a circle enclosure

RELATED LINKS
Layout Options dialog on page 745
Bar number paragraph styles on page 829

Hiding/Showing bar number ranges on multi-bar rests
You can hide/show bar number ranges on multi-bar rests; for example, so it is clear in part 
layouts which bars the player does not play. Multi-bar rests can include bar repeat regions, if you 
have chosen to consolidate bar repeat regions as well as empty bars into multi-bar rests.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show bar number ranges on 
multi-bar rests.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Showing and Hiding subsection, activate/deactivate Show ranges of bar numbers 
under multi-bar rests and consolidated bar repeats.

5. Click Apply, then Close.
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RESULT
Bar number ranges are shown beneath multi-bar rests and consolidated bar repeats in the 
selected layouts when the option is activated, and hidden when it is deactivated.

RELATED LINKS
Hiding/Showing bar numbers on page 826
Hiding/Showing multi-bar rests on page 1279
Bar number paragraph styles on page 829
Numbered bar regions on page 1253

Hiding/Showing guide bar numbers
You can hide/show guide bar numbers on every bar and above every system in page view and 
galley view independently; for example, to make it easier to check the bar number in scores with 
many staves. Guide bar numbers are not printed.

PROCEDURE

● Hide/Show guide bar numbers in any of the following ways:

● To hide/show guide bar numbers in page view, choose View > Bar Numbers > Page 
View.

● To hide/show guide bar numbers in galley view, choose View > Bar Numbers > Galley 
View.

RESULT
Guide bar numbers are hidden/shown for every bar and above every staff in the corresponding 
view type.

EXAMPLE

Guide bar numbers shown in page view

RELATED LINKS
Hiding/Showing guide page numbers on page 1152
Switching to galley/page view on page 50

Bar number paragraph styles
In Dorico Elements, bar numbers use paragraph styles so that you can use different paragraph 
styles in different layouts. In particular, part layouts often require differently formatted bar 
numbers compared to full score layouts.

By default, there are the following paragraph styles for bar numbers:

● Bar numbers (parts): Used in part layouts

● Bar numbers (score): Used in full score and custom score layouts

Bar numbers
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Initially, both paragraph styles have the same settings, but you can change the settings of each 
paragraph style independently. For example, you might want to use a bold italic font for bar 
numbers in part layouts but use a plain font with a much larger font size in full score layouts.

You can then change which paragraph style is used in each layout independently.

RELATED LINKS
Paragraph Styles dialog on page 756

Editing the bar number paragraph styles
You can edit the formatting of the paragraph styles used for bar numbers; for example, if you 
want to increase their font size. By default, there is a paragraph style for bar numbers in full 
score layouts and another paragraph style for bar numbers in part layouts.

PREREQUISITE
If you want to use additional bar number paragraph styles to the ones provided by default, you 
have created new paragraph styles.

PROCEDURE

1. Choose Library > Paragraph Styles to open the Paragraph Styles dialog.

2. In the paragraph styles list, select one of the following bar number paragraph styles:

● Bar numbers (parts)

● Bar numbers (score)

3. Optional: Select one of the available styles from the Parent menu.

If you select a parent style, an activated switch is shown beside all the options that are 
different in the selected paragraph style, compared to its parent style.

4. Activate and change the options you want for the selected paragraph style.

5. Click OK to save your changes and close the dialog.

RESULT
The selected bar number paragraph style is changed. This affects the appearance of bar 
numbers in all layouts that use the selected style.

TIP

You can also make additional bar number paragraph styles, as each layout can use a different 
paragraph style for bar numbers.

RELATED LINKS
Creating paragraph styles on page 758

Changing the bar number paragraph style used in layouts
You can choose which paragraph style is used for bar numbers in each layout independently. By 
default, full score layouts and part layouts use different paragraph styles for bar numbers.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.
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2. In the Layouts list, select the layouts in which you want to change the paragraph style used 
for bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Appearance subsection, select a paragraph style from the Paragraph style menu.

5. Click Apply, then Close.

RESULT
The selected paragraph style is used for all bar numbers in the selected layouts.

Positions of bar numbers
Bar numbers are typically shown at the start of each system, above the staff, and aligned with 
the initial barline.

You can change the default positions and frequency of bar numbers in each layout 
independently on the Bar Numbers page in Layout Options, and you can move individual bar 
numbers in Engrave mode. For example, you might want to show bar numbers every bar in full 
score layouts but only at the start of each system in part layouts.

Showing bar numbers above specific staves
You can change the staves above which bar numbers appear, which allows you to show bar 
numbers at multiple vertical positions in each system. For example, in large orchestral scores, 
you might show bar numbers both at the top of the system and above the string section.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical positions of 
bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Placement subsection, activate the checkbox for each player in the Show above 
specific players list above whose top staff you want to show bar numbers.

5. Click Apply, then Close.

RESULT
The vertical positions of bar numbers are changed in the selected layouts. For players holding 
multiple instruments, bar numbers appear above their top instrument staff.

Bar numbers
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NOTE

You can change the distances between bar numbers and the staff/other objects and your vertical 
spacing settings for the gaps between staves in order to accommodate bar numbers shown 
between staves.

RELATED LINKS
Changing the default staff/system spacing on page 603
Per-layout vertical spacing options on page 621
Moving instruments on page 135

Changing the horizontal position of bar numbers
You can change the horizontal position of bar numbers in each layout independently. For 
example, you can have bar numbers centered in the middle of bars in full score layouts but 
centered on barlines in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the horizontal position of 
bar numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Horizontal Position subsection, choose one of the following options for Horizontal 
position:

● To show barlines left-aligned on barlines at the start of bars, choose Left-aligned on 
barline.

● To show bar numbers centered on barlines at the start of bars, choose Centered on 
barline.

● To show bar numbers in the middle of bars, choose Centered on bar.

5. Click Apply, then Close.

RESULT
The horizontal position of bar numbers is changed in the selected layouts.

RELATED LINKS
Showing bar numbers above specific staves on page 831
Moving items graphically on page 514

Changing the distance between bar numbers and the staff/other 
objects

You can change the minimum distance between bar numbers and the staff, and set a separate 
value for the distance between bar numbers and other objects, in each layout independently. For 
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example, you can position bar numbers further from the staff/other objects in full score layouts 
than in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the minimum distance of 
bar numbers from the staff.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Placement subsection, change the values for the following options, individually or 
together:

● Minimum distance from staff

● Minimum distance from other objects

5. Activate/Deactivate Align bar numbers across width of system.

6. Activate/Deactivate Avoid collisions.

7. Click Apply, then Close.

RESULT
Increasing the values positions bar numbers further away from the staff and/or other objects, 
either above or below the staff depending on your setting for Placement relative to staff. 
Decreasing the values positions bar numbers closer to the staff and/or other objects.

When Align bar numbers across width of system is activated, bar numbers automatically 
vertically align within systems, with their position determined by the bar number furthest from 
the staff.

When Avoid collisions is deactivated, bar numbers do not automatically avoid collisions with 
other items, and are instead positioned using the minimum distance values you set. This allows 
bar numbers to appear directly above/below the staff, regardless of the pitch of notes or 
presence of other notations, such as ties and slurs.

NOTE

● Bar numbers can be positioned further from the staff than your minimum distance values 
when Avoid collisions is activated.

● If you want bar numbers within systems to appear closer to the staff than bar numbers at 
the start of systems, such as in part layouts with treble clefs, we recommend deactivating 
Align bar numbers across width of system.

RELATED LINKS
Hiding/Showing bar numbers on page 826
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Changing the system-relative placement of bar numbers
You can show bar numbers either above or below each system in each layout independently. For 
example, bar numbers can appear below the system in full score layouts but above the system in 
individual part layouts.

NOTE

This does not affect the placement of bar numbers shown above specific staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the bar number 
placement.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Placement subsection, choose one of the following options for Placement relative to 
system:

● Show above top staff of system

● Show below bottom staff of system

5. Click Apply, then Close.

RESULT
The placement of bar numbers relative to the system is changed in the selected layouts.

Hiding bar numbers at time signatures shown at system object 
positions

You can choose to hide bar numbers at the same rhythmic position as time signatures shown at 
system object positions, as the resulting collision can be difficult to resolve in a visually clear way 
when bar numbers are centered on barlines.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide bar numbers at time 
signatures shown at system object positions.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Bar Numbers.

4. In the Showing and Hiding subsection, activate/deactivate Show bar numbers at time 
signatures at system object positions.

5. Click Apply, then Close.

Bar numbers
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RESULT
Bar numbers are shown at time signatures shown at system object positions when the option is 
activated, and hidden when it is deactivated.

EXAMPLE

Bar numbers shown at time signatures at system 
object positions

Bar numbers hidden at time signatures at system 
object positions

RELATED LINKS
Time signatures on page 1381
Large time signatures on page 1387

Bar number changes
Bar numbers follow a continuous sequence, with each bar having a unique bar number that 
continues from the previous bar number. However, you can make manual changes to the bar 
number sequence, including changing to a subordinate sequence.

In Dorico Elements, you can make the following types of changes to bar number sequences 
using the Insert Bar Number Change dialog:

Primary
Adds a change to the main bar number sequence, which the bars in your project follow 
in a continuous sequence in each flow separately by default.

Subordinate
Adds a secondary bar number sequence that uses letters rather than numbers to 
indicate the sequence. This can be useful in situations where a new version of a piece 
has been created with more bars inserted, but the original bar numbers are required.

Don’t Include
Excludes the selected bar from the current bar number sequence. If bar numbers are 
shown every bar, no bar number is shown in bars in which you have chosen Don’t 
Include.

Continue Primary
Returns the bar number sequence to the Primary sequence without counting 
intervening bars; for example, after a section of bars following the Subordinate bar 
number sequence.

RELATED LINKS
Subordinate bar numbers on page 837
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Adding bar number changes
You can manually add bar number changes to bar number sequences; for example, if you want 
bar numbers in the second flow in your project to appear to continue the sequence from the first 
flow, rather than start again from bar one.

PROCEDURE

1. In Write mode or Engrave mode, select one of the following:

● An item in the bar from the beginning of which you want to change the bar number 
sequence.

● An existing bar number or barline from which you want to change the bar number 
sequence.

2. Choose Edit > Notations > Bar Numbers > Add Bar Number Change to open the Insert 
Bar Number Change dialog. You can also choose this option from the context menu.

3. Choose one of the following options for Type:

● Primary

● Subordinate

● Don’t Include

● Continue Primary

4. Optional: If you chose Primary or Subordinate, change the bar number where you want 
the bar number sequence change to start by changing the value in the corresponding value 
field.

5. Click OK to save your changes and close the dialog.

RESULT
The bar number sequence changes, starting from the beginning of the bar in which you selected 
an item, or from the position of a selected bar number or barline.

This affects the corresponding bar number sequence from the changed bar number until the 
next bar number change, or until the end of the flow.

Deleting bar number changes
You can delete any bar number changes you have added.

PROCEDURE

1. In Write mode, select the bar number changes you want to delete.

2. Press Backspace or Delete .

RESULT
The bar number changes are deleted. Subsequent bars follow the previous bar number 
sequence until the next bar number change, or until the end of the flow.

Bar numbers
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Subordinate bar numbers
Subordinate bar numbers are useful for numbering repeat endings, and for situations when the 
music is being altered, but the original bar numbers cannot be changed.

For example, you can use subordinate bar numbers to show where music has been added if a 
previous, shorter version has already been rehearsed. In this situation, players have likely started 
to associate certain parts of the piece with particular bar numbers, so if four bars need to be 
added after bar 10, they would be numbered 10a to 10d. The bar number of the following bar 
then continues from 11 exactly as it did before the new bars were added.

They might also be useful if you want different bar numbers for a repeat ending.

Subordinate bar numbers are shown with lowercase letters.

You can show both primary bar numbers and subordinate letters or only subordinate 
alphabetical letters in subordinate bar number sequences.

Lowercase subordinate bar number

Adding subordinate bar numbers
You can create a subordinate bar number sequence that is independent of your primary bar 
number sequence. This can be useful if you want to insert new bars without changing the bar 
numbers of existing subsequent bars.

PROCEDURE

1. In Write mode or Engrave mode, select one of the following:

● An item in the bar from the beginning of which you want subordinate bar numbers to 
start.

● An existing bar number or barline from which you want subordinate bar numbers to 
start.

2. Choose Edit > Notations > Bar Numbers > Add Bar Number Change to open the Insert 
Bar Number Change dialog. You can also choose this option from the context menu.

3. Choose Subordinate for Type to activate the Subordinate value field.

4. Optional: If you want to change the primary bar number that accompanies subordinate bar 
numbers, activate Primary and change the value in the value field.

For example, if you want the bar number sequence 6, 7a, 7b rather than 6, 7, 7a.

5. Change the first letter in the subordinate bar number sequence by changing the value in the 
Subordinate value field.

The corresponding alphabetical letter is shown to the right of the value field. For example, 
entering 1 into the value field is shown as a, 2 appears as b, and so on.

6. Activate/Deactivate Hide primary bar numbers.

7. Click OK to save your changes and close the dialog.

RESULT
The subordinate bar number sequence starts from the bar in which you selected an item, or from 
the position of a selected bar number or barline.
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● If you activated Primary and changed the value, the primary bar number shown alongside 
subordinate bar numbers is changed.

● If you deactivated Hide primary bar numbers, bar numbers in the subordinate sequence 
show both a number and an alphabetical letter. If you activated Hide primary bar numbers, 
they appear only with alphabetical letters.

For example, if you start a subordinate bar number sequence from what was originally bar 5 
without changing the Primary value, the sequence starts from 4a and continues until the next 
specified bar number change, or until the end of the flow.

Returning to the primary bar number sequence
You can specify the point where you want to return to the primary bar number sequence after a 
section of subordinate bar numbers.

PROCEDURE

1. In Write mode or Engrave mode, select one of the following:

● An item in the bar from the beginning of which you want to return to the primary bar 
number sequence.

● An existing bar number or barline from which you want to return to the primary bar 
number sequence.

2. Choose Edit > Notations > Bar Numbers > Add Bar Number Change to open the Insert 
Bar Number Change dialog. You can also choose this option from the context menu.

3. Choose Continue Primary for Type.

Text indicating the new bar number appears below the value fields for Primary and 
Subordinate. For example, Primary sequence will continue from bar 5.

4. Click OK to save your changes and close the dialog.

RESULT
The primary bar number sequence resumes from the bar in which you selected an item, or from 
the position of a selected bar number or barline.

TIP

You do not have to add subordinate bar number changes in chronological order. You can enter 
a return to the primary bar number sequence first, before adding the subordinate bar number 
sequence.

Bar numbers and repeats
By default in Dorico Elements, repeats are not included in the bar number count. For example, if 
the first ending ends in bar 10, the second ending starts in bar 11, even though the first section 
is repeated and therefore more than ten bars have been played.

Including repeats in the bar number count, so that bar numbers reflect the total number of 
bars played rather than the number of bars written on the page, can make music with multiple 
playthroughs clearer, as you can refer to a specific bar number for each playthrough instead of, 
for example, “bar eight the third time round”.
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Bar number for subsequent repeat shown in parentheses beside the initial bar number

In Dorico Elements, you cannot automatically include repeats in the bar number count. However, 
you can add bar number changes manually if you want bar numbers to reflect the total number 
of bars played.

RELATED LINKS
Adding bar number changes on page 836
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Beaming

A beam is a line that connects notes with tails to show rhythmic grouping, which varies according 
to the metrical structure of the prevailing time signature.

This way of grouping notes helps performers calculate quickly exactly how to play their given 
rhythm and helps them follow both their part and, if applicable, the conductor.

If appropriate for the current meter and position in the bar, beams are automatically formed in 
Dorico Elements when you input two or more adjacent notes or chords that are an eighth note 
(quaver) or shorter in duration.

Multiple beam groups in a 6/8 time signature

Dorico Elements has sophisticated underlying rules for producing beam groupings that follow 
the accepted conventions of music theory, including crossing the half-bar in time signatures like 
4/4, beaming all eighth notes together in 3/4, beam groups that include tuplets, and many other 
situations.

You can control how notes are beamed in multiple ways in Dorico Elements.

● You can set beam grouping defaults in each flow in your project independently on the Beam 
Grouping page in Notation Options.

● You can set beam groups by controlling subdivisions of time signatures.

● You can beam notes together and split beams manually.

RELATED LINKS
Inputting notes on page 224
Secondary beams on page 855
Tuplets within beams on page 858
Rests within beams on page 858

Per-flow notation options for beam grouping
You can find options to control the default beam grouping rules in each flow independently on 
the Beam Grouping page in Notation Options.

The available options include beams crossing the half-bar in time signatures like 4/4, beaming all 
eighth notes together in 3/4, how to handle secondary beam groups, stemlets, and beams over 
rests.

Musical examples demonstrate how each option affects the appearance of your music.

RELATED LINKS
Notation Options dialog on page 747
Beam slants on page 847
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Beam grouping according to meters
According to accepted conventions, notes are beamed differently in different time signatures 
to make the meter clear and easily readable. In Dorico Elements, default beam groupings are 
determined by time signatures.

Dorico Elements has default beaming settings for common time signatures, based on general 
conventions and your chosen settings. For example, although the time signatures of 3/4 and 6/8 
contain the same number of beats, they imply different meters and so are beamed differently. 
In 3/4, phrases of eighth notes are beamed together within each bar and phrases of other 
durations are beamed in quarter notes (crotchets) by default, but in 6/8, phrases are beamed in 
dotted quarter notes.

Default eighth note beam grouping in 3/4 Default eighth note beam grouping in 6/8

Dorico Elements groups and beams notes in irregular time signatures, such as 5/8 or 7/8, 
according to the most common practices for those time signatures.

Default beam grouping in 5/8 Default beam grouping in 7/8

For situations where you want to control the beat grouping in more detail, you can input a 
custom time signature with an explicit rhythmic subdivision. Dorico Elements then automatically 
beams phrases according to this subdivision. For example, entering [7]/8 into the time signatures 
popover means all seven eighth notes (quavers) are beamed together, whereas entering 
[2+2+3]/8 subdivides the seven eighth notes into two, then two, then three.

NOTE

The duration of beam groups in Dorico Elements depends on the beat grouping in the prevailing 
time signature and your per-flow beam grouping settings in Notation Options.

RELATED LINKS
Note and rest grouping on page 860
Creating custom beat groupings for meters on page 861
Inputting time signatures with the popover on page 287

Beaming notes together manually
You can beam notes in the same voice together manually, including notes across barlines as 
well as system/frame breaks. For example, if you want to beam a phrase differently to how it is 
usually beamed in the prevailing time signature.

Beams by default stay within bars and systems, so to have beams cross barlines, system breaks, 
and frame breaks, you must force the phrase to beam together.
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TIP

● If you want a single beam to span multiple staves, you can create cross-staff beams.

● Inputting time signatures with custom beat groupings is often the quickest and most 
consistent way to control beam grouping.

● You can find options to control the default beam grouping rules in each flow independently 
on the Beam Grouping page in Notation Options.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes you want to beam together. You can do this in Write mode and Engrave 
mode.

2. Choose Edit > Notations > Beaming > Beam Together. You can also choose this option 
from the context menu.

RESULT
Selected notes in the same voice are beamed together, even if they cross barlines or system/
frame breaks.

If there are notes either side of the new beam group that were previously beamed to part or 
all of your selection, they either beam together as separate beams, or appear unbeamed. This 
depends on how many notes are left either side in the bar, and on the beam grouping settings 
for the flow.

NOTE

● Even if part of the beamed group previously had a centered beam, the new beam is not 
centered.

● You can assign a key command for Beam Together on the Key Commands page in 
Preferences.

EXAMPLE

Phrase with default beaming Notes in each bar beamed together

RELATED LINKS
Engrave toolbox on page 503
Allowing/Disallowing tuplets to span barlines on page 1411
Changing the voice of existing notes on page 466
Centered beams on page 848
Creating cross-staff beams/tremolos on page 851
Beam grouping according to meters on page 841
Creating custom beat groupings for meters on page 861
Key Commands page in the Preferences dialog on page 60
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Unbeaming notes
You can separate all notes in a beamed group so that each note shows its own tail; for example, 
if you are engraving vocal music that requires syllabic beaming.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes you want to make unbeamed. You can do this in Write mode and Engrave 
mode.

2. Choose Edit > Notations > Beaming > Make Unbeamed. You can also choose this option 
from the context menu.

RESULT
The selected notes are unbeamed and show their own tails.

TIP

You can assign a key command for Make Unbeamed on the Key Commands page in 
Preferences.

EXAMPLE

Phrase with default beaming All notes unbeamed

Splitting beam groups
You can split beams into two beam groups at specific rhythmic positions. You can also split 
secondary beams within beamed groups.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the noteheads to the right of where you want to split beams. You can do this in Write 
mode and Engrave mode.

2. Split the beam or secondary beam in one of the following ways:

● Choose Edit > Notations > Beaming > Split Beam.

● Choose Edit > Notations > Beaming > Split Secondary Beam.

TIP

You can also choose these options from the context menu.
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RESULT
Beams/Secondary beams are split to the left of each selected note, but the notes either side of 
the split remain grouped if there are at least two beamed notes on each side that can be in a 
beam group.

TIP

● To unbeam the entire selection and give all notes in the group individual tails, you can make 
all notes unbeamed.

● You can change how beams and secondary beams are split by default in each flow 
independently on the Beam Grouping page in Notation Options

● You can assign key commands for Split Beam and Split Secondary Beam on the Key 
Commands page in Preferences.

EXAMPLE

Phrase with default beaming Two beams split at the second 16th note

RELATED LINKS
Per-flow notation options for beam grouping on page 840
Beam grouping according to meters on page 841
Engrave toolbox on page 503
Key Commands page in the Preferences dialog on page 60

Resetting beam grouping
You can remove all changes made to the beam grouping of notes and chords. This can also be 
useful if, for example, MusicXML files you have imported have incorrect beaming, such as beam 
lines appearing instead of stem flags.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes/chords whose beaming you want to reset. You can do this in Write mode 
and Engrave mode.

2. Choose Edit > Notations > Beaming > Reset Beaming. You can also choose this option 
from the context menu.

RESULT
Beam grouping is reset to your default settings in Notation Options for the current flow and 
time signature.

RELATED LINKS
Importing MusicXML files on page 82
Notation Options dialog on page 747
Per-flow notation options for beam grouping on page 840
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Resetting stem directions on page 1078

Changing the thickness of beams
You can change the thickness of individual beams, which can be useful in certain engraving 
situations. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select all the noteheads in the beams whose thickness you want to 
change.

NOTE

For the best results, we recommend selecting all notes in each beam.

2. In the Properties panel, activate Thickness in the Beaming group.

3. Change the value in the value field.

RESULT
The thickness of all beam lines in the selected beams is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Changing the gaps between beam lines on page 857

Beam placement relative to the staff
The default staff-relative placement of beams is determined by the staff positions of the notes 
within the beamed group and their resulting stem directions.

This means that the note furthest from the middle line of the staff determines the placement of 
the beam, although there are exceptions to this rule and other considerations that can influence 
the staff-relative placement of beams.

Changing the staff-relative placement of beams involves changing the direction of the stems 
in the beam. Therefore, Dorico Elements categorizes changing the staff-relative placement of 
beams as a stem change.
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Changing the staff-relative placement of beams
You can change the side of the staff on which beams appear by forcing the stem direction to 
change. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select at least one note in each of the beamed phrases whose staff-relative placement you 
want to change. You can do this in Write mode and Engrave mode.

2. Force the stem direction of notes in the selected beams in any of the following ways:

● Choose Edit > Notations > Stem > Force Stem Up.

● Choose Edit > Notations > Stem > Force Stem Down.

TIP

● You can also choose these options from the context menu.

● You can also change the staff-relative placement of selected beams by pressing F .

RESULT
The beam appears on the side of the staff that corresponds to its forced stem direction. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Removing beam placement changes
You can undo changes to the staff-relative placement of beams in order to remove the stem 
direction change. This reverts selected beams to their default placement.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select at least one note in each of the beamed phrases whose staff-relative placement 
change you want to remove. You can do this in Write mode and Engrave mode.

2. Choose Edit > Notations > Stem > Remove Forced Stem. You can also choose this option 
from the context menu.

RESULT
The selected beams revert to their default staff-relative placement.
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Beam slants
The slant of a beam controls how steeply the beam deviates from horizontal, according to the 
pitches of the notes within the beamed group.

● When the last note of the phrase is higher than the first, the beam slants upwards.

● When the last note of the phrase is lower than the first, the beam slants downwards.

● If the group makes a concave shape, where inner notes are closer to the beam than the 
outer ones at either end of the beam, then the beaming is horizontal by default.

Beams are also horizontal if all the pitches are the same, or for certain patterns of repeated 
pitches.

When a beam is drawn inside the staff, each end of the beam, meaning the end of the stem of 
the note at either end of the beam, must be snapped to a staff line position. A beam line may 
sit on a staff line, be centered on a staff line, or hang from a staff line. Ted Ross describes these 
three positions as “sit”, “straddle”, and “hang” respectively in “Teach Yourself the Art and Practice 
of Music Engraving”.

A phrase containing multiple different beam slants and directions

The amount by which a beam slants is typically determined by the interval between the first and 
last note in the beamed group, provided the pattern of notes in the beam does not dictate a 
horizontal beam instead. Smaller intervals require a shallower slant and larger intervals require a 
steeper one.

However, the desired amount of slant is not the only factor that must be considered. The 
innermost beam line should not come too close to the innermost notehead, and the beam itself, 
if possible, should be positioned relative to the staff lines such that it does not form a wedge. A 
wedge is a tiny triangle formed by the horizontal staff line, the vertical stem, and the angled line 
of the slanted beam, which can be visually confusing.

Determination of the amount of slant for a beam is therefore a balancing act that must weigh up 
several factors: the desired amount of slant, valid snapping positions for each end of the beam, 
ensuring a minimum distance between the note closest to the beam and the innermost beam 
line, and avoiding wedges where possible.

In Dorico Elements, you can change the beam slants of individual beams.

RELATED LINKS
Rests within beams on page 858

Changing beam slants
You can change the slants, or angles, of individual beams. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the square handles on the beam corners of the beams whose slants 
you want to change.

2. Move the handles in any of the following ways:

● To move beam handles upwards/downwards a standard amount, press Alt/Opt  plus 
the corresponding arrow key. For example, press Alt/Opt-Up Arrow  to move them 
upwards by 1/4 space per press.

● To move beam handles a large amount, press Ctrl/Cmd  plus the standard key 
command; for example, Ctrl/Cmd-Alt/Opt-Up Arrow . This moves beam handles by 1 
space per press.

● To move beam handles a moderate amount, press Shift  plus the standard key 
command; for example, Shift-Alt/Opt-Up Arrow . This moves beam handles by 1/2 
space per press.

● To move beam handles a small amount, press Ctrl/Cmd - Shift  plus the standard key 
command; for example, Ctrl/Cmd-Shift-Alt/Opt-Up Arrow . This moves beam handles 
by 1/32 space per press.

● Click and drag them upwards/downwards.

3. Optional: Repeat steps 1 and 2 to move the other end of the selected beams.

RESULT
The slants of the selected beams are changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

TIP

You can also use Beam direction in the Beaming group of the Properties panel to change the 
slant of beams. The property is available when you select noteheads within the beam group, and 
its options all ensure that beam ends are positioned correctly relative to staff lines.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503

Centered beams
Centered beams are beams that are vertically positioned between notes within the same beamed 
group, with stems for notes above the beam pointing downwards and stems for notes below the 
beam pointing upwards.

Centered beams are also known as “kneed” or “elbowed” beams due to their often angular 
shape.
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When a beamed phrase spans a large pitch range, normal beams are often positioned very close 
to some notes in the phrase but very far from other notes in the phrase, making some stems 
very long. Having a centered beam in a phrase that spans a large pitch range can reduce the 
maximum distance between noteheads and the beam, but can also place the beam within the 
staff, which can obscure staff lines.

By default, Dorico Elements allows beams that include notes on both sides of the middle staff 
line to appear centered. You can also create custom centered beams for beams that include 
notes only on one side of the middle staff line.

A phrase with high and low notes with default 
beaming

The same phrase with high and low notes, but with a 
centered beam

TIP

To center beams between multiple staves, you can create cross-staff beams.

RELATED LINKS
Changing the staff-relative placement of beams on page 846
Creating cross-staff beams/tremolos on page 851

Creating centered beams
You can center beams between the notes in the beamed group. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

NOTE

These steps only apply to beams on a single staff. To center beams between multiple staves, you 
can create cross-staff beams.

PREREQUISITE

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select at least one note in each of the beams you want to center. You can do this in Write 
mode and Engrave mode.

2. Create a centered beam in one of the following ways:

● If the selected beams include notes on both sides of the middle staff line, choose Edit > 
Notations > Stem > Force Centered Beam.

● If the selected beams include notes only on one side of the middle staff line, choose 
Edit > Notations > Stem > Custom Centered Beam to open the Custom Centered 
Beam dialog.
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TIP

You can also choose these options from the context menu.

3. Optional: If you created a custom centered beam, change the stem direction of each note in 
the selected beams as required in the Custom Centered Beam dialog, then click OK.

RESULT
Beams are centered between the notes in the selected beam groups. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

If you select notes in multiple beams, each beam is centered separately. If you want to create a 
single centered beam, you can beam the notes in those beam groups together. You can do this 
both before and after centering the beams.

NOTE

● Dorico Elements automatically angles the beam based on the shape of the phrase, but you 
can change the angles or slants of beams manually.

● You can assign a key command for Force Centered Beam on the Key Commands page in 
Preferences.

RELATED LINKS
Beaming notes together manually on page 841
Changing beam slants on page 847
Resetting stem directions on page 1078
Engrave toolbox on page 503

Removing centered beams
You can remove centered beams and revert beams to their default placements either above or 
below the phrase.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select at least one note in each centered beam that you want to revert to the default 
placement. You can do this in Write mode and Engrave mode.

2. Choose Edit > Notations > Stem > Remove Centered Beam. You can also choose this 
option from the context menu.

RESULT
The centered beams are removed.

TIP

You can assign a key command for Remove Centered Beam on the Key Commands page in 
Preferences.
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Creating cross-staff beams/tremolos
Cross-staff beams and cross-staff tremolos work in a similar way to normal beams and tremolos, 
but allow a phrase that covers a wide pitch range to be shown on multiple staves. You can create 
cross-staff beams/tremolos by inputting all notes in the phrase on one staff and crossing some 
notes to appear on another staff.

PREREQUISITE

● You have input a phrase on one staff.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes you want to cross to another staff. You can do this in Write mode and 
Engrave mode.

NOTE

You can only cross notes to other staves held by the same player.

2. Cross the notes to other staves in any of the following ways:

● To cross notes to the staff above, press N .

● To cross notes to the staff below, press M .

● Choose Edit > Notations > Cross Staff > Cross to Staff Above.

● Choose Edit > Notations > Cross Staff > Cross to Staff Below.

TIP

You can also choose these options from the context menu.

RESULT
The selected notes are shown on a different staff, with a cross-staff beam shown if the notes are 
part of a beam group. This does not change the staff to which the notes belong.

NOTE

● When crossing notes to a staff that already contains notes, the stem direction of the existing 
notes on the staff can change. This is due to how multiple voices at the same rhythmic 
position are handled. Therefore, you may have to change the stem direction of notes 
manually.

● If you want notes to belong to a different staff, you can move them to another staff.
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EXAMPLE

Notes shown on their original staves Cross-staff beams created by crossing some notes to 
the other staff

AFTER COMPLETING THIS TASK
If your cross-staff beams/tremolos have incorrect stem directions, you can reset or change stem 
directions.

RELATED LINKS
Resetting stem directions on page 1078
Changing the stem direction of notes on page 1076
Resetting notes crossed to other staves on page 854
Moving notes/items to other staves on page 464
Moving notes/items rhythmically on page 461
Notes crossed to staves with existing notes in other voices on page 1444
Note positions in multiple-voice contexts on page 1440
Inputting notes on page 224
Stem direction on page 1074
Hiding/Showing voice colors on page 1439
Tremolos on page 1399
Engrave toolbox on page 503

Changing to optical cross-staff beam spacing
You can make the stems in cross-staff beams, rather than the noteheads, evenly spaced in each 
layout independently. This can make it easier to perceive the evenness of rhythmic spacing in 
cross-staff beams than when noteheads are evenly spaced.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts that you want to change to optical cross-staff beam 
spacing.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Note Spacing.

4. Activate Use optical spacing for beams between staves.

5. Click Apply, then Close.
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RESULT
Optical cross-staff beam spacing is enabled in the selected layouts.

EXAMPLE

Default spacing: The distance between noteheads is 
even.

Optical spacing for cross-staff beaming: The distance 
between stems is even.

RELATED LINKS
Note spacing on page 507

Cross-staff beam placement in multiple staves
When instruments have three or more staves, cross-staff beams can be placed in multiple ways. 
For example, the beam can be placed between the top and the middle staves, and also between 
the middle and bottom staves.

If a beam only crosses two staves, the cross-staff beam goes between those two staves.

A cross-staff beam across the upper two staves on 
an instrument with three staves

A cross-staff beam across the lower two staves on an 
instrument with three staves

If a beam group contains notes on all three staves, the placement of the beam depends on the 
stem directions of the notes in each staff.
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1 If all notes in the beam group are stem-up, the beam is placed above the top staff.

2 If all notes in the beam group are stem-down, the beam is placed below the bottom staff.

3 If notes are stem-down on the top staff and stem-up on the bottom two staves, the beam is 
placed between the top and middle staves.

4 If notes are stem-down on the top two staves and stem-up on the bottom staff, the beam is 
placed between the bottom and middle staves.

NOTE

If you have not specified stem directions, Dorico Elements might place the beam above/below 
the staff into which the notes were originally input, even if the stem directions mean it should be 
placed between other staves.

If you want the beam to be placed between specific staves, you can change the stem directions 
of notes in the beam group.

RELATED LINKS
Changing the stem direction of notes on page 1076

Resetting notes crossed to other staves
You can reset notes that have been crossed to other staves so that they appear on their default 
staff. We recommend resetting cross-staff notes before copying and pasting them to other 
staves to avoid unexpected beaming.

PROCEDURE

1. Select the cross-staff notes you want to reset. You can do this in Write mode and Engrave 
mode.

2. Choose Edit > Notations > Cross Staff > Reset to Original Staff. You can also choose this 
option from the context menu.

RESULT
The selected cross-staff notes are reset and appear on their default staff.

TIP

You can assign a key command for this option on the Key Commands page in Preferences.
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Beam corners
Beam corners can occur when a change of stem direction within a beam is combined with a 
break in the secondary beam group. This can be at the end of a subdivision or at a change in 
rhythmic speed.

Beam corners do not follow accepted rules regarding the order and rhythmic meaning of 
secondary beams, and can be confusing for the reader.

Dorico Elements avoids beam corners by analyzing the pitches and stems within a phrase, and 
implementing stem directions that avoid a beam corner.

Secondary beams
Secondary beams are the lines that are added between the primary beam and the notehead as 
the rhythmic division gets smaller.

The primary beam is the outermost beam line that joins all of the notes in the beamed group. 
Depending on the durations of the notes in the beamed group, the primary beam may in fact be 
two or more lines; that is, for notes of a 16th or shorter in duration.

Secondary beams are additional beam lines that join only some of the notes in the group, 
creating subdivisions of the beam in order to make the metrical groupings of the beam clearer.

A phrase of 64th notes, with secondary beams subdivided to show 16th and eighth note groups

You can set per-flow options for splitting secondary beams and their appearance on the Beam 
Grouping page in Notation Options.

RELATED LINKS
Rests within beams on page 858
Notation Options dialog on page 747
Changing the gaps between beam lines on page 857

Changing the direction of partial beams
Dorico Elements automatically inputs a partial beam if one is required. You can change on which 
side of stems individual partial beams appear.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes whose partial beam direction you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Partial beam direction in the Beaming group.

3. Choose one of the following options:

● Left

● Right

RESULT
The partial beam appears on the corresponding side of the stem.

EXAMPLE

Partial beam direction Left Partial beam direction Right

Changing the number of beam lines in secondary beams
You can change the number of beam lines shown in secondary beams individually, 
independently of your default setting for the current flow.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes to the right of where you want to change the number of secondary beaming 
lines. You can do this in Write mode and Engrave mode.

2. Optional: If any of the notes you selected do not immediately follow existing splits in the 
secondary beam, split the secondary beams in any of the following ways:

● In the Properties panel, activate Split secondary beam in the Beaming group.

NOTE

The Beaming group is only shown in the Properties panel if your selection only contains 
notes.

● Choose Edit > Notations > Beaming > Split Secondary Beam. You can also choose this 
option from the context menu.

3. In the Properties panel, select the note value that corresponds to the number of beam lines 
you want shown from the Split secondary beam menu.
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RESULT
The number of beam lines shown immediately to the left of each selected note is changed.

NOTE

● Deactivating the property returns the selected notes to showing their default number of 
beam lines.

● The number of beam lines shown at a split in the secondary beam cannot be the same or 
greater than the number of beam lines in the secondary beam. For example, if you split a 
secondary beam containing 64th notes, the maximum number of beam lines shown at the 
split in that beam is three, the equivalent of 32nd notes.

● You can change the default number of secondary beam lines shown in each flow 
independently on the Beam Grouping page in Notation Options.

RELATED LINKS
Engrave toolbox on page 503
Notation Options dialog on page 747
Resetting beam grouping on page 844

Changing the gaps between beam lines
You can change the gaps that separate beam lines in individual beams, which can be useful in 
certain engraving situations. You can do this for the current layout and frame chain only, or for 
all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select all the noteheads in the beams whose beam line gaps you want to 
change.

NOTE

For the best results, we recommend selecting all notes in each beam.

2. In the Properties panel, activate Separation in the Beaming group.

3. Change the value in the value field.

RESULT
The gaps that separate beam lines in the selected beams are changed. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Changing the thickness of beams on page 845
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Tuplets within beams
Tuplets that contain notes that produce beams, such as eighth notes, are beamed together. 
However, special beam grouping rules apply to tuplets within beams that also contain non-tuplet 
notes.

The default setting for a tuplet in a beamed group with secondary beams is to split the secondary 
beam and to show the tuplet with a bracket. The primary beam is not split. If necessary, you can 
hide/show tuplet brackets individually.

The default setting for a tuplet in a beamed group with only a primary beam is to separate the 
tuplet entirely. However, you can change this setting on the Beam Grouping page in Notation 
Options.

16th note triplet beamed together with non-tuplet 
16th notes

Eighth note (quaver) triplet beamed separately from 
non-tuplet eighth notes

RELATED LINKS
Tuplets on page 1408
Tuplet brackets on page 1413
Tuplet numbers/ratios on page 1416

Rests within beams
There are different conventions for how beams interact with rests, including whether beams 
should extend over rests or split at rests.

You can change how primary and secondary beams interact with rests in each flow 
independently on the Beam Grouping page in Notation Options.

RELATED LINKS
Note and rest grouping on page 860
Beam slants on page 847
Notation Options dialog on page 747
Changing the direction of partial beams on page 855

Stemlets
Stemlets are short stems that extend from beams to rests within beam groups. They can help 
make music easier to read, as they help to maintain a regular pattern of stems within beams.

In the examples, beaming all notes and rests together to show the boundaries of quarter note 
(crotchet) beats makes the syncopation of the notes easier to read. The stemlets on the rests 
help make clear where within the quarter note beats each note occurs.

Beaming
Tuplets within beams 
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A syncopated phrase without stemlets The same phrase with stemlets

In Dorico Elements, you cannot add stemlets or change where they are shown. However, 
stemlets are shown if you import or open a project that contains them.

Fanned beams
Fanned beams show either an accelerando or rallentando by having multiple beam lines either 
converging on, or diverging from, a single beam line at the other end. Fanned beams are also 
known as “feathered beams”.

A single fanned beam can have multiple changes of direction within it.

The grouping can use either two or three beams, with three beams indicating a greater change 
of speed than two beams. The slowest part of the phrase is where the beams converge, and the 
fastest is where the beams are the most spread out.

In Dorico Elements, you cannot create fanned beams or change their direction. However, fanned 
beams are shown if you import or open a project that contains them.

EXAMPLE

Fanned beam accelerando with three lines

Fanned beam accelerando with two lines

Fanned beam rallentando with three lines

Fanned beam rallentando with two lines

Beaming
Fanned beams 
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Note and rest grouping

There are generally accepted conventions for how notes and rests of different durations 
are notated and grouped in different contexts and meters. In Dorico Elements, notes are 
automatically notated to fit within bars and are grouped according to your per-flow settings.

Depending on the prevailing time signature, there can be many different ways to beam notes 
together. For example, you might want to beam all notes in the bar together in time signatures 
that cannot be divided in half and are often not divided at all, such as 3/4.

A passage containing different meters. Notes are grouped and beamed differently in the different meters, 
and notes that cross beats and barlines are automatically shown as tied notes.

Tied notes are affected by your note and rest grouping settings, as there are different 
conventions for how notes within tie chains should be divided to indicate significant beat 
boundaries within bars, and in which contexts they can cross beat boundaries.

Similar options apply to dotted notes, which are often notated as a single dotted note if they 
start at the beginning of bars, but as a tie chain that shows significant beat boundaries in the bar 
if they start part-way through bars.

TIP

● You can change the default note grouping and beam grouping settings for each flow 
independently on the Note Grouping and Beam Grouping pages in Notation Options.

Musical examples demonstrate how each option affects the appearance of your music.

● You can also specify custom beat groupings within individual time signatures.

RELATED LINKS
Beam grouping according to meters on page 841
Note grouping in slash regions on page 1262
Forcing the duration of notes/rests on page 262
Types of time signatures on page 1382
Numbered bar regions on page 1253
Allowing/Disallowing noteheads in opposing voices to overlap on page 1440
Notation Options dialog on page 747
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Hiding/Showing ties across beat boundaries
You can change whether notes that span beat boundaries are notated as tie chains or single 
notes in each flow independently; for example, to show half notes over half-bars, instead of two 
tied quarter notes.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to hide/show ties across beat 
boundaries.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Note Grouping.

4. Change the settings as required.

There are separate options for ties across beat boundaries in time signatures with and 
without a half-bar, for notes followed by rests, and for ties in syncopated rhythm patterns.

5. Click Apply, then Close.

RESULT
Notes are notated as either tie chains or single notes in the corresponding contexts in the 
selected flows.

TIP

You can also force the duration of individual notes/rests to specify their notation.

EXAMPLE

● Notes starting at the start of the bar or the half-bar of multiple beats in duration 
affects the dotted half note in the first bar.

● Notes starting on a beat followed by a rest in the middle of the beat affects the dotted 
quarter note in the second bar.

Notes split at half-bar/beat boundaries Notes notated as single notes

RELATED LINKS
Notation Options dialog on page 747
Beam grouping according to meters on page 841
Forcing the duration of notes/rests on page 262

Creating custom beat groupings for meters
If your music requires a different beat grouping for a particular meter than the default setting 
for that time signature, you can specify your preferred beat grouping within the time signature. 

Note and rest grouping
Hiding/Showing ties across beat boundaries 
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You can choose whether or not the time signature shows this custom beat grouping. You can 
also input time signatures only on specific staves.

NOTE

The duration of beam groups in Dorico Elements depends on the beat grouping in the prevailing 
time signature and your per-flow beam grouping settings in Notation Options. For example, 
entering [1+1+1+1]/4 into the time signatures popover inputs a time signature with four quarter 
note (crotchet) groups. Because this creates a time signature with a half-bar, beam grouping 
options for time signatures with a half-bar apply.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select an item at the rhythmic position where you want to input a time signature with 
custom beat grouping. If you want to input a time signature with custom beat grouping 
on a single staff, select an item that belongs to that staff only.

2. Optional: If you want to input a time signature with custom beat grouping onto multiple 
specific staves at once, extend the caret to those staves.

3. Optional: If you want Dorico Elements to add beats at the end of the region affected by the 
new time signature if required, activate Insert mode in any of the following ways:

● Press I .

● In the Notes toolbox, click Insert .

4. Open the time signatures popover in any of the following ways:

● Press Shift-M .

● In the Notations toolbox, click Popovers , then Time Signatures (Meter) .

5. Enter the division you want in square brackets into the popover.

For example, to divide a 7/8 time signature into 2+3+2, enter [2+3+2]/8 into the popover. To 
divide a 5/4 time signature into 2+3 rather than 3+2, enter [2+3]/4 into the popover.

6. Input the time signature and close the popover in one of the following ways:

● To input a time signature on all staves, press Return .

● To input a time signature only on the selected staff or staves across which the caret 
extends, press Alt/Opt-Return .

RESULT
The time signature specified is input and beam and beat grouping in subsequent bars follows the 
division you specified.

TIP

You can change the appearance of numerators in individual time signatures so that they show a 
single number or beat groups.

RELATED LINKS
Time signatures popover on page 283
Time signature styles on page 1389

Note and rest grouping
Creating custom beat groupings for meters 
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Changing the beat grouping for cut common time 
signatures

You can change the beat grouping of individual cut common time signatures, independently of 
your per-flow setting. For example, if you want some cut common time signatures, such as 2/2, 
to group notes and rests in the same ways as common time signatures, such as 4/4.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the cut common time signatures whose beat grouping you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Use common time note grouping in the Time 
Signatures group.

RESULT
The selected cut common time signatures use common time beat grouping when Use common 
time note grouping is activated, and cut common time beat grouping when it is deactivated.

TIP

You can change the beat grouping for all cut common time signatures in each flow 
independently in Notation Options > Note Grouping > Time Signatures With Half-bars.

RELATED LINKS
Notation Options dialog on page 747
Types of time signatures on page 1382
Changing the appearance of common/cut common time signatures on page 1393
Input methods for time signatures and pick-up bars on page 283
Hiding/Showing zones on page 44
Properties panel on page 663
Engrave toolbox on page 503

Note and rest grouping
Changing the beat grouping for cut common time signatures 
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Brackets and braces

Brackets and braces are thick straight and curved lines in the left-hand margin that show 
instrument groupings.

Brackets

A bracket is a thick black line, the width of a beam, that groups staves together, most commonly 
according to instrument family. It often has winged ends that point inwards towards the score.

It is always positioned directly to the left of a systemic barline. If secondary brackets are used 
in addition to a bracket, they are positioned further away from the start of the system to allow 
space for the bracket.

An example of a bracket, connecting instruments in the string family. A sub-bracket connects the two violin 
lines.

By default in Dorico Elements, barlines join the same staves that are joined by brackets and 
braces, meaning that bracketed groups of staves and braced pairs of staves appear with barlines 
extending across the group.

Braces

A brace is a wavy or curly line that joins multiple staves belonging to the same instrument, 
usually a grand staff instrument such as the piano or harp. If necessary, a brace can extend to 
three or more staves, although two is most common.

The brace is also sometimes used instead of a sub-bracket to show groupings of identical 
instruments within a family whose staves are joined by a bracket.

It is positioned outside the systemic barline, and if used in place of a sub-bracket, outside of the 
bracket as well.
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A brace connecting two piano staves

NOTE

● Staves cannot be bracketed and braced simultaneously. Therefore, braced staves are 
excluded from bracketed groups. They also cannot show sub-brackets or sub-sub-brackets.

● System objects are only shown above instrument families that are bracketed or braced 
together.

● Blank staves can only show brackets/braces when they are shown after final flows. You 
cannot show brackets/braces on blank staves in music frames.

RELATED LINKS
Barlines across staff groups on page 822
Player groups on page 167
Secondary brackets on page 868
Brackets according to ensemble type on page 866
Changing the default barline joins on page 824
System objects on page 1326
Staff labels on page 1309
Player group labels on page 1317

Changing bracket grouping according to ensemble type
You can change which staves are included in brackets by changing the ensemble type for each 
layout independently; for example, if a part layout containing all percussion players requires 
different bracketing than used for percussion staves in the full score layout.

The default setting is Orchestral. We recommend that you change this setting for projects 
containing small ensembles.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the ensemble type for 
bracket grouping.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Brackets and Braces.

4. Choose one of the following options for Ensemble type:

● No brackets

● Orchestral

● Small ensemble

Brackets and braces
Changing bracket grouping according to ensemble type 
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● Wind band

● Big band

● British brass band

5. Click Apply, then Close.

RESULT
The default bracket grouping is changed in the selected layouts.

TIP

● There are further options for bracketing on the Brackets and Braces page, such as hiding/
showing brackets when there is only a single instrument in the bracket group and hiding/
showing braces when only a single staff is shown.

● Player groups and soloists also influence which staves are bracketed together.

● You can also input custom bracket/brace grouping for specific staves, independently of the 
bracket grouping setting in the layout. However, you cannot change brackets/braces on 
blank staves.

RELATED LINKS
Barlines across staff groups on page 822
Hiding/Showing blank staves after final flows on page 608
Player groups on page 167
Designating players as soloists on page 127
Staff labels on page 1309
Player group labels on page 1317

Brackets according to ensemble type
In Dorico Elements, default staff grouping is determined by the ensemble type chosen for each 
layout. This affects which staves are bracketed together and joined by barlines.

The following ensemble types are available on the Brackets and Braces page in Layout 
Options:

No brackets
All staves appear separately, with no brackets. Grand staff instruments are still shown 
with braces.

This is the default setting for full score layouts in projects started from Solo and small 
Jazz project templates.

Orchestral
Staves are bracketed according to their instrument family. For example, adjacent string 
instruments are bracketed together separately from adjacent woodwind instruments. 
However, vocal staves are not joined by barlines.

This is the default setting for all layouts in new projects and projects started from 
Orchestral, Choral and Vocal, and Concert band project templates, and for custom 
score and part layouts in projects started from all other project templates.

Small ensemble
All staves in the project are bracketed together, regardless of their instrument family, 
excluding braced staves.

Brackets and braces
Changing bracket grouping according to ensemble type 
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This is the default setting for full score layouts in projects started from Chamber and 
Pit band project templates.

Wind band
Staves are bracketed according to their instrument type. For example, Flute 1 and Flute 
2 are bracketed together, but separately from the other woodwind instruments.

Big band
Staves are bracketed according to their instrument family, except for brass 
instruments, which are all bracketed according to their instrument type.

Rhythm section instruments are bracketed together.

Percussion and timpani are bracketed together.

British brass band
Brass instruments are bracketed according to their instrument type, except for horns 
and trumpets, which are bracketed together.

Any other instruments in the score are bracketed according to their instrument family.

Percussion and timpani are bracketed separately.

This is the default setting for full score layouts in projects started from the Big band 
project template.

NOTE

● Staves cannot be bracketed and braced simultaneously. Therefore, braced staves, such as 
the piano and other grand staff instruments, are excluded from brackets. They also split 
brackets if they are placed within a bracketed group.

● By default, there must be at least two adjacent instruments to show a bracket. You 
can choose to show brackets on single instruments in each layout independently on the 
Brackets and Braces page in Layout Options.

● Player groups and soloists also influence which staves are bracketed together.

● Vocal staves are never joined by barlines, even when bracketed together.

● System objects are only shown above instrument families that are bracketed or braced 
together.

RELATED LINKS
Layout Options dialog on page 745
Project templates on page 77
System objects on page 1326

Hiding/Showing braces on single staves
You can hide/show braces on single staves in each layout independently. For example, if you only 
want to show braces for the piano when both staves are shown.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show braces on single 
staves.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

Brackets and braces
Hiding/Showing braces on single staves 

867
Dorico Elements 5.1.30



3. In the category list, click Brackets and Braces.

4. Choose one of the following options for When only one staff of braced group is shown:

● Draw brace

● Do not draw brace

5. Click Apply, then Close.

Secondary brackets
Secondary brackets are a second level of staff grouping. They are positioned to the left of 
brackets and allow you to mark groups of staves within a bracketed group. In Dorico Elements, 
secondary brackets can appear as a brace or as a sub-bracket.

By default, secondary brackets appear as sub-brackets: thin lines with square corners that extend 
beyond the bracket. You can change the appearance of secondary brackets and hide/show them 
for adjacent identical instruments in bracketed groups in each layout independently.

Secondary bracket as a sub-bracket Secondary bracket as a brace

NOTE

You cannot show sub-sub-brackets in addition to braces, you can only show sub-sub-brackets in 
addition to sub-brackets.

Hiding/Showing secondary brackets
You can hide/show secondary brackets for adjacent identical instruments in bracketed groups 
in each layout independently. You can also choose only to show secondary brackets when sub-
bracketed groups contain at least two staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show secondary brackets.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Brackets and Braces.

Brackets and braces
Secondary brackets 

868
Dorico Elements 5.1.30



4. Choose one of the following options for Instruments of the same kind within a bracketed 
group:

● Use secondary brackets

● No secondary brackets

5. Choose one of the following options for When only one staff of sub-bracketed group is 
shown:

● Draw sub-bracket

● Do not draw sub-bracket

6. Choose one of the following options for When sub-bracket matches primary bracket:

● Draw sub-bracket

● Do not draw sub-bracket

7. Choose one of the following options for Sub-brackets for adjacent violin players:

● To show a single sub-bracket across all violin staves, choose Single.

● To show a separate sub-bracket for each violin player, choose Separate.

● To show a single sub-bracket when each violin player uses a single staff, but show 
a separate sub-bracket for each violin player when at least one player uses multiple 
staves, such as in a divisi section, choose Separate for multiple staves.

8. Click Apply, then Close.

RESULT
Secondary brackets are shown in the selected layouts when you choose Use secondary 
brackets, and hidden when you choose No secondary brackets.

If you chose Use secondary brackets and Do not draw sub-bracket, secondary brackets are 
only shown when sub-bracketed groups contain at least two staves.

Showing secondary brackets as sub-brackets/braces
Secondary brackets extend beyond brackets, allowing you to mark groups of staves within a 
bracketed group. You can show secondary brackets as either braces positioned outside the 
bracket or as sub-brackets in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the appearance of 
secondary brackets.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Brackets and Braces.

4. Choose one of the following options for Secondary bracket appearance:

● Brace

● Sub-bracket

5. Click Apply, then Close.

Brackets and braces
Secondary brackets 
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RESULT
The appearance of all secondary brackets in the selected layouts is changed.

NOTE

Because you cannot show sub-sub-brackets in addition to braces, sub-sub-brackets are not 
shown in layouts where sub-brackets appear as braces.

Sub-sub-brackets
Sub-sub-brackets are a tertiary level of staff grouping with the same design as sub-brackets. They 
are positioned outside of both brackets and sub-brackets, allowing you to mark groups of staves 
within bracketed and sub-bracketed groups. Sub-sub-brackets can only appear as brackets in 
Dorico Elements.

Sub-sub-brackets cannot extend beyond their sub-bracket and cannot be shown on staves with a 
brace as either the primary or secondary group.

Brackets and braces
Sub-sub-brackets 
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Chord symbols

Chord symbols describe the vertical harmony of the music at a specific moment. They 
are frequently used in jazz and pop music, where players often improvise around chord 
progressions.

Chord symbols shown above slashes on the Clarinet and Piano staves to help the players improvise around 
the notated Cornet melody.

You can input chord symbols using the chord symbols popover and you can automatically 
generate chord symbols based on existing music.

In Dorico Elements, chord symbols exist globally at the corresponding rhythmic positions by 
default. This means that you only have to input chord symbols once, but they can appear above 
multiple or no staves as required. However, in some circumstances it is necessary to show 
different chord symbols for different players at the same rhythmic position. In such cases, you 
can input local chord symbols.

Dorico Elements automatically shows the appropriate chord symbols for transposing 
instruments in transposing layouts, including for fretted instruments whose transposition you 
have changed to reflect a capo. You can also define capos for chord symbols and show only main 
chord symbols, only capo chord symbols, or both.

You can hide/show chord symbols project-wide above specific instrument staves, including if 
multiple instruments belong to the same player, and in different layouts. You can also show 
chord symbols only within chord symbol/slash regions and hide/show individual chord symbols.

If you have input chord symbols but no players in the current layout are set to show them, they 
are indicated by signposts.

Depending on the style of music, there are different conventions regarding how to present chord 
names.

Dorico Elements provides a comprehensive set of chord symbol appearance presets that you can 
choose from.

RELATED LINKS
Inputting chord symbols on page 318
Chord symbol appearance presets on page 872
Chord symbol font styles on page 877
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Hiding/Showing chord symbols on page 878
Chord diagrams on page 894
Capos on page 157
Capo vs. main chords on page 158
Hiding/Showing signposts on page 450
Chords track on page 535
Enabling chord symbol playback on page 535

Chord components
Chord symbols consist of a root and a quality, with intervals, alterations, and an altered bass note 
included if required.

Root
The root note of the chord, expressed either as a note name or as a specific degree of a 
scale.

Quality
Defines the type of chord, such as major, minor, diminished, augmented, half-
diminished, or with added note, such as six or nine.

Interval
Chord symbols can include one or more added intervals, such as a major seventh or 
ninth. Intervals in chord symbols are also known as “extensions”.

Alterations
Define notes in chords that are different to what is normally expected of that chord. 
For example, a sharpened fifth, flattened ninth, suspensions, or omissions.

Altered bass note
A chord symbol has an altered bass note if the lowest pitch of a chord is not its root 
note, such as Cm7♭5/E♭.

Chord symbol appearance presets
There are many conventions for the appearance of chord symbols, so Dorico Elements provides a 
choice of preset conventions that you can use and edit.

For example, you can edit default preset chord symbols, you can edit individual chord symbols 
without changing the default appearance for that chord symbol, and you can edit individual 
components within chord symbols.

● You can access chord symbol presets in the Chord Symbols Options dialog by choosing 
Library > Chord Symbols.

Chord symbol preset example Chord symbol preset name

Default

Boston

Chord symbols
Chord components 
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Chord symbol preset example Chord symbol preset name

Brandt-Roemer

Indiana

New York

Nashville

Jazz Standards

Ross

Japanese

These presets use specific combinations of the options in the Chord Symbols Options dialog. 
You can also adjust these options individually to suit your requirements.

● Default uses a set of symbols intended to be as unambiguous as possible. For example, 
Default avoids the use of symbols for major seventh, augmented, diminished, and half-
diminished. This is the default preset for new projects.

● Custom is automatically selected when you change any of the preset options.

Edit Chord Symbol Appearance dialog
The Edit Chord Symbol Appearance dialog allows you to edit the appearance and arrangement 
of single chord symbol instances, without changing the project default appearance of that chord 
symbol. For example, if you want the first Gmaj7 chord symbol to appear differently than all 
subsequent Gmaj7 chord symbols.

● You can open the Edit Chord Symbol Appearance dialog in Engrave mode by selecting 
the chord symbol you want to customize and pressing Return , or double-clicking a chord 
symbol.

Chord symbols
Chord symbol appearance presets 
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The Edit Chord Symbol Appearance dialog contains the following sections:

1 Editor

Allows you to arrange and edit the components that make up the chord symbol.

As well as using the controls at the bottom of the dialog, you can move individual 
components in any of the following ways after selecting them in the editor:

● Press the standard key commands for moving items. For example, press Alt/
Opt-Right Arrow  to move components to the right, or press Ctrl/Cmd-Alt/Opt-
Right Arrow  to move components to the right by larger increments.

● Click and drag each component.

NOTE

You cannot move the first component in chord symbols.

In addition to using Scale, you can also change the size of components by clicking and 
dragging the square handle in the top right corner after selecting a component in the editor.

2 Controls

Allow you to move individual components and change their size. You can also reset their 
position and size.

● X offset moves components horizontally. Increasing the value moves components to the 
right, decreasing the value moves components to the left.

● Y offset moves components vertically. Increasing the value moves components 
upwards, decreasing the value moves components downwards.

Chord symbols
Chord symbol appearance presets 
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● Scale changes the size of components. Increasing the value increases the size of 
components proportionally, decreasing the value decreases the size of components 
proportionally.

● Reset X offset resets the horizontal position of the selected component.

● Reset Y offset resets the vertical position of the selected component.

● Reset Scale resets the size of the selected component.

3 Components list

You can create new components and edit existing components by clicking the respective 
button in the action bar.

● Add Component 

● Edit Component 

Clicking either button opens the Edit Chord Symbol Component dialog, in which you can 
create new components and edit existing components. Editing components from inside the 
Edit Chord Symbol Appearance dialog only affects the selected chord symbol.

RELATED LINKS
Chord symbol appearance presets on page 872
Moving items graphically on page 514

Edit Chord Symbol Component dialog
The Edit Chord Symbol Component dialog allows you to create custom chord symbol 
components and edit existing components for single instances of chord symbols.

● You can open the Edit Chord Symbol Component dialog from inside the Edit Chord Symbol 
Appearance dialog by selecting the component you want to duplicate in the components 
list, and clicking Add Component  in the components list action bar.

The Edit Chord Symbol Component dialog contains the following sections:

1 Name

Chord symbols
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Contains an automatically generated name for the chord symbol component. You cannot 
change this name.

2 Component selector

Allows you to choose components to add to your chord symbol component. You can add 
different types of components by clicking the respective tab titles.

● Glyph, for example, ♮ or ♯. You can use different styles of glyphs by selecting different 
fonts and font styles/weights from the menus. You can search using SMuFL or Unicode 
ranges. Click Add Glyph to add the selected glyph to the chord symbol component.

NOTE

A full list of the different ranges of glyphs is available on the SMuFL website.

● Text, including numbers and other text. You can use numbers and text from the 
available Preset text list or select any font available from the menu and enter your 
preferred text into the text box at the bottom. Click Add Text to add the selected or 
input text to the chord symbol component.

● Graphic: Allows you to load a new graphics file or select an existing graphic from the 
Select existing list in SVG, PNG, or JPG format. You can see a preview of the graphic 
in the Preview box. Click Add Graphic to add the selected graphic to the chord symbol 
component.

● Composite: Allows you to select a composite from the list. Click Add Composite to add 
the selected composite to the chord symbol component.

3 Editor

Allows you to arrange and edit the components that make up your chord symbol 
component. You can arrange and edit components using the controls at the bottom of the 
dialog.

4 Editor action bar

Contains selection and view options for the editor.

● Zoom: Allows you to change the zoom level in the editor.

● Select: Allows you to select the next/previous component.

● Delete : Deletes the selected component.

5 Controls

Contains controls that allow you to edit individual components. Controls are divided into 
tabs according to the aspect of the selected component they affect. For chord symbols, the 
Component and Attachments tabs are available.

The Component tab contains the following options:

● Offset: Controls the position of the selected component. X moves it horizontally, Y 
moves it vertically.

● Scale: Controls the size of the selected component. For graphics, X controls its width, Y 
controls its height.

NOTE

Although some components scale their height and width independently, others retain 
their aspect ratio, meaning only one value affects their overall size.

● Z order: Allows you to Bring Forward or Send Backward the selected component in 
relation to other components when they overlap.

● Color: Allows you to change the color of the selected component.
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The Attachments tab is only available if the chord symbol component comprises at least two 
separate components. It contains the following options:

● Attachment from: Sets the attachment point on the component to the left of the 
selected component to which the selected component attaches. We recommend that 
you select a right edge attachment point for Attachment from.

● Attachment to: Sets the attachment point on the selected component which attaches to 
the component to its left. We recommend that you select a left edge attachment point 
for Attachment to.

There are eight attachment points for glyphs and graphics, and eleven for text, due to the 
extra space required for letters that extend below the baseline. The example diagram helps you 
visualize how these points relate to components.

The attachment points have the following names in the Edit Chord Symbol Component dialog:

1 Top Left

2 Top Center

3 Top Right

4 Middle Left

5 Middle Right

6 Baseline Left (text only)

7 Baseline Center (text only)

8 Baseline Right (text only)

9 Bottom Left

10 Bottom Center

11 Bottom Right

RELATED LINKS
Chord symbol appearance presets on page 872
Edit Chord Symbol Appearance dialog on page 873

Chord symbol font styles
There are different font styles for different chord symbol components. You can change different 
aspects of these fonts in the Edit Font Styles dialog, such as changing their font size to make 
accidentals in chord symbols appear larger.

1 Chord Symbols Font: Used for note names in chord symbols, such as “B” or “F”.
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2 Chord Symbols Music Text Font: Used for accidentals in chord symbols, such as ♭ and ♯. 
Must be SMuFL-compliant.

3 Chord Symbols Altered Bass Separator Font: Used for text altered bass separators.

RELATED LINKS
Edit Font Styles dialog on page 754
Changing the default font family on page 760

Positions of chord symbols
In layouts where chord symbols are shown, they are positioned either above all instrument 
staves set to show chord symbols or only above the top staff in each system.

By default, chord symbols are left-aligned with noteheads and vertically aligned across the width 
of each system.

RELATED LINKS
Hiding/Showing capo chord symbols on page 163
Moving notes/items rhythmically on page 461
Moving items graphically on page 514
Chord symbol regions on page 882

Hiding/Showing chord symbols
You can hide/show chord symbols above particular staves or only within chord symbol/slash 
regions project-wide on a per-player basis. By default, chord symbols appear above rhythm 
section instrument staves, such as keyboards, guitars, and bass guitars.

Any player on whose staff you input chord symbols is automatically set to show chord symbols 
for all instruments and in the current layout type.

PROCEDURE

1. In Setup mode, select a player in the Players panel for whom you want to hide/show chord 
symbols.

2. In the action bar, click Player Settings  and choose one of the following options:

● To show chord symbols above all instrument staves held by the player, choose Chord 
Symbols > Show for All Instruments.

● To show chord symbols only above rhythm section instrument staves held by the player, 
choose Chord Symbols > Show for Rhythm Section Instruments.

● To show chord symbols only in chord symbol/slash regions on instrument staves held by 
the player, choose Chord Symbols > Show in Chord Symbol and Slash Regions.

● To hide chord symbols above all instrument staves held by the player, choose Chord 
Symbols > Hide for All Instruments.

RESULT
Chord symbols are hidden/shown above the corresponding instrument staves held by the 
selected player, depending on the layouts in which chord symbols are shown for that player 
in your project.
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TIP

● You can also right-click players and choose these options from the context menu.

● You can choose to show chord symbols only once at the top of each system in each layout 
independently.

● You can also hide/show individual chord symbols in layouts where chord symbols are shown 
by selecting them and activating Hidden in the Chord Symbols group of the Properties 
panel. Signposts are shown at the position of each hidden chord symbol. However, signposts 
are not printed by default.

You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences.

RELATED LINKS
Players panel on page 110
Layouts on page 174
Inputting chord symbols on page 318
Chord symbol regions on page 882
Inputting chord symbol regions on page 326
Inputting slash regions on page 417
Signposts on page 450
Hiding/Showing chord diagrams on page 895
Showing only chord symbols or chord diagrams on page 897
Showing chord symbols above one/multiple staves on page 880
Changing the staff-relative placement of chord symbols on page 882
Capo vs. main chords on page 158
Hiding/Showing capo chord symbols on page 163
Key Commands page in the Preferences dialog on page 60
Layout Options dialog on page 745
Chord symbol appearance presets on page 872

Hiding/Showing chord symbols in layouts
You can hide/show chord symbols in different types of layouts. By default, chord symbols appear 
in all applicable layouts for rhythm section instruments.

NOTE

If chord symbols are hidden for all instruments in the current layout, signposts are shown above 
the top staff.

PROCEDURE

1. In Setup mode, select a player in the Players panel.

2. In the action bar, click Player Settings  and choose one of the following options:

● To show chord symbols for the selected player in all layouts, choose Chord Symbols > 
Show in Full Score and Parts.

● To show chord symbols for the selected player only in full score/custom score layouts 
and not in part layouts, choose Chord Symbols > Show in Full Score Only.

● To show chord symbols for the selected player only in part layouts and not in full score/
custom score layouts, choose Chord Symbols > Show in Parts Only
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TIP

You can also right-click players and choose these options from the context menu.

Showing chord symbols above one/multiple staves
You can choose to show chord symbols above all instrument staves set to show chord symbols or 
only above the top staff in each system in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical position of 
chord symbols.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Symbols section, choose one of the following options for Show chord 
symbols:

● Above specific players’ staves

● Above top staff of system

5. Click Apply, then Close.

RELATED LINKS
Inputting chord symbols on page 318
Showing only chord symbols or chord diagrams on page 897
Capo vs. main chords on page 158
Hiding/Showing capo chord symbols on page 163

Changing the alignment of chord symbols relative to notes
You can change the horizontal alignment of individual chord symbols relative to notes, 
independently of your project-wide setting. For example, you might center-align wide chord 
symbols to avoid collisions with barlines. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols whose alignment you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Alignment in the Chord Symbols group.

Chord symbols
Positions of chord symbols 

880
Dorico Elements 5.1.30



3. Select one of the following alignment options from the menu:

● Left

● Center

● Right

RESULT
The alignment of the selected chord symbols is changed. Note spacing is automatically adjusted 
to avoid collisions with adjacent chord symbols.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can change the default horizontal alignment of all chord symbols project-wide in the 
Position section of the Chord Symbols Options dialog.

EXAMPLE

Left-aligned G#dim7 chord symbol 
on beat 3

Center-aligned G#dim7 chord 
symbol on beat 3

Right-aligned G#dim7 chord 
symbol on beat 3

Changing the vertical alignment of chord symbols
You can change whether chord symbols are aligned at the same vertical position across the 
width of each system. You can also change how multi-line chord symbols, such as polychord 
chord symbols, are vertically aligned relative to single-line chord symbols.

PROCEDURE

1. Choose Library > Chord Symbols to open the Chord Symbols Options dialog.

2. In the Position section, activate/deactivate Align chord symbols across width of system.

3. Choose one of the following options for Alignment of multi-line chord symbols relative to 
single-line chord symbols:

● Top

● Middle

● Bottom

4. Click Apply, then Close.

RELATED LINKS
Chord symbol appearance presets on page 872
Changing the arrangement of compound chord symbols on page 887
Hiding/Showing capo chord symbols on page 163
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Changing the staff-relative placement of chord symbols
You can show individual chord symbols either above or below the staff, independently of your 
project-wide setting. You can do this for the current layout and frame chain only, or for all layouts 
and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols whose staff-relative placement you want to change. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate Placement in the Chord Symbols group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of the selected chord symbols is changed. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

TIP

● You can choose to show chord symbols between the staves of grand staff instruments in 
each layout independently in Layout Options > Chord Symbols and Diagrams > Chord 
Symbols.

● You can change the default placement of all chord symbols project-wide in the Position 
section of the Chord Symbols Options dialog.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Large selections on page 424
Layout Options dialog on page 745

Chord symbol regions
Chord symbol regions specify passages where you want to show chord symbols. They are 
particularly useful for players and layouts that do not need chord symbols for most of the project 
but have improvisation sections that require chord symbols to be shown.

Chord symbol regions allow you to show chord symbols only where players require them, instead 
of showing chord symbols throughout the project and manually hiding the ones you do not want 
to show.

When you input, copy, or move chord symbol regions in Dorico Elements, the corresponding 
players are automatically set to show chord symbols in chord symbol/slash regions. This is 
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because it is common to use both slashes and chord symbols to aid players in improvisation 
sections. Any chord symbols outside chord symbol/slash regions are automatically hidden and 
are indicated by signposts.

By default, chord symbol regions are highlighted with a solid colored line above the top staff line 
and a colored background. As you zoom out, the colored backgrounds become more opaque, 
which is especially useful when viewing full score layouts in galley view. These highlights are 
considered annotations, are not printed by default, and you can hide/show them.

Chord symbol region followed by chord symbol signposts after the end of the chord symbol region

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

Handles on a selected chord symbol region

RELATED LINKS
Inputting chord symbol regions on page 326
Slash regions on page 1261
Hiding/Showing chord symbols on page 878
Hiding/Showing signposts on page 450
Annotations on page 597

Hiding/Showing chord symbol region highlights
You can hide/show colored highlights for chord symbol regions at any time; for example, if you 
want to show the highlights when inputting music but hide them when engraving.

PROCEDURE

● Choose View > Highlight Chord Symbol Regions.

Transposing chord symbols
You can transpose chord symbols after you have input them, independently of any notes.

TIP

● Dorico Elements automatically shows the appropriate chord symbols for transposing 
instruments in transposing layouts.
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● If you want to transpose chord symbols to reflect a capo, you can instead show capo chord 
symbols.

PROCEDURE

1. In Write mode, select the chord symbols you want to transpose.

2. Choose Write > Transpose to open the Transpose dialog.

3. Adjust the parameters required for your transposition, such as interval and quality.

TIP

● We recommend using the Calculate interval section to determine your required 
settings; for example, if you want to transpose from G♭ major to G major.

● Different intervals have different possible qualities. For example, you can specify a major 
third but not a major octave. Therefore, if you want to set your transposition parameters 
manually, we recommend selecting the interval before the quality.

4. Click OK to save your changes and close the dialog.

RESULT
The selected chord symbols are transposed.

RELATED LINKS
Transpose dialog on page 470
Concert vs. transposed pitch on page 178
Making layouts transposed/concert pitch on page 178
Capos on page 157

Respelling chord symbols
You can change the enharmonic spelling of chord symbols for transposing instruments; for 
example, to choose a simpler enharmonic equivalent spelling. This changes the enharmonic 
spelling of chord symbols in all transposing layouts and for all instruments with the same 
transposition.

PROCEDURE

1. In Write mode, open a layout with the transposition for which you want to respell chord 
symbols.

For example, to respell a chord symbol for all instruments in B♭, open the part layout for an 
instrument in B♭.

2. Select the chord symbol you want to respell.

3. Press Return  to open the chord symbols popover for the selected chord symbol.

The existing entry for the chord symbol is shown inside the popover.

4. Change the root name of the chord, but leave other details as they were, such as quality, 
interval, or alterations.

For example, change just the root of D♭maj13 from Db to C#.

5. Press Return  to close the popover.
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RESULT
The spelling of the chord symbol is changed in transposing layouts for all instruments with the 
same transposition. For example, changing the spelling of a chord symbol for a Clarinet in B♭ also 
changes the spelling of that chord symbol in the part layout for a Trumpet in B♭.

RELATED LINKS
Chord symbols popover on page 320
Respelling notes on page 473
Fretted instrument tuning on page 153
Defining capos for chord symbols/diagrams on page 163
Hiding/Showing capo chord symbols on page 163

Showing chord symbols as modes
You can show individual chord symbols as their modal equivalent if one exists for that chord 
symbol.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the chord symbols you want to show as a mode. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Show as mode in the Chord Symbols group.

3. Select the mode you want from the menu.

RESULT
The selected chord symbols are respelled according to the selected mode. This does not affect 
the notes included in the chord symbols.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503

Resetting the enharmonic spelling of chord symbols
You can remove enharmonic spelling overrides for chord symbols you have respelled and 
return them to their default spelling. You can remove overrides for instruments with a single 
transposition only, such as instruments in B♭, or for all instrument transpositions.

PROCEDURE

1. In Write mode, select the chord symbol whose spelling you want to reset.

● If you want to reset the enharmonic spelling of the chord symbol for a single instrument 
transposition only, select the chord symbol on a staff belonging to an instrument with 
that transposition. For example, select it on the staff of any instrument in B♭ to reset the 
chord symbol for all instruments in B♭.
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● If you want to reset the enharmonic spelling of the chord symbol for all instrument 
transpositions, select the chord symbol on any staff that belongs to a transposing 
instrument.

2. Press Return  to open the chord symbols popover for the selected chord symbol.

The existing entry for the chord symbol is shown inside the popover.

3. Reset the enharmonic spelling of the chord symbol in any of the following ways:

● To reset the enharmonic spelling of the chord symbol for instruments only with the 
selected transposition, enter Alt/Opt-S  into the chord symbols popover.

● To reset the enharmonic spelling of the chord symbol for all instrument transpositions, 
enter Shift-Alt/Opt-S  into the popover.

4. Press Return  to close the popover.

RESULT
The enharmonic spelling of the selected chord symbol in transposing layouts is reset, either just 
for instruments with the specified transposition or for all transposing instruments.

Hiding/Showing the root and quality of chord symbols
You can hide the root and quality of chord symbols if they follow another chord symbol with the 
same root and quality, but have a different altered bass note.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the chord symbols whose root and quality you want to hide. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Hide root and quality in the Chord Symbols group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The root and quality of the selected chord symbols are hidden when the checkbox is activated, 
and shown when the checkbox is deactivated.

When the property is deactivated, chord symbols follow your project-wide setting.

TIP

You can choose to show the root and quality of chord symbols always, even if successive chord 
symbols have the same root and quality, in the Altered Bass Notes section of the Chord 
Symbols Options dialog.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Chord symbol appearance presets on page 872
Large selections on page 424
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Changing the arrangement of compound chord symbols
You can change the arrangement of individual polychord and altered bass note chord symbols, 
independently of your project-wide settings. For example, if you want to show some polychord 
chord symbols stacked vertically but others in a horizontal row. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the compound chord symbols whose arrangement you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Compound chord arrangement in the Chord Symbols 
group.

3. Select one of the following options from the menu:

● Diagonal arrangement

● Stacked arrangement

● Linear arrangement

RESULT
The arrangement of the selected compound chord symbols is changed. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the default arrangement of all polychord and altered bass note chord symbols 
project-wide and independently of each other in the Chord Symbols Options dialog.

EXAMPLE

Diagonal arrangement Stacked arrangement Linear arrangement

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Large selections on page 424
Chord components on page 872
Chord symbol appearance presets on page 872
Inputting chord symbols on page 318

Chord symbols
Changing the arrangement of compound chord symbols 

887
Dorico Elements 5.1.30



Changing the vertical alignment of chord symbols on page 881

Erasing the background of chord symbols
You can erase the background of individual chord symbols; for example, to ensure chord 
symbols remain legible when crossing barlines. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the chord symbols whose backgrounds you want to erase.

2. In the Properties panel, activate Erase background in the Chord Symbols group.

RESULT
The backgrounds of the selected chord symbols are erased. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating Erase background returns the selected chord symbols to the default non-erased 
background.

EXAMPLE

Chord symbol with non-erased background Chord symbol with erased background

RELATED LINKS
Engrave toolbox on page 503
Changing the alignment of chord symbols relative to notes on page 880
Changing the staff-relative placement of chord symbols on page 882

Changing the erasure padding of chord symbols
You can change the erasure padding of individual chord symbols, including changing the 
padding between chord symbols and each edge of their erased areas independently. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the chord symbols whose erasure padding you want to change.

2. In the Properties panel, activate the Erasure padding properties, individually or together, in 
the Chord Symbols group.

● L changes the padding between chord symbols and their left edge.

● R changes the padding between chord symbols and their right edge.

● T changes the padding between chord symbols and their top edge.

● B changes the padding between chord symbols and their bottom edge.

3. Change the values in the value fields.

RESULT
Increasing the values increases the padding, decreasing the values decreases the padding. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

TIP

You can change the default erasure padding of all chord symbols project-wide in the Design 
section of the Chord Symbols Options dialog. However, this does not allow you to change the 
padding of each edge independently.

Parenthesized chord symbols
Parentheses around chord symbols are often used to indicate an alternative set of chord changes 
or that chords are optional. In Dorico Elements, you can show parentheses around any chord 
symbol that uses appearance presets.

A phrase containing parenthesized chord symbols

You can add chord symbol parentheses both when inputting chord symbols and by 
parenthesizing existing chord symbols.

By default, parenthesized chord symbols show parentheses on both sides. You can show only a 
single left or right parenthesis on individual parenthesized chord symbols.

NOTE

● You cannot show parentheses on custom chord symbols; that is, chord symbols whose 
appearance you have overridden.

● You can change the default appearance of chord symbol parentheses project-wide, including 
suppressing parentheses around alterations inside parenthesized chord symbols in different 
circumstances, in the Parentheses section of the Chord Symbols Options dialog.
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RELATED LINKS
Inputting chord symbols on page 318
Chord symbol appearance presets on page 872
Bracketed noteheads on page 1066
Showing single brackets on figured bass on page 960

Parenthesizing chord symbols
You can show individual chord symbols in parentheses; for example, to indicate optional chords. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

You cannot show parentheses on custom chord symbols; that is, chord symbols whose 
appearance you have overridden.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols you want to parenthesize. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Parenthesized in the Chord Symbols group.

RESULT
Parentheses are shown around each selected chord symbol. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating Parenthesized removes parentheses from the selected chord symbols.

EXAMPLE

Chord symbols without parentheses Chord symbols with parentheses

Showing single parentheses on chord symbols
You can show only a single left or right parenthesis on individual parenthesized chord symbols; 
for example, to indicate that all chord symbols between two parenthesized chord symbols are 
optional. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the parenthesized chord symbols on which you want to show a single parenthesis. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Parenthesis to show in the Chord Symbols group.

3. Choose one of the following options:

● Start

● End

RESULT
Parentheses are hidden on the corresponding side of the selected chord symbols, leaving a 
single parenthesis on the other side. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

EXAMPLE

Parentheses around all chord symbols Parentheses at the start of the first chord and end of 
the last chord

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Large selections on page 424
Showing brackets around one/all noteheads in tie chains on page 1069

Changing the style of chord symbol parentheses
You can change the parenthesis style for individual chord symbols. For example, you might show 
stacked chord symbols with slender/tall parentheses due to their height.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the parenthesized chord symbols whose parenthesis style you want to change. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Parenthesis style in the Chord Symbols group.
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3. Select one of the following options from the menu:

● Thick

● Slender

● Slender/tall

RESULT
The parenthesis style of the selected parenthesized chord symbols is changed.

EXAMPLE

Thick Slender Slender/tall

Changing the size of chord symbol parentheses
You can change the size of chord symbol parentheses without changing the size of the chord 
symbols to which they apply; for example, to ensure that parentheses appear the same size on 
adjacent chord symbols with different heights. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the parenthesized chord symbols whose parenthesis size you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Parenthesis scale % in the Chord Symbols group.

3. Change the value in the value field.

The scale size is expressed as a percentage of the parenthesis glyph rather than the chord 
symbol, allowing you to create a consistent parenthesis size regardless of the chord symbol 
height.

RESULT
The size of parentheses around the selected chord symbols is changed.

TIP

You can change the default height of all chord symbol parentheses project-wide in the 
Parentheses section of the Chord Symbols Options dialog.

RELATED LINKS
Chord symbol font styles on page 877
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Large selections on page 424

Moving chord symbol parentheses graphically
You can move individual chord symbol parentheses graphically to the right or left. For example, 
to increase the space between particular chord symbols and their parentheses. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the parenthesized chord symbols whose parentheses you want to 
move.

2. In the Properties panel, activate the following properties, individually or together, in the 
Chord Symbols group:

● Open parenthesis offset

● Closed parenthesis offset

3. Move the corresponding parentheses in one of the following ways:

● To move them to the right, increase the value in the value field.

● To move them to the left, decrease the value in the value field.

RESULT
The corresponding parentheses for the selected parenthesized chord symbols are moved 
graphically. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

TIP

You can change the default gap between all chord symbols and parentheses project-wide in the 
Parentheses section of the Chord Symbols Options dialog.

Chord symbols imported from MusicXML
Chord symbols are imported from MusicXML files. However, chords that specify Neapolitan, 
Italian, French, German, Pedal, Tristan, and Other values for the kind of element are ignored 
during import, as there is no information to specify what notes these chord symbols are meant 
to describe.

RELATED LINKS
Generating chord symbols from notes on page 326

Chord symbols
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Chord diagrams

Chord diagrams represent the pattern of strings and frets on fretted instruments and use dots 
to indicate the stopped finger positions required to produce the corresponding chord. This 
demonstrates the specific shape of chords in a compact way and is useful if a particular voicing is 
required.

In Dorico Elements, chord diagrams are part of chord symbols, meaning you can show them 
below chord symbols wherever they are shown. For players set to show chord diagrams, you can 
show only the chord symbol or chord diagram for individual chord symbols.

You can show chord diagram shapes for any fretted instrument, including different tunings and 
string arrangements, such as guitar DADGAD tuning. This can be different to the instrument 
above which they appear; for example, if you want to show chord diagram shapes for standard 
guitar tuning above the bass staff.

You can also show chord diagrams for all chord symbols used in a flow in a grid at the start of the 
flow, as is common in lead sheets for pop and rock music. You can show used chord diagrams 
grids independently of showing them alongside chord symbols in the music.

A sequence of chord symbols with chord diagrams for banjo

The positions of stopped frets relative to each other are known as “shapes” in Dorico Elements. 
Any playable shape can be re-used for other chords whose pitches match the shape, including 
any new chord diagram shapes you have created. This includes shapes being available for other 
instruments, other tunings, and other positions along the fretboard, so long as any open strings 
included in the shape can be played with a barré at other fret positions.

A single chord can appear with different chord diagram shapes for different instruments and 
tunings, as their open string pitches and the number of strings they have varies.

RELATED LINKS
Chord symbols on page 871
Hiding/Showing chord diagrams on page 895
Showing only chord symbols or chord diagrams on page 897
Hiding/Showing fingerings in chord diagrams on page 900
Used chord diagrams grids on page 898
Changing the chord diagram shape on page 902
Creating new chord diagram shapes on page 903
Capos on page 157
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Chord diagram components
Chord diagrams use a combination of symbols, dots, and lines to convey the information about 
strings, fret positions, and finger positions that performers require to play the corresponding 
chord.

1 Omitted string

Indicates a string that must not sound.

2 Open string

Indicates a string that must sound but must be left open; that is, not stopped.

3 Dots

Indicate the fret positions where strings should be stopped, usually with left-hand fingers.

4 Barré

Indicates that multiple strings must be stopped with the same finger, usually pressed flat 
against the fretboard.

5 Starting fret number

Indicates the number of the highest fret in the chord diagram when this is not the first fret.

6 Nut

Represents the top of the fretboard, or “nut”, and appears in chord diagrams whose highest 
fret is the first fret.

7 Fingerings

Indicate the finger used to stop the string. Fingerings can be positioned inside dots or at the 
ends of strings.

RELATED LINKS
Chord diagram font styles on page 906

Hiding/Showing chord diagrams
You can hide/show chord diagrams for any type of fretted instrument alongside all chord 
symbols on a per-player basis. You can also change the fretted instrument or tuning for which 
chord diagrams are shown.

NOTE

You cannot show chord diagrams when chord symbols are hidden entirely. However, you can 
show only the chord symbol or chord diagram for individual chord symbols.

Chord diagrams
Chord diagram components 
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PREREQUISITE

● You have input the chord symbols for which you want to show chord diagrams.

● Chord symbols are shown above the staves where you want to show chord diagrams.

● If you want to show chord diagrams using a custom fretted instrument tuning, you have 
imported the tuning or changed the tuning of a fretted instrument in the project accordingly.

PROCEDURE

1. In Setup mode, in the Players panel, select a player for whom you want to hide/show chord 
diagrams.

2. In the action bar, click Player Settings  and choose one of the following options:

● To show chord diagrams, choose Chord Diagrams > [Fretted instrument and tuning]. 
For example, to show chord diagrams for a guitar in DADGAD tuning, choose Chord 
Diagrams > DADGAD guitar tuning.

● To hide chord diagrams, choose Chord Diagrams > No Chord Diagrams.

RESULT
Chord diagrams are shown alongside all chord symbols for the selected player, as appropriate 
for the selected fretted instrument and tuning. Dorico Elements shows the simplest shape 
available for each chord; that is, shapes with the most open strings, easy barré positions, or 
finger positions closest to the nut.

If no chord diagram is available for a chord symbol, an empty chord diagram is shown.

TIP

● You can also hide/show chord diagrams by right-clicking players and choosing these options 
from the context menu.

● You can edit empty chord diagrams to save a new chord diagram shape.

EXAMPLE

Chord symbols shown but chord diagrams hidden Chord diagrams shown (standard guitar tuning)

RELATED LINKS
Players panel on page 110
Inputting chord symbols on page 318
Hiding/Showing chord symbols on page 878
Fretted instrument tuning on page 153

Chord diagrams
Hiding/Showing chord diagrams 
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Showing only chord symbols or chord diagrams
You can show only the chord symbol or chord diagram for individual chord symbols on staves set 
to show chord diagrams. For example, if you want to show both the symbol and diagram for the 
first time each chord appears but only show chord symbols for subsequent instances. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● You have shown chord diagrams for the players on whose staves you want to show only 
chord symbols or chord diagrams.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the chord symbols whose shown symbols/diagrams you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Show only in the Chord Symbols group.

3. Choose one of the following options:

● Chord Symbol

● Chord Diagram

RESULT
The selected chord symbols show only symbols or diagrams. In systems containing both chord 
symbols and chord diagrams, chord symbols are aligned further from the staff than chord 
diagrams.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

EXAMPLE

Chord symbols shown Chord diagrams shown (standard guitar tuning)

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503

Chord diagrams
Hiding/Showing chord diagrams 
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Used chord diagrams grids
Used chord diagrams grids are commonly used in lead sheets for pop and rock music. They are 
typically shown instead of chord diagrams alongside chord symbols in the music to save vertical 
space, and so they can appear at a larger scale size, making the details of each chord diagram 
easier to read.

By default, all chord diagrams in each flow are included in the corresponding used chord 
diagrams grid.

The order of chord diagrams in used chord diagrams grids is determined by the order in which 
they first appear in the flow. Each different voicing appears as a separate chord diagram, but 
each voicing appears only once in the grid.

If you input more chord symbols or change the voicing of existing chord diagrams, the used 
chord diagrams grids update automatically to include them.

Used chord diagrams grid frame at the start of a flow

In Engrave mode, used chord diagrams grids appear inside frames.

You can hide/show used chord diagrams grids in each layout independently. You can also 
include/exclude individual chord diagrams.

NOTE

● You cannot select or edit used chord diagrams grid frames.

● You cannot select or edit individual chord diagrams in used chord diagrams grids.

Hiding/Showing used chord diagrams grids
You can hide/show grids that contain all chord diagrams used in each flow in each layout 
independently. By default, used chord diagrams grids display standard guitar tuning chord 
diagrams, but you can change this to show chord diagrams for any fretted instrument or tuning.

PREREQUISITE

● You have removed page template overrides from all pages on which you want to show used 
chord diagrams grids.

● If you want to show chord diagrams using a custom fretted instrument tuning, you have 
imported the tuning or changed the tuning of a fretted instrument in the project accordingly.

Chord diagrams
Used chord diagrams grids 
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● We recommend that you have input chord symbols and changed the shape of any chord 
symbols you want to appear with a specific voicing.

NOTE

It is customary not to show chord diagrams alongside chord symbols when showing a 
used chord diagrams grid, and you cannot change the chord diagram shape when chord 
diagrams are hidden.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show used chord diagrams 
grids at the start of flows.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Diagrams section, activate/deactivate Show chord diagrams used at start of 
flow.

5. Optional: Change the settings for used chord diagrams grids as required.

For example, you can change the fretted instrument tuning for chord diagrams in the grid, 
their scale size, and the distance between chord diagrams and/or rows of chord diagrams.

6. Click Apply, then Close.

RESULT
Chord diagrams for all chord symbols used in the flow are shown in a grid above the start of each 
flow in the selected layouts, and are positioned according to the settings for the selected layouts. 
If flow headings are shown, the used chord diagrams grid appears below them.

NOTE

Even if no chord symbols exist in a flow, vertical space for the used chord diagrams grid is added 
at the start of the flow.

AFTER COMPLETING THIS TASK
You can change the margins of pages, music frames, and/or flow headings if required to 
accommodate used chord diagrams grids.

RELATED LINKS
Inputting chord symbols on page 318
Hiding/Showing chord symbols on page 878
Defining capos for used chord diagrams grids on page 165
Fretted instrument tuning on page 153
Creating new chord diagram shapes on page 903
Hiding/Showing systemic barlines on single-staff systems on page 821
Margins on page 614
Removing page template overrides on page 651

Chord diagrams
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Including/Excluding chord diagrams from used chord diagrams grids
You can include/exclude individual chord diagram shapes from used chord diagrams grids. This 
allows you to control how many shapes appear for the same chord.

By default, all chord diagrams in each flow are included in the corresponding used chord 
diagrams grid.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the chord symbols whose diagram shape you want to include/exclude from used 
chord diagrams grids. You can do this in Write mode and Engrave mode.

NOTE

To exclude a chord diagram that occurs multiple times in the flow, you must select all 
occurrences.

2. In the Properties panel, activate/deactivate Exclude from chords used at start of flow in 
the Chord Symbols group.

RESULT
The selected chord diagrams are excluded from used chord diagrams grids when the property is 
activated for all occurrences of the corresponding shape in the flow.

The selected chord diagrams are included in used chord diagrams grids when the property is 
deactivated for at least one occurrence of the corresponding shape.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Hiding/Showing chord diagrams on page 895
Changing the chord diagram shape on page 902

Hiding/Showing fingerings in chord diagrams
You can hide/show fingerings in chord diagrams shown alongside chord symbols and in used 
chord diagrams grids independently of each other and in each layout independently. You can 
choose whether fingerings appear inside dots or at the ends of strings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show fingerings in chord 
diagrams.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

Chord diagrams
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3. In the category list, click Chord Symbols and Diagrams.

4. In the Chord Diagrams section, activate/deactivate the following options, individually or 
together:

● To hide/show fingerings in chord diagrams shown alongside chord symbols, activate/
deactivate Show fingerings in chord diagrams.

● To hide/show fingerings in used chord diagrams grids, activate/deactivate Show 
fingerings in chord diagrams at start of flow.

5. Choose one of the following options for Fingerings position:

● Inside dot

● At end of string

6. Click Apply, then Close.

RESULT
Fingerings are shown in the corresponding position in chord diagrams in the selected layouts 
when the options are activated, and hidden when they are deactivated. This also affects whether 
fingerings appear in the Edit Chord Diagram dialog.

EXAMPLE

Fingerings hidden Fingerings shown inside dots Fingerings shown at the ends of 
strings

AFTER COMPLETING THIS TASK
You can change the fingerings shown in chord diagrams when editing their shape.

RELATED LINKS
Used chord diagrams grids on page 898
Creating new chord diagram shapes on page 903
Edit Chord Diagram dialog on page 904
Chord diagram font styles on page 906
Fingering on page 971
Hiding/Showing fingering on page 978

Resetting chord diagram fingerings
You can reset changes you have made to fingerings in individual chord diagrams without 
resetting other changes to the shape.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Chord diagrams
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PROCEDURE

1. Select the chord diagrams whose fingerings you want to reset. You can do this in Write mode 
and Engrave mode.

2. Choose Edit > Notations > Chord Symbols and Diagrams > Reset Chord Diagram Finger 
Numbering. You can also choose this option from the context menu.

Changing the chord diagram shape
You can change the chord diagram shape shown at individual rhythmic positions; for example, if 
you require a shape with a different voicing. Many chords have multiple playable shapes.

You can also apply your changes to all other instances of the same chord for instruments with 
compatible tunings.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the chord diagram whose shape you want to change. You can do this in Write mode 
and Engrave mode.

NOTE

You can only change the shape of a single chord diagram at a time.

2. Change the shape in any of the following ways:

● To cycle through all the available shapes for the selected chord, press Alt/Opt-Q .

● To open the Choose Chord Diagram dialog and see all the available shapes for the 
selected chord at once, press Shift-Alt/Opt-Q .

3. Optional: In the Choose Chord Diagram dialog, select the shape you want to use.

TIP

If the shape you require is not available, you can click Edit, which allows you to create a new 
shape.

4. Click OK to save your changes and close the dialog.

5. Optional: To apply the new shape to other instances of the same chord for instruments 
with compatible tunings, choose Edit > Notations > Chord Symbols and Diagrams > Copy 
Shape to Matching Chord Symbols. You can also choose this option from the context 
menu.

RESULT
The shape shown for the selected chord diagram is changed. This also updates all other chord 
diagrams using the same fretted instrument tuning at the same rhythmic position.

Your most recently selected chord diagram shapes are automatically shown when you 
subsequently input the same chord symbols at other rhythmic positions in the flow.

Chord diagrams
Changing the chord diagram shape 
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Choose Chord Diagram dialog
The Choose Chord Diagram dialog allows you to view all available chord diagram shapes for the 
selected chord and select the one you want to use.

● You can open the Choose Chord Diagram dialog in Write mode by selecting a chord 
diagram and pressing Shift-Alt/Opt-Q .

The Choose Chord Diagram dialog comprises the following:

1 Available chord diagrams

Displays all the valid chord diagram shapes for the selected chord and allows you to select a 
different shape to show at the selected rhythmic position. Shapes you have created yourself 
appear in a different color.

2 Edit

Opens the Edit Chord Diagram dialog, which allows you to edit the shape of chord 
diagrams, including changing the number of frets shown, stopped fret positions, and the 
starting fret number.

Creating new chord diagram shapes
You can create new chord diagram shapes by editing an existing one; for example, if you want 
an alternative voicing for a chord or to show a barré. Your changes to existing chord diagram 
shapes are saved as a new shape, they do not overwrite the existing one.

NOTE

In Dorico Elements, you cannot start new chord diagram shapes from scratch.

PROCEDURE

1. In Write mode, select the chord diagram whose shape you want to edit.

2. Press Shift-Alt/Opt-Q  to open the Choose Chord Diagram dialog.

3. Click Edit to open the Edit Chord Diagram dialog.

4. Edit the shape and settings of the chord diagram as required.

For example, you can change open strings to omitted strings, change the stopped fret 
position on strings to change the corresponding string pitch, or change the fingering of 
individual stopped fret positions.

Chord diagrams
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5. Optional: If you want the shape to be available for chords with different start fret positions, 
activate Chord may be moved along the neck.

6. Click Save, then Close.

RESULT
The new shape is saved and is used for the selected chord diagram. The new shape also becomes 
available for any other chord for which it is valid.

Edit Chord Diagram dialog
The Edit Chord Diagram dialog allows you to edit the shape of individual chord diagrams, 
including changing the number of frets shown, stopped fret positions, and the starting fret 
number.

You can open the Edit Chord Diagram dialog in any of the following ways:

● In Write mode by opening the Choose Chord Diagram dialog, selecting the chord diagram 
whose shape you want to edit, and clicking Edit.

● In Engrave mode by double-clicking a chord diagram, or selecting it and pressing Return .

The Edit Chord Diagram dialog contains the following options and sections:

1 Name

Displays the name of the chord whose chord diagram you are editing in the dialog. You 
cannot change this name.

2 Tuning

Displays the fretted instrument and tuning for the current chord diagram.

3 Chord may be moved along the neck

Chord diagrams
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Allows you to specify whether or not the shape of the chord diagram can be reused at other 
fret positions; for example, by playing open strings with a barré at higher fret positions.

4 Notes not in chord diagram

Displays any pitches that are part of the chord but not currently included in the chord 
diagram.

5 Open string pitch

Displays the open pitch of the corresponding string for reference.

6 Current string pitch

Displays the current pitch of the corresponding string if it is open or stopped. If the pitch of a 
string is not part of the chord, the string pitch appears red.

7 String status

Displays the current usage status of the corresponding string and allows you to switch the 
status of individual strings between open and omitted by clicking in this row.

● O: Open string

● X: Omitted string

● No symbol: Stopped string

8 Chord diagram shape editor

Displays the current arrangement of stopped frets using dots and allows you to change the 
chord diagram shape. You can move stopped frets by clicking at the required positions. Each 
string can only have a single stopped fret position.

If two or more strings are stopped at the same fret, you can hide/show a barré by clicking 
any of the dots at that fret position.

You can change fingerings by double-clicking them and entering a new number, including 0 
to show no fingering or T for thumb fingerings on the lowest string.

9 Action bar

Contains options that allow you to edit and change the number of frets.

● Starting fret: Changes the fret number of the highest fret in the chord diagram.

● Starting fret number offset: Changes the offset of the starting fret number. For 
example, if you want the starting fret label to appear beside the second fret down the 
chord diagram in order to include a barré.

● Add fret : Adds a fret to the bottom of the chord diagram.

● Remove fret : Removes a fret from the bottom of the chord diagram.

● Reset Chord Diagram : Removes your changes to the chord diagram and resets it to 
its default shape.

10 Save

Saves the chord diagram shape and updates the selected chord diagram in the music area. 
The shape also becomes available as an alternative shape for other compatible chords.

Chord diagrams
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Chord diagram font styles
There are different font styles for fingerings and starting fret numbers in chord diagrams. You 
can change different aspects of these fonts in the Edit Font Styles dialog, such as changing their 
font size to make chord diagram fingerings appear smaller.

The following font styles are used for chord diagrams:

1 Chord Diagram Fingering Font: Used for fingerings in chord diagrams, both inside dots 
and at the ends of strings. However, fingerings inside dots never appear larger than dots, 
regardless of the font size.

2 Chord Diagram Fret Number Font: Used for starting fret numbers in vertical chord 
diagrams.

3 Chord Diagram Horizontal Fret Number Font: Used for starting fret numbers in horizontal 
chord diagrams.

RELATED LINKS
Edit Font Styles dialog on page 754
Hiding/Showing fingerings in chord diagrams on page 900
Changing the chord diagram shape on page 902

Chord diagrams
Chord diagram font styles 

906
Dorico Elements 5.1.30



Clefs

Clefs are the symbol at the start of every system that give the notes on the staff context; that is, 
the clef tells you which note of the scale applies to each line or space of the staff. To minimize 
the number of ledger lines required for notes, different clefs are typically used according to the 
register of instruments.

The common clefs are:

● Treble clef, or G clef, whose spiral shape centers around G, normally the G above middle C.

● The bass clef, or F clef, in which two dots are shown either side of the line corresponding to 
F, normally the F below middle C.

● The C clef, in which the center of the bracket to the right of the clef’s thick vertical line is 
positioned on the line that corresponds to C, normally middle C. When positioned on the 
middle line of the staff, the C clef is known as the alto clef. When positioned on the second 
staff line from the top, the C clef is known as the tenor clef.

The E below middle C 
shown in a treble clef

The E below middle C 
shown in a bass clef

The E below middle C 
shown in a C (alto) clef

The E below middle C 
shown in a C (tenor) clef

In Dorico Elements, notes are automatically positioned on staves according to the prevailing clef.

Initial clefs at the start of flows and systems appear full size, while mid-system clef changes are 
automatically scaled down.

Many instruments in Dorico Elements have variants that show alternative clefs according to 
the layout transposition by default. You can select the appropriate instrument variant from the 
instrument picker when adding or changing instruments.

NOTE

● You can only select clefs that you have input. You cannot select initial clefs at the start of 
flows or clefs shown automatically at the start of each system.

● You can hide/show clefs in individual layouts, according to the layout transposition, and at 
the start of single-staff systems.

● If clef changes occur at the start of a new system or page, a cautionary clef is shown at the 
end of the previous system. In Dorico Elements, the clefs shown at the end of one system 
and at the start of the next system are the same item, not separate items. You cannot hide 
cautionary clefs.
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RELATED LINKS
Input methods for clefs and octave lines on page 329
Clefs with octave indicators on page 913
Instrument picker on page 112
Hiding/Showing clefs on page 910
Hiding/Showing clefs according to layout transpositions on page 910
Hiding/Showing clefs at the start of systems on page 911
Cautionary key signatures on page 1024
Cautionary time signatures on page 1384

Showing clefs after grace notes
According to convention, clefs are positioned before grace notes so this is the default in Dorico 
Elements. However, in some circumstances you might want to position clefs between grace notes 
and normal notes.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the clefs you want to show after grace notes. You can do this in Write mode and 
Engrave mode.

2. Choose Edit > Notations > Clef > After Grace Notes. You can also choose this option from 
the context menu.

RESULT
The selected clefs are positioned between normal notes and grace notes.

NOTE

You can reset the position of clefs relative to grace notes by selecting the clefs whose position 
you want to reset and choosing Edit > Notations > Clef > Reset Clef Position. You can also 
choose this option from the context menu.

EXAMPLE

Treble clef before grace notes Treble clef after grace notes to align with bass clef

RELATED LINKS
Engrave toolbox on page 503

Clefs
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Moving clefs graphically
You can move individual clefs graphically without affecting the positions of any other items.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the square note spacing handle above the clef you want to move.

A circular handle appears beside the clef.

2. Press Tab  to select the circular handle.

3. Move the handle in any of the following ways:

● To move it a standard amount to the right or left, press Alt/Opt  plus the corresponding 
arrow key. For example, press Alt/Opt-Left Arrow  to move handles to the left.

● To move it a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move it a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow .

● To move it a small amount, press Ctrl/Cmd - Shift  plus the standard key command; for 
example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

NOTE

You cannot move note spacing handles with the mouse, you can only move them using the 
keyboard.

RESULT
The clef is moved graphically to the right/left without affecting other items at the same rhythmic 
position.

TIP

You can also change Spacing offset in the Clefs group of the Properties panel to move clefs 
horizontally. However, this also affects global note spacing around the rhythmic position of the 
clef.

The Spacing offset property in the Clefs group of the Properties panel is not available when 
Note Spacing  is activated.

RELATED LINKS
Note spacing on page 507

Clefs
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Hiding/Showing clefs
You can hide/show individual clefs in layouts of any transposition; for example, if some clef 
changes are only necessary in full scores to avoid ledger lines. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the clefs you want to hide, or the signposts of clefs you want to show. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hide in the Clefs group.

RESULT
The selected clefs are hidden when Hide is activated, and shown when it is deactivated. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

Signposts are shown at the position of each hidden clef. However, signposts are not printed by 
default.

TIP

● You can hide/show clef signposts by choosing View > Signposts > Clefs.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Input methods for clefs and octave lines on page 329
Key Commands page in the Preferences dialog on page 60
Signposts on page 450

Hiding/Showing clefs according to layout transpositions
You can show individual clefs only in layouts that are either concert or transposed pitch. For 
example, due to their transpositions, some instruments require clef changes in concert pitch 
scores to avoid excess ledger lines, but do not require those clef changes in their transposed 
pitch parts.

By default, all clefs appear in all layouts.

TIP

Many instruments in Dorico Elements have variants that show alternative clefs according to 
the layout transposition by default. You can select the appropriate instrument variant from the 
instrument picker when adding or changing instruments.

Clefs
Hiding/Showing clefs 
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the clefs or signposts of clefs you want to hide/show according to the layout 
transposition. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Show for transposition in the Clefs group.

3. Choose one of the following options:

● Concert Pitch

● Transposing Pitch

RESULT
The selected clefs only appear in layouts with the corresponding transposition. In layouts where 
clefs are hidden, they are indicated by signposts.

Hidden clefs have no effect on note and staff spacing.

RELATED LINKS
Engrave toolbox on page 503
Instrument picker on page 112
Making layouts transposed/concert pitch on page 178
Transposing instruments on page 132
Signposts on page 450

Hiding/Showing clefs at the start of systems
By default, clefs are shown at the start of all systems. You can hide/show clefs at the start of 
single-staff systems from the second system onwards in each flow independently.

Hiding clefs on single-staff systems after the first system is a convention used in hand-copied 
lead sheets, usually in combination with hiding key signatures and showing systemic barlines.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to hide/show clefs after the first system.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Clefs.

4. Choose one of the following options for Clefs at start of systems following first system:

● Show clefs

● Hide clefs

5. Click Apply, then Close.

Clefs
Hiding/Showing clefs 
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RESULT
Clefs are hidden or shown at the start of single-staff systems from the second system onwards in 
the selected flows.

NOTE

Clefs are always shown at the start of systems that contain more than one staff.

RELATED LINKS
Hiding/Showing systemic barlines on single-staff systems on page 821
Hiding/Showing key signatures at the start of systems on page 1022

Changing the octave of clefs
You can change the octave shift of individual clefs. For example, to accommodate different horn 
and bass clarinet transposition conventions. You can change the octaves of clefs in concert pitch 
and transposed pitch layouts independently.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have opened a layout with the required transposition in the music area. For example, 
if you want to change the octave of clefs in concert pitch, you have opened a concert pitch 
layout.

● If you want to change the octave of initial clefs, you have input clefs at the start of each flow.

PROCEDURE

1. Select the clefs whose octave you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Octave shift in the Clefs group.

3. Change the value in the value field.

RESULT
The octave of the selected clefs is changed in all layouts with the same transposition. For 
example, 1 shifts clefs up one octave, and -1 shifts clefs down one octave.

The pitches of notes on the staves of the selected clefs are adjusted automatically. For example, 
if you shift a clef up one octave, notes after the clef appear an octave lower than they do without 
the octave shift.

TIP

● You can specify octave shifts when inputting clefs using the clefs and octave lines popover.

● You can also change whether Dorico Elements respects or ignores octave indicators on clefs, 
such as treble G clef, octave above.

RELATED LINKS
Engrave toolbox on page 503
Clefs and octave lines popover on page 329
Concert vs. transposed pitch on page 178

Clefs
Changing the octave of clefs 
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Clefs with octave indicators
Clefs with octave indicators indicate that notes are played in a different register to the one 
notated. An octave indicator above the clef indicates that notes are played higher than notated, 
while an octave indicator below the clef indicates that notes are played lower than notated.

Of these clefs, only the treble clef 8 below is still commonly used for tenor vocal parts.

Traditionally, clef octave indicators were used as a reminder of transposing instruments; 
however, in more recent music, some composers use clef octave indicators as an alternative 
to octave lines for extended passages. Therefore, Dorico Elements ignores clef octave indicators 
by default. However, transposing instruments are always transposed correctly automatically. For 
example, notes belonging to piccolo instruments are automatically notated an octave lower than 
their pitch in playback, regardless of whether they have a clef with an octave indicator. You 
can change whether Dorico Elements respects or ignores clef octave indicators in each flow 
independently.

RELATED LINKS
Transposing instruments on page 132
Concert vs. transposed pitch on page 178
Octave lines on page 915
Respecting/Ignoring clef octave indicators on page 913
Changing the octave of clefs on page 912
Input methods for clefs and octave lines on page 329

Respecting/Ignoring clef octave indicators
Traditionally, clef octave indicators were used as a reminder of transposing instruments; 
however, in more recent music, some composers use clef octave indicators as an alternative 
to octave lines for extended passages. You can change whether Dorico Elements respects or 
ignores clef octave indicators in each flow independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to respect/ignore clef octave indicators.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Clefs.

4. Choose one of the following options for Clefs with octave indicators:

● Ignore octave indicator

● Respect octave indicator

5. Click Apply, then Close.

Clefs
Clefs with octave indicators 
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RESULT
The handling of clefs with octave indicators is changed in the selected flows. When clef octave 
indicators are respected, the pitches of notes on staves with clefs with octave indicators are 
adjusted automatically. For example, notes with treble G clefs, octave above, appear an octave 
lower than they do when clef octave indicators are ignored.

RELATED LINKS
Transposing instruments on page 132
Changing the octave of clefs on page 912
Hiding/Showing clefs according to layout transpositions on page 910

Clefs
Clefs with octave indicators 
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Octave lines

Octave lines indicate where notes are played higher/lower than they appear in the score or 
part. They are dashed or dotted horizontal lines with an italic numeral at the start. The numeral 
indicates the number of pitches by which the phrase is changed, such as 8 for one octave and 15 
for two octaves.

Octave lines that indicate notes are played higher than notated are placed above the staff, while 
octave lines that indicate notes are played lower than notated are placed below the staff.

A treble clef phrase notated at 
pitch

The treble clef phrase with an 
octave above line

The treble clef phrase with a two 
octaves above line

A bass clef phrase notated at pitch The bass clef phrase with an 
octave below line

The bass clef phrase with a two 
octaves below line

In Dorico Elements, pitches are adjusted automatically when an octave line is present. You do not 
have to change the register of the notes within octave lines.

Octave lines should be horizontal, meaning they can take up significant vertical space, as octave 
lines are usually placed outside all other notations. However, they can be placed within slurs and 
tuplet brackets if the slur or tuplet bracket is longer than the octave line.

Octave lines can continue across system and page breaks. It is customary to show the numeral 
again at the start of each system as a reminder. Cautionary octave line numerals are usually 
parenthesized and the suffix is optional.

RELATED LINKS
Input methods for clefs and octave lines on page 329
Clefs with octave indicators on page 913
Lines on page 1194
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Positions of octave lines
By default, octave lines that indicate notes are played higher than written are placed above the 
staff, while octave lines that indicate notes are played lower than written are placed below the 
staff.

You can move octave lines to new rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

You can move octave lines graphically in Engrave mode, but this does not change the rhythmic 
positions to which they apply.

RELATED LINKS
Input methods for clefs and octave lines on page 329
Moving notes/items rhythmically on page 461
Moving items graphically on page 514
Tucking index properties on page 518

Changing the alignment of octave line numerals relative to notes
You can change whether the left edge, center, or right edge of individual octave line numerals 
is aligned with the first note to which each octave line applies. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the octave lines whose numeral alignment relative to notes you want to change. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate L alignment in the Octave Lines group.

3. Select one of the following options from the menu:

● Left

● Center

● Right

RESULT
The alignment of the numerals of the selected octave lines is changed. For example, if you select 
Right, the right edge of the selected octave line numerals is aligned with the first noteheads to 
which the octave lines apply. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Octave lines
Positions of octave lines 
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Changing the position of octave line numerals relative to accidentals
You can change whether the numerals at the start of individual octave lines are positioned on 
noteheads or accidentals. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the octave lines whose numeral alignment relative to accidentals you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate L position in the Octave Lines group.

3. Choose one of the following options:

● Notehead

● Accidental

RESULT
The alignment of the numerals of the selected octave lines is changed. For example, if you 
choose Accidental, the octave line numerals are aligned with the accidental on the first 
noteheads to which the octave lines apply. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

Hiding/Showing octave lines
You can hide/show individual octave lines in layouts of any transposition; for example, if some 
octave lines are only necessary in full scores to avoid ledger lines. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the octave lines you want to hide, or the signposts of octave lines you want to show. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hide in the Octave Lines group.

RESULT
The selected octave lines are hidden when Hide is activated, and shown when it is deactivated. 
If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

Octave lines
Hiding/Showing octave lines 

917
Dorico Elements 5.1.30



Signposts are shown at the position of each hidden octave line. However, signposts are not 
printed by default.

TIP

● You can hide/show octave line signposts by choosing View > Signposts > Octave Lines.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences.

RELATED LINKS
Clefs on page 907
Concert vs. transposed pitch on page 178
Signposts on page 450
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Key Commands page in the Preferences dialog on page 60
Annotations on page 597

Octave lines in Engrave mode
In Engrave mode, each octave line has three square handles. You can use these handles to move 
the start/end of octave lines graphically, and to lengthen/shorten octave line hooks.

An octave line in Engrave mode

● The start handle moves the start of octave lines graphically. You can move this handle to the 
right/left. When using the keyboard, you can also move this handle upwards/downwards to 
move the whole octave line.

● The top end handle moves the end of octave lines graphically. You can move this handle to 
the right/left.

● The bottom end handle changes the length of the hook. You can move this handle upwards/
downwards.

If octave lines cross system and frame breaks, you can move the line segments on each side of 
the break independently.

RELATED LINKS
Moving items graphically on page 514
Lengthening/Shortening items on page 430
Tucking index properties on page 518

Octave lines
Octave lines in Engrave mode 
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Changing the vertical stacking order of octave lines
You can change the placement of individual octave lines relative to other objects in the vertical 
stack by changing their tucking index value. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

According to general convention, octave lines are placed outside all other objects, but there are 
some instances where they can go inside other objects; for example, inside a slur if that slur is 
longer than the octave line.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the octave lines whose placement in the vertical stack you want to 
change.

2. In the Properties panel, activate Tucking index in the Octave Lines group.

3. Change the value in the value field.

0 positions items closest to notes. The higher the number, the further the item is positioned 
from notes in the stacking order.

RESULT
The placement of the selected octave lines in the vertical stacking order is changed. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Changing the vertical order of playing techniques on page 1185
Tucking index properties on page 518

Octave lines
Changing the vertical stacking order of octave lines 
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Cues

Cues are passages of music shown in instrumental parts that are played by a different player, 
usually to help orientate players before entries or solos following a significant passage of rests.

Cues can also be used to assist with co-ordination or tuning between players, or to indicate 
material that the player might be asked to double.

A cue in a timpani part showing music from the bassoons

NOTE

In Dorico Elements, you cannot input or edit cues. However, cues are shown if you import or 
open a project that contains them.
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Dynamics

Dynamics indicate the loudness of the music and can be combined with expressive text to 
give further clarification about how to perform the music. Dynamics can indicate an immediate 
change in volume or a gradual change over a specified duration.

A phrase with multiple different dynamics

You can add modifiers to dynamics that can give stylistic direction context alongside the 
volume level, such as  espressivo, which indicates that a passage is played loudly but also with 
expressive feeling.

While almost all expressive text is written in italics, dynamics such as  and  use a bold italic 
font.

RELATED LINKS
Input methods for dynamics on page 309
Positions of dynamics on page 922
Gradual dynamics on page 937
Messa di voce hairpins on page 945
Niente markings on page 947
Dynamic modifiers on page 932
Voice-specific dynamics on page 931
Groups of dynamics on page 949
Linked dynamics on page 951
Dynamics editor on page 694
Exporting text on page 102

Types of dynamics
Dorico Elements categorizes dynamics into different groups according to their function.

Immediate dynamics
Immediate dynamics apply to the note to which they are attached until the next 
dynamic marking, and indicate an immediate change from any previous dynamic. 
Immediate dynamics include dynamic symbols, such as  or , and dynamic 
modifiers, such as subito or molto.

Gradual dynamics and hairpins
Gradual dynamics indicate a change in volume that happens incrementally over the 
specified duration. They usually appear either as hairpins or as text instructions, such 
as cresc. or dim..
Gradual dynamics can also have dynamic modifiers that qualify the change in volume, 
such as poco, molto, poco a poco, and niente.
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In Dorico Elements, a hairpin can be shown as messa di voce, which shows a pair of 
hairpins. In some cases, this is easier than having separate lines for each half of the 
pair.

Force/Intensity of attack
These dynamics, such as  and , indicate that a note has a stronger attack than is 
usually expected for the dynamic, similar to an accent articulation.

Combined dynamics
Combined dynamics, such as  or –, specify a sudden change of dynamic.

You can create custom combined dynamics in Dorico Elements, and control the 
intensity of each dynamic in the pair, in the Combined Dynamics section of the 
Dynamics panel. For example, you can make dynamics such as , –, and 
.

NOTE

Combined dynamics must include one  level and one  level.

RELATED LINKS
Gradual dynamics on page 937
Messa di voce hairpins on page 945
Niente markings on page 947
Dynamic modifiers on page 932
Hiding/Showing immediate dynamics on page 927
Changing the appearance/position of subito modifiers on page 934
Changing the appearance of sforzando/rinforzando dynamics on page 929
Hiding/Showing combined dynamic separators on page 928

Positions of dynamics
By default, dynamics are placed below instrumental staves, where they can be read alongside the 
notes, and above vocal staves. This way, they do not clash with lyrics placed below the staff, and 
are still close enough to the notes to be read simultaneously.

Immediate dynamics, such as  or , are centered on the notehead to which they apply. 
The beginnings of gradual dynamics are centered on the notehead from which they begin, or 
immediately after an immediate dynamic at the same position. The ends of gradual dynamics are 
centered on the notehead at which they end, or immediately before an immediate dynamic at 
the same position.

The staff-relative placement of dynamics varies, depending on their function and the type of 
player. For example, dynamics are placed below instrumental staves and above vocal staves by 
default. This ensures dynamics are kept as close to the staff as possible for legibility but are not 
placed between noteheads and lyrics on vocal staves. For grand staff instruments, such as piano 
or harp, dynamics are usually placed between the two staves, but can be placed both above and 
below when each staff requires separate dynamics.

In general, dynamics are not placed within the staff, as hairpins in particular become very hard 
to read. They are also not usually placed within tuplet brackets. Dynamics are placed outside of 
notations such as slurs, which must be kept close to noteheads, but inside pedal lines, which can 
be placed further from noteheads and still be clearly understood.

You can move dynamics to different rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

Dynamics
Positions of dynamics 
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NOTE

When using the mouse, you can only move and lengthen/shorten dynamics to noteheads. When 
using the keyboard, you can move and lengthen/shorten dynamics according to the current 
rhythmic grid resolution.

You can move dynamics graphically in Engrave mode; however, this does not change the 
rhythmic positions to which they are attached.

RELATED LINKS
General placement conventions for hairpins relative to barlines on page 925
Changing the alignment of dynamics relative to noteheads on page 924
Moving the center of messa di voce hairpins on page 945
Changing the staff-relative placement of items on page 434
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430
Moving items graphically on page 514
Gradual dynamics in Engrave mode on page 938
Gradual dynamics on page 937
Messa di voce hairpins on page 945
Niente markings on page 947

Changing the horizontal beat-relative position of dynamics
You can position individual dynamics before or after the beat. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics whose position relative to the beat you want to change. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate Beat-relative position in the Dynamics group.

3. Choose one of the following options:

● Before

● After

RESULT
The beat-relative position of the selected dynamics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Dynamics
Positions of dynamics 
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EXAMPLE

A dynamic positioned before the beat A dynamic positioned after the beat

RELATED LINKS
Erasing the background of dynamics on page 930
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the alignment of dynamics relative to noteheads
Immediate dynamics, such as  and , are usually horizontally aligned with the optical 
center of noteheads. However, you can change the horizontal alignment of immediate dynamics 
individually. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics whose alignment relative to noteheads you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Text alignment in the Dynamics group.

3. Choose one of the following options:

● Align optical center with notehead 

● Left-align with notehead 

● Align optical center with left of notehead 

RESULT
The alignment of the selected immediate dynamics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Aligning dynamics
You can graphically align individually selected dynamics in a row without grouping/ungrouping 
them; for example, if system breaks in part layouts are different to the full score layout and so 

Dynamics
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require parts of different groups of dynamics to be aligned. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the dynamics you want to align.

2. Choose Edit > Notations > Dynamics > Align Dynamics. You can also choose this option 
from the context menu.

RESULT
The selected dynamics are aligned in a row with the dynamic within the selection that was 
furthest from the staff. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

RELATED LINKS
Groups of dynamics on page 949
Engrave toolbox on page 503
Resetting the position of items on page 436

General placement conventions for hairpins relative to barlines
In Dorico Elements, the ends of hairpins align with the left edge of the note to their right. This 
can include hairpins extending across barlines.

Hairpins that end on the first note of a bar extend across the preceding barline in the following 
cases:

● If there is no immediate dynamic on the first note in the next bar.

● If there is a time signature or key signature change at the barline that increases the gap 
between the end of the current bar and the first note in the new bar.

Dorico Elements avoids hairpins overlapping barlines by a small amount, as this is less visually 
clear. However, this means that the same dynamic phrase on different staves can appear 
differently if one of the staves does not have a barline join extending below it.

The hairpin ends are not aligned because the barline does not extend beyond the bottom staff

Dynamics
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You can allow/disallow hairpins across barlines if the hairpin ends on the first note in the next 
bar. Disallowing hairpins across barlines ensures hairpins appear the same length on all staves.

Allowing/Disallowing hairpins across barlines
You can allow/disallow hairpins across barlines when they end on the first note in the next bar; 
for example, so all hairpins appear the same length across multiple staves that do not all have 
barline joins. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the hairpins you want to allow/disallow across barlines. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Barline interaction in the Dynamics group.

3. Choose one of the following options:

● Stop before

● Continue

RESULT
The selected hairpins are allowed across barlines when you choose Continue, and disallowed 
when you choose Stop before. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing dynamic levels
You can change the levels of dynamics without reopening the dynamics popover and for multiple 
different dynamics simultaneously; for example, if you want to increase the dynamic level of all 
dynamics in a phrase.

PROCEDURE

1. In Write mode, select the dynamics whose dynamic level you want to change.

2. Change the dynamic level in one of the following ways:

● To increase the dynamic level, choose Edit > Notations > Dynamics > Increase 
Dynamic Intensity.

● To decrease the dynamic level, choose Edit > Notations > Dynamics > Decrease 
Dynamic Intensity.

Dynamics
Changing dynamic levels 
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TIP

You can also choose these options from the context menu.

RESULT
The dynamic level of the selected dynamics is increased/decreased. For example, increasing the 
dynamic level of a  dynamic changes it to .

TIP

You can assign key commands for these options on the Key Commands page in Preferences.

RELATED LINKS
Input methods for dynamics on page 309
Dynamics editor on page 694
Changing existing items on page 432
Dynamic modifiers on page 932
Key Commands page in the Preferences dialog on page 60

Hiding/Showing immediate dynamics
You can hide/show individual immediate dynamics such as  and ; for example, if you 
only want to show the dynamic modifier, such as “sim.”, without its accompanying immediate 
dynamic. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the immediate dynamics you want to hide, or the signposts of immediate dynamics 
you want to show. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hide intensity marking in the Dynamics group.

RESULT
The selected immediate dynamics are hidden when Hide intensity marking is activated, and 
shown when it is deactivated. If the property scope was set to Locally, this change only takes 
effect in the current layout and frame chain.

If no other dynamic exists at their rhythmic position, they are indicated by signposts. However, 
signposts are not printed by default.

RELATED LINKS
Dynamic modifiers on page 932
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Properties panel on page 663
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Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Signposts on page 450
Annotations on page 597
Input methods for dynamics on page 309

Hiding/Showing combined dynamic separators
You can hide/show different separators in combined dynamics individually. For example, if you 
want to separate some  dynamics with slashes. You can do this for the current layout and 
frame chain only, or for all layouts and frame chains.

By default, only combined dynamics with at least one mezzo dynamic in the pair, such as -, 
show a separator.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the combined dynamics whose separator you want to hide/show. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Separator shown in the Dynamics group.

3. Activate/Deactivate the corresponding checkbox.

4. Optional: If you showed separators, activate Separator and select one of the following 
options from the menu:

● Hyphen

● Colon

● Space

● Slash

RESULT
Separators are shown when the Separator shown checkbox is activated, and hidden when it is 
deactivated. The separator shown follows your selection for Separator. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Types of dynamics on page 921
Changing the appearance/position of subito modifiers on page 934
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Parenthesizing dynamics
You can show individual dynamics in parentheses; for example, to indicate editorial dynamics 
that were not in the original manuscript. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics you want to parenthesize. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Parenthesized in the Dynamics group.

RESULT
Parentheses are shown around each selected dynamic. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

Deactivating Parenthesized removes parentheses from the selected dynamics.

Changing the appearance of sforzando/rinforzando 
dynamics

You can change the appearance of individual  and  dynamics. For example, if you want some 
 dynamics to appear as . You can do this for the current layout and frame chain only, or for 
all layouts and frame chains.

NOTE

These steps do not apply to force/intensity of attack dynamics with other intensities, such as .

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the  and/or  dynamics whose appearance you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate rfz/sfz style in the Dynamics group.

3. Choose one of the following options:

●  
●  
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RESULT
The appearance of the selected  and/or  dynamics is changed. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Properties panel on page 663
Hiding/Showing zones on page 44
Types of dynamics on page 921
Abbreviating gradual dynamics on page 943
Changing the appearance/position of subito modifiers on page 934

Erasing the background of dynamics
You can erase the background of individual dynamics; for example, to ensure dynamics remain 
legible when crossing barlines. You can do this for the current layout and frame chain only, or for 
all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the dynamics whose backgrounds you want to erase.

2. In the Properties panel, activate Erase background in the Dynamics group.

RESULT
The backgrounds of the selected dynamics are erased. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

Deactivating Erase background returns the selected dynamics to the default non-erased 
background.

NOTE

This does not affect hairpins, including stems crossed by hairpins.

EXAMPLE

Dynamic with non-erased background Dynamic with erased background
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AFTER COMPLETING THIS TASK
You can change the padding between dynamics and each edge of their erased areas.

RELATED LINKS
Positions of dynamics on page 922
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Dynamic modifiers on page 932

Changing the erasure padding of dynamics
You can change the erasure padding of individual dynamics, including changing the padding 
between dynamics and each edge of their erased areas independently. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

Erasure padding considers the prefix/suffix separately from immediate dynamics and also takes 
into account ascenders/descenders in the text. This can cause the erasure padding to appear 
larger below the dynamic than above, such as for “espressivo” due to the “p”. In such cases, you 
can change the padding on the affected edge to make the padding appear symmetrical.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the dynamics whose erasure padding you want to change.

2. In the Properties panel, activate the Erasure padding properties, individually or together, in 
the Dynamics group.

● L changes the padding between dynamics and their left edge.

● R changes the padding between dynamics and their right edge.

● T changes the padding between dynamics and their top edge.

● B changes the padding between dynamics and their bottom edge.

3. Change the values in the value fields.

RESULT
Increasing the values increases the padding, decreasing the values decreases the padding. This 
also affects the area considered for collision avoidance. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

Voice-specific dynamics
Voice-specific dynamics only apply to a single voice on a staff, which allows you to specify 
different dynamics for each voice in multiple-voice contexts or for the separate staves of grand 
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staff instruments. By default, dynamics apply to all voices on all staves belonging to a single 
instrument, including grand staff instruments.

Inputting voice-specific dynamics allows you to show different dynamics for multiple voices on a 
staff, or to highlight an inner melody voice in a piano part. Voice-specific dynamics change the 
dynamics of each voice in playback independently.

NOTE

● You can only input voice-specific dynamics when the caret is active, such as during note 
input. Voice-specific dynamics apply to the voice indicated by the quarter note symbol beside 
the caret.

● Voice-specific dynamics only affect playback automatically for sounds that use velocity to 
control dynamics. When using playback devices that control dynamics in other ways, such as 
with CC, you must enable independent voice playback to hear different dynamics in different 
voices for the same instrument.

RELATED LINKS
Input methods for dynamics on page 309
Caret on page 218
Enabling independent voice playback on page 545
Dynamics editor on page 694
Extra staves on page 1323

Dynamic modifiers
Modifiers add further detail to dynamics than simply their volume level, and can help guide how 
a player performs a note or phrase. Modifiers include poco a poco, molto and subito. They are also 
known as “expressive text”.

Modifiers accompanying immediate and gradual dynamics

In Dorico Elements, modifiers must accompany either a dynamic level, such as  or , or a 
gradual dynamic.

You can input dynamic modifiers by entering them into the dynamics popover alongside an 
immediate dynamic or by clicking available options in the Dynamics panel. You can also add 
dynamic modifiers to existing dynamics.

You can add modifiers both before and after immediate dynamics. Modifiers can also appear 
either inside hairpins or above/below the start of hairpins.

TIP

You can hide immediate dynamics if you only want to show the modifier.

RELATED LINKS
Input methods for dynamics on page 309
Hiding/Showing immediate dynamics on page 927
Abbreviating dynamic modifiers on page 934
Adding poco a poco text to gradual dynamics on page 942
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Changing the appearance of sforzando/rinforzando dynamics on page 929
Showing consecutive hairpins as continuous on page 940
Exporting text on page 102

Adding modifiers to existing dynamics
You can add modifiers both before and after dynamics after they have been input; for example, if 
you want to add “sim.” instead of repeating dynamics across multiple phrases.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the dynamics to which you want to add modifiers. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Dynamics group:

● To add modifiers before dynamics, activate Prefix.

● To add modifiers after dynamics, activate Suffix.

3. Enter the text you want to add into the corresponding value field.

4. Press Return .

RESULT
The text you entered is added to the selected dynamics as a modifier. Text entered into the 
Prefix field appears before immediate dynamics, while text entered into the Suffix field appears 
after immediate dynamics.

Modifiers appear below hairpins placed below the staff and above hairpins placed above the 
staff, and are aligned with the start of the hairpin.

Deactivating the properties removes the corresponding modifiers from the selected dynamics.

NOTE

Deactivating properties permanently deletes any custom text entered.

AFTER COMPLETING THIS TASK
If you added modifiers to hairpins, you can show them centered inside the hairpins.

RELATED LINKS
Engrave toolbox on page 503
Niente markings on page 947
Input methods for dynamics on page 309
Showing modifiers centered inside hairpins on page 935
Adding poco a poco text to gradual dynamics on page 942
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Abbreviating dynamic modifiers
You can show individual subito/possibile dynamic modifiers with either abbreviated or full text, 
such as sub. or subito. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dynamics whose subito/possibile modifiers you want to abbreviate. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Dynamics group:

● Subito style

● Possibile style

3. Choose one of the following options:

● subito or possibile

● sub. or possib.

RESULT
The length of the corresponding dynamic modifiers is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Abbreviating gradual dynamics on page 943
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Properties panel on page 663
Changing the property scope on page 665

Changing the appearance/position of subito modifiers
You can change the appearance and/or position of individual subito modifiers. For example, if 
you want to show subito modifiers as sub. on the left of dynamics, or  sub. dynamics as . You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the dynamics whose subito modifier appearance and/or position you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Subito position and choose one of the following options:

● Left

● Right

3. Optional: If you selected dynamics that include at least one , activate Subito forte style and 
choose one of the following options:

● sub. 
● 

RESULT
The appearance and/or position of the selected subito modifiers is changed. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the appearance of sforzando/rinforzando dynamics on page 929
Abbreviating dynamic modifiers on page 934
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Showing modifiers centered inside hairpins
You can show modifiers you have added to hairpins, such as poco a poco or molto, centered both 
horizontally and vertically inside hairpins. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains. By default, modifiers appear at the start of and either 
above or below hairpins.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the hairpins whose modifiers you want to show centered inside hairpins. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Modifier position in the Dynamics group.

3. Choose one of the following options:

● Above or Below

● Inside

RESULT
Modifiers on the selected hairpins appear centered inside the hairpins. They automatically erase 
their background so the text does not collide with the hairpin lines. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.
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EXAMPLE

Modifier (molto) below a hairpin Modifier (molto) centered inside hairpin

RELATED LINKS
Adding modifiers to existing dynamics on page 933
Changing the erasure padding of dynamics on page 931
Showing consecutive hairpins as continuous on page 940
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Moving gradual dynamic modifiers graphically
You can move individual dynamic modifiers graphically, independently of the gradual dynamics 
to which they apply. For example, if you want specific modifiers to appear further from hairpins 
than other modifiers. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the gradual dynamics whose modifiers you want to move 
graphically.

2. In the Properties panel, activate Modifier offset in the Dynamics group.

3. Change the values in the value fields.

X moves modifiers horizontally, Y moves modifiers vertically.

RESULT
The selected gradual dynamic modifiers are moved graphically. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
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Gradual dynamics
Gradual dynamics indicate a change in volume that happens incrementally over the specified 
duration. They usually appear either as hairpins or as text instructions, such as cresc. or dim..

The change in volume indicated by individual hairpins is shown in the distance between the two 
diverging lines at their apertures.

Hairpins typically have a closed end and an open end. If the hairpin crosses a system or frame 
break, the closed end appears with a small gap so that the hairpin is not misread as two separate 
hairpins.

A pair of hairpins without an immediate dynamic in the middle is known as a messa di voce.

A phrase containing multiple gradual dynamics

In Dorico Elements, gradual dynamics appear as hairpins by default. You can change the 
appearance of individual gradual dynamics. For example, if you want to show a particularly long 
crescendo using cresc. text rather than a hairpin.

You can show gradual dynamic text in the following ways:

● cresc. or dim.: Abbreviated text with no continuation line

● cresc... or dim...: Abbreviated text with a dotted continuation line

● cre-scen-do or di-mi-nuen-do: The full word spread out across the duration of the gradual 
dynamic

In Write mode, ungrouped gradual dynamics each have start and end handles that show their 
duration.

NOTE

Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce hairpins 
share a single center handle.

RELATED LINKS
Input methods for dynamics on page 309
Types of dynamics on page 921
Messa di voce hairpins on page 945
Niente markings on page 947
Dynamic modifiers on page 932
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Groups of dynamics on page 949
Gradual dynamics in Engrave mode on page 938
Changing the appearance of gradual dynamics on page 939
Abbreviating gradual dynamics on page 943
Moving items graphically on page 514
General placement conventions for hairpins relative to barlines on page 925
Showing consecutive hairpins as continuous on page 940
Moving the center of messa di voce hairpins on page 945
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430

Gradual dynamics in Engrave mode
In Engrave mode, each hairpin has multiple handles that you can move to adjust their graphical 
position, length, angle, and aperture.

● The middle handles at the start/end of hairpins change their start/end offset positions. 
Moving one middle handle changes the angle of the hairpin.

● The pair of outer handles at the start/end of hairpins, and in the center of messa di voce 
hairpins, adjusts the corresponding aperture. These handles are linked and mirror each 
other: moving one handle also moves the other handle by the same amount, but in the 
opposite direction. This ensures that hairpins remain symmetrical.

A hairpin with the start middle handle selected in 
Engrave mode

A messa di voce hairpin with a center aperture handle 
selected in Engrave mode

NOTE

● You can also change the aperture of individual hairpins by activating Hairpin open aperture 
and/or Hairpin closed aperture in the Dynamics group of the Properties panel.

Increasing the value makes the corresponding aperture wider. Decreasing the value makes 
the corresponding aperture narrower.

● Pairs of separate hairpins are treated differently than messa di voce hairpins. For example, 
separate hairpins each have start and end handles in Write mode, whereas messa di voce 
hairpins share a single center handle.

You can move separate hairpins independently; for example, if you want to adjust the 
graphical peak of a pair of hairpins. You can move the graphical peak of messa di voce 
hairpins by moving their center.
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EXAMPLE

A diminuendo that goes across a system break: 
aperture at the start is open, aperture at the end 
is closed. It appears slightly open to indicate the 
diminuendo continues after the system break.

The diminuendo continues onto a new system: 
aperture at the start is open, aperture at the end is 
closed.

RELATED LINKS
Input methods for dynamics on page 309
Groups of dynamics on page 949
Niente markings on page 947
Messa di voce hairpins on page 945
Moving the center of messa di voce hairpins on page 945
Moving items graphically on page 514
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430
Note spacing on page 507
Adjusting note spacing at individual rhythmic positions on page 509

Changing the appearance of gradual dynamics
You can change the appearance of individual gradual dynamics; for example, to show a 
particularly long crescendo using “cresc.” text rather than a hairpin. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the gradual dynamics whose appearance you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Gradual style in the Dynamics group.

3. Select one of the following options from the menu:

● Hairpin

● cresc./dim.

● cresc...

● cre - scen - do

4. Optional: Customize the appearance of the selected gradual dynamics in one of the following 
ways, depending on their Gradual style:
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● If you selected Hairpin, activate Hairpin line style and choose one of the available 
options.

● If you selected cresc./dim., cresc..., or cre - scen - do, activate Diminuendo style and 
select one of the available options from the menu.

● If you selected cresc..., activate Continuation line style and choose one of the available 
options.

● If you selected cre - scen - do, activate Final syllable at end of line, then activate/
deactivate the corresponding checkbox.

RESULT
The appearance of the selected gradual dynamics is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Hairpin cresc./dim. cresc…. cre - scen - do

RELATED LINKS
Abbreviating gradual dynamics on page 943
Showing modifiers centered inside hairpins on page 935
Turning existing gradual dynamics into messa di voce hairpins on page 946
Adding niente markings to existing gradual dynamics on page 948

Showing consecutive hairpins as continuous
You can show two or more consecutive hairpins of the same direction that are separated by 
immediate dynamics as a single hairpin that continues through any immediate dynamics; for 
example, to indicate that you want a single smooth change in dynamic rather than multiple 
separate ones. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The hairpins are grouped together.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select at least one of the hairpins in each group that you want to show as 
continuous.

2. In the Properties panel, activate Hairpin shown as continuation in the Dynamics group.

3. Activate the corresponding checkbox.
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RESULT
Consecutive hairpins of the same direction in the selected groups appear as a single continuous 
hairpin. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

EXAMPLE

Hairpin not shown as continuation Hairpin shown as continuation

RELATED LINKS
Grouping dynamics together on page 950
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Hiding/Showing flared ends on hairpins
Flared ends are usually shown at the end of crescendo hairpins and indicate a sudden burst in 
volume at the end of the crescendo. You can hide/show flared ends on any hairpin.

NOTE

You can only show flared ends on hairpins with solid lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the hairpins on which you want to hide/show flared ends. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate/deactivate Flared end in the Dynamics group.

RESULT
A flared end is shown on the selected dynamics when Flared end is activated, and hidden when 
it is deactivated.
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EXAMPLE

Crescendo hairpin with flared end hidden Crescendo hairpin with flared end shown

Changing the size of flared ends on hairpins
You can change the height and width of flared ends on individual hairpins. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the flared hairpins whose flare size you want to change.

2. In the Properties panel, activate Flare size in the Dynamics group.

3. Change the flare size of the selected hairpins in any of the following ways:

● To change the width of the flared ends, change the value for W.

● To change the height of the flared ends, change the value for H.

RESULT
The size of the flared ends on the selected hairpins is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

● Increasing the W value makes the selected flared ends wider by starting their angle earlier in 
the hairpin, decreasing the value makes the selected flared ends narrower.

● Increasing the H value makes the selected flared ends taller, decreasing the value makes 
them shorter.

● Changing the values independently of each other changes the angle of the flared ends. For 
example, increasing the W value without changing the H value makes the angle shallower.

RELATED LINKS
Moving items graphically on page 514
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Adding poco a poco text to gradual dynamics
You can add poco a poco text to individual gradual dynamics after they have been input.

PREREQUISITE

● The lower zone is shown.
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the gradual dynamics to which you want to add poco a poco. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Poco a poco (little by little) in the Dynamics group.

RESULT
Poco a poco is shown immediately after gradual dynamic text, below hairpins placed below the 
staff, and above hairpins placed above the staff.

Deactivating Poco a poco (little by little) removes poco a poco text from the selected gradual 
dynamics.

EXAMPLE

Text gradual dynamic with poco a poco Hairpin gradual dynamic with poco a poco

AFTER COMPLETING THIS TASK
You can show poco a poco text centered inside hairpins.

RELATED LINKS
Dynamic modifiers on page 932
Showing modifiers centered inside hairpins on page 935
Abbreviating gradual dynamics on page 943
Engrave toolbox on page 503

Abbreviating gradual dynamics
You can show individual gradual dynamics with either abbreviated or full text, such as cresc. or 
crescendo. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the gradual dynamics that you want to abbreviate. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Abbreviate in the Dynamics group.
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3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected gradual dynamics appear with abbreviated text when the checkbox is activated, and 
full text when the checkbox is deactivated. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the appearance of gradual dynamics on page 939
Abbreviating dynamic modifiers on page 934
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Properties panel on page 663
Changing the property scope on page 665

Gradual dynamic spacing
Dorico Elements ensures that hairpins can always be clearly distinguished by giving hairpins a 
minimum default length. However, this can affect note spacing.

The default minimum hairpin length is three spaces. When hairpins are shorter than this, they 
can sometimes be confused with the accent articulation mark. Therefore, if you add a hairpin 
to a note which would make the hairpin less than three spaces long, the spacing of the note is 
changed to ensure the hairpin meets the minimum length.

RELATED LINKS
Gradual dynamics in Engrave mode on page 938
Moving the center of messa di voce hairpins on page 945

Gradual dynamics truncated by immediate dynamics
A hairpin is automatically truncated if an immediate dynamic is positioned within its range, either 
before or after the hairpin is input.

The hairpin remains tied to its originally designated rhythmic positions, even if graphically it 
appears shorter. This means that if the immediate dynamic that truncated it is ever deleted, the 
hairpin extends up to its end or the next immediate dynamic within its range.

The examples demonstrate a crescendo hairpin that is truncated by two dynamics, but the 
hairpin extends to its total length as they are deleted. The dotted attachment line shows the link 
between the hairpin and the rhythmic position to which its end is attached.

A long hairpin truncated by a  After deleting the , the hairpin is 
now truncated by the 

Deleting both immediate 
dynamics allows the hairpin to 
extend to its full length

RELATED LINKS
Showing consecutive hairpins as continuous on page 940
Lengthening/Shortening items on page 430
Hiding/Showing attachment lines on page 437
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Messa di voce hairpins
Messa di voce hairpins are single gradual dynamic items that appear as a pair of hairpins without 
an immediate dynamic in the middle. They indicate that within their duration, the volume either 
increases then decreases, or decreases then increases.

A phrase containing two messa di voce hairpins

In Write mode, messa di voce hairpins have three handles: one at the start, one at the end, and 
one in the center. This is different to separate, ungrouped hairpins, which each have a handle at 
the start and end.

You can move the graphical peak of messa di voce hairpins by moving their center. In Engrave 
mode, you can use messa di voce center handles to control their center aperture.

RELATED LINKS
Input methods for dynamics on page 309
Groups of dynamics on page 949
Gradual dynamics in Engrave mode on page 938
Note spacing on page 507

Moving the center of messa di voce hairpins
You can move the center of individual messa di voce hairpins rhythmically; for example, if you 
want them to peak on different notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the messa di voce hairpins whose center you want to move. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Messa di voce inflection in the Dynamics group.

3. Move the center of the selected messa di voce hairpins in any of the following ways:

● To move them to the right, increase the value in the left value field.

● To move them to the left, decrease the value in the left value field.

● To move them to the left to grace notes at the rhythmic position set by the left value 
field, decrease the value in the right value field.
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TIP

1 represents a quarter note.

RESULT
The centers of the selected messa di voce hairpins are moved rhythmically.

TIP

In Write mode, you can also click and drag messa di voce hairpin center handles to noteheads to 
the right/left.

EXAMPLE
For example, entering 1 1/2 into the left value field and -1/2 into the right value field moves 
messa di voce hairpin centers a dotted quarter note to the right of their start position, and to the 
first of two sixteenth grace notes at that rhythmic position.

RELATED LINKS
Hiding/Showing zones on page 44
Properties panel on page 663
Grace notes on page 1002
Showing grace notes before/after barlines on page 1005
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430

Turning existing gradual dynamics into messa di voce hairpins
You can turn existing gradual dynamics into messa di voce hairpins; for example, if you change 
your mind about the dynamic phrasing in some bars.

PROCEDURE

1. Select the gradual dynamics that you want to turn into messa di voce hairpins. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, choose Messa di voce for Type in the Dynamics group.

RESULT
The selected gradual dynamics are turned into messa di voce hairpins. The first direction follows 
the previous overall direction of the selected gradual dynamics.

TIP

You can also turn existing gradual dynamics into messa di voce hairpins by selecting them and 
clicking the corresponding buttons in the Gradual Dynamics section of the Dynamics panel.
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You can also press Shift-Alt/Opt-,  for a crescendo/diminuendo messa di voce hairpin, or Shift-
Alt/Opt-.  for a diminuendo/crescendo messa di voce hairpin.

RELATED LINKS
Hiding/Showing zones on page 44
Properties panel on page 663
Dynamics panel on page 312
Inputting dynamics with the popover on page 313
Inputting dynamics with the panel on page 315
Grace notes on page 1002

Niente markings
Niente markings at the start/end of gradual dynamics indicate that the dynamic either increases 
from, or decreases to, silence.

This effect works very well on strings and singers with vowels, but it cannot always be played 
literally. For example, singers with words beginning with consonants cannot begin from silence, 
nor can reed and brass instruments, as they have to achieve a certain air pressure before a note 
sounds.

Niente markings can be shown in the following ways, depending on the gradual dynamic style:

● For hairpins, niente markings can be shown as either a circle, or the letter “n”.

● For text gradual dynamics, niente markings appear as “dal niente” for crescendos, and as “al 
niente” for diminuendos.

You can input gradual dynamics with niente markings in the same ways as inputting other 
dynamics. You can also add niente markings to existing gradual dynamics.

EXAMPLE

Circle niente marking Letter niente marking Niente marking alongside a text 
gradual dynamic

RELATED LINKS
Input methods for dynamics on page 309
Changing the appearance of niente hairpins on page 948
Gradual dynamics in Engrave mode on page 938
Lengthening/Shortening items on page 430
Showing consecutive hairpins as continuous on page 940

Dynamics
Niente markings 

947
Dorico Elements 5.1.30



Adding niente markings to existing gradual dynamics
You can add niente markings to, and remove them from, existing gradual dynamics; for example, 
if you change your mind about which diminuendos should decrease to silence.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the gradual dynamics to which you want to add niente markings. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Niente in the Dynamics group.

RESULT
Niente markings are added to the selected gradual dynamics.

TIP

● Deactivating the property removes niente markings from the selected gradual dynamics.

● You can also add niente markings to, and remove them from, existing gradual dynamics by 
selecting them and clicking niente in the Gradual Dynamics section of the Dynamics panel.

AFTER COMPLETING THIS TASK
You can change the appearance of individual niente hairpins; for example, if you want to show 
some niente hairpins with a circle but others with text.

RELATED LINKS
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Properties panel on page 663
Dynamics panel on page 312

Changing the appearance of niente hairpins
You can show niente hairpins in two ways in Dorico Elements, and you can change how they 
appear individually. You can do this for the current layout and frame chain only, or for all layouts 
and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the hairpins whose niente style you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Niente style in the Dynamics group.
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3. Choose one of the following options:

● Circle on hairpin 

● Text 

RESULT
The niente style of the selected hairpins is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

EXAMPLE

A niente shown as Circle on hairpin A niente shown as Text

RELATED LINKS
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Properties panel on page 663
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Groups of dynamics
Groups of dynamics are automatically aligned in a row and can be moved and edited as a group. 
When you move immediate dynamics within a group, the length of the hairpins on either side 
automatically adjust to compensate.

A group of dynamics The same group of dynamics adjusts to compensate 
when the middle dynamic moves rhythmically.

A single dynamic, either immediate or gradual, is considered a group on its own.

Two or more dynamics are automatically grouped together if they immediately follow each 
other horizontally on the staff, were input together or in sequence, and have gradual dynamics 
between the immediate dynamics.

All of the dynamics in a group are highlighted when any of the dynamics in the group are 
selected.
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NOTE

● Groups of dynamics apply project-wide, meaning you cannot have dynamics grouped one 
way in some layouts but differently in other layouts. However, you can graphically align 
selected dynamics independently of their groups.

● As well as horizontal groups of dynamics, you can also link groups of dynamics vertically if 
you want the same dynamics to appear on multiple staves. This can be useful when multiple 
instruments play the same dynamics simultaneously and you want to make the same change 
in all staves; for example, moving the peak of a crescendo to a later beat, or changing a  to 
a .

RELATED LINKS
Linked dynamics on page 951
Aligning dynamics on page 924
Inputting dynamics with the popover on page 313

Grouping dynamics together
You can manually group dynamics together that were not automatically grouped when they were 
input. Grouped dynamics are automatically aligned in a row and can be moved and edited as a 
group.

PROCEDURE

1. In Write mode, select the dynamics you want to group together.

2. Choose Edit > Notations > Dynamics > Group Dynamics. You can also choose this option 
from the context menu.

RESULT
The selected dynamics are grouped together. If the first dynamic in the group is linked to other 
staves, all dynamics in the group are added to those staves. This applies to all layouts in which 
the dynamics appear.

RELATED LINKS
Linked dynamics on page 951

Ungrouping dynamics and removing dynamics from groups
You can ungroup dynamics so that all dynamics in the group become ungrouped. You can also 
remove only selected dynamics from groups while leaving other dynamics in the group.

This applies to all layouts in which the dynamics appear.

PROCEDURE

1. In Write mode, select the dynamics you want to ungroup or remove from groups.

2. Do one of the following:

● To ungroup all dynamics in the selected groups, choose Edit > Notations > Dynamics > 
Ungroup Dynamics.

● To remove only the selected dynamics from their groups, choose Edit > Notations > 
Dynamics > Remove from Group.
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TIP

You can also choose these options from the context menu.

Linked dynamics
Identical dynamics at the same rhythmic position on multiple staves can be linked together. This 
happens automatically when you copy and paste dynamics between staves.

If you select one dynamic in a linked group, all other dynamics in the linked group appear 
highlighted. If one linked dynamic is moved to a new rhythmic position, all linked dynamics 
move.

Two linked dynamics with only the top dynamic 
selected

Moving just the top dynamic of the linked group 
automatically moves the other to match its new 
position.

Similarly, if you change one linked dynamic, for example, from  to , all dynamics linked to the 
changed dynamic are also changed. If you group other dynamics to one of the linked dynamics, 
such as a hairpin, the hairpin is added at the same position in all linked staves.

If one staff has another immediate dynamic before the end of a hairpin, the hairpin is truncated 
automatically. If you delete such a dynamic, the hairpin extends automatically up to the next 
immediate dynamic or to its full length, whichever comes first.

Two staves with linked dynamics, but the lower staff 
has another immediate dynamic that truncates the 
hairpin.

Deleting the mf at the end of the first bar in the 
second staff causes the hairpin to extend to match 
the range of the top staff.

NOTE

● If you delete only some dynamics from a group that is linked to other staves, those dynamics 
are also deleted from the linked staves. If you delete a whole dynamic group from one staff, 
this does not affect linked dynamics on other staves.
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● As well as vertically linked dynamics, you can also group dynamics horizontally. This 
automatically aligns the dynamics in a row and allows them to be moved and edited as a 
group.

● Linking or unlinking dynamics applies project-wide, meaning you cannot have dynamics 
linked one way in some layouts but differently in other layouts.

RELATED LINKS
Groups of dynamics on page 949
Linked slurs on page 1297
Disabling automatic linking of dynamics and slurs when pasting on page 460

Linking dynamics together
When you copy and paste identical dynamics to the same rhythmic position on other staves, 
those dynamics are linked together automatically. You can also manually link dynamics and 
groups of dynamics together that are not automatically linked to allow simultaneous editing.

NOTE

Groups of dynamics must be the same in order to link them together. For example, you can link 
two  dynamics together if neither is part of a group, but you cannot link them together if one is 
grouped with a hairpin.

PROCEDURE

1. In Write mode, select the dynamics you want to link together.

2. Choose Edit > Notations > Dynamics > Link. You can also choose this option from the 
context menu.

RESULT
The selected dynamics are linked together. If you later change one of the linked dynamics, all 
linked dynamics are changed to match. This applies to all layouts in which the dynamics appear.

RELATED LINKS
Groups of dynamics on page 949
Copying and pasting notes/items on page 457

Unlinking dynamics
You can unlink dynamics, including dynamics that were linked automatically. For example, if you 
want to lengthen/shorten gradual dynamics independently of each other.

PROCEDURE

1. In Write mode, select a dynamic in each linked group that you want to unlink.

2. Choose Edit > Notations > Dynamics > Unlink. You can also choose this option from the 
context menu.

RESULT
All dynamics in the linked groups are unlinked. This applies to all layouts in which the dynamics 
appear.

Dynamics
Linked dynamics 

952
Dorico Elements 5.1.30



RELATED LINKS
Disabling automatic linking of dynamics and slurs when pasting on page 460

Dynamics font styles
There are different font styles for different types of dynamics. You can change different aspects 
of these fonts in the Edit Font Styles dialog, such as changing their font size to make dynamics 
appear larger.

The following font styles are used for dynamics:

1 Dynamic Music Text Font: Used for dynamic glyphs, such as  and . Must be SMuFL-
compliant.

2 Dynamic Text Font: Used for dynamic modifiers, such as poco a poco and molto, and gradual 
dynamics shown as text.

NOTE

Changes made to font styles apply to the entire project, including part layouts.

RELATED LINKS
Edit Font Styles dialog on page 754
Types of dynamics on page 921
Dynamic modifiers on page 932
Changing the default font family on page 760
Input methods for dynamics on page 309

Dynamics in playback
The volume settings for sustaining instruments and non-sustaining instruments vary in terms of 
their control of gradual dynamics.

Sustaining instruments
Sustaining instruments include string, wind, and brass instruments, because they can 
hold a note while being in control of its volume throughout.

Dorico Elements applies gradual dynamics to these instruments in playback.

Non-sustaining instruments
Non-sustaining instruments, such as piano, harp, marimba, and most percussion 
instruments, have no further control of the dynamic of notes after they have been 
struck. For this reason, non-sustaining software instruments often use note velocity for 
dynamics, because this is set at the start of the note.

TIP

You can control settings for each software instrument in the Expression Maps dialog.
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RELATED LINKS
Expression Maps dialog on page 762
Dynamics editor on page 694
MIDI CC editor on page 701

Playback Options for dynamics
You can change how the dynamics of all instruments project-wide are interpreted in playback on 
the Dynamics page in Playback Options.

Dynamic Curve

The graph at the top of the Dynamics page in Playback Options maps a continuous curve. This 
curve determines how the volume of dynamics increases across the default range  to 
.

A dynamic curve power of 1 creates a straight line, producing a steady dynamic increase. The 
difference between  and  is the same as between  and .

A dynamic curve power higher than 2 creates a curved line, producing a faster dynamic increase 
in the middle of the range. The difference between  and  is much smaller than the 
difference between  and .

The higher the dynamic curve power, the greater the contrast between dynamics in the middle of 
the range, and the smaller the contrast between dynamics at the ends of the range.

TIP

If your project uses a wide range of dynamics, including dynamics such as  and , you 
might want a lower curve power with larger differences between the extremes of the range.

If your project has a smaller range of dynamics, such as a minimum of  to a maximum of , 
you might prefer a higher curve power, so the differences between the dynamics in the middle of 
the range are more discernible. You might also prefer a smaller dynamic level range, such as -2 
to 2 for this example.

Humanize

Humanize allows dynamics to vary randomly, to mimic the natural fluctuations in a live 
performance.

For sound libraries that use MIDI CC 1 to control dynamics, you can see the effect humanization 
has on dynamics in the MIDI CC 1 editor.

Polyphonic Instruments

In the Polyphonic Instruments section, you can enable/disable polyphonic voice balancing 
and rules for contrapuntal music, which automatically adjust dynamic levels between voices 
belonging to the same instrument.

These options are most useful for instruments that can play multiple musical lines 
simultaneously, such as piano, harp, guitar, and pitched percussion.

Note Dynamics

In the Note Dynamics section of the Dynamics page, you can set how much the volume of notes 
in playback is affected by stresses and articulation marks.
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RELATED LINKS
Playback Options dialog on page 749
MIDI CC editor on page 701
Dynamics editor on page 694
Changing dynamic levels on page 926
Playback techniques on page 787
Expression maps on page 761

VST Expression Maps for volume types
If you are using a third-party sound library, you may need to change or edit the expression map 
to make instruments respond to gradual dynamics. Otherwise, the sound library uses velocity by 
default.

The setup of the expression map for dynamics depends on how the instrument is configured. 
Consult the documentation for the sound library for further information.

Dorico Elements provides the following default expression maps:

● CC11 Dynamics for dynamics produced by changing MIDI channel expression

● Modulation Wheel Dynamics for dynamics produced by changing MIDI controller 1

TIP

You can edit expression maps in the Expression Maps dialog.

Enabling/Disabling pitch contour emphasis
Pitch contour emphasis emulates the subtle dynamic changes produced by performers, allowing 
melodies to play back more expressively. You can enable/disable pitch contour emphasis project-
wide, and change how much it affects the dynamic level.

In general, performers increase dynamics when melodies rise in pitch, and decrease dynamics 
when melodies fall in pitch.

Pitch contour emphasis considers the pitch of notes, as well as their duration and position 
relative to other notes, on each staff independently to calculate changes to dynamic levels.

NOTE

● Pitch contour emphasis does not affect unpitched percussion instruments.

● In order to produce smooth transitions between phrases, pitch contour emphasis can reduce 
dynamic levels as well as increasing them.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Dynamics.

3. In the Humanize section, activate/deactivate Use pitch contour emphasis.

4. Optional: If you activated Use pitch contour emphasis, change its effect on the default 
dynamic level by changing the values for the following options:

● Scale effect by

● Maximum change to written dynamic
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NOTE

Scale effect by never exceeds the Maximum change to written dynamic value.

5. Click Apply, then Close.

RELATED LINKS
Dynamics editor on page 694
Velocity editor on page 691
Enabling independent voice playback on page 545

Enabling/Disabling polyphonic voice balancing
Dorico Elements can identify melodies and bass notes in polyphonic music, and emphasize them 
by different amounts relative to any remaining accompanying notes. You can enable/disable 
rules for contrapuntal music project-wide, and change how much they affect the dynamic level.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Dynamics.

3. In the Polyphonic Instruments section, activate/deactivate Use automatic polyphonic 
instrument voice balancing.

4. Optional: If you activated Use automatic polyphonic instrument voice balancing, change 
the values of the available options.

5. Click Apply, then Close.

RELATED LINKS
Enabling independent voice playback on page 545

Enabling/Disabling dynamic rules for contrapuntal music
In addition to polyphonic voice balancing, Dorico Elements can identify contrapuntal themes 
specifically, and emphasize them and bass notes by different amounts, relative to any remaining 
accompanying notes. You can enable/disable rules for contrapuntal music project-wide, and 
change how much they affect the dynamic level.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Dynamics.

3. In the Polyphonic Instruments section, activate/deactivate Use rules for contrapuntal 
music.

4. Optional: If you activated Use rules for contrapuntal music, change the values of the 
available options.

5. Click Apply, then Close.

RELATED LINKS
Enabling/Disabling polyphonic voice balancing on page 956
Enabling independent voice playback on page 545
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Figured bass

Figured bass is a shorthand that uses figures to specify the harmony above the notated bass 
notes. It is particularly common in Baroque and early Classical music and in the parts of 
accompanying instruments, such as harpsichords and viols.

Figured bass informs performers about the intended harmony but allows room for 
interpretation, such as improvised arpeggiated phrases using notes from the chord.

Figures use a combination of Arabic numbers, accidentals, and horizontal hold lines to specify 
both the intervals above the bass note that make up the chord and its duration. For example, 
they show where suspensions resolve or when the bass note changes but the chord remains the 
same.

Tasto solo indications inform performers that sections should be played without harmony.

A basso continuo part with figured bass below the staff

In Dorico Elements, figured bass exists globally at the corresponding rhythmic positions by 
default because most music that includes figured bass is tonal, meaning players perform notes 
from the same chord. Therefore, you only have to input figures once, but they can appear above 
multiple or no staves as required and the figures automatically update according to the notes 
on each staff. However, in some circumstances it is necessary to specify different chords for 
different players at the same rhythmic position. In such cases, you can input local figured bass.

Dorico Elements calculates and saves the pitches implied by the figures you enter in relation to 
the lowest note at that rhythmic position. This semantic understanding of the harmony implied 
by figures allows Dorico Elements to update the displayed figures on different staves and if you 
transpose or change the pitch of notes.

When you transpose music that includes figured bass, Dorico Elements also transposes the 
figures accordingly.

Figured bass in Dorico Elements uses a bold roman font by default. You can edit the formatting 
of figured bass font styles. You can also edit the Figured Bass Tasto Solo paragraph style, which 
is used for tasto solo indications.

You can hide or show figured bass in each layout independently and only above the staves of 
specific players. You can also change whether figured bass appears above or below staves by 
default in each layout independently. Figures appear as signposts if Dorico Elements either does 
not normally show them, such as third intervals, or cannot identify the bass note for them, such 
as on a rest.

NOTE

Figured bass does not yet include notations commonly used for harmonic analysis, such as 
Roman numerals. This is planned for future versions.
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RELATED LINKS
Inputting figured bass on page 395
Figured bass hold lines on page 961
Showing figured bass on rests on page 959
Showing single brackets on figured bass on page 960
Changing the staff-relative placement of figured bass on page 965
Appearance of figured bass on page 967

Hiding/Showing figured bass in layouts
You can hide/show figured bass in each layout independently and only above the staves of 
specific players. For example, you can show figured bass in the full score and bass part layouts 
but hide figured bass in the other part layouts.

Any player on whose staff you input figured bass is automatically set to show figured bass in the 
current layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show figured bass.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Figured Bass section, activate/deactivate each player above/below which you want to 
show figured bass.

5. Click Apply, then Close.

RESULT
Figured bass is shown above/below all instruments belonging to the corresponding players in 
the selected layouts when their checkboxes are activated, and hidden when their checkboxes are 
deactivated. Figured bass is hidden completely when no checkboxes are activated.

AFTER COMPLETING THIS TASK

● You can change the staff-relative placement of figured bass.

● You can hide figured bass figures individually in layouts where figured bass is shown.

RELATED LINKS
Inputting figured bass on page 395
Changing the staff-relative placement of figured bass on page 965
Figured bass hold lines on page 961

Hiding/Showing figured bass figures individually
You can hide/show individual figured bass figures in layouts in which figured bass is shown. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains. 
However, you cannot show individual figures in layouts where figured bass is hidden.

PREREQUISITE

● The lower zone is shown.
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the figured bass figures you want to hide, or the signposts of figures you want to 
show. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hidden in the Figured Bass group.

RESULT
The selected figured bass figures are hidden when Hidden is activated, and shown when it is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Signposts are shown at the position of each hidden figure. However, signposts are not printed by 
default.

TIP

● You can hide/show figured bass signposts by choosing View > Signposts > Figured Bass.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences.

RELATED LINKS
Signposts on page 450
Engrave toolbox on page 503
Changing the property scope on page 665
Key Commands page in the Preferences dialog on page 60
Annotations on page 597

Showing figured bass on rests
By default, figured bass is hidden on rests because figures typically indicate harmony in relation 
to a bass note. You can show figured bass on individual rests; for example, if the harmony 
changes while the bass is resting. You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

PREREQUISITE

● You have input figured bass at the positions of the rests.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the rests on which you want to show figured bass. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Show figured bass in the Notes and Rests group.
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RESULT
Figured bass is shown on the selected rests. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

Deactivating Show figured bass hides figured bass on selected rests again.

Showing single brackets on figured bass
You can show only a single left or right bracket on individual bracketed figured bass figures. For 
example, if you want to indicate that all figures between two bracketed figures are optional. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● You have input figured bass figures with brackets.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the bracketed figures on which you want to show a single bracket. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Hide single bracket in the Figured Bass group.

3. Choose one of the following options:

● Start

● End

RESULT
Brackets are hidden on the corresponding side of the selected figures, leaving a single bracket 
on the other side. If the property scope was set to Locally, this change only takes effect in the 
current layout and frame chain.

EXAMPLE

Brackets shown on both sides of all figures Brackets shown at the start of the first figure and the 
end of the last figure only

RELATED LINKS
Showing brackets on figured bass hold lines on page 963
Bracketed noteheads on page 1066
Hiding/Showing zones on page 44
Properties panel on page 663
Changing the property scope on page 665

Figured bass
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Figured bass hold lines
Figured bass hold lines indicate that chords remain the same over changing notes in the bass.

By default, Dorico Elements shows hold lines for figures that have duration, but hides 
lines between suspensions and resolutions or after resolutions. You can hide/show hold and 
suspension lines for individual suspension figures.

Figure (selected) with no duration Figure (selected) with duration and hold line

TIP

You can move figures graphically in Engrave mode, including changing the graphical length of 
hold lines.

RELATED LINKS
Figured bass in Engrave mode on page 965
Moving items graphically on page 514
Grace notes on page 1002

Hiding/Showing figured bass hold/suspension lines
You can hide/show suspension lines between suspension and resolution figures and hold lines 
after resolution figures, independently of each other.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the figured bass suspensions whose hold/suspension lines you want to hide/show. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Figured Bass group:

● Line between susp. and resolution

● Continue line after resolution

3. Activate/Deactivate the corresponding checkboxes.

RESULT
Hold lines are shown between suspension and resolution figures and/or after resolutions in 
the selected figured bass suspensions when the corresponding checkboxes are activated, and 
hidden when the checkboxes are deactivated.

Figured bass
Figured bass hold lines 

961
Dorico Elements 5.1.30



EXAMPLE

Suspension and hold lines both 
hidden

Suspension line between 
suspension and resolution shown

Suspension line between 
suspension and resolution and 
hold line after resolution both 
shown

RELATED LINKS
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Properties panel on page 663
Showing figured bass on rests on page 959
Moving figured bass resolutions on page 966

Lengthening/Shortening figured bass hold lines
You can change the duration of figured bass figures after they have been input, which changes 
the length of their hold lines. Lengthening a figure that was input without duration gives it 
duration and shows a hold line. You can also change the end positions of figured bass hold lines 
relative to notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the figured bass figures you want to lengthen/shorten. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Duration in the Figured Bass group.

3. Lengthen/Shorten the selected figured bass figures in any of the following ways:

● To lengthen them, increase the value in the left value field.

● To shorten them, decrease the value in the left value field.

● To move their end to the left to a grace note at the rhythmic position set by the left value 
field, decrease the value in the right value field.

TIP

1 represents a quarter note.

4. Do one of the following:

● To position the end of hold lines to the right of noteheads and across grace notes, 
activate Draw line through figures at end.

Figured bass
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● To position the ends of hold lines to the left of noteheads and before grace notes, 
deactivate Draw line through figures at end.

RESULT
The duration of the selected figured bass figures, and the length of their hold lines, is changed.

TIP

You can also lengthen/shorten figured bass figures in the same ways as for other items.

EXAMPLE
These examples all have an overall duration of a half note; that is, 2 entered into the left value 
field.

Draw line through figures at end 
deactivated

Draw line through figures at end 
activated

-1 1/4 entered into the right 
value field and Draw line through 
figures at end activated

RELATED LINKS
Figured bass in Engrave mode on page 965
Lengthening/Shortening items on page 430

Showing brackets on figured bass hold lines
You can show brackets on individual figured bass hold and suspension lines; for example, to 
indicate editorial hold lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the figured bass hold/suspension lines on which you want to show brackets. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together as 
appropriate for your selection, in the Figured Bass group:

● Bracket sus. lines

● Bracket hold lines

3. Select one of the following options from each menu:

● Both ends

● Start

Figured bass
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● End

RESULT
Brackets are shown at the corresponding ends of the selected figured bass hold/suspension 
lines.

EXAMPLE

Both ends brackets on hold lines Start bracket on suspension lines and End bracket 
on hold lines

RELATED LINKS
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Properties panel on page 663
Inputting figured bass on page 395

Positions of figured bass
Figured bass is automatically organized into rows according to the number of rows required in 
each system independently. By default, rows are aligned at the top when below the staff and at 
the bottom when above the staff to minimize the gap between figured bass and the staff.

The vertical position of figured bass is determined by the staves above which they are set to 
appear and your per-layout setting for their staff-relative placement.

You can move individual figured bass figures to different rhythmic positions in Write mode. They 
are automatically positioned to avoid collisions. This includes Dorico Elements’s kerning, which 
applies across whole systems to ensure all figures and alterations are legible.

You can move figures and hold lines graphically in Engrave mode, but this does not change the 
rhythmic positions to which they apply.

RELATED LINKS
Hiding/Showing figured bass in layouts on page 958
Hiding/Showing figured bass hold/suspension lines on page 961
Lengthening/Shortening figured bass hold lines on page 962
Moving figured bass resolutions on page 966
Moving notes/items rhythmically on page 461
Moving items graphically on page 514
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Figured bass in Engrave mode
In Engrave mode, each figured bass hold line has two square handles, one at the start and one at 
the end. You can move these handles to adjust the graphical position and length of figured bass 
hold lines.

You can also move whole figured bass hold lines graphically.

Handles on a hold line in Engrave mode

Moving figures with hold lines moves them both together. Moving hold lines or hold line handles 
moves the hold lines independently of the figure. Dorico Elements automatically lengthens hold 
lines between suspensions and resolutions when you move resolution figures.

NOTE

● A single figure includes all numbers at that position. For example, you cannot select and 
move the 6 in a 6,4 figure independently of the 4.

● If you want to move handles at the start/end of figured bass hold lines because you want 
to change their length, we recommend that you lengthen/shorten them rhythmically first 
before refining their graphical length.

● Multiple different properties in the Figured Bass group of the Properties panel are activated 
automatically when you move the corresponding figure, hold line, or hold line handle.

● Main figure offset moves figures. X moves them horizontally, Y moves them vertically.

● Resolution offset moves the resolution figure in suspensions. X moves them 
horizontally, Y moves them vertically.

● Line [n] offset moves the start and end handles of hold lines in the corresponding 
figured bass row horizontally. L moves start (left) handles, R moves end (right) handles.

● Line [n] Y offset moves whole hold lines in the corresponding figured bass row 
vertically.

Changing the staff-relative placement of figured bass
You can change the default staff-relative placement of all figured bass figures in each layout 
independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the staff-relative 
placement of figured bass.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Figured Bass section, choose one of the following options for Default placement:
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● Above staff

● Below staff

5. Click Apply, then Close.

RESULT
The default staff-relative placement of all figured bass figures in the selected layouts is changed.

TIP

You can also change the staff-relative placement of individual figured bass figures by selecting 
them and pressing F . If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

EXAMPLE

Figured bass below the staff Figured bass above the staff

RELATED LINKS
Changing the property scope on page 665

Moving figured bass resolutions
You can move resolution figures rhythmically, without affecting the position of the suspension 
figure or the overall duration of the figured bass suspension; for example, if you want a 
suspension to resolve on a different note.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the resolution figures you want to move. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Resolution pos. in the Figured Bass group.

3. Move the selected resolution figures in any of the following ways:

● To move them to the right, increase the value in the left value field.

● To move them to the left, decrease the value in the left value field.

● To move them to the left to grace notes at the rhythmic position set by the left value 
field, decrease the value in the right value field.

Figured bass
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TIP

1 represents a quarter note.

RESULT
The selected resolution figures are moved rhythmically.

TIP

In Write mode, you can also click and drag resolution figure handles to the right/left according to 
the current rhythmic grid resolution.

EXAMPLE
For example, entering 1 into the left value field and -1/2 into the right value field moves 
resolution figures a quarter note to the right of suspension figures, and to the first of two 
sixteenth grace notes at that rhythmic position.

RELATED LINKS
Figured bass hold lines on page 961
Figured bass in Engrave mode on page 965
Moving notes/items rhythmically on page 461
Changing the rhythmic grid resolution on page 217
Inputting figured bass on page 395

Appearance of figured bass
The appearance of individual figures is determined either by the default settings in Dorico 
Elements or your popover entry, depending on whether you instructed Dorico Elements to follow 
your entry literally when you input each figure.

When inputting figured bass, by default Dorico Elements interprets your entries and applies its 
default settings for the appearance of figured bass to them. You can specify that you want Dorico 
Elements to follow your entries exactly for individual figures; for example, if you are reproducing 
a piece of music and know in advance exactly how you want figures to appear.

You can reset individual figures that you input with the figured bass input setting Follow input 
literally so they follow the default settings, and you can fix the current appearance of individual 
figures.

Figured bass in Dorico Elements uses a bold roman font by default. You can edit the formatting 
of figured bass font styles. You can also edit the Figured Bass Tasto Solo paragraph style, which 
is used for tasto solo indications.

Figures appear as signposts if Dorico Elements either does not normally show them, such as 
third intervals, or cannot identify the bass note for them, such as on a rest.
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RELATED LINKS
Inputting figured bass on page 395
Figured bass hold lines on page 961
Showing figured bass on rests on page 959
Showing single brackets on figured bass on page 960

Editing the figured bass font styles
You can edit the formatting of the font styles used for all figured bass figures project-wide; for 
example, if you want them to appear larger by default.

NOTE

These steps do not apply to tasto solo indications, which use the Figured Bass Tasto Solo 
paragraph style.

PROCEDURE

1. Choose Library > Font Styles to open the Edit Font Styles dialog.

2. In the font styles list, select one of the following font styles:

● Figured Bass Font: Used for bold figured bass figures

● Figured Bass Text Font: Used for plain figured bass figures

3. Activate the following options, individually or together, to change the corresponding aspect 
of the font:

● Font family

● Size

● Style

● Underlined

NOTE

You must choose a SMuFL-compliant font family for the Figured Bass Font font style.

4. Optional: If you selected Figured Bass Font, activate Substitutes and change its substitute 
fonts as required.

5. Click OK to save your changes and close the dialog.

RESULT
The formatting of the selected figured bass font style is changed project-wide.

RELATED LINKS
Edit Font Styles dialog on page 754
Paragraph Styles dialog on page 756
Changing the default font family on page 760
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Simplifying figured bass compound intervals
You can simplify compound intervals in individual figured bass figures; that is, figures 9 and 
above. Some editions prefer to simplify compound intervals so figures reflect the first octave and 
appear out of order in the stack.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the compound figured bass figures you want to simplify. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Show compound intervals as simple in the Figured Bass 
group.

RESULT
The selected compound figures are simplified. Deactivating the property returns the selected 
figures to their default octave.

EXAMPLE

Figure with compound intervals Figure with simplified compound intervals

RELATED LINKS
Engrave toolbox on page 503
Properties panel on page 663

Fixing the current appearance of figured bass
You can fix the current appearance of individual figured bass figures; for example, if you 
input them with the input setting Follow Engraving Options but want to keep their current 
appearance, regardless of future changes you make to figured bass engraving options.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the figured bass figures whose current appearance you want to fix. You can do this in 
Write mode and Engrave mode.

2. Choose Edit > Notations > Figured Bass > Force Current Appearance.
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RESULT
The current appearance of the selected figures is fixed, meaning they are not affected by any 
future changes to figured bass engraving options.

NOTE

● You cannot access the Engraving Options dialog in Dorico Elements, as it is only available in 
Dorico Pro. However, fixing figures maintains their appearance if you share the project with 
other users who later change figured bass engraving options.

● You can assign a key command for Force Current Appearance on the Key Commands page 
in Preferences.

Resetting figured bass
You can reset individual figured bass figures; for example, if they were input with the figured 
bass input setting Follow input literally. Reset figures follow the default settings in Dorico 
Elements.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the figured bass figures you want to reset. You can do this in Write mode and Engrave 
mode.

2. Choose Edit > Notations > Figured Bass > Reset Figured Bass.

RESULT
The selected figured bass figures are reset to follow the default settings. This can affect their 
appearance and suspension duration.

TIP

You can assign a key command for Reset Figured Bass on the Key Commands page in 
Preferences.

RELATED LINKS
Engrave toolbox on page 503
Inputting figured bass on page 395
Key Commands page in the Preferences dialog on page 60
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Fingering

Fingerings use numbers and letters to recommend which fingers players should use for notes. 
This can be useful for music aimed at players learning the instrument and for difficult musical 
passages where certain fingering patterns make the notes much easier to play.

Fingerings are often used in keyboard music, as players can use all ten fingers to play notes, and 
in guitar music, where fingerings are often used alongside fret positions. However, fingerings 
can also be useful for other instruments; for example, to indicate that string players should 
change the finger used to stop the string while holding the note, or to instruct wind players to 
use uncommon fingerings for particular notes in order to create a special sonic effect.

Piano music containing multiple fingerings, including a substitution fingering and alternative fingerings

Dorico Elements also provides fingerings for brass and fretted instruments. For example, you can 
specify which valves players should depress for instruments such as trumpet and horn, and you 
can specify the horn branch you want players to use for double horns. For fretted instruments, 
you can input fingerings for both hands.

Fingerings in Dorico Elements use a bold roman font by default, following accepted conventions 
for the appearance of fingerings.

RELATED LINKS
Inputting fingerings on page 274
Fingerings popover on page 276
Fingerings for fretted instruments on page 981
Fingerings for valved brass instruments on page 989
Fingering slides on page 986
Fingering font styles on page 979
Hiding/Showing fingering on page 978
String indicators on page 993
Hiding/Showing fingerings in chord diagrams on page 900

General placement conventions for fingering
Fingerings are placed as close as possible to the notes to which they apply, so the performer can 
read them easily and clearly.

In music for grand staff instruments, such as the piano and harp, it is accepted to place 
fingerings for the right hand above the top staff, and fingerings for the left hand below the 
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bottom staff. However, in dense contrapuntal music for these instruments, fingerings can be 
placed between the staves to follow the direction of the voices to which they apply.

Different conventions apply to fingerings for fretted instruments, as they require fingerings for 
both the right and left hands.

Right-hand fingering placement

By default, all right-hand fingerings are placed outside the staff and on the notehead side of 
notes, which can be above or below the staff depending on the stem direction. When shown 
beside notes inside the staff, Dorico Elements automatically joins adjacent notes with the same 
right-hand fingering with a bracket.

Left-hand fingering placement

Left-hand fingerings are usually positioned inside the staff and to the left of the notes to 
which they apply. However, they also must not collide with other items, such as accidentals 
and rhythm dots. Dorico Elements automatically calculates the most appropriate positions for 
left-hand fingerings and erases their backgrounds by default, which improves their readability 
when placed on staff lines.

RELATED LINKS
Fingerings for fretted instruments on page 981

Changing fingerings to substitution fingerings
Substitution fingerings indicate where players should change the finger used for the note. You 
can change existing fingerings to substitution fingerings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the fingerings you want to change to substitution fingerings. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Substitution in the Fingering and Positions group.

3. Enter the fingering you want for the substitution into the value field.

4. Press Return .

RESULT
The selected fingerings are now shown as substitution fingerings. The deferred position of the 
substitution is the same as the original fingering by default, but you can change the rhythmic 
position of substitution fingerings.

RELATED LINKS
Engrave toolbox on page 503
Inputting fingerings on page 274
Fingerings popover on page 276
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Changing the rhythmic position of substitution fingerings
Substitution fingerings are shown as immediate by default, meaning that the substitution 
takes place on the same note, but you can change the rhythmic position at which individual 
substitutions take place.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the substitution fingering whose deferred rhythmic position you want to change. You 
can do this in Write mode and Engrave mode.

2. Change the rhythmic position of the substitution fingering in any of the following ways:

● In Write mode, click and drag the circular handle to the right/left.

● In Write mode and Engrave mode, activate Substitution offset in the Fingering and 
Positions group of the Properties panel.

Change the rhythmic position of substitutions as fractions of a quarter note (crotchet) by 
entering a value into the left value field, or by clicking the arrows beside the value field. 
Increasing the value moves substitutions to later positions, decreasing the value moves 
them to earlier positions.

NOTE

The right value field is for the grace note position at which substitutions occur, if 
applicable.

RESULT
The rhythmic position of the substitution fingering is changed.

Dorico Elements automatically arranges deferred substitutions so they are ordered appropriately 
alongside any fingerings that coincide with the substitution.

NOTE

You can only change the position of single substitution fingerings when dragging their handles 
with the mouse. However, you can change the positions of multiple substitution fingerings with 
Substitution offset in the Fingering and Positions group of the Properties panel.

Deferred substitutions are always shown with horizontal lines.

Changing existing fingerings
You can change fingerings after you have input them; for example, if you decide a different 
fingering would be better.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the fingerings you want to change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, enter the new fingering you want into the Finger or position value 
field in the Fingering and Positions group.

3. Press Return .

RESULT
The selected fingerings are changed.

TIP

You can also change existing fingerings in Write mode by opening the fingerings popover. Any 
existing fingerings on the selected note are shown in the popover.

RELATED LINKS
Inputting fingerings on page 274
Fingerings popover on page 276
Engrave toolbox on page 503

Changing the staff-relative placement of fingerings
Dorico Elements automatically follows conventions for fingering placement, but you can show 
individual fingerings belonging to non-fretted instruments either above or below the staff. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

According to convention, keyboard instrument fingering is positioned above the right-hand staff, 
and below the left-hand staff. String and brass instrument fingering is always positioned above 
the staff.

NOTE

These steps only apply to non-fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the fingerings whose staff-relative placement you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Staff-relative position in the Fingering and Positions 
group.

3. Choose one of the following options:

● Above

● Below
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RESULT
The selected fingerings appear above/below the staff. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

You can also change the staff-relative placement of fingerings by selecting them in Engrave 
mode and pressing F .

RELATED LINKS
Fingerings for fretted instruments on page 981
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Showing fingerings inside the staff
You can show individual fingerings belonging to non-fretted instruments beside noteheads 
inside the staff.

NOTE

● These steps only apply to non-fretted instruments. Left-hand fingerings for fretted 
instruments are shown inside the staff by default.

● These steps do not apply to substitution fingerings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Do one of the following:

● In Write mode, select the notes whose fingerings you want to show inside the staff.

● In Engrave mode, select the fingerings you want to show inside the staff.

2. In the Properties panel, activate Position left of notehead in the Fingering and Positions 
group.

RESULT
Fingerings belonging to the selected notes are shown inside the staff, directly beside the 
noteheads. By default, if they belong to a note on a staff line, they erase part of the staff line to 
ensure legibility.

EXAMPLE

Fingering
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Changing the position of individual fingerings relative to slurs, 
octave lines, and tuplet brackets

By default, fingerings are positioned inside the arcs of slurs, but outside the start/end of slurs. 
You can change the position of individual fingerings relative to slurs. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the fingerings whose position relative to slurs you want to change.

2. In the Properties panel, activate Slur-relative position in the Fingering and Positions 
group.

3. Choose one of the following options:

● Inside

● Outside

RESULT
The position of the selected fingerings relative to slurs, octave lines, and tuplet brackets is 
changed. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

NOTE

If fingerings also coincide with the first note or last note of slurs, fingerings are positioned 
outside all of these notations.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the size of fingerings
You can change the size of fingerings individually without changing the size of the noteheads to 
which they apply. You can do this for the current layout and frame chain only, or for all layouts 
and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Fingering
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PROCEDURE

1. In Engrave mode, select the fingerings whose size you want to change.

2. In the Properties panel, activate Scale in the Fingering and Positions group.

3. Change the value in the value field.

4. Press Return .

RESULT
The scale size of the selected fingerings is changed. For example, changing the value to 50 scales 
the selected fingerings to half their normal size. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

TIP

You can change the default size of all fingerings project-wide by changing the size of the 
Fingering Font in the Edit Font Styles dialog.

RELATED LINKS
Edit Font Styles dialog on page 754
Fingering font styles on page 979

Showing enclosures/underlines on fingerings
You can show individual fingerings belonging to non-fretted instruments with either a circle 
enclosure or an underline.

NOTE

These steps only apply to non-fretted instruments. For fretted instruments, you can instead show 
string indicators inside the staff, which are shown in a circle enclosure.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the fingerings on which you want to show an enclosure/underline.

2. In the Properties panel, activate Decoration in the Fingering and Positions group.

3. Choose one of the following options:

● Circle

● Underline

RESULT
The selected fingerings are shown with the chosen decoration.

Fingering
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EXAMPLE

Fingering with circle Fingering with underline

RELATED LINKS
Engrave toolbox on page 503
String indicators on page 993

Hiding/Showing fingering
You can hide/show fingering in each layout independently. For example, you can show fingering 
in part layouts but hide fingering in full score layouts as conductors rarely require fingering 
information.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show fingering.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Fingering section, activate/deactivate Show fingering.

5. Click Apply, then Close.

RESULT
All fingerings are shown in the selected layouts when the checkbox is activated, and hidden when 
the checkbox is deactivated.

RELATED LINKS
Changing the appearance of cautionary fingerings on page 981
Hiding/Showing fingerings in chord diagrams on page 900

Deleting fingerings
You can remove fingerings from notes after you have input them. However, because fingerings 
are properties of notes rather than separate items in Dorico Elements, you cannot select and 
delete them as you would for other items.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Fingering
Hiding/Showing fingering 
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PROCEDURE

1. Select the notes from which you want to remove fingerings. You can do this in Write mode 
and Engrave mode.

2. Choose Edit > Notations > Fingering > Reset Fingering.

RESULT
All fingerings are removed from the selected notes.

TIP

You can assign a key command for Reset Fingering on the Key Commands page in 
Preferences.

RELATED LINKS
Large selections on page 424
Assigning key commands on page 63
Engrave toolbox on page 503

Fingering font styles
There are different font styles for different types of fingerings. You can change different aspects 
of these fonts in the Edit Font Styles dialog, such as changing their font size to make fingerings 
appear larger.

The following font styles are used for fingering:

1 Fingering Font: Used for bold fingerings, including bold italic fingerings. Must be SMuFL-
compliant.

2 Fingering Text Font: Used for plain fingerings.

3 Fingering Text Italic Font: Used for italic fingerings.

4 Fingering Horn Branch Text Font: Used for note names in horn branch indicators.

5 Fingering Horn Branch Accidental Font: Used for accidentals in horn branch indicators. 
Must be SMuFL-compliant.

6 Fingering Horn Branch Alto Text Font: Used for the alto abbreviation in triple horn branch 
indicators.

NOTE

Changes made to font styles apply to the entire project, including part layouts.

RELATED LINKS
Edit Font Styles dialog on page 754
Changing the size of fingerings on page 976

Fingering
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String indicators on page 993
Changing the default font family on page 760

Showing individual fingerings in italics
Fingerings are normally shown in a bold, non-italic font, but you can show individual fingerings in 
italics.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the fingerings you want to show in italics.

2. In the Properties panel, activate Italic in the Fingering and Positions group.

RESULT
The selected fingerings are shown in a bold italic font if your project-wide setting for fingerings is 
a bold font, and in a plain italic font if your project-wide setting for fingerings is a plain font.

NOTE

Bold italic fingerings look very similar to tuplet numbers, which can be confusing.

Cautionary fingerings
Cautionary fingerings remind players that fingerings specified at previous rhythmic positions 
continue to apply to notes that are still sounding. Dorico Elements automatically shows 
cautionary fingerings when you add other fingerings at rhythmic positions where notes with 
existing fingerings are still sounding.

By default, cautionary fingerings are shown enclosed in parentheses. You can change the 
appearance of cautionary fingerings individually; for example, if you want to show cautionary 
fingerings manually on tied notes that cross system or frame breaks.

Cautionary fingering shown in parentheses (default)

RELATED LINKS
Inputting fingerings on page 274
Fingerings popover on page 276

Fingering
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Changing the appearance of cautionary fingerings
You can change the appearance of cautionary fingerings individually; for example, if you want 
particular fingerings to appear without parentheses or to hide specific cautionary fingerings. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

These steps only apply to cautionary fingerings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the noteheads whose cautionary fingering appearance you want to 
change.

NOTE

You must select the specific noteheads to which the cautionary fingerings apply, not the 
fingerings themselves.

2. In the Properties panel, activate Cautionary in the Fingering and Positions group.

3. Select one of the following options from the menu:

● Default

● With parentheses

● Without parentheses

● Suppress

RESULT
The appearance of cautionary fingerings on the selected notes is changed. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Hiding/Showing or parenthesizing cautionary accidentals on page 801

Fingerings for fretted instruments
Fretted instruments, such as the classical guitar, require additional fingering instructions for 
both hands due to the complex nature of the music.

Fingerings for fretted instruments use the same fonts as normal fingerings.

Fingering
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A passage for guitar with right-hand and left-hand fingerings

Right-hand fingering
Right-hand fingerings tell the performer which finger to use to pluck the string, which 
is usually the right hand. By default, all right-hand fingerings are placed outside the 
staff, on the notehead side of notes, and follow the stem directions of voices in 
multiple-voice contexts. When the same finger plays multiple notes in a chord, you 
can show a single fingering with a bracket for the notes plucked by that finger.

Dorico Elements shows “p” for right-hand thumb fingerings and “e” for right-hand 
fingerings for the pinky finger.

NOTE

In Dorico Elements, we use “pinky” to refer to the smallest finger, but it can also be 
called “little” or “fifth digit”.

Left-hand fingering
Left-hand fingerings tell the performer which finger to use to stop the string, which 
is usually the left hand. In Dorico Elements, left-hand fingerings are placed inside the 
staff and to the left of the notes to which they apply.

When shown inside the staff next to notes, left-hand fingering appears smaller than 
fingering shown outside the staff.

RELATED LINKS
Inputting fingerings on page 274
Fingerings popover on page 276
Fingering font styles on page 979
Adding fingerings to arpeggio signs on page 985
Fingering slides on page 986
String indicators on page 993
Tapping on page 1138
Hammer-ons and pull-offs on page 1139

Fingering
Fingerings for fretted instruments 

982
Dorico Elements 5.1.30



Hiding/Showing brackets for right-hand fingerings
When multiple notes in the same chord are plucked by the same right-hand finger, you can show 
the same fingering multiple times, once for each note, or show a single fingering for all notes 
with a bracket spanning the notes plucked by that finger. When showing a separate fingering for 
each note, you can also choose to place each fingering either above or below the staff. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

These steps only apply to right-hand fingerings belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select all the notes for which you want to hide/show brackets for right-hand fingerings. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Vertical position in the Plucked Fingering group.

3. Select one of the following options from the menu:

● To hide brackets and show a separate fingering for each selected note, select Above 
staff or Below staff.

● To show brackets and a single fingering for all notes in each bracket, select Next to 
note.

RESULT
Brackets on the selected right-hand fingerings are hidden/shown. If you selected Above staff or 
Below staff, their staff-relative placement is changed accordingly. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Right-hand fingerings shown next 
to notes with a bracket

Right-hand fingerings shown 
above the staff

Right-hand fingerings shown 
below the staff

RELATED LINKS
Engrave toolbox on page 503

Fingering
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Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the position of left-hand fingerings
You can change the position of individual left-hand fingerings. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains. By default, they are positioned 
inside the staff and to the left of the notes to which they apply.

NOTE

These steps only apply to left-hand fingerings belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the left-hand fingerings whose position you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Stopping finger position in the Fingering and Positions 
group.

3. Select one of the following options from the menu:

● Outside staff

● Left of note

● Right of note

RESULT
The position of the selected left-hand fingerings is changed. When shown outside the staff, they 
are placed above the staff by default. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

EXAMPLE

Outside staff Left of note Right of note

RELATED LINKS
General placement conventions for fingering on page 971
Inputting fingerings on page 274

Fingering
Fingerings for fretted instruments 
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Erasing the background of left-hand fingerings inside the staff
By default in Dorico Elements, left-hand fingerings have erased backgrounds because they are 
often placed in the staff on staff lines. You can change whether individual left-hand fingerings 
have erased backgrounds or not. You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

NOTE

These steps only apply to left-hand fingerings belonging to fretted instruments positioned inside 
the staff.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the left-hand fingerings whose background erasure you want to 
change.

2. In the Properties panel, activate Erase background in the Fingering and Positions group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The backgrounds of the selected left-hand fingerings are erased when the checkbox is activated, 
and not erased when the checkbox is deactivated. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

When the property is deactivated, left-hand fingerings have erased backgrounds by default.

EXAMPLE

Left-hand fingerings with erased backgrounds Left-hand fingerings without erased backgrounds

Adding fingerings to arpeggio signs
You can add fingerings to arpeggio signs to indicate which right-hand finger should be used to 
strum a chord. By default, fingerings are placed at the bottom of arpeggio signs.

NOTE

These steps only apply to arpeggio signs belonging to fretted instruments.

Fingering
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PREREQUISITE

● You have input the arpeggio signs to which you want to add fingerings.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the arpeggio signs belonging to fretted instruments to which you to add fingerings. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Finger in the Plucked Fingering group.

3. Enter the fingering you want into the value field.

For example, for the thumb, enter p.

RESULT
The specified fingering is added to the selected arpeggio signs. It is positioned at the bottom of 
the arpeggio signs by default.

EXAMPLE

Arpeggio signs played with the thumb

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340
Engrave toolbox on page 503

Fingering slides
Fingering slides indicate that the performer should slide their finger up/down the neck of the 
instrument. They are notated as an angled line between fingerings.

The note at the start of a fingering slide is known as a source note. The note at the end of a 
fingering slide is known as the destination note.

A passage with fingering slides

Fingering
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When the source and destination notes are sufficiently close horizontally, fingering slides are 
shown between the fingerings, joining them directly in their existing positions without moving 
them. When the source and destination notes are far apart horizontally, fingering slides appear 
with a fixed length to the left of the destination note. You can change the length of individual 
fingering slides.

Fingering slides automatically avoid obstructions, such as noteheads, accidentals, and other 
fingerings.

NOTE

● Dorico Elements automatically adjusts the length/angle of fingering slides when you move 
the fingerings at the start/end.

● In Dorico Elements, you can only show fingering slides on staves belonging to fretted 
instruments, and between notes up to three noteheads apart by default. You can show string 
fingering shift indicators on staves belonging to other string instruments.

RELATED LINKS
Hiding/Showing string fingering shift indicators on page 990
Glissando lines on page 1115
Jazz articulations on page 1145

Fingering slides in Engrave mode
In Engrave mode, each join fingering slide has two square handles, one at the start and one at 
the end. You can move these handles to adjust the graphical position, length, and angle of join 
fingering slides.

Handles on a slide joining two notes in Engrave mode

NOTE

● If you want to change the length of fingering slides, we recommend that you do so by 
first changing their Slide type property or by moving the fingerings. Dorico Elements 
automatically adjusts the length/angle of fingering slides when you move the fingerings 
at the start/end.

● You cannot move fingering slides rhythmically. If you want to change the notes to which 
fingering slides apply, you must hide them between their original notes and show new 
fingering slides between the new notes.

● Fingering slides shown only before the destination note have a fixed length, and so do not 
have handles at the start/end.

● You cannot move whole fingering slides that join notes. You can only move their handles.

Fingering
Fingering slides 
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Hiding/Showing fingering slides
You can hide/show slides between notes played by the same left-hand finger on the same string 
on fretted instruments.

NOTE

These steps only apply to fingerings belonging to fretted instruments, and on notes up to three 
noteheads apart by default.

PREREQUISITE

● You have input the same left-hand fingering for the notes at the start and end of the slides.

● You have specified the same string for the notes at the start and end of the slides.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the destination notes before which you want to hide/show fingering slides. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Slide in in the Fingering and Positions group.

RESULT
Fingering slides are shown before the selected notes when Slide in is activated, and hidden 
when it is deactivated.

● If the gap between the source and destination notes is small enough, fingering slides appear 
as an angled line joining the fingerings.

● If the gap is large, fingering slides appear as a fixed length angled line to the left of the 
destination notes.

TIP

If you want to adjust the placement or angle of the slide, you can move either the fingerings 
or the slide itself graphically in Engrave mode. Dorico Elements automatically adjusts the length/
angle of fingering slides when you move the fingerings at the start/end.

RELATED LINKS
Engrave toolbox on page 503
Inputting fingerings on page 274
Changing existing fingerings on page 973
Assigning notes to strings on page 1059
Moving items graphically on page 514

Changing the length of fingering slides
You can change the length of individual fingering slides and show them either joining the source 
and destination fingerings or with a fixed length before the destination note. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

Fingering
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NOTE

These steps only apply to fingerings belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the fingering slides whose length you want to change.

2. In the Properties panel, activate Slide type in the Fingering and Positions group.

3. Choose one of the following options:

● To show fingering slides between the fingerings at the start/end, choose Join.

● To show fixed length fingering slides before the destination fingerings, choose 
Destination only.

RESULT
The length of the selected fingering slides is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

EXAMPLE

Join Destination only

RELATED LINKS
Fingerings for fretted instruments on page 981
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Fingerings for valved brass instruments
For instruments like trumpet and horn, fingering is used to show which valves must be 
depressed to produce a specific note.

You can enter fingerings for valved brass instruments into the fingerings popover as numbers 
without any separation. For example, enter 12 for a C♯ on a trumpet to indicate that the first two 
valves must be depressed.

Fingering
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By default, Dorico Elements automatically stacks fingerings added to notes on brass instrument 
staves vertically. They are shown with no separator by default.

RELATED LINKS
Fingering font styles on page 979
Inputting fingerings on page 274
Fingerings popover on page 276

Showing horn branch indicators
You can indicate the branch on which notes are played for double horns and triple horns by 
adding branch indicators as prefixes to horn fingerings. Some publications simply indicate “T” for 
thumb, while others more explicitly indicate which branch is to be used by specifying its pitch.

NOTE

You can only add branch indicators to notes belonging to horns in F.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the horn fingerings to which you want to add branch indicators. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Horn branch in the Fingering and Positions group.

3. Select one of the following horn branches from the menu:

● F

● B flat

● F alto

● E flat alto

● Thumb trigger

RESULT
Branch indicators are added to the selected fingerings.

Hiding/Showing string fingering shift indicators
You can hide/show shift indicators after individual fingerings belonging to string instruments. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

Shift indicators are angled lines that indicate the direction of movement when string players 
must shift their finger position on the fingerboard to play a higher/lower note with the same 
finger as the previous note.

Fingering
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NOTE

These steps do not apply to fingerings belonging to fretted instruments, which can show 
fingering slides instead.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes or fingerings on string instrument staves from which you want to indicate a 
fingering shift. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Indicate shift to next note in the Fingering and 
Positions group.

RESULT
Shift indicators are shown when the property is activated, even if neither of the notes at each 
end have explicit fingerings, and hidden when the property is deactivated. They are positioned 
between the selected notes and the notes that immediately follow them. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can specify that fingerings should show shift indicators when inputting fingerings for string 
instruments.

EXAMPLE

RELATED LINKS
Inputting fingerings on page 274
Fingering slides on page 986
Assigning notes to strings on page 1059
Engrave toolbox on page 503
Changing the property scope on page 665

Changing the direction of string fingering shift indicators
You can change the direction of individual string fingering shift indicators if they do not point in 
the direction required.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Fingering
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● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the shift indicators whose direction you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Shift direction in the Fingering and Positions group.

3. Choose one of the following options:

● Up

● Down

RESULT
The selected shift indicators are angled up/down.

NOTE

You can also affect the direction of string shift indicators by specifying the strings on which notes 
are played.

Fingerings imported from MusicXML files
Dorico Elements imports fingerings that are specified using the fingering element in MusicXML 
files.

MusicXML files exported from Finale typically represent fingerings in the correct way. However, 
because Sibelius does not use the fingering element, Dorico Elements cannot import fingerings 
from MusicXML files exported by Sibelius.

Fingering
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String indicators

String indicators are commonly used in guitar music to tell performers the string on which they 
should play a note, particularly for pitches that are possible on multiple strings.

String indicators show the string number inside a circle enclosure, optionally with a dashed line 
to indicate they apply to a range of notes. Open pitches commonly appear as a zero without an 
enclosure.

In Dorico Elements, string indicators for stopped pitches appear in a plain font while string 
indicators for open strings use the fingering font.

A phrase with string indicators and left-hand fingerings

There are two types of string indicators in Dorico Elements, which you input in different ways.

String indicators outside the staff
String indicators outside the staff always appear inside circle enclosures. They 
automatically show dashed duration lines when they have duration to indicate that 
multiple notes are played on that string.

In Dorico Elements, string indicators outside the staff are considered playing 
techniques. You can select and delete them independently of the notes to which they 
apply. You can also change the duration line style of string indicators outside the staff 
in the same ways as for playing technique continuation lines.

String indicator outside the staff with duration line

String indicators inside the staff
String indicators inside the staff appear inside circle enclosures, except when they 
show open strings, which appear as a bold number zero without an enclosure. They 
automatically erase their backgrounds so they do not collide with staff lines. They 
appear to the left of noteheads by default but automatically appear to the right if 
left-hand fingerings are present.

The string number shown in string indicators inside the staff is calculated 
automatically, but you can also specify the string manually.

String indicators inside the staff for stopped pitches are scaled-down versions of string 
indicators outside the staff.
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In Dorico Elements, string indicators inside the staff are considered properties of the 
corresponding notes. You can only select them independently of their corresponding 
notes in Engrave mode.

NOTE

You can only show string indicators inside the staff on notes belonging to fretted 
instruments.

String indicators inside the staff, with the last one for an open string

RELATED LINKS
Fingerings for fretted instruments on page 981
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367
Playing techniques on page 1180
Playing technique duration on page 1187
Playing technique continuation lines on page 1186
Lengthening/Shortening items on page 430
Fingering font styles on page 979
Assigning notes to strings on page 1059

Deleting string indicators
You can remove string indicators inside the staff from notes after you have input them. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains. However, 
because string indicators inside the staff are properties of notes rather than separate items, you 
cannot select and delete them as you would for other items.

NOTE

These steps only apply to string indicators inside the staff. You can delete string indicators 
outside the staff in the same ways as for other items.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes from which you want to remove string indicators inside the staff. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, deactivate Show in the String Indicators group.

String indicators
Deleting string indicators 
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RESULT
String indicators inside the staff are removed from the selected notes. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Deleting notes/items on page 455
Inputting string indicators inside the staff on page 383
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Positions of string indicators
String indicators outside the staff are placed above it by default. In multiple-voice contexts, 
string indicators for the up-stem voices are placed above the staff and string indicators for the 
down-stem voices are placed below the staff.

String indicators inside the staff automatically erase their backgrounds so they do not collide 
with staff lines. They appear to the left of noteheads by default but automatically appear to the 
right if left-hand fingerings are present. You can change the notehead-relative position of string 
indicators individually.

You can move string indicators outside the staff to different rhythmic positions in Write mode. 
They are automatically positioned to avoid collisions. You can also change the staff-relative 
placement of string indicators outside the staff individually, in the same ways as for playing 
techniques.

You can move string indicators graphically in Engrave mode, but this does not change the 
rhythmic positions to which they are attached.

RELATED LINKS
Playing technique continuation lines on page 1186
Lengthening/Shortening items on page 430
Moving notes/items rhythmically on page 461
Moving items graphically on page 514
Changing the staff-relative placement of items on page 434

Changing the notehead-relative position of string indicators
By default, string indicators inside the staff appear to the left of noteheads when there are no 
left-hand fingerings and to the right of noteheads when there are left-hand fingerings. You can 
change the side of noteheads on which string indicators inside the staff appear individually. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the string indicators inside the staff whose notehead-relative position you want to 
change. You can do this in Write mode and Engrave mode.

String indicators
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2. In the Properties panel, activate Notehead-relative pos. in the String Indicators group.

3. Choose one of the following options:

● Left

● Right

RESULT
The notehead-relative position of the selected string indicators is changed. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

String indicators to the left of noteheads String indicators to the right of noteheads

String indicators
Positions of string indicators 
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Front matter

Front matter in Dorico Elements is a broad term that covers all information included before the 
first bar of music in scores.

Front matter includes musical information often added on pages before the first pages of scores, 
such as a title page, instrumentation list, program note, and performance instructions.

Front matter also includes information above the music on the first page of scores and parts, 
such as the dedication, title, subtitle, composer, and lyricist.

TIP

An efficient way of keeping information consistent across all layouts is to use tokens that refer 
to fields in the Project Info dialog. The default page templates display different information 
according to their type.

You can use paragraph styles to keep the formatting and appearance of text consistent 
throughout your project; for example, if you want your title to use a specific font style wherever it 
appears.

RELATED LINKS
Project Info dialog on page 75
Flow names and flow titles on page 187
Tokens on page 655
Page templates on page 647
Page template sets on page 647
Types of page templates on page 648
Paragraph Styles dialog on page 756
Frames on page 654
Page formatting on page 598
Hiding/Showing flow headings on page 611
Editing layout transposition text on page 1000

Adding titles
You can enter a title for the project and for each flow, independently of each other. For example, 
you might add the title “Sechs Lieder” for the project, then “Schwanenlied” for the first flow, 
“Wanderlied” for the second flow, and so on.

Dorico Elements displays titles on pages automatically using tokens on page templates.

In projects that only contain a single flow, you can enter information for either the project or 
flow. However, you must then ensure that you use the appropriate tokens.

PROCEDURE

1. Press Ctrl/Cmd-I  to open the Project Info dialog.

2. In the list on the left, select Project.

3. On the right, enter the title for the whole project in the Title field.

4. In the list on the left, select a flow for which you want to add a title.

997
Dorico Elements 5.1.30



5. In the action bar at the bottom of the list, click Rename Flow .

6. Enter the title into the flow name field.

7. Press Return .

8. At the bottom right of the dialog, click Apply.

TIP

● This updates the flow title in the Title field to match the flow name. Flow names and flow 
titles can be different and are used in different places. Titles can be referenced using 
tokens, whereas flow names are used when exporting audio, for example.

● You can also enter flow titles directly into their Title fields; however, this removes the 
link between flow titles and flow names.

9. Optional: Repeat steps 4 to 8 for other flows in the project.

TIP

You can copy project information that you have already entered by selecting the source from 
the Copy info from menu at the bottom of the dialog, then clicking Copy.

10. Click Close.

RESULT
Titles for the project and each flow are updated. They automatically appear on pages that use the 
corresponding tokens, such as the first page and in flow headings.

By default, project titles on first pages use the Title paragraph style and flow headings use the 
Flow Title paragraph style for text formatting and alignment.

RELATED LINKS
Project Info dialog on page 75
Types of page templates on page 648
Flow names and flow titles on page 187
Flow headings on page 651
Tokens on page 655
Paragraph Styles dialog on page 756

Adding composers
You can enter a composer name for the project and for each flow, independently of each other; 
for example, when compiling songbooks with different composers.

In projects that only contain a single flow, you can enter information for either the project or 
flow. However, you must then ensure that you use the appropriate tokens.

Dorico Elements displays the project composer on first pages automatically, using a token on the 
First page template.

PROCEDURE

1. Press Ctrl/Cmd-I  to open the Project Info dialog.

2. In the list on the left, select Project.

3. On the right, enter the composer for the whole project in the Composer field.

4. Optional: Repeat steps 2 to 3 for each flow in the project.

Front matter
Adding composers 
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TIP

You can copy project information that you have already entered by selecting the source from 
the Copy info from menu at the bottom of the dialog, then clicking Copy.

5. Click Apply, then Close.

RESULT
Composer names for the project and each flow are updated. They automatically appear on pages 
that use the corresponding tokens, such as the first page.

By default, composer names on first pages use the Composer paragraph style for text 
formatting and alignment.

Adding lyricists
You can enter a lyricist for the project and for each flow, independently of each other; for 
example, when compiling songbooks with different lyricists.

In projects that only contain a single flow, you can enter information for either the project or 
flow. However, you must then ensure that you use the appropriate tokens.

Dorico Elements displays the project lyricist on first pages automatically, using a token on the 
First page template.

PROCEDURE

1. Press Ctrl/Cmd-I  to open the Project Info dialog.

2. In the list on the left, select Project.

3. On the right, enter the lyricist for the whole project in the Composer field.

4. Optional: Repeat steps 2 to 3 for each flow in the project.

TIP

You can copy project information that you have already entered by selecting the source from 
the Copy info from menu at the bottom of the dialog, then clicking Copy.

5. Click Apply, then Close.

RESULT
Lyricist names for the project and each flow are updated. They automatically appear on pages 
that use the corresponding tokens, such as the first page.

By default, lyricist names on first pages use the Lyricist paragraph style for text formatting and 
alignment.

Adding copyright information
You can enter copyright information for the project and for each flow, independently of each 
other; for example, when compiling books of songs composed at different times.

In projects that only contain a single flow, you can enter information for either the project or 
flow. However, you must then ensure that you use the appropriate tokens.

Front matter
Adding lyricists 

999
Dorico Elements 5.1.30



Dorico Elements displays the project copyright on first pages automatically, using a token on the 
First page template.

PROCEDURE

1. Press Ctrl/Cmd-I  to open the Project Info dialog.

2. In the list on the left, select Project.

3. On the right, enter copyright information for the whole project in the Composer field.

4. Optional: Repeat steps 2 to 3 for each flow in the project.

TIP

You can copy project information that you have already entered by selecting the source from 
the Copy info from menu at the bottom of the dialog, then clicking Copy.

5. Click Apply, then Close.

RESULT
Copyright information for the project and each flow is updated. It automatically appears on 
pages that use the corresponding tokens, such as the first page.

By default, copyright information on first pages uses the Copyright paragraph style for text 
formatting and alignment.

RELATED LINKS
Project Info dialog on page 75
Types of page templates on page 648
Tokens on page 655
Paragraph Styles dialog on page 756

Editing layout transposition text
You can override layout transposition token text in each layout independently; for example, if you 
want some layouts to display “Concert Pitch” but others to display “Full Score in C”.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose layout transposition text you want to edit.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Text Tokens section, activate the following options, individually or together:

● Custom text for concert layout

● Custom text for transposed layout

5. Enter the text you want into the corresponding value fields.

6. Click Apply, then Close.

Front matter
Editing layout transposition text 
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RELATED LINKS
Tokens on page 655
Layouts on page 174
Concert vs. transposed pitch on page 178
Making layouts transposed/concert pitch on page 178

Hiding/Showing borders on layout names
You can hide/show borders on all layout names project-wide. By default, layout names appear 
with borders at the top of pages in part layouts that use the First page template.

PROCEDURE

1. Choose Library > Paragraph Styles to open the Paragraph Styles dialog.

2. In the paragraph styles list, select Layout name.

3. Activate/Deactivate the checkbox for Border.

4. Optional: If you activated the checkbox, activate and change the available border options as 
required.

For example, you can change the border style and border thickness.

5. Click OK to save your changes and close the dialog.

RELATED LINKS
Paragraph Styles dialog on page 756
Player, layout, and instrument names on page 181
Renaming layouts on page 183
Tokens on page 655
Types of page templates on page 648
Adding borders to text items on page 1358
Changing the style of text item borders on page 1359

Front matter
Hiding/Showing borders on layout names 
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Grace notes

Grace notes are notes without a fixed duration, which are intended to be played quickly. They 
are scaled-down versions of normal notes, and are commonly shown with a slash through their 
stem.

Grace notes with slashed stems are known as “acciaccaturas” and are often played very fast. 
Grace notes without slashed stems are known as “appoggiaturas” and are often played slower 
than acciaccaturas. In Baroque music, appoggiaturas are often understood to last for a specific 
duration, based on the prevailing meter and the rhythmic value of the notehead to which they 
are attached. Therefore in Dorico Elements, slashed and unslashed grace notes are handled 
differently in playback.

Grace notes do not take up space rhythmically, as they are intended to be fitted into the space 
before the note to which they are attached, which is the note immediately to their right.

There can be multiple grace notes before a notehead. If there are two or more grace notes 
attached to the same notehead, and they have a rhythmic value that shows a flag on the stem, 
such as eighth notes (quavers) and 16th notes (semiquavers), they are automatically beamed 
together.

Multiple grace notes before notes

In Dorico Elements, grace notes are scaled to 3/5 the size of a normal notehead by default and 
are affected by your note spacing settings. There is a separate option specifically for grace note 
spacing.

You can add notations, such as slurs and articulations, to grace notes in the same ways as to 
normal notes, and you can transpose grace notes after they have been input.

RELATED LINKS
Inputting grace notes on page 249
Slur placement relative to grace notes on page 1285
Changing the pitch of individual notes on page 468
Inputting articulations on page 271
Inputting slurs on page 273
Note spacing on page 507

General placement conventions for grace notes
Grace notes function like normal notes in many ways, but there are some specific conventions 
about their stem direction, position relative to noteheads, and the placement of stem slashes.

Grace notes are always positioned before a notehead, even if they are intended to be played on 
the beat rather than before the beat. They are normally placed after a barline, so they can be 
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positioned directly before the notehead to which they are attached. You can show grace notes 
before barlines instead; for example, if you have a group of three or more grace notes and want 
to reduce the gap between the barline and the first beat in the bar.

Grace note stem slashes appear at the beginning of grace note beams. If there is a single grace 
note, the slash appears across its stem and flag, if applicable, and extends either side of the 
stem.

Adding accidentals causes their spacing to readjust so that the accidentals are clearly legible, 
similar to normal notes.

Articulations can be added to grace notes wherever they are most clearly legible, which is most 
likely outside the staff. Dorico Elements automatically places articulations on the stem-side of 
grace notes, and outside the staff if the stem or beam is within the staff.

Grace notes in multiple-voice contexts

According to accepted notation convention, grace notes appear stem up by default when there is 
only one voice on a staff, even if the notehead to which they are attached is stem down.

However, when there are multiple voices on the staff, all notes in the upper voices appear stem 
up and all notes in the lower voices appear stem down, including grace notes. This also affects 
the curvature direction of slurs.

This adjustment happens automatically in Dorico Elements, but you can also change the stem 
direction of grace notes manually.

Slurs relative to grace notes

By default, slurs starting on grace notes and ending on tie chains end on the first note of the 
tie chain. You can change the position of individual slurs relative to tie chains, including those 
starting from grace notes.

TIP

You can change the note spacing scale factor for grace notes in each layout independently on the 
Note Spacing page in Layout Options.

RELATED LINKS
Slur placement relative to grace notes on page 1285
Slur position relative to tie chains on page 1284
Changing the stem direction of notes on page 1076
Layout Options dialog on page 745

Grace notes
General placement conventions for grace notes 
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Turning existing notes into grace notes
You can turn any existing notes into grace notes; for example, if you want to edit music you input 
using MIDI recording.

PROCEDURE

1. In Write mode, select the notes that you want to turn into grace notes.

2. Optional: Change the grace note type to slashed/unslashed in any of the following ways:

● Press Alt/Opt-/ .

● In the Notes toolbox, click and hold Grace Notes , then click Unslashed Grace Notes 
 or Slashed Grace Notes .

3. Do one of the following:

● Press / .

● In the Notes toolbox, click Grace Notes .

RESULT
The selected notes are turned into grace notes with the same notated duration. However, any 
rhythm dots are removed.

By default, slashed grace notes attach to the rhythmic position following the last selected note in 
each range, while unslashed grace notes attach to the rhythmic position of the first selected note 
in each range.

TIP

You can change the default direction when turning existing notes into grace notes in 
Preferences > Note Input and Editing > Editing.

AFTER COMPLETING THIS TASK
You can change the duration of grace notes.

RELATED LINKS
Notes toolbox on page 196
Inputting grace notes on page 249
Changing the duration of notes on page 259
Changing the type of grace notes on page 1006
Turning existing notes into tuplets on page 1410
Preferences dialog on page 58

Turning grace notes into normal notes
You can turn any existing grace notes into normal notes starting from their original rhythmic 
position; for example, if you want to turn a run of grace notes at the start of a flow into standard 
notes in a pick-up bar.

PROCEDURE

1. In Write mode, select the grace notes you want to turn into normal notes.

2. Optional: If you want the selected grace notes to push subsequent notes to later rhythmic 
positions if required, press I  to activate Insert mode.

3. Optional: If you activated Insert mode, choose the appropriate Insert mode scope.

Grace notes
Turning existing notes into grace notes 
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4. Do one of the following:

● Press / .

● In the Notes toolbox, click Grace Notes .

RESULT
The selected grace notes are turned into normal notes with the same notated duration. For 
example, an eighth grace note becomes a standard eighth note.

If Insert mode was activated, subsequent existing notes are pushed to later rhythmic positions to 
accommodate the extra rhythmic durations if required. If Insert mode was deactivated, the grace 
notes expand and overwrite subsequent notes.

RELATED LINKS
Turning tuplets into normal notes on page 1410
Pick-up bars on page 1386
Insert mode on page 451

Showing grace notes before/after barlines
By default, grace notes are positioned after barlines and directly before the notehead to which 
they apply, including for the first note in a bar. You can position individual grace notes before 
barlines; for example, so the first normal note in the bar is not pushed too far from the barline, 
or to indicate that grace notes are played before the beat.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the grace notes whose position relative to barlines you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Grace note before barline in the Grace Notes 
group.

RESULT
Grace notes at the selected rhythmic positions are positioned before barlines when the property 
is activated, and after barlines when the property is deactivated.

NOTE

This affects all grace notes at the selected rhythmic positions.

RELATED LINKS
Engrave toolbox on page 503
Barlines on page 815

Grace notes
Showing grace notes before/after barlines 
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Grace note size
Grace notes are smaller versions of normal notes, and are scaled down by a ratio that is set by 
default to 3/5 of a normal note.

You can change the size of grace notes individually in the same way as for normal notes.

RELATED LINKS
Changing the size of notes/items on page 433
Inputting grace notes on page 249

Grace note slashes
Slashes shown diagonally across grace note stems are often used to distinguish different types 
of grace notes. Grace notes with slashed stems are known as acciaccaturas and are often played 
very fast. Grace notes without slashed stems are known as appoggiaturas and are often played 
slower than acciaccaturas.

In Dorico Elements, grace notes appear with slashed stems by default. You can change whether 
grace notes are slashed or unslashed during note input as well as by changing the type of 
existing grace notes.

Changing the type of grace notes
You can change the type of individual grace notes after they have been input. Grace notes have 
slashed stems by default, but you can change them to have unslashed stems.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the grace notes whose type you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, choose one of the following options for Grace note type in the 
Grace Notes group:

● Slashed stem 

● Unslashed stem 

RESULT
The selected grace notes are shown with slashed/unslashed stems.

TIP

You can also change the type of selected grace notes by pressing Alt/Opt-/  or clicking and 
holding Grace Notes  in the Notes toolbox, then clicking Unslashed Grace Notes  or 
Slashed Grace Notes .

Grace notes
Grace note size 
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Moving slashes on grace note stems
You can change the vertical position of individual grace note slashes. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the grace notes whose slash positions you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Grace Notes group:

● Slash inset from stem tip

● Slash offset to right

3. Change the values in the value fields.

RESULT
Increasing Slash inset from stem tip moves grace note slashes further from the tips of stems 
and closer to the noteheads. Decreasing the value moves them closer to the tips of stems and 
further from the noteheads.

Increasing Slash offset to right moves grace note slashes to the right, decreasing the value 
moves them to the left.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Inputting grace notes on page 249

Changing the length of grace note slashes
You can change the length of slashes on grace note stems individually. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the grace notes whose slash length you want to change.

Grace notes
Grace note slashes 
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2. In the Properties panel, activate the following properties, individually or together, in the 
Grace Notes group:

● Slash length

● Slash protrusion from beam (beamed grace notes only)

NOTE

Grace note slashes seem to disappear when you activate Slash length because activating 
the property resets the value to 0.

3. Change the length and/or protrusion of the selected slashes by changing the values in the 
corresponding value fields.

RESULT
Increasing Slash length lengthens grace note slashes on both single grace notes and grace note 
beams, decreasing the value shortens grace note slashes.

Increasing Slash protrusion from beam increases how far slashes extend beyond grace note 
beams, decreasing the value decreases how far slashes extend beyond grace note beams.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

Grace note stems
Grace notes are scaled-down notes, so the length of grace note stems is determined by the 
default settings for the stem length of all notes.

Following accepted conventions, grace notes in Dorico Elements are stem up by default in any 
clef, regardless of the stem direction of the note to which they apply. The stem directions of 
grace notes are changed automatically when there are multiple voices on a staff, but you can 
change the stem direction of individual grace notes manually. You can also lengthen/shorten 
grace note stems in the same ways as for normal stems.

RELATED LINKS
Stems on page 1074

Grace note beams
Dorico Elements automatically beams multiple adjacent grace notes together if they are an 
eighth note (quaver) or shorter in duration.

Like all beams, grace note beams ideally follow the accepted standards for beam placement 
relative to staff lines, in order to avoid wedges. However, because grace notes are smaller than 
normal notes, this can lead to extreme slants in grace note beams.

You can adjust the slants of individual grace note beams in the same ways as for normal beams.

RELATED LINKS
Beaming on page 840

Grace notes
Grace note stems 
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Grace notes in playback
Slashed and unslashed grace notes are handled differently in playback.

Slashed grace notes of any note duration, and unslashed grace notes a 16th note or shorter, play 
back before the beat with a single default sounding duration.

Unslashed grace notes an eighth note or longer play back on the beat. Their sounding duration 
is half the note duration of the note to which they are attached. For example, if an unslashed 
eighth note grace note is attached to a quarter note, both notes play back as if they were eighth 
notes.

You can change whether single unslashed grace notes play on or before the beat, the maximum 
note duration for unslashed grace notes to play back as short appoggiaturas, and the default 
sounding duration of grace notes in Playback Options > Timing > Grace Notes.

RELATED LINKS
Playback Options dialog on page 749
Grace note slashes on page 1006

Grace notes
Grace notes in playback 
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Holds and pauses

Different notations are used to show where the established rhythmic flow of the music is 
interrupted, either with a moment of repose or a short silence, before continuing. The most 
subtle effect is produced by a tenuto mark, with more significant effects denoted with holds and 
pauses.

The duration of the break in the music intended by the hold or pause does not need to be 
specified. This leaves significant room for interpretation, even though the different styles of 
holds and pauses normally indicate larger or smaller breaks.

In Dorico Elements, there are the following types of holds and pauses:

Fermatas
Fermatas indicate that a note is held for longer than its notated length, which 
applies to the whole ensemble. In Dorico Elements, fermatas exist globally at the 
corresponding rhythmic positions, meaning they are automatically shown on all staves 
and voices.

They are also known as “pauses” and informally sometimes called “birds’ eyes”.

Breath marks
Breath marks show suitable places for players to breathe, or suggest how the music is 
phrased to create a similar effect. Breath marks apply to single staves only.

Caesuras
Caesuras indicate that a note is sustained for its full value and is followed by a 
break in sound before continuing. In Dorico Elements, caesuras exist globally at the 
corresponding rhythmic positions, meaning they are automatically shown on all staves.
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RELATED LINKS
Input methods for holds and pauses on page 336
Types of fermatas on page 1011
Types of breath marks on page 1012
Types of caesuras on page 1012
Positions of holds and pauses on page 1012
Holds and pauses in playback on page 1016

Types of fermatas
There are different types of fermatas available in Dorico Elements. Each fermata indicates a 
suggested pause duration whilst leaving room for interpretation.

In Dorico Elements, the different types of fermatas affect playback according to their intended 
duration. For example, long fermatas produce longer held notes and gaps than short fermatas.

Fermata Description

Very short fermata Indicates that a note is held only a fraction 
longer than the rhythm indicates.

Short fermata Indicates that a note is held a little bit longer 
than the rhythm indicates.

Short fermata (Henze) Indicates that a note is held a little bit longer 
than the rhythm indicates, as used by Hans 
Werner Henze.

Fermata Indicates that a note is held for longer than the 
rhythm indicates.

Long fermata Indicates that a note is held quite a lot longer 
than the rhythm indicates.

Long fermata (Henze) Indicates that a note is held quite a lot longer 
than the rhythm indicates, as used by Hans 
Werner Henze.

Very long fermata Indicates that a note is held for much longer 
than the rhythm indicates.

Curlew (Britten) Indicates that a note or rest is held until the 
next synchronization point in asynchronous 
music, as used by Benjamin Britten.

Fermatas can be divided into two styles. Because their meanings overlap, it can be confusing for 
players if both styles are used in a single project.

Holds and pauses
Types of fermatas 
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Style Very short 
fermata

Short 
fermata

Fermata Long fermata Very long 
fermata

Standard

Henze N/A N/A

RELATED LINKS
Holds and pauses in playback on page 1016
Input methods for holds and pauses on page 336

Types of breath marks
There are different types of breath marks available in Dorico Elements. Breath marks indicate a 
suitable place for a player to take a breath, or create a musical effect like a breath.

Comma-like Tick-like Upbow-like Salzedo

Types of caesuras
There are different types of caesuras available in Dorico Elements. All caesuras indicate a break in 
sound, but different types are often needed for different styles of musical scores.

Caesura Thick caesura Short caesura Curved caesura Single-stroke 
caesura

Two diagonal 
slashes

Two thick diagonal 
slashes

Two straight, 
vertical slashes

Two curved 
diagonal slashes

One straight, 
vertical slash

If you intend to communicate a specific length of hold or gap with each type of caesura, we 
recommend that you consider adding a legend, as different players may interpret these symbols 
differently.

Positions of holds and pauses
Holds and pauses are placed above the staff by default in single-voice contexts, and are shown 
on all staves at the closest rhythmic position available; for example, if a single staff has a fermata 
on the last beat in the bar, it is shown above the bar rests on the other empty staves. For staves 
with multiple voices, fermatas are also shown inverted below the staff.

You can move holds and pauses to different rhythmic positions in Write mode. They are 
automatically positioned to avoid collisions.

You can move holds and pauses graphically in Engrave mode; however, this does not change the 
rhythmic positions to which they are attached.

Holds and pauses
Types of breath marks 
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Fermatas

Fermatas are positioned horizontally so that they are centered on front noteheads in the first 
voice column, regardless of the stem direction of notes.

Fermatas affect the overall tempo of the piece, so all players must be able to see where 
they occur. Therefore, fermatas are shown on all staves at the same rhythmic position, or the 
rhythmic position of the note, chord, or rest that corresponds with the end of the fermata, 
including over a bar rest if a staff has no notes in that bar.

Breath marks

Breath marks are placed above the top line of the staff by default, at the end of the note to which 
they apply; that is, they appear just before the following note.

Breath marks apply only to the staff to which they were added, as they do not affect the overall 
tempo, but instead only indicate to a single player or group of players a suitable place to break 
their line in order to breathe.

Caesuras

Caesuras are positioned at the top of the staff, with the top staff line passing through the 
middle of the caesura and the bottom of the caesura resting on the second staff line. They are 
commonly placed at the end of a bar, before the barline.

Caesuras are automatically added to all staves at the same rhythmic position, immediately to the 
left of the notehead or barline to which they were input. They are not linked to noteheads, and 
adjust note spacing to create a clear gap.

RELATED LINKS
Input methods for holds and pauses on page 336
Holds and pauses in playback on page 1016
Moving notes/items rhythmically on page 461
Moving items graphically on page 514

Combinations of holds and pauses
Some types of holds and pauses cannot appear at the same rhythmic position as other holds and 
pauses.

At a single rhythmic position, Dorico Elements can show the following:

Holds and pauses
Positions of holds and pauses 
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● A single type of fermata or caesura on all staves. For example, you cannot have a short 
fermata on one staff and a long fermata at the same rhythmic position on another staff. 
Changing the type of fermata or caesura on one staff automatically changes the type on all 
staves at that rhythmic position, as a pause at one particular rhythmic position can only be of 
one duration.

● A single type of breath mark or a Curlew mark on each staff independently. For example, 
each staff can show a different type of breath mark, but you cannot show two different 
breath marks at the same rhythmic position on the same staff.

You can combine holds and pauses in the following ways:

● Fermatas cannot exist at the same rhythmic position as any other hold or pause. Breath/
Curlew marks override fermatas, causing them not to appear on the corresponding staves. 
Caesuras and fermatas permanently replace each other.

● Caesuras can exist at the same rhythmic position as breath/Curlew marks, but not fermatas.

● Breath marks cannot exist at the same rhythmic position as Curlew marks. They permanently 
replace each other.

EXAMPLE
To show a fermata and breath mark on the same note, ensure that the breath mark exists at a 
different rhythmic position, as indicated by its attachment line. For example, move it rhythmically 
from an adjacent note, or input it when the caret is at the required position.

RELATED LINKS
Input methods for holds and pauses on page 336
Caret on page 218
Rhythmic position on page 24
Moving notes/items rhythmically on page 461
Hiding/Showing attachment lines on page 437

Changing the number of fermatas per staff
You can change the maximum number of fermatas that appear on each staff at individual 
positions when there are multiple voices on a staff.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the fermatas whose maximum number per staff you want to change. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate Max. fermatas per staff in the Holds and Pauses group.

3. Select one of the following options from the menu:

Holds and pauses
Positions of holds and pauses 
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● One per voice

● One per each side of staff

● One per staff

RESULT
The number of fermatas shown at the selected positions is changed.

RELATED LINKS
Properties panel on page 663
Hiding/Showing zones on page 44
Engrave toolbox on page 503

Positioning fermatas on barlines
You can position individual fermatas over a barline instead of over a note to indicate a gap 
before the start of the following bar.

NOTE

Fermatas cannot be positioned on barlines if Max. fermatas per staff is also activated.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the fermatas you want to position over barlines. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Attach to barline in the Holds and Pauses group.

RESULT
The selected fermatas are positioned above the barline at the end of the bars they were in 
originally, appearing only above staves that are not joined by the barline. Depending on the 
instrumentation, this may mean they only appear at the top of the system.

Deactivating Attach to barline returns the selected fermatas to their default positions.

EXAMPLE

Fermata input on last quarter note in the bar Fermata positioned on barline

Holds and pauses
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Holds and pauses in playback
Dorico Elements uses a combination of changing note durations and inserting gaps to reflect all 
types of fermatas, breath marks, and caesuras in playback.

Fermatas in playback
Fermatas both lengthen the duration of notes at their positions, and insert gaps after 
them. The durations of holds and gaps depends on the type of fermata, with long 
fermatas producing longer held notes and gaps than short fermatas.

Breath marks in playback
Breath marks shorten the duration of the notes that precede them. By default, they 
shorten notes by 50% of a quarter note at 120 bpm, up to a maximum of half the 
duration of affected notes.

Breath marks do not insert time in playback.

Caesuras in playback
Caesuras insert gaps after notes at their positions, before notes at the next rhythmic 
position. By default, they insert gaps equivalent to 50% of the beat duration at their 
positions.

Caesuras do not extend the duration of notes at their positions.

You can change the gap/hold durations of individual fermatas and caesuras, including editing 
them in the Tempo editor.

You can also change the default gap/hold durations of all holds and pauses project-wide in 
Playback Options > Timing > Pauses.

NOTE

Fermatas and caesuras do not affect playback if they overlap with gradual tempo changes. 
We recommend that you position gradual tempo changes to end rhythmically before fermatas/
caesuras. You can lengthen gradual tempo changes graphically in Engrave mode if you want to 
show them extending beyond fermatas/caesuras.

RELATED LINKS
Playing back music on page 540
Changing the played duration of notes on page 689
Gradual tempo changes on page 1345
Tempo editor on page 706

Including/Excluding pauses in playback
By default, Dorico Elements plays back all holds and pauses. You can include/exclude all holds 
and pauses project-wide in playback; for example, to hear your music at a consistent speed and 
without gaps.

NOTE

Fermatas and caesuras never affect playback in fixed tempo mode.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Timing.

Holds and pauses
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3. In the Pauses section, activate/deactivate Play back pauses.

4. Click Apply, then Close.

RELATED LINKS
Playing back music on page 540
Changing the tempo mode on page 543
Playback Options dialog on page 749
Including/Excluding slash voices in playback on page 1260
Including/Excluding repeats in playback on page 550
Input methods for holds and pauses on page 336

Changing the gap/hold durations of fermatas in playback
You can change the gap and hold durations of individual fermatas in playback, independently of 
your project-wide settings. For example, to make a single fermata last longer without changing 
its notated type.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the fermatas whose playback gap/hold durations you want to change. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate the following properties, individually or together, 
in the Holds and Pauses group:

● Hold duration %

● Gap duration %

3. Change the values in the value fields.

4. Optional: To make the selected fermatas play back without gaps, activate Hold only.

RESULT
The gap and/or hold durations of the selected fermatas in playback are changed.

TIP

● You can also edit the playback of individual fermatas in the Tempo editor.

● You can change the default playback gap/hold durations of all fermatas project-wide, 
including setting different values for each type of fermata, in Playback Options > Timing > 
Pauses.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Types of fermatas on page 1011
Tempo editor on page 706

Holds and pauses
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Changing the gap duration of caesuras in playback
You can change the gap duration of individual caesuras in playback, independently of your 
project-wide settings. For example, if your music requires some caesuras to have larger gaps 
than others.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the caesuras whose playback gap duration you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Gap duration % in the Holds and Pauses group.

3. Change the value in the value field.

RESULT
The gap duration of the selected caesuras in playback is changed.

TIP

● You can also edit the playback of individual caesuras in the Tempo editor.

● You can change the default playback gap duration of all caesuras project-wide in Playback 
Options > Timing > Pauses.

Holds and pauses
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Key signatures

Key signatures are the markings that show the current key of music by indicating which notes in 
the scale for that key are sharpened or flattened. They are shown at the start of each system on 
every applicable staff.

Traditionally, accidentals are organized following the pattern of the circle of fifths, which is 
different for sharp keys and flat keys.

Using key signatures saves space, as by indicating which notes are generally going to be sharp or 
flat in the music in one group at the start of each system, these notes do not need an accidental 
beside them every time they occur.

Once you have input a key signature, all notes you subsequently input follow the key signature; 
for example, if you input an F  after inputting a G major key signature, an F♯ is input 
automatically.

Key signatures that do not show accidentals, such as A minor or open key signatures, are 
indicated by signposts.

Instruments that do not usually have key signatures, such as timpani or horn, have a No key 
sig variant in Dorico Elements which never show key signatures. You can select the appropriate 
instrument variant from the instrument picker when adding or changing instruments.

Flows without any key signatures are treated as if there were an open/atonal key signature 
rather than A minor or C major.

By default, key signatures apply to all staves. However, there are certain situations, such as in 
polytonal music, where some parts require their own key signature, independently of the rest of 
the ensemble. You can input key signatures that apply to all staves or only apply to single staves 
in Dorico Elements.

In Dorico Elements, key signatures exist within the overarching tonality system for your project. 
The only tonality system that comes as standard in Dorico Elements is 12-EDO.

NOTE

● You cannot hide key signatures, as they provide crucial information about the pitch of notes. 
If you do not want to see a key signature, you can input an open key signature or delete all 
key signatures from the flow or project.

● You do not have to input multiple simultaneous key signatures if you have transposing 
instruments in your score. Dorico Elements handles instrument transpositions automatically.

RELATED LINKS
Input methods for key signatures on page 278
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Types of key signatures on page 1021
Tonality systems on page 1028
Instrument picker on page 112
Note input on page 223
Deleting notes/items on page 455
Transposing instruments on page 132
Concert vs. transposed pitch on page 178
MIDI Import Options dialog on page 85

Key signature arrangements
Dorico Elements automatically follows conventions for the placement and appearance of key 
signatures, such as showing accidentals in the accepted circle of fifths order and positioning key 
signatures between clefs and time signatures.

The order in which accidentals are shown in key signatures is different for sharp keys and flat 
keys.

● For sharps: F♯, C♯, G♯, D♯, A♯, E♯, B♯
● For flats: B♭, E♭, A♭, D♭, G♭, C♭, F♭
Accidentals are arranged automatically in these orders in Dorico Elements for all standard 
Western key signatures. There is an accepted pattern for the placement of accidentals in a key 
signature, so that they fit inside the staff according to the current clef. The pattern of accidentals 
is the same in all clefs, apart from the tenor clef, which requires sharp key signatures to follow a 
different, ascending pattern to ensure the accidentals fit on the staff.

Clef Arrangement of sharps Arrangement of flats

Treble

Bass

Alto

Tenor

RELATED LINKS
Positions of key signatures on page 1022

Key signatures
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Types of key signatures
There are multiple types of key signatures in Dorico Elements, which can all be input, moved, and 
deleted in the same ways.

Major and minor key signatures

The key signature for a major key appears the same as the key signature for its relative minor, 
and vice versa. For example, B♭ major has two flats in its key signature. This is the same number 
of flats as for G minor, which is the relative minor key to B♭ major. The difference is that music 
in G minor usually has sharpened Fs, as the seventh degree of the scale is raised in minor keys. 
Therefore, if you input an F♯/G♭ after a G minor key signature, Dorico Elements prefers to spell it 
as F♯ in most cases, in order to follow the convention of harmonic minor keys.

A B flat major scale following a B flat major key 
signature

A G minor scale following a G minor key signature

Open key signature

Although open, or atonal, key signatures appear the same as C major or A minor key signatures 
because none shows any accidentals, open key signatures behave differently.

In an open key signature, the spelling of accidentals is based on the current direction of the 
music. If the music is rising, sharps are preferred, whereas if the music is falling, flats are 
preferred. There is no hierarchy of pitches in an open key signature, so the same pitch might be 
spelled differently each time it appears depending on its context, even within a few bars.

In a C major or A minor key signature, accidentals are spelled based on the context of the major 
or minor tonality implied. For example, in C major, sharps in general are preferred, whether the 
music is going up or going down. Similarly, in A minor, G♯ in particular is preferred, whether the 
music is going up or going down, as G♯ is the leading note in A minor.

No key signature

Some instruments are accustomed to seeing no key signatures in their parts, no matter the 
overall key of the piece. These instruments include timpani, percussion, horn, trumpet, and 
sometimes the harp.

If you have added the No key sig version of these instruments, then no key signature is shown in 
their parts, even if they are a transposing instrument, such as horn or trumpet.

Any pitch can be input into these instruments, and they show accidentals if needed.

RELATED LINKS
Input methods for key signatures on page 278
Instrument picker on page 112
Adding instruments to players on page 133

Key signatures
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Hiding/Showing key signatures at the start of systems
By default, key signatures are shown at the start of all systems. You can hide/show key 
signatures at the start of single-staff systems from the second system onwards in each flow 
independently.

Hiding key signatures on single-staff systems after the first system is a convention used in 
hand-copied lead sheets, usually in combination with hiding clefs and showing systemic barlines.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to hide/show key signatures after the 
first system.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Key Signatures.

4. Choose one of the following options for Key signatures at start of systems following first 
system:

● Show key signatures

● Hide key signatures

5. Click Apply, then Close.

RESULT
Key signatures are hidden or shown at the start of single-staff systems from the second system 
onwards in the selected flows.

NOTE

● Key signature changes that occur at system breaks after the first system are always shown.

● Key signatures are always shown at the start of systems that contain more than one staff.

RELATED LINKS
Hiding/Showing systemic barlines on single-staff systems on page 821
Hiding/Showing clefs at the start of systems on page 911

Positions of key signatures
Key signatures are positioned between clefs and time signatures by default, and are shown 
on every staff that requires a key signature. They are not shown on staves for unpitched 
instruments.

Key signatures are shown at the start of a piece and at the start of subsequent movements, 
even if the music carries straight on and in the same key. Unlike time signatures, key signatures 
appear at the start of every system, even if the key signature has not changed. They apply until 
the end of the flow or until the next key signature change, whichever comes first.

Key signatures
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The correct position for key signatures is between clefs and time signatures.

If a key signature change occurs during a piece or movement, it should be placed immediately 
after a barline. It is customary to have a double barline where a key signature change takes 
place, which is the default setting in Dorico Elements.

Examples of key signatures positioned after double barlines

You can move key signatures to new rhythmic positions in Write mode. They are automatically 
positioned correctly.

RELATED LINKS
Cautionary key signatures on page 1024
Key signature arrangements on page 1020
Moving notes/items rhythmically on page 461
Moving key signatures graphically on page 1023

Moving key signatures graphically
You can make individual changes to the graphical position of key signatures without affecting the 
positions of any other items.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the square note spacing handle above the key signature you want to 
move.

A smaller circular handle appears beside the key signature.

2. Press Tab  to select the circular handle.

3. Move the handle in any of the following ways:

● To move it a standard amount to the right or left, press Alt/Opt  plus the corresponding 
arrow key. For example, press Alt/Opt-Left Arrow  to move handles to the left.

● To move it a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow .

Key signatures
Positions of key signatures 

1023
Dorico Elements 5.1.30



● To move it a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow .

● To move it a small amount, press Ctrl/Cmd - Shift  plus the standard key command; for 
example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

NOTE

You cannot move note spacing handles with the mouse, you can only move them using the 
keyboard.

RESULT
The key signature is moved graphically to the right/left.

TIP

When Graphic Editing  is selected in the Engrave toolbox, you can also change Spacing 
offset in the Key Signatures group of the Properties panel to move key signatures horizontally. 
However, this also affects global note spacing at the rhythmic position of the key signature, 
including moving cancellation naturals.

You can also move cancellation naturals graphically, independently of the subsequent key 
signature and without affecting the spacing of any other item using the Cancellation naturals X 
offset property.

RELATED LINKS
Engrave toolbox on page 503
Note spacing on page 507

Cautionary key signatures
When a key signature change occurs at a system break, either in the score or in a part, the new 
key signature is shown at the end of the first system as well as at the start of the new system.

This is sometimes considered a “cautionary key signature”, as players become used to seeing the 
key signature at the start of the system and therefore may miss a change of key signature if it is 
not conspicuously shown at the end of systems. It is also known as a “courtesy key signature”.

In Dorico Elements, the key signatures shown at the end of one system and at the start of the 
next system are the same item, not separate items. You can hide cautionary key signatures, 
either individually or by default in each flow.

TIP

We recommend using flows for separate spans of music. Dorico Elements does not show 
cautionary key signatures or time signatures between flows.

RELATED LINKS
Flows on page 171
Splitting flows on page 501
Hiding/Showing key signatures at the start of systems on page 1022
System breaks on page 633
Cautionary time signatures on page 1384
Repeat markers on page 1236
Clefs on page 907
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Hiding/Showing cautionary key signatures
You can hide/show individual cautionary key signatures shown at the ends of systems when key 
signature changes occur at system breaks, independently of your per-flow setting. For example, 
to save horizontal space when using key signatures with many accidentals. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the cautionary key signatures that you want to hide/show. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Cautionary at end of system in the Key Signatures group.

3. Choose one of the following options:

● Hide

● Show

RESULT
The selected cautionary key signatures are hidden/shown at the ends of systems. This does not 
affect key signatures shown at the start of systems.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can hide/show cautionary key signatures by default in each flow independently on the Key 
Signatures page in Notation Options.

RELATED LINKS
Cautionary key signatures on page 1024
Cautionary time signatures on page 1384
Hiding/Showing key signatures at the start of systems on page 1022
System breaks on page 633
Notation Options dialog on page 747
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Enharmonic equivalent key signatures
Enharmonic equivalent key signatures are keys with different names that include the same 
pitches, such as C♯ major and D♭ major. Dorico Elements follows the convention for transposing 

Key signatures
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to keys with the same type of accidental as the previous key, except where the enharmonic 
equivalent key signature has fewer accidentals.

When transposing selections of notes, Dorico Elements prefers keys with the same type 
of accidental as the previous key signature. When choosing key signatures for transposing 
instruments, Dorico Elements prefers key signatures with the same type of accidental as the 
current concert pitch key.

However, there are some instances where you might prefer to transpose to a key with a different 
type of accidental as it has fewer accidentals than the enharmonic equivalent key. For example, 
C♯ major has seven sharps, whereas the enharmonic equivalent key of D♭ major only has five 
flats. This means the player has to remember the accidentals for fewer notes.

Transposing to an enharmonic equivalent key with fewer accidentals can have the added benefit 
of improving readability by avoiding double sharps or double flats. For example, transposing 
music from F♯ to G♯ requires the leading note to be spelled as an F, but transposing to A♭ instead 
means the leading note is G♮.

G♯ major requires a double sharp leading note A♭ major, the enharmonic equivalent to G♯, does not 
require a double sharp leading note

By default, Dorico Elements selects an enharmonic equivalent key signature if it has fewer 
accidentals. You can change this setting in each flow independently.

How key signatures affect transposing instruments

If there is a key signature in the full score, it is transposed for a transposing instrument by the 
same degree as the transposing interval for the instrument. For example, in a project in E major, 
a B♭ clarinet part has a key of F♯ major, as a B♭ clarinet sounds a whole step (tone) below its 
notated pitch.

Instruments that do not show a key signature

Some instruments are accustomed to seeing no key signatures in their parts, no matter the 
overall key of the piece. These instruments include timpani, percussion, horn, trumpet, and 
sometimes the harp. If you have input the No key sig version of these instruments, then no 
key signature is shown in their parts, even if they are a transposing instrument, such as horn or 
trumpet.

You can still transpose music in the staves of these instruments, but they show accidentals as 
necessary, instead of showing a key signature.

RELATED LINKS
Notation Options dialog on page 747
Transpose dialog on page 470
Transposing selections on page 469
Respelling notes on page 473
Adding instruments to players on page 133
Concert vs. transposed pitch on page 178
Transposing instruments on page 132

Key signatures
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Allowing/Disallowing enharmonic equivalent key signatures
By default, Dorico Elements selects enharmonic equivalent key signatures if they have fewer 
accidentals when transposing selections that include a key signature and in transposing layouts. 
You can change this setting in each flow independently; for example, if you want all layouts to 
have flats in their key signatures, regardless of the number of accidentals.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to allow/disallow enharmonic equivalent 
key signatures.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Accidentals.

4. In the Transposition section, activate/deactivate Prefer enharmonic equivalent key 
signatures with fewer accidentals.

5. Click Apply, then Close.

RESULT
Enharmonic equivalent key signatures with fewer accidentals are allowed when the option is 
activated, and disallowed when the option is deactivated. This affects resulting key signatures 
when transposing selections that include a key signature and in transposing layouts.

Key signatures
Enharmonic equivalent key signatures 

1027
Dorico Elements 5.1.30



Tonality systems

The term “tonality system” is used in Dorico Elements to encompass three crucial elements that 
together make up the concept of tonality.

The three elements that make up tonality systems are:

● A number of equal divisions of the octave, or EDO. For example, standard Western scales 
with half-step (semitone) steps have 12-EDO.

● A set of accidentals. This allows you to notate how much a note is raised or lowered.

● A key signature. In Dorico Elements, you can use any traditional Western key signature.

In Dorico Elements, you cannot change the tonality system; this is only available in Dorico Pro.

Equal Division of the Octave (EDO)
EDO stands for Equal Division of the Octave: the number of equal pieces, or intervals, into which 
an octave is divided.

Traditional Western harmony is based on equal temperament, another method used to describe 
tonality systems, or 12-EDO, as the traditional scale from C-C is made up of twelve steps spread 
across the seven notes in the scale.

For example, between the notes A and B there are two steps, but between B and C there is one 
step. This is because in 12-EDO, each step represents a half-step (semitone), and there are two 
half-steps between A and B according to standard equal temperament, but only one half-step 
between B and C.

Other tonality systems can have different equal divisions of the octave; for example, in 24-EDO 
each octave division is a quarter tone. However, the only tonality system in Dorico Elements is 
12-EDO.
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Lyrics

In Dorico Elements, the term “lyrics” is used for all text that is sung by singers.

Lyrics for a soprano duet with basso continuo accompaniment

Lyrics are organized into lyric lines to ensure consistent horizontal alignment and to make 
showing verse numbers simple and accurate. There are different types of lyric lines for lyrics 
with different purposes, and the appearance of lyrics changes depending on their line type. For 
example, lyrics in chorus and translation lines are shown in an italic font by default.

In Dorico Elements, lyrics were designed so that it is simple to make changes to existing lyrics 
without having to re-input new lyrics each time. For example, you can change the syllable type of 
lyrics so that they are either followed or not followed by a hyphen.

When inputting lyrics, you can use key commands to switch between lyric lines, to change on 
which side of the staff lyrics are input, and to switch the lyric style between normal lyrics, chorus 
lyrics, and translation lyrics. You can also change the type of lyrics after they have been input.

You can input multiple lines of lyrics, chorus lyrics, and translations, both above or below staves. 
You can filter existing lyrics according to their type and lyric line.

RELATED LINKS
Inputting lyrics on page 392
Lyric line numbers on page 1047
Filters for lyrics on page 1034
Lyric hyphens and lyric extender lines on page 1045
Lyrics paragraph styles on page 1041
Exporting lyrics on page 1034

Types of lyrics
Lyrics are divided into different lyric types in Dorico Elements.

Lyric lines
Lyric lines contain normal lyrics and can be shown with verse numbers. They can be 
both below and above the staff.
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Chorus lines
Chorus lines contain lyrics in an italic font and are placed between lyric lines. For 
example, if there are two lyric lines, the chorus line appears between Line 1 and Line 2.

Chorus lines do not have verse numbers.

Lyric line translations
Lyric line translations show the text in lyric lines or chorus lines in different languages. 
They are placed directly below the lyric line or chorus line of which they are a 
translation. They are shown in an italic font.

Each lyric line can have its own lyric line translation, including chorus lines.

Lyric line translations do not have verse numbers, as they are part of the line of which 
they are a translation.

You can input all types of lyrics using the lyrics popover. The icon shown on the left-hand side of 
the popover indicates the type of lyric currently being input.

RELATED LINKS
Lyric line numbers on page 1047
Inputting lyrics on page 392

Changing the type of individual lyrics
You can change the type of individual lyrics after they have been input. For example, you can 
change lyrics into chorus lyrics or translation lyrics.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the individual lyrics whose type you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate/deactivate the following properties, individually or together, 
in the Lyrics group:

● Chorus

● Is translation

RESULT

● Activating Chorus changes the selected individual lyrics to chorus lyrics.

● Activating Is translation changes the selected lyrics to translation lyrics of the same lyric line 
number. For example, selecting lyrics in Line 2 and activating Is translation turns them into 
translation lyrics for Line 2.

● Activating both properties changes the selected lyrics to translation lyrics of the chorus.

● Deactivating both properties changes the selected lyrics to normal lyrics. Their line number 
is indicated by the number in Line number in the Lyrics group of the Properties panel.
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NOTE

If other chorus lines exist at the same position on the side of the staff where you want to change 
your current selection to chorus lines, the two lines collide. To avoid this, change the type of the 
whole lyric line, which automatically avoids collisions.

RELATED LINKS
Showing lyrics in italics on page 1041
Engrave toolbox on page 503

Types of syllables in lyrics
There are different types of syllables in lyrics, depending on their position in words. The key you 
press to advance the popover indicates the syllable type for each lyric.

Dorico Elements defines lyrics as different syllables depending on how you advance the popover 
when inputting lyrics.

Whole word
Lyrics are considered a whole word if the lyric comes after a gap and is followed by a 
gap or a period.

No hyphens are shown either side of whole word lyrics. Extender lines can be shown 
after lyrics.

Start
Lyrics are considered the start syllable in a multi-syllabic word if the lyric comes after a 
gap, but is followed by a hyphen.

Hyphens are shown after start lyrics, which can be continuation hyphens depending on 
the distance before the next lyric in the same lyric line.

Middle
Lyrics are considered the middle syllable in a multi-syllabic word if the lyric comes after 
a hyphen, and is followed by a hyphen.

Hyphens are shown after middle lyrics, which can be continuation hyphens depending 
on the distance before the next lyric in the same lyric line.

End
Lyrics are considered the end syllable in a multi-syllabic word if the lyric comes after a 
hyphen but is followed by a gap or a period.

Extender lines can be shown after end lyrics.

RELATED LINKS
Inputting lyrics on page 392
Lyric hyphens and lyric extender lines on page 1045
Positions of lyrics on page 1035
Changing the alignment of lyrics relative to notes on page 1037

Changing the syllable type of existing lyrics
You can change the syllable type of lyrics after they have been input.

For example, if you advanced the lyrics popover to the next note by pressing Space  but you later 
want it to be followed by a hyphen, you can change its syllable type.
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NOTE

Changing the syllable type changes whether a hyphen is shown after the selected lyrics, not 
before them. Therefore, if you want to show a hyphen before lyrics, you must change the syllable 
type of the lyrics immediately preceding them.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lyrics whose syllable type you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, select one of the following options from the Syllable type menu in 
the Lyrics group:

● Whole word

● Start

● Middle

● End

RESULT
Lyrics with a syllable type of Whole word or End are followed by a space.

Lyrics with a syllable type of Start or Middle are followed by a hyphen.

Copying and pasting lyrics
You can copy and paste lyrics from both existing lyric lines in Dorico Elements and from external 
text editors; for example, if you want to copy a lyric line to a player who has different rhythms to 
the source but uses the same lyrics.

When copying text from outside Dorico Elements, you must format the text so it is suitably 
separated into syllables; for example, by adding hyphens in multi-syllabic words. This ensures 
Dorico Elements can correctly identify the characters required for each word/syllable and 
therefore format the resulting lyrics appropriately. There are automatic hyphenation tools that 
you can use, but results from these are not always reliable. Dorico Elements checks text you 
have copied to your clipboard to make sure it contains only single spaces and single hyphens for 
correct syllable input.

NOTE

You cannot currently copy and paste lyrics containing Chinese, Japanese, or Korean characters. 
This is planned for future versions.

PROCEDURE

1. Select the lyrics/text you want to copy. You can do this within Dorico Elements or externally.

NOTE

● If you are copying existing lyrics/text in Dorico Elements, you must be in Write mode.
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● If you want to select many existing lyrics in Dorico Elements, you can use filters for lyric 
lines or you can select a single lyric and press Ctrl/Cmd-Shift-A  multiple times to select 
the rest of the lyrics in the lyric line.

2. Press Ctrl/Cmd-C  to copy the selected lyrics/text.

3. In Write mode, select the first note in the voice to which you want to copy lyrics.

4. Open the lyrics popover in any of the following ways:

● Press Shift-L .

● In the Notations toolbox, click Popovers , then Lyrics .

5. Optional: Change the lyric type into which you will paste lyrics in one of the following ways:

● To change the lyric line number, press Down Arrow .

● To change to a lyric line above the staff, press Shift - Up Arrow .

● To change to a chorus line, press Up Arrow .

● To change to a translation lyric line, press Alt/Opt - Down Arrow .

6. Press Ctrl/Cmd-V  to paste the first word/syllable of the copied lyrics/text.

The lyrics popover automatically advances to the next note in the selected voice according 
to the source text. For example, for syllables followed by hyphens in the source, the popover 
advances as if you had pressed -  (hyphen), which automatically shows hyphens after those 
syllables.

7. Optional: For words/syllables that you want to apply to two or more notes, you must advance 
the popover manually in one of the following ways:

● After complete words or the final syllable in multi-syllabic words, press Space .

● After syllables that are not the final syllable in multi-syllabic words, press -  (hyphen).

● After syllables that you do not want to be followed by an extension line or hyphen, press 
Right Arrow .

8. Continue pressing Ctrl/Cmd-V  for each word/syllable you want to paste.

RESULT
The selected lyrics/text is pasted into the selected lyric line belonging to the voice in which you 
selected a note.

NOTE

Words/syllables are removed from your clipboard as you paste them. If you want to paste the 
same lyrics/text into another lyric line or staff, you must copy the source again.

RELATED LINKS
Edit Lyrics dialog on page 1043
Lyric line numbers on page 1047
Large selections on page 424
Lyrics popover on page 394
Copying and pasting notes/items on page 457
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Exporting lyrics
You can export all lyrics from all flows in the project to a plain text file; for example, if you want to 
create a libretto of all the text sung in a project.

PROCEDURE

1. Choose File > Export > Lyrics to open the File Explorer/macOS Finder.

2. Specify a name and location for the text file.

3. Click Save.

RESULT
All lyrics from all flows in the project are exported to a plain text file, which opens automatically 
in your default text editor.

Dorico Elements automatically removes hyphens between syllables, and adds contextual 
information for lyrics, such as their line number and the instrument to which they belong.

RELATED LINKS
File import and export on page 78
Lyric hyphens and lyric extender lines on page 1045
Types of lyrics on page 1029
Positions of lyrics on page 1035
Exporting comments on page 500
Exporting text on page 102

Filters for lyrics
In Dorico Elements, lyrics filters allow you to select all lyrics of a specified type across your project 
or across a specific selection.

The following lyrics filters are available:

All Lyrics
Selects all types of lyrics in the current selection, with any lyric line number and 
placement above/below the staff.

Line 1
Selects only Line 1 lyrics and translation lyrics for Line 1 in the current selection, 
including Line 1 below the staff and Line 1 above the staff.

Line 2
Selects only Line 2 lyrics and translation lyrics for Line 2 in the current selection, 
including Line 2 below the staff and Line 2 above the staff.

Line 3
Selects only Line 3 lyrics and translation lyrics for Line 3 in the current selection, 
including Line 3 below the staff and Line 3 above the staff.

Line 4
Selects only Line 4 lyrics and translation lyrics for Line 4 in the current selection, 
including Line 4 below the staff and Line 4 above the staff.

Line 5
Selects only Line 5 lyrics and translation lyrics for Line 5 in the current selection, 
including Line 5 below the staff and Line 5 above the staff.
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Above Staff
Selects all lyrics above the staff in the current selection. You can use this filter in 
addition to the other filters. For example, you can filter first by line number, and then 
filter again by staff-relative placement.

Below Staff
Selects all lyrics below the staff in the current selection. You can use this filter in 
addition to the other filters. For example, you can filter first by line number, and then 
filter again by staff-relative placement.

Chorus
Selects all chorus lyrics in the current selection.

Translations
Selects all translation lyrics in the current selection.

RELATED LINKS
Filters on page 429
Large selections on page 424

Selecting lyrics using filters
You can use lyric filters to select all lyrics of a specified type across your project or across a 
specific selection.

PREREQUISITE
You filter setting is set to Select Only.

PROCEDURE

1. In the music area, make a selection that includes all the lyrics you want to select.

For example, press Ctrl/Cmd-A  to select the whole flow.

2. Choose Edit > Filter > Lyrics > [Lyrics type].

RESULT
All lyrics of the selected type in your selection are selected. For example, if you choose Edit > 
Filter > Lyrics > Chorus, all chorus lyrics in your selection are selected.

Positions of lyrics
Dorico Elements automatically positions lyrics and makes adjustments to accommodate 
variations in the length of lyrics, including adjusting the horizontal alignment of lyrics in 
melismatic music. However, you can also move lyrics manually.

You can move lyrics to different rhythmic positions in Write mode.

You can move individual lyrics graphically in Engrave mode, but this does not change the 
rhythmic positions to which they are attached.

Positions of syllables

Lyrics typically coincide with notes. The number of notes sung on syllables or words determines 
the alignment of lyrics relative to notes:

Lyrics
Positions of lyrics 

1035
Dorico Elements 5.1.30



● Single syllables, which are whole words or parts of longer words that are sung on only 
one note, are centered on their corresponding note, provided it is notated using a single 
notehead. Single syllables on tie chains are left-aligned with the left side of the first note in 
the tie chain.

● Melismata, which are syllables or words that are sung on more than one note, are left-
aligned with the left side of the first note to which they apply.

The horizontal spacing of lyrics must be wide enough so that words or syllables do not overlap 
with the words or syllables on either side. For this reason, note spacing must sometimes be 
adjusted to accommodate lyrics.

To reduce how severely the note spacing is changed to accommodate lyrics, which can distort 
the appearance of rhythms, Dorico Elements allows the alignment of some lyrics to be adjusted 
relative to their corresponding notes. For example, if a long, single-syllable word on a long note 
follows another long, single-syllable word on a short note, the second word is moved a little to 
the right to give both words enough space.

In this musical phrase, the lyric "breeze" has been moved to the right to accommodate the lyric "spring" on 
the previous note.

NOTE

Moving lyrics graphically in Engrave mode overrides the automatic spacing for the selected 
lyrics. If you move a lyric whose position was automatically readjusted, the note spacing at that 
rhythmic position might change.

You can prevent Dorico Elements from considering lyrics in note spacing calculations using 
the Make space for lyrics option on the Note Spacing page in Layout Options; however, we 
recommend using this option with caution.

Placement of lyric lines

Lyrics are generally placed below the staff to which they apply and relative to other lyric lines 
according to their line number. For example, lyrics in Line 1 are placed at the top, including when 
there are multiple lyric lines above the staff.

If a line of lyrics is missing across the width of a whole system, no additional gap is left between 
the remaining lines of lyrics.

You can also move individual lyric lines vertically. In Engrave mode, when you select any lyric in a 
lyric line, a square handle appears on the bottom left of the first lyric in the line on that system. 
This allows you to adjust the vertical position of lyric lines independently of other lyric lines.

Square handle selected at the start of a lyric line in Engrave mode
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EXAMPLE
You have three lines of lyrics, but one system does not have a second line of lyrics. On this 
system, the third line of lyrics is moved upwards, closer to the first line of lyrics.

If a subsequent system does not have a first line, but does have the second and third lines, then 
the second and third lines of lyrics are moved upwards. The second line of lyrics takes the place 
of the first line.

RELATED LINKS
Lyric hyphens and lyric extender lines on page 1045
Changing the gaps between lyrics/hyphens on page 1046
Moving notes/items rhythmically on page 461
Moving items graphically on page 514
Moving lyric lines vertically on page 1039
Changing the line number and type of lyric lines on page 1048
Changing the staff-relative placement of lyric lines on page 1038
Layout Options dialog on page 745
Per-layout note spacing options on page 508

Changing the alignment of lyrics relative to notes
You can change the horizontal alignment of individual lyrics relative to notes; for example, if you 
want to force lyrics at the same position on multiple staves with different default alignments to 
have the same alignment. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

There is no default setting for the alignment of lyrics relative to notes, as Dorico Elements 
automatically adjusts the horizontal position of lyrics to minimize note spacing changes. By 
default, lyrics on single noteheads are center-aligned, and lyrics spanning multiple noteheads are 
left-aligned.

NOTE

Changing the alignment of lyrics manually overrides Dorico Elements’s automatic spacing for the 
selected lyrics, meaning that note spacing at the affected rhythmic positions might change.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the lyrics whose alignment you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Lyric text alignment in the Lyrics group.

3. Select one of the following alignment options from the menu:

● Left

● Center

● Right

Lyrics
Positions of lyrics 

1037
Dorico Elements 5.1.30



RESULT
The alignment of the selected lyrics is changed. Note spacing is automatically adjusted to avoid 
collisions with adjacent lyrics.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

EXAMPLE

Left-aligned lyric "l’aube" Center-aligned lyric "l’aube" Right-aligned lyric "l’aube"

RELATED LINKS
Types of syllables in lyrics on page 1031
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Changing the property scope on page 665

Changing the staff-relative placement of lyric lines
You can show whole lyric lines either above or below the staff after they have been input.

PROCEDURE

1. In Write mode, select a lyric in each line whose staff-relative placement you want to change.

TIP

You can also make a selection and use the lyric filters to select different lyric lines according 
to their line numbers and staff-relative placement.

2. Choose one of the following staff-relative placements:

● Choose Edit > Notations > Lyrics > Placement > Above.

● Choose Edit > Notations > Lyrics > Placement > Below.

TIP

You can also choose these options from the context menu.

RESULT
The staff-relative placement of the whole lyric lines in which you selected lyrics is changed.

NOTE

If other lyric lines with the same lyric line number exist at the same position on the side of 
the staff to which you want to change your current selection, the two lines switch sides. For 
example, if there is already a Line 2 above the staff at the position where you want to change the 
placement of Line 2 below the staff, then the existing Line 2 above the staff is placed below the 
staff to accommodate your most recent preference.
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RELATED LINKS
Lyric line numbers on page 1047
Filters for lyrics on page 1034

Changing the staff-relative placement of individual lyrics
You can show individual lyrics either above or below the staff, independently of the staff-relative 
placement of their lyric line. For example, to clarify the lyrics for each part when two voices on 
the same staff have different rhythms.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lyrics whose staff-relative placement you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, choose one of the following options for Line placement in the 
Lyrics group:

● Above

● Below

RESULT
The staff-relative placement of the selected lyrics is changed.

NOTE

If other lyric lines with the same lyric line number already exist at the same position on the same 
side of the staff, the two lines collide. To avoid this, you can change the lyric line number of one 
of the lyric lines, for example.

Moving lyric lines vertically
You can move lyric lines graphically upwards/downwards on a per-system basis, independently 
of other layouts and your project-wide settings. For example, if the shapes of phrases on certain 
systems make lyric lines appear unevenly centered between staves.

NOTE

● You cannot move individual lyrics upwards/downwards; instead, you can change their lyric 
line number or staff-relative placement.

● We recommend that you add extra pages and finish laying out your pages before moving 
individual lyric lines vertically, as lyric line offsets are automatically deleted if the frame in 
which they occur changes. For example, if you move lyric lines individually and then add a 
blank page at the start of the layout, all of the individual lyric line offsets in the layout are 
deleted.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. In Engrave mode, select any of the following in each system where you want to move lyric 
lines vertically:

● Any lyric in each lyric line you want to move vertically.

● The handles on the bottom left of the first lyric on each lyric line you want to move 
vertically.

NOTE

When using the mouse, you must only select handles at the start of each lyric line.

2. Move the selected lyric lines upwards/downwards in any of the following ways:

● To move them a standard amount, press Alt/Opt-Up Arrow / Alt/Opt-Down Arrow . 
This moves lyric lines by 1/4 space per press.

● To move them a large amount, press Ctrl/Cmd-Alt/Opt-Up Arrow / Ctrl/Cmd-Alt/Opt-
Down Arrow . This moves lyric lines by 1 space per press.

● To move them a moderate amount, press Shift-Alt/Opt-Up Arrow / Shift-Alt/Opt-
Down Arrow . This moves lyric lines by 1/2 space per press.

● To move them a small amount, press Ctrl/Cmd-Shift-Alt/Opt-Up Arrow / Ctrl/Cmd-
Shift-Alt/Opt-Down Arrow . This moves lyric lines by 1/32 space per press.

● Click and drag the handles upwards/downwards.

RESULT
The selected lyric lines are moved upwards/downwards on the selected systems. This does not 
affect the vertical offset of any other lyric lines on those systems or the same lyric lines in other 
layouts.

EXAMPLE
Because of the shape of the music in this example, the default vertical alignment of the chorus in 
the middle of the three lyric lines for the verses in the previous bar causes the chorus to appear 
much closer to notes on the top staff than the bottom staff. Moving the chorus line downwards 
makes it appear more evenly distributed between the staves.

Default chorus placement Chorus line moved downwards

RELATED LINKS
Changing the line number of individual lyrics on page 1049
Engrave toolbox on page 503
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Changing the type of individual lyrics on page 1030

Lyrics paragraph styles
There are different paragraph styles for different types of lyrics. You can change different aspects 
of these paragraph styles in the Paragraph Styles dialog, such as changing their font size to 
make lyrics appear larger.

The following paragraph styles are used for lyrics:

1 Lyrics: Used for lyric lines and verse numbers

2 Lyrics (Translation): Used for lyric line translations

3 Lyrics (Chorus): Used for chorus lines

4 Lyrics (Chorus Translation): Used for chorus line translations

RELATED LINKS
Paragraph Styles dialog on page 756
Types of lyrics on page 1029
Verse numbers on page 1049

Showing lyrics in italics
You can show individual lyrics in an italic font without changing their paragraph style, lyric type, 
or staff-relative placement. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

TIP

● If you want to show lyrics in an italic font because they are intended to be either chorus lyrics 
or translation lyrics, you can change their lyric type instead.

● You can use the Edit Lyric dialog to show individual characters in lyrics in italics.

● If you want all normal lyric lines to appear in an italic font project-wide, you can change the 
Lyrics paragraph style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. Select the lyrics you want to show in an italic font. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Italic in the Lyrics group.

RESULT
The selected lyrics are shown in an italic font. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Types of lyrics on page 1029
Lyric line numbers on page 1047
Lyric hyphens and lyric extender lines on page 1045
Edit Lyric dialog on page 1044
Engrave toolbox on page 503
Changing the property scope on page 665

Changing the paragraph style used for lyrics
You can change the paragraph style used for individual lyrics; for example, if you want to use 
narrower paragraph styles for lyrics on tightly spaced systems. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the lyrics whose paragraph style you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Paragraph style in the Lyrics group.

3. Select a paragraph style from the menu.

RESULT
The paragraph style used for the selected lyrics is changed. This also affects hyphens shown after 
and verse numbers shown before selected lyrics.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can edit the formatting of the paragraph styles used for lyrics in the Paragraph Styles 
dialog.

RELATED LINKS
Types of lyrics on page 1029
Lyric line numbers on page 1047
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Lyric text editing
Proofreading lyrics can be challenging, because lyrics are spaced more widely than regular text 
and individual words are often split up over large horizontal distances. In Dorico Elements, you 
can change the text and formatting of individual lyrics, including viewing entire lyric lines in a 
single dialog.

Changing the text of existing lyrics
You can change the text of lyrics after they have been input; for example, to correct misspellings.

NOTE

● You can only change one lyric at a time when following these steps. To edit multiple lyrics at 
once, you can use the Edit Lyrics dialog.

● If you want to edit the formatting of individual lyrics, you can use the Edit Lyric dialog. 
However, any edits you have made to the formatting of individual lyrics are removed when 
you change their text using the popover.

PROCEDURE

1. In Write mode, select the lyric whose text you want to change.

2. Press Return  or Shift-L  to open the lyrics popover.

3. Change the existing text in the lyrics popover.

4. Optional: If you want to change other existing lyrics, advance the popover in one of the 
following ways:

● To advance the popover to the next note if you entered a complete word, or the final 
syllable in a multi-syllabic word, press Space .

Existing lyrics are automatically selected in the popover when you press Space .

● To advance the popover to the next note if you entered one syllable of a multi-syllabic 
word, press - .

● To move the cursor one character to the right, press Right Arrow .

● To move the cursor one character to the left, press Left Arrow .

The cursor automatically moves to the next/previous lyric/note if you keep pressing the 
arrow keys.

5. Press Return  or Esc  to close the popover when you have finished changing lyrics.

The popover closes automatically when you reach the last note on the staff.

Edit Lyrics dialog
The Edit Lyrics dialog allows you to view and edit entire lyric lines in one place and with the 
text displayed with consistent spacing. This is more convenient than changing each word/syllable 
individually alongside the music, where lyrics can be split up over large horizontal distances.

● You can open the Edit Lyrics dialog by selecting at least one lyric and choosing Edit > 
Notations > Lyrics > Edit Line of Lyrics. You can also choose this option from the context 
menu.

The dialog shows all lyrics in the same lyric line as the selected lyric and allows you to edit the 
lyrics, such as fixing misspellings, adding commas, or changing where in a word the hyphen is 
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placed. If you selected multiple lyrics to open the dialog, Dorico Elements populates the dialog 
with the lyric line of the earliest lyric on the highest staff you selected.

The Edit Lyrics dialog comprises the following:

1 Text editor

Allows you to edit all the lyrics in the selected lyric line in the current flow, with hyphens and 
spaces as appropriate. For example, you can add a comma after the final syllable in a line for 
a poem setting or replace a hyphen with a space.

Non-breaking spaces appear as mid-dot characters. You can enter non-breaking spaces by 
pressing Shift-Alt/Opt-Space .

NOTE

You cannot add, delete, or change the duration/rhythmic position of lyrics, such as the 
number of notes to which each lyric applies.

2 Zoom controls

Allow you to increase/decrease the size of text in the dialog.

3 Current number of lyrics

Displays the number of lyrics currently shown in the text editor and the target number of 
lyrics in the lyric line. The target number is the number of lyrics that already exists in the 
selected lyric line in the flow.

The current number of lyrics updates automatically as you work in the dialog. Dorico 
Elements requires the current number and target number of lyrics to match before you 
can confirm the dialog.

4 OK button

Allows you to confirm your changes and close the dialog. You can only confirm the dialog 
when the current number and target number of lyrics match.

Edit Lyric dialog
The Edit Lyric dialog allows you to edit the formatting of individual lyrics, such as making single 
characters underlined.

● You can open the Edit Lyric dialog by selecting a lyric and choosing Edit > Notations > 
Lyrics > Edit Single Lyric. You can also choose this option from the context menu.
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The Edit Lyric dialog comprises the following:

1 Text editor options

Allows you to customize the font, size, and formatting of the selected part of the lyric.

2 Text editing area

Shows the current text for the lyric. You can select any part of the lyric and edit 
it independently of other parts; for example, if you want some characters to appear 
underlined.

RELATED LINKS
Lyrics paragraph styles on page 1041
Text editor options in Write mode on page 389
Changing the paragraph style used for lyrics on page 1042
Resetting the appearance of items on page 436

Lyric hyphens and lyric extender lines
Lyric hyphens indicate that individual lyrics are syllables within multi-syllabic words; for example, 
“Hal-le-lu-jah”. Lyric extender lines indicate that individual lyrics, either whole words or the last 
syllables in multi-syllabic words, extend across multiple notes.

A phrase containing hyphens and an extender line

Dorico Elements automatically shows lyric hyphens when you advance the lyrics popover by 
pressing -  between syllables. Lyric hyphens use the paragraph style of the preceding lyric.

Dorico Elements automatically shows lyric extender lines when you advance the lyrics popover 
by pressing Space , either once for tied notes or multiple times for multiple separate notes, 
provided there is sufficient horizontal space between the end of the lyric and the end position of 
the extender line. Lyric extender lines end at the right edge of the last notehead to which they 
apply.

In Engrave mode, lyric hyphens and lyric extender lines have two square handles, one at the start 
and one at the end. You can move whole lyric hyphens and lyric extenders lines, and you can 
also move their handles independently of each other. This allows you to lengthen/shorten lyric 
hyphens and extender lines.

Lyrics
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For lyric hyphens, this increases/decreases the space in which lyric hyphens are shown and can 
result in more/fewer hyphens appearing. You can change the gaps between lyrics/hyphens to 
control how many hyphens appear.

Lyric extender line with handles shown Lyric hyphen with handles shown

The start handles of lyric extender lines are attached to the lyrics from which they extend, and 
the start handles and end handles of lyric hyphens are attached to the lyrics on each side. If you 
move either of those lyrics, the corresponding lyric extender line or hyphen handles also move.

NOTE

You cannot move lyric extender lines or hyphens upwards/downwards, as their vertical position 
is determined by their lyric line number and the vertical position of their lyric line.

RELATED LINKS
Inputting lyrics on page 392
Navigation during lyric input on page 395
Changing the gaps between lyrics/hyphens on page 1046
Positions of lyrics on page 1035
Moving lyric lines vertically on page 1039
Moving items graphically on page 514

Changing the gaps between lyrics/hyphens
You can change the gaps between hyphens, and between lyrics and hyphens, independently of 
each other. For example, to show more or fewer hyphens in specific bars.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the lyrics whose lyric/hyphen gaps you want to change.

TIP

You only need to select one lyric before/after each hyphen, as hyphens are always centered 
between lyrics.

2. In the Properties panel, activate the following properties, individually or together, in the 
Lyrics group:

● Gap between lyrics and hyphens

● Gap between hyphens

3. Change the values in the value fields.

Lyrics
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RESULT
The gaps between hyphens and/or between lyrics and hyphens for the selected lyrics are 
changed.

EXAMPLE

Two hyphens shown between "plan" and "tes" Increasing both gaps results in one hyphen

RELATED LINKS
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Properties panel on page 663
Per-layout note spacing options on page 508

Lyric line numbers
Lyric line numbers are used to organize lyrics when a single musical passage can have different 
lyrics sung to it, such as music that contains multiple verses. In Dorico Elements, you can specify 
the line number of lyrics as you input them and by changing the line number of existing lyrics.

For example, if you input lyrics in Line 3 but later want to change those lyrics to Line 4 because 
you want to input different lyrics as Line 3, you can change your current Line 3 into Line 4, and 
then input a new line of lyrics as Line 3. The spacing is automatically adjusted to show lyric lines 
in the correct order.

The start of a choral piece with three lyric lines for its three verses

In Dorico Elements, you can have multiple lines of lyrics both above and below the same staff. 
Turning lyric lines into chorus lyric lines or lyric line translations changes both their placement 
and appearance as chorus lyrics generally use an italic font.

RELATED LINKS
Verse numbers on page 1049
Positions of lyrics on page 1035
Showing lyrics in italics on page 1041
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Changing the line number and type of lyric lines
You can change the lyric line number of whole lyric lines after they have been input. You can also 
change whole lyric lines to chorus lines and lyric line translations.

For example, you can change the existing Line 1 into a lyric translation of Line 4, or change Line 2 
into a chorus line.

TIP

To identify which line you are working on, select a syllable in the line of lyrics and check the 
number in the Line number value field in the Lyrics group of the Properties panel.

PROCEDURE

1. In Write mode, select a lyric in the line whose lyric line type you want to change. The lyric line 
can be above or below the staff.

TIP

You can also make a selection and use the lyric filters to select different lyric lines according 
to their line numbers.

2. Change the line number and/or type of the selected lyric line in one of the following ways:

● Choose Edit > Notations > Lyrics > Line > [Line number].

● Choose Edit > Notations > Lyrics > Line > Chorus.

● Choose Edit > Notations > Lyrics > Translations > [Line number Translation].

● Choose Edit > Notations > Lyrics > Translations > Chorus Translation.

TIP

You can also choose these options from the context menu.

RESULT
The line number or type of the whole lyric line of the selected lyric is changed.

NOTE

The position of the selected lyric line relative to other lyric lines at the same position might be 
changed. For example, if there were two lyric lines and you changed Line 1 to Line 3, it now 
appears below Line 2.

If a lyric line with the same number already exists at the same position on the same side of the 
staff, the two lines switch. For example, if there is already a Line 1 at the rhythmic position where 
you want to change Line 2 to Line 1, then the existing Line 1 becomes Line 2 to accommodate 
your most recent preference. The same applies to chorus lines and lyric line translations.

RELATED LINKS
Types of lyrics on page 1029
Filters for lyrics on page 1034

Lyrics
Lyric line numbers 

1048
Dorico Elements 5.1.30



Changing the line number of individual lyrics
You can change the lyric line number of individually selected lyrics after they have been input.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the individual lyrics whose line number you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, change the value for Lyric number in the Lyrics group.

RESULT
The line number of the selected lyrics is changed to match the value in the value field.

NOTE

The position of the selected lyrics relative to other lyric lines might be changed. For example, if 
there were two lyric lines and you changed lyrics in Line 1 to Line 3, they now appear below Line 
2.

Verse numbers
Verse numbers indicate the order in which lyrics are sung when multiple lines of lyrics share the 
same musical passage. They are commonly used in hymns and song sheets.

Depending on the type of music you are writing, verse numbers might not be appropriate. 
Therefore, hiding/showing verse numbers in Dorico Elements is optional. By default, verse 
numbers are not shown. You can hide/show verse numbers on individually selected lyrics.

Verse numbers use the same paragraph style as the following lyric.

NOTE

Lyric line translations are part of the lyric line of which they are a translation, so they do not have 
their own verse number.

RELATED LINKS
Lyrics paragraph styles on page 1041

Hiding/Showing verse numbers
You can hide/show verse numbers on individual lyrics; for example, if you want to show the verse 
number at the start of every system.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the lyrics before which you want to hide/show verse numbers. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate/deactivate Show verse number in the Lyrics group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Verse numbers are shown before the selected lyrics when the checkbox is activated, and hidden 
when the checkbox is deactivated.

RELATED LINKS
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Changing the property scope on page 665

Elision slurs
Elision slurs are used to show that two or more syllables or characters are part of the same lyric. 
Elision slurs are also sometimes used to tell singers not to breathe between the joined lyrics.

A soprano part containing multiple elision slurs

Dorico Elements automatically shows elision slurs in lyrics that contain the underscore character.

RELATED LINKS
Inputting lyrics on page 392
Slurs on page 1283

Hiding/Showing East Asian elision slurs
You can hide/show East Asian elision slurs for individual lyrics. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the lyrics on which you want to show East Asian elision slurs. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate/deactivate Show East Asian elision slur in the Lyrics group.

3. Activate/Deactivate the corresponding checkbox.
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RESULT
East Asian elision slurs are shown on the selected lyrics when the checkbox is activated, and 
hidden when the checkbox is deactivated. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

EXAMPLE

East Asian elision slur shown East Asian elision slur hidden
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Notes

Notes are shapes that are positioned on staves to indicate musical pitches. Notes are most 
commonly shown with oval-shaped, round noteheads that are either filled or void depending on 
their duration, but there are many different designs of noteheads that you can use.

Depending on their duration, notes can have stems that help indicate their duration.

In Dorico Elements, a sequence of adjacent notes joined with ties is considered a single note of 
the total duration of the tie chain, rather than separate notes. Note grouping is automatically 
adjusted according to the prevailing beat grouping, which is normally set by the time signature.

RELATED LINKS
Inputting notes on page 224
Note spacing on page 507
Stems on page 1074
Notehead sets on page 1052
Changing the notehead design of individual noteheads on page 1058
Note tools popover on page 487
Adding notes above/below existing notes on page 258
Bracketed noteheads on page 1066
Ties on page 1364
Note and rest grouping on page 860
Beam grouping according to meters on page 841

Notehead sets
A notehead set is a collection of related noteheads that together allow you to represent all the 
different noteheads required for the different durations used in music notation.

A typical notehead set contains at least four noteheads:

● A black notehead for quarter notes (crotchets) and shorter

● A white notehead for half notes (minims)

● A wider white notehead for whole notes (semibreves)

● A wider white notehead with one or two vertical strokes on either side, or a square white 
notehead, for double whole notes (breves)

Pitch-dependent notehead sets contain noteheads that vary according to the pitch of notes 
rather than their duration.

● In pitched notehead sets, there are different noteheads for different pitches.

For example, the Pitch Names notehead set shows the letter name and any applicable 
accidental of each note within its notehead.

● In scale degree notehead sets, there is a different notehead for each scale degree, relative to 
the current key signature.

For example, the Aikin 7-shape notehead set uses a different notehead shape for each pitch.
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NOTE

● A single notehead can appear in multiple notehead sets. If you edit a notehead within one 
notehead set, your changes affect the appearance of that notehead in all notehead sets that 
contain it.

● Notehead sets can only contain noteheads of the same type. For example, you cannot use a 
normal notehead in a pitched notehead set.

● You cannot change the type of an existing notehead set or an existing notehead.

RELATED LINKS
Pitch-dependent notehead set designs on page 1057

Notehead set designs
There are a number of different notehead set designs that you can use for individual noteheads 
in Dorico Elements.

● You can find the available notehead designs by selecting at least one note and choosing 
Edit > Notations > Notehead > [Notehead type or design] > [Notehead design]. You can 
also choose these options from the context menu.

NOTE

Dorico Elements does not offer stemless noteheads. Instead, you can hide the stems of notes 
with any notehead design.

General noteheads

Notehead set design Notehead set name

Larger Noteheads

Default Noteheads

Large Circled Noteheads

Circled Noteheads

Slashed Noteheads (Bottom Left to Top Right)
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Notehead set design Notehead set name

Slashed Noteheads (Top Left to Bottom Right)

Cross noteheads

Notehead set design Notehead set name

Circle X Noteheads

Large X and Diamond Noteheads

Ornate X Noteheads

Plus Noteheads

With X Noteheads

X Noteheads

X and Circle X Noteheads

X and Diamond Noteheads
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Triangular noteheads

Notehead set design Notehead set name

Large Arrow Down Noteheads

Large Arrow Up Noteheads

Triangle Down Noteheads

Triangle Left Noteheads

Triangle Right Noteheads

Triangle Up Noteheads

Diamond noteheads

Notehead set design Notehead set name

Diamond Noteheads

Old-Style Diamond Noteheads

White Diamond Noteheads

Wide Diamond Noteheads
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Slash noteheads

Notehead set design Notehead set name

Muted Slash Noteheads

Oversized Slash Noteheads

Slash Noteheads

Small Slash Noteheads

Round and square noteheads

Notehead set design Notehead set name

Moon Noteheads

Rectangular Noteheads

Round White with Dot Noteheads

RELATED LINKS
Changing the notehead design of individual noteheads on page 1058
Resetting notehead designs on page 1059
Hiding/Showing stems on page 1079
Hiding/Showing noteheads on page 1060
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Pitch-dependent notehead set designs
Pitch-dependent notehead sets use different notehead designs or different notehead colors 
depending on the pitch of notes. There are a number of different pitch-dependent notehead sets 
available in Dorico Elements.

● You can find the available notehead designs by selecting at least one note and choosing 
Edit > Notations > Notehead > [Notehead type or design] > [Notehead design]. You can 
also choose these options from the context menu.

Scale degree noteheads

Notehead set design Notehead set name

Aikin 7-shape Noteheads

Funk 7-shape Noteheads

Walker 4-shape Noteheads

Walker 7-shape Noteheads

Pitched noteheads

Notehead set design Notehead set name

Figurenotes© Noteheads

Pitch Name Noteheads

RELATED LINKS
Hiding/Showing stems on page 1079
Hiding/Showing noteheads on page 1060
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Changing the notehead design of individual noteheads
You can change the notehead design of individual noteheads, including trill auxiliary notes. For 
example, cross noteheads might be used to indicate where players should produce pitchless 
sounds, such as air sounds on wind instruments.

NOTE

● These steps do not apply to notes in slash voices.

● To represent different playing techniques for notes belonging to unpitched percussion 
instruments, you can instead change their playing technique.

● To represent harmonics or rhythm slashes, you can instead turn notes into harmonics or 
change them to a slash voice. You can also input slash regions.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the noteheads whose design you want to change. You can do this in Write mode and 
Engrave mode.

2. Choose Edit > Notations > Notehead > [Notehead type] > [Notehead design].

For example, to change the notehead design of the selected notes to X noteheads, choose 
Edit > Notations > Notehead > Crosses > X Noteheads.

TIP

You can also choose these options from the context menu.

RESULT
The notehead design of the selected notes is changed.

TIP

You can assign a key command for each factory default notehead design on the Key Commands 
page in Preferences.

RELATED LINKS
Engrave toolbox on page 503
Selecting notes/items on page 421
Rhythm slashes on page 1258
Slash voices on page 1258
Slash regions on page 1261
Changing the voice of existing notes on page 466
Harmonics on page 1081
Turning notes into harmonics on page 1082
Playing technique-specific noteheads on page 1421
Changing playing technique-specific noteheads on page 1424
Hiding/Showing stems on page 1079
Hiding/Showing noteheads on page 1060
Key Commands page in the Preferences dialog on page 60
Changing the size of accidentals on page 794
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Resetting notehead designs
You can reset the notehead design of individual notes and return them to using the default 
notehead design.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the noteheads whose design you want to reset. You can do this in Write mode and 
Engrave mode.

2. Choose Edit > Notations > Notehead > Reset to Default Notehead. You can also choose 
this option from the context menu.

RELATED LINKS
Selecting notes/items on page 421

Assigning notes to strings
You can change the string on which individual notes belonging to string instruments are played; 
for example, to allow you to specify the correct harmonic. Many notes can be played on multiple 
strings, depending on where along its length the string is stopped.

Assigning notes to strings can be useful for glissando lines or fingering shifts, as the string 
and finger position required to play the note affects the direction of these changes. However, 
the string number is not shown in the music. You can instead input string indicators and/or 
fingerings, which can help string players understand the string on which they should play.

NOTE

You can only change the assigned string of notes belonging to string instruments, such as violin, 
cello, or guitar.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes whose assigned string you want to change. You can do this in Write mode 
and Engrave mode.

NOTE

If selecting multiple notes at once, select notes only in staves of the same instrument type. 
For example, select multiple Cs in Violin 1 and Violin 2 staves.

2. In the Properties panel, activate String in the Notes and Rests group.

3. Select the string you want from the menu.
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The string number for the instrument is shown, followed by the fundamental pitch and 
the octave number of that string in parentheses. For example, the lowest cello string is 
expressed as 4 (C2).

NOTE

The options available in the menu depend on the selected pitches and the instrument type.

RESULT
The string to which the selected notes are assigned is changed.

NOTE

If you subsequently change the pitches of notes, String is automatically deactivated for all notes 
that can no longer be played on their assigned string.

RELATED LINKS
Engrave toolbox on page 503
Glissando lines on page 1115
Changing the direction of string fingering shift indicators on page 991
Fingerings for fretted instruments on page 981
String indicators on page 993
Inputting string indicators inside the staff on page 383
Turning notes into harmonics on page 1082
Changing the harmonic partial on page 1083
Changing the middle C numbering convention on page 51

Hiding/Showing noteheads
You can hide/show the noteheads of individual notes with any notehead design; for example, if 
you want to indicate the exact durations of glissando lines using stems without noteheads.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the notes whose noteheads you want to hide.

2. In the Properties panel, activate/deactivate Hide notehead in the Notes and Rests group.

RESULT
The selected noteheads are hidden when Hide notehead is activated, and shown when it is 
deactivated.

This also hides rhythm dots, provided all noteheads represented by consolidated rhythm dots are 
hidden, but does not affect the visibility of accidentals or ledger lines.

Hidden noteheads are included in note spacing calculations as if they were shown.

Notes
Hiding/Showing noteheads 

1060
Dorico Elements 5.1.30



EXAMPLE

Noteheads shown Middle noteheads hidden

RELATED LINKS
Properties panel on page 663
Hiding/Showing zones on page 44
Hiding/Showing hidden noteheads on page 1065
Hiding/Showing ledger lines on page 1062
Hiding/Showing stems on page 1079
Hiding/Showing or parenthesizing accidentals on page 793
Changing the consolidation of rhythm dots on page 1062
Note spacing on page 507
MIDI trigger regions on page 574

Changing the width of ledger lines
You can change the width of ledger lines on individual notes; for example, to allow notes with 
short durations to be spaced more tightly and still be legible. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the noteheads whose ledger line width you want to change.

2. In the Properties panel, activate Ledger line in the Notes and Rests group.

3. Change the values for L and R.

RESULT
Increasing Ledger line L makes the left side of ledger lines longer, decreasing the value makes 
the left side of ledger lines shorter.

Increasing Ledger line R makes the right side of ledger lines longer, decreasing the value makes 
the right side of ledger lines shorter.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
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Copying property settings to other layouts/frame chains on page 646

Hiding/Showing ledger lines
You can hide/show ledger lines on individual notes; for example, if you want to indicate 
approximate pitches using the relative vertical positions of notes. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the noteheads whose ledger lines you want to hide/show.

NOTE

If you want to hide ledger lines, you must also select all other noteheads in the same voice 
and voice column index.

2. In the Properties panel, activate/deactivate Hide ledger lines in the Notes and Rests group 
of the Properties panel.

RESULT
Ledger lines are hidden/shown for the selected notes. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

If you deactivated Hide ledger lines for only some notes in a chord, ledger lines are also shown 
on all notes between the selected notes and the staff in the same voice and voice column index.

RELATED LINKS
Voice column index on page 1442

Changing the consolidation of rhythm dots
You can change how rhythm dots in multiple voices are consolidated at individual rhythmic 
positions. For example, if you want to show fewer rhythm dots for a very dense chord. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the notes whose rhythm dot consolidation you want to change.

2. In the Properties panel, activate Rhythm dot consolidation in the Notes and Rests group.
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3. Activate/Deactivate the corresponding checkbox.

RESULT
Rhythm dots for notes of any duration are consolidated when the checkbox is activated, and no 
rhythm dots are consolidated when the checkbox is deactivated. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Notes of any duration have rhythm dots 
consolidated

No rhythm dot consolidation

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Note positions in multiple-voice contexts on page 1440
Voice column index on page 1442
Allowing/Disallowing noteheads in opposing voices to overlap on page 1440

Moving rhythm dots
You can move rhythm dots horizontally. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains. However, you cannot move an individual rhythm dot 
independently of other rhythm dots at the same rhythmic position.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select a notehead at each rhythmic position where you want to move 
rhythm dots.

2. In the Properties panel, activate Rhythm dot X in the Notes and Rests group.

3. Change the value in the value field.

RESULT
Increasing the Rhythm dot X value moves all rhythm dots at the selected rhythmic positions to 
the right, decreasing the value moves them to the left. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

Notes
Changing the consolidation of rhythm dots 

1063
Dorico Elements 5.1.30



View options for notes and rests
You can show notes and rests in different colors in various contexts, which can help you identify 
them more easily as you are working. For example, showing voice colors makes notes and rests 
appear in different colors according to their voice.

RELATED LINKS
Color setup on page 52
Hiding/Showing rest colors on page 1275
Hiding/Showing voice colors on page 1439
Hiding/Showing colors for muted notes/items on page 549

Hiding/Showing colors for notes out of range
You can show colors for notes that are considered out of range, such as notes too high/low for 
the instrument to play or the voice type to sing, or pitches that do not fit with the current harp 
pedal settings. When colors for notes out of range are hidden, all notes appear black by default.

Colors for notes out of range are considered annotations and are not printed by default.

NOTE

You cannot show colors for voices and notes out of range simultaneously.

PROCEDURE

● Do one of the following:

● To show colors for notes out of range, choose View > Note And Rest Colors > Notes 
Out Of Range.

● To hide colors for notes out of range, choose View > Note And Rest Colors > None.

RESULT
Colors for notes out of range are hidden/shown.

Notes that are considered challenging are shown in a darker red, while notes that are impossible 
or virtually impossible are shown in a bright red.

NOTE

Notes out of the fret range of the corresponding string on tablature are always shown as 
question marks, even if you do not show colors for notes out of range.

EXAMPLE

Colors for notes out of range shown. Three notes in the middle of the phrase are bright red, while the rest 
are the darker red.
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AFTER COMPLETING THIS TASK
If showing colors for notes out of range reveals some notes do not fit with the current harp pedal 
settings, you can input a new pedal diagram for that passage or calculate a suitable harp pedal 
diagram.

RELATED LINKS
Changing music area colors on page 54
Inputting harp pedal diagrams with the panel on page 380
Calculating harp pedal diagrams based on existing music on page 381
Hiding/Showing voice colors on page 1439
Annotations on page 597

Hiding/Showing hidden noteheads
You can show hidden noteheads in translucent gray, so you can identify and select them more 
easily.

PROCEDURE

● Choose View > Note And Rest Colors > Hidden Noteheads.

RESULT
Hidden noteheads are hidden/shown.

EXAMPLE

Hidden noteheads shown Hidden noteheads hidden

RELATED LINKS
Hiding/Showing noteheads on page 1060

Notes
View options for notes and rests 
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Bracketed noteheads

Bracketed noteheads are often used to indicate that notes are optional, editorial, not played in all 
playthroughs in music with repeats, or pressed down but not fully struck on the piano. In Dorico 
Elements, you can show brackets on any notehead.

Notehead brackets extend slightly above and below noteheads so it is clear which notes are 
included in each bracket.

A phrase containing round and square notehead brackets

You can also show brackets on noteheads on notation staves and tablature independently of 
each other.

By default, bracketed notes have reduced velocity, causing them to sound quieter in playback 
than normal notes.

The following types of notehead brackets are available in Dorico Elements:

Round notehead brackets
Round notehead brackets have a similar appearance to slurs, but vertical.

By default, round brackets on single noteheads use the font glyph on notation staves 
and the drawn curve on tablature. In Engrave mode, round notehead brackets that use 
the drawn curve have handles that allow you to change their shape. Round notehead 
brackets that use the font glyph do not have handles in Engrave mode.

NOTE

On tablature, round brackets are automatically shown around the second note/chord 
and all subsequent notes/chords in tie chains. If you show brackets around all 
noteheads in tie chains on tablature, these automatic notehead brackets are included.

Round brackets on 
single noteheads on 
a notation staff

Round bracket on a 
chord on a notation 
staff

Round brackets on 
single noteheads on 
tablature

Round bracket on a 
chord on tablature
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Square notehead brackets
Square notehead brackets comprise a straight vertical line with horizontal hooks at the 
top and bottom. Dorico Elements automatically adjusts the length of square brackets 
to ensure they do not end on staff lines and their hooks remain visible.

Square brackets on 
single noteheads on 
a notation staff

Square bracket on a 
chord on a notation 
staff

Square brackets on 
single noteheads on 
tablature

Square bracket on a 
chord on tablature

RELATED LINKS
Showing brackets around one/all noteheads in tie chains on page 1069
Notehead brackets in Engrave mode on page 1072
Showing notes as dead notes on page 1141
Inputting notes on page 224
Ties on page 1364
Guitar bends on page 1122
Guitar pre-bends and pre-dives on page 1124
Vibrato bar dives and returns on page 1127
Parenthesized chord symbols on page 889

Showing brackets on noteheads
You can show round or square brackets on individual noteheads, on single notes within chords, 
and on whole chords. For example, if you want to indicate that specific notes are optional or 
an editorial change, or to show notes belonging to unpitched percussion instruments as ghost 
notes.

NOTE

If you want to show brackets on noteheads to represent dead notes, you can instead show notes 
belonging to fretted instruments as dead notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the noteheads on which you want to show brackets. You can do this in Write mode 
and Engrave mode.

NOTE

● If you want to show brackets on individual noteheads in tie chains that are not the first 
notehead, you must select them in Engrave mode.

● If you want to show brackets on whole chords, you must select all notes in those chords.

Bracketed noteheads
Showing brackets on noteheads 
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● If you want to show brackets on both notation staves and tablature, you must select 
notes on both.

2. In the Properties panel, activate Bracket style in the Bracketed Noteheads group.

3. Choose one of the following options:

● Round

● Square

RESULT
The corresponding type of notehead brackets is shown on the selected notes. If you only 
selected notes on tablature, brackets are not shown on the corresponding notes on the notation 
staff, and vice versa.

In Write mode, only the first noteheads in tie chains are bracketed. In Engrave mode, only the 
selected noteheads are bracketed, including in tie chains.

If you selected all notes in chords, Dorico Elements shows a single bracket for each chord unless 
they contain very large gaps, in which case Dorico Elements automatically splits brackets. If you 
selected individual notes within chords, they are each shown with separate brackets.

By default, bracketed notes have reduced velocity, causing them to sound quieter in playback 
than normal notes.

TIP

● Deactivating Bracket style hides brackets on the selected notes.

● You can also hide/show brackets on noteheads by choosing Edit > Notations > Notehead > 
Toggle Round Brackets or Edit > Notations > Notehead > Toggle Square Brackets. You 
can also choose these options from the context menu.

You can assign key commands for these options on the Key Commands page in 
Preferences.

● You can change the volume reduction of bracketed unpitched percussion notes in playback 
in Playback Options > Dynamics > Note Dynamics.

EXAMPLE

Round brackets on single 
noteheads on a notation staff

Round bracket on a chord on a 
notation staff

Split round bracket on a chord on 
a notation staff

Round brackets on single 
noteheads on tablature

Round bracket on a chord on 
tablature

Split round bracket on a chord on 
tablature

Bracketed noteheads
Showing brackets on noteheads 
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RELATED LINKS
Engrave toolbox on page 503
Showing notes as dead notes on page 1141
Inputting notes on page 224
Velocity editor on page 691
Playback Options dialog on page 749

Showing brackets around one/all noteheads in tie chains
You can change whether brackets appear only on the first notehead in tie chains or span the 
entire duration of the tie chain; that is, with the left bracket on the first notehead and the 
right bracket on the last notehead in the tie chain. By default, brackets appear only on the first 
notehead in tie chains.

PREREQUISITE

● You have shown brackets on the required notes.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes whose notehead bracket positions relative to tie chains you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Bracket until end of tie chain in the Bracketed 
Noteheads group.

RESULT
Brackets appear at the start and end of the selected tie chains when Bracket until end of tie 
chain is activated, and only around the first note/chord when it is deactivated.

If you activated Bracket until end of tie chain for a single note in a bracketed chord, the bracket 
on the first chord is not split but an additional bracket appears at the end of the tie chain for 
the selected note only. If you deactivated Bracket until end of tie chain for a single note in a 
bracketed chord whose other notes are bracketed to the end of the tie chain, the bracket at the 
end of the tie chain is split.

If you selected notes on tablature, the automatic brackets shown around the second note/chord 
and all subsequent notes/chords in tie chains are updated to follow your property setting.

EXAMPLE

Brackets around only the first chords in tie chains on 
a notation staff

Brackets at the start and end of whole tie chains on a 
notation staff

Bracketed noteheads
Showing brackets around one/all noteheads in tie chains 
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Brackets around only the first chord in a tie chain, 
with automatic brackets shown on the second chord 
on tablature

Brackets around the start and end of the whole tie 
chain on tablature

RELATED LINKS
Ties on page 1364
Showing single brackets on figured bass on page 960
Engrave toolbox on page 503

Splitting brackets on chords
You can split brackets on any notehead within a chord. By default, Dorico Elements automatically 
shows a single bracket for all notes in a chord unless it contains very large gaps, in which case 
Dorico Elements automatically splits brackets.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the individual notes in chords immediately above where you want to split brackets. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Break bracket in the Bracketed Noteheads group.

RESULT
Brackets are split immediately below the selected notes.

EXAMPLE

Chord with single round bracket Chord with split round bracket

Bracketed noteheads
Splitting brackets on chords 
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RELATED LINKS
Inputting chords on page 251
Parenthesized chord symbols on page 889

Changing the shape of round notehead brackets
You can change the shape of individual round notehead brackets; for example, if you want 
some notehead brackets to appear wider or to change their curvature, so that their endpoints 
approach noteheads at a sharper angle. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

NOTE

You can only change the shape of round notehead brackets on single noteheads if they use the 
drawn curve, rather than the font glyph.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the middle handles of each round notehead bracket whose shape 
you want to change.

2. Change the shape of the selected round notehead brackets in any of the following ways:

● To widen right notehead brackets or narrow left notehead brackets, press Alt/Opt-
Right Arrow .

● To narrow right notehead brackets or widen left notehead brackets, press Alt/Opt-
Left Arrow .

● To increase the angle of notehead bracket endpoints, press Alt/Opt-Up Arrow .

● To decrease the angle of notehead bracket endpoints, press Alt/Opt-Down Arrow .

TIP

● To move handles by large increments, press Ctrl/Cmd  plus the standard key 
command; for example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move handles by moderate increments, press Shift  plus the standard key 
command; for example, Shift-Alt/Opt-Left Arrow .

● To move handles by small increments, press Ctrl/Cmd - Shift  plus the standard key 
command; for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

● You can also click and drag middle handles in the corresponding directions.

RESULT
The shape of the selected notehead brackets is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

If necessary, other nearby items, such as ties and slurs, automatically move to avoid collisions. 
This might affect note spacing and casting off.

Bracketed noteheads
Changing the shape of round notehead brackets 
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TIP

The following properties in the Bracketed Noteheads group of the Properties panel are 
activated automatically when you move the middle handle of notehead brackets.

● L round br. middle moves left notehead bracket middle handles. X moves them horizontally, 
changing the width of notehead brackets, and Y moves them vertically, changing the 
curvature of notehead brackets.

● R round br. middle moves right notehead bracket middle handles. X moves them 
horizontally, changing the width of notehead brackets, and Y moves them vertically, 
changing the curvature of notehead brackets.

You can also use these properties to change the width and shape of round notehead brackets by 
changing the values in the value fields.

Deactivating the properties resets the selected notehead brackets to their default shape.

EXAMPLE

Widened round notehead 
bracket

Narrowed round 
notehead bracket

Endpoint angle increased Endpoint angle 
decreased

RELATED LINKS
Showing brackets on noteheads on page 1067
Moving items graphically on page 514
Engrave toolbox on page 503
Changing the property scope on page 665
Slur shoulder offset on page 1306

Notehead brackets in Engrave mode
In Engrave mode, each round notehead bracket has multiple handles that you can move 
independently to adjust their graphical position, length, and shape.

Round notehead brackets that use the drawn curve have three square handles that you can 
move independently. When you move either of the top/bottom handles, the middle handle also 
moves to retain its position relative to the start/end handles.

NOTE

Round brackets on single noteheads that use the font glyph do not show handles in Engrave 
mode, meaning you cannot lengthen/shorten them or change their shape/width.

Square notehead brackets have two handles, one at the top and one at the bottom.

Bracketed noteheads
Notehead brackets in Engrave mode 
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Round notehead bracket handles in Engrave mode Square notehead bracket handles in Engrave mode

● Top and bottom handles move the corresponding end of the notehead bracket, controlling 
its graphical length.

● Middle handles control the shape of round notehead brackets. Moving them vertically 
adjusts their curve by changing the angle at which notehead bracket endpoints approach 
noteheads, while moving them horizontally changes the width of round notehead brackets.

You can move these handles to change the graphical length of notehead brackets and the 
shape of round notehead brackets. If necessary, other nearby items, such as ties and slurs, 
automatically move to avoid collisions.

TIP

The following properties in the Bracketed Noteheads group of the Properties panel are 
activated automatically when you move the corresponding notehead bracket or handle:

● L bracket body moves left notehead brackets. X moves them horizontally, Y moves them 
vertically.

● R bracket body moves right notehead brackets. X moves them horizontally, Y moves them 
vertically.

● L bracket extents controls the height of left notehead brackets. T moves their top handles, 
B moves their bottom handles.

● R bracket extents controls the height of right notehead brackets. T moves their top 
handles, B moves their bottom handles.

Bracketed noteheads
Notehead brackets in Engrave mode 
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Stems

Stems are vertical lines that extend from noteheads that are a half note or shorter in duration. In 
combination with notehead design, they allow the duration of each note to be clearly identified.

For example, quarter notes (crotchets) and eighth notes (quavers) both have solid black 
noteheads and stems, but eighth notes also have flags on their stems. 16th notes have two 
flags, 32nd notes have three flags, and so on. The length of stems is determined by default in 
Dorico Elements, so stems automatically adjust their length to accommodate more/fewer flags.

The stems of notes and chords can point upwards/downwards, depending on the conventions of 
music engraving and the context of the music. For example, in choral music on two staves, stems 
in the soprano and tenor lines point up, and stems in the alto and bass lines point down.

RELATED LINKS
Note and rest grouping on page 860
Altered unisons on page 798
Voices on page 1438
Inputting notes on page 224
Resetting beam grouping on page 844

Stem direction
In Dorico Elements, the stem direction of notes and chords follows rules that are based on the 
conventions of music engraving.

Stem direction is determined automatically, but you can manually change the stem direction of 
individual notes, chords, or of an entire voice. The rules that are applied depend on the following:

● How many voices are active on the staff.

● Whether notes, chords, or beamed groups of notes are affected.

● Whether notes in the same chord or notes in the same beamed group are split between 
staves.

Single notes in single voices

On a five-line staff with only a single voice active, the default stem direction of a single note is 
determined by its staff position.

● If the note is above the middle line, its stem points downwards.

● If the note is below the middle line, its stem points upwards.

● If the note is on the middle line of the staff, its stem direction is determined by the stem 
directions of any adjacent notes, beam groups, or chords. If they both have the same 
stem direction, the note matches them. If the adjacent notes, beam groups, or chords have 
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different stem directions, or if there are no adjacent notes, beam groups, or chords, the note 
follows the default stem direction.

The default stem direction depends on the instrument type. By default, the stems of notes 
on the middle lines of staves point downwards on instrumental staves and upwards on vocal 
staves, to avoid lyrics.

Notes on the middle line are stem up because the 
fourth note is stem up

Notes on the middle line are stem down because the 
fourth note is stem down

By default, notes are first input into an up-stem voice, and Dorico Elements treats notes as the 
only voice on the staff until you input more voices.

Single notes in multiple voices

When there are multiple voices on a staff and all voices contain notes, the stem direction of notes 
is determined by the stem direction of their voice. Notes in up-stem voices have up stems, and 
notes in down-stem voices have down stems. This applies even when the stems of notes would 
normally point in the other direction, based on their position on the staff.

NOTE

The order in which notes appear between different up-stem voices and different down-stem 
voices depends on their pitch and your settings on the Voices page in Notation Options. You 
can also change the voice column index of notes individually.

When there are only notes in one voice for at least a whole bar, Dorico Elements automatically 
changes the directions of stems so they point in the default direction for their pitch. For example, 
if a staff contains a single up-stem voice and a single down-stem voice but only the down-stem 
voice contains notes or rests, then the stems of notes in the down-stem voice may point 
upwards, depending on the position of the notes on the staff. However, showing rests or implicit 
rests in empty voices forces the stem direction of notes to follow the stem direction of their voice.

Notes in an up-stem voice shown in 
blue.

Notes in a down-stem voice 
shown in orange.

When notes in up-stem and down-
stem voices are in the same bar, 
the stem direction is automatically 
changed.

Chords in single voices

The stem direction for a chord in a single voice is determined by the balance of notes above/
below the middle line of the staff.

● If the note furthest from the middle line is above the middle line, the stem of the chord 
points downwards.

● If the note furthest from the middle line is below the middle line, the stem of the chord 
points upwards.

Stems
Stem direction 
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● If the chord is equally balanced on either side of the middle line of the staff, the stem 
direction is determined by the stem directions of any adjacent notes, beam groups, or 
chords. If they both have the same stem direction, the chord matches them. If the adjacent 
notes, beam groups, or chords have different stem directions, equally balanced chords 
follow the default stem direction.

The default stem direction depends on the instrument type. By default, the stems of notes 
on the middle lines of staves point downwards on instrumental staves and upwards on vocal 
staves, to avoid lyrics.

Beam groups in single voices

The stem direction within beam groups is determined by the balance of notes within the beam 
group that are above/below the middle line of the staff.

● If the majority of notes in the beam group are above the middle line, stems in the beam 
group point downwards.

● If the majority of notes in the beam group are below the middle line, stems in the beam 
group point upwards.

● If the beam group contains an equal number of notes either side of the middle line of the 
staff, the stem direction is determined by the stem directions of any adjacent notes, beam 
groups, or chords. If they both have the same stem direction, the beam group matches 
them. If the adjacent notes, beam groups, or chords have different stem directions, equally 
balanced beam groups follow the default stem direction.

The default stem direction depends on the instrument type. By default, the stems of notes 
on the middle lines of staves point downwards on instrumental staves and upwards on vocal 
staves, to avoid lyrics.

RELATED LINKS
Per-flow notation options for voices on page 1439
Notation Options dialog on page 747
Voice column index on page 1442
Implicit rests in multiple-voice contexts on page 1273
Hiding/Showing voice colors on page 1439
Altered unisons on page 798

Changing the stem direction of notes
You can manually change the stem direction of any note. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose stem direction you want to change. You can do this in Write mode 
and Engrave mode.

NOTE

In Write mode, you can only select whole tie chains. In Engrave mode, you can select 
individual notes within tie chains.

Stems
Stem direction 
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2. Change the stem direction in one of the following ways:

● Choose Edit > Notations > Stem > Force Stem Up.

● Choose Edit > Notations > Stem > Force Stem Down.

TIP

You can also choose these options from the context menu.

RESULT
The stem direction of the selected notes is changed. The selected notes follow this stem 
direction, even if you later change their pitch to one that usually requires a different stem 
direction. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

NOTE

● This does not change the voice to which notes belong.

● You can also change the stem direction of notes by selecting them and pressing F .

EXAMPLE

Stems pointing in the same direction but in different 
voices

Stems in the same direction and in the same voice

RELATED LINKS
Changing the voice of existing notes on page 466
Changing the staff-relative placement of items on page 434
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the default stem direction of voices
You can change the default stem direction of voices after they have been input, including slash 
voices.

NOTE

This changes the implicit stem direction of the voice, but may not change the stem direction of 
all notes in single-voice contexts. Stem directions are automatically changed in Dorico Elements 
when only one voice contains notes.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Stems
Stem direction 
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PROCEDURE

1. Select a note or chord in the voice whose stem direction you want to change. You can do this 
in Write mode and Engrave mode.

2. Change the default stem direction of the selected voice in one of the following ways:

● Choose Edit > Notations > Voices > Default Stems Up.

● Choose Edit > Notations > Voices > Default Stems Down.

TIP

You can also choose these options from the context menu.

Resetting stem directions
You can remove changes to the directions of stems and revert stems to their default directions.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes whose stem direction changes you want to remove. You can do this in Write 
mode and Engrave mode.

2. Choose Edit > Notations > Stem > Remove Forced Stem. You can also choose this option 
from the context menu.

RESULT
All stem direction changes are removed from the selected notes. The stems of the selected notes 
revert to their default directions.

NOTE

Alternatively, you can change the stem direction to the opposite direction. However, notes with 
forced stems do not change automatically if, for example, you later change their pitch.

RELATED LINKS
Resetting beam grouping on page 844
Creating cross-staff beams/tremolos on page 851
Importing MusicXML files on page 82

Stem length
The length of stems is determined by default in Dorico Elements, according to accepted 
standards for the appearance of stems of notes at different positions on staves.

You can lengthen/shorten individual stems in Engrave mode.

Lengthening/Shortening stems
You can lengthen/shorten the stems of individual notes. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

Stems
Stem length 
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PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the stems you want to lengthen/shorten.

2. Lengthen/Shorten the stems by moving the selected stem handles in any of the following 
ways:

● To move them upwards/downwards a standard amount, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Up Arrow  to move handles 
upwards. This moves handles by 1/8 space per press.

● To move them upwards/downwards a large amount, press Ctrl/Cmd  plus the standard 
key command; for example, Ctrl/Cmd-Alt/Opt-Up Arrow . This moves handles by 1 
space per press.

● To move them upwards/downwards a moderate amount, press Shift  plus the standard 
key command; for example, Shift-Alt/Opt-Up Arrow . This moves handles by 1/2 space 
per press.

● To move them upwards/downwards a small amount, press Ctrl/Cmd - Shift  plus the 
standard key command; for example, Ctrl/Cmd-Shift-Alt/Opt-Up Arrow . This moves 
handles by 1/32 space per press.

● Click and drag them upwards/downwards.

RESULT
The selected stems are lengthened/shortened. For example, moving the end of downwards-
pointing stem upwards shortens the stem. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

TIP

Stem adj. in the Notes and Rests group of the Properties panel is activated when you lengthen/
shorten stems.

You can also use this property to lengthen/shorten stems by changing the value in the value 
field. However, the Notes and Rests group is only available when the notehead is selected rather 
than the stem.

Deactivating the property resets the selected stems to their default length.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Hiding/Showing stems
You can hide/show the stems on notes with any notehead design. For example, you might hide 
stems if you do not want to show exact rhythms in an unmeasured passage.

Dorico Elements allows you to hide stems rather than using a stemless notehead design as this 
allows you to hide the stem of any notehead design.

Stems
Hiding/Showing stems 
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the notes whose stems you want to hide.

2. In the Properties panel, activate/deactivate Hide stem in the Notes and Rests group.

RESULT
The stems and any applicable flags of the selected notes are hidden when Hide stem is 
activated, and shown when it is deactivated.

NOTE

● Beams are only hidden when you hide the stems of all notes in beamed groups.

● You can assign a key command for Toggle Hide Stem on the Key Commands page in 
Preferences.

EXAMPLE

Stems shown Stems hidden

RELATED LINKS
Properties panel on page 663
Hiding/Showing zones on page 44
Selecting/Deselecting notes and items individually on page 421
Large selections on page 424
Notehead set designs on page 1053
Inputting notes on page 224
Hiding/Showing noteheads on page 1060
MIDI trigger regions on page 574
Preferences dialog on page 58

Stems
Hiding/Showing stems 
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Harmonics

Harmonics are pitches produced by touching resonating strings at specific positions along their 
length, allowing the corresponding harmonic partial to sound. Harmonics often have a high pitch 
with a glassy, purer sound than stopped pitches. There are two different types of harmonics: 
natural and artificial.

Harmonic partials are numbered according to their order in the harmonic series, which also 
correlates to the node on the string which produces them. For example, the second partial in the 
harmonic series is produced by the node halfway along a string; that is, the node that divides the 
string into two equal parts. The third partial is produced by the node that divides the string into 
thirds, and so on.

Natural harmonics
Natural harmonics are produced by touching an open string at one of its nodes and 
then bowing or plucking the string. The sounding pitch of the resulting harmonic 
varies according to the node and its corresponding partial in the harmonic series. For 
example, touching the node halfway along a string produces the second partial, which 
sounds an octave above the open string pitch.

Artificial harmonics
Artificial harmonics are produced by stopping a string fully (as if playing a normal note) 
and then touching the string at one of the nodes of its stopped length. The sounding 
pitch of the resulting harmonic varies according to the node and its corresponding 
partial in the harmonic series. For example, touching the node that is the equivalent of 
a fourth higher than the stopped pitch produces the fourth partial, which sounds two 
octaves above the stopped pitch.

To produce artificial harmonics, players must both fully stop the string and touch 
the string at the correct node. This can be more difficult to produce than natural 
harmonics.

A passage for violin alternating between artificial 
and natural harmonics on the A string

The sounding pitches of the same passage

Dorico Elements supports multiple conventions for the notation of harmonics on stringed and 
fretted instruments, including for both natural and artificial harmonics. For artificial harmonics 
shown using two noteheads, one normal and one diamond, Dorico Elements automatically 
calculates the correct pitch for the touched pitch diamond notehead for the second to sixth 
harmonic partials. These pitches are reflected in playback, using dedicated sounds for harmonics 
if the corresponding playback device includes them.
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Turning notes into harmonics
You can turn existing notes into artificial and natural harmonics. Harmonics can represent the 
sounding, touched, or stopped pitch.

PREREQUISITE

● You have input the notes you want to turn into harmonics. However, the pitch you should 
input depends on the harmonic type you want to use.

● For natural harmonics, we recommend that you input the desired sounding pitch.

● For artificial harmonics, we recommend that you input the stopped pitch.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes you want to turn into harmonics. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Type in the Harmonics group.

3. Choose one of the following options:

● Artificial

● Natural

RESULT
The selected notes are turned into harmonics of the corresponding type. If the corresponding 
playback device has dedicated sounds for harmonics, the selected notes automatically use those 
sounds. The sounding pitch of artificial harmonics in playback is also changed accordingly.

● Artificial harmonics represent the second partial by default. They are shown with a diamond 
notehead indicating the touched pitch an octave above the selected notes. On tablature, the 
stopped fret is shown on the left and the touched fret is shown on the right in parentheses.

● Natural harmonics represent the sounding pitch by default. They are shown with a circle 
symbol above the selected notes. On fretted instrument notation staves, natural harmonics 
appear as black diamond noteheads. On tablature, the fret of the touched pitch is shown, if it 
can be calculated; if it cannot be calculated, a pink question mark is shown.

EXAMPLE
The following examples show the default appearances of natural and artificial harmonics on 
different staves.

Harmonics
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Artificial 
harmonic on 
notation staff 
(any instrument)

Artificial 
harmonic on 
tablature

Natural 
harmonic on 
non-fretted 
instrument staff

Natural 
harmonic on 
fretted 
instrument 
notation staff

Natural 
harmonic on 
tablature

Natural 
harmonic on 
tablature that 
cannot be 
calculated

AFTER COMPLETING THIS TASK
You can change the partial for harmonics. You can also change the appearance of natural 
harmonics and the style of artificial harmonics.

If you want to turn harmonics back into normal notes, deactivate Type in the Harmonics group.

RELATED LINKS
Inputting notes on page 224
Engrave toolbox on page 503
Appearances/Styles of harmonics on page 1085
Changing music area colors on page 54
Assigning notes to strings on page 1059
Tablature on page 1330

Changing the harmonic partial
By default, harmonics indicate the second partial in the harmonic series, which is an octave 
above the fundamental. You can change the partial for individual harmonics; for example, if you 
want a higher partial instead.

NOTE

Dorico Elements can only correctly calculate artificial harmonic partials for nodes two to six.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the harmonics whose partial you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Partial in the Harmonics group.

3. Change the value in the value field to the node at which the string should be touched to 
produce the partial you want.

Harmonics
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RESULT
The partial of the selected harmonics is changed. For artificial harmonics using the Normal type, 
the pitch of the white diamond notehead/parenthesized fret number is updated automatically. 
The sounding pitch of artificial harmonics in playback is also changed accordingly.

EXAMPLE

Artificial harmonic with default partial

(notation and tablature)

Partial changed to the fifth

(notation and tablature)

Hiding/Showing or parenthesizing harmonic accidentals
You can hide/show individual harmonic accidentals, or show them in round or square brackets, 
independently of hiding/showing or parenthesizing accidentals of stopped pitch notes. For 
example, you can show cautionary accidentals on subsequent notes in tie chains that cross 
system/frame breaks by showing accidentals in round brackets. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the harmonics whose accidentals you want to hide/show or parenthesize. You can do 
this in Write mode and Engrave mode.

NOTE

You can only select individual noteheads within tie chains in Engrave mode.

2. In the Properties panel, activate Accidental in the Harmonics group.

3. Select one of the following options from the menu:

● Hide

● Show

● Round brackets

Harmonics
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● Square brackets

RESULT
Accidentals on the selected harmonics are hidden, shown, or shown in round or square brackets. 
If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

NOTE

● Hiding accidentals does not affect the pitch of notes in playback.

● If you are hiding/showing many accidentals, we recommend that you consider changing the 
accidental duration rule.

● You can assign key commands for Hide Accidental, Show Accidental, Show Accidental in 
Round Brackets, and Show Accidental in Square Brackets on the Key Commands page in 
Preferences.

AFTER COMPLETING THIS TASK
You can also hide/show or parenthesize accidentals on the normal noteheads that indicate the 
stopped pitch for artificial harmonics shown using diamond noteheads.

RELATED LINKS
Hiding/Showing or parenthesizing accidentals on page 793
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Accidental duration rules on page 800
Hiding/Showing or parenthesizing cautionary accidentals on page 801

Appearances/Styles of harmonics
Both artificial and natural harmonics can be notated in different ways. In Dorico Elements, it is 
possible to indicate the desired sounding pitch, either the stopped or touched pitch, or both 
stopped and touched pitches for individual harmonics.

In this documentation we refer to “styles” of artificial harmonics, because one artificial harmonic 
style indicates the use of a different performance technique, and “appearances” of natural 
harmonics, as their different appearances do not indicate different performance techniques.

Natural harmonics

Circle above
Shows a harmonic circle symbol on the notehead side of notes. Usually indicates the 
desired sounding pitch of the harmonic. Used for natural harmonics on staves that do 
not belong to fretted instruments by default, such as violin.

Diamond notehead
Changes the notehead of notes to a diamond notehead. The diamond notehead 
appears black/filled when the note is a quarter note or shorter, and white/unfilled 
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when the note is a half note or longer. Usually indicates the touched pitch required. 
Used for natural harmonics on fretted instrument notation staves by default.

White diamond notehead
Changes the notehead of notes to a diamond notehead that is always unfilled, 
regardless of the duration of notes. Usually indicates the touched pitch required.

On tablature, the touched fret is always shown for natural harmonics, regardless of the selected 
appearance. If the touched fret cannot be calculated, a pink question mark is shown.

Artificial harmonics

Normal
Shows two noteheads: one indicating the stopped pitch, the other the touched pitch. 
The touched pitch is automatically calculated based on the partial; the default partial is 
the second partial. On tablature, the stopped fret is shown on the left and the touched 
fret is shown on the right in parentheses. This is the default appearance of artificial 
harmonics on all staves.

Normal artificial harmonic on notation staff Normal artificial harmonic on tablature

Pinch
Shows two noteheads: one indicating the stopped pitch, the other the sounding pitch. 
The sounding pitch is automatically calculated based on the partial; the default partial 
is the second partial. On tablature, only the stopped fret is shown.

Harmonics
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NOTE

Intended for fretted instruments only. A pinch is produced by the performer catching 
a resonating string at a node near the pick-ups, producing a high-pitched squeal. Also 
known as a “false harmonic” or “squeal”.

Pinch harmonic on notation staff Pinch harmonic on tablature

Single notehead (sounding)
Shows a single notehead indicating the sounding pitch. On tablature, the stopped fret 
is shown on the left and the sounding pitch is shown on the right in parentheses.

Single notehead (sounding) artificial 
harmonic on notation staff

Single notehead (sounding) artificial 
harmonic on tablature

Single notehead (stopped)
Shows a single notehead indicating the stopped pitch. On tablature, the stopped fret is 
shown on the left and the touched fret is shown on the right in parentheses.

Single notehead (stopped) artificial 
harmonic on notation staff

Single notehead (stopped) artificial 
harmonic on tablature

RELATED LINKS
Changing music area colors on page 54

Changing the appearance of natural harmonics
By default, natural harmonics appear as normal noteheads with a circle shown above, which 
indicates the desired sounding pitch. You can change the appearance of natural harmonics 
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individually; for example, to show them as a white diamond notehead to indicate the touched 
pitch.

NOTE

These steps only apply to harmonics with the Natural type.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the natural harmonics whose appearance you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Style in the Harmonics group.

3. Select one of the following options from the menu:

● Circle above

● Diamond notehead

● White diamond notehead

RESULT
The appearance of the selected natural harmonics is changed, including on fretted instrument 
notation staves. The touched pitch shown on tablature is not changed automatically.

NOTE

● Changing the appearance of natural harmonics does not automatically change their notated 
pitch. For example, if you want to change a sounding pitch Circle above harmonic to a 
touched pitch White diamond notehead harmonic, you must also change the pitch of the 
note.

● Dorico Elements automatically assigns natural harmonics with the White diamond 
notehead style to the lowest possible string for that harmonic. You can specify different 
strings if necessary.

● You can change the staff-relative placement of harmonic circle symbols by activating 
Placement in the Harmonics group of the Properties panel and choosing the option you 
want.

RELATED LINKS
Turning notes into harmonics on page 1082
Changing the pitch of individual notes on page 468
Assigning notes to strings on page 1059
Engrave toolbox on page 503
Tablature on page 1330
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Changing the style of artificial harmonics
By default, artificial harmonics appear as two noteheads: one normal, which indicates the 
stopped pitch, and one diamond, which indicates the touched pitch. You can change the style 
of artificial harmonics individually; for example, to indicate pinch harmonics.

NOTE

These steps only apply to harmonics with the Artificial type.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the artificial harmonics whose style you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Style in the Harmonics group.

3. Select one of the following options from the menu:

● Normal

● Pinch

● Single notehead (sounding)

● Single notehead (stopped)

RESULT
The style of the selected artificial harmonics is changed.

NOTE

Pinch indicates the use of a different technique to produce the harmonic.

Harmonics
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Ornaments

Ornaments are markings that indicate multiple notes are played in addition to the notated pitch. 
They are used to decorate music, such as in Baroque music, which is highly decorated with trills 
and other ornaments.

Over time, specific ways of notating how performers should play notes have developed 
and different ornament symbols indicate different patterns of decorative notes. Nonetheless, 
ornaments give some freedom to performers to embellish music in their own way.

In Dorico Elements, the term “ornaments” refers to ornament symbols, including mordents and 
turns, and trill marks.

A phrase containing a turn, short trills, and a trill with extension line

NOTE

Only trills are currently reflected in playback. Playback of other ornaments is planned for future 
versions.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340
Grace notes on page 1002
Positions of ornaments on page 1091
Trills on page 1094
Trills in playback on page 1104

Changing ornament intervals
You can change the intervals of ornaments, both above and below the notated pitch, to 
indicate which pitches are played in the ornament. The intervals of ornaments are indicated 
by accidentals.

For some ornaments, you can only change the interval in one direction. For example, you can 
only change the interval above short trills and below mordents.

NOTE

These steps do not apply to trills.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the ornaments whose interval you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Ornaments group, as appropriate for the selected ornaments:

● Interval above

● Interval below

3. Change the values in the value fields to the intervals you want.

● 0 or 4 and above shows no accidental.

● 1 shows a flat.

● 2 shows a natural.

● 3 shows a sharp.

RESULT
The intervals of the selected ornaments are changed.

NOTE

Some ornaments do not show accidentals either above or below, depending on their type.

EXAMPLE

No accidentals Flats above and below Naturals above and 
below

Sharps above and below

RELATED LINKS
Engrave toolbox on page 503
Trill intervals on page 1097
Changing vibrato bar dip intervals on page 1142

Positions of ornaments
Ornaments, including trills, are placed above the notes to which they apply. They are only placed 
below the staff for down-stem voices in multiple-voice contexts.

Ornaments and trills are positioned outside of slurs by default. Similarly, they are positioned 
further from noteheads than articulations.

The center of ornaments aligns with the center of the notehead to which they apply. Trills are 
aligned differently, as the left side of trill marks aligns with the left edge of the notehead to which 
the trill applies.

Dorico Elements automatically positions ornaments correctly according to their type, and 
attaches them to their notehead.

Ornaments
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You can move ornaments to different rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

You can move ornaments graphically in Engrave mode, but this does not change the rhythmic 
positions to which they are attached.

RELATED LINKS
Trills on page 1094
Hiding/Showing trill marks on page 1094
Moving notes/items rhythmically on page 461
Moving items graphically on page 514

Changing the position of ornaments relative to slurs
Ornaments are positioned outside of slurs by default. You can change the position of ornaments 
relative to slurs individually. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the ornaments whose slur-relative position you want to change.

2. In the Properties panel, activate Slur-relative position in the corresponding group for the 
selected ornaments:

● Ornaments

● Trills

3. Choose one of the following options:

● Inside

● Outside

RESULT
The selected ornaments are positioned either inside or outside of slurs. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

Changing the start position of trills
You can change whether the start position of individual trills is aligned with the notehead or with 
its accidental. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.
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Positions of ornaments 

1092
Dorico Elements 5.1.30



PROCEDURE

1. Select the trills whose start position you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Start position in the Trills group.

3. Choose one of the following options:

● Notehead

● Accidental

RESULT
The start position of the selected trills is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Hiding/Showing trill extension lines on page 1096
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Trills

Trills are fast alternations between two notes, similar to a tremolo, that were a common 
decoration in Baroque, Classical, and Romantic music. Trill marks are usually added to a single 
note, to indicate the performed notes are the notated pitch and the note either a half-step or 
whole step above, and can have extension lines to show the duration of the trill.

A phrase containing multiple trills with extension lines

Because of their legacy as an ornament, many performers interpret trills differently to tremolos: 
some players add more emphasis to the notated pitch in a trill and less on the trilled-to note but 
play both notes equally in tremolos.

The most common trills are to notes a major or minor second above, but it is also possible to 
specify other trill intervals.

In Dorico Elements, you can specify any trill interval, change their appearance on notation staves, 
and hear them in playback.

On tablature, the trilled-to pitch always appears as a parenthesized fret number.

Trills on a notation staff and tablature

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340
Trill intervals on page 1097
Changing the start position of trills on page 1092
Trills in playback on page 1104
Tablature on page 1330
MIDI Import Options dialog on page 85

Hiding/Showing trill marks
You can hide/show trill marks at the start of individual trills. This also hides/shows trill marks on 
all systems on which the trills extend.

PREREQUISITE

● The lower zone is shown.
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills whose trill marks you want to hide/show. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Show trill mark in the Trills group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Trill marks are shown when the checkbox is activated, and hidden when the checkbox is 
deactivated.

When the property is deactivated, trill marks are shown by default.

RELATED LINKS
Trill interval appearance on page 1102
Hiding/Showing trill interval accidentals on page 1098
Hiding/Showing speed changes in trill extension lines on page 1096
Hiding/Showing trill extension lines on page 1096
Engrave toolbox on page 503

Changing the speed of trills
You can indicate different speeds for trills, including indicating a change of speed within a single 
trill, by changing the height and frequency of wiggles in their extension lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills whose speed you want to change. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Trills group:

● Start speed

● End speed

3. Select one of the following options from each property menu:

● Slow

● Normal

● Fast

RESULT
The speed of the selected trills is changed. This affects both the frequency of wiggles in their 
extension lines and their playback speed.

Trills
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If only Start speed is activated, the speed of the whole trill extension line is changed. If only End 
speed is activated, the speed of the end half of the trill extension line is changed.

EXAMPLE

A trill extension line starting slow and ending fast Trill with normal speed throughout

AFTER COMPLETING THIS TASK
You can customize the playback speed of trills individually.

RELATED LINKS
Changing the playback speeds of trills on page 1106
Engrave toolbox on page 503

Hiding/Showing speed changes in trill extension lines
You can hide/show speed changes in the extension lines for individual trills; for example, if you 
want to hear different speeds in playback but show extension lines with consistent wiggles.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills whose speed changes you want to hide/show. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate/deactivate Suppress drawing speed changes in the Trills 
group.

RESULT
Speed changes are hidden when the property is activated, and shown when it is deactivated.

Hiding/Showing trill extension lines
You can hide/show the extension lines of individual trills. You can do this for the current layout 
and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Trills
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PROCEDURE

1. Select the trills whose extension lines you want to hide/show. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate/deactivate Has trill line in the Trills group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Trill extension lines are shown when the checkbox is activated, and hidden when the checkbox is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

When the property is deactivated, trill extension lines are only shown on tied notes by default.

RELATED LINKS
Changing the start position of trills on page 1092
Changing the speed of trills on page 1095
Changing the playback speeds of trills on page 1106
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Trill intervals
Trill intervals tell performers which notes to play and also affect the pitches used in playback in 
Dorico Elements. For example, a trill with a sharp accidental on an E indicates that the performer 
trills between E and F♯, rather than between E and F.

The different accidentals on these trills indicate changes in the trilled-to note.

If you do not specify an interval when inputting a trill, Dorico Elements calculates an appropriate 
interval based on the top note in the voice to which the trill belongs, the current key signature, 
and any accidentals earlier in the bar. For example, inputting a trill on an E♮ in C major produces 
a half-step/minor second trill interval to F♮. If there were a sharp accidental on the F earlier in the 
bar, the trill interval produced is a whole step/major second between the E♮ and F♯.
In open/atonal key signatures, Dorico Elements produces whole step/major second trill intervals 
by default.

You can specify trill intervals when inputting them with the popover, including at different 
noteheads in the same trill, and you can change individual trill intervals after they have been 
input. In 12-EDO, you can describe trill intervals based on their quality, such as major or minor.

When trill intervals do not require a trill interval indicator, they are indicated by signposts. 
However, trill interval signposts are hidden by default.

Trills
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Trills and accidentals

If required, Dorico Elements shows accidentals to clarify trill intervals. Dorico Elements also 
automatically shows accidentals on other notes in the bar if they have different accidentals to 
any upper notes of trills.

By default, trill marks themselves show intervals, unless the upper note is modified by an 
accidental in the key signature. If the upper note has been modified by an accidental earlier in 
the bar, trills always show the interval. If trills modify pitches modified by an accidental in the key 
signature, any subsequent notes of that pitch show the appropriate accidental automatically. Any 
cautionary accidentals required in the current and following bars are also shown automatically.

Microtonal trill intervals

When using other tonality systems than 12-EDO, such as 24-EDO, you must specify trill intervals 
as an interval degree, expressed as the number of staff position steps, and total number of 
octave divisions from the notated pitch. This is because specifying only the interval quality is 
insufficient in such cases.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340
Trill interval appearance on page 1102
Inputting ornaments/trills with the popover on page 346
Ornaments popover on page 341
Signposts on page 450
Changing ornament intervals on page 1090
Changing vibrato bar dip intervals on page 1142

Hiding/Showing trill interval accidentals
You can hide/show accidentals for individual trill intervals; for example, if you want to show the 
accidental for the first note of a trill but hide the accidentals for subsequent notes. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

● In order to show trill interval accidentals, trills must have intervals that require accidentals.

● These steps only hide the accidentals shown in trill intervals, they do not hide auxiliary notes 
or Hollywood-style markings.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the trill intervals, or trill interval signposts whose accidentals you want to hide/show. 
You can do this in Write mode and Engrave mode.
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NOTE

For trills that span multiple notes and have multiple trill interval accidentals, you must select 
each accidental or signpost individually. If you select the whole trill, only the first trill interval 
accidental is changed.

2. In the Properties panel, activate Accidental in the Trills group.

3. Choose one of the following options:

● Hide

● Show

RESULT
Accidentals in the selected trill intervals are hidden when you choose Hide, and shown when 
you choose Show. If the property scope was set to Locally, this change only takes effect in the 
current layout and frame chain.

Signposts are shown at the position of each hidden trill interval accidental. However, trill interval 
signposts are hidden by default.

RELATED LINKS
Changing the appearance of trill intervals on page 1103
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Annotations on page 597
Hiding/Showing signposts on page 450

Changing trill intervals
The default trill interval is a second, either major or minor depending on the context. In addition 
to specifying the interval when inputting trills with the ornaments popover, you can change the 
intervals of trills and existing trill intervals within their duration individually after they have been 
input.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills, trill intervals, or trill interval signposts whose interval you want to change. 
You can do this in Write mode and Engrave mode, but in Engrave mode you must select the 
trill intervals/trill interval signposts.

NOTE

For trills that span multiple notes and have multiple interval changes, you must select each 
trill interval you want to change individually. If you select the trill mark/extension line, only 
the first trill interval is changed.

2. In the Properties panel, activate Interval in the Trills group.
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3. Change the interval degree, expressed as the number of staff position steps, by changing 
the value in the value field.

4. Change the interval quality or total number of octave divisions from the trilled note in one of 
the following ways:

● For trills in 12-EDO, select an interval quality from the menu.

● For trills in other tonality systems, select a total number of octave divisions from the 
menu.

Together, the interval degree and either interval quality or total number of octave divisions 
specify the desired note name and accidental for the trilled-to note.

RESULT
The interval of the selected trill intervals is changed. This applies from the selected trill intervals 
until the next interval change in the trill or the end of the trill, whichever comes first. For 
example, if you selected a trill with no interval changes within its duration, the interval is 
changed for the whole trill.

By default, trill intervals appear as accidentals when the interval is a second and as auxiliary 
notes for all other intervals. Signposts are shown at the position of each trill interval that does 
not require an accidental or auxiliary note. However, trill interval signposts are hidden by default.

RELATED LINKS
Resetting trill intervals on page 1101
Ornaments popover on page 341

Changing trill intervals partway through trills
You can change the intervals of existing trills at any notehead within their duration; for example, 
if you want a trill to change seamlessly from a minor second in one bar to a major second in the 
next.

PROCEDURE

1. In Write mode, select one of the following:

● The note whose trill interval you want to change.

● An item or rest on the staff where you want to specify trill intervals.

2. Start note input in any of the following ways:

● Press Shift-N .

● In the Notes toolbox, click Start Note Input .

● Double-click the staff.

3. Press Right Arrow / Left Arrow  to move the caret according to the current rhythmic grid 
resolution to the notehead where you want to change the trill interval.

NOTE

You can only change trill intervals at noteheads.

4. Open the ornaments popover in any of the following ways:

● Press Shift-O .

● In the Notations toolbox, click Popovers , then Ornaments .

5. Enter the trill interval you want into the popover. For example, enter m3 for a minor third.

Trills
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6. Press Return  to close the popover.

7. Optional: Repeat steps 3 to 6 to change the trill interval at other noteheads in the trill.

8. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
The trill interval is changed at the corresponding noteheads. By default, all trill intervals in the 
trill appear as accidentals when the intervals are all seconds and as auxiliary notes when the trill 
contains at least one trill interval with a different interval.

Signposts are shown at the position of each trill interval that does not require an accidental or 
auxiliary note. However, trill interval signposts are hidden by default.

EXAMPLE

Trill with interval changes shown as accidentals Trill with interval changes shown as auxiliary notes

RELATED LINKS
Changing the appearance of trill intervals on page 1103
Ornaments popover on page 341
Signposts on page 450
Hiding/Showing signposts on page 450
Notes toolbox on page 196
Rhythmic grid on page 217

Resetting trill intervals
You can reset trill intervals to the default trill interval of a second, either major or minor 
depending on the context, including resetting individual trill intervals within a single trill 
independently.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills, trill intervals, or trill interval signposts whose interval you want to reset. You 
can do this in Write mode and Engrave mode, but in Engrave mode you must select the trill 
intervals/trill interval signposts.

Trills
Trill intervals 

1101
Dorico Elements 5.1.30



NOTE

For trills that span multiple notes and have multiple interval changes, you must select each 
trill interval you want to reset individually. If you select the trill mark/extension line, only the 
first trill interval change is reset.

2. In the Properties panel, deactivate Interval in the Trills group.

RESULT
The interval of the selected trill intervals is reset. This applies from the selected trill intervals until 
the next interval change in the trill or the end of the trill, whichever comes first. For example, if 
you selected a trill with no interval changes within its duration, the interval is reset for the whole 
trill.

By default, trill intervals appear as accidentals when the interval is a second and as auxiliary 
notes for all other intervals. Signposts are shown at the position of each trill interval that does 
not require an accidental or auxiliary note. However, trill interval signposts are hidden by default.

RELATED LINKS
Properties panel on page 663
Signposts on page 450

Trill interval appearance
There are different accepted ways to present trill intervals on notation staves, including 
accidental symbols and the Hollywood convention of showing “H.T.” for a half-step (semitone) 
and “W.T.” for a whole step (tone).

In Dorico Elements, trill intervals can appear in the following ways on notation staves:

Accidental
Indicates the trill interval using accidentals positioned above, below, or beside the tr 
mark. This is the default trill interval appearance in Dorico Elements for major or minor 
second trills.

Hollywood-style
Indicates the trill interval using text.

● H.T. for half-step/minor second trills

● W.T. for whole step/major second trills

Auxiliary note
Indicates the trill interval using a small, parenthesized, stemless notehead shown in 
the staff immediately to the right of the first note to which the trill applies, and at the 
correct staff position for the trilled-to pitch.

Trills
Trill interval appearance 

1102
Dorico Elements 5.1.30



Auxiliary notes are used for all trill intervals that are not a major or minor second, but 
are automatically hidden for unison trills if the notehead design of the auxiliary note 
has not been overridden.

NOTE

On tablature, the trilled-to pitch always appears as a parenthesized fret number.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340

Changing the appearance of trill intervals
You can change the appearance of trills with a second interval on notation staves individually; for 
example, if you want to show auxiliary notes on some trills to clarify a change in the trilled-to 
pitch.

NOTE

You can only change the trill interval appearance of trills with a major/minor second interval.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills whose trill interval appearance you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Appearance in the Trills group.

3. Select one of the following options from the menu:

● Accidental

● Hollywood style

● Auxiliary note

RESULT
The appearance of the selected trill intervals on notation staves is changed. This does not affect 
their appearance on tablature.

AFTER COMPLETING THIS TASK
You can change the notehead design of individual auxiliary notes; for example, to show that the 
trilled-to note is a harmonic.

RELATED LINKS
Engrave toolbox on page 503
Changing the notehead design of individual noteheads on page 1058
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Changing the position of trill interval indicators
You can change where trill interval indicators, such as an accidental or W.T. marking, are 
positioned relative to individual trill marks. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

NOTE

This does not affect the position of trill interval accidentals on subsequent notes over which trills 
extend.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the trills whose interval indicator position you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Interval position in the Trills group.

3. Select one of the following options from the menu:

● Above

● Below

● On the right

● Superscript

RESULT
The position of interval indicators relative to the selected trill marks is changed. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Above Below On the right Superscript

RELATED LINKS
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Trills in playback
Dorico Elements plays back trills by using a combination of sampled trills, when available, and 
triggering multiple notes.

● You can find options for trill playback on the Trills page in Playback Options.

Trills
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Dorico Elements can play back sampled half-step (semitone) and whole step (tone) trills 
automatically if these playing techniques are defined in the VST expression map, which is the 
case for a number of instruments in HALion Symphonic Orchestra. For sound libraries that do 
not provide sampled trills, or for intervals beyond a whole step, Dorico Elements generates trills. 
If your project contains some trill intervals that can only be generated, you can disable sampled 
trills and use generated trills throughout to produce a more consistent result.

When playing generated trills, Dorico Elements incorporates grace notes immediately before and 
after trills. A single unslashed grace note on the initial trill note produces an appoggiatura, while 
multiple grace notes on the initial trill note are included in the trill pattern. Grace notes on the 
note immediately following a trill are also included in the trill pattern.

A trill with grace notes at both the start and end

Variable speeds within trills are included in playback. You can determine the default playback 
speeds of slow, normal, and fast trills on the Trills page in Playback Options, and you can 
change the playback speed of individual trills. Additionally, you can hide trill speed changes in trill 
extension lines whilst retaining the speed changes in playback.

In contemporary performance practice, trills are usually performed starting on the written note, 
while in the historical performance practice of the Baroque and Classical eras, trills are usually 
performed starting on the upper (trilled-to) note. You can change the default starting pitch for 
trills individually and by changing the default setting.

Another common performance practice, in particular for Romantic piano music, is to perform all 
trills with an acceleration, starting slowly and getting faster during the trill. You can choose this 
setting on the Trills page in Playback Options. It applies to all trills whose speed has not been 
changed.

RELATED LINKS
Playback Options dialog on page 749
Changing the speed of trills on page 1095
Hiding/Showing speed changes in trill extension lines on page 1096
Changing the starting pitch of trills on page 1107
Playback techniques on page 787
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340

Sampled vs. generated trills
Sampled trills are recorded, looped samples, whereas generated trills are produced by manually 
triggering separate notes.

Because they use fixed sounds, sampled trills typically offer no parameters that allow any kind 
of variation in the trill interpretation, such as different trill speeds or incorporating grace notes 
and termination notes into the pattern of trilled notes. By contrast, generated trills can provide 
greater flexibility but produce a less natural and realistic sound.

If your project contains some trill intervals that can only be generated, you can disable sampled 
trills and use generated trills throughout to produce a more consistent result.

Trills
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Enabling/Disabling trill samples in playback
You can enable/disable the use of sampled trills in your project. This can be useful if your project 
contains some trill intervals that can only be generated and you want to use only generated trills 
throughout, or if you want to incorporate grace notes immediately before/after trills.

NOTE

If you are using NotePerformer for playback, we recommend that you disable sampled trills to 
allow Dorico Elements to send the correct notes and controllers for NotePerformer to produce its 
most realistic trill playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Trills.

3. Choose one of the following options for Playback approach for trills:

● Generated trills only

● Use samples if possible

4. Click Apply, then Close.

RESULT
Sampled trills are enabled when you choose Use samples if possible, and disabled when you 
choose Generated trills only.

Changing the playback speeds of trills
In addition to changing the speed of trills, which changes both the frequency of wiggles in their 
extension lines and their playback speed, you can also change the playback speed of each speed 
variant in individual trills; for example, if you want to make the fastest part of an individual trill 
faster than your default setting.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills whose playback speeds you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate any of the following properties, as appropriate for your 
selected trills:

● Slow trill speed

● Normal trill speed

● Fast trill speed

3. Change the values in the value fields.

Trills
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RESULT
The playback speed of the selected trills is changed. The values in the value fields correspond to 
the number of notes sounding per second.

TIP

You can change the default speeds for each level on the Trills page in Playback Options.

You can also change whether the speed of generated trills follows tempo changes or remains 
constant.

RELATED LINKS
Changing the speed of trills on page 1095
Hiding/Showing speed changes in trill extension lines on page 1096
Engrave toolbox on page 503
Playback Options dialog on page 749

Changing the starting pitch of trills
By default in Dorico Elements, trills start on the lower note, which is usually the written note. 
However, the accepted practice in Baroque and Classical music is to start trills on the upper note. 
You can change the starting pitch of trills individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the trills whose starting note you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Start on upper note in the Trills group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected trills start on the upper note when the checkbox is activated, and on the lower note 
when the checkbox is deactivated.

When the property is deactivated, trills follow your project-wide setting for the starting pitch of 
trills.

TIP

You can change the default starting pitch of all trills project-wide on the Trills page in Playback 
Options.

Trills
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Arpeggio signs

Arpeggio signs are vertical lines that indicate chords are to be played arpeggiated, or “spread”, 
so that the notes in the chord are played very quickly one after another. Arpeggio signs are 
normally shown as vertical wavy lines.

Arpeggiated chords can be played in two directions:

● Upwards, starting from the bottom note in the chord.

● Downwards, starting from the top note in the chord.

It is most common for up arpeggio signs to have nothing at the top end, because chords are 
usually arpeggiated upwards, and for down arpeggio signs to have an arrow at the bottom, 
so these are the defaults in Dorico Elements. However, it is also accepted practice to show up 
arpeggio signs with an arrow at the top if down arpeggio signs are also used in the same piece of 
music.

Arpeggio signs in Dorico Elements automatically span the range of all notes in the voices/staves 
to which they apply.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340
Glissando lines on page 1115
Jazz articulations on page 1145
Lines on page 1194

Types of arpeggio signs
There are different types of arpeggio signs to convey the different arpeggiation directions and 
techniques.

Up arpeggio

A vertical wavy line that indicates chords are to be arpeggiated from the bottom note 
upwards.
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Down arpeggio

A vertical wavy line that indicates chords are to be arpeggiated from the top note 
downwards.

Non arpeggio

A bracket with straight lines that indicates all notes in the chord are to be played 
together, not arpeggiated.

Curved arpeggio

A curved line, similar to a slur but vertical, that some composers use to indicate gentle 
or partial arpeggiation.

You can show both up and down arpeggio signs with one of the following ends in Dorico 
Elements:

● Nothing

● Arrow

● Swash

Up arpeggio sign with nothing at 
the end

Up arpeggio sign with an arrow at 
the end

Up arpeggio sign with a swash at 
the end

Changing the type of arpeggio signs
You can change the type of arpeggio signs after they have been input.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Arpeggio signs
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PROCEDURE

1. Select the arpeggio signs whose type you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, select one of the following options from the Arpeggio type menu in 
the Arpeggios group:

● Non arpeggio

● Up arpeggio

● Down arpeggio

● Up arpeggio (curve)

RESULT
The type of the selected arpeggio signs is changed.

TIP

You can also change the arpeggio type by opening the ornaments popover and changing the 
entry.

Changing the end appearance of arpeggio signs
Down arpeggio signs have an arrowhead at the bottom of the line by default, but up arpeggio 
signs have no arrowhead by default. You can change the appearance of the ends of arpeggio 
signs individually.

NOTE

These steps only apply to up and down arpeggio signs. They do not apply to curved or non 
arpeggio signs.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the arpeggio signs of any direction whose ends you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Sign end in the Arpeggios group.

3. Select the end you want from the menu:

● Nothing

● Arrow

● Swash

RESULT
The appearance of the ends of the selected arpeggio signs is changed.

Arpeggio signs
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EXAMPLE

Up arpeggio sign with nothing at 
the end

Up arpeggio sign with an arrow at 
the end

Up arpeggio sign with a swash at 
the end

Length of arpeggio signs
The length of arpeggio signs is determined by the pitch range of notes in the voices/staves to 
which the arpeggio sign applies. Dorico Elements automatically adjusts the length of arpeggio 
signs if pitches change or you add notes to, or delete notes from, chords.

In Engrave mode, each arpeggio sign has two square handles, one at the top and one at the 
bottom. You can move these handles to adjust the graphical position and length of arpeggio 
signs. For example, you might lengthen an arpeggio sign on a chord with a small pitch range so 
the arpeggio sign is more clearly visible.

RELATED LINKS
Moving items graphically on page 514
Moving notes/items rhythmically on page 461

General placement conventions for arpeggio signs
Arpeggio signs are positioned to the left of the notes, including any applicable accidentals, to 
which they apply, but are positioned between grace notes and normal notes. They should appear 
within the same bar as the notes to which they apply, and not on the other side of the barline.

Dorico Elements makes automatic adjustments to note spacing and staff spacing to 
accommodate arpeggio signs and ensure they are positioned correctly.

Arpeggio signs should cover the whole vertical range of all notes in the chord to which they 
apply, and protrude slightly at each end. However, they do not need to cover the stems of notes. 
Dorico Elements automatically creates the lengths of arpeggio signs to cover the notes in chords, 
and adjusts their lengths if the notes in chords change or are deleted.

If an arpeggiated chord spans two staves, such as in a piano part, its arpeggio sign can extend 
across both staves.

You can move arpeggio signs to different rhythmic positions in Write mode.

You can move arpeggio signs graphically in Engrave mode; however, this does not change the 
rhythmic positions to which they are attached.

Showing arpeggio signs before/after grace notes
You can show arpeggio signs before/after grace notes individually. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains. By default, arpeggio 

Arpeggio signs
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signs are positioned immediately to the left of the notes to which they apply, and so are 
positioned between normal notes and grace notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the arpeggio signs you want to show before grace notes. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate/deactivate Arpeggio before grace notes in the Arpeggios 
group.

RESULT
The selected arpeggio signs are shown before grace notes when the property is activated, and 
after grace notes when the property is deactivated. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503

Arpeggios in playback
You can find options to control the playback of all arpeggios project-wide in the Arpeggio Signs 
section of the Timing page in Playback Options.

For example, you can control the speed of arpeggiation and whether arpeggiation starts on the 
beat or ends on the beat.

You can set a default arpeggio length for wiggly arpeggio signs and curved arpeggio signs 
separately, expressed as a fraction of a quarter note (crotchet) at 120 bpm. It can be helpful to 
set arpeggio lengths using this measurement instead of defining arpeggios as a fraction of their 
notated rhythm, as otherwise arpeggios in very slow music would play back much slower than 
most people intend.

As well as setting a default length for arpeggios, you can also set minimum and maximum values 
for the length of arpeggios, expressed as a fraction of the notated value of the arpeggio. This is 
to ensure all notes with arpeggio signs can be heard within their notated duration.

TIP

You can also use properties in the Arpeggios Playback group of the Properties panel to override 
the default playback options for individual arpeggio signs.

Changing arpeggio playback relative to the beat
You can change whether individual arpeggios are played before their notated position or after 
their notated position, independently of your project-wide settings.

Arpeggio signs
Arpeggios in playback 
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the arpeggio signs whose playback relative to the beat you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Playback position in the Arpeggios Playback group.

3. Choose one of the following options:

● Start on beat

● End on beat

RESULT
The beat-relative position of the selected arpeggios in playback is changed.

TIP

You can change the playback of all arpeggios relative to the beat project-wide on the Timing 
page in Playback Options.

EXAMPLE

Arpeggio starting on the beat Arpeggio ending on the beat

RELATED LINKS
Properties panel on page 663
Playback Options dialog on page 749

Changing the playback duration of arpeggios
You can change the duration of individual arpeggios in playback, independently of your project-
wide settings.

The duration of arpeggios is expressed as a fraction of the notated rhythm of chords. For 
example, an arpeggio on a quarter note (crotchet) chord with a note offset value of 1/2 lasts an 
eighth note (quaver), whereas with a note offset value of 1/8 it lasts a 32nd note.

PREREQUISITE

● The lower zone is shown.

Arpeggio signs
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the arpeggio signs whose playback duration you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Note offset in the Arpeggios Playback group.

3. Change the playback duration of the selected arpeggio signs by changing the value in the 
value field.

4. Press Return .

RESULT
The playback duration of the selected arpeggios is changed. This overrides your project-wide 
settings for the duration of arpeggios for the selected arpeggios.

EXAMPLE

Arpeggiated chord with a note offset value of 1/8 Arpeggiated chord with a note offset value of 1/2

Arpeggio signs
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Glissando lines

Glissando lines indicate a continuous transition between two notes, which can be smooth or 
in chromatic steps. They can have straight lines or wiggly lines, and can be shown with a text 
indication or as a line without text.

Because glissando lines are positioned between noteheads, the steepness of their angle reflects 
the interval between the notes: the steeper the angle, the greater the interval.

There are different conventions regarding the playing techniques for glissando and portamento. 
Some people understand glissando lines to indicate a chromatic scale between the two notes, 
either rising or falling in a series of half-steps (semitones), and portamento lines to indicate a 
smooth, continuous glide between the two notes. However, the terms glissando and portamento 
can be used interchangeably in other cases.

You can input both glissando lines and portamento lines in Dorico Elements, and you can easily 
change their style after they have been input.

Glissando lines in Dorico Elements automatically follow the notes at each end, meaning if you 
change the pitch of either note, the glissando line end positions move accordingly. Dorico 
Elements automatically positions glissando lines so they do not collide with accidentals.

An example glissando line with text shown and a 
wiggly line

An example portamento line with text shown and a 
straight line

Glissando lines can cross system breaks and page breaks. If text is shown for glissando lines that 
span system or page breaks, then that text is shown on every glissando line segment. By default, 
the start and end positions of each segment match the original start and end points of the whole 
glissando line.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340
Changing the style of glissando lines on page 1116
Glissando lines in Engrave mode on page 1119
Arpeggio signs on page 1108
Jazz articulations on page 1145
Fingering slides on page 986
Playing technique continuation lines on page 1186
Lines on page 1194
Changing the pitch of individual notes on page 468
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Glissando lines across empty bars
In Dorico Elements, you can input glissando lines between any two notes, even if there are rests 
or other notes between them, and including between notes in different voices and notes on 
different staves.

For very long glissando lines that extend across multiple bars, you might not want to show 
pitches at the start of each bar; for example, to indicate that performers do not emphasize 
pitches during the course of the glissando, or that performers can play the glissando at their own 
speed. By default, Dorico Elements shows notes or rests in every bar.

To avoid note spacing issues caused by removing rests, we recommend inputting notes in the 
intervening bars, then hiding their noteheads and/or stems.

EXAMPLE

A glissando line across multiple bars with hidden notes between the start/end notes

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340
Hiding/Showing bar rests in empty bars on page 1277
Hiding/Showing noteheads on page 1060
Hiding/Showing stems on page 1079

Changing the style of glissando lines
Glissando lines can be shown as straight lines or wiggly lines. You can change the glissando line 
style of glissando lines individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the glissando lines whose style you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Glissando style in the Glissando Lines group.

3. Choose one of the following options:

● Straight line 

● Wiggly line 

RESULT
The glissando line style is changed for the selected glissando lines.

TIP

● Deactivating Glissando style returns the selected glissando lines to the default style.

Glissando lines
Glissando lines across empty bars 
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● You can also change the glissando style by opening the ornaments popover and changing 
the entry.

RELATED LINKS
Engrave toolbox on page 503
Ornaments popover on page 341
Changing existing items on page 432

Changing glissando line text
You can show individual glissando lines with “gliss.” text, “port.” text, or without text. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

Glissando line text is automatically hidden on staves belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the glissando lines whose text you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Glissando text in the Glissando Lines group.

3. Select one of the following options from the menu:

● Gliss.

● Port.

● No text

RESULT
The text shown on the selected glissando lines is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340

Glissando lines
Changing glissando line text 
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Changing when glissando line text is shown
By default, glissando text is not shown when glissando lines are too short to accommodate the 
text. You can choose to show text on individual glissando lines always, or only if there is sufficient 
space. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

Glissando line text is automatically hidden on staves belonging to fretted instruments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the glissando lines whose setting for when text is shown you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Glissando text shown in the Glissando Lines group.

3. Choose one of the following options:

● Show if sufficient space

● Always show

RESULT
When Show if sufficient space is chosen, glissando line text is not shown if the glissando line is 
too short.

When Always show is chosen, glissando line text is always shown, even if the glissando line 
is short. However, this can cause the glissando line text to collide with other items, such as 
noteheads and stems.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can increase the default gaps between noteheads by changing the default note spacing, 
and between individual noteheads by adjusting note spacing at individual rhythmic positions in 
Engrave mode.

RELATED LINKS
Note spacing on page 507
Changing the default note spacing on page 507
Adjusting note spacing at individual rhythmic positions on page 509

Glissando lines
Changing glissando line text 

1118
Dorico Elements 5.1.30



Glissando lines in Engrave mode
In Engrave mode, each glissando line has two square handles, one at the start and one at the 
end. You can move these handles to adjust the graphical position, length, and angle of glissando 
lines.

You can also move whole individual glissando lines graphically. If glissando lines cross system 
and frame breaks, you can move the glissando line segments on each side of the break 
independently.

Handles on a glissando line in Engrave mode

NOTE

You cannot move glissando lines rhythmically. If you want to change the rhythmic positions of 
glissando lines, you must delete them from their original positions and input new glissando lines 
at the new positions.

RELATED LINKS
Moving items graphically on page 514

Glissando lines in playback
Glissando lines are reflected in playback using either a sequence of notes or a continuous pitch 
bend between the start and end notes for each glissando.

Glissando playback type

In Dorico Elements, there are the following glissando playback types:

Continuous
Glissandos sound as a smooth slide between the start and end pitches for each 
glissando line, using MIDI pitch bend.

The following instrument families use continuous glissando playback by default: brass, 
singers, electronics, and strings.

NOTE

Continuous glissando playback requires the support of the sound library, consecutive 
notes only, and an appropriate pitch range set for the corresponding expression map. 
For example, HALion Symphonic Orchestra only supports a continuous glissando range 
of one whole step (two semitones).

Glissandos use chromatic glissando playback as a fallback if their pitch range is wider 
than is supported, or if the instrument ever plays chords; that is, two or more notes 
simultaneously.

Glissando lines
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Chromatic
Glissandos sound as a sequence of notes, usually a half-step (semitone) apart, between 
the start and end pitches for each glissando line.

● Harp pedal diagrams affect the pitches used in harp glissando playback.

● All other instruments use the 12-EDO chromatic scale, regardless of the current 
tonality system.

Chromatic glissando playback is the default for all instruments that do not use either 
continuous or white notes glissando playback.

White notes
Glissandos sound as a sequence of notes, only comprising natural pitches; that is, the 
pitches represented by white keys on keyboards.

White notes glissando playback is the default for keyboard and pitched percussion 
instruments.

Glissando playback duration

When glissando lines start or end on tie chains, their playback starts from the last notehead and 
ends at the first notehead.

By default, glissandos start sounding halfway through their duration; for tied notes, this is the 
duration of the last notehead in the tie chain. You can change the delay at the start of glissando 
lines in playback.

RELATED LINKS
Harp pedaling on page 1153
Equal Division of the Octave (EDO) on page 1028
Inputting glissando lines with the popover on page 349
Expression Maps dialog on page 762

Changing the glissando playback type
You can change the playback type of individual glissando lines; for example, if you want some 
glissando lines to play back using white notes instead of chromatic notes. By default, Dorico 
Elements automatically selects the glissando playback type according to the instrument family.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the glissando lines whose playback type you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Playback type in the Glissando Lines group.

3. Select one of the following options from the menu:

● Auto

● Continuous

● Chromatic

● White notes

Glissando lines
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● None

Delaying the start of glissandos in playback
You can change the delay at the start of glissandos in playback. By default, glissandos start 
sounding halfway through their duration; for tied notes, this is the duration of the last notehead 
in the tie chain.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the glissando lines whose playback start you want to delay. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Delayed start in the Glissando Lines group.

3. Activate/Deactivate the corresponding checkbox.

4. Optional: If you want to specify exactly how far through the glissando lines playback starts, 
activate Delay and change the value in the value field.

The value represents fractions of a quarter note. For example, 1/2 delays the start of 
glissandos by an eighth note.

RESULT
When the Delayed start checkbox is activated, the selected glissando lines start playing back 
halfway through the duration of the last notehead to which they apply.

When the Delayed start checkbox is deactivated, the selected glissando lines start playing back 
from the beginning of the last notehead to which they apply.

If you also activated Delay, playback of the selected glissando lines follows your set value.

When Delayed start is deactivated, glissando lines follow your project-wide setting for glissando 
line playback.

NOTE

You can change whether all glissando lines project-wide have delayed starts on the Glissando 
Lines page in Playback Options.

RELATED LINKS
Engrave toolbox on page 503
Properties panel on page 663
Hiding/Showing zones on page 44
Playback Options dialog on page 749

Glissando lines
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Guitar bends

The guitar bend is a technique commonly performed on electric guitars, where the performer 
pushes strings out of their normal alignment after notes start to sound. Bending strings tightens 
them, which produces the characteristic pitch fluctuation.

Performing a guitar bend often also involves sustaining the bent pitch before allowing the string 
to return to its natural position and un-bent pitch. In Dorico Elements, these actions are called a 
“guitar bend hold” and “release” respectively.

A phrase containing guitar bends, a guitar bend hold, guitar pre-bends, and releases, shown on both a 
notation staff and tablature

Guitar bends and releases with bend intervals of up to a whole step (tone) are reflected in 
playback.

Guitar bends
Guitar bends indicate that the performer should bend the string after playing a note, 
so that the pitch increases while the note sounds. In Dorico Elements, each guitar bend 
joins two notes: the start pitch and the pitch at the peak of the bend.

On notation staves, guitar bends are notated using an angled line between the 
noteheads at the start and end. On tablature, guitar bends are notated using an 
upwards-pointing curved line with an arrowhead at the top and a bend interval above 
the arrowhead. The fret number of the end note is hidden automatically.

Guitar bend on notation staff Guitar bend on tablature

If you input guitar bends on multiple notes in chords, their arrowheads are 
automatically aligned on tablature.
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Guitar bends on chord on notation staff Guitar bends on chord on tablature

Sequences of consecutive guitar bends are notated as bend runs on tablature. In 
Engrave mode, guitar bend runs function as a group.

Guitar bend runs on tablature

Guitar bend holds
Guitar bend holds indicate that the performer should maintain the pitch at the peak of 
a guitar bend. They are usually shown on tied notes.

On tablature, guitar bend holds are notated using a horizontal line. They are not 
notated on notation staves.

Guitar bend hold on tablature

Releases
Releases indicate that the performer should allow a bent string to return to its natural 
position, which decreases the pitch. In Dorico Elements, each release joins two notes: 
the pitch at the peak of the bend and the end pitch.

On notation staves, releases are notated using an angled line between the noteheads 
at the start and end. On tablature, releases are notated using a downwards-pointing 
curved line with an arrowhead at the bottom and parenthesized fret numbers below 
the arrowhead to indicate the end pitches. The fret number of the start note is hidden 
automatically.

Release on notation staff Release on tablature

Guitar bends
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If you input releases on multiple notes in chords, they are notated with a single 
downwards-pointing curved line on tablature. If the bend intervals are the same for 
all notes, the end pitches are parenthesized together.

Releases on chord on notation staff Releases on chord on tablature

NOTE

● In addition to guitar bends, Dorico Elements supports guitar pre-bends/pre-dives, guitar 
post-bends, vibrato bar dives and returns, and other guitar techniques.

● Because you input releases in the same way as you input guitar bends, in this 
documentation, “guitar bends” refers to both guitar bend and release items in projects.

● Stems, stem flags, and beaming always appear stem-up on tablature in single-voice contexts, 
which means they can collide with guitar bends.

RELATED LINKS
Bend intervals on page 1128
Guitar bends in Engrave mode on page 1131
Guitar techniques on page 1137
Input methods for guitar bends and guitar techniques on page 353
Tablature on page 1330
Hiding/Showing notation staves and tablature on page 1331
Bracketed noteheads on page 1066
String indicators on page 993
Lines on page 1194

Guitar pre-bends and pre-dives
Guitar pre-bends and pre-dives are techniques commonly performed on electric guitars, where 
the performer changes the initial sounding pitch of strings before playing notes, either by 
bending strings to tighten them or using the vibrato bar to loosen them.

A phrase containing a guitar pre-bend with release and multiple guitar pre-dives with release

In Dorico Elements, guitar pre-bends and pre-dives are properties of notes belonging to fretted 
instruments, meaning they only apply to single notes.

Guitar bends
Guitar pre-bends and pre-dives 
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Guitar pre-bends
Guitar pre-bends indicate that the performer should bend the string before playing the 
note to raise the pitch; for example, to repeat a note that was at the end of a previous 
guitar bend. The pitch can then be lowered after starting to sound.

On notation staves, guitar pre-bends are notated using an angled line between the 
noteheads at the start and end. However, unlike guitar bends, the parenthesized 
auxiliary notehead at the start is shown automatically as part of the pre-bend. On 
tablature, guitar pre-bends are notated using a solid vertical line with an arrowhead at 
the top, a bend interval above the arrowhead, and a small fret number below the line 
to indicate the start pitch.

Guitar pre-bend on notation staff Guitar pre-bend on tablature

Guitar pre-dives
Guitar pre-dives indicate that the performer should use the vibrato bar to lower the 
pitch before playing the note. The pitch can then be raised after starting to sound.

On notation staves, guitar pre-dives appear the same as guitar pre-bends. On 
tablature, guitar pre-dives are notated using a dashed vertical line with an arrowhead 
at the top, a bend interval above the arrowhead, and a small fret number below the 
line to indicate the start pitch.

Guitar pre-dive on notation staff Guitar pre-dive on tablature

NOTE

Stems, stem flags, and beaming always appear stem-up on tablature in single-voice contexts, 
which means they can collide with guitar bends.

RELATED LINKS
Guitar pre-bends/pre-dives in Engrave mode on page 1133
Inputting guitar pre-bends/pre-dives on page 355
Tablature on page 1330

Guitar post-bends
The guitar post-bend is a technique commonly performed on electric guitars, where the 
performer pushes strings out of their normal alignment after notes start to sound. Bending 

Guitar bends
Guitar post-bends 
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strings tightens them, which produces the characteristic pitch fluctuation. Microtonal post-bends 
are particularly idiomatic in Blues music.

In Dorico Elements, guitar post-bends are properties of notes belonging to fretted instruments, 
meaning they only apply to single notes. They are notated the same on notation staves and 
tablature, using an upwards-pointing curved line with an arrowhead at the top and a bend 
interval above the arrowhead.

Guitar post-bend on notation staff Guitar post-bend on tablature

Microtonal post-bend on notation staff Microtonal post-bend on tablature

If you input guitar post-bends on multiple notes in chords, their arrowheads are automatically 
aligned. On notation staves, the appropriate number of curved lines is shown according to the 
staff positions of notes in chords.

Guitar post-bends on chord on notation staff Guitar post-bends on chord on tablature

NOTE

Guitar post-bends are not currently reflected in playback. This is planned for future versions.

RELATED LINKS
Guitar post-bends in Engrave mode on page 1134
Inputting guitar post-bends on page 356

Guitar bends
Guitar post-bends 
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Vibrato bar dives and returns
The vibrato bar dive and return is a technique performed on electric guitars with a vibrato bar, 
where the performer uses the vibrato bar to loosen then tighten strings after notes start to 
sound. This produces the characteristic downwards-then-upwards pitch fluctuation.

In Dorico Elements, each vibrato bar dive and return comprises two vibrato bar bend items, 
where the first vibrato bar bend ends on the same note that the second vibrato bar bend starts 
on. Vibrato bar bends each join two notes.

Vibrato bar dives and returns with bend intervals of up to a whole step (tone) are reflected in 
playback.

On notation staves, vibrato bar dives and returns are notated using an angled line between the 
noteheads at the start and end, meaning they appear the same as guitar bends. On tablature, 
vibrato bar dives and returns are notated using two straight lines that form a V and a bend 
interval shown at the point. The fret number of the middle note is hidden and the fret number of 
the end note is parenthesized automatically.

Vibrato bar dive and return on notation staff Vibrato bar dive and return on tablature

Sequences of consecutive vibrato bar bends on notes with the same pitch direction, such as 
E-D-C, are notated on tablature with an additional line protrusion beyond the staff and bend 
interval for each vibrato bar bend.

Consecutive vibrato bar bends on notation staff Consecutive vibrato bar bends on tablature

If you input vibrato bar dives and returns on multiple notes in chords, a single V appears on 
tablature as long as the bend intervals are the same for all notes.

Vibrato bar dive and return on chords on notation 
staff

Vibrato bar dive and return on chords on tablature

Guitar bends
Vibrato bar dives and returns 
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RELATED LINKS
Inputting vibrato bar dives and returns with the popover on page 358
Inputting vibrato bar dives and returns with the panel on page 359
Vibrato bar dives and returns in Engrave mode on page 1135
Vibrato bar techniques on page 1137
Bracketed noteheads on page 1066
Tablature on page 1330

Bend intervals
Bend intervals indicate the amount guitar bends, pre-bends, pre-dives, post-dives, and dives and 
returns change the pitch, expressed in relation to whole steps using text or numbers/fractions. 
Bend intervals appear only on tablature for most types of bends, except for guitar post-bends, 
whose bend intervals also appear on notation staves.

For example, full indicates a whole step guitar bend, pre-bend, or post-bend, 1/2 a half-step, and 
1 1/2 a minor third.

Bend intervals for guitar pre-dives and vibrato bar dives and returns always appear as numbers/
fractions, such as 1 for a whole step vibrato bar dive and return.

Microtonal bend intervals appear as fractions according to the prevailing tonality system, such as 
3/4. Bend intervals for microtonal post-bends appear as 1/4.

EXAMPLE

Guitar bend with whole step 
interval, displayed as full

Guitar pre-bend with 
minor third interval, 
displayed as 1 1/2

Vibrato bar dive and return 
with whole step interval, 
displayed as -1

Guitar post-bend with 
microtonal interval, 
displayed as 1/4

Bend intervals for guitar bends, pre-bends, pre-dives, and post-dives are positioned above the 
arrowhead/line for the corresponding notation. For dives and returns, bend intervals appear at 
the point of the V, either above or below the staff according to the pitch direction of notes in the 
dive and return.

Bend intervals appear only on tablature for guitar bends, pre-bends, pre-dives, and dives and 
returns. They appear on both notation staves and tablature for guitar post-bends.

RELATED LINKS
Tablature on page 1330
Changing vibrato bar dip intervals on page 1142
Input methods for guitar bends and guitar techniques on page 353

Guitar bends
Bend intervals 
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Hiding/Showing guitar bend hold lines
Guitar bend hold lines indicate that the bend should be held for the duration of the note, which is 
usually a tied note. You can hide/show hold lines on guitar bends on tablature.

NOTE

These steps only apply to guitar bends. You cannot show hold lines on pre-bends or releases.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the guitar bends on which you want to hide/show hold lines. You can do this on 
notation staves and tablature in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Show hold in the Guitar Bends group.

RESULT
Hold lines are shown on the selected bends on tablature when Show hold is activated, and 
hidden when it is deactivated.

EXAMPLE

Hold line hidden Hold line shown

Changing the direction of guitar pre-bends/pre-dives
You can change the direction of guitar pre-bends/pre-dives individually. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains. By default, guitar 
pre-bends/pre-dives are positioned on the notehead-side of notes in single-voice contexts. In 
multiple-voice contexts, they are positioned on the stem-side of notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Guitar bends
Hiding/Showing guitar bend hold lines 
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PROCEDURE

1. Select the guitar pre-bends/pre-dives whose direction you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Pre-bend direction in the Guitar Pre-bends group.

3. Choose one of the following options:

● Up

● Down

RESULT
The direction of the selected guitar pre-bends/pre-dives is changed. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

TIP

You can change the direction of guitar bends on notation staves by selecting them and pressing 
F . However, you cannot use this key command for guitar pre-bends/pre-dives.

RELATED LINKS
Changing the staff-relative placement of items on page 434
Changing vibrato bar dip intervals on page 1142
Changing the staff-relative placement of guitar techniques on page 1142
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Hiding/Showing accidentals on guitar pre-bends/pre-dives
You can hide/show accidentals on guitar pre-bends/pre-dives individually; for example, to save 
horizontal space in a layout that also shows the interval clearly on tablature. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the guitar pre-bends/pre-dives whose accidentals you want to hide/show. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Pre-bend accidental in the Guitar Pre-bends group.

3. Choose one of the following options:

● Hide

● Show

Guitar bends
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RESULT
Accidentals on the selected guitar pre-bends are hidden when you choose Hide, and shown 
when you choose Show. This does not affect the interval shown for the selected guitar pre-bends 
on tablature. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Deleting guitar pre-bends, pre-dives, and post-bends
You can remove guitar pre-bends, pre-dives, and post-bends from notes after you have input 
them. However, because guitar pre-bends, pre-dives, and post-bends are properties of notes 
rather than separate items in Dorico Elements, you must select and delete them differently from 
other items.

PROCEDURE

1. In Write mode, select the notes from which you want to remove guitar pre-bends, pre-dives, 
and/or post-bends.

2. Do one of the following:

● To remove guitar pre-bends/pre-dives, deactivate Pre-bend interval in the Guitar Pre-
bends group of the Properties panel.

● To remove guitar post-bends, deactivate Post-bend interval in the Guitar Post-bends 
group of the Properties panel.

RESULT
Guitar pre-bends, pre-dives, and/or post-bends are removed from the selected notes.

RELATED LINKS
Inputting guitar pre-bends/pre-dives on page 355
Inputting guitar post-bends on page 356

Guitar bends in Engrave mode
In Engrave mode, each guitar bend, release, and hold has multiple handles that you can move 
independently to adjust their graphical position and shape on notation staves and tablature 
independently.

On notation staves, guitar bends and releases have three square handles. When you move either 
of the start/end handles, the middle handle also moves to retain its position relative to the 
start/end handles.

Guitar bend handles on notation staff in Engrave mode

Guitar bends and holds

On tablature, guitar bends and holds have the following handles:

Guitar bends
Deleting guitar pre-bends, pre-dives, and post-bends 
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1 Guitar bend start handle

2 Guitar bend middle handle

3 Guitar bend end handle

4 Bend interval handle

5 Hold start handle

6 Hold end handle

Releases

On tablature, releases have the following handles:

1 Release start handle

2 Release middle handle

3 Release end handle

You can move these handles to change the shape of guitar bends and releases, change the 
graphical length and angle of guitar bend holds, and move bend intervals. When you move 
guitar bend end handles, the bend interval also moves to retain its position relative to the end 
handle.

If guitar bends cross system and frame breaks, you can move the guitar bend segment on each 
side of the break independently.

NOTE

● Adjoining guitar bends, such as guitar bend runs or a guitar bend that ends on the same 
note that a return starts on, function as a group. When using the mouse, moving any guitar 
bend in the group upwards/downwards moves all the others. When you move individual 
handles within the group using the mouse, adjacent guitar bends automatically adjust to 
compensate.

When you move individual guitar bends in a group or individual handles using the keyboard, 
this does not affect adjacent guitar bends.

Guitar bends
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● You cannot move whole holds, you must move their handles.

● The following properties in the Guitar Bends group of the Properties panel are activated 
automatically when you move the corresponding guitar bend handle:

● Start offset moves start guitar bend and release handles. X moves them horizontally, Y 
moves them vertically.

● Mid offset moves middle guitar bend and release handles. X moves them horizontally, Y 
moves them vertically.

● End offset moves end guitar bend and release handles. X moves them horizontally, Y 
moves them vertically.

● Interval offset moves guitar bend interval handles. X moves them horizontally, Y moves 
them vertically.

● Hold start offset moves start guitar bend hold handles. X moves them horizontally, Y 
moves them vertically.

● Hold end offset moves end guitar bend hold handles. X moves them horizontally, Y 
moves them vertically.

RELATED LINKS
Moving items graphically on page 514
Bend intervals on page 1128
System breaks on page 633
Frame breaks on page 636
Input methods for guitar bends and guitar techniques on page 353

Guitar pre-bends/pre-dives in Engrave mode
In Engrave mode, each guitar pre-bend/pre-dive has multiple handles that you can move 
independently to adjust their graphical position and shape on notation staves and tablature 
independently.

On notation staves, guitar pre-bends/pre-dives have three square handles. When you move 
either of the start/end handles, the middle handle also moves to retain its position relative to the 
start/end handles.

Guitar pre-bend/pre-dive handles on notation staff in Engrave mode

On tablature, guitar pre-bends/pre-dives have the following handles:

Guitar bends
Guitar bends in Engrave mode 
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Guitar pre-bend handles Guitar pre-dive handles

1 Bend interval handle

2 Guitar pre-bend/pre-dive end handle

3 Guitar pre-bend/pre-dive start handle

You can move these handles to change the shape of guitar pre-bends/pre-dives on notation 
staves, change the graphical length and angle of guitar pre-bends/pre-dives on tablature, and 
move bend intervals. When you move guitar pre-bend/pre-dive end handles, the bend interval 
also moves to retain its position relative to the end handle.

NOTE

● You cannot move whole guitar pre-bends/pre-dives, you must move their handles.

● The following properties in the Guitar Pre-bends group of the Properties panel are activated 
automatically when you move the corresponding guitar pre-bend/pre-dive handle:

● Start offset moves guitar pre-bend/pre-dive start handles. X moves them horizontally, Y 
moves them vertically.

● Mid offset moves guitar pre-bend/pre-dive middle handles. X moves them horizontally, 
Y moves them vertically.

● End offset moves guitar pre-bend/pre-dive end handles. X moves them horizontally, Y 
moves them vertically.

● Interval offset moves guitar pre-bend/pre-dive interval handles. X moves them 
horizontally, Y moves them vertically.

RELATED LINKS
Inputting guitar pre-bends/pre-dives on page 355

Guitar post-bends in Engrave mode
In Engrave mode, each guitar post-bend has multiple handles that you can move independently 
to adjust their graphical position and shape on notation staves and tablature independently.

On both notation staves and tablature, guitar post-bends have the following handles:

Guitar bends
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1 Guitar post-bend start handle

2 Guitar post-bend middle handle

3 Guitar post-bend end handle

4 Bend interval handle

You can move these handles to change the shape of guitar post-bends and move bend intervals. 
When you move guitar post-bend end handles, the bend interval also moves to retain its position 
relative to the end handle.

NOTE

The following properties in the Guitar Post-bends group of the Properties panel are activated 
automatically when you move the corresponding guitar post-bend handle:

● Start offset moves guitar post-bend start handles. X moves them horizontally, Y moves 
them vertically.

● Mid offset moves guitar post-bend middle handles. X moves them horizontally, Y moves 
them vertically.

● End offset moves guitar post-bend end handles. X moves them horizontally, Y moves them 
vertically.

● Interval offset moves guitar post-bend interval handles. X moves them horizontally, Y 
moves them vertically.

RELATED LINKS
Moving items graphically on page 514
Inputting guitar post-bends on page 356

Vibrato bar dives and returns in Engrave mode
In Engrave mode, each vibrato bar dive and return has multiple handles that you can move 
independently to adjust their graphical position and shape.

On notation staves, each vibrato bar dive and vibrato bar return has three square handles that 
you can move independently. When you move either of the start/end handles, the middle handle 
also moves to retain its position relative to the start/end handles.

Vibrato bar dive and return handles on notation staff in Engrave mode

On tablature, vibrato bar dives and returns have the following handles:

Guitar bends
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1 Vibrato bar dive start handle

2 Vibrato bar dive end handle/Vibrato bar return start handle

3 Vibrato bar return end handle

4 Bend interval handle

You can move these handles to change the shape or angle of vibrato bar dives and returns 
and move bend intervals. When you move the vibrato bar dive end handle/vibrato bar return 
start handle with the mouse, both handles move together. When you move the handle using 
the keyboard, by default only the vibrato bar dive end handle moves. The same is true for 
consecutive vibrato bar bends with the same pitch direction.

When you move the vibrato bar dive end handle, the bend interval also moves to retain its 
position relative to the end handle.

If vibrato bar dives and returns cross system and frame breaks, you can move the vibrato bar 
dive and return segment on each side of the break independently.

NOTE

The following properties in the Guitar Bends group of the Properties panel are activated 
automatically when you move the corresponding vibrato bar dive/return handle:

● Start offset moves vibrato bar dive/return start handles. X moves them horizontally, Y 
moves them vertically.

● Mid offset moves vibrato bar dive/return middle handles. X moves them horizontally, Y 
moves them vertically.

● End offset moves vibrato bar dive/return end handles. X moves them horizontally, Y moves 
them vertically.

● Interval offset moves vibrato bar dive/return interval handles. X moves them horizontally, Y 
moves them vertically.

RELATED LINKS
Vibrato bar techniques on page 1137
Input methods for guitar bends and guitar techniques on page 353
System breaks on page 633
Frame breaks on page 636

Guitar bends
Guitar bends in Engrave mode 
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Guitar techniques

The term “guitar techniques” covers a range of techniques typically associated with guitar music, 
such as hammer-ons, pull-offs, and pitch alterations that use the vibrato bar on electric guitars.

RELATED LINKS
Input methods for guitar bends and guitar techniques on page 353
Guitar bends on page 1122
Guitar pre-bends and pre-dives on page 1124
Guitar post-bends on page 1125
Vibrato bar dives and returns on page 1127
Bend intervals on page 1128

Vibrato bar techniques
There are a number of different techniques that can be performed using the vibrato bar 
on electric fretted instruments, typically guitars. In Dorico Elements, the available vibrato bar 
techniques are categorized differently.

Vibrato bar dives
Vibrato bar dives indicate that the performer should use the vibrato bar to lower 
the pitch after playing the note, so that the pitch falls after starting to sound. This 
technique is also known as a “dive bomb”.

In Dorico Elements, you can notate vibrato bar dives using jazz articulations to show 
falling lines to the right of noteheads in combination with a vibrato bar indication.

Vibrato bar scoops
Vibrato bar scoops indicate that the performer should depress the vibrato bar just 
before playing the note and then release the vibrato bar quickly, so that the pitch rises 
after starting to sound.

In Dorico Elements, vibrato bar scoops are properties of notes, meaning they only 
apply to single notes. By default, vibrato bar scoops only appear on notation staves 
and are placed to the left of noteheads on the staff.

Vibrato bar dips
Vibrato bar dips indicate that the performer should use the vibrato bar to lower and 
then raise the pitch by the specified interval after playing the note.

In Dorico Elements, vibrato bar dips are considered ornaments. You can select and 
delete them independently of the notes to which they apply. Vibrato bar dips appear 
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on both notation staves and tablature and are placed above the staff. You can change 
the staff-relative placement of individual vibrato bar dips.

Vibrato bar indications/lines
Vibrato bar indications are text instructions that indicate that the performer should use 
the vibrato bar. When they apply to a range of notes, they typically show dashed lines.

In Dorico Elements, vibrato bar indications/lines are considered playing techniques. 
They show lines when they have duration. You can select and delete them 
independently of the notes to which they apply. You can also change the duration 
line style of vibrato bar lines in the same ways as for playing technique continuation 
lines.

NOTE

Vibrato bar techniques are not currently reflected in playback. This is planned for future versions.

RELATED LINKS
Input methods for guitar bends and guitar techniques on page 353
Inputting guitar pre-bends/pre-dives on page 355
Guitar pre-bends and pre-dives on page 1124
Vibrato bar dives and returns on page 1127
Jazz articulations on page 1145
Ornaments on page 1090
Playing techniques on page 1180
Playing technique continuation lines on page 1186
Playing technique duration on page 1187
Lengthening/Shortening items on page 430
Changing the style of playing technique continuation lines on page 1190
Changing the staff-relative placement of items on page 434
Changing the staff-relative placement of guitar techniques on page 1142

Tapping
Tapping involves performers pressing the strings of fretted instruments strongly enough that the 
corresponding pitch sounds without additional striking. Tapping indications can specify whether 
the performer should use their right or left hand for individual notes. They typically appear as the 
letter T, a plus sign, or a dot.

According to convention, tapping indications for the same hand and for consecutive notes on the 
same string with different pitches are notated alongside slurs that span the tapped phrase. This 
is similar to hammer-ons and pull-offs, except tapping indications appear on every note whereas 
hammer-on and pull-off indications typically appear centered on slurs.

Guitar techniques
Tapping 
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A phrase containing right-hand and left-hand tapping

By default, tapping indications only appear on notation staves and are placed above the staff. 
You can change the staff-relative placement of individual tapping indications.

In Dorico Elements, tapping indications are considered properties of notes. There are the 
following types of tapping indications:

Right-hand tapping
Right-hand tapping indications specify that the performer should tap the string at the 
specified pitch with their right hand. In Dorico Elements, right-hand tapping indications 
appear as the letter T.

Right-hand tapping on notation staff

Left-hand tapping
Left-hand tapping indications specify that the performer should tap the string at the 
specified pitch with their left hand. In Dorico Elements, left-hand tapping indications 
appear as a dot.

Left-hand tapping on notation staff

RELATED LINKS
Inputting tapping on page 366
Changing the staff-relative placement of guitar techniques on page 1142
Moving items graphically on page 514
Fingerings for fretted instruments on page 981

Hammer-ons and pull-offs
Hammer-ons and pull-offs involve performers tapping or plucking the strings of fretted 
instruments with their left hand strongly enough that the corresponding pitch sounds without 
additional striking, producing a legato effect. Ligados are a combination of at least one hammer-
on and one pull-off in a single phrase.

Hammer-ons and pull-offs are notated as the letters H or P, respectively, combined with a slur 
spanning the corresponding notes. Dorico Elements automatically centers hammer-on/pull-off 
indications on slurs. For ligados, each hammer-on/pull-off indication is centered over the range 
of notes in the corresponding direction.

Guitar techniques
Hammer-ons and pull-offs 
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A phrase containing hammer-ons, a pull-off, and a ligado

By default, hammer-ons/pull-offs appear on both notation staves and tablature and are placed 
above the staff. You can change the staff-relative placement of individual hammer-on/pull-off 
indications.

In Dorico Elements, hammer-on/pull-off indications are considered properties of notes.

Hammer-ons
Hammer-ons specify that the performer should tap the string at the specified pitch 
with their left hand without restriking the string. Hammer-ons require at least two 
notes on the same string with an ascending pitch direction, such as C-D. In Dorico 
Elements, hammer-ons appear as a letter H.

Hammer-ons on notation staff
Hammer-ons on tablature

Pull-offs
Pull-offs specify that the performer should pluck the string at the specified pitch with 
their left hand without restriking the string. Pull-offs require at least two notes on 
the same string with a descending pitch direction, such as D-C. In Dorico Elements, 
pull-offs appear as a letter P.

Pull-off on notation staff

Pull-off on tablature

Ligados
Ligados specify that the performer should both hammer on and pull off notes within a 
single phrase. Ligados require at least three notes on the same string with alternating 
pitch directions, such as C-D-C. In Dorico Elements, ligados comprise at least one 
hammer-on and pull-off.

Guitar techniques
Hammer-ons and pull-offs 
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Ligado on notation staff
Ligado on tablature

RELATED LINKS
Inputting hammer-ons/pull-offs on page 364
Changing the staff-relative placement of guitar techniques on page 1142
Moving items graphically on page 514
Fingerings for fretted instruments on page 981

Showing notes as dead notes
You can show individual notes belonging to fretted instruments as dead notes. Dead notes are 
notated with cross noteheads on notation staves and with an X on tablature.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes belonging to fretted instruments that you want to show as dead notes. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Dead note in the Guitar Techniques group.

RESULT
The selected notes are shown as dead notes.

NOTE

This does not currently affect their sound in playback; this is planned for future versions.

EXAMPLE

Normal notes Dead notes

Guitar techniques
Showing notes as dead notes 
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RELATED LINKS
Engrave toolbox on page 503
Inputting notes on tablature on page 242
Bracketed noteheads on page 1066
Tablature on page 1330

Changing vibrato bar dip intervals
You can change the intervals of individual vibrato bar dips. By default, vibrato bar dips have half 
step intervals.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the vibrato bar dips whose interval you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, change the value for Interval above in the Ornaments group.

For example, enter 1 for a half step interval, 2 for a whole step interval, or 3 for a minor third 
interval.

RESULT
The interval of the selected vibrato bar dips is changed.

EXAMPLE

Vibrato bar dip with half step 
interval

Vibrato bar dip with whole step 
interval

Vibrato bar dip with minor third 
interval

RELATED LINKS
Inputting vibrato bar dips with the popover on page 362
Inputting vibrato bar dips with the panel on page 362
Changing ornament intervals on page 1090
Trill intervals on page 1097

Changing the staff-relative placement of guitar techniques
You can show individual tapping, hammer-on, and pull-off indications either above or below the 
staff. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

Guitar techniques
Changing vibrato bar dip intervals 
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose guitar technique staff-relative placement you want to change. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Technique placement in the Guitar Techniques group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of tapping, hammer-on, and pull-off indications on the selected 
notes is changed. If the property scope was set to Locally, this change only takes effect in the 
current layout and frame chain.

TIP

You can change the staff-relative placement of vibrato bar dips and lines by selecting them and 
pressing F .

RELATED LINKS
Changing the direction of guitar pre-bends/pre-dives on page 1129
Moving items graphically on page 514
Changing the staff-relative placement of items on page 434
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Deleting guitar techniques
You can remove vibrato bar scoops and tapping, hammer-on, and pull-off indications from notes 
after you have input them. However, because these guitar techniques are properties of notes 
rather than separate items in Dorico Elements, you must select and delete them differently from 
other items.

PROCEDURE

1. In Write mode, select the notes from which you want to remove guitar techniques.

2. Remove guitar techniques in any of the following ways:

● To remove tapping, hammer-on, and pull-off indications, deactivate Technique in the 
Guitar Techniques group of the Properties panel.

● To remove guitar vibrato bar scoops, deactivate Vibrato bar scoop in the Guitar 
Techniques group of the Properties panel.

Guitar techniques
Deleting guitar techniques 
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RESULT
Tapping, hammer-on, and pull-off indications and/or vibrato bar scoops are removed from the 
selected notes.

Guitar techniques
Deleting guitar techniques 
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Jazz articulations

Jazz articulations in Dorico Elements cover a range of note ornamentations that are idiomatic to 
jazz music, and brass instruments in particular.

Although they are often known as jazz “articulations”, these techniques function more like 
ornaments than articulations because they change the pitch rather than the duration or attack of 
notes. For this reason, they are considered ornaments in Dorico Elements. They are found in the 
Ornaments panel, and you can also input them using the ornaments popover.

Jazz articulations can be shown as a curved line similar to a slur, which is called a “bend” in Dorico 
Elements, and as a straight line, which can be solid, dashed, or wiggly, which is called “smooth” in 
Dorico Elements.

Each note can have a single jazz articulation on each side of it, one before the note and one after. 
Jazz articulations after notes can have different lengths.

The following jazz articulations can be shown before notes:

Plop
An approach into the note from above.

Plop (bend) Plop (smooth)

Scoop/Lift
An approach into the note from below. A bend approach is a scoop, a smooth approach 
is a lift.

Scoop Lift (straight)

The following jazz articulations can be shown after notes:

Doit
A rise in pitch after the note.

Doit (bend) Doit (smooth)

Fall
A lowering of pitch after the note.

1145
Dorico Elements 5.1.30



Fall (bend) Fall (smooth)

Additionally, there are other jazz ornaments commonly used by brass instruments that you can 
add to notes in the same ways as inputting jazz articulations.

If your sound library includes samples for jazz articulations, Dorico Elements loads the required 
samples using playback techniques.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340
Playback techniques on page 787
Glissando lines on page 1115
Arpeggio signs on page 1108
Fingering slides on page 986
Lines on page 1194

Jazz ornaments
Jazz ornaments are notations that are commonly used in jazz music and by brass instruments, 
such as flips and smears, that are positioned outside of the staff rather than beside noteheads 
like jazz articulations.

Jazz ornaments behave more like other ornaments than jazz articulations, in that they are items 
separate from notes, and so can be selected independently of notes in Write mode and added 
to notes in addition to jazz articulations. Because they are so commonly used alongside jazz 
articulations, in Dorico Elements they are also included in the Jazz section of the Ornaments 
panel.

You can input jazz ornaments in the same ways as inputting other ornaments rather than jazz 
articulations.

The following ornaments are considered jazz ornaments in Dorico Elements:

Flip

Smear

Jazz turn/Shake

Bend

NOTE

Jazz articulations are not currently reflected in playback.

RELATED LINKS
Ornaments on page 1090

Jazz articulations
Jazz ornaments 
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Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340

Positions of jazz articulations
In Dorico Elements, jazz articulations are automatically positioned relative to the noteheads to 
which they apply, with any other notations on those notes, such as rhythm dots, accidentals, and 
back notes, automatically considered.

When multiple notes in a chord have a jazz articulation, Dorico Elements considers the best way 
to align them based on how close to the noteheads they can be positioned and how many jazz 
articulations to show in total. Dorico Elements allows a maximum of one jazz articulation per 
space, meaning fewer jazz articulations than noteheads are sometimes shown on cluster chords.

In Engrave mode, each smooth jazz articulation has two square handles, one at the start and one 
at the end. You can move these handles to adjust the graphical position, length, and angle of jazz 
articulations. You can also move whole individual jazz articulations graphically.

Handles on a smooth doit in Engrave mode

NOTE

● You cannot move jazz articulations rhythmically. If you want to change the notes to which 
jazz articulations apply, you must delete them from their original notes and input new jazz 
articulations on the new notes.

● The following properties in the Jazz Articulations group of the Properties panel are 
activated automatically when you move the corresponding smooth jazz articulation handle:

● In far offset moves the start handle of jazz articulations shown before notes; that is, the 
handle further from the note. X moves them horizontally, Y moves them vertically.

● In offset moves the end handle of jazz articulations shown before notes; that is, the 
handle closer to the note. X moves them horizontally, Y moves them vertically.

● Out offset moves the start handle of jazz articulations shown after notes; that is, the 
handle closer to the note. X moves them horizontally, Y moves them vertically.

● Out far offset moves the end handle of jazz articulations shown after notes; that is, the 
handle further from the note. X moves them horizontally, Y moves them vertically.

RELATED LINKS
Input methods for ornaments, arpeggio signs, glissando lines, and jazz articulations on page 340
Moving items graphically on page 514
Deleting jazz articulations on page 1149

Changing the type/length of existing jazz articulations
You can change the type and length of jazz articulations after you have input them; for example, 
if you want to change a smooth doit to a long bend doit. You can specify the type/length of jazz 
articulations when using the Ornaments panel but not when using the ornaments popover.

PROCEDURE

1. In Write mode, select the notes whose jazz articulation you want to change.

Jazz articulations
Positions of jazz articulations 
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2. In the Ornaments panel, click the jazz articulation you want in the Jazz section.

RESULT
The jazz articulation shown on the selected notes is changed.

TIP

You can also change the type/duration of jazz articulations using the In and Out properties in the 
Jazz Articulations group of the Properties panel.

EXAMPLE

Short bend doit Medium bend doit Long bend doit

Changing the line style of smooth jazz articulations
You can change the line style of smooth jazz articulations individually. For example, if you want 
selected smooth falls to have straight lines instead of wavy lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes with smooth jazz articulations whose line style you want to change. You can 
do this in Write mode and Engrave mode.

NOTE

You must select notes with smooth jazz articulations on the same side; for example, only 
select notes with smooth jazz articulations before them.

2. In the Properties panel, select one of the following line styles from the In line style menu 
and/or Out line style menu in the Jazz Articulations group:

● Straight

● Wavy

● Dashed

NOTE

In line style is available when you select notes with smooth jazz articulations before them, 
and Out line style is available when you select notes with smooth jazz articulations after 
them. Both are available when you select notes with smooth jazz articulations on both sides.

Jazz articulations
Changing the line style of smooth jazz articulations 
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RESULT
The line style of the selected smooth jazz articulations is changed.

TIP

You can reset jazz articulations back to their default line style by selecting them and choosing 
Edit > Reset Appearance.

EXAMPLE

Doit smooth with straight line Doit smooth with wavy line Doit smooth with dashed line

Deleting jazz articulations
You can remove jazz articulations from notes after you have input them. However, because jazz 
articulations are properties of notes rather than separate items in Dorico Elements, you must 
select and delete them differently from other items.

PROCEDURE

1. In Write mode, select the notes from which you want to remove jazz articulations.

2. In the Ornaments panel, click Remove in the Jazz section.

RESULT
All jazz articulations are removed from the selected notes.

Jazz articulations
Deleting jazz articulations 
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Page numbers

Page numbers are used to give each page a unique number, and indicate its position relative to 
other pages. Just as in newspapers and books, musical scores and parts use page numbers to 
make sure the music stays in the correct order.

Because you can have multiple flows in a single project in Dorico Elements, you do not need to 
change page numbers manually in most cases. However, if you have separate files that together 
make up a single piece, page number changes are necessary to make sure the page numbers 
continue seamlessly from movement to movement.

In such cases, you can change the default page numbers. For example, if you want to have four 
pages of front matter before the first page of music in the score, but you want the first page of 
music in the score to be shown as page 1, you can insert a page number change on the first page 
of music.

Page numbers are layout-specific in Dorico Elements, meaning you can change the page 
numbers in each layout independently. For example, you can change the page numbers in the 
score but show the default page numbers in the parts.

Page numbers in Dorico Elements use a token to ensure the number is correct.

NOTE

You must have a text frame containing the page number token on every page on which you want 
page numbers to be shown.

Default page templates contain text frames with page number tokens. You can change the 
position of page number text frames in the page template editor, which changes the position of 
page numbers on all pages that use that page template. You can also move page number text 
frames on individual pages.

You can also change the type of number used to show page numbers in each layout. For 
example, if you want the front matter to use Roman numerals but the music pages to use Arabic 
numerals, you can change the type of number together with the page number.

RELATED LINKS
Page templates on page 647
Types of page templates on page 648
Tokens on page 655

Page number paragraph styles
The paragraph style for page numbers controls all aspects of their appearance, including their 
font, size, and horizontal alignment. You can edit the existing page number paragraph style, and 
create additional page number paragraph styles, in the Paragraph Styles dialog.

● You can open the Paragraph Styles dialog by choosing Library > Paragraph Styles.

Dorico Elements offers a single paragraph style for page numbers by default, but you can create 
other paragraph styles for page numbers. For example, if you want page numbers to appear 
bold and centered at the tops of pages in full score layouts but appear italic and on the outer 
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edges of pages in part layouts, you can create a new paragraph style based on the existing Page 
Number paragraph style, but rename it and change the settings.

RELATED LINKS
Paragraph Styles dialog on page 756
Creating paragraph styles on page 758

Changing the page number numeral style
Page numbers can appear as Arabic or Roman numerals. You can change the numeral style of 
page numbers in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose page number numeral style you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Page Setup.

4. In the Page Numbers section, select one of the following options from the Use menu:

● Number

● Roman numeral

5. Click Apply, then Close.

RESULT
The page number numeral style is changed in the selected layouts.

Hiding/Showing page numbers
You can hide/show page numbers in each layout independently, including specifying whether to 
hide/show a page number on the first page. For example, you can show page numbers on every 
page in the score but hide page numbers on the first page in the parts.

NOTE

To show page numbers, there must be a text frame containing the page number token on the 
page. The First page templates in the default page template sets do not contain text frames 
containing page number tokens, so you must add these if you want to show page numbers on 
pages that use these page templates.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show page numbers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

Page numbers
Changing the page number numeral style 
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3. In the category list, click Page Setup.

4. In the Page Numbers section, select one of the following options from the Visibility menu:

● Always shown

● Always hidden

● Not on first page

5. Click Apply, then Close.

RESULT

● If you select Always shown, page numbers are shown on all pages that have a text frame 
containing the page number token in the selected layouts.

● If you select Always hidden, page numbers are hidden on all pages in the selected layouts, 
including on pages that have a text frame containing the page number token.

● If you select Not on first page, page numbers are hidden on the first page in the selected 
layouts, but shown on all other pages that have a text frame containing the page number 
token.

NOTE

Your per-layout setting for whether page numbers are hidden/shown above flow headings 
affects whether page numbers are shown on pages where they are higher on the page than 
flow headings.

RELATED LINKS
Tokens on page 655
Flow headings on page 651
Hiding/Showing information above flow headings on page 611

Hiding/Showing guide page numbers
You can hide/show guide page numbers at the top of every page in page view; for example, to 
make it easier to check the page number of pages that use the First page template. Guide page 
numbers are not printed.

PROCEDURE

● Choose View > Page Numbers.

RELATED LINKS
Switching to galley/page view on page 50
Hiding/Showing guide bar numbers on page 829
Types of page templates on page 648

Page numbers
Hiding/Showing guide page numbers 
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Harp pedaling

Harp pedaling is a broad term that covers the specific requirements for notating music for harps. 
This primarily involves harp pedal diagrams, which are often necessary due to the way in which 
modern concert harps change their tuning.

A passage with a full harp pedal diagram at the start and two subsequent partial pedal changes

Harps have seven strings in each octave, one for each diatonic pitch C-B, unlike pianos, which 
have twelve keys in each octave, one for each half-step (semitone) degree between C-B. 
Therefore, harps have a mechanical action to change their tuning that includes seven pedals, 
with each pedal controlling the pitch of the corresponding note in all octaves. These pedals are 
organized into two groups, one for each foot: three pedals for the left foot and four pedals for 
the right foot.

Each harp pedal has three possible positions:

1. Flat or highest position: lowers the pitch of the corresponding note by a half-step

2. Natural or middle position

3. Sharp or lowest position: raises the pitch of the corresponding note by a half-step

NOTE

The lowest two harp strings, C and D, are not affected by the C and D pedal positions.

There are different ways to notate the pedal settings required for a piece of music or a passage 
within a piece. In Dorico Elements, you can show harp pedaling in the following ways:

Diagram

Indicates the physical positions of the seven pedals. The vertical line represents the 
split between left-foot and right-foot pedals and the horizontal line represents the 
natural position.

● Pedals below the horizontal line indicate sharpened notes.

● Pedals above the horizontal line indicate flattened notes.

1153
Dorico Elements 5.1.30



Note Names

Indicates the required accidentals for the seven diatonic pitches, arranged in two lines. 
Right-foot pedals are shown on top and left-foot pedals are shown below.

Any pitches that you input that do not fit with the current harp pedal diagram are considered out 
of range, and appear red when colors are shown for notes that are out of range. If you do not 
input any harp pedaling, Dorico Elements assumes all harp pedals are in their natural setting, as 
they would be for C major.

In Dorico Elements, you can input harp pedal diagrams using the playing techniques popover 
and you can automatically generate accurate harp pedal diagrams based on an entire flow or a 
specific passage of music. However, you can only input and show harp pedal diagrams on staves 
belonging to harp instruments; if you copy material from harp staves to other instruments, harp 
pedaling is automatically removed.

By default, harp pedaling is hidden in full score/custom score layouts and shown in part layouts. 
In layouts where harp pedaling is hidden, harp pedal diagrams are indicated by signposts. 
You can hide/show harp pedaling in each layout independently and hide individual harp pedal 
diagrams in layouts where harp pedaling is shown. You can also determine when to show partial 
harp pedaling, such as when only a single pedal must be changed at one time.

Harp pedal diagrams in Dorico Elements affect the pitches played back in glissando lines.

RELATED LINKS
Inputting harp pedal diagrams with the popover on page 379
Inputting harp pedal diagrams with the panel on page 380
Calculating harp pedal diagrams based on existing music on page 381
Hiding/Showing colors for notes out of range on page 1064
Glissando lines in playback on page 1119

Changing the appearance of harp pedal diagrams
Harp pedaling can be shown as a diagram or using note names. You can change the appearance 
of harp pedal diagrams individually. You can do this for the current layout and frame chain only, 
or for all layouts and frame chains.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the harp pedal diagrams whose appearance you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Appearance in the Harp Pedals group.

3. Choose one of the following options:

Harp pedaling
Changing the appearance of harp pedal diagrams 
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● Diagram

● Note Names

RESULT
The appearance of the selected harp pedal diagrams is changed in the current layout. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

TIP

You can change the default appearance of harp pedaling in each layout independently in Layout 
Options > Players > Harp Pedaling.

EXAMPLE

Harp pedaling shown as a diagram

Harp pedaling shown using note names

RELATED LINKS
Layout Options dialog on page 745
Engrave toolbox on page 503
Changing the property scope on page 665

Hiding/Showing harp pedaling in layouts
You can input and calculate harp pedaling in any layout, but by default harp pedaling is not 
shown in full score layouts, as they are usually only useful for the performer. You can hide/show 
harp pedaling in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show harp pedaling.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Harp Pedaling section, activate/deactivate Show harp pedaling.

5. Click Apply, then Close.

RESULT
Harp pedaling is shown in the selected layouts when the checkbox is activated, and hidden when 
the checkbox is deactivated.

In layouts where harp pedaling is hidden, harp pedal diagrams are indicated by signposts.

Harp pedaling
Hiding/Showing harp pedaling in layouts 
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NOTE

● You can hide individual harp pedal diagrams in layouts where harp pedaling is shown, but 
you cannot show individual harp pedal diagrams in layouts where harp pedaling is hidden.

● You can hide/show harp pedaling signposts by choosing View > Signposts > Harp Pedals.

Hiding/Showing harp pedal diagrams individually
You can hide/show individual harp pedal diagrams in layouts in which harp pedaling is shown. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In the music area, open the layout in which you want to hide/show individual harp pedal 
diagrams. You can do this in Write mode and Engrave mode.

2. Select the harp pedal diagrams you want to hide, or the signposts of harp pedal diagrams 
you want to show.

3. In the Properties panel, activate/deactivate Hide in the Harp Pedals group.

RESULT
The selected harp pedal diagrams are hidden when Hide is activated, and shown when it is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Signposts are shown at the position of each hidden harp pedal diagram. However, signposts are 
not printed by default.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Signposts on page 450
Annotations on page 597

Hiding/Showing borders on harp pedal diagrams
You can hide/show borders on individual note name harp pedal diagrams. For example, on 
systems with very tight vertical spacing, hiding borders on harp pedal diagrams can give you a 
little extra space.

NOTE

These steps only apply to harp pedal diagrams using note names.

Harp pedaling
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PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the note name harp pedal diagrams on which you want to hide/show borders. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate Border in the Harp Pedals group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Borders are shown on the selected note name harp pedal diagrams when the checkbox is 
activated, and hidden when the checkbox is deactivated.

EXAMPLE

Note name harp pedal diagram with border hidden Note name harp pedal diagram with border shown

Changing the thickness of harp pedal diagram borders
You can change the thickness of borders on individual note name harp pedal diagrams.

NOTE

These steps only apply to harp pedal diagrams using note names.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the note name harp pedal diagrams whose border thickness you 
want to change.

2. In the Properties panel, activate Border thickness in the Harp Pedals group.

Harp pedaling
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3. Change the value in the value field.

RESULT
The thickness of borders on the selected harp pedal diagrams is changed.

RELATED LINKS
Paragraph Styles dialog on page 756

Changing the padding around harp pedal diagrams
You can change the padding around harp pedal diagrams individually, and for each edge 
independently. This affects the distance between harp pedal diagrams and erased backgrounds 
and borders. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the harp pedal diagrams whose padding you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Harp Pedals group:

● Left padding

● Right padding

● Top padding

● Bottom padding

3. Change the values in the value fields.

RESULT
The padding around the selected harp pedal diagrams is changed. Increasing the values 
increases the padding, decreasing the values decreases the padding. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665

Positions of harp pedal diagrams
By default, harp pedal diagrams are centered vertically between the two staves usually shown for 
harps.

You can move harp pedal diagrams to different rhythmic positions in Write mode. They are 
automatically positioned to avoid collisions.

Harp pedaling
Positions of harp pedal diagrams 
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You can move harp pedal diagrams graphically in Engrave mode, but this does not change the 
rhythmic positions to which they are attached.

RELATED LINKS
Moving notes/items rhythmically on page 461
Moving items graphically on page 514

Partial harp pedaling
Partial harp pedal diagrams only show the notes whose pedal setting must change at that 
position, rather than showing the required settings for all pedals. This can make those changes 
immediately clear to the performer, as they have fewer pedals to read.

Partial pedal diagrams for a sequence containing several quick pedal changes

You can allow partial harp pedaling for individual harp pedal diagrams and you can set a 
maximum threshold of pedal changes at a single position, above which all harp pedal diagrams 
must show all pedals. This is because performers are used to the pattern of note names in 
complete harp pedal diagrams, and if there are many changes in a partial harp pedal diagram, 
this can be harder to read than a complete one.

By default, Dorico Elements shows notes in partial harp pedal diagrams on two lines with right-
foot pedals on top and left-foot pedals below.

NOTE

Only harp pedal diagrams using note names can be shown as partial.

Allowing/Disallowing partial harp pedaling
You can allow/disallow partial harp pedaling for individual note name harp pedal diagrams. The 
default setting in Dorico Elements is to allow partial harp pedaling for up to three pedal changes. 
You can do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

● These steps only apply to harp pedal diagrams using note names.

● Harp pedal diagrams positioned at the very beginning of a flow can only appear as full harp 
pedal diagrams.

PREREQUISITE

● Harp pedaling is shown in the current layout.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Harp pedaling
Partial harp pedaling 
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● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the note name harp pedal diagrams for which you want to allow/disallow partial harp 
pedaling. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Partial pedaling in the Harp Pedals group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Partial harp pedaling is allowed for the selected note name harp pedal diagrams when the 
checkbox is activated, and disallowed when the checkbox is deactivated. If the property scope 
was set to Locally, this change only takes effect in the current layout and frame chain.

EXAMPLE

Harp pedal diagram showing all pedals Partial harp pedal diagram

RELATED LINKS
Hiding/Showing harp pedaling in layouts on page 1155
Inputting harp pedal diagrams with the popover on page 379
Engrave toolbox on page 503
Changing the property scope on page 665

Harp pedaling
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Pedal lines

Pedal lines indicate to performers which piano pedals to use, and can also give performance 
instructions, such as how far down to depress the pedals and when to lift the pedal to clear the 
resonance.

Most pianos have either two or three pedals. These pedals are:

Sustain pedal
The sustain pedal controls the dampers on the piano strings, which is why it is also 
known as the “damper pedal”. It is also the most commonly used pedal. Depressing the 
sustain pedal removes the dampers, allowing the strings to resonate longer. Sustain 
pedals are usually on the right.

Sostenuto pedal
The sostenuto pedal only allows the strings of the notes currently depressed on the 
keyboard to resonate. It is also known as the “middle pedal” as it is usually in the 
middle of the other pedals.

Una corda pedal
The una corda pedal shifts the action inside the piano so that the hammers hit fewer 
strings than normal. Historically, this caused hammers only to hit one string, not the 
usual three, which is where the name comes from. Because this reduces the volume 
and impact of the sound, it is also known as the “soft pedal”.
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Dorico Elements offers comprehensive notational and playback support for piano pedal lines. 
You can create pedaling for the sustain, sostenuto, and una corda pedals, with support for 
modern sustain pedaling techniques, including changing the pedal level over the course of a 
single pedal instruction.

You can change the appearance of pedal lines, including changing their start sign and 
continuation type. For example, if you want to show some pedal lines with a continuation line 
and some only with a sign at the end.

In Dorico Elements, pedal lines are considered playing techniques because they alter the sound 
produced by the instrument. Therefore, pedal lines are included in the Playing Techniques panel 
in Write mode and you can input them using the playing techniques popover. However, pedal 
lines have additional, unique requirements that do not apply to other playing techniques, such as 
retakes, pedal level changes, start signs, end signs, and continuation lines.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367
Pedal line start signs, hooks, and continuation lines on page 1171
Text pedal line signs on page 1176
Pedal lines in playback on page 1178
Playing technique continuation lines on page 1186
Lines on page 1194
MIDI Import Options dialog on page 85

Sustain pedal retakes and pedal level changes
Pedal retakes indicate where a player should lift the sustain pedal, which dampens the piano’s 
strings and clears the resonance, before depressing the pedal again. Pedal level changes indicate 
a change to how far the pedal is depressed.

Dorico Elements provides clear representations of pedal retakes and level changes for pedal lines 
with the line continuation type.

NOTE

● In Dorico Elements, you cannot input pedal level changes. However, pedal level changes are 
shown if you import or open a project that contains them, and you can remove them in the 
same way as removing retakes.

● You can only add pedal retakes to sustain pedal lines.

EXAMPLE

1 Ped. glyph

2 Retake

3 One quarter depressed

4 Half depressed

5 Three quarters depressed

Pedal lines
Sustain pedal retakes and pedal level changes 
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6 Fully depressed

7 Line end hook

RELATED LINKS
Changing the pedal line continuation type on page 1173
Positions of pedal lines on page 1167
Removing retakes and pedal level changes on page 1167
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367

Sustain pedal lines in Engrave mode
When you select sustain pedal lines in Engrave mode, handles appear at the start/end of each 
pedal line, and on any retakes or pedal level changes on the line. These handles allow you to 
move each part of the pedal line independently, and to change the pedal levels at the start, end, 
and at each retake or pedal level change.

A sustain pedal with a retake in Engrave mode

There are two handles for the start of the pedal line, three for retakes and pedal level changes, 
and three for the end of the pedal line.

NOTE

● Pedal levels cannot be lower than 0 or higher than 1, as shown in properties in either the 
Pedal Lines group or the Pedal Line Retakes group of the Properties panel.

● 1 is fully depressed.

● 0 is not depressed.

● Sostenuto and una corda pedal lines only have a single handle at their start/end, which allows 
you to move their start/end positions graphically, but only horizontally.

Start of sustain pedal lines

There are two handles at the start of pedal lines.

● The left handle moves the start point of the pedal line. You can move this handle to the 
right/left.

● The right handle changes the start pedal level of the pedal line. You can move this handle 
upwards/downwards. This changes the angle of the pedal continuation line in relation to the 
next retake or pedal level change, or the end of the pedal line.

Pedal lines
Sustain pedal retakes and pedal level changes 
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Pedal level changes and retakes

● The left handle changes the pedal level before the retake or pedal level change. You can 
move this handle upwards/downwards.

● The right handle changes the pedal level after the retake or pedal level change. You can 
move this handle upwards/downwards.

● The bottom handle corresponds to the position of the retake or pedal level change. You can 
move this handle to the right/left.

End of sustain pedal lines

● The top handle changes the hook length. You can move this handle upwards/downwards.

● The right handle changes the pedal level at the end of the pedal line. You can move this 
handle upwards/downwards.

● The bottom handle moves the end point of the pedal line. You can move this handle to the 
right/left.

RELATED LINKS
Pedal line start signs, hooks, and continuation lines on page 1171
Moving items graphically on page 514

Changing the type of pedal line retakes
You can change existing retakes on sustain pedal lines to pedal level changes and vice versa.

For example, if you do not want the pedal to be released completely between the old and new 
levels, change the type to Change Level instead of Retake.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the retake or pedal level change whose type you want to change.

2. In the Properties panel, activate Retake type in the Pedal Line Retakes group.

3. Choose the type you want from the following options:

● Retake

● Change Level

RESULT
The type of pedal line retake is changed.

Pedal lines
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NOTE

The appearance of the new type of pedal line retake depends on the pedal levels already set on 
each side. For example, a retake notch is only shown on one side of the retake if the pedal level 
on the other side is set to 0.

Changing the global level for pedal lines
You can change the global level for individual sustain pedal lines and show the level as a prefix 
before the pedal line start sign, such as “1/2 Ped.”. For example, to indicate a pianist should only 
half depress the sustain pedal throughout a piece.

By default, the global level of sustain pedal lines is fully depressed.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the pedal lines whose global level you want to change.

2. In the Properties panel, activate Global level in the Pedal Lines group.

3. Select one of the following options from the menu:

● 1/8

● 1/4

● 1/2

● 3/4

RESULT
The global level for the selected pedal lines is changed and the selected level appears as a prefix 
before their start signs.

NOTE

Level prefixes do not appear for pedal lines with hook start signs.

EXAMPLE

Pedal line with default fully depressed pedal level Pedal line with half depressed pedal level

Pedal lines
Sustain pedal retakes and pedal level changes 
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RELATED LINKS
Pedal line start signs, hooks, and continuation lines on page 1171
Changing the start sign appearance of pedal lines on page 1171

Changing pedal line levels
You can change the level at the start and end of individual sustain pedal lines, and at each retake 
or pedal level change. For example, if you want to specify how far to depress the pedal at specific 
rhythmic positions.

NOTE

You can only change the level of pedal lines with the line continuation type.

PREREQUISITE
Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select any of the following handles on each pedal line whose pedal line 
levels you want to change:

● To change the start pedal level, select the right handles on start signs.

● To change the pedal level immediately before retakes/level changes, select the left 
handle of retakes/level changes.

● To change the pedal level immediately after retakes/level changes, select the right 
handle of retakes/level changes.

● To change the end pedal level, select the right handles on end hooks.

2. Move the handles in any of the following ways:

● To move them upwards, press Alt/Opt-Up Arrow .

● To move them downwards, press Alt/Opt-Down Arrow .

● To snap the level to 0 (not depressed), press Ctrl/Cmd-Alt/Opt-Up Arrow .

● To snap the level to 1 (fully depressed), press Ctrl/Cmd-Alt/Opt-Down Arrow .

● Click and drag the handles upwards/downwards to the level you want.

RESULT
The pedal levels at the selected positions on the corresponding pedal lines are changed.

TIP

The following properties in the Pedal Lines group of the Properties panel are activated when you 
change the corresponding pedal line level:

● Start level

● Start level at retake

● End level at retake

● End level

You can also use these properties to change the pedal line level at the corresponding positions 
by changing the values in the value fields. For example, 1 is fully depressed and 0 is not 
depressed.

Pedal lines
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Deactivating the properties resets the selected pedal lines to their default pedal line levels.

RELATED LINKS
Engrave toolbox on page 503
Changing the pedal line continuation type on page 1173

Removing retakes and pedal level changes
You can remove pedal retakes and level changes without deleting the sustain pedal line or 
changing its rhythmic position.

PROCEDURE

1. In Write mode, select an item on each staff and at each rhythmic position where you want to 
remove retakes or pedal level changes.

2. Remove the retakes or pedal level changes in any of the following ways:

● Open the playing techniques popover, enter nonotch into the popover, then press 
Return .

NOTE

nonotch must be spelled as one word, without a space.

● Choose Edit > Notations > Pedal Lines > Remove Retake. You can also choose this 
option from the context menu.

RESULT
The retakes or pedal level changes at each selected rhythmic position on each selected staff are 
removed. The corresponding sustain pedal lines return to their previous levels as set by either 
the start of the pedal line, or the retake or pedal level change immediately preceding the ones 
you removed.

RELATED LINKS
Playing techniques popover on page 367
Adding retakes with the popover on page 377
Adding retakes with the panel on page 378
Merging pedal lines on page 1170

Positions of pedal lines
The default placement of pedal lines is below the bottom staff, even if there are only notes in the 
upper staff for the right hand. They are placed outside all other notations, including octave lines, 
slurs, and articulations.

If one pedal is used, it is placed as close to the bottom of the staff as possible, while remaining 
outside of all other notations.

If multiple pedals are used simultaneously, they are organized below the bottom of the staff as 
follows:

1. Sustain pedal: closest to the staff

2. Sostenuto pedal: below the sustain pedal line

3. Una corda pedal: furthest from the staff

Pedal lines
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The beginning of the glyph/text that indicates the start position of pedal lines aligns with the 
note to which it applies. If you are using a line end hook to indicate the end of pedal lines, the 
hook aligns with the note or rhythmic position to which it applies.

You can move pedal lines to different rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

NOTE

You cannot move retakes rhythmically. You must remove them and input a new retake at the 
position you want.

You can move pedal lines graphically in Engrave mode. However, this does not change the 
rhythmic positions to which they are attached. You can move multiple pedal lines together, but 
only upwards/downwards. Similarly, you can move handles on multiple pedal lines together, but 
only to the right/left.

RELATED LINKS
Text pedal line signs on page 1176
Pedal line start signs, hooks, and continuation lines on page 1171
Sustain pedal retakes and pedal level changes on page 1162
Moving items graphically on page 514
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367

Changing the position of pedal lines relative to grace notes
You can change the start/end positions of individual pedal lines relative to grace notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the pedal lines whose position relative to grace notes you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate any of the following properties in the Pedal Lines group:

● Starts before grace notes

● Ends before grace notes

3. Activate/Deactivate the corresponding checkboxes.

RESULT
When the checkboxes are activated, the corresponding parts of the selected pedal lines are 
positioned before grace notes.

When the checkboxes are deactivated, the corresponding parts of the selected pedal lines are 
positioned after grace notes.

Pedal lines
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TIP

You can adjust the precise position of pedal lines in further detail in Engrave mode.

EXAMPLE

Pedal line starting/ending before grace notes Pedal line starting/ending after grace notes

Splitting pedal lines
You can split sustain pedal lines at any rhythmic position with an existing item along their length 
into two separate pedal lines.

NOTE

These steps only apply to sustain pedal lines.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select an item on the staff and at the rhythmic position where you want to split the sustain 
pedal line. You can do this in Write mode and Engrave mode.

NOTE

You can only split pedal lines on one staff at a time.

2. Choose Edit > Notations > Pedal Lines > Split Pedal Line. You can also choose this option 
from the context menu.

RESULT
The pedal line on the selected staff is split at the selected rhythmic position.

Pedal lines
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EXAMPLE

A single pedal line The pedal line after being split into two

AFTER COMPLETING THIS TASK
You can move, lengthen/shorten, and edit both pedal lines independently.

RELATED LINKS
Engrave toolbox on page 503
Moving notes/items rhythmically on page 461
Selecting/Deselecting notes and items individually on page 421
Pedal line start signs, hooks, and continuation lines on page 1171
Changing the pedal line continuation type on page 1173
Text pedal line signs on page 1176
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367

Merging pedal lines
You can merge existing sustain pedal lines together; for example, if you want to fill in a gap 
between two sustain pedal lines.

NOTE

These steps only apply to sustain pedal lines.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the sustain pedal lines on the same staff that you want to merge together. You can do 
this in Write mode and Engrave mode.

NOTE

You can only merge pedal lines on one staff at a time.

2. Choose Edit > Notations > Pedal Lines > Merge Pedal Lines. You can also choose this 
option from the context menu.

RESULT
The selected pedal lines are merged together into a single pedal line.

For sustain pedal lines with line continuation types, retakes are added at the start position of 
each merged pedal line.
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Pedal line start signs, hooks, and continuation lines
Pedal lines normally comprise a start sign, a continuation line, and an end hook. This indicates 
clearly to performers where to depress each type of pedal, how long to keep it depressed, and 
where to lift it.

1 Start sign

2 Continuation line

3 End hook

In Dorico Elements, you can change the appearance of each part of pedal lines individually; for 
example, if you want the start sign of an individual pedal line to show text instead of a glyph.

You can select whole pedal lines in Write mode and change most aspects of their appearance 
according to the type of pedal line, such as their continuation line or start sign.

For sustain pedals only, you can select each segment of a sustain pedal independently in Engrave 
mode, and set different properties for each segment. Sustain pedal lines have independent 
segments on each separate system on which they appear.

RELATED LINKS
Sustain pedal lines in Engrave mode on page 1163
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367

Changing the start sign appearance of pedal lines
You can change the appearance of the start of pedal lines individually. Pedal line start signs can 
be shown as variations of the traditional pedal line glyph, other symbols, or text.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the pedal lines whose start sign appearance you want to change. You can do this in 
Write mode and Engrave mode.

NOTE

The pedal lines you select must be the same type; for example, only sustain pedal lines.

2. In the Properties panel, activate Sign appearance in the Pedal Lines group.

3. Select one of the options from the menu.

The options are different according to the type of pedal line selected.
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RESULT
The start sign appearance of the selected pedal lines is changed.

TIP

● The end signs of una corda pedal lines automatically match their start signs.

● Deactivating Sign appearance returns the selected pedal lines to your default setting for 
start sign appearance.

EXAMPLE

Sustain 
pedal lines

Ped. Glyph Ped Glyph P Glyph Symbol Ped. Text Hook

Sostenuto 
pedal lines

Sost. Glyph S Glyph Symbol Sost. text Sostenuto 
text

Una corda 
pedal lines

Symbol u. c. una corda

AFTER COMPLETING THIS TASK
If you selected a text sign appearance, you can edit the text shown.

RELATED LINKS
Editing pedal line start text on page 1176

Changing the type of hook at the start/end of pedal lines
You can change the type of hook shown at the start/end of pedal lines individually.

NOTE

You can only change the start hook type of pedal lines that have a hook as their start sign, and 
you can only change the end hook type of pedal lines that have a continuation line.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the pedal lines whose hook type you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Pedal Lines group:
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● Line start hook

● Line end hook

3. Select one of the following options from each menu:

● No Hook

● Vertical Hook

● Slant Hook

● Inverse Hook

RESULT
The hook type at the start/end of the selected pedal lines is changed.

EXAMPLE

No Hook line end Vertical Hook line end Slant Hook line end Inverse Hook line end

Changing the pedal line continuation type
You can change the continuation type used for individual pedal lines. For example, if you want 
some pedal lines to show a dashed line and a sign at the end, but others to show a line and end 
hook.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the pedal lines whose continuation type you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Continuation type in the Pedal Lines group.

3. Select one of the following continuation types from the menu:

● Line

● Sign at End

● Sign at End and Dashed Line

● None

RESULT
The continuation type of the selected pedal lines is changed.
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EXAMPLE

Line Sign at End Sign at End and Dashed Line None

RELATED LINKS
Engrave toolbox on page 503
Properties panel on page 663
Sustain pedal retakes and pedal level changes on page 1162
Inputting pedal lines with the popover on page 375
Editing una corda pedal line restorative text on page 1178

Lengthening/Shortening gaps and dashes in pedal continuation 
lines

You can change the length of dashes and the gaps between dashes in individual dashed pedal 
continuation lines. You can do this for the current layout and frame chain only, or for all layouts 
and frame chains.

NOTE

These steps only apply to pedal lines with dashed continuation lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the pedal lines whose dashes you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Pedal Lines group:

● Dash length

● Dash gap length

3. Change the values in the value fields.

RESULT
Increasing Dash length makes dashes in pedal continuation lines longer, decreasing the value 
makes dashes shorter.

Increasing Dash gap length makes gaps between dashes in pedal continuation lines longer, 
decreasing the value makes gaps shorter.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.
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RELATED LINKS
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the line width of pedal lines
You can change the thickness of continuation lines individually. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the pedal lines whose continuation line thickness you want to 
change.

2. In the Properties panel, activate Line width in the Pedal Lines group.

The value resets to 0 automatically when you first activate the property.

3. Change the value in the value field.

RESULT
Increasing Line width makes pedal continuation lines thicker, decreasing the value makes pedal 
continuation lines thinner. If the property scope was set to Locally, this change only takes effect 
in the current layout and frame chain.

Parenthesizing pedal line continuation signs
You can show individual pedal line continuation signs with/without parentheses. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains. 

Pedal line continuation signs are shown by default at the start of new systems when pedal lines 
continue across system/frame breaks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the pedal lines whose continuation sign appearance you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Show continuation sign in parentheses in the Pedal Lines 
group.

3. Activate/Deactivate the corresponding checkbox.
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RESULT
Continuation signs are shown with parentheses when the checkbox is activated, and without 
parentheses when the checkbox is deactivated. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

Text pedal line signs
All types of pedal lines can have text as their start signs, instead of glyphs or hooks. You can 
override the text shown at the start of pedal lines that have text start signs, you can change the 
continuation text shown at the start of new systems, and you can override the restorative text 
shown at the end of una corda pedal lines.

Pedal lines that use a text indication rather than a symbol

For pedal lines such as una corda or sustain that have text for their start sign, such as Ped. Text, 
rather than the more ornate symbol, you can override the text shown at the start of the pedal 
line and replace it with your preferred performance direction.

Continuation sign/text

When pedal lines continue onto subsequent systems, a continuation sign/text is shown in 
parentheses by default. If the pedal line is using text for their start sign, such as Ped. Text, 
rather than a symbol, you can change the text shown at the start of a new system and replace it 
with your preferred performance direction.

Una corda pedal lines

The equivalent to the final pedal lift for the una corda pedal marking is the indication to return to 
tre corde. You can override the tre corde text shown at the end of the pedal line and replace it with 
your preferred performance direction.

RELATED LINKS
Changing the start sign appearance of pedal lines on page 1171
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367

Editing pedal line start text
You can change the text shown at the start of individual pedal lines that use text as their start 
sign.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the pedal lines whose start text you want to edit. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Text in the Pedal Lines group.

3. Enter the text you want into the value field.
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4. Press Return .

RESULT
The text shown at the start of the selected pedal lines is changed.

Deactivating Text restores the default start text for the selected pedal lines.

NOTE

Deactivating properties permanently deletes any custom text entered.

RELATED LINKS
Engrave toolbox on page 503

Editing pedal line continuation text
You can change the text shown at the start of subsequent systems when pedal lines continue 
across system/frame breaks.

NOTE

These steps only apply to pedal lines that use text as their start sign.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the pedal lines whose continuation text you want to edit. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Continuation text in the Pedal Lines group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The continuation text shown at the start of subsequent systems for the selected pedal lines is 
changed.

Deactivating Continuation text restores the default continuation text for the selected pedal 
lines.

NOTE

Deactivating properties permanently deletes any custom text entered.
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Editing una corda pedal line restorative text
The equivalent to the final pedal lift for una corda pedal lines is the indication to return to tre 
corde. You can change the tre corde text shown at the end of individual una corda pedal lines.

NOTE

These steps only apply to una corda pedal lines that use text as their start sign.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the una corda pedal lines whose restorative text you want to edit. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Restorative text in the Pedal Lines group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The restorative text shown at the ends of the selected una corda pedal lines is changed.

Deactivating Restorative text restores the default restorative text for the selected pedal lines.

NOTE

Deactivating properties permanently deletes any custom text entered.

Pedal lines in playback
Pedal lines are automatically played back in Dorico Elements.

The three piano pedals send MIDI controllers as follows:

● Sustain pedal lines send MIDI controller 64 (Sustain).

● Sostenuto pedal lines send MIDI controller 66 (Sostenuto).

● Una corda pedal lines send MIDI controller 67 (Soft Pedal).

Some piano VST instruments, such as Pianoteq and Garritan CFX Concert Grand, support 
partial depression of the sustain pedal. Consult the manufacturer’s documentation for more 
information.

Playback Options

You can find options for how Dorico Elements plays back pedaling on the Pedal Lines page in 
Playback Options.

You can control the following parameters of pedal line playback:

● The length of the initial pedal depression

● The length of a retake in the middle of a pedal line

Pedal lines
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● The length of the final pedal release

● Whether initial depressions and retakes are played before or after the onset of the notes or 
chords at their rhythmic positions

RELATED LINKS
Playback Options dialog on page 749
MIDI CC editor on page 701

Pedal lines imported from MusicXML files
Sustain pedal lines can be imported from MusicXML files. MusicXML can only describe the sustain 
pedal, and it cannot describe changes in pedal depression level.

Pedal lines
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Playing techniques

The term “playing techniques” covers a wide range of instructions intended to tell performers to 
modify the sound of the notes they are playing; for example, by changing their embouchure or 
changing the position of their bow, or by modifying their instrument, such as adding a mute or 
depressing a pedal.

In Dorico Elements, there are the following types of playing techniques:

Glyph playing techniques
Playing techniques that display symbols, such as up bow  or down bow  markings.

Text playing techniques
Playing techniques that display text, such as pizz. or con sordino.

You can find all available playing techniques in the Playing Techniques panel in Write mode, 
organized by instrument family. For example, you can find pedal lines in the Keyboard section of 
the Playing Techniques panel.

NOTE

Because pedal lines have additional, unique requirements that do not apply to other playing 
techniques, such as retakes, start signs, and continuation lines, they are documented separately. 
Pedal lines also have their own group of the Properties panel that is separate from the Playing 
Techniques group.

Musical phrase with glyph and text playing techniques, including grouped text playing techniques with a 
continuation line

Playing techniques can change how instruments play back. For example, inputting a pizz. playing 
technique on a violin staff activates a key switch that changes the sound produced by the 
VST instrument. Dorico Elements uses playback techniques to produce the required sounds 
in playback for the playing techniques you input, provided your sound library includes the 
corresponding samples.

Many playing techniques that only appear once in the music nonetheless imply that the playing 
technique continues. For example, pizzicato usually appears once but applies until the next 
playing technique, such as arco. In Dorico Elements, you can show continuation lines after and 
between playing techniques to convey clearly to performers the notes to which you want them to 
apply. You can also group multiple playing techniques together.

Playing technique texts use a plain font, neither bold nor italic, so they are not confused with 
dynamics and expressive text.

TIP

You can change different aspects of the Playing Technique Font font style in the Edit Font 
Styles dialog. Pedal lines use a separate font style to other playing techniques.
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RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367
Playback techniques on page 787
Pedal lines on page 1161
String indicators on page 993
Edit Font Styles dialog on page 754
Changing the default font family on page 760
MIDI Import Options dialog on page 85
Exporting text on page 102

Adding text to playing techniques
You can add text to playing techniques after they have been input; for example, to clarify the 
intention of the playing technique. You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

NOTE

These steps do not apply to pedal lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the playing techniques to which you want to add text. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Suffix in the Playing Techniques group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text you entered is added to the selected playing techniques and appears after them. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

EXAMPLE

Playing techniques without suffixes Suffixes added to playing techniques
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RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Text pedal line signs on page 1176

Erasing the background of playing techniques
You can erase the background of individual playing techniques; for example, to ensure they 
remain legible when crossing barlines. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the playing techniques whose backgrounds you want to erase.

2. In the Properties panel, activate Erase background in the Playing Techniques group.

RESULT
The backgrounds of the selected playing techniques are erased. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating Erase background returns the selected playing techniques to the default non-
erased background.

EXAMPLE

Text playing technique with non-erased background Text playing technique with erased background

AFTER COMPLETING THIS TASK
You can change the padding between playing techniques and each edge of their erased areas.

RELATED LINKS
Erasing the background of text items on page 1361
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Changing the erasure padding of text playing techniques
You can change the erasure padding of individual playing techniques, including changing the 
padding between playing techniques and each edge of their erased areas independently. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the text playing techniques whose erasure padding you want to 
change.

2. In the Properties panel, activate the Erasure padding properties, individually or together, in 
the Playing Techniques group.

● L changes the padding between playing techniques and their left edge.

● R changes the padding between playing techniques and their right edge.

● T changes the padding between playing techniques and their top edge.

● B changes the padding between playing techniques and their bottom edge.

3. Change the values in the value fields.

RESULT
Increasing the values increases the padding, decreasing the values decreases the padding. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

Hiding/Showing playing techniques
You can hide/show playing techniques individually; for example, if your expression map requires 
you to input a playing technique to trigger the correct playback but you do not want that 
technique to appear in the music. You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the playing techniques you want to hide, or the signposts of playing techniques you 
want to show. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hidden in the Playing Techniques group.
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RESULT
The selected playing techniques are hidden when Hidden is activated, and shown when it is 
deactivated. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Signposts are shown at the position of each hidden playing technique. However, signposts are 
not printed by default.

TIP

● You can hide/show playing technique signposts by choosing View > Signposts > Playing 
Techniques.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences.

● You can input hidden playing techniques when using the playing techniques popover.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Expression maps on page 761
Signposts on page 450
Key Commands page in the Preferences dialog on page 60
Annotations on page 597
Inputting playing techniques with the popover on page 372

Positions of playing techniques
Playing techniques, both as text and symbols, are placed above the staff by default. On vocal 
staves, they are placed above the staff and below dynamics. In multiple-voice contexts, playing 
techniques for the up-stem voices are placed above the staff, and playing techniques for the 
down-stem voices are automatically placed below the staff.

Glyph playing techniques are center-aligned on noteheads. Text playing techniques are left-
aligned with noteheads.

Placement of playing techniques with two voices on the same staff

You can move playing techniques to different rhythmic positions in Write mode. They are 
automatically positioned to avoid collisions.

You can move playing techniques graphically in Engrave mode, but this does not change the 
rhythmic positions to which they are attached.

You can change the vertical order of playing techniques, but only within their stacking category.

RELATED LINKS
Playing technique continuation line components on page 1188
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Groups of playing techniques on page 1191
Moving notes/items rhythmically on page 461
Moving items graphically on page 514

Changing the vertical order of playing techniques
You can change the vertical order of playing techniques within each stacking order category 
when multiple playing techniques exist at the same rhythmic position. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

In Dorico Elements, there are the following vertical stacking categories for playing techniques:

1. Text/Grouped playing techniques, including playing techniques with continuation lines: 
furthest from the staff

2. Bowing marks: inside text/grouped playing techniques by default, but outside fermatas

3. Glyph playing techniques: closest to the staff, and inside fermatas

Musical passage containing all vertical stacking categories for playing techniques

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the playing techniques whose vertical order you want to change.

2. In the Properties panel, activate Tucking index in the Playing Techniques group.

3. Change the value in the value field.

RESULT
The order of the selected playing techniques relative to other playing techniques in the same 
stacking category, either at the same rhythmic position or along their duration, is changed. This 
also affects other playing techniques in the same groups.

Playing techniques with higher Tucking index values are placed further from the staff, while 
playing techniques with lower values are placed closer.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Changing the staff-relative placement of items on page 434
Tucking index properties on page 518
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Types of fermatas on page 1011

Playing technique continuation lines
Playing technique continuation lines convey exactly the notes to which playing techniques apply, 
and can also indicate a gradual transition between playing techniques.

A phrase with multiple playing technique continuation lines

In Dorico Elements, there are the following types of playing technique continuation lines:

Duration line

Indicates a specific duration to which the playing technique applies. The duration line 
for most playing techniques is a solid line with a hook cap at the end.

Playing techniques show duration lines when the following conditions are met:

● The playing technique has duration.

● The continuation type for the playing technique is set to show lines.

● The playing technique is ungrouped or is the final playing technique in a group.

Transition line

Indicates that the playing technique at the start must gradually turn into the playing 
technique at the end over the duration specified by the line. The transition line for 
most playing techniques is a solid line with an arrow cap at the end.

Transition lines are automatically shown between playing techniques in groups.

NOTE

Playing technique continuation lines do not affect playback. The sounds produced in playback 
rely on the playback technique associated with the playing technique, the expression map 
settings, and the sound libraries loaded in the project.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367
Lengthening/Shortening items on page 430
Lines on page 1194
Line components on page 1196
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Playing technique duration
In Dorico Elements, playing techniques have an explicit duration when they apply to a specific 
range, rather than from a single rhythmic position onwards. Playing techniques with duration 
only affect playback within their duration and can show continuation lines.

In Write mode, playing techniques with duration have start and end handles that show their 
duration.

Start and end handles on a playing technique with duration

You can give duration to any playing technique in any of the following ways:

● Group playing techniques together

● Input playing techniques with an open end during note input and extend them

● Add playing techniques to a range of notes

● Lengthen playing techniques

String indicator (selected) with no duration String indicator (selected) with duration and duration 
line

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367
Lengthening/Shortening items on page 430
Grouping playing techniques together on page 1192
Vibrato bar techniques on page 1137
String indicators on page 993
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Playing technique continuation line components
In Dorico Elements, playing technique continuation lines consist of multiple components that 
together function as a single item. The duration line and transition line for the same playing 
technique can have different default components.

1 Playing technique

Controls the default appearance of the following line.

2 Start cap

Symbol shown at the start of playing technique continuation lines.

3 Line body

Horizontal line, pattern, or wedge that makes up the main part of a playing technique 
continuation line and extends across its entire length.

4 Continuation end cap

Symbol shown at the end of segments of playing technique continuation lines that continue 
across multiple systems.

5 Playing technique continuation sign

Parenthesized reminder of the current playing technique shown at the start of subsequent 
segments of playing technique continuation lines that continue across multiple systems. You 
cannot hide playing technique continuation signs independently of the playing technique.

6 Continuation cap

Symbol shown at the start of subsequent segments of playing technique continuation lines 
that continue across multiple systems.

7 End cap

Symbol shown at the end of playing technique continuation lines.

RELATED LINKS
Lines on page 1194

Playing technique continuation lines in Engrave mode
In Engrave mode, each playing technique continuation line has two square handles, one at the 
start and one at the end. You can move these handles to adjust the graphical position, length, 
and angle of playing technique continuation lines.

If playing technique continuation lines cross system and frame breaks, you can move the line 
segments on each side of the break independently.
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Playing technique continuation lines 
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Moving playing techniques with continuation lines moves them both together, including any 
adjacent playing techniques and continuation lines in the same group. Moving continuation 
lines or continuation line handles moves the continuation lines independently of the playing 
technique.

RELATED LINKS
Moving items graphically on page 514

Hiding/Showing playing technique duration lines
You can hide/show duration lines for individual playing techniques. When hiding duration lines, 
you can show nothing or sim.. When showing duration lines, you can show a line or repeat the 
signs of glyph playing techniques. You can do this for the current layout and frame chain only, or 
for all layouts and frame chains.

NOTE

These steps only apply to playing technique duration lines. They do not apply to playing 
technique transition lines.

PREREQUISITE

● The playing techniques whose duration lines you want to hide/show have duration.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Write mode, select the playing techniques whose duration lines you want to hide/show.

2. In the Properties panel, activate Continuation type in the Playing Techniques group.

3. Select one of the following options from the menu:

● None

● sim.

● Line

● Repeat the signs (glyph playing techniques only)

RESULT
Duration lines are hidden after the selected playing techniques when you select None. When 
you select sim., duration lines are hidden and sim. is shown once after each selected playing 
technique.

Duration lines are shown after the selected playing techniques when you select Line.

For glyph playing techniques, the playing technique is repeated for each note within the duration 
automatically when you select Repeat the signs.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

Playing techniques
Playing technique continuation lines 
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EXAMPLE

Duration line shown Duration line hidden Duration line hidden but 
sim. shown

Signs repeated on each 
note

AFTER COMPLETING THIS TASK
You can change the style of the duration lines.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665

Changing the style of playing technique continuation lines
You can change the style of individual playing technique duration lines and transition lines; for 
example, if you want to show a single duration line as a wiggly line. You can change the whole 
line style, including the caps, or only the body style, which does not affect the caps.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the playing technique continuation lines whose style you want to 
change.

2. In the Properties panel, activate one of the following properties in the Playing Techniques 
group:

● To change the whole line style, including caps, activate Line style.

● To change only the body style, excluding caps, activate Line body style.

3. Select the style you want from the menu.

RESULT
The corresponding style of the selected playing technique continuation lines is changed.

AFTER COMPLETING THIS TASK
You can change the caps of individual playing technique continuation lines.

RELATED LINKS
Engrave toolbox on page 503
Changing the body style of lines on page 1206

Playing techniques
Playing technique continuation lines 
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Changing the caps of playing technique continuation lines
You can change the caps of individual playing technique continuation lines independently of 
their line body styles. You can also change the caps of individual segments of playing technique 
continuation lines that continue across multiple systems.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the playing technique continuation lines whose caps you want to 
change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Playing Techniques group:

● To change the cap at the start of the selected lines, activate Start cap.

● To change the cap at the end of the selected lines, activate End cap.

● To change the cap at the start of segments of the selected lines on subsequent systems, 
activate Continuation cap.

● To change the cap at the end of segments of the selected lines on subsequent systems, 
activate Continuation end cap.

3. Select the style you want from each menu.

RESULT
The corresponding caps of the selected playing technique continuation lines are changed.

AFTER COMPLETING THIS TASK
You can change the style of individual playing technique continuation lines.

RELATED LINKS
Changing the caps of lines on page 1207

Groups of playing techniques
Groups of playing techniques are automatically aligned in a row and can be moved and edited 
as a group. When you move individual playing techniques within a group, the lengths of any 
continuation lines on either side automatically adjust to compensate.

A group of playing techniques The same group of playing techniques with adjusted 
transition lines after the middle playing technique 
moved rhythmically

Playing techniques
Groups of playing techniques 
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Two or more playing techniques are automatically grouped together if they are adjoining with 
duration between them and were added to existing music together or input in sequence during 
note input.

Transition lines are automatically shown between playing techniques in groups. The final playing 
technique in playing technique groups can show a duration line if it has duration.

All of the playing techniques in a group are highlighted when any of the playing techniques in 
the group are selected.

In Engrave mode, you can move each playing technique and continuation line within a group 
individually. Playing techniques in groups are attached to continuation lines, meaning that if you 
move a playing technique, any adjacent continuation lines automatically move with it. Groups of 
playing techniques have a handle at the start of the group, which controls the vertical position of 
the whole group.

NOTE

● You cannot group a playing technique group to another playing technique group, you can 
only group single playing techniques together or single playing techniques to an existing 
group.

● Groups of playing techniques apply project-wide, meaning you cannot have playing 
techniques grouped one way in some layouts but differently in other layouts. However, you 
can move playing techniques graphically in each layout independently and independently of 
their groups.

RELATED LINKS
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367
Playing technique duration on page 1187
Lengthening/Shortening items on page 430
Moving notes/items rhythmically on page 461
Moving items graphically on page 514

Grouping playing techniques together
You can manually group playing techniques together that were not automatically grouped when 
they were input. Grouped playing techniques are automatically aligned in a row, show transition 
lines between them, and can be moved and edited as a group.

NOTE

You cannot group a playing technique group to another playing technique group, you can only 
group single playing techniques together or single playing techniques to an existing group.

If you want to group a playing technique group to another playing technique group, you must 
first ungroup them.

Playing techniques
Groups of playing techniques 
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PROCEDURE

1. In Write mode, select the playing techniques you want to group together.

2. Choose Edit > Notations > Playing Techniques > Group Playing Techniques. You can also 
choose this option from the context menu.

RESULT
The selected playing techniques are grouped together. Their durations are extended to reach the 
next playing technique in the group, and transition lines are shown between playing techniques 
in the group.

RELATED LINKS
Playing technique continuation lines on page 1186

Ungrouping playing techniques and removing playing techniques 
from groups

You can ungroup playing techniques so that all playing techniques in the group become 
ungrouped. You can also remove only selected playing techniques from groups while leaving 
other playing techniques in the group.

This applies to all layouts in which the playing techniques appear.

PROCEDURE

1. In Write mode, select the playing techniques you want to ungroup or remove from groups.

2. Do one of the following:

● To ungroup all playing techniques in the selected groups, choose Edit > Notations > 
Playing Techniques > Ungroup Playing Techniques.

● To remove only the selected playing techniques from their groups, choose Edit > 
Notations > Playing Techniques > Remove Playing Technique from Group.

TIP

You can also choose these options from the context menu.

RESULT
The selected playing techniques or all playing techniques are removed from the selected groups. 
Playing techniques that previously had transition lines now appear with duration lines.

Playing techniques
Groups of playing techniques 
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Lines

Lines can convey a variety of meanings in music, such as indicating which hand to use in piano 
music or a gradual change in bow pressure. In Dorico Elements, lines can be vertical, horizontal, 
or angled between notes and have different styles and appearances.

A phrase containing horizontal and vertical lines that convey a range of meanings

NOTE

Due to their generic designs, such as a dashed line with arrow end cap, lines in Dorico Elements 
have no definitive musical meaning and function primarily graphically, meaning they do not 
affect playback. Dorico Elements includes dedicated features for specific notations that affect 
playback if applicable, such as dynamics, arpeggios, glissandi, and trills.

The following types of lines are available in Dorico Elements:

Horizontal lines
Horizontal lines span a specified duration; that is, they start at one rhythmic position 
and end at a later rhythmic position. They might indicate a change over time, such 
as a wedge that represents bow pressure, or suggest a link between notes, such as a 
bracket spanning the theme in a fugue or a straight line between notes showing where 
a melody moves to a different staff.

By default, horizontal lines only apply to single staves. However, there are certain 
situations where you require a horizontal line to appear in all part layouts but only 
at system object positions in the full score layout. You can input horizontal lines that 
apply to all staves or only apply to single staves in Dorico Elements.

Attachment types control the positions of horizontal lines and certain aspects of their 
functionality. Horizontal lines can have different attachment types at their start and 
end. For example, a line can be attached to a notehead at the start, but attached to a 
barline at the end.

NOTE

You cannot change the attachment type of horizontal lines after they have been input.

In Dorico Elements, each end of horizontal lines can have the following attachment 
types:

● Notehead-attached

Attached to an individual note independently of its rhythmic position, meaning 
that the ends of notehead-attached lines move with notes if you change their 
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pitch or move them rhythmically. Notehead-attached lines can be both angled 
or horizontal, as their end positions and resulting angles are determined by the 
interval between the start and end notes.

A phrase containing two notehead-attached lines, showing where the melody moves 
between piano staves

● Barline-attached

Attached to a rhythmic position and aligned with barlines, if their rhythmic 
positions coincide with barline positions. Barline-attached lines are always 
horizontal.

A barline-attached line spanning two full bars

● Rhythmic position-attached

Attached to a rhythmic position and positioned relative to notes, chords, or rests at 
those rhythmic positions.

Rhythmic position-attached lines are horizontal and placed above the staff by 
default. Their endpoints start to the left and end to the right of notes, chords, 
or rests at the corresponding rhythmic positions.

A rhythmic position-attached line spanning two full bars

Vertical lines
Vertical lines exist at a single rhythmic position and are positioned relative to notes or 
chords at that position. They might convey details about a specific moment, such as 
indicating which hand to use for specific notes in piano music.

Lines
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Vertical lines indicating which notes to play with the right hand

RELATED LINKS
Input methods for lines on page 385
Lines panel on page 385
Adding text to lines on page 1208
Changing the placement of horizontal lines on page 1201
Arpeggio signs on page 1108
Glissando lines on page 1115
Jazz articulations on page 1145
Octave lines on page 915
Trills on page 1094
Playing technique continuation lines on page 1186
Pedal lines on page 1161
Repeat endings on page 1230
Guitar bends on page 1122
Tuplet brackets on page 1413

Line components
In Dorico Elements, lines consist of multiple components that together function as a single item.

1 Start cap

Symbol shown at the start of lines. Caps can be arrowheads, hooks, or terminal lines.

2 Line body

Horizontal or vertical line, repeating symbols, dash/dot pattern, or wedge that makes up the 
main part of a line and extends across its entire length or height.

3 Text

Lines
Line components 
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Text shown in addition to caps, either centered in the middle of each line segment or only at 
the start or end of lines. On vertical lines, text reads upwards by default.

4 Continuation end cap

Symbol shown at the end of segments of lines that continue across multiple systems. Caps 
can be arrowheads, hooks, or terminal lines.

5 Continuation cap

Symbol shown at the start of subsequent segments of lines that continue across multiple 
systems. Caps can be arrowheads, hooks, or terminal lines.

6 End cap

Symbol shown at the end of lines. Caps can be arrowheads, hooks, or terminal lines.

NOTE

Dorico Pro provides further options for customizing lines and line components, such as using 
text for caps and music symbols for annotations in the center of lines. You might encounter lines 
with different components than are available in Dorico Elements if you import or open a project 
that contains them.

RELATED LINKS
Input methods for lines on page 385
Changing the body style of lines on page 1206
Changing the caps of lines on page 1207
Adding text to lines on page 1208
Changing the position of text relative to horizontal lines on page 1210
Changing the position of text relative to vertical lines on page 1210
Playing technique continuation lines on page 1186

Positions of lines
The position of lines relative to notes and staves depends on the line type and, for horizontal 
lines, their attachment type.

Notehead-attached horizontal lines
Notehead-attached lines are positioned in relation to the corresponding noteheads; 
that is, starting to the right of the start note and ending to the left of the end note. 
They automatically follow the notes at each end, meaning if you change the pitch 
of either note or move them rhythmically, the line end positions move accordingly. 
Because their positions depend on the pitches of notes, they can appear both inside 
and outside the staff. If they are only attached to noteheads at one end, they remain 
horizontal but follow the staff position of the note to which they are attached.

Barline-attached horizontal lines
Barline-attached horizontal lines are placed above the staff by default. Their endpoints 
align with barlines if their duration coincides with barline positions. If their endpoints 
do not coincide with barlines, they are positioned like rhythmic position-attached lines.

Rhythmic position-attached horizontal lines
Rhythmic position-attached lines are placed above the staff by default. Their endpoints 
start to the left and end to the right of notes, chords, or rests at the corresponding 
rhythmic positions.

Lines
Positions of lines 
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Vertical lines
Vertical lines are positioned to the left of the notes to which they apply, including 
any applicable accidentals, but are positioned between grace notes and normal notes. 
If multiple vertical lines exist at the same rhythmic position, the most recent line is 
positioned furthest to the right; that is, directly to the left of notes or chords.

You can change the position/placement of lines in a variety of ways, such as showing vertical 
lines on the right of notes or changing the placement of horizontal lines to show them inside the 
staff.

RELATED LINKS
Changing the horizontal order of vertical lines on page 1199
Showing vertical lines before grace notes on page 1200
Changing the placement of horizontal lines on page 1201
Moving items graphically on page 514
Input methods for lines on page 385

Showing vertical lines on the right/left of notes
You can change the side of notes on which vertical lines appear; for example, to show selected 
vertical lines on the right side of notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the vertical lines whose horizontal position you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Side in the Vertical Lines group.

3. Choose one of the following options:

● Left

● Right

RESULT
The selected lines appear on the corresponding side of notes.

Lines
Positions of lines 
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EXAMPLE

Vertical line on the left of notes Vertical line on the right of notes

AFTER COMPLETING THIS TASK
You can change the order of vertical lines when multiple vertical lines exist at the same rhythmic 
position and on the same side of notes.

Changing the horizontal order of vertical lines
You can change the horizontal order of vertical lines when multiple vertical lines exist at the 
same rhythmic position and on the same side of notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the vertical lines whose order you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Column in the Vertical Lines group.

3. Change the value in the value field.

RESULT
The order of the selected vertical lines relative to any other vertical lines at the same rhythmic 
positions is changed.

Lines with higher Column values are placed further to the left, while lines with lower values are 
placed further to the right.

Enabling/Disabling vertical line collision avoidance
You can change whether individual vertical lines avoid collisions, which can affect horizontal 
spacing. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

Lines
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● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the vertical lines whose collision avoidance you want to enable/
disable.

2. In the Properties panel, activate Avoid collisions in the Vertical Lines group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected vertical lines avoid collisions when the checkbox is activated, and do not avoid 
collisions when the checkbox is deactivated. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

EXAMPLE

Collision avoidance enabled Collision avoidance disabled

AFTER COMPLETING THIS TASK
You can move lines graphically in Engrave mode; for example, to accommodate accidentals.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Note spacing on page 507
Moving items graphically on page 514

Showing vertical lines before grace notes
You can position individual vertical lines so they appear to the left of grace notes. By default, 
vertical lines are positioned after grace notes; that is, between grace notes and normal notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the vertical lines you want to show before grace notes. You can do this in Write mode 
and Engrave mode.

Lines
Positions of lines 
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2. In the Properties panel, activate Line before grace notes in the Vertical Lines group.

RESULT
The selected vertical lines are positioned before grace notes.

Deactivating Line before grace notes shows the selected vertical lines after grace notes again.

EXAMPLE

Vertical line after grace notes Vertical line before grace notes

Changing the placement of horizontal lines
You can show individual horizontal lines above, below, or inside the staff. By default, horizontal 
lines are placed above the staff.

NOTE

These steps only apply to barline-/rhythmic position-attached horizontal lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the horizontal lines whose placement you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Placement in the Horizontal Lines group.

3. Select one of the following options from the menu:

● Above

● Below

● Inside staff

RESULT
The placement of the selected horizontal lines is changed. Horizontal lines inside the staff are 
centered on the middle staff line by default.

Lines
Positions of lines 
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TIP

You can also cycle through the different placement options for selected horizontal lines by 
pressing F .

AFTER COMPLETING THIS TASK

● You can change the staff position of lines shown inside the staff.

● You can erase the background of text on lines shown inside the staff.

RELATED LINKS
Engrave toolbox on page 503
Moving items graphically on page 514
Changing the staff-relative placement of items on page 434

Changing the staff position of horizontal lines inside the staff
You can change the staff position of horizontal lines shown inside the staff, including changing 
the staff position of the start/end of lines independently of each other; for example, if you want 
lines to appear angled.

PREREQUISITE

● The horizontal lines whose staff position you want to change are placed inside the staff and 
have at least one barline-/rhythmic position-attached end.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the horizontal lines placed inside the staff whose staff position you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Horizontal Lines group:

● Start position

● End position

3. Change the values in the value fields.

RESULT
The staff positions of the corresponding ends of the selected lines are changed according to the 
new values. For example, 0 is the middle line of the staff, 4 is the top line of the staff, and -4 is the 
bottom line of the staff.

Lines
Positions of lines 
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EXAMPLE

Horizontal lines inside the staff with different staff positions at their start/end

Length of lines
Dorico Elements automatically calculates the appropriate length for both horizontal and vertical 
lines.

● The length of horizontal lines is determined by the rhythmic duration of the line. Horizontal 
lines with different attachment types are positioned differently, which can affect their 
graphical length. For example, barline-attached lines can appear longer than rhythmic 
position-attached lines with the same duration.

● The length of vertical lines is determined by the pitch range of notes in the voices/staves to 
which the line applies. Dorico Elements automatically adjusts the length of vertical lines if 
pitches change or you add notes to, or delete notes from, chords.

You can lengthen/shorten both horizontal and vertical lines; for example, if you want an 
individual vertical line to extend above the top note in a chord.

Lengthening/Shortening horizontal lines
You can lengthen/shorten horizontal lines rhythmically after they have been input.

NOTE

These steps only apply to barline-/rhythmic position-attached horizontal lines. You cannot 
lengthen/shorten notehead-attached horizontal lines, except by lengthening/shortening the 
notes to which they are attached.

PROCEDURE

1. In Write mode, select the horizontal lines you want to lengthen/shorten.

NOTE

When using the mouse, you can only lengthen/shorten one line at a time.

2. Lengthen/Shorten the lines in any of the following ways:

● To lengthen them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Right Arrow .

● To shorten them by the current rhythmic grid resolution, press Shift-Alt/Opt-
Left Arrow .

Lines
Length of lines 
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● To snap the end of a single line to the next notehead, press Ctrl/Cmd-Shift-Alt/Opt-
Right Arrow .

● To snap the end of a single line to the previous notehead, press Ctrl/Cmd-Shift-Alt/
Opt-Left Arrow .

NOTE

● When multiple lines are selected, you can only lengthen/shorten them according to 
the current rhythmic grid resolution.

● When using the keyboard, lengthening/shortening lines only moves their end. You 
can move the start of lines by moving lines rhythmically, or by clicking and dragging 
the start handle of a single line.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
Single lines are lengthened/shortened according to the current rhythmic grid resolution or to the 
next/previous notehead, whichever is closer.

Multiple lines are lengthened/shortened according to the current rhythmic grid resolution.

TIP

You can move lines graphically in Engrave mode, including changing their graphical length.

RELATED LINKS
Inputting horizontal lines on page 386
Moving notes/items rhythmically on page 461
Moving items graphically on page 514
Rhythmic grid on page 217

Lengthening/Shortening vertical lines
You can lengthen/shorten individual vertical lines to different staff positions. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains. By default, vertical 
lines automatically span the pitch range of notes in the voices to which they apply.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the vertical lines you want to lengthen/shorten. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Vertical Lines group:

● Top position

● Bottom position

Lines
Length of lines 
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3. Change the values in the value fields.

RESULT
The vertical length of the selected lines is changed. Increasing the values moves the 
corresponding end up by staff positions, decreasing the values moves the corresponding end 
down by staff positions. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

TIP

You can move lines graphically in Engrave mode, including changing their graphical length.

RELATED LINKS
Moving items graphically on page 514
Inputting vertical lines on page 387
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the start/end positions of horizontal lines
By default, rhythmic position-attached horizontal lines start before notes/accidentals and end 
immediately after the last note, chord, or rest at their end rhythmic position. You can change the 
start and end positions of individual rhythmic position-attached horizontal lines independently; 
for example, if you want them to start before noteheads rather than accidentals and end 
immediately before the following note, chord, or rest.

NOTE

These steps only apply to rhythmic position-attached horizontal lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the rhythmic position-attached horizontal lines whose start and/or end position you 
want to change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Horizontal start position in the Horizontal Lines group.

3. Select one of the following options from the menu:

● Notehead

● Notehead center

● Accidental

4. Activate Horizontal end position in the Horizontal Lines group.

5. Select one of the following options from the menu:

● End at right-hand side of final note

● End on center of final note

Lines
Length of lines 
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● End immediately before following note

RESULT
The start and/or end position of the selected rhythmic position-attached horizontal lines is 
changed.

EXAMPLE

Horizontal line starting before the 
notehead

Horizontal line starting centered 
on the notehead

Horizontal line starting before the 
accidental

Horizontal line ending after final 
note

Horizontal line ending centered on 
the final notehead

Horizontal line ending before 
following note

Changing the body style of lines
You can change the body style of individual lines without changing their caps.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lines whose body style you want to change. You can do this in Write mode and 
Engrave mode.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Line body style in either the Horizontal Lines or Vertical 
Lines group.

3. Select the style you want from the menu.

RESULT
The body style of the selected lines is changed.

NOTE

This does not affect the caps of the selected lines.

Lines
Changing the body style of lines 
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RELATED LINKS
Line components on page 1196
Lines panel on page 385
Input methods for lines on page 385
Engrave toolbox on page 503

Changing the caps of lines
You can change the caps of individual lines without changing their body style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lines whose caps you want to change. You can do this in Write mode and Engrave 
mode.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate the following properties, individually or together, in either 
the Horizontal Lines or Vertical Lines group:

● To change the cap at the start/bottom of the selected lines, activate Start cap.

● To change the cap at the end/top of the selected lines, activate End cap.

● To change the segment start cap of the selected horizontal lines on subsequent systems, 
activate Continuation cap.

● To change the segment end cap of the selected horizontal lines on previous systems to 
where the lines end, activate Continuation end cap.

3. Select the style you want from each menu.

RESULT
The corresponding caps of the selected lines are changed.

NOTE

This does not affect the body style of the selected lines.

Changing the direction of lines
You can change the direction of both horizontal and vertical lines; for example, to make a 
horizontal line with an arrow end cap point to the left, or to make a vertical line with text appear 
upside-down with its text reading downwards.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Lines
Changing the caps of lines 
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● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lines whose direction you want to change. You can do this in Write mode and 
Engrave mode.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Reverse in either the Horizontal Lines or Vertical Lines 
group.

RESULT
The direction of the selected lines is change. Text on vertical lines now reads downwards.

Deactivating Reverse returns the selected lines to their default direction.

EXAMPLE

Horizontal and vertical lines with default directions Reversed horizontal and vertical lines

Adding text to lines
You can add text to both horizontal and vertical lines; for example, to clarify the intention of the 
line.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lines to which you want to add text. You can do this in Write mode and Engrave 
mode.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Text in either the Horizontal Lines or Vertical Lines group.

3. Enter the text you want into the value field.

Lines
Adding text to lines 
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4. Press Return .

RESULT
The text you entered into the value field is shown centered in the middle of the selected lines. On 
vertical lines, it reads upwards.

EXAMPLE

Text on a horizontal line

Text on a vertical line

AFTER COMPLETING THIS TASK

● If you want text on vertical lines to read downwards, you can reverse the lines.

● You can erase the backgrounds of text on lines.

RELATED LINKS
Engrave toolbox on page 503
Line components on page 1196
Input methods for lines on page 385

Line text font styles
There are different font styles for line text according to the line type. You can change different 
aspects of these fonts in the Edit Font Styles dialog, such as changing the font size to make line 
text appear larger.

The following font styles are used for line text:

● Horizontal Line Font: Used for text on horizontal lines.

● Vertical Line Font: Used for text on vertical lines.

NOTE

Changes made to font styles apply to the entire project, including part layouts.

RELATED LINKS
Edit Font Styles dialog on page 754
Changing the default font family on page 760

Lines
Adding text to lines 
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Changing the position of text relative to horizontal lines
You can change the position of text relative to horizontal lines individually; for example, to show 
text above horizontal lines. By default, text is centered on horizontal lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the horizontal lines whose text position you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Text position in the Horizontal Lines group.

3. Select one of the following options from the menu:

● Above

● Centered

● Below

● Inside

● Outside

RESULT
The position of text relative to the selected horizontal lines is changed. When annotations are 
positioned Inside or Outside, their position relative to the line changes according to the staff-
relative placement of the line.

EXAMPLE

Text Above Text Centered Text Below

RELATED LINKS
Engrave toolbox on page 503
Changing the placement of text relative to lines on page 1211

Changing the position of text relative to vertical lines
You can change the position of text relative to vertical lines individually; for example, to show text 
on the left of vertical lines. By default, text is centered on vertical lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Lines
Adding text to lines 
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● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the vertical lines whose text position you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Text position in the Vertical Lines group.

3. Select one of the following options from the menu:

● Left

● Centered

● Right

RESULT
The position of text relative to the selected vertical lines is changed.

EXAMPLE

Text Left Text Centered Text Right

Changing the placement of text relative to lines
You can change the placement of text relative to lines individually; for example, to show text at 
the start of horizontal lines or the top of vertical lines. By default, text appears in the center of 
lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lines whose text placement you want to change. You can do this in Write mode 
and Engrave mode.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Text placement in either the Horizontal Lines or Vertical 
Lines group.

Lines
Adding text to lines 
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3. Select one of the following options from the menu:

● Start

● Center

● End

4. Optional: If you chose Start or End and want to change the offset from the corresponding 
end of the line, activate Start/end gap in either the Horizontal Lines or Vertical Lines 
group and change the value in the value field.

RESULT
The placement of text relative to the selected lines is changed. For vertical lines, Start places text 
at the bottom of the line, End places text at the top.

If you also activated Start/end gap, the gap between text on the selected lines and the 
corresponding end is changed.

RELATED LINKS
Engrave toolbox on page 503
Changing the direction of lines on page 1207

Forcing line text to be horizontal
You can force the text of individual lines always to appear horizontal; for example, to make text 
on vertical lines easier to read.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the lines whose text you want to keep horizontal. You can do this in Write mode and 
Engrave mode.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Keep text horizontal in either the Horizontal Lines or 
Vertical Lines group.

RESULT
Text on the selected lines always appears horizontal, even if the line is angled or vertical.

Adding borders to line text
You can add borders to text shown on individual lines and change the border thickness; for 
example, if you want to make the boundary of the text relative to the line clear. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

Lines
Adding text to lines 
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● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the lines whose text you want to add borders to.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Border thickness in either the Horizontal Lines or Vertical 
Lines group.

3. Change the value in the value field.

RESULT
Borders with the corresponding thickness are added to text on the selected lines. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the placement of text relative to lines on page 1211
Adding borders to text items on page 1358
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Erasing the background of line text
You can erase the background of text shown on individual lines; for example, to ensure they 
remain legible if they appear inside the staff. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the lines whose text backgrounds you want to erase.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate Erase background in either the Horizontal Lines or 
Vertical Lines group.

RESULT
The backgrounds of text on the selected lines are erased. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Lines
Adding text to lines 
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Deactivating Erase background returns text on the selected lines to the default non-erased 
background.

EXAMPLE

Line text with non-erased background Line text with erased background

Changing the erasure padding of line text
You can change the erasure padding of text on individual lines, including changing the padding 
between line text and each edge of their erased areas independently. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the lines whose text erasure padding you want to change.

NOTE

You must select either only horizontal lines or only vertical lines.

2. In the Properties panel, activate the Erasure padding properties, individually or together, in 
either the Horizontal Lines or Vertical Lines group.

● L changes the padding between line text and their left edge.

● R changes the padding between line text and their right edge.

● T changes the padding between line text and their top edge.

● B changes the padding between line text and their bottom edge.

3. Change the values in the value fields.

RESULT
Increasing the values increases the padding, decreasing the values decreases the padding. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

Lines
Adding text to lines 
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RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Lines in Engrave mode
In Engrave mode, each line has two square handles, one at the start and one at the end of 
horizontal lines, and one at the top and one at the bottom of vertical lines. You can move these 
handles to adjust the graphical position, length, and angle of lines.

You can also move whole individual lines graphically. If horizontal lines cross system and frame 
breaks, you can move the line segments on each side of the break independently.

Handles on a vertical line and horizontal line in Engrave mode

RELATED LINKS
Line components on page 1196
Positions of lines on page 1197
Lengthening/Shortening horizontal lines on page 1203
Lengthening/Shortening vertical lines on page 1204
Showing vertical lines on the right/left of notes on page 1198
Changing the horizontal order of vertical lines on page 1199
Enabling/Disabling vertical line collision avoidance on page 1199
Changing the placement of horizontal lines on page 1201
Changing the staff position of horizontal lines inside the staff on page 1202
Moving items graphically on page 514

Lines
Lines in Engrave mode 
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Rehearsal marks

Rehearsal marks are ordered sequences of letters or numbers that provide useful reference 
points, such as indicating significant changes in the music. They allow performers to co-ordinate 
easily in rehearsals and make the chronological sequence of the music clear.

In Dorico Elements, rehearsal marks follow an automatic sequence where each rehearsal mark 
has a unique index, ensuring there are never duplicate rehearsal marks.

A rehearsal mark, showing the letter G

By default, rehearsal marks in Dorico Elements appear as letters, but you can change the 
sequence type to show letters, numbers, or bar numbers. You can use all three available 
rehearsal mark sequences simultaneously.

In order to ensure they are easily noticeable, and cannot be confused with bar numbers when 
using numbers for rehearsal marks, rehearsal marks are shown in a rectangular enclosure.

In Dorico Elements, rehearsal marks are categorized as system objects. Therefore, rehearsal 
marks follow your per-layout settings for the visibility and positioning of system objects.

RELATED LINKS
Inputting rehearsal marks on page 400
Changing the index of rehearsal marks on page 1217
Changing the rehearsal mark sequence type on page 1218
Going to rehearsal marks on page 442
Layout Options dialog on page 745
System objects on page 1326
Changing the positions of system objects on page 1327
Exporting text on page 102
Tempo marks on page 1335
Bar numbers on page 826

Positions of rehearsal marks
Rehearsal marks are placed outside the music, above the staff, and at the same positions as 
other system objects so they can be seen easily.

By default, rehearsal marks are positioned above barlines and to the right of clefs or key 
signatures at the start of systems. Although you can input rehearsal marks at rhythmic positions 
within a bar in Dorico Elements, this is not common practice.

When rehearsal marks coincide with tempo changes, Dorico Elements automatically positions 
tempo marks to the right of rehearsal marks. Dorico Elements automatically adjusts staff spacing 
to ensure rehearsal marks are correctly positioned.
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You can move rehearsal marks to different rhythmic positions in Write mode. They are 
automatically positioned to avoid collisions.

The vertical spacing between the top two staves is increased to allow room for the rehearsal mark and the 
tempo marks.

You can move rehearsal marks graphically in Engrave mode, but this does not change the 
rhythmic positions to which they are attached.

Rehearsal marks are categorized as system objects in Dorico Elements, which you can show 
above the first bracket of selected instrument families. You can change the instrument families 
above which system objects appear in each layout independently; for example, if you want 
rehearsal marks to appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Inputting rehearsal marks on page 400
Input methods for bars, beats, and barlines on page 300
Moving items graphically on page 514
Changing the positions of system objects on page 1327

Changing the index of rehearsal marks
By default, the rehearsal mark sequence resets at the start of each flow. If you want the 
rehearsal mark sequence to continue across flows, for example, to avoid having multiple 
rehearsal marks with the same letter in the same project, you can change the index position 
of individual rehearsal marks.

Changing the index position changes the shown number or letter. For example, index position 1 
appears as rehearsal mark A or 1, position 2 appears as B or 2, and so on.

You can also change the index position of a rehearsal mark to avoid showing a letter that could 
easily be confused with another letter or another number, such as I or O.

NOTE

These steps do not apply to rehearsal marks using the bar number sequence type.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Rehearsal marks
Changing the index of rehearsal marks 

1217
Dorico Elements 5.1.30



PROCEDURE

1. Select the rehearsal mark whose index position you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Index in the Rehearsal Marks group.

3. Change the value in the value field.

RESULT
The selected rehearsal mark changes according to the Index value and its sequence type.

Any subsequent rehearsal marks without index changes in the same sequence follow the new 
index automatically. For example, if you changed a rehearsal mark from A to P, the next 
rehearsal mark changes from B to Q.

TIP

You can also change the sequence type of rehearsal marks; for example, if you want rehearsal 
mark C to appear as rehearsal mark 3.

Changing the rehearsal mark sequence type
Rehearsal marks can be letters, numbers, or bar numbers. You can change the sequence type of 
individual rehearsal marks, and create secondary rehearsal mark sequences.

In Dorico Elements, you can use all three available rehearsal mark sequences simultaneously. For 
example, you can have the main sequence of rehearsal marks showing letters, but also have a 
secondary sequence of numbers to mark different moments, perhaps entry points for a solo line, 
and also highlight prominent bar numbers within those sections.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the rehearsal mark whose sequence type you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Sequence type in the Rehearsal Marks group.

3. Select one of the following options from the menu:

● Letters

● Numbers

● Bar numbers

RESULT
The selected rehearsal mark now displays a letter, a number, or the current bar number.

If it is the first rehearsal mark in either the letters sequence or the numbers sequence in the flow, 
it shows either A or 1. If there are already rehearsal marks in either the letters sequence or the 
numbers sequence in the flow, it shows the next letter or number according to the index.

Rehearsal marks
Changing the rehearsal mark sequence type 
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NOTE

You can change the index of a rehearsal mark sequence independently of other rehearsal mark 
sequences. However, you cannot change the index of rehearsal marks using the bar number 
sequence type.

RELATED LINKS
Inputting rehearsal marks on page 400
Adding bar number changes on page 836
Engrave toolbox on page 503

Adding prefixes/suffixes to rehearsal marks
You can add both prefixes and suffixes to individual rehearsal marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the rehearsal marks to which you want to add a prefix or suffix. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Rehearsal Marks group:

● Prefix

● Suffix

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text you entered into the value field is added to the selected rehearsal marks as a prefix or a 
suffix.

Editing the rehearsal mark paragraph style
You can edit the formatting of the paragraph style used for rehearsal marks; for example, if you 
want to change the size of rehearsal marks in full score layouts without affecting their size in part 
layouts.

PROCEDURE

1. Choose Library > Paragraph Styles to open the Paragraph Styles dialog.

2. In the paragraph styles list, select Rehearsal Marks.

3. Optional: Select one of the available styles from the Parent menu.

If you select a parent style, an activated switch is shown beside all the options that are 
different in the selected paragraph style, compared to its parent style.

4. Activate and change the available options as required.

Rehearsal marks
Adding prefixes/suffixes to rehearsal marks 
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5. Click OK to save your changes and close the dialog.

RESULT
The formatting of the rehearsal mark paragraph style is changed.

RELATED LINKS
Paragraph Styles dialog on page 756

Rehearsal marks
Editing the rehearsal mark paragraph style 
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Markers

Markers are labels locked to a particular position in time, most commonly in relation to a video. 
They typically indicate an important moment that requires musical prominence, and composers 
often use them to help shape the writing process.

Markers on a timecode staff showing custom text and timecodes

By default, markers in Dorico Elements show the default text “Marker” and also include the 
timecode of their fixed position in time.

In Dorico Elements, you can use markers in any project. However, because they are most 
commonly used in conjunction with video, markers are included in the Video panel in Write 
mode. There is also a Markers track in Play mode that displays markers, and allows you to input 
new ones.

You can use markers to help find suitable tempos for your project, as Dorico Elements can 
calculate possible tempos between important markers so that the markers occur on strong beats 
in the time signature.

You can show markers above/below the start of each system or below the timecode staff, if there 
is one, in each layout independently.

Any markers you input are automatically included when you export MIDI.

RELATED LINKS
Inputting markers/timecodes on page 401
Editing marker text on page 1223
Video panel on page 402
Changing the timecodes of markers on page 1224
Defining markers as important on page 1225
Timecodes on page 1226
Markers track on page 534
Exporting text on page 102

Hiding/Showing markers
By default, markers are shown in full score layouts and hidden in part layouts. You can hide 
and show markers in each layout independently; for example, if markers are helpful for the 
conductor to see but not for the players.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.
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2. In the Layouts list, select the layouts in which you want to hide/show markers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Markers and Timecode.

4. Activate/Deactivate Show markers.

5. Click Apply, then Close.

RESULT
Markers are hidden/shown in the selected layouts.

Changing the vertical position of markers
You can show markers above the system, below the system, or on a separate single-line 
timecode staff above a selected bracketed instrument family group, which can make them 
clearer in the score. When markers are shown on a timecode staff, timecodes are also 
automatically shown below the timecode staff.

NOTE

You cannot show multiple timecode staves in a system.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical position of 
markers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Markers and Timecode.

4. In the Markers subsection, choose one of the following options for Vertical position:

● Above system

● Below system

● Timecode staff

5. Optional: If you chose Timecode staff, select the bracketed instrument family above which 
you want to show the timecode staff from the Position timecode staff above bracket 
menu.

6. Click Apply, then Close.

RESULT
The vertical position of markers is changed in the selected layouts.

Markers
Changing the vertical position of markers 
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NOTE

● If you show markers on a timecode staff, timecodes are also shown on the staff by default. 
If you only want to show markers on a separate staff and exclude timecodes, you must then 
change Timecode frequency on timecode staff to Never.

You can also change the vertical position of timecodes so they appear above/below the start 
of systems rather than on the timecode staff.

● You can change the default distance between the timecode staff and other staves on the 
Vertical Spacing page in Layout Options.

AFTER COMPLETING THIS TASK
You can change the frequency of timecodes on the timecode staff.

RELATED LINKS
Changing the vertical position of timecodes on page 1227
Changing the timecode frequency on page 1228
Changing bracket grouping according to ensemble type on page 865
Layout Options dialog on page 745

Editing marker text
The default text shown in new markers is “Marker”. You can change the text shown in each 
marker individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the markers whose text you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Marker text in the Markers group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown in the selected markers is changed. It uses the Marker Text Font font style.

TIP

You can also enter custom text for markers when inputting them using the Add Marker dialog, 
and change marker text in the Markers section of the Video panel in Write mode.

RELATED LINKS
Add Marker dialog on page 402
Engrave toolbox on page 503

Markers
Editing marker text 
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Editing the marker/timecode font styles
You can edit the formatting of the font styles used for all markers and timecodes project-wide; 
for example, if you want markers to appear bold and italic. Markers and timecodes use different 
fonts, meaning you can change them independently of each other.

PROCEDURE

1. Choose Library > Font Styles to open the Edit Font Styles dialog.

2. In the font styles list, select one of the following font styles:

● Marker Text Font: Used for markers

● Marker Timecode Font: Used for timecodes shown in markers

● Timecode Font: Used for timecodes shown on a timecode staff

3. Activate the following options, individually or together, to change the corresponding aspect 
of the font:

● Font family

● Size

● Style

● Underlined

4. Optional: If required, repeat steps 2 and 3 to change the other font.

5. Click OK to save your changes and close the dialog.

RESULT
The formatting of the selected font styles is changed project-wide.

RELATED LINKS
Edit Font Styles dialog on page 754

Changing the timecodes of markers
You can change the timecodes of individual markers after they have been input; for example, if 
the video has been edited and the marker now occurs ten seconds later.

NOTE

Because this changes where markers occur in the project, this also moves markers relative to the 
notated music.

PROCEDURE

1. In Write mode, select an item in the flow containing the markers whose timecodes you want 
to change.

2. In the Notations toolbox, click Panels , then Video  to show the Video panel.

3. In the Markers section, double-click the timecode you want to change.

4. Enter the new timecode you want into the value field.

5. Press Return .

Markers
Editing the marker/timecode font styles 
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RESULT
The timecode of the marker is changed. The marker automatically moves relative to the music to 
reflect its new time position.

RELATED LINKS
Video panel on page 402
Changing the initial timecode value on page 1227

Defining markers as important
You can define individual markers as important, which allows them to be considered when 
finding suitable tempos in the Find Tempo dialog.

PROCEDURE

1. In Write mode, click Video in the Notations toolbox to show the Video panel.

2. In the Markers section, activate the checkbox in the Imp. column for each marker you want 
to define as important.

RESULT
Markers with activated checkboxes are defined as important. The Find Tempo button at the 
bottom of the Markers section becomes available.

RELATED LINKS
Find Tempo dialog on page 403

Markers
Defining markers as important 
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Timecodes

Timecodes indicate an exact position in time, usually in the context of a video. They allow precise 
synchronization between multiple elements, such as music and moving images, and can be used 
as a reference tool.

Timecodes are displayed in the format hh:mm:ss:ff, which is two-digit hours, minutes, seconds, 
and frames.

A timecode on a timecode staff

In Dorico Elements, you can specify the type of timecode from the following types:

Non-drop frame timecodes
Each frame is numbered sequentially from the preceding one without skipping any 
frame numbers.

Non-drop frame timecodes are shown with the suffix fps and use a colon separator 
between seconds and frames; for example, 00:00:01:05.

Drop frame timecodes
Some frame numbers are skipped in order to accommodate the difference in frame 
rate between 29.97 fps and 30 fps. In every minute except every tenth minute, two 
timecode numbers are dropped from the frame count.

Drop frame timecodes are shown with the suffix dfps and use a semicolon separator 
between the seconds and frames; for example, 00:00:01;05.

Timecodes in Dorico Elements are flow-specific, meaning you can set timecodes for each flow 
that are completely independent of the timecodes for other flows. You can set timecodes in the 
Video Properties dialog, including for flows without a video.

NOTE

The timecodes shown in flow cards in the Flows panel in Setup mode reflect the timecode at the 
start of the flow, which can be different to the timecode you set in the Video Properties dialog. 
For example, if you set the Timecode start to 02:00:00:00 but also set the Flow attachment 
position to 8 quarter note beats, and the tempo is 60 bpm, the timecode shown in the flow card 
is 01:59:52:00.

By default, timecodes appear in markers. You can show markers above/below the start of each 
system or below the timecode staff, if there is one, in each layout independently.

Additionally, you can change the time displayed in the Transport window to be the timecode 
rather than elapsed time, which is shown by default.
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RELATED LINKS
Inputting markers/timecodes on page 401
Frame rates on page 193
Video Properties dialog on page 190
Editing the marker/timecode font styles on page 1224
Changing the content shown in the transport display on page 558
Markers on page 1221
Changing the timecodes of markers on page 1224

Changing the initial timecode value
You can change the timecode at which each flow in your project starts; for example, if you are 
using a separate project for the second reel of a film. You can also change the initial timecode in 
projects without videos.

PROCEDURE

1. In Write mode, select an item in the flow whose initial timecode value you want to change.

2. In the Notations toolbox, click Panels , then Video  to show the Video panel.

3. In the Video panel, click Properties to open the Video Properties dialog.

4. Change the value for Timecode start.

5. Click OK to save your changes and close the dialog.

RESULT
The initial timecode for the flow in which you selected an item is changed.

RELATED LINKS
Video panel on page 402
Changing the start position of videos on page 191
Changing the timecodes of markers on page 1224

Changing the vertical position of timecodes
You can show timecodes either above/below the start of systems or on a separate single-line 
staff in each layout independently. For example, you can show timecodes and markers on a 
separate timecode staff in full score layouts but show only timecodes above the start of systems 
in part layouts.

NOTE

You cannot show timecodes on multiple staves in a system.

PREREQUISITE
If you want to show timecodes on a separate staff, you have changed the vertical position of 
markers so they appear on a separate staff.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the vertical position of 
timecodes.

Timecodes
Changing the initial timecode value 
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By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Markers and Timecode.

4. In the Timecode subsection, choose one of the following options for Show timecode:

● Above or below start of system

● Below timecode staff

5. Optional: If you chose Above or below start of system, choose one of the following options 
for Timecode position relative to system:

● Above system

● Below system

6. Optional: If you chose Above or below start of system and want to change the gap 
between timecodes and the staff, change the values in the Offset at start of system value 
fields.

7. Click Apply, then Close.

RESULT
The vertical position of timecodes is changed in the selected layouts.

NOTE

Your setting for Timecode frequency on timecode staff also applies when timecodes are shown 
above/below the start of systems.

RELATED LINKS
Changing the vertical position of markers on page 1222

Changing the timecode frequency
You can show timecodes at different intervals in layouts in which timecodes are shown on a 
separate staff. For example, you can show timecodes every bar in full score layouts but only at 
the start of each system in part layouts.

NOTE

We do not recommend that you show timecodes every bar in layouts with multi-bar rests, as 
the result is illegible overlapping timecodes. If you want to show timecodes in part layouts with 
multi-bar rests, we recommend either showing timecodes only at the start of each system or not 
showing multi-bar rests in the layout.

PREREQUISITE
Markers are shown in the selected layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the timecode frequency.

Timecodes
Changing the timecode frequency 
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By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Markers and Timecode.

4. Optional: If the selected layouts do not show timecodes on a separate staff, choose 
Timecode staff for Vertical position.

5. Choose one of the following options for Timecode frequency on timecode staff:

● Start of system

● Every bar

● Never

6. Click Apply, then Close.

RELATED LINKS
Hiding/Showing markers on page 1221
Hiding/Showing multi-bar rests on page 1279

Timecodes
Changing the timecode frequency 

1229
Dorico Elements 5.1.30



Repeat endings

For music with repeated passages, repeat endings show which bars are played at the end of each 
repetition, with different endings each time if required. They are also known as “volta lines”, or as 
“first and second endings”, but in this documentation, we refer to them as “repeat endings”.

Repeat endings comprise two or more segments, where each segment contains a different 
possible ending. When you input repeat endings, Dorico Elements automatically inputs an end 
repeat barline at the end of the first segment. Segments in repeat endings are clearly marked 
with solid lines above and numbers that indicate the playthroughs in which the segment is used.

A repeat ending with three playthroughs divided across two endings

Dorico Elements allows you to create repeat endings containing any number of segments, 
and allows you to control which segments are used for each playthrough. For example, you 
might want a repeat ending with two segments but four total playthroughs, where the first two 
playthroughs use the first repeat ending segment and the final two playthroughs use the second 
repeat ending segment.

In Dorico Elements, repeat endings are categorized as system objects. Therefore, repeat endings 
follow your per-layout settings for the visibility and positioning of system objects.

RELATED LINKS
Input methods for repeats and tremolos on page 405
Layout Options dialog on page 745
System objects on page 1326
Repeats in playback on page 549
Changing the number of playthroughs at repeat barlines on page 551
Types of barlines on page 816
Lines on page 1194

Changing the total number of playthroughs in repeat 
endings

By default, each segment in repeat endings is played once, so each segment shows a single 
digit that indicates the playthrough for which it is used. You can increase the total number of 
playthroughs for repeat endings individually so that segments are played more than once.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the repeat endings whose total number of playthroughs you want to change. You can 
do this in Write mode and Engrave mode.

2. In the Properties panel, activate No. times played in the Repeat Endings group.

3. Change the value in the value field.

NOTE

You cannot have fewer playthroughs than the number of segments.

RESULT
The total number of playthroughs in the selected repeat endings is changed. Dorico Elements 
adds additional playthroughs to the last closed segment in the repeat ending.

AFTER COMPLETING THIS TASK
Once you have set the total number of playthroughs, you can then change which segment is 
used for each playthrough.

RELATED LINKS
Repeats in playback on page 549
Changing the number of playthroughs at repeat barlines on page 551
Muting notes/items individually on page 548
Engrave toolbox on page 503
Input methods for repeats and tremolos on page 405

Dividing playthroughs across repeat ending segments
You can control how the total number of playthroughs is divided across the different segments in 
individual repeat endings. For example, if in a repeat ending with six playthroughs, you want to 
include playthroughs 1 to 3 in the first ending and playthroughs 4 to 6 in the second ending.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select an individual segment in the repeat ending structure whose 
included playthroughs you want to change.

2. In the Properties panel, activate Times played for segment in the Repeat Endings group.

3. Enter the number of each playthrough that you want to include in the selected segment, 
with each playthrough separated by a comma.

For example, for a repeat ending with six playthroughs, enter 4,5,6 to include the 4th, 5th, 
and 6th playthroughs in the second segment.

RESULT
The playthroughs included in the selected segment are changed.

Repeat endings
Changing the total number of playthroughs in repeat endings 
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EXAMPLE

Default distribution of playthroughs Customized distribution of playthroughs

Lengthening/Shortening segments in repeat endings
You can increase/decrease the number of bars included in each segment of repeat endings by 
lengthening/shortening each segment independently.

PROCEDURE

1. In Write mode, select the repeat ending you want to lengthen/shorten.

NOTE

You can only lengthen/shorten one repeat ending segment at a time.

2. Select the circular handle at the end of the segment you want to lengthen/shorten.

The selected handle in the middle has a thicker line.

3. Click and drag the handle to the right/left to snap it to the next/previous barline.

NOTE

Segments must contain at least one bar.

4. Optional: Repeat steps 1 to 3 for each segment in the repeat ending.

RESULT
The selected segment is lengthened/shortened.

NOTE

● This does not automatically input or move repeat barlines. You must input and delete repeat 
barlines as appropriate manually.

● You can also lengthen/shorten the final segment in a single repeat ending by selecting the 
repeat ending and using the following key commands:

● To lengthen the final segment, press Shift-Alt/Opt-Right Arrow .

● To shorten the final segment, press Shift-Alt/Opt-Left Arrow .

RELATED LINKS
Input methods for bars, beats, and barlines on page 300
Deleting notes/items on page 455

Repeat endings
Lengthening/Shortening segments in repeat endings 
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Moving items graphically on page 514
Changing the appearance of repeat ending segments on page 1234

Positions of repeat endings
Repeat endings are placed above the staff at the same positions as other system objects, and 
their hooks align with barlines. They are commonly positioned outside of other notations, but 
some long items, such as gradual tempo changes, can be placed above repeat endings.

You can move repeat endings to different rhythmic positions in Write mode.

You can move each repeat ending segment graphically in Engrave mode and independently of 
other segments in the repeat ending; however, this does not change the rhythmic positions to 
which they are attached.

In Engrave mode, each repeat ending segment has two square handles, one at the start and one 
at the end.

If repeat ending segments cross system and frame breaks, you can move the segments on each 
side of the break independently.

Repeat endings are categorized as system objects in Dorico Elements, which you can show above 
the first bracket of selected instrument families. You can change the instrument families above 
which system objects appear in each layout independently; for example, if you want repeat 
endings to appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Moving notes/items rhythmically on page 461
Moving items graphically on page 514
System objects on page 1326
Input methods for repeats and tremolos on page 405

Editing repeat ending text
You can replace the text shown in individual segments in repeat endings with custom text. By 
default, it shows the playthrough numbers for the segment.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the repeat ending segments whose text you want to change.

2. In the Properties panel, activate Custom text in the Repeat Endings group.

3. Enter the text you want into the value field.

4. Press Return .

Repeat endings
Positions of repeat endings 
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RESULT
The text shown in the selected segments is changed.

Deactivating Custom text restores the default text for the selected repeat ending segments.

NOTE

● Deactivating properties permanently deletes any custom text entered.

● You can edit the formatting of the Repeat Endings Font in the Edit Font Styles dialog. For 
example, if you want all repeat ending text project-wide to appear in italics.

RELATED LINKS
Engrave toolbox on page 503
Edit Font Styles dialog on page 754
Changing the total number of playthroughs in repeat endings on page 1230
Dividing playthroughs across repeat ending segments on page 1231

Changing the appearance of repeat ending segments
You can change the appearance and length of individual repeat ending segments, independently 
of other segments.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the repeat ending segments whose appearance you want to 
change.

NOTE

You must select either only final segments or only preceding segments.

2. In the Properties panel, activate End of line in the Repeat Endings group.

3. Select one of the following options from the menu:

● Open, short

● Open, full length

● Closed

RESULT
The appearance of the selected repeat ending segments is changed.

Lengthening/Shortening repeat ending hooks
You can lengthen/shorten the hooks in repeat endings individually. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

Repeat endings
Changing the appearance of repeat ending segments 
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NOTE

You cannot change the hook length of an individual segment in a repeat ending. Changing the 
hook length affects the whole repeat ending.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the repeat endings whose hooks you want to lengthen/shorten.

2. In the Properties panel, activate Hook length in the Repeat Endings group.

3. Change the value in the value field.

RESULT
Increasing the value makes repeat ending hooks longer. Decreasing the value makes repeat 
ending hooks shorter. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Repeat endings in MusicXML files
All aspects of repeat endings can be imported from and exported in MusicXML files.

However, while MusicXML can represent this, segments in the middle of sets of endings cannot 
have an open right-hand end in Dorico Elements.

Repeat endings
Repeat endings in MusicXML files 

1235
Dorico Elements 5.1.30



Repeat markers

Repeat markers show that musical material is to be repeated, but unlike repeat endings, repeat 
markers often involve jumping to different positions and sections in the music instead of moving 
through the music consecutively.

A mid-system coda section

In Dorico Elements, repeat markers are divided into the following types:

Repeat jumps
Specify the position from which players or playback must jump, such as D.C. al Coda or 
D.S. al Fine.

Repeat jumps are right-aligned with their rhythmic position, meaning their text or 
symbol ends at that rhythmic position and extends to the left.

Repeat sections
Specify the destinations for jumps, such as segno or coda, or where the music 
should end, such as Fine. In Dorico Elements, coda sections that start mid-system are 
automatically separated from the preceding music with a gap. Coda sections at the 
start of systems are indented by the same amount.

Repeat markers are left-aligned with their rhythmic position, meaning their text or 
symbol starts at that rhythmic position and extends to the right.

By default, repeat markers are shown on a single line, but you can show them on two 
lines individually to reduce their horizontal length if necessary. You can also customize their 
paragraph styles, including changing their font size, in the Paragraph Styles dialog.

RELATED LINKS
Input methods for repeats and tremolos on page 405
Showing repeat markers on one/two lines on page 1239
Paragraph Styles dialog on page 756
Repeats in playback on page 549
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Repeat counts on page 1242
Changing the gap before codas on page 1242
Types of barlines on page 816

Repeat marker paragraph styles
Repeat markers use paragraph styles to format their fonts, including their size, spacing, 
alignment, and other formatting options. Because the different types of repeat markers require 
different formatting, they each have a separate paragraph style by default.

Dorico Elements provides the following default paragraph styles for repeat markers:

● Repeat Marker Jumps: The default paragraph style used for repeat jumps, such as D.C. al 
Coda or D.S. al Fine.

● Repeat Marker Sections: The default paragraph style used for repeat sections, such as coda 
or Fine.

By default, the formatting of these paragraph styles is the same but you can edit paragraph 
styles independently of each other in the Paragraph Styles dialog; for example, if you want to 
decrease the size of repeat jumps but leave repeat sections with their default size.

NOTE

The Repeat Marker Jumps paragraph style inherits settings from the Repeat Marker Sections 
style. If you change the Repeat Marker Sections paragraph style, this also affects any 
corresponding options for the Repeat Marker Jumps paragraph style that have not been 
overridden.

RELATED LINKS
Paragraph Styles dialog on page 756
Editing repeat marker text on page 1238
Showing repeat markers on one/two lines on page 1239

Changing the index for repeat markers
You can change the index of individual repeat markers; for example, if a flow requires two 
different codas with different symbols so players can tell them apart.

By default, all repeat markers of the same type have the same appearance, even when there are 
multiple repeat markers in the flow.

NOTE

You cannot change the index of Fine or D.C. repeat markers.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the repeat marker whose index you want to change. You can do this in Write mode 
and Engrave mode.

Repeat markers
Repeat marker paragraph styles 
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2. In the Properties panel, activate the following properties, individually or together as 
appropriate for your selection, in the Repeat Markers group:

● Marker index

● ‘Jump to’ index

3. Change the values in the value fields.

NOTE

You can only enter values between 1 and 3.

RESULT
Marker index changes the order of the selected repeat marker relative to other repeat markers 
of the same type.

‘Jump to’ index changes the destination of the selected repeat marker.

EXAMPLE
If you have two codas in a flow with two different D.S. al Coda markers, you might set Marker 
index to 1 for the first coda and 2 for the second, then set ‘Jump to’ index to 1 for the first D.S. al 
Coda marker and 2 for the second.

D.S. al Coda marker with default indexes D.S. al Coda marker with both indexes set to 2

RELATED LINKS
Repeats in playback on page 549
Engrave toolbox on page 503
Input methods for repeats and tremolos on page 405

Editing repeat marker text
You can change the text shown in individual repeat markers; for example, if you are typesetting a 
score with an unusual repeat marker instruction.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the repeat markers whose text you want to change. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Custom text in the Repeat Markers group.

3. Enter the text you want into the value field.

4. Press Return .

Repeat markers
Editing repeat marker text 
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RESULT
The text shown in the selected repeat markers is changed. Segno symbols and coda symbols in 
D.C./D.S. repeat jumps are removed and replaced with your custom text.

RELATED LINKS
Engrave toolbox on page 503

Showing repeat markers on one/two lines
You can show individual repeat markers either on a single line or spread across two lines, 
independently of your per-layout settings; for example, if a single long repeat marker extends 
beyond the page margins in one part layout. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

NOTE

You can only change the word wrapping of repeat jumps, such as D.C. al Fine and D.S. al Coda, 
that do not have custom text.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the repeat markers whose word wrapping you want to change.

2. In the Properties panel, activate Word wrap in the Repeat Markers group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected repeat markers are shown on two lines when the checkbox is activated, and on one 
line when the checkbox is deactivated. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

When the property is deactivated, repeat markers follow your per-layout setting for word 
wrapping.

TIP

You can show all repeat markers on two lines in each layout independently in Layout Options > 
Staves and Systems > Repeat Markers. For example, you can show them on one line in the full 
score but on two lines in part layouts.

Repeat markers
Editing repeat marker text 
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EXAMPLE

Repeat marker without word wrapping Repeat marker with word wrapping

RELATED LINKS
Layout Options dialog on page 745
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Hiding/Showing repeat markers
You can hide/show repeat markers individually; for example, if you want a separated coda 
section without showing the coda symbol and text.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the repeat markers you want to hide, or the signposts of repeat markers you want to 
show. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hide in the Repeat Markers group.

RESULT
The selected repeat markers are hidden when Hide is activated, and shown when it is 
deactivated.

Signposts are shown at the position of each hidden repeat marker. However, signposts are not 
printed by default.

TIP

You can hide/show repeat marker signposts by choosing View > Signposts > Repeat Markers.

RELATED LINKS
Signposts on page 450
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Annotations on page 597
Input methods for repeats and tremolos on page 405

Repeat markers
Hiding/Showing repeat markers 
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Positions of repeat markers
Repeat markers are placed above the staff by default, and at the same positions as other system 
objects. Coda sections are separated from the preceding music by a gap in the system.

You can move repeat markers to different rhythmic positions in Write mode.

You can move repeat markers graphically in Engrave mode, but this does not change the 
rhythmic positions to which they are attached.

You can change the default staff-relative placement of repeat markers in each layout 
independently.

Repeat markers are categorized as system objects in Dorico Elements, which you can show above 
the first bracket of selected instrument families. You can change the instrument families above 
which system objects appear in each layout independently; for example, if you want repeat 
markers to appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Input methods for repeats and tremolos on page 405
Layout Options dialog on page 745
Changing the positions of system objects on page 1327
Moving notes/items rhythmically on page 461
Moving items graphically on page 514
Repeats in playback on page 549

Changing the staff-relative placement of repeat markers
You can show repeat markers either above, below, or both above and below the staff in each 
layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the staff-placement of 
repeat markers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Repeat Markers section, choose one of the following options for Default placement 
for repeat jumps and ‘Fine’:

● Above staff

● Below staff

● Above and below bottom staff

5. Click Apply, then Close.

RESULT
The staff-relative placement of all repeat markers is changed in the selected layouts.

Repeat markers
Positions of repeat markers 
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Changing the gap before codas
You can change the gap preceding individual coda sections.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the codas whose gap you want to change. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Coda gap width in the Repeat Markers group.

3. Change the value in the value field.

RESULT
The gap preceding the selected coda sections is changed.

RELATED LINKS
Moving the start/end of systems on page 513
Changing the first system indent on page 1328
Hiding/Showing systemic barlines and brackets/braces on page 820
Input methods for repeats and tremolos on page 405

Repeat counts
Repeat counts at end repeat barlines tell performers how many times to play through sections of 
music. This is particularly helpful for sections played through three or more times, as end repeat 
barlines typically indicate that the preceding music is played through twice.

By default, Dorico Elements shows repeat counts at system object positions for end repeat 
barlines set to have three or more playthroughs, when repeats are included in playback.

Repeat count at the end of a section, indicating it should be played four times

Repeat counts are right-aligned with their end repeat barline by default. You can change the 
location of repeat counts; for example, if you want to show repeat counts at both the start and 
end of repeated sections, or hide repeat counts entirely. Repeat counts shown at the start of 
repeated sections are left-aligned with start repeat barlines.

Repeat markers
Repeat counts 
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TIP

Repeat counts use the Repeat Counts paragraph style, which you can edit in the Paragraph 
Styles dialog.

RELATED LINKS
Changing the number of playthroughs at repeat barlines on page 551
Repeats in playback on page 549
Including/Excluding repeats in playback on page 550
Input methods for bars, beats, and barlines on page 300
System objects on page 1326
Changing the application language on page 57
Paragraph Styles dialog on page 756
Bar repeat counts on page 1247
Slash region counts on page 1265
Numbered bar region counts on page 1254

Changing the location of repeat counts
You can change the location of individual repeat counts relative to the repeated section. For 
example, if you want to show some repeat counts at the start of repeated sections or hide some 
repeat counts entirely. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● Repeats are included in playback.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the end repeat barlines or repeat counts whose count location you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Count location in the Time Signatures group.

3. Select one of the following options from the menu:

● Start

● End

● Neither

● Both

RESULT
The location of the selected repeat counts is changed. Repeat counts shown at the start of 
repeated sections are left-aligned with the start repeat barlines that correspond to the selected 
end repeat barlines.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

Repeat markers
Repeat counts 
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EXAMPLE

Both Neither

RELATED LINKS
Repeats in playback on page 549
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Moving items graphically on page 514

Repeat markers
Repeat counts 
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Bar repeats

Bar repeats indicate that the musical material in preceding bars must be repeated exactly, but 
without notating that material again. Bar repeats can comprise groups of one, two, or four bars.

For example, a one-bar repeat indicates that the material in one bar is repeated, meaning every 
bar in the region repeats the same material. A four-bar repeat indicates that the material in the 
previous four bars is repeated.

One-bar repeat region Two-bar repeat region

Four-bar repeat region

This notation short-hand can make repetitive music easier to read, as performers must only read 
the repeated phrase once and then simply count how many times they repeat it. Bar repeats can 
also save horizontal space, as bar repeat symbols are usually narrower than the equivalent fully 
written-out bars.

In Dorico Elements, bar repeat regions are used to display bar repeats, meaning as many bar 
repeat symbols as necessary to fill the region are shown automatically.

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

By default, bar repeat regions are highlighted with a colored background. As you zoom out, the 
highlights become more opaque, which is especially useful when viewing full score layouts in 
galley view. These highlights are considered annotations, are not printed by default, and you can 
hide/show them.

You can also show adjacent bar repeat regions; for example, if you want to use a two-bar repeat 
in the first iteration of a phrase, and then a four-bar repeat to indicate the whole phrase is 
repeated. When two different bar repeat regions are adjacent, they alternate highlight colors to 
ensure the separate regions are always identifiable.

Phrase containing two adjacent bar repeat regions
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RELATED LINKS
Inputting bar repeats on page 418
Repeats popover on page 406
Bar repeat counts on page 1247
Bar repeat grouping on page 1251
Numbered bar regions on page 1253
Slash regions on page 1261
Repeat counts on page 1242
Moving notes/items rhythmically on page 461
Lengthening/Shortening items on page 430
Hiding/Showing multi-bar rests on page 1279
Types of barlines on page 816
Changing the number of playthroughs at repeat barlines on page 551
Annotations on page 597

Changing the length of the repeated phrase in bar repeat 
regions

You can change the number of bars that make up the repeated phrase in individual bar repeats 
after you have input them; for example, if you want the region to repeat the previous two bars 
rather than the previous four bars.

NOTE

You cannot repeat more bars than exist before the bar repeat region. For example, if a bar 
repeat region follows the first notated bar in a flow, you cannot increase the number of bars in 
the repeated phrase.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the bar repeat regions whose phrase length you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, select one of the following options from the No. bars menu in the 
Bar Repeat Regions group:

● One bar

● Two bars

● Four bars

RESULT
The number of bars that make up the repeated phrase in the selected bar repeat regions is 
changed. This is also reflected in playback.

TIP

● Any dynamics you add within bar repeat regions affect the playback of the repeated music.

Bar repeats
Changing the length of the repeated phrase in bar repeat regions 
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● You can also change the length of the repeated phrase by opening the repeats popover and 
changing the entry.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Repeats popover on page 406

Hiding/Showing region highlights
You can hide/show colored highlights for bar repeat and numbered bar regions at any time; 
for example, if you want to show the highlights when inputting music but hide them when 
engraving.

PROCEDURE

● Choose View > Highlight Bar Repeat Regions.

RELATED LINKS
Numbered bar regions on page 1253

Bar repeat counts
Bar repeat counts are numbers shown at regular intervals either above or below bar repeats, to 
help performers keep track of how many bars have passed. The intervals are usually based on 
typical musical phrases, such as every four or eight bars.

NOTE

Bar repeat counts are only shown on one-bar repeat regions.

Because bar repeats must start with a fully notated phrase of at least one bar, the bar repeat 
count starts from the notated bar rather than the first bar in the bar repeat region. For example, 
the third bar in a bar repeat region shows the count number 4, as that bar is the fourth time the 
original notated bar is played. Each bar repeat region has its own separate count.

Bar repeat region with counts shown every four bars

In Dorico Elements, you can change the start count of each bar repeat region, how frequently 
counts are shown, and whether counts are shown with parentheses, without parentheses, or 
hidden. You can also customize the count font style.

NOTE

Bar repeat, slash, and numbered bar region counts use the same font style.

RELATED LINKS
Editing the count font style on page 1250
Repeats popover on page 406

Bar repeats
Hiding/Showing region highlights 
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Inputting bar repeats on page 418
Bar repeat grouping on page 1251
Hiding/Showing bar number ranges on multi-bar rests on page 828
Hiding/Showing multi-bar rests on page 1279
Repeat counts on page 1242
Slash region counts on page 1265
Numbered bar region counts on page 1254

Changing the start count of bar repeats
You can change the number from which individual bar repeats start; for example, if you want to 
notate the first bar in a repeated phrase at the start of each system, but show a continuous count 
across multiple bar repeats.

NOTE

● The start count applies to the first bar in the bar repeat, which is the notated bar. For 
example, changing the start count of a one-bar repeat region lasting three bars to 5, with 
bar repeat counts shown every four bars, causes the count at the end of the bar repeat 
region to show the number 8.

● Bar repeat counts are only shown on one-bar repeat regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the one-bar repeat regions whose start count you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Count from in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The start count of the selected bar repeat regions is changed. If the count frequency is every two 
bars or more, counts appear on different bars. For example, changing the start count from 1 to 
2, with counts shown every four bars, causes the count to appear on the second bar in the bar 
repeat region instead of the third.

Bar repeats
Bar repeat counts 
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EXAMPLE

Separate bar repeats on multiple systems in the 
same part layout with the default count

Separate bar repeats on multiple systems in the 
same part layout with their counts changed to imply 
a continuous region

Changing the bar repeat count frequency
You can change how often counts are shown on individual one-bar repeat regions; for example, if 
you want to show the count after eight bars on a single bar repeat region.

NOTE

Bar repeat counts are only shown on one-bar repeat regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the one-bar repeats whose count frequency you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Count frequency in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The count frequency is changed for the selected bar repeat regions.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Hiding/Showing bar number ranges on multi-bar rests on page 828

Hiding/Showing or parenthesizing bar repeat counts
You can hide counts or show counts with or without parentheses for individual bar repeat 
regions. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

Bar repeats
Bar repeat counts 
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NOTE

Bar repeat counts are only shown on one-bar repeat regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the one-bar repeats whose counts you want to hide/show or parenthesize. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Count appearance in the Bar Repeat Regions group.

3. Select one of the following options from the menu:

● With parentheses

● Without parentheses

● Do not show

RESULT
Counts in the selected bar repeat regions are shown with parentheses, without parentheses, or 
hidden. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665

Editing the count font style
You can edit the formatting of the font style used for all bar repeat, slash, and numbered bar 
region counts project-wide; for example, if you want counts to appear bold and italic.

PROCEDURE

1. Choose Library > Font Styles to open the Edit Font Styles dialog.

2. In the font styles list, select Bar Repeat Count.

3. Activate the following options, individually or together, to change the corresponding aspect 
of the font:

● Font family

● Size

● Style

● Underlined

4. Click OK to save your changes and close the dialog.

Bar repeats
Bar repeat counts 
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RESULT
The formatting of the font style used for counts in bar repeat, slash, and numbered bar regions 
is changed project-wide.

RELATED LINKS
Edit Font Styles dialog on page 754
Slash region counts on page 1265
Numbered bar region counts on page 1254

Bar repeat grouping
Bar repeat grouping allows you to consolidate longer bar repeat regions, which can be helpful in 
very regular music as it can simplify the overall phrasing.

The symbols shown on the staff are different for the different groupings, and two-bar and 
four-bar repeats also show a number to indicate how many bars are included in the group.

One-bar repeat symbol Two-bar repeat symbol Three-bar repeat symbol Four-bar repeat symbol

You can specify the grouping when inputting bar repeats, and you can change the grouping 
of bar repeats after they have been input. Depending on where the bar repeat region starts 
and ends relative to the written material, Dorico Elements automatically adjusts the displayed 
symbols to achieve an accurate result. For example, an eight-bar phrase containing a single 
notated bar followed by seven one-bar repeats grouped every four bars is automatically shown 
with a one-bar repeat, two-bar repeat, then four-bar repeat to fill the seven bars.

Eight-bar phrase with seven one-bar repeats grouped every four bars

TIP

When showing multi-bar rests, you can also choose to consolidate one-bar repeat regions.

RELATED LINKS
Inputting bar repeats on page 418
Hiding/Showing multi-bar rests on page 1279

Changing bar repeat grouping
You can change how bar repeats are grouped after they have been input; for example, if you 
want to group a region of one-bar repeats every two bars.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

Bar repeats
Bar repeat grouping 

1251
Dorico Elements 5.1.30



● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the bar repeat regions whose grouping you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, select one of the following options from the Group every menu in 
the Bar Repeat Regions group:

● One bar

● Two bars

● Four bars

NOTE

The options available depend on the minimum length of the selected bar repeat regions. For 
example, if you select bar repeat regions that last three bars, only One bar and Two bars are 
available in the menu.

RESULT
The grouping in the selected bar repeat regions is changed. Dorico Elements automatically 
calculates the clearest way to group the region. For example, an eight-bar phrase containing a 
single notated bar followed by seven one-bar repeats grouped every four bars is automatically 
shown with a one-bar repeat, two-bar repeat, then four-bar repeat to fill the seven bars.

Bar repeats
Bar repeat grouping 
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Numbered bar regions

Numbered bar regions allow you to show bar counts in specific regions without additional 
notations. This can help performers keep track of how many bars have passed when playing 
repetitive music.

Numbered bar region spanning six bars

By default, numbered bar regions are hidden in full score/custom score layouts and shown in 
part layouts. You can hide/show numbered bar regions in each layout independently.

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

By default, numbered bar regions are highlighted with a colored background. As you zoom out, 
the highlights become more opaque, which is especially useful when viewing full score layouts in 
galley view. These highlights are considered annotations, are not printed by default, and you can 
hide/show them.

When two different numbered bar regions are adjacent, they alternate highlight colors to ensure 
the separate regions are always identifiable.

Phrase containing two adjacent numbered bar regions

RELATED LINKS
Inputting numbered bar regions on page 419
Hiding/Showing region highlights on page 1247
Lengthening/Shortening items on page 430
Bar repeats on page 1245
Slash regions on page 1261
Repeat counts on page 1242
Bar numbers on page 826
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Hiding/Showing numbered bar regions
You can input numbered bar regions in any layout, but by default they do not appear in full 
score layouts, as they are normally most useful in part layouts. You can hide/show numbered bar 
regions in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show numbered bar regions.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Numbered Bar Regions section, activate/deactivate Show bar count in numbered 
bar regions.

5. Click Apply, then Close.

RESULT
Numbered bar regions are shown in the selected layouts when the checkbox is activated, and 
hidden when the checkbox is deactivated.

Numbered bar region counts
Numbered bar region counts are numbers shown at regular intervals either above or below the 
staff, to help performers keep track of how many bars have passed.

By default, bar counts are shown on every bar in numbered bar regions. They are also shown on 
the last bar in each system and on the first and last bars in each region, regardless of the count 
frequency.

When numbered bar regions last four or more bars, Dorico Elements adds the total range in 
parentheses to the count on the first bar, such as showing “1 (-8)” on the first bar in a numbered 
bar region lasting eight bars.

Numbered bar region with counts shown every three bars, count and range shown at the start, and 
parenthesized count shown at the end of the system

In Dorico Elements, you can change the start count of each numbered bar region, how 
frequently counts are shown, their staff-relative placement, and whether counts and ranges are 
shown with parentheses, without parentheses, or hidden. You can also customize the count font 
style.

NOTE

Bar repeat, slash, and numbered bar region counts use the same font style.

Numbered bar regions
Hiding/Showing numbered bar regions 
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RELATED LINKS
Inputting numbered bar regions on page 419
Editing the count font style on page 1250
Repeat counts on page 1242
Bar repeat counts on page 1247
Slash region counts on page 1265

Changing the start count of numbered bar regions
You can change the number from which individual numbered bar regions start; for example, if 
you want to show a continuous count across multiple numbered bar regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the numbered bar regions whose start count you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Count from in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The start count of the selected numbered bar regions is changed. If the count frequency is every 
two bars or more, counts appear on different bars. For example, changing the start count from 
1 to 2, with counts shown every four bars, causes the count to appear on the third bar in the 
region instead of the fourth.

Changing the numbered bar region count frequency
You can change how frequently counts are shown in individual numbered bar regions; for 
example, if you want to show the count after eight bars in a single numbered bar region.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the numbered bar regions whose count frequency you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Count frequency in the Bar Repeat Regions group.

3. Change the value in the value field.

RESULT
The count frequency is changed for the selected numbered bar regions.

Numbered bar regions
Numbered bar region counts 

1255
Dorico Elements 5.1.30



RELATED LINKS
Engrave toolbox on page 503
Hiding/Showing bar number ranges on multi-bar rests on page 828

Hiding/Showing or parenthesizing numbered bar region counts
You can show counts with or without parentheses for individual numbered bar regions. You can 
also hide/show or parenthesize counts at the ends of systems and on the first and last bars in 
each region independently of each other. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the numbered bar regions whose counts you want to hide/show or parenthesize. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Count appearance in the Bar Repeat Regions group.

3. Select one of the following options from the menu:

● Without parentheses

● With parentheses

4. Activate Range appearance and select one of the following options from the menu:

● With parentheses

● Without parentheses

● No range

5. Activate the following properties, individually or together, to change the appearance of the 
corresponding count:

● Show in first bar

● Show in final bar

● Show at ends of systems

6. Select one of the following options from each menu:

● With parentheses

● Without parentheses

● Do not show

RESULT
The corresponding counts and ranges in the selected numbered bar regions are shown with 
parentheses, without parentheses, or hidden. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

Numbered bar regions
Numbered bar region counts 
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EXAMPLE

Counts and range shown without parentheses Range hidden and counts shown with parentheses

RELATED LINKS
Numbered bar region counts on page 1254
Inputting numbered bar regions on page 419
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the staff-relative placement of numbered bar region 
counts

You can show the counts in individual numbered bar regions either above or below the staff. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

Changing the staff-relative placement of counts affects all counts in the region. You cannot 
change the placement of a single count independently of other counts in the region.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the numbered bar regions whose count staff-relative placement you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Staff-relative position in the Bar Repeat Regions group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of all counts in the selected numbered bar regions is changed. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

Numbered bar regions
Numbered bar region counts 
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Rhythm slashes

Rhythm slashes are diagonal lines positioned on staves that are used to indicate that performers 
should play something, but without specifying the exact rhythms and pitches. They are often 
accompanied by chord symbols to indicate the set of notes the performer should use.

There are two different types of rhythm slashes:

Slashes with stems

Slashes with stems usually indicate the rhythm to be played, but not the pitches. Also 
known as “rhythmic notation”.

Slashes without stems

Slashes without stems do not usually indicate either rhythms or pitches. Also known as 
“slash notation”

In Dorico Elements, you can present both types of rhythm slashes simultaneously by using a 
combination of slash regions and slash voices.

RELATED LINKS
Inputting slash regions on page 417
Inputting notes into slash voices on page 233
Hiding/Showing notes alongside slash regions on page 1263
Including/Excluding slash voices in playback on page 1260
Chord symbols on page 871

Slash voices
Slash voices allow you to notate specific rhythms for rhythm slashes. They behave similarly to 
normal voices as you must input notes and rhythms manually, but all notes in slash voices are 
positioned by default on the middle line of the staff, regardless of the pitches you input.

If you later change the time signature, such as from 3/4 to 6/8, Dorico Elements only changes the 
note grouping to fit the meter just like for other notes; it does not change the presentation of 
rhythm in slash voices like it does for slash regions.

NOTE

● Because you can change notes in slash voices to normal voices and vice versa, the pitches 
you input are retained.

● By default, notes in slash voices are not played back. However, if you include slash voices in 
playback, notes in slash voices play back with their input pitch.

You can have multiple slash voices active at the same time. To accommodate all slash voices in 
multiple-voice contexts, Dorico Elements changes their staff position automatically. However, you 
can also change the staff position of rhythm slashes manually.
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You can use slash regions and slash voices in the same project and at the same rhythmic 
positions; for example, you can input a slash region where you do not want to be specific about 
the rhythm, then input notes in a slash voice for a single bar where you want to specify an exact 
rhythm.

RELATED LINKS
Slashes in multiple-voice contexts on page 1268
Implicit rests in multiple-voice contexts on page 1273
Inputting notes into slash voices on page 233
Changing the voice of existing notes on page 466

Changing the slash voice type
You can change the voice type of slash voices; for example, if you want to change a slash voice 
from having stems to being stemless. You can also change the type to normal notes, which 
restores the original pitches you input, and change normal notes to rhythm slashes.

NOTE

This affects all notes in the same voice. If you only want to change the slash voice type of some 
notes, you must change the voice of those notes instead.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select a note in the voice whose slash type you want to change. You can do this in Write 
mode and Engrave mode.

2. Choose Edit > Notations > Voices > Rhythmic Slashes > [Voice type].

For example, to change a whole normal voice to a stemless slash voice, choose Edit > 
Notations > Voices > Rhythmic Slashes > Slashes without Stems.

TIP

You can also choose these options from the context menu.

RESULT
The slash voice type of all notes in the same voice and flow as the selected note is changed.

If you change normal notes to a slash voice, they are all automatically positioned on a single staff 
line. By default in single-voice contexts, this is the middle line of the staff.

If you change rhythm slashes to normal notes, their original pitches are restored, meaning their 
staff positions reflect their pitches.

RELATED LINKS
Engrave toolbox on page 503

Rhythm slashes
Slash voices 
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Adding slash voices to percussion kits
You can add slash voices to percussion kits; for example, to show the desired rhythm for a 
passage without specifying the instruments to be played. You can add multiple slash voices to 
the same kit, including slash voices with and without stems.

NOTE

Rhythm slashes in percussion kits only appear when the five-line staff presentation is used. They 
do not appear in grid or single-line instrument presentations.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the percussion kit 
to which you want to add slash voices.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. In the action bar below the five-line staff editor, click the button that corresponds to the type 
of slash voice you want to add.

● Slashes with stems 

● Slashes without stems 

RESULT
The corresponding type of slash voice is added to the kit. It is positioned on the middle line of the 
staff by default.

During note input, you can move the caret to slash voices just like moving it to other instruments 
in the kit, and input notes into slash voices just like inputting notes in percussion kit instruments.

AFTER COMPLETING THIS TASK
You can change the staff position of slash voices in the kit.

RELATED LINKS
Percussion kits and drum sets on page 142
Percussion kit presentation types on page 1428
Players panel on page 110
Edit Percussion Kit dialog on page 143
Moving instruments in percussion kits on page 149

Including/Excluding slash voices in playback
By default, notes in slash voices are not played back. You can include/exclude all notes in slash 
voices project-wide in playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Repeats.

3. In the Rhythm Slashes section, activate/deactivate Play slash voices.

4. Click Apply, then Close.

Rhythm slashes
Slash voices 
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RESULT
All notes in slash voices project-wide are included in playback when Play slash voices is 
activated, and excluded when it is deactivated.

When slash voices are included in playback, notes in slash voices play back with their input pitch.

RELATED LINKS
Playback Options dialog on page 749
Repeats in playback on page 549
Including/Excluding pauses in playback on page 1016
Inputting notes into slash voices on page 233

Slash regions
Slash regions automatically display rhythm slashes as appropriate for the meter throughout their 
duration; for example, they show four slashes per bar in 4/4 and two slashes per bar in 6/8 by 
default. A single slash region can extend across multiple different meters.

A single slash region covering multiple different meters

Multiple slash regions can exist at the same rhythmic position. When slash regions overlap, 
Dorico Elements treats this as a multiple-voice context and changes the staff position of slashes 
automatically.

In Write mode, each region has a handle at the start and end, which you can use to move and 
lengthen/shorten regions.

By default, slash regions are highlighted with a colored background. As you zoom out, the 
highlights become more opaque, which is especially useful when viewing full score layouts in 
galley view. These highlights are considered annotations, are not printed by default, and you can 
hide/show them.

When two different slash regions are adjacent, they alternate highlight colors to ensure the 
separate regions are always identifiable.

Two adjacent slash regions with different highlight colors

You can use slash regions and slash voices in the same project and at the same rhythmic 
positions; for example, you can input a slash region where you do not want to be specific about 
the rhythm, then input notes in a slash voice for a single bar where you want to specify an exact 
rhythm.

By default, Dorico Elements hides notes at the same rhythmic positions as slash regions, but you 
can show notes alongside individual slash regions.

Rhythm slashes
Slash regions 
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TIP

Because rhythm slashes are often accompanied by chord symbols to indicate the set of notes the 
performer should use, you can show chord symbols in slash/chord symbol regions but hide them 
elsewhere.

RELATED LINKS
Inputting slash regions on page 417
Hiding/Showing chord symbols on page 878
Chord symbol regions on page 882
Numbered bar regions on page 1253
Bar repeats on page 1245
Repeat counts on page 1242
MIDI trigger regions on page 574
Annotations on page 597

Note grouping in slash regions
You can find options to control the grouping and duration of rhythm slashes in slash regions in 
each flow independently in Notation Options > Note Grouping > Rhythmic Slashes.

The available options include changing whether rhythm slashes follow the beat grouping or 
the time signature denominator, and set the duration for rhythm slashes in open meter. For 
example, you can show six slashes in 6/8 instead of two dotted slashes.

Musical examples demonstrate how each option affects the appearance of your music.

Rhythm slashes following beat grouping Rhythm slashes following time signature denominator

RELATED LINKS
Notation Options dialog on page 747
Note and rest grouping on page 860
Time signatures on page 1381

Splitting slash regions
You can split slash regions after they have been input; for example, if you later want to input 
more precise notation in the middle of an existing slash region.

PROCEDURE

1. In Write mode, select a slash in each slash region you want to split, immediately to the right 
of where you want to split them.

2. Split the slash regions in any of the following ways:

● Press U .

● In the Notes toolbox, click Scissors .

Rhythm slashes
Slash regions 

1262
Dorico Elements 5.1.30



RESULT
The slash regions are split immediately to the left of the selected slashes. Each part now has its 
own start/end handles, which you can use to lengthen/shorten each part independently.

RELATED LINKS
Notes toolbox on page 196
Changing the slash region count frequency on page 1266
Lengthening/Shortening items on page 430
Moving notes/items rhythmically on page 461

Hiding/Showing stems in slash regions
You can hide/show stems and beams, where applicable, on slashes in individual slash regions. By 
default, slashes in slash regions are shown without stems.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select any part of each slash region in which you want to hide/show stems. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Slash type in the Slash Regions group.

3. Choose one of the following options:

● With stems

● Without stems

RESULT
Stems are hidden in the selected slash regions when you choose Without stems, and shown 
when you choose With stems.

If appropriate for the prevailing meter, such as 3/8, beams are shown in addition to stems.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503

Hiding/Showing notes alongside slash regions
You can hide/show notes at the same rhythmic positions as slash regions; for example, if you 
want to input notes to hear in playback but only want to show the slash region, or if you want to 
notate suggested notes in addition to the slash region.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Rhythm slashes
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PROCEDURE

1. Select any part of each slash region alongside which you want to hide/show other notes. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Show other voices in the Slash Regions group.

RESULT
All notes in other voices present alongside the selected slash regions are shown when Show 
other voices is activated, and hidden when it is deactivated.

EXAMPLE

Notes hidden alongside a slash region Notes shown alongside a slash region

Hiding/Showing padding rests before/after slash regions
You can hide/show padding rests before/after slash regions that start partway through bars 
individually; for example, if you have other notes at those positions and the rests would be 
misleading. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

By default, Dorico Elements automatically shows implicit padding rests around slash regions that 
start/end partway through bars, so that the full duration of each bar is clear.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select any part of each slash region whose padding rests you want to hide/show. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Slash Regions group:

● Hide rests before start

● Hide rests after end

RESULT
Padding rests are hidden on the corresponding side of the selected slash regions. For example, 
activating both properties hides padding rests both before and after the selected slash regions.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

Rhythm slashes
Slash regions 
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RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Implicit vs. explicit rests on page 1272

Hiding/Showing slash region highlights
You can hide/show the colored highlights for slash regions at any time; for example, if you want 
to show the highlights when inputting music but hide them when engraving.

PROCEDURE

● Choose View > Highlight Slash Regions.

Slash region counts
Slash region counts are numbers shown at regular intervals, either above or below slash regions, 
to help performers keep track of how many bars have passed. The intervals are usually based on 
typical musical phrases, such as every four or eight bars.

By default, slash region counts are shown in parentheses every four bars and are placed below 
the staff. Each slash region has its own separate count.

Slash region with counts shown every two bars

In Dorico Elements, you can change the start count of each slash region, how frequently counts 
are shown, their staff-relative placement, and whether counts are shown with parentheses, 
without parentheses, or hidden. You can also customize the count font style.

NOTE

Bar repeat, slash, and numbered bar region counts use the same font style.

RELATED LINKS
Editing the count font style on page 1250
Repeat counts on page 1242
Bar repeat counts on page 1247
Numbered bar region counts on page 1254

Changing the start count of slash regions
You can change the number from which individual slash region counts start; for example, if you 
want to input more precise notation between two slash regions but want the count to appear to 
continue across the regions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Rhythm slashes
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PROCEDURE

1. Select any part of each slash region whose start count you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Count from in the Slash Regions group.

3. Change the value in the value field.

RESULT
The start count of the selected slash regions is changed. If the count frequency is every two bars 
or more, counts appear on different bars. For example, changing the start count from 1 to 2, with 
counts shown every four bars, causes the count to appear on the third bar in the region instead 
of the fourth.

EXAMPLE

Two separate slash regions, where the start count in the second region has been changed so it appears to 
continue on from the first region.

Changing the slash region count frequency
You can change how frequently counts are shown on individual slash regions; for example, if you 
want to show the count after eight bars on a single slash region. By default, slash region counts 
are shown every four bars.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select any part of each slash region whose count frequency you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Count frequency in the Slash Regions group.

3. Change the value in the value field.

RESULT
The count frequency is changed for the selected slash regions.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Splitting slash regions on page 1262
Hiding/Showing bar number ranges on multi-bar rests on page 828

Rhythm slashes
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Hiding/Showing or parenthesizing slash region counts
You can hide counts or show counts with or without parentheses for individual slash regions. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select any part of each slash region whose counts you want to hide/show or parenthesize. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Count appearance in the Slash Regions group.

3. Select one of the following options from the menu:

● With parentheses

● Without parentheses

● Do not show

RESULT
Counts in the selected slash regions are shown with parentheses, without parentheses, or 
hidden. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503

Changing the staff-relative placement of slash region counts
You can show the counts in individual slash regions either above or below the staff. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

Changing the staff-relative placement of counts affects all counts in the region. You cannot 
change the placement of a single count independently of other counts in the region.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Rhythm slashes
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PROCEDURE

1. Select any part of each slash region whose count staff-relative placement you want to 
change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Count position in the Slash Regions group.

3. Choose one of the following options:

● Above

● Below

RESULT
The staff-relative placement of all counts in the selected slash regions is changed. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

Slashes in multiple-voice contexts
Multiple slash regions and slash voices can exist at the same rhythmic positions. In multiple-voice 
contexts for slash voices and when slash regions overlap, Dorico Elements automatically changes 
their staff position and offset to accommodate all slashes as legibly as possible.

Single slash region Two slash regions, one up-stem and one down-stem

You can set default per-flow settings for the position and offset of slashes relative to other 
slashes at the same rhythmic positions on the Voices page in Notation Options.

NOTE

These options affect all rhythm slashes, including notes in slash voices as well as slash regions.

You can also control the positions of rhythm slashes relative to each other manually by changing 
their stem/voice direction and by changing their staff position.

RELATED LINKS
Notation Options dialog on page 747
Note positions in multiple-voice contexts on page 1440
Changing the voice of existing notes on page 466

Changing the voice direction of slash regions
You can change the voice direction of slash regions individually. When multiple slash regions 
overlap, this affects their stem directions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

Rhythm slashes
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PROCEDURE

1. Select any part of each slash region whose voice direction you want to change. You can do 
this in Write mode and Engrave mode.

2. In the Properties panel, activate Voice direction in the Slash Regions group.

3. Choose one of the following options:

● Up

● Down

RESULT
The voice direction, and therefore stem direction, of the selected slash regions is changed.

NOTE

This only affects the direction of stems in slash regions on the middle line of the staff and when 
multiple slash regions exist at the same rhythmic position. For example, if you change the voice 
direction of a slash region on the bottom line of the staff to Down, its stem direction does not 
change if it does not overlap with another slash region.

Changing the staff position of rhythm slashes
You can change the staff position of rhythm slashes in both slash voices and slash regions; for 
example, to accommodate other notes at the same rhythmic positions better. By default, rhythm 
slashes are positioned on the middle line of the staff.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the rhythm slashes whose staff position you want to change. You can do this in Write 
mode and Engrave mode.

● For notes in slash voices, you must select every note whose staff position you want to 
change.

● For slash regions, you can select any part of each region whose staff position you want 
to change.

2. In the Properties panel, activate Slash pos. in the corresponding group for the type of 
rhythm slash whose staff position you want to change:

● Notes and Rests for notes in slash voices

● Slash Regions for slash regions

3. Change the value in the value field.

RESULT
The staff position of the selected rhythm slashes is changed. For example, changing the Slash 
pos. value to 4 positions rhythm slashes on the top line of a five-line staff, while -4 positions them 
on the bottom line.

If any of the rhythm slashes have stems, their stem direction is adjusted automatically.

Rhythm slashes
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RELATED LINKS
Engrave toolbox on page 503
Stem direction on page 1074
Adding slash voices to percussion kits on page 1260

Rhythm slashes
Slashes in multiple-voice contexts 
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Rests

Rests are markings with a rhythmic value that indicate no note is played for that duration. Each 
note duration has an equivalent rest; for example, a quarter note rest is different to a sixteenth 
note rest.

All notes and rests within a bar must add up to the duration of the bar, according to the 
prevailing time signature. Dorico Elements automatically fills the gaps between notes with 
implicit rests of the appropriate duration. Therefore, it is usually not necessary to input rests 
in Dorico Elements.

The table shows some examples of notes and the rests with the equivalent rhythmic value.

Duration Note Rest

Half

Quarter

Eighth

Sixteenth

RELATED LINKS
Inputting rests on page 245
Deleting rests on page 1276
Inputting notes on page 224
Rests within beams on page 858
Note and rest grouping on page 860
Implicit rests in multiple-voice contexts on page 1273
Showing figured bass on rests on page 959

General placement conventions for rests
Rests are positioned at the rhythmic position at the start of their duration, and not in the middle 
of beats as this can cause confusion over when the rest begins and ends. Rests are aligned with 
other items at the same rhythmic position.

The only exception is whole bar rests, which are positioned at the visual center of bars. This way, 
they are clearly distinguishable from half note and whole note rests that are followed by notes in 
the same bar.
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Rests stay within the staff wherever possible. They do not move above or below the staff when 
the notes around them are very high or very low.

However, on staves with multiple voices, rests are placed higher on the staff, or above the staff, 
for up-stem voices and lower on the staff, or below the staff, for down-stem voices.

Example rest positions in a multiple-voice context

Rests in multiple voices must not overlap. You can consolidate rests so that only one is shown 
when multiple voices have a rest of the same duration at the same rhythmic position.

The precise vertical positioning of rests is limited, as their detailed shapes require specific 
positions relative to staff lines and staff spaces.

RELATED LINKS
Voices on page 1438
Inputting notes into multiple voices on page 232
Creating cross-staff beams/tremolos on page 851
Moving rests vertically on page 1275

Implicit vs. explicit rests
Implicit rests are automatically shown between the notes you input, and their duration 
automatically follows the time signature and their position in the bar. Explicit rests are rests that 
are explicitly entered during note input by forcing their duration, or rests that were imported 
from a MusicXML file.

Dorico Elements notates implicit rests according to the prevailing time signature; for example, 
different implicit rests are shown in 6/8 compared to 4/4. This also applies if you later change the 
time signature for existing notes and rests.

Therefore, it is not necessary to input rests in Dorico Elements, as implicit rests are automatically 
shown around the notes that you input. You can turn implicit rests into explicit rests by forcing 
their duration to be fixed.

A quarter note input at the fourth eighth note of 
the bar in a 6/8 time signature has a dotted quarter 
implicit rest at the start of the bar.

A quarter note input at the fourth eighth note of the 
bar in a 4/4 time signature has two implicit rests, a 
quarter and an eighth, at the start of the bar.

Explicit rests cannot be suppressed when using the Starts voice and Ends voice properties to 
hide rests before the first note in voices and after the last note in voices.

You can show rest colors to see which rests are implicit and which are explicit in your project.

Rests
Implicit vs. explicit rests 
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RELATED LINKS
Inputting rests on page 245
Inputting notes on page 224
Deleting rests on page 1276
Forcing the duration of notes/rests on page 262
Turning explicit rests into implicit rests on page 1274
Hiding/Showing rest colors on page 1275

Implicit rests in multiple-voice contexts
In Dorico Elements, implicit rests are shown automatically to fill in rhythmic positions around 
notes, including when there are multiple voices on the staff. However, in these contexts you 
might want more control over when and where rests are shown.

Usually, rests or notes are shown for whole bars when voices contain at least one note in the bar. 
This helps make the rhythmic position of every note in all voices in the bar immediately clear.

When there are multiple voices on a staff, implicit rests are shown in every bar in which there are 
notes of any duration in more than one voice. Bar rests are always shown for the first voice on a 
staff, including in bars that only contain notes in a slash voice.

However, there might be circumstances in which you do not want to show rests either before the 
first note in a voice or after the last note in a voice when there are multiple voices on the staff. 
For example, it can be useful to hide rests when a voice is being used to show passing notes 
within a bar that otherwise contains a single melodic line.

A second voice used to notate passing notes

You can choose when rests are shown in a number of different multiple-voice contexts in each 
flow independently on the Rests page in Notation Options.

You can also delete rests from selected passages.

TIP

By default, Dorico Elements consolidates rests when multiple voices have rests of the same 
duration at the same rhythmic position.

You can show multiple rests at individual rhythmic positions by changing the vertical position of 
rests. You can also change your per-flow settings for the consolidation of rests in multiple-voice 
contexts on the Rests page in Notation Options.

Rests
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A phrase with multiple voices showing implicit rests. The same phrase without implicit rests.

RELATED LINKS
Notation Options dialog on page 747
Per-flow notation options for rests on page 1274
Moving rests vertically on page 1275
Deleting rests on page 1276
Slash voices on page 1258

Turning explicit rests into implicit rests
Implicit rests and explicit rests behave differently. For example, the notation of explicit rests does 
not update automatically if their position in the bar of the time signature changes.

PROCEDURE

1. In Write mode, select the explicit rests you want to turn into implicit rests.

2. Press Backspace or Delete .

RESULT
The selected explicit rests are now implicit rests. You can check this by showing rest colors.

RELATED LINKS
Hiding/Showing rest colors on page 1275
Deleting rests on page 1276

Per-flow notation options for rests
You can find per-flow options controlling how rests are positioned and notated, and when rests 
are shown, on the Rests page in Notation Options.

For example, you can change whether bar rests are shown in additional voices, when dotted 
rests are permitted, and the default positions of rests in different contexts. You can also change 
whether rests of the same duration and at the same rhythmic position in different voices are 
consolidated into a single rest.

Musical examples demonstrate how each option affects the appearance of your music.

RELATED LINKS
Notation Options dialog on page 747
Voices on page 1438
Per-flow notation options for voices on page 1439
Stem direction on page 1074

Rests
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Hiding/Showing rest colors
You can hide/show rest colors, which causes implicit rests and explicit rests to appear with 
different colors.

When rest colors are shown, implicit rests appear gray and explicit rests appear black. For 
example, this can help diagnose why rests do not disappear when you activate Starts voice and 
Ends voice, as these properties only hide implicit rests.

PROCEDURE

● Choose View > Note And Rest Colors > Implicit Rests.

RESULT
Rest colors are hidden/shown.

EXAMPLE

Rest colors hidden Rest colors shown

AFTER COMPLETING THIS TASK
You can delete rests that you have identified as explicit rests. The implicit rests that replace them 
now respect the Starts voice and Ends voice properties.

Moving rests vertically
You can change the vertical position of rests individually; for example, if you want to change 
the staff line from which a whole bar rest hangs, or you want to show rests for all voices at a 
particular rhythmic position. You can do this for the current layout and frame chain only, or for 
all layouts and frame chains.

Moving rests vertically shows multiple rests at that rhythmic position if more than one voice on 
the staff has a rest of the same duration. By default, Dorico Elements consolidates coincident 
rests of the same duration in multiple-voice contexts and automatically positions rests in 
multiple-voice contexts to avoid collisions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the rests whose vertical positions you want to change, or rests at the rhythmic 
positions where you want to see rests for every voice. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Rest pos. in the Notes and Rests group.

Rests
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3. Change the value in the value field.

RESULT
Increasing the value moves rests upwards, decreasing the value moves rests downwards. 
Position 0 is the middle line of the staff. If there are multiple voices on the staff with rests of 
the same duration at the same rhythmic position, multiple rests are now shown.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

● Deactivating Rest pos. returns the selected rests to their default positions.

● You can choose to show coincident rests of the same duration in every voice or only show 
one rest for all voices in Notation Options > Rests > Rest Positioning.

● You can choose to align rests in the same voice vertically in Notation Options > Rests > Rest 
Positioning.

● You can change the horizontal position of rests, and the spacing around them, in Engrave 
mode when Note Spacing  is activated, in the same ways as changing the position of 
notes.

RELATED LINKS
Notation Options dialog on page 747
Note spacing on page 507
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Deleting rests
You can delete both implicit rests and explicit rests; for example, if you want to hide rests before/
after notes in another voice used to show passing notes.

TIP

● If you want to delete rests because you want to remove the corresponding duration from the 
flow, you can instead delete bars/beats.

● If you want to delete rests because you do not want to show bar rests in empty bars, you can 
instead hide bar rests.

● If you want to delete rests because multiple rests of the same duration appear at the same 
position in multiple-voice contexts, you can choose to consolidate these rests in Notation 
Options > Rests > Rest Positioning.

PROCEDURE

1. In Write mode, select the rests you want to delete.

TIP

You can select rests individually, or make a larger selection that contains the rests you want 
to delete.

2. Choose Edit > Remove Rests.

Rests
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RESULT
All rests in the selection are deleted. This is done by automatically activating Starts voice 
and Ends voice in the Notes and Rests group of the Properties panel on the notes or rests 
immediately to the right/left of deleted rests, so that no rests are shown in the selected regions.

NOTE

● You can show rests again later by selecting the notes or rests immediately to the right/left of 
deleted rests, then deactivating the corresponding Starts voice or Ends voice properties in 
the Notes and Rests group of the Properties panel.

● You can assign a key command for Remove Rests on the Key Commands page in 
Preferences.

● In layouts where no other notes, rests, or items with duration exist at rhythmic positions 
where you have deleted rests, Dorico Elements has nothing to use to calculate horizontal 
spacing. Therefore, such empty bars/beats can appear narrower.

EXAMPLE

A phrase with multiple voices showing implicit rests. The same phrase after deleting the rests.

RELATED LINKS
Notation Options dialog on page 747
Implicit vs. explicit rests on page 1272
Large selections on page 424
Deleting bars/beats on page 810
Changing the width of empty bars on page 813
Note spacing on page 507
Changing the horizontal justification of final systems on page 612

Hiding/Showing bar rests in empty bars
You can hide/show bar rests in empty bars in each layout independently. For example, you can 
hide bar rests in full score layouts but show bar rests in part layouts.

Bar rests are usually shown in empty bars in music to indicate to performers that they have 
nothing to play. However, there are contexts in which it is preferable to hide bar rests in empty 
bars, and instead leave the bar completely empty.

For example, hiding bar rests in empty bars is sometimes the preferred visual aesthetic in large 
scores, so that it is quicker to identify bars containing music. You can also hide bar rests in 
layouts where you want to include other instructions, such as verbal indications for performers 
to do something other than play notated pitches.

Rests
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PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show bar rests in empty 
bars.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Bar Rests and Multi-bar Rests section, activate/deactivate Show bar rests in empty 
bars.

5. Click Apply, then Close.

RESULT
All bar rests in empty bars in the selected layouts are shown when the checkbox is activated, and 
hidden when the checkbox is deactivated.

RELATED LINKS
Hiding/Showing multi-bar rests on page 1279

Hiding/Showing bar rests in additional voices
You can hide/show bar rests between notes or explicit rests in additional voices on a per-flow 
basis; for example, you might show bar rests in contrapuntal music to ensure each voice can be 
easily followed.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the Flows list, select the flows in which you want to hide/show bar rests in additional 
voices.

By default, only the current flow is selected when you open the dialog. You can select other 
flows by clicking Select All in the action bar, clicking and dragging across multiple flows, 
Shift -clicking adjacent flows, and Ctrl/Cmd -clicking individual flows.

3. In the category list, click Rests.

4. In the Rests in Additional Voices section, choose one of the following options for Bar rests 
in additional voices:

● Show bar rests

● Omit bar rests

5. Optional: To show bar rests for each voice in empty bars, in the Rest Positioning section, 
choose Show every rest in each voice for Coincident rests of the same duration in 
opposing voices.

6. Click Apply, then Close.

RESULT
Bar rests are shown between notes and explicit rests in additional voices in the selected flows 
when you choose Show bar rests, and hidden when you choose Omit bar rests.

Rests
Hiding/Showing bar rests in empty bars 

1278
Dorico Elements 5.1.30



NOTE

● Show bar rests does not automatically show bar rests in empty bars before the first note or 
explicit rest in additional voices. For additional voices that do not start in the first bar, you 
must input a bar rest in the first bar manually.

● Omit bar rests does not hide bar rests in the primary voice on each staff.

RELATED LINKS
Per-flow notation options for rests on page 1274
Implicit vs. explicit rests on page 1272
Inputting notes into multiple voices on page 232
Inputting bar rests into specific voices on page 246

Multi-bar rests
Multi-bar rests group two or more consecutive empty bars together into a single unit, commonly 
shown with a thick horizontal line positioned on the middle staff line, known as an “H-bar”. They 
can reduce the horizontal space required by multiple empty bars and make it easier for players 
to find their place in the music.

A multi-bar rest representing four empty bars

NOTE

Multi-bar rests are automatically split by items positioned within their range, such as system-
attached text, rehearsal marks, and holds and pauses. However, if items are positioned at the 
start of the first bar in a multi-bar rest, that bar remains part of the subsequent multi-bar rest.

You can hide/show multi-bar rests in each layout independently in Dorico Elements, and you can 
hide/show bar number ranges below them.

By default, the multi-bar rest bar counts only appear once between the staves of grand staff 
instruments.

RELATED LINKS
Hiding/Showing bar number ranges on multi-bar rests on page 828
Splitting multi-bar rests on page 1281

Hiding/Showing multi-bar rests
You can hide/show multi-bar rests in each layout independently, and choose whether or not to 
consolidate one-bar repeats. For example, you can hide multi-bar rests in full score layouts but 
show multi-bar rests in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show multi-bar rests.
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By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Bar Rests and Multi-bar rests section, choose one of the following options for 
Consolidate:

● None

● Multi-bar Rests

● Multi-bar Rests and Bar Repeats

5. Click Apply, then Close.

RESULT

● When you choose None, no multi-bar rests are shown in the selected layouts. Each empty 
bar is shown separately.

● When you choose Multi-bar Rests, any adjacent empty bars are consolidated into multi-bar 
rests in the selected layouts. However, bar repeats prevent the consolidation of multi-bar 
rests, even if there are no other notes in those bars.

● When you choose Multi-bar Rests and Bar Repeats, any adjacent empty bars or bars that 
only contain one-bar repeats are consolidated into multi-bar rests in the selected layouts. 
Multi-bar rest counts are also shown above consolidated one-bar repeats.

RELATED LINKS
Bar repeats on page 1245
Hiding/Showing bar number ranges on multi-bar rests on page 828

Changing the width of multi-bar rest H-bars
You can change the width of individual multi-bar rest H-bars. This allows you to control the exact 
positions of multi-bar rests; for example, when there are clef changes at the end of multi-bar 
rests.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the multi-bar rests whose width you want to change.

2. In the Properties panel, activate H-bar width delta in the Multi-bar Rests group.

3. Change the value in the value field.

RESULT
The width of the selected H-bars is changed. Increasing the value increases their width, 
decreasing the value decreases their width.

RELATED LINKS
Engrave toolbox on page 503
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Properties panel on page 663
Casting off on page 629

Moving multi-bar rest H-bars
You can move individual multi-bar rest H-bars horizontally. This allows you to control the exact 
positions of multi-bar rests; for example, when there are clef changes at the end of multi-bar 
rests.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the multi-bar rests you want to move.

2. In the Properties panel, activate H-bar X offset in the Multi-bar Rests group.

3. Change the value in the value field.

RESULT
The selected H-bars are moved horizontally. Increasing the value moves H-bars to the right, 
decreasing the value moves H-bars to the left.

Splitting multi-bar rests
You can manually split multi-bar rests without showing any extra notation in the music. Splitting 
multi-bar rests affects all layouts in the project, including full scores and parts.

NOTE

Multi-bar rests are automatically split by items positioned within their range, such as system-
attached text, rehearsal marks, and holds and pauses.

PREREQUISITE

● You have opened a layout in the music area that either has items in the bars where you want 
to split multi-bar rests or in which multi-bar rests are hidden. You cannot select rhythmic 
positions within multi-bar rests.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select an item at the rhythmic position where you want to split multi-bar 
rests.

2. Choose Engrave > Split Multi-bar Rest.

RESULT
All multi-bar rests in all layouts are split at the selected position. A signpost is shown at the 
position of the multi-bar rest split.
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RELATED LINKS
Engrave toolbox on page 503
Hiding/Showing signposts on page 450
Hiding/Showing multi-bar rests on page 1279
Switching between layouts on page 43
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Slurs

Slurs are tapered, curved lines that join notes to indicate legato articulation and phrasing.

Depending on the context and the instrument to which they apply, slurs can have additional 
meanings to simply marking phrases. For example, for wind players, a slur indicates that all the 
notes in the phrase are played in the same breath and without re-tonguing or re-articulating any 
notes. For string players, a slur indicates that all the notes in the phrase are played legato and 
under one bow. For singers, slurs indicate that more than one note is sung to the same syllable.

Slurs both above and below the staff, including a cross-staff slur

Dorico Elements automatically determines the appropriate endpoint position and curvature 
direction for slurs based on the notes within their ranges, but you can change this manually.

You can input any number of nested slurs.

NOTE

Slurs must not be confused with ties, which look superficially similar, but instead join notes of 
the same pitch to indicate that they are played as a single note. In that sense, ties are part of 
rhythmic notation, while slurs are considered articulation.

RELATED LINKS
Inputting slurs on page 273
Inputting nested slurs on page 1295
Ties vs. slurs on page 1365
Cross-staff and cross-voice slurs on page 1294
Elision slurs on page 1050
Slurs in playback on page 1308
Slur endpoint positions on page 1286
Slur curvature direction on page 1292
Changing the position of slurs relative to tie chains on page 1284
MIDI Import Options dialog on page 85

General placement conventions for slurs
There are different conventions for the placement, endpoint position, shape, and curvature 
direction of slurs in various contexts.

RELATED LINKS
Slur endpoint positions on page 1286
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Short slurs that cover large pitch ranges on page 1288
Slurs over system and frame breaks on page 1287
Slur curvature direction on page 1292

Slur position relative to tie chains
There are different conventions for the position of slurs relative to tie chains in music for modern 
use and historical editions.

Modern practice is for slurs to start on the first note in tie chains, and end on the last note in tie 
chains. This makes the full length of the phrase visually clear to the performer, which helps their 
performance, and is the default in Dorico Elements.

However, in historical editions, slurs might end on the first note in a tie chain, and start on the 
last note in a tie chain. Both of these changes save vertical space, as shorter slurs do not extend 
as far above or below a staff.

Slur starting on the first note and ending on the last 
note in tie chains

Slur starting on the last note and ending on the first 
note in tie chains

Changing the position of slurs relative to tie chains
You can change the position of individual slurs relative to tie chains, including slurs starting on 
grace notes. For example, slurs that start on the last note in tie chains and end on the first note 
in tie chains are shorter and require less vertical space.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the slurs whose position relative to tie chains you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate the following properties, individually or together, in the 
Slurs group:

● Start pos. in tie chain

● End pos. in tie chain

3. Choose one of the following options for each property:

● First note

● Last note

RESULT
The position of the selected slurs relative to tie chains is changed.
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Slur placement relative to grace notes
There are specific placement rules that affect slurs when they start from a grace note and end on 
a normal note immediately following the grace note.

These rules are:

● Slurs connect noteheads rather than stems.

● Slurs are scaled to match the proportions of grace notes.

● Slurs must not obscure ledger lines.

● Slurs are placed above notes if they would collide with the accidental of a standard note 
when placed below the notes.

Due to the general placement conventions of grace notes, slurs in Dorico Elements appear below 
grace notes and curve downwards by default. Slurs starting from grace notes only appear above 
notes and curve upwards in up-stem voices in multiple-voice contexts.

Slur curvature direction on grace notes in a single-
voice context

Slur curvature direction on grace notes in a multiple-
voice context

You can change the automatic placement of grace note slurs by changing the stem direction of 
a grace note, changing the direction of a slur, and using the slur handles in Engrave mode to 
adjust the position of a slur in finer detail.

RELATED LINKS
Changing the curvature direction of slurs on page 1293
Changing the stem direction of notes on page 1076
General placement conventions for grace notes on page 1002
Slurs in Engrave mode on page 1300
Changing the shape/angle of slurs on page 1302

Slur position relative to staff lines
Slur endpoints must not touch staff lines, and the high point of the arcs of slurs should not stop 
on staff lines.

This is the convention because a slur whose arc peaks on a staff line can create the appearance 
of a triangular wedge between the staff line and the curve of the slur. If a slur peaks on a staff 
line, you can adjust its height so that it peaks either above/below the staff.

NOTE

Although Dorico Elements automatically ensures slur endpoints do not touch staff lines, manual 
adjustments might be necessary to position the arcs of slurs correctly.

RELATED LINKS
Changing the height of slurs on page 1305
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Slur endpoint positions
In order to avoid collisions, the default positions of slur endpoints vary depending on whether 
slurs are placed on the notehead side or stem side of notes, their position relative to staff lines, 
and whether articulations, ties, and other slurs exist at the same rhythmic position.

Slur endpoints relative to noteheads and stems

The default position of slur endpoints relative to noteheads is 1/2 space above a notehead in a 
space on the staff, and 1/4 space above a notehead on a line on the staff.

Slurs appear between the stems of unbeamed notes when placed on their stem side, and the 
default setting is for their endpoints to attach a short distance from the end of the stem.

Slurs between the stems of unbeamed notes

Slur endpoints relative to notes with different stem directions

For slurs between notes with different stem directions, Dorico Elements positions their endpoints 
close to the notehead by default so that the shape and curvature direction of slurs reflects the 
rising or descending pitch contour of phrases, including when they span multiple staves.

Slur endpoints near noteheads Slur endpoints near stem ends

Slur endpoints relative to articulations

By default, articulations of force and stress are placed outside slur endpoints, and articulations of 
duration are placed inside slur endpoints, which automatically raises the endpoints. For example, 
accents and stress marks are placed outside the ends of slurs but staccato and tenuto marks are 
placed inside the ends of slurs.

Slurs are placed outside articulations on notes in the middle of slurs.

Slur endpoints relative to ties and other slurs

The default position of slur endpoints is 1/4 space above an existing slur that starts/ends on the 
same note.

RELATED LINKS
Slurs in Engrave mode on page 1300
Changing the shape/angle of slurs on page 1302
Cross-staff and cross-voice slurs on page 1294
Nested slurs on page 1295
Stem direction on page 1074
Articulations on page 804
Changing the placement of articulations relative to slurs on page 808
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Slurs over system and frame breaks
Slurs automatically cross system breaks and frame breaks, appearing in two parts on either side 
of the break.

By default, the endpoints of slurs that cross system/frame breaks are positioned at least 1/2 
space outside the outer staff line and at a suitable position based on the pitch contour of the 
phrase before/after the break; that is, indicating whether the phrase rises or falls after the break.

If multiple slurs cross the same system break or frame break, such as if a phrase split by a break 
contains nested slurs, the ends of the slurs are stacked automatically and spaced a minimum of 
1/2 space apart vertically.

The end of a system showing the first slur part; the 
end on the right indicates a continuation to the next 
system.

The start of the next system showing the second 
slur part; the end on the left indicates a continuation 
from the previous system.

In Engrave mode, you can move and edit each slur part separately. This allows you to adjust the 
start/end height of each slur part independently on each system.

Slur collision avoidance
By default, Dorico Elements automatically adjusts the shape and position of slurs to avoid 
collisions with items under their arc.

This means that if a notehead under a slur is either higher than the others under a slur curving 
upwards, or lower than the others under a slur curving downwards, the curvature of the slur is 
adjusted to avoid the collision and keep the notehead under the slur. You can manually disable 
collision avoidance for individual slurs.

Slur with collision avoidance activated (default) Slur with collision avoidance deactivated

RELATED LINKS
Cross-staff and cross-voice slurs on page 1294
Accidentals on page 792

Enabling/Disabling slur collision avoidance
You can allow or prevent individual slurs from automatically adjusting to avoid collisions. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the slurs whose collision avoidance you want to enable/disable.

2. In the Properties panel, activate/deactivate Avoid collisions in the Slurs group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected slurs avoid collisions when the checkbox is activated, and do not avoid collisions 
when the checkbox is deactivated. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Short slurs that cover large pitch ranges
When short slurs span large pitch ranges, they are significantly rotated to compensate. This can 
make the ends of short slurs appear too angular.

You can move the control point handles of slurs to improve their curves.

Of the three examples, the middle slur has the smoothest curve. The handles on the slur on the 
right have been moved poorly, making the curve far too angular.

In the bottom row, the positions of the handles are shown to indicate how each curve above was 
created.

Short slur spanning a large pitch 
range, without adjustment

The same slur with some shape 
adjustment, making the curve 
smoother

The same slur again with poor 
adjustment, making the curve too 
angular

Default slur handle placement Slur handle placement to create 
the corresponding slur

Slur handle placement to create 
the corresponding slur

TIP

When adjusting slur ends, you can achieve the best results using the following guidelines:

● The control point at the lower end of the slur does not extend outside the width of the slur, 
as marked by its neighboring endpoint.
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● The control point at the higher end of the slur does not form an angle greater than 90 
degrees relative to the endpoints. You can use the dashed lines to help you judge this.

You can adjust the shape of short slur ends in different ways:

● Individually, by activating Start handle offset and End handle offset in the Properties panel 
in Engrave mode, and changing their X values.

● Individually, by moving the handles of slurs in Engrave mode.

RELATED LINKS
Slurs in Engrave mode on page 1300
Slur shoulder offset on page 1306
Changing the shape/angle of slurs on page 1302

Slur styles
There are different styles of slurs available in Dorico Elements, which indicate different meanings 
and have different use cases.

Solid
This is the default style for slurs. Slurs appear as tapered solid lines: thinner at the ends 
and thicker in the middle.

Dashed
Slurs appear as tapered dashed lines. Can be used to indicate an optional slur; for 
example, to recommend breathing/bowing patterns.

Dotted
Slurs appear as dotted lines. The dots are the same size and the same distance apart 
over the whole length of the slur.

Half-dashed start
The first halves of slurs appear as dashed lines, the second halves as solid lines. Used 
to denote that a slur was written incompletely in the source in critical editions.

Half-dashed end
The first halves of slurs appear as solid lines, the second halves as dashed lines. Used 
to denote that a slur was written incompletely in the source in critical editions.

Editorial
Slurs appear as solid black lines, but with a smaller vertical line intersecting them 
exactly halfway along their length, perpendicular to the curve of the slur. Used to show 
that a slur was added by the editor and was not present in the original source.
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Changing the style of slurs
You can change the style of individual slurs after they have been input. For example, to indicate 
editorial slurs, or to make specific slurs appear dashed. You can do this for the current layout and 
frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the slurs whose style you want to change. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Style in the Slurs group.

3. Select one of the following options from the menu:

● Solid

● Dashed

● Dotted

● Half-dashed start

● Half-dashed end

● Editorial

RESULT
The style of the selected slurs is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the size of dashes/dots in slurs
You can change the length of dashes and the size of dots in dashed/dotted slurs individually. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

These steps only apply to dashed/dotted slurs.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the dashed/dotted slurs whose dash length/dot size you want to 
change.

2. In the Properties panel, activate one of the following properties in the Slurs group:

● For dashed slurs, activate Dash length.

● For dotted slurs, activate Dot size.

3. Change the value in the value field.

RESULT
Increasing the value makes dashes longer and dots bigger, decreasing the value makes dashes 
shorter and dots smaller. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

Changing the size of gaps in dashed/dotted slurs
You can change the length of gaps in dashed/dotted slurs individually. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the dashed/dotted slurs whose gap length you want to change.

2. In the Properties panel, activate one of the following properties in the Slurs group:

● For dashed slurs, activate Dash gap length.

● For dotted slurs, activate Dot gap length.

3. Change the values in the value fields.

RESULT
Increasing the values makes the gaps between dashes/dots larger. Decreasing the values makes 
the gaps between dashes/dots smaller. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.
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Changing individual slurs to flat slurs
Although they are not often used as standard, some publishers use flat slurs in order to reduce 
the vertical space occupied by slurs. You can change individual slurs to flat slurs. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

Short slurs, that is, slurs between only a few notes, can look odd as flat slurs, so it may not be 
appropriate to select the flat curvature style project-wide. However, it would also be unusual only 
to use flat slurs once or twice in a project. Therefore, we recommend that you avoid changing the 
curvature style for only one or two slurs in a project.

It can be more effective to modify them rather than changing their curvature style; for example, 
by making an individual slur thicker/thinner, adjusting the shoulder offset of slurs, or adjusting 
their height using their slur height handles in Engrave mode.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the slurs whose curvature style you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Curvature type in the Slurs group.

3. Choose one of the following options:

● Normal (curved)

● Flat

RESULT
The curvature style of the selected slurs is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

RELATED LINKS
Changing the thickness of slurs on page 1304
Changing the height of slurs on page 1305
Changing the shoulder offset of slurs on page 1306
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Slur curvature direction
Slurs can curve upwards, downwards, or have a multi-segment S-shape. Dorico Elements 
automatically determines the appropriate curvature direction for slurs based on the notes within 
their ranges, but you can change the curvature direction of slurs manually.

A slur on a single staff always curves upwards and is placed above the notes, unless all of the 
notes under the slur are up-stem, in which case it curves downwards and is placed below the 
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notes. If a slur applies to a mixture of up-stem and down-stem notes, it is placed above the staff 
and curves upwards.

Examples of the slur direction changing according to the stem direction

The following options for slur curvature direction are available when you activate Direction in 
the Slurs group of the Properties panel:

Up

Forces slurs to curve upwards, and appear above notes.

Down

Forces slurs to curve downwards, and appear below notes.

Up/Down

Forces slurs to comprise two segments: the first curves upwards, the second curves 
downwards to create a mirrored S-shape. It is typically used when phrases start in the 
lower staff and end in the upper staff; for example, in piano parts.

Down/Up

Forces slurs to comprise two segments: the first curves downwards, the second curves 
upwards to create an S-shape. It is typically used when phrases start in the upper staff 
and end in the lower staff; for example, in piano parts.

TIP

● You can adjust the precise shapes of individual slurs, and each slur segment, in Engrave 
mode using the square handles on each slur.

● In jazz scores, slurs are sometimes treated as an articulation, so positioning all slurs above 
the staff is preferred.

RELATED LINKS
Slurs over system and frame breaks on page 1287
Cross-staff and cross-voice slurs on page 1294
Slurs in Engrave mode on page 1300
Slur styles on page 1289

Changing the curvature direction of slurs
You can change the curvature direction of individual slurs so that they curve upwards, 
downwards, or have a multi-segment S-shape. You can do this for the current layout and frame 
chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the slurs whose curvature direction you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Direction in the Slurs group.

3. Choose one of the following options:

● Up 

● Down 

● Up/Down  (mirrored S-shape)

● Down/Up  (S-shape)

RESULT
The curvature direction of the selected slurs is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

You can adjust the precise shapes of slurs, and each slur segment, in Engrave mode using the 
handles on each slur.

RELATED LINKS
Slurs in Engrave mode on page 1300
Changing the shape/angle of slurs on page 1302
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Cross-staff and cross-voice slurs
Cross-staff slurs start on one staff and end on another staff, and cross-voice slurs start in one 
voice and end in another voice.

Cross-staff slurs between two piano staves

Dorico Elements positions cross-staff and cross-voice slurs in the same way as it positions 
standard slurs. This includes adjusting cross-staff slurs to avoid collisions.
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You can move and lengthen/shorten cross-staff and cross-voice slurs in the same ways as 
standard slurs; however, they do not behave in the same way. For example, you cannot move 
cross-voice slurs to notes on the same staff in other voices, and you cannot lengthen cross-voice 
slurs to notes on the same staff in other voices. You also cannot lengthen/shorten cross-voice 
slurs to notes in different voices to those in which the slur started/ended.

You can only move and lengthen/shorten cross-staff slurs to notes on the same staff as the 
corresponding endpoint. For example, if a cross-staff slur covers a phrase that starts on the 
bottom staff and ends on the upper staff, you can only shorten the cross-staff slur to the first 
note on the upper staff, you cannot shorten it to any notes on the bottom staff.

The different voices can be on the same staff, or on different staves.

RELATED LINKS
Inputting slurs on page 273
Lengthening/Shortening items on page 430
Slur collision avoidance on page 1287
Slur endpoint positions on page 1286
Moving notes/items rhythmically on page 461

Nested slurs
Nested slurs are two or more slurs used simultaneously, where the overarching slur shows the 
structure of the phrase and the inner slurs show the articulation within the phrase. They are also 
known as “slurs within slurs”.

Depending on the stem directions within the overarching outer slur, inner slurs may appear on 
the opposite side of the staff to the outer slur.

A phrase with nested slurs

You can input nested slurs in the same ways as inputting standard slurs. By default, Dorico 
Elements makes automatic adjustments to their positioning to avoid collisions.

RELATED LINKS
Slur collision avoidance on page 1287

Inputting nested slurs
You can input nested slurs, both during note input and by adding them to existing notes. You 
can also add nested slurs to existing notes on multiple staves at the same time and to notes 
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in different voices or on different staves belonging to the same instrument; for example, when 
phrases span both staves of grand staff instruments.

PROCEDURE

1. In Write mode, do one of the following:

● Start note input.

● Select the notes you want to include in the outer slur.

TIP

● If you only select a single note, the slur connects that note to the next note in the 
same voice on the staff. To input slurs between notes in different voices, you must 
select both notes; for example, by selecting the first note then Ctrl/Cmd -clicking 
the second note.

● For instruments with multiple staves, such as piano and harp, you can select existing 
notes on multiple staves to create cross-staff slurs. However, you cannot create 
cross-staff slurs between different instruments.

● You can select notes on multiple staves to input slurs on those staves 
simultaneously.

2. Optional: If you want to input slurs onto multiple staves at once, extend the caret to those 
staves.

3. Input or start the outer slur in any of the following ways:

● Press S .

● In the Notes panel, click Slur .

● In the Keyboard panel toolbar, click Slur .

4. Input the inner slur in one of the following ways:

● When adding nested slurs to existing notes: Select the notes within the outer slur that 
you want to place under an inner slur and press S  or click Slur  in the Notes panel.

● To start the inner slur on the same note as the outer slur during note input, press S  or 
click Slur  in the Notes panel.

● To start the inner slur on a later note during note input, input notes or advance the caret 
manually to where you want the inner slur to start, then press S  or click Slur  in the 
Notes panel.

NOTE

If you added nested slurs to existing notes, stop here.

5. During note input, input the notes you want to include in the inner slur.

The slurs extend automatically as you continue inputting notes, even if there are rests 
between the notes you input.

6. End the inner slur on the currently selected note in any of the following ways:

● Press Shift-S .

● In the Keyboard panel toolbar, click Slur .

7. Continue inputting notes.

8. Optional: Start/End other inner slurs.

9. End the outer slur on the currently selected note in any of the following ways:
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● Press Shift-S .

● In the Keyboard panel toolbar, click Slur .

RESULT
During note input, slurs begin from the currently selected note on all staves across which the 
caret extends, not from the caret position. Slurs extend automatically as you input notes, and 
end on the currently selected note.

When adding slurs to existing notes, the selected notes are connected by slurs. For example, if 
you select two notes belonging to one instrument and two notes belonging to another, two slurs 
are input connecting the notes on each selected staff. If you selected notes on different staves 
belonging to the same instrument, a cross-staff slur is input.

Slurs are placed either above or below the notes, depending on the stem direction of the notes 
within the selection. Inner slurs can have different curvature directions to outer slurs. By default, 
Dorico Elements makes automatic adjustments to their positioning to avoid collisions.

TIP

You can input the outer slur and inner slurs in any order as Dorico Elements automatically 
adjusts slurs so that shorter slurs are positioned within longer slurs, and ensures they do not 
collide.

RELATED LINKS
Inputting slurs on page 273
Changing the curvature direction of slurs on page 1293

Linked slurs
Slurs of the same duration at the same rhythmic position on multiple staves can be linked 
together. This happens automatically when you copy and paste slurs or material including slurs 
between staves, or enter them simultaneously.

If slurs are linked, moving one slur in the linked group moves any slurs linked to it in the same 
way. Similarly, lengthening or shortening a slur in a linked group lengthens or shortens any slurs 
linked to it in the same way. However, deleting one slur in a linked group only deletes the slur 
selected, not the whole group.

Linked slurs appear highlighted when any slur in the linked group is selected.

Linked slurs with the top slurs selected

You can also manually link and unlink slurs.

Slurs
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RELATED LINKS
Inputting slurs on page 273
Linked dynamics on page 951
Disabling automatic linking of dynamics and slurs when pasting on page 460

Linking slurs together
Dorico Elements automatically links slurs of the same duration at the same rhythmic positions 
together when you copy and paste slurs or material including slurs between staves, or enter 
them simultaneously. However, you can also link slurs together manually.

PROCEDURE

1. In Write mode, select the slurs you want to link together.

NOTE

Only slurs that have the same duration and start at the same position can be linked together.

2. Choose Edit > Notations > Slurs > Link. You can also choose this option from the context 
menu.

RESULT
The selected slurs are linked together.

Unlinking slurs
You can unlink slurs, including slurs that were linked automatically. For example, if you want to 
lengthen/shorten slurs independently of each other.

PROCEDURE

1. In Write mode, select a slur in each linked group that you want to unlink.

2. Choose Edit > Notations > Slurs > Unlink. You can also choose this option from the context 
menu.

RESULT
All slurs in the linked groups are unlinked. This applies to all layouts in which the slurs appear.

Slur segments
A standard slur consists of one segment. You can make more elaborate shapes with slurs with 
multiple segments; for example, to allow you to create more complex slur shapes than are 
possible with a single curved segment.

Adding more segments to a slur by default creates evenly spaced waves within its length. 
Therefore, having more segments makes each wave shorter.

Slurs
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Slur with eight segments

In Engrave mode, you can move each segment graphically as each segment has its own set of 
five square handles. These allow you to form slurs into unusual and complicated shapes.

NOTE

● You may find that you need more segments than there are curves in your planned shape, as 
in many cases you need a segment for each significant change of angle. In Dorico Elements, 
you can increase/decrease the number of segments in existing slurs.

● Handles on multi-segment slurs are connected between adjacent segments. Moving a 
connected control point causes the control point at the start/end of the next/previous 
segment to move the same amount in the opposite direction.

An unusual slur shape created using five segments. The same slur, showing the positions of the handles 
of all five segments.

Changing the number of segments in individual slurs
You can change the number of segments in individual slurs; for example, to allow you to create 
slurs with unusual shapes. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the slurs whose number of segments you want to change.

2. In the Properties panel, activate Number of segments in the Slurs group.

3. Change the value in the value field.

Slurs
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RESULT
Increasing the value increases the number of slur segments. Decreasing the value decreases the 
number of slur segments. If the property scope was set to Locally, this change only takes effect 
in the current layout and frame chain.

AFTER COMPLETING THIS TASK
You can adjust the shape of slur segments in more detail using their handles.

NOTE

Handles on multi-segment slurs are connected to the corresponding type of handle on adjacent 
segments. Moving handles causes any connected handles to move the same amount in the 
opposite direction.

RELATED LINKS
Changing the shape/angle of slurs on page 1302
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Slurs in Engrave mode
In Engrave mode, each slur has five square handles that you can move independently. Some 
handles are connected to others, meaning moving one can affect the position of neighboring 
handles.

Slurs have the following handles in Engrave mode:

1 Left endpoint

2 Left control point

3 Slur height

4 Right control point

5 Right endpoint

For example, moving the left endpoint moves both the start of a slur and the other handles apart 
from the right endpoint. However, moving the right control point only causes the slur height 
handle to move as well. This gives you fine control over the shape of slurs, while ensuring the 
end result remains curved and smooth.

NOTE

Multi-segment slurs have additional links between control point handles that affect how they 
move in relation to other handles moving.

Slurs
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You can move these handles to change the shape of slurs with the keyboard, with the mouse, 
and by using properties in the Slurs group of the Properties panel. You can also change the 
angle of slurs without changing their overall shape.

RELATED LINKS
Slur height on page 1304
Slur shoulder offset on page 1306

Multi-segment slurs in Engrave mode
In Engrave mode, each segment in multi-segment slurs, such as S-shaped slurs, has handles just 
like standard slurs. This allows you to edit each segment of multi-segment slurs independently as 
if they were separate slurs, but in order to maintain a consistent shape, moving certain handles 
causes other handles to move simultaneously.

Multi-segment slurs have the following handles in Engrave mode:

1 Left endpoint

2 Left control point

3 Slur height

4 Right control point

5 Center control point

6 Left control point

7 Slur height

8 Right control point

9 Right endpoint

You can select and move each handle in the same ways as for standard slurs; however, handles 
on multi-segment slurs are connected between adjacent segments. Moving a connected control 
point causes the control point at the start/end of the next/previous segment to move the same 
amount in the opposite direction. This avoids tight corners, ensuring that multi-segment slurs 
are always as smoothly and symmetrically curved as possible.

In multi-segment slurs, right control points are connected to the left control point in the adjacent 
segment. If there is no adjacent segment, the right/left control points next to the right/left 
endpoints can be moved independently. For example, in the labeled diagram, control point 4 is 
connected to control point 6, but control points 2 and 8 are not connected to another control 
point.

Similarly, moving the slur height handle causes the slur height handle on any adjacent segments 
to move the same amount in the opposite direction. For example, if you move the slur height 
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handle on the middle segment of a slur with three segments, all three slur height handles are 
moved.

EXAMPLE

The left control point is selected. Moving the selected left control point upwards and 
to the left causes the right control point on the 
adjacent segment to move downwards and to the 
right.

Changing the shape/angle of slurs
You can move slurs and slur handles graphically, allowing you to change the shape and/or angle 
of individual slurs; for example, to adjust an endpoint relative to an individual notehead. You can 
do this for the current layout and frame chain only, or for all layouts and frame chains.

Changing the angle of slurs is useful, for example, if you want one end of a slur to start higher 
after a system break than its default position, as you can change the rotation of the slur while 
keeping all slur handles on the slur in the same positions relative to each other.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the whole slurs or individual slur handles you want to move in any 
of the following ways:

● Ctrl/Cmd -click multiple slurs.

● Ctrl/Cmd -click individual handles on multiple slurs.

● Select a whole slur and press Tab  to cycle through the handles until the one you want to 
move is selected.

● Click the handle you want to move.

NOTE

● To change the angle of slurs, select slur endpoints only.

2. Move the slurs or handles in any of the following ways:

● To move them a standard amount to the right, left, up, or down, press Alt/Opt  plus 
the corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move slurs/
handles to the left. This moves slurs/handles by 1/8 space per press.

● To move them a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow . This moves slurs/handles by 1 space per press.
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● To move them a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow . This moves slurs/handles by 1/2 space per press.

● To move them a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow . This moves slurs/handles by 1/32 
space per press.

● Click and drag them in any direction.

TIP

To constrain movement either horizontally or vertically, start dragging, then press and 
hold Shift .

RESULT
The selected slurs or slur handles are moved. Depending on the handles you selected and the 
directions in which you moved them, this can change the shape, angle, and/or proportional size 
of the corresponding slurs. If the property scope was set to Locally, this change only takes effect 
in the current layout and frame chain.

TIP

The following properties in the Slurs group of the Properties panel are activated automatically 
when you move the corresponding slur handles:

● Start offset moves the left endpoints of slurs. X moves them horizontally, Y moves them 
vertically.

● End offset moves the right endpoints of slurs. X moves them horizontally, Y moves them 
vertically.

● Start handle offset moves the left control points of slurs. X moves them horizontally, Y 
moves them vertically.

● End handle offset moves the right control points of slurs. X moves them horizontally, Y 
moves them vertically.

For example, if you move a whole slur upwards and to the right, all of its handles are moved so 
all properties are activated. You can also use these properties to change the shape of individual 
slurs by changing the values in the value fields.

Deactivating the properties resets the corresponding handles on the selected slurs to their 
default positions.

EXAMPLE

Slur with default angle and right endpoint selected Slur with changed angle after moving the right 
endpoint downwards

RELATED LINKS
Inputting slurs on page 273
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Slur shoulder offset on page 1306
Slurs over system and frame breaks on page 1287
Lengthening/Shortening items on page 430
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the thickness of slurs
You can change the thickness of individual slurs, including changing the thickness of the middle 
of slurs independently of the ends of slurs. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the slurs whose thickness you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Slurs group:

● End thickness

● Middle thickness

3. Change the values in the value fields.

RESULT
Increasing the values makes the corresponding part of the selected slurs thicker, decreasing the 
values makes the corresponding part of the selected slurs thinner. If the property scope was set 
to Locally, this change only takes effect in the current layout and frame chain.

Deactivating the properties returns the corresponding part of the selected slurs to their default 
thickness.

Slur height
The height of slurs determines how far above/below notes slurs extend vertically.

Increasing the height of slurs makes them extend further from the staff. This gives them a 
rounder shape, which takes up more vertical space. Where vertical space is limited, there should 
be a balance between how curved slurs are, which can help readability for players, and ensuring 
staves do not overlap.
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A long slur with default height A long slur with increased height

A long flat slur with default height A long flat slur with increased height

TIP

You can change the height of individual slurs in Engrave mode.

RELATED LINKS
Slurs over system and frame breaks on page 1287

Changing the height of slurs
You can change the height of individual slurs; for example, to reduce the height of a particularly 
long slur. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the slur height (middle) handle of the slurs whose height you want 
to change.

2. Move the handles in any of the following ways:

● To move them upwards/downwards a standard amount, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Up Arrow  to move handles 
upwards. This moves handles by 1/8 space per press.

● To move them upwards/downwards a large amount, press Ctrl/Cmd  plus the standard 
key command; for example, Ctrl/Cmd-Alt/Opt-Up Arrow . This moves handles by 1 
space per press.

● To move them upwards/downwards a moderate amount, press Shift  plus the standard 
key command; for example, Shift-Alt/Opt-Up Arrow . This moves handles by 1/2 space 
per press.

● To move them upwards/downwards a small amount, press Ctrl/Cmd - Shift  plus the 
standard key command; for example, Ctrl/Cmd-Shift-Alt/Opt-Up Arrow . This moves 
handles by 1/32 space per press.

● Click and drag them upwards/downwards.
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TIP

To constrain movement either horizontally or vertically, start dragging, then press and 
hold Shift .

RESULT
The height of the selected slurs is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

NOTE

● To maintain a visually pleasing and symmetrical curve when changing the height of slurs 
manually, you may need to move slur height handles to the right/left by a small amount, as 
well as upwards/downwards.

● Moving slur height handles to the right/left affects the shape of the whole slur.

RELATED LINKS
Changing the shape/angle of slurs on page 1302
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Slur shoulder offset
Slur shoulders affect the angles of the curves of slurs as they taper towards an endpoint, because 
the tapered ends often approach noteheads at a steeper angle than that of a slur’s arch.

Increasing the shoulder offset makes the onset of the curve shallower, whereas decreasing the 
shoulder offset makes the onset steeper. The shoulder offset must therefore be balanced with 
the height of the slur in order to achieve the ideal curved shape.

A long slur with default shoulder 
offset of 1/3

A long slur with increased 
shoulder offset of 1.5

A long slur with decreased 
shoulder offset of -1/2

You can adjust the shoulders of individual slurs in Engrave mode.

Changing the shoulder offset of slurs
You can adjust the shoulders of individual slurs by moving their control point handles. You can 
move each control point independently. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.
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PROCEDURE

1. In Engrave mode, select one of the control point handles on each of the slurs whose 
shoulders you want to adjust in any of the following ways:

● Select a whole slur and press Tab  to cycle through the handles until the one you want to 
move is selected.

● Click the handle you want to move.

● Ctrl/Cmd -click individual handles on multiple slurs.

2. Move the handles in any of the following ways:

● To move them a standard amount to the right, left, up, or down, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move handles to 
the left. This moves handles by 1/8 space per press.

● To move them a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow . This moves handles by 1 space per press.

● To move them a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow . This moves handles by 1/2 space per press.

● To move them a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow . This moves handles by 1/32 space per 
press.

● Click and drag them in any direction.

TIP

To constrain movement either horizontally or vertically, start dragging, then press and 
hold Shift .

3. Optional: Repeat steps 1 and 2 for the other control point handle on the slurs whose 
shoulders you want to adjust.

RESULT
The shoulder offset of the selected slurs is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

TIP

The following properties in the Slurs group of the Properties panel are activated automatically 
when you move the corresponding slur handles:

● Start handle offset moves the left control points of slurs. X moves them horizontally, Y 
moves them vertically.

● End handle offset moves the right control points of slurs. X moves them horizontally, Y 
moves them vertically.

You can also use these properties to change the shoulder offset of individual slurs by changing 
the values in the value fields.

Deactivating the properties resets the corresponding handles on the selected slurs to their 
default positions.

RELATED LINKS
Slurs in Engrave mode on page 1300
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Slurs in playback
Slurs trigger the legato playback technique. By default, this increases the length of the MIDI 
notes without affecting the notation of the music.

Slurred notes sound for 105% of the length indicated by their notated rhythm, as opposed to 
non-slurred notes which sound for 95% of their notated rhythm.

The final note of a slur sounds for 95% of its notated rhythm, as there is no slur after it and the 
legato technique is no longer required.

The example shows how MIDI note length, indicated by the filled, light-colored rectangles, is 
increased when slurs are used. The thin, darker rod shows the notated duration of each note. 
The first three notes are non-slurred, so the MIDI length rectangle is shorter than the line of the 
notated rhythm. The last four notes are slurred together, so the MIDI length is longer than the 
notated length in order to create the legato, slurred sound. However, the last note of the slurred 
group is not longer, as the last note of a slurred phrase is treated like a normal, non-slurred note.

A phrase in an instrument staff The same phrase in the piano roll editor

TIP

● You can change the default values for the sounding duration of slurred notes on the Timing 
page in Playback Options.

● You can enable independent voice playback for individual instruments to hear different 
sounds in different voices simultaneously; for example, if you have slurs in one voice and 
staccatos in another voice.

● To ensure correct handling in playback, you can limit monophonic legato to music without 
chords in the Expression Maps dialog.

RELATED LINKS
Playback Options dialog on page 749
Playback techniques on page 787
Played vs. notated note durations on page 687
Piano roll editor on page 678
Enabling independent voice playback on page 545
Expression Maps dialog on page 762
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Staff labels

Staff labels are used to identify the instruments playing the music on the corresponding staves, 
and are positioned to the left of systems, before the initial barline of each system. Staff labels are 
typically used in music containing multiple players.

It is usual to show instrument names in full in the staff labels for the first systems in each flow, 
and abbreviated instrument names in the staff labels of subsequent systems. Using abbreviated 
instrument names saves horizontal space, allowing you to include more music in each system.

Examples of staff labels on the first system in a flow

By default in Dorico Elements, staff labels show the instrument names set for each instrument. 
You can show player names in staff labels instead for each player in each layout independently; 
for example, for percussionists who play multiple instruments.

For players holding multiple instruments and showing instrument names in staff labels, the staff 
label shows the instrument they are currently playing. If the player changes instrument partway 
through a system, the name of the new instrument is shown above the staff at its first note and 
the staff label is updated at the start of the next system.

Dorico Elements includes the instrument transposition, or instrument pitch, in staff labels for 
transposing instruments by default. Transposing instruments are instruments whose sounding 
pitch is different to the notated pitch.

Part layouts by default do not show staff labels, as most parts only contain a single staff whose 
identity is clear from the context and the layout name. The layout name is shown at the top left 
of the first page in part layouts by default.

You can change when instrument transpositions, or instrument pitches, are shown in staff 
labels. You can also change whether the instrument transposition is shown before or after the 
instrument name in staff labels.

NOTE

● You do not need to number instruments in staff labels manually, as Dorico Elements 
automatically numbers instruments when there are multiple players of the same type 
holding instruments with identical names.

● Layout names are different to the instrument names used for staff labels.
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● Staff labels do not show all instruments held by players; for example, in the staff label for 
the first system. You should include a comprehensive instrumentation list that shows any 
doubling at the front of your score.

Staff labels imported from MusicXML files

When exporting MusicXML files from Cubase and importing them into Dorico Elements, you can 
improve the accuracy of the automatic instrument selection by changing the instrument names 
in the Cubase Score Editor to the same English instrument names that Dorico Elements uses 
before exporting the file.

RELATED LINKS
Player, layout, and instrument names on page 181
Transposing instruments on page 132
Instrument numbering on page 131
Changing instrument names on page 183
Renaming players on page 182
Staff label paragraph styles on page 1318

Hiding/Showing staff labels
You can show full or abbreviated instrument/player names in staff labels, or hide all staff labels 
entirely, in each layout independently. The first system in each flow and all subsequent systems 
can have different staff label lengths.

By default, full staff labels are shown on the first system of each flow and abbreviated staff labels 
are shown on subsequent systems in full score layouts. In part layouts, staff labels are not shown 
on any systems.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show staff labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, choose one of the following options for Staff labels on first 
system:

● Full

● Abbreviated

● None

5. Choose one of the following options for Staff labels on subsequent systems:

● Full

● Abbreviated

● None

6. In the Flows subsection, choose one of the following options for Show staff labels:

● On all flows
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● On first flow only

7. Click Apply, then Close.

RESULT
Staff labels are hidden/shown on the corresponding staves and flows in the selected layouts.

● None hides staff labels.

● Full and Abbreviated show staff labels using the corresponding instrument/player name 
length.

TIP

We recommend choosing settings that are appropriate for most flows in the layout, then 
changing the length of staff labels at other positions if required. For example, if you want to 
show full staff labels only on the first system of the first flow, with abbreviated staff labels on all 
other systems.

AFTER COMPLETING THIS TASK

● You can change the full and short names for each instrument.

● You can change whether staff labels show instrument or player names for each player in 
each layout independently.

RELATED LINKS
Hiding/Showing staff labels at system/frame breaks on page 1312
Hiding/Showing instrument change labels at the start of flows on page 141
Changing the first system indent on page 1328
Changing instrument names on page 183
Staff labels on condensed staves on page 1320
Staff labels for percussion kits on page 1319

Changing the minimum indent for systems with staff labels
You can change the minimum indent for all systems that show staff labels to optimize horizontal 
space in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose minimum indent for systems with staff labels 
you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, change the value for Minimum indent for systems with staff 
labels.

5. Click Apply, then Close.

RESULT
The minimum indent on all systems that show staff labels is changed in the selected layouts.
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RELATED LINKS
Changing the first system indent on page 1328
Moving the start/end of systems on page 513

Hiding/Showing staff labels at system/frame breaks
You can change whether staff labels at individual system/frame breaks show full, abbreviated, or 
no instrument/player names, independently of your per-layout settings. For example, if you want 
full staff labels at the start of the first flow but abbreviated staff labels at the start of subsequent 
flows, or if you want to show staff labels in choral music only on systems that contain more 
complicated parts, solo lines, or divisi lines.

PREREQUISITE

● You have inserted system/frame breaks at the positions where you want to hide/show staff 
labels.

● Signposts are shown for system/frame breaks.

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the system/frame break signposts at the positions where you want 
to hide/show staff labels.

2. In the Properties panel, activate Staff labels in the Format group.

3. Select one of the following options from the menu:

● Full

● Abbreviated

● None

RESULT
Staff labels are hidden/shown on the corresponding systems to the selected system/frame 
breaks. Horizontal spacing is automatically adjusted so the system fills the width of the music 
frame.

● None hides staff labels.

● Full and Abbreviated show staff labels using the corresponding instrument/player name 
length.

Deactivating the property returns any selected system break signposts to your per-layout 
settings.

Staff labels
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EXAMPLE

Full staff labels shown No staff labels shown

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Inserting system breaks on page 634
Inserting frame breaks on page 637
Hiding/Showing signposts on page 450

Staff label contents
Staff labels can show the instrument names set for each instrument or the player name of the 
corresponding player. Staff labels can show full or short names.

Instrument numbers are automatically shown in both full and abbreviated staff labels that use 
instrument names.

● Full staff labels use full instrument/player names.

● Abbreviated staff labels use short instrument/player names.

● None shows no staff labels.

NOTE

● You can change the full and short names for each instrument and player.

● Renaming instruments and players does not change the name shown at the top of each part 
layout if you have already renamed the layout. You can rename layouts separately.

RELATED LINKS
Player, layout, and instrument names on page 181
Instrument numbering on page 131
Instrument changes on page 136
Staff label paragraph styles on page 1318

Showing instrument/player names in staff labels
You can change whether staff labels show instrument or player names for each player in each 
layout independently, and on either all systems or only the first system in each flow. For example, 
you can show the player names for percussionists in full score layouts and instrument names in 
percussion part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

Staff labels
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2. In the Layouts list, select the layouts in which you want to change the contents of staff 
labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, in the Show player name instead of instrument names list, 
activate the checkbox for each player whose player name you want to show in staff labels.

5. Choose one of the following options for Show player names:

● On all systems

● On first system only

6. Click Apply, then Close.

RESULT
Player names are shown for players when their checkbox is activated. Instrument names are 
shown for players when their checkbox is deactivated.

Full and short player names are used according to your staff label settings.

If you chose On first system only, activated player names are only shown on the first system in 
each flow, with instrument names shown on all other systems.

AFTER COMPLETING THIS TASK
You can change the full and short names for each instrument and player.

RELATED LINKS
Percussion kit presentation types on page 1428
Renaming groups in grid presentation percussion kits on page 151
Staff label paragraph styles on page 1318

Instrument transpositions in staff labels
Instrument transpositions indicate the interval between the note an instrument plays and the 
sounding note produced. Transposing instruments, such as Horn in F and Clarinet in B♭, are 
commonly shown with their transposition, also known as their “instrument pitch”, as part of their 
instrument name or layout name.

Depending on the options set for Show transposition in the Edit Instrument Names dialog 
for each transposing instrument, they might show transpositions in staff labels even if you have 
hidden transpositions in staff labels in their layout.

Dorico Elements sets common transposing instruments, such as Clarinet in B♭ and Trumpet in B♭, 
to follow your per-layout settings for hiding/showing instrument transpositions in staff labels.

To reduce the risk of confusion, uncommon transposing instruments, such as Clarinet in A or 
Trumpet in E, are set to show their transposition in staff labels always, even if you have hidden 
instrument transpositions in the layout.

RELATED LINKS
Transposing instruments on page 132
Player, layout, and instrument names on page 181
Changing the language for instrument names on page 57

Staff labels
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Hiding/Showing instrument transpositions in staff labels
You can hide/show instrument transpositions in staff labels in each layout independently. For 
example, you can hide instrument transpositions in staff labels in full score layouts but show 
them in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show instrument 
transpositions in staff labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, activate/deactivate the following options for Instrument pitch 
or transposition:

● Show in full staff labels

● Show in abbreviated staff labels

5. Click Apply, then Close.

RESULT
Instrument transpositions are shown in staff labels of the corresponding length in the selected 
layouts when the corresponding checkbox is activated, and hidden when the corresponding 
checkbox is deactivated.

NOTE

Depending on the options set for Show transposition in the Edit Instrument Names dialog 
for each transposing instrument, they might show transpositions in staff labels even if you have 
hidden transpositions in staff labels in their layout.

Changing the appearance/position of instrument transpositions in 
staff labels

You can change the appearance and position of instrument transpositions in staff labels in each 
layout independently. For example, if you want to show instrument transpositions on a separate 
line in part layouts, but on the same line and parenthesized in full score layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose instrument transposition appearance/position 
you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

Staff labels
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4. In the Staff Labels section, choose one of the following options for Position of instrument 
pitch in full staff labels:

● Start

● End

5. Optional: If you chose Start, enter the characters you want to appear as separators into the 
Separator between instrument pitch at start and name field.

6. Optional: If you chose End, activate/deactivate the following options:

● Show on separate line

● Show in parentheses

● Show instrument number before transposition

7. Click Apply, then Close.

RESULT
The appearance and position of instrument transpositions in staff labels is changed in the 
selected layouts.

EXAMPLE

Instrument transposition 
shown at start, with 
hyphen separator

Instrument transposition 
shown at end, on 
separate line

Instrument transposition 
shown at end, in 
parentheses

Instrument transposition 
shown at end, after 
instrument number

RELATED LINKS
Changing the language for instrument names on page 57
Instrument numbering on page 131

Staff labels
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Player group labels
Player group labels show the names of player groups as vertical text on vertical brackets to the 
left of staff labels. They allow you to identify groups of staves and are typically used in large-scale 
works, such as for orchestra and double choir.

Player group labels to the left of staff labels, showing sections in an orchestra

Player group labels show full player group names by default. Short player group names are used 
when the full player group name is longer than the bracket.

You can show player group labels in each layout independently.

TIP

Player group labels use the Player Group Labels paragraph style, which you can edit in the 
Paragraph Styles dialog.

RELATED LINKS
Player groups on page 167
Renaming player groups on page 169
Brackets and braces on page 864
Paragraph Styles dialog on page 756

Hiding/Showing player group labels
You can hide/show player group labels in each layout independently. For example, if you want 
to show player group labels for choirs in the full score layout but hide them in the vocal score 
layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

Staff labels
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2. In the Layouts list, select the layouts in which you want to hide/show player group labels.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, activate/deactivate Show player group names.

5. Click Apply, then Close.

RESULT
Player group labels are shown for player groups in the selected layouts when Show player 
group names is activated, and hidden when it is deactivated.

Staff label paragraph styles
Staff labels use paragraph styles to format their fonts, including their size, spacing, alignment, 
and other formatting options. When staff labels contain multiple separate parts, such as when 
the instrument name and instrument number have different vertical positions, you can format 
each part separately.

The following paragraph styles are used for staff labels:

1 Player Group Labels: Used for player group labels.

2 Staff Labels: The default style used for staff labels that have the instrument/player name 
and number aligned and next to each other. It is also used for the group labels on 
divisi staves, groups in grid presentation percussion kits, and for instrument/player names 
grouped between multiple identical instruments or between player numbers in staff labels 
on condensed staves.

3 Staff Labels (Inner): Used for individual staves within divisi groups, instrument numbers 
when instrument names are aligned between multiple identical instruments, and player 
numbers in staff labels on condensed staves.

4 Staff Labels (Percussion Grid): Used for individual instruments in grid presentation 
percussion kits.

Staff labels
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You can edit each paragraph style independently of each other in the Paragraph Styles dialog; 
for example, if you want outer staff labels to be left-aligned but inner staff labels to be right-
aligned.

TIP

You can make further changes to the appearance and alignment of staff labels on divisi staves at 
each individual divisi change.

RELATED LINKS
Paragraph Styles dialog on page 756
Player group labels on page 1317
Instrument change label paragraph styles on page 142
Percussion kit presentation types on page 1428

Staff labels for percussion kits
The staff labels shown for percussion kit staves depend on their percussion kit presentation type.

The following staff labels are shown for the corresponding percussion kit presentation type:

5-line staff
Single instrument name using the instrument name of the percussion kit.

Grid
Multiple instrument names: one for each kit instrument, positioned at the staff position 
of the corresponding instrument.

Group names are centered between instruments in each group.

Staff labels for individual instruments in grids use a smaller font and a different 
paragraph style than used for standard instrument staff labels. Groups in grids use 
the standard staff label paragraph style.

Single-line instruments
Multiple instrument names: one for each kit instrument, positioned beside the 
corresponding single-line staff.

Staff labels for single-line instruments use the same font and paragraph style as used 
for standard instrument staff labels.

Staff labels
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You can change the player names, layout names, and instrument names of percussion kits in 
the same ways as for other players and instruments. However, to change the staff labels for 
percussion kits, you must change kit instrument names in different ways for percussion kits, 
depending on your percussion kit presentation type:

● 5-line staff: Open the Edit Instrument Names dialog from the Players panel in Setup mode, 
or use the Name field in the Edit Percussion Kit dialog, to change the name of the kit.

● Grid/Single-line instruments: Open the Edit Instrument Names dialog from inside the Edit 
Percussion Kit dialog in Setup mode to change the names of individual instruments.

The same instrument name fields and options are available for kit instruments as for standard 
pitched instruments.

NOTE

Smaller staff labels for each line in grid presentations use the Staff Labels (Percussion Grid) 
paragraph style. You can edit this paragraph style in the Paragraph Styles dialog.

RELATED LINKS
Edit Instrument Names dialog on page 184
Player, layout, and instrument names on page 181
Renaming groups in grid presentation percussion kits on page 151
Creating groups of instruments within grid presentation percussion kits on page 150
Edit Percussion Kit dialog on page 143
Unpitched percussion on page 1419
Percussion kit presentation types on page 1428

Staff labels on condensed staves
Staff labels on condensed staves must reflect all the players included on the staff. Dorico 
Elements automatically consolidates identical instrument names in staff labels on condensed 
staves but always shows all the required player numbers.

On condensed staves containing different types of instruments or instruments with different 
names, all required instrument names are shown.

Staff labels
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Staff labels on condensed brass staves

Because condensing can change frequently, staff labels on condensed staves can vary from one 
system to another. The staff labels for condensed divisi staves reflect the divisions at the start of 
the system and show instrument names.

Dorico Elements also shows player labels above/below condensed staves to identify the players 
to which notes on condensed staves belong, as condensing can change within a single system. 
For condensed divisi staves, Dorico Elements shows the player labels “div.”, with any required 
qualifications, and your set unison indication where each division starts and ends respectively.

RELATED LINKS
Condensing on page 643
Player, layout, and instrument names on page 181

Staff labels
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Staves

A staff is a line or group of lines on which musical notes are notated to indicate the pitch 
and rhythm of music. Pitched instruments use the traditional five-line staff and unpitched 
instruments often use a single-line staff.

Notes are positioned on the lines and in the spaces on five-line staves, and can also use ledger 
lines above/below the staff to represent pitches that cannot fit on the staff.

A phrase on a five-line staff The same phrase on a single-line staff

The pitch and register of notes on five-line staves are determined by clefs, which can also be 
combined with octave lines to indicate what pitches performers play.

On five-line staves for unpitched percussion instruments, the different staff positions correspond 
to different percussion instruments.

Because it is often necessary to have different staff sizes in different layouts depending on their 
type, such as having smaller staves in full score layouts than in part layouts, in Dorico Elements 
you can change various aspects of staves in Layout Options.

RELATED LINKS
Page formatting on page 598
Layout Options dialog on page 745
Staff size on page 617
System objects on page 1326
Brackets and braces on page 864
Staff labels on page 1309
Hiding/Showing empty staves on page 605
Hiding/Showing blank staves after final flows on page 608
Adding players on page 124
Adding instruments to players on page 133
Condensing on page 643
Divisi on page 1329
System dividers on page 1324
System indents on page 1327
Clefs on page 907
Octave lines on page 915
Percussion kit presentation types on page 1428
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Extra staves
It is sometimes necessary to add extra staves to instruments; for example, to make complex 
contrapuntal music easier to read because it is spread out across more staves than usual for that 
instrument.

In Dorico Elements, you cannot add extra staves. However, extra staves are shown if you import 
or open a project that contains them.

An extract of Debussy's piano prelude "Feuilles mortes" with three staves

RELATED LINKS
Ossia staves on page 1323
Divisi on page 1329
Voice-specific dynamics on page 931
Hiding/Showing empty staves on page 605
Signposts on page 450

Ossia staves
Ossia staves are smaller staves shown above/below the main staff of an instrument. They are 
used to show alternative phrases that can be played instead of the original phrase, such as 
suggestions for ornaments, alternative notations from other sources, or an easier version.

In Dorico Elements, you cannot add ossia staves. However, ossia staves are shown if you import 
or open a project that contains them.

Staves
Extra staves 
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An ossia staff below the left-hand piano staff shows an easier alternative

RELATED LINKS
Extra staves on page 1323

System dividers
System dividers are used to clarify the separation of different systems when they appear on the 
same page. They are usually shown as two thick, parallel angled lines positioned to the left of 
initial barlines.

In Dorico Elements, the outer edges of system dividers are aligned with the corresponding edges 
of music frames.

A system divider between two systems in a string quartet score

You can show system dividers in different circumstances and change their appearance in each 
layout independently.

Hiding/Showing system dividers
You can change the circumstances in which system dividers are shown, including specifying the 
minimum number of players required to show them, in each layout independently. For example, 
if you only want to show system dividers between systems that contain different numbers of 
staves.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

Staves
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2. In the Layouts list, select the layouts in which you want to hide/show system dividers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the System Dividers section, activate/deactivate Show system dividers.

5. If you activated Show system dividers, choose one of the following options:

● To show system dividers only between systems containing more than a set number of 
staves, choose When min. staves exceeded.

● To show system dividers between all systems in flows that contain more than a set 
number of players, choose When min. players exceeded.

● To show system dividers only between systems containing different numbers of staves, 
When number of staves differs.

6. Optional: Do one of the following:

● If you chose When min. staves exceeded, change the value for Minimum number of 
staves in system.

● If you chose When min. players exceeded, change the value for Minimum number of 
players.

7. Click Apply, then Close.

RESULT

● If you deactivated Show system dividers, system dividers are hidden in the selected layouts.

● If you activated Show system dividers, system dividers are shown in the corresponding 
circumstances in the selected layouts.

RELATED LINKS
Hiding/Showing empty staves on page 605

Changing the length of system dividers
You can change the length of system dividers in each layout independently; for example, if you 
want to show longer system dividers in layouts that show full staff labels.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to show system dividers.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the System Dividers section, choose one of the following options for Appearance:

● Default

● Long

● Extra long

Staves
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5. Click Apply, then Close.

System objects
System objects are items that apply to all staves in the system and appear in all layouts, but 
are not necessary to show on every staff in full score layouts. For example, tempo marks and 
rehearsal marks are important for all players to see in their parts, but would cause an orchestral 
full score to appear very cluttered if they were shown on every staff.

In Dorico Elements, the following items are considered system objects:

● Rehearsal marks

● Repeat endings

● Repeat markers

● System-attached text

● Tempo marks

● Time signatures shown above the staff

● Horizontal lines that apply to all staves

System objects automatically appear at least once in all layouts. You can show system objects 
at multiple positions in each system by showing them above multiple instrument families. For 
example, you might show them above the woodwind, brass, percussion, and string families. In 
an orchestral full score, this would ensure system objects are spread out evenly across the page, 
meaning no staff is very far from these important markings. You can also show rehearsal marks 
and repeat endings additionally below the bottom staff.

NOTE

● System objects are only shown above instrument families that are bracketed or braced 
together. You can change bracket grouping in each layout independently.

● If the size of system object font styles is set to Staff-relative, the staff size of the top staff in 
each instrument family group affects the size of system objects if they are shown above that 
bracketed group. Font styles that are set to Absolute are unaffected by staff size.

RELATED LINKS
Brackets according to ensemble type on page 866
Paragraph Styles dialog on page 756
Edit Font Styles dialog on page 754
Brackets and braces on page 864
Rehearsal marks on page 1216
Tempo marks on page 1335
Repeat endings on page 1230
Large time signatures on page 1387
Inputting text items on page 388

Staves
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Changing the positions of system objects
You can show system objects above different instrument families in each layout independently. 
Multiple items are categorized as system objects, including system-attached text, rehearsal 
marks, tempo marks, repeat markers, and repeat endings.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the instrument families 
above which system objects appear.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the System Objects section, activate the checkboxes for the instrument families above 
which you want system objects to appear.

5. Activate/Deactivate Show system objects above first soloist.

6. Activate/Deactivate the following options for Also show below bottom staff:

● Repeat endings

● Rehearsal marks

7. Click Apply, then Close.

RESULT
System objects appear above the top staff in each bracketed group you select, provided a 
bracketed group for that instrument family is included in the selected layouts.

If you activated options for Also show below bottom staff, the corresponding notations 
additionally appear below the bottom staff.

NOTE

System objects are only shown above instrument families that are bracketed or braced together. 
You can change bracket grouping in each layout independently.

RELATED LINKS
System objects on page 1326
Designating players as soloists on page 127

System indents
System indents control the distance between the left page margin and the start of systems of 
music. According to tradition, the first system in part layouts is indented, but in modern use this 
is not always necessary.

According to convention, coda sections at the start of new systems are also indented. Dorico 
Elements uses the same gap size before the start of codas whether they occur partway through 
systems or at the start of a new system.

Staves
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A violin part with the first system indented

In Dorico Elements, system indents automatically adjust to accommodate staff labels. For 
example, if a system contains a staff label that is significantly longer than the minimum system 
indent, Dorico Elements increases the indent on that system to ensure the staff label remains 
legible and is not cut off on the left edge or collides with the music.

You can change both the minimum indent on systems with staff labels and the first system 
indent in each layout independently. You can also adjust the system indent at both the start and 
end of individual systems, independently of your per-layout settings.

Changing the first system indent
By default in Dorico Elements, the first system of each flow is indented in part layouts. You can 
change the indent for the first system of all flows in each layout independently.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts whose first system indent you want to change.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Staves and Systems.

4. In the Staff Labels section, change the value for Indent first system of flow by.

5. Activate/Deactivate Apply indent when staff labels are shown.

6. Click Apply, then Close.

RESULT
The indent of the first system of all flows is changed in the selected layouts.

If you deactivated Apply indent when staff labels are shown, first systems with staff labels are 
only indented by the space required for their staff labels.

RELATED LINKS
Changing the minimum indent for systems with staff labels on page 1311
Changing the gap before codas on page 1242
Hiding/Showing staff labels on page 1310
Moving the start/end of systems on page 513
Changing the horizontal justification of final systems on page 612
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Divisi

Divisi is when players split, or “divide”, in order to play multiple lines of music, commonly for a 
limited passage, before returning to play together, or “tutti”. Divisi passages can be notated with 
all lines on a single staff or across multiple staves.

Divisi is a technique most commonly used in orchestral string writing, as the string section 
typically contains a large number of players compared to the number of staves. For example, 
large orchestras commonly have twelve first violins all playing the same part most of the time. 
Dividing those players into multiple parts allows composers to write more complex contrapuntal 
music.

An example divisi change in a Violin I part, splitting it into two sections and a solo line

If the division is relatively simple, it is possible to write all parts on the same staff and label the 
section, with an indication of how many players are required for each line if necessary. If the 
parts have different rhythms at times, you can input them into separate voices on the same staff.

However, when a section is divided into multiple parts that are too different to be clearly written 
on a single staff, it is necessary to divide them onto multiple staves. In Dorico Pro, divisi changes 
allow you not only to divide sections into any number of parts with any number of staves, but 
also to include solo lines and group staves as required.

In Dorico Elements, you cannot input divisi changes. However, divisi changes are shown if you 
import or open a project that contains them.

RELATED LINKS
Extra staves on page 1323
Inputting notes into multiple voices on page 232
Condensing on page 643
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Tablature

Tablature is an alternative notation to the five-line staff, and is used for fretted instruments. On 
tablature, pitches are indicated by fret numbers positioned on lines, each of which represents a 
string on the instrument. As tablature is commonly used for guitars, it usually shows six lines.

An extract of guitar music shown on both a notation staff and tablature

In Dorico Elements, you can show music for fretted instruments, such as the guitar or bass, 
on a regular notation staff and tablature together or only show one or the other. Notes and 
notations are linked between both presentations, meaning any changes you make to one, 
including inputting notes, automatically update the other.

On tablature, ties are automatically notated as round brackets around the second note/chord 
and all subsequent notes/chords in tie chains.

Any notes beyond the range of the instrument or impossible to calculate, such as below the nut 
on the lowest string or a natural harmonic without a suitable node, are shown on tablature as 
pink question marks. If two notes are allocated to the same string at the same rhythmic position, 
both notes appear beside each other and are colored green.

Note on tablature that cannot be calculated

The appropriate tablature is automatically shown for instruments according to their strings and 
tuning settings. There are default tunings stored for each instrument type in Dorico Elements, 
which you can customize in the Edit Strings and Tuning dialog.

RELATED LINKS
Hiding/Showing notation staves and tablature on page 1331
Fretted instrument tuning on page 153
Inputting notes on tablature on page 242
Changing music area colors on page 54
Harmonics on page 1081
Guitar bends on page 1122
Guitar techniques on page 1137
Ties on page 1364
Trills on page 1094
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Capos on page 157

Rhythms on tablature
When notation staves and tablature are both shown, it is customary only to notate rhythms on 
the notation staff. However, when only tablature is shown, it is necessary to show rhythms on 
tablature.

The following items are shown to indicate rhythms on tablature:

● Time signatures

● Stems, stem flags, and beaming

● Rhythm dots

Rhythms shown on tablature

NOTE

Stems, stem flags, and beaming always appear stem-up on tablature in single-voice contexts, 
which means they can collide with guitar bends.

RELATED LINKS
Inputting notes on tablature on page 242

Hiding/Showing notation staves and tablature
You can show notation staves only, tablature only, or both in each layout independently and for 
each player holding at least one fretted instrument independently. For example, you can show 
only notation staves in the full score layout, but the notation staff and tablature in a guitar part 
layout.

When tablature is shown, it can appear with or without rhythms.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to hide/show tablature.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Fretted Instruments section, choose one of the following options for each player 
holding at least one fretted instrument in your project:

● To show only notation staves and hide tablature, choose Notation only.

● To show both notation staves and tablature, choose Notation and tablature.

Tablature
Rhythms on tablature 
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● To show only tablature and hide notation staves, choose Tablature only.

5. Optional: If you chose Notation and tablature or Tablature only, activate/deactivate Show 
rhythms in tablature.

6. Click Apply, then Close.

RESULT
Notation staves and tablature are hidden/shown for the corresponding players in the selected 
layouts.

If tablature is shown, it appears with rhythms when Show rhythms in tablature is activated, and 
without rhythms when it is deactivated.

EXAMPLE

Notation only Notation and 
tablature with 
rhythms

Notation and 
tablature without 
rhythms

Tablature only with 
rhythms

Tablature only 
without rhythms

RELATED LINKS
Players on page 123
Fretted instrument tuning on page 153
Inputting notes on tablature on page 242
Guitar bends on page 1122
Guitar techniques on page 1137
Hiding/Showing empty staves on page 605
Changing instruments on page 134

Changing the allocated string for notes on tablature
You can change the string to which individual notes are allocated on tablature manually; for 
example, if you input the notes on the notation staff and want to change their default string 
allocation.

NOTE

You cannot allocate notes to a string on which they are impossible, such as if the note is lower 
than the open pitch of the string.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. On tablature, select the fret numbers of notes whose allocated string you want to change. 
You can do this in Write mode and Engrave mode.

NOTE

You must select fret numbers on tablature, you cannot select the notes on notation staves.

2. Change their allocated string in any of the following ways:

● To move them up a string, press N .

● To move them down a string, press M .

● In the Properties panel, select a string from the String menu in the Notes and Rests 
group.

RESULT
The string to which the selected notes are allocated is changed. Using the key commands 
changes the string of the selected notes proportionally, whereas selecting a string from the 
String menu allocates all selected notes to the selected string.

NOTE

● If they are now allocated to the same string as another note at that rhythmic position, both 
notes appear beside each other and are colored green.

● Deactivating the property resets the selected notes to their default string.

EXAMPLE

Notes allocated to the same string After changing the strings for some notes to reduce 
the distance between frets

RELATED LINKS
Inputting notes on tablature on page 242
Engrave toolbox on page 503
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Editing the tablature numbers font style
You can edit the formatting of the font used for all numbers on tablature project-wide; for 
example, if you want them to appear larger by default.

PROCEDURE

1. Choose Library > Font Styles to open the Edit Font Styles dialog.

2. In the font styles list, select Tablature Numbers Font.

3. Activate the following options, individually or together, to change the corresponding aspect 
of the font:

● Font family

● Size

● Style

● Underlined

4. Click OK to save your changes and close the dialog.

RESULT
The formatting of the font used for numbers on tablature is changed project-wide.

RELATED LINKS
Edit Font Styles dialog on page 754

Tablature
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Tempo marks

Tempo marks indicate how fast music is played, often with a combination of text instructions and 
metronome marks. They are also known as “tempo changes”, “tempo indications”, and “tempo 
markings”.

A tempo mark can show text instructions, a metronome mark, or a combination of the two.

Tempo mark containing text instruction in French and metronome mark

Text instructions are traditionally expressed in Italian, such as largo or allegretto, but other 
languages, such as English, French, and German, have become widely accepted. The text 
instruction can express simply how fast the music is played, but can also suggest its character. 
For example, grave means slow but also solemn and sad, and vivo means fast but also lively and 
sprightly.

Metronome marks show the speed of the music, indicated in beats per minute, or “bpm”. 
Metronome marks can show a fixed bpm or indicate a range of possible or acceptable values.

Gradual tempo changes indicate a change in tempo over a defined period of time. They can 
appear differently; for example, with/without a continuation line or with the text split into 
syllables and spread across their duration.

Tempo marks use a bold font with a large point size, so they are clearly noticeable on the page. 
They do not usually use an italic font.

In Dorico Elements, tempo marks are categorized as system objects. Therefore, tempo marks 
follow your per-layout settings for the visibility and positioning of system objects.

By default, the tempo marks you input set the tempo for playback and MIDI recording, but 
you can change the tempo mode if, for example, you want to use a single fixed tempo when 
recording MIDI. Gradual tempo changes also affect the playback tempo, and you can change the 
final tempo at the end of gradual tempo changes; for example, if you want to reach a specific 
bpm at the end. If you do not input any tempo marks into your project, the default playback 
tempo is 120 bpm.

RELATED LINKS
Input methods for tempo marks on page 293
Tempo mark font styles on page 1339
Tempo track on page 532
Tempo editor on page 706
Changing the positions of system objects on page 1327
Changing the tempo mode on page 543
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Exporting text on page 102

Types of tempo marks
Dorico Elements groups tempo marks into different types according to their function and effect 
on the music.

In Dorico Elements, there are the following types of tempo marks:

Absolute Tempo Change
Indicates a defined change in tempo, and is often shown with a metronome mark. For 
example, “Adagio =76”.

Absolute tempo changes can show tempo text and metronome marks, both 
individually and together.

Gradual Tempo Change
Indicates a change in tempo over a defined period of time, such as rallentando (slowing 
down) or accelerando (speeding up).

Relative Tempo Change
Indicates a change in tempo that is relative to the previous tempo, such as mosso 
(movement).

Relative tempo changes often include modifiers that qualify the change, such as poco 
meno mosso (a little less movement), and are not defined by a metronome mark. 
You can, however, set a relative metronome mark change as a percentage of the 
previous metronome mark that updates automatically if the previous metronome mark 
changes.

Reset Tempo
Returns the tempo to the previous tempo, such as A tempo, or a previously defined 
tempo, such as Tempo primo (return to the first tempo of the piece).

Tempo Equation
Indicates a change in the beat unit on which metronome marks are based. For 
example, if the time signature changes from 3/4 to 6/8, a tempo equation of = 
indicates the same metronome mark value that applied to the quarter note beat unit in 
3/4 now applies to the dotted quarter note beat unit in 6/8.

RELATED LINKS
Metronome marks on page 1341
Gradual tempo changes on page 1345
Tempo equations on page 1349
Input methods for tempo marks on page 293
Changing the relative tempo mark value on page 1344
Tempo mark font styles on page 1339

Positions of tempo marks
Tempo marks are placed above the staff and at the same positions as other system objects, 
because they usually apply to all staves. They are placed above notations such as slurs, ties, and 
octave lines, and are often aligned with rehearsal marks to ensure clear readability.

By default in Dorico Elements, tempo marks align with either a time signature or the notehead/
rest at the rhythmic position to which they apply. For example, if there is a notehead with an 
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accidental at the rhythmic position of a tempo mark, it is convention to align the tempo mark 
with the accidental.

If a repeat mark occurs mid-system and is not treated as a barline, tempo marks are aligned with 
the repeat mark.

When a tempo mark includes both text and a metronome mark, the text appears first, followed 
by the metronome mark.

You can move tempo marks to different rhythmic positions in Write mode. They are automatically 
positioned to avoid collisions.

You can move tempo marks graphically in Engrave mode, but this does not change the rhythmic 
positions to which they are attached.

In Engrave mode, each gradual tempo change has two square handles, one at the start and one 
at the end. You can move these handles to adjust the graphical position and length of gradual 
tempo changes. You cannot change the angle of gradual tempo changes.

If gradual tempo changes cross system and frame breaks, you can move the line segments on 
each side of the break independently.

Tempo marks are categorized as system objects in Dorico Elements, which you can show above 
the first bracket of selected instrument families. You can change the instrument families above 
which system objects appear in each layout independently; for example, if you want tempo 
marks to appear at multiple vertical positions in each system in the full score only.

RELATED LINKS
Changing the positions of system objects on page 1327
Moving notes/items rhythmically on page 461
Moving items graphically on page 514

Changing the end position of gradual tempo changes relative to 
barlines

You can change how the ends of individual gradual tempo change continuations are positioned 
relative to barlines. You can do this for the current layout and frame chain only, or for all layouts 
and frame chains.

NOTE

This does not affect the appearance of gradual tempo changes with the text-only style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the gradual tempo changes whose end position relative to barlines you want to 
change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Barline interaction in the Tempo group.

3. Choose one of the following options:
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● Stop before

● Continue

RESULT
The end position of the selected gradual tempo changes is changed. If the property scope was 
set to Locally, this change only takes effect in the current layout and frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Changing the style of gradual tempo changes on page 1347
Changing the order of metronome marks on page 1345

Changing tempo text
You can change the text of existing tempo marks individually. For example, if you want to add “al 
fine” to a ritardando at the end of a flow.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the tempo marks whose tempo text you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, enter the tempo text you want into the Text field in the Tempo 
group.

3. Press Return .

RESULT
The tempo text for the selected tempo marks is changed.

TIP

You can also change the tempo text by opening the tempo popover and changing the entry.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Changing existing items on page 432
Changing the order of metronome marks on page 1345
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Showing abbreviated tempo text
You can show individual tempo marks with custom abbreviated text in some layouts; for 
example, if a long tempo mark extends beyond the page boundary in some part layouts but 
the abbreviated version fits within the boundary.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In the music area, open the layout in which you want to show abbreviated tempo text. You 
can do this in Write mode and Engrave mode.

2. Select the tempo marks you want to show with abbreviated text.

3. In the Properties panel, activate Abbreviation in the Tempo group.

4. Enter the text you want into the value field.

5. Activate Abbreviate in the Tempo group.

6. Activate the corresponding checkbox.

RESULT
The selected tempo marks appear with abbreviated text when Abbreviation is activated and 
Abbreviate is deactivated, or when Abbreviation and both Abbreviate and its corresponding 
checkbox are all activated.

This allows you to switch between showing abbreviated/full text in different layouts without 
deleting your abbreviated text from the Abbreviation value field.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503

Tempo mark font styles
There are different font styles for different types of tempo marks and tempo mark components. 
You can change different aspects of these fonts in the Edit Font Styles dialog, such as changing 
their font size to make tempo marks appear larger.

The following font styles are used for tempo marks:

1 Gradual Tempo Text Font: Used for gradual tempo changes, such as "rallentando".
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2 Immediate Tempo Text Font: Used for absolute tempo changes, such as “Adagio”.

3 Metronome Music Text Font: Used for note value glyphs in metronome marks, such as "". 
Must be SMuFL-compliant.

4 Metronome Text Font: Used for equal signs and numbers in metronome marks, such as 
“=76”.

NOTE

Changes made to font styles apply to the entire project, including part layouts.

RELATED LINKS
Edit Font Styles dialog on page 754
Changing the default font family on page 760

Hiding/Showing tempo marks
You can hide/show the different components in individual tempo marks without changing the 
speed of playback. This affects their appearance in all layouts.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the tempo marks you want to hide, or the signposts of tempo marks you want to 
show. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate the following properties in the Tempo group:

● Text shown

● Metronome mark shown

RESULT
When at least one of the properties is activated, the selected tempo marks are shown. They 
display components according to the properties that are activated.

When neither property is activated, the selected tempo marks are hidden. Signposts are shown 
at the position of each hidden tempo mark as they still affect the speed of playback.

TIP

You can input hidden tempo marks when using the tempo popover.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Input methods for tempo marks on page 293
Signposts on page 450
Changing the tempo mode on page 543
Muting notes/items individually on page 548
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Parenthesizing tempo marks
You can show individual absolute tempo marks in parentheses; for example, to indicate 
metronome marks that are suggestions.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the absolute tempo marks you want to parenthesize. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Parenthesized in the Tempo group.

RESULT
The selected tempo marks are shown in parentheses.

● When only either tempo text or metronome marks are shown, the visible component is 
parenthesized.

● When both tempo text and metronome marks are shown, metronome marks are 
parenthesized.

Metronome marks
Tempo marks often include a metronome mark value. Metronome marks show the speed of the 
music, indicated in beats per minute, or “bpm”. For example, a bpm of 60 means one beat per 
second. The more beats per minute, the faster the music.

A metronome mark shown as a range

Metronome marks can be precise, such as  = 176, or can indicate an acceptable range, such as 
 = 152-176. They can also be shown in parentheses, which is useful if the metronome mark is 
intended as a guide rather than a fixed value.

By default, metronome marks appear as integers and do not show decimal places. If you input 
a metronome mark with a decimal place, it is rounded to the nearest integer. Metronome marks 
that you input in the Tempo editor appear as signposts by default.

The beat unit used in metronome marks commonly relates to the meter; for example, the 
metronome mark beat unit is often a quarter note in 4/4 but a dotted quarter note in 6/8.

In Dorico Elements, metronome marks can appear as an individual value or as a range. 
Depending on the type and appearance of metronome marks, the bpm value can indicate a 
fixed tempo or an approximate tempo.

RELATED LINKS
Input methods for tempo marks on page 293
Tempo mark font styles on page 1339
Tempo equations on page 1349
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Tempo track on page 532
Tempo editor on page 706

Changing the metronome mark value
You can change the metronome mark value of individual absolute tempo marks after they have 
been input, including changing the beat unit.

NOTE

These steps do not apply to gradual tempo changes or reset/relative tempo marks.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the absolute tempo marks whose metronome mark values you want to change. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, change the value for Tempo (bpm) in the Tempo group.

3. Press Return .

4. Choose the appropriate note duration and rhythm dot, if applicable, for Beat unit.

RESULT
The metronome mark value and beat unit is changed for the selected absolute tempo marks. 
This affects the tempo of playback, even if no metronome mark component is shown for those 
tempo marks.

NOTE

● By default, any decimals you enter are hidden and the displayed metronome mark value 
appears as the nearest integer. However, metronome marks always reflect their exact values 
in playback.

● You can also change the metronome mark value by opening the tempo popover and 
changing the entry.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Changing existing items on page 432

Showing the metronome mark value as a range
You can show the metronome mark value of individual absolute tempo marks as a range. 
For example, you can use this to indicate that any speed within the given range is musically 
appropriate for the piece.

NOTE

These steps do not apply to gradual tempo changes or reset/relative tempo marks.
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PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the absolute tempo marks whose metronome mark values you want to show as a 
range. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Tempo range (bpm) in the Tempo group.

3. Change the value in the value field.

RESULT
The tempo range, expressed as beats per minute, is changed for the selected tempo marks. By 
default, metronome mark ranges use a dash separator.

NOTE

Depending on the values set for each property, both Tempo (bpm) and Tempo range (bpm) 
can be the minimum/maximum tempo in the range, as Dorico Elements automatically arranges 
metronome mark ranges with the lower value first. However, the metronome mark used for 
playback is always Tempo (bpm), regardless of whether that is the higher/lower value in the 
range.

Showing metronome marks as approximate
You can show individual metronome marks as approximate, and change the appearance of the 
approximate indication.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the metronome marks that you want to show as approximate. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Is approximate in the Tempo group.

3. Optional: Change the appearance of the approximate indication in any of the following ways:

● Activate Approximate appearance, then select the approximate appearance you want 
from the menu.

● Activate Show equals sign, then activate/deactivate the corresponding checkbox.

RESULT
The selected metronome marks are shown as approximate.
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Changing the relative tempo mark value
You can change the tempo of individual relative tempo marks, expressed as a percentage of the 
previous tempo mark.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the relative tempo marks whose value you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, change the value for Relative % in the Tempo group.

3. Press Return .

RESULT
The tempo at the relative tempo mark is changed. For example, if the previous tempo was 
100 bpm, and you change a relative tempo mark to 90, the new tempo is 90% of 100 bpm, which 
is 90 bpm.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503

Changing the final tempo at the end of gradual tempo changes
You can change how significantly gradual tempo changes affect the tempo in playback, 
expressed as a percentage of the tempo at the start of the gradual tempo change.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the gradual tempo changes whose final tempo you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, change the value for Final tempo % in the Tempo group.

3. Press Return .

RESULT
The final tempo at the end of the selected gradual tempo changes is changed.

For example, if you change the value to 20 on a gradual tempo change that started at 100 bpm, 
the final tempo is 20% of 100 bpm, which is 20 bpm. If you change the value to 120 on a gradual 
tempo change that started at 100 bpm, the final tempo is 120% of 100 bpm, which is 120 bpm.
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Changing the order of metronome marks
You can change the order of metronome marks relative to tempo text for individual tempo 
marks. For example, if you want to show metronome marks before tempo text in some tempo 
marks but after tempo text in others.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the tempo marks whose metronome mark order you want to change. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate Metronome mark order in the Tempo group.

3. Choose one of the following options:

● Before

● After

RESULT
The order of metronome marks relative to tempo text in the selected tempo marks is changed.

EXAMPLE

Metronome mark before tempo text Metronome mark after tempo text

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Input methods for tempo marks on page 293

Gradual tempo changes
Gradual tempo changes indicate a change in tempo over a defined period of time, such as 
rallentando, which indicates slowing down, and accelerando, which indicates speeding up.

Rallentando with dashed line
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Gradual tempo changes are considered a type of tempo mark in Dorico Elements, meaning you 
can input them in the same ways as for tempo marks.

Because gradual tempo changes have a different metronome mark value at the start/end, you 
can change the final tempo at the end of individual gradual tempo changes.

In Dorico Elements, you can show gradual tempo changes with different styles, such as with a 
continuation line or with syllables spread across their duration. You can also show gradual tempo 
changes with different line styles, such as dotted or dashed.

NOTE

You cannot change the angle of gradual tempo changes.

RELATED LINKS
Input methods for tempo marks on page 293
Changing the final tempo at the end of gradual tempo changes on page 1344
Tempo mark font styles on page 1339
Lengthening/Shortening items on page 430
Exporting text on page 102

Adding poco a poco text to gradual tempo changes
You can add poco a poco text immediately after individual gradual tempo changes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the gradual tempo changes to which you want to add poco a poco text. You can do this 
in Write mode and Engrave mode.

2. In the Properties panel, activate Poco a poco in the Tempo group.

RESULT
Poco a poco text is shown immediately after the text in the selected gradual tempo changes.

Deactivating Poco a poco (little by little) removes poco a poco text from the selected gradual 
tempo changes.

EXAMPLE

Rallentando with poco a poco text
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Changing the style of gradual tempo changes
You can change the style of individual gradual tempo changes. Gradual tempo changes can 
appear as text only with no continuation line, text with a continuation line, or with the word 
spread across their duration.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the gradual tempo changes whose style you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Gradual style in the Tempo group.

3. Select one of the following options from the menu:

● rit.

● rit...

● rit - ar - dan - do

RESULT
The style of the selected gradual tempo changes is changed.

NOTE

Only gradual tempo changes with valid full text appear separated into syllables; for example, 
ritenuto or accelerando. Gradual tempo changes automatically have valid full text when you input 
them using the panel or select a suggested entry from the menu when using the popover. You 
can also change the text of existing gradual tempo changes, including adding hyphens manually 
to control how they are separated into syllables.

EXAMPLE

rit.: Text only rit...: Text with a continuation line rit - ar - dan - do: Syllables in the 
text spread across the duration of 
the gradual tempo change

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Input methods for tempo marks on page 293
Changing tempo text on page 1338

Changing the line style of gradual tempo changes
You can change the line style of individual gradual tempo changes whose style includes a 
continuation line.
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NOTE

This does not affect the appearance of gradual tempo changes with the text-only style.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the gradual tempo changes whose line style you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Line style in the Tempo group.

3. Select one of the following options from the menu:

● Solid

● Dotted

● Dashed

RESULT
The line style of the selected gradual tempo changes is changed.

Lengthening/Shortening gaps and dashes in gradual tempo changes
You can change the length of dashes and the gaps between dashes in individual gradual tempo 
changes. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

NOTE

These steps only apply to gradual tempo changes with dashed lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the gradual tempo changes with dashed lines whose dash length 
you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the 
Tempo group:

● Line dash length

● Line dash gap

3. Change the values in the value fields.
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RESULT
Increasing Line dash length makes dashes in gradual tempo changes longer, decreasing the 
value makes dashes shorter.

Increasing Line dash gap makes gaps between dashes in gradual tempo change lines longer, 
decreasing the value makes gaps shorter.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503

Changing the line thickness of gradual tempo changes
You can change the thickness of dashed and solid lines in individual gradual tempo changes. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

NOTE

These steps only apply to gradual tempo changes with dashed and solid lines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the gradual tempo changes whose thickness you want to change.

2. In the Properties panel, activate Line thickness in the Tempo group.

3. Change the value in the value field.

RESULT
Increasing the value makes dashed and solid lines thicker, decreasing the value makes dashed 
and solid lines thinner. If the property scope was set to Locally, this change only takes effect in 
the current layout and frame chain.

Tempo equations
Tempo equations indicate a change in the beat unit on which metronome marks are based. They 
are often used to maintain a consistent pulse across multiple different meters.

For example, if the time signature changes from 6/8 to 3/4, a tempo equation of  = indicates the 
same metronome mark value that applied to the dotted quarter note beat unit in 6/8 now applies 
to the quarter note beat unit in 3/4.

Tempo marks
Tempo equations 
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Tempo equations are considered a type of tempo mark in Dorico Elements, meaning you can 
input them in the same ways as for tempo marks.

NOTE

Tempo equations do not yet include tuplet durations. This is planned for future versions.

RELATED LINKS
Input methods for tempo marks on page 293

Tempo marks
Tempo equations 
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Text items

Text items exist at rhythmic positions within flows and allow you to display generic text in the 
music.

You can customize the formatting of text in text items using the available text editor options, 
such as by applying different paragraph styles to each line of text and different character styles 
to each character.

A text item below a piano staff

In Dorico Elements, there are the following types of text items:

Staff-attached text
Text items that apply to individual staves and only appear on those staves.

System-attached text
Text items that apply to all staves and appear in all applicable layouts. In Dorico 
Elements, system-attached text is categorized as a system object. Therefore, system-
attached text follows your per-layout settings for the visibility and positioning of 
system objects.

NOTE

● You can only use tokens in text frames. You cannot use tokens in text items. Full text frame 
functionality is only available in Dorico Pro.

● There are dedicated features for other types of text that often appear in musical scores, such 
as tempo marks and dynamics.

RELATED LINKS
Inputting text items on page 388
Text editor options in Write mode on page 389
Tokens on page 655
System objects on page 1326
Changing the default font family on page 760
Paragraph Styles dialog on page 756
Exporting text on page 102
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Types of text
Generic text in Dorico Elements can exist as text items, either staff-attached or system-attached, 
or in text frames, which are fixed to the page rather than the music. There are dedicated features 
for other types of text that often appear in musical scores, such as tempo marks and dynamics.

In Dorico Elements, there are the following types of text:

Text items
Text items exist at rhythmic positions within flows. They can display any text you enter, 
apart from tokens. You can customize the formatting of text in text items using the 
available text editor options, such as by applying different paragraph styles to each line 
of text and different character styles to each character.

Text items can apply either to individual staves, which is known as “staff-attached text”, 
or to all staves, which is known as “system-attached text”.

A text item below a piano staff

Text in text frames
Text frames exist on pages independently of rhythmic positions within flows. They can 
display any text you enter, including tokens. You can customize the formatting of text 
in text frames using the available text editor options, such as by applying different 
paragraph styles to each line of text and different character styles to each character.

Text frames on the first page in a piano part layout, with the project title frame selected

NOTE

The project title, page numbers, and running headers that are automatically shown in 
layouts exist in text frames. Their contents and formatting come from page templates, 
which you cannot edit or create in Dorico Elements. Editing text frames in layouts 
is considered a page template override. Pages with page template overrides are not 
automatically deleted, even if they are empty because the layout became shorter.

If you want to change the information shown at the tops of pages, we recommend 
that you do so in the Project Info dialog to avoid page template overrides. The default 
page templates display different information according to their type.

Text items
Types of text 

1352
Dorico Elements 5.1.30



Tempo marks
Tempo marks indicate how fast music is played, often with a combination of text 
instructions and metronome marks.

For example, A tempo, Larghetto, ritardando, and accelerando are all tempo marks.

Tempo mark containing text instruction in French and metronome mark

Rehearsal marks
Rehearsal marks are ordered sequences of letters or numbers that provide useful 
reference points. They are often shown in a rectangular enclosure.

A rehearsal mark, showing the letter G

Playing techniques
The term “playing techniques” covers a wide range of instructions intended to tell 
performers to modify the sound of the notes they are playing; for example, by 
changing their embouchure or changing the position of their bow, or by modifying 
their instrument, such as adding a mute or depressing a pedal.

For example, pizzicato, flutter-tongue, con sordino, and “snares on” are all playing 
techniques.

Dynamics
Dynamics indicate the loudness of the music and can be combined with expressive text 
to give further clarification about how to perform the music. Dynamics can indicate an 
immediate change in volume or a gradual change over a specified duration.

For example, , , and “crescendo” are all dynamics.

A phrase with multiple different dynamics

Text items
Types of text 
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Lyrics
In Dorico Elements, the term “lyrics” is used for all text that is sung by singers. Lyrics 
are organized into lyric lines, with different types of lyric lines available for lyrics with 
different purposes. For example, lyrics in a chorus line are shown in an italic font by 
default.

Lyrics for a soprano duet with basso continuo accompaniment

Fingering
Fingerings use numbers and letters to recommend which fingers players should use 
for notes.

Piano music containing multiple fingerings, including a substitution fingering and alternative 
fingerings

Figured bass
Figured bass is a shorthand that uses figures to specify the harmony above the notated 
bass notes. Figures use a combination of Arabic numbers, accidentals, and horizontal 
hold lines to specify both the intervals above the bass note that make up the chord and 
its duration.

A basso continuo part with figured bass below the staff

Chord symbols
Chord symbols describe the vertical harmony of the music at a specific moment. They 
are frequently used in jazz and pop music, where players often improvise around chord 
progressions.

For example, “Gm7”, “Dsus4”, and “C6/9” are all chord symbols.

Text items
Types of text 
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Chord symbols shown above slashes on the Clarinet and Piano staves to help the players 
improvise around the notated Cornet melody.

Repeat markers
Repeat markers show that musical material is to be repeated. They often involve 
jumping to different positions and sections in the music instead of moving through 
the music consecutively.

For example, D.C. al Coda, D.S., and Fine are all repeat markers.

A mid-system coda section

Comments
Comments are notes or instructions added at precise positions in a project without 
affecting the music. They are considered annotations in Dorico Elements, meaning they 
are not printed by default.

A passage with comments and replies

RELATED LINKS
Tokens on page 655
Text formatting on page 753
Changing the default font family on page 760
Editing text in text items on page 392
Exporting text on page 102
Flow headings on page 651

Text items
Types of text 
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Page numbers on page 1150
Tacets on page 640
Tempo marks on page 1335
Rehearsal marks on page 1216
Playing techniques on page 1180
Dynamics on page 921
Lyrics on page 1029
Fingering on page 971
Figured bass on page 957
Chord symbols on page 871
Repeat markers on page 1236
Comments on page 494
Staff labels on page 1309
Instrument changes on page 136
Player group labels on page 1317

Changing the paragraph style of text items
You can change the paragraph style that is applied to individual text items; for example, if you 
want to use different paragraph styles according to the information included in different text 
items.

PROCEDURE

1. In Write mode, select the text items whose paragraph style you want to change.

2. Choose Edit > Notations > Text > Change Paragraph Style to open the Change Paragraph 
Style dialog. You can also choose this option from the context menu.

3. Select a paragraph style from the Paragraph style menu.

4. Click OK to save your changes and close the dialog.

RESULT
The paragraph style applied to the selected text items is changed. The formatting of the selected 
text items now follows the paragraph style, such as its font size, font style, or horizontal 
alignment.

NOTE

If you override the paragraph style of text in an individual text item or text frame, such as by 
making text bold, any changes you later make to corresponding parameters of the paragraph 
style are not applied to the overridden text. However, font size overrides are combined with the 
font size in the paragraph style.

RELATED LINKS
Paragraph Styles dialog on page 756
Types of page templates on page 648
Removing page template overrides on page 651
Selecting more items of the same type on page 423

Aligning text items with the start of systems
You can align individual text items whose rhythmic position is at the start of systems with the 
systemic barline rather than the first note/rest, independently of the system alignment setting 

Text items
Changing the paragraph style of text items 
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for their paragraph style. You can do this for the current layout and frame chain only, or for all 
layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the text items you want to align with the start of systems. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Align with system start in the Text group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected text items are aligned with the start of systems when the checkbox is activated, 
and aligned with the first note/rest in systems when the checkbox is deactivated. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

When the property is deactivated, text items follow the system alignment setting of their 
paragraph style.

TIP

You can change the default alignment of each paragraph style relative to the start of systems in 
the Paragraph Styles dialog.

EXAMPLE

Text aligned with the first note in the system Text aligned with the start of the system

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Inputting text items on page 388
Moving items graphically on page 514

Enabling/Disabling text collision avoidance
You can change whether individual text items automatically move to avoid collisions. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

Text items
Enabling/Disabling text collision avoidance 
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Text items with collision avoidance disabled do not contribute to automatic staff spacing 
calculations.

NOTE

These steps do not apply to text in text frames.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the text items whose collision avoidance you want to enable/disable.

2. In the Properties panel, activate Avoid collisions in the Text group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
The selected text items avoid collisions when the checkbox is activated, and do not avoid 
collisions when the checkbox is deactivated. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

RELATED LINKS
Staff spacing on page 620

Adding borders to text items
You can add borders to individual text items; for example, if you want to make the boundaries of 
text items clear. You can show borders on text items in addition to erasing their backgrounds.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the text items to which you want to add borders. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Border in the Text group.

RESULT
Borders are added to the selected text items.

TIP

● Deactivating Border removes borders from the selected text items.

Text items
Adding borders to text items 
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● You can show borders on text items automatically by using paragraph styles set to show 
borders by default.

EXAMPLE

Text with no border Text with border shown

AFTER COMPLETING THIS TASK

● You can change the style and thickness of text item borders.

● You can change the padding between text items and each edge of their borders.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Paragraph Styles dialog on page 756
Hiding/Showing borders on layout names on page 1001
Instrument change label paragraph styles on page 142

Changing the style of text item borders
You can change the style of borders shown on individual text items; for example, if you want to 
show rectangle borders on some text items but capsule borders on others. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the text items whose border style you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Border style in the Text group.

3. Select one of the following options from the menu:

● Rectangle

● Rounded rectangle

● Capsule

● Angled ends rectangle

RESULT
The border style of the selected text items is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

Text items
Adding borders to text items 
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TIP

You can change the border style used by each paragraph style by default in the Paragraph 
Styles dialog.

EXAMPLE

Rectangle Rounded rectangle Capsule Angled ends rectangle

Changing the thickness of text item borders
You can change the thickness of borders around individual text items.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the text items whose border thickness you want to change.

2. In the Properties panel, activate Border thickness in the Text group.

3. Change the value in the value field.

RESULT
The thickness of borders around the selected text items is changed.

Changing the padding around text items
You can change the padding around text items individually, and for each edge independently. 
This affects the distance between text and erased backgrounds and borders. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the text items whose padding you want to change.

2. In the Properties panel, activate the Erasure padding properties, individually or together, in 
the Text group.

Text items
Adding borders to text items 
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● L changes the padding between text items and their left edge.

● R changes the padding between text items and their right edge.

● T changes the padding between text items and their top edge.

● B changes the padding between text items and their bottom edge.

3. Change the values in the value fields for the edges whose padding you want to change.

RESULT
The padding around the selected text items is changed. Increasing the values increases the 
padding, decreasing the values decreases the padding. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

You can change the default padding between text and each border edge for individual paragraph 
styles in the Paragraph Styles dialog. However, paragraph style border padding settings are 
only used when Border is activated for the corresponding paragraph style.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Paragraph Styles dialog on page 756

Erasing the background of text items
You can erase the background of individual text items; for example, to ensure the text remains 
legible when crossing barlines. You can do this for the current layout and frame chain only, or for 
all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the text items whose backgrounds you want to erase.

2. In the Properties panel, activate Erase background in the Text group.

RESULT
The backgrounds of the selected text items are erased. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

● You can show borders on text items in addition to erasing their backgrounds.

● Deactivating Erase background returns the selected text items to the default non-erased 
background.

Text items
Erasing the background of text items 
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EXAMPLE

Text with non-erased background Text with erased background

AFTER COMPLETING THIS TASK
You can change the padding between text items and each edge of their erased areas.

Hiding/Showing text items
You can hide/show individual text items. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains. For example, you can show specific text items in part 
layouts but hide them in full score layouts.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the text items you want to hide, or the signposts of text items you want to show. You 
can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hide in the Text group.

RESULT
The selected text items are hidden when Hide is activated, and shown when it is deactivated. If 
the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

Signposts are shown at the position of each hidden text item. However, signposts are not printed 
by default.

TIP

● You can hide/show text signposts by choosing View > Signposts > Text.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665

Text items
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Engrave toolbox on page 503
Signposts on page 450
Key Commands page in the Preferences dialog on page 60
Annotations on page 597

Text items
Hiding/Showing text items 
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Ties

A tie is a curved line that joins two notes of the same pitch. When notes are longer than the 
maximum duration of a bar in the prevailing time signature, they automatically appear in Dorico 
Elements as tie chains; that is, a sequence of adjacent notes joined with ties.

Each sequence of ties, whether they join two notes or ten notes together, represents a single 
note with the duration of all the tied notes combined. A performer plays the notes as one note, 
without re-striking, re-blowing, or re-bowing the note at any point within the rhythmic duration 
of the tie chain.

A tie chain across several bars on the bottom piano staff

On tablature, tied notes appear as parenthesized fret numbers at the start of subsequent bars by 
default. When tablature is shown with rhythms, ties within the same bar are indicated with stems 
rather than bracketed noteheads.

A phrase on tablature with some ties within bars and 
a chord tied across two bars

The same phrase on a notation staff

In Dorico Elements, most ties are created automatically. Rhythms are notated according to the 
prevailing beat grouping, which is normally set by the time signature. Therefore, notes that 
cannot be notated using a single duration are automatically drawn as tie chains. For example, 
if you input a dotted whole note at the start of a bar in a 4/4 time signature, it is automatically 
notated as a whole note tied to a half note in the next bar. If the time signature changes, tie 
chains are automatically adjusted to remain correct in the new meter.

Dorico Elements automatically determines the appropriate endpoint position and curvature 
direction for ties to avoid collisions, according to the context.

NOTE

● Slurs must not be confused with ties, which look superficially similar, but instead join notes 
of the same pitch to indicate that they are played as a single note. In that sense, ties are part 
of rhythmic notation, while slurs are considered articulation.

● In Write mode, you can only select whole tie chains because Dorico Elements considers each 
tie chain to be a single note. However, you can still input notations, such as dynamics, in the 
middle of tie chains by activating the caret and moving it to the required rhythmic position 
within the tie chain.
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In Engrave mode, you can select individual notes and ties within tie chains and edit them 
independently.

● When you tie existing notes together, they might be consolidated into fewer or more notes 
within a tie chain, depending on the musical context, the time signature, and the position of 
the start of the note in the bar.

● Articulations can only appear once on each tie chain, either at the start or the end, 
depending on the type of articulation. For example, staccato marks appear at the end 
whereas accents appear at the start. You can change the positions of articulations relative to 
individual tie chains.

RELATED LINKS
Inputting ties on page 247
Time signatures on page 1381
Hiding/Showing ties across beat boundaries on page 861
Changing the positions of articulations on tie chains on page 807
Hiding/Showing or parenthesizing accidentals on page 793
Bracketed noteheads on page 1066
Numbered bar regions on page 1253
Caret on page 218

Ties vs. slurs
Ties and slurs look superficially similar but differ in meaning.

Ties indicate that a note should not be re-struck. They are used to join notes of the same pitch 
together. For example, ties can be used to extend notes across multiple bars. Although multiple 
notes can be included in a single tie chain, each tie in the chain only joins one notehead to the 
next notehead on the staff.

Articulations on tied notes only affect the attack at the start of the tie chain and the release at the 
end of the tie chain.

Two long notes tied together Two phrases with slurs

Slurs indicate articulation, such as bowing or breathing, and normally group notes of different 
pitches together. Slurs can join two noteheads together with any number of pitches in between. 
They often indicate the shaping of phrases.

Slurs can also be used in conjunction with articulation. Unlike ties, articulation within slurs can 
affect the sound throughout the phrase. For example, staccato articulations on repeated notes of 
the same pitch within a slur indicate that notes should be played on a stringed instrument using 
the same bow direction, but stopping the bow between each note.

RELATED LINKS
Slurs on page 1283

Ties
Ties vs. slurs 
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Tie styles
There are different styles of ties available in Dorico Elements, which you can use to indicate 
different meanings.

Solid
This is the default style for ties. Ties appear as tapered solid lines: thinner at the ends 
and thicker in the middle.

Dashed
Ties appear as tapered dashed lines. Can be used to denote optional or suggested ties; 
for example, in vocal music where some verses have more syllables than others and 
therefore require more notes.

Dotted
Ties appear as dotted lines. The dots are the same size and the same distance apart 
over the whole length of the tie. Can also be used to denote optional or suggested ties.

Half-dashed start
The first halves of ties appear as dashed lines, the second halves as solid lines. Used to 
denote that a tie was written incompletely in the source in critical editions.

Half-dashed end
The first halves of ties appear as solid lines, the second halves as dashed lines. Used to 
denote that a tie was written incompletely in the source in critical editions.

Editorial
Ties appear as solid black lines, but with a smaller vertical line intersecting them 
exactly halfway along their length. Used to show that ties were added by the editor and 
were not present in the source.

Changing the style of ties
You can change the style of individual ties. For example, to show dashed ties for notes with 
different lyrics in some verses. You can do this for the current layout and frame chain only, or for 
all layouts and frame chains. By default, all ties are solid.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Ties
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PROCEDURE

1. Select the ties whose style you want to change. You can do this in Write mode and Engrave 
mode.

NOTE

In Write mode, you can only select whole tie chains. In Engrave mode, you can select 
individual ties within tie chains.

2. In the Properties panel, activate Style in the Ties group.

3. Select one of the following options from the menu:

● Solid

● Dashed

● Dotted

● Half-dashed start

● Half-dashed end

● Editorial

RESULT
The style of the selected ties is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503

Changing the size of dashes/dots in ties
You can change the size of the dashes/dots in dashed/dotted ties individually. You can do this for 
the current layout and frame chain only, or for all layouts and frame chains.

NOTE

These steps only apply to dashed/dotted ties.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the dashed/dotted ties whose dash/dot size you want to change. You can do this in 
Write mode and Engrave mode.

Ties
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NOTE

In Write mode, you can only select whole tie chains. In Engrave mode, you can select 
individual ties within tie chains.

2. In the Properties panel, activate Dash/dot in the Ties group.

3. Change the value in the value field.

RESULT
Increasing the value makes dashes/dots bigger, decreasing the value makes dashes/dots 
smaller. If the property scope was set to Locally, this change only takes effect in the current 
layout and frame chain.

Changing the size of gaps in dashed/dotted ties
You can change the size of the gaps in dashed/dotted ties individually. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the individual dashed/dotted ties whose gap size you want to 
change.

2. In the Properties panel, activate Gap in the Ties group.

3. Change the value in the value field.

RESULT
Increasing the value makes the gaps between dashes/dots larger. Decreasing the value makes 
the gaps between dashes/dots smaller. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503

Tie curvature direction
The direction of tie curvatures is determined by the stem direction of the notes/chords at each 
end of the tie, the number of notes in chords at each end, and the number of voices on the staff.

Tied single notes in single-voice contexts

If a single voice is active and a tie joins two single notes, tie curvature direction is determined by 
the stem directions of the notes at either end of the tie.

Ties
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● If the stem directions match, the tie curves away from the notes and is positioned on the 
notehead side.

● If the stem directions differ, the tie curves upwards by default.

Tied chords in single-voice contexts

If a tie joins two chords, the direction of the ties is determined by the number of tied notes in the 
chords.

● For an even number, the ties are equally split between curving towards the notehead end 
and curving towards the stem end.

● For an uneven number, the majority of ties curve towards the notehead end.

In chords that contain both tied and untied notes, ties curve towards the stem end by default.

Tied notes in multiple-voice contexts

Ties are positioned on the stem side and are curved as follows:

● For up-stem voices, ties curve upwards.

● For down-stem voices, ties curve downwards.

● For overlapping/interlocking pitches in multiple voices, the rules for tied chords in single-
voice contexts apply. All notes in all voices are treated as if they belong to a single voice.

TIP

You can change the curvature direction of ties individually.

RELATED LINKS
Tie height on page 1377
Tie shoulder offset on page 1379

Changing the curvature direction of ties
You can change the curvature direction of ties individually, including individual ties within tie 
chains. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the ties whose curvature direction you want to change. You can do this in Write mode 
and Engrave mode.

NOTE

In Write mode, you can only select whole tie chains. In Engrave mode, you can select 
individual ties within tie chains.

2. In the Properties panel, activate Direction in the Ties group.

Ties
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3. Choose one of the following options:

● Up 

● Down 

RESULT
The curvature direction of the selected ties is changed. If the property scope was set to Locally, 
this change only takes effect in the current layout and frame chain.

TIP

You can adjust the precise shapes of tie chains, and of each tie within tie chains, in Engrave mode 
using the square handles on each tie.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Changing the shape/angle of ties on page 1375

Non-standard ties
Usually, ties join two notes of the same pitch in the same staff. However, ties can also cross 
system breaks and frame breaks, clef changes, or time signature changes. These types of ties are 
all positioned automatically in Dorico Elements.

Ties can also join non-adjacent notes, notes in different voices, or notes in different staves 
together. In Dorico Elements, you must input these types of ties manually.

Ties across system/frame breaks

The ends of ties that cross system/frame breaks are automatically positioned in Dorico Elements.

Their vertical position remains the same, as both ends are centered on the noteheads to which 
they are attached. Their behavior also remains the same, as selecting one note in a tie chain that 
crosses a system/frame break in Write mode selects all notes in the tie chain.

The horizontal space for the parts of ties shown to the left of notes at the start of new systems/
frames may not be sufficient to show an ideal tie curve. In such cases, you can use Note Spacing 

 in Engrave mode to adjust the spacing of individual notes at the start of systems/frames to 
give ties more space.

The start of a tie chain before a system break The end of the same tie chain after a system break

Tied notes with accidentals across system/frame breaks

The ends of ties for tied notes with accidentals across system/frame breaks are also 
automatically positioned.

Ties
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As tied notes in Dorico Elements are treated as one note notated to fit in time signatures, 
cautionary accidentals at the start of new systems/frames are not shown by default. If you 
choose to show accidentals beside notes in tie chains at the start of new systems/frames, the 
position of the notes is changed to accommodate accidentals. However, this automatic position 
might not leave sufficient room for the part of the tie to the left of the notes to be shown with an 
ideal curve.

The start of a tie chain before a 
system break

The end of the same tie chain, 
with a cautionary accidental in 
parentheses

The end of the same tie chain 
after adjusting note spacing to 
give the tie beside the accidental 
more space

Ties across time signature changes

Ties are automatically positioned between notes that span a time signature change. If ties 
crossing a time signature change are joining notes in the middle of a staff, the top or bottom of 
the time signature change is partially obscured by the ties. However, as ties are curved, the time 
signature is unlikely to be completely obscured.

Ties across clef changes

Ties are automatically positioned between notes that span a change of clef. Ties across clef 
changes are not horizontal, as the same pitch is positioned differently in each clef.

The result of cross-clef ties is likely to be visually and musically confusing, as they can be misread 
as slurs. In this case, consider moving the change of clef to before/after the tied note.

Ties between non-adjacent notes

You can input ties between notes of the same pitch that are not directly beside each other and 
between grace notes and normal notes. This can be useful when inputting ties between multiple 
notes before a chord, for example.

Tied notes building up a chord Notes tied to the following chord Multiple grace notes tied to 
the following chord

Ties between different voices

You can input ties between notes of the same pitch in different voices belonging to the same 
instrument.

Ties between notes on different staves

You can input ties between notes of the same pitch in different staves belonging to the same 
instrument, such as the two staves of a piano.

Ties
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Laissez vibrer ties

Laissez vibrer ties are short ties that indicate a note should be left to ring, and should not be 
stopped. They extend a small amount to the right of the note to which they apply, but do not 
connect to another note.

You can add laissez vibrer ties to any note. You can edit laissez vibrer ties in Engrave mode like any 
other tie.

RELATED LINKS
Inputting ties on page 247
Hiding/Showing or parenthesizing accidentals on page 793
Note spacing on page 507

Hiding/Showing laissez vibrer ties
You can add laissez vibrer ties to any note; for example, to specify which notes must not be 
stopped after being played but instead left to ring.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes on which you want to add a laissez vibrer tie. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate/deactivate Laissez vibrer tie in the Notes and Rests group.

RESULT
Laissez vibrer ties are added to the selected notes when the property is activated, and are 
removed when the property is deactivated. Laissez vibrer ties are positioned automatically.

TIP

● You can edit the length and shape of laissez vibrer ties individually like any other tie in 
Engrave mode.

● You can assign a key command for Toggle Laissez Vibrer Tie on the Key Commands page 
in Preferences.

EXAMPLE

Phrase without laissez vibrer ties Phrase with laissez vibrer ties

Ties
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RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Changing the shape/angle of ties on page 1375
Hiding/Showing ties across beat boundaries on page 861

Deleting ties
You can delete ties without deleting the notes to which they are attached.

NOTE

Deleting ties from tie chains removes all ties in the tie chain. If you want to remove single ties 
from longer tie chains, you can split the tie chain.

PROCEDURE

1. In Write mode, select the tie chains from which you want to delete all ties.

2. Delete all ties in any of the following ways:

● Press U .

● In the Notes toolbox, click Scissors .

RESULT
All ties in the selected tie chains are deleted. Notes previously in the tie chain remain at their 
rhythmic positions.

RELATED LINKS
Notes toolbox on page 196
Changing the duration of notes on page 259

Splitting tie chains
You can split tie chains at specified positions; for example, if you want to change the pitch 
halfway through a tie chain or delete individual ties within tie chains. This does not remove any 
other ties in the tie chain.

NOTE

If you want to split ties because Dorico Elements notated notes differently than you expected, 
you can change the default note and rest grouping settings according to different meters. You 
can also set custom beat groupings for individual time signatures.

PROCEDURE

1. In Write mode, double-click the staff where you want to split a tie chain to start note input at 
that position.

2. Optional: Move the caret to where you want to split the tie chain.

● To move the caret according to the current rhythmic grid resolution, press 
Right Arrow / Left Arrow .

● To advance the caret according to the note value currently selected, press Space  or click 
Advance Caret  in the Keyboard, Fretboard, or Drum Pads panel toolbar.

Ties
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● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

3. Split the tie chain in any of the following ways:

● Press U .

● In the Notes toolbox, click Scissors .

4. Optional: If you want to split the same tie chain in multiple places, move the caret to the next 
rhythmic position where you want to split the tie chain and repeat step 3.

5. Stop note input in any of the following ways:

● Press Esc  or Return .

● In the Notes toolbox, click Start Note Input .

RESULT
The tie chain is split at the caret position.

RELATED LINKS
Note and rest grouping on page 860
Beam grouping according to meters on page 841
Creating custom beat groupings for meters on page 861
Splitting notes by duration on page 261
Notes toolbox on page 196
Caret on page 218
Moving the caret manually on page 223
Rhythmic grid on page 217
Keyboard panel on page 206
Fretboard panel on page 208
Drum Pads panel on page 209

Ties in Engrave mode
In Engrave mode, each tie has five square handles that you can move independently. Some 
handles are connected to others, meaning moving one can affect the position of neighboring 
handles.

Ties have the following handles in Engrave mode:

1 Left endpoint

2 Left control point

3 Tie height

4 Right control point

5 Right endpoint

For example, moving the left endpoint moves both the start of a tie and the other handles apart 
from the right endpoint. However, moving the right control point only causes the tie height 
handle to move as well. This gives you fine control over the shape of ties, while ensuring the end 
result remains curved and smooth.

Ties
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RELATED LINKS
Slurs in Engrave mode on page 1300

Changing the shape/angle of ties
You can change move ties and tie handles graphically, allowing you to change the shape and/or 
angle of individual ties; for example, to adjust an endpoint relative to an individual notehead. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the whole ties or individual tie handles you want to move in any of 
the following ways:

● Ctrl/Cmd -click multiple ties.

● Ctrl/Cmd -click individual handles on multiple ties.

● Select a whole tie and press Tab  to cycle through its handles until the one you want to 
move is selected.

● Click the handle you want to move.

NOTE

● To change the angle of ties, select tie endpoints only.

● You cannot move whole ties to the right/left, you can only move them upwards/
downwards.

2. Move the ties or handles in any of the following ways:

● To move them a standard amount to the right, left, up, or down, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move handles to 
the left. This moves ties/handles by 1/8 space per press.

● To move them a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow . This moves handles by 1 space per press.

● To move them a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow . This moves handles by 1/2 space per press.

● To move them a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow . This moves handles by 1/32 space per 
press.

● Click and drag whole ties upwards/downwards.

● Click and drag them in any direction.

TIP

To constrain movement either horizontally or vertically, start dragging, then press and 
hold Shift .

RESULT
The selected ties or tie handles are moved. Depending on the handles you selected and the 
directions in which you moved them, this can change the shape, angle, and/or proportional size 
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of the corresponding ties. If the property scope was set to Locally, this change only takes effect 
in the current layout and frame chain.

TIP

The following properties in the Ties group of the Properties panel are activated automatically 
when you move the corresponding tie handles:

● Start offset moves the left endpoints of ties. X moves them horizontally, Y moves them 
vertically.

● End offset moves the right endpoints of ties. X moves them horizontally, Y moves them 
vertically.

● Start handle offset moves the left control points of ties. X moves them horizontally, Y 
moves them vertically.

● End handle offset moves the right control points of ties. X moves them horizontally, Y 
moves them vertically.

You can also use these properties to change the shape of individual ties by changing the values 
in the value fields.

Deactivating the properties resets the corresponding handles on the selected ties to their default 
positions.

EXAMPLE
Moving the left endpoint moves both the start of a tie and the other handles apart from the right 
endpoint. This allows you to change the angle and/or width of the tie without changing its overall 
shape.

Moving the left control point causes the tie height handle to move but does not affect the 
position of the left and right endpoints or right control point. This gives you fine control over the 
shape of ties while ensuring that the end result remains curved and smooth.

Changing the thickness of ties
You can change the thickness of individual ties, including changing the thickness of the middle 
of ties independently of the ends of ties. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the ties whose thickness you want to change.

2. In the Properties panel, activate the following properties, individually or together, in the Ties 
group:

● End thickness

● Middle thickness

3. Change the values in the value fields.

Ties
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RESULT
Increasing the values makes the corresponding part of the selected ties thicker, decreasing the 
values makes the corresponding part of the selected ties thinner. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating the properties returns the corresponding part of the selected ties to their default 
thickness.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503

Tie height
The height of ties determines how far above/below their endpoints ties extend vertically.

To avoid the end points or curve apexes of ties starting or ending on staff lines, Dorico Elements 
automatically makes small changes to the curvature shape, height, and vertical position of ties. 
These changes are small, but the placement of ties is subtly different depending on the position 
of notes relative to staff lines.

A tie outside noteheads When transposed one note down, the tie appears 
with a steeper curve to avoid reaching its apex on 
the staff line.

A tie between noteheads, with the ends slightly 
above the vertical center of the noteheads to avoid 
the tie appearing too close to the staff line at its 
ends or apex.

When transposed up, the ends of the tie are now 
positioned at the vertical center of the notehead, as 
there is no staff line with which it could collide.

You can change the height of individual ties in Engrave mode.

Increasing the height of ties makes them extend further from the vertical position of their 
endpoints, which gives them a rounder shape and means they take up more vertical space. Ties 
generally do not need to be as curved as slurs, as they join notes of the same pitch instead of 
arching over or above a range of pitches.

Where vertical space is tight, a balance must be found between how curved ties are and ensuring 
staves do not overlap.

A long tie with default height A long tie with increased height
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Changing the height of ties
You can change the height of individual ties; for example, to save vertical space on tightly-spaced 
pages. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the tie height (middle) handle of the ties whose height you want to 
change.

2. Move the handles in any of the following ways:

● To move them upwards/downwards a standard amount, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Up Arrow  to move handles 
upwards. This moves handles by 1/8 space per press.

● To move them upwards/downwards a large amount, press Ctrl/Cmd  plus the standard 
key command; for example, Ctrl/Cmd-Alt/Opt-Up Arrow . This moves handles by 1 
space per press.

● To move them upwards/downwards a moderate amount, press Shift  plus the standard 
key command; for example, Shift-Alt/Opt-Up Arrow . This moves handles by 1/2 space 
per press.

● To move them upwards/downwards a small amount, press Ctrl/Cmd - Shift  plus the 
standard key command; for example, Ctrl/Cmd-Shift-Alt/Opt-Up Arrow . This moves 
handles by 1/32 space per press.

● Click and drag them upwards/downwards.

TIP

To constrain movement either horizontally or vertically, start dragging, then press and 
hold Shift .

RESULT
The height of the selected ties is changed. If the property scope was set to Locally, this change 
only takes effect in the current layout and frame chain.

NOTE

● To maintain a visually pleasing and symmetrical curve when changing the height of ties 
manually, you may need to move tie height handles to the right/left by a small amount, as 
well as upwards/downwards.

● Moving tie height handles to the right/left affects the shape of the whole tie.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
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Tie shoulder offset
Tie shoulders affect the angles of the curves of ties as they taper towards an endpoint, as the 
tapered ends often approach noteheads at a steeper angle than that of a tie’s arch.

Increasing the shoulder offset makes the onset of the curve shallower, whereas decreasing the 
shoulder offset makes the onset steeper.

A long tie with default shoulder offset A long tie with increased shoulder offset

You can change the shoulder offset of ties individually by moving their control point handles in 
Engrave mode.

Changing the shoulder offset of ties
You can change the shoulder offset of individual ties. For example, you might want to change the 
shoulder offset of a few very short or very long ties in your project to improve their shape. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select one of the control point handles on each of the ties whose 
shoulders you want to adjust in any of the following ways:

● Select a whole tie and press Tab  to cycle through the handles until the one you want to 
move is selected.

● Click the handle you want to move.

● Ctrl/Cmd -click individual handles on multiple ties.

2. Move the handles in any of the following ways:

● To move them a standard amount to the right, left, up, or down, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Left Arrow  to move handles to 
the left. This moves handles by 1/8 space per press.

● To move them a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow . This moves handles by 1 space per press.

● To move them a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow . This moves handles by 1/2 space per press.

● To move them a small amount, press Ctrl/Cmd - Shift  plus the standard key command; 
for example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow . This moves handles by 1/32 space per 
press.

● Click and drag them in any direction.
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TIP

To constrain movement either horizontally or vertically, start dragging, then press and 
hold Shift .

3. Optional: Repeat steps 1 and 2 for the other control point handle on the ties whose 
shoulders you want to adjust.

RESULT
Moving tie offset handles further apart reduces the shoulder offset, while moving them closer 
together increases the shoulder offset. If the property scope was set to Locally, this change only 
takes effect in the current layout and frame chain.

TIP

The following properties in the Ties group of the Properties panel are activated automatically 
when you move the corresponding tie handles:

● Start handle offset moves the left control points of ties. X moves them horizontally, Y 
moves them vertically.

● End handle offset moves the right control points of ties. X moves them horizontally, Y 
moves them vertically.

You can also use these properties to change the shoulder offset of individual ties by changing the 
values in the value fields.

Deactivating the properties resets the corresponding handles on the selected ties to their default 
positions.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
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Time signatures

Time signatures indicate the meter of music, and apply to all bars from where they first appear 
until a subsequent change of time signature. Meter describes the rhythmic pulse of music, and 
its division into beats and bars.

A time signature is made up of two parts: numerator on top, and denominator underneath. 
These are the same mathematical terms as are used for fractions due to their similar 
arrangement.

1 Numerator

Specifies the number of beats in each bar for the time signature. The duration of beats is 
specified by the denominator.

2 Denominator

Specifies the beat duration for the time signature. The denominator doubles for every 
halving of the beat duration: 1 is a whole note (breve), 2 is a half note (minim), 4 is a quarter 
note (crotchet), 8 is an eighth note (quaver), and so on.

For example, a 4/4 time signature tells you the bar is made up of four beats, and each of those 
beats is a quarter note in length. A time signature of 4/2 contains four half notes in each bar, and 
4/8 contains four eighth notes (quavers) in each bar. Both 3/4 and 6/8 contain six eighth notes, 
but it is understood that a 3/4 bar contains three quarter note beats, whereas a 6/8 bar contains 
two dotted quarter note beats.

Bars are rhythmic groups, divided according to the time signature, and they make following the 
music much more practical and easier to read. Notes are beamed differently in different time 
signatures for the same reasons.

By default, time signatures apply to all staves. However, there are certain situations, such as in 
polymetric music, where some parts require their own time signature, independently of the rest 
of the ensemble. You can input time signatures that apply to all staves or only apply to single 
staves in Dorico Elements.

Time signatures apply until the next time signature change or the end of the flow, whichever 
comes first.

Time signatures traditionally use a unique, heavy font that ensures they stand out against staff 
lines, and fill the height of a single staff. For some types of music, particularly film music, it is 
typical to use large time signatures that span several staves.

NOTE

● You can input notes without inputting a time signature.

● Beat lengths are fixed across all staves in your project, regardless of the time signature. For 
example, if you have a 2/4 time signature on one staff and a 6/8 time signature on another 
staff, then one quarter note in the 2/4 time signature equals one quarter note in the 6/8 time 
signature, meaning their barlines do not match.
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● Dorico Elements does not automatically add beats to fill bars when you input time signatures 
unless Insert mode is activated.

A 5/8 time signature input before an existing 4/4 time signature without Insert mode activated, leaving 
only three eighth note beats in the second 5/8 bar.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 283
Beam grouping according to meters on page 841
Note and rest grouping on page 860
Creating custom beat groupings for meters on page 861
Bars on page 810
Insert mode on page 451

Types of time signatures
There are different types of time signatures, which can indicate various and complex meters.

NOTE

Dorico Elements uses the definitions for meters commonly used in American English. These 
definitions, such as which meters are considered simple and compound, might be different in 
other languages.

Simple
In simple time signatures, each beat is divided by two into equal groups of notes. 
Simple time signatures can be simple duple, such as 2/4, simple triple, such as 3/4, or 
simple quadruple, such as 4/4.

Compound
In compound time signatures, each beat is divided by three into equal groups of 
dotted notes, such as 6/8, which contains two dotted quarter note beats, or 9/4, which 
contains three dotted half note beats.

Irregular
Irregular time signatures, such as 5/4 or 7/8, cannot be subdivided into equal beat 
groups. Because the numerator is odd, these time signatures must be divided into 
unequal beat groups. For example, 5/4 usually contains a half note beat and a dotted 
half note beat.

Time signatures
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Additive
Additive time signatures show how bars are subdivided into beat groups. You can show 
beat group numerators for any type of time signature. For example, instead of 7/8, you 
could show an additive time signature of 2+3+2/8.

Alternating
An alternating time signature indicates a regular pattern that switches every bar 
between two or more time signatures, in the indicated order. For example, for a phrase 
with twelve eighth notes that needs to be emphasized 3+3+2+2+2, an alternating time 
signature of 6/8+3/4 might allow the two meters to be read more clearly.

Interchangeable
An interchangeable time signature indicates a set of time signatures at the start of 
the piece that can be used during the piece, such as 3/4–2/4. Unlike alternating time 
signatures, interchangeable time signatures do not require a fixed pattern; any bar in 
the piece can follow any of the time signatures in the set without having to restate the 
time signature.

NOTE

You must manually input the appropriate time signatures where you want them, 
as unlike alternating time signatures, there is no fixed pattern for them. Any time 
signatures you input after an interchangeable time signature that are specified in it are 
hidden automatically until you end the interchangeable time signature.

They can have different separator styles in Dorico Elements, which you can change for 
individual time signatures.

Aggregate
An aggregate time signature shows two or more meters within the same bar, such 
as 2/4+3/8+5/4. Dorico Elements automatically shows dashed barlines to indicate the 
divisions between the different meters, but you can also specify that you do not want 
to show dashed barlines when you input aggregate time signatures with the popover.

Open
An open time signature has no restrictions on meter, beaming, or beats. Any number 
of notes can be added, with any beaming. For example, open time signatures might be 
used for cadenza passages.

NOTE

In open meters, you must input barlines and add beats manually. You can also extend 
open meter bars by inputting notes with Insert mode activated and set to a global 
scope.
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Non-power of two
A non-power of two time signature is one such as 5/6, which indicates five sextuplet 
quarter notes (crotchets) where the sextuplet overall equals a whole note (semibreve). 
Examples of time signatures like this can be found in the music of Adès.

NOTE

Some composers, such as Boulez, have written fractional time signatures. Dorico Elements does 
not currently support fractional time signatures.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 283
Input methods for bars, beats, and barlines on page 300
Changing the beat grouping for cut common time signatures on page 863
Ending interchangeable time signatures on page 1397
Combining aggregate time signatures on page 1394

Cautionary time signatures
When a time signature change occurs at a system break, either in the score or in a part, the new 
time signature is shown at the end of the first system as well as at the start of the new system.

This is sometimes considered a “cautionary time signature”, because it warns performers of an 
upcoming change of time signature before it takes effect. It is also known as a “courtesy time 
signature”.

In Dorico Elements, the time signatures shown at the end of one system and at the start of the 
next system are the same item, not separate items. You can hide cautionary time signatures, 
either individually or by default in each flow.

TIP

We recommend using flows for separate spans of music. Dorico Elements does not show 
cautionary key signatures or time signatures between flows.

RELATED LINKS
Flows on page 171
Splitting flows on page 501
System breaks on page 633
Cautionary key signatures on page 1024
Repeat markers on page 1236
Clefs on page 907

Hiding/Showing cautionary time signatures
You can hide/show individual cautionary time signatures shown at the ends of systems when 
time signature changes occur at system breaks, independently of your per-flow setting. For 
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example, to save horizontal space when using additive time signatures. You can do this for the 
current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the cautionary time signatures that you want to hide/show. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Cautionary at end of system in the Time Signatures 
group.

3. Choose one of the following options:

● Hide

● Show

RESULT
The selected cautionary time signatures are hidden/shown at the ends of systems. This does not 
affect time signatures shown at the start of systems.

If the property scope was set to Locally, this change only takes effect in the current layout and 
frame chain.

TIP

You can hide/show cautionary time signatures by default in each flow independently on the Time 
Signatures page in Notation Options.

RELATED LINKS
Properties panel on page 663
Changing the property scope on page 665
Engrave toolbox on page 503
Hiding/Showing time signatures on page 1396
System breaks on page 633
Notation Options dialog on page 747
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Pick-up bars
Pick-up bars allow you to include music before the first full bar. They are also known as an 
“upbeat” or “anacrusis”. Often, pick-up bars only comprise a few beats whose main purpose is to 
lead in to the start of the piece.

Pick-up bar of four eighth notes at the start of a piece in 9/8

Pieces that start with a pick-up bar have time signatures that are positioned at the start of the 
system as normal. However, the first full bar of the time signature occurs after the first barline 
and not before. Therefore, pick-up bars do not contribute to the bar number count. Bar numbers 
are counted from the first full bar in the flow.

Because pick-up bars are linked to the number of notes/rests in the music, in Dorico Elements 
they are linked to time signatures. However, you can hide time signatures you do not want to 
show in the music.

TIP

● Time signatures with pick-up bars are indicated by signposts.

● You can use the Global Adjustment of Current Bar Insert mode scope to create and delete 
pick-up bars by deleting notes/rests in the first bar in the flow. You can also use it to shorten 
the last bar in flows that start with a pick-up bar.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 283
Hiding/Showing time signatures on page 1396
Insert mode scopes on page 452
Signposts on page 450
Bars on page 810
Bar numbers on page 826
Track overview on page 520
Turning grace notes into normal notes on page 1004

Defining partial bars as pick-up bars or irregular bars
You can change whether explicit irregular bars at the start of time signatures are defined as 
pick-up bars. This affects how notes in the bars are beamed and grouped.

Notes in irregular bars defined as pick-up bars are beamed/grouped backwards from the end of 
the bar, while notes in irregular bars not defined as pick-up bars are beamed/grouped forwards 
from the start of the bar.

Time signatures
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NOTE

You must input explicit irregular bars and pick-up bars as part of a time signature, such as by 
entering 4/4,1.5 into the time signatures popover to input a 4/4 time signature with a pick-up bar 
containing 1.5 quarter note beats, or three eighth notes.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the time signatures or the signposts of time signatures starting with an explicit 
irregular bar whose pick-up definition you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Group first bar as pick-up in the Time Signatures group.

3. Activate/Deactivate the corresponding checkbox.

RESULT
Irregular bars at the start of the selected time signatures are defined as pick-up bars when 
Group first bar as pick-up and its corresponding checkbox are both activated, and defined as 
normal irregular bars when the corresponding checkbox is deactivated.

When the property is deactivated, Dorico Elements uses internal heuristics to define them as 
either pick-up bars or normal irregular bars automatically.

EXAMPLE

Irregular bar defined as pick-up into common time Irregular bar defined as normal irregular bar, not a 
pick-up

Large time signatures
Large time signatures are scaled-up time signatures that appear much larger than normal 
relative to the staff size. They can be helpful in orchestral scores, as the smaller staff size in 
such scores means standard time signatures are small and harder for conductors to read.

Large time signatures are also very commonly used in film scores, as conductors rarely have 
much time to prepare the scores before recording sessions. Having large time signatures makes 
changes in meter more visually clear on the page, especially when music contains multiple 
changes in meter.

In Dorico Elements, you can show large time signatures at the following positions:

● Once per bracketed group

● Above the staff and at system object positions

Time signatures
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Time signatures shown once per bracketed group

Instead of showing a time signature on every staff that is the same height as the staff, you can 
instead show a single large time signature on each bracketed group of staves. When shown once 
per bracketed group, time signatures are scaled up in size according to the number of staves in 
the bracketed group. The largest time signatures are shown on bracketed groups containing four 
or more staves. When shown on single staves, they extend a small amount above and below the 
staff, which is commonly used for parts for film music recording sessions.

Narrow, serif time signatures shown once per bracketed group

Large time signatures shown on bracketed groups occupy horizontal space, which can be a 
significant amount when they are especially large and use the standard time signature design. 
Therefore, we recommend that you use one of the narrow designs in layouts that show large 
time signatures on bracketed groups.

Time signatures shown at system object positions

Similar to showing large time signatures once per bracketed group, you can also show time 
signatures only at system object positions and above the staff. Therefore, their positions in each 
system are controlled by the same options that control the positions of other system objects, 
such as rehearsal marks and tempo marks.

Normal time signatures shown at system object positions

Time signatures shown at system object positions do not occupy horizontal space, meaning it 
is less important to use a narrow font style. This also reduces the horizontal distance between 
notes either side of time signatures. Because of this reduced disruption to note spacing, this 
placement of time signatures has become popular in contemporary art music since the 20th 
Century.

When using the note denominator style for time signatures shown at system object positions, 
the note is shown to the right of the numerator rather than below.

By default, time signatures at system object positions are twice the size of normal time 
signatures and force other items at the same position to appear to the right.

RELATED LINKS
Input methods for time signatures and pick-up bars on page 283
Changing the design of time signatures on page 1397
Hiding bar numbers at time signatures shown at system object positions on page 834
Time signature font styles on page 1398

Time signatures
Large time signatures 

1388
Dorico Elements 5.1.30



System objects on page 1326

Changing the size and position of time signatures
You can change the size of time signatures in each layout independently, including changing 
their vertical position. For example, you can show large time signatures centered on each bracket 
in full score layouts but standard-sized time signatures on each staff in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the size of time 
signatures.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Time Signatures.

4. Choose one of the following options for Time signature position and size:

● Show on every staff

● Show once per bracket

● Show at system object positions

5. Click Apply, then Close.

RESULT
The size and position of time signatures in the selected layouts is changed.

Showing large time signatures above the staff at system object positions means they do not 
occupy any rhythmic or horizontal space, whereas the other options do cause time signatures to 
occupy horizontal space.

RELATED LINKS
Positions of time signatures on page 1394
Changing the design of time signatures on page 1397
Hiding bar numbers at time signatures shown at system object positions on page 834

Time signature styles
Dorico Elements allows you to show time signatures in a variety of styles. For example, you can 
show denominators as a number or as a note value.

Numerator styles
The numerator is always one or more numbers, and can either show the total number 
of beats in the bar as a single number, or show how the total duration of the bar is 
subdivided into beat groups.

Number numerator Beat group numerator
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Denominator styles
The denominator can appear as a number, as a note indicating the equivalent 
duration, or not appear at all.

Number denominator Note denominator None denominator

Open meter styles
Open time signatures can be shown as an X, Penderecki’s symbol, or be hidden with no 
symbol. Open time signatures with no symbol are indicated by signposts.

X open style Penderecki’s symbol open 
style

No symbol open style

Interchangeable time signature separator styles
Interchangeable time signatures can have different separator styles. You can specify 
the separator style when inputting interchangeable time signatures using the popover 
and for individual interchangeable time signatures after they have been input.

Parentheses separator Brackets separator Equals sign separator

Slash separator Space separator Hyphen separator

RELATED LINKS
Inputting time signatures with the popover on page 287
Changing the design of time signatures on page 1397
Types of time signatures on page 1382
Signposts on page 450

Changing the numerator style of time signatures
You can choose whether the numerators of individual time signatures show the total number of 
beats in each bar, or the subdivision of beats in each bar.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the time signatures whose numerator style you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Numerator style in the Time Signatures group.

3. Choose one of the following options:

● Number

● Beat group

RESULT
The numerator style of the selected time signatures is changed.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503

Changing the denominator style of time signatures
You can change the denominator style of individual time signatures; for example, if you want to 
show the denominator as a note instead of a number.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the time signatures whose denominator style you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, activate Denominator style in the Time Signatures group.

3. Choose one of the following options:

● Number

● Note

● None

RESULT
The denominator style of the selected time signatures is changed.

Changing the open meter style of time signatures
You can change the open meter style of individual time signatures.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.
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PROCEDURE

1. Select the open meter time signatures whose style you want to change. You can do this in 
Write mode and Engrave mode.

2. In the Properties panel, choose one of the following options for Open style in the Time 
Signatures group:

● No symbol 

● X 

● Penderecki’s symbol 

RESULT
The open meter style of the selected time signatures is changed. No symbol open time 
signatures are indicated by signposts.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Signposts on page 450

Changing the separator style of interchangeable time signatures
You can change the separator shown in interchangeable time signatures individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the interchangeable time signatures whose separator you want to change. You can do 
this in Write mode and Engrave mode.

NOTE

In the Properties panel, Separator in the Time Signatures group is automatically activated 
for interchangeable time signatures.

2. Select one of the following options from the Separator menu:

● Parentheses 

● Brackets 

● Equals sign 

● Slash 

● Space 

● Hyphen 

RESULT
The separator style of the selected interchangeable time signatures is changed.

Time signatures
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TIP

● You can specify the separator style when inputting interchangeable time signatures using 
the popover.

● Although they might look similar to interchangeable time signatures, aggregate time 
signatures behave differently. Aggregate time signatures are separated by a + sign, whereas 
interchangeable time signatures can be shown with six different separators but not a + sign.

Therefore, although you can activate Separator and choose from the available options for 
aggregate time signatures, the property only affects the appearance of interchangeable time 
signature separators.

RELATED LINKS
Inputting time signatures with the popover on page 287

Changing the appearance of common/cut common time signatures
You can show individual common/cut common time signatures with either common/cut common 
symbols or with a numerator and denominator, such as 2/2 or 4/4.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the common/cut common time signatures whose appearance you want to change. 
You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Common/Cut common in the Time Signatures 
group.

RESULT
The selected time signatures appear with common/cut common symbols when Common/Cut 
common is activated, and with a numerator and denominator when it is deactivated.

EXAMPLE

Common time signature 
symbol

Cut common time 
signature symbol

Common time signature, 
appearing as 4/4

Cut common time 
signature, appearing as 
2/2

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Changing the beat grouping for cut common time signatures on page 863
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Combining aggregate time signatures
You can combine aggregate time signatures with the same denominator into a single time 
signature, while retaining dashed barlines for meter divisions. For example, to show a 
4/8+2/8+7/8 aggregate time signature as 13/8.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the aggregate time signatures that you want to combine. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate Combine compatible aggregates in the Time Signatures 
group.

3. Activate the corresponding checkbox.

RESULT
The selected aggregate time signatures are combined into a single time signature, provided that 
all denominators in each aggregate time signature are the same.

The combined numerator indicates the total number of denominator beats in each bar.

EXAMPLE

Uncombined aggregate time signature Combined aggregate time signature

RELATED LINKS
Types of time signatures on page 1382

Positions of time signatures
Standard time signatures are positioned on staves with the middle staff line, or only staff line for 
single-line staves, passing through their center. Large time signatures can be positioned in the 
middle or at the top of bracket groups, or above staves at system object positions.

Dorico Elements automatically positions time signatures after clefs, key signatures, and barlines.

You can move time signatures to different rhythmic positions in Write mode. They are positioned 
automatically to avoid collisions.

You can also change the position of time signatures in each layout independently; for example, if 
you want to show time signatures above the staff and at system object positions in some layouts 
but only once per bracket in other layouts.

RELATED LINKS
Changing the positions of system objects on page 1327
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Large time signatures on page 1387
Cautionary time signatures on page 1384
Input methods for time signatures and pick-up bars on page 283

Moving time signatures graphically
You can move individual time signatures to new graphical positions without affecting the 
positions of any other items.

NOTE

● These steps do not apply to time signatures shown at system object positions, which you can 
move when Graphic Editing  is selected in the Notes toolbox.

● You cannot move time signatures shown at the start of systems. You can only move time 
signature changes that occur partway through systems or at the end of systems.

PREREQUISITE
Note Spacing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select a square note spacing handle at the rhythmic position of the time 
signature you want to move.

A circular handle appears beside the time signature.

2. Press Tab  to select the circular handle.

3. Move the handle in any of the following ways:

● To move it a standard amount to the right or left, press Alt/Opt  plus the corresponding 
arrow key. For example, press Alt/Opt-Left Arrow  to move handles to the left.

● To move it a large amount, press Ctrl/Cmd  plus the standard key command; for 
example, Ctrl/Cmd-Alt/Opt-Left Arrow .

● To move it a moderate amount, press Shift  plus the standard key command; for 
example, Shift-Alt/Opt-Left Arrow .

● To move it a small amount, press Ctrl/Cmd - Shift  plus the standard key command; for 
example, Ctrl/Cmd-Shift-Alt/Opt-Left Arrow .

NOTE

You cannot move note spacing handles with the mouse, you can only move them using the 
keyboard.

RESULT
The time signature is moved graphically to the right/left.
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TIP

You can also change the value for Spacing offset in the Time Signatures group of the Properties 
panel to move time signatures horizontally. However, this also affects global note spacing 
around the rhythmic position of the time signature.

The Spacing offset value is independent of note spacing changes.

RELATED LINKS
Engrave toolbox on page 503
Note spacing on page 507
Moving items graphically on page 514

Hiding/Showing time signatures
You can hide/show time signatures without deleting them from your project. This hides/shows 
them in all layouts, not just the one currently open in the music area.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the time signatures you want to hide, or the signposts of time signatures you want to 
show. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Hide time signature in the Time Signatures 
group.

RESULT
The selected time signatures are hidden in all layouts when Hide time signature is activated, 
and shown when it is deactivated.

Signposts are shown at the position of each hidden time signature. However, signposts are not 
printed by default.

NOTE

● Hidden time signatures do not take up any horizontal space, so hiding/showing time 
signatures affects note spacing.

● You can hide/show time signature signposts by choosing View > Signposts > Time 
Signatures.

● You can assign a key command for Hide/Show Item on the Key Commands page in 
Preferences.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
Signposts on page 450
Hiding/Showing cautionary time signatures on page 1384
Input methods for time signatures and pick-up bars on page 283
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Annotations on page 597

Ending interchangeable time signatures
Any time signatures you input after an interchangeable time signature that are specified in 
it are hidden automatically. You can end interchangeable time signatures from selected time 
signatures, which shows them.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the barlines or signposts of time signatures from which you want to end 
interchangeable time signatures. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate End interchangeable in the Time Signatures group.

RESULT
Interchangeable time signatures are ended at the selected time signatures. The selected time 
signatures and all subsequent time signatures specified in the prevailing interchangeable time 
signature are shown until the next existing interchangeable time signature or the end of the 
flow, whichever comes first.

Changing the design of time signatures
You can change the design of time signatures in each layout independently, including changing 
the font style used for them; for example, if you want to use a plain font for time signatures in 
full score layouts but the standard time signature font in part layouts.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the design of time 
signatures.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Time Signatures.

4. Choose one of the following options for Time signature design:

● Normal

● Narrow, serif

● Narrow, sans serif

● Plain font

5. Click Apply, then Close.
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RESULT
The design of time signatures in the selected layouts is changed. If you choose Plain font, time 
signatures use a different font style than the one used for the other options.

Time signature font styles
Different time signature designs use different font styles. You can edit the formatting of fonts 
used for time signatures in the Edit Font Styles dialog.

The following font styles are used for time signatures:

● Time Signature Font: Used for standard time signatures and large time signatures that 
use the Normal, Narrow, serif, or Narrow, sans serif design types. Must use a SMuFL-
compliant font family.

● Time Signature Plain Font: Used for time signatures using the Plain font design type. Can 
use any font family, but we recommend that you use narrow fonts for large time signatures.

NOTE

Changes made to font styles apply to the entire project, including part layouts.

RELATED LINKS
Edit Font Styles dialog on page 754
Large time signatures on page 1387
Changing the default font family on page 760
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Tremolos

Tremolos are thick, slanted lines that cross individual stems or are positioned between multiple 
stems. They are used to indicate that notes are repeated, either individually or in sequences of 
multiple notes.

Using tremolo strokes instead of notating each notehead can save horizontal space and make 
fast passages easier to read.

The number of tremolo strokes indicates both how many times notes are repeated and how fast 
they are. In measured tremolos, for example, one tremolo stroke on the stem of a quarter note 
(crotchet) indicates two eighth notes (quavers) are played, whereas three tremolo strokes on the 
stem of a quarter note indicates eight 32nd notes are played.

Quarter note with a one-stroke single-note tremolo 
and its equivalent notation

Quarter note with a three-stroke single-note tremolo 
and its equivalent notation

There are different types of tremolos:

Single-note tremolos
Individual notes are repeated. Single-note tremolos are positioned on note stems.

Two-stroke single-note tremolos added to four quarter notes

Multi-note tremolos
Multiple notes, usually two, are played in sequence, similar to a trill. However, trills 
usually indicate a fast alternation between two adjacent notes, such as G and A, 
whereas multi-note tremolos can be between any notes, limited only by the capabilities 
of the instrument.

All notes in multi-note tremolos indicate the total duration of the tremolo. For example, 
two quarter notes joined by a multi-note tremolo both appear as half notes.

Multi-note tremolos are positioned between the stems of two or more notes.
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Four quarter notes without tremolos Multi-note tremolos input between those 
quarter notes, in two pairs

Tuplet tremolos
Multiple notes in tuplets are repeated in the notated sequence. Tuplet tremolos are 
positioned between all the notes in the tuplet.

Quarter notes in two different tuplets 
without tremolos

Multi-note tuplet tremolos input across 
those tuplets

Depending on the musical context, tremolos can be either measured or unmeasured. There is 
no visual difference between measured/unmeasured tremolos, so composers/arrangers often 
specify how they want tremolos to be played, such as an indication in the front matter of the 
score or as a text instruction in the score.

Measured tremolos
The number of tremolo strokes corresponds to a precise rhythm in the prevailing 
tempo and meter.

Unmeasured tremolos
There is no link between the number of strokes and rhythm. Instead, unmeasured 
tremolos are played as fast as possible, whatever the tempo.

Unmeasured tremolos often use three or more tremolo strokes, and can also be 
accompanied by a “trem.” text indication.

RELATED LINKS
Input methods for repeats and tremolos on page 405
Tremolos in tie chains on page 1401
Changing the speed of tremolos on page 1403
Tremolos in playback on page 1405
MIDI Import Options dialog on page 85

General placement conventions for tremolos
Single-note tremolos are positioned on note stems, whereas multi-note tremolos are positioned 
between the stems of two or more notes. When multi-note tremolos cross three or more notes, 
the tremolo strokes are positioned between all the notes.

Tremolo strokes are slightly thinner than beams, so that the gaps between strokes are large 
enough and the number of strokes can be instantly recognized.

Dorico Elements automatically avoids collisions between tremolo strokes and ledger lines or 
stem flags.

Tremolos
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Tremolo strokes within the staff are positioned so that they are at least one staff space clear of 
noteheads, and at valid positions relative to staff lines and staff spaces. This means that tremolo 
strokes might not move every time you change the pitch of notes.

The positions of the tremolo strokes on the first two notes and the last two notes are the same, although the 
pitches are all different.

In Dorico Elements, the angle of single-note tremolo strokes is always the same, no matter the 
direction of the phrase. The angles of multi-note tremolo strokes are determined by the height 
of the stems to which the multi-note tremolos apply. You can change the angles of multi-note 
tremolo strokes individually by lengthening/shortening the stems at the start/end of the tremolo.

Tremolos in tie chains
By default, single-note tremolos appear either on all notes in tie chains, or on all notes apart 
from the first or last note. Deleting tremolo strokes from tied notes removes tremolo strokes 
from all notes in tie chains.

In Dorico Elements, we use “tremolo with attack” and “tremolo with release” to refer to 
single-note tremolos that appear on all notes in tie chains apart from the first and last note, 
respectively.

Single-note tremolo added to tie chain Tremolo with release added to tie chain

In Dorico Elements, tremolos are considered measured by default, so the number of tremolo 
strokes shown is automatically adjusted on subsequent notes in tie chains as required. For 
example, if an eighth note with two tremolo strokes is tied to a quarter note, the quarter note 
has three tremolo strokes. This is because tremolo strokes function like beams, so two tremolo 
strokes and an eighth note stem flag is the equivalent of three tremolo strokes.

The default number of tremolo strokes in a tie chain 
where the second note is longer than the first.

The number of tremolo strokes on the second note 
has been changed to match the first.

However, there might be circumstances in which you want all notes to have the same number of 
tremolo strokes, whatever their duration. You can also start tremolos partway through tie chains, 
or stop tremolos partway through tie chains.

You can change the number of tremolo strokes shown on individual notes independently in 
Engrave mode.

RELATED LINKS
Ties on page 1364
Input methods for repeats and tremolos on page 405
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Deleting tremolos on page 1403

Changing the number of tremolo strokes on individual notes in tie 
chains

Dorico Elements automatically changes the number of tremolo strokes on subsequent notes in 
tie chains according to their duration, but you can manually change the number of single-note 
tremolo strokes shown on each note in tie chains individually to represent your intended rhythm. 
For example, if you want all notes in a tie chain to have the same number of tremolo strokes, 
whatever their duration.

TIP

If you want to remove tremolo strokes from the first or last notes in tie chains, you can input 
tremolos with an attack or release, respectively.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. In Engrave mode, select the noteheads of the notes whose number of tremolo strokes you 
want to change.

2. In the Properties panel, activate Single stem tremolo in the Notes and Rests group.

3. Select one of the following options from the menu:

● None

● One stroke

● Two strokes

● Three strokes

● Four strokes

● Buzz roll

RESULT
The number of tremolo strokes shown on the selected notes is changed.

EXAMPLE

The default number of tremolo strokes in a tie chain 
where the second note is longer than the first.

The number of tremolo strokes on the second note 
has been changed to match the first.

RELATED LINKS
Properties panel on page 663
Engrave toolbox on page 503
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Changing the speed of tremolos
You can change the speed of tremolos after they have been input by changing the number of 
strokes.

PROCEDURE

1. In Write mode, select the notes with tremolos whose speed you want to change.

The buttons with the number of tremolo strokes corresponding to your selection are 
highlighted in the Tremolos section of the Repeat Structures panel.

NOTE

Select single-note tremolos and multi-note tremolos separately.

2. Click the button with the number of tremolo strokes you want in the Tremolos section of the 
Repeat Structures panel.

For example, click Two Strokes Single-note Tremolo  to input single-note tremolos with 
two strokes, or click Three Strokes Multi-note Tremolo  to input multi-note tremolos with 
three strokes.

RESULT
The number of tremolo strokes on the selected notes is changed, which changes the speed of 
the tremolos.

RELATED LINKS
Tremolos in playback on page 1405

Deleting tremolos
You can remove single-note tremolos and multi-note tremolos from notes separately without 
affecting the notes to which they applied.

PROCEDURE

1. In Write mode, select the notes whose tremolo strokes you want to delete.

2. In the Notations toolbox, click Panels , then Repeat Structures  to show the Repeat 
Structures panel.

3. In the Tremolos section, click one or both of the following buttons, depending on the types 
of tremolos selected:

● Remove Single-note Tremolo 

● Remove Multi-note Tremolo 

RESULT
The corresponding types of tremolo strokes are deleted.

TIP

You can also delete tremolos by entering 0 or clear into the repeats popover.

RELATED LINKS
Notations toolbox on page 201

Tremolos
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Repeat Structures panel on page 409
Repeats popover on page 406

Rhythmic positions of notes with tremolos
You can move notes with single-note tremolos and multi-note tremolos to new rhythmic 
positions in the same ways as normal notes. However, if you move multi-note tremolos across 
barlines, the tremolo strokes are deleted automatically.

You can move single-note tremolos to new rhythmic positions and across barlines without 
affecting their tremolo strokes. The notes are automatically respelled as tie chains if required 
by their new rhythmic positions and time signature, in the same ways as normal notes.

NOTE

If tie chains with single-note tremolos contain notes of different durations, the number of 
tremolo strokes on each note in the tie chain is different. You can change the number of tremolo 
strokes shown on each note in tie chains individually.

RELATED LINKS
Moving notes/items rhythmically on page 461

Moving tremolo strokes
You can move tremolo strokes upwards/downwards graphically. You can do this for the current 
layout and frame chain only, or for all layouts and frame chains.

NOTE

● You cannot move tremolo strokes to the right/left.

● You cannot move tremolo strokes rhythmically, as they apply to specific notes, but you can 
move notes with tremolos to different rhythmic positions. Notes with single-note tremolos 
can cross barlines; however, multi-note tremolo strokes are deleted automatically when their 
notes cross barlines.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the tremolo strokes you want to move.

2. Move the tremolo strokes in any of the following ways:

● To move them upwards/downwards a standard amount, press Alt/Opt  plus the 
corresponding arrow key. For example, press Alt/Opt-Up Arrow  to move tremolo 
strokes upwards. This moves tremolo strokes by 1/8 space per press.

● To move them upwards/downwards a large amount, press Ctrl/Cmd  plus the standard 
key command; for example, Ctrl/Cmd-Alt/Opt-Up Arrow . This moves tremolo strokes 
by 1 space per press.

Tremolos
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● To move them upwards/downwards a moderate amount, press Shift  plus the standard 
key command; for example, Shift-Alt/Opt-Up Arrow . This moves tremolo strokes by 1/2 
space per press.

● To move them upwards/downwards a small amount, press Ctrl/Cmd - Shift  plus the 
standard key command; for example, Ctrl/Cmd-Shift-Alt/Opt-Up Arrow . This moves 
tremolo strokes by 1/32 space per press.

● Click and drag them upwards/downwards.

RESULT
The selected tremolo strokes are moved upwards/downwards. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

NOTE

● Moving multi-note tremolo strokes also changes the length of the stems to which they 
are attached. You can change the angles of multi-note tremolo strokes individually by 
lengthening/shortening the stems at the start/end of the tremolo.

● When you first move tremolo strokes graphically, they may appear to move in the wrong 
direction or by a larger increment than you expected. This is because their positions are 
reset when you override those positions by moving them.

● The following properties in the Beaming group of the Properties panel are activated 
automatically when you move the start/end of multi-note tremolo strokes:

● Start Y offset moves the start of multi-note tremolo strokes vertically by moving the end 
of the corresponding stem.

● End Y offset moves the end of multi-note tremolo strokes vertically by moving the end 
of the corresponding stem.

Tremolo Y in the Notes and Rests group of the Properties panel is activated automatically 
when you move single-note tremolo strokes. It moves single-note tremolo strokes vertically.

For example, if you move a whole multi-note tremolo stroke upwards, both stem handles are 
moved so both properties are activated. You can also use these properties to move tremolo 
strokes by changing the values in the value fields. However, you must select the noteheads 
rather than the tremolo strokes in order to see the relevant groups in the Properties panel.

Deactivating the properties resets the selected stem handles, and therefore tremolo strokes, 
to their default positions.

RELATED LINKS
Changing the property scope on page 665
Engrave toolbox on page 503
Input methods for repeats and tremolos on page 405
Deleting tremolos on page 1403

Tremolos in playback
You can control the playback of unmeasured tremolos by specifying the minimum number of 
tremolo strokes that are interpreted as unmeasured tremolos. This considers both the number of 
tremolo strokes and the number of beam lines that would be used for the note.

● You can do this on the Timing page in Playback Options.

Tremolos
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For example, if the option is set to require three tremolo strokes, an eighth note with two 
tremolo strokes is played as unmeasured, because the single beam of the eighth note is included 
in the calculation.

You can also specify the default length of notes in unmeasured tremolos. You express the 
duration of notes as a fraction of the length of a quarter note played at 120 quarters per minute 
in the Tremolos section.

The number of tremolo strokes determines the note value of the repeated notes. For example, 
one stroke indicates an eighth note, two strokes indicate a 16th note, and so on.

If your sound library includes samples for unmeasured tremolo playback, Dorico Elements 
loads the required samples using playback techniques. For sound libraries that do not provide 
unmeasured tremolo samples, Dorico Elements generates tremolos.

TIP

You can enable independent voice playback for individual instruments to hear different sounds 
in different voices simultaneously; for example, if you have tremolos in one voice and slurs in 
another voice.

RELATED LINKS
Playback techniques on page 787
Playback Options dialog on page 749
Enabling independent voice playback on page 545

Changing the duration of tremolos in playback
You can change both the default length of each note in unmeasured tremolos in playback, and 
the minimum number of tremolo strokes required to indicate tremolos should be unmeasured in 
playback.

PROCEDURE

1. Press Ctrl/Cmd-Shift-P  to open Playback Options.

2. In the category list, click Timing.

3. Optional: In the Tremolos section, change the value for Minimum number of strokes for 
playback of unmeasured tremolos.

4. Change the value for Default unmeasured tremolo length.

For example, to set the default length of unmeasured tremolo notes to 0.5 seconds, change 
the value to 1.

TIP

If you hover over either of the arrows beside the value field, a small box appears that 
displays the current fraction as a decimal.

5. Click Apply, then Close.

RESULT
The sounding duration of each note in unmeasured tremolos in playback is changed project-
wide.

Tremolos
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Changing the value for Minimum number of strokes for playback of unmeasured tremolos 
changes the minimum number of tremolo strokes required for tremolos to be unmeasured in 
playback.

Tremolos
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Tuplets

Tuplets indicate where a beat is divided into a different number of subdivisions than is usually 
expected according to the current meter. They can be used to fit more notes or fewer notes in a 
beat than usually exist in a beat, according to the usual pattern of subdivision.

Because these subdivisions are not standard but tuplet notes use the same rhythmic notation as 
normal notes, tuplets must be clearly marked to show that their rhythmic duration is different. 
Tuplet numbers/ratios indicate the number of notes in the tuplet, and tuplet brackets show the 
duration of tuplets that are not joined by beams.

In Dorico Elements, tuplets function like containers into which you can input notes of any 
duration, such as inputting a quarter note at the start of an eighth note triplet.

When tuplets extend across barlines, Dorico Elements automatically notates them correctly, such 
as a sextuplet appearing as two triplets. You can also allow tuplets to span barlines without 
division.

During tuplet input, tuplets are sticky when you input notes with the keyboard, meaning that 
Dorico Elements continues inputting notes as the specified tuplet until you stop tuplet input or 
note input.

You can show tuplets with different combinations of tuplet brackets and tuplet numbers/ratios. 
You can also show note symbols indicating the note value of the tuplet alongside tuplet 
numbers/ratios.

RELATED LINKS
Inputting tuplets on page 254
Tuplet brackets on page 1413
Tuplet numbers/ratios on page 1416
Allowing/Disallowing tuplets to span barlines on page 1411
Moving notes/items rhythmically on page 461

Nested tuplets
Nested tuplets are tuplets within larger tuplets that are often used to create complex rhythms. In 
Dorico Elements, there is no limit to the number of levels you can have in nested tuplets.

EXAMPLE

Nested tuplets
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Inputting nested tuplets
You can input nested tuplets on empty staves and select existing tuplets and input nested tuplets 
within them.

PROCEDURE

1. In Write mode, start note input.

2. Open the tuplets popover in any of the following ways:

● Press ; .

● In the Notes toolbox, click and hold Tuplets , then click x:y .

When inputting tuplets with the keyboard, Dorico Elements automatically continues 
inputting notes as the specified tuplet.

NOTE

You can skip steps 3 and 4 if you are inputting nested tuplets into existing tuplets.

3. Optional: If inputting nested tuplets on an empty staff, enter the ratio for the outer tuplet 
into the popover.

For example, enter 3:2q to input quarter note triplets.

4. Optional: Press Return  to close the popover and input the outer tuplet.

5. Press ;  to open the tuplets popover again.

6. Enter the ratio for the inner tuplet into the popover.

For example, enter 5:4e to input eighth note quintuplets.

7. Press Return  to close the popover and input the inner tuplet.

8. Input the notes you want.

When inputting tuplets with the keyboard, Dorico Elements automatically continues 
inputting notes as the specified tuplet.

9. Stop inputting nested tuplets in one of the following ways:

● To stop the inner tuplet and continue inputting the outer tuplet, press :  once.

● To stop both tuplets and return to inputting normal notes, press :  twice or move the 
caret with the arrow keys.

● To stop note input completely, press Esc .

RESULT
Notes are input as nested tuplets, starting from the caret position.

If multiples of the inner tuplet fit exactly inside the outer tuplet, you can continue inputting notes 
as the specified nested tuplet until you stop the tuplets manually.

If multiples of the inner tuplet do not fit exactly inside the outer tuplet, the inner tuplet stops 
automatically at the end of the last tuplet that fits in the outer tuplet. After that, the outer tuplet 
continues until you stop it manually.

NOTE

You can also input nested tuplets by clicking and holding Tuplets  in the Notes toolbox, then 
clicking the tuplet you want. However, the inner tuplet you click must fit inside the outer tuplet, 
based on the currently selected note duration.

Tuplets
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RELATED LINKS
Tuplets popover on page 256
Notes toolbox on page 196
Inputting notes on page 224
Selecting note/rest durations on page 259

Turning existing notes into tuplets
You can turn any existing notes into tuplets; for example, if you need to fit extra notes into an 
existing duration.

PROCEDURE

1. In Write mode, select the notes on a single staff that you want to turn into tuplets.

2. Open the tuplets popover in any of the following ways:

● Press ; .

● In the Notes toolbox, click and hold Tuplets , then click x:y .

The popover is automatically populated with a suggested ratio based on your selection.

3. Optional: Change the ratio in the popover. For example, enter 3:2 to input triplets.

4. Press Return  to close the popover.

RESULT
The selected notes are turned into tuplets according to the ratio in the popover. For example, 
if you select five eighth notes and enter 5:4 into the popover, the selected notes become 
quintuplet eighth notes.

If the selected notes fit into a single tuplet of the specified ratio, only a single tuplet is created. 
If the selected notes do not fit into a single tuplet, as many tuplets as required are created 
automatically.

TIP

You can also turn existing notes into tuplets by clicking and holding Tuplets  in the Notes 
toolbox, then clicking the tuplet you want.

RELATED LINKS
Inputting tuplets on page 254
Turning existing notes into grace notes on page 1004

Turning tuplets into normal notes
You can turn any existing tuplet notes into normal notes; for example, if you want to turn tuplet 
eighth notes into standard eighth notes.

PROCEDURE

1. In Write mode, select just the brackets, numbers/ratios, or signposts of the tuplets you want 
to turn into normal notes.

NOTE

You must not select any of the noteheads in the tuplets.

Tuplets
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2. Optional: If you want the selected tuplets to push subsequent notes to later rhythmic 
positions if required, press I  to activate Insert mode.

3. Optional: If you activated Insert mode, choose the appropriate Insert mode scope.

4. Press Backspace or Delete .

RESULT
The selected tuplets are deleted. All notes previously in the tuplets are unscaled and appear as 
normal notes with the same notated duration; for example, a tuplet quarter note becomes a 
standard quarter note.

When Insert mode is activated, all notes in the tuplets are retained and any subsequent existing 
notes are pushed to later rhythmic positions to accommodate the extra rhythmic durations 
required. When Insert mode is deactivated, the earliest selected tuplets expand and overwrite 
subsequent notes and tuplets.

RELATED LINKS
Tuplet numbers/ratios on page 1416
Tuplet brackets on page 1413
Inputting notes on page 224
Turning grace notes into normal notes on page 1004
Insert mode on page 451
Insert mode scopes on page 452

Allowing/Disallowing tuplets to span barlines
You can allow tuplets to span barlines; for example, in Renaissance music, you might want 
tuplets to span tick barlines without affecting their notation. By default, Dorico Elements 
automatically splits tuplets over barlines so that both the durations of bars and the divisions 
in tuplets are clear.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the tuplet brackets or tuplet numbers/ratios of the tuplets you want to allow/disallow 
to span barlines. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate/deactivate Spans barline in the Tuplets group.

RESULT
The selected tuplets span barlines when Spans barline is activated, and are automatically split at 
barlines when it is deactivated.

Tuplets
Allowing/Disallowing tuplets to span barlines 

1411
Dorico Elements 5.1.30



EXAMPLE

A 16th note sextuplet across a barline, notated as 
two triplets

The same sextuplet allowed to span the barline

AFTER COMPLETING THIS TASK
You can beam notes in the selected tuplets together.

RELATED LINKS
Barlines on page 815
Beaming notes together manually on page 841
Tuplet brackets on page 1413
Tuplet numbers/ratios on page 1416
Engrave toolbox on page 503

Tuplet beams
Tuplet beams join notes in tuplets that can be joined with beams just like non-tuplet beams. You 
can make the same changes to tuplet beams that you can make to any other beam.

For example, duplet eighth notes do not need a bracket as they can be joined by a beam and 
notated using only a tuplet number/ratio.

A 6/8 bar with the standard subdivision of six eighth 
notes

A 6/8 bar with a subdivision of four duplet eighth 
notes in the space of six regular eighth notes

RELATED LINKS
Beaming on page 840
Tuplets within beams on page 858
Changing the direction of partial beams on page 855
Changing beam slants on page 847

Tuplets
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Tuplet brackets
Tuplet brackets show the duration of tuplets that are not joined by beams, such as triplet quarter 
notes, by showing the notes within the tuplet under a bracket.

EXAMPLE

A 4/4 bar with the standard subdivision of four 
quarter notes

A 4/4 bar with a subdivision of six triplet quarter 
notes in the space of four regular quarter notes

You can change the precise positions and shapes of tuplet brackets individually in Engrave mode.

Each tuplet bracket has four handles that can be moved graphically.

● The two upper handles set the position of the start/end of the tuplet bracket. These handles 
can be moved independently of each other to create angled tuplet brackets.

● The two lower handles set the length of the tuplet bracket hooks. Moving either of these 
handles changes the length of both hooks.

NOTE

You can use properties in the Tuplets group of the Properties panel to edit individual tuplet 
brackets; however, the Tuplets group is only shown if you select tuplet numbers/ratios or 
brackets. It is not shown if you select notes within the tuplet, or notes within the tuplet and 
the tuplet number/ratio or bracket.

RELATED LINKS
Moving items graphically on page 514
Lines on page 1194

Hiding/Showing tuplet brackets
You can hide/show tuplet brackets for individual tuplets, and independently of tuplet numbers/
ratios. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets you want to hide, or the signposts of tuplets whose brackets you 
want to show. You can do this in Write mode and Engrave mode.

Tuplets
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2. In the Properties panel, activate Bracket in the Tuplets group.

3. Choose one of the following options:

● Hidden 

● Shown 

RESULT
Brackets on the selected tuplets are hidden/shown. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

Signposts are shown at the position of each hidden tuplet; that is, tuplets with no numbers/ratios 
or brackets shown.

AFTER COMPLETING THIS TASK
If you want to hide indications of tuplets entirely, you might also need to hide the tuplet 
numbers/ratios.

RELATED LINKS
Signposts on page 450
Hiding/Showing tuplet numbers/ratios on page 1416
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the staff-relative placement of tuplet brackets
You can show individual tuplet brackets and tuplet numbers/ratios above or below the staff or 
between staves. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets and tuplet numbers/ratios whose staff-relative placement you 
want to change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Placement in the Tuplets group.

3. Choose one of the following options:

● Above 

● Below 

● Cross-staff above 

● Cross-staff below 

RESULT
The placement of the selected tuplet brackets is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Tuplets
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TIP

● Deactivating Placement returns the selected tuplets to their default placement.

● You can also switch selected tuplets between being above/below the staff or cross-staff 
above/cross-staff below by pressing F .

RELATED LINKS
Tucking index properties on page 518

Changing the rhythmic end position of tuplet brackets
You can change the rhythmic end position of tuplet brackets relative to individual notes 
individually. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets whose end position you want to change. You can do this in Write 
mode and Engrave mode.

2. In the Properties panel, activate End position in the Tuplets group.

3. Choose one of the following options:

● End at right-hand side of final note 

● End immediately before following note 

● End at position of final tuplet division 

RESULT
The end position for the selected tuplet brackets is changed. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating the property returns the selected tuplets to your default settings.

RELATED LINKS
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646
Moving items graphically on page 514

Forcing tuplet brackets to be horizontal
You can change the angle of individual tuplet brackets so that they appear horizontal. You can do 
this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

Tuplets
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● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplet brackets whose angle you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Force horizontal in the Tuplets group.

RESULT
The selected tuplet brackets appear horizontal when the property is activated. If the property 
scope was set to Locally, this change only takes effect in the current layout and frame chain.

Tuplet numbers/ratios
Tuplet numbers and ratios are very similar: both indicate the number of equal notes included in 
the tuplet, such as 3 for triplets, but tuplet ratios also include the number of normal notes into 
whose duration the tuplet fits, such as 3:2 for triplets.

Additionally, tuplet ratios can include a note glyph that indicates the duration of notes in the 
tuplet.

A triplet with a ratio and note value indication

Tuplet numbers/ratios help performers quickly identify the type of tuplet and how they must fit 
the number of notes indicated into the prevailing tempo and meter.

NOTE

You can use properties in the Tuplets group of the Properties panel to edit individual tuplet 
numbers/ratios; however, the Tuplets group is only shown if you select tuplet numbers/ratios or 
brackets. It is not shown if you select notes within the tuplet, or notes within the tuplet and the 
tuplet number/ratio or bracket.

Hiding/Showing tuplet numbers/ratios
You can hide/show tuplet numbers/ratios for individual tuplets, and independently of tuplet 
brackets. You can do this for the current layout and frame chain only, or for all layouts and frame 
chains. When showing tuplet numbers/ratios, you can choose a different type for each tuplet 
individually.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

Tuplets
Tuplet numbers/ratios 

1416
Dorico Elements 5.1.30



PROCEDURE

1. Select the tuplet brackets whose numbers/ratios you want to hide/change, or the signposts 
of tuplets whose numbers/ratios you want to show. You can do this in Write mode and 
Engrave mode.

2. In the Properties panel, activate Number in the Tuplets group.

3. Choose one of the following options:

● None 

● Number 

● Ratio 

● Ratio+note 

RESULT
The tuplet number/ratio shown for the selected tuplets is changed. If you selected None, the 
tuplet numbers/ratios for the selected tuplets are hidden. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Signposts are shown at the position of each hidden tuplet; that is, tuplets with no numbers/ratios 
or brackets shown.

Deactivating Number returns the selected tuplets to the default setting.

AFTER COMPLETING THIS TASK
If you want to hide indications of tuplets entirely, you might also need to hide the tuplet brackets.

RELATED LINKS
Hiding/Showing tuplet brackets on page 1413
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the position of tuplet numbers/ratios
You can show individual tuplet numbers/ratios at either the visual or rhythmic horizontal center 
of tuplets. You can do this for the current layout and frame chain only, or for all layouts and 
frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the tuplets or the signposts of tuplets whose tuplet number/ratio horizontal position 
you want to change. You can do this in Write mode and Engrave mode.

2. In the Properties panel, activate Center in the Tuplets group.

3. Choose one of the following options:

● Visual

Tuplets
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● Rhythmic

RESULT
The horizontal position of tuplet numbers/ratios on the selected tuplets is changed. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

● Visual positions tuplet numbers/ratios at the visual center of the tuplet.

● Rhythmic positions tuplet numbers/ratios at the rhythmic center of the tuplet, which might 
be visually off-center.

EXAMPLE

Visual center Rhythmic center

RELATED LINKS
Tuplet brackets on page 1413
Moving items graphically on page 514
Signposts on page 450
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Unpitched percussion

The term “unpitched percussion” covers all percussion instruments that are not tuned to specific 
pitches. This includes instruments such as bass drum, guiro, maracas, cymbals, and shakers.

Dorico Elements provides comprehensive support for unpitched percussion notation, with 
flexible options for combining music for multiple instruments into percussion kits that can then 
be displayed differently in different layouts. You can also define percussion kits as drum sets, 
which changes the default stem directions of notes.

You can also customize and create new playing technique-specific noteheads for unpitched 
percussion. This allows you to indicate how notes are played by using different noteheads for 
different playing techniques on each instrument in percussion kits.

RELATED LINKS
Percussion kits and drum sets on page 142
Percussion kit presentation types on page 1428
Staff labels for percussion kits on page 1319
Defining percussion kits as drum sets on page 148
Inputting notes for unpitched percussion on page 238
Playing techniques for unpitched percussion instruments on page 1420
Playing technique-specific noteheads on page 1421
Showing brackets on noteheads on page 1067
Percussion editor on page 679

Percussion kits vs. individual percussion instruments
Percussion kits allow you to show multiple unpitched percussion instruments held by a single 
player at the same time in different ways. Multiple percussion instruments not combined into kits 
are shown on a single line that only shows the instrument currently being played by default.

One common type of percussion kit is a drum set. A drum set consists of a number of separate 
instruments mounted together on a frame, and is typically written on a regular five-line staff. 
Each instrument has its own position on the staff, and sometimes its own notehead type. 
Similarly, a pair of bongos is a percussion kit by default in Dorico Elements, consisting of the 
two bongo drums, typically written on a grid with two lines: the smaller drum shown on the top 
line, and the larger drum shown on the bottom line.

Showing individual percussion instruments separately can be appropriate if a player only has one 
or two percussion instruments. However, combining percussion instruments into a kit gives you 
more flexibility over the presentation of music, which you can vary in each layout independently. 
Kits also give you greater control over the labeling of instruments.

In layouts where instrument changes are enabled, Dorico Elements changes from one unpitched 
percussion instrument to the next, just as it does for pitched instruments.

Kit instruments in player cards in the Players panel in Setup mode are colored green, whereas 
individual percussion instruments not part of percussion kits are colored the same light blue as 
all other instruments.
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EXAMPLE

A single player holding a percussion kit in the 
Players panel in Setup mode

A single player holding an unpitched percussion 
instrument in the Players panel in Setup mode

RELATED LINKS
Players panel on page 110
Instruments on page 130
Percussion kits and drum sets on page 142
Allowing/Disallowing instrument changes on page 137
Importing drum set patterns from Groove Agent SE on page 94

Playing techniques for unpitched percussion instruments
Playing techniques for unpitched percussion instruments, both as individual instruments and 
within percussion kits, can be notated in different ways, including using different notehead 
designs and positions.

You can indicate playing techniques for unpitched percussion instruments in any of the following 
ways:

● Use playing technique-specific noteheads, including positioning notes above/below their 
normal staff line

● Add articulations or single-note tremolos

● Add playing techniques in the same ways as for pitched instruments

For example, you can add open and closed techniques for hi-hats as playing techniques and use 
playing technique-specific cross noteheads for side stick notes for the snare drum.

You can select playing technique-specific noteheads for unpitched percussion instruments when 
inputting notes and change the playing technique-specific noteheads of existing notes. You can 
input playing techniques during note input and by adding them to existing music.

RELATED LINKS
Playing techniques on page 1180
Articulations on page 804
Tremolos on page 1399
Edit Percussion Kit dialog on page 143
Inputting notes for unpitched percussion on page 238
Changing playing technique-specific noteheads on page 1424
Defining how combinations of articulations and single-note tremolos sound in playback on page 
786
Exporting percussion kits on page 152
Importing percussion kits on page 153
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367

Unpitched percussion
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Playing technique-specific noteheads
Playing technique-specific noteheads use the design and position of noteheads to indicate 
different playing techniques for unpitched percussion instruments, both as individual 
instruments and within percussion kits.

For example, side stick notes on the snare drum notes are typically notated using cross 
noteheads. Other techniques might use the staff positions above or below the single-line staff to 
indicate different playing techniques.

Multiple different playing technique-specific noteheads for snare drum

You can edit the set of playing technique-specific noteheads and staff positions defined for each 
unpitched percussion instrument in the Percussion Instrument Playing Techniques dialog.

You can select playing technique-specific noteheads for unpitched percussion instruments when 
inputting notes and change the playing technique-specific noteheads of existing notes.

RELATED LINKS
Creating new playing technique-specific noteheads on page 1425
Changing playing technique-specific noteheads on page 1424
Inputting notes for unpitched percussion on page 238

Percussion Instrument Playing Techniques dialog
The Percussion Instrument Playing Techniques dialog allows you to edit the set of playing 
technique-specific noteheads defined for each unpitched percussion instrument.

You can open the Percussion Instrument Playing Techniques dialog in the following ways:

● For an individual percussion instrument: In Setup mode, in the Players panel, click 
the instrument menu  in the instrument label, and choose Edit Percussion Playing 
Techniques from the menu.

● For percussion instruments that are part of percussion kits: In Setup mode, in the Players 
panel, click the instrument menu  in the kit instrument label, and choose Edit Percussion 
Kit to open the Edit Percussion Kit dialog. In the main editing area, select the instrument 
whose playing techniques you want to edit, then click Edit Percussion Playing Techniques.

Unpitched percussion
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1 Playing technique-specific noteheads list

Contains the main playing technique-specific noteheads currently defined for the selected 
percussion instrument, showing the notehead set and the staff position corresponding to 
the playing technique as applicable.

You can add new playing technique-specific noteheads for unpitched percussion 
instruments. Normally, percussion instruments define at least the Natural playing 
technique, which is usually shown using the default notehead set.

2 Playback of Articulations and Tremolos

Allows you to define how combinations of articulations and tremolo strokes affect or 
override the playback of playing techniques.

For example, you can define an entirely different playing technique for a playing technique-
specific notehead for when an accent is added to it.

3 Overrides of articulations and tremolos list

Displays any overrides of articulations and tremolos you define.

EXAMPLE

Three different snare drum playing technique-specific noteheads followed by two clash cymbal playing 
technique-specific noteheads

RELATED LINKS
Changing playing technique-specific noteheads on page 1424
Creating new playing technique-specific noteheads on page 1425
Overriding the appearance of playing technique-specific noteheads on page 1425

Unpitched percussion
Playing techniques for unpitched percussion instruments 

1422
Dorico Elements 5.1.30



Defining how combinations of articulations and single-note tremolos sound in playback on page 
786
Inputting notes for unpitched percussion on page 238
Exporting percussion kits on page 152
Importing percussion kits on page 153

Override Percussion Noteheads dialog
The Override Percussion Noteheads dialog lists the playing technique-specific noteheads 
defined for the selected instrument in the Percussion Instrument Playing Techniques dialog, 
shows the notehead type mapped for each technique, and allows you to override those 
noteheads for five-line staff kit presentations only.

For example, the same notehead can indicate different playing techniques for different 
instruments. When those instruments are presented on the same five-line staff, this can cause 
confusion, so you can use the Override Percussion Noteheads dialog to disambiguate the 
notes for one instrument from another in five-line staff kit presentations only.

● You can open the Override Percussion Noteheads dialog from inside the Edit Percussion 
Kit dialog by selecting an instrument, then clicking Edit Noteheads.

The Override Percussion Noteheads dialog comprises the following:

1 Instrument name

Displays the name of the percussion instrument whose noteheads are listed in the dialog.

2 Playing Technique

Displays the playing technique associated with the notehead in the corresponding row of the 
table.

3 Default Notehead

Displays the notehead used by default for the playing technique in the corresponding row of 
the table.

4 Notehead Override

Displays the notehead override used in five-line staff presentations for the playing technique 
in the corresponding row of the table.

You can change the notehead override by clicking the corresponding field, then selecting 
another notehead from the menu.

RELATED LINKS
Edit Percussion Kit dialog on page 143
Notehead set designs on page 1053
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Overriding the appearance of playing technique-specific noteheads on page 1425
Changing playing technique-specific noteheads on page 1424
Inputting notes for unpitched percussion on page 238
Percussion kit presentation types on page 1428

Changing playing technique-specific noteheads
You can change the playing technique-specific noteheads of notes belonging to unpitched 
percussion instruments after they have been input; for example, to switch selected snare drum 
notes to the side stick technique and corresponding notehead.

PREREQUISITE
The unpitched percussion instruments whose playing techniques you want to change have at 
least two playing technique-specific noteheads defined in the Percussion Instrument Playing 
Techniques dialog.

PROCEDURE

1. In Write mode, select the notes whose playing technique-specific notehead you want to 
change.

TIP

If you select a single note in percussion kits using five-line staff or grid presentations, the 
current playing technique is shown above the rhythmic grid.

2. Cycle through the available playing techniques for the selected unpitched percussion 
instruments in any of the following ways:

● To cycle upwards, press Shift-Alt/Opt-Up Arrow .

● To cycle downwards, press Shift-Alt/Opt-Down Arrow .

RESULT
The playing techniques of the selected unpitched percussion notes are changed. Their notehead 
design and/or staff position might be changed.

RELATED LINKS
Playing technique-specific noteheads on page 1421
Playing techniques for unpitched percussion instruments on page 1420
Percussion Instrument Playing Techniques dialog on page 1421
Inputting notes for unpitched percussion on page 238
Moving notes to other instruments in percussion kits on page 465
Percussion editor on page 679
Inputting notes using the Drumstick tool on page 682
Moving percussion notes between instruments/playing techniques on page 685
Defining how combinations of articulations and single-note tremolos sound in playback on page 
786
Playing techniques on page 1180
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367
Showing brackets on noteheads on page 1067
Changing the notehead design of individual noteheads on page 1058
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Creating new playing technique-specific noteheads
You can define new playing technique-specific noteheads for unpitched percussion instruments, 
which are saved for that type of percussion instrument in your project. You can also export 
playing technique-specific noteheads from your project and import them into other projects.

PROCEDURE

1. Open the Percussion Instrument Playing Techniques dialog in any of the following ways:

● For an individual percussion instrument: In Setup mode, in the Players panel, click 
the instrument menu  in the instrument label, and choose Edit Percussion Playing 
Techniques from the menu.

● For percussion instruments that are part of percussion kits: In Setup mode, in the 
Players panel, click the instrument menu  in the kit instrument label, and choose Edit 
Percussion Kit to open the Edit Percussion Kit dialog. In the main editing area, select 
the instrument whose playing techniques you want to edit, then click Edit Percussion 
Playing Techniques.

2. In the playing technique-specific noteheads list, click Add Playing Technique .

3. Select the playback technique you want to use in the dialog that opens.

4. Click OK to add the selected playback technique as a new playing technique-specific 
notehead.

5. From the Notehead set menu, select the notehead you want for the playing technique-
specific notehead.

NOTE

To use the default notehead set, leave Notehead set as (Unset).

6. Choose one of the following options for Staff position:

● Below

● Line

● Above

RESULT
A new playing technique-specific notehead is added to the selected unpitched percussion 
instrument.

RELATED LINKS
Defining how combinations of articulations and single-note tremolos sound in playback on page 
786
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367

Overriding the appearance of playing technique-specific noteheads
It might be necessary to override the appearance of playing technique-specific noteheads in 
order to disambiguate the notes for one instrument from another if they share a staff position in 
five-line staff kit presentations.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit whose 
playing technique-specific noteheads you want to override.
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2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. Select the instrument whose noteheads you want to override.

4. Click Edit Noteheads to open the Override Percussion Noteheads dialog.

5. Click in the Notehead Override column for the appropriate playing technique, then select a 
new notehead type from the menu.

6. Click OK to save your changes and close the dialog.

RESULT
The playing technique-specific notehead is overridden for the selected instrument in five-line 
staff kit presentations.

NOTE

This does not affect the appearance of playing technique-specific noteheads in grid and single-
line instrument kit presentation types.

RELATED LINKS
Players panel on page 110
Edit Percussion Kit dialog on page 143
Override Percussion Noteheads dialog on page 1423

Per-flow notation options for unpitched percussion
You can find options for how notes in percussion kits are notated in each flow independently on 
the Percussion page in Notation Options.

For example, you can choose to notate all notes in a percussion kit in a single voice rather than in 
multiple voices.

RELATED LINKS
Notation Options dialog on page 747

Notations on notes in percussion kits
You can add notations to notes and use different rhythms in percussion kits in the same ways as 
for normal notes; however, they can behave differently.

Articulations

You can add articulations to percussion instruments in all kit presentation types in the same ways 
as for other instruments.

However, in grid and five-line staff presentations, any articulations you add apply to all 
instruments in the same voice that have notes at that rhythmic position. For example, if both 
a snare drum and tom-tom note are at the same rhythmic position, and you add an accent, the 
accent is added to both instruments because they are both shown in the same down-stem voice 
by default.

You can see the accent applied to each note if you switch to the single-line instruments 
presentation type.

Unpitched percussion
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Tuplets

When working in the grid and five-line staff kit presentation types, tuplets are added to all 
instruments in the same voice.

You can switch to the single-line instruments presentation type to input cross-rhythms on each 
instrument separately. When you switch back to the grid or five-line staff kit presentation types, 
Dorico Elements attempts to resolve the rhythmic conflicts.

● Conflicting tuplets: One tuplet is moved into an extra voice for the duration of the conflict.

● Tuplet notes in one instrument and non-tuplet notes in another instrument starting at the 
same rhythmic position: The non-tuplet note is displayed as if it were part of the tuplet. This 
is because the note onset is at the same position as the start of the tuplet, so it sounds the 
same as the original notation.

● Tuplet notes in one instrument and non-tuplet notes in another instrument that do not start 
at the same rhythmic position, or other non-tuplet notes that start part-way through the 
tuplet: Non-tuplet notes are moved into an extra voice for the duration of the conflict.

NOTE

Deleting a tuplet from grid and five-line staff kit presentation types deletes the tuplet from 
all instruments whose notes contribute to the same shared voice.

Playing techniques

You can input playing techniques, such as + for closed and o for open hi-hat, during note input 
and add them later to existing music in the same ways as for other instruments.

Playing techniques are only added to the instrument to which the note you select belongs, even 
if there are other instruments in the same voice.

Percussion stickings

Dorico Elements does not yet have a dedicated feature for percussion stickings. However, you 
can use lyrics to represent percussion stickings in all kit presentation types:

● Grid/Five-line staff presentation types: Select a note in the instrument in which you want to 
show stickings.

● Single-line instruments presentation type: Input lyrics directly into instruments in which you 
want to show stickings.

RELATED LINKS
Inputting articulations on page 271
Inputting tuplets on page 254
Changing the pitch of individual notes on page 468
Input methods for playing techniques, pedal lines, string indicators, and harp pedal diagrams on 
page 367
Inputting lyrics on page 392

Dynamics in percussion kits
Unlike other items, dynamics are not shared between the grid/five-line staff presentation types 
and the single-line instruments presentation type. Any dynamics added to instruments in the 
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single-line instruments presentation type do not appear when you switch to grid/five-line 
presentations.

This is due to the complexity of combining a large number of different dynamics at the same 
rhythmic position, as allowed in the single-line instruments presentation, into the single position 
required for both the grid and five-line staff presentations. Therefore, you can add dynamics 
in the grid and five-line staff presentation types independently of the single-line instruments 
presentation type.

RELATED LINKS
Input methods for dynamics on page 309

Percussion kit presentation types
You can show percussion kits in three different presentation types, which can be different in each 
layout in your project.

NOTE

Dynamics are not shared between the grid/five-line staff presentation types and the single-
line instruments presentation type. Any dynamics added to instruments in the single-line 
instruments presentation type do not appear when you switch to grid/five-line presentations.

You can edit the appearance/structure of each presentation type independently in the Edit 
Percussion Kit dialog. For example, changing the order of instruments in the five-line staff 
presentation does not affect the order of instruments in the grid presentation of the same 
percussion kit.

5-line staff
Kit instruments are shown on a five-line staff. You can determine which instruments 
are shown on each line and in each space of the staff. A single staff label containing the 
name of the kit is shown.

The numbers down the left-hand side of the editing area in the Edit Percussion Kit 
dialog correspond to staff positions. For example, position 0 is the middle line of the 
five-line staff, position 1 is the space immediately above the middle staff line, position 
-2 is the line below the middle staff line, and so on.

Bold black lines show the five staff lines, while gray lines above and below the staff 
show nominal staff line positions. Each instrument is shown on its staff position.

Grid
Kit instruments are shown on a grid, with each instrument on its own line. You can 
customize the size of the gaps between each line. Staff labels are shown for each 
instrument in a smaller font than normal staff labels.

The numbers down the right-hand side of the editing area in the Edit Percussion Kit 
dialog correspond to the number of staff spaces between each instrument line. By 
default, all instruments in a grid are two spaces apart.

The order in which the instruments are listed matches the order in which they appear 
in the score.

Each instrument in a grid shows its own staff label by default, aligned vertically with its 
own line, but you can group adjacent instruments together and show a single label for 
each group.
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Single-line instruments
Kit instruments are shown as individual instruments with their own lines. Normal-sized 
staff labels are shown for each instrument.

The editing area in the Edit Percussion Kit dialog lists all of the instruments in the 
order in which they appear in the score.

RELATED LINKS
Percussion kits and drum sets on page 142
Edit Percussion Kit dialog on page 143
Staff labels for percussion kits on page 1319
Overriding the appearance of playing technique-specific noteheads on page 1425
Override Percussion Noteheads dialog on page 1423
Layout Options dialog on page 745

Changing the percussion kit presentation type
You can change the presentation type of percussion kits in each layout independently and 
independently of each other. For example, you can use a five-line staff in the full score layout 
but a grid in the percussion part layout, and have two percussion kits with different presentation 
types in the same full score layout.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. In the Layouts list, select the layouts in which you want to change the percussion kit 
presentation type.

By default, the layout currently open in the music area is selected when you open the 
dialog. You can select other layouts by using the selection options in the action bar, clicking 
and dragging across multiple layouts, Shift -clicking adjacent layouts, and Ctrl/Cmd -clicking 
individual layouts.

3. In the category list, click Players.

4. In the Percussion section, choose one of the following options for each percussion kit in 
your project:

● 5-line Staff

● Grid

● Single-line Instruments

5. Click Apply, then Close.

RESULT
The presentation type is changed for the selected percussion kits in the selected layouts.
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Percussion legends
Percussion legends list the percussion instruments in use when using the five-line presentation 
type. Percussion legends can include all instruments that are represented on the staff, or only 
show sounding instruments in a set range to remind players which instruments to play at certain 
points.

Two sounding instrument percussion legends

By default, percussion legends appear above the staff. You can change the staff-relative 
placement of percussion legends individually.

You can change various aspects of the paragraph style for percussion legends, such as the font 
size and style, in the Paragraph Styles dialog.

NOTE

● Percussion legends appear as signposts if there are no instruments sounding at their 
position, or when the layout uses the grid presentation type. Percussion legends do not 
appear at all in layouts using the single-line instrument presentation type.

● Percussion legends only appear in the layout in which they were added. If you want to show 
percussion legends in multiple layouts, you must add them in each layout.

● You can hide/show percussion legend signposts by choosing View > Signposts > Percussion 
Legends.

RELATED LINKS
Changing the staff-relative placement of items on page 434
Paragraph Styles dialog on page 756
Per-flow notation options for unpitched percussion on page 1426
Edit Percussion Kit dialog on page 143
Percussion kit presentation types on page 1428
Hiding/Showing instrument change labels at the start of flows on page 141
Staff labels for percussion kits on page 1319

Adding percussion legends to five-line staff kit presentations
You can add percussion legends at specific rhythmic positions to indicate the instruments in the 
kit. Percussion legends can show all instruments in the kit or only instruments sounding within 
the specified range.

NOTE

Percussion legends only appear when kits use the five-line staff percussion kit presentation type 
and in the layout in which they were added. If you want to show percussion legends in multiple 
layouts, you must add them in each layout.

Unpitched percussion
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PROCEDURE

1. In Write mode, select one of the following:

● An item on the staff at the rhythmic position where you want to add a percussion legend 
for all instruments.

● The range of notes/items for which you want to show a percussion legend for sounding 
instruments.

2. Add a percussion legend in one of the following ways:

● Choose Edit > Notations > Percussion > Legend for All Instruments.

● Choose Edit > Notations > Percussion > Legend for Sounding Instruments.

TIP

You can also choose these options from the context menu.

RESULT
A percussion legend is added to the kit. It appears above the staff when the kit uses the five-line 
staff presentation. It lists instruments, either all instruments or just instruments with notes 
within the selected range, in the order in which they appear in the five-line staff, from highest 
down to lowest.

RELATED LINKS
Percussion kit presentation types on page 1428
Editing percussion legend text on page 1433

Changing the percussion legend type
You can change the type of percussion legends so they show all instruments or only sounding 
instruments in five-line staff presentations.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the percussion legends whose type you want to change. You can do this in Write mode 
and Engrave mode.

2. In the Properties panel, activate Legend type in the Percussion Legends group.

NOTE

The property is already activated for sounding instrument percussion legends.

3. Choose one of the following options:

● Legend

● Sounding instruments

RESULT
The legend type of the selected legends is changed.
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RELATED LINKS
Percussion legends on page 1430
Percussion kit presentation types on page 1428
Adding percussion legends to five-line staff kit presentations on page 1430
Engrave toolbox on page 503

Changing the sounding instrument percussion legend range
You can change the rhythmic range of sounding instrument percussion legends to include more/
fewer instruments in the legend, as they only show the instruments playing at the rhythmic 
positions included in the range.

PROCEDURE

1. In Write mode, select the sounding instrument percussion legend whose range you want to 
change.

2. Change the range in any of the following ways, according to the current rhythmic grid 
resolution:

● To move the whole range to the right, press Alt/Opt-Right Arrow .

● To move the whole range to the left, press Alt/Opt-Left Arrow .

● To lengthen the range, press Shift-Alt/Opt-Right Arrow .

● To shorten the range, press Shift-Alt/Opt-Left Arrow .

NOTE

Key commands lengthen/shorten items by moving their end only.

● Click and drag the circular handle at the start/end to the right/left.

RESULT
The rhythmic range covered by the selected sounding instrument percussion legend is changed 
according to the current rhythmic grid resolution.

The instruments included in the percussion legend are automatically updated to reflect the 
instruments playing within the range.

RELATED LINKS
Rhythmic grid on page 217

Showing short instrument names in percussion legends
Percussion legends use full instrument names by default, but you can choose to use short names 
to save space.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the percussion legends whose instrument name lengths you want to change. You can 
do this in Write mode and Engrave mode.
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2. In the Properties panel, activate Use short names in the Percussion Legends group.

RESULT
Short instrument names are shown in the selected percussion legends.

Deactivating Use short names returns the selected percussion legends to showing full 
instrument names.

RELATED LINKS
Staff labels for percussion kits on page 1319
Percussion legends on page 1430
Percussion kit presentation types on page 1428
Adding percussion legends to five-line staff kit presentations on page 1430
Engrave toolbox on page 503

Editing percussion legend text
By default, percussion legends show the instrument names of percussion instruments in five-line 
staff presentations, stacked vertically. You can change the text shown in percussion legends to 
show custom text.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the percussion legends you want to edit. You can do this in Write mode and Engrave 
mode.

2. In the Properties panel, activate Custom text in the Percussion Legends group.

3. Enter the text you want into the value field.

4. Press Return .

RESULT
The text shown in the selected percussion legends is changed.

RELATED LINKS
Engrave toolbox on page 503
Hiding/Showing zones on page 44
Properties panel on page 663

Erasing the background of percussion legends
You can erase the background of individual percussion legends; for example, to ensure they 
remain legible when crossing barlines. You can do this for the current layout and frame chain 
only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.
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● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the percussion legends whose backgrounds you want to erase.

2. In the Properties panel, activate Erase background in the Percussion Legends group.

RESULT
The backgrounds of the selected percussion legends are erased. If the property scope was set to 
Locally, this change only takes effect in the current layout and frame chain.

Deactivating Erase background returns the selected percussion legends to the default non-
erased background.

AFTER COMPLETING THIS TASK
You can change the padding between percussion legends and each edge of their erased areas.

RELATED LINKS
Engrave toolbox on page 503
Properties panel on page 663
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the erasure padding of percussion legends
You can change the erasure padding of individual percussion legends, including changing the 
padding between percussion legends and each edge of their erased areas independently. You 
can do this for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select the percussion legends whose erasure padding you want to change.

2. In the Properties panel, activate the Erasure padding properties, individually or together, in 
the Percussion Legends group.

● L changes the padding between percussion legends and their left edge.

● R changes the padding between percussion legends and their right edge.

● T changes the padding between percussion legends and their top edge.

● B changes the padding between percussion legends and their bottom edge.

3. Change the values in the value fields.

RESULT
Increasing the values increases the padding, decreasing the values decreases the padding. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

Unpitched percussion
Percussion legends 
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Voices in percussion kits
Dorico Elements automatically combines music into a smaller number of voices when multiple 
percussion instruments are presented in a five-line staff or as a grid, even if they contain 
different rhythms. By default, music is combined into one up-stem voice and one down-stem 
voice.

Alternatively, you can choose to notate all notes in a percussion kit in a single voice when the kit 
is defined as a drum set on the Percussion page in Notation Options. This convention is used 
less frequently for orchestral percussion.

You can also override this option for individual notes and whole instruments in individual 
percussion kits.

Notes in the same voice cannot be notated using different durations and are notated using ties 
by default instead. You can eliminate the use of ties by choosing to truncate longer notes so that 
only their onsets appear on the Percussion page in Notation Options.

If one of the instruments in a percussion kit has a tuplet rhythm, other instruments can share the 
voice if their notation is compatible, such as if the tuplet structure is the same, or if they have a 
single note that coincides with the start of the tuplet. In this case, the single non-tuplet note is 
notated as the same duration of the first note of the tuplet.

If the music of the different instruments in the same voice is incompatible, Dorico Elements 
dynamically creates another voice and notates the remaining music in that voice until the music 
is compatible again.

RELATED LINKS
Edit Percussion Kit dialog on page 143
Notations on notes in percussion kits on page 1426
Defining percussion kits as drum sets on page 148
Adding slash voices to percussion kits on page 1260

Specifying the stem direction/voice of instruments in percussion kits
You can specify the stem direction for each instrument in individual percussion kits. You can also 
set which voice they are in, allowing you to control which instruments share voices in percussion 
kits.

PROCEDURE

1. In Setup mode, in the Players panel, expand the card of the player holding the kit whose 
instrument stem directions and voices you want to specify.

2. In the kit instrument label, click the instrument menu  and choose Edit Percussion Kit to 
open the Edit Percussion Kit dialog.

3. In the dialog, select an instrument whose stem direction and voice you want to specify.

4. Choose one of the following stem directions for Stem direction and voice:

● Up-stem 

● Down-stem 

5. Specify a voice by changing the value for Stem direction and voice.

NOTE

You do not have to change the voice number if you are switching between up- and down-
stem voices, as the number corresponds to the voice number for each stem direction.

Unpitched percussion
Voices in percussion kits 
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6. Click Apply, then Close.

RESULT
The default stem direction and voice of the selected instrument is changed.

RELATED LINKS
Players panel on page 110
Edit Percussion Kit dialog on page 143

Changing the voice of individual notes in percussion kits
You can override the default voice for individual notes in percussion kits, including drum sets.

PREREQUISITE
If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

PROCEDURE

1. Select the notes whose voice you want to override. You can do this in Write mode and 
Engrave mode.

2. Choose Edit > Notations > Percussion > Change Voice > [Voice].

For example, to change notes to the second down-stem voice, choose Edit > Notations > 
Percussion > Change Voice > Down-stem Voice 2. You can also choose this option from the 
context menu.

RESULT
The voice of the selected notes is changed, independently of the default voice for their 
instrument and independently of your setting for voices in drum sets.

TIP

You can reset the voice of individual notes by selecting them and choosing Edit > Notations > 
Percussion > Change Voice > Reset Note Destination Voice. You can also choose this option 
from the context menu.

RELATED LINKS
Engrave toolbox on page 503

Universal Indian Drum Notation
Dorico Elements supports the Universal Indian Drum Notation system developed by Keda Music 
Ltd.

Universal Indian Drum Notation has been designed primarily for tabla, but can also be applied to 
other Indian drums with two heads, such as nagara, dhol, dholak, mridangam, and pakhawaj.

Indian drum clefs are automatically shown on the staves of tabla instruments and tabla 
percussion kits, but you can also input Indian drum clefs manually.

Unpitched percussion
Universal Indian Drum Notation 
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RELATED LINKS
Adding players on page 124
Adding instruments to players on page 133
Inputting clefs with the panel on page 333
Percussion kits and drum sets on page 142
Percussion maps on page 780

Unpitched percussion
Universal Indian Drum Notation 
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Voices

For many instruments, such as flute or trombone, each staff usually contains a single musical line 
in a single voice that is read from left to right along the staff. When multiple, independent lines 
must be shown in a single staff, each line can be a separate voice.

An excerpt of piano music with two voices active on each staff

One common use for showing multiple voices in a single staff is in vocal music, when the 
soprano and alto lines share a single staff and the tenor and bass lines share another staff. 
Showing each vocal line in its own voice helps to separate the lines, making the music easier to 
read and making the shape of each melodic line clear.

In Dorico Elements, notes belong to voices. You can create as many voices as you like on each 
pitched instrument staff. Each voice has its own color, which you can see if you show voice 
colors. This can help you to keep track of which notes are in which voices if there are multiple 
overlapping musical lines in your project.

Voices in Dorico Elements are divided into up-stem voices and down-stem voices. Stems of notes 
in up-stem voices point upwards, while stems of notes in down-stem voices point downwards. 
However, in bars where only one voice contains notes, stem directions are automatically changed 
to the directions they would have if there were only one voice on the staff. By default, the first 
voice on the staff is up-stem.

Following most notation conventions, rests are shown in bars for all voices that have notes in 
the bar. If two or more voices have a rest of the same rhythmic duration at the same rhythmic 
position, that rest is consolidated by default: instead of showing two identical rests, only one is 
shown.

RELATED LINKS
Inputting notes into multiple voices on page 232
Changing the voice of existing notes on page 466
Swapping the contents of voices on page 467
Voices in percussion kits on page 1435
Slash voices on page 1258
Adding notes above/below existing notes on page 258
Stem direction on page 1074
Voice column index on page 1442
Unused voices on page 1444
Implicit rests in multiple-voice contexts on page 1273
Moving rests vertically on page 1275
Deleting rests on page 1276
Dynamics in playback on page 953
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Per-flow notation options for voices
You can find options controlling how notes in multiple voices are positioned in each flow 
independently on the Voices page in Notation Options.

The options on this page allow you to change the position and order of notes in multiple-voice 
contexts, and choose when noteheads in different voices can overlap.

Musical examples demonstrate how each option affects the appearance of your music.

RELATED LINKS
Notation Options dialog on page 747
Per-flow notation options for rests on page 1274

Hiding/Showing voice colors
You can show notes in different colors according to their voice; for example, to check which notes 
are in which voice. When voice colors are hidden, all notes appear black by default.

Voice colors are considered annotations and are not printed by default.

NOTE

You cannot show colors for voices and notes out of range simultaneously.

PROCEDURE

● Do one of the following:

● To show voice colors, choose View > Note And Rest Colors > Voice Colors.

● To hide voice colors, choose View > Note And Rest Colors > None.

RESULT
Voice colors are hidden/shown. The first eight voices on each staff use the colors set in 
Preferences > Colors > Voice Colors. Voice colors are automatically assigned to subsequent 
voices.

TIP

You can also identify voices by selecting individual notes and looking at the display in the status 
bar.

EXAMPLE

Voice colors shown

Voices
Per-flow notation options for voices 
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AFTER COMPLETING THIS TASK
If showing voice colors reveals some notes are not in the voice you want, you can change their 
voice.

RELATED LINKS
Preferences dialog on page 58
Changing music area colors on page 54
Changing the voice of existing notes on page 466
Stem direction on page 1074
Hiding/Showing colors for notes out of range on page 1064
Annotations on page 597
Status bar on page 38

Allowing/Disallowing noteheads in opposing voices to 
overlap

You can allow/disallow the noteheads of unison notes in opposing voices to overlap in different 
contexts in each flow independently. For example, if you want to allow notes with and without 
rhythm dots to overlap but disallow half notes to overlap with shorter notes.

PROCEDURE

1. Press Ctrl/Cmd-Shift-N  to open Notation Options.

2. In the category list, click Voices.

3. In the Ordering Multiple Voices section, choose one of the following options for Unison 
half notes (minims) and shorter notes in opposing voices:

● Allow noteheads to overlap

● Do not allow noteheads to overlap

4. Choose one of the following options for Unison dotted and undotted notes in opposing 
voices:

● Allow noteheads to overlap

● Do not allow noteheads to overlap

5. Click Apply, then Close.

RELATED LINKS
Notation Options dialog on page 747
Inputting notes into multiple voices on page 232
Note and rest grouping on page 860

Note positions in multiple-voice contexts
Notes are usually placed directly above each other and at the same horizontal position, so that 
it is immediately clear which notes are played together. However, the horizontal alignment of 
notes can be different in multiple-voice contexts.

There are circumstances when some notes must be positioned slightly to one side in a different 
voice column to ensure the division of notes across the voices is clear. For example, when there 
are three or more voices in a single staff, or when notes in two voices are a second interval apart.

Voices
Allowing/Disallowing noteheads in opposing voices to overlap 
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A phrase with multiple voice columns for some beats on the top staff

Interlocking notes in different voices can be positioned in two ways:

1. Notehead to notehead, which allows noteheads to overlap partially. This voice order often 
takes up less horizontal space than positioning notes stem to stem, as notes can overlap.

2. Stem to stem, which does not allow noteheads to overlap. This voice order keeps notes in 
different voices separate.

Dorico Elements positions notes by default with the noteheads partially overlapping, in order to 
minimize the horizontal space they occupy and to maintain the clarity of the rhythm. The order 
and position of notes in different voices is also automatically adjusted so that each rhythmic 
position uses as little horizontal space as possible, while remaining clear and legible.

● You can change the default order of notes in multiple voices in each flow independently in 
Notation Options > Voices.

● You can manually swap the order in which opposing voices are positioned horizontally and 
change the voice column of individual notes.

● You can move notes graphically in Engrave mode by changing the note spacing. You can 
move individual voice columns independently of all other items at that rhythmic position, or 
move everything at the same rhythmic position.

RELATED LINKS
Stem direction on page 1074
Slashes in multiple-voice contexts on page 1268
Implicit rests in multiple-voice contexts on page 1273
Per-flow notation options for voices on page 1439
Notation Options dialog on page 747
Note spacing on page 507

Voices
Note positions in multiple-voice contexts 
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Voice column index
The voice column index is used to determine the positions of notes when multiple columns are 
needed; for example, when notes in two voices are a second interval apart and therefore cannot 
be placed directly above each other vertically, instead they must partially overlap.

Dorico Elements automatically changes the voice column of voices according to the number of 
active voices and the pitch of notes. Dorico Elements prefers showing voices with the widest 
pitch range between them on the left of the rhythmic position and voices with narrower pitch 
ranges to the right, as this produces the most balanced result, especially when there are multiple 
accidentals.

One voice Two voices 
horizontally aligned 
in the same voice 
column

Three voices all still 
horizontally aligned

Four voices with 
two voice columns

Five voices with two 
voice columns

You can adjust the horizontal spacing of voice columns independently of other voice columns at 
their rhythmic positions.

RELATED LINKS
Allowing/Disallowing noteheads in opposing voices to overlap on page 1440
Adjusting the spacing of individual notes/items independently of their rhythmic positions on 
page 511

Swapping the order of voices
Dorico Elements automatically positions notes with the noteheads partially overlapping, in order 
to minimize the horizontal space they occupy and maintain the clarity of the rhythm. You can 
manually swap the order in which opposing voices are positioned horizontally. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● If you are in Engrave mode, Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. Select the notes whose order you want to change. You can do this in Write mode and 
Engrave mode.

2. Choose Edit > Notations > Voices > Swap Voice Order. You can also choose this option 
from the context menu.

RESULT
The voice order of the selected notes is changed by changing their voice column index. If the 
property scope was set to Locally, this change only takes effect in the current layout and frame 
chain.

Voices
Note positions in multiple-voice contexts 
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NOTE

If you want to revert voices to their default voice order, we recommend that you reset their voice 
column by deactivating Voice column index in the Notes and Rests group of the Properties 
panel instead of swapping their voice order again.

EXAMPLE

Interlocking notes in opposing voices positioned 
notehead to notehead.

Interlocking notes in opposing voices positioned 
stem to stem.

RELATED LINKS
Stem direction on page 1074
Implicit rests in multiple-voice contexts on page 1273
Swapping the contents of voices on page 467
Changing the voice of existing notes on page 466
Engrave toolbox on page 503
Changing the property scope on page 665
Copying property settings to other layouts/frame chains on page 646

Changing the voice column of notes
You can change the voice column, and therefore the horizontal order, of all notes in selected 
voices at individual rhythmic positions, independently of your per-flow settings. You can do this 
for the current layout and frame chain only, or for all layouts and frame chains.

PREREQUISITE

● The lower zone is shown.

● Properties  is selected in the lower zone toolbar.

● Graphic Editing  is selected in the Engrave toolbox.

● You have chosen the appropriate property scope for local properties.

PROCEDURE

1. In Engrave mode, select at least one note in each voice whose voice column you want to 
change.

2. In the Properties panel, activate Voice column index in the Notes and Rests group.

3. Change the value in the value field.

RESULT
The voice column of the selected voices is changed. If the property scope was set to Locally, this 
change only takes effect in the current layout and frame chain.

Deactivating the property returns the selected voice to their default order according to your 
per-flow settings.

Voices
Note positions in multiple-voice contexts 
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TIP

The Voice column index property in the Notes and Rests group of the Properties panel is 
automatically activated when you swap the order of voices manually.

AFTER COMPLETING THIS TASK
You can adjust the horizontal spacing of voice columns independently of other voice columns at 
their rhythmic positions.

RELATED LINKS
Note positions in multiple-voice contexts on page 1440
Voice column index on page 1442
Allowing/Disallowing noteheads in opposing voices to overlap on page 1440
Adjusting the spacing of individual notes/items independently of their rhythmic positions on 
page 511
Engrave toolbox on page 503

Unused voices
An unused voice is one that contains no notes anywhere in the project. Any unused voices are 
automatically deleted when you close a project, but you cannot manually delete voices once they 
have been created. You can create as many voices as you want in each staff.

NOTE

Deleting all notes in a voice does not delete the voice immediately.

If you later want to input notes in a voice that was automatically deleted when you last closed the 
project, you can create a new voice at any rhythmic position.

Notes crossed to staves with existing notes in other voices
When you create cross-staff beams by crossing notes to staves that already contain notes, the 
stem direction of the existing notes may change. This is due to how multiple voices at the same 
rhythmic position are handled in Dorico Elements.

For example, if a piano part contains notes in up-stem voices on both staves, the stem direction 
of notes in both voices can change if notes from the upper staff are crossed to the lower staff. 
In this situation, the notes from the two staves are not combined, but are instead treated as two 
up-stem voices in a multiple-voice context.

Two piano staves, each with notes in a single up-
stem voice.

When the notes in the upper staff are crossed to the 
lower staff, the stem direction of the notes already in 
the lower staff changes so they point upwards.

Voices
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You can change the stem direction of the notes originally in the lower staff in any of the following 
ways:

● Select the notes originally in the lower staff and change their voice to another voice, such as 
a down-stem voice.

● Select the notes originally in the lower staff and change their stem direction.

Alternatively, you can move the notes in the upper staff permanently to the lower staff.

RELATED LINKS
Creating cross-staff beams/tremolos on page 851
Moving notes/items to other staves on page 464
Inputting notes into multiple voices on page 232
Changing the voice of existing notes on page 466
Stem direction on page 1074

Voices
Notes crossed to staves with existing notes in other voices 
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Glossary

A
action (expression maps)
A control in expression maps that determines how individual switches are controlled in order to 
trigger the required playback technique or combination of playback techniques.

action (harps)
The mechanism that raises or lowers the pitch of harp strings, as controlled by the position of 
each pedal.

action (pianos)
The mechanism that allows piano hammers to strike the strings with different forces, depending 
on the strength with which the player depresses the corresponding key. It allows pianos to use a 
greater dynamic range, hence their full name “pianoforte”.

alignment relative to noteheads
When calculating the horizontal alignment of items relative to noteheads, Dorico Elements uses 
the front notehead in the first voice column at the corresponding rhythmic position. The front 
notehead is the notehead on the correct side of the stem; that is, on the left of up-stems and 
on the right of down-stems. Items that can be aligned relative to noteheads include lyrics, chord 
symbols, and playing techniques.

anacrusis
See pick-up bar.

articulation (music notation)
A symbol that indicates how a note should be played, typically affecting its onset (attack), release, 
or duration. For example, staccato marks and accents.

articulation (sound libraries)
A term that refers to playing techniques generally.

attachment
The rhythmic position at which an item occurs, or to which an item applies, in the music. In Write 
mode and Engrave mode, an attachment line is shown between a single selected item and its 
rhythmic position.

B
bar
A span of music comprising a specific number of beats, as defined by the prevailing time 
signature, whose boundaries are indicated by bar lines. Also known as a “measure”, but this 
documentation uses “bar”.

C
cancellation natural
A natural accidental positioned on the staff immediately before a change in key signature or 
a single note. It indicates that the previous accidental no longer applies and can be followed 
immediately by a new accidental if applicable. Showing cancellation naturals before single 
accidentals that follow double accidentals is also known as “archaic cancellation”. Cancellation 
naturals before a change in key signature are known as “traditional” when positioned after the 
barline and “Russian” when positioned before the barline.
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caret
Shown during note input, the caret is the vertical line that extends above and below the staff and 
indicates the rhythmic position at which items are input. Also known as an “insertion point”. In 
Dorico Elements, the caret, cursor, and mouse pointer are related but serve different purposes. 
See also rhythmic grid, note input, cursor, mouse pointer.

casting off
The act of fixing the layout of pages of music, such as defining a set number of systems per page 
or the number of bars per system.

cautionary accidental
A restatement of an earlier accidental to eliminate ambiguities, such as when a tied note with an 
accidental continues onto another page. Also known as a “courtesy accidental”.

CC
Short for “continuous controller” or “control change”, it is a MIDI message that combines a 
controller number and a value. The value for an individual controller can change over time, 
allowing incremental manipulation of the corresponding sound or effect, such as increasing/
decreasing the string vibrato intensity. You can specify the sound or effect that each CC 
switches to and controls in each sound library using expression maps. In Dorico Elements, each 
instrument track has 127 available MIDI CCs, each with a value range from 0 to 127. Because 
MIDI CC does not use notes on a MIDI keyboard, it allows you to use the full range of MIDI 
keyboard notes for note input. However, it is therefore harder to trigger MIDI CC whilst recording 
notes. See also MIDI, PC.

channel
In MIDI, a channel determines which note, controller, or other data is played by which sound on 
which device. In Dorico Elements, notes on a single staff may be played by different channels, 
depending on which playing techniques are provided by the patch assigned to each channel. See 
also MIDI, patch.

chord
Two or more notes of the same duration that start at the same rhythmic position and share a 
stem.

chord input
A variation of note input where notes are stacked on top of each other to create chords, rather 
than being input after the previous note in sequence. Notes are input at the caret position, which 
does not advance automatically. See also caret, note input, Insert mode.

collision avoidance
Automatic adjustments made by Dorico Elements to ensure multiple items at the same position 
do not overlap and that all remain clearly legible. Includes changing the shape of items, such as 
slurs, and changing the vertical and/or horizontal position of items, such as accidentals in chords.

column
A vertical line representing the same horizontal position across all staves in the system. Used 
to determine the position of notes and chords for the purposes of spacing music accurately. 
Multiple columns can be used for the same rhythmic position to accommodate multiple voices, 
with notes or chords in some voices being offset horizontally from notes or chords in other 
voices.

concert pitch
All notes are written as they sound. Full scores are often notated in concert pitch, so that 
harmonies and themes are easier to identify. Also known as “sounding pitch”. See also 
transposed pitch, instrument transposition.

condensing
The process of showing the music for multiple players on fewer staves than is normal, usually 
by allowing multiple instruments of the same type to share a staff, such as Flutes 1-2 or Horns 
1-4. Most commonly used for large orchestral scores, as when there are fewer staves on a page 
it is possible to use a larger staff size, which is easier for conductors to read. See also divisi, pitch 
crossing, reducing.

Glossary
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constant point
A change in value in the Key Editor that sets a fixed value until the next point. See also point (Key 
Editor), linear point, value line.

context menu
A menu that you can access by right-clicking on a mouse or double-tapping on a touchpad. Its 
options vary by the location of the mouse pointer and what is selected when you access it, but it 
most commonly contains options also found on the Edit menu.

cursor
The vertical blinking line that appears when entering or editing text. See also caret, mouse 
pointer.

D
dead note
A note played on a fretted instrument whose sound is muted to produce a sound that is more 
percussive than pitched. Usually produced by gently resting one hand on the string. Also known 
as a “muted”, “muffled”, “ghost”, or “silenced” note. In Dorico Elements, only notes belonging to 
fretted instruments, such as the guitar or banjo, can be dead notes.

disclosure arrow
A small arrow that is shown on all edges of the main window in Dorico Elements. It allows you to 
hide/show the toolbar and panels individually.

divisi
Italian for “divide” or “divided”, divisi is when players split in order to play multiple lines of music. 
This commonly involves a section, such as Violin I, dividing and using two staves rather than one 
for a limited passage. Divisi passages can be notated all on the same staff, using multiple voices 
if required, or across multiple staves. See also tutti, condensing, exploding, reducing.

drum set
A particular type of percussion kit that is often used in pop and rock music. Drum sets often 
use a different arrangement of voices than percussion kits. In this documentation, references to 
“percussion kits” also apply to drum sets, as drum sets are a type of percussion kit.

E
EDO
An abbreviation for Equal Division of the Octave, it is a unit used to describe how an octave 
can be divided into equal parts, often for the purpose of defining a microtonal scale or tonality 
system. Traditional Western European music uses 12-EDO; that is, each octave is divided into 12 
equal half-steps (semitones). Music that uses equal quarter tones uses 24-EDO. See also pitch 
delta.

endpoint
The unique combination of inputs and outputs that together allow the correct sounds to be 
played for each instrument.

Engrave mode
A mode in Dorico where you can manipulate and modify every item in your project, but without 
deleting them, moving them rhythmically, or changing the pitch of notes. You can also determine 
how the pages in each layout of your project are formatted for printing or exporting. See also 
modes.

enharmonic equivalent
An alternative spelling of a note that uses a different scale degree and accidental but produces 
the same sounding pitch, such as G♯ and A♭.

Glossary
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ensemble
A predefined collection of players, each holding instruments that are often used together, such 
as string quartet, wind quintet, brass quintet, string ensemble, and double woodwinds.

envelope
A change in sound over time that comprises multiple stages, such as attack, sustain, and decay. 
In the Dynamics editor, envelopes are represented by highlighted regions and multiple separate 
points, each controlling a different parameter of the overall envelope. See also point (Key Editor), 
constant point, linear point, value line.

explicit rest
A rest that was deliberately input during rest input or imported from a MusicXML file. Explicit 
rests cannot be suppressed between notes in a particular voice. See also rest, implicit rest.

exploding
The process of assigning music to more instruments than it was written for originally. Exploding 
music is often a key step in arranging and orchestrating music, such as when a piano piece is 
arranged for string quartet. See also reducing, divisi.

F
family
Instruments of a similar kind that are typically bracketed together in a score, such as woodwind, 
brass, percussion, and strings.

fermata
A notation that indicates all notes at that position are held for longer than their notated length. 
It is most commonly shown as a curved line with a dot under the curve, but it can also be shown 
with a pointed arch or square shape. Also known as a “pause” or a “birds’ eye”.

flow
A self-contained span of music of any scope, such as a movement in a symphony, a song in 
an album, a number in a musical, or a short exercise in a music theory worksheet. A flow can 
contain the same players as other flows in the project or separate players just for that flow. See 
also player.

formatting
The act of determining the number of bars in a system, the number of systems on a page, and 
the distances between staves and systems.

fps
A unit of measurement, short for “frames per second”, that refers to the number of video frames 
occurring each second.

fragment
Part of a notation item. For example, fragments of a note include its notehead, rhythm dots, 
accidentals, the tip of its stem, and beam. In Write mode, selecting any part of an item also 
selects all of its fragments, so any changes you make affect the whole item. In Engrave mode, 
you can select each fragment individually to tweak its position or appearance. See also item, 
segment.

frame
A rectangular container for music, text, or graphics on a page.

fretted instrument
A type of instrument that in most cases has multiple strings, a neck with marked frets, and 
is played by stopping the strings at fret positions on the neck with one hand, usually the left, 
and plucking the corresponding strings with the other hand, usually the right. Common fretted 
instruments include the guitar, ukulele, and banjo.

full score
A score comprising all of the music for all of the players and their instruments, typically laid 
out in a specific order. The order used varies according to the ensemble for which the music 
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is written. In full scores for orchestra, the players are typically ordered from the highest wind 
instrument at the top of the page, such as piccolo, to the lowest string instrument at the bottom 
of the page, such as contrabass, with brass, keyboards, voices, and percussion in between.

G
galley view
A viewing option that shows music laid out as a single, infinitely wide system.

grace note
A small note, often used to show an ornament or embellishment, that is not counted towards the 
number of beats in the bar; instead, it steals from the duration of either the preceding or the 
following rhythmic notes. Also known as an “arhythmic” or “crushed” note. In common practice, a 
grace note with a slashed stem is an “acciaccatura”, which is to be played as quickly as possible, 
either immediately before or at the rhythmic position of the note or chord that follows it. A grace 
note with an unslashed stem is an “appoggiatura”, which is played as half of the written duration 
of the note or chord that follows it.

grand staff instrument
An instrument that normally uses two or more staves joined by a brace to display their notes. 
Common grand staff instruments include the piano, organ, and harp. Upper staves usually 
indicate higher notes and use the treble clef, while lower staves usually indicate lower notes and 
use the bass clef.

H
hairpin
A notation for dynamics that uses a pair of angled lines, diverging from or converging on a 
single point, to show a gradual increase or reduction in the dynamic level; that is, a crescendo or 
diminuendo.

half-bar
The rhythmic position that divides bars into two equal sections when the prevailing time 
signatures can be divided into four equal beats. In Dorico Elements, specific beam grouping 
and note grouping settings apply to bars with a half-bar. Time signatures that have a half-bar 
include 4/4 and 12/8.

handle
A selectable item that marks the ends of lines, the corners of frames, and other moveable 
positions, such as pedal line retakes and slur control points. In Write mode, handles are 
circular and mark rhythmic positions. In Engrave mode, handles are square and mark graphical 
positions.

harmonic series
A naturally-occurring set of frequencies that are all related to a single pitch, known as the 
“fundamental”. When a fundamental pitch is played, the note produced contains many different 
notes within the harmonic series. These additional notes are known as “partials” or “overtones”. 
It is also possible to bring out the sound of individual partials by playing them as harmonics. 
There is a consistent pattern of intervals between partials within the harmonic series, and 
these intervals become progressively smaller the further up the harmonic series they occur. 
For example, the interval between the first and second partials is an octave whereas the interval 
between the seventh and eighth partials is only approximately a major second. At the top end of 
the harmonic series, most partials are microtones. See also partial.

hook
A short line that extends from other lines, most commonly at a right angle, that helps to clarify 
the end position of lines. In Dorico Elements, hooks can be used at the end of pedal lines, octave 
lines, repeat endings, and tuplet brackets.

horizontal justification
The alignment of musical content to the left and right edges of the frame. To ensure that all 
staves in a system occupy the same width, any remaining space that is left over after the music 
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is spaced is distributed evenly between all of the columns in the system. Sometimes the final 
system of a flow is not fully justified and is allowed to end partway across the width of the frame. 
See also frame, justification.

I
implicit rest
A rest that is automatically shown around the notes you input. Its notated duration automatically 
adjusts according to the time signature and its position in the bar. Implicit rests can be 
suppressed between notes in a particular voice, which hides them. See also rest, explicit rest, 
padding rest, multi-bar rest.

Insert mode
A way of changing how notes are input. When Insert mode is activated, new notes push all 
subsequent notes in the same voice along by the input duration instead of overwriting existing 
notes. Similarly, reducing the duration of notes with Insert mode activated pulls them closer 
together without leaving rests between the notes. This also affects edits you make outside of 
note input, such as deleting notes, changing the duration of notes, or inputting time signatures. 
See also note input, chord input.

instrument
Anything that requires at least one staff to represent the sounds or music it produces. Common 
instruments include the violin, flute, tuba, and bass drum. However, human voices, computer 
triggering samples, and tape recordings can also be instruments.

instrument transposition
The interval difference between the pitch the instrument plays and the resulting sounding pitch, 
often included as part of the instrument name. For example, when a Clarinet in B♭ plays a C, the 
pitch produced is a concert B♭. Instrument transposition is also known as “instrument pitch”. See 
also concert pitch, transposed pitch.

item
Generic term for any note, rest, chord, notation, or other selectable object that appears in the 
score in Dorico Elements. See also fragment, segment.

J
justification
The alignment of musical content to the edges of the frame, both horizontally and vertically. See 
also frame, horizontal justification, vertical justification.

K
key command
A set of keys that perform a defined task when pressed together. Also known as a “keyboard 
shortcut” or “hotkey”.

L
layer
See voice.

layout
A page-based presentation of the music for one or more players in one or more flows; for 
example, a full score that contains all players or an instrumental part that contains only a single 
player. See also flow, player.
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layout options
Options that affect the setup of an individual layout, such as page and staff size. These options 
can be set in each layout independently in the Layout Options dialog. See also layout.

linear point
A change in value in the Key Editor that acts as a point on a curve, setting a value for its position 
only and allowing for a smooth change in value from that position until the next point. See also 
point (Key Editor), constant point, value line.

lock duration
Functionality that allows you to change the pitches of existing music while retaining existing 
rhythms.

lyric
Any text that is intended to be sung or spoken by an individual singer or group of singers. A lyric 
can be a whole word or an individual syllable in a multi-syllabic word. Lyrics are shown at each 
rhythmic position where a new word or syllable begins. Typically, lyrics are found below the staff, 
but are sometimes placed above the staff; for example, in the case of a short score.

M
measure
See bar.

MIDI
An abbreviation for Musical Instrument Digital Interface, a standard for how electronic musical 
instruments, computers, and virtual instruments can connect to and communicate with each 
other. In Dorico Elements, MIDI data can be sent to one of 16 channels, which allow either a 
specific instrument, or a specific patch on a specific instrument, to receive and respond to the 
data. See also channel, patch, CC, PC.

minor key
A key signature based on a minor scale, which has a different pattern of intervals to a major 
scale. See also minor scale.

minor scale
A sequence of notes containing the pitches of a minor key. There are three types of minor scales: 
natural, harmonic, and melodic. Natural minor scales follow the interval pattern of the Aeolian 
mode, which on a keyboard is all the white notes from A-A. Harmonic minor scales also follow 
the Aeolian mode interval pattern but the seventh degree of the scale is sharpened; for example, 
G♯ in A harmonic minor. Melodic minor scales follow different interval patterns when they are 
rising/falling: when rising, melodic minor scales have sharpened sixth and seventh degrees, but 
when falling, the sixth and seventh degrees are both natural. See also minor key.

modes
Selectable workspaces in the project window that represent different phases in the workflow of 
preparing a score. See also Setup mode, Write mode, Engrave mode, Play mode, Print mode.

mouse pointer
The icon on the screen that allows you to interact with items and the user interface, usually by 
clicking. Its position is typically controlled by an external mouse or touchpad. Its appearance 
varies depending on the context, such as appearing as a hand when it hovers over a hyperlink, 
but it most commonly appears as an arrow pointing towards the top left corner of the screen. 
Also known as a “mouse arrow”, “cursor”, or simply a “pointer” or “mouse” In this documentation, 
we use the term “mouse pointer” to differentiate from the cursor and caret. See also cursor, 
caret, touchpad.

multi-bar rest
A consolidation of multiple adjacent empty bars into a smaller unit, typically shown as a single 
bar with the total number of bars' rest written above the staff. A multi-bar rest normally shows 
an H-bar symbol, which is a thick horizontal line with vertical lines at each end. In some older 
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published scores, a multi-bar rest of up to nine bars in length is shown using a combination of 
double whole and whole rests. Also known as a “multirest”.

music area
The main part of the window in Setup, Write, and Engrave modes where you input and edit your 
music.

MusicXML
A file format designed to allow the interchange and archiving of music notation data in an open 
and non-proprietary way. It is useful for exchanging scores between different music applications.

N
node
A position along the length of a string that marks an equal division of the string, such as a 
quarter of the way along a string. Touching, but not fully stopping, a string at a node produces a 
harmonic partial. See also partial, harmonic series.

notation options
Options that affect the way the music is notated, particularly concerning how notes and rests are 
grouped according to meter, rules for the extent of accidentals, and options for transposition. 
These options can be set independently for each flow in the Notation Options dialog.

note input
The standard method of adding notes to staves in sequence that is possible when the caret is 
active. The caret automatically advances to the next rhythmic position after each note is input. 
During note input, it is also possible to input other items at the caret position. Also known as 
“step input” because notes are input step-by-step. See also caret, chord input, Insert mode.

O
octave division
A single step within an octave whose interval depends on the total number of divisions in the 
octave. For example, in 12-EDO, there are twelve octave divisions, each a half-step (semitone) 
apart. See also EDO, pitch delta.

overtone
See partial. See also harmonic series, node.

P
padding
The minimum distance/gap between two items, such as text and its enclosure. Padding values 
can be independent of other set values, such as minimum height or width.

padding rest
A rest that fills the extra rhythmic space before or after cues that start or end partway through 
bars. This shows clearly how the rhythm of the cue fits within the time signature and how it 
relates to the player’s existing material. See also implicit rest.

page break
The forced termination of a page of music at a particular rhythmic position, typically at a barline. 
Often used to ensure a convenient page turn in a part. In Dorico Elements, page breaks can be 
achieved using frame breaks, which are indicated using signposts. See also system break.

page view
A viewing option that shows music laid out on a page with a fixed width and height, as it appears 
when printed. See also galley view.

Glossary
 

1453
Dorico Elements 5.1.30



panel
Wide palettes of tools on the left, right, and bottom edges of the program window that are 
available in all modes, but their content varies in each mode.

part
The music belonging to the instruments played by one or more players, shown on its own rather 
than in a full score. Performers who do not need to see the music belonging to the whole 
ensemble play from parts so they only have to read the music they play themselves. See also full 
score, layout.

partial
A single pitch or frequency in the harmonic series, which varies in pitch according to the pitch 
of the fundamental but is always a consistent interval above the fundamental according to 
its number in the harmonic series. For example, the second partial is an octave above the 
fundamental, the third partial is an octave and a fifth above the fundamental, and the fourth 
partial is two octaves above the fundamental. Also known as simply a “harmonic” or “overtone”, 
although when described as an overtone it has a different number, as the first overtone is the 
same as the second partial. See also harmonic series.

patch
An older term for a discrete sound on a MIDI device or virtual instrument. See also channel, 
MIDI, PC.

pause (holds)
A notation that shows where the established rhythmic flow of the music is interrupted, either 
with a moment of repose or a short silence, before continuing. Also known as a “hold”, “fermata”, 
“breath mark”, and “caesura”. See also fermata.

pause (rest)
A marking with a rhythmic value that indicates no note is played for that duration. In this 
documentation, we refer to this as a “rest”. See also rest.

PC
Short for “program change” or “patch change”, it is a MIDI message that allows you to access 
different sounds by switching to the corresponding programs. Because programs can also 
include effects presets, they allow you to change to specific sounds quickly, which is particularly 
useful in live performances. You can specify the programs that each PC switches to in each sound 
library using expression maps. See also MIDI, CC, patch.

pedal level change
A change to how far a piano sustain pedal is depressed, between 1 (fully depressed) and 0 (not 
depressed). It is notated as a change to the height of a pedal line. Also known as a “pedal lift”.

pick-up bar
A note or notes played before the first full bar of a piece. Also known as an “upbeat” or 
“anacrusis”. Pick-up bars often only comprise one or two beats whose main purpose is to lead in 
to the start of the piece.

pitch crossing
A possible situation on staves containing multiple voices or parts, such as condensed staves, 
where notes in down-stem voices have higher pitches than notes in up-stem voices. See also 
condensing.

pitch delta
The number of octave divisions by which accidentals raise or lower the pitch of notes. For 
example, in 12-EDO, a pitch delta of 1 raises notes by a half-step (semitone) and is commonly 
notated using the sharp accidental (♯). See also EDO.

player
A musician who plays one or more instruments. Players are defined as either single players or 
section players and are assigned to flows and layouts. See also single player, section player, flow, 
layout.
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player group
A collection of players that comprises either a subset of the main ensemble, such as a choir 
within an orchestra, or a separate group, such as an off-stage brass group or second orchestra. 
Each group of players is labeled separately in the full score and is grouped and numbered 
together in the instrument order. See also player.

playhead
A vertical line that moves alongside music during playback and when recording, showing the 
current rhythmic position. Also known as a “playback line”.

Play mode
A mode in Dorico where you can change how your music sounds in playback, including by 
changing the playback template and assigning VST instruments, inputting automation, adjusting 
the mix, and changing the sounding duration of notes in playback without affecting their notated 
duration. See also modes.

playthrough
A single time playing from the beginning of the piece to the end. Music that contains multiple 
possible endings, such as music with repeat endings or codas, requires multiple playthroughs.

plug-in
A software program that can operate within another software program. Dorico Elements 
supports VST instruments and effects and script plug-ins written in Lua.

point (Key Editor)
A change in value in the Key Editor. Points appear as squares that you can select and edit, such 
as by dragging them. Points can be constant or linear. See also constant point, linear point, value 
line.

point (size)
A unit of measurement in typography that describes the size of fonts.

pointer
See mouse pointer.

polymeter
Music containing multiple simultaneous meters; for example, one instrument in the ensemble 
plays in 6/8 and another plays in 7/4.

popover
A temporary value field that is evoked using a key command and allows you to input items using 
text entries. You can open popovers in Write mode during note input or when items are selected 
in the music area. There are dedicated popovers for different types of items.

preamble
The notations typically drawn before the first note or rest on each system of music. The preamble 
usually includes clefs, key signatures, and time signatures. In Dorico Elements, the preamble is 
drawn automatically, so you cannot select any items included in it.

Print mode
A mode in Dorico that allows you to print and export the layouts in your project. See also modes.

print preview area
The main part of the window in Print mode where you can see a preview of what is going to be 
printed or exported as a graphic. See also Print mode.

project
A Dorico Elements file that can contain multiple flows and layouts. See also flow and layout.

properties
The characteristics of individual items and fragments of items in your project that can be edited 
via the Properties panel. There are two types of properties: local and global. Local properties are 
layout- and frame chain-specific, meaning that by default, changing local properties for an item 
in one layout does not affect the same item in other layouts or other frame chains.
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Q
quantization
In music, the act of adjusting the positions and durations of notes so they align with the nearest 
defined beat. This process eliminates small variations in rhythm and duration produced naturally 
by live performers, and can be useful when importing/exporting MIDI data as quantized music 
produces neater notation.

R
rastral size
The size of a full five-line staff, measured from the bottom line to the top line. The term comes 
from the rastra engravers historically used to draw five-line staves on blank paper. Because the 
rastrum is a fixed object, people became used to their set sizes and Dorico Elements continues 
this tradition by offering users a selection of rastral staff sizes.

reducing
The process of taking music for more than one instrument and assigning it to fewer instruments, 
such as a keyboard reduction of a choral piece. A piece of music that has been reduced is known 
as a “reduction”. See also exploding, condensing, divisi.

rest
A marking with a rhythmic value that indicates no note is played for that duration. Also known 
as a “silence” or “pause”, but in this documentation, we refer to them as “rests”. See also implicit 
rest, explicit rest, padding rest, multi-bar rest, pause (holds).

rhythmic grid
A unit of rhythmic duration whose value affects certain aspects of inputting and editing, such as 
the amount by which items move. Its current value is shown by the note value in the status bar, 
and by ruler markings indicating beat divisions and subdivisions above the staff on which the 
caret is active. See also caret.

rhythm section
A collection of instruments typically found in jazz and commercial music. Customarily, the rhythm 
section includes keyboards, percussion kits, guitars, and bass guitars or double basses. In 
Dorico Elements, instruments defined as being in the rhythm section can show chord symbols 
differently to other instruments.

S
score
See full score, part, layout, project.

section player
Multiple musicians who all play the same instrument and read from the same part layout; for 
example, Violin I. Section players may not play multiple different instruments, but can divide. See 
also player, single player.

segment
Part of a notation item that functions autonomously in Engrave mode. Segments can exist 
regardless of their position, such as individual ending brackets within a repeat ending, or only 
when a single item is split across a system or frame break, such as glissando lines. See also item, 
fragment.

Setup mode
A mode in Dorico where you can set up the fundamental elements of the project: instruments 
and the players that hold them, flows, layouts, and videos. You can also determine how they 
interact with each other; for example, by changing the players assigned to layouts. See also 
modes.
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single player
An individual musician who can play one or more instruments; for example, a flute doubling 
piccolo. See also player, section player.

SMuFL
Short for “Standard Music Font Layout”, it is a font specification that maps all the different 
symbols required for music notation onto a standard layout. Dorico Elements requires SMuFL-
compliant fonts for certain areas of the program, such as clefs and dynamic glyphs, to ensure it 
can locate the correct symbol. SMuFL-compliant fonts include Bravura, Petaluma, and November 
2.0.

space
A unit of measurement in music engraving based on the distance between the center of two 
adjacent staff lines. Practically all notation items are scaled in proportion to the size of a space; 
for example, a notehead is normally one space tall.

spacing
The act of determining the horizontal distance between successive columns in order to format 
the music. Horizontal spacing in Dorico Elements considers the graphical shape and size of notes 
and other items, such as rhythm dots and accidentals, and the note spacing values set. Full 
systems are automatically horizontally justified.

spelling
The way in which a note of a given pitch is specified by a letter name plus an accidental. For 
example, assuming the conventional 12-EDO pitch system, MIDI note 61 can be spelled as C♯, D♭, 
and B. The same pitch is normally spelled a certain way in a given key; for example, MIDI note 61 
is normally spelled as C♯ in D major, but is spelled as D♭ in A♭ major. See also EDO, MIDI.

split stem
A way of presenting altered unisons that keeps each accidental directly beside the notehead to 
which it applies. Also known as a “cherry stalk” or “tree”.

staff-relative placement
The vertical position of items relative to musical staves; that is, either above or below.

staff spacing handle
The square handle on the bottom left corner of each staff when Staff Spacing  is activated in 
Engrave mode. Staff spacing handles only change the vertical position of a single staff. See also 
system spacing handle.

string shift indicator
An angled line that indicates the direction of movement when string players have to shift 
position on the fingerboard to play a higher/lower note with the same finger as the previous 
note.

stroke
The short line that bisects editorial slurs and ties. Also known as a “notch”.

SVG
SVG stands for Scalable Vector Graphics, which is an XML-based way of displaying and modifying 
graphics. Due to the way it is coded, it allows you to modify graphics very flexibly compared to 
other formats.

system
A horizontal span of music that is played together. Most printed music displays systems 
spanning the full width of pages. A system can contain any number of staves. For example, 
in orchestral full scores, systems typically contain staves for all instruments in the orchestra, 
meaning a single system often occupies the full height of the page. In part layouts, each system 
only contains the staves required for that player, which is often a single staff and means multiple 
systems can fit on each page. See also system break, page break, casting off.

system break
The forced termination of a system of music at a particular rhythmic position, typically at a 
barline. Indicated in Dorico Elements with signposts. See also page break.
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system formatting
The distribution of bars into systems and systems into frames. When copying part formatting 
between layouts, Dorico Elements considers the positions of system breaks, frame breaks, and 
note spacing changes to be aspects of system formatting.

system object
An item that applies to all staves in the system, but is not necessary to show on every staff, 
such as tempo marks and rehearsal marks. In Dorico Elements, you can show system objects at 
multiple positions in each system by showing them above multiple instrument families.

system spacing handle
The square handle on the top left corner of each system when Staff Spacing  is activated in 
Engrave mode. System spacing handles change the vertical position of the top staff in systems, 
which also moves all staves in the system accordingly. See also staff spacing handle.

T
tempo track
The timing-related information included in MIDI data that affects tempo, SMPTE offsets, time 
signatures, timecodes, and markers, which can be imported independently of the rest of the data 
in MIDI files.

token
A code used in a text string that is automatically replaced by a piece of information from 
elsewhere in the project, such as the title of the current flow, the name of the player, or the 
page number. Also known as a “wildcard” or “text code”.

touchpad
Any flat device with a tactile sensor that functions as an alternative to the traditional computer 
mouse. Commonly built into laptop computers but can also be separate appliances connected 
wirelessly or via a cable.

transport
Encompasses all options related to playback and recording.

transposed pitch
In transposed pitch, the pitches notated are the pitches that the instrument plays, rather than 
the desired sounding pitch. Instrumental parts are always in transposed pitch so that players can 
simply play the written notes, which is especially important for transposing instruments. See also 
concert pitch, instrument transposition.

tuplet
A rhythm that is performed at a fraction of its normal written duration. For example, a triplet is 
three notes of a given note value played in the time it would normally take to play two notes of 
that note value. Also known as an “irrational rhythm” or a “countermetric rhythm”.

tutti
Italian for “everyone”, tutti indicates that a passage of music is to be played by all players reading 
from that part or staff. It is most commonly used to indicate the end of a divisi passage, or for 
clarification when a staff can indicate both solos and tutti passages at different times. See also 
divisi.

U
upbeat
See pick-up bar.
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V
value line
A visual representation of value over time. In Dorico Elements, you typically find value lines in the 
Key Editor. Fully horizontal value lines indicate a constant value, while angled value lines indicate 
a smooth change in value within a given duration, usually between two points. See also point 
(Key Editor), constant point, linear point.

vertical justification
The spreading out of staves and systems across the full height of frames with as even a 
distribution of space as possible. If the music in the frame requires less vertical space than 
is available, the remaining space is distributed evenly between the systems, and between the 
staves of the systems. See also frame, justification.

vibrato bar
A device on electric fretted instruments, typically guitars, that allows the performer to add 
vibrato to notes and to adjust the pitch of notes, similar to a guitar bend. Also known as a 
“whammy bar”, “tremolo bar”, “tremolo arm”, or “vibrato arm”.

voice
In Dorico Elements, a series of notes, chords, rests, and other notations that make up a single 
musical line and are normally played by the same instrument. Assigning notes and items to 
different voices allows multiple lines of music to be presented on the same staff as clearly as 
possible, such as in vocal music where the soprano line uses an up-stem voice and the alto line 
uses a down-stem voice. Dorico Elements allows as many voices as are needed to be input onto a 
single staff, and lays them out and spaces them automatically. See also instrument.

VST instrument
Short for “Virtual Studio Technology instrument”, it is a digital plug-in that converts MIDI data 
into audio output. It can emulate an existing piece of studio hardware or can be an entirely new 
creation.

W
Write mode
A mode in Dorico where you can input and edit your music, including changing the rhythmic 
positions of items, changing the pitch of notes, and deleting notes and items. See also modes.
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Index

A
A paper sizes 593, 600
abbreviated

dates 660
dynamics 921, 934, 943
instrument names 181, 183, 184, 449, 1313
staff labels 143, 1310, 1312, 1313
tempo text 1339

absolute channel change actions 775
absolute font size 754, 756
absolute tempo changes 1336

parentheses 1341
Academico font 753, 754, 756
accelerando. See gradual tempo changes. See also 
tempo marks
accents. See articulations
acciaccaturas. See grace notes
accidental duration rules 800

changing 801
common practice 800
Modernist 800
Second Viennese School 800

accidental spelling 245
changing 473, 475, 476
resetting 476

accidentals 792
altered unisons. See altered unisons
appearance 793, 801
arrows 1028
brackets 793, 801, 1084
cancellation 800, 802
cautionary. See cautionary accidentals
changing 244, 279
chord symbols 158, 163, 165, 320, 872, 877, 
883–885
chords 795
collision avoidance 795, 797
color 54, 795
deleting 792
duration rules. See accidental duration rules
enharmonic equivalents 473, 475, 476
figured bass 399
glissando lines 1115
Gould arrows 1028
guitar pre-bends 1130
harmonics 1084
harp pedaling. See harp pedaling
hiding 792, 793, 801, 802, 1084, 1098
horn branch indicators 979
inputting 214, 244, 279
intervals 341, 487, 1099
kerning 796
key signatures 792, 1019, 1020, 1025
layout names 183
lines 1205

accidentals (continued)
microtonal 800
MIDI input 245
moving 797
none 278, 793, 1021, 1084
octave divisions 1028
ornaments 1090, 1104
panel 200, 281
parentheses 793, 801, 1084
part names 183
piano roll editor 678, 681
pitch before duration 214
quarter tones 800, 1028
respelling 473, 475, 476
restating 800, 801
showing 792, 793, 801, 1084, 1098
signposts 450
size 794, 877
spacing 796
stacking order 795, 797
Stein-Zimmermann 1028
text 388, 391, 657
ties across breaks 793, 1370
titles 657
tokens 657
transposing 470, 1025, 1027
trills 1097–1099, 1102, 1104

accolades. See braces
accompaniment

chords 251, 871, 878, 894, 895
inputting 224, 227, 230, 232, 251
playback 956

actions 767, 775
activating 63, 222, 450

caret 222
channel effects 722, 729
chord input 196, 251
dotted notes 196
EQ 722
force duration 196
frames 503
grace note input 196
graphic editing 503
graphic slices 503
independent voice playback 545
Insert mode 196, 237
inserts 729
instrument filters 448
lock duration 196
MIDI thru 216
mouse editing 212
mouse input 196, 212
note input 222, 224, 227
note spacing 503, 509
pitch before duration 196
playback 30, 540, 542, 558, 564
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activating (continued)
player sorting 125
plug-ins 527
rest input 196
scissors 196
signposts 450
staff spacing 503, 624
system track 427
tuplet input 196
VST instruments 525, 527, 542

adagio. See tempo marks
add intervals popover. See note tools popover
Add Marker dialog 402
add-on switches 766, 774
added notes

chord symbols 322
adding. See inputting
additional

endings 410, 412, 1230
voices 232, 1278, 1438

additive time signatures. See time signatures
advanced options

hiding 42
showing 42

advancing
caret 223
chord symbols popover 325
figured bass popover 400
hairpins 430
lyrics popover 395
slurs 430

aeolian
chord symbols 323, 885
scales 484, 485, 492

aggregate time signatures 283, 1382
combining 1394
dashed barlines 283, 1382
inputting 283, 285, 287, 288

aikin noteheads 1057, 1058
air sounds. See playing techniques. See also diamond 
noteheads
aliases

jump bar 67, 68
alignment

arpeggio signs 1111
bar numbers 832
barlines 822
bars 612, 822, 1328
chord symbols 872, 878, 880, 881
counts 1242, 1243
crosshairs 517
dynamics 923, 924, 949–952
fermatas 1013–1015
fingerings 973
gradual dynamics 925
instrument names 184
items 517
lines 1197, 1205
lyrics 1035, 1037
measures 612, 1328
notes 1440, 1442, 1443. See also voice column 
index
octave line numerals 916, 917

alignment (continued)
ornaments 1091
page numbers 1150
pedal lines 1162, 1163, 1166, 1167, 1169, 1170
playing techniques 1184, 1188, 1192
repeat counts 1242, 1243
repeat endings 1233
repeat markers 1237
rests 1271, 1274, 1275
rhythm dots 1062, 1442
staff labels 184, 1311, 1318
staves 604, 612, 621, 1311, 1328
systems 604, 612, 621, 1311, 1328
tempo marks 1336
text 389, 756, 759, 1356
time signatures 1394
trills 1092
voices 1440, 1442, 1443. See also voice column 
index

allegretto. See tempo marks
allocating. See assigning
allowing. See activating. See also enabling
alpha channel 586, 596
alterations

chord symbols 322, 872
jazz ornaments 345

altered bass notes 322, 872, 886
arrangement 887
inputting 318, 322
separator 872, 877, 887

altered unisons 798
appearance 799
formatting 799
split stems 798

alternating time signatures. See time signatures
alto abbreviation

horn fingerings 979
alto clef. See clefs
ambience 529
amp modeling 722, 728
AmpSimulator 722, 728
anacrusis. See pick-up bars
analysis

chords 326
fugues 56, 956, 1194
harmony 957, 1194

angles
beams 847, 859
borders 756, 1359
fanned beams 859
fingering slides 986
glissando lines 514, 1115, 1119
hairpins 514, 938
jazz articulations 1147
lines 385, 514, 1194, 1202, 1215
pedal lines 1162, 1163, 1166, 1167
slurs 1287, 1302
string shift indicators 990
ties 1375
tremolos 1400
tuplet brackets 514, 1413
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annotations 218, 494, 597, 1196
comments 494
highlights 575, 882, 883, 1245, 1247, 1261, 1265
lines 1196
note/rest colors 54, 56, 549, 1064, 1275, 1439
ornaments. See ornaments
signposts 450
voice colors 54, 1439

aperture
hairpins 937, 938, 945
messa di voce 938, 945

apostrophes 659
appearance

default settings 745, 747
items 663
resetting 436

appending
crescendo 943
diminuendo 943
flows 78
possibile 934
subito 934

Apply Space Template dialog 738
Apply Stage Template dialog 731
applying. See assigning. See also activating
appoggiaturas. See grace notes
Arabic numerals

page numbers 1151
archaic accidental cancellation 802
arco. See playing techniques
areas

editing 37, 143, 1428
graphs 713
music 34
print preview 36
project start 34
selecting 424, 425, 427, 428, 676, 715
tools 37, 663

arhythmic notes. See grace notes
arms

vibrato. See vibrato bar
arpeggio signs 1108, 1111, 1194

alignment 1111
appearance 1108–1110
beat-relative playback 1112
brackets 1108
changing 432
cross-staff 347, 348
crosshairs 517
curved 343
deleting 455
direction 1108
duration 1112, 1113
ends 1110
filter 429
fingerings 985
formatting 1109, 1110
grace notes 1111
handles 1111
inputting 340, 343, 347, 348
length 347, 348, 514, 1111
moving 461, 464, 514
muting in playback 548

arpeggio signs (continued)
panel 345, 348
playback 1112, 1113
popover 343, 347
position 1111
spacing 1111
swash 1108
ties 247
types 343, 1109
voices 347, 348

arrangements
accidentals in key signatures 1020
chord symbols 872, 887
flows 171
movements 171
pages 41, 50

arranger 75
adding 75
bold 75, 756
exporting 102
fonts 756
italics 75, 756
tokens 658

arranging 455, 457
changing instruments 134
chord symbols 326, 327
condensing. See condensing
copying 457–459
filters 429, 445
MIDI import 85
pasting 459
reducing 643. See also condensing
tools 455, 477
transforming notes. See transformations
transposing. See transposing
voices 464, 466, 467

arrows 1194
accidentals 1028
arpeggio signs 1108
caps 1191, 1207
design 1190
disclosure 42
lines 1196
noteheads 1055, 1058
panels 38, 44, 109
zones 38, 44, 109

articulations 804, 1180
changing 271
collision avoidance 808
copying 805
deleting 805
duration 804, 809
dynamics 954
inputting 206, 214, 271, 272
inverting 808
jazz. See jazz articulations
key commands 272
kits 1426
MIDI import 88
moving 514, 807, 808
notes 806
order 806
overlapping 808
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articulations (continued)
panel 200
percussion 786, 1420, 1421, 1426
pitch before duration 214
placement 806, 808
playback 545, 546, 749, 762, 786–788, 809, 954
playing technique-specific noteheads 786
position 514, 805–807
slurs 806, 808, 1286
spacing 514
stems 806
ties 807, 809, 1364
tremolos 786
tuplets 271
types 804

artificial harmonics 1081
accidentals 1084
changing 1089
hiding 1082
partials 1083
pitch 1083
playback 1081–1083
showing 1082
styles 1085, 1089

assigning 63
expression maps to endpoints 522, 570
flows to layouts 121, 177
instruments to endpoints 569
key commands 63
MIDI commands 63
notehead designs 1058
notes to strings 1059
page templates 601
percussion kit voices 1260, 1435, 1436
percussion maps to endpoints 522, 570
players to flows 121, 172
players to layouts 121, 176
voices 232, 233, 466, 545, 1260, 1435, 1436
voices to endpoints 569

atonal key signatures 1021
note spelling 470

attacca 545, 818
attachment lines 24, 461, 514

caesuras 340
crosshairs 517
dynamics 944
hiding 437
playing techniques 1184, 1187, 1188, 1191
showing 437
text 1352

attachment points
chord symbol components 875
items 461, 514
lines 385–387, 1194, 1197

attack
articulations 804, 1365
delay 769
dynamics 312, 921
playback 761
tremolos 407, 414, 416, 1401
VST instruments 529

attribute playback techniques 787, 788
inputting 372, 788

audio
buffer size 268, 269
device setup 58
dialog 101
exporting 100, 101
mixer 717, 718
outputs in mixer 567
panning 726, 730, 735
playback 558, 564
repeats 549
reverb 738, 742, 744
videos 193
volume 193, 717, 718, 725
warning 38

auditioning
chords 216, 420, 542
MIDI devices 216, 264, 420
notes 215, 216, 264, 420, 542
scrub playback 542

augmented 487
accidentals 800
chord symbols 321, 872
intervals 341, 470, 487, 800, 1099, 1100
scales 484, 485, 492
trills 341, 1099, 1100

author name 494, 496
changing 499
hiding 499
lyricist 999
showing 499
sorting by 500

auto-save 103, 104
date and time 104
deleting projects 103
disabling 105
interval 105
recovering projects 104

automation lanes. See MIDI CC editor. See also Key 
Editor
AutoPan 722, 728
auxiliary notes 1102

notehead design 1058
position 1104
showing 1103

B
B paper sizes 593, 600
backgrounds 52

chord symbols 888
colors 53, 54, 756, 759
dynamics 930
erasing 888, 930, 985, 993, 1182, 1213, 1361, 1433
fingerings 985
gradients 54
lines 1213
pages 53
percussion legends 1433
playing techniques 1182
text 389, 756, 759, 1182, 1213, 1361
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backups 105
auto-save. See auto-save
location 106
number 105

backwards 439
moving bars 633, 636
navigation 325, 395, 400, 439
pitches 478, 479, 490, 491
playback. See scrubbing
rhythms 478, 479, 490, 491

balalaika. See fretted instruments
balance

mix. See mixer
ballroom

panning. See stage templates
reverb. See space templates

bands 77
adding 71, 114
EQ 722
player order 110, 125
project templates 71, 77
staff grouping 866
stage templates 731

banjo. See fretted instruments
bar counts

multi-bar rests 828
bar graphs 713
bar numbers 826

alignment 832
alternative 838
appearance 826, 829
barlines 832
brackets 838
changing 836, 837
clefs 832
collision avoidance 832
colors 56
comments 494, 496, 497, 499, 500
counts 1254
default settings 826
deleting 836
enclosures 827
erased backgrounds 827
font 829, 830
frequency 826
galley view 40
gaps 832
guide 829
hiding 826, 829, 834, 837
layout options 826
moving 514, 832
multi-bar rests 826, 828
multiple positions 831
paragraph styles 830
parentheses 838
part layouts 829
pick-up bars 1386
position 831, 832, 1257
ranges 828, 1253. See also numbered bar regions
rehearsal marks 1218
repeat sections 838
returning to primary sequence 838
sequence changes 835

bar numbers (continued)
showing 826, 829, 837
signposts 450
size 829, 830
staff-relative placement 831, 1257
statistics 106
subordinate 837
subsequent repeats 838
system-relative placement 834
time signatures 834
total. See counts

bar repeats 1245, 1399
bar numbers 828
brackets 1247, 1249
casting off 629
changing 432, 1246
changing number 1248
colors 56
consolidating 1279
counts 1247–1250
deleting 455
dynamics 1246
erased backgrounds 1245
filter 429
font style 1247, 1250
frame breaks 637
frequency 1249
grouping 1251
handles 430
highlights 1245, 1247
inputting 408, 409, 418
length 430
moving 461, 464
moving counts 514
multi-bar rests 1279
panel 409
parentheses 1247, 1249
phrase length 432, 1246
playback 432, 1246
popover 408
regions 1245
symbols 1251
system breaks 634
types 408
viewing options 1247

bar rests 1277
counts 1279
cues 747, 920, 1274
deleting 1273, 1276
hiding 605, 1273, 1274, 1276–1278
inputting 246, 301
moving 1275
multi-bar rests 1279
showing 605, 1274, 1277, 1278
slashes 1273
statistics 106
voices 1273, 1274, 1278

barbershop quartet. See project templates
barline joins 822, 824

default 824, 865, 866
hiding 820, 821, 824

barline-attached lines. See lines
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barlines 815
across staves 822, 824
alignment 822
bar numbers 832
caesuras 340
changing 306, 307, 816–819
chord symbols 880, 888
coda 820
copying 172
counts. See repeat counts
custom joins. See barline joins
dashed 816, 817, 819, 1382, 1394
default 817, 818
default settings 816
deleting 455, 824
double 816, 817, 819
dynamics 924–926, 930
end barlines 818, 819
fermatas 1015
final. See final barlines
frame breaks 633
gaps 888, 930, 1182, 1213, 1361, 1433
grace notes 1005
gradual tempo changes 1337
grand staff instruments 822, 824
hiding 283, 818–820, 888, 930, 1182, 1213, 1361, 
1382, 1433
initial. See systemic barlines
inputting 300, 303, 306, 307, 813
joins. See barline joins
key signatures 819, 1022
length 822, 824
moving 455, 821
multi-bar rests 306
none 283, 818, 819, 1382
notation options 816
open meter 1382
panel 303, 307
popover 301, 303, 306
rehearsal marks 1216
repeat. See repeat barlines
scale size 816, 817
short 816, 817, 819
signposts 306, 307, 450, 455, 815
single 816, 817, 819
staff grouping 822, 824, 866
system breaks 633, 819
systemic 820, 821
thickness 816, 817, 819
tick 816, 817, 819
time signatures 824, 1394
triple 303
tuplets 1411
types 303, 816
vocal staves 822, 824

Baroque
appoggiaturas 1002, 1009
figured bass. See figured bass
ornaments 345, 1090
trills 1104, 1107
tuning 545

barré 1180
adding 903
chord diagrams 895, 904
hiding 1183
inputting 367, 372, 374

bars 14, 810
alignment 612, 822, 1275, 1328
bar rests. See bar rests
beam grouping 24, 860, 861, 863
chord symbols 882
combining 455
count-in 268
deleting 301, 452, 810–812
deleting contents 812
display 555, 558
divisions 813
duration 810
expanding 304, 305, 452, 453
fixing number 629, 630, 635, 638
frame breaks 633, 636
frames 106
gaps 1242, 1328
glissando lines 1116
going to 441
graphs 713
grouping. See bar repeats. See also multi-bar rests
half-bar 747, 860, 863
height 602–604, 621
inputting 300, 301, 303–305, 451
Insert mode 451
length 452, 810
moving 631, 633–637
multi-bar rests 1279
navigation 441
note grouping 24, 860, 861, 863, 1262
numbers 826
panel 303, 305
pick-up bars 1386
playback 540, 555
popover 301, 304
red 453, 454
repeat 1230, 1236, 1245
rest alignment 1275
rests. See bar rests
rhythm slashes 1261, 1262
selecting 421, 422, 424, 427
size 451, 452, 507, 602, 603, 612, 621, 810, 1328
spacing 507, 509, 813, 1199, 1276
splitting 633, 634, 636, 637, 813
system breaks 633
timecodes 1228
tuplets 1411
upbeats. See pick-up bars
vibrato. See vibrato bar. See also guitar
width 507, 509, 612, 813, 1276, 1328

Bars and Barlines panel 303, 305, 307
Bartók pizzicato. See playing techniques
base switches 766, 774
baseline

attachment points 875
chord symbols 872
dynamics 939
instrument names 184

Index
 

1465
Dorico Elements 5.1.30



baseline (continued)
lyrics 1039, 1044
staff labels 184
text 389, 759

bass clef. See clefs
bass drum. See unpitched percussion
bass guitar. See fretted instruments
bass notes

altered 318, 322
counterpoint 956
figured bass. See figured bass

bassoon. See instruments
beam corners 855
beam groups 23, 840, 841, 860

creating 841
cut common time 863
default settings 747, 840
defining 840, 861
half-bar 840
notation options 840
pick-up bars 1386
resetting 844
selecting 421, 422
stem directions 1076
time signatures 841

beam lines
direction 855
gaps 857
number 856
thickness 845

beam slants 847
changing 847
grace notes 1008

beaming 840, 841, 859
accidentals 800
angles 847, 859
centered beams 848, 849
corners 855
cross-staff. See cross-staff beams
default settings 840
direction 845–847, 855
fanned 859
gaps 857
grace notes 1008
grouping 840, 841, 860, 863. See also beat groups
half-bar 840, 861
handles 847
hiding 1079
inverting 845, 846
large pitch ranges 1008
lyrics 843
meter 861
multiple staves. See cross-staff beams
notation options 840
notes 841
optical cross-staff spacing 852
partial 855
placement 845, 851, 854, 1078
primary beams 855
resetting 844, 846, 850, 854
restating accidentals 800
rests 840, 841, 858
secondary beams 855, 856

beaming (continued)
slants 847, 1008
slashes 1263
spacing 852
splitting 747, 840, 843, 860, 863
staff-relative placement 845, 846
stem direction 845, 849, 851, 853, 1078
stemlets. See stemlets
tablature 1331
thickness 845
ties 247
time signatures 841, 861
tuplets 840, 843, 844, 858, 860, 1412
unbeaming 843
vocal staves 843

beat groups 23, 840, 860
cut common time 863
defining 283, 861
numerators 1389
rhythm slashes 1262
ties 1364
time signatures 1389, 1390

beat units 1341
deleting beats 302
inputting beats 302
metronome marks 432, 1342
setting 296
tempo marks 294
tuplets 257

beats
deleting 302, 452, 810–812
display 555, 558
inputting 302, 304, 305, 451, 452
Insert mode 451, 452
per minute 1341
pick-up. See pick-up bars
popover 302
recording latency 268, 269
relative position 436
selecting 428

beep. See click
bend intervals 1128

handles 1131, 1133–1135
microtonal 1128

bends
guitar. See guitar bends. See also dives
jazz. See jazz articulations. See also jazz ornaments
vibrato. See vibrato bar

big band. See bands. See also jazz
bindings. See ties. See also laissez vibrer ties
birds eyes. See fermatas
bit depths 100, 101
black and white 596
black noteheads 1052, 1053
blank areas. See erased backgrounds
blank pages

deleting 651
staff spacing changes 624

blank staves
adding 124, 128, 133
after flows 608
hiding 605, 608
showing 605, 608
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blog 69
blue selections 951, 1297
Blues guitar post-bends 1125
body

changing 1206
lines 1194, 1196, 1206
playing technique continuation lines 1188, 1190

bold text 389, 753, 754, 756, 759, 1352
chord symbols 877
composer 75, 756
dedication 75, 756
figured bass 968
fingerings 979
instrument change labels 142
lyricist 75, 756
lyrics 1041, 1042
Markdown 75
project information 75, 756
rehearsal marks 1219
repeat endings 1233
subtitles 75, 756
tasto solo 968
tempo marks 1339
titles 75, 756

bomb
dive. See dives

bongos. See unpitched percussion. See also percussion 
kits
booklets 591

duplex printing 592
printing 590, 591

borders 597, 1358
bar numbers 827
chord symbols 888
exporting 585
fingerings 977
harp pedaling 1156–1158
instrument change labels 142, 756
layout names 1001
lines 1212
padding 756, 888, 1158, 1360
part names 756
printing 581
shape 756, 827, 1359
style 756, 1359
tacets 640, 756
text 756, 1212, 1358, 1359
thickness 1157, 1212, 1360

Boston chord symbols 872
bottom zone. See lower zone
bowing. See playing techniques. See also slurs
boxes. See borders. See also frames
bpm 1341

changing 709, 1342
braces 864

hiding 820, 865, 867, 868
secondary brackets 868, 869
showing 820, 865, 867, 868
signposts 450
staff spacing 603, 604, 621

bracketed noteheads 1066, 1067, 1141
changing type 1067
chords 1066, 1067, 1070

bracketed noteheads (continued)
curve 1071
formatting 1071
gaps 1102
ghost notes 1067
guitar bends 1122, 1124
handles 1072
hiding 1067
inputting 1067
length 514, 1072
moving 514, 1071, 1072
percussion 1067
playback 1067
shape 1071, 1072
showing 1067
slurs 1072
splitting 1070
tablature 1066, 1067, 1122, 1127
tie chains 1069
ties 1072
ties on tablature 1069, 1364
trills 1102
vibrato bar dives and returns 1127
width 1071

brackets 864
accidentals 793, 801, 1084
arpeggio signs 1108
bar numbers 838
bar repeats 1247, 1249, 1254, 1256
barlines 822, 824
capo chord symbols 158, 872
chord symbols. See parenthesized chord symbols
counts 1249, 1256, 1267
divisi 865, 866, 868, 869, 1194, 1329
dynamics 929
ensemble types 77, 866
figured bass 397, 960, 963
fingerings 274, 276, 980, 981, 983
grouping 167, 865, 866, 1317
guitar bends 1122, 1124
harmonics 1085
hiding 820, 865, 868
hold lines 963
horizontal. See lines
instrument transpositions 1315
layouts 865
metronome marks 1341, 1343
moving 893, 1072
noteheads. See bracketed noteheads
numbered bar regions 1254, 1256
pedal lines 1175, 1176
player groups 167, 824, 1317
playing techniques 1188
project templates 77
repeat endings 1230, 1232, 1234
secondary 868, 869
showing 820, 865, 868
signposts 450
size 892
slash regions 1267
staff labels 1315
staff spacing 603, 621
staves 865, 866, 1317
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brackets (continued)
sub-brackets 868, 869
sub-sub-brackets 870
tablature 1085, 1122, 1124, 1127
templates 77
tempo marks 1341, 1343
thickness 891
time signatures 283, 1388, 1389, 1392
tuplets 1413
vibrato bar dives and returns 1127

Brandt-Roemer chord symbols 872
brass band. See bands. See also project templates
brass instruments 130

adding 112, 114, 124, 128, 133
brackets 866, 1317
chord symbols 878
fingerings 971, 979, 989
glissando lines 1119, 1120
groups 167
horn branch indicators 979, 990
panning. See stage templates
player order 110, 125
playing techniques 371
project templates 77
reverb. See space templates
system objects 1327
transposition 112, 132

Bravura music font 753
breaking

multi-bar rests 1279, 1281
notes 261
tie chains 261, 1373

breaks
frame 636
page 636
playback 545, 1016
system 633

breath marks 1010–1012
appearance 432
caesuras 1013
colors 56
Curlew marks 1013
deleting 455
fermatas 1013
inputting 337–339
moving 461, 464, 514
multiple at same position 1013
placement 1013
playback 1016
position 1013
types 432, 1012

breves. See double whole notes
Brickwall Limiter 722, 728
Britten Curlew. See fermatas. See also breath marks
Broadcast WAVE format 101
broken beams 855
buffer

audio 268, 269
building ensembles 114, 129
bypassing 722, 729. See also muting

C
C clef. See clefs
cadenzas 283, 304, 305, 452, 453, 810, 1382

system dividers 1324
caesuras 1010, 1012

appearance 432
breath marks 1013
colors 56
Curlew marks 1013
deleting 455
fermatas 1013
gaps 1013
gradual tempo changes 1016
inputting 337–340
linking 1013
moving 461, 514
multiple at same position 1013
placement 1013
playback 1016, 1018
position 340, 1013
types 432, 1012

calando. See gradual tempo changes. See also tempo 
marks
calculating

chord symbols 326, 327
harp pedaling 381
stacking 518, 795
statistics 106
tempo marks 403
values 666

cancellation
accidentals 800, 802
double accidentals 802
key signatures 1023
naturals 1023

candidate menus
playing techniques popover 367
tempo popover 293

cantabile. See dynamic modifiers
Capo Chord Symbol Definition dialog 163
Capo Definition dialog 160
capos 157

adding 159, 160
alignment 880, 881
chord symbols 157, 158, 162–164, 166, 872, 880, 
881
defining 159–163, 165
deleting 161, 163
gaps 158, 872
hiding 163, 164, 166
italics 158, 872
notation staves 161, 162
parentheses 158, 872
partial 159, 160
position 163, 881
tablature 157, 159–161

caps 1186, 1196
arrows 1191, 1207
changing 1191, 1207
continuation 1196
lines 1196
playing technique continuation lines 1188, 1191
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capsule
borders 756, 1359

cards
disclosure arrows 42
flows 120
layouts 117
players 110
timecodes 120

caret 218
activating 196, 222
advancing 223
chords 218, 251
color 54
deactivating 196, 222
extending 222, 235
grace notes 218, 249
inputting vs. editing 210
Insert mode 218, 237
lock duration 218
moving 217, 223, 1409
multiple staves 222, 235
percussion kits 238
rhythmic grid 217
slash voices 218
slashes 233
tablature 218
types 218
voice indicator 218, 232, 931

casting off 629
bars per system 629, 635
copying to other layouts 643
flows 501, 609
locking 629–631
moving bars 631
note spacing 507, 508
resetting 632
staff spacing 603, 620, 621
systems per frame 630, 638

categories
ensembles 114, 116, 129
lines 385, 1194
noteheads 1053, 1057
project templates 77
templates 71, 866

cautionary 1024
accidentals. See cautionary accidentals
key signatures. See cautionary key signatures
time signatures. See cautionary time signatures

cautionary accidentals 800, 801
color 54, 795
common practice 801
hiding 793, 801, 1084
Modernist 800
parentheses 800, 801
showing 793, 801, 1084
tie chains 793, 1084, 1370
trills 1098

cautionary clefs 907
cautionary fingering 980

hiding 981
parentheses 981
showing 981

cautionary key signatures 1024
hiding 1025
showing 1025

cautionary time signatures 1384
hiding 1384
showing 1384

CC64
pedal lines 91, 268, 270

cello. See instruments
center selection 50
centered beams 848

creating 849
removing 850

centered text
bar numbers 832
hairpins 935

centimeters
staff spacing 624
unit of measurement 51

chains
frames 662
ties 1364

chamber
ensembles 77, 114, 116, 128, 730
panning. See space templates
reverb. See space templates

change labels
instruments. See instrument change labels

Change Paragraph Style dialog 1356
channel change actions 522, 567, 570, 775
channels 717, 720, 721

adding 727
bypassing inserts 729
changing 569
controls 720, 722
effects. See FX channels
endpoints 567
expression maps 522, 567, 570, 775. See also 
channel change actions
FX. See FX channels
height 724
hiding 724
importing 91
inserts 722, 728, 729
instruments 569, 720, 721
meter 720
MIDI 91, 720, 721
mixer 717, 718, 720–722, 728
muting 547
names 728
panning 726, 730
percussion maps 522, 567, 570
playback 567
plug-ins 567
renaming 728
reverb 729, 738
scrolling 724
setup 567
showing 724
soloing 547
strips 717, 718, 722
video 721
volume 725

Index
 

1469
Dorico Elements 5.1.30



character styles 753, 759
creating 760
deleting 759
dialog 759
missing fonts 73
saving as default 759

Character Styles dialog 759
cherry stalks. See split stems
choir templates 71, 77, 731

staff grouping 866
Choose Chord Diagram dialog 903
choral

lyrics 1029
playing techniques 371
verse numbers 1049

chord brackets. See bracketed noteheads. See also 
parenthesized chord symbols
chord diagrams 871, 894

barré 895, 904
changing 902, 903
colors 903, 904
components 895
copying shapes 902
custom 903
dots 903, 904
editing 903
fingerings 895, 900, 901, 903, 904
font styles 906
formatting 903, 904
fret numbers 900, 901, 903, 904, 906
gaps 898
grid 898, 900
hiding 895, 897, 898, 900
inputting 895, 897
nut 895
omitted strings 895, 904
open strings 895, 904
resetting 901, 904
rows 898, 900, 901
shapes 902–904
showing 895, 897, 898, 900
size 898
symbols. See chord symbols
thumb 900, 901, 904
tuning 154, 156, 898, 902

chord input 254
activating 196, 251
arpeggio signs 347
caret 218
exploding 235
multiple staves 235
register selection 226
tablature 242, 251

chord symbol components 872
appearance 872
attachment points 875
custom 875
handles 873, 875
inputting 320
popover 320
types 872

chord symbol regions 882
handles 430, 882
hiding 878, 880
highlights 883
inputting 324, 326
length 430
moving 461, 464
popover 324
showing 878, 880

chord symbols 251, 871
accidentals 158, 163, 165, 320, 872, 877, 883, 884
added notes 322
alignment 872, 878, 880, 881, 887
alterations 872
altered bass notes 318, 877, 887
appearance 872, 873, 875
arrangement 887
backgrounds 888
barlines 880, 888
brackets. See parenthesized chord symbols
capos 157, 158, 163, 164, 166, 872
changing 432, 872
colors 56, 875
components. See chord symbol components
copying 425, 878–881
crosshairs 517
custom 873, 875
default settings 872
deleting 455, 878
diagrams. See chord diagrams
dialog 873, 875
engraving options 872
enharmonic spelling 157, 158, 163–166, 872, 884, 
885
erased backgrounds 872, 888
figured bass 395, 397
filter 429
fonts 877
gaps 158, 872
generating 326, 327
global 871
height 881, 887
hiding 326, 878–880, 882, 886, 897
highlights 883
inputting 318, 320, 325–327, 878
instruments 318, 878, 880
intervals 322
inversions 318
italics 158, 872, 877
layouts 879
local 871
main 158
MIDI input 318
MIDI navigation 63
modal 323, 885
moving 461, 514, 880–882
MusicXML import 893
navigation during input 325
no chord 323
note spacing 880
omissions 322
padding 872, 888, 893
parentheses. See parenthesized chord symbols
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chord symbols (continued)
pitch 178
placement 882
playback 522, 535, 536
players 318, 878, 880
polychords 318, 323, 887
popover 320
position 872, 878, 880, 881, 887
quality 318, 872, 886
regions. See chord symbol regions
roots 318, 320, 872, 886
selecting 421, 425, 427–429
separators 877, 887
showing 318, 326, 878–880, 882, 886, 897
signposts 450, 871, 882
size 433, 877, 887, 892
slash regions 878, 882, 1261
spacing 880, 881
spelling 157, 158, 163–166, 872, 884, 885
staff-relative placement 882
staves 318, 878, 880
suspensions 322
systems 880, 881
track. See chords track
transposing 158, 161–166, 178, 469, 470, 871, 883
transposing instruments 158, 178, 884, 885
types 320, 872
viewing options 883
voicing 318, 536

Chord Symbols Options dialog 872
chords 251, 871

accidentals 795, 797
arpeggio signs 1111
auditioning 216
bracketed noteheads 1066, 1067, 1070
brackets 889
building 258, 488
caret 218, 223, 251
collision avoidance 795, 797
dense 796
exploding 235
figured bass 395, 397, 957, 969
fingerings 985
grace notes 249–251
guitar bends 1122, 1125
identifying 38, 326
inputting 196, 235, 251, 258, 488
inverting 478
lines 235, 347–350, 386, 387
moving 478, 480
parentheses 889
pitch mappings 482
playback 535, 540, 545, 548, 1260
post-bends 1125
register selection 226
reversing 478. See also retrograde
rolled. See arpeggio signs
rotating 480
scale mapping 484
selecting 421, 422
stem directions 1075. See also voices
symbols. See chord symbols. See also chord 
diagrams

chords (continued)
tablature 227, 242, 1067, 1069
ties 247, 1369
track. See chords track
transformations 477
velocity 692. See also Velocity editor
vibrato bar dives and returns 1127
voices 232, 1438

chords track 535
hiding 536
showing 536

Chorus 722, 728
chorus lyrics 1029

changing lines to 1048
changing lyrics to 1030
paragraph styles 1041
popover 394

chromatic glissando 1115
playback 1119, 1120

church
panning. See stage templates
reverb. See space templates

circa
tempo marks 1343

circle
bar number enclosures 827
chord symbols 872
fingerings 977
hairpins. See niente
harmonics 1085, 1087
noteheads 1053, 1058, 1421, 1424, 1425
pitches 480, 481, 491
playing techniques 371, 1180
rhythms 480, 481, 491
string indicators 993
tapping 1138

clarinet. See instruments. See also transposing 
instruments
clash cymbals. See unpitched percussion
Classical

ornaments 345
trills 1104, 1107

classical guitar. See fretted instruments
clefs 907

bar numbers 832
cautionary 907
changing 112, 332, 333
colors 56
deleting 455
filter 429
gaps 907, 909
grace notes 908
guitar 132, 913
hiding 332, 333, 910, 911
Indian drum 333, 1436
inputting 329–333
instrument changes 138
instruments 112
key signatures 1022
layouts 910
moving 138, 461, 464, 908, 909
multi-bar rests 1280, 1281
octave indicators 330, 912, 913
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clefs (continued)
overrides 112, 332, 333
panel 333
popover 329, 330, 332
position 213, 908
restorative 332, 333
showing 910, 911
signposts 450, 910
spacing 909
ties 1371
tokens 657
transposing instruments 112
transposition 330, 910, 912, 913
types 330

Clefs panel 331, 333
click 267, 555

count-in 264, 268
disabling 540
enabling 540
MIDI recording 264
mixer 717, 718
playback 267, 532, 533, 540
reverb 739, 741
settings 267
sound 267, 532, 533
volume 725

clipping 725
closing. See opening
CMYK processing 596
coda 1236

barlines 820
brackets 820
font 1237
gap 513, 1241, 1242, 1327
hiding 1240
indent 513, 1241, 1242, 1327
inputting 413, 414
mid-system gap 1236, 1241, 1242
multiple 1237
sections 1236
showing 1240
size 1237

codec 189
codes 655

time 1226
col legno. See playing techniques
collision avoidance

accidentals 795–797
articulations 808
bar numbers 832
barlines 888, 930
chord symbols 888
clefs 832
dynamics 922, 924, 930
flow headings 614
galley view 623
lines 1199
margins 614
notehead brackets 1072
playing techniques 1185
slurs 1287, 1295
staves 603, 604, 621, 623, 624
text 1357

collision avoidance (continued)
ties 1364, 1377
titles 614

colon
dynamics 309, 928
tuplets 1416

colored regions 531, 575, 883, 1247, 1261, 1265
Dynamics editor 694
exporting 597
hiding 437
MIDI CC editor 701
MIDI Pitch Bend editor 700
percussion editor 679
piano roll editor 678
Playing Techniques editor 690
printing 597
Tempo editor 706, 708
tempo track 532
Transform tool 713

colors 52
accidentals 54, 795
background 54, 55
bar numbers 56
bar repeats 56, 1247
breath marks 56
caesuras 56
caret 54
cautionary accidentals 54, 795
chord diagrams 903, 904
chord symbols 56, 875, 883
clefs 56
comments 56
dark theme 52
dynamics 56
exporting 586
fermatas 56
graphics 586, 596
holds 56
instrument change labels 142
instrument names 184, 1318
instruments 531, 678, 679, 732, 733, 736
inverting 55
light theme 52
lines 56
lyrics 56, 1041
markers 56
MIDI trigger regions 575
mixer 721
monochrome 596
muted 549
note ranges 54, 1064
noteheads 56, 1057
notes 54, 56, 549, 1439
ornaments 56
pages 53, 55
pedal lines 56
piano roll editor 678, 679
Play mode 531
playhead 54
playing techniques 56
rehearsal marks 56, 1219
resetting 53, 54, 56
rests 56, 1275
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colors (continued)
rhythmic grid 54
slash regions 1261, 1265
slurs 56
staff labels 184, 1318
stage templates 732, 733, 736
tablature 54, 56, 1064, 1330, 1332
tempo marks 56
text 56, 389, 756, 759
time signatures 56
tracks 531, 678, 679
trills 56
tuplets 56
voices 54, 531, 678, 679, 1438, 1439
windows 52

columns
accidentals 795, 797
figured bass 957
lines 1199
markers 402
missing fonts 73
videos 402
voices 1440, 1442

combinations
part layouts 176
playback techniques 773, 777, 786
tremolos 786

combined dynamics. See dynamics
combining. See consolidation
comma

breath marks. See breath marks
commands

jump bar 65, 67
key commands 60, 63
MIDI 60, 63

Comment dialog 495
comments 450, 494, 1066

adding 497, 498
authors 494, 499
bar numbers 496, 497, 499
changing 499
colors 56
date 496, 499
deleting 455, 496
dialog 495
display 496, 499
exporting 500, 585, 597
flows 496, 499
hiding 501
initials 494, 499
instruments 496, 499
list 496, 499
order 500
panel 496, 499
printing 500, 581, 597
replying 498
showing 501
sorting 500

common practice
accidental duration rule 800

common practice accidental duration rule 801
common time. See time signatures

components
articulations 805
chord diagrams 895
chord symbols 320, 872, 875
lines 1196
playing technique continuation lines 1188
tempo marks 1339

composer 69, 75, 998
adding 998
bold 75, 756
exporting 102
first pages 648, 997
flow headings 651–653
fonts 756, 998
italics 75, 756
tokens 658

compound figured bass intervals 395, 397, 969
compound time signatures 1382

beam grouping 840, 1262
inputting 283, 285, 287, 288
note grouping 860, 1262
rhythm slashes 1262

compressed MusicXML 83, 84
Compressor 722, 728, 744
con sordino. See playing techniques
concert band. See bands. See also project templates
concert hall

panning. See stage templates
reverb. See space templates

concert pitch 178
clefs 330, 910, 912
exporting 585
input pitch 215
instrument transpositions 1314
layouts 174, 178, 581, 585, 656, 1000
printing 581
staff labels 1309, 1314
status bar 38
tokens 656, 1000
viewing 178

concertina dragging 627
concertos

cadenzas 452, 453, 1382
movements. See flows
soloists 127

condensing 603–605, 643, 1329
divisi 1320
extra staves 1323
fonts 756, 1318, 1320
ossia staves 1323
paragraph styles 1318, 1320
percussion. See percussion kits
signposts 450
staff labels 1318, 1320

conditions
expression maps 768, 777

conductor score. See condensing. See also layouts
configurations

accidentals 797, 800, 1020
endpoints 567, 571–573
Key Editor 675, 715, 716
key signatures 1020
playback 58, 558
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connecting. See linking
consecutive

dynamics 313, 315, 940, 945, 949, 954
guitar bends 1122, 1127
MIDI CC 713–715
notes 224, 472, 477, 713–715
rests 1279
velocity 713–715

consolidation 643
aggregate time signatures 1394
bar repeats 1279
bars 455
breath marks 1013
caesuras 1013
fermatas 1013–1015
flows 78
notes 254, 466, 1440
part layouts 176
players 168, 176, 643
rests 747, 1272–1274, 1278, 1279
rhythm dots 1062
staff labels 150, 151, 1319, 1320
staves. See condensing
stems 143, 1435, 1436, 1438
time signatures 1394
voices 143, 466, 643, 1435, 1436, 1438, 1440, 1442, 
1443

constant points 697, 704, 706
inputting 696, 703, 708

contents
bars 812
front matter 997
lines 1188, 1196
playing techniques 1188
table 997
tempo marks 1338, 1340, 1345

continuation caps 1196
continuation lines 1186, 1194

angles 1163
caps 1191
duration 1187
dynamics 309, 921, 926, 937, 939, 940
figured bass 961
hiding 1347
inputting 367, 372, 374
pedal lines 1161, 1163, 1171, 1173–1175, 1177, 
1178
playing techniques 1186, 1189–1192
slurs across breaks 1287
tempo marks 1337, 1345, 1347
thickness 1175, 1349

continuation signs 1176
lines 1196
parentheses 1175
playing technique continuation lines 1188
text 1177

continuous
bar counts 1248, 1255
beams across staves 851
controller 775
hairpins 940
rehearsal marks 1217
view 40, 50, 667, 678, 679

contrabass. See instruments
contracting. See expanding
contrapuntal. See counterpoint
control change actions 767, 775
control points

handles 1288, 1306, 1379
slurs 1300, 1301
ties 1374, 1375, 1379

controllers
expression maps 761
MIDI. See MIDI controllers

conventions
accidentals 792, 800, 1020, 1028
arpeggio signs 1111
breath marks 1013
caesuras 1013
cues 920
dynamics 922
ensembles 77
fermatas 1013
fingerings 971
grace notes 1002
harp pedaling 1158
key signatures 1020, 1022
lyrics 1035
middle C 51
ornaments 1091
pauses 1012
pedal lines 1167
playing techniques 1184
rehearsal marks 1216
rests 1271
tempo marks 1336
tremolos 1400
trills 1091
voices 1440

converting
grace notes into normal notes 1004
layouts to graphics files 585
notes into grace notes 1004
notes into tuplets 1410
PDF 585
tuplets into normal notes 1410

copies
printing multiple 581

Copy Staff Spacing dialog 628
copying 455, 457–459

articulations 805
barlines 172
beams 854
chord diagram shapes 902
Chord mode 254
chord symbols 425, 878–881
dynamics 457, 460, 676, 699, 951
flows 78, 172
frames 647, 648
Insert mode 451
instruments 125
lyrics 1032
MIDI 460, 676, 705
notes 457–459, 686, 805, 854
page formatting 645
page templates 647, 648
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copying (continued)
part formatting 643
pitches 482, 491
players 125
playing techniques 1189
points 676
properties 646
slurs 460, 805
staff spacing 628
system objects 425, 1327
tempo marks 457, 676
text 58, 457
tremolos 854

copyright 75, 999
adding 999
bold 75, 756
exporting 102
first pages 648
fonts 756, 999
italics 75, 756
tokens 658

cor anglais. See instruments. See also transposing 
instruments
corners

beaming 855
crop marks 597

count-in
duration 264, 268
metronome click 264, 268

counterpart layout 43
counterpoint 246

bar rests 246, 1278
MIDI import 88
MIDI recording 264
playback 956
voices 232, 1438

counts 1247
bar numbers 828, 838, 1386
bar repeats 1247–1249
barlines 1242
bars 419, 1247, 1253, 1254, 1256, 1265
frames 1226
hiding 1243, 1249, 1256, 1267
lyrics 1043
moving 514, 1243, 1257, 1267
multi-bar rests 1279
numbered bar regions 419, 1254–1256
page numbers 659
pick-up bars 1386
placement 1257, 1267
ranges 828, 1254, 1256
repeats 551, 838, 1230, 1242, 1243
rhythm slashes 1265–1267
staff-relative placement 1257, 1267
statistics 106
timecodes 1226

courtesy. See cautionary
cowbell. See unpitched percussion. See also playing 
technique-specific noteheads
crash cymbals. See unpitched percussion
creating. See inputting
crescendo. See gradual dynamics

crop marks 597
exporting 585
printing 581

cross noteheads 1054, 1058
dead notes 1141
percussion 1421, 1424, 1425
resetting 1059

cross stick. See unpitched percussion. See also playing 
technique-specific noteheads
cross-staff

arpeggio signs 347, 348
beams 851–854, 1078
lines 386, 387
overlapping notes 1440
resetting 854
slurs 273, 430, 461, 464, 1287, 1294
spacing 852
stems 851, 854, 1078
ties 247, 1371
tremolos 851, 854

cross-voice
arpeggio signs 347, 348
lines 386, 387
slurs 273, 430, 461, 464, 1294
ties 247, 1371

crosshairs 517
crotchets. See quarter notes
crushed notes. See grace notes
CSV files 102
Cubase

expression maps 761, 779
instrument names 1310
staff labels 1310

cue labels
moving 514
staff-relative placement 434

cues 920
bar rests 747, 1274
deleting 455
instrument changes 138
moving 464
rests 747
signposts 450
spacing 507
staves 618

cup mute. See playing techniques
Curlew mark. See fermatas
curly quotes 656, 659
cursor

caret 218
chord symbols 325
figured bass 400
fingerings 274
lyrics 395, 1043
text 655

curvature direction
grace notes 1285
guitar bends 434
guitar pre-bends 1129
notehead brackets 1071, 1072
slurs 1285, 1292, 1293, 1306
ties 1368, 1369, 1377
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curve
dynamics 954

curved arpeggio signs 1108
duration 1112, 1113
inputting 343
playback 1112, 1113
popover 343

custom
barline joins 824
chord diagrams 903
chord symbols 872, 873, 875
endpoint configurations 571, 572
ensembles 114, 129
key commands 60, 63, 67
layouts 121
markers 401, 1223
page size 593
paper size 593
percussion techniques 1421, 1423–1425
playback templates 558, 561, 564
player order 126
repeat endings 1233
repeat markers 1238
score layouts. See layouts
size 433, 602, 617
staff order 126
staff size 620
tempo text 1338
trill speeds 1106
tuning 154, 156, 157, 895, 898
zoom levels 444

Custom Centered Beam dialog 849
custom notehead sets

percussion 1421, 1423–1425
custom playing techniques

percussion 1421, 1423–1425
playback 787

custom score layouts. See layouts
Custom Staff Size dialog 620
custom text 1351

dynamics 932
instrument changes 140
markers 402, 1223
percussion legends 1433
repeat endings 1233
repeat markers 1238
repeats 1242

cut common time 1382
appearance 1393
beat grouping 863

cutting
bars 810–812
beats 452, 810
notes 261
selections 457, 501, 810–812
slash regions 1262
tie chains 261, 1373

D
da capo

al coda 1236
al fine 1236

da capo (continued)
al segno 1236
font 1237
hiding 1240
inputting 413, 414
showing 1240
size 1237
word wrapping 1239

dal segno 1236
hiding 1240
showing 1240

damping. See playing techniques
dangling ties. See laissez vibrer ties
dark theme 52, 55
dashed

barlines 283, 817–819, 1382, 1394. See also 
aggregate time signatures
figured bass 961
frames 651, 898
guitar bend hold lines 1129
hairpins 939
jazz articulations 1148
lines. See dashed lines
lyrics 392, 395, 1045, 1046
octave lines 915
pedal continuation lines 1174
pedal lines 1173
slurs 1289–1291
staff labels 1315
string indicator lines 993, 1187
tempo marks 1345, 1347, 1348
ties 1366–1368
vibrato bar lines 363, 364, 1137

dashed lines 514
attachment 437, 461, 514
between staves 445
crosshairs 517
Engrave mode 509
lines 385, 1194
lyrics 392, 1045, 1046
octave lines 915
tempo marks 1345, 1347

data
expression maps 762
library 745

date and time 660
annotations 597
auto-saved projects 104
comments 494, 496, 499, 500
exporting 585
language 58
printing 581
tokens 58, 660

deactivating
caret 222
chord input 251
double-click mode switching 43, 195
highlights 437
Insert mode 237
mouse editing 212
mouse input 212
muted tracks 548, 717–719
note input 224, 227
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deactivating (continued)
playback 542
player sorting 125
playhead following 539
signposts 437, 450
soloed tracks 548, 717–719

dead notes 1141
decimal places

metronome marks 298, 299, 1342
decorations. See ornaments
decrescendo. See gradual dynamics
dedications 75, 997

exporting 102
tokens 658

default flow headings 647, 651
default page templates 647, 648

composer 997
lyricist 997
title 997
tokens 997

default settings 18, 27, 58, 663, 745, 747, 749
accidentals 214
articulations 214
barlines 817, 818
beam grouping 747, 844
chord symbols 872, 877
dialogs 27
dynamics 460
file names 588
flow headings 651
flows 747
font styles 760
hand tool 40
instrument names 57, 183, 184, 187
key commands 26, 60, 63
layouts 180, 632, 745
library 745
marquee tool 40
MIDI 460
mouse input 211
notations input 213, 317
note grouping 747
note input options 214
note spacing 507, 508
noteheads 1059
overlapping notes 747
panning 735
playback 558, 564, 725, 735, 742, 744, 749
playback templates 559
playing techniques 1186
project templates 77
resetting 745, 747, 749
reverb 742, 744
rhythm dots 214
selection tools 40
slurs 460
space templates 738, 744
staff grouping 866
staff labels 57, 183, 184, 187
staff spacing 603, 621
stage templates 731
tablature strings 224, 227
text 754, 756, 760, 1357

default settings (continued)
voice order 747
volume 725

delay
expression maps 769
glissando line playback 1121
inserts 722, 728
instrument changes 138

deleting 455, 502
accidentals 792
articulations 805
auto-saved projects 103, 104
bar number changes 836
barlines 820, 824
bars 301, 452, 810–812
beams 843
beats 302, 452, 810, 812
borders 756, 1001, 1358
braces 820
brackets 793, 801, 820, 890, 929, 960, 963, 1067
capos 161, 163
centered beams 850
chord diagrams 895, 897, 900
chord symbols 878
clefs 455, 910, 911
comments 496
counts 1243
dynamics 677
editors 675
effects 729
effects channels 727
empty pages 25
endpoints 571, 573
fermatas 1014
files 69
fingering slides 988
fingerings 978
flow headings 611
flow numbers 652, 653
flows 174, 177
frame breaks 632, 639
frames 611
FX channels 727
gaps between notes 259
grace notes 1004
groups from percussion kits 152
guitar post-bends 1131
guitar pre-bends 1131
guitar techniques 1143
indents 1328
Insert mode 451
inserts 729
instrument filters 449
instrument names 1310, 1312
instrument transpositions 184, 1315
instruments 127, 136, 147
jazz articulations 1149
jump bar aliases 68
key commands 64, 65
Key Editor configurations 716
layouts 180
markers 402
MIDI points 677
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deleting (continued)
niente markings 948
note spacing changes 512
notehead brackets 1067
notes 452, 687, 810, 1060, 1065
overlapping notes 259
page numbers 1150
page template overrides 651
pages 651
parentheses 793, 801, 890, 929, 960, 963, 1067
pedal level changes 1167
pedal lines 1167
pick-up bars 452
pitch mappings 483
playback overrides 689
playback techniques 779, 788
players 127, 169, 170, 172, 176
projects 69
rests 259, 810, 1276, 1277
retakes 1167
rhythm dots 1060, 1062, 1065
rhythmic feel change 555
scoops 1143
staff labels 1310, 1312
staff spacing changes 626
staves 605, 606
stem direction changes 1078
stop positions 454
string indicators 994
strings 154
system breaks 632, 636
system indents 1328
tapping 1143
templates 716
tempo marks 677
ties 466, 860, 861, 863, 1373, 1435
time 451, 452, 810–812
time signatures 455
titles 611
tre corde 1178
tremolos 1403
trill intervals 1101
tuplets 1410
velocity changes 693
videos 193
voices 1444

delta 711, 712, 714
demo projects 69
denominators

styles 1389, 1391
time signatures 1381

dense chords
accidental stacking 796

depressed keys 206
depth

audio 726
nested slurs 1295
nested tuplets 1408

deselecting. See selecting
design

arrows 1190, 1191, 1194, 1207
fingerings 977
grace note slashes 1006

design (continued)
lines 1190, 1191, 1194, 1206, 1207
noteheads 1053, 1057–1059
slurs 1289, 1290, 1292
time signatures 1397, 1398

designation
strings. See string indicators

destination
exporting files 587
instruments 920
notes 482–485, 492, 986

détaché. See playing techniques. See also articulations
detecting

grace notes 93
inversions 327
strings 383
tuplets 93

detuned fretted instruments 157, 161, 162
devices

audio 58, 268, 269, 545
diagonal

accidental stacking 795
chord symbols 872, 887
lines 386, 859, 1115, 1145

diagrams
chords. See chord diagrams
harp pedaling. See harp pedaling. See also harp 
pedal diagrams

dialogs 27
diamond noteheads 1054, 1055, 1058, 1180

accidentals 1084
harmonics 1082, 1085, 1087, 1089
percussion 1421, 1424, 1425
resetting 1059

diddle 224, 259, 1399, 1408
playback 1405

dimensions
frames 38
page size 593
paper size 593

diminished. See augmented. See also intervals
diminuendo. See gradual dynamics
dips 1137

inputting 362
intervals 1142
moving 514
popover 343

direction
arpeggio signs 1108, 1109
audio. See panning
beams 845, 846, 855
fanned beams 859
glissando lines 1059
grace notes 1004
gradual dynamics 937, 945, 946, 954
guitar bends 434
guitar pre-bends 1129
hairpins 937, 945, 946
lines 1207
panning 726
paper orientation 593
partial beams 855
playback techniques 787, 788
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direction (continued)
rhythm slashes 1268
slur curvature 1292, 1293
stems 1074, 1076–1078
string shift indicators 991, 1059
tie curvature 1368, 1369
transposing 469, 470

disabling. See enabling. See also deactivating
disclosure arrows 42

Expression Maps dialog 762
Properties panel 38

disconnecting. See unlinking
display options 29, 40

date 660
frames 598, 662
image resolution 595
Key Editor 667
language 57
layouts 33
music area 34, 41, 50
pages 598
panels 37, 44
percussion editor 679
piano roll 667, 678
playback 558
print preview 36
project window 33
tabs 45
time 32, 558, 660
transport 32
zones 37

distance
bar numbers 832
beams 858
braces 868
brackets 868, 870
breath marks 1013
chord diagrams 898
fermatas 1013
flow headings 615
hyphens 1045, 1046
instrument change labels 138
instruments 730, 732, 733, 736, 738, 739, 741, 742
lyrics 1035, 1039, 1045, 1046, 1357
margins 601, 614–616
noteheads 852
page edges 601, 616
panning 730, 732, 733, 736, 738, 739, 741, 742
reverb 730, 732, 733, 736, 738, 739, 741, 742
staff labels 1311
staves. See staff spacing
stems 852
system indents 1311, 1328
text borders 756, 1360

Distortion 722, 728
distribution

bars per system 629
beats in bars 861
dynamics 939
staves per frame 604
systems per frame 630
values 710
velocity 710

dives 1122, 1127, 1137
handles 1133, 1135
inputting 355, 356, 358, 359
moving 514
popover 343
pre-dives. See guitar pre-bends
vibrato bar. See vibrato bar. See also guitar bends

dividers. See system dividers
dividing. See splitting
divisi 643, 1329

brackets 865, 866, 868, 869, 1194, 1329
condensing 643, 1320, 1329
fonts 1318
hiding empty staves 605–607
hiding staff labels 1310
lengthening 461, 464
moving 461, 464
paragraph styles 1318
playback 545, 546, 569
shortening 461, 464
signposts 450
staff labels 1310, 1320
staff size 618
staff spacing 604
staves 605–607

DJ-EQ 722, 728
djembe. See unpitched percussion
documentation 15, 69
doits. See jazz articulations
dolce. See dynamic modifiers
dorian

chord symbols 323, 492, 885
scales 484, 485

DoricoBeep 267, 522, 532
sound 533

dots
barlines. See repeat barlines
chord diagrams 894, 895, 903, 904
guitar tapping 1138
Keyboard panel 206
rhythm. See rhythm dots. See also dotted notes

dotted
beat units 296
dynamics 921
hairpins 939
lines. See dotted lines
noteheads 1056
notes. See dotted notes
octave lines 915
rests 196, 747
slurs 1289–1291
tempo marks 1345, 1347
ties 1366–1368
tremolos 414, 416

dotted lines 514
attachment 437, 461, 514
crosshairs 517
lines 1194
octave lines 915
stop positions 454
tempo marks 293, 1345, 1347
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dotted notes 230, 860
consolidation 1062, 1440
double 230
forcing 262, 861
inputting 196, 230
moving dots 1063
note grouping 23, 860, 861, 863, 1262
rhythm slashes 1262
swing playback 552
tempo equations 1349
tremolos 414, 416
triple 230
voices 1440

double 666
accidentals 244, 279, 470, 473, 475, 476, 802
barlines 303, 306, 307, 816–819
bass. See instruments. See also transposing 
instruments
cadence. See ornaments
dotted notes 23, 230, 860
note durations 259
octaves 487
slashes 1324, 1399
stems 798, 1438. See also voices
values 666
whole notes 14, 200, 224, 227, 232, 235, 237, 238, 
242, 251, 259, 261

doubling instruments 123
adding 133
inputting notes 224, 227
instrument changes. See instrument changes
moving 135
showing staves 50

down arpeggio signs. See arpeggio signs
down bow. See playing techniques
down-stem voices. See voices
downloads 69
dpi 595
draft staves. See sketch staves
dragging 40, 212, 442, 468, 542, 676. See also drawing
drags. See grace notes
drawing 40, 212, 442, 468, 542, 669, 676

crosshairs 517
dynamics 696
highlights 258, 457, 461, 464, 468
marquee selections 676, 715
MIDI 703
mouse editing 212
notes 681. See also note input
rhythmic grid 217, 258, 457, 461, 464, 468
scrubbing 542
tempo 532, 706
velocity 692

drop frame timecodes 1226
drops. See jazz articulations
drum editor. See percussion editor
drum kits. See percussion kits. See also drum sets
Drum Pads panel 209

key commands 44
drum rolls. See tremolos
drum sets 142, 143, 1419

adding 133
caret 238

drum sets (continued)
defining kits as 148
exporting 152
filtering instruments 143
hits 1258, 1261, 1263
importing 153
inputting notes 94, 238, 240, 682
laissez vibrer ties 1372
naming 143
noteheads 1425
patterns 94
rhythm slashes 1258, 1261, 1263
setting up 143, 240
stem direction 148
voices 148, 1435

dry
reverb 729

DualFilter 722, 728
duplets. See tuplets
duplex printing 581, 592

booklets 591
duplicating

character styles 760
copying. See copying
dynamics 457, 699
expression maps 776
flows 172
items 457–459
key signatures 1024
MIDI 676, 705
notes 457–459, 686
paragraph styles 758
percussion maps 784
pitches 482, 491
playback templates 564
players 125
playing techniques 1189
points 676, 699, 705
rehearsal marks 1327
repeat endings 1327
switches 777
tempo marks 457, 676, 1327
time signatures 1384

duration 14, 430, 1187, 1271
accidentals 800, 801
arpeggio signs 1112, 1113
articulations 804, 809
audio 100, 101
bars 24, 452, 810
changing 259, 262, 430, 861
count-in for MIDI recording 268
display 32, 555, 656, 659
dynamics 317, 430, 937, 945, 949, 951
exporting 106, 107, 656, 659
fermatas 432
figured bass 430, 961, 962, 966
flows 545, 659, 810–812
forcing 262, 861
glissando lines 1120, 1121
grace notes 1009
horizontal lines 1203
input settings 213, 317
jazz articulations 1147
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duration (continued)
lines. See duration lines
locking 472
notated 687
notes 24, 200, 259, 261, 681, 682, 684, 687
pedal lines 1178
percussion 682
played 687
playing techniques 367, 372, 374, 430, 1187, 1192
pre-roll 544
project 656
repeat endings 1232
rests 245, 259, 262, 861, 1271
slurs 1308
statistics 106
terminology 14
tokens 656, 659
tremolos 1405, 1406
vibrato bar lines 1137

duration before pitch note input 224
duration lines 1186, 1194

appearance 1190
figured bass 961, 962, 966
handles 1184, 1187, 1188
hiding 430, 1187, 1189, 1190
inputting 367, 372, 374
playing techniques 1187, 1191
showing 430, 1187, 1189, 1190
string indicators 381, 383, 993, 1186

dyads. See chords. See also chord symbols
dynamic curve 954
dynamic glyphs 921

font styles 953
dynamic levels 309, 312, 313, 315, 926, 954

changing 698, 926
playback 694, 954, 955
resetting 677, 694, 698, 954–956

dynamic modifiers 921, 932, 1335, 1345
appearance 934
centered 935
font styles 953
hairpins 935
inputting 309, 312, 313, 315, 933
moving 936
poco a poco 942
possibile 934
showing 927
subito 934

dynamics 921, 932
abbreviating 934, 943
alignment 923–925, 949–952
appearance 929
articulations 954
backgrounds 930
bar repeats 1246
barlines 924–926, 930
brackets 929
changing 432, 698, 926
colors 56
combined 921
continuation lines 921, 937
continuous hairpins 940
conventions 922

dynamics (continued)
copying 457, 460, 676, 699, 951
crescendo. See gradual dynamics
crosshairs 517
deleting 455
diminuendo. See gradual dynamics
duration 317
dynamic curve 954
editing 926
editor. See Dynamics editor. See also Velocity 
editor
endpoint positions 925
erased backgrounds 930, 931
exporting 102
expression maps 769
expressive text. See dynamic modifiers
filters 429
flared hairpins 941, 942
font styles 953
force 921
gradual. See gradual dynamics
grand staff instruments 313, 315, 931
grouping 949, 950
hairpins. See gradual dynamics
handles 430, 937, 938, 945
hiding 927–929, 934
humanize 694, 954, 955
hyphens 309, 928, 939
immediate 921
inputting 309, 312, 313, 315, 696, 699
intensity 432, 698, 926
length 430, 514, 698, 934, 938
levels. See dynamic levels
linking 460, 951, 952
messa di voce. See messa di voce
modifiers. See dynamic modifiers
moving 461, 464, 478, 480, 514, 698, 922, 924, 934, 
936, 938, 945, 949–952
muting in playback 215, 548
niente. See niente
non-sustaining instruments 953
overriding 696, 699
padding 931
panel 315
parentheses 929
percussion kits 1427
phrases 309, 313, 949, 954–956
placement 922
playback 215, 545, 546, 549, 694, 701, 769, 787, 
788, 931, 953–955
poco a poco 935, 942
popover 309, 313
position 922, 923
possibile 934
repeats 549
reversing 478. See also retrograde
rfz 929
rotating 480
selecting 423, 429
separators 309, 928
sfz 929
showing 927
signposts 450, 927
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dynamics (continued)
size 433, 953
spacing 944
staff-relative placement 434
subito 934
sustaining instruments 953
swells. See messa di voce
syllables 939
tempo marks 1338
text 939, 953
ties 313, 315, 461, 922
tracks. See Dynamics editor. See also Velocity 
editor
types 309, 921
ungrouping 950
unlinking 460, 952
velocity 691, 692, 926, 954, 955
voice-specific 313, 315, 694, 696, 931
volume 926, 953–955

Dynamics editor 309, 691, 694, 921, 951
adding 675
closing 675
constant points 697
copying points 676
deleting points 677
height 673, 674
hiding 694
inputting points 696
linear points 697
moving points 698
selecting points 676
showing 694

dynamics lanes. See Dynamics editor
Dynamics panel 312, 315

E
East Asian elision slurs 1050
edges

frames 651, 654
margins 614
pages 614

Edit Chord Diagram dialog 904
Edit Chord Symbol Appearance dialog 873
Edit Chord Symbol Component dialog 875
Edit Endpoint Configurations dialog 573
Edit Flow Heading dialog 653
Edit Font Styles dialog 754
Edit Instrument Names dialog 184
Edit Percussion Kit dialog 143
Edit Playback Techniques dialog 788
Edit Space Template dialog 741
Edit Stage Template dialog 733
editing 210, 430, 432

area 143, 1428
flow headings 652, 653
handles 516
inputting vs. editing 210
items 432, 516, 663
lyric text 1043, 1044
mouse editing 212
mouse input 211
moving. See moving

editing (continued)
note durations 259, 430
notes 196
redoing 438
rhythmic grid 217
undoing 438

editorial
accidentals 794
chord symbols 889, 890
dynamics 929
figured bass 960, 963
notes 1066, 1067
slurs 1289, 1290
ties 1366

editors 667
adding 675, 716
closing 675
configurations 715, 716
drum. See percussion editor
dynamics. See Dynamics editor
histogram. See Histogram tool
Key Editor. See Key Editor
MIDI CC. See MIDI CC editor. See also MIDI Pitch 
Bend editor
percussion. See percussion editor
piano roll. See piano roll editor
pitch bends. See MIDI Pitch Bend editor. See also 
MIDI CC editor
playing techniques. See Playing Techniques editor
saving 715
scrolling 674
templates 715, 716
tempo. See Tempo editor
text 389
velocity. See Velocity editor

EDO 1028
effects channels. See FX channels
eighth notes 14, 200, 224, 259

beaming 841, 861
beats 302
chords 251
glissando lines 1121
grace notes 249
hiding 1060, 1079
Insert mode 237
metronome marks 294
percussion 238, 682
pick-up bars 285, 289, 291
playback 749, 769
quantization 93
rests 245, 1271
rhythm dots 230, 860, 861, 863, 1062
rhythmic grid 217
showing 861, 1060, 1079
splitting notes 261, 861, 863
swing playback 295, 552
tablature 242
tempo equations 1349
ties 860, 861, 863
tremolos 414, 416, 1399
tuplets 254, 257
voices 232

elbowed beams. See centered beams
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electric guitar. See fretted instruments
electronics 112

glissando lines 1119
elision slurs 1050

inputting 392, 395
size 1050
width 1035

empty bars
deleting 812
hiding 605, 1277, 1279
inputting 304, 305
multi-bar rests 1279
rests. See bar rests
showing 605, 1277, 1279
statistics 106
width 813

empty pages
deleting 25, 651, 1352
staff spacing changes 624

empty staves 605
after flows 608
hiding 605–607, 621
showing 605–607, 621
system dividers 1324
tacets 640

empty voices 1444
enabling 222

auto-save 105
channel effects 722, 729
chord symbol playback 535
click during playback 540
double-click mode switching 43, 195
dynamics linking 460
EQ 722
independent voice playback 545, 546
inserts 729
instrument changes 137
instrument filters 448
line collision avoidance 1199
Markdown 75
MIDI copying 460
MIDI devices 270
MIDI import 87
MIDI thru 216
mouse editing 212
mouse input 212
partial harp pedaling 1159
playback 542
playhead following 539
plug-ins 527
sampled trills in playback 1106
slur collision avoidance 1287
slurs linking 460
swing playback 295, 553–555
system track 427
text collision avoidance 1357
tracks 87
VST instruments 527
Write mode double-click 43, 195

enclosures
bar numbers 827
fingerings 977
layout names 1001

enclosures (continued)
lines 1212
rehearsal marks 1216
text 756, 1212, 1358–1360

end barlines 818, 819
end repeat barlines 303, 816, 817

counts. See repeat counts
inputting 301, 303, 306, 307
playthroughs 549, 551, 1230, 1242
repeat endings 1230

endings
additional 410, 412
arpeggio signs 1108–1110
playthroughs 1230
repeat. See repeat endings

endpoint positions
arpeggio signs 1111
dynamics 925
lines 1197, 1203, 1205
octave lines 916, 917
pedal lines 1168
repeat endings 1234
slurs 808, 1284–1287, 1300–1302
staff lines 1285
ties 1374, 1377
trills 1092
tuplet brackets 1415

Endpoint Setup dialog 567
endpoints 567

changing 522, 569, 570
configurations 571, 572
custom 573
deleting 573
expression maps 522, 567, 570
glissando lines 1115, 1119
instruments 569
moving 430, 461, 514
notehead brackets 1071
percussion maps 522, 567, 570
plug-ins 558
renaming 573
saving 573
setup 567
voices 569

Engrave mode 19, 502
frame breaks 636
key commands 503
make into frame 638
make into system 635
moving items 514
note spacing 507
page breaks. See frame breaks
panels 37, 502, 504, 663
percentages 506
playhead 539
selecting items 421, 423, 424, 439, 503
staff spacing 620
switching 43, 502
system breaks 633
toolbox 503

engraving options
chord symbols 872
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engraving tools. See properties. See also default 
settings
enharmonic spelling

accidentals 245, 473, 475, 476
chord symbols 158, 872, 884, 885
key signatures 1025, 1027
MIDI 85, 264
modes 885
notes 245, 473, 475, 476
pitch mappings 482, 483, 492
respelling 206, 473, 475, 476

ensemble picker 114
ensembles 110, 128

adding 114, 128
brackets 865, 866, 1317
custom 114, 116, 129
divisi 1329
filters 446
groups. See player groups
language 114
player order 125
project templates 71, 77
saving 116, 129
staff grouping 866, 1317

entrance
instrument changes 138, 141, 142
labels 139, 141, 142

envelopes
dynamics 694, 698

EnvelopeShaper 722, 728
equal division of the octave 1028
equalization 722

changing 728
equations

tempo marks 295, 296, 1349
erased backgrounds 1361

bar numbers 827
bar repeats 1245
chord symbols 872, 888
dynamics 930, 931
fingerings 985
harp pedaling 1158
lines 1213, 1214
padding 756, 888, 931, 1158, 1183, 1214, 1360, 
1434
percussion legends 1433, 1434
playing techniques 1182, 1183
staff lines 888, 930, 975, 985, 1182, 1213, 1361, 
1433
string indicators 993
text 756, 1182, 1214, 1360, 1361

erasing. See deleting
espressivo. See dynamic modifiers
even staff spacing 604
event display. See track overview
events

markers 534
exchanging. See switching
excluding 121

chord diagrams 900
flows from layouts 121, 177
pauses from playback 1016
playback 548

excluding (continued)
players from flows 121, 172
players from layouts 121, 176
repeats from playback 550
slash voices from playback 1260
tempo changes from playback 543, 1016

exclusion groups
expression maps 762

exercises. See flows
expanding 430

barlines 822, 824
bars 304, 305, 452, 453
caesuras 1018
caret 222, 235
duration 259, 430, 1016, 1017
editors 673, 674
fermatas 1016, 1017
flow headings 614, 615
gaps 1017, 1018
grace notes 1004
instruments 732, 733, 736
items 430
Key Editor 673, 674
margins 601, 614–616
menus 42
notes 259, 1004, 1016, 1017, 1410
options 42
pages 600
panning 732, 733, 736
percussion grids 152
ranges 154
selections 422–424
slurs 1284
spacing 603, 604, 614
stage templates 732, 733, 736
staves 152, 603, 604, 623, 1428
strings 154
systems 603, 604, 612, 623
tuplets 1410

explicit rests 1271, 1272
colors 1275
deleting 1276
hiding 1276
implicit rests 1274
showing 1276

exploding 222, 235
chords 235
MIDI import 88
note input 222, 235

exponential hairpins. See flared hairpins
Export Audio dialog 101
Export File Names dialog 588
Export Flows dialog 80
Export MIDI dialog 96
Export MusicXML dialog 84
Export Tempo Track dialog 99
exporting 78

annotations 597
arrangements 590
audio 100, 101
borders 597
color graphics 596
comments 500, 597
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exporting (continued)
crop marks 597
date 597
dynamics 102
ensembles 77, 116
expression maps 780
file names 588
FLAC files 100, 101
flows 80, 583–585
font styles 754
fretted instrument tunings 157
key commands 60
Key Editor configurations 715
layouts 585
lyrics 1034
markers 102
MIDI 95, 96
monochrome graphics 596
MP3 files 100, 101
MusicXML files 83, 84, 1235
note colors 597
options 578
output format 585
page ranges 583, 584, 590
paragraph styles 756
path 587
PDF 585, 586
percussion kits 152
percussion maps 785
playback templates 566
players 80
playing techniques 102
PNG 585, 586
rehearsal marks 102
repeats 549
signposts 597
space templates 744
stage templates 737
statistics 107
stems 100, 101
SVG 585, 586
tempo marks 102
tempo tracks 98, 99
text 102
TIFF 585, 586
time 597
voice colors 597
watermarks 597
WAV files 100, 101

expression maps 761, 762
actions 767, 777
conditions 768, 777
creating 776, 777, 779
dialog 762, 773
dynamics 769
endpoints 522, 567, 570–572
exporting 780
file format 761, 780
filters 762
hiding playing techniques 1183
importing 779
legato 769
MIDI 955

expression maps (continued)
mutual exclusion groups 771, 776, 779
order 762
pitch 762, 776
playback techniques 762, 773, 777
playing techniques 787, 1183
resetting 772
switches 766, 774, 777
transpose 763, 767, 769
trills 1104
volume 955

Expression Maps dialog 762
expressive text. See dynamic modifiers
extended techniques

noteheads 1053
extending. See expanding
extension lines

lyrics 395, 1031, 1045
trills 1094–1096

extra staves 1323
condensing 1323
divisi. See divisi
hiding 605–607
moving 461, 464
ossia staves. See ossia staves
showing 605–607
signposts 450, 1323
ties 247

extracts. See flows

F
F clef. See clefs
facing pages 647, 648
factory default

playback templates 559
space templates 738
stage templates 731

faders 717, 718, 720
moving 725
resetting 725

fallback
music font styles 754
playback techniques 788
playback templates 561
reverb 739, 741

falls. See jazz articulations
false harmonic. See pinch harmonics
families

fonts 73, 760
instruments. See instrument families

fanned beams 859
direction 859

far send 739, 741
fast-forwarding 538, 542, 555
feathered beams. See fanned beams
feedback

comments. See comments
fermatas 1010, 1011

appearance 432
barlines 1015
bowing marks 1185
breath marks 1013
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fermatas (continued)
caesuras 1013
changing 1013
colors 56
crosshairs 517
Curlew marks 1013
deleting 455, 1014
duration 432, 1011, 1016, 1017
gradual tempo changes 1016
hiding 1014
inputting 336–339
linking 1013, 1014
moving 461, 514, 1015
multiple at same position 1013
number per staff 1014
overrides 1013
placement 1013
playback 1016, 1017
playing techniques 1185
position 1013
showing 1014
single staves 1013
stems 1013
types 432, 1011, 1013
voices 1014

figured bass 957, 961
accidentals 399
appearance 967, 969, 970
brackets 397, 960, 963
crosshairs 517
deleting 455
duration 430, 961, 962, 966
fixing 969
font 967, 968
global 395
grace notes 962, 966
handles 430, 961, 965, 966
hiding 958
hold lines 961
input options 969, 970
inputting 395, 397, 400
instruments 395
inverting 965
length 430, 514, 961, 962, 965, 966
local 395, 957
moving 461, 514, 961, 962, 965, 966
navigation during input 400
octaves 969
parentheses 397, 960, 963
pitches 468
placement 964, 965
players 395, 958
popover 397
position 964
resetting 970
resolutions 395, 397, 961, 966
rests 395, 957, 959, 967
rows 964
showing 395, 958
signposts 395, 450, 957, 958, 967
simplifying 969
size 968
slashes 397

figured bass (continued)
staff-relative placement 965
staves 395
suspensions 397, 961
transposing 469, 472
vertical position 958

file formats 595
audio 100, 101
backups 105
CSV 102
expression maps 761, 780
graphics files 595
MIDI 85
MusicXML 82
PDF 595
percussion maps 785
playback templates 558
videos 189

file names 588
ingredients 588
recipes 588
setting 588
tokens 656

files 78
different Dorico versions 73
exporting 78, 102, 585–587
importing 78
missing fonts 73
opening 72
videos 191

filled noteheads 1053
fills 238, 249, 250. See also grace notes
films. See videos
filters 429, 445

deselect 429
drums 143
dynamics 429
effects 722, 728, 729
ensembles 114, 128, 129
equalization 722, 728, 729
expression maps 762
frequencies 722, 728, 729
harp pedaling 429
Histogram tool 712
inserts 722, 728, 729
instruments 112, 114, 445. See also instrument 
filters
Key Editor 712
key switches 91
lyrics 429, 1034, 1035
mixer 722, 724, 728, 729
notes 429
options 745, 747, 749
percussion 143
percussion maps 781
pitch 429
properties 663
select 429
staves. See instrument filters
stem direction 429
tempo marks 429
text items 429
voices 429, 669, 712
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final barlines 303, 816–818
end of systems 819
inputting 301, 303, 306, 307, 818
number of times played 551, 1230
repeat barlines 819

final tempo 1344
Finale music fonts 751, 753
Find Tempo dialog 403

important markers 1225
finding. See searching
fine

barlines 819
d.c. al 1236
font 1237
hiding 1240
inputting 413, 414
sections 1236
showing 1240
size 1237

finger tapping. See tapping
fingering 971

alignment 973
appearance 906, 977, 979, 980
arpeggio signs 985
backgrounds 985
borders 977
brackets 274, 276, 980, 981, 983
cautionary 980
changing 901, 904, 973
chord diagrams 894, 895, 900, 901, 903, 904
circles 977
deleting 978
design 977
enclosures 977
erased backgrounds 985
font 906, 979, 980
font styles 980
fretted instruments 981. See also tapping
grace notes 976
hammer-ons. See hammer-ons
handles 973
hiding 900, 978, 981
horn branch indicators 990
inputting 274, 276
inside the staff 975
inverting 974
italics 980
moving 514, 900, 984
MusicXML import 992
parentheses 274, 276, 980, 981
placement 971, 975, 983, 984
popover 274, 276
position 900, 971
pull-offs. See hammer-ons
resetting 436
separators 989
showing 978, 981
size 906, 976, 979
slides. See fingering slides
slurs 976
staff-relative placement 974
string shift indicators 990, 991
strings 1059

fingering (continued)
substitution 972, 973
tapping. See tapping
thumb letter 900, 901, 904
types 276, 989
underlines 977
valved brass instruments 989

fingering slides 986
deleting 988
handles 986, 987
hiding 988
length 988
moving 514, 987
resetting 987
showing 988

finials. See caret. See also annotations
first and second endings. See repeat endings
first page templates 648

assigning to pages 610
formatting 648
page numbers 1151

first steps 69
first systems

indents 1328
page numbers 1151
staff labels 1310

fit to paper 594. See also staff size
five-line staff 1322

noteheads 1423, 1425
percussion kits 143, 1428, 1429
percussion legends 1430

fixed tempo mode 543
fixing

bars 629, 638
figured bass 969
frames 638
layouts 631
note durations 247, 259, 262, 861
pages 630, 638
systems 630, 635

FLAC files
exporting 100, 101

flageolet. See harmonics
flags

above staves. See signposts
hiding 841, 1079
markers. See markers
notes 841, 843, 844, 1074
resetting 844
showing 843, 1079
stems 841, 843, 844, 1074

flams. See grace notes. See also playing technique-
specific noteheads
Flanger 722, 728
flared hairpins 941

size 942
flat

accidentals. See accidentals
beams 847
slurs 1292

flipping 434, 1076, 1293, 1369. See also inverting
flips. See jazz ornaments
floor tom. See unpitched percussion
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flow cards 121
flow headings 75, 647, 648, 651–653, 756

changing 652, 653
chord diagrams 898, 900
default 651
dialog 653
editing 652, 653
exporting 102
flow titles 611
fonts 651
frames 651
gaps 614, 615, 898
hiding 69, 611
margins 614, 615, 898
moving 615, 624
page numbers 611, 1151
page templates 610
paragraph styles 651
removing overrides 651
resetting 652
showing 69, 611
size 756
titles 611

Flow Import Options dialog 79
flow names 75, 187, 188, 588

adding 997
flow numbers 173

changing 75, 173
deleting 652, 653
flow headings 651–653
hiding 652, 653
tokens 659

flow titles 75, 187, 188
adding 997
exporting 102

flows 20, 121, 171
accidental duration rules 800, 801
adding 171, 172, 501
adding players 172
adding to layouts 177
attacca 545
audio 100, 101
cards 120
chord diagrams 898, 900
comments 496, 499
composer 75, 998
copying 78, 172
copyright 75, 999
default settings 747
deleting 174
deleting empty bars 812
duplicating 172
duration 659, 810–812
end barlines 818
exporting 80, 583, 584
gaps 545
going to 440
headings. See flow headings
hiding 177
importing 78, 79, 82, 85
indents 513, 1327, 1328
instrument change labels 141
justification 612

flows (continued)
key signatures 1019
layouts 121
lyricist 75, 999
merging 78, 85, 609
MIDI import 85
moving 637, 638
multiple on pages 609
MusicXML files 84
names 75, 102, 187, 188, 588, 997
navigation 440
notation options 747
numbers. See flow numbers
opening 521
order 75, 173
page numbers 611, 659
page templates 610
panel 120
PDF files 585, 588
playback 544, 545, 569
players 121, 172
pre-roll 544
printing 583, 584
project templates 77
rehearsal marks 1217
removing from layouts 177
removing players 172
selecting 424
showing 177
sorting 173
splitting 501, 609
staff labels 1310
staff size 618
statistics 106
switching 521
system dividers 1324
systems 612
tacets 640, 641
tempo tracks 97
timecodes 120
titles 69, 75, 102, 187, 188, 611, 648, 651, 997
tokens 658, 659
transposing 469, 470
trimming 301, 306, 307, 812
videos 120, 189, 191
voices 569

Flows panel 109, 120
flute. See instruments
flutter-tongue. See playing techniques
flz. See playing techniques
folders

backups 105, 106
export path 587

follow playhead 539
scrubbing 542

follow tempo mode 543
font styles 753, 754, 756, 1352

bar numbers. See paragraph styles
bar repeats 1247, 1250
borders 756, 1001
changing 754, 760
character styles 759
chord diagrams 906
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font styles (continued)
chord symbols 877
composer 998
condensing 756, 1318, 1320
copyright 999
default 760
dialog 754
divisi 1318
dynamics 953
exporting 754
family 760
figured bass 967, 968
fingerings 906, 979, 980
flow headings 651, 756
glyphs 751, 753, 953
importing 754
instrument change labels 142
instrument names 1318
layout names 1001
line text 1209
lyricist 999
lyrics 1029, 1041, 1042, 1044
markers 1224
missing fonts 73
music 751, 753
notations 751, 753
notes 751, 753
numbered bar regions 1250, 1254
page numbers 1150
paragraph styles. See paragraph styles
PDF files 596
percussion kits 1319
player group labels 1317, 1318
playing techniques 1184
rehearsal marks. See paragraph styles
repeat markers 1237
resetting 754, 756
rhythm slashes 1250, 1265
size 754, 756
staff labels 1318, 1319
string indicators 979, 993
substitutes 754
SVG files 596
tablature 1334
tasto solo 968
tempo marks 1339
time signatures 1397, 1398
timecodes 1224
titles 648, 651, 756, 997
verse numbers 1041, 1042

force
articulations 804
duration. See force duration
dynamics 921
figured bass appearance 969, 970
frames 638
horizontal 1212, 1415
staff visibility 606
systems 635

force duration 196, 262
activating 196
inputting notes with 262
inputting rests with 245, 262

foreground colors 389, 756, 759
formats. See file formats
formatting 598

altered unisons 799
arpeggio signs 1109, 1110
bar numbers 826, 829–831
bar repeats 1250
caps 1191, 1207
chord diagrams 903, 906
chord symbols 873, 875
dynamics 939, 953
file names 588
flow headings 652, 653
fonts 754
frames 505, 643
front matter 997
glissando lines 1116
grace notes 1004
gradual dynamics 939
hairpins 939
handles 516
instrument change labels 139, 140, 142
layouts 601, 643, 645
lines 1190, 1191, 1206, 1207
lyrics 1041, 1042, 1044
markers 401, 1223, 1224
niente hairpins 948
notehead brackets 1071, 1072
noteheads 1058, 1059
page formatting 629, 647
page templates 647
pages 598, 643, 645, 997
pedal lines 1171–1173, 1175
player group labels 1317, 1318
repeat markers 1237
slurs 1290–1292, 1302, 1304
staff labels 184, 1318
systems 504, 643
tablature font 1334
tacets 640, 641
tempo marks 1347–1349
text 389, 392, 753, 756, 758–760, 1352, 1356
ties 1366–1368, 1375, 1376
time signatures 1398
timecodes 1224
tuplets 1410, 1416

Formatting panel 502, 504
forte. See dynamics
forum 69
forwards. See backwards
forzando. See dynamics
fps 193
fractions

arpeggio signs 1112, 1113
chord symbols 872
figured bass 397
fingerings 973
glissando lines 1121
guitar bends 1128
tempo marks 298, 299, 403, 1341, 1342
time signatures 283, 1381, 1382
tremolos 1405, 1406
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frame breaks 505, 598, 629, 636
bar repeats 637
barlines 633, 820
brackets 820
clefs 907
copying to other layouts 643, 645
deleting 632, 639
divisi 1329
first page on the left 609
glissando lines 1119
hiding staves 606
inserting 631, 637
key signatures 1024, 1025
lines 1215
moving 633
octave lines 918
playing techniques 1188
repeat endings 1233
signposts 450, 639
slurs 1287
staff labels 1312
staff size 618
staff spacing 603
staff visibility 606
ties 1370
time signatures 1384

frame chains
music. See music frame chains
properties 646, 663–665

frame fullness indicator 506
frame rates 193

changing 190, 194
dialog 190
drop frame timecodes 1226
non-drop frame timecodes 1226
transport window 555, 558

frames 654, 1358
bars 106
breaks 598, 636
chord diagrams 898, 900
constraints 614
copying 647, 648
dashed 651, 898
dimensions 38
duration 32, 555, 1226
editing 503
flow headings 611, 614, 615, 651
fullness 506
gaps 614–616
hiding 437
making from selection 638
margins 614, 616
measures 106
moving 614, 615
padding 598, 616
resetting 651
running headers 611
selecting 503
size 38
statistics 106
staves 604, 612
systems 604, 612, 630
timecodes 1226

frames (continued)
tokens 655
transport 32, 555

frequency
auto-save 105
bar numbers 826, 1255
bar repeat counts 1249
harmonics 1081
numbered bar region counts 1255
pitches in playback 545
slash region counts 1266
timecodes 1228
trills 1095

Fretboard panel 208
key commands 44

frets 153, 1330
adding 154, 242, 904
brackets. See bracketed noteheads
capos. See capos
changing 1332
chord diagrams. See chord diagrams
deleting 154, 904
font styles 906, 1334
intervals 154
note input 208, 242
notes out of range 1332
parentheses. See bracketed noteheads
position 154
size 906, 1334
spacing 154
starting number 895, 903, 904, 906
string number 1059

fretted instruments 153
adding 112, 133
arpeggio fingering 985
capos. See capos
changing tuning 112, 134, 154, 156
chord diagrams 894, 895
chord symbols 158, 161, 884
detuned 157, 161, 162
exporting tunings 157
fingerings 274, 981
frets 154
glissando lines 1119, 1120
guitar bends 1122
guitar techniques. See guitar techniques
harmonics 1081–1083, 1085
importing tunings 157
note input 208
open pitches 156
panning. See stage templates
pinch harmonics 1089
popover 277
reverb. See space templates
slides 986, 988, 1119, 1120
string indicators. See string indicators
strings 153, 154, 156, 157, 1059
tablature. See tablature
thumbs 900, 901, 904
transposition 132, 154, 159–162
tuning 134, 153, 154, 157, 158, 161, 162, 884
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front matter 997
composer 648
copyright 648
lyricist 648
page templates 647, 648
performance instructions 647, 648
player list 655
title 647, 648

fugues
analysis 56, 1194
playback 956
voices 232

full score layouts. See layouts
full screen 49
full stop. See period
fullness

frames 506
pages 506, 602, 604, 612, 617, 618
systems 506

fullness threshold
horizontal justification 612
vertical justification 604, 621

functions
key commands 62
removing key commands 64

fundamental
harmonics 1081
string pitches 154

funk noteheads 1057, 1058
FX channels 720–722

adding 727
deleting 727
inserts 728
mixer 717, 718
names 728
reverb 729
volume 725

G
G clef. See clefs
galley view 40, 50

bar numbers 40, 829
dragging pages 442
flows 501
instrument changes 136
instrument filters 445, 446
instrument labels 50
staff labels 40
staff spacing 621, 623

gamelan. See instruments
gaps 514, 614

around items. See erased backgrounds
articulations 805, 808
auxiliary notes 1102
bar numbers 832
barlines 888, 930, 1182, 1183, 1213, 1361, 1433, 
1434
bars 1242, 1328
beams 857, 858
breath marks 1016
caesuras 1013, 1016, 1018
capos 154, 158, 159, 161, 163, 165, 872

gaps (continued)
chord diagrams 898
chord symbols 872, 888, 893
clefs 907, 909
codas 513, 1241, 1242, 1327
dynamics 922, 928, 931
elision slurs 1050
erased backgrounds. See erased backgrounds
extender lines 1035, 1045
fermatas 1016, 1017
fingering slides 986
flow headings 614, 615
frames 614–616
galley view 623
H-bars 1280, 1281
hairpins 938
hyphens 1035, 1045, 1046
instrument changes 138
lines 1199, 1211
lyrics 1035, 1045, 1046
margins 614
multi-bar rests 1280, 1281
notes. See note spacing
ossia staves 603, 621
paragraphs 756, 758
parentheses 893
pauses 1016–1018
pedal lines 1169, 1170
percussion legends 1433, 1434
playback 545, 1016–1018
playing techniques 1182, 1183
quantization 93
removing 259
rests 858
slurs 1286, 1287, 1291, 1295
staff labels 1311
staves 152, 513, 603, 604, 620, 621, 1236, 1328
stemlets 858
stems 852
system indents 1311, 1327, 1328
systems 604, 1236
tacets 642
tempo marks 1348
text 756, 758, 759, 1182, 1211, 1356, 1357, 1360, 
1361
ties 1368
time signatures 1394
trills 1102

Gate 722, 728
General MIDI 85, 91, 761, 775
Generate Chord Symbols From Selection dialog 327
generated trills 1104, 1105

playback 1106
generating

chord symbols 326, 327
harp pedaling 381

ghost notes 1066, 1067
guitar. See dead notes. See also bracketed 
noteheads

gli altri. See divisi
glissando lines 1115, 1145, 1194

accidentals 1115
angles 1115, 1119
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glissando lines (continued)
changing 432
deleting 455
direction 1059
duration 1120, 1121
endpoints 1115, 1119
filter 429
formatting 1116
frame breaks 1119
guitar bends. See guitar bends
handles 1119
harp pedaling 1119, 1120, 1153
hiding 1117, 1118
inputting 340, 343, 349, 350, 1116
length 514, 1119
line styles 1116
moving 514, 1119
one note 1145
panel 345, 350
playback 764, 1119–1121, 1153
popover 343, 349
segments 1119
showing 1117, 1118
styles 1116
system breaks 1119
text 1117, 1118
tie chains 1119–1121
types 343

global
chord symbols 318, 871
fermatas 1010
figured bass 395, 957
key commands 61
note spacing 507, 509
options 27
pedal level 1165
properties 646, 663–665

glockenspiel. See instruments. See also transposing 
instruments
glyphs

accidentals 473, 475, 476
bracketed noteheads 1072
chord symbols 875
dynamics 953
fonts 751, 753, 754, 953
music symbols 388, 391, 657
pedal lines 1171
playing techniques 1180
substitute fonts 754
text 388, 391, 657
trills 1090, 1091

go to. See navigation
Go To Bar dialog 441
Go To Page dialog 441
Go To Rehearsal Mark dialog 442
Golden Age music font 751, 753
gongs. See unpitched percussion
Gould

accidentals 279, 1028
grace notes 238, 249, 250, 1002

appearance 1008
arpeggio signs 1111
barlines 1005

grace notes (continued)
beams 1008
caret 218, 249
chords 249–251
clefs 908
default settings 1002
deleting 455, 1004
duration 249, 1009
figured bass 962, 966
fingerings 976
glissando lines 349, 350
guitar bends 354
hairpins 945
inputting 93, 196, 249, 1004
inverting 478, 1002
lines 1200
messa di voce 945
moving 461, 464, 478, 480, 1004, 1005
pedal lines 1168
percussion 250
pitch 468
pitch mappings 482
placement 1002
playback 544, 1009
position 1002, 1005
quantization 93
register 468
reversing 478. See also retrograde
rotating 480
scale mapping 484
scrubbing 542
size 433, 1006
slashes 1002, 1006, 1007
slurs 273, 1002, 1284, 1285
spacing 507, 1002
speed 1009
stems 1002, 1006, 1008
ties 247, 1371
transformations 477, 1004
transposing 469
trills 1104
types 1006
unscaling 1004
voices 1002

gradient background 54
gradual dynamics 921, 937

abbreviating 943
alignment 924, 925, 949–952
angles 514, 938
aperture 938
appearance 939, 941–943
barlines 925, 926
centered text 935
consecutive 940, 945, 949, 954
continuation lines 939
continuous hairpins 940
dashed 939
direction 309, 940, 945, 954
dotted 939, 943
duration 317, 430, 937, 945, 949, 951
end position 925, 938
flared hairpins 941, 942
font styles 953
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gradual dynamics (continued)
grace notes 945
grouping 949, 950
handles 430, 938
hyphens 939
inputting 309, 312, 313, 315
length 317, 430, 937, 943, 945, 949, 951
line style 939
linking 951, 952
messa di voce 945
moving 461, 922, 924, 938, 945, 949, 951
niente. See niente
playback 953
poco a poco 935, 942
position 944
rotating 514, 938
spacing 944
start position 938
syllables 939
system breaks 938
tempo marks 1338
ties 313, 315, 461
truncated 943, 944
ungrouping 950
unlinking 952
volume 953
width 938

gradual tempo changes 1104, 1336, 1345
barlines 1337
caesuras 1016
continuation lines 1345, 1347
dashes 1348
drawing 706
exporting 102
fermatas 1016
final tempo 1344
formatting 1347–1349
gaps 1348
hyphens 1347
inputting 293, 296, 298, 299, 708
length 430, 514
lines 1345, 1347
moving 514
Play mode 532, 706
poco a poco 1346
popover 293
position 1337
style 1347, 1349
syllables 1347
Tempo editor 706
text 1338
thickness 1349
trills 1106

grand staff instruments 130
barlines 822, 824
beams 851–854, 1078
braces 864
brackets 866
centered beams 848, 851–853
chord symbols 882
cross-staff 851–854, 1078
dynamics 313, 315, 922, 931, 955, 956
hiding staves 605–607, 621

grand staff instruments (continued)
MIDI import 91
MIDI recording 264
multi-bar rests 1279
slurs 273
split point 91
staff grouping 866
staff spacing 621
staves 604, 822
stems 852, 1078
swing playback 554
ties 247
tremolos 414, 416, 851, 854
vertical justification 621
voices 218, 232, 955, 956, 1438

graphical adjustments 514
graphics

chord symbols 875
files. See graphics files

graphics files 585, 595
colors 596
exporting 585–587
file names 588
fonts 596
formats 595
image resolution 595
monochrome 596

graphs 713
green notes

Dynamics editor 694
tablature 1332

grids
chord diagrams 898, 900
gaps 152
groups 151
Hub 69
percussion kits 150–152, 1319, 1428, 1429
rhythmic 217
staff labels 1310, 1313
staves 1319, 1428

Groove Agent
editing 529
endpoints 529, 569
loading 528, 558, 564
middle C 51
MIDI trigger regions 420, 574
panning 730
patterns 94, 574
playback templates 558, 559, 564
reverb 738
space templates 738
stage templates 730

groups
bar repeats 1251
beams. See beam groups
braces 864
brackets 864
dynamics 949–951
guitar bends 1122, 1131
instruments. See instrument groups
notes. See note grouping
percussion kits 143, 150–152, 1319
players. See player groups
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groups (continued)
playing techniques 1186, 1187, 1191, 1192
rests. See note grouping
staff labels 1320
staff spacing 603, 621
staves 822, 824
tabs 48

guide
bar numbers 50, 437, 829
instrument labels 50, 182
lines 217, 517
page numbers 437, 1152

guitar 1137
adding 112, 114, 124, 133
amp modeling 722, 728, 729
bends. See guitar bends
capos. See capos
changing string for notes 1332
chord diagrams. See chord diagrams
chord symbols. See chord symbols
clefs 132, 913
dead notes 1141
dips 362, 1137
dives 356, 358, 359, 1127, 1133, 1135, 1137
effects 529, 728
fingerings 981
hammer-ons 364, 1139
harmonics 1081, 1083, 1085
lines 363, 364, 1122, 1127, 1131, 1133–1135, 1137
note input 242
notes out of range 154, 1064
open pitches 156
playback 535, 1122, 1127, 1137, 1141, 1260
position in score 125–127
pre-bends. See guitar pre-bends
pre-dives. See guitar pre-bends
pull-offs 364, 1139
scoops 360, 361, 1137
score order 126
slashes. See rhythm slashes
slides 986
string indicators. See string indicators
strings 156
strumming 985
tablature. See tablature
tapping 366, 1138
techniques. See guitar techniques
tuning 112, 132, 153, 154, 156
vibrato bar. See vibrato bar

guitar bends 1122, 1127
chords 1122, 1125
crosshairs 517
deleting 455
direction 434
dives 1127
groups 1122, 1131
handles 1131, 1135
hold lines 1129
holds 1122, 1129, 1131, 1135
inputting 343, 353, 354
intervals. See bend intervals
length 514
microtonal 356, 1125, 1128

guitar bends (continued)
moving 514
parentheses 1122
playback 1122
popover 343, 354
post-bends 356, 1125
pre-bends 1124
releases 1122
runs 1122, 1131
segments 1131, 1135
shape 1131, 1135
tablature 1331

guitar post-bends 1125
bend intervals 1128
chords 1125
deleting 1131
handles 1134
inputting 356
microtonal 356, 1125
moving 514, 1134
shape 1134

guitar pre-bends 1124
accidentals 1130
bend intervals 1128
deleting 1131
direction 1129
handles 1133
inputting 355
length 514, 1133
moving 514, 1133
shape 1133

guitar pre-dives. See guitar pre-bends
guitar slides 1115

text 1117, 1118
guitar techniques 1137–1139, 1180

dead notes 1141
deleting 1143
inputting 343, 353, 356, 358–364, 366
intervals 1142
moving 514, 1142
panel 345
popover 343
staff-relative placement 1142

H
H-bars. See multi-bar rests
hairpins. See gradual dynamics
half depressed pedal lines 1162, 1163, 1165, 1166
half notes 14, 200, 224, 259

beats 302
chords 251
glissando lines 1121
hiding 1060, 1079
Insert mode 237
metronome marks 294
percussion 238, 682
pick-up bars 285, 289, 291
quantization 93
rests 245, 1271
rhythm dots 230, 860, 861, 863, 1062
rhythmic grid 217
showing 861, 1060, 1079
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half notes (continued)
splitting notes 261, 861, 863
tablature 242
tempo equations 1349
ties 860, 861, 863
tremolos 414, 416, 1399
tuplets 254, 257
voices 232

half-bar
beam grouping 840, 861
cut common time 863
note grouping 747, 860, 863
ties 747, 860, 863

half-diminished. See scales. See also intervals
half-step trills 1097, 1104

appearance 1102
hiding 1094, 1098
inputting 341, 346, 347
position 1104
showing 1094, 1098

half-steps 14, 792
accidentals 244, 792
bend intervals 1119, 1120, 1128, 1142
figured bass 399
glissando lines 1115, 1119, 1120
harp pedaling 1153
pitch bends 700
string pitches 154
tonality systems 1028
trills. See half-step trills

half-whole diminished
chord symbols 323
scales 484, 485, 492

HALion Sonic Selection
editing 529
endpoints 529, 569
independent voice playback 545
loading 528, 558, 564
panning 730
playback templates 558, 559, 564
reverb 738
space templates 738
stage templates 730

HALion Symphonic Orchestra
editing 529
endpoints 529, 569
independent voice playback 545
loading 528, 558, 564
panning 730
playback templates 558, 559, 564
reverb 738
space templates 738
stage templates 730

halving. See double
hammer-ons 1139

deleting 1143
inputting 364
moving 514, 1142
popover 343
slurs 1139
staff-relative placement 1142

hand tool 40
dragging pages 442

hand-written fonts 751
handles

arpeggio signs 1111
beams 847
bend intervals 1131, 1133–1135
brackets 1072
chord symbols 873, 875, 882
duration 430
dynamics 937, 938, 945
figured bass 961, 965, 966
fingerings 973, 987
glissando lines 1119
guitar bends 1131, 1133–1135
hairpins 938, 945
jazz articulations 1147
length 430
lines 1215
lyrics 1036, 1039, 1045
MIDI trigger regions 574
moving 514, 945
note spacing 509, 511
notehead brackets 1072
numbered bar regions 1253
octave lines 918
pedal lines 1163
percussion legends 1432
playing techniques 1187, 1188, 1191
releases 1131, 1135
repeat endings 1232, 1233
selecting 511, 516
slurs 1288, 1298, 1300, 1301
staff spacing 624
stems 1078, 1404
string indicators 1188
system spacing 624
tempo marks 1336
ties 1374, 1375, 1377–1379
tuplet brackets 1413

harmonic analysis. See figured bass
harmonic minor. See scales. See also key signatures
harmonics 1081

accidentals 1084
appearance 1085, 1087, 1089
artificial 1081
hiding 1082
inputting 1082
natural 1081
noteheads 1058, 1082, 1085
partials 1083
pitch 1083
playback 1081–1083
question marks 1082
showing 1082
string number 1059, 1332
styles 1085, 1089
tablature 1082, 1085

harp. See instruments. See also harp pedaling
harp pedal diagrams 1153, 1154

placement 1158
position 1158
showing 1154
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harp pedaling 130, 1153
appearance 1153, 1154
borders 1156, 1157
calculating 381
crosshairs 517
diagrams. See harp pedal diagrams
erased backgrounds 1158
filter 429
glissando lines 1119, 1120, 1153
hiding 1155, 1156
inputting 367, 370, 379–381
moving 461, 464, 514
note names 1154
notes out of range 1064
padding 1158
partial 1159
playback 1153
popover 370
showing 1155
signposts 450, 1153, 1155, 1156

headers
Dynamics editor 694
editors 675
flows 651
Key Editor 667
MIDI CC editor 701
MIDI Pitch Bend editor 700
percussion editor 679
piano roll editor 671, 678
Tempo editor 706
tracks 520, 522, 531, 532, 534, 535
Velocity editor 691

heavy swing. See swing playback
height

bars 602–604, 621
braces 867
brackets 865, 866, 892, 1317
channels 724
chord symbols 881, 887, 892
drum pads 209
editors 673
flared hairpins 942
hairpins 938, 942
handles 1300, 1301, 1305, 1374
Key Editor 669, 673, 674
keyboard 206
lines 1204
mixer 717, 719, 724
notehead brackets 1072
pages 600, 601, 604
parentheses 892
pedal lines 1163, 1166
percussion editor 673, 674
piano roll editor 673, 674
slurs 1304, 1305
staves 602–604, 614, 616, 617, 621
systems 603, 604, 621
ties 1377–1379
tracks 537, 674

hemiola
forcing note durations 262
independent time signatures 287–289, 291

Henze fermatas. See fermatas

hexadecimal 388
hi-hat. See unpitched percussion
hiding 44, 437, 450, 455, 714, 1247, 1265, 1362

accidental colors 795
accidentals 792, 793, 801, 802, 1084, 1098, 1130
attachment lines 437
audio outputs in mixer 567
backgrounds 888, 930, 1182, 1213, 1361, 1433
bar numbers 826, 828, 829, 834, 837
bar repeat counts 1249
bar rests 1273, 1274, 1276–1278
barlines 283, 818–821, 888, 930, 1182, 1213, 1361, 
1382, 1433
beams 1079, 1263
borders 437, 756, 827, 1001, 1156, 1212, 1358
braces 865, 867, 868
brackets 793, 801, 865, 868, 890, 929, 960, 963, 
1067, 1317
brackets on noteheads 1067
capos 163, 164, 166
caps 1191
caret 222
cautionary accidentals 793, 801, 1084
cautionary key signatures 1025
cautionary time signatures 1384
channels 724
chord diagram fingering 900, 904
chord diagrams 895, 897, 898, 900
chord symbol parentheses 890
chord symbols 326, 878–880, 882, 886, 897
circles 827, 948
clefs 332, 333, 910, 911
coda 1240
colors 549, 575, 795, 1064, 1247, 1265, 1275, 1439
comments 501
condensing colors 437
continuation lines 1189, 1190
counts 828, 1243, 1249, 1256, 1267
da capo 1240
dal segno 1240
dead notes 1141
divisi colors 437
divisi labels 1310
divisi staves 605–607
dynamics 927–929, 934
Dynamics editor 675, 694
elision slurs 1050
empty staves 605
fermatas 1014
figured bass 397, 958, 959, 961
figured bass brackets 960, 963
fine 1240
fingering slides 988
fingerings 900, 978, 981
flags 841, 843, 844, 1079
flared hairpins 941
flow headings 69, 611
flow numbers 652, 653
flow page numbers 611
flow titles 611
flows 177, 640
Flows panel 120
glissando line text 1117, 1118
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hiding (continued)
guitar bend hold lines 1129
guitar pre-bend accidentals 1130
harmonics 1082
harp pedaling 1155, 1156, 1159
highlights 437
Histogram tool 710
hold lines 961, 1129
hyphens 928
initial page numbers 1151
instrument change labels 141
instrument changes 137, 140
instrument names 1310, 1312, 1313
instrument transpositions 184, 1315
interchangeable time signatures 1382
jump bar 66, 67
key signatures 112, 134, 278, 280, 281, 1019, 1021, 
1022, 1024, 1025
laissez vibrer ties 1372
ledger lines 1062
lines 430, 437, 961, 1189, 1190, 1317, 1347
margins 437
markers 1221
metronome marks 298, 1340
MIDI CC editor 675, 701
MIDI Pitch Bend editor 675
mixer 717–719, 724
multi-bar rests 1279
niente 948
note colors 437, 597, 1064
notes 574, 1060, 1062, 1065, 1079, 1263
numbered bar regions 1254, 1256
octave lines 917
padding rests 1264
page numbers 611, 1151, 1152
panels 31, 38, 42, 44, 110, 117
parentheses 793, 801, 890, 929, 960, 963, 1067
partial harp pedaling 1159
pedal lines 1171–1173
percussion legend signposts 1430
player group labels 1317
players 172, 176
playhead 539, 542
playing techniques 372, 1183, 1189
Playing Techniques editor 690
prefixes 140
quality in chord symbols 886
rectangles 827
repeat counts 1243
repeat markers 1240
rest colors 1275
rests 1273, 1276–1279
rhythm dots 1060, 1062, 1065
root in chord symbols 872, 886
running headers 611
secondary brackets 868
segno 1240
separators 928
signposts 437, 450, 636, 639
slash region counts 1267
staff labels 1310, 1312
staff lines 888, 930, 985, 1182, 1213, 1361, 1433
status bar tools 40

hiding (continued)
staves 121, 172, 176, 177, 445, 448, 605–607, 1331
stems 1079, 1263
string indicators 383, 430
sub-brackets 868
symbols 910, 917, 1183
system dividers 1324
system track 427, 437
systemic barlines 820, 821
tablature 1331
tabs 31
tacets 641
Tempo editor 675
tempo marks 298, 1340, 1347
text 1362
text borders 756, 1001, 1212, 1358
text on lines 1208
ties 861
time signatures 452, 1384, 1396, 1397
timecodes 1228
toolbar 30
tracks 536, 671
transport window 555
tre corde 1178
trill extension lines 1096
trill intervals 1098
trill marks 1094
tuplets 1413, 1416
Velocity editor 675, 691
verse numbers 1049
vibrato bar lines 430
video window 192
voice colors 437, 597, 1439
VST instruments 525
zones 31, 44

highlights
bar repeats 1245, 1247
chord symbol regions 882, 883
comments 501
dynamics 694, 696, 697, 699
exporting 597
flags. See signposts
hiding 437
MIDI 700, 701, 703, 705
MIDI trigger regions 574, 575
mouse editing 258, 457, 461, 464, 468
music frames 502, 624
notes 258, 457, 461, 464, 468
numbered bar regions 1247
printing 597
search matches 58, 745, 747, 749
slash regions 1261, 1265
stop positions 453
tempo changes 532, 706, 708
tracks 520, 532

Histogram tool 710, 711, 713, 714
area graph 713
bar graph 713
changing values 692, 712
controls 711, 712
filter 712
graph type 713
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Histogram tool (continued)
hiding 710
showing 710

History dialog 438
hits 1263
hold lines 1122, 1129

brackets 963
figured bass 430, 961, 962, 965, 966
guitar bends 1131
handles 965, 1131
hiding 961, 1129
length 961, 962, 966, 1131
moving 514, 1131
showing 961, 1129

holds. See pauses
Holds and Pauses panel 339
Hollywood-style trills 1102

intervals 1104
position 1104
showing 1103

hooks
length 1234
octave lines 918
pedal lines 1162, 1163, 1166, 1171, 1172
playing techniques 1186, 1189
repeat endings 1234
tuplets 1413

horizontal alignment
chord symbols 887
crosshairs 517
dynamics 924, 949, 950
instrument names 184
items 517
lyrics 1035, 1037
ornaments 1091
staff labels 184
staves 612
systems 612
text 756, 1356

horizontal justification
staves 612
systems 612
text 756

horizontal lines. See lines. See also glissando lines
horizontal position 514

accidentals 795–797
arpeggio signs 1111
bar numbers 832
chord symbols 878, 880
clefs 908, 909
dynamics 922, 923, 935, 936
H-bars 1280, 1281
instrument changes 138
instrument names 184
lines 461, 464, 1198–1200, 1205, 1215
lyrics 1035, 1037
modifiers 935
multi-bar rests 1280, 1281
notes 506, 507, 1062, 1440, 1442, 1443
ornaments 1091
poco a poco 935
rehearsal marks 1216
rests 1271, 1276, 1280, 1281

horizontal position (continued)
rhythm dots 1063
staff labels 184
staves 612
string indicators 995
systems 513, 612
tempo marks 1336
text 756, 1356
time signatures 1394
trills 1091
tuplet brackets 1415
tuplets 1417

horizontal spacing. See note spacing
horns 130

branch indicators 979, 990
clefs 112, 134, 330, 912
fingerings 979, 989
key signatures 112, 134
panning. See stage templates
reverb. See space templates
transposition 112, 132, 134

hotkeys. See key commands
hours

timecodes 1226
transport 32, 555

HTML files
comments 500

Hub 69
opening projects 72, 73
starting projects 71
video tutorials 69

humanize
dynamics 694, 954, 955
note durations 749

hymnals
lyrics 508, 1041
note spacing 508
tick barlines 817

hyphens
dynamics 309, 928, 939, 942
gaps 1046
lyrics 392, 395, 1031, 1045, 1046
staff labels 1315
tempo marks 1347
time signatures 1389, 1392

Hz
playback tuning 545

I
Iconica Sketch

editing 529
endpoints 529, 569
independent voice playback 545
loading 528, 558, 564
panning 730
playback templates 558, 559, 564
reverb 738
space templates 738
stage templates 730

illustrations
exporting 585, 586
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images
exporting 585, 586
resolution 585, 586, 595
videos 189

immediate dynamics. See dynamics
implicit rests 23, 1271, 1272

colors 1275
deleting 1276
explicit rests 1274
hiding 1273, 1276
showing 1276
voices 1273

Import Tempo Track dialog 97
important markers 403, 1225
importing 78

Cubase data 761, 779
drum sets 94, 153
expression maps 761, 779
flows 78, 79, 85
font styles 754
fretted instrument tunings 157
Key Editor configurations 716
MIDI files 85
MusicXML files 82, 83, 1235
paragraph styles 756
pedal lines 85, 91, 270
percussion kits 94, 153
percussion maps 785
playback templates 566
playing techniques 87, 91
space templates 743
stage templates 737
tempo tracks 97
tracks 85
unpitched percussion 83, 85

inches
staff spacing 624
unit of measurement 51

incipits 820
including. See excluding
indents 1327, 1328

codas 513, 1241, 1242, 1327
final systems 612
first systems 1328
removing 1328
staff labels 1311
systems 513, 612, 1310–1312, 1328
text 756

independent voice playback 522, 545
changing endpoints 569
disabling 546
enabling 545
inputting notes 681
piano roll editor 678
playing techniques 372, 374

index
rehearsal marks 1217
tokens 655
vertical stacking 518, 1185
voice columns. See voice column index

Indian drum notation 1436
Indiana chord symbols 872

indicators
audio engine 38
caret 931
clefs 913
fingerings 276, 990
frame fullness 506
horn branches 990
MIDI input 38
octaves 913
string fingerings 990, 991, 1059
system fullness 506
tempo. See tempo marks
thumbs 276
trill intervals 1097, 1104
voices 931

information. See project information
ingredients 588
init switches 766, 774
initial pages

left-hand page 609
page numbers 609, 1151

initial trill notes 1104
initials

comments 494, 499
input pitch 215
inputting 210, 213

accidentals 214, 244, 279, 792
additional repeat endings 410, 412
altered bass note chord symbols 318
arpeggio signs 340, 343, 347
articulations 214, 271, 272
bar number changes 836, 837
bar number counts 408, 419
bar repeats 408, 409, 418
bar rests 246, 301
barlines 300, 303, 306, 307
bars 300, 301, 303–305
beams 224, 841
beats 302, 304, 305
bracketed noteheads 1067
breath marks 336–339
caesuras 336–339
capos 159, 160
caret 218, 222
centered beams 849
channels 727
character styles 760
chord diagram shapes 903
chord diagrams 878, 895, 897
chord symbol parentheses 318, 324, 890
chord symbol regions 324
chord symbols 318, 320, 325–327
chords 196, 251, 258, 488
clefs 329–333
comments 495, 497, 498
dips 362
dives 355, 356, 358, 359
drum sets 94, 133
dynamic modifiers 309, 312, 313, 315, 933
dynamics 309, 312, 313, 315, 317, 696, 699, 933
editors 675, 716
effects channels 727
elision slurs 392, 395
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inputting (continued)
ensembles 114, 128, 129
expression maps 776, 777, 779
fermatas 336–339
figured bass 395, 397, 400
figured bass hold lines 395, 397, 430, 961, 962
fingerings 274
flows 78, 171–173, 501
font styles 758, 760
frame breaks 631, 637, 638
FX channels 727
gaps 338, 339, 1016–1018
glissando lines 340, 343, 349, 350, 1116
grace notes 93, 249, 1004
gradual dynamics 309, 312, 313, 315, 317
gradual tempo changes 293, 296, 298, 299, 708
guitar bend hold lines 1129
guitar bends 343, 353, 354
guitar dips 343, 362
guitar dives 343, 356, 358, 359
guitar lines 343, 363, 364
guitar post-bends 356
guitar pre-bends 355
guitar pre-dives 355
guitar scoops 343, 360, 361
guitar tapping 343, 366
hammer-ons 343, 364
harmonics 1082
harp pedaling 367, 370, 379–381
hold lines 430, 961, 962
inputting vs. editing 210
Insert mode 237
instrument changes 224, 227
instrument filters 449
instruments 112, 124, 133
instruments in percussion kits 146
intervals 487
jazz articulations 340, 342, 351, 352
jazz ornaments 342, 346, 347
key commands 63
Key Editor 671, 675, 681, 696, 703, 708, 716
key signatures 278–281, 792
layouts 176, 180
left-hand fingerings 277
line text 1208
lines 367, 372, 374, 385–387
lyrics 392, 395
markers 401, 402, 534
messa di voce 309, 312, 313, 315, 317, 945, 946
metronome marks 293, 298, 299
MIDI 85, 264, 270, 528, 558, 559, 564
MIDI points 703, 705
MIDI trigger regions 420
mouse input 211, 212
multi-bar rests 1279
mutual exclusion groups 779
nested slurs 1295
nested tuplets 1409
niente 309, 312, 313, 315, 317, 948
notehead brackets 1067
noteheads 685, 1424, 1425
notes 214, 223, 224, 227, 235, 237, 242, 258, 262, 
264, 488, 681, 682

inputting (continued)
notes in multiple voices 232
notes in percussion kits 94, 238, 240, 682
numbered bar regions 408, 419
octave lines 329, 331, 333, 335
octaves 487
ornaments 340, 341, 346, 347
panels 201
panning 731
paragraph styles 758
parentheses 318, 324, 395, 397, 793, 890, 929, 960, 
963, 1067, 1084
pauses 336–339
pedal lines 367, 369, 375, 377, 378
percussion kits 94, 133, 143, 146, 147, 238, 681, 
682, 685, 1424, 1425
percussion legends 1430
pick-up bars 283, 285, 289, 291, 452
pitch mappings 482, 483, 492
playback techniques 777, 788
playback templates 564, 566
player groups 168
players 114, 124, 129
playing techniques 367, 372, 374, 681, 682, 685, 
1424, 1425
popovers 22, 201
position 210
post-bends 356
pull-offs 343, 364
register selection 226
rehearsal marks 400
repeat endings 406, 409–412
repeat markers 406, 409, 413, 414
rests 196, 206, 224, 245, 262
retakes 375, 377, 378, 1170
reverb 738, 742
rhythm dots 214, 224, 227, 230
rhythm slashes 408, 409, 417
rhythmic feels 293, 554
rhythmic grid 217
right-hand fingerings 277
scoops 360, 361
settings 211, 213, 214, 317
slash regions 408, 417
slash voices 233, 1260
slurs 273, 364, 1295
soloists 127
sounds 522, 528, 529, 564, 569, 570, 572
space templates 738, 739, 741–743
stage templates 731–733, 736, 737
staves 124, 128, 133, 1329
stem direction 241
stems 232, 1438. See also voices
string indicator lines 430
string indicators 367, 370, 381, 383
strings 154
swing playback 295
switches 777
system breaks 631, 634, 635
system-attached text 388
tablature 242, 1331
tapping 343, 366
tempo equations 293, 296, 298, 299
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inputting (continued)
tempo marks 293, 296, 298, 299, 708
text 388, 1208
ties 196, 247
time signatures 283, 287, 288
timecodes 401, 1222, 1227
tokens 655
tremolos 407, 409, 414, 416
trill intervals 1100
trills 341, 346, 347
tuplets 93, 254, 1409, 1410
Unicode 388
unpitched percussion 681, 682
upbeats. See pick-up bars
velocity 692
vibrato bar 353, 355, 356
vibrato bar dips 362
vibrato bar dives 358, 359
vibrato bar lines 363, 364, 430
vibrato bar scoops 360, 361
videos 191
voices 232, 233, 466
VST instruments 528, 558, 559, 564

Insert Bar Number Change dialog 835
Insert mode 196, 210, 451

activating 196, 237
caret 218, 237
deactivating 237
inputting notes 237
scope 452, 453
stop positions 451, 453, 454
time signatures 287–289, 291, 452, 1381
tuplets 455

Insert Music Text dialog 391
inserting. See inputting. See also Insert mode
insertion point 218
inserts 722

changing 728, 729
loading 728
removing 729
reverb 729, 739, 742

inspector. See Track Inspector. See also properties
instances

adding 528
chord symbols 871
plug-ins 522, 525

instrument change labels 130, 136, 142
borders 142, 756
colors 142
cues 138
editing 139, 140
font 142
font style 756
hiding 141
moving 138, 514
paragraph styles 142
prefixes 139
showing 141
size 142
suffixes 139

instrument changes 136, 137, 142
allowing 137
cues 138

instrument changes (continued)
disallowing 137
inputting 133, 224, 227
labels. See instrument change labels
language 57, 136, 139, 184
position 138
staff labels 138

instrument channels 717, 718, 720, 721
instrument colors 531

Dynamics editor 694, 699
MIDI CC editor 701, 705
MIDI Pitch Bend editor 700, 705
percussion editor 679
piano roll editor 678
Playing Techniques editor 690
stage templates 732, 733
Velocity editor 691

instrument families 112
barlines 822
brackets 864–866
ensemble picker 114
glissando lines 1119
instrument filters 446
instrument picker 112
markers 1222
MIDI import 87
playback templates 561, 564
playing techniques 371, 1180
rehearsal marks 1216
repeat endings 1233
repeat markers 1241
stage templates 732, 733
system objects 1326, 1327
tempo marks 1336
timecodes 1222

instrument filters 112, 114, 445
activating 448
adding 449
deactivating 448
deleting 449
instruments 446, 449
key commands 445, 446
names 446, 449
order 446

instrument groups 150, 167
deleting 152
filters 446
labels 1317
naming 151
percussion kits 150, 1319

instrument names 181, 1309
abbreviated 183, 184, 1313
alignment 184, 1318
baseline shift 184
borders 1001
changing 183
colors 184, 1318
Endpoint Setup dialog 567
fonts 1318
hiding 1310, 1312, 1313
length 184, 1310, 1312
mixer 717, 718
numbering 131, 132, 1313
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instrument names (continued)
overline 184
Play mode 531, 567, 718
resetting 184, 187
saving as default 184
showing 1310, 1312
size 1318
solo 127
staff labels 184, 657, 1310, 1312, 1313
stretch 184
subscript 184
superscript 184
tokens 657
tracks 531. See also instrument tracks
underline 184

instrument numbering 131, 132, 733, 1315
instrument picker 112
instrument pitches. See instrument transpositions
instrument score orders

changing 125
instrument tracks 530, 531

automation. See MIDI CC editor
dynamics. See Dynamics editor
MIDI. See MIDI CC editor
piano roll editor 678
velocity. See Velocity editor

instrument transpositions 132, 1314
changing 112, 134
clefs 910
hiding 184, 1315
layout names 183
layouts 183
order 1315
parentheses 1315
showing 184, 1315
staff labels 184, 1314, 1315

instrumental parts. See layouts
instrumentation lists 656, 997

page templates 647, 648
instruments 21, 130

adding 112, 114, 124, 128, 133
adding to flows 172
adding to parts 176
adding to percussion kits 146
arranging tools 455
assigning to endpoints 569
automatic numbering 131
barline joins. See barline joins
beams 851
brackets 865, 866
changes. See instrument changes
changing existing 134, 148
changing transposition 134
channels 717, 718, 720, 721
chord symbols 318, 878
clefs 112, 134
colors 531, 678, 679, 732, 733
combined parts 176
combining into kits 147
comments 494, 496, 499, 500
copying 125
cross-staff 851
deleting 127, 136

instruments (continued)
divisi 1329
doubling 50, 133
dynamics 694, 931, 951, 953. See also Dynamics 
editor
empty staves 605
endpoints 567, 569
ensembles. See ensembles
expression maps 567, 762
families. See instrument families
figured bass 395
filters. See instrument filters
fretted 153
fretted fingerings 981
glissando lines 1119
groups. See instrument groups
hiding 172, 176, 445
importing 85
inputting notes 224, 227
key signatures 112, 1021, 1025–1027
labels 50, 136, 137, 139, 140, 142, 151, 182, 1309, 
1313, 1318, 1320
language 57, 112, 114, 187
loading 528, 542, 558, 564
merging. See condensing. See also reducing
MIDI 522, 526, 528
MIDI import 85
MIDI recording 264
mixer 717, 718, 720, 721, 725
moving 135, 170, 732, 733, 736
muting 547, 548, 717, 719
names. See instrument names
non-sustaining 953
numbering 131, 132
order 125–127, 135, 149, 167
panning 726, 730–733, 735, 736
part layouts. See layouts
percussion 149, 780, 1428
percussion legends 1430, 1432
percussion maps 567
Play mode 531
playback 540, 542, 545–548, 558, 559, 561, 564, 
567, 569, 761, 780
players 123
Players panel 110
plucked fingerings 981
position in score 110, 125
project templates 71, 77
ranges 1064
removing from kits 147
removing from parts 172, 176
repeats 548
reverb 729, 738, 739, 741, 742, 744
rhythm section 866, 878
searching 112, 114
showing 172, 176, 445
showing staves 50
soloing 542, 547, 548, 717, 719
sorting 110, 125
staff grouping 866
staff labels 184, 1313, 1315
staff size 618
staff spacing 621
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instruments (continued)
stage templates. See stage templates
statistics 106
staves 50, 606, 607, 931, 1323, 1428
strings 153
sustaining 953
swing playback 554
tablature 1330, 1331
templates 71, 77, 114, 116, 558, 730
tracks. See instrument tracks
transposing 132, 178. See also instrument 
transpositions
tremolos 414, 416, 851
tuning 112, 153
velocity 691. See also Velocity editor
volume 725, 931
VST 522, 525, 528

intensity
dynamics 313, 315, 432, 694, 921, 926, 927, 954, 
955

interactive key commands map 61
interchangeable time signatures 1382

ending 1397
inputting 283, 285, 287, 288

interface. See user interface
interspersion

accidentals 795
intervals

accidentals 341, 487, 1099
adding 251, 258, 488
auto-save 105
chord symbols 322, 872
dips 1142
figured bass 969
fretted instruments 154
glissando lines 1115
guitar bends. See bend intervals
handles 1131, 1133–1135
harmonics 1081–1083, 1085, 1089
microtonal 487
note input 226
octave divisions 1028
ornaments 1090
pitch mappings 482, 483, 492
popover 487
simplifying 969
transposing 469, 470, 489
trills 341, 346, 1097–1100, 1104
vibrato bar dives and returns 1127

inversions
chord symbols 318, 536
figured bass 395, 397, 957
pitches 478, 479, 489
playback 536

Invert Pitches dialog 479
inverting 434, 436, 478, 479, 1076, 1293, 1369

articulations 808
beaming 845, 846
chord symbols 882
colors 55
duplex printing 592
figured bass 965
fingerings 974

inverting (continued)
grace note stems 1002
guitar bends 1129
guitar techniques 1142
lines 1201, 1202
notes 1076–1078
pitches 478, 479, 489
playing techniques 1185
resetting 436
slurs 1285, 1292, 1293
stems 1076–1078
ties 1369
tuplets 1414

invisible. See hiding
ionian

chord symbols 323, 885
scales 484, 485, 492

irrational time signatures. See time signatures
irregular

bars as pick-up bars 1386
time signatures 1382

italics
chord diagrams 906
chord symbols 158, 872, 877
composer 75, 756
copyright 75, 756
dedication 75, 756
dynamics 921
figured bass 968
fingerings 906, 979, 980
instrument change labels 142
instrument names 1318
lyricist 75, 756
lyrics 1041, 1042, 1044
Markdown 75
player group labels 1317, 1318
project information 75, 756
rehearsal marks 1219
repeat endings 1233
staff labels 184, 756, 1318
subtitles 75, 756
tasto solo 968
tempo marks 1339
text 389, 756, 759
titles 75, 756

items 210, 421
behind other items 421
changing 432
copying 457
deselecting 429
editing 663
resetting 436
selecting 210, 421–424, 429, 439
settings. See properties

J
Japanese

chord symbols 872
jazz

articulations. See jazz articulations
band templates 71, 77
chord symbols 872
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jazz (continued)
glyphs 751, 753
music fonts 751, 753
player order 110, 125
staff grouping 866

jazz articulations 1145, 1146
appearance 1147, 1148
bend 1145
changing 1147
copying 805
deleting 1149
duration 1147
handles 1147
inputting 340, 342, 351, 352
length 514, 1147
line styles 1148
moving 514, 1147
ornaments. See jazz ornaments
panel 345, 352
playback 787, 788, 1145
popover 342, 351
position 1147
smooth 1145
types 342, 1145, 1147

jazz ornaments 1145, 1146
inputting 342, 346, 347
popover 342
types 342

Jazz Standards chord symbols 872
jeté. See playing techniques
job types 578, 590

page ranges 583, 584
printing 590
selecting 590

joins
attachment lines 437
barlines. See barline joins
beams 841, 843, 851, 854, 1078
pedal lines 1170
staves with barlines 824
stems 851, 854, 1078

jump bar 65
aliases 67, 68
Commands 65, 67
entries 65
Go To 66
showing 66, 67

jumps
hiding 1240
inputting 413, 414
playback 550
rehearsal marks 442, 1217
repeat 1236
showing 1240

justification
staves 604, 612, 621, 1328
systems 513, 604, 612, 621, 1328
vertical 604, 621

K
kerning

accidentals 796
figured bass 964

key clicks. See playing techniques
key commands 17, 26, 60, 65

articulations 272
assigning 63, 67
defining 58
Engrave mode 503
finding 62, 65
galley view 50
instrument filters 445, 446
Key Editor 671
keyboard layouts 64
languages 64
lower zone 44
maps 61
MIDI 63
mouse input 196
muting 547, 548
navigation 36, 440–442
notehead sets 1058
page view 50
panels 44
playback 540
played duration 689
removing 64
resetting 65
searching 61, 62
soloing 547, 548
text formatting 389
zoom levels 444

Key Editor 667, 669, 701
configurations 675, 715, 716
controls 710, 711, 713, 714
copying 676, 686
deleting notes 687
dynamics. See Dynamics editor
height 673
histogram. See Histogram tool. See also Transform 
tool
inputting notes 681
instruments 671
key commands 44, 671, 673, 674
locking 671
MIDI CC. See MIDI CC editor
moving notes 683
note duration 681, 682, 684, 687
panel 667, 669
percussion. See percussion editor
piano roll. See piano roll editor
pitch bends. See MIDI Pitch Bend editor
playhead 539
playing techniques. See Playing Techniques editor
rhythmic grid 669, 675
scrolling 539, 667, 674
selecting 676
selecting velocity bars 715
slurred notes 1308
tempo 706
toolbar 669
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Key Editor (continued)
Transform tool. See Transform tool. See also 
Histogram tool
transposing notes 685
tuplets 678
velocity. See Velocity editor
voices 545, 669, 671
zoom 667, 674

key signatures 1019, 1028
accidentals 278, 279, 469, 470, 473, 792, 1020
atonal 1021
barlines 819, 1022
cautionary 1024, 1025
changes 819, 1020, 1022
changing 280, 281, 432
clefs 1022
deleting 455
enharmonic equivalent 1025, 1027
filter 429
hiding 112, 134, 278, 280, 281, 1019, 1021, 1022, 
1025
inputting 278–281
instrument changes 138
instruments without 112, 134, 1019, 1021, 1026
major 1021
MIDI import 91
minor 1021
moving 138, 461, 464, 1023
multi-bar rests 1280, 1281
multiple 1019
none 112, 1021
octave divisions 1028
open 1021
panel 279, 281
placement 1022
polytonality 280, 281, 1019
popover 278, 280
position 280, 1022
respelling 1027
scales 1021
selecting 421, 425, 427, 428
showing 1022, 1025
signposts 280, 281, 450, 1019
start repeat barlines 819
tonality systems 1028
transposing 469, 470, 1027
transposing instruments 178, 747, 1026
types 278, 1021

Key Signatures, Tonality Systems, and Accidentals 
panel 279, 281
key switches 775

expression maps 761, 767
MIDI import 91
percussion maps 781

Keyboard panel 206
key commands 44

keyboard shortcuts. See key commands
keyboards

adding 112, 114, 124
beams 851–854
chord symbols 318, 878
cross-staff 851–853, 1078
glissando lines 1119

keyboards (continued)
inputting notes 223, 224, 264
key command maps 61
layouts 64
MIDI 216, 264, 268, 678
panel 206
slashes. See rhythm slashes
sounds 216, 540, 558
stems 852, 1078
tremolos 414, 416, 851

keys
major 1021
minor 1021
signatures. See key signatures
transposing 469, 470

kick drum. See unpitched percussion
kits. See percussion kits
kneed beams. See centered beams

L
l.v. ties. See laissez vibrer ties
labels

brackets 1317
instrument changes. See instrument change labels
instruments 151, 184, 1309
markers 1221
percussion kits 151, 1319, 1428
player groups 151, 1317
staves. See staff labels

laissez vibrer ties 1180, 1364, 1372
angle 1375
shape 1375
width 1372, 1375

landscape orientation 593, 594, 600
lanes. See editors. See also tracks
languages 56

application 57
date and time 58
ensembles 114
instruments 57, 112, 114, 136, 139, 184, 187
key commands 26, 61, 64
staff labels 57
tokens 58

large
noteheads 1056
selections 424
time signatures. See large time signatures

large time signatures 1387, 1389
bar numbers 834

largo. See tempo marks
latency

changing value 269
MIDI recording 264, 268

lattice arrangement
accidentals 795

layers. See voices
layout cards 117, 121

disclosure arrows 42
numbers 117. See also layout numbers
opening 117
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layout names 181, 183
accidentals 183
borders 1001
changing 183
first pages 648
resetting 183
running headers 649
tokens 656

layout numbers 117
changing 180
order 179

layout options 27, 745
bar numbers 826–828, 831
copying to other layouts 643
dialog 745
saving as default 745
searching 745

Layout Options dialog 745
layout selector 31

order of layouts 179
switching layouts 43

layouts 24, 117, 121, 174, 643
accidentals 473, 476
adding flows 177
adding players 176
bar numbers 826, 828–830
blank staves 608
borders 1001. See also margins
braces 865–868. See also staff grouping
brackets 865, 866, 868. See also staff grouping
cards. See layout cards
casting off 629–632
chord symbols 879
clefs 330, 910, 912, 917
color mode 586
combining players 176
comparing 48
concert pitch 178, 656, 1000
condensing 643
copies 581
copying formatting 643, 645
copying properties 646
creating 91, 176, 180
cues. See cues
custom scores 174
deleting 180
divisi 1329
dynamics 924
empty staves 605, 608
enharmonic spelling 473, 476
exporting 585, 590
exporting audio 100
exporting MIDI 95
figured bass 958
file names 588
fingering 978
fit to paper 594
fixing 629–631
flow headings 611, 651–653
flow ranges 583, 584
flows 121, 177, 609, 610
font size 754, 756
formatting 598, 643

layouts (continued)
frame breaks 636
frame chains. See music frame chains
front matter 997
full scores 174
graphics files 585, 595
harp pedaling 1155
hiding staves 605–607
image resolution 586
indents 1327, 1328
instrument change labels 141
instrument filters. See instrument filters
instrument order 125
justification 604, 612, 621
Key Editor 667
keyboard 61, 64
large time signatures 1387, 1389
Layouts panel 117
left pages 609
locking 629–631
margins 601, 614, 616
markers 1221, 1222
MIDI import 91
multi-bar rests 828, 1279, 1281
multiple windows 49
MusicXML files 84
naming 183. See also layout names
navigation 439–442
note spacing 507
note spelling 473, 476
numbered bar regions 1254
numbers. See layout numbers
opening 33, 43
opening multiple 45, 48
orchestral order 125–127, 167, 1317
order 179
orientation 593, 594, 600
page numbers 1150
page ranges 583, 584, 590
page size 593, 600
page template sets 601, 647
page templates. See page templates
page turns 636
panel in Print mode 577
panel in Setup mode 117, 174
paper sizes 593
parts 174, 176, 643
percussion kit presentation 1429
percussion legends 1430
player order 125–127, 167, 1317
players 121, 176
printing 581, 590, 594
propagating parts 643, 645
properties 646, 663–665
rehearsal marks 1216, 1219, 1327
removing flows 177
removing page overrides 651
removing players 176
renaming 183
renumbering 180
repeat marker text 1239
resetting 632, 651, 745
restoring 180
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layouts (continued)
running headers 611
scale size 594
selecting 31
settings 745
sorting 179
staff filters. See instrument filters
staff labels 181, 657, 1310, 1313
staff size 602
staff spacing 603, 604, 621, 1357
statistics 106
staves 605–607
switching 43
system dividers 1324
system formatting 603, 612, 621, 633, 643
system objects 1326, 1327
tabs 33, 45
tacets 640–642
text 388, 648, 1351, 1357, 1362
time signatures 1387, 1389, 1397
timecodes 1222, 1227, 1228
titles 647, 648, 651
tokens 656, 657, 1000
transposing 132, 174, 178, 656, 1000
vertical justification 604
view types 40
zoom 42, 443

Layouts panel
Print mode 576, 577
Setup mode 109, 117

lead sheets
adding instruments 124, 133
barlines 821
bars per system 629
capo chord symbols 163–166
chord diagrams grid 898, 900
chord symbols 318, 326, 871
clefs 911
drums 142
key signatures 1022
multi-bar rests 1279
percussion kits 142
playback 1260
project template 77
slashes. See rhythm slashes
systems per frame 630

leading 756, 758, 1356
learning materials 69
ledger lines 1061

hiding 1062
width 1061

left hand hooks. See lines
left pages 647, 648

starting from 609
left pan 739, 741
left zone 37, 38

Engrave mode 504
hiding 44
Print mode 577
Setup mode 110
showing 44
Write mode 200

left-foot pedals. See harp pedaling. See also pedal lines

left-hand fingering 981
erased backgrounds 985
hammer-ons. See hammer-ons
inputting 274, 277
placement 972
popover 277
position 984
pull-offs. See hammer-ons
size 981
slides 986, 988
tapping. See tapping

left-hand guitar tapping. See tapping
legal paper size 593
legato

note durations 259
playback 749, 769, 1308
playing technique. See playing techniques. See also 
playback techniques
slurs 1283, 1308

legends
percussion. See percussion legends

leggiero. See dynamic modifiers
Leipzig music font 751, 753
Leland music font 751, 753
length 430, 514

arpeggio signs 347, 348, 1111
audio 101
bar repeat phrases 432, 1246
barlines 822, 824
bars 69, 283, 300, 452, 810–812, 1016
braces 867
brackets 1072
chord symbol parentheses 891
continuation lines 1186, 1188, 1191
divisi passages 461, 464
dynamics 317, 430, 698, 934, 938, 943
figured bass 961, 962, 965, 966
fingering slides 988
flows 32, 69, 106, 300, 555, 656, 659, 810–812
glissando lines 1119
grace note slashes 1007
guitar bends 1131, 1133, 1135
H-bars 1280
hairpins 926, 944
hold lines 961, 962, 965, 966, 1131
hooks 514, 1163, 1234
instrument names 139, 140, 183, 1310, 1312
jazz articulations 1147
laissez vibrer ties 1372
lines 386, 387, 430, 1186–1188, 1191, 1203–1205, 
1215
lyric extender lines 1045
lyric hyphens 1045, 1046
messa di voce 944
multi-bar rests 1280
music 69, 300, 810–812, 1016
notated duration of notes 687
notehead brackets 1072
notes 259, 682, 684, 687, 689
octave lines 430, 918
pauses 1016
pedal lines 1163, 1167, 1170, 1174
percussion legends 1432
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length (continued)
played duration of notes 687, 689
player group names 169
player names 182, 1310, 1312
playing techniques 1186, 1188, 1191
projects 32, 69, 106, 300, 555, 656, 659, 810–812
repeat endings 1232, 1234
reverb tail 101
slurs 1284, 1294
staff labels 1310, 1312, 1313
stemlets 858
stems 847, 1078
string indicators 1186, 1188
system dividers 1325
systems 513, 612
tempo marks 1336, 1348
tuplet brackets 1413

lentando. See gradual tempo changes. See also tempo 
marks
lento. See tempo marks
let ring. See laissez vibrer ties
letter paper sizes 593, 600
letters

rehearsal marks 1218
levels

channels 717, 718, 725
dynamics. See dynamic levels
nested tuplets 1408
pedal lines 1162, 1163, 1165, 1166. See also pedal 
level changes

libraries 745
fretted instrument tunings 157
percussion 780
project templates 77
sound 522, 525, 527, 558, 761, 762, 780

libretto
exporting 1034
librettist 75, 658, 999

lieder. See flows. See also projects
lifts

jazz articulations. See jazz articulations
pedal lines. See pedal retakes

ligado. See hammer-ons
light swing. See swing playback
light theme 52
Limiter 722, 728
limits 711, 712, 714

histogram controls 711, 712, 714
Lin One Dither 722, 728
line breaks

project information 75
repeat markers 1239
staff labels 184, 1315
text 388

line spacing 602, 756, 758, 1356. See also staff spacing
linear points 697, 704, 706

inputting 696, 703, 708
lines 1115, 1180, 1186, 1194, 1196

accidentals 1205
alignment 517, 1205
angled 385, 1194, 1202
annotations 1196
appearance 1190, 1206, 1207

lines (continued)
arpeggio signs. See arpeggio signs
attachments 385, 386, 1194, 1197
backgrounds 1213
bar numbers 831, 832
barlines. See barlines
beams. See beaming
brackets 864, 868, 870, 1317
caesuras. See caesuras
caps 1191, 1196, 1207
changing 1190, 1206, 1207
chords 235, 347–350, 386, 387
collision avoidance 1199
colors 56
columns 1199
components 1196
cross-staff 387
crosshairs 517
deleting 455
diagonal 386
drawing 708
duration 1203, 1204
dynamics 694, 696, 699, 939
enclosures 827
end position 1205
ends 1196
Engrave mode 509, 1199
erased backgrounds 1213, 1214
figured bass. See figured bass
fingerings 990
fonts 1209
frame breaks 1215
glissando. See glissando lines
grace notes 1006, 1200
gradual tempo changes 1349
groups 1317
guide 217, 517
guitar bends. See guitar bends. See also vibrato bar
handles 1215
harp pedaling 1153, 1159
hiding 430, 961, 1189
holds. See hold lines
horizontal 386, 1194, 1197, 1198
horizontal text 1212
inputting 385–387
Insert mode 453, 454
jazz articulations 1145, 1148
joining notes. See beams
ledger 1061
length 514, 1203–1205, 1215
lyrics 392, 394, 395, 1029, 1045, 1047. See also lyric 
extender lines
markers 1222
MIDI 701, 703, 705
moving 461, 464, 514, 1198–1202, 1215
noteheads 1053, 1205, 1421
notes. See stems. See also beaming
octave lines. See octave lines
order 1185, 1198, 1199
padding 1214
pauses. See caesuras. See also pauses
pedal. See pedal lines
placement 1198, 1201, 1202
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lines (continued)
playback. See playhead
player groups. See player group labels
playing techniques. See playing technique lines
position 1197
repeat endings. See repeat endings
repeat marker text 1239
reversing 1207
secondary beams 856
secondary brackets 868, 870
segments 1215
showing 430, 961, 1189
size 1203, 1209
slurs 1283, 1290
staff-relative placement 1201, 1202
start position 1205
staves 1322
stemlets. See stemlets
stop position 453, 454
string indicators 381, 383, 430
string shift indicators 991
system breaks 1196, 1215
system dividers. See system dividers
tablature 1330
tempo marks 532, 706, 1345, 1347
text 756, 1196, 1208–1214, 1358
thickness 872
through noteheads 1053, 1421
ties 1366, 1367
timecodes 1222
trills 1095, 1096
tuplet brackets. See tuplet brackets
types 1190, 1194, 1197
velocity 692
vertical 387, 1194, 1197, 1199
vertical position 1185, 1197, 1201
vibrato bar. See vibrato bar
width 612
wiggly 1095, 1108

linking 951
barlines 822, 824, 865
caesuras 1010, 1013
dynamics 460, 951, 952
fermatas 1010, 1013, 1014
flow names 187, 997
flow titles 187, 997
groups of dynamics 949, 950
Key Editor 671
MIDI 460, 705
percussion maps to VST/MIDI 522, 570
slurs 460, 1297, 1298
staves. See brackets. See also braces
tracks 671

lists
comments 496
Hub 69
players 181, 656

little finger. See pinky finger
Live Space dialog 739
Live Stage dialog 732
loading

MIDI instruments 528, 542, 558, 564
playback templates 564

loading (continued)
reverb 728, 729, 742, 744
sounds 528, 542, 558, 564, 727–729, 742, 744
space templates 742, 744
stage templates 735
video files 191
VST instruments 528, 542, 558, 564

local
chord symbols 318, 871
figured bass 395, 957
properties 646, 663–665

locations
backups folder 106

lock
duration. See lock duration
frames 505, 631, 632
Key Editor 671
layouts 631, 632
played durations 669, 688
systems 504, 631, 632, 635

lock duration 196, 472
loco. See octave lines
locrian

chord symbols 323, 885
scales 484, 485, 492

lower case
chord symbols 872
flow titles 659
Roman numerals 659

lower limits. See limits
lower notes

percussion 238, 1421, 1424
trills 1107

lower zone 30, 37, 205
Engrave mode 663, 717
hiding 44
key commands 44
Key Editor. See Key Editor
Mixer panel. See Mixer panel
Play mode 667, 717
Properties panel. See Properties panel
Setup mode 120
showing 44
Write mode 663, 667, 717

lute. See fretted instruments
lv ties. See laissez vibrer ties
lydian

chord symbols 323, 885
scales 484, 485, 492

lyric extender lines 392, 394, 395, 1029, 1031, 1045, 
1047

extending 392
handles 1045
inputting 392, 395
moving 514, 1045

lyric hyphens 1031, 1045
extending 392
gaps 1046
handles 1045
inputting 392
moving 514, 1045, 1046
paragraph styles 1042, 1045
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lyric lines 394, 1029, 1047
adding 392, 394
changing 1030, 1048, 1049
copying 1032
deleting 455
moving 1039
navigation 395
numbers 1047–1049
offsets 1039
placement 1036
position 1036, 1039

lyricist 75, 999
adding 999
bold 75, 756
exporting 102
first pages 648, 997
fonts 756, 999
italics 75, 756
tokens 658

lyrics 1029, 1352
alignment 1035, 1037
beaming 843
changing 1030, 1043, 1044, 1048
chorus 394, 1029, 1030, 1048
colors 56, 1041
copying 1032
counts 1043
crosshairs 517
deleting 455
East Asian elision slurs 1050
editing 1043, 1044
elision slurs 392, 395, 1050
exporting 1034
extender lines. See lyric extender lines
filters 429, 1034, 1035
font styles 1041, 1042, 1044
gaps 1035
handles 1036, 1039, 1045
hyphens. See lyric hyphens
inputting 392, 395
italics 1041, 1044
lines. See lyric lines. See also lyric extender lines
melismatic 392, 395, 1035, 1045, 1046
moving 461, 464, 514, 1037–1039, 1048, 1049
non-breaking spaces 392, 395, 1043
note spacing 508, 1035, 1037
offsets 1039
paragraph styles 1041, 1042
placement 1035
popover 392, 394, 395
position 1035
printing 1034
saving 1034
selecting 423, 429, 1035
size 1041, 1042, 1044
slurs 1050, 1290
spaces 392, 395, 1043
spacing 508, 1035, 1037, 1039, 1041, 1042, 1044
staff-relative placement 1038, 1039
statistics 106
syllable types 395, 1031
text 1043, 1044
ties 247, 262, 392, 1035, 1045, 1046, 1366

lyrics (continued)
translations 394, 1029, 1030, 1048
types 394, 1029, 1031
verse numbers 1041, 1042, 1049
vertical position 1029, 1030, 1038, 1039, 
1047–1049
zoom 1043

M
macOS

printing 584
main chord symbols 157, 158, 163, 164, 166

transposing 162
major

chord symbols 321, 322, 872
intervals 469, 470, 472, 487
keys 1021
scales 484, 485, 492, 1021

make into
frame 505, 638
system 504, 635

Manage Instrument Filters dialog 446
mandolin. See fretted instruments
manual staff visibility 606, 607
manuscript paper 608

bar numbers 826
barlines 283, 817, 818, 820–822
key signatures 280, 281
rests 1277, 1279
staff labels 1310
staves 124
width 600, 601, 612

Map Pitches dialog 483
Map Scale dialog 485
maps

expression. See expression maps
key commands 61
percussion. See percussion maps
pitches. See pitch mapping
scales. See scale mapping

marcato. See articulations
margins 614, 1001

changing 513, 601
chord diagrams 898
flow headings 615
hiding 437
instrument names. See staff labels
music frames 614, 616, 624
MusicXML files 82
pages 598, 601, 614
staves 513, 612, 614, 616, 1310, 1311, 1328
tacets 642

marimba. See instruments. See also grand staff 
instruments
mark-up. See comments. See also annotations
Markdown 75

text items 58
markers 1221, 1226

colors 56
comments. See comments
deleting 402, 455
dialog 402
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markers (continued)
exporting 95, 96, 101, 102
filter 429
flags. See signposts
font style 1224
hiding 1221, 1240
important 403, 1225
importing 97
inputting 401, 402, 534
moving 461, 1224
panel 402
repeats 406, 1236
showing 1221, 1240
signposts. See signposts
staff 1222
staff spacing 603, 621
text 97, 401, 402, 1223
timecodes 402, 1224
track 534, 536
vertical position 603, 621, 1222

marks
rehearsal. See rehearsal marks
tempo. See tempo marks
trills 1090, 1091, 1094, 1104

marquee tool 40
Key Editor 676
using 424, 676, 715

martelé. See articulations
masking. See hiding
master output volume 717, 718, 720, 721, 725
master pages. See page templates
matches

options search 58, 745, 747, 749
Maximizer 722, 728
measured tremolos. See tremolos
measurement

units 51
measures. See bars
medium swing. See swing playback
melismatic lyrics 392, 395, 1035, 1045, 1046
melodic minor. See scales. See also key signatures
melodies

chords 251, 871, 878, 894, 895
inputting 224, 227, 230. See also note input
playback 540, 545, 547, 955, 956
stems 232, 643
voices 232, 545, 643, 1438

meno. See tempo marks. See also dynamic modifiers
Mensurstriche 823
merging

beams 840, 841
flows 78, 85, 609
notes 91, 251, 254, 262, 643, 860, 861, 863
pedal lines 1170
players 78, 79, 82, 85, 88, 91
projects 78
rests 245, 262, 860, 861, 863, 1272, 1273
staves 643
voices 88, 91, 643

messa di voce 945
aperture 938
duration 317
gaps 944

messa di voce (continued)
grace notes 945
handles 938, 945
inputting 309, 312, 313, 315, 946
length 944
moving 461, 922, 938, 945
showing 946
ties 313, 315, 461

meter 1381
beam grouping 841, 861
changing 432
channel levels 717, 718
cut common time 863
irregular 810, 813
note grouping 841, 860, 863, 1262
open 1382, 1389, 1391
rest grouping 841, 860, 863
rhythm slashes 1262
time signatures. See time signatures
tremolos 1399
tuplets 1408

metric modulation
tuplets 1410

metronome click. See click
metronome marks 1335, 1336, 1341

appearance 1343
approximate 1343
beat units 294, 432, 1341, 1342
brackets 1341, 1343
changing 432, 709, 1342, 1344
click 267, 533
components 1343
decimal places 298, 299, 1342
equations 296, 1349
fonts 1339
hiding 298, 1340
inputting 293, 298, 299, 708
moving 461, 514, 1345
multiple positions 1326, 1327
order 1345
parentheses 1341, 1343
period 1343
playback 267, 533, 555, 1342
popover 293
range 1342
relative tempo changes 1344
selecting 423
showing 1340
size 1339
staves 1327
trills 1106
values 432, 709, 1342
vertical positions 1326, 1327

mezzo
dynamics. See dynamics

microtones 800
EDO 1028
guitar bends 356, 1125, 1128
identifying 38
intervals 487, 488
MIDI pitch 38
playback 764
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microtones (continued)
transposing 489
trills 1098–1100

mid-system gaps
codas 1236, 1241, 1242

middle C 51
changing 51
clefs 907
expression maps 767
fretted instruments 153, 154, 156, 161
Groove Agent 94
inversions 479, 489
percussion maps 781
pitch mapping 483, 492
playback 51, 545, 767, 781

middle line
stem direction 1074

MIDI
accidental spelling 245
channels 522, 567, 717, 718, 720, 721
commands 60, 63
controllers. See MIDI controllers
copying 460, 676, 705
deleting 677
devices. See MIDI devices
dialog 85, 93, 96
editor. See MIDI CC editor. See also MIDI Pitch 
Bend editor
endpoints 567, 569, 571, 572
exporting 99
expression maps 761, 762, 776, 777
fader 718
files. See MIDI files
glissando lines 1119, 1120
Histogram tool 710, 712
importing 85, 93, 94
inputting 703, 705
instruments 522, 526, 531. See also MIDI 
instruments
Key Editor 701
linking 460
loading instruments 528, 542, 558, 564
markers 534
middle C 51
mixer 717, 718, 720, 721
navigation 63
note input 223, 235, 245
note range 130
opening 72
order 767
overlapping notes 259
overriding 705
pan 718, 720, 726
patterns 94
pedal lines 1178
percussion maps 522, 570, 780, 781, 784
piano roll editor 678
pitch bend 701, 764, 1119, 1120
pitches 38
playback 531, 567, 780
ports 522, 567
quantization 93
range 130

MIDI (continued)
recording. See MIDI recording
slurs 1308
tempo 532, 543, 706
Tempo editor 706
tempo track 532
tempo tracks 97–99
thru 216
unlinking 460
values 704, 710, 711, 714
volume 955

MIDI CC editor 574, 700, 701
adding 675, 701
closing 675, 701
constant points 704
copying points 676
deleting points 677
filter 712
height 673
Histogram controls 711
inputting points 703
linear points 704
moving points 704
pedal lines 1178
selecting points 676
Transform controls 714
transformations. See Transform tool. See also 
Histogram tool
values 704, 710, 712, 713, 715
zoom 674

MIDI channels 717, 718, 720, 721
MIDI controllers 701, 955

copying 460, 676, 705
dynamics 955
editor. See MIDI CC editor. See also MIDI Pitch 
Bend editor
inputting 675, 703, 705
pedal lines 1178
Transform tool 713
transformations. See Transform tool. See also 
Histogram tool
values 704, 710–715

MIDI devices 270
activity 38
chord symbols 318, 522, 535
disabling 270
enabling 270
expression maps 761, 776, 777
note input setup 240
panning 730
percussion kits 240
percussion maps 780, 784
playback templates 558, 559
polychords 318
reverb 738
space templates 738
stage templates 730
warning 38

MIDI files 85
dialog 85, 96
exporting 95, 96
grace notes 93
importing 85
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MIDI files (continued)
key signatures 91
opening 72
pedal lines 85, 91, 270
percussion maps 88
playback overrides 689
playing techniques 91
quantization 85, 93
repeats 549
requantizing 266
slurs 91
sustain pedal controllers 270
tremolos 91
trills 91
tuplets 93
unpitched percussion 85

MIDI Import Options dialog 85
MIDI instruments 522, 526

endpoints 571, 572
instances 526
loading 528, 542, 558, 564
numbering 526
panel 525

MIDI Pitch Bend editor 700, 701
adding 675
closing 675
copying points 676
deleting points 677
height 673
moving points 704
selecting points 676
transformations. See Transform tool. See also 
Histogram tool
values 704, 712, 715
zoom 674

MIDI points
copying 460
linking 460
unlinking 460

MIDI Quantize Options dialog 93
MIDI recording 264

audio buffer size 268, 269
click settings 267, 533
count-in 268
devices 270. See also MIDI devices
dialog 93
grace notes 93, 1004
input pitch 215
latency 269
MIDI thru 216
optimization 268
overlapping notes 259
pedal lines 268, 270
pitch 215
quantization 93, 264
repeats 266
requantizing 266
retrospective recording 266
setup 268
slurs 268
starting 264
stopping 264
sustain pedal controllers 270

MIDI recording (continued)
tempo mode 543
time signatures 264
transport window 555
tremolos 268
trills 268
voices 264

MIDI thru 216
MIDI trigger regions 574

changing 432
handles 574
highlights 575
inputting 420
length 430
moving 461
pitch 51
popover 420
velocity 420, 574
viewing options 575

millimeters
frame dimensions 38
staff spacing 624
unit of measurement 51

milliseconds 32, 555
delay 769

mini transport 30, 32
minims. See half notes
minor

chord symbols 321, 322, 872
intervals 469, 470, 472, 487
keys 1021
scales 484, 485, 492, 1021

minutes
duration tokens 656, 659
timecodes 1226
transport 32, 555

Missing Fonts dialog 73
missing sounds

loading 564
mixer 717, 718

channel strips 722
channels 717, 718, 720, 721, 724, 728
filters 722, 724
height 719, 724
hiding 717–719
hiding audio outputs 567
muting tracks 547, 548, 717–719
panning 720, 726
ports 717, 718
resetting 548, 717, 725
scrolling 724
showing 717–719
soloing tracks 547, 548, 717–719
soundtracks 193
toolbar 719
videos 193
volume 725

Mixer panel 717
key commands 44

mixolydian
chord symbols 323, 885
scales 484, 485, 492
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mock-ups
exporting 100

modal
chord symbols 323, 885
glissando lines 1119, 1120
scales 484, 485, 492

moderato. See tempo marks
modern accidental cancellation 802
Modernist accidental duration rule 800, 801
modes 19, 30

chords 218, 885
Engrave 502
glissando lines 1119, 1120
Insert 218, 237, 254, 451
jump bar 65–67
Play 519
Print 576
scale mapping 484, 485, 492
Setup 109
tempo 543
transposing 484, 485, 492
Write 195

modifier keys
key commands 61
searching 61

modifiers. See dynamic modifiers
modulation wheel dynamics 955
molto

centered 935
dynamics 309, 312, 932, 935
font style 953
marcato. See articulations
moving 936
tempo marks 293, 296

monochrome graphics 596
MonoDelay 722, 728
monophonic legato 769, 1308
monophony. See polyphony
MonoToStereo 722, 728
moon noteheads 1056, 1058
mordents. See ornaments
morendo. See gradual tempo changes. See also 
dynamic modifiers
MorphFilter 722, 728
mosso. See tempo marks
motors. See playing techniques
mouse editing

activating 212
deactivating 212

mouse input 210
activating 196, 212
deactivating 196, 212
settings 211

movements 20, 171
adding 171
exporting 80
flow headings 651
importing 78, 79
multiple on pages 609
splitting 501
tacets 640

movies. See videos

moving 439, 461, 464, 514
accents 807
accidentals 797
arpeggio signs 1111
articulations 807, 808
bar numbers 832
bar rests 1275
barlines 455, 821
bars 631, 634–637
braces 865, 866
brackets 865, 866, 890, 893, 1072
breath marks 1013
caesuras 1013
cancellation naturals 1023
caret 223, 254
channels 724
chord diagrams 900
chord symbols 880–882, 890, 893
clefs 138, 461, 464, 908, 909
comments 500
counts 1243, 1257, 1267
crosshairs 517
cursor 274, 325, 395, 400
dives 1133, 1135
dynamics 461, 698, 922, 924, 934, 936, 938, 945, 
949–952
fermatas 1013, 1015
figured bass 961, 965, 966
fingerings 900, 984, 987, 988
flow headings 615, 624
flows 173, 637, 638
frame breaks 633
frames 614, 615
glissando lines 1119
grace notes 1004, 1005, 1007
gradual dynamics 461, 922, 938
guitar bends 1131, 1133–1135
H-bars 1281
hairpins 461, 922, 938, 945
hammer-ons 1142
hold lines 1131
instrument changes 138
instruments 135, 136, 170, 732, 733, 736
jazz articulations 1147
Key Editor 674
key signatures 138, 1023
layouts 179
lines 1198–1202, 1215
lyric extender lines 1045
lyric hyphens 1045, 1046
lyrics 1037–1039, 1048, 1049
marcato 807
markers 1224
messa di voce 461, 938, 945
MIDI points 704
modifiers 936
multi-bar rests 1281
navigating. See navigation
notehead brackets 1071, 1072
notes 461, 466, 468, 507, 683, 685, 1062, 1440, 
1442, 1443
notes to other staves 464, 465, 685, 851, 854
notes to other strings 1332
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moving (continued)
numbered bar region counts 1257
octave lines 918
ornaments 1091
pages 442, 539
panning 726
parentheses 890, 893
pedal lines 91, 1163, 1167
percussion 149
piano roll 674
players 125–127, 170
playhead 441, 538, 539, 542
playing techniques 1184, 1185, 1188
pull-offs 1142
repeat counts 1243
resolutions 966
rests 507, 1275
rhythm dots 1062, 1063, 1442
rhythm slashes 1269
selection. See navigation
slash region counts 1267
slashes 1007
slurs 1294, 1302
staccato 807
staves 125–127, 513, 602, 603, 614, 616, 624
stop positions 453
stress marks 807
string indicators 995, 1184, 1185, 1188
subito 934
system breaks 633–635
systems 624, 627, 634, 635, 637, 638
tablature notes 1332
tabs 48
tacets 642
tapping 1142
tempo marks 709
tenuto 807
text 514, 1356, 1357
text on lines 1210, 1211
time signatures 1394, 1395
tremolos 1404
tuplets 464, 1417
vibrato bar 1135, 1184, 1188
view 440–442, 539, 674, 724

mp. See dynamics
MP3 files

exporting 100, 101
muffed notes. See dead notes
multi-bar rests 640, 1245, 1279

bar numbers 826, 828
barlines 306
clefs 1280, 1281
hiding 1279
key signatures 1280, 1281
moving 1281
showing 1279
signposts 450, 1281
single bars 1279
splitting 1279, 1281
tacets 640, 641
time signatures 1280, 1281
width 1280

multi-note tremolos. See tremolos

multi-pasting 458, 459
multi-rests. See multi-bar rests
multi-segment slurs 1298, 1299, 1301
multi-staff instruments 1323

beams 851–854, 1078
cross-staff 851–854, 1078
hiding staves 605–607, 621
slurs 273
stems 852, 1078
tremolos 851, 854

multiple
bar numbers per system 831
bounce roll. See tremolos
codas 1237
flows on pages 609
movements 171
segnos 1237
staff input 222, 235

multiple-voice contexts 1438
articulations 805
dynamics 434, 931
fermatas 1012, 1014
grace notes 1002, 1285
guitar pre-bends 1129
inputting notes 232
note alignment 1440
notes 1444
ornaments 434, 1091
rests 1271, 1273–1275
rhythm dot consolidation 1062
slashes 1263, 1268
slurs 1285
stem direction 1002, 1075, 1444
ties 1369
voice column index 1442

music
arranging. See arranging
condensing. See condensing
deleting 127, 136, 174, 452, 455, 810–812
editing 210
extracts. See flows
fixing into frames 638
fixing into systems 635
playing back. See playback
transforming. See transformations

music area 34
making selections 424
moving music 440–442, 539
multiple windows 49
navigation. See navigation
opening flows 521
opening layouts 33, 43, 47
page arrangements 41, 50
panels 44
Play mode. See track overview
view options 40, 41, 50
zoom options 42, 443, 444

music fonts 69
substitutes 754

Music Fonts dialog 753
music frame chains 662

propagating part formatting 643
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music frames 654
frame chains. See music frame chains
fullness 506
highlights 502, 624
margins 614, 616, 624
padding 506, 614, 616, 624
vertical justification 621

music symbols
character styles 759
inputting 388, 391, 657
text 388, 391, 657
tokens 657

MusicXML
barlines 450
chord symbols 893
dialog 84
exporting 83, 84
importing 82
opening 72
pedal lines 1179
percussion 83
repeat endings 1235
resetting beaming 844
signposts 450
staff labels 1310

muted
colors 549
notes. See dead notes

mutes. See playing techniques
muting

channels 547, 720, 729
colors 549
deactivating 548, 717–719
effects 729
inserts 729
instruments 547
items 548, 549
MIDI keyboards 216
notes 215, 548, 549
slash notes 466, 1258, 1260
tracks 547, 717, 718
voices 547

mutual exclusion groups 771
editing 779

N
names

channels 728
composer 998
drum sets 143
flow headings 651
flows 187, 188, 588, 997
groups 151
instrument filters 446, 449
instruments. See instrument names
layouts 181, 183, 588
lyricist 999
mixer 720, 728
noteheads 1057
percussion kits 143, 151
player groups 167, 169, 1317
players 181–183, 656, 1313

names (continued)
staff labels. See staff labels. See also instrument 
names
tokens 655

naming schemes
file names 588

narrow time signatures 1397
Nashville

chord symbols 320, 872
numbers 320

natural harmonics 1081
appearance 1085, 1087
hiding 1082
inputting 367, 1082
showing 1082

natural minor. See scales. See also key signatures
naturale. See playing techniques
naturals

hiding 793, 801, 802, 1084
inputting 244
parentheses 793, 801, 1084
showing 793, 801, 802, 1084

navigation 65, 439
bars 441
caret 223
chord symbols popover 325
figured bass popover 400
fingerings popover 274
flows 440
handles 511, 516, 624
items 439
jump bar 65, 66
Key Editor 674
layouts 43, 47
lyrics popover 395
mixer 724
music area 439
note input 224, 226, 227, 242
notes 439
pages 441, 442, 539
part layouts 43, 47, 521
percussion editor 674
piano roll 674
playback 538, 540, 542
print preview area 36, 576
rehearsal marks 442
rhythmic grid 217
selections 421–424, 439
strings 154
Write mode 439

near send 739, 741
nested

slurs 1286, 1295
tuplets 1408, 1409

new projects 71
New York chord symbols 872
niente 947

circle 947, 948
deleting 948
duration 317
inputting 309, 312, 313, 315, 948
moving 922, 938
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niente (continued)
styles 948
text 947, 948

no chord symbols 323
nodes 1081

changing 1083
non-arpeggio signs. See arpeggio signs
non-breaking spaces 392, 395, 1043
non-drop frame timecodes 1226
non-power of two time signatures. See time signatures
non-sustaining instruments 953

velocity 691. See also Velocity editor
non-transposing layouts 178
nonuplets. See tuplets
notated duration 687–689

played duration 687
requantizing 266
tool 669

notation options 27, 747
barlines 816, 818
beaming 840
dialog 747
percussion kits 1426
rests 1274
saving as default 747
searching 747
voices 1439

Notation Options dialog 747
notation reference 791
notation staves 1330

hiding 1331
showing 1331

notations
appearance 663
changing 432
copying 457–459
editing 663
inputting 22, 271
panels 195
percussion kits 1426
popovers 22
position 663
properties 663
selecting 422–424
settings 745, 747
stacking order 518
tucking index 518
zoom options 42, 443, 444

Notations toolbox 201
notches

pedal lines. See pedal retakes
slurs 1289, 1290
ties 1366

note and rest colors 56, 1064, 1275
changing 54, 56
exporting 585, 597
hiding 437, 549, 1064, 1439
inverting 55
muted 549
notehead sets 1057
notes out of range 54, 1064, 1330
printing 581, 597
rests 1275

note and rest colors (continued)
tablature 1330
voices 54, 1439

note brackets. See bracketed noteheads
note durations 14, 200, 259, 687, 689

changing 259, 684
chords 251
different 232
expression maps 762, 777
forcing 262, 861
glissando lines 1121
hiding 200
inputting 224, 227, 259, 262
inputting beats 302
Key Editor 682, 684
metronome marks 294
notated. See notated duration
percussion 238, 682, 684
playback 749, 769
played. See played duration
quantization 93
rhythm dot consolidation 1062
selecting 259, 261
showing 200
slash regions 1262
splitting 261
tablature 242
tempo equations 295
transformations 477
tuplets 254, 257
voices 232

note event actions. See key switches
note grouping 23, 860

beaming 840, 841, 843, 844, 860
changing 262, 861
cut common time 863
hemiola 262
meter 841, 861
note input 23, 24
pick-up bars 1386
rests 23
rhythm slashes 1262
ties 247
time signatures 24

note input 223, 224, 227, 230, 681
adding notes 258, 488
caret 218, 223
chords 218, 251
Drum Pads panel 209
Fretboard panel 208
fretted instruments 208
grace notes 249
input pitch 215
inputting vs. editing 210
Insert mode 218
Keyboard panel 206
lock duration 472
MIDI 264, 266, 268
mouse input 212
multiple staves 222, 235
muting notes 215
percussion 94, 238, 240, 241, 682
piano keyboard 206
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note input (continued)
pitch 215
playing notes back 215
register selection 226
repitching notes 472
rests 1272
retrospective recording 266
rhythmic grid 217
starting 222
stem direction 241
strings 208
tablature 227, 242
ties 247
tuplets 254
voices 232

note names 492
case 57
chord symbols 320, 322, 323, 877
harp pedaling 1153, 1154, 1159
horn branch indicators 979
inversion 489
language 57
middle C 51
MIDI trigger regions 420, 574
noteheads 1057
piano roll editor 678
pitch mapping 492

note spacing 503, 507, 508, 687, 852, 1275, 1281, 1440
accidentals 797
activating 503
barlines 821
changing 507, 509, 1199, 1276, 1442
chord symbols 880
copying to other layouts 643
cross-staff beams 852
default 507
fullness 506
galley view 40
grace notes 1002
handles 509, 511
individual notes 509, 511
justification 506, 612
key signatures 1023, 1025
layout options 508, 745
layouts 507
lines 509, 1199
lyrics 508, 1035, 1037
rests 1276
reverting 512
rhythm dots 1442
stems 852
systems 506, 612
time signatures 1384
vertical lines 1199
voices 1442

note spelling 473, 475
adding notes 488
automatic 475
layouts 476
resetting 476
transposing 489

note tools popover 487
adding notes 258
transposing notes 472

note values. See note durations
note velocities

MIDI import 91, 268
notehead sets 1052, 1053, 1057, 1058

colors 1057
designs 1053, 1057
ledger lines 1062
pitch-dependent 1057
resetting 1059
scale degree 1057
types 1052

notehead-attached lines. See lines
noteheads 1053

aikin 1057
arrows 1055
articulations 808
brackets. See bracketed noteheads
changing 1058, 1059
circular 1053
colors 56, 1057
crosses 1054
cues. See cues
designs 1053, 1057–1059. See also notehead sets
diamond 1054, 1055, 1082, 1085
dotted 1056
dynamics 461
editing 1058
fermatas 1013
five-line staff 1423
funk 1057
hairpins 461
harmonics 1082, 1085
hiding 1060, 1065
large 1056
ledger lines 1062
lines 1205
moon 1056
muted 1056
note names 1057
overlapping 1440
parentheses. See bracketed noteheads
percussion 238, 682, 685, 1421, 1423–1425
pitch-dependent 1057
playing techniques 685, 1421, 1423–1425
rectangular 1056
resetting 1059
sets. See notehead sets
shapes 1053, 1057, 1058. See also notehead sets
showing 1060, 1065
size 433, 602, 617, 920, 1053, 1058, 1059
slashes 1056, 1258, 1421
square 1056
statistics 106
stemless 1079
time signatures 1391
triangular 1055
types 1053
unpitched percussion 1421, 1423
walker 1057
wedges 1055
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NotePerformer
trills 1106

notes 23, 1052
above staves 258, 468, 851, 871, 915, 1062, 1323
accidentals 200, 244, 468–470, 473, 475, 476, 792
adding to existing notes 258
alignment 924
appearance 663
arpeggio signs. See arpeggio signs
articulations 200, 805–807
auditioning 215, 216
auxiliary 1102
beaming 840, 841
below staves 258, 468, 851, 871, 915, 1062, 1323
brackets. See bracketed noteheads
brass fingerings 989
changing pitch 468, 472
chord symbol alignment 880
chords 251, 254, 326, 327
colors 54, 56, 549, 1057, 1064, 1439
condensing. See condensing
copying 457–459, 686, 805
crossing to other staves 464, 851, 854
cues. See cues
dead notes 1141
deleting 452, 455, 687, 810, 1403
deselecting 429
dotted 230, 841, 860, 863
durations 200, 259, 261, 682, 684, 687
dynamics 309, 691, 694, 921. See also Dynamics 
editor
dynamics alignment 923, 924
editing 196, 663
editorial. See bracketed noteheads. See also 
comments
enharmonic spelling 473, 475, 476
filters 429
fixing duration 262, 861
fonts 751, 753
ghost notes 1067
glissando lines. See glissando lines
grace notes 249, 1002, 1004
grouping 841, 860
guitar bends 354, 1122
guitar post-bends 356, 1125
guitar pre-bends 355, 1124
harmonics. See harmonics
harp pedaling 1153, 1154
hiding 574, 1060, 1065, 1263
hiding ledger lines 1062
hiding stems 1079
horizontal spacing. See note spacing
horn branch indicators 990
inputting 214, 223, 224, 227, 230, 237, 238, 251, 
262, 681, 682
Insert mode 237, 451
inverting 478, 479, 489
jazz articulations. See jazz articulations
Key Editor 667, 678
key signatures 469, 470, 473, 475, 476
laissez vibrer ties 1372
ledger lines 1061, 1062
length 259, 682, 684

notes (continued)
lines. See lines. See also glissando lines
lock duration 472
lyric alignment 1037
moving 478, 480, 1062, 1421, 1424, 1440, 1442
moving graphically. See note spacing
moving rhythmically 461, 683
moving to other instruments 465, 685
moving to other staves 464, 685, 851, 854
moving to other strings 1332
multiple-voice contexts 1440, 1444
muting 547, 548, 1141, 1180
navigation 439
notated duration 24, 688
note spacing 507
notehead designs 1053
notehead sets 1052
order 1442, 1443
out of range 54, 1064, 1332
overlapping 259, 1439, 1440, 1442
overrides 689
parentheses 1066, 1067
partials 1081
pedal lines 1167
percussion editor 676, 679, 681–685
percussion kits 142, 238, 682, 1419, 1421, 1428, 
1435
percussion maps 781
piano roll editor 667, 676, 678, 681, 683–685
pitch 468, 472
pitch mappings 482
pitch-dependent noteheads 1057
Play mode 681
playback 540, 545, 547, 548, 761
played duration 687, 689
popover 487
properties 663
ranges 54, 1064
register 226, 468, 472
removing stem direction changes 1078
repitching 472
requantizing 266
resetting 689
respelling 473, 475, 476
rests 1272
retakes 1167
reversing 478. See also retrograde
rhythm dots 230, 1062, 1063, 1442
rhythm slashes 1259
rhythmic grid 217
rolls. See tremolos
rotating 480
scale mapping 484
secondary beams 855
selecting 421–424, 429, 439, 676
showing 1060, 1065, 1263
size 433, 602, 617, 920
slash regions 1263
slashes 1258
slurs 200, 805, 1286
spacing. See note spacing
speed 259, 261, 859, 1335
spelling 473, 475, 476
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notes (continued)
splitting 196, 261, 1373
staff spacing 603
statistics 106
stem direction 466, 1074, 1076, 1077, 1435
stem length 1078
stemlets 858
stems. See stems
string fingerings 990, 991, 1059
string indicators. See string indicators
strings 1332
tablature 1332
terminology 14
ties 24, 247, 807, 1371
time signatures 1391
transforming 477
transposing 468–470, 472, 489, 685
tremolos. See tremolos
trill intervals 1099, 1100
trills 1094
tuplets 1408, 1410
types 200
unbeaming 843
undamped 1372
unisons 1440
unscaling 1004, 1410
velocity 691. See also Velocity editor
voices 232, 466, 467

Notes panel 195, 200
Notes toolbox 196
November music font 751, 753
nudging. See moving
numbered bar regions 828, 1253

changing number 1255
counts 1254–1256
font style 1250, 1254
frequency 1255
handles 430, 1253
hiding 1254
highlights 1247
inputting 419
length 430
moving 461
panel 409
parentheses 1256
placement 1257
popover 408
showing 1254
staff-relative placement 1257
systems 1254

numbers
backups 105
bar repeats 1247, 1248
barlines 551, 1230
bars. See bar numbers
bars per system 629
beam lines 856
chord diagrams 900, 901, 903, 904
condensing 1320
empty bars 106
exporting 106, 107
figured bass. See figured bass
flows. See flow numbers

numbers (continued)
frets. See frets. See also tablature
hyphens 1045, 1046
instruments 127, 131, 132, 733, 1315
layouts 180
lyric lines 1047–1049
moving 514
multi-bar rests 1279
numbered bar regions 1253–1255
pages 1150, 1151
plug-in instances 522, 525, 526
rehearsal marks 1217, 1218
repeats 551, 1230
rhythm slashes 1265
slash region counts 1265
slur segments 1299
staff labels 1315, 1320
staff lines 608, 1428, 1429
statistics 106
staves 106, 605, 1323
strings. See string indicators
systems 106, 630
systems per frame 630
tablature. See tablature
time signatures 1390
tuplets 1416
value fields 666
verses 1049

numerators
styles 1389, 1390
time signatures 1381

numeric value fields 666
nut

chord diagrams 895
fretted instruments 154
tablature 157, 159, 1330

O
oboe. See instruments
octatonic

chord symbols 323
scales 484, 485

octave divisions 1028
EDO 1028
playback 764, 1119, 1120
transposing 469, 470

octave lines 915
alignment 916, 917
crosshairs 517
deleting 455
Engrave mode 918
filter 429
frame breaks 918
handles 918
hiding 917
hooks 918
inputting 329, 331, 333, 335
layouts 917
length 430, 514, 918
moving 461, 464, 514
panel 335
placement 518
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octave lines (continued)
popover 329, 331, 333
position 518, 916, 917
selecting 423
showing 917
signposts 917
size 433
stacking order 919
staff-relative placement 434
system breaks 918
tucking index 518
types 331, 915

octave transpositions 468–470
cautionary accidentals 801
clefs 132, 330, 912, 913
figured bass 969
instruments 132
inversions 478, 479, 489
octave lines 331, 915
pitch mapping 482, 483, 492
scale mapping 484, 485, 492

Octaver 722, 728
octuplets. See tuplets
odd-numbered layouts

booklets 591
printing 581, 591

offsets 514, 666
accidentals 797
bar numbers 831, 832, 834–837
chord symbols 882, 893
fret numbers 903, 904
instrument changes 138
lyric lines 1039
multi-bar rests 1280, 1281
notes. See note spacing
played duration 669, 683, 684, 688, 689
rehearsal marks 1217
resetting 436
rhythm dots 1442
text 1356, 1357
timecodes 190, 1227
tuplets 1417
videos 190
voice columns 1442, 1443

omissions
chord diagrams 895, 904
chord symbols 322

opacity 450, 586, 596
open

key signatures 1021
meter 283, 287, 288, 1234, 1382, 1389, 1391
strings. See open strings
time signatures 283, 287, 288, 1382, 1389, 1391

open strings 1081
chord diagrams 895, 904
harmonics 1081
pitches 154, 156

opening 72
auto-saved files 104
documentation 69
editors 675, 716
files 72, 104
flows 521

opening (continued)
Key Editor 667, 675, 716
layouts 43
MIDI files 72, 85
mixer 717–719
MusicXML files 72
panels 44
projects 71–73, 104
Properties panel 44, 205, 663
sound libraries 529
tabs 45, 47
templates 71
transport window 555
video tutorials 69
video window 192
VST instruments 529
windows 49, 529
zones 44

optical spacing
cross-staff beams 852

optimized staves 603–605. See also condensing
optional notes. See bracketed noteheads. See also 
parenthesized chord symbols
options 27, 663

items 663
layout 745
notation 663, 747
page sizes 594
playback 749
preferences 58
properties 663
searching 58, 745, 747, 749
text formatting 389
toolbar 30
transport 30, 32
workspaces 30, 31
zoom 38, 42, 443, 444

orchestral
cues. See cues
instrument filters. See instrument filters
order 125, 126, 135, 167, 180, 1317
panning 726
project templates 71, 77, 114
shorthand 114
staff grouping 866, 1317
stage templates 731

orchestrating. See arranging
order 518

accidentals 795, 797, 1020
actions 767
articulations 806
band 125
chord symbols 887
comments 500
expression maps 762
fermatas 1185
flows 75, 173
frame chains 662
instrument filters 446
instruments 127, 131, 132, 135, 149, 182, 1315
jazz 125
key signatures 1020
layouts 179
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order (continued)
lines 1198, 1199
metronome marks 1345
MIDI messages 767
names 135, 182
notes 1442, 1443
orchestral 125–127, 135, 167, 1317
pages 41, 50
players 125–127, 167, 1317
playing techniques 1185
rehearsal marks 1217
repeat markers 1237
rhythm dots 1062, 1442
score 125–127, 167, 1317
staff labels 1315
string indicators 1185
tabs 48
tempo marks 1345
voices 747, 1439, 1442

Orff instruments. See instruments
organ. See instruments
orientation

changing 600
exporting 594
landscape 593, 594
portrait 593, 594
printing 581, 594

ornaments 1090
acciaccaturas. See grace notes
accidentals 1090, 1104
alignment 1091
appoggiaturas. See grace notes
changing 432
colors 56
crosshairs 517
deleting 455
filter 429
inputting 340, 341, 346, 347
intervals 1090
jazz 1146. See also jazz articulations
length 430
moving 461, 464, 478, 480, 514, 1091
panel 345, 347
placement 1091
popover 341, 346
position 1091
reversing 478. See also retrograde
rotating 480
selecting 423
slurs 1092
staff-relative placement 434
text borders 756, 1359
trills. See trills
types 341

Ornaments panel 347, 348, 350
ossia staves 1323

condensing 1323
moving 461, 464
playback 1323
signposts 450, 1323
staff spacing 603, 621
vertical spacing 603, 620, 621

ottava lines. See octave lines

outputs
audio export 58
mixer 567, 717, 718
panning 731–733
plug-ins 567
reverb 738, 739, 741, 742
volume 725

overdubbing
MIDI recording 266

overlapping
accidentals 795, 797
articulations 808
bar numbers 832
barlines 925
dynamics 925
notes 254, 259, 450, 623, 1062, 1439, 1440, 1442
slash regions 1268
slurs 1287
staves 600, 602, 603, 617, 623
text 450, 623, 1357
voices 1062, 1439, 1440, 1442

overline text 389, 756, 759
instrument names 184
staff labels 184

Override Percussion Noteheads dialog 1423
overrides

barlines 306, 307, 450, 819
beams 841, 843, 844, 854
clefs 112, 330, 332, 333, 910, 912
dynamics 696, 699
endpoints 571
flow headings 651
MIDI points 705
note duration 689
octave lines 917
paragraph styles 1356
placement 434
playback templates 558, 559, 561, 564, 571, 572
played duration 689
removing 689
rests 245
space templates 739, 741, 742, 744
stage templates 735
text 1356
transposition 112, 330, 910, 912, 917
velocity 689

overscroll 442
overtones. See partials

P
padding

auxiliary notes 1102
chord diagrams 898
chord symbols 872, 888, 893
clefs 909
dynamics 931
frames 598
harp pedaling 1158
lines 1214
music frames 506, 614, 616
percussion legends 1434
playing techniques 1183
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padding (continued)
rests. See padding rests
silence 101
text 756, 1214, 1360
time signatures 1394
trills 1102

padding rests 1271
hiding 1264
slash regions 1264

page arrangements 40, 41, 50
page breaks. See frame breaks
page formatting 598

bars per system 629
blank staves 608
casting off 629
copying 628
divisi 1329
empty staves 605, 608
fixing 629–631, 638, 643, 645, 646
flow headings 598, 651
formatting 647
left pages 609
locking 631
make into frame 638
make into system 635
moving systems 627
multi-bar rests 1281
multiple flows 609
page size 600
page templates 601, 647, 648
resetting 632, 651
staff size 617
staff spacing 603, 620, 628, 1357
staves 606, 607
systems 513, 603, 630
tacets 641
text 753, 754, 756, 759, 760, 1357
titles 647, 651

page margins 598, 614
changing 601, 616
hiding 437

page numbers 649, 1150
appearance 1150
count 659
deleting 1150
flow headings 611, 1151
flows 659
font styles 1150
guide 1152
hiding 611, 1151, 1152
horizontal alignment 1150
initial 609, 1151
numeral style 1151
page templates 649
paragraph styles 1150
showing 611, 1152
size 1150
tokens 659
total 659

page ranges
exporting 583, 584
flows 583, 584

page ranges (continued)
printing 583, 584
selecting 590

page size 593, 594
changing 600
graphics files 585
layout options 745
MusicXML files 82
new projects 69

page template overrides 1352
removing 651

page template sets 647
applying 601
flow headings 647, 651
layouts 601

page templates 25, 647, 648
assigning to pages 610
composer 648
copying 647, 648
default 648
first 610, 648
flow headings. See flow headings
page numbers 649, 1150
project templates 77
sets. See page template sets
titles 648
types 648

page turns. See frame breaks
page view 40, 50

arrangements 41, 50
bar numbers 829
flows 501
navigation 441, 442
page numbers 1152

pages
arrangements 41, 50
background color 54, 55
breaks. See frame breaks
changing view 50
color 53, 55
copying 647, 648
deleting 651
dragging 442
edges. See page margins
editing 651
exporting 583–585, 590
facing 647, 648
flow headings. See flow headings
formatting 997
frames. See frames
fullness 506, 602, 604, 617, 618
going to 441
height 600, 601, 604
hiding empty staves 606
layouts 598, 629, 630, 647
left 647, 648
locking 631
making from selection 638
margins 598, 601, 614–616
multiple flows 609
navigation 441, 442
numbers. See page numbers
orientation 600
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pages (continued)
page templates. See page templates. See also flow 
headings
printing 583, 584, 590, 594
ranges 590
rectangles. See frames
right 647, 648
setup 594
size. See page size
staff spacing 628
statistics 106
templates. See page templates. See also flow 
headings
tokens 659
total number 106, 659
turns. See frame breaks
view options 38
width 600, 601, 612

Pages panel 502
palettes. See panels
palm mute. See playing techniques. See also guitar 
techniques
panels 37, 201

accidentals 281
arpeggio signs 345, 348
bar repeats 409
barlines 303, 307
bars 303, 305
clefs 331, 333, 335
drum pads 209
dynamics 312, 315
Engrave mode 502, 663
flows 109, 120
formatting 504
fretboard 208
glissando lines 345, 350
guitar techniques 345, 354, 359, 361, 362, 364
hiding 31, 42, 44
holds 339
jazz articulations 345, 352
Key Editor 667
key signatures 279, 281
keyboard 206
layouts 109, 117, 577
MIDI instruments. See track inspector
mixer 717
notations 204
notes 200
octave lines 335
ornaments 345, 347, 348, 350, 352
pauses 339
pedal lines 371, 377
Play mode 519
players 109, 110
playing techniques 371, 374, 377
Print mode 576
print options 578
properties 663
repeat endings 409
repeat markers 409
rhythm slashes 409
Setup mode 109
showing 31, 42, 44, 205

panels (continued)
tempo 296, 299
time signatures 285, 288, 291
tonality systems 281
tremolos 409, 416
VST instruments. See track inspector
Write mode 195, 200, 204, 663

panning 718, 720, 726, 730–733, 736, 739, 741
paper

color 53
duplex printing 592
orientation 593, 594
size 593, 594, 600

paradiddle 224, 259, 1408
paragraph styles 753, 756, 829, 1219

bar numbers 829, 830
borders 756
changing 756, 758, 760, 1356
composer 998
condensing 1318
copyright 999
creating 758
default 760
deleting 756
dialog 756
divisi 1318
exporting 756
flow headings 651
horizontal alignment 756
importing 756
inputting text 388
instrument change labels 142
instrument names 1318
lyricist 999
lyrics 1041, 1042
missing fonts 73
overrides 1356
page numbers 1150
percussion kits 1319
player group labels 1317, 1318
rehearsal marks 1219
repeat markers 1237
resetting 1356
saving as default 756
staff labels 1318, 1319
tacets 640
titles 648, 756, 997
verse numbers 1041, 1042

Paragraph Styles dialog 756
parallel

lines 840, 855, 1012, 1115, 1186, 1324
parent styles

paragraph styles 756, 758
parentheses

accidentals 793, 801, 1084
bar numbers 838
bar repeats 1247, 1249
capo chord symbols 158, 872
chord symbols. See parenthesized chord symbols
counts 1249, 1254, 1256, 1265, 1267
dynamics 929
figured bass 397, 960, 963
fingerings 274, 276, 980, 981
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parentheses (continued)
fret numbers 1122, 1127
ghost notes. See bracketed noteheads
guitar bends 1122, 1124
harmonics 1084
hiding 890
inputting 318, 324, 395, 397, 793, 890, 929, 960, 
963, 1067, 1084
instrument transpositions 1315
metronome marks 1341, 1343
moving 893, 1072
noteheads. See bracketed noteheads
numbered bar regions 1254, 1256
octave line numerals 915
padding 893
pedal continuation signs 1175, 1176
percussion notes. See bracketed noteheads
playing techniques 1188
shape 891, 963, 1067
showing 890
size 892
slash regions 1265, 1267
staff labels 1315
string shift indicators 1059
style 891
tablature 1085, 1122, 1124, 1127
tempo marks 1341, 1343
thickness 891
tie chains 1069
time signatures 283, 287, 1389, 1392
trills 1102
vibrato bar dives and returns 1127

parenthesized chord symbols 889, 1066
capos 158, 872
moving 893
padding 893
showing 890
single 890
size 889, 891, 892
style 891

part formatting 643, 645
system formatting 643

part layouts. See layouts
part names 181, 183
partial

beams 855
capos 159–161
harp pedaling 1159
hiding. See erased backgrounds

partial bars. See pick-up bars
partials 1081, 1083
parts. See layouts
pasting. See copying
pataflafla. See grace notes. See also sixteenth notes
patches

endpoints 567
playback 567, 761, 780

path
audio 100
backups 106
flows 80
layouts 587
MIDI files 95, 96

path (continued)
MusicXML files 83
projects 656
tempo tracks 98

patterns
chord diagrams 894, 902–904
drum sets 94
Groove Agent 94
inversion 478, 479
mapping 482–485, 492
MIDI trigger regions 420, 574
pitches 482, 491
repeating 457, 482, 491
retrograde 478, 479
rotating 480, 481
scales 484, 485, 492

pauses 1010, 1012
appearance 432
barlines 1015
breath marks. See breath marks
caesuras. See caesuras
changing 1013
colors 56
crosshairs 517
default settings 1012
deleting 455, 1276
duration 432, 1016–1018
fermatas 1011, 1014
filter 429
hiding 1276
inputting 336–339
linked 1013
moving 461, 514, 1015
multiple at same position 1013
panel 339
playback 542, 1016–1018
popover 336, 338
position 1012
rests. See rests
selecting 423, 429
single staves 1013
staff-relative placement 1012
types 336, 1010, 1016

PDF files 595
color 596
exporting 585, 586, 588
file names 588
flows 585, 588
fonts 596
key commands 60
layout numbers 180
layouts 585, 586
page size 585
project preview 75

peaking 725
pedal level changes 1162, 1163, 1165, 1166

end level 1166
handles 1163
inputting 1165
removing 1167
start level 1165, 1166
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pedal lines 1153, 1161
alignment 1162, 1163, 1166, 1167, 1169, 1170
appearance 1171, 1173, 1176–1178
brackets 1175, 1176
changing 432
colors 56
continuation lines 1161, 1171, 1173–1175
crosshairs 517
dashed 1173
dashes 1174
deleting 455
duration 1178
end signs 1172, 1173
Engrave mode 1163
filter 429
formatting 1171–1173, 1175
gaps 1174
grace notes 1168
handles 1163
harp pedaling. See harp pedaling
hiding 1171–1173
hooks 1163, 1171, 1172
inputting 367, 369, 375, 377
length 430, 514, 1163, 1167, 1170
levels. See pedal level changes
lifts 1162
merging 1170
MIDI controllers 1178
MIDI import 85, 91, 270
MIDI recording 268, 270
moving 91, 461, 514, 1163, 1167
MusicXML import 1179
muting in playback 548
notes 1167
order 1167
panel 371, 377
parentheses 1175, 1176
percussion 1180
playback 1178
popover 369, 375
position 1167, 1168
releases 1171
removing retakes 1167
retakes. See pedal retakes
signposts 450
splitting 1169
staff-relative placement 1167
start signs 1171, 1176
text 1176–1178
thickness 1175
types 369, 1161

pedal retakes 1162
handles 1163
inputting 369, 375, 377, 378, 1170
notes 1167
pedal level 1166
removing 1167
types 1164

pedals
harp pedaling. See harp pedaling
piano. See pedal lines

percentages
Engrave mode 506
horizontal spacing 506, 508, 612
note duration 769, 1308
scale size 433, 581, 594, 892, 981
tempo marks 1336, 1344
vertical spacing 506, 604, 621

percussion
adding 112, 114, 124, 133, 146
articulations 1421
drum sets. See drum sets
grace notes 250
groups 167, 1317
instrument changes 133, 136
kits. See percussion kits
laissez vibrer ties 1372
legends. See percussion legends
MIDI 38, 667, 679, 701, 780
note input 94, 238, 240, 241, 681, 682
noteheads 685, 1421, 1423–1425
panning. See stage templates
part layouts 176, 1429
part names 181, 183
pitched percussion. See instruments
playing techniques 786
reverb. See stage templates
rudiments 224, 250, 259, 1002, 1399, 1405, 1408
staff labels 1313, 1317, 1319
staff lines 143, 152, 1428, 1429
system objects 1327
tremolos 786, 1421
unpitched percussion. See unpitched percussion

percussion editor 679
copying notes 686
deleting notes 687
height 673, 674
inputting notes 681
moving notes 683, 685
navigation 674
note duration 682, 684, 687, 689
played vs. notated durations 687
playhead 539
playing techniques 679
scrolling 539, 674
selecting notes 676
tools 669
tracks 530
zoom 674

Percussion Instrument Playing Techniques dialog 1421
percussion kits 142, 1419

adding instruments 146
adding to players 112, 133
caret 238
changing instruments 148
creating 112, 133, 142, 143, 146, 147
drum sets. See drum sets
dynamics 1427
editing area 143, 1428
exporting 152
filtering instruments 143
five-line staff 1322, 1428
gap sizes 152
grace notes 250
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percussion kits (continued)
grids 150–152, 1428
Groove Agent 574
groups 150–152
hits 1258, 1261, 1263
importing 153
individual instruments vs. kits 1419
inputting notes 94, 238, 682
instrument order 149
legends 1430
MIDI 38, 667, 679, 701, 780
moving notes 465
naming 143, 150, 151
notation options 1426
notations 1426
note input 240, 241, 681
noteheads 685, 1421, 1423–1425
patterns 574
playing techniques 685, 1420, 1421, 1424
presentation types 143, 1419, 1428, 1429
removing instruments 147
rests 747
rhythm slashes 1258, 1260, 1261, 1263
routing 569
rudiments 250, 1002
setting up 143, 240
single-line instruments 1428
spacing 152
staff labels 143, 150, 151, 1310, 1319, 1428
staff lines 143, 152, 1428, 1429
staff position 149, 240, 1421
staff-relative legend placement 434
staves 143, 1419, 1428, 1429
stem direction 143, 241, 747, 1435
stickings 1427
tracks 520, 531
voices 143, 747, 1435, 1436

percussion legends 1430
adding 1430
backgrounds 1433
changing 1431
crosshairs 517
erased backgrounds 1433, 1434
handles 1432
instrument names 1432
layouts 1430
length 1432
padding 1434
position 1430
ranges 1430, 1432
signposts 450, 1430
sounding instruments 1432
staff-relative placement 434
text 1433
types 1430, 1431

percussion maps 780
creating 784
custom 784
dialog 781
endpoints 522, 567, 570
exporting 785
file format 785
filters 781

percussion maps (continued)
importing 785
linking 522, 570
MIDI import 88
MIDI notes 38, 780
note input 240
playback techniques 781
resetting 781

Percussion Maps dialog 781
percussion stickings 1427
perfect intervals 469, 470, 472, 487
performance instructions 647, 648, 997, 1352

adding 388
parts 388
playing techniques. See playing techniques

period 14
dynamics 934, 943
lyrics 1031
possibile 934
rhythm dots 196, 230
subito 934
tempo marks 1343

Petaluma music font 751, 753
Phaser 722, 728
phrases

bar repeats 432, 1246
chord symbol regions 882
dynamics 313, 949, 954–956
slurs 1283

phrygian
chord symbols 323, 885
scales 484, 485, 492

piano 130
arpeggio signs 347, 348
beams 851–854
braces 867
chord symbol playback 535
cross-staff 851–854, 1078
depressed notes. See bracketed noteheads
dynamics. See dynamics
glissando lines 1119
hand marks. See lines
level changes 1162, 1167
panning. See stage templates
pedal lines. See pedal lines
playback 1178
position in score 125–127
retakes 1162, 1167, 1170
reverb. See space templates
score order 125–127
slurs 273
stems 232, 852, 1438
substitution fingering 972
tremolos 414, 416, 851
voices 232, 1438

piano roll editor 678
copying notes 686
deleting notes 687
height 673, 674
independent voice playback 678
inputting notes 681
middle C 51
moving notes 683
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piano roll editor (continued)
navigation 674
note duration 681, 684, 687, 689
pitch 51, 678, 681, 685
played vs. notated durations 687
playhead 539
scrolling 539, 674
selecting notes 676
tools 669
tracks 530
transposing notes 685
tuplets 678
zoom 674

piccolo. See instruments. See also transposing 
instruments
pick-up bars 1382, 1386

deleting beats 302, 452, 810, 811
inputting 283, 285, 289, 291, 452
signposts 450
turning bars into 452, 1386

pictures
videos 189

pincé. See ornaments
pinch harmonics 1085, 1089
PingPongDelay 722, 728
pinky finger 981

inputting 277
popover 277

pit band. See bands. See also project templates
pitch

accidentals 244, 469, 470, 473, 475, 476, 792
bends. See pitch bends
changing 51, 156, 468–470, 472, 685
changing string 1332
chord diagrams 903, 904
clefs 332, 333, 907
click 267, 533
concert 178
contour emphasis 955
dips 1142
display 38
expression maps 762, 776
filters 429
fretted instrument strings 156
guitar strings 156
guitar techniques 1142
harmonics 1081–1083
identifying 38
input 215
instruments 132, 134
inverting 478, 479, 489
jazz articulations 1145
key signatures 1019
mapping 482, 484
metronome click 267, 533
microtonal 487, 800, 1028
middle C 51
MIDI 38, 667, 678, 679, 700, 701, 761, 780, 1119
MIDI trigger regions 420, 574
note input 226, 244
noteheads 1052, 1057
octave lines 333, 335, 915
open strings 154, 156

pitch (continued)
ornaments 1090
partials 1081, 1083
piano roll editor 678, 685
playback 545
popover 487
ranges 764, 1064, 1119, 1120
repeating 482, 491
reversing 478, 479. See also retrograde
rhythm slashes 233, 1260
rotating 480, 481, 491
strings 154, 156, 903, 904, 1059, 1153
transposed 132, 178
transposing. See transposing. See also transposed 
pitch
trills 1097, 1099, 1100, 1103, 1104, 1107

pitch before duration 227
accidentals 214
activating 196
articulations 214
rhythm dots 214

pitch bends 1115, 1122
expression maps 764
glissando lines 764, 1119, 1120
guitar. See guitar bends
microtonal 764
MIDI controllers 700, 703

pitch contour emphasis 955
pitch mapping 482, 483, 492
pitched percussion. See instruments. See also 
transposing instruments
più. See tempo marks. See also dynamic modifiers
pizzicato. See playing techniques
placement

articulations 808
breath marks 1013
caesuras 1013
changing 434
chord symbols 882
dynamics 922
fermatas 1013
fingerings 971, 975
grace notes 1002
harp pedal diagrams 1158
lines 1198, 1201, 1202
lyrics 1035
octave lines 919
order 518
ornaments 1091
pauses 1012
pedal lines 1167
playing techniques 434, 1184
rehearsal marks 1216
rests 1271, 1274, 1275
slurs 1283, 1286, 1292
tempo marks 1336
ties 1368, 1377
tremolos 1400
tucking index 518, 919
voices 1440

plain font 753, 754, 756, 1352
bar numbers 829
chord symbols 877

Index
 

1528
Dorico Elements 5.1.30



plain font (continued)
figured bass 968
fingerings 906, 979
playing techniques 1180
rehearsal marks 1219
string indicators 993
tablature 1334
tasto solo 968
tempo marks 1339
time signatures 1397, 1398

Play mode 19, 519
channels. See channels. See also tracks
deleting notes 687
Endpoint Setup dialog 567
exporting expression maps 780
expression maps 761, 773
inputting notes 681
loading sounds 527, 528, 558, 564
MIDI instruments 522, 526, 528, 558, 564
mixer. See mixer
moving notes 683
note durations 682, 684, 687, 689
overrides 689
panels 37, 519, 522
percussion editor 679
percussion maps 780
piano roll editor 678
playback 540, 749
playhead. See playhead
switching 43, 519
toolboxes 519
track overview 520
tracks 530
transport 32, 555
VST and MIDI panel 525
VST instruments 522, 525, 527, 528, 558, 564
window elements 519
zooming 537, 674

playback 540, 558, 787, 1329
accents 809
activating 30, 540, 542
arpeggio signs 1112, 1113
articulations 545, 546, 749, 762, 809
audio buffer size 268, 269
bar repeats 1246
bracketed noteheads 1067
breath marks 1016
bypassing inserts 729
caesuras 1016, 1018
changing sound libraries 564
channels. See channels. See also tracks
chord symbols 522, 535, 536
chords 216
click 267, 532, 533, 540, 555, 706
deactivating 542
dead notes 1141
default settings 564, 735, 742, 744
default tempo 455, 1335
delay 722, 727, 728, 769, 1121
dynamic curve 954
dynamics 215, 545, 546, 694, 769, 931, 953–955
elapsed time 555, 558
endpoints 522, 567, 569–572

playback (continued)
excluding items 548
exporting audio 100, 101
expression maps 761, 762
faders 717, 718, 725
fast-forwarding 538
fermatas 1016, 1017
fixed tempo 543
flows 569
follow tempo 543
gap between flows 545
gaps 1016–1018
ghost notes 1067
glissando lines 764, 1119–1121, 1153
grace notes 1009
guitar bends 1122
harmonics 1081–1083
hiding notes 1263
instrument sounds 528, 529, 558, 564
instruments 545, 546, 761, 780
jazz articulations 787, 1145
Keyboard panel 206
legato 749, 769, 1308
line 538, 539
loading sounds 528, 529, 558, 564
marcato 809
metronome 555
metronome click 533
microtones 764
MIDI controllers 701
MIDI thru 216
mixer. See mixer
multiple windows 49
muting 547, 548, 717
mutual exclusion groups 779
note durations 687, 749, 769
note velocity 691
notes 215, 216, 545, 546
number of times played 551, 1230
options. See playback options
ornaments 1090
ossia staves 1323
overrides 689
panning 726, 730, 731, 735
patches 567
pauses 1016–1018
pedal lines 1178
percussion 522, 570, 679, 685, 780, 781, 1420, 
1421, 1423, 1424
pitch 545
playhead. See playhead
playing techniques 545, 546, 777, 787, 788
playthroughs 548–551, 1230
plug-ins 718
pre-roll 544
preferences 58
recording notes 266
repeats 549–551, 1230
resetting volume 725
reverb 720, 721, 729, 738, 742, 744
rewinding 538
scrubbing 542
selections 540
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playback (continued)
silence playback template 558, 559
slashes 466, 1258, 1260, 1263
slurs 273, 545, 546, 749, 1308
soloing 547, 548, 717
sounds 528, 529, 558, 564
space templates 738
spatial sounds. See stage templates. See also space 
templates
staccato 809
stage templates 730, 731
starting 540
swing 552–555
templates. See playback templates
tempo 532, 543, 555, 706, 1016, 1342, 1344
tempo equations 1349
tenuto 809
timecode 555, 558, 1221, 1226
transport 555, 558
tremolos 545, 546, 786, 1405, 1406
trills 1104–1106
tuning 545
velocity 691
vibrato bar dives and returns 1127
voices 545, 546, 569
volume 215, 717, 718, 725

playback options 27, 749
dialog 749
dynamics 954, 955
pedal lines 1178
repeats 549
saving as default 749
searching 749
slurs 1308
swing playback 553
timing 809, 1112
tremolos 1405
trills 1104

Playback Options dialog 749
Playback Technique Combinations dialog 773
playback techniques 567, 777, 787, 788, 804, 1180

attribute 788
combinations 773, 777
creating 788
deleting 779, 788
direction 788
display 38
editing 788
endpoints 567
expression maps 761, 762
fallback 788
identifying 38
mutual exclusion groups 779
percussion 786
percussion maps 781
playback templates 558
resetting 788

playback templates 558, 559
changing 564
creating 522, 528, 529, 564, 569, 570
custom 558, 561, 564
dialog 559, 561
endpoint configurations 525, 567, 571, 572

playback templates (continued)
exporting 566
factory default 559
fallback 561
file format 558
importing 566
metronome click 267, 533
overriding 558
resetting 564
space templates 561, 566, 738
stage templates. See stage templates
track inspector 522

played duration 687, 1009, 1406
changing 689
key commands 689
locking 669, 683, 684, 688
notated duration 687
overrides 689
resetting 689
slurs 1308
tool 669

player cards 110, 121
disclosure arrows 42

player group labels 1309, 1317
fonts 1317, 1318
hiding 1317
showing 1317

player groups 110, 167
adding players 168
bracket grouping 824
creating 91, 168
deleting 169
ensembles 114
filters 446
labels. See player group labels
MIDI import 91
moving players 170
naming 169
panning 733
removing players 170

player labels
hiding 141, 1317
showing 141, 1317
staff labels 1309, 1313, 1317, 1320

player names 181
changing 182
groups. See player group labels
hiding 1310, 1312
instrument tracks 531
length 1310, 1312
resetting 182
showing 1310, 1312
staff labels 1310, 1312, 1313
tokens 656

players 21, 121, 123
adding 112, 114, 124, 128, 129, 133, 168
adding to flows 172
brackets 865, 866, 1317
cards 110
changing transposition 134
chord symbols 318, 878
clefs 910
colors 531, 678, 679
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players (continued)
combined parts 176
condensing 643
copying 125
deleting 127, 136, 169
divisi 1329
duplicating 125
empty staves 605
ensembles 110, 128
exporting 80
exporting audio 100
exporting MIDI 95, 96
extra staves 1323
figured bass 395, 958
flows 121, 172
groups. See player groups
hiding 172, 176
importing 78, 79
instrument change labels 141
instrument order 135
instruments 21, 50, 130, 133, 134
layouts 121, 176, 183
lists 181, 656
maximum number 123
merging 78, 79, 82, 85, 88, 91
MIDI import 85
moving 125, 126, 170
moving between groups 170
moving instruments between 135
multiple instruments 50, 133, 182, 1313
muting 547, 548, 717
naming 181–183, 1313
numbering instruments 131, 132
octave lines 917
ossia staves 1323
panel 109, 110
panning 726, 730
part layouts. See layouts
percussion kits 146, 147
pitch 132
player names 182
position in score 110, 125, 126
removing from flows 172
removing from groups 170
renaming 182
reverb. See space templates
saving 116
section players 110, 123, 124
showing 172, 176
single players 110, 123, 124
soloing 547, 548, 717
soloists 127
sorting 110, 125
staff labels 1313
staff size 618
statistics 106
staves 606, 607
swing playback 554, 555
system dividers 1324
tablature 1330, 1331
tokens 656
transposition 132
volume 725, 931

Players panel 109, 110
playhead 538

color 54
fast-forwarding 538
following 38, 539
hiding 539, 542
moving 441, 538, 539, 542
pausing 542
playback 540, 555
position 540
repeats 549
rewinding 538
showing 539, 542
transport 555, 558
zooming 537, 674

playing technique lines 1186, 1191
appearance 1189, 1190
caps 1191
changing 1190, 1193
components 1188
default settings 1186
duration 430, 1187, 1189
hiding 1189, 1190
showing 1189, 1190, 1192
system breaks 1188

playing technique-specific noteheads 1002, 1180, 
1419, 1421, 1423

appearance 1425
articulations 786
changing 685, 1424
creating 1425
inputting 238, 682
playback 786

playing techniques 1180
adding text 1181
backgrounds 1182
brackets 1188
changing 432, 685, 1424
collision avoidance 1185
colors 56
combinations 773, 777, 786
continuation lines 1186, 1190–1192
creating 1425
crosshairs 517
deleting 455
dialog 788
display 38
divisi 1329
duplicating 1189
duration 430, 1187, 1189, 1192
editor. See Playing Techniques editor
endpoint configurations 572
erased backgrounds 1182, 1183
exporting 102
expression maps 761, 762, 787
fermatas 1185
filter 429
font 1180
frame breaks 1188
grouping 1186, 1191, 1192
guitar. See guitar techniques. See also vibrato bar
handles 1187, 1188, 1191
harmonics. See harmonics
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playing techniques (continued)
hiding 372, 1183
identifying 38
inputting 367, 372, 374
length 430, 514, 1186, 1188
lines. See playing technique lines
MIDI import 87, 88, 91
moving 461, 464, 478, 480, 514, 1184, 1185, 1188
muting 548
noteheads 685, 786, 1421, 1423–1425
order 1185
padding 1183
panel 371, 374
parentheses 1188
percussion 786, 1420, 1421, 1423, 1427
placement 1184
playback 545, 546, 761, 762, 787, 788
popover 367, 372
position 1184, 1188
repeating 1189
reversing 478. See also retrograde
rotating 480
selecting 423
showing 1183
signposts 450, 1183
size 433
staff-relative placement 434
system breaks 1188
text 1180, 1181
ties 372, 374
tracks. See Playing Techniques editor
types 367, 1180
ungrouping 1193
vertical position 1185
voices 372, 374, 545, 546

Playing Techniques editor 690
hiding 690
showing 690

playing techniques lanes. See Playing Techniques 
editor
Playing Techniques panel 374, 377
playthroughs 549, 1230

bar numbers 838
changing 551, 1230, 1231
dividing 1231
MIDI recording 266
muting 548
optional notes. See bracketed noteheads
repeats 550, 551, 1016, 1230, 1231
total number 551, 1230

plops. See jazz articulations
plucked instruments

arpeggio fingering 985
fingerings 274, 981
popover 277
slides 986, 988
string indicators. See string indicators
strings 1059
tablature. See tablature
tuning 153

plug-ins 558
allowing 527
blocking 527

plug-ins (continued)
changing 529, 558, 729
configurations 561, 567, 569, 571–573
endpoints 522, 558, 567, 569, 570
expression maps 522, 570, 762
instances 522, 525
loading 528, 542, 558, 564, 727–729, 739, 742
mixer 567, 718, 722
opening 529
percussion maps 522, 570
playback 522, 525, 558, 718
reference 69
reverb 729, 739, 742
saving 571–573
windows 529

plus sign
caret 218
chord symbols 872
mutes. See playing techniques
rim shots. See playing techniques. See also playing 
technique-specific noteheads
tapping 1138
time signatures 283, 1382

PNG files 595
color 596
exporting 585, 586, 588
file names 588
layout numbers 180
layouts 585, 586
project preview 75
resolution 595
transparent 586

poco a poco
centered 935
dynamics 309, 312, 932, 935, 942
font style 953
moving 936
tempo marks 1346

points
constant 697, 704
copying 676, 699, 705
deleting 677
dynamics 694, 696–698
linear 697, 704
MIDI 701, 703, 704
selecting 676
staff spacing 624
tempo changes 706, 708
unit of measurement 51

polychord chord symbols 323, 871
arrangement 887
inputting 318

polymeter 287, 288, 1381
polyphony 1438

adding voices 232
changing voices 466
condensing. See condensing
MIDI import 88
MIDI recording 264
playback 545, 546, 956

polytonality 280, 281, 1019
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popovers 22, 201
add intervals. See note tools popover
arpeggio signs 343, 347
bar repeats 408, 418
barlines 301, 303, 304, 306, 307
bars 301, 304
beats 302
changing items 432
chord symbols 320, 325
clefs 329, 330, 332
commands. See jump bar
dynamics 309, 313
ensembles. See ensemble picker
figured bass 397, 400
fingerings 274, 276
glissando lines 343, 349
guitar techniques 343, 354, 356, 358, 360, 
362–364, 366
harp pedaling 370
holds 336, 338
instrument filters 445
instruments. See instrument picker
jazz articulations 342, 351
key signatures 278, 280
lyrics 392, 394, 395
metronome marks 293
MIDI trigger regions 420
note tools 258, 472, 487
numbered bar regions 408
octave lines 329, 331, 333
ornaments 341, 346, 347, 349, 351
pauses 336, 338
pedal lines 369, 375
playing techniques 367, 372, 375
repeat endings 406
repeat markers 406
repeats 406, 414, 418
rhythm slashes 408
string indicators 370
tempo 293, 298
time signatures 283, 287, 289
transpose 489
tremolos 407, 414
trills 341, 1100
tuplets 254, 256

port de voix. See ornaments
portamento. See glissando lines
portrait orientation 593, 594, 600

status bar 40
ports 522, 532, 567, 706

changing 569
chords track 522
expression maps 522, 567, 570
instruments 569
mixer 718
percussion maps 522, 567, 570
setup 567
Tempo editor 706
tempo track 532

position
arpeggio signs 1111
articulations 805, 807
clefs 213, 907, 908

position (continued)
dynamics 317, 922
figured bass 964
fingerings 971
grace notes 1002
gradual dynamics 944
hairpins 944
inputting 210
Insert mode 451, 453, 454
instruments in percussion kits 149
items 436, 663
jazz articulations 1147
key signatures 1022
lines 1197
new items 210
notes in multiple-voice contexts 1440
octave lines 916, 917
order 518
pauses 1012
pedal lines 1168
resetting 436
rhythmic 24
slurs 1283, 1286, 1292
stage. See stage templates
stop 451, 453, 454
string indicators 995
trill intervals 1104
tucking index 518
vertical order 518
videos 191

possibile. See dynamic modifiers
post-bends. See guitar post-bends
pre-bends. See guitar pre-bends
pre-dives. See guitar pre-bends
pre-roll 544

duration 544
flows 545

preamble 997
barlines 820, 821
clefs 911
key signatures 1022
page templates 647

precipitando. See gradual tempo changes. See also 
tempo marks
preferences

colors 52
comments 499, 500
key commands 60, 63
MIDI 270
missing fonts 73
mouse input 211
notations input 213, 317
note input 214, 215, 227
pedal lines 270
selection tools 40
sustain pedal controllers 270
theme 52

Preferences dialog 58
prefixes

dynamics 932, 933
fingerings 990
hiding 140
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prefixes (continued)
instrument change labels 57, 139, 140
rehearsal marks 1219

presentation types 143
changing 1429
dynamics 1427
editing area 143, 1428
percussion kits 1419, 1428

presets 27
background color 54
chord symbols 872
effects 775
instrument filters 446
staff size 617
zoom 42

pressure. See playing techniques. See also lines
presto. See tempo marks
preview

color 53, 54
file names 588
font styles 754, 756
images 75, 103
note spacing 508
print preview 36, 576
projects 75, 103

previous versions 73
primary

beams 855
instruments 671, 699, 703, 705

primary bar number sequence 835
changing 836, 837
returning to 838

primes 656, 659
primo

repeat endings 1230
Print mode 19, 576

landscape orientation 590
page setup 594
panels 37, 576–578
portrait orientation 590
printers 589
switching 43, 576

Print Options panel 576, 578
print preview area 36

navigation 36, 576
printers 589

selecting 581
printing 576, 581

annotations 597
arrangements 590
booklets 591
borders 597
comments 500, 597
copies 581
crop marks 597
date 597
duplex 581, 592
flows 583, 584
job types 590
key commands 60
landscape 590, 593
layouts 581
lyrics 1034

printing (continued)
macOS options 584
note colors 597
options 578
orientation 593
page sizes 593, 594
paper sizes 593
PDF files 585
portrait 590, 593
preview 36, 437
ranges 581, 583, 584
scale size 581
signposts 597
spreads 590
text 102
time 597
voice colors 597
watermarks 597

program change actions 761, 767, 775
Project Info dialog 75
project information 75

composer 998
copyright 999
exporting 77, 102
flow titles 187, 997
lyricist 999
page templates 648, 997
project templates 77
titles 997
tokens 75, 187, 648, 658

Project Statistics dialog 106, 107
project templates 71, 77

categories 77
Hub 69
MIDI import 85
starting projects 71

project window 29
dark 52, 55
Engrave mode 502
light 52
opening multiple 49
Play mode 519
Print mode 576
Setup mode 109
splitting 48
theme 52
width 40, 49
Write mode 195

projects 19, 75, 78, 121, 171
audio 100
auto-save 103, 104
backup location 106
backups 105
composer 998
copyright 999
default font styles 760
different Dorico versions 73
duration 656
exporting 83, 84, 95, 96, 98
exporting flows 80
file path 106, 587, 656
flows 78–80, 171, 188, 501
font styles 760
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projects (continued)
frame rates 194
full screen mode 49
Hub 69
importing flows 78, 79, 82
layouts. See layouts
lyricist 999
merging 78
MIDI files 95, 96
missing fonts 73
movements 171
multiple windows 49
MusicXML files 83, 84
opening 49, 72, 73, 104
PDF files 585, 595
preview 75
recent 73
recovering 104
settings 27, 745, 747, 749
splitting flows 501
start area 34
starting 71
statistics 106
tabs 48
templates. See project templates
titles 69, 188, 648, 651, 997
tokens 656, 658
videos 189, 191
window 29
workspaces 43

proofreading
accidentals 795
cautionary accidentals 795

Propagate Part Formatting dialog 645
propagating

part formatting 643
properties 646

properties 663
copying to other layouts 646
global 664, 665
local 664, 665
notations 663
notes 663
scope 663–665
searching 663
selected items 663
values 666
videos 190

Properties panel 663
disclosure arrow 38
key commands 44
Write mode 195, 205

pulgar. See thumbs
pull-offs. See hammer-ons
punctuation

duration 656, 659
timecodes 1226

Q
qualifiers 309, 312

quality
chord symbols 318, 321, 872, 886
intervals 487, 488
transposing 469, 470, 489

quantization 93
changing 266
grace notes 93
MIDI import 85, 91, 93
MIDI recording 93, 264, 268
requantizing 266
splitting notes 261
tuplets 93

quarter depressed pedal lines 1162, 1163, 1165, 1166
quarter notes 14, 200, 224, 259

beats 302
chords 251
glissando lines 1121
grace notes 249
hiding 1060, 1079
Insert mode 237
metronome marks 294
percussion 238, 682
pick-up bars 285, 289, 291
playback 749, 769
quantization 93
rests 245, 1271
rhythm dots 230, 860, 861, 863, 1062
rhythmic grid 217
showing 861, 1060, 1079
splitting notes 261, 861, 863
swing playback 552
tablature 242
tempo equations 1349
ties 860, 861, 863
tremolos 414, 416, 1399
tuplets 254, 257
voices 232

quarter tones 800, 1028
accidentals 800, 1028
guitar bends 356, 1125, 1128
octave divisions 1028
tonality systems 1028
transposing 489

quartet templates 71, 77, 731
staff grouping 866

quavers. See eighth notes
question marks

harmonics 1082
tablature 468, 1330

quick tool selector 669
quintet templates 71, 77, 731

staff grouping 866
quintuplets. See tuplets
quotation marks

duration tokens 656, 659

R
rack. See VST and MIDI panel
rallentando. See gradual tempo changes. See also 
tempo marks
randomization 711, 712, 714
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ranges
arpeggio signs 347, 348, 1111
bar numbers 828, 1254–1256
colors 54, 56, 1064
copying notes 459
counts 1254–1256
cues 920
dynamics in playback 954, 955
flows 583, 584
glissando lines 764, 1119, 1120
instruments 130, 154
keys 206
lines 387, 1111, 1203
metronome marks 1341, 1342
notes 154, 764, 1064, 1119, 1120
numbered bar regions 1254–1256
pages 581, 583, 584
percussion legends 1432
pitches 154, 764, 1064, 1119, 1120
selecting 424
slurs 1288
strings 154

rasterizing. See staff size
rastral size 617
ratamacue. See grace notes. See also tuplets
rates

frames 193
ratios

grace notes 1006
note spacing 508
swing playback 552
tuplets 1416, 1417

re-strikes. See guitar pre-bends
read-only mode 72, 123
recent projects 69, 73
recipes 588
recording

audio 100
click settings 267, 533
count-in 268
devices 270
input pitch 215
MIDI. See MIDI recording
pedal lines 268
playing techniques 268
retrospective recording 266, 555
tempo 543

Recover Auto-saved Projects dialog 104
recovering 266

backups 105
files 103–105
notes 233, 266, 1260

rectangle
above systems. See system track
bar number enclosures 827
borders 756, 1359
colored. See signposts
music. See music frames. See also frames
noteheads 1056
notes 678, 679, 687
text enclosures 756, 1001, 1358, 1359

redo 30, 438
history 438

reducing 174, 466, 617, 643
condensing. See condensing
note durations 259, 261
notes into chord symbols 326, 327

reeds 174
adding 112, 114, 124, 133
instrument changes 136
part names 181, 183
staff labels 1313
transposition 132

regions
bar repeats. See bar repeats
bars. See numbered bar regions
chord symbols. See chord symbol regions
counts 1247, 1254, 1265
dynamics 694
Key Editor 667, 676, 678, 679, 690, 694, 700, 701, 
706, 713, 715
MIDI notes. See MIDI trigger regions. See also MIDI 
CC editor
notes 678, 679
Play mode. See colored regions
playing techniques 690
selecting 424, 676, 713, 715
slashes 1261, 1262. See also rhythm slashes
tempo 706

register
changing 468, 470, 472
clefs 332, 333, 907, 913
note input 226
octave lines 333, 335, 915
plug-ins 527
transposing 472, 913

rehearsal marks 1216
barlines 1216
colors 56, 1219
crosshairs 517
deleting 455
enclosures 1216
exporting 102
filter 429
font 1219
going to 442
index 1217
inputting 400
moving 461, 514
multiple positions 1216, 1326, 1327
navigation 442
order 1217
placement 1216
position 1216, 1327
prefixes 1219
selecting 421, 425, 427, 428
sequences 1217, 1218
size 433, 1219
staff-relative placement 1216, 1327
starting number 1217
staves 1327
suffixes 1219
tempo marks 1216
types 1218
vertical positions 1326, 1327

relative channel change actions 775
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relative tempo changes 1336, 1344
releases

guitar bends 1122
handles 1131, 1135
tremolos 407, 414, 416, 1401

reloading
video files 191

removing. See deleting
Rename Player dialog 182
Rename Player Group dialog 169
renaming

channels 728
drum sets 143
endpoints 573
files 69
flows 187, 997
groups 151
instrument filters 446, 449
instruments 181, 183
layouts 181, 183
percussion kits 143, 151
player groups 169
players 181, 182
staves 181, 183
titles 187, 997

renumbering
bars 835–837
flows 173
instrument filters 446, 449
instruments 132
layouts 180

repeat barlines 816, 817, 1236
brackets 1230, 1234
counts. See repeat counts
end of systems 819
exporting 549
inputting 301, 303, 306, 307
MIDI recording 266
number of times played 551, 1230
panel 303, 307
playback 549, 550, 1016
playthroughs 551, 1230
popover 301, 303, 306
repeat endings 1230, 1234
start of systems 819
text. See repeat counts

repeat counts 1242
changing 551, 1230
hiding 1243
location 1243
moving 1243
showing 1243

repeat endings 1230
additional endings 410, 412
alignment 1233
appearance 1234
bar numbers 838
crosshairs 517
deleting 455
exporting 549
filter 429
final segments 1234
font style 1233

repeat endings (continued)
frame breaks 1233
handles 1232, 1233
hooks 1234
inputting 406, 409–412
length 514, 1232
MIDI recording 266
moving 461, 514, 1232
multiple positions 1233, 1326, 1327
MusicXML files 1235
number of playthroughs 1230
optional notes. See bracketed noteheads
panel 409, 411, 412
playback 549, 550, 1016
playthroughs 1230, 1231
popover 406, 409, 410
position 1233, 1327
segments 1230, 1233
selecting 421, 425, 427, 428
size 1232, 1233
staves 1327
system breaks 1233
text 1233
types 406
vertical positions 1326, 1327

repeat jumps. See repeat markers
repeat markers 1236

bar numbers 838
barlines 819
changing 432
crosshairs 517
deleting 455
exporting 549
filter 429
fonts 1237
hiding 1240
index 1237
inputting 406, 409, 413, 414
lines 1239
MIDI recording 266
moving 461, 514
multiple 1237
multiple positions 1241, 1326, 1327
number of times played 551
optional notes. See bracketed noteheads
order 1237
panel 409, 414
paragraph styles 1237
playback 549, 550, 1016
popover 406, 413
position 1241, 1327
showing 1240
size 1237
staff-relative placement 1241
staves 1327
text 1238
types 406
vertical positions 1326, 1327
word wrapping 1239

Repeat Pitches dialog 482
repeat sections. See repeat markers
Repeat Structures panel 409
repeating. See copying. See also repeats
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repeats
barlines. See repeat barlines
bars 1245, 1253
counts 551, 1230, 1247, 1254
dynamics 549
endings. See repeat endings
export 549
font style 1250
frequency 548, 1249, 1255
grouping 1251
length 432, 1246
markers. See repeat markers
moving counts 514
muting 548
notes. See tremolos. See also bar repeats
numbers 551, 1230, 1237, 1247, 1254, 1265
optional notes. See bracketed noteheads
playback 548–551, 1016, 1230
playing techniques 1189
tempo marks 549

repeats popover 406
repitching notes 472
replacing 432

fonts 73, 754
Key Editor configurations 715

replying
comments 494, 498

requantizing notes 266, 683, 684, 688
resetting 455

accidentals 792
appearance 436
background color 54
bar numbers 836, 838
beaming 844, 846, 850, 854, 856
capos 161–163
casting off 632
channel names 728
channel volume 725
character styles 759
chord diagrams 901, 904
chord symbol voicing 536
chord symbols 885
colors 54, 56
cross-staff beaming 850, 854
dynamic levels 956
dynamics 677, 954, 955
expression maps 772
faders 725
figured bass 970
fingering slides 987
fingerings 901, 984
flow headings 652
font styles 754, 756
instrument names 184, 187
items 436
key commands 65
layout names 183
layouts 180, 632, 651, 745
mute states 548, 717
note spacing 512
note velocity 693
noteheads 1059
options 58, 745, 747, 749

resetting (continued)
page color 53
page size 600, 745
page templates 610
pages 651
paragraph styles 756, 1356
part layouts 180
percussion maps 781
playback overrides 689
playback techniques 788
playback templates 564
played duration 689
player names 182
position 436, 518
preferences 58
rests 1274, 1276
secondary beams 856
solo states 548, 717
space templates 742
staff labels 187
staff spacing 626
stage templates 735
staves 606, 607, 624, 632
stems 844, 1078
systems 624, 632
tempo 1336
text 1356
trill intervals 1101
velocity 693
vertical spacing 626
voice order 1443
voicing 536
volume 725

resolution
changing 586
figured bass 395, 397, 961, 966
images 595
rhythmic grid 38, 217, 675

respelling
accidentals 206, 473, 475, 476
chord symbols 158, 884, 885
key signatures 1027
notes 206, 473, 475, 476, 482–485, 492

rest grouping. See note grouping
restating

accidentals 800, 801
restorative

clefs 332, 333
pedal lines 1176, 1178
text 1176, 1178

restoring. See resetting. See also hiding
rests 23, 1271

alignment 1271, 1274, 1275
bar rests. See bar rests
beaming 840, 841, 858
changing type 1274
colors 56, 1275. See also note and rest colors
consolidation 747, 1272–1274, 1279
deleting 259, 452, 810–812, 1276, 1277
dotted 747
durations 259
empty bars 1277, 1279
explicit 1271, 1272, 1274

Index
 

1538
Dorico Elements 5.1.30



rests (continued)
figured bass 395, 957, 959, 967
filling in 259
forcing duration 245, 262, 861
grouping. See note grouping
H-bars. See multi-bar rests
hiding 1264, 1276–1279
implicit 1271, 1272, 1274
inputting 196, 206, 224, 245, 246, 262
inputting items at 213, 317
moving 507, 1275, 1281. See also note spacing
multi-bar rests. See multi-bar rests
notation options 1274
padding 1264
percussion kits 747
placement 1271, 1274, 1275
position 1271, 1274, 1275
resetting 1274, 1276
restoring 1276
showing 1276–1279
spacing. See note spacing
voices 1271, 1273–1275, 1278
width 1280

retakes. See pedal retakes
reticles. See crosshairs
retrieving. See recovering. See also retrospective 
recording
retrograde 478, 479, 490
retrospective recording 266, 555
reverb 720–722, 730, 738

adding 727, 738, 742
changing 729, 738, 742, 744
channels 718
default settings 744
deleting 727
hiding 724
mixer 718
saving 739, 741, 742
showing 724
tail 101
templates. See space templates. See also stage 
templates

REVerence 722, 728, 729, 744
reverse

lines 1207
pitches 478, 479, 490
playback. See scrubbing
printing 591, 592
rhythms 478, 479, 490
stems 848, 849, 851, 854, 1074, 1076–1078

Reverse and Invert Pitches dialog 479
Reverse Rhythms dialog 479
reverting. See resetting
reviewing

comments 494
print preview 36, 437, 576

rewinding 538, 542, 555
rfz. See dynamics
rhythm

chord symbols 326, 327
locking 472
requantizing 266
reversing 478, 479, 490. See also retrograde

rhythm (continued)
rotating 480, 481, 491
slashes. See rhythm slashes
tablature 1331
ties 860, 861, 863

rhythm dots 230, 860, 861
Chord mode 254
compound time signatures 1262
consolidation 1062
cut common time signatures 863
deleting 1060, 1065
hiding 1060, 1062, 1065
inputting 214, 224, 227, 230, 259
Insert mode 451
moving 1062, 1063, 1442
number 230, 259
pitch before duration 214
rhythm slashes 1262
showing 1062
splitting notes 261
tremolos 414, 416
voices 1062, 1440, 1442

rhythm section
adding 112, 114, 124, 128, 133
brackets 866, 1317
chord symbols 871, 878, 879
playback 1260
slashes. See rhythm slashes
staff grouping 866, 1317

rhythm slashes 1258, 1261
appearance 1268
bar rests 1273
beaming 1263
caret 218, 233
changing number 1265
counts 1265, 1267
deleting 455
filter 429
font style 1250, 1265
frequency 1266
hiding rests 1264
highlights 1261, 1265
inputting 233, 409, 417
moving 461, 464, 1269
moving counts 514
note grouping 860, 1262
panel 409
parentheses 1267
percussion kits 143, 149, 238, 1260
pitch 233, 1260
placement 1267
playback 1260
popover 408, 417
regions 1258, 1261, 1265
rests 1264, 1273
rhythm dots 1262
splitting 1262
staff position 149, 1269
staff-relative placement 1267
stem direction 1077, 1268
stemless 218, 233
stems 1263
type 1259
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rhythm slashes (continued)
vertical position 1269
viewing options 1265
voices 233, 466, 1258, 1259, 1268

rhythmic feel 552
changing 554
default settings 552
deleting changes 555
popover 295
signposts 450, 554, 555

rhythmic grid 38, 217
attachment lines 437
changing 217
color 54
key commands 60, 63
Key Editor 669, 675
resolution 38, 217
selecting music 428

rhythmic notation 24, 1258
rhythmic position 24

attachment lines 437
playback 538

rhythmic position-attached lines. See lines
rich black 596
ride bell. See unpitched percussion. See also playing 
technique-specific noteheads
right hand hooks. See lines
right pages 647, 648

starting from 609
right pan 739, 741
right zone 37, 38

hiding 44
Print mode 578
Setup mode 117
showing 44
Write mode 204

right-foot pedals. See harp pedaling. See also pedal 
lines
right-hand fingering 981

arpeggio signs 985
brackets 983
inputting 274
placement 972
popover 277
tapping. See tapping

right-hand guitar tapping. See tapping
rim shots. See playing techniques. See also playing 
technique-specific noteheads
rinforzando. See dynamics
rips. See jazz articulations. See also glissando lines
ritardando. See gradual tempo changes. See also 
tempo marks
ritenuto. See gradual tempo changes. See also tempo 
marks
rolled chords. See arpeggio signs
rolls. See tremolos. See also tuplets
Roman numerals

flow numbers 659
harmonic analysis 957
page numbers 1151
tokens 659

Romantic
trills 1104

rooms
panning. See stage templates
reverb. See space templates

RoomWorks SE 722, 728
roots

chord symbols 318, 320, 322, 872, 886
Ross chord symbols 872
Rotary 722, 728
rotating 480

hairpins 514, 938
pitches 480, 481, 491
rhythms 480, 481, 491
slurs 1302
text 1317
ties 1375

round
chord symbol parentheses 889, 891
figured bass brackets 963
notehead brackets 1066, 1067

rounded rectangle
borders 756, 1359
text enclosures 756, 1359

routing 522, 531, 569, 570
rows

bar numbers 832
buttons. See toolbar. See also lower zone
chord diagrams 898, 900
chord symbols 158, 163, 164, 166, 872
dynamics 924, 949, 950
figured bass 964, 965

rubato
expressive text 309, 932, 933
system-attached text 388, 756
tempo marks 293, 1335
text 388, 756

rudimental drumming. See unpitched percussion
ruffs. See grace notes
rulers

crosshairs 517
Play mode 520
rhythmic grid 217

running headers 648
exporting 102
flow titles 69, 75, 611, 997
fonts 756
hiding 611
page numbers 611
page templates 649
project titles 69, 75, 997

runs
grace notes 250
guitar bends 1122, 1131

Russian
instrument names 57

S
S-shaped slurs 1292, 1293
salzedo breath marks. See breath marks
sample libraries. See sound libraries
sample rate 38, 268, 269
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sampled trills 1104, 1105
disabling 1106
enabling 1106

Save Endpoint Configuration dialog 573
saving 69, 103

audio 95, 96, 100, 101
auto-save. See auto-save
backups 105
character styles as default 759
chord diagram shapes 903
comments 500
custom ensembles 116
editors 715
endpoint configurations 571–573
ensembles 116
expression maps 780
folder location 106
font styles as default 754
graphics files 585, 587
import settings 85
instrument names as default 184
Key Editor configurations 715
layout options as default 745
lyrics 1034
MIDI files 85, 95, 96
MusicXML files 83
notation options as default 747
paragraph styles as default 756
PDF files 585
percussion kits 152
percussion maps 785
playback options as default 749
playback templates 566
played notes 266
players 116
plug-in instances 571, 572
PNG files 585
project templates 85
settings as default 85, 745, 747, 749, 754, 756
space templates 739, 742–744
stage templates 732, 736, 737
SVG files 585
text 102
TIFF files 585

saxophone. See instruments. See also transposing 
instruments
scale degrees

chord symbols 320, 872
mapping 484, 485
Nashville numbers 320
noteheads 1057
popover 487
trills 1097, 1099, 1100

scale mapping 484, 485, 492
scale multiplication 711, 712, 714
scale size

accidentals 794
barlines 816, 817, 819
chord diagrams 898
chord symbol components 873, 875
cues 507, 508
fingerings 976, 981
grace notes 507, 508, 1002, 1006

scale size (continued)
note spacing 507, 508
notes 433
printing 581, 593, 594
staves 617, 618, 620, 621

scales 1028
degrees 872, 1057
EDO 1028
exercises. See flows
key signatures 1019, 1021
major 484, 485, 492, 1021
mapping 484, 485, 492
minor 484, 485, 492, 1021
modal 484, 485, 492
octave divisions 1028
transposing 470, 484, 485, 492
values. See scale multiplication. See also Histogram 
tool

scissors 196
activating 196
slashes 1262
ties 1373

scoops
deleting 1143
inputting 351, 352, 360, 361
jazz. See jazz articulations
popover 342, 343
vibrato bar 1137

scope
crosshairs 517
Insert mode 452, 453
jump bar 65
properties 664, 665

scordatura 154, 156
scores. See layouts
scrapes. See playing techniques
scroll view. See galley view
scrolling 442

Key Editor 667, 674
mixer 724
percussion editor 674
piano roll editor 674
playback 539, 542

scrubbing 32, 542, 555
searching 58

ensembles 114
instruments 112
key commands 60–62
layout options 745
notation options 747
notes 429
playback options 749
preferences 58
properties 663

Sebastian music font 751, 753
Second Viennese School accidental duration rule 800, 
801
second voices

adding 232
bar rests 246, 1278

secondary beams 855
changing 856
direction 855
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secondary beams (continued)
lines 856
resetting 856
rests 858
splitting 843

secondary brackets 868, 870
braces 869
hiding 868
showing 868
sub-brackets 869
sub-sub-brackets 870

secondary instruments 671, 699, 703, 705
secondo

repeat endings 1230
seconds

duration tokens 656, 659
timecodes 1226
transport 32, 555

section players 123
adding 124, 128, 129
divisi 1329
empty staves 605
ensembles 114, 128, 129
MIDI import 85
ossia staves 1323
staff labels 1309
staves 606, 607

sections
coda 1236
fine 1236
hiding 42, 1240
repeat 1236
showing 42, 1240

segments
caps 1207
final 1234
glissando lines 1119
guitar bends 1131, 1135
hairpins 938
hooks 1234
length 1232, 1234
lines 1215
moving 514
playing technique continuation lines 1191
playthroughs 1231
repeat endings 410, 412, 1231–1234
slurs 1298, 1299
tuplets 1411

segno 1236
font 1237
hiding 1240
inputting 413, 414
multiple 1237
sections 1236
showing 1240
size 1237

selecting 40, 421, 422, 424, 429, 439
bars 421, 422, 425, 427
beats 428
blue 951, 1297
changing the selection. See navigation
chord symbols 425, 427, 428
chords 216

selecting (continued)
dynamics 423, 429
Engrave mode 421, 423, 424, 439
everything 424, 425, 427, 428
extending selection 422–424
filters 429
flows 424
handles 516
items 210, 421, 422, 424, 439, 503, 676
items behind other items 421
Key Editor 676
key signatures 425, 427, 428
lyrics 423, 429, 1035
marquee 40, 424, 676, 715
more 422–424
notations 40, 424, 439
note spacing handles 511
notes 40, 215, 216, 421, 422, 424, 429, 439, 676
panels 201, 204, 205
playback 540, 555
points 676
redoing 438
rehearsal marks 425, 427, 428
repeat endings 425, 427, 428
staff spacing handles 624
status bar 38
staves 424
system objects 425, 427, 428
system spacing handles 624
system track 425
system-attached text 425, 427, 428
tempo marks 425, 427, 428
time signatures 425, 427, 428
tools 38, 40, 196, 669
tracks 87
transposing selections 469
undoing 438
velocity bars 715
voices 423, 429, 466, 671, 676
Write mode 196, 421–424, 427, 428, 439

selectors
layouts 30, 31
panels 201, 204, 205

semibreves. See whole notes
semiquavers. See sixteenth notes
semitones. See half-steps
sends 722

loading 728
mixer 717, 718
removing 729

separators
beams 857, 861
chord symbols 877, 887
duration tokens 659
dynamics 309, 928
fingerings 989
staff labels 1315
systems. See system dividers
time signatures 1389, 1392
timecodes 1226
tokens 656, 659

septuplets. See tuplets
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sequences
bar numbers 835–837
page numbers 609
playback 542, 549
rehearsal marks 1217
staff labels 131, 132
subordinate 837
types 1218

sets
drum sets. See drum sets
page templates. See page template sets

setting up
audio devices 58, 268, 269
drum sets 143
duplex printing 581
key commands 63
MIDI recording 268
percussion kit note input 240
percussion kits 143
windows 43
workspaces 43

settings 27, 745
audio 58
copying properties 646
default 58, 745, 747, 749
flow-specific 747
harp pedals 1153
individual items. See properties
layout-specific 745
MIDI import 85
mouse input 211
notations input 213, 317
note input 214, 215, 227
preferences 58
properties 663–665
videos 190

Setup mode 19, 109
adding players 128
ensembles 128
flows. See flows
instruments. See instruments
layouts. See layouts
panels 37, 109, 110, 117, 120
percussion 143
player groups 167
players. See players
signposts 450
switching 43, 109

sextuplets. See tuplets
sfz. See dynamics
shadow notes 210

color 54
shakes. See jazz ornaments
shape

bar number enclosures 827
beaming 845, 847–851, 854, 855, 857, 859, 1078
borders 756, 827, 1359
chord diagrams 894, 900, 902–904
figured bass brackets 963
guitar bends 1131, 1133–1135
multi-segment slurs 1301
notehead brackets 1067, 1071, 1072
noteheads 1053, 1057

shape (continued)
parentheses 891, 963, 1067
slurs 1287, 1288, 1298, 1300–1302, 1306
text enclosures 756, 1359
ties 1374, 1375
tuplet brackets 1413–1415

sharing staves. See condensing. See also divisi
sharps. See accidentals
shifts

clefs 330, 912
octaves 330, 468–470, 472, 477, 912
pitches. See rotating
rhythms. See rotating

short
barlines 817, 819
dynamics 934, 943
notes 93, 224, 249, 259, 507, 1002
notes in playback 93, 749, 768, 809, 1009
percussion notes 682
scores. See condensing. See also layouts
stemlets 858
tempo text 1339

shortcuts. See key commands
shoulder offset

notehead brackets 1071
slurs 1306
ties 1379

showing. See hiding
shrinking. See size
side stick. See unpitched percussion. See also playing 
technique-specific noteheads
signatures

annotations 597
key signatures. See key signatures
printing 597
time signatures. See time signatures

signposts 450
barlines 306, 307, 455, 813, 815, 1397
bars 813
chord symbols 871, 878, 882
clefs 910
dynamics 927
exporting 585, 597
extra staves 1323
figured bass 395, 957, 958, 967
frame breaks 639
harp pedaling 1153, 1155, 1156
hiding 437, 450
key signatures 280, 281, 1019
multi-bar rests 1281
octave lines 917
ossia staves 461, 464, 1323
percussion legends 1430
pick-up bars 1386
playing techniques 1183
printing 581, 597
showing 450
staff changes 1323
staves 461, 464
system breaks 633, 636
tempo marks 1340, 1341, 1343
text 1362
time signatures 813, 1386, 1389, 1391, 1396, 1397
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signposts (continued)
trills 1097–1100
tuplets 1413, 1416

silence
hairpins. See niente
leading. See pre-roll
MIDI keyboards 216
missing sounds 564
muting items 548
notes 1141
playback template 558, 559, 564
rests. See rests

simile
dynamics 309, 312, 932
hiding 1189
playing techniques 1189
showing 1189

simple time signatures. See time signatures
simplifying

accidentals 475
figured bass 969
time signatures 1394

singers 114, 130. See also vocal staves
single bar rests

bar counts 1279
H-bars 1279
hiding 1277
showing 1277

single barlines 306, 307, 816, 817, 819
single players 123, 127

adding 124, 128, 129
empty staves 605
ensembles 114, 128, 129
extra staves 1323
MIDI import 85
ossia staves 1323
staff labels 1309
staff size 618
staves 606, 607

single-line
percussion kits 1428, 1429
staves 1322

single-note tremolos. See tremolos
single-sided printing 581
single-stroke caesuras 337, 1012
single-voice contexts 1438

articulations 805
grace notes 1002
guitar pre-bends 1129
stem direction 1002, 1074
tie curvature direction 1368

six-line staff
tablature. See tablature

sixteenth notes 14, 200, 224, 259, 1002
beaming 841, 861
beats 302
chords 251
glissando lines 1121
grace notes 249
hiding 1060, 1079
Insert mode 237
metronome marks 294
percussion 238, 682

sixteenth notes (continued)
pick-up bars 285, 289, 291
quantization 93
rests 245, 1271
rhythmic grid 217
showing 1060, 1079
splitting notes 261
swing playback 295, 552
tablature 242
tremolos 414, 416, 1399
tuplets 254, 257
voices 232

size 617
absolute 754, 756
accidentals 794, 877
arpeggio sign fingerings 985
audio buffer 268, 269
bar numbers 829, 830
barlines 822, 824
bars 451, 452, 507, 602, 603, 612, 621, 810, 1328
beams 845, 847, 857
brackets 865, 866, 892, 1317
channels 724
chord diagrams 898, 906
chord symbols 433, 877, 889, 892
cues 920
dynamics 433, 953
elision slurs 1035, 1050
figured bass 968
fingerings 906, 976, 979, 985, 1334
flared hairpins 942
flow headings 756
font styles 389, 754, 756, 1356
fret numbers 906
gaps 152, 1291, 1368
grace notes 433, 1002, 1006
H-bars 1280
instrument change labels 142
instrument names 1318
Key Editor 673, 674
laissez vibrer ties 1372
left-hand fingering 981
line text 1209
lyrics 1041–1044
measures 612, 1328
metronome marks 1339
mixer 724
multi-bar rests 1280
noteheads 602, 617, 920, 1053, 1058, 1059
notes 433, 602, 617, 920
octave lines 433
page numbers 1150
pages 593, 600, 745
paper 593, 594
paragraph styles 756
parentheses 892
percussion editor 673, 674
piano roll editor 673, 674
player group labels 1317, 1318
playing techniques 433
project window 40, 49
rastral 617
rehearsal marks 433, 1219
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size (continued)
repeat endings 1232, 1233
repeat markers 1237
slurs 1302
space 617
staff labels 1318, 1319
staff-relative 754, 756
staves 602, 617, 618, 745
system objects 602, 618
systems 612
tablature 1334
tasto solo 968
tempo marks 1339
text 389, 754, 756, 1356
ties 1375
time signatures 1387, 1389, 1397
titles 756
tracks 537, 673, 674
unit of measurement 51
video window 192

sketch staves 112, 114
slants

beams 847, 1008
pedal line hooks 1172

slap tongue. See playing techniques
slash notation 1258
slash regions 1261

beaming 1263
beat grouping 1262
chord symbols 878, 882, 1261
compound time signatures 1262
counts 1265, 1267
default settings 1262
deleting 455
filter 429
font style 1250
handles 430
hiding other notes 1263
hiding rests 1264
highlights 1261, 1265
inputting 417
length 430
moving 461, 464, 1269
moving counts 514
multiple 1268
note grouping 860, 1262
overlapping 1268
parentheses 1267
placement 1267
popover 408, 417
rests 1264
showing other notes 1263
staff position 1269
staff-relative placement 1267
stem direction 1268
stems 1263
vertical position 1269
viewing options 1265
voices 1258, 1268

slash voices 1258, 1399
bar rests 1273
caret 218, 233
changing 466, 1259

slash voices (continued)
hiding stems 1079
inputting 233
moving 1269
multiple-voice contexts 1268
percussion kits 143, 238, 1260
playback 1258, 1260
popover 408
rests 1273
staff position 1269
stem direction 1077
stemless 218, 233
vertical position 1269

slashes 1258
bar rests 1273
caesuras. See caesuras
chord symbols 872, 886
double 1324, 1399
dynamics 309, 928
figured bass 397
grace notes 1002, 1006, 1007, 1009
noteheads 1053, 1056, 1258, 1421
notes. See slash voices. See also tremolo strokes
pauses. See caesuras
percussion 1421
regions. See slash regions
rests 1273
stemless 1259
stems. See tremolo strokes
systems. See system dividers
time signatures 1389, 1392
tremolos. See tremolo strokes
triple 1399
voices. See slash voices

slides
fingerings. See fingering slides
guitar 1115
jazz. See jazz articulations
Key Editor 667
pitch. See glissando lines. See also pitch bends
tempo 32
zoom 667

slight bends. See guitar bends
slots 522, 722
slur segments 1298, 1301

number 1299
slurs 1180, 1283, 1365

angles 1287, 1302
arpeggio signs. See curved arpeggio signs
articulations 806, 808, 1286
bar numbers 832
collision avoidance 1287, 1295
colors 56
control points 1300
copying 457, 460, 805
cross-staff 273, 1287, 1294
cross-voice 273, 1294
crosshairs 517
curvature 1285, 1292, 1293, 1306
dashed 1289–1291
deleting 455
dotted 1289–1291
duration 1308
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slurs (continued)
East Asian elision 1050
editorial 1289, 1290
elision 1050
endpoints 1286, 1287, 1300, 1302
Engrave mode 1300
filter 429
fingerings 976
flat slurs 1292
formatting 1290–1292, 1302, 1304
frame breaks 1287
gap size 1291
gaps 1287, 1295
grace notes 273, 1002, 1284, 1285
guitar techniques 364
hammer-ons 364, 1139
handles 1288, 1298, 1300, 1301
height 1304, 1305
inputting 206, 273, 364, 1295
inverting 1285, 1292, 1293
large pitch ranges 1288
length 430, 1284
linking 460, 1297, 1298
lyrics 1050, 1290
MIDI import 91
MIDI recording 268
moving 461, 464, 1302
multi-segment 1301
muting 548
nested 1286
nested slurs 1295
notehead brackets 1072
ornaments 1092
overlapping 1287
panel 200
placement 518, 1283, 1285–1287, 1292, 1293
playback 273, 545, 546, 749, 1308
position 518, 1283, 1285–1287, 1292
pull-offs 364, 1139
ranges 1288
rotating 1302
segments. See slur segments
selecting 423, 439
shape 1287, 1288, 1298, 1299, 1301, 1302, 1306
short 1288
shoulder offset 1306
staff lines 1285
stem direction 1286, 1292
styles 1289, 1290
system breaks 1287
thickness 1304
ties 1284, 1286
ties vs. slurs 1365
tucking index 518
unlinking 460, 1298
within slurs 1295

small notes 433
cues. See cues
grace notes. See grace notes
harmonics. See harmonics
staves. See staff size
trills. See trills
tuplets 1408. See also tuplet numbers

smart quotes 656, 659
smears. See jazz ornaments
smooth

dynamics 697
glissando lines 1115, 1119, 1120
jazz articulations 1145
MIDI 704
slur shapes 1300, 1301
tie shapes 1374, 1375

smorzando. See gradual tempo changes. See also 
tempo marks
SMPTE. See timecodes. See also markers
SMuFL 751, 753

accidentals 391
chord symbols 877
dynamics 953
figured bass 968
fingerings 979
metronome marks 1339
music symbols 391
noteheads 391
tempo marks 1339
time signatures 1398
tokens 657

snap pizzicato. See playing techniques
snapping pitches

pitches 482, 483, 492
scales 484, 485, 492

snare drum. See unpitched percussion
snare rolls. See tremolos
solfège chord symbols 320, 872
solid

lines 1194, 1206
slurs 1289, 1290
tempo marks 1347
ties 1366

solo
indication 388
players. See soloists. See also single players
scrubbing 542
staff labels 127
system objects 1327

soloing 717, 718
channels 547, 720
deactivating 548, 717–719
instruments 542, 547
playback 542, 545, 546
tracks 547
voices 547

soloists 127
panning 733
system objects 1327

sonata. See flows
songbooks 19, 75, 121, 171

composer 998
copyright 999
lyricist 999
titles 997

songs. See flows
sordino. See playing techniques
sorting

comments 500
flows 173
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sorting (continued)
instruments 125–127
layouts 179, 180
players 110, 125–127

sostenuto pedal 1161
MIDI controller 1178
start signs 1171
text 1176, 1177

sound libraries 558, 780
changing 564
delay 769
documentation 69
expression maps 762
loading sounds 528, 542, 558, 564
missing sounds 564
panning. See stage templates. See also space 
templates
percussion maps 784
playback 761, 762, 780
trills 1104

sounding
duration 687, 1009, 1406. See also played duration
percussion legend ranges 1430, 1432
pitch. See sounding pitch. See also concert pitch

sounding pitch 178, 1081
harmonics 1085
input pitch 215
layouts 178
playback 545

sounds. See playback
soundtracks

audio 193
volume 193

source instruments 920
source notes 986

pitch mapping 482, 483, 492
scale mapping 484, 485, 492

space size 602, 617, 618
space templates 730, 738

changing 742, 744
creating 739, 742
dialog 738, 739, 741
exporting 744
expression maps 764
factory default 738
importing 743
percussion maps 781
playback templates 561, 566
resetting 742

spacing 507, 603, 620, 621
accidentals 795–797
arpeggio signs 1111
bars 507, 509, 813, 1199, 1276
caesuras 340
capos 158, 872
chord diagrams 898
chord symbols 872, 880, 881, 887, 888, 893
clefs 907, 909
condensing 643
cross-staff beams 852
cues 507
flow headings 615
frame fullness 506

spacing (continued)
frets 154
galley view 40
gaps 507
grace notes 507
gradual dynamics 944
hyphens 1035, 1045, 1046
layout options 745
lyrics 508, 1035, 1037, 1039, 1041, 1042, 
1044–1046
mixer 724
notes. See note spacing
percussion 143, 152, 1429
rehearsal marks 1216
rests. See note spacing
rhythm dots 1442
staff lines 143, 152, 1429
staves. See staff spacing
stems 852
systems. See system spacing. See also staff spacing
tacets 642
text 756, 759, 1356
time signatures 1394
voice columns 1442, 1443

spatial sounds. See panning. See also reverb
speech bubbles

comments. See comments
speed

arpeggio signs 1112, 1113
beaming. See fanned beams
bpm 1341
changing 293, 543, 708, 709, 1016, 1342, 1344
frame rates 193
grace notes 1009
playback 543, 1016, 1335
swing playback 552
tempo marks 1335, 1342, 1344, 1345
tremolos 1403
trills 1095, 1104, 1106
videos 193

spelling
accidentals 245, 473, 475, 476
chord symbols 157, 158, 871, 883, 884
notes 245, 473, 475, 476

spiccato. See playing techniques
spin boxes 666
split point 91
split stems 798

appearance 799
splitting 261

barline joins 824
bars 633, 634, 636, 637, 813, 1382, 1394
beams 747, 840, 843, 855, 858, 860, 861, 863
brackets 1070
flows 501, 583–585
multi-bar rests 1279, 1281
notehead brackets 1070
notes 196, 261, 262, 466, 747, 860, 861, 863, 1262, 
1373, 1435
PDF files 585
pedal lines 1169
phrases 466, 1329
project window 48
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splitting (continued)
repeat marker text 1239
rests 245, 262, 861, 863, 1273
slash regions 1262
staves 413, 414, 633, 634, 636, 637, 643, 1236, 
1329
ties 261, 262, 747, 860, 861, 1373
tuplets 1411
voices 466, 1435

spreads
histogram controls 711, 712, 714
page arrangement 41, 50, 590

square
accidental brackets 793, 1084
bracketed noteheads 1066, 1067, 1072
brackets 868–870, 1194
figured bass brackets 963
noteheads 1056

squeal. See pinch harmonics
squeezes. See jazz ornaments
staccatissimo. See articulations
staccato. See articulations. See also playback 
techniques
stacking order 518

accidentals 795, 797
bowing marks 1185
changing 919
chord symbols 163, 164, 166, 872, 887
fermatas 1185
lines 1199
octave lines 518
playing techniques 1185
signposts 450
slurs 518
string indicators 1185
tuplets 518

staff grouping
barline joins 822, 824
changing 865
default settings 77, 865, 866
ensemble types 865, 866
player groups 167

staff labels 181, 1309
alignment 184, 1311, 1318
baseline shift 184
brackets 1317
changing 183, 1313, 1315
colors 184, 1318
condensed staves 1318, 1320
Cubase 1310
default settings 77
divisi 1320
first system 1310, 1328
flows 1310
fonts 756, 1318
galley view 40
grouping 150, 151, 1317, 1319, 1320
hiding 1310, 1312
indents 1311, 1318, 1327, 1328
instrument change labels 141
instrument changes 138
instrument names 57, 150, 151, 181, 183, 184, 187, 
657, 1310, 1313

staff labels (continued)
italics 184, 756
language 57
length 1310, 1312, 1313
line breaks 1315
MusicXML import 1310
numbering 131, 132, 1313, 1320
overline 184
paragraph styles 756, 1318
parentheses 1315
percussion 143, 150, 151, 1313, 1319, 1428, 1432
player groups. See player group labels
player names 182, 1313
project templates 77
resetting 187
separators 1315
showing 1310, 1312
size 1318, 1319
solo 127
stretch 184
subscript 184
superscript 184
systems 1312
tokens 657
transposing instruments 1309, 1314, 1315
underline 184

staff lines
erasing 888, 930, 975, 985, 993, 1182, 1213, 1361, 
1433
fingerings 985
number 143, 608, 1428, 1429
percussion 143, 152, 1429
slurs 1285
spacing 143, 152, 1429
string indicators 993
tablature 154, 1330
text 1182, 1213, 1361
ties 1377

staff position
lines 1111, 1202–1204
note input 240
percussion 685, 1420, 1421, 1424, 1425
percussion kits 149, 240

staff size 594, 602, 617
changing 602, 618, 620
custom 620
dialog 620
individual staves 618
layouts 602, 617, 618
MusicXML files 82
rastral size 617
space size 617

staff spacing 503, 602, 620
activating 503
changing 603, 604, 620, 624
condensing 643
copying 628
default settings 603, 621
divisi 604
final systems 612
flow headings 615
fullness 506
galley view 621, 623
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staff spacing (continued)
handles 624
hiding staves 605–607
horizontal 506, 612
justification 506, 604, 612, 621
layout options 745
layouts 603
moving systems 627
rehearsal marks 1216
reverting 626
system fullness 506
systems 506
text collision avoidance 1357

staff text. See staff-attached text
staff-attached text 1351, 1352

alignment 756, 1356
backgrounds 1361
borders 756, 1358
erased backgrounds 1361
exporting 102
formatting 389, 392, 756, 1356
hiding 1362
inputting 388
moving 478, 480, 514, 1356
padding 756, 1360
paragraph styles 1356
reversing 478. See also retrograde
rotating 480
selecting 421
showing 1362
signposts 450
staff-relative placement 434

staff-relative font size 754, 756
staff-relative placement

articulations 808
bar numbers 834
beaming 845, 846
changing 434
cue labels 434
dynamics 434, 922
figured bass 965
fingering 983
fingerings 974, 975
guitar bends 434
guitar pre-bends 1129
hammer-ons 1142
harmonics 1087
left-hand fingerings 984
lines 1201, 1202
lyrics 1038, 1039
numbered bar region counts 1257
octave lines 434, 916
ornaments 434
pedal lines 1167
percussion legends 434
playing techniques 434
pull-offs 1142
rehearsal marks 1216
repeat markers 1241
resetting 436
slash region counts 1267
slurs 1293
string indicators 381, 383, 993, 995

staff-relative placement (continued)
tapping 1142
text 434
trills 434
tuplet brackets 1414

stage templates 730, 731, 738
changing 735
creating 732, 733, 736
dialog 731–733
exporting 737
expression maps 764
factory default 731
importing 737
percussion maps 781
resetting 735

stars
pedal lines 1161, 1173

start area 34
start position

frames 629, 636
lines 1205
pages 629, 636
playback 538
systems 629, 633
trills 1092
videos 191

start repeat barlines 303, 816, 817
counts. See repeat counts
inputting 301, 303, 306, 307
key signatures 819
playthroughs 549, 1242
system breaks 819

start signs
lines 1188, 1196
pedal lines 1171, 1176

starting 222
area 34
Hub 69
interchangeable time signatures 283, 287, 288, 
1382, 1397
MIDI recording 264
note input 222, 224, 227
playback 540
players 34
projects 34, 71
timecode values 1227
workspaces 43

statistics 106
exporting 107

status bar 38
selection tools 40
view types 40, 41
width 40

staves 14, 1322
adding 124, 128, 133, 1323, 1329
arranging tools 455
bar numbers 829, 831
bar rests. See bar rests
barlines 822, 824
beaming 851–854
brackets 77, 865, 866, 1317
casting off 629–631
chord symbols 178, 318, 878, 880–882
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staves (continued)
clefs 913
collision avoidance 603, 604, 621, 623, 624
color 55
comments 494, 496, 499
condensing. See condensing
copying items 457, 458
crossing notes 851, 854
dialog 620
dividers. See system dividers. See also divide 
arrows
divisi 1329
dynamics 313, 315, 434, 931
dynamics linking 460, 951
empty. See empty staves. See also blank staves
extra 1323
fermatas 1014
figured bass 395, 957
filtering. See instrument filters. See also filters
fingerings 975, 985
five-line 1319, 1322, 1428
fixing 629–631
galley view 50
gaps 513, 604, 1236, 1328
glissando lines 349, 350
grids 1319, 1428
groups 167, 824, 866. See also staff grouping
height 602–604, 614, 616, 617
hiding 121, 172, 176, 177, 445, 448, 449, 605–608, 
1331
indents 513, 612, 1310, 1311, 1327, 1328
inputting on multiple 213, 222, 235
instrument change labels 141
instrument changes 136, 139, 140
key signatures 280, 281, 1019
labels. See staff labels
language 57
large time signatures 1389
layout options 602
margins 612, 614, 616, 1310, 1311, 1328
markers 1222
metronome marks 1326, 1327
moving 513, 602, 603, 614, 616, 624
multiple voices 232, 643
names. See staff labels. See also instrument names
notation 1330, 1331
note input 222, 235
notes 464
number 106, 605, 608, 630, 1323
order 125–127
ossia staves. See ossia staves
page view 50
pauses 1012
percussion 1428, 1429
pick-up bars. See pick-up bars
playback 540
rasterizing. See staff size
reducing 643
rehearsal marks 1326, 1327
renaming 183
repeat endings 1326, 1327
repeat markers 1241
selecting 424

staves (continued)
showing 50, 172, 176, 445, 448, 449, 605–608
single-line 1222, 1227, 1228, 1319, 1322, 1428
size. See staff size
slurs 1294, 1297
slurs linking 460
spacing. See staff spacing
splitting 413, 414, 1236
staff labels. See staff labels
statistics 106
stem length 1078
string indicators. See string indicators
swing playback 554
system breaks 633
system dividers 1324
system objects 1326, 1327
tablature 1330, 1331
tacets 640
tempo marks 1326, 1327
text 388, 1326, 1327
ties 247, 1371, 1377
time signatures 287–289, 291, 1326, 1327, 1381, 
1387–1389, 1394
timecodes 1222, 1227, 1228
transposing instruments 132
tremolos 851, 854
vertical spacing. See staff spacing
voices 232
VST instruments 529
white 55
width 612

Stein-Zimmermann accidentals 279, 1028
stem direction 1074

beam groups 1076
beam placement 845, 853
centered beams 849
changing 466, 1076, 1077, 1268
chords 1075
cross-staff beams 851, 1078
drum sets 148
filters 429
grace notes 1002, 1008
guitar pre-bends 1129
middle line 1074
multiple-voice contexts 1075
notes crossed to other staves 851, 854, 1444
notes on middle line of staff 1074
percussion kits 143, 148, 241, 747, 1435, 1436
resetting 846, 1078
rhythm slashes 1077, 1268
single-voice contexts 1074, 1077
slurs 1286, 1292
staff-relative placement 846
ties 1076
voices 466, 1074, 1077, 1438

stemless
noteheads 1079
rhythm slashes 218, 233, 1259

stemlets 858
gaps 858
length 858
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stems 840, 1074
altered unisons 798
articulations 808
audio 100, 101
beam placement 853
beaming 843, 847, 852
combining. See voices
cross-staff 851, 854, 1078
deleting tremolos 1403
direction. See stem direction
double 232, 798, 1438. See also voices
durations 200, 224, 259, 261
fermatas 1013
flags 1074
gaps 852. See also note spacing
grace notes 1006, 1008
handles 1078, 1404
hiding 1079
inputting 232, 1438. See also voices
length 847, 1008, 1078
percussion kits 143, 148, 241, 747, 1435, 1436
resetting 844, 1078
reverse 848, 849, 851, 854, 1074, 1076–1078
rhythm slashes 1259, 1263, 1268
showing 1079
slashes 1399
slurs 1286
split stems 798, 799
stemlets. See stemlets
tablature 1331
ties 1076
tremolos 1399, 1402, 1404
unbeaming 843
voices 232, 466, 1074, 1077, 1438, 1442, 1443

step input. See note input
step-wise movement

scrub playback 542
stereo pan 718, 720

changing 726
StereoEnhancer 722, 728
stickings 1427
stop positions 451

adding 453
deleting 454
moving 453

stopped pitch 1081
Fretboard panel 208
harmonics 1085

stopping. See starting
stopping finger. See left-hand fingering
straight lines 1194

duration 656, 659
glissando lines 1115
guitar bends 1122
jazz articulations 1148
pedal lines 1161
quotes 656, 659

straight playback. See swing playback
stress marks. See articulations
stretch

instrument names 184
lyrics 1041, 1042, 1044
note spacing 507

stretch (continued)
pages 604, 621
staff labels 184
systems 506, 604, 612, 621
text 389, 756, 759

strikethrough text 389, 756, 759
string designation. See string indicators
string indicators 981, 993, 1059

deleting 994
duration 430, 1186, 1187
font 979, 993
handles 1188
horizontal position 995
inputting 367, 370, 381, 383
inside staff 383, 993, 994
length 1186, 1188
lines 381, 383, 430, 1186, 1187
moving 461, 464, 514, 995, 1184, 1185, 1188
order 1185
outside staff 381, 383, 993
panel 371, 383
placement 995
popover 367, 370, 381
position 995
string number 1059

string instruments 130, 153
adding 112, 114, 124, 128, 133
bowing marks 367, 371, 1184
brackets 866, 1317
chord symbols 878
fingering shifts 990
glissando lines 1119, 1120
groups 167
panning. See stage templates
player order 110, 125
playing techniques. See playing techniques
reverb. See space templates
string number 1059
substitution fingering 972
system objects 1327

string pitches
changing 156, 1059
fretted instruments 156

string shift indicators 990
angles 990
direction 991, 1059
inputting 274, 276, 990
thickness 990

stringendo. See gradual tempo changes. See also 
tempo marks
strings

adding 154
assigning notes to 1059
bends. See guitar bends
bowing marks 367, 371, 1184
capos. See capos
changing 1059, 1332
changing pitch 154
chord diagrams 895, 904
color 54
deleting 154
fingering 981, 1059. See also string indicators
fretted instruments 112, 153, 154
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strings (continued)
hammer-ons. See hammer-ons
harmonics 1081
indicators. See string indicators
notes out of range 1064, 1332
numbers. See string indicators
pitches 154, 1059
pull-offs. See hammer-ons
ranges 154
resetting 1332
slurs. See hammer-ons
tapping. See tapping
tuning 112, 153, 154, 545, 1059

strokes
figured bass 397
grace notes 249, 250, 1002, 1006
slurs 1289, 1290
ties 1366
tremolos 1399, 1400, 1402–1404

structures
documentation 15
meters 283, 840, 860, 1262, 1381, 1382
repeat 409, 549, 1230, 1236, 1245

strumming
arpeggios. See arpeggio signs
fingering 985
rhythm slashes 233, 1260

studio
panning. See stage templates
reverb. See space templates

styles
appearance 436
breath marks 1012
caesuras 1012
fermatas 1011
fonts 753, 754
glissando lines 1115, 1116
jazz articulations 1148
margins 598
niente hairpins 948
page numbers 1150
parentheses 891, 963, 1067
resetting 436
slurs 1289, 1290
tempo marks 1336, 1345
text 753, 756, 759
ties 1366
time signatures 1389, 1391, 1393

sub-brackets. See secondary brackets
sub-sub-brackets. See secondary brackets
subdivision

bars 860, 861, 863, 1262
cut common time 863
slash regions 1262
tempo equations 1349
time signatures 283, 861, 1389, 1390

subito. See dynamic modifiers
subordinate bar numbers 837

adding 837
changing 837

subscript
chord symbols 872
instrument names 184

subscript (continued)
staff labels 184
text 389, 759

subsequent repeats
bar numbers 838

substitution fingering 972
handles 973
position 973

substitution font styles 754
subtitles 75, 647, 648, 651–653, 756. See also flow 
headings
suffixes

dynamics 932, 933
instrument changes 57, 139
playing techniques 1181
rehearsal marks 1219
timecodes 1226

sul ponticello. See playing techniques
sul tasto. See playing techniques
super locrian scales 484, 485, 492
superscript

chord symbols 872
instrument names 184
staff labels 184
text 389, 759
trill intervals 1104

SuperVision 722, 728
suppressing

highlights 437, 450, 1247, 1265. See also hiding
playback 548, 549
staves 605–607

suspensions
brackets 963
chord symbols 322
figured bass 395, 397, 961, 965, 966

sustain pedal 1161
continuation lines 1173
Engrave mode 1163
handles 1163
inputting 369, 375, 377
level changes 378, 1162, 1165
merging 1170
MIDI controller 270, 1178
MusicXML import 1179
popover 369, 375
removing retakes/level changes 1167
retakes 377, 378, 1162, 1164
splitting 1169
start signs 1171
text 1176, 1177

sustaining instruments 953
SVG files 595

color 596
exporting 585, 586, 588
file names 588
fonts 596
layout numbers 180
layouts 585, 586

swapping. See switching
swash arpeggio signs 1108, 1110
swells. See messa di voce
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swing playback 552
disabling 555
enabling 295, 553, 554
popover 295
ratios 552
triplets 552

Swiss army triplet. See grace notes. See also tuplets
switches 766, 774

creating 776, 777
properties 663

switching 467
flows 440–442, 521
galley view 50
handles 511, 516
instruments. See instrument changes
layouts 30, 43, 47
modes 43
note order 1443
notes 465, 511, 1442
page view 50
rehearsal marks 1217
selection 421, 439, 511
staff spacing handles 624
tabs 47
view type 50
voices 467
windows 43, 49

syllables
beaming 843
dynamics 939
lyrics 1031, 1035, 1037
position 1035
tempo marks 1347
types 1031

symbols
bar repeats 1245, 1251
bar rests 1275
caret 218
chords. See chord symbols. See also chord 
diagrams
coda 1238
ornaments 1090
pedal lines 1162, 1171, 1173, 1176
playing techniques 1180
repeats. See repeat markers. See also repeat 
barlines
segno 1238
speech bubbles. See comments
text 388, 391
vibrato bar 1137

symphony. See flows
syncing

dynamics 699
instruments 669, 699, 705
Key Editor 669
MIDI 705
tracks 669
videos to music 191

syncopation
beat grouping 860
stemlets 858

system breaks 504, 598, 633
automatic 629, 631
bar repeats 629, 634
barlines 633, 819, 820
brackets 820
clefs 907
copying to other layouts 643, 645
deleting 632, 636
divisi 1329
dynamics 938
glissando lines 1119
hairpins 938
hiding staves 606
inserting 631, 634
key signatures 1024, 1025
lines 1196, 1215
make into system 635
moving 633
octave lines 918
playing technique lines 1188
playing techniques 1188
repeat endings 1233
signposts 450, 633, 636
slurs 1287
staff labels 1312
staff size 618
staff spacing 603
staff visibility 606
ties 1370
time signatures 1384

system dividers 1324
hiding 1324
showing 1324
width 1325

system formatting 598
casting off. See casting off
condensing. See condensing
copying to other layouts 643
frame breaks. See frame breaks
indents 1310, 1327, 1328
note spacing. See note spacing
staff labels 1310, 1312
system breaks. See system breaks
system dividers. See system dividers
system objects. See system objects

system fullness indicator 506
system objects 1326

copying 425
layouts 1326
lines 386, 1194
positions 1327
rehearsal marks 1216
repeat counts 1242
repeat endings 1230, 1233
repeat markers 1241
selecting 421, 425, 427, 428
size 602, 618
tempo marks 1335, 1336
text 388
time signatures 1388, 1394

system spacing 503, 603, 620
changing 603, 604, 624
default settings 603, 621

Index
 

1553
Dorico Elements 5.1.30



system spacing (continued)
handles 511, 624
justification 604, 621

system text. See system-attached text
system track 425

deleting music 811
hiding 427, 437
inputting bars 305
inputting beats 305
selecting music 427, 428
stop positions 453, 454

system-attached text 1351, 1352
alignment 756, 1356
backgrounds 1361
borders 756, 1358
copying 425
erased backgrounds 1361
exporting 102
formatting 389, 392, 756, 1356
hiding 1362
inputting 388
markers 97
moving 514, 1356
multiple positions 1327
padding 756, 1360
paragraph styles 1356
selecting 421, 425, 427, 428
showing 1362
signposts 450
staff-relative placement 434
staves 1326, 1327
tempo tracks 97

systemic barlines 820, 821
braces 864
brackets 864
hiding 820, 821
secondary brackets 868, 869
showing 820, 821
sub-brackets 868, 869
sub-sub-brackets 870
text alignment 756, 1356

systems
alignment 604, 612
bar numbers 826, 831, 834, 1254
barlines 819–821
breaks. See system breaks
casting off 629–632
changing indents 1328
chord symbols 880, 881
clefs 911
coda gap 1241, 1242
condensed staves. See condensing
dividers. See system dividers
divisi 1329
end position 513
fixing 629–631
formatting 504
fullness. See system fullness indicator
gaps 603, 604, 1236, 1328
height 602–604
indents 513, 612, 1310, 1311, 1327, 1328
justification 604, 612
key signatures 1022

systems (continued)
length 513, 612
lyrics 1036, 1039, 1047, 1049
make into system 635
margins 612, 1310, 1311, 1328
moving 624, 627, 634, 635, 637
number 106, 630
numbered bar regions 1254
rehearsal marks 1216
repeat barlines 819
resetting 632
sections 1236
selecting 423, 424
spacing. See system spacing
splitting 1236
staff labels 1310, 1312, 1320, 1328
staff size 618
start position 513
statistics 106
staves. See staves
text. See system-attached text
timecodes 1227, 1228
tonality 1028
track. See system track
trill marks 1094
vertical position. See system spacing
width 513, 612

T
tabla notation 1436
tablature 1330

appearance 1334
beaming 1331
bend intervals 1128
bends. See guitar bends
bracketed noteheads 1066, 1067, 1122, 1127
capos 157, 159–161
caret 218
changing string for notes 1332
chords 227, 242, 1067, 1069
clefs 907
color 54
colors 56
dead notes 1141
default notation 224, 227
dives 1127, 1135
font style 1334
frets 154, 159–161
green notes 1330, 1332
guitar bends 1122, 1331
harmonics 1082, 1085
hiding 1331
hold lines 1122, 1129
intervals 1128
moving notes to other strings 1332
note input 227, 242
notes out of range 468, 1064, 1330, 1332
numbers 1330, 1332, 1334
open pitches 156
parenthesized fret numbers 1122, 1127
post-bends. See guitar post-bends
pre-bends. See guitar pre-bends
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tablature (continued)
question marks 468, 1330
resetting strings 1332
rhythms 1331
showing 1331
size 1334
stems 1331
strings 154, 156, 224, 227, 1332
ties 1069, 1364
trills 1094
tuning 153, 154, 157, 159–161

tables
actions 767
comments 500
conditions 768
contents. See front matter
endpoint setup 567
exporting 102
fonts 73
markers 402
MIDI import 87
percussion maps 781
switches 766
text 102
tracks 87

tabloid 593
tabs

bar 33
closing 47
groups 48
hiding 31
layouts 43, 45, 47
moving 48
opening 45
order 48
showing 31
showing multiple 48
switching 47
view options 45

tacets 20, 640
borders 756
exporting 80
formatting 640
hiding 641, 1279
margins 642
moving 642
paragraph styles 640
removing players from flows 172
showing 641, 1279
text 641
thickness 756

tags. See signposts. See also comments
tails. See stems
tambourine. See unpitched percussion
tanto. See tempo marks
tap tempo 296
tapping 981, 1138

deleting 1143
inputting 366
moving 514, 1142
percussion. See grace notes. See also tuplets
popover 343
staff-relative placement 1142

tasto solo 395, 397, 756, 957, 968
techniques 1180

combinations 773, 777
endpoint configurations 572
exclusion groups 771
expression maps 762
guitar 1137
percussion 781, 786, 1421, 1423
playback 773, 777, 787, 788

templates
brackets 77
categories 71
deleting 716
ensembles 114, 116, 128, 129, 730
flow headings 651
Key Editor 675, 715, 716
new projects 69
pages. See page templates
playback 525, 558
players 114, 116, 128, 129, 730
projects. See project templates
spaces. See space templates
staff grouping 866
stages. See stage templates
staves 77, 114, 129, 866
text. See paragraph styles. See also font styles
titles 648, 651

tempo 1335
bpm 1341
changing 709
click settings 267, 533
default 455, 1335
deleting changes 677
drawing 706
equations. See tempo equations
finding 403, 1225
fixed tempo 543, 555
follow tempo 543, 555
inputting 708
marks. See tempo marks
metronome marks 1341
MIDI recording 543
muting in playback 548
pauses 1016
Play mode 532, 706
playback 293, 296, 298, 299, 543, 706, 1016
range 1342
recording 543
tracks. See tempo tracks

tempo changes. See tempo marks
Tempo editor 532, 706

adding 671, 675
changing tempo 709
closing 671, 675
copying points 676
deleting points 677
height 673
inputting tempo changes 708
moving tempo changes 709
selecting points 676
zoom 674
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tempo equations 1349
inputting 295, 296, 298, 299
panel 296
popover 295

tempo marks 706, 1335, 1345
abbreviated 1339
absolute tempo changes 296, 1336
alignment 1336
appearance 1343
approximate 1343
barlines 1337
beat units 294, 432, 1342
brackets 1341, 1343
caesuras 1016
changing 432, 1338, 1339, 1342–1344
colors 56
components 1339, 1340, 1343, 1345
continuation lines 1335, 1345, 1347
copying 457, 676
crosshairs 517
dashes 1348
decimal places 298, 299, 1342
deleting 455
equations. See tempo equations
exporting 102
fermatas 1016
filters 429
finding 403, 1225
fonts 1339
formatting 1347–1349
gaps 1348
gradual tempo changes 296, 1336, 1344, 1345
handles 430, 1336
hiding 298, 1340
hyphens 1347
inputting 293, 296, 298, 299
integers 298, 299
length 430, 514, 1336
lines 1345, 1347
metronome marks. See metronome marks
moving 461, 514, 709, 1345
multiple positions 1326, 1327, 1336
muting in playback 548
order 1345
panel 296
parentheses 1341, 1343
period 1343
placement 1336
playback 455, 549, 1335, 1342, 1344
poco a poco 1346
popover 293
position 1327, 1336
rehearsal marks 1216
relative tempo changes 296, 1336, 1344
repeats 549
reset tempo 296, 1336
selecting 421, 423, 425, 427–429
showing 1340
signposts 450, 1340, 1341, 1343
size 1339
staves 1327
style 1347, 1349
text 432, 1336, 1338, 1339

tempo marks (continued)
trills 1106
types 293, 296, 1336
vertical positions 1326, 1327

Tempo panel 296
tempo track 532, 706

editing. See Tempo editor
editor. See Tempo editor
hiding 536, 675, 706
showing 536, 675, 706

tempo tracks 97–99, 706
dialog 97, 99
exporting 98, 99
importing 97
Play mode. See tempo track. See also Tempo editor

tenor clef. See clefs
tenuto. See articulations
terminal lines 1196
terminology

British vs. American English 14
note durations 14

text 753, 1351, 1352
abbreviated dynamics 934, 943
abbreviated tempo text 1339
accidentals 388, 391
alignment 389, 756, 1356
annotations 1196
appearance 389, 754, 756, 759
background color 389, 756, 759
backgrounds 1182, 1361
bar numbers. See bar numbers
baseline shift 389
borders 756, 1001, 1212, 1358–1360
character styles 759, 760
codes. See tokens
collision avoidance 1357
colors 56, 389, 756, 759
comments. See comments
composer 75, 648, 998
copying 58, 457
copyright 75, 648, 999
crosshairs 517
default settings 388, 760, 1357
distance from staff 514
dynamics. See dynamics. See also dynamic 
modifiers
Edit Font Styles dialog 754
editing 392, 1338, 1352
editor. See text editor
erased backgrounds 1182, 1214, 1361
exporting 102
expressive. See dynamic modifiers
filter 429
fingerings 980
flow titles 188
formatting 69, 389, 753, 754, 756, 760, 1356
front matter 75, 648, 997–999
glissando lines 1117, 1118
glyphs 388, 391, 657
headers 648
hiding 1243, 1362
horizontal 1212
horizontal alignment 756, 1356
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text (continued)
inputting 388, 1208
instrument changes. See instrument change labels
instrument names. See instrument names
layout names 181, 1001
leading 756, 758, 1356
lines 1196, 1208–1214
lyricist 75, 648, 999
lyrics 1031, 1043, 1044
markers 97, 401, 402, 1221, 1223
missing fonts 73
moving 461, 514, 1356, 1357
multiple positions 1326, 1327
music fonts 751, 753
music symbols 388, 391, 657
overlapping 1357
overline 389, 756
padding 756, 1214, 1360
paragraph styles 756, 758, 1356
part names. See layout names
pedal lines 1176–1178
percussion legends 1433
playing techniques 1180, 1181
printing 102
rehearsal marks 1216, 1219
repeat endings 1233
repeat markers 1237–1239
resetting 1356, 1357
restorative 1176, 1178
running headers 648
saving 102
selecting 423, 429
showing 1243, 1362
signposts 450, 1362
spacing 389, 756, 759, 1356
staff labels. See staff labels. See also player group 
labels
staff-relative placement 434
statistics 106
stretch 389, 756
strikethrough 389
styles 753
subscript 389
superscript 389
system-attached text 388, 1326, 1327, 1351
tacet. See tacets. See also multi-bar rests
tacets 641
tempo marks 432, 1335, 1338–1340, 1345
timecodes 1223
titles 75, 648, 997
tokens. See tokens
types 1352
underline 389, 756
vertical. See player group labels
word wrapping 1239

text editor 389, 392
comments 495, 497–499
lyrics 1043, 1044
Write mode 389

text frames 1352
exporting 102
flow headings 611
identifying 1352

text frames (continued)
running headers 611
tokens 655

text items 1351, 1352
colors 56, 389, 756
copying 58, 457
crosshairs 517
editing 392
exporting 102
filter 429
hiding 1362
identifying 1352
inputting 388
moving 461
positions 1326, 1327
selecting 423, 429
showing 1362
signposts 1362
staves 1326, 1327
vertical positions 1326, 1327

text styles 753
text tokens. See tokens
theme 52
theorbo. See fretted instruments
thick barlines 817–819
thickness

bar numbers 829
beams 845, 857
borders 756, 1157, 1212, 1360
brackets 868, 891
chord symbols 872, 891
grace note slashes 1006
gradual tempo changes 1349
line borders 1212
lines 872
parentheses 891
pedal lines 1175
rehearsal marks 1219
slurs 1290, 1304
string shift indicators 990
tacets 756
text borders 1212, 1360
ties 1367, 1376

three quarters depressed pedal lines 1162, 1163, 1165, 
1166
thru

MIDI 216
thumbs 981

chord diagrams 900, 901, 904
fingerings 981
inputting 277
popover 276, 277

tick
barlines 817, 819
breath marks. See breath marks
played duration 687, 689

tie chains 1364
accents 807
articulations 807, 1364
bracketed noteheads 1069
deleting 1373
glissando lines 1119–1121
numbering bars. See numbered bar regions
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tie chains (continued)
selecting 1364
slurs 1284
splitting 261, 861, 1373
staccato 807
stem direction 1076
tablature 1364
tenuto 807
tremolos 1401, 1402

ties 23, 860, 1364–1366, 1370
accents 807
accidentals 793, 1370
appearance 1366
articulations 807, 809, 1364
bar numbers 832
beat grouping 860, 861, 863
bracketed noteheads 1069
breaking 1373
cautionary accidentals 793, 1084
chains. See tie chains
chords 1369
clef changes 1371
collision avoidance 1364, 1377
control points 1374
cross-staff 247, 1371
cross-voice 247, 1371
curvature direction 1368, 1369
dashed 1366–1368
deleting 466, 860, 1373, 1435
dotted 1366–1368
dynamics 313, 315, 461, 922, 945
editorial 1366
endpoints 1374
Engrave mode 1374
forcing 262, 861
formatting 1366–1368, 1375, 1376
frame breaks 1370
gap size 1368
grace notes 247, 1371
guitar bends 1129
hairpins 313, 315, 461, 922
half-bar 747, 860, 863
half-dashed 1366
handles 1374, 1375, 1377–1379
height 1377, 1378
inputting 196, 247
inverting 1369
laissez vibrer 1372
lyrics 247, 262, 392, 1035, 1045, 1046, 1366
messa di voce 945
non-adjacent notes 247, 1371
non-standard types 1370
note grouping 262, 861
notehead brackets 1072
numbering bars. See numbered bar regions
parentheses 1069
pedal lines 377
placement 1368
playing techniques 372, 374
position 1284, 1375, 1377
rotating 1375
shape 1375
shoulder offset 1379

ties (continued)
slurs 1284, 1286
slurs vs. ties 1365
solid 1366
splitting 261, 262, 860, 861, 1373
staccato 807
staff lines 1377
stems 1076
style 1366
system breaks 1370
tablature 1364
tenuto 807
thickness 1376
tie chains. See tie chains
time signatures 1364, 1371
tremolos 1401, 1402
voices 247, 1368, 1443
width 1375

TIFF files 595
color 596
exporting 585, 586, 588
file names 588
layout numbers 180
layouts 585, 586
resolution 595
transparent 586

time
deleting 451, 452, 810–812
display 555, 558
inserting 237, 304, 305, 451, 452, 545, 1016
language 58
latency 264, 268, 269
markers 1221
rhythmic position 24
signatures. See time signatures
tokens 660. See also date and time
track. See tempo track. See also Tempo editor
transport window 555, 558
videos 191

time and date. See date and time
time bars. See repeat endings
time signatures 1381, 1382

above staff 1388
additive 1382
aggregate 1382, 1394
alternating 1382
appearance 1397
bar numbers 834
barlines 815, 824, 1394
beam grouping 24, 747, 841, 861
beat groups 24, 747, 1390
bracketed groups 1388
brackets 283, 1389, 1392
cautionary 1384
changing 237, 432, 451–453, 813
click 264
colors 56
common 283, 285, 1393
compound 1382
custom 1382
cut common 283, 285, 1393
dashed barlines 1382, 1394
deleting 455
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time signatures (continued)
denominators 1381, 1389, 1391
design 1397, 1398
filter 429
font styles 1397, 1398
hiding 452, 1384, 1396, 1397
inputting 283, 287, 288
Insert mode 237, 451–453
interchangeable 1382, 1397
irregular 1382
large 1387
MIDI recording 264
moving 461, 464, 514, 1394, 1395
multi-bar rests 1280, 1281
multiple positions 1326, 1327
non-power of two 1382
note grouping 24, 841, 860, 863, 1262
noteheads 1391
numerators 1381, 1389, 1390
open 1382, 1389, 1391
panel 285
parentheses 283, 287, 1389, 1392
pick-up bars 285, 289, 291, 1382, 1386
polymeter 287–289, 291, 1381
popover 283
position 287, 288, 1327, 1389, 1394
rest grouping 841, 860, 863
rhythm slashes 1262
selecting 421, 425, 427, 428
separators 1389, 1392
showing 1384, 1396, 1397
signposts 450, 813, 1389, 1391, 1396
simple 1382
size 1387, 1389, 1397
spacing gaps 1394
staves 1327, 1387, 1389
styles 1389, 1392
system objects 1388
ties 1364, 1371
types 283, 1382
upbeats. See pick-up bars
vertical position 1326, 1327, 1387, 1389

Time Signatures (Meter) panel 285
timecodes 1226

changing 190, 1224, 1227
dialog 190
drop frame 1226
exporting 101
flows 120
font style 1224
frequency 1228
inputting 401
markers 402, 403
non-drop frame 1226
offset 1227
panel 402
staff 1222, 1227
staff spacing 603, 621
start values 1227
tempo 403
text 1223
transport window 555, 558
vertical position 1227

times played 1242
changing 551, 1230

timpani 130
key signatures 112
laissez vibrer ties 1372
panning. See stage templates
reverb. See space templates
rolls. See tremolos. See also trills

title pages 647, 997
tokens 655

titles 75, 187, 648, 651, 997
accidentals 657
adding 69, 997, 1352
bold 75, 756
changing 75, 188, 1352
exporting 102
file names 588
first pages 648, 997
flow headings 611, 651–653
flows 187, 188, 651, 997
fonts 648, 651, 756, 997
hiding 69, 611
italics 75, 756
movements 651
page templates 648
paragraph styles 648, 651, 756, 997
projects 187, 588, 997
running headers 611, 649
showing 69, 611
size 756
templates 651
tokens 655

to indications. See instrument change labels
toggle. See hiding. See also activating
tokens 655, 1352

accidentals 657
clefs 657
composer 648, 658, 998
copyright 648, 658, 999
date 660
exporting 102
file names 588, 656
first pages 648
flows 187, 651–653, 658, 659, 997
inputting 655
language 58
layout name 648, 658
lyricist 648, 658, 999
music symbols 657
page numbers 659
page templates 648, 997
project information 75, 187, 648, 658
Roman numerals 659
running headers 649
SMuFL 657
staff labels 657
time 660
titles 187, 648, 658

tom-tom. See unpitched percussion
tonality systems 1028

octave divisions 1028
panel 281
scale mapping 484, 485, 492

Index
 

1559
Dorico Elements 5.1.30



ToneBooster 722, 728
tones

intervals. See whole steps. See also pitch
microtones. See microtones. See also quarter tones
playback. See click

tongue clicks. See playing techniques
toolbar 30

hiding 30
Key Editor 669
mixer 719
transport options 30, 32
workspace options 30, 31

toolboxes 38
Engrave 503
Key Editor 669
Notations 195, 201
Notes 195, 196

tools 38
arranging. See arranging
editing. See properties. See also default settings
selecting 38, 40
timecodes 1226

touched pitch 1081
harmonics 1085

Track Inspector 519, 522, 663
track overview 520

automation. See MIDI CC editor
chords track 535
dynamics. See Dynamics editor
Key Editor 667
markers track 534
MIDI CC. See MIDI CC editor
MIDI pitch bend. See MIDI Pitch Bend editor. See 
also MIDI CC editor
pitch bends. See MIDI Pitch Bend editor. See also 
MIDI CC editor
Tempo editor 706
tempo track 532. See also Tempo editor

tracks 530, 667, 717
adding 675
automation. See MIDI CC editor
chords. See chords track
colors 531, 678, 679
dynamics. See Dynamics editor
height 537, 673
hiding 536, 671, 675
importing 85
independent voice playback 545, 546, 569
inputting notes 681
inserts 717, 718, 722, 728, 729
instruments. See instrument tracks
Key Editor 667
locking 671
markers 534
MIDI. See MIDI CC editor
MIDI import 85
muting 547
names 85
percussion. See percussion editor
piano roll. See piano roll editor
playing techniques. See Playing Techniques editor
routing 522, 569
selecting 87

tracks (continued)
showing 536, 671, 675
soloing 547
system. See system track
tempo. See tempo tracks
time. See tempo track. See also Tempo editor
types 530
unlocking 671
velocity. See Velocity editor
voices 531, 545, 546
volume 725
width 537, 674
zoom 537, 673, 674

traditional
music fonts 751, 753
rastral size 617
tonality systems 1028

transcribing
MIDI import 88, 91
MIDI recording 264, 268
voices 264

Transform tool 710, 713, 714
hiding 715
showing 715

transformations 477
inversion 478
Key Editor 710, 711, 714
MIDI CC 711
pitch mapping 482
popover 487
repetition 482
retrograde 478
rotation 480
scale mapping 484
selections 715
velocity 710, 711, 714

transition lines 1186, 1194
appearance 1190
duration 1187
dynamics 697
hiding 1190
inputting 367, 372, 374
MIDI 704
playing techniques 1191
showing 1190, 1192
tempo 706, 708

translation lyrics 1029
changing lines to 1048
changing lyrics to 1030
paragraph styles 1041
popover 394

transparent
graphics 586
items 56
notes 56, 1060

transport 555
activating 542
basic options 30, 32
deactivating 542
hiding 555
playhead 538
playhead position 555, 558
repeats 549
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transport (continued)
showing 555
window 555

Transpose dialog 469, 470
transposed pitch 178, 468

chord symbols 158, 178, 884, 885
clefs 330, 910, 912
exporting 585
input pitch 215
instrument transpositions 1314
layouts 178, 656, 1000
MIDI import 88
note input 215
part layouts 174, 178, 581, 585
printing 581
score layouts 581, 585
showing 178
staff labels 1309, 1314
status bar 38
tokens 656, 1000
viewing 178

transposing 468, 470
accidentals 470, 1025, 1027
chord symbols 157, 158, 161–163, 165, 166, 178, 
469, 470, 871, 880, 883
clefs 112, 913
dialog 470
expression maps 761, 763, 766, 769
figured bass 469, 472
flows 469, 470
fretted instruments 153, 154, 156, 157
instruments. See transposing instruments
key signatures 469, 470, 1019, 1025, 1027
layouts 38, 174, 178, 183, 656, 1000
MIDI import 88
notes 468–470, 472, 482–485, 489, 492, 685
octaves 468
pitch. See transposed pitch
popover 489
scales 484, 485, 492
selections 469
staff labels 1315
strings 157
tokens 656, 1000

transposing instruments 130, 132, 178, 1309
adding 133
chord symbols 158, 884, 885
clefs 112, 910, 913
concert pitch 178
fretted instruments 132, 161, 162
instrument transpositions 1314, 1315
key signatures 178, 747, 1019, 1021, 1026
layout names 183
layouts 178
staff labels 1309, 1314, 1315
transposed pitch 178

tre corde. See una corda pedal. See also pedal lines
treble clef. See clefs
trees. See split stems
tremblements. See ornaments
tremolo arm. See vibrato bar
Tremolo plug-in 722, 728

tremolo strokes 1258, 1399, 1403
changing number 1402, 1403
moving 1404

tremolos 1399
angles 1400
articulations 786
attack 407, 414, 416, 1401
cross-staff 851, 854
deleting 1403
duration 1405
inputting 407, 409, 414, 416
measured 1399
MIDI import 88, 91
MIDI recording 268
moving strokes 1404
multi-note 407, 1399
number of strokes 1402
panel 409, 416
percussion 1420, 1421
placement 1400
playback 545, 546, 786–788, 1405, 1406
popover 407, 414
position 1400, 1404
release 407, 414, 416, 1401
single-note 407, 1399
speed 1403
strokes. See tremolo strokes
tie chains 1401
tuplets 1399
types 407, 1399
unmeasured 1399
voices 1405

triads. See chords. See also chord symbols
triangles

beams 847
chord symbols 872
noteheads 1055, 1058, 1421, 1424, 1425
percussion. See unpitched percussion
playback 780

triggers
MIDI 94, 574

trill intervals 1097, 1098, 1104
accidentals 1099, 1102
appearance 1102, 1103
auxiliary notes 1102
changing 1099, 1100
deleting 1101
hiding 1098
Hollywood-style 1102
indicators 1097
inputting 346
microtonal 1098–1100
position 1104
resetting 1101
showing 1098
signposts 450, 1098

trill lines 1095, 1096
hiding 1096
length 430, 514
showing 1096
speed 1095, 1096
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trills 1090, 1094, 1102, 1104, 1399
accidentals 1099, 1102, 1104
alignment 1092, 1096
appearance 1102, 1103
auxiliary notes 1102
colors 56
crosshairs 517
deleting 455
deleting intervals 1101
extension lines. See trill lines
filter 429
generated 1105
grace notes 1104
handles 430
hiding marks 1094
Hollywood-style 1102
inputting 341, 346, 347
intervals 341, 1097–1100, 1102, 1104
length 430
lines. See trill lines
MIDI import 88, 91
MIDI recording 268
moving 461, 464, 514, 1091
NotePerformer 1106
panel 345, 347
pitch 1099, 1100, 1107
placement 1091
playback 787, 788, 1104–1106
popover 341
position 1091, 1092
resetting 1101
sampled 1105
signposts 450, 1097–1100
speed 1095, 1104, 1106
staff-relative placement 434
start position 1092
starting pitch 1107
tablature 1094

trimming flows 301, 812
triple accidentals

inputting 244, 279
respelling 473, 475, 476
transposing 470

triple barlines 817, 819
triple-dotted notes 230
triplets 1408

inputting 196, 254, 256
swing playback 552

trombone. See instruments
troppo. See tempo marks
true black 596
trumpet. See instruments. See also transposing 
instruments
tuba. See instruments
Tube Compressor 722, 728
tucking index 518

bar numbers 832
bowing marks 1185
changing 919, 1185, 1199
chord symbols 163, 164, 166
fermatas 1185
lines 1199

tucking index (continued)
playing techniques 1185
string indicators 1185

tuning
capos. See capos
changing 112, 154, 156
chord diagrams 898, 902, 903
custom 154, 156, 157, 895, 898
dialog 154
exporting 157
fretted instruments 112, 153, 154, 157
guitar 112, 153, 154, 157
importing 157
open pitches 156
playback 545
strings 156
systems. See tonality systems

tuplet brackets 1413
angle 514, 1413
end position 1415
handles 1413
hiding 1413
hooks 1413
horizontal 1415
length 514, 1413
moving 514
showing 1413

tuplet numbers 1408, 1416
appearance 1416
hiding 1416
horizontal position 1417

tuplet ratios. See tuplet numbers
tuplets 1002, 1399, 1408

accidentals 244
appearance 1413, 1416
articulations 271, 806
barlines 1411
beams 840, 843, 844, 858, 860, 1412
beat units 257
brackets. See tuplet brackets
colors 56
deleting 1410
end position 1415
filter 429
formatting 1416
handles 1413
hiding 1413, 1416
hooks 1413
horizontal brackets 1415
inputting 93, 254, 1409, 1410
inverting 1414
Key Editor 678
moving 461, 464, 478, 480, 514, 1417
nested tuplets 1408, 1409
notes 1410
numbers. See tuplet numbers
percussion kits 1427
piano roll editor 678
placement 518
popover 254, 256
position 518
quantization 93
ratios. See tuplet numbers
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tuplets (continued)
reversing 478. See also retrograde
rotating 480
showing 1416
signposts 450, 1413, 1416
slurs 273
staff-relative placement 1414
swing playback 552
transformations 477, 1410
tremolos 1399
tucking index 518
types 256, 1408
unscaling 1410

Turkish music
octave divisions 1028

turn off. See hiding. See also deactivating
turns 1090

intervals 1090
jazz. See jazz ornaments
pages. See frame breaks

tutorials 69
tutti 1329
two-up page arrangement 590
TXT files

lyrics 1034
statistics 106, 107

types
appearance 436
arpeggio signs 343
articulations 1146
bar repeats 408
barlines 816
breath marks 337, 1012
caesuras 337, 1012
caret 218
chord symbols 320, 872
clefs 330
dynamics 309, 921
enclosures 827
fermatas 336, 1011, 1017
fingerings 276, 989
glissando lines 343
grace notes 1006
holds 336, 1010
jazz articulations 342, 1145–1147
key signatures 278
lines 1194, 1196
lyrics 394, 1029, 1030
notehead sets 1052
noteheads 1053, 1057
notes 200
octave lines 331, 915
ornaments 341, 1146
page templates 648
pauses 336, 1010
pedal lines 369, 1161
percussion legends 1431
players 85, 123, 127
playing technique lines 1188, 1190
playing techniques 367, 1180
rehearsal marks 1218
repeat endings 406
repeat markers 406

types (continued)
resetting 436
rhythm slashes 1259
syllables 1031
templates 77
tempo marks 293, 296, 1336
text 1352
ties 1366
time signatures 283, 1382, 1389, 1392
tracks 530
tremolos 407, 1399
tuplets 256, 1408

U
ukulele. See fretted instruments
una corda pedal 1161, 1176

appearance 1178
hiding 1178
MIDI controller 1178
start signs 1171
text 1176–1178

unassigned instruments
loading sounds 564

uncompressed MusicXML 83, 84
undamped. See playing techniques. See also laissez 
vibrer ties
underlines

fingerings 977
instrument names 184
lyrics 1044
staff labels 184
text 389, 754, 756, 759

underscores
dynamics 939

undo 30, 438
history 438

ungrouping
dynamics 950
playing techniques 1193

Unicode
inputting 388
text 388

unisons 1329
altered. See altered unisons
stems 232
voices 232, 1439, 1440, 1442

units
beats 190, 296, 403, 432, 1341, 1342
measurement 51
metronome marks 432, 1342
quantization 93
rhythmic grid 217
swing playback 552
system track 425
tempo 296, 403
time 190, 555
tuplets 256
video 190

Universal Indian Drum Notation 1436
unlinking 951

dynamics 952
Key Editor 671
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unlinking (continued)
slurs 1298
tracks 671

unmeasured tremolos. See tremolos
unpitched percussion 1419

adding 112, 114, 133
articulations 786, 1421, 1426
drags. See grace notes
drum sets. See drum sets
dynamics in kits 1427
exporting kits 152
flams. See grace notes
ghost notes. See bracketed noteheads
grace notes 250
grid kit presentation 150–152, 1319
groups 150, 1319
importing kits 153
Indian drum notation 1436
individual instruments 1419
instrument order 149
Key Editor. See percussion editor
kits. See percussion kits
laissez vibrer ties 1372
legends 1430, 1432, 1433
MIDI 38, 667, 679, 701, 780
MIDI import 85
moving notes 465
MusicXML files 83
naming groups 151
notation options 1426
notations 1426
note input 94, 238, 240, 241, 681, 682
noteheads 1421, 1425
panning. See stage templates
parentheses. See bracketed noteheads
part layouts 176, 1429
percussion maps 522, 570, 780, 781
Play mode. See percussion editor
playback 522, 570, 780, 781, 786, 1420
playing techniques 685, 786, 1420, 1421, 1423, 
1424, 1427
presentation types 143, 1419, 1428, 1429
rhythm slashes 143, 1260
rudiments 224, 250, 259, 1002, 1399, 1405, 1408
scrapes. See playing techniques
staff labels 150, 151, 1319
staff position 685, 1421, 1424, 1425
staves 143, 1428, 1429
stem direction 143, 241, 1435
stickings 1427
techniques. See playing techniques
tremolos 786, 1421
tuplets 1427
voices in kits 1435, 1436

unscaling
grace notes 1004
tuplets 1410

up arpeggio signs. See arpeggio signs
up bow. See playing techniques
up-bow breath marks. See breath marks
up-stem voices. See voices
upbeats. See pick-up bars

upper case
chord symbols 872
flow numbers 659
Roman numerals 659

upper limits. See limits
upper notes

percussion 238, 1421, 1424
trills 1107

used chord diagrams 898, 900
capos 165, 166
fingerings 900

user interface 29
colors 52–55
language 57, 64
transport options 32
windows 29

user name
comments 494, 499

V
value fields 666
value line

dynamics 694, 697
MIDI 701, 704
tempo 532, 706

values
faders 720, 725
frame rates 190
gradual tempo changes 1344
histogram controls 712
latency compensation 269
metronome marks 432, 1342, 1344
MIDI CC 704, 710–715
notes. See note durations
properties 666
relative tempo changes 1344
rhythmic grid 38, 217, 681
timecodes 190, 1227
velocity 691–693, 710–714

valves
fingerings 989

vamping 327
variants

adding 112, 133
changing 134

velocity
bracketed noteheads 1067
changing 420, 432, 692, 693, 710–714
controls 692, 710–714
editor. See Velocity editor
expression maps 769
Histogram tool 710, 711
MIDI import 91
MIDI recording 268
MIDI trigger regions 420, 574
resetting 693
selecting 715
Transform tool 713, 714

Velocity editor 691, 692, 694
adding 675, 691
changing velocity 692, 710–714
closing 675, 691
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Velocity editor (continued)
filter 712
height 673
Histogram controls 711
resetting velocity 693
Transform controls 714
zoom 674

velocity lanes. See Velocity editor
verse numbers 1049

exporting 1034
hiding 1049
lyric line numbers 1047
paragraph styles 1041, 1042
showing 1049

versions
files 73

vertical alignment
chord symbols 881
crosshairs 517
dynamics 924, 949–952
items 517
lines 1191
playing techniques 1191
rests 1274, 1275

vertical justification
staves 604, 621
systems 604, 621

vertical lines. See lines. See also arpeggio signs
vertical position 514

articulations 806, 808
bar numbers 831, 832, 834, 1257
bowing marks 1185
breath marks 1013
caesuras 1013
capo chord symbols 163
changing 434
chord symbols 163, 872, 878, 880–882, 887, 897
comments 500
counts 1257, 1267
dynamics 922, 935, 936
fermatas 1013, 1185
figured bass 958, 965
fingerings 971, 983–985
flipping items 434
flow headings 611, 614, 615, 651
harp pedal diagrams 1158
instruments 125–127
layouts 179
lines 1185, 1197, 1201, 1202, 1204, 1215
lyrics 1029, 1035, 1038, 1039, 1047–1049
markers 1222
modifiers 935
ornaments 1091
pauses 1012
pedal lines 1167
players 125–127
playing techniques 434, 1184, 1185
poco a poco 935
rehearsal marks 1216, 1326, 1327
repeat endings 1233, 1326, 1327
repeat markers 1241, 1327
rests 1271, 1274, 1275
rhythm slashes 1269

vertical position (continued)
slurs 1287, 1292
stacking order. See stacking order
staves 125–127, 603, 604, 621, 624
string indicators 1185
system objects 1327
systems 603, 604, 621
tacets 642
tempo marks 1326, 1327, 1336
text 434, 1326, 1327, 1357
ties 1368, 1377
time signatures 1326, 1327, 1387, 1389, 1394
timecodes 1222, 1227
tremolos 1400
trills 1091

vertical spacing
bracketed noteheads 1067, 1070
chord diagrams 898
frame fullness indicator 506
lyrics 1039
ossia staves 1323
percussion kits 152
staves. See staff spacing
systems. See system spacing
tacets 642
text 756, 758

vertical stacking order. See stacking order
vibraphone. See instruments. See also grand staff 
instruments
vibrato. See playing techniques
vibrato bar 1122, 1127, 1137

chords 1127
deleting 455, 1143
dips 362, 1137, 1142
dives 1127, 1135, 1137
duration 430, 1187
handles 1133, 1135
inputting 355, 356, 358, 359, 363, 364
intervals 1128, 1142
length 430
lines 363, 364, 430, 1137, 1187
moving 514, 1133, 1135
playback 1127
pre-dives. See guitar pre-bends
returns 1127, 1135, 1137
scoops 1137

Vibrato plug-in 722, 728
Video Properties dialog 190
videos 69, 189

adding 191
audio 193, 717, 718, 720, 724
channel 717, 718, 720, 724
dialog 190
flows 120
formats 189
frame rates 193, 194
hiding 192
locating 191
markers 534, 1221
mixer 717, 718, 720, 724
panel 402
reloading 191
removing 193
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videos (continued)
size 192
start position 191
syncing 191
timecodes 1226, 1227
tutorials 69
volume 193
window 192

Viennese accidental duration rule 800
view options 40, 597

accidentals 795
attachment lines 437
background color 54
bar numbers 829
bar repeats 1247
changing 38, 713
chord diagrams 895, 897, 898, 900
chord symbols 163, 164, 166, 878–880, 882, 883, 
897
colors 52–56
comments 494, 501
exporting 597
figured bass 967
flows 521
frame break signposts 639
full screen mode 49
galley view 40, 50
harp pedaling 1064
hiding 437
Histogram tool 713
Hub 69
Key Editor 667, 671, 673–675, 713
language 57, 64
layouts 33, 43, 47
lines 437
MIDI trigger regions 575
mixer 717, 719, 724
moving music 440–442, 539
music area 34, 41, 50
notes 549, 1064, 1439
notes out of range 54, 1064
numbered bar regions 1247
page arrangements 38, 41, 50
page color 53
page numbers 1152
page view 40, 41, 50
panels 37, 44
percussion legends 1430
piano roll 667, 671, 673–675, 678
playhead 539, 558
print preview 437, 576
printing 597
recent projects 69
rests 1064, 1275
signposts 450
slash regions 1265
system break signposts 636
system track 427
tabs 33, 43, 45, 47
time signature signposts 1396
timecode 558
tracks 537, 674
transport 558

view options (continued)
types 40
video window 192
voices 1438, 1439
windows 49
zoom 42, 443, 444, 537, 674

VintageCompressor 722, 728
violin. See instruments
vivace. See tempo marks
vocal scores. See layouts
vocal staves 77, 112, 114, 130, 133

barlines 822, 824
brackets 866, 1317
glissando lines 1119, 1120
groups 167
panning. See stage templates
reverb. See space templates
staff grouping 866, 1317
syllabic beaming 843

voice colors
changing 54
exporting 597
hiding 437, 1439
printing 597
showing 1439

voice column index 1440, 1442, 1443
default settings 747
ledger lines 1062
note spacing 511
order 1442, 1443
resetting 1443
rhythm dots 1062, 1442

voices 232, 798, 1438
accidental stacking order 795, 797
adding 232, 233, 466
alignment 1440, 1442, 1443
articulations 805
bar rests 246, 1274, 1278
beaming 1076
caret 218, 232
cautionary accidentals 801
changing 466, 467, 1259
chord symbol playback 318, 535, 536
chords 251
colors 54, 531, 678, 679, 1438, 1439
column index 1442
copying 686
creating new 232, 233, 466
cues 920
deleting 1444
direction 1268
divisi. See divisi. See also condensing
drum sets 142, 148, 1426, 1435, 1436
dynamics 313, 315, 694, 931, 955, 956
endpoints 569
fermatas 1012, 1014
filters 429, 669, 712
flows 569
glissando lines 349, 350
grace notes 1002
hiding 1263
Histogram tool 710, 712
identifying 38, 1439
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voices (continued)
inputting 232, 233, 251, 466, 681
Insert mode 237, 451
Key Editor 545, 671, 681
ledger lines 1062
MIDI CC editor 701
MIDI import 88, 91
MIDI recording 264, 266, 268
mixer 717, 718, 725
moving notes 464
muting 547
notation options 1439
note spacing 511
octave lines 333, 335
order 747, 1442, 1443
overlapping 1440, 1442
panning 726, 931
parts. See layouts
pasting notes into 686
percussion kits 142, 143, 148, 1426, 1435, 1436
piano roll editor 671, 678, 681
placement 1440
playback 545, 546, 569
playing techniques 372, 374, 690
position 1440
rests 1271, 1273–1275
rhythm dots 1062, 1442
rhythm slashes 233, 1268
scrub playback 542
selecting 421–424, 429, 466, 671, 676, 681
showing 1263
slash regions 1263
slashes 233, 466, 1258, 1259, 1268
slurs 1286, 1292, 1294
soloing 547
spacing. See note spacing
status bar 38
stem direction 1074, 1077, 1435, 1438, 1444
stems 1442, 1443
swapping contents 467
swapping order 1442
switching between 232
ties 247, 1368, 1371
tracks 522, 531, 545
tremolos 1405
velocity 691–693, 710, 712, 955, 956
volume 725
VST instruments 529

voicing
chord diagrams 894, 898, 900, 902, 903
chord symbols 318, 535, 536
notes 232, 251
percussion kits 143, 148

volta lines. See repeat endings
volume

bracketed noteheads 1067
channel meters 717, 718, 725
click 725
dynamics 698, 921, 926, 947, 953–955
metronome click 267
MIDI 955
mixer 717, 718, 725
playback 725, 769, 954, 955

volume (continued)
resetting 725
silence playback template 558, 559
swells. See messa di voce
tracks 717, 718, 725
velocity 691–693, 710, 713, 769
video audio 193

VST Amp Rack 722, 728
VST and MIDI panel 519, 525
VST Bass Amp 722, 728
VST instruments 522, 525

activating 525, 542
allowing 527
blocking 527
chord symbols 535
click 533
deactivating 525, 542
editing 525, 529
endpoints 567, 571, 572
expression maps 522, 570, 762
instances 525
loading 527, 528, 542, 558, 564
names 567
numbering 525
panel 525
panning 730
percussion maps 522, 570
playback 558, 559, 567, 761, 780
ports 522, 567
reverb 738
saving 564, 572
setting up 528, 529, 564, 572
space templates 738
stage templates 730
window 529

VSTDynamics 722, 728

W
w/ bar. See vibrato bar
WahWah 722, 728
walker noteheads 1057, 1058
warnings

audio engine 38
deleting players 110, 127
different Dorico versions 73
exporting 585
instrument changes 136, 141, 142
MIDI input 38
missing fonts 73
printing 581
transposition 581, 585

watermarks 597
exporting 585
font style 754
printing 581

WAV files
exporting 100, 101

wavy lines. See wiggly lines. See also lines
wedge lines 385, 1194

hiding 1189
inputting 386
showing 1187, 1189, 1190, 1206
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wedge noteheads 1055, 1058
weight

fonts 875
time signatures 1397

Western tonality
key signatures 1020
octave divisions 1028

whammy bar. See vibrato bar
whistle tones. See playing techniques. See also 
diamond noteheads
white

areas. See erased backgrounds
noteheads 1052, 1053, 1058
notes 1119, 1120
pages 53, 55
staves 55

whole notes 14, 200, 224, 259
beats 302
chords 251
glissando lines 1121
Insert mode 237
metronome marks 294
percussion 238, 682
rests 245, 1271
splitting notes 261
tablature 242
tremolos 414, 416, 1399
tuplets 254, 257
voices 232

whole step trills 1097, 1104
appearance 1102
hiding 1094, 1098
inputting 341, 347
position 1104
showing 1094, 1098

whole steps 792
bend intervals 1119, 1120, 1128, 1142
glissando lines 1119, 1120
pitch bends 700
string pitches 154
tonality systems 1028
transposing instruments 132, 1026
trills. See whole step trills

whole tone
chord symbols 323
scales 484, 485, 492

whole-half diminished. See scales. See also intervals
width

accidentals 796
barlines 816
bars 507, 509, 612, 813, 1276, 1328
beams 845, 857
braces 868
brackets 868, 870
columns 73
elision slurs 1035, 1050
empty bars 813, 1276
flared hairpins 942
graphics 875
H-bars 1279, 1280
hairpins 926, 938, 944
Key Editor 674
keys 206

width (continued)
laissez vibrer ties 1372
ledger lines 1061
line borders 1212
lines 612
measures 612
messa di voce 944
multi-bar rests 1280
note durations 507, 687. See also note spacing
notehead brackets 1071
noteheads 1055
notes 674
pages 600, 601, 612
percussion editor 674
piano roll editor 674
system dividers 1325
systems 513, 612, 1328
text borders 1212, 1360
ties 1375
time signatures 1397
tracks 537, 674
windows 40, 49

wiggly lines 1115, 1145, 1194
glissando lines 1115, 1116
hiding 1189
inputting 347–352, 386
jazz articulations 342, 345, 351, 352, 1145, 1148
playing techniques 1190
showing 1187, 1189, 1206
trills 1095, 1096

wildcards. See tokens
wind band. See bands. See also project templates
wind instruments. See woodwind instruments
windows

full screen 49
MIDI instruments 522
mixer 718, 719
moving tabs 48
multiple 45, 48, 49
opening 49
playback 49, 539
project 29
splitting 48
tabs 48
transport 555
video 192
VST instruments 522, 525, 529
workspaces 43

wizard. See hub
wood blocks 142, 1419

adding 124, 133
click 267, 533

woodwind instruments 130
adding 112, 114, 124, 128, 133
brackets 866, 1317
chord symbols 878
glissando lines 1119, 1120
groups 167
panning. See stage templates
player order 110, 125
playing techniques 371
reverb. See space templates
transposition 112, 132
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word spacing 389, 756, 759
instrument names 184
lyrics 1041, 1042, 1044
staff labels 184

words. See lyrics. See also text
workflow

comments 494
worksheets

colors 56, 1057
extracts. See flows
note name noteheads 1057
text alignment 1356

workspaces 19
key commands 26, 63
options 30, 31
preferences 58
setting up 43, 56

wrapping text
repeat markers 1239

Write mode 19, 195
caret 222
inputting notations 271
inputting notes 223
inputting vs. editing 210
navigation. See navigation
notation options 747
panels 37, 195, 200, 204, 663
playhead 539
popovers 22
selecting 421–424, 427, 428, 439
signposts 450
spacing 623
switching 43, 195
system track 425
text editor 389
toolboxes 38, 195, 196, 201
Transpose dialog 470

written tempo 298, 299, 543, 1335, 1341

X
X-noteheads 1054, 1058

dead notes 1141
percussion 238, 682, 1421, 1423–1425
resetting 1059

xylophone. See instruments. See also transposing 
instruments

Z
zero

bar numbers 1386
chord diagrams 894, 904
fingerings 979
string indicators 383, 993

zig-zag
accidentals 795
lines. See lines

zones 29, 37
Engrave mode 502, 663
hiding 44
lower 663
Play mode 519, 667, 717

zones (continued)
Print mode 576–578
Setup mode 109, 110, 117, 120
showing 44
Write mode 195, 200, 204–206, 208, 209, 663, 667, 
717

zoom 38
bar repeats 1247
changing 443, 444
chord symbols 883
key commands 444
Key Editor 667, 673, 674
lyrics 1043
MIDI trigger regions 575
numbered bar regions 1247
options 38, 42, 443
percussion editor 673–675
piano roll editor 673–675
slash regions 1261, 1265
tracks 537, 673, 674
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